Carlson Survey 2010 Embedded AutoCAD

Carlson Software Inc.  User’s manual

November 2, 2009
## Contents

### Chapter 1. Introduction

- Using the Carlson Software Manual ......................................................... 2
- Product Overview .................................................................................. 2
- System Requirements ............................................................................ 4
- Installing Carlson Software .................................................................... 4
- Authorizing Carlson Software ............................................................... 10
- Carlson Registration ................................................................................ 12
- Setting Up a Project ................................................................................ 13
- Startup Wizard ....................................................................................... 13
- Command Entry ..................................................................................... 16
- Layer and Style Defaults ....................................................................... 16
- What is New ............................................................................................ 17
- Standard Report Viewer .......................................................................... 20
- Report Formatter ................................................................................... 22
- Instruction Manual and Program Conventions ....................................... 25
- Carlson File Types .................................................................................. 26
- Quick Keys ............................................................................................. 29
- Obtaining Technical Support ................................................................ 30
- License Agreement ................................................................................ 31

### Chapter 2. Tutorials

- Lesson 1: Entering a Deed ..................................................................... 37
- Lesson 2: Making a Plat .......................................................................... 46
- Lesson 3: SurvNET .................................................................................. 84
- Lesson 4: Field to Finish for Faster Drafting ......................................... 109
- Lesson 5: Intersections and Subdivisions ............................................. 129
- Lesson 6: Contouring, Break Lines and Stockpiles .............................. 154
2D Scale .......................................................... 221
Scale .......................................................... 222
Edit Text ....................................................... 222
Text Enlarge/Reduce .......................................... 222
Rotate Text .................................................... 223
Change Text Font ............................................. 223
Change Text Size ............................................. 224
Change Text Width ........................................... 224
Change Text Oblique Angle .................................. 225
Flip Text ....................................................... 225
Split Text into Two Lines .................................... 225
Text Explode To Polylines .................................. 226
Add Prefix/Suffix To Text .................................... 226
Remove Spaces From Text ................................... 227
Line Up Text .................................................. 227
Join Text Entities ............................................. 228
Replace Text .................................................. 228
2D Align ....................................................... 228
Standard Align .............................................. 230
Fillet .......................................................... 230
Mirror ........................................................ 231
Properties Manager .......................................... 232
Entities to Polylines ....................................... 234
Reverse Polyline ............................................ 234
Reduce Polyline Vertices ................................... 235
Densify Polyline Vertices .................................. 235
Smooth Polyline ............................................ 236
Draw Polyline Blips ......................................... 236
Add Intersection Points .................................... 237
Add Polyline Vertex ........................................ 238
Add Polyline Arcs .......................................... 238
Add Point by Two Slopes .................................... 239
Edit Polyline Vertex ....................................... 240
Edit Polyline Section ....................................... 241
Remove Duplicate Polylines ............................... 242
Remove Polyline Arcs ...................................... 242
<table>
<thead>
<tr>
<th>Task Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit Point Attributes</td>
<td>453</td>
</tr>
<tr>
<td>Edit Multiple Pt Attributes</td>
<td>455</td>
</tr>
<tr>
<td>Move Point Attributes Single</td>
<td>459</td>
</tr>
<tr>
<td>Move Point Attributes with Leader</td>
<td>460</td>
</tr>
<tr>
<td>Scale Point Attributes</td>
<td>461</td>
</tr>
<tr>
<td>Erase Point Attributes</td>
<td>461</td>
</tr>
<tr>
<td>Twist Point Attributes</td>
<td>461</td>
</tr>
<tr>
<td>Resize Point Attributes</td>
<td>462</td>
</tr>
<tr>
<td>Fix Point Attribute Overlaps</td>
<td>463</td>
</tr>
<tr>
<td>Trim by Point Symbol</td>
<td>466</td>
</tr>
<tr>
<td>Change Point LayerColor</td>
<td>466</td>
</tr>
<tr>
<td>Renumber Points</td>
<td>467</td>
</tr>
<tr>
<td>Explode Carlson Points</td>
<td>468</td>
</tr>
<tr>
<td>Convert Surveyor1 to CRD</td>
<td>469</td>
</tr>
<tr>
<td>Convert CRD to TDS CR5/Convert TDS CR5 to CRD</td>
<td>469</td>
</tr>
<tr>
<td>Convert CRD to Land Desktop MDB</td>
<td>469</td>
</tr>
<tr>
<td>Convert Land Desktop MDB to Carlson Points</td>
<td>469</td>
</tr>
<tr>
<td>Convert Civil 3D to Carlson Points</td>
<td>470</td>
</tr>
<tr>
<td>Convert Carlson Points to Land Desktop</td>
<td>470</td>
</tr>
<tr>
<td>Convert Softdesk to Carlson Points</td>
<td>471</td>
</tr>
<tr>
<td>Convert Carlson Points to C&amp;G</td>
<td>471</td>
</tr>
<tr>
<td>Convert C&amp;G to Carlson Points</td>
<td>471</td>
</tr>
<tr>
<td>Convert Carlson Points to Simplicity</td>
<td>472</td>
</tr>
<tr>
<td>Convert Simplicity to Carlson Points</td>
<td>473</td>
</tr>
<tr>
<td>Convert Leica to Carlson Points</td>
<td>473</td>
</tr>
<tr>
<td>Convert Geodimeter to Carlson Points</td>
<td>473</td>
</tr>
<tr>
<td>Convert Carlson Points to Ashtech GIS</td>
<td>474</td>
</tr>
<tr>
<td>Convert Carlson Points to Softdesk</td>
<td>474</td>
</tr>
<tr>
<td>Convert PacSoft CRD to Carlson CRD</td>
<td>474</td>
</tr>
<tr>
<td>Convert Carlson Points to Eagle Point</td>
<td>475</td>
</tr>
<tr>
<td>Convert Eagle Point to Carlson Points</td>
<td>475</td>
</tr>
</tbody>
</table>
Chapter 11. Survey Menu

Data Collectors ........................................... 477
Edit-Process Raw Data File ............................... 501
Edit-Process Level Data ................................ 549
Edit Process SDMS File .................................. 556
Draw Field to Finish ..................................... 557
Field to Finish Inspector ................................. 583
Enter Deed Description ................................ 585
Deed Reader ............................................... 588
Process Deed File ........................................ 591
Deed Linework ID ......................................... 592
Deed Correlation .......................................... 593
Legal Description Writer ................................. 596
Closure by Point Numbers ............................... 603
Map Check by Pnts ....................................... 606
Map Check by Screen Entities ......................... 608
Cut Sheet ................................................. 609
Set Point Elevations by Surface Model ............ 618
Set Point Elevations by 3D Polylines ............... 618
Polyline Report .......................................... 619
Polyline to RW5 File .................................... 620
4 Sided Building ......................................... 620

Chapter 12. COGO Menu

Draw-Locate Points ..................................... 623
Inverse ...................................................... 623
Occupy Point ............................................. 624
Traverse .................................................. 625
Side Shots ................................................. 627
Enter-Assign Point ...................................... 627
Raw File On/Off ......................................... 628
Line On/Off .............................................. 629
Visual COGO ............................................ 629
Locate by Line-Bearing ................................. 633
Locate by Turned Angle ................................. 634
Locate by Azimuth ...................................... 634
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Locate by Bearing</td>
<td>635</td>
</tr>
<tr>
<td>Pick Intersection Points</td>
<td>635</td>
</tr>
<tr>
<td>Linework Intersection Points</td>
<td>636</td>
</tr>
<tr>
<td>Bearing-Bearing Intersect</td>
<td>637</td>
</tr>
<tr>
<td>Bearing-Distance Intersect</td>
<td>638</td>
</tr>
<tr>
<td>Distance-Distance Intersect</td>
<td>639</td>
</tr>
<tr>
<td>2 Point - 2 Point Intersect</td>
<td>640</td>
</tr>
<tr>
<td>Create Points from Entities</td>
<td>641</td>
</tr>
<tr>
<td>Resection</td>
<td>643</td>
</tr>
<tr>
<td>Benchmark</td>
<td>645</td>
</tr>
<tr>
<td>Numeric Pad COGO</td>
<td>646</td>
</tr>
<tr>
<td>Point on Arc</td>
<td>647</td>
</tr>
<tr>
<td>Divide Between Points</td>
<td>647</td>
</tr>
<tr>
<td>Divide Along Entity</td>
<td>648</td>
</tr>
<tr>
<td>Interval Along Entity</td>
<td>649</td>
</tr>
<tr>
<td>Create Points from Entities</td>
<td>650</td>
</tr>
<tr>
<td>Line by Angle-Distance</td>
<td>652</td>
</tr>
<tr>
<td>Tangent Line from Circles</td>
<td>653</td>
</tr>
<tr>
<td>Building Offset Extensions</td>
<td>653</td>
</tr>
<tr>
<td>Radial Stakeout</td>
<td>654</td>
</tr>
<tr>
<td>Section Subdivision</td>
<td>656</td>
</tr>
<tr>
<td>GLO Corner Proportioning</td>
<td>657</td>
</tr>
<tr>
<td>One Way Control</td>
<td>657</td>
</tr>
<tr>
<td>Two Way Control</td>
<td>659</td>
</tr>
<tr>
<td>Three Way Control</td>
<td>660</td>
</tr>
<tr>
<td>Four Way Control</td>
<td>662</td>
</tr>
<tr>
<td>Solar Observations</td>
<td>663</td>
</tr>
<tr>
<td>Triangle Solutions</td>
<td>666</td>
</tr>
<tr>
<td>Best Fit Circle</td>
<td>667</td>
</tr>
<tr>
<td>Best Fit Line by Average</td>
<td>669</td>
</tr>
<tr>
<td>Best Fit Line by Least Squares</td>
<td>670</td>
</tr>
</tbody>
</table>
Contents

Elevate 2D Polylines .................................................. 729
Parking ............................................................................. 731
Set Back Measure-Move ............................................... 732
Draw Lot Setback ......................................................... 732
Fit Structure ..................................................................... 733
Lot Network Settings ..................................................... 742
Lot Network Boundary .................................................. 747
Tag Sub-Area .................................................................. 747
Untag Sub-Area ............................................................. 748
Identify Sub-Area .......................................................... 748
Report Sub-Area ............................................................ 749
Hatch Sub-Areas ............................................................ 749
Erase Sub-Areas Hatch .................................................. 749
Label Sub-Areas ............................................................ 750
Input-Edit ROW Offsets ............................................... 750
Lot Network Road Network ........................................... 751
Lot Network Linework ................................................... 755
Lot Network Subdivide Area ........................................... 755
Size Lot by Frontage ....................................................... 757
Lot Network Sliding Side Area ....................................... 757
Lot Network Hinged Area .............................................. 758
Lot Network Labels ........................................................ 758
Lot Network Report ........................................................ 758
Lot Network Inspector ................................................... 759
Check Lot Network Parameters ...................................... 759
Find Lot Name ............................................................... 760
Lot Network Renumber Lots .......................................... 760
Lot Network Output To Lot File ....................................... 760
Set Lot File .................................................................... 760
Design Lot ...................................................................... 761
Polyline to Lot File ........................................................ 762
Lot File by Pick Interior .................................................. 763
Lot File by Interior Text .................................................. 764
Lot Manager ................................................................. 765
Lot Inspector ................................................................. 769
Define Lot Attributes ..................................................... 769
Import Lot File From MDB Database .......................................................... 771
Export Lot File to MDB Database ................................................................. 771
Export Lot File To Old SurvCADD ............................................................... 772
Set CRD File for Lot Files ............................................................................. 772
Lot File to Centerline ..................................................................................... 772

Chapter 15. Annotate Menu ........................................................................ 774
  Annotation Defaults .................................................................................... 775
  Auto Annotate .............................................................................................. 783
  Custom Label Formatter AD ....................................................................... 792
  Draw End Point Leaders ............................................................................ 793
  Dynamic Annotation Note .......................................................................... 794
  Switch Bearing/Azimuth Quadrant .............................................................. 795
  Mirror Selected Labels ................................................................................ 795
  Mirror and Flip Selected Labels ................................................................. 796
  Flip Last Label ............................................................................................. 796
  Flip Selected Labels .................................................................................... 797
  Flip On/Off .................................................................................................. 797
  Move Label with Leader ............................................................................. 797
  Bearing with Leader .................................................................................... 800
  Distance with Leader .................................................................................. 801
  Bearing-Distance with Leader ..................................................................... 801
  Azimuth-Distance with Leader .................................................................... 802
  Fix Label Overlaps ..................................................................................... 803
  Global Reannotate ...................................................................................... 805
  Survey Text Defaults .................................................................................. 805
  Offset Dimensions ...................................................................................... 807
  Building Dimensions .................................................................................. 807
  Adjoiner Text ............................................................................................... 808
  Draw Grid .................................................................................................... 809
  Draw Legend ................................................................................................ 811
  Draw North Arrow ....................................................................................... 813
  Draw Barscale .............................................................................................. 814
  Create Point Table ....................................................................................... 815
  Update Point Table ..................................................................................... 816
  Table Defaults ............................................................................................. 816
<table>
<thead>
<tr>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table Header</td>
</tr>
<tr>
<td>Set Table Position</td>
</tr>
<tr>
<td>Curve Table</td>
</tr>
<tr>
<td>Line Table</td>
</tr>
<tr>
<td>Railroad Curve Table</td>
</tr>
<tr>
<td>Delete Table Elements</td>
</tr>
<tr>
<td>Label Arc</td>
</tr>
<tr>
<td>Stack Label Arc</td>
</tr>
<tr>
<td>Custom Label Formatter</td>
</tr>
<tr>
<td>Draw Text On Arc</td>
</tr>
<tr>
<td>Draw Text On Tangent</td>
</tr>
<tr>
<td>Edit Text On Arc or Tangent</td>
</tr>
<tr>
<td>Fit Text Inside Arc</td>
</tr>
<tr>
<td>Fit Text Outside Arc</td>
</tr>
<tr>
<td>Change Polyline Linetype</td>
</tr>
<tr>
<td>Polyline to Special Line</td>
</tr>
<tr>
<td>Polyline to Tree Line</td>
</tr>
<tr>
<td>Add Zig to Polyline</td>
</tr>
<tr>
<td>Add Culvert to Polyline</td>
</tr>
<tr>
<td>Sketch Tree Line</td>
</tr>
<tr>
<td>Special Line/Entity</td>
</tr>
<tr>
<td>Guard Rail</td>
</tr>
<tr>
<td>Label Angle</td>
</tr>
<tr>
<td>Label Coordinates/Elevation</td>
</tr>
<tr>
<td>Label Lat/Long</td>
</tr>
<tr>
<td>Label Curb/Flow Elevations</td>
</tr>
<tr>
<td>Replot Descriptions</td>
</tr>
<tr>
<td>Leader With Text</td>
</tr>
<tr>
<td>Special Leader</td>
</tr>
<tr>
<td>Text Box</td>
</tr>
<tr>
<td>Label Offset Distances</td>
</tr>
<tr>
<td>Label Elevations Along Polyline</td>
</tr>
<tr>
<td>Contents</td>
</tr>
<tr>
<td>---------------------------------</td>
</tr>
<tr>
<td>Vertical Curve Design</td>
</tr>
<tr>
<td>Area</td>
</tr>
<tr>
<td>Area Summary</td>
</tr>
<tr>
<td>Bearing Area Cut-off</td>
</tr>
<tr>
<td>Hinge-Radial Area Cut-off</td>
</tr>
<tr>
<td>Roadways</td>
</tr>
<tr>
<td>Right-of-Way Easements</td>
</tr>
<tr>
<td>Intersections/Cul-de-sacs</td>
</tr>
<tr>
<td>T Intersections</td>
</tr>
<tr>
<td>X Intersections</td>
</tr>
<tr>
<td>Y Intersections</td>
</tr>
<tr>
<td>Bubble Cul-de-Sac</td>
</tr>
<tr>
<td>Standard Cul-de-Sac</td>
</tr>
<tr>
<td>Fit Structure</td>
</tr>
<tr>
<td>Fit Structure Setup</td>
</tr>
<tr>
<td>Stake-Out</td>
</tr>
<tr>
<td>Angles Right</td>
</tr>
<tr>
<td>Radial Stake Out</td>
</tr>
<tr>
<td>Best Fit</td>
</tr>
<tr>
<td>Resection</td>
</tr>
<tr>
<td>Angle Resection</td>
</tr>
<tr>
<td>Distance Resection</td>
</tr>
<tr>
<td>Triangulation</td>
</tr>
<tr>
<td>NAD83</td>
</tr>
<tr>
<td>Solar Observation</td>
</tr>
<tr>
<td>Public Land Section</td>
</tr>
<tr>
<td>Section Subdivision</td>
</tr>
<tr>
<td>GLO-Corner-Proportioning</td>
</tr>
<tr>
<td>One Way Control</td>
</tr>
<tr>
<td>Two Way Control</td>
</tr>
<tr>
<td>Three Way Control</td>
</tr>
<tr>
<td>Four Way Control</td>
</tr>
<tr>
<td>CGDraw</td>
</tr>
<tr>
<td>Drawing Settings</td>
</tr>
<tr>
<td>Set Line Type</td>
</tr>
<tr>
<td>Global Edit</td>
</tr>
</tbody>
</table>
Legend ............................................................... 1190
Border .................................................................... 1197
Coordinate Grid ..................................................... 1198
Text on Arc ........................................................... 1200
Create .................................................................... 1200
Move ...................................................................... 1201
Edit ...................................................................... 1201
Delete .................................................................... 1202
Label Area .............................................................. 1202
Draw Mapcheck ....................................................... 1204
Multi-Draw ............................................................ 1206
Plot Points and Symbols ......................................... 1210
Plot Points on Screen ............................................. 1210
Remove Points from Screen .................................... 1211
Graphic Scale ......................................................... 1212
Text in object .......................................................... 1213
Place Symbol ........................................................ 1215
Lines and Polylines .................................................. 1216
Lines by Point Number .......................................... 1216
Lines by Description ............................................. 1217
Lines by Codes ...................................................... 1219
Polylines by Point ................................................... 1219
Fit Polylines ........................................................... 1220
Calls .................................................................. 1222
Place Calls ............................................................. 1222
Move Calls ............................................................. 1225
Reverse Calls ........................................................ 1225
Tables ................................................................... 1226
Coordinates ........................................................... 1226
Call Table .............................................................. 1228
Curve ................................................................... 1229
Auto Map ............................................................... 1231
Draw .................................................................. 1232
Erase ................................................................ 1238
Leaders ................................................................. 1238
Text ................................................................ 1239
<table>
<thead>
<tr>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coordinate Leader</td>
</tr>
<tr>
<td>Point Label</td>
</tr>
<tr>
<td>Station-Offset</td>
</tr>
<tr>
<td>Query</td>
</tr>
<tr>
<td>Drawing Inspector</td>
</tr>
<tr>
<td>Drop C&amp;G Attributes</td>
</tr>
<tr>
<td>re-Associate Coord. file</td>
</tr>
<tr>
<td>Refresh Screen</td>
</tr>
<tr>
<td>CGMngmt</td>
</tr>
<tr>
<td>Point Manager</td>
</tr>
<tr>
<td>Edit Coordinates (CGEditor)</td>
</tr>
<tr>
<td>Auto Create Points</td>
</tr>
<tr>
<td>Manual Storage</td>
</tr>
<tr>
<td>Show Used/Free Points</td>
</tr>
<tr>
<td>Show Free Points</td>
</tr>
<tr>
<td>Show Used Points</td>
</tr>
<tr>
<td>Delete</td>
</tr>
<tr>
<td>Fix Coords</td>
</tr>
<tr>
<td>List</td>
</tr>
<tr>
<td>Renumber Points</td>
</tr>
<tr>
<td>Transformations</td>
</tr>
<tr>
<td>Combined Transformations</td>
</tr>
<tr>
<td>Best Fit Transformation</td>
</tr>
<tr>
<td>Copy Coordinates</td>
</tr>
<tr>
<td>Cut Sheet</td>
</tr>
<tr>
<td>Description Tables</td>
</tr>
<tr>
<td>Create</td>
</tr>
<tr>
<td>Edit</td>
</tr>
<tr>
<td>Set Current</td>
</tr>
<tr>
<td>Close Current</td>
</tr>
<tr>
<td>Set Default</td>
</tr>
<tr>
<td>Convert to SurvCE FCL file</td>
</tr>
<tr>
<td>Point Groups</td>
</tr>
<tr>
<td>Create</td>
</tr>
<tr>
<td>Edit</td>
</tr>
<tr>
<td>Refresh Status Line</td>
</tr>
</tbody>
</table>
CGTopo

Topographic Settings

New Surface

Open Surface

Close Surface

Break Lines

By Point Number

By Description

By Code

Map Draw

Map Erase

From Breakline Layer

Delete From Tin File

Edit Points

Add Points

Remove Points

Swap Triangles

Show Surface

Define Boundaries

By Point Number

By Description

By Code

Process Boundaries

Write Surface to DWG

Erase Surface from DWG

Tin

Main Contours

Intermediate Contours

Break Lines

Include Boundaries

Exclude Boundaries

All topo items

Label Contours

Place Labels

Delete Labels

TIN from 3D Faces
Chapter 19. SurvNET

Introduction .......................................................... 1430
Starting Survnet ....................................................... 1433
Menu System Overview ............................................. 1436
File Menu ............................................................ 1437
Settings Menu ........................................................ 1451
Process Menu ........................................................ 1468
Tools Menu ........................................................... 1486
View Menu ............................................................. 1496
Toolbars ................................................................. 1500
Raw Traverse Data ..................................................... 1501
SurvNET Editor (CGEditor) ........................................ 1516
Data Collector Transfer .............................................. 1516
Example Projects ...................................................... 1581
Network Processing Reports ........................................ 1582
  2D-1D Local Coordinate System ................................. 1583
  2D-1D State Plane Coordinate System .......................... 1597
  GPS Network ......................................................... 1612
  GPS Vectors and Total Station .................................... 1623

Contents
Using the Carlson Software Manual

This manual is designed as a reference guide. It contains a complete description of all commands in the Carlson Software product. The chapters are organized by program menus, and are arranged in the order that the menus appear in Carlson Software.

Product Overview

Carlson Software offers a full suite of commands for downloading, entering, and processing field survey data and for generating final plats and drawings. Carlson Software can function as a total and complete software solution for the land surveying firm, or as an affordable downloading, calculation, and preparatory solution used in conjunction with the more full-featured Carlson Software. Built around the Autodesk 2007 OEM graphics engine, Carlson Software reads and writes standard AutoCAD drawings and assures familiarity to AutoCAD trained staff.

Data Collection

The power of Carlson Survey begins with data collection. Carlson Survey downloads all major collectors ranging from Geodimeter and TDS to Leica, Nikon, Sokkia, and SMI. The raw data is stored in "RW5" format and can be viewed, edited and processed. The processing, or calculation of coordinates, recognizes "direct and reverse" and other forms of multiple measurement, and processes sets of field measurements. Surveys can be balanced and closed by selective use of angle balance, compass, transit, Crandall, and least squares methods-or simply by direct calculation with no adjustment. Commands exist for finding bad angles and for plotting the traverse and sideshot legs of the survey in distinct colors as a means of searching for "busts" or errors. In addition to downloading of data from electronic data collectors, the program accepts manual entry of field notes directly into a spreadsheet format, permitting review, storage, and editing. Alternatively, field notes can be entered for immediate calculation and screen plotting of points, with the "raw notes" stored simultaneously, permitting re-processing and re-calculation as needed. For data that was not field-surveyed, but was provided in the form of an ASCII or binary point file, Carlson Software offers the "Import Text/ASCII File" command, unrivaled in its flexibility to read foreign data sources.

Field to Finish

The survey world is recognizing the power of coding field shots with descriptions that lead to automatic layering, linework, and symbol work. Office drafting time can be reduced by 50% or more with intelligent use of descriptions, leading to "field to finish" plotting. For example, breaklines, which act as barriers to triangulation, should be placed on streams, ridges, toe-of-slopes and top-of-banks for more accurate contouring. With the field to finish command, breaklines can be created by field coding, with descriptions such as DL, for creating 3D polyline ditch lines, or TB for creating top-of-bank polylines, etc. and this coordinate data can be simply plotted to the screen as undifferentiated points. However, with the field to finish command, the data can be plotted in one step, creating 3D polyline break lines, building lines, light poles, manholes, edge-of-pavements, that are all distinctly layered and fully annotated. The field to finish command within Carlson Survey is extremely robust, so much so that it can adapt to a coding system made up on-the-fly, or a coding system that has been received from an outsourced survey. Field crew coding and office processing using the field to finish command can save valuable hours of drafting and eliminate misinterpretations, paving the way for quick plat generation or supporting supplemental engineering work.

Deed Work

Carlson Survey allows you to enter old deeds and plot the linework, then add bearing and distance annotation optionally. Distances can be entered in meters and feet, and even in the old measurement forms of chains, poles, links, and varas. Both tangent and non-tangent arcs can be entered. Closures, distances traversed, and areas are
automatically reported. Working in reverse, the command Legal Description creates a property description suitable for deed recording directly from a closed polyline on the screen. If that polyline has point numbers with descriptions at any of the property corners, these descriptions will appear in the deed report, as in "...thence N 45 degrees, 25 minutes, 10 seconds E to a fence post...". Deed files can be saved, re-loaded, edited, re-drawn and printed or plotted to the screen in a report form.

**Drafting and Design**

Carlson Software offers approximately 150 different symbols and north arrows, broken down by categories (for example, points, trees, map symbols). You can create new categories or supplement or change the available point symbols within any category. The program is designed to receive entire sets of new, customized point symbols in a single command. Attributes of points, such as elevation and point number, can be selectively "frozen," allowing the creation of final plats with symbols and optional descriptions remaining on points, as desired. Linework, typically in the form of polylines, can be drawn by any combination of point number and "snap" selection, to create property lines, street lines, easements and right-of-ways, building lines and borders. In addition to Carlson Software's standard line types, dozens of special line types are available, including tree lines, fence lines, all manner of utility lines, stonewalls, and customizable line types. Design features include automatic street intersections and cul-de-sacs, and automatic lot layout. For lots, you can pick your right-of-way and back property polylines, specify desired acreages and frontage/rear lot parameters, and the lots are automatically calculated and drawn. Hinged Area, Sliding Side Area, and Area Radial from Curve are excellent design tools, with an easy, graphic interface. All design polylines can be converted to point numbers at vertices and radius points for purposes of field stakeout.

**Annotation**

With a full slate of annotation commands, Carlson Survey is all you need to finalize your boundary surveys and plats. There is a wide range of bearing and distance annotation options, including the Auto-annotate command, which allows you to annotate an entire selection set of polylines in one step. Station and offset annotating, as for right-of-way lines, is provided. Use commands such as Special Leader, Station Polyline, Draw North Arrow, and Draw Bar Scale to dress up the drawing and give it a hand-drafted look. Commands such as Title Block and Draw Legend, as well as sequential lot numbering and the area labeling commands, help you complete the finished drawing quickly.

**Powerful Utilities**

Carlson Software contains many strong utilities, particularly polyline utilities. You can Join Nearest disconnected polylines, turn 2-sided figures into closed, 4-sided figures, offset, trim, and extend 3D polylines, create building "footprints" with left and right entries using Extend by Distance, even reverse polyline directions. There are over 20 significant polyline utilities available, including Reduce Vertices, which weeds out duplicate or unnecessary vertices and cuts down on drawing size. Boundary Polyline is a simplified version of the AutoCAD command Boundary, and its opposite, Shrinkwrap Entity. Other categories of utilities include point attribute editing, scaling, twisting and re-sizing, text editing, font alteration and re-sizing, and advanced layer manipulation. Raster images such as aerial photos and scanned images can be placed on drawings.

**Contouring and Terrain Modeling**

There are many higher order features in Carlson Survey. Full contouring is provided, with options for smoothing and labeling contours, highlighting index contours and clipping contours to selected perimeters. Carlson Survey can be used to create both grid files and TIN files (.flt format). Volumes can be computed between grid files, inside any selected polyline perimeter. Profiles can be extracted from contour maps or hand-entered, as generic "point-to-point" profiles or as road profiles with vertical curves. The Design Pad Template command carves in building pads, pits, parking lots, roads, and other 3D features into any existing terrain. Land forms created by contouring and Design

---

**Chapter 1. Introduction**
Pad Template can be viewed in 3D and rotated in real time, using the 3D Viewer Window command. In addition to all the commands needed to create final drawings, Carlson Survey also contains commands to perform many engineering tasks typically encountered by survey firms.

Carlson Software is the ideal stand-alone solution for the survey and drafting organization, but it is also the perfect go-between product for the large civil engineering firm with in-house or outsourced survey operations. It compliments Carlson Roads. Carlson Survey enables Carlson Software to serve the full spectrum of the surveying and civil engineering design world.

**System Requirements**

**Requirements for installation on AutoCAD platform:**

Carlson's system requirements are equivalent to that of the AutoCAD version you are running. See your CAD installation guide for minimum system configuration. It is always recommended that you use the highest performance PC possible.

Note: Carlson does require a minimum screen resolution of 800x600.

Carlson 2010 will operate with the following platforms:


64-bit version of AutoCAD 2009/2010 is supported.

**Requirements for installation on IntelliCAD platform:**

- Microsoft Windows 2000, XP or Vista.
- Intel Pentium processor (minimum) or greater (recommended).
- 512 MB of RAM.
- 400 MB of free hard-disk space for installation.

**Installing Carlson Software**

If you're installing Carlson Software on Microsoft® Windows NT® 4.0 or Windows 2000, you must have permission to write to the necessary system registry sections. To do this, make sure that you have administrative permissions on the computer on which you're installing. Before you install Carlson Software, close all running applications. Make sure you disable any virus-checking software. Please refer to your virus software documentation for instructions.

Note: If you are upgrading from an older version of Carlson Software, you must uninstall the older version before installing Carlson Software. This is required for successful software installation and to meet the guidelines of the EULA (End User License Agreement).

1 Insert the CD into the CD-ROM drive.

If Autorun is enabled, it begins the setup process when you insert the CD.

To stop Autorun from starting the installation process automatically, hold down the SHIFT key when you insert the CD.
To start the installation process without using Autorun, from the Start menu (Windows), choose Run. Enter the CD-ROM drive letter, and setup. For example, enter d:\setup.

2 The Windows Installer dialog box is displayed briefly, followed by a dialog box for entering in your serial number.

In the Enter Carlson Software 2008 Serial Number dialog box, you must enter the serial number provided with your copy of Carlson Software. Then click OK.

3 The Setup dialog box appears briefly, followed automatically by the Carlson Software 2008 Setup dialog. If this is the initial installation, you will see the dialogs shown below.
After reading this second dialog box, press Next. If this version of Carlson Software has already been installed, you will see a different Add/Remove dialog instead. In this case, it is recommended that you Cancel the current install and go to Windows > Control Panel > Add/Remove Programs and remove Carlson Software 2008. After the old installation is removed, you may start the install process once more to continue.

4 Review the End-user License Agreement, accept it with the correct click choice, and then click Next. You can optionally print it out.

5 On the Select Installation Type dialog box, select the type of installation you want: Typical or Custom. Choose Next.
Typical installs the following features:

- Program files: Executables, menus, toolbars, Help templates, TrueType® fonts, and additional support files
- Internet tools: Support files
- Fonts: SHX fonts
- Samples: Sample drawings
- Help files: Online documentation

Custom installs only the files you select. By default, the Custom installation option installs all Carlson Software features. To install only the features you want, choose a feature, and then select one of the following options from the list:

- Will be installed on local hard drive: Installs a feature or component of a feature on your hard drive.
- Entire feature will be installed on local hard drive: Installs a feature and its components on your hard drive.
- Feature will be installed when required only: Installs a feature on demand.
- Entire feature will be unavailable: Makes the feature unavailable.

6 On the Destination Folder dialog box, do one of the following:
Choose Next to accept the default destination folder/directory.

Choose Browse to specify a different drive and folder where you want Carlson Software to be installed. Choose any directory that is mapped to your computer (including network directories), or enter a new path. Choose OK and then Next.

Setup installs some files required by Carlson Software in your system folder (for example, c:\Windows\System, or c:\Winnt\System32). This folder may be on a different drive than the folder you specify as the installation folder (for example, d:\Program Files\Carlson Software). You may need up to 60 MB of space in your system folder, depending on the components you select to install. Setup alerts you if there is insufficient free space on the drive that contains your system folder.

On the Start Installation page, choose Next to start the installation.
The Updating System dialog box is displayed while Carlson Software is installed.

![Updating System dialog box](image1)

When the installation is complete, the Setup Complete dialog box is displayed. Choose Finish to exit the installation program.

![Setup Complete dialog box](image2)

It is strongly recommended that you restart your computer at this point in order for the new configuration settings to take effect.

Congratulations! You have successfully installed Carlson Software. You are now ready to register your product and...
start using the program. To register the product, double-click the Carlson Software icon on your desktop and follow the instructions.

**Authorizing Carlson Software**

The first time you start Carlson Software, the Registration Wizard is displayed.

Carlson Software has installed an automated procedure for registering your software license. Change keys are no longer given over the telephone. Please choose one of the following registration methods.

**Form:** This method allows you to fill out a form that you can print out and fax or mail to Carlson Software for registration.

**Internet:** If your computer is online, you may register automatically over the Internet. Your information is sent to a Carlson Software server, validated and returned in just a few seconds. If you are using a dial-up connection, please establish this connection before attempting to register.

**Enter change key:** Choose this method after you have received your change key from Carlson Software (if you previously used the Form method above).

**Register Later:** Choose this method if you want to register later. You may run Carlson Software for 30 days before you are required to register.

After you choose the registration method, press Next.
Choose the reason for installation. The very first time you install Carlson Software is the only time you will choose the first reason. All subsequent installations require a choice from the remaining options.

**New install or maintenance upgrade of Carlson Software**: If you are installing Carlson Software for the first time, choose this reason.

**Home use. See License Agreement**: Choose this reason if you are installing on your home computer. See your license agreement for more details!

**Re-Installation of Carlson Software**: Choose this reason if you are reinstalling on the same computer with no modifications.

**Windows or AutoCAD upgrade**: Choose this reason if you have reinstalled Carlson Software after installing a new version of Microsoft Windows.

**New Hardware**: Choose this reason if you are installing Carlson Software on a new computer or if your existing computer has had some of its hardware replaced such as the hard disk, network adapter, etc.

After you choose the reason for installation, press Next, and then enter the required information into the dialog.

If you are using the Form method, press the Print Fax Sheet button, to print out the form. You may fax this form to the number printed on the form, or mail it to Carlson Software, 102 W. Second St., Suite 200, Maysville, KY
If you are using the Internet method, press Next. After a few seconds, your registration will complete. If your registration is successful, you will receive a message such as the one below. If your registration is unsuccessful, please note the reason why and try again. Keep in mind that each serial number may be registered to a single computer only.

![Automatic Registration completed successfully. Please print registration report for future reference.](image)

If you do not have access to the Internet, and do not have a printer, you must write down the information from the User Info tab (shown above) and fax it to 606-564-9525, or mail it to Carlson Software, 102 W. Second St., Suite 200, Maysville, KY 41056-1003.

### Carlson Registration

Each Carlson program is licensed for use on one workstation which must be registered. The registration records your company name, Carlson serial number and AutoCAD serial number. To register your copy of Carlson, start Carlson and choose "Register Now". The following dialog will appear.

Note: Carlson Software will no longer issue change keys over the telephone. There are four registration options.

#### Fax:
This method allows you to print out the required information on a form which you then fax to Carlson Software. The fax number is printed on the form. The change key will be faxed back to you within 72 hours.

#### Internet:
Register automatically over the Internet. Your information is sent to a Carlson Software server, validated and returned in just a few seconds. If you are using a dial-up connection, please establish this connection before attempting to register.

#### Enter pre-authorized change key:
If you originally chose the Fax method above, you will need to choose this method now to enter the change key that is faxed back to you.
Register Later: If you wish, you may defer registration up to 30 days. After this time, Carlson will enter demo mode which displays a message each time a Carlson command is run.

After you select the registration method, choose Next and select the type of installation you are performing, choose Next again to review the copyright information and to fill out the required information. At this point, if you are using the Fax method, press the Print Fax Sheet button. If you are registering using the Internet method, press Next and the process will start.

If you have any problems with Internet registration, please repeat this process and use the Fax method. The registration form is available on the Carlson Software website at http://www.carlsonsw.com/registration.html.

Tip: If Carlson is running, you may access the registration dialog by choosing About Carlson from the Help menu, then pick the Change Registration button.

Setting Up a Project

Over 200 Carlson Software settings can be specified in the Configure command on the Settings menu. These values are used to initialize Carlson Software options when opening a new or existing drawing. Among these settings is the coordinate point number format, object linking options, and settings for the COGO portion of Carlson Software. The template drawing is the default drawing that opens up each time Carlson Software is started. To customize the template drawing, run the OPEN command under the File pulldown menu, change the files of type setting to Drawing Template and choose the template drawing, "survey.dwt". Then make your changes and SAVE the drawing as survey.dwt in the Template folder.

When starting a new drawing, one of the first steps is to run Drawing Setup in the Settings menu. Drawing Setup sets the drawing scale, the units mode as either english or metric, and the text, symbol and linetype size scalers. The initial values for these Drawing Setup variables are set in Configure > General Settings. When a drawing is saved, the Drawing Setup variables are saved with the drawing. Carlson Software will set the text height according to the drawing scale and text size scaler set in Drawing Setup. For example, if the horizontal scale is set to 50 and the text size scaler is 0.1, Carlson Software will draw the text with a height of 5 (50 * 0.1). Then, when the drawing is plotted at 1"=50', the text will be 0.1 inches.

Every drawing remembers the data files that are being used for the drawing. When the drawing (.DWG) file is saved with the SAVE or SAVEAS command, Carlson Software writes a settings file that contains all the active data file names. Then, when the drawing is reopened, the data files default to their previous settings. For example, you won't have to choose which coordinate file to use unless you want to change it. The settings file is stored in the same folder as the drawing file, and has the same name as the drawing, with an .INI extension. For example, a drawing called survey.dwg would have a settings file called survey.ini.

The Drawing Explorer command, in the Settings menu within the Project command, tracks and stores project files associated with each saved drawing. You may use this command to generate a report of all files used in a particular drawing. Project Explorer takes this concept one level further and allows you to group drawing files and their associated project files. Reports can also be generated using this tool.

Startup Wizard

For creating a new drawing in Carlson Software, the Startup Wizard can guide you through starting and setting up the drawing. This wizard is optional, and it can be turned on or off in the Settings menu by clicking Configure, then General Settings. You can also exit out of the Startup Wizard at any time. When the Startup Wizard is turned on and the New drawing command is executed, you will see the Select template dialog box.
Typically, you want to choose the drawing template SURVEY.DWT when you are using Carlson Survey, and then click Open. Remember that for Carlson Roads you will use ROADS.DWT. For Carlson Field you will use ROADS.DWT. The drawing template will set some of the basic drawing parameters, such as the default layer names. The Startup Drawing Wizard dialog appears.

Here, you need to set the new drawing name and scale. Set the drawing (.dwg) name by picking the Set button. The Drawing to Create dialog box opens. Change to the directory/folder ("Save in" field) where you want to store the drawing. You can either select an existing folder or create a new folder. Type in the drawing name in the File name field and click the Save button.
Then you can set the drawing horizontal scale, symbol size, text size and unit mode (English or Metric). Clicking the Next button brings up the Startup Wizard Data Files dialog box. This is for setting the Data Path and CRD File. The Set button for the Data Path is for setting the folder where Carlson Software will store the data files, such as raw (.RW5) files and profile (.PRO) files. The Set button for the Data Path allows you to select an existing folder or create a new folder. See the Set Data Directory command for more information.

The Coordinate (.CRD) File is the coordinate file for storing the point data. There is an option to create a new or existing coordinate file. The New option will erase any point data that is found in the specified CRD file. The Existing option will retain any point data in the specified coordinate (.CRD) file. If the specified coordinate (.CRD) file does not exist, the wizard will create a new file.

The next wizard step depends on the Import Points option. The Data Collector option will start the data collection routines to download data from a collector. The Text/ASCII option will import point data from a text/ASCII file. See the Data Collection and Import Text/ASCII File commands for more information on running these routines. If the None option is set, then the Startup Wizard is finished.
Once point data has been imported from the data collector or text/ASCII file, the wizard guides you through drawing the points. There are options to run Draw/Locate Points, Field To Finish or None. If None is selected, then the Startup Wizard is finished. Draw/Locate Points will import the points into the drawing using the same symbol and layer for all the points. From the Draw/Locate Points dialog, set the symbol, layer and point attributes to draw (description, elevation) and then pick the Draw All button. The Field To Finish command will import the points into the drawing using different layers and symbols depending on the point descriptions that refer to the code table defined in Field to Finish. Also Field to Finish can draw linework. See the Draw/Locate Point and Field To Finish commands for more information on running these routines. After drawing the points, the wizard will zoom the display around the points. Then the wizard is finished.

**Command Entry**

Commands may be issued by selecting a pulldown menu, screen menu, digitizer tablet item, or by typing a command at the command prompt. Pressing Enter at the command prompt repeats that last command. Pulldown menus have a row of header names across the top of the screen. Selecting one of these header names displays the possible commands under that name. Screen menu items are shown in the screen menu (typically on the right side of the screen). The screen menu can be toggled off and on inside of the AutoCAD Options dialog. The Pulldown menus are the primary method for Carlson command selection. Each section of this manual shows the pulldown menu which contains the commands that are explained in that section. Pulldown menus are sometimes also referred to as dropdown menus.

Command availability depends on which menu is loaded. Carlson menus have a mixture of both Carlson and CAD commands. This allows you to execute the commonly used CAD commands from the menus while running Carlson.

Quick Keys are user-defined short cut names that can be typed in to start commands. To review the current set of Quick Keys, run the Quick Keys command in the Settings pulldown menu. Quick Keys are explained in more detail in the next section.

**Layer and Style Defaults**

Many Carlson Software commands have default layers such as AREATXT for area labels and BRGTX for bearing and distance annotations. These layers can be specified in dialogs for the corresponding commands, and several can be set in the Configure command under the Settings menu. Sometimes you may want to use the current layer, and it can be an extra step to have to open the dialog to set the layer. In this case, instead of using the default layer that is set in the dialog, the default layer can be set as "CLAYER", which will use the current layer.

For example, if the annotation layer is set to CLAYER, then annotation will be drawn in the current layer instead of BRGTX or whatever the annotation layer used to be. This same concept applies for text styles. Several commands have specific text styles and if you want to use the current style instead of the command style, use the name "CSTYLE" for the style name.
What is New

General

- **New Transparent Commands** - Added four new transparent command to use at any pick point prompt. These commands are bearing-bearing intersection ('bbpt), bearing-distance intersection ('bdpt), distance-distance intersection ('ddpt) and center-of-mass ('centroid). For the existing centerline transparent command ('cl), added a method to specify the station along the centerline as a distance factor.
- **Drawing Inspector** - Added area to report for polyline data of closed polylines plus a 3D Faces report option.
- **Hot Drawing Explorer** - Redesigned as a docked dialog with file type icons and customizable layout. Added right-click support on the files in the list for executing functions by file type.
- **Project Explorer** - Redesigned as a docked dialog with file icons, customizable layout and right-click functions.
- **New Layer Library** - New command to store layer names with properties organized by category to help manage layer standards. Layer Library functions include comparing the drawing with the library and reporting. The Layer Library can be used when selecting layers in other commands.
- **Symbol Library** - Added 43 new point symbols.
- **Settings Folder** - New configuration setting to have a default folder for program setting files that is separate from the default data folder.
- **3D Viewer Window** - Added pre-defined 3D views for NE, SE, SW, NW and plan. Expanded range of vertical scaling from 0.001 to 100.
- **New Highlight Non-Tangent Polylines** - New commands to highlight and report any non-tangent segments from the selected polylines.
- **New Draw Arc by PC, PT, Tangent** - New command to create an arc by PC and PT points plus the tangent-in.
- **New Draw Arc by 2 Tangents, Through Point** - New command to create an arc by tangents in/out plus a pass through point on the arc.
- **New Offset To Layer** - New command to put the offset polyline into a separate layer from the original.
- **New Offset Multiple** - New command to apply the same offset multiple times at once.
• **New Temporary Erase** - New command to erase entities while tracking their data to allow for restoring.
• **New Draw Flow Leader** - New command to create flow leaders.
• **New Draw Bold Curve Leader** - New command to create a thick style leader.
• **New Draw Box Around Text** - New command to draw a polyline box around the selected text.
• **New White Solid Behind Text** - New command to create a white solid for background of the selected text.
• **New Trim Linework Through Text** - New command to trim linework for sections that overlap text.
• **New Add Prefix/Suffix Text** - New command to add prefix and/or suffix to the selected text.
• **New Remove Spaces From Text** - New command to remove leading and trailing spaces from the selected text.
• **New Line Up Text** - New command to line up selected text to either a horizontal or vertical line.
• **New Join Text Entities** - New command to append selected text entities into a single text entity.

**Survey Commands**

• **Move Point Attributes with Leader** - Added settings for arrow size, offset of leader head from the point and option to draw leader tick mark at label end.
• **Edit Multiple Point Attributes** - Added setting for parent layer of point attribute block and method to size all of the attributes at once.
• **Export Text/ASCII File** - Added method to select multiple coordinates file and batch process exporting them.
• **Legal Description** - Added option to always report in clockwise or counter-clockwise direction.
• **Visual COGO** - Added option to not draw points, only linework.
• **Best-Fit Circle** - Added method to use points in 3D by projecting the points onto a best-fit plane, calculating the best-fit circle and projecting the resulting circle back to world coordinates. Applies to circles for tunnel sections.
• **Field-to-Finish** - Added fixed parameter coding method for special codes in set order in the point description such as for tree shots where the first part of the description is the tree code and the second part has the size. Added special codes for Offset Left (OFL), Offset Both Left/Right (OFB) and split multiple codes (MULT). For drawing text as attributes, added settings to control the text rotation. Added method to output point notes for the special codes and the drawing description. Improved creation of 3D polylines from points on an arc that projects the points onto a plane to get the true 3D arc. Added ability to output points to multiple point groups per code.
• **Edit-Process Raw File** - Added option to Direct & Reverse report to show horizontal distances. Added horizontal distances and point descriptions to the Check Points report.
• **Edit-Process Level Data** - Added support for importing SurvCE differential-level TLV files.
• **SurvNET** - Added EDM calibration function. Added support for NGS G-Files and for OPUS reports for importing GPS vectors. Added functions to save and load project settings to a file. For 1D/2D models, added the ability to assign standard errors to benchmarks for elevation adjustment. Added import/export of standard errors. New option to draw error ellipses.
• **MText Annotation** - Added the option to create angle-distance labels as MText.
• **Area Labels** - Added ability to fix label overlaps by applying specified rules as well as a separate routine to find overlaps and then step through them to fix manually. Added controls per label field for size, style, decimals, prefix, suffix, color and justification. Added method for automatic placement along the edge of the area. Added alignment methods for by twist screen and by lot sides. Added options to draw labels as Mtext and to draw a symbol around the labels.
• **Area By Closed Polylines** - For multiple polylines, added methods to label each area or the total only
• **Area Table** - Added controls per field for style, justification and background color. Added settings to tag labels for size and layer. Added option to draw final row of area totals. Added setting for table title to draw as top row.
• **New Area Table: Create New Table, Set Active Table** - New commands to add support for multiple area tables in the drawing.
• **New Area Table: Edit Properties** - New command to edit any of the settings for the selected area table.
• **New Area Table: Remove Row** - New command to remove the selected row and associated label tag and update the table.
• **New Area Table: Consolidate Table** - New command to renumber area tables to remove any numbering gaps.

**Design Commands**

• **Offset 3D Polylines** - Added method for multiple 3D offsets with separate layers.
• **Triangulate & Contour** - Added option for slope arrows to label the slope value.
• **Make 3D Grid File** - Added method to use a triangulation file as the data source. Added option to use inclusion/exclusion perimeters and only set grids within these areas.
• **Grid File Utilities** - Added support for the Export function in GFU macros.
• **Hot Design Pad Template** - Added ability to process multiple pad perimeters at a time with precedence and slopes assigned by layer.
• **Centerline Report** - Report highlights any non-tangent segments. Added radial-in, radial-out and degree of curve to the report for curve sections.
• **Station Polyline/Centerline** - Added options to label spiral stations and to apply a dz for offset points.
• **Offset Point-Entry** - Added option to include station-offset in point descriptions.
• **Label Station-Offset** - Reorganized label layout for flexible ordering and grouping. Added method to label elevations from reference 3D polyline or profile. Added option to use text style, draw text box and leader layer. Added more leader options including how many segments for the leader. Added functions to save and load the settings to a .sos file.
• **Input-Edit Profile** - Dialog is now resizeable.
• **Draw Profile** - For plan-profile sheets, added option to draw in Model space and option to include starting and ending station in Layout names. For horizontal axis elevations, added controls to select which profiles to label. Added many controls to road profile vertical curve labels. Added method to stack profile grids for multiple profiles. Added settings for manhole label prefix and suffix. For sewer profiles, added an option to label invert in/out at projected elevation to the manhole center and added a method to label the pipe length as stations along the horizontal axis. Added settings for title block and viewport layers. New function to draw a profile legend. Added station label option for interval stations to have partial label while main stations have full label. Added more controls for labeling the horizontal and vertical scales. Added option to output the profile plot to a separate drawing. Added separate settings for each profile for break point labels. Added break point label settings for prefix, suffix, symbol, leader and position. Added save and load functions for the initial select profile dialog to store the profile file selection to a .pst file. Reorganized the sewer label layout for flexible ordering and groups of labels. Added separate sewer label settings for labels at the rim and at the invert for with and without leaders. Added method to label multiple inverts at a manhole. More flexible pipe labels to arrange in any order. Added option to draw vertical line through manhole from rim to bottom of profile grid. Added option to draw lines for pipe cradles. Added option to draw the profile grid for profiles on sheets. Added the ability to draw station and elevation labels at intervals.
• **Parking Layout** - Added support for arcs. Added setting for number of stall along linework and method to fit by min/max width. Added setting for layer name.
• **Hot Lot Network** - Added ability to place building pads within lots during layout. For lot layout routines, added setting for minimum setback area.
• **New Lot Network Sub-Areas** - Added seven new commands to create and manage sub-areas for open spaces within the lot network boundary. The open space areas are assigned name and description. These areas are not used for lot layout such as wetlands.
• **New Size Lot By Frontage** - New lot network command to size a lot by a specified frontage.
• **New Check Lot Network Parameters** - New command to check the area and frontage parameters of the lot network and report any problems.
• **New Find Lot Name** - New lot network command to highlight and zoom to the specified lot name.
GIS Commands

- **New Import MrSid Images** - New command to import MrSid images to jpg, tif or bmp formats.
- **Import SHP File** - Added ability to apply coordinate conversion on import for converting units between English and metric and for applying grid projections to the current drawing coordinate system. Added layer control support. When importing an SHP file the user will be able from now on to choose a field from the DBF file associated with the SHP file from which the program will create/use a layer where the entities are created. If the SHP file has the type points than the user has the option to control the layer using the description of the point, description also available through a field selected from the DBF file. The Draw-Locate Points routine which is very flexible will allow the user to plot the points in layer based on their descriptions. Added Point ID/Entity ID control support. When importing an SHP point type the user has not the option to choose a field from a DBF file associated with the SHP file from which the program will generate the name of the point. In the case of a non-point SHP file type the user can decide the unique key associated with the newly created AutoCAD entity, id which matches the record id from the database. Added Point Description control support. When importing an SHP point type the user has not the option to choose a field from a DBF file associated with the SHP file from which the program will generate the description of the point. Added Inclusion control support. The user when importing an SHP file can control using inclusion polylines the data imported from the SHP file.

Data Conversions

- **Google Earth** - In Write Polyline File, added ability to create KML file for Google Earth for drawing linework.
- **LandXML** - Added ability to convert between feet and meter units. Added method to export breaklines. Added support to import Eagle Point and GeoPak style surfaces. Added support for importing Topcon Link raw data.
- **Latvia98** - Added support for this geoid.
- **Leica GSI** - Added function to export survey raw data to Leica GSI in Liscad format.
- **MOSS** - Added function in Write Polyline File to output MX/MOSS Genio format data.
- **Netherlands 2004** - Added support for this geoid.
- **New Caledonia Geoid** - Added support for this geoid.
- **NLS MMH360** - New routines to import/export point data with this format.
- **Norway Geoid** - Added support for this geoid.
- **OSU91A Geoid** - Added support for this geoid.
- **Topcon LN3** - Added LN3 support in the Write Polyline File command.
- **Topcon Raw** - Added support for Topson GTS raw data import.

**Standard Report Viewer**

Many Carlson routines display output in the Standard Report Viewer as shown below. The report can be edited directly in the report viewer. Report Viewer commands are described below.

**Open:** This allows you to open an ASCII file and display the contents in the report viewer.

**Save:** Save the contents of the report viewer to a text file.

**SaveAs:** This allows you to save the contents of the report viewer to a file.

**Append To:** This allows you to append the contents of the report viewer to another file.

**Print:** Print the contents of the report viewer. This will open the standard Windows Print dialog where you can choose the printer and modify any of the printer settings before you actually print.
**Screen:** Draws the report in the current drawing. The program will prompt you for a starting point, text height, rotation, layer and whether you want it inserted as Mtext or Text.

**Undo:** Reverses the effect of your last action. If you mistakenly deleted some text, stop and choose the Undo command to restore it. The key combination Ctrl+Z also performs this action.
Select All: Selects all the text in the report viewer.
Cut: Deletes the selected text and places it on the Windows® clipboard.
Copy: Copies the selected text to the Windows® clipboard.
Paste: Inserts ASCII text from the Windows® Clipboard into the report viewer at the cursor.
Search: Opens the Find Text dialog. Allows you to search for text in the report viewer.
Replace: Opens the Find and Replace Text dialog. Allows you to search for text and replace it.
Options: Opens the Report Viewer Options dialog. In this dialog, you can specify print settings, such as lines per page and margins. You can also specify the font used in the report viewer. This font is used for both the display and for printing.
Hide: This button allows you to minimize the report viewer window and give focus back to the Carlson CAD screen. This allows you to return to working on the Carlson CAD screen without closing the report. You can re-activate the report by picking on the minimized report viewer icon.

Report Formatter

A number of Carlson routines use a dialog box called Report Formatter Options to allow you to specify how and which results of calculations should be presented in the report. This report routine lets you select a set of data to report and the format of the selected data. The report can be displayed in either the standard report viewer as described in the previous section, Microsoft® Excel or Microsoft® Access.

The data set in the Report Formatter may be thought of as a spreadsheet, where columns are various fields related to a single item such as time period, drillhole, area and etc. Each new row represents a new item. Descriptions of these field names are displayed in the Available list of the Report Formatter. To include a data field in the report, highlight the field name in the Available list on the left and pick the Add button. This moves the field name to the Used list on the right. The order of items in the right list defines the order in which they will be displayed. In addition, the items may be sorted as specified by the user in the right column. Items are first sorted by the first column, then items with the same value in the first column are sorted as specified for the second column, and so on.
These subsequent sortings do not modify sortings of previous columns. If you specify no sorting for some column (even the first one) then no sorting will happen in subsequent columns either. For example, you may want to sort production by mining panel name but not by month.

To generate the report after selecting columns and other preferences, click on Display button. It will bring up a standard report viewer showing the report data. Upon exiting the viewer, you come back into the Report Formatter for further data manipulation if needed. The other data output and destination options include saving the specified data into a comma-delimited text or CSV file, creating a spreadsheet preview whereby the data may be exported using several methods, and direct export to Microsoft® Excel. Due to the popularity of the Excel output choice, you can also customize certain Excel options, including setting mirror output, just prior to export. Data can also be merged to combine current and old reports, and it be exported to XML format files. There is an option for output to other database formats as well.

You may define new columns as equations based on existing columns. Click on the Edit User Attributes button to add a new field name. A list of the existing attributes is available for reference.

User attributes may have one of the several summation options just like program-generated ones (except that for
them these options are set by program). The summation level is defined by the "Total" pop-up list in the middle of the dialog. By default only grand total will be displayed at the bottom of the list. By picking the next item in that box, you will get subtotals added each time the value in first column is changed. It makes most sense to use this kind to summation if the corresponding column is sorted. For example if the first column is "Area Name" and it is sorted, and "Total" is set to "Grand, Area Name" the report will have a sub-total for each distinct Area Name. This feature makes the Report Formatter a very flexible tool for results exploration, even before or without using a spreadsheet.

Various forms of reports may be saved and recalled using controls in the top line of the dialog.

To save a new version of the format, type in a new name (or use default to overwrite old one) and click on the Save button. The next time that you come to the Report Formatter from the same Carlson routine it will recall this last format. To pick another format just pull down on list of formats in the left top corner and pick which format to use. To Delete an unwanted format, pick it from the list first and then click on Delete button.

There are several Microsoft® Excel export options provided. You may specify a spreadsheet file to load before export, as well as a left upper cell to start with and sheet number to use. Totals which are reported when using built-in viewer may be skipped when using Microsoft® Excel export.
For commands that process reports using perimeter polylines, the Report Formatter has an option to create GIS links between the polylines and the database records when the Export to MS Access function is used. When the polyline data is available for the GIS Links, there will be a report field called Handle. This Handle field is the AutoCAD entity name for the polyline and serves as the hook for the GIS link. The Handle field does not need to be put into the report Used list in order to create the links. When the Export function is called with the MS Access method, there is a pop-up window prompt for whether to create the GIS links. When these links are created, you can then use the GIS menu commands to manage and report the data.

Instruction Manual and Program Conventions

*Westwood*

Italic text represent responses by the user that should be typed in and followed by the Enter key.

**Number/<Pick point>:**

Bold text represents prompts or questions that the computer program will ask the user.

<90.0000>

Values enclosed in corner brackets represent default values obtained by pressing Enter with a blank response.

[end on]

Lower case text enclosed in brackets in Command prompts denotes an OSNAP mode that is turned on by the command.
Carlson File Types

.AAN Auto-Annotation Settings
.ADF Annotation Default Settings
.ARX AutoCAD Runtime Extension For Carlson Program
.ATR Strata attribute definitions
.AVG Mining Composite Quality Analysis
.BLK Mining Block Model
.CAL Mining equipment calendar
.CAP Capacity file for hydrology (stage-storage)
.CDF Geology Channel Sample File Format
.CDS MDL Laser Raw Data
.CDT Mining custom date table
.CFG Configure Configuration Settings
.CFZ Cut/Fill Color Map Zones
.CGZ C&G Coordinate File
.CGR C&G Raw Data
.CH Corehole definition
.CL Centerline file
.CLT Culvert Settings
.CN Hydrology CN Factors
.COG CadVantage Coordinate Data
.COT Multiple Outlet Design Data
.CQT Mining custom quantity table
.CRB Template Curb Definition
.CRD Coordinate file (point#, northing, easting, elevation, description) in binary form
.CTL SDMS Format Raw Data
.CTR Auto-Run Strata Isopach Maps
.CUI Customized User Interface AutoCAD Menu
.CUT SMI Format Cutsheet
.CVZ SEDCAD Format Hydro Network
.DAT GPS Localization Definition
.DCF Deed Correlation File
.DCL Carlson dialogs
.DEM Digital Elevation Model
.DEQ Drillhole equations
.DHF Drillhole Text File
.DHT Dragline History
.DIL StrataCalc Convert As-Determined Qualities
.DLL Carlson programs files
.DTF Drillhole Data Format
.DTS Drillhole Text Settings
.DWG Drawings
.DXF Drawing Exchange Format
.DZR Dozer Push Settings
.EDO Mining equipment options
.EQU Mining equipment definitions
.ERD Erodible Channel Settings
.EW Earthwork Section End Areas
.EXE Carlson programs

Chapter 1. Introduction
Chapter 1. Introduction
Chapter 1. Introduction
Quick Keys

"Quick Keys" allows you to enter in the coding shown here on the left, and by doing so run the commands shown on the right.

2DP = 2D Polyline
3DP = 3D Polyline
A = Arc
AL = Align
B = Block
BB = Bearing-Bearing Intersect
BD = Bearing-Distance Intersect
BH = Boundary Hatch
C = Circle
CH = Change Properties
CO = Color
CP = Copy
DD = Distance-Distance Intersect
DI = Distance
DT = Draw Text
E = Erase
EA = Enter-Assign Point
EX = Extend
F = Fillet
Obtaining Technical Support
via Discussion Groups

- Carlson Software operates user discussion groups located at news://news.carlsonsw.com. You can participate in user-to-user discussions on tips, tricks and problems. Our staff monitors these groups to ensure that all the issues are addressed. Visit our website at http://www.carlsonsw.com for information on how to access these groups.
- You may also access the Carlson Software Knowledge Base. Visit it directly at http://update.carlsonsw.com/kbase_main.php.
via Electronic Mail

• The Technical Support e-mail address is support@carlsonsw.com.

via Phone/Fax

• Phone: (606) 564-5028
• Fax: (606) 564-6422

via Web Site

Check the Carlson Software web site at http://www.carlsonsw.com for:

• Knowledge Base, discussion groups, technical support documents and newsletters
• Carlson Software manuals (PDF) and training movies
• Training and seminar schedules
• Step by step procedures on popular called-in topics
• Carlson Software and Autodesk downloads and updates (Feel free to register for automatic update notification of updates when you come to that area.)

via Training

• Basic, advanced and update training is available from Carlson College. Enroll on our webpage or call 606-564-5028 and ask for Carlson College.

License Agreement

Copyright 1992-2009 Carlson Software All Rights Reserved

CAUTION! READ THIS NOTICE BEFORE USING SOFTWARE

Please read the following Software License Agreement before using the SOFTWARE. Using this SOFTWARE indicates that you have accepted its terms and conditions.

Carlson 2010

END-USER LICENSE AGREEMENT FOR CARLSON SOFTWARE

IMPORTANT-READ CAREFULLY: This Carlson Software End-User License Agreement ("EULA") is a legal agreement between you (either an individual or a single entity) and Carlson Software, Inc for the Carlson SOFTWARE accompanying this EULA, which includes computer software and may include associated media, printed materials, and "online" or electronic documentation ("SOFTWARE PRODUCT" or "SOFTWARE"). By exercising your rights to use the SOFTWARE, you agree to be bound by the terms of this EULA. If you do not agree to the terms and conditions of this EULA, you may not use the SOFTWARE. IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS EULA, DO NOT CLICK THE "ACCEPT" BUTTON, AND DO NOT INSTALL OR USE ANY PART OF THE SOFTWARE.

Carlson Software, Inc., referred to as "LICENSOR", develops and/or licenses proprietary computer programs and sells use licenses for such proprietary computer programs together with or apart from accompanying copyrighted material and documentation and;

Chapter 1. Introduction
End User desires to obtain the benefits thereof and, in return for which, is willing to abide by the obligations and fee agreements applicable to LICENSOR's use licenses in LICENSOR's proprietary computer programs.

For good and valuable consideration, including but not limited to license grant in accordance with this Agreement by LICENSOR to End User's covenant regarding LICENSOR's proprietary rights, LICENSOR agrees to permit End User to utilize materials representing LICENSOR's product or products subject to the following terms and conditions:

1. License Grant: Subject to the terms, conditions and limitations of this EULA, LICENSOR hereby grants End User a personal, limited, non-exclusive, non-transferable, license to utilize the Software Product you have purchased. The license granted in this EULA creates no license, express or implied, to any other intellectual property of Licensor, except for the specific Software Product which they have lawfully purchased from LICENSOR.

This EULA grants you the following rights: You may install and use one copy of the SOFTWARE PRODUCT, or any prior version for the same operating system, on a single computer. The primary user of the computer on which the SOFTWARE PRODUCT is installed may make a second copy for his or her exclusive use on a portable computer.

Storage/Network Use. You may also store or install a copy of the SOFTWARE PRODUCT on a storage device, such as a network server, used only to install or run the SOFTWARE PRODUCT on your other computers over an internal network; however, you must acquire and dedicate a license for each separate computer on which the SOFTWARE PRODUCT is installed or run from the storage device. A license for the SOFTWARE PRODUCT may not be shared or used concurrently on different computers.

2. Exclusive Source. End User shall obtain all LICENSOR authorized product materials through LICENSOR or LICENSOR'S authorized representative and no other source. LICENSOR authorized product materials include, but are not limited to, manuals, license agreements and media upon which LICENSOR's proprietary computer programs are recorded. End User shall make no copies of any kind of any of the materials furnished by LICENSOR or LICENSOR's authorized representative, except as specifically authorized to do so in this EULA. End User is not entitled to make archival copies of those portions of LICENSOR's product(s) that are provided on a machine readable media.

3. Proprietary Rights of Licensor. End User agrees that LICENSOR retains exclusive ownership of the trademarks and service marks represented by its company name and logo and all of the documentation and computer recorded data related thereto. End User also agrees that all techniques, algorithms, and processes contained in LICENSOR's computer program products or any modification or extraction thereof constitute TRADE SECRETS OF LICENSOR and will be safeguarded by End User, but in no event shall End User exercise less than due diligence and care in accordance with the laws of the country of purchase and International Law, whichever operates to best protect the interests of LICENSOR. End User shall not copy, reproduce, re-manufacture or in any way duplicate all or any part of LICENSOR products WHETHER MODIFIED OR TRANSLATED INTO ANOTHER LANGUAGE OR NOT, or in any documentation, or in any other material provided by LICENSOR in association with LICENSOR's computer program products regardless of what manner of storage and retrieval the product exists, except as specified in this Agreement and in accordance with the terms and conditions of this Agreement which remain in force. End User agrees that in the event End User breaches this EULA, End User will be liable for damages as may be determined by a court of competent jurisdiction.

4. Restrictions. End User's rights and obligations under this EULA are nonexclusive and personal in nature, and the intellectual property Licensor grants to End User is subject to applicable law other than bankruptcy law. End User may not transfer or assign the SOFTWARE, rights under this EULA or accompanying user documentation, or any updates of the SOFTWARE which may be provided under this EULA, to a third party unless End User
receives written consent from Licensor at least 30 days prior to the completion of transfer. Licensor reserves the right to deny transfer or assignment if, in its sole discretion, Licensor determines the transfer not to be a necessity. Whether or not a transfer or assignment is allowed shall be determined in Licensor's sole discretion after taking into consideration certain factors to find the existence of a necessity including, but not limited to, merger or acquisition of an entity, complete asset acquisition, change of control, severe economic hardship, severe loss of human resources or significant loss in business divisions, or winding down of entity affairs.

If Carlson consents to a transfer, such transfer shall be allowed only as a one-time permanent transfer of this EULA and Software to another end user, provided the initial End User retains no copies or previous versions of the Software. The transfer must include all of the Software, including all component parts, any media and printed materials, any upgrades, this EULA, and any associated license key. The transfer may not be an indirect transfer, such as a consignment, rental or lease. No corresponding Maintenance Agreement rights shall transfer with the SOFTWARE transfer to the subsequent end user. Prior to the transfer, the subsequent end user receiving the Software from the initial End User must agree to all terms of this EULA, with the added condition that no further transfers to third parties are permitted for any reason whatsoever, and shall agree to the terms and conditions of a new Maintenance Agreement with Licensor.

You may not reverse engineer, decompile, or disassemble the SOFTWARE or alter the images utilized in the SOFTWARE and user documentation. The SOFTWARE PRODUCT is licensed as a single product. Its component parts may not be separated for use on more than one computer. You shall communicate to any individual user in your facility that they are bound by the restrictions of this license agreement may not copy or alter the SOFTWARE for use outside End User's facilities.

Upgrades. If you purchase an upgrade of a SOFTWARE PRODUCT and you use it on different machine from one where upgraded SOFTWARE PRODUCT was used, use of original SOFTWARE PRODUCT must be discontinued and confirmed within 30 days. If such use is not discontinued, it is a material breach of this EULA and LICENSOR shall be entitled to all remedies available to it under this EULA, and under the laws of Kentucky, USA.

5. Warranty. THE PRODUCT IS PROVIDED "AS IS" WITH ALL FAULTS. TO THE MAXIMUM EXTENT PERMITTED BY LAW, LICENSOR HEREBY DISCLAIMS ALL WARRANTIES, WHETHER EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND WARRANTIES THAT THE PRODUCT IS FREE OF DEFECTS AND NON-INFRINGEMENT, WITH REGARD TO THE SOFTWARE, AND THE ACCOMPANYING WRITTEN MATERIALS. YOU BEAR ENTIRE RISK AS TO SELECTING THE PRODUCT FOR YOUR PURPOSES AND AS TO THE QUALITY AND PERFORMANCE OF THE PRODUCT. THIS LIMITATION WILL APPLY NOTWITHSTANDING THE FAILURE OF ESSENTIAL PURPOSE OF ANY REMEDY. In any event, LICENSOR will not honor any warranty shown to exist for which inaccurate or incorrect identifying data has been provided to LICENSOR. The product(s) provided are intended for commercial use only and should not be utilized as the sole data source in clinical decisions as to levels of care.

6. LIMITATION OF LIABILITY. EXCEPT AS REQUIRED BY LAW, LICENSOR AND ITS DISTRIBUTORS, DIRECTORS, LICENSORS, CONTRIBUTORS AND AGENTS (COLLECTIVELY, THE "LICENSOR GROUP") WILL NOT BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL OR EXEMPLARY DAMAGES ARISING OUT OF OR IN ANY WAY RELATING TO THIS EULA OR THE USE OF OR INABILITY TO USE THE PRODUCT, INCLUDING WITHOUT LIMITATION DAMAGES FOR LOSS OF GOODWILL, WORK STOPPAGE, LOST PROFITS, LOSS OF DATA, AND COMPUTER FAILURE OR MALFUNCTION, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES AND REGARDLESS OF THE THEORY (CONTRACT, TORT OR OTHERWISE) UPON WHICH SUCH CLAIM IS BASED. THE LICENSOR GROUP'S COLLECTIVE LIABILITY UNDER THIS AGREEMENT WILL NOT EXCEED THE GREATER OF $500 (FIVE HUNDRED DOLLARS) AND THE FEES PAID BY YOU UNDER THIS LICENSE (IF ANY).
7. Update Policy. LICENSOR may, from time to time, revise the performance of its product(s) and in doing so, incur NO obligation to furnish such revisions to any End User nor shall it warrant or guarantee that any revision to the SOFTWARE will perform as expected by the End User on End User's equipment. At LICENSOR's option, LICENSOR may provide such revisions to the End User.

8. Customer Service. Although it is the LICENSOR's customary practice to provide reasonable assistance and support in the use of its products to its customers, LICENSOR shall not be obligated to any End User to provide technical assistance or support through this Agreement and may at LICENSOR's sole election charge a fee for customer support.

9. Termination of End User License. If any one or more of the provisions of this Agreement is breached, the license granted by this Agreement is hereby terminated. In the event of such termination, all rights of the LICENSOR shall remain in force and effect. Any protected health information data of End User maintained on LICENSOR'S data base shall upon reasonable notice to End User and at the discretion of LICENSOR may be destroyed.

10. Copyright. The SOFTWARE (including, but not limited to, any images, photographs, animations, video, audio, music and or text incorporated into the SOFTWARE), and all intellectual property rights associated with it, whether exists in a tangible media or in an electronic image media is owned by LICENSOR and is protected by United States copyright laws and international treaty provisions and all other commonwealth or national laws. LICENSOR reserves all intellectual property rights in the Products, except for the rights expressly granted in this Agreement. You may not remove or alter any trademark, logo, copyright or other proprietary notice in or on the Product. This license does not grant you any right to use the trademarks, service marks or logos of LICENSOR or its licensors. You may not copy any user documentation accompanying the SOFTWARE.

11. Injunctive Relief. It is understood and agreed that, notwithstanding any other provision of this Agreement, LICENSOR has the unequivocal right to obtain timely injunctive relief to protect the proprietary rights of LICENSOR.

12. Entire Agreement. This Agreement constitutes the entire agreement between the parties and supersedes any prior agreements. This Agreement may only be changed by mutual written consent.

13. End User Agreement Acknowledgment. The End User hereby accepts all the terms and conditions of this Agreement without exception, deletion, alteration. End User acknowledges they are authorized to enter this agreement on behalf of any organization for which the license is sought. Any unauthorized use of LICENSOR products will be considered a breach of this Agreement, subject to liquidated damages and otherwise unlawful and willful infringement of LICENSOR's trade secrets and/or proprietary products.

14. Payment and Refund Policy. The use of the SOFTWARE herein is deemed a commercial use and under the terms of this license agreement End User shall not be entitled to any refund of purchase price. End User agrees to pay all user fees promptly. LICENSOR is authorized by End User to suspend any further access to SOFTWARE in the event fees are not fully paid. End user entity shall promptly pay any and all access and use charges incurred regardless of the end user. End user is responsible for protecting any pass word and user identity supplied to End User.

15. Loss/Theft/Misuse. End user shall promptly report to LICENSOR the theft or other loss of any pass word and/or user identity required to access SOFTWARE. LICENSOR shall not be responsible for maintaining the integrity of End User data in the event that end user's data base is accessed and/or altered by an unauthorized end user due to the failure of licensed End User to protect its password or user identity. End User shall be responsible for any costs incurred by LICENSOR due to the negligence or reckless disregard of End User's failure to protect its password or user identity.

Chapter 1. Introduction
16. Civil/Criminal Investigation. End user shall fully cooperate with LICENSOR and or any person authorized by LICENSOR (including local, state, or federal law enforcement officials) to investigate any alleged theft, misuse or unauthorized use of SOFTWARE or data related thereto.

17. U.S. Government Restricted Rights. The SOFTWARE and documentation are provided with RESTRICTED RIGHTS. Use, duplication, or disclosure by the Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer Software-Restricted Rights at 48 CFR 52.227-19, as applicable.

18. Governing Law. This EULA shall be governed and construed in accordance with the laws of the Commonwealth of Kentucky, USA.
This section contains tutorials designed to assist you in learning this Carlson Software product. It is recommended that you try some of these out when you are first starting to learn the software, or when you need some pointers later on.

You will see how to enter a deed, make a plat and use Field to Finish for faster drafting. There are also lessons on intersections and subdivisions, SurvNET, contouring, DTM and design. Using break lines and surfaces are also covered.

Some of the tutorials will ask you to open drawing and data files that are provided to you at purchase. Good luck!
Lesson 1: Entering a Deed

In this short lesson you will create a simple drawing. You will enter a 6-sided deed, add a title block, bar scale, and north arrow, add a title and certification text, and plot the deed area.

Note that the Esc key will cancel most commands, so if you choose the wrong command or enter something incorrectly and want to start over, just press Esc.

1 Click the icon for Carlson. You may be presented with a "Startup Wizard" dialog box. If so, click Exit.
2 Under the Settings menu, click Drawing Setup. Set the unit setting to English and the Horizontal Scale to 50. Click OK.

3 Choose Point Defaults from the Points menu, and, in the dialog box, click Elevations off to eliminate the Elevation prompt. Click Descriptions on and also set the point symbol name to symbol 4 (SPT4), which is the round, open circle. Click Automatic Point Numbering on. Click OK.
4 Under the Survey menu, select Enter Deed Description. Use the default settings as shown in this dialog box image.
Set the To Table Scaler option to 0.00. This places all of the deed calls in the drawing. The To Table Scaler determines which deed calls appear in the drawing and which deed calls appear in a table. Deed calls less than the To Table Scaler value multiplied by the Drawing Scale will be placed in a table of calls. Set the dialog box options to match those shown above. Click OK.

The command line is the area below the graphics and to the left. When prompted to "Pick point or point number" at the command line, pick a point in the lower left quadrant of your screen to start the deed plotting. If you are prompted for elevation, you failed to turn off the elevation prompt in Point Defaults. Press Esc and return to the Point Defaults command.

The following dialog box will appear so you can specify where to store the coordinates:
Select the New tab. Then, for the File Name, type in Deed. This creates a file called Deed.crd. All Carlson points are stored in files with the "crd" extension, which stands for "coordinates." Click Open. Now respond to the command line prompts exactly as shown here:

When you are prompted for a description, enter "Fence Post".

**Exit/Curve/<Bearing (Qdd.mmss)>**: 125.3500
The quadrant (Q) is 1 for Northeast (2 is Southeast, 3 is Southwest and 4 is Northwest). The bearing is 25 degrees, 35 minutes, and 00 seconds. If all digits for the minutes and seconds are entered as shown above, then the deed call will be fully plotted, including the seconds. If only the degrees and minutes were entered, as in 125.35, then the plot would appear as "N 25° 35' E".

**Varas/Meters/Poles/Chains/<Distance(ft)>**: 200.51 Note that you can enter old deeds in the forms of Poles and Links, Chains and Links and even Varas (a unit of measurement formerly used in the southwestern states of the U.S.).

**Enter Point Description <Fence Post>: Iron Pin**

**Undo/Exit/Curve/<Bearing (Qdd.mmss)>**: 189.4321

**Varas/Meters/Poles/Chains/<Distance>:** 225.00

**Enter Point Description <Iron Pin>: press Enter**
Pressing Enter selects the default, which is Iron Pin.

**Undo/Exit/Curve/<Bearing (Qdd.mmss)>**: C

**Radius**: 75

**Curve direction [Left/<Right>]? press Enter for right**

**Non-tangent/Reverse-tangent/Bearing/Chord/DeltaAng/Tangent/<Arc Len>:** 118.17
If you don't know the arc length, but you know the tangent, you would choose "T" for tangent.

**Enter Point Description <Iron Pin>: press Enter**

**Undo/Exit/Curve/<Bearing (Qdd.mmss)>**: 200.0000 (due south)
If you were to enter just 2 (no degrees, minutes, or seconds), then the deed call would be plotted "S 000 E".
Varas/Meters/Poles/Chains/<Distance>: 178.00
Enter Point Description <Iron Pin>: Concrete Monument

Undo/Exit/Curve/<Bearing (Qdd.mmss)>: 488.2300
This entry specifies Northwest 88 degrees, 23 minutes.

Varas/Meters/Poles/Chains/<Distance>: 300.34
Enter Point Description <Concrete Monument>: Fence Post

Undo/Exit/Curve/<Bearing (Qdd.mmss)>: 454.1109
Varas/Meters/Poles/Chains/<Distance>: 106.93
Enter Point Description <Fence Post>: press Spacebar, then press Enter
Simply pressing Enter uses the default text (Fence Post) again. To avoid drawing the text "Fence Post" twice on the end point, press the spacebar, skip a blank character, and press Enter.
You have now completed the 6-sided figure (including one curve).

Undo/Exit/Curve/<Bearing (Qdd.mmss)>: E

The following results are reported:

SQ. FEET: 83921.8  SQ. YARDS: 9324.6  SQ. MILES: 0.0
ACRES: 1.93
Closure error distance> 0.01708540  Error Bearing> S 52d5'26'' E
Closure Precision> 1 in 66076.89  Total Distance Traversed> 1128.95

SQ. FEET: 82302.9  SQ. YARDS: 9144.8  SQ. MILES: 0.0
ACRES: 1.89

The resulting deed, has a closure of 1:66077. In the initial prozmpt "Undo/Exit/Curve...", U for Undo would allow you to reenter the previous deed call.

Use the Extents command on the View menu to see the entire area. Then choose Zoom Out under the View menu giving you adequate room for the next step.

5 Under the Settings menu, select Title Block. The first dialog you will see is shown here:
Select Paper Size B2 (11 x 17), and enter the layer name of BORDER, then choose OK. You will be prompted for the border location, pick a point in the lower left of the survey.

The following dialog appears, allowing you to enter the attributes for the Title Block. After you have completed the title block entries, as shown below, select OK.

Note that the title line is plotted in large text on the title block. Its length, therefore, should not exceed 15 characters.

Your drawing should look like the example below at this point.
Use the *Extents* command, found in the View menu, to see the entire working area. If you want to move the border, use the *Move* command on the Edit menu. Pick the border lines and the title block objects (up to 3 picks total), press Enter (to end object selection), then pick two points representing the vector of the move.

If you want to see a margin around the working area after you use the Extents command, use the *Zoom Out* command on the View menu. Then use the Window command on the View menu to capture the view and margin you prefer.

If you make a mistake, enter U for undo, or select the back arrow icon that appears at the top of the screen.

6 On the Annotate menu, select *Draw North Arrow*.

Accept the default north arrow that is shown at the right side of the dialog, click OK, and place it in the upper right of your drawing. Choose *Move* on the Edit menu (or Enter M for move at the command line) and move it.

7 On the Annotate menu, select *Draw Bar Scale*. Accept the defaults, and then pick an insertion point below the north arrow and directly above the "a" in Farmer, and approximately the same distance from both. You can move the bar scale using the *Move* command on the Edit menu, if you need to.

8 On the Draw menu, select *Dynamic* within the *Text* command. Respond to the prompts as shown below:

**Specify start point of text or [Justify/Style]: J**
Enter an option [Align/Fit/Center/Middle/Right/TL/TC/TR/ML/MC/MR/BL/BC/BR]: C for center justified
Specify center point of text: Choose a point near the top-center of the drawing.
Specify height <4.00>: 10 Entering 10 make the title text bigger than the default.
Specify rotation angle of text <E>: E
Text: Farmer Survey
Text: Ashland, KY
Text: press Enter

To enter a certification in the lower-right of the drawing, again select Text > Dynamic from the Draw menu, or type "dtext" at the command line. If you haven’t done anything else, such as Zoom or Pan, you can simply press Enter to repeat the last command. If pressing Enter does not repeat the Text command, press Esc to cancel. Enter Dtext at the command prompt, and respond to the resulting prompts as shown below.

Pick a point above and to the left of the title block for the certification. You don’t have to enter L for left-justification. The Dtext command defaults to left-justification every time.

Height <10.00>: 4
Rotation angle <E>: press Enter
Text: Surveyor's Certification
Text: Press spacebar, then press Enter
Text: I do hereby certify that the survey shown hereon
Text: is a true and correct representation.....
Text: press spacebar, then press Enter
Text: ____________________________
Text: Arnold James, PLS #2534
Text: press Enter twice to end

The following is a closeup of the certification that we just entered:

![Certification Closeup]

9 Enlarge the two title lines ("Farmer Survey" and "Surveyor's Certification") by a factor of 2.0 using the command Text Enlarge/Reduce on the Edit menu, option Text. When prompted for Scaling Multiplier, enter 2. Select both the Farmer Survey text (at the top of the screen, not in the title block) and the Surveyor's Certification text. When asked
again to Select Objects, press Enter.

When you are selecting objects, if you select something you don't want, you can enter "R" at the next Select Objects prompt, and remove items from the selection set. If you want to add objects after you have removed an object, enter "A" at the next Select Objects prompt.

10 Make the enlarged Farmer Survey text at the top of the screen bold by changing its font to the bold font. Select the Text command from the Edit menu, Text, then select the Change Text Font option.

**Select Objects:** pick the Farmer Survey Text at the top of the drawing

**Select Objects:** press Enter for no more selections.

**Style Name:** Bold

11 Select the Edit Text command (under the Edit menu, Text option) to change S 00°00'00" E to S 00° E. When you are prompted, "Select Text to Edit:" pick the due South bearing text. A dialog box appears as follows:

![Edit Text dialog box]

The degree symbol is represented as %d. (If you had typed N 15%d25'35" E in the Dtext command, Carlson would draw that entry as N15°25'35"E.) Click in the text to the immediate right of the quotation mark and press the Backspace key until the text reads as shown here.

![Edit Text dialog box]

Click OK. Press Enter to exit the command.

12 In the enlargement in Step 8 showing the title block and also showing point 5, notice how the linework travels into the circle that represents the point. To clip off the linework at the edge of the corner symbols, use the Trim by Point Symbol command on the Points menu. This command requires that all points be in view, so if you cannot see your entire drawing, use the Extents command on the View menu (sometimes referred to as Zoom Extents). Respond to the following prompts:

**Select point symbols to trim against. Select objects:** ALL

Entering "all" at the command line selects everything on the screen. Only the linework crossing into the corner symbols will be trimmed.

**Select objects:** press Enter

You can continue to select objects until you press Enter.

The trimming is completed.

13 Prepare for area labeling by selecting the Area Defaults command on the Area menu. The dialog box shown below appears. Change the Other Area Labels and Inverse with Area decimal precision to 4 decimal places. Also,
make the Area Text Size Scaler 0.2 (doubled from the default of 0.1).

You are going to compute the area by point number. You could have chosen the Area by Lines & Arcs command. In that command, you would pick the lines and arcs that make up the figure. But since the closure was 0.017 off (the distance from point 7 to point 1), you would exceed the default Max gap tolerance. Unless you change that tolerance in this dialog box to something larger than 0.017, you would get no result using the Area by Lines & Arcs command. So do not change it for this exercise because you might forget to change it back. Instead, you will compute the area by inversing from 1 through 7 and back to 1. Click OK to exit the Area Defaults dialog box.

14 Select Inverse with Area on the Area menu. Respond to the prompts as shown below:

Station/<Pick Starting point or point number>: 1
Pick point or point numbers (R-RadiusPt, U-Undo, Enter to end): 2
Pick point or point numbers (R-RadiusPt, U-Undo, Enter to end): 3
Pick point or point numbers (R-RadiusPt, U-Undo, Enter to end): R
Radius point number or pick point: CEN for center "snap"
Now move the cursor, without picking, to the arc and see how the center snap becomes active. When the radius point is found, pick on the arc.
Curve direction [Left/<Right>?] press Enter for the Right option
Pick End of Arc or point number (U-Undo, Enter to end): 4
Pick point or point numbers (R-RadiusPt, U-Undo, Enter to end): 5
Pick point or point numbers (R-RadiusPt, U-Undo, Enter to end): 6
Pick point or point numbers (R-RadiusPt, U-Undo, Enter to end): 7
Pick point or point numbers (R-RadiusPt, U-Undo, Enter to end): 1
Pick point or point numbers (R-RadiusPt, U-Undo, Enter to end): press Enter to end

A Standard Report Viewer dialog box showing the Inverse with Area results will appear. Select Exit at the top of the dialog box and respond to the prompts as shown below:

Chapter 2. Tutorials 45
Pick area label centering point (Enter for none): pick a point near the center of the figure, in its interior. The area units you chose in Area Defaults are labeled on the screen.

Erase Polyline [<Yes>/No]: Y
This erases a polyline that has been drawn over the original lines and arcs. The Inverse with Area command draws this polyline because often you are solving the area from points and want the new linework drawn.

You snapped to the radius point using the "cen" snap. Additional object snaps appear under Aperture-Object Snap command on the Settings menu. Since all plotted points have a node, you could have inversed around this figure by using the "nod" snap for points 1 through 7, and the "cen" snap to capture the radius point. Snaps are typically entered at the keyboard as 3 characters (for example, "int" for intersect and "end" for endpoint).

15 Freeze the point numbers to finish the drawing by choosing Layer Control on the View menu. In the PNTNO row, click the sun icon to change it to a snowflake icon, which freezes the PNTNO layer. Click OK. The point numbers remain in the drawing, waiting to be "thawed", but they are not displayed.

This completes the Lesson 1 tutorial: Entering a Deed.

Lesson 2: Making a Plat
In this lesson you will draw out a plat of a single lot, using Carlson drafting techniques. You will make the plat from an ASCII file of points named Plat.txt.
1 Click the icon for Carlson. You may be presented with a Startup Wizard dialog box, as shown below:

You will use the Wizard in Lesson 3 to quickly perform a series of commands. In this lesson, however, you will enter the commands individually, so that you can see what each one does.

If you see the Startup Wizard dialog box, and you don't want to see it again, click the Skip Startup Wizard Next Time option in the dialog box above. Make sure the other settings are as shown above and click Exit.

Another way to turn off the Wizard is to click it off within the Configure > General Settings command, found under the Settings menu. You will open this General Settings dialog box now.

2 On the Settings menu, click Configure to display the following menu:

Click General Settings to display the dialog box shown here.
The settings in this dialog box, along with the settings in other Configure sub-options, determine default working conditions for Carlson. Turn on Group Point Entities, which groups point elevations, numbers, and descriptions (all aspects of the points) into a single entity for moving, erasing and other commands.

Choose Numeric Only to store points in numeric form. This produces point numbers such as 1, 2, 3, 10 and 11. If you selected Alphanumeric, then you could have point numbers like 1A, 1B, 1C, HUB5, CTRL, SS10, etc. There is a slight speed advantage to working with purely numeric point numbers. The highest numeric point number allowed is 32000. Regardless of format, point numbers are stored in a file that has a .crd extension. There is no limit to the number of points in an alphanumeric coordinate file. In anticipation of Lesson 3, click on the Use Startup Wizard option. Click OK at the bottom of this dialog box.

Now we want to set the data path. Another of the Configure sub-options is Project/Data Folders. Click this option and you will see this dialog box.

For this lesson, you will keep it simple. Click on Fixed Folder at the top. Notice the Current Data Folder section at the bottom. This specifies where data files, such as .crd files in this case, are to be stored. Set the folder to...
3 Select **Drawing Setup** from the Configure main dialog box.

The scale acts as a multiplier on all text annotation. For example, \(100 \times \text{Text Plot Size} (0.08) = 8\) (text height of 8 units). The Text Plot Size is the effective height, in inches, that the text will appear when plotted at the Horizontal Scale (here 100).

Bearings and Distances, Legends, Title Blocks, and Point Symbols will size up or down on the basis of the Horizontal Scale set within **Drawing Setup**. Set the Horizontal Scale to 100. Then click OK to exit Drawing Setup. Then click Exit to close the Configure dialog box.

4 Next, you will import the ASCII file called Plat.txt and store the points in a Coordinate file called Plat.crd. However, since you are in a new drawing, you have not yet set a coordinate file to store the points in. You must have a Carlson coordinate file (.crd) open and established as the container for your points.

So, under the Points menu, select the command **Set Coordinate File** to display a dialog box. Click the New tab, as shown here. To the right of File name enter Plat and click Open. You have now created the required .crd file.
You are now ready to import the points. This time, under the Points menu, select **Import Text/ASCII File** to display the Text/ASCII File Format dialog box, as shown below. Click the Select Text/ASCII Files button and then choose Plat.txt listed on the right. It is found in the default data folder (C:\Carlson2008\Data). Click Open.
Plat.txt is an ASCII file containing 54 points in the form of Point Number, Northing, Easting, Elevation and Description. The format of the points appears in the Preview Window. The format is: Point (P), Northing (Y), Easting (X), Elevation (Z), Description (D), or, in short, P,Y,X,Z,D. You must match this format in the Coordinate Order. If you don't see P,Y,X,Z,D in the Coordinate Order box, then select that format from the Common Formats option. Or, you can type the list directly into the Coordinate Order box. Make sure that Draw Points is set to Off.

Click OK. The points will be saved and stored in Plat.crd. A confirming dialog appears as follows:

Click OK.

5 Choose the List Points command under the Points menu.

The List Points dialog box will typically default to the full range of points, which is 1 through 54 in this exercise. You can control the decimal places for the Northing/Easting and the Elevation of the points in the lower portion of the dialog box. Click OK and the settings shown above result in the report exhibited below in the Standard Report Viewer:
Exit the report by selecting the Exit icon at the top of this report viewer box, or by clicking the X in the upper right of the window.

6 Select the **Draw-Locate Points** command on the Points menu to draw the points on the screen.

```
<table>
<thead>
<tr>
<th>PointNo.</th>
<th>Northing (Y)</th>
<th>Easting (X)</th>
<th>Elevation (Z)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>4922.730</td>
<td>5570.695</td>
<td>502.510</td>
<td>FL CM/(4&quot; DIAM)</td>
</tr>
<tr>
<td>2</td>
<td>4739.612</td>
<td>5499.121</td>
<td>396.050</td>
<td>HUB</td>
</tr>
<tr>
<td>3</td>
<td>4448.940</td>
<td>5342.352</td>
<td>495.430</td>
<td>UP</td>
</tr>
<tr>
<td>4</td>
<td>4504.253</td>
<td>5426.930</td>
<td>496.650</td>
<td>UP</td>
</tr>
<tr>
<td>5</td>
<td>4794.880</td>
<td>5495.289</td>
<td>505.110</td>
<td>SHED</td>
</tr>
<tr>
<td>6</td>
<td>4771.855</td>
<td>5486.661</td>
<td>505.350</td>
<td>SHED</td>
</tr>
<tr>
<td>7</td>
<td>4782.648</td>
<td>5457.861</td>
<td>505.080</td>
<td>SHED</td>
</tr>
<tr>
<td>8</td>
<td>4854.766</td>
<td>5357.221</td>
<td>501.970</td>
<td>IP FL</td>
</tr>
<tr>
<td>9</td>
<td>4467.748</td>
<td>5476.238</td>
<td>496.370</td>
<td>IP</td>
</tr>
<tr>
<td>10</td>
<td>4571.003</td>
<td>5617.447</td>
<td>499.130</td>
<td>IP</td>
</tr>
<tr>
<td>11</td>
<td>4689.990</td>
<td>5551.491</td>
<td>503.010</td>
<td>18D/OAK</td>
</tr>
<tr>
<td>12</td>
<td>4811.615</td>
<td>5579.171</td>
<td>504.120</td>
<td>24D/OAK</td>
</tr>
<tr>
<td>13</td>
<td>4675.933</td>
<td>5564.350</td>
<td>504.970</td>
<td>12P</td>
</tr>
<tr>
<td>14</td>
<td>4714.739</td>
<td>5606.389</td>
<td>502.750</td>
<td>OP</td>
</tr>
</tbody>
</table>
```
In this figure shown above, the current Symbol Name is showing as SPT10, which stands for Survey Point symbol 10. SPT10 is an X, shown in the symbol display window. You can select a different default symbol using the *Point Defaults* command on the Points menu.

In this exercise you will change the Symbol Name to null, or symbol 0, listed as SPT0 (in effect, no symbol). Later, you will add official property corner and utility symbols. Although you are working without a default symbol, there will always be a "dot" or a node at the correct insertion point of each point number.

At the top click Select. You will see the following dialog box:

![Select Symbol Dialog Box](image)

Note that the scroll bar at the right of this Select Symbol dialog box leads to more pages of symbols. Click the blank SPT0 point symbol option.

When you select a symbol, you automatically return to the Draw-Locate Point dialog box. Click Draw All to display the rather busy drawing shown below:
You will now be using the *Scale Point Attributes* command on the Points menu. Notice how the lower-right corner of the drawing is very congested, with many point attributes overlapping. You can specify a window containing these points and scale them down by a factor of 0.4. For Scaling Multiplier, you will enter 0.4. When you are prompted to Select Carlson Software points, you will enter WP for Window Polygon and make a polygon around the congested area. Press Enter when you have surrounded the points with the polygon as shown below. Here is the command line sequence, along with the responses you will enter, after clicking *Scale Point Attributes*:

**Scaling Multiplier <0.500>:** .4  
Scale symbols only, point labels only or both [Symbols/Labels/<Both>]? *press Enter*  
Select points from screen, group or by point number [Screen>/Group/Number]? *press Enter*  
Select Carlson Software points.  
Select objects: wp  
First polygon point: start creating your polygon
Once this polygon is complete, you are again prompted to select points. Press Enter. The following shows the scaled points.

Next, you will prepare for drawing linework by setting the current layer. You should draft linework and symbol work in designated layers. In this example, you will put linework and symbol work in a layer named Final. (You could put property linework in the Final layer and utility linework in the Utility layer, but, for now, you will put all linework and symbols in the layer Final.) To pick the current working layer, select the Layer Control command from the View menu.
Click Final. Click Current. Click OK.

9 The 2D Polyline command allows you to enter point numbers to draw a line. First, connect portions of the property line. Select the 2D Polyline command on the Draw menu. A dialog box might appear. If it does, accept the defaults and click OK.

[Continue/Extend/Follow/Offset/Options/<Pick point or point numbers>]: 1
[Arc/Close/Distance/Follow/Offset/Undo/<Pick point or point numbers>]: 8
[Arc/Close/Distance/Extend/Follow/Line/Offset/Undo/<Pick point or point numbers>]: press Enter

This creates a polyline. Keep this as a separate polyline because later you will turn this back lot line into a fence line.

Now, connect some of the other property lines. Repeat the 2D Polyline command. You can press Enter to
repeat the command, or you can select it from the Draw menu. Connect points 8 through 10, and start an arc, by entering as follows:

[Continue/Extend/Follow/Offset/OPtions/<Pick point or point numbers>]: 8-10
[Arc/Close/Distance/Extend/Line/Offset/Undo/<Pick point or point numbers>]: a
[Radius pt/radius Length/Arc length/Chord/Second pt/Undo/<Endpoint or point number>]: 15
[Arc/Close/Distance/Extend/Line/Offset/Undo/<Pick point or point numbers>]: 1
[Arc/Close/Distance/Extend/Line/Offset/Undo/<Pick point or point numbers>]: press Enter to end the command

This creates the full lot, with the arc coming off point 10 on a tangent. The line from 15 to 1 is not guaranteed to be tangent to the previous arc.

You should have the following linework at this point:

10 You will now create a fence line on the polyline you drew from points 1 to 8. Go back to Drawing Setup from the Settings menu and set the Horizontal Scale to 50. Click OK to exit Drawing Setup.

Now, choose the Line Types command on the Annotate menu and select the Change Polyline Linetype command. The Line Types command creates polylines that respond as one entity when selected. When the dialog box appears, click Next twice to display the dialog box shown below.
Choose the Fence_S option (the solid fence line).

When prompted to Select Objects, pick the polyline you created from points 1 to 8. Press Enter to end selection. Notice in the dialog box above that the current Line Type Scaler, governing spacing, should be 0.5 (inches) and the Text (height) Scaler is 0.1. If your settings are different, you may want to Undo (by entering U for undo) the fence line and select the Annotate Defaults command on the Annotate menu, and set these items to match the example.

On the View menu, select the Isolate Layers command, pick the property line, and press Enter twice. Here is the result:
Next, you will connect up the edge of pavement. On the View menu, select the Restore Layers command to restore your points. Then select the 2D Polyline command under the Draw menu. Again, a dialog box might appear as shown below. If it does, make sure that the options selected are the same. In the future you can choose not to see this box.

![Polylie 2D Options](image)

Click OK. Proceed as follows to connect up the edge of pavement:

[Continue/Extend/Follow/Options/\(<\text{Pick point or point numbers}\)>\]: 45-47, 49-51

Press Enter at the next prompt to exit the command and create the road. Press Enter one more time. Note how you can separate range entries using a comma.

To smooth the edge of the road, select the Polyline Utilities command on the Edit menu, and select Smooth Polylines.
Enter the looping factor (1-10) <5>: press Enter
Enter the offset cutoff <0.05>: press Enter
Select objects: pick the edge of road polyline
Select objects: press Enter

13 To offset the smoothed edge-of-road polyline by 24 feet to make the opposite edge of the road, Select the Standard Offset command on the Edit menu.

Specify offset distance or [Through/Erase/Layer] <Through>: 24
Select object to offset or [Exit/Undo] <Exit>: pick the edge-of-road polyline
Specify point on side to offset or [Exit/Multiple/Undo] <Exit>: pick to the right of the polyline
Select object to offset or [Exit/Undo] <Exit>: press Enter to end the command

Now, select the Isolate Layers command again from the View menu, pick on any of your linework, and only the entities on the picked layers are displayed.

Select the Restore Layers command from the View menu to recover your points. Experiment with the "cadence" of Isolate and Restore Layers. Select Isolate Layers, pick the layers to isolate, then press Enter twice. Then select Restore Layers.

14 Next, you will draw the shed. Select the 2D Polyline command on the Draw menu. To draw a two-sided shed, connect points 5 through 7 as follows:

[Continue/Extend/Follow/Options/<Pick point or point numbers>]: 5-7, press Enter twice
This produces the 2-sided building shown here:

Select the 4 Sided Building command on the Survey menu. Turn the 2-sided shed into a 4-sided shed as follows:

Options/<Pick a line or polyline>: Pick the shed

Now your 2-sided building looks like this:
Focus your attention on the area of tightly spaced points with point numbers ranging from 27 to 44. This is the driveway and paving area. In the case of the driveway, assume that the surveyor who collected the points shot in 3-point arcs. They came up to a PC, shot a point on the arc, and finished up at the PT.

On the View menu, select the Window option, and pick a lower left and upper right point that windows the driveway area. (If you wish to use the View>Previous command to zoom out, then use View>Window to zoom in again.) Select the 2D Polyline command under the Draw menu, and walk the polyline through the two arcs as follows:

[Continue/Extend/Follow/Options/<Pick point or point numbers>]: 27
[Arc/Close/Distance/Follow/Undo/<Pick point or point numbers>]: 28
[Arc/Close/Distance/Extend/Follow/Line/Undo/<Pick point or point numbers>]: A
[Radius pt/radius Length/Arc length/Chord/Second pt/Undo/<Endpoint or point number>]: S
Use S for 3-pt arcs.
Second point or point number: 29
Endpoint or point number: 30
[Arc/Close/Distance/Extend/Follow/Line/Undo/<Pick point or point numbers>]: 31
[Arc/Close/Distance/Extend/Follow/Line/Undo/<Pick point or point numbers>]: A
[Radius pt/radius Length/Arc length/Chord/Second pt/Undo/<Endpoint or point number>]: S
Second point or point number: 32
Endpoint or point number: 33
[Arc/Close/Distance/Extend/Follow/Line/Undo/<Pick point or point numbers>]: press Enter
In the above exercise you started at point 27, went to the PC at point 28 and inserted a 3-point arc through points 29 and 30. You proceeded tangent to point 31, which was another PC, then completed a 3-point arc through points 32 and 33, and ended.

Now, connect up the basketball court area. Select the 2D Polyline command under Draw, or press Enter to repeat the previous command.

[Continue/Extend/Follow/Options/<Pick point or point numbers>]: 27
[Arc/Close/Distance/Follow/Undo/<Pick point or point numbers>]: 44
[Arc/Close/Distance/Extend/Follow/Line/Undo/<Pick point or point numbers>]: 43-39 (you can enter "backwards" ranges)
[Arc/Close/Distance/Extend/Follow/Line/Undo/<Pick point or point numbers>]: A
Next you will make a building footprint. Points 18 and 19 are two shot corners of a building. Assume that the surveyors taped the main house, going clockwise from point 18, as follows: 10'L, 20'R, 40'L, 20'R, 20'L, 83'L, 60'L, 23'L, 10'R.

You can easily enter these "jogs" in the building using the Extend by Distance command. If you are zoomed in on the driveway, use View > Zoom > Zoom Out, then View > Pan to focus on the building north of the driveway. Now use the 2D Polyline command on the Draw menu to draw a line from 18 to 19.

**Pick point or point numbers:** 18
**Undo/Arc/Length/**Pick point of point numbers**: 19, then press Enter twice to end

Select the By Distance option from the Edit menu, Extend command.

**Pick line or pline to extend:** pick the building line closer to point 18

This makes the arrow point toward 18 rather than 19. Now you can go clockwise:
Enter or pick distance to Draw (A,B,C,E,I,L,M,N,O,P,R,S,T,U,Z,?,Help): L10 (lower case "l" and "r" work also)


17 Next, you will complete the linework for the sewer line and the electric utility line. Use the View > Extents command so you can see all your points.

The sewer line runs from points 52 to 53 to 54. Select the 2D Polyline command from the Draw menu. To create the sewer line, enter the following:

[Continue/Extend/Follow/Options/<Pick point or point numbers>]: 52-54, press Enter twice to end

You will next annotate the sewer polyline using the Change Polyline Linetype command, but first you must set the default spacing for the annotation. Select the Annotate Defaults command on the Annotate menu. The following dialog box appears.

![Annotate Defaults dialog box]

Change the Line Type Spacing to 1.5. This will label "S" on the sewer line every 1.5" at the current scale (1"=50').

To annotate the sewer line with an S, select the Line Types command on the Annotate menu, then choose Change Polyline Linetype. Within the dialog box, click Next four times, select the Sewer linetype from the list, and then
select the sewer polyline that runs next to the road. The polyline will be annotated.

Next, create the electric utility line, which runs from point 3 to point 4 to point 17. Select the 2D Polyline command on the Draw menu.

[Continue/Extend/Follow/Options/<Pick point or point numbers>: 3
Arc/Close/Distance/Follow/Undo/<Pick point or point numbers>: 4
Arc/Close/Distance/Extend/Follow/Line/Undo/<Pick point or point numbers>: 17
Arc/Close/Distance/Extend/Follow/Line/Undo/<Pick point or point numbers>: press Enter twice to end

No points were taken beyond point 17, due to obstructions from the various setups in the field. So you must extend the polyline from point 17 to beyond the property. Under the Edit menu, choose Extend, then By Distance. Pick on the electric utility polyline near point 17. Then pick beyond the property. Press Enter to end.

Before you annotate the electric utility line, you must offset it 25' on both sides, for a 50' total right-of-way. You will do this using Standard Offset. Select the Offset>Standard Offset command under the Edit menu. Enter the offset distance of 25. Pick the electric utility polyline and then pick to one side for the first offset. Repeat for the other side, by first picking the electric utility polyline, then picking the other side for the offset. Press Enter to end.

Now annotate the central electric line with an E by selecting the Line Types command on the Annotate menu, then choose Standard Offset. Choose the Electric linetype, which appears on the second page of linetypes. Then select the electric utility polyline to annotate it, and press Enter.

18 Next, make the Property lines bold. Under the Edit menu, select Polyline Utilities, then Edit Polyline and then select Change Polyline Width.

New Width <0.0>: 1.5
Select objects: pick the property polylines while holding down the Shift key Pick once for the fence line portion and once for the remaining property lines.
Select objects: press Enter to end

19 To add color and improve layer management, make a layer for your road and driveway. Select the Layer Control command on the View menu.

Click the New Layer button, and enter the name "Road" for the new layer. Choose the color cyan by clicking the color square to the right of the layer name. Click OK.

On the View menu, select the Change Layer command.
Select entities to be changed.
Select objects: with Shift key held down, pick all driveway and road entities and press Enter

This brings up the dialog box shown below. Select ROAD and click OK.
Your linework is now complete and is shown below:

If you have not already saved your drawing, now is a good time to do it. Use the Save command on the File menu, and call the file Lesson2.dwg.

You will add symbols for trees, property corners, manholes and a light pole.

20 You will add symbols for trees, property corners, manholes and a light pole.

Start with the trees. Points 11, 12, and 20 are oak trees of different sizes, and point 14 is a pine tree. Use symbol 61 for the deciduous oak trees and symbol 53 for the pine tree. On the Draw menu select Symbols. Then select the Insert Symbols command. The following dialog box appears.
Click the Select button, and within the Select Symbol dialog box, use the down arrow at the right to scroll forward to the tree symbols, which are several pages deep. Choose symbol SPT61. You can also choose Trees under the Symbol category field in this dialog. You are returned to the Insert Symbols dialog box.

Click the Select Layer button, and type in TREES in the Layer Name field. This creates a Trees layer if one does not exist. Click OK. For the Symbol Size use 18. A symbol size equal to the diameter of the tree is often effective. Click OK.

Options/Select entities/Enter Coords/<Pick point or point numbers>: 11
Options/Select entities/Enter Coords/<Pick point or point numbers>: 20
Options/Select entities/Enter Coords/<Pick point or point numbers>: press Enter

Place symbol 61 on the larger point 12 at size 24. Press Enter to repeat the last command, or once again select the Insert Symbols command from the Draw menu. Symbol 61 will now be the default. Change the Symbol Size to 24 and click OK.

Options/Select entities/Enter Coords/<Pick point or point numbers>: 12
Options/Select entities/Enter Coords/<Pick point or point numbers>: press Enter

Place symbol 53 on the larger point 14 at size 8. To do this, press Enter to repeat the last command, or select Insert Symbols from the Draw menu. Select symbol 53 and a Symbol Size of 8. Click OK.

Options/Select entities/Enter Coords/<Pick point or point numbers>: 14
Options/Select entities/Enter Coords/<Pick point or point numbers>: press Enter

Place symbol 5 (representing an iron pin) on points 8-10 and point 15. Repeat Insert Symbols by pressing Enter to repeat the last command, or again select the Insert Symbols command from the Draw menu. Select symbol 5 (first page) and leave the Symbol Size of 8. Change the layer to FINAL. Click OK.

Options/Select entities/Enter Coords/<Pick point or point numbers>: 8-10,15
Wildcard match of point description <*>: press Enter
This puts symbols on points 8 through 10, as well as point 15.
Options/Select entities/Enter Coords/<Pick point or point numbers>: press Enter
Place a concrete monument (symbol 13) on point 13 on layer FINAL. Keep the Symbol Size of 8. Press Enter to repeat the last command, or select the Insert Symbols command from the Draw menu. Select symbol 13.

Options/Select entities/Enter Coords/<Pick point or point numbers>: 13
Options/Select entities/Enter Coords/<Pick point or point numbers>: press Enter

Place a manhole (symbol 34) on the vertices (endpoints) of the sewer line, at points 52 through 54. You could use the above method, but you can also use S for Select entities, and place the symbol automatically at the vertices of the selected entity.

Select the Insert Symbols command from the Draw menu. Select symbol 34 from the list. Keep with layer FINAL and Symbol Size 8. Click OK.

Options/Select entities/Enter Coords/<Pick point of point numbers>: S
The following dialog box appears. Click OK.

Select arcs, circles, faces, points, text, lines and polylines.
Select objects: pick the sewer polyline

The symbols are inserted at the three polyline endpoints.

21 You can reduce clutter by selecting the Freeze Layer command under the View menu, and picking a point number. The points freeze, leaving only linework and symbols. To bring the points back, use the Thaw Layer command under the View menu. The Freeze Layer and Thaw Layer commands go together, just like the Isolate and Restore Layers commands.

22 Next, you will create (in reduced size) your building dimensions. You can set the building dimension text size for the current work session using the Survey Text Defaults option of the Survey Text command on the Annotate menu. However, you can set the text size permanently using the Configure command on the Settings menu, then selecting the Configure command. Use this last method. This dialog box appears:
Select Survey Settings and the following dialog box appears:

Choose Survey Text Defaults. The following dialog box appears:

The changes you will make are in the upper-left section "Building Dimensions." Change the Text Size Scaler to
0.04, change Offset From Line to 0.02, and select Drop Trailing Zeros.

The Drop Trailing Zeros option will label 17.0' as 17'. To save more space, you could blank the Characters to Append box, but not this time. Enter the name of a new layer for the building text called BTXT, so that building dimensions can be frozen to reduce the clutter even more. It is generally a good strategy to use layers for selective freezing and thawing.

Click OK on the above dialog box, then click Exit until you return to the command prompt. On the Annotate menu, choose the Survey Text command, Building Dimensions option. Click on the middle of the bottom segment of the building and then drag the alignment to the right, along the same bottom segment being dimensioned. The resulting label is shown below.

If you had dragged the cursor to the left rather than to the right, with the same near-parallel angle to the line, the 83' would be drawn below the building rather than above.

Another example is shown below. Select Annotate > Survey Text > Building Dimensions, and click on the left-most segment of the building. Then click roughly perpendicular to the left. This creates a perpendicular, rather than parallel, label as shown below.
Label the rest of the building. Notice that the sides of the building that you are dimensioning are measured in even feet. Because you had selected the Drop Trailing Zeros option when you set your Survey Text Defaults, and you set the Decimal Places default at 0.0, the ".0" is not reflected in the labels.

If you choose the wrong direction while you are labeling, you can exit the command, or you can erase the incorrect dimension by typing E for erase at the command line, or you can enter U for undo to back out your last work. Once the labels are in place, you can type M for the Move command, and move the text to the desired position.

Next, you will label the offset dimension from property lines to two building corners, the SE corner as offset from the south property line, and the SW corner as offset from the west property line. Because of the options you set in the Survey Text Defaults dialog box above, Offset Dimensions will be created on layer DTXT, and they will be horizontal, with arrowheads.

On the Annotate menu select Survey Text, Survey Text Defaults. The dialog previously shown will reappear. Change the Text Size and Arrow Size Scalers to 0.040. Then select Dual Arrows Line and click OK. On the Annotate menu, select Survey Text, Offset Dimensions option.

[**end on**] Pick Bldg/Object Corner: **pick on the SE building corner**
[perp] Pick Line To Offset From: **pick on the South property line** (before the arc, near the end of the driveway)

The setback is labeled 43.5 ft. Why "ft" and not " " for distance? If you review the Survey Text Defaults dialog box again, you will see that you set the Characters to Append option to "ft".
On the Annotate menu, select Survey Text > Survey Text Defaults. Under Offset Dimension Text, change the characters to Append to an apostrophe, "'". Also, change the Text Alignment to Parallel instead of Horizontal. Click OK. Select Annotate > Survey Text > Offset Dimensions.

[**end on**] Pick Bldg/Object Corner: *pick on the SW building corner*
[**perp**] Pick Line To Offset From: *pick on the West property line (avoid the electric right-of-way line)*

Use the Move command to move the 20' text label to the right, so that it is not overwritten by the offset dimension. The result is shown below:

![Diagram showing offset dimensions and adjoiner text placement](image)

Notice the display, within the above prompts, of the [**end on**] and [**perp**] snaps. When Carlson sets a snap for temporary use, it displays the snap within the brackets as shown. A building corner is always an endpoint, so the end snap always applies to the first pick. The offset is the perpendicular distance to the property lines, so the [**perp**] snap always applies to the second pick. The per, or perpendicular, snap applies to offsets from arcs as well. In the case of arcs, the per snap finds the shortest, radial distance to the arc.

When you enter a snap at the keyboard in response to a "Pick object" request, type only the first 3 letters of the snap, such as "per" or "end". You could use the Offset Dimension command to label the Electric utility right-of-way distance of 50' total by entering "nea" (for nearest snap) for the first pick, then entering the default "per" snap for the second pick on the other side of the right-of-way.

24 Next, you will add adjoiner ownership text to the property lines. Select the Survey Text Defaults command, under the Annotate menu, and set the Adjoiner Text Justification option to C for centered, and the Text Size Scaler to 0.06. Click OK and then select the Adjoiner Text option on the Annotate > Survey Text command.

**Pick Line Or Polyline**: *pick the west property line*

**Pick Starting Point**: *pick a centering point west of the property for the adjoiner text*

**Text**: Brian W. and Mary T. Jones

**Text**: D.B. 101, P. 37

**Text**: press Enter twice

This produces parallel, center-justified text on the west side of the property. Repeat the command for the north side. Press Enter to repeat the Adjoiner Text command or select it from the menus.

**Pick Line Or Polyline**: *pick the north property line*
**Pick Starting Point:** pick a centering point north of the north property line  
**Text:** Stan W. Bosworth  
**Text:** D.B. 94, P. 272  
**Text:** press Enter twice

The results are shown here:

25 Next, you will add bearing annotation. Select the Annotate menu, choose Angle/Distance, select the BearingDistance option to place Bearing and Distance above the line.

**Define bearing by, Points/<select line or polyline>**: pick the northern property line to the east, or right side The bearing direction will be labeled towards the picked end, which is northeast.

**Define bearing by, Points/<select line or polyline>; pick the eastern property line** Pick closest to the southern endpoint of the line

To label the western property line on the lower (western) side of the line, select the BearingDistance option of the Angle/Distance command.

**Define bearing by, Points/<select line or polyline>; pick the western property line** on the northern portion of the line

To label the southern line segment with a leader, on the Annotate menu select the Annotate w/Leader command, Brg-Dist w/Leader option.

**Options/Points/<Select line or polyline>; pick the southern property line segment** on the southwest side

**Pick point to start leader:** pick a point to start and locate the pointed end of the arrowhead

**Pick next leader point:** pick a point Pick a point off to the right for the left-justified bearing and distance

**Pick next leader point (Enter to end):** press Enter

**Options/Points/<Select line or polyline>; press Enter** to end

26 Next, you will want to annotate the arc in the drawing. The label will consist of four entries: arc length, radius, chord bearing (angle) and chord distance.
Select the *Annotate Arc* command, on the Annotate menu, and choose the *Stack Label Arc* option. The Stack Label Arc dialog box appears.

Set the sequence column to 1, 2, 3 and 4 as shown. Remember that changes to this box apply only to this work session. To set these options permanently, go to the Settings menu, choose *Configure > Survey Settings* > and choose the *Stack Label Arc* command. When you are done with the dialog box, click OK.

**Define arc by, Points/<select arc or polyline>:** *pick the arc*

**Pick point for labels:** *pick a point* to the right to place the label

As the cursor moves, the text "ghosts", allowing you to make the best possible placement decision

**Pick point to start leader at ([Enter] for none):** *pick a point on or near the arc* for the arrowhead

**Define arc by, Points/<select arc or polyline>:** *press Enter* to end

Sometimes Carlson displays an arc as a series of chords. Type Regen at the command prompt to "regenerate" the arc. Even if an arc shows up on the screen as a group of jagged chords, it will plot as a smooth arc to a printer or plotter.

27 Next, you will label the trees, the shed, and the building using a special leader, for a hand-drafted appearance. Under the Annotate menu, select the *Special Leader* command.

**Options/Pick Arrow Location:** *pick near the southern most corner of the shed*

**Text location:** *pick slightly down and to the right*

**Text:** *Shed*

**Text:** *press Enter twice* to end

Repeat the process for all the special leader text items shown in the drawing below. In the case of the 18" Oak trees, create just one leader with text, and on the second oak tree, create only the leader, and then press Enter when asked for Text. For the best appearance, enter 18"Oak and 24"Oak with no spaces between the characters.

Your drawing should be similar to this one:
28 You can add a North Arrow and Bar Scale by selecting these options under the Annotate menu. When you place the North Arrow, pick your North Arrow symbol, maybe change the scale, and click OK. Then pick an insertion point. You place the Bar Scale by answering the prompts and picking a location. Both the North Arrow and the Bar Scale can be moved to desired locations with the Move command on the Edit menu.

29 Next, you will insert a title block with a border. Select the Title Block command from the Settings menu.
Choose paper size A1 (portrait view, 8-1/2 by 11). Click OK. Pick a point below and to the left of the survey in order to locate the lower-left corner of the border outer line. Remember that the title block will be at the bottom, so leave extra room at the bottom.

The following dialog appears, prompting you for the attributes of the title block. Be sure to also click Next in order to enter in more attributes.

![Enter Attributes dialog]

Your drawing should resemble the one shown below.

![Drawing example]
30 Next, you will add a legend. On the Annotate menu, select the *Draw Legend* command. Choose the New tab, then Open the default legend name. When the dialog box appears, select Add from Drawing. You will make one pick for each symbol you want to appear in the legend. So, with the Shift key held down, select one of the sewer manholes, one of the iron pins, the concrete monument, one oak tree and the pine tree. Press enter. You will then see the symbols that you picked listed.

If you want to change the order of the items in the list, use the Move Up and Move Down buttons, after first selecting and highlighting the item to be moved. After the list is ordered correctly, highlight one item on the list and click the Edit button to edit the symbol definition.

Edit each symbol definition individually, typing the following descriptions in the description box:

SPT5 = "Iron Pin"
SPT34 = "Manhole"
SPT13 = "Concrete Monument"
SPT 61 = "Oak Tree"
SPT53 = "Pine Tree"

Below is the symbol definition, with Description, for SPT13.

![Symbol Definition](image)

After you have entered the descriptions for the symbols, choose the Add option from the Legend Definition dialog box, and add the Fence Line type to the list by picking the Select Linetype command, as shown below:
Save the completed legend, which is shown below.

Select the Draw option from the Legend Definitions dialog box. Set the defaults as shown below.
Click OK. Pick a point for the legend, at roughly 5260,4380. Then click Exit.

You may need to move the fence line portion of the legend to fit in the tight space. You also may need to move the previously drawn bar scale. Use the *Move* command to do this. The following shows the drawing to this point:

![Drawing of the legend and bar scale]

If you wish to reset the spacing of the sewer and electric utility annotation, use the LTSCALE box in the Drawing Setup dialog box, under the Settings menu, to set it. (The setting is 50, in this example).

31 Next, you will use Dtext to label the road and Mtext to create a certification block. Zoom in on the area shown below. At the command line, type Dtext.

**Specify start point of text or [Justify/Style]:** R (for right-justified)

**Specify right endpoint of text baseline:** *pick a point* as shown below, just to the left of the leader annotation

**Specify height <8.00>:** 10

**Specify rotation angle of text <E>:** *pick a point* as shown below by the location of the crosshair

Text: Meadow Lane
Text: press Enter

This right-justifies the label Meadow Lane, ending it before it contacts the leader line.

Now you will enter a certification using Mtext. The Mtext command stretches an entire block of text. This command breaks up the lines in the block of text, depending on how you edit and adjust the Mtext window. First, use the View > Extents command to view the entire drawing. Then, at the command line, type in Mtext.

Specify first corner: pick a point in the 5660,4980 range
Specify opposite corner or [Height/Justify/Line spacing/Rotation/Style/Width]: pick a point below and to the right of the first, but inside the inside border line.

You now see a dialog box that displays all the text heights that you have used in the drawing. Choose the text height of 8. Then type the following into the dialog box:

```
Surveyor’s Certification
I do hereby certify that the survey shown hereon was performed under my direction by method of random traverse, and that the error of closure was 1:52544

Brad Smith  PLS No 11952
```

The command adds carriage returns to the text when it runs out of space in the Mtext window. Click OK at the upper right to place this text into the drawing.

After the Mtext is plotted, you can click on the text to activate the grips. All 4 corners highlight as grips. Pick on a grip, and then you can expand or change the shape of the Mtext rectangle. When you do this, the text adjusts automatically, adding more lines and carriage returns, or condensing many lines into fewer, but longer, lines of text. You can also move the entire text block to a new location.

32 Next, you will define a text style, then add text using that style. On the Draw Menu, under Text, choose select the Set Style option. The Text Style dialog box appears. Click New, enter Bold in the New Text Style dialog, and click OK.
Create a Bold Style consisting of the Arial Black font tilted at a 10 degree oblique angle, by entering the settings as show below.

Then click Apply and Close. Now, run the Dtext command by typing Dtext at the command line, and place the text at the top of the drawing as follows:

**Specify start point of text or [Justify/Style]:** pick a point near the northwest corner of the drawing  
**Specify height <10.00>:** 20  
**Specify rotation angle of text <N 54d40'16'' E>:** E for due East  
**Text:** William T. Farmer  
**Text: press Enter twice**

33 Next, you will create an area label for the drawing. Select the Area Defaults command, under the Area/Layout menu, and change the Precision for Other Area Labels to 2 decimal places.

Select the **Areas by Lines & Arcs** command, under the Area menu. When prompted to Select objects, pick the 2 polylines that, taken together, completely enclose the property.

Pick an area labeling centering point for the area label under the William T. Farmer title at the top of the drawing.

34 Next, bring the points back and draw a contour map. To draw the points, use the **Thaw Layer** command under the View menu. If you did not complete this lesson in one sitting, then Carlson won't "remember" what layer to thaw. In that case, select the **Layer Control** command on the View menu, and thaw the PNTS layer by turning the snowflake to a sun symbol.

Go to the Surface menu and select the **Triangulate & Contour** command. Click the Contour tab.
In this Contour tab section, change the contour interval to 1.0. Now click on the Triangulate tab, then click on Use Inclusion/Exclusion Areas. Press OK and then answer as follows:

**Select the Inclusion perimeter polylines or ENTER for none.**  
*Select objects:* press Enter  
We have no "inclusion" perimeter.

**Select the Exclusion perimeter polylines or ENTER for none.**  
*Select objects:* select the building and the shed while holding down the Shift key, then press Enter  
Since the building and shed are closed polygons acting as exclusion perimeters, the contours will not pass through them when they are created.

**Select the points and barrier lines to Triangulate:** select a window around the points by picking from the lower left to the upper right

The contour map is created. Freeze the points again by using View > Freeze Layer and picking one of the points.

Next, label the contours. Select the Contour Elevation Label command from the Surface menu > Contour Labels. Select OK after matching the settings in the dialog box shown here:
Now pick two points that cross through one or more contours. The contours are automatically labeled using the current text style. You can use the Change Text Font command, part of the Text command in the Edit menu, to change the font to Romans, or to another font, if you wish to.

The Completed Plat is shown here:

![Completed Plat Image]

If you have not saved your drawing for awhile, now is a good time to do it. Use the Save command on the File menu.

36 Now we are ready to plot the drawing.
Before plotting it's a good idea to do a Zoom Extents, then a Zoom Out (both on the View Menu) before executing the plot command.

To get started, choose Plot from the File menu. There are many variables that can affect how the dialog box will look, such as what version of AutoCAD you are using. Here is a common Plot dialog box:

With this layout, you have two tabs on the dialog labeled "Plot Device" and "Plot settings". We will start with "Plot device". The first thing to select is your plotting device (see arrow #1). Here DWF6 ePlot.pc3 is already selected, and that is what we want to use. Next, arrow #2 points to the "What to Plot" section. In this version of AutoCAD, you are either working in the model tab or one of the layout tabs. Our example is drawn in the model tab, so the option labeled "Current Tab" should be selected. If you want more than one copy of your plot, this is where you would change that number. Arrow #3 points to the plot settings tab. Click on here next. Now the dialog should look like this:
Now we are on the "Plot settings" tab. Arrow #4 points to where you can change the paper size and units. Here we chose 8.5 X 11 for our size and inches for our units. The next thing to select is the drawing orientation, arrow #5 shows you where this is. We will choose portrait.

Now looking at arrow #6, we want to choose the window button in order to select the area we want to plot. After you select this button, the dialog will disappear and you can select the upper left and the lower right corners of the drawing border. When you finish, the dialog will reappear.

The next thing to do (arrow #7) is choose the correct plotting scale, our drawing is 1"=100' or 1:100. Choose this from the dropdown list. Now we are ready to preview the plot. Press the Full Preview button in the lower left corner of the main dialog. Press ESC to return to the main dialog. One new feature starting in AutoCAD 2000 is the ability to save all the information you have just entered in a "Page Setup". In the upper part of the dialog, check on the box labeled "Save changes to layout", then to the right of that, click the button labeled "Add". A new dialog will appear, at the top of this dialog, enter a name to save your page setup as and click OK. I chose 8.5 X 11 STD. You can see this in the dialog shown above. If your plot preview looked OK, choose OK from the bottom of the dialog and your plot is on its way. The advantage to saving the page setup is that you can open this drawing tomorrow or 3 weeks later and choose 8.5 X 11 STD as your page setup, and then choose OK to plot the drawing exactly like you did today, without having to remember all the settings yourself.

This completes the Lesson 2 tutorial: Making a Plat.

**Lesson 3: SurvNET**

This tutorial is divided into two lessons covering the process of reducing and adjusting raw survey data into final adjusted coordinates, using the SurvNET program. The tutorial will describe the reviewing and editing of the raw data prior to the processing of the raw data. Next, the least squares project settings will be described, and then the
final report generated from the least squares processing will be reviewed. This tutorial will review both a total station only project, and a project that combines both total station and GPS vectors.

The raw data files associated with this tutorial is located in the Carlson2008\Data folder, under the installation folder on your computer (example: \Carlson2008\DATA).

**Lesson One - Processing an Assumed Coordinate System 2D Total Station Network**

1. The easiest way to start the program is to select *SurvNET* from the Survey menu. This opens the SurvNET window and program.

2. The first step is to open an existing project or create a new project. We will open an existing project. Choose *Open Project* from the File menu. Navigate to the \Carlson2008\DATA\ folder and open the SurvNetTut01 project.
Learning the meaning and implications of the different project settings is the most critical initial step in learning how to use SurvNET. Let's review the different project screens. Choose *Project* from the Settings menu.

**Least Squares Settings**

The Network Least-Squares Settings dialog box is displayed. In this dialog, the different settings required for the Least Squares reduction are available in the different tabbed dialog boxes. When all of the settings are set as desired, press OK to save the changes to the project settings, or press Cancel to return to the raw data editor without saving any project settings. For the purpose of this tutorial, the Coordinate System settings tab should look as follows before proceeding to the next step. To use an assumed coordinate system, the 'Local' Coord. System...
needs to be checked, and the 2D,1D Adjustment Model must be chosen. When using a local coordinate system, the distance units are not important other than for display purposes in the report. Computing elevation factors and performing Geoid modeling is not applicable to assumed datums. Notice that in this example we are not performing a vertical adjustment.

For more information on the content of this dialog box section, please review the SurvNET chapter of this manual.

5 Choose the 'Input Files' tab. This is the section of the Settings dialog box where you define the data files that make up the project. You can have multiple raw files in a single project. The ability for multiple raw files allows flexibility in collecting the data and processing large projects. It is typically easier in a large project to analyze and edit subsets of the total project, before combining all the data for a final adjustment. Notice that since we are working in a local coordinate system and using the 2D,1D Adjustment Model, GPS vectors cannot be incorporated into this project.

Note: The sample tutorial project has the input raw file in the default data folder of C:\Carlson2008\DATA. If you have a different data directory, then set the correct data file by highlighting the default file, pick Delete and then pick Add and select SurvNetTut01.rw5 from your data folder.
Choose the Preprocessing tab to review the least squares preprocessing settings. For the purpose of this tutorial, the Preprocessing settings should look as follows before proceeding to the next step. Preprocessing consists of reducing and averaging all the multiple measurements, applying curvature and refraction correction, reducing the measurements to grid if appropriate, and computing unadjusted traverse closures if appropriate. Much of the data validation is performed during the preprocessing step.
For more information on the content of this dialog box section, please review the SurvNET chapter of this manual.

7 Choose the Standard Errors tab to review the standard error settings. The standard error settings should look as follows before proceeding to the next step. Standard errors are an estimate of the different errors you would expect to obtain based on the type of equipment and field procedures you used to collect the raw data. For example, if you are using a 5 second theodolite, you could expect the angles to be measured within +/- 5 seconds (Reading error).

8 Choose the Adjustment tab to review the Adjustment settings. The Adjustment settings should look as follows before proceeding to the next step. The Adjustment settings affect how the actual least squares portion of the processing is performed. Additionally, from the screen the user can set whether ALTA reporting is performed.
Choose the Output Options tab to review the output settings. For the purpose of this tutorial, the Output Options settings should look as follows before proceeding to the next step. These settings apply only to the output of data to the report files. These settings do not affect computational precision. Press OK to return to the main SurvNET screen.
General Rules For Collecting Data for Use in Least Squares Adjustments

Least squares is very flexible in terms of how the survey data needs to be collected. Generally speaking, any combination of angles and distances, combined with a minimal amount of control points and azimuths, are needed. This data can be collected in any order. But there needs to be at least some redundancy in the measurements.

Redundant measurements are measurements that are in excess of the minimum number needed to determine the unknown coordinates. Redundancy can be created by including multiple GPS, and other control points, within a network or traverse. Measuring angles and distances to points in the network that have already been located create redundancy. Running additional cut-off traverses, or additional traverses to existing control points, creates redundancy. Following are some general rules and tips in collecting data for least squares reduction.

- Backsights should be to point numbers. Some data collectors allow the user to backsight an azimuth not associated with a point number. SurvNET requires that all backsights be associated with a point number.
- There has to be at least a minimum amount of control. There has to be at least one control point. Additionally, there needs to be either one additional control point or a reference azimuth. Control points can be entered in either the raw data file, or there can be a supplemental control point file containing the control point. Reference azimuths are entered in the raw data file. The control points and azimuths do not need to be for the first points in the raw file. The control points and azimuths can be associated with any point in the network or traverse. The control does not need to be adjacent to each other. It is permissible to have one control point on one side of the project, and a reference azimuth on the other side of the project.
- At least one of the control points needs to be occupied. There may be situations where no control point is ever occupied in the network, but only backsighted. In these situations, a preliminary value for one of the occupied points needs to be computed and entered as a floating point control point.
- Some data collectors do not allow the surveyor to shoot the same point twice using the same point number. SurvNET requires that all measurements to the same point use a single point number. The raw data may need to be edited after it has been downloaded to the office computer to insure that points are numbered correctly.
- The majority of all problems in processing raw data are related to point number problems. Using the same point number twice to different points, not using the same point number when shooting the same point, misnumbering backsights or foresights, and misnumbering control points are all common problems.
- It is always best to explicitly define the control for the project. A good method is to put all the control for a project into a separate raw file. A big source of problems with new users is a misunderstanding in defining their control for a project.
- Some data collectors may have preliminary unadjusted coordinates included with the raw data. These coordinate records should be removed from the raw file. The only coordinate values that should be in the raw file are the control points.
- When a large project is not processing correctly, it is often useful to divide the project into several raw data files and debug and process each file separately as it is easier to debug small projects. Once the smaller projects are processing separately, they can be combined for a final combined adjustment.

Reviewing and Editing the Raw data

Chapter 2. Tutorials 91
To review or edit the raw data, choose the *Edit Raw Files* command from the Tools menu.

If there are problems with the raw data, such as point numbering problems or incorrect rod heights, the raw data can be edited from this dialog. See the section on the raw data editor in the Carlson documentation to learn the details of the editor. Review the following *Standard Errors and Control Points* section before exiting the raw data editor.

**Standard Errors and Control Points**

The default standard errors for points are defined in the Standard Errors sheet of the Settings dialog box. There are times when the default values may need to be overridden. For example, the control may be from GPS and the user has differing standard errors for his various GPS points. Or maybe some of the control points were collected with
RTK methods, and other GPS points collected with more accurate static GPS methods. Standard error for individual points can be inserted into the raw data file. The following is the menu option used to insert standard errors into the raw file. Notice in the above raw data file that points TR1 and TR100 are the control points for this project. Also, notice there is a standard error record, CSE, preceding the control points.

The CSE record has the character '!' in the N,E,& Z field. The character '!' designates that all following control points will be fixed. Points that are fixed will not be adjusted during the adjustment. Placing a very small standard error on a control point is almost equivalent to fixing the point. Points can also be designated to be floating points by using the '#' character. The only practical use of creating a floating point is if SurvNET cannot compute preliminary coordinates because no control point is occupied. The surveyor can compute a preliminary value for one of the occupied points, and insert that point as a floating point. The floating point will be adjusted, and no weight will be given to the floating coordinate values.

Standard error records effect all the records that follow the standard error record. To revert the standard errors back to the default values, a CSE record can be inserted containing the '*' character. In the following example, point TR1 has been designated as a fixed point. TR100 has a north standard error of .02 and an east standard error of .01. Following the TR100 point record there is a CSE record containing the '*' character. So, if there were any control points further down in the raw data file they would use the default standard errors as set in the project settings dialog box.
There may be times when non-control standard errors need to be overridden for certain measurements. For example, if fixed tripods were used for backsights and foresights for part of the traverse, and hand-held rods were used for another portion of the traverse, it would be appropriate to have differing 'Rod Ctr' standard errors for the different sections of the raw data.

Standard errors for angles and distances can also be inserted into the raw data file using the Add menu options Setup Standard Error and Measurement Standard Error. The standard errors set by these inserted records override the default standard errors. In the following example, a setup standard record, SSE record, has been inserted in record 12. The SSE record effects all setup data that follow until another SSE record is inserted. In the following example, the foresight rod centering error is set to .005, the total station centering error is set to .005, the total station measure-up error is set to .005 and the foresight measure-up error is set to .005.
The following is another example where it would be appropriate to insert a measurement standard error record, MSE, into the raw data. If two different total stations with different accuracy specifications were used to collect the data, it would be appropriate to have different standard errors for the different sections of the raw file, depending on which total station was used to collect the data. In the following example, a MSE record has been inserted for record 27. The horizontal pointing and reading error has been changed to 5 seconds, and the vertical pointing and reading error has been changed to 10 seconds. The inserted MSE record will effect all following raw data until another MSE is inserted.

Least Squares Processing
After exiting the raw data editor, we are ready to perform the least squares adjustment. From the Process menu, choose the Network Adjustment option.

The least squares adjustment is performed, and the results from the adjustment are displayed. If the solution converged correctly, the report should look similar to the following window. If there were errors or the solution did not converge, an error message dialog will be generated.

If there are errors, you will need to return to the raw data editor to review and edit the raw data. Since the tutorial example should have converged, we will next review the reports generated by the least squares adjustment. There are four windows created by the least squares program during processing. These files include the .err file, which contains any errors or warnings that were generated during processing. The .rpt file is the primary least squares report file summarizing the data and the results from the adjustment. An .out file is created containing a listing of the final coordinates. There is also a Graphics window that is displayed. The graphic window is temporary and useful only for seeing the results of the survey. To bring up the Graphics window, choose under the Window menu the Graphics command, or click the View Graphics icon on the toolbar.

Relative Error Ellipses

Relative error ellipses are a statistical measure of the expected error between two points. Regular error ellipses are a measure of the absolute error of a single point. Some survey accuracy standards such as the ALTA standards state the maximum allowable error between any two points in a survey. Relative error ellipses can give you
13 Press the Relative Error Ellipse toolbar icon button, or choose, off of the Tools menu, Relative Error Ellipse. Enter TR3 and TR7 in the From Pt. and To Pt. fields. Press OK to calculate. The dialog box should look as follows.

At the 95% confidence level there should only be around .02 feet of error between points TR3 and TR7. If you need to compute relative error ellipses for sideshots make sure the "Enable sideshots for error ellipse" toggle is set in the Adjustment tab of the Settings/Project dialog box.

Review of the Least Squares Report

14 In this section, the different sections of the least squares report are explained. If the Least Squares Report is not already showing, choose the Window menu and select the Least Square Report item. The report viewer has tabs to quickly access different sections of the report.

Preprocessing and Header Information

The following excerpt from the report shows the header information and the preprocessing results. The header information consists of the date and time, the input and output file names, the coordinate system, the curvature/refraction setting, maximum iterations, and distance units.

During the preprocessing process, multiple angles are reduced to a single angle and multiple slope distances, vertical angles, HIs, and rod heights are reduced to a single horizontal distance and vertical difference. During this process the horizontal angle, horizontal distance, and vertical difference spreads are computed. If the spreads exceed the tolerance settings from the Settings dialog box, then a warning message is displayed showing the high and low measurement and the difference between the high and low measurement.

Chapter 2. Tutorials 97
Unadjusted Measurements

The following excerpt from the report shows the unadjusted measurements. Measurements consist of some combination of control X, Y, horizontal distances, horizontal angles, and azimuth measurements. These measurements consist of a single averaged measurement. For example, if multiple distances were collected between two points during data collection, only the single averaged measurement is used in the least squares adjustment.

Also, standard errors for the measurements are displayed in this section of the report. The standard errors are computed from the standard error setting in the Settings dialog box using error propagation formulas. The standard error of an angle that was measured several times would typically be lower than an angle that was measured only once.

If the data had been adjusted into NAD 83 coordinates both the ground distances and the grid distances would be displayed. The grid, elevation, and combined factor would also be displayed in this section of the report.
Adjusted Coordinates
The next section of the report shows the final adjusted coordinates. Additionally, the computed standard errors of the coordinates are displayed. If this project was reduced to NAD 83, the final latitude and longitudes are also displayed. Error ellipses computed to the 95 percent confidence interval are also displayed.

Adjusted Measurements
The following section from the report shows the final adjusted measurements. This section is one of the most important sections to review when analyzing the results of the adjustment. In addition to the adjusted measurement, the residual is displayed. The residual is the amount of adjustment applied to the measurement. The residual is computed by subtracting the unadjusted measurement from the adjusted measurement.

The standard deviation of the measurement is also displayed. Ideally, the computed standard deviation and residual and the standard error displayed in the unadjusted measurement would all be of similar magnitude. The standard residual is a measure of the similarity of the residual to the a-priori standard error. The standard residual is the
measurements residual divided by the standard error displayed in the unadjusted measurement section. A standard residual greater than 2 is marked with an "*". A high standard residual may be an indication of a blunder. If there are consistently a lot of high standard residuals it may indicate that the original standard errors set in the Settings dialog box were not realistic.

<table>
<thead>
<tr>
<th>Adjusted Observations</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Adjusted Distances</strong></td>
</tr>
<tr>
<td><strong>FROM STA. TO STA.</strong></td>
</tr>
<tr>
<td>TR1</td>
</tr>
<tr>
<td>TR1</td>
</tr>
<tr>
<td>TR1</td>
</tr>
<tr>
<td>TR2</td>
</tr>
<tr>
<td>TR2</td>
</tr>
<tr>
<td>TR2</td>
</tr>
<tr>
<td>TR3</td>
</tr>
<tr>
<td>TR4</td>
</tr>
<tr>
<td>TR5</td>
</tr>
<tr>
<td>TR6</td>
</tr>
</tbody>
</table>

| Root Mean Square (RMS) | 0.01 |

<table>
<thead>
<tr>
<th>Adjusted Angles</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>BE STA. OCC. STA. FS STA.</strong></td>
</tr>
<tr>
<td>TR100</td>
</tr>
<tr>
<td>TR300</td>
</tr>
<tr>
<td>TR3</td>
</tr>
<tr>
<td>TR7</td>
</tr>
<tr>
<td>TR7</td>
</tr>
<tr>
<td>TR7</td>
</tr>
<tr>
<td>TR7</td>
</tr>
<tr>
<td>TR7</td>
</tr>
</tbody>
</table>

| Root Mean Square (RMS) | 0.01 |

Statistics

The next section displays some statistical measures of the adjustment including the number of iterations needed for the solution to converge, the degrees of freedom of the network, the reference variance, the standard error of unit weight, and the results of a Chi-square test.

The degree of freedom is an indication of how many redundant measurements are in the survey. Degree of freedom is defined as the number of measurements in excess of the number of measurements necessary to solve the network.

The standard error of unit weight relates to the overall adjustment and not to an individual measurement. A value of one indicates that the results of the adjustment are consistent with the a-priori standard errors. The reference variance is the standard error of unit weight squared.

The chi-square test is a test of the "goodness" of fit of the adjustment. It is not an absolute test of the accuracy of the survey. The a-priori standard errors which are defined in the project settings dialog box or with the SE record in the raw data file are used to determine the weights of the measurements. These standard errors can also be looked at as an estimate of how accurately the measurements were made. The chi-square test merely tests whether the results of the adjusted measurements are consistent with the a-priori standard errors. Notice that if you change the project standard errors and then reprocess the survey the results of the chi-square test change, even though the measurements themselves did not change.

In our example the chi-square test failed at the 95% significant level. Our example failed the chi-square test on the low end, 52.6 is less than 60.5. Failing on the low end indicates that our data is actually better than expected compared to our a-priori standard errors. If we were to decrease the pointing and reading standard error in the Settings screen by 5-10 seconds we would probably pass the chi-square. Also notice that if you change the standard errors by only 5-10 seconds and reprocess the data the final coordinates will not change significantly.
Sideshots

If the "Enable sideshots for relative error ellipses" is not set in in the Adjustment screen of the project settings screen, sideshots are computed separately after the adjustment is completed.

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Bearing</th>
<th>Dist.</th>
<th>N</th>
<th>E</th>
<th>StDev. N</th>
<th>StDev. E</th>
</tr>
</thead>
<tbody>
<tr>
<td>TRL</td>
<td>100</td>
<td>72-22' 23&quot;E</td>
<td>20.06</td>
<td>4693.7449</td>
<td>5019.6883</td>
<td>0.0024</td>
<td>0.0083</td>
</tr>
<tr>
<td>TRL</td>
<td>101</td>
<td>74-30' 43&quot;E</td>
<td>23.26</td>
<td>4863.7863</td>
<td>5022.4128</td>
<td>0.0033</td>
<td>0.0084</td>
</tr>
<tr>
<td>TRL</td>
<td>102</td>
<td>04-55' 59&quot;E</td>
<td>134.11</td>
<td>5123.6541</td>
<td>5010.6728</td>
<td>0.0088</td>
<td>0.0008</td>
</tr>
<tr>
<td>TRL</td>
<td>103</td>
<td>09-19' 36&quot;E</td>
<td>144.50</td>
<td>5063.7459</td>
<td>5010.4993</td>
<td>0.0089</td>
<td>0.0013</td>
</tr>
<tr>
<td>TRL</td>
<td>104</td>
<td>57-42' 43&quot;E</td>
<td>116.78</td>
<td>5045.4450</td>
<td>5006.4090</td>
<td>0.0047</td>
<td>0.0074</td>
</tr>
<tr>
<td>TRL</td>
<td>105</td>
<td>63-39' 22&quot;W</td>
<td>132.17</td>
<td>5061.9176</td>
<td>4861.0026</td>
<td>0.0010</td>
<td>0.0082</td>
</tr>
<tr>
<td>TRL</td>
<td>106</td>
<td>68-32' 48&quot;W</td>
<td>160.16</td>
<td>5061.8696</td>
<td>4842.5590</td>
<td>0.0051</td>
<td>0.0084</td>
</tr>
</tbody>
</table>

If the project had valid elevation benchmarks and measured HI’s and rod heights the project could have been defined to adjust elevations. When using the 2D/1D least squares model the horizontal and the vertical adjustments are separate least squares adjustment processes. As long as there are redundant vertical measurements the vertical component of the network can also be reduced and adjusted using least squares. In the vertical adjustment, benchmarks are held fixed.

This is the final step in the adjustment. The final adjusted coordinates are now stored in the current project point database and can now be used for mapping and design.

Lesson Two - Processing a 3D Network With Both Total Station Data and GPS Vectors

In this lesson we will process a project that contains both GPS vectors and total station measurements.

1. Following is the opening SurvNET window. The first step is to open the project for lesson two. Choose the File/Open Project.. option. Navigate to the \Carlson2008>Data\ subdirectory and open the SurvNetTut02 project.
2 Let's review the project settings. Go to Settings/Project.

In order process GPS vectors, the coordinate system must be set to 'SPC 1983' with the appropriate state plane zone. The 'Coordinate System Adjustment Model' must be set to the 3D Model. With the 3D model, horizontal units and vertical units must be the same in regards to output and total station raw data. Geoid modeling may or may not be important depending on the extent of the project and the accuracies required. The most accurate results are typically obtained by using a 'Geoid File' set to GEOID03.
The project raw data is defined from the 'Input Files' settings screen. Notice that the units need to be specified for both the GPS vector data and the total station raw data. Typically, but not always, GPS vectors are in meters while the total station and the final output may need to be in feet. Also make sure that the correct GPS vector format is correct. Some GPS formats are binary and cannot be edited easily. Sometimes it is needed to edit the GPS vectors usually in terms of point numbers.

Note: The sample tutorial project has the input raw file in the default data folder of C:\Carlson2008\Data. If you have a different data directory, then set the correct data file by highlighting the default file, pick Delete and then pick Add and select GPSAndTS.cgr (C&G format raw file) from your data folder. Do the same for the GPS Vector files of GPSAndTS1.gps and GPSAndTS2.gps.
Though this tutorial does not cover the topic, it is from this screen that you would define the traverse file needed to compute either GPS loop closures or totals station traverse closure. See the manual for further details.

Notice the standard error settings related to GPS. The GPS instrument centering error can be defined. The vector
standard error is a factor that can be used to increase the standard errors as defined in the GPS vector files.

None of the settings in this screen are specific to processing GPS vectors. See the manual for details on the settings in the 'Adjustment' dialog box.
None of the settings in this screen are specific to processing GPS vectors. See the manual for details on the settings in the 'Output' dialog box. Press the OK to return to the main SurvNET dialog box.

Following is the main SurvNET window. To process the data chose the Process/Network Adjustment option.

The project should process and converge and the following windows should be displayed.
Let's review sections of the report that are unique to the processing of GPS vectors and the 3D model.

Unadjusted Observations

control coordinates: 1 observed points, 0 fixed points, 0 approx points

<table>
<thead>
<tr>
<th>sta.</th>
<th>Lat: 40-19 '38.59654&quot;N</th>
<th>Lon: 76-12 '33.03901&quot;W</th>
<th>z (Ellip)</th>
<th>StErr N: 0.0080</th>
<th>StErr E: 0.0080</th>
<th>StErr Z: 0.0043</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grid XYZ</td>
<td></td>
<td></td>
<td></td>
<td>885.21</td>
<td>0.0030</td>
<td>0.0030</td>
</tr>
<tr>
<td>Sta.</td>
<td>N: 339768.1500</td>
<td>E: 2396585.1700</td>
<td>Z (Geoid):</td>
<td>StErr N:</td>
<td>StErr E:</td>
<td>StErr Z:</td>
</tr>
<tr>
<td>200</td>
<td></td>
<td></td>
<td>885.21</td>
<td>0.0030</td>
<td>0.0030</td>
<td>0.0043</td>
</tr>
<tr>
<td>Geocentric XYZ</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sta.</td>
<td>X: 1160984.9395</td>
<td>Y: -4750365.2290</td>
<td>Z:</td>
<td>StErr X:</td>
<td>StErr Y:</td>
<td>StErr Z:</td>
</tr>
<tr>
<td>200</td>
<td></td>
<td></td>
<td>4164024.27</td>
<td>0.0009</td>
<td>0.0009</td>
<td>0.0023</td>
</tr>
</tbody>
</table>

Notice that now that we are working with a specific datum instead of an assumed coordinate system that latitude/longitude, state plane coordinates and geocentric coordinates are all displayed.
In the above unadjusted observations section of the report, notice that distances have been converted to mark to mark distances. Note that vertical angles are now treated as measurements in the 3D model. And lastly, notice that the GPS vectors are also displayed. The GPS vectors are displayed as delta X, Y, & Z in the geocentric coordinate system.

Adjusted Geographic Coordinates

<table>
<thead>
<tr>
<th>Sta.</th>
<th>Latitude</th>
<th>Longitude</th>
<th>2 (Clfns.)</th>
<th>Conv. Ang.</th>
<th>Grid Factor</th>
<th>2 Factor</th>
<th>Combined Factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>200</td>
<td>60-18 38.19634'N</td>
<td>76-12 51.63665'W</td>
<td>868.33</td>
<td>0.00000000</td>
<td>0.99996247</td>
<td>0.99999189</td>
<td>0.99992421</td>
</tr>
<tr>
<td>201</td>
<td>60-18 39.14130'N</td>
<td>76-12 51.67019'W</td>
<td>859.10</td>
<td>0.00000000</td>
<td>0.99996246</td>
<td>0.99999184</td>
<td>0.99992373</td>
</tr>
</tbody>
</table>

Adjusted Grid coordinates, (US Feet)

<table>
<thead>
<tr>
<th>Sta.</th>
<th>E (ft)</th>
<th>Z (Geo')</th>
<th>E (Err M)</th>
<th>E (Err E)</th>
<th>Z (Err Z)</th>
</tr>
</thead>
<tbody>
<tr>
<td>200</td>
<td>39769.1899</td>
<td>2396381.1702</td>
<td>838.21</td>
<td>0.0019</td>
<td>0.0019</td>
</tr>
<tr>
<td>201</td>
<td>39663.3761</td>
<td>2396390.3441</td>
<td>829.70</td>
<td>0.0016</td>
<td>0.0013</td>
</tr>
</tbody>
</table>

In the above adjusted coordinate section of the report, notice that the grid, elevation, and combined factor are displayed with the adjusted geographic coordinates.
In the above adjusted measurements section the adjusted measurements are shown along with their residuals, standard residuals and standard deviation.

This completes the Lesson 3 tutorial title SurvNET.

**Lesson 4: Field to Finish for Faster Drafting**

In this lesson, you will make a plat using field to finish techniques, with the help of the Startup Drawing Wizard.

1. Launch Carlson, or, if you are already in the program, select the File menu, and select New to start a new drawing.

2. Save your existing drawing first, if you'd prefer. If you are asked to use a template, choose carlsonxx.dwt, where xx is the last two digits of the AutoCAD release that you are working with. For example, for AutoCAD 2006, you will select carlson06.dwt.

The first of several Startup Wizard dialog boxes appears. If the Startup Wizard does not appear, then go to the Settings menu, choose *Configure* and then select General Settings. In the General Settings dialog, click Use Startup Wizard in the upper-left and click OK. Then open a new drawing again.
Once in the Startup Drawing Wizard, click Set at the top of the dialog box, and enter in a new Drawing Name. Since this is Lesson 3, call the new drawing Plat3.

Verify that the other settings match the settings shown above, and click Next. You will see the Startup Wizard Data Files dialog. This dialog box is used to specify where to store data, and the existing point information source. Set Plat3.crd as the new CRD file name.

Our source is the same file as in Lesson 2, Plat.txt. This is an ASCII file, so click Next, and in the new dialog box click the option to Select Text/ASCII Files. In the next dialog box, titled Text File to Read, choose plat.txt from the \DATA folder, and then click Open.
The Text/ASCII File Format dialog appears again, and the format of the points appears in the Preview Window, for verification, as shown below. Be sure that to the right of Draw Point, that Draw-Locate Pts is selected. Set the other options as shown. Click OK.

The points are then copied into the file Plat3.crd. If you repeat this exercise, and again use the file name Plat3.crd,
you will be asked:

[O]verwrite w/new coordinates, overwrite [A]ll, or use number <55>: A (for all)

In either case, when you correctly complete the process, the following dialog box appears:

![AutoCAD Message](image)

Then this Drawing Import Wizard dialog box appears:

![Data Import Wizard](image)

Choose the Field to Finish option, and click Next. If you receive a file selection dialog titled Specify Field Code Definition File, choose the file called "Carlson.fld". A dialog box now appears with a warning that some codes have two descriptions.

![Possible Multiple Codes Found](image)

The command is asking whether these codes are to be treated as two separate descriptions, or as one description that has a space in it. Choose the default (Split all multiple codes), to tell the command that codes with spaces are really two separate descriptions, and click OK.

The Draw Field to Finish dialog box appears. Choose the options as shown here. Then click Additional Draw Options.
This displays a dialog box that provide many additional options, as shown below.

You want to draw all 1 through 54. Make sure the other options are set as shown above. Click OK twice.

*Draw Field to Finish* now draws the points and linework. Got to View, and then *Extents* to show the points, as well as the linework and point symbols. *Draw Field to Finish* saves you many manual steps. Your plat is shown below:
To understand how the above drawing was created, select *Draw Field to Finish* again from the Survey menu, and then select the Edit Codes/Points button from the dialog box. This takes you to the Field to Finish dialog box.

The display window shows a list of point codes, such as IP for iron pin and FL for fence line, that are converted to...
special symbols and linetypes by *Draw Field to Finish*. For an example of how the codes are used, look at the sewer line running from point 52 to 53 to 54 (the southernmost point), which is based on a field code of MH. Select MH for Manhole, as shown above, and then click Edit. The following dialog box is displayed.

MH has several attributes that are used by *Draw Field to Finish*, based on the settings shown above. *Draw Field to Finish* draws a manhole using the symbol SPT34. It draws a sewer line with the letter S for sewer. It places the manhole on layer SEWER, and plots a text description of "MANHOLE" underneath the symbol. (Descriptions can be upper or lower case.) When you are done looking at the MH field code definition dialog, click OK.

Other codes have fewer attributes. LP is set only to draw a symbol and text (Light Pole), but not to draw linework. FL, for fence line, is set to draw linework but not corner symbols or points descriptions. A code's attributes depend on the entries in the Set Linetype, Set Symbol, Description and Entity Type options.

The "Carlson.fld" Field to Finish code table is provided with the Carlson software. This table shows one possible system, but with far too many codes for a field crew to remember. You can make your own table by choosing the Code Table Settings option from the Field to Finish dialog box, then choose the Set button at the top right. Then select the New or the Existing tab from the top of the Specify the Code Definition File dialog box, in order to create or select a different code table (.FLD) file.

3 Use the *Layer ID* command, located under Inquiry, to verify the layers of the various plotted entities. Select *Layer ID*. Pick on the fence line, the road and the utility line, and notice the different layers (FENCE, EOP, UTILITY). You should study the layers in a drawing before deciding what to freeze and thaw. To reduce clutter on the screen, select the *Layer Control* command from the View menu. (The appearance of this dialog box might differ from what you see. It varies, depending upon what AutoCAD version is in use.)
Freeze the PNTS layer, the SPOT layer, and the PNTELEV layer by turning the sun into a snowflake. Then click OK.

4 Now you will do some drawing cleanup. Note that a single property line is drawn from point 8 to 9 to 10 and to 15. The chord from point 10 to 15 should be an arc. You will erase the segment from 9 to 10 and from 10 to 15, so that you can re-draw it, establish the tangent, then draw the arc and finish back at point 1.

To eliminate part of a polyline, select the Edit menu, then select the Polyline Utilities command, then Remove Polyline, and then click Remove Polyline Segment.

**Break polyline at removal or keep continuous** [<Break>/Continuous]: press Enter for Break

**Select polyline segment to remove:** Pick the segment from 9 to 10, then the segment from 10 to 15, then press Enter to end

To draw the correct polyline, use the 2D Polyline command under the Draw menu. If you prefer to type in the command, enter 2dp, which stands for 2D Polyline.

[Continue/Extend/Options/<Pick point or point numbers>]: 9
[Arc/Close/Distance/Extend/Options/Undo/<Pick point or point numbers>]: 10
[Arc/Close/Distance/Extend/Options/Line/Undo/<Pick point or point numbers>]: A
[Radius pt/radius Length/Arc length/Chord/Second pt/Undo/<Pick point or point number>]: 15
[Arc/Close/Distance/Extend/Options/Line/Undo/<Pick point or point numbers>]: 1
[Arc/Close/Distance/Extend/Options/Line/Undo/<Pick point or point numbers>]: press Enter

Now erase the plotted traverse line that makes a "V" near the left side of the drawing. Then use the 4-Sided Building command you learned in Lesson 2 to create the other two sides of the shed, located in the upper middle of the screen, near point 17. The end result, except the house, is shown below:
5 Much of the text in the above drawing, such as tree sizes and types, the manhole text, and the light pole text, can be used in the final drawing. But some of the text, such as the text plotted for iron pins and poles, can be fully described in the Legend without the redundancy of plotting to the screen. If you use the Erase command to remove the iron pin and pole text, the entire point will be erased because the attributes are grouped with the point. Instead, use the Erase Point Attributes command under the Points menu.

Select Point No., Elev, or Desc to Erase: Pick the 3 poles and the 4 iron pins

6 Next, you will use Extend by Distance command to create a building. The building will be less complex than the building you created in Lesson 2, but you will learn the "t" and "c" options, in addition to "l" for left and "r" for right. Under Edit, choose the Extend command. Select the By Distance option. Pick the western side of the small line segment west of the 12'' pine and north of the driveway. Follow the prompts:

Pick line or polyline to extend:
"T" or "t" means "total" distance or "to" the distance - so extend "to" 50 feet total.

The Extend by Distance "T" option for total distance solves the dilemma of making an existing line, of unknown length, extend to an exact known length.

7 Use the Twist Screen command to position the plat on the sheet. Not every drawing can be plotted "due North." Sometimes North needs to be rotated so that property lines and important features run nearly left-to-right or top-to-bottom on the plotted page, for a better fit. In this drawing, you want the western line from point 8 to point 9 to run left-to-right on a sheet that will be plotted in landscape style (longer left-to-right than top-to-bottom). Under
the View menu, select Twist Screen, then Line, Polyline or Text.

**Pick a line, polyline or text to make horizontal:** *Pick the western line* from point 8 to point 9, closer to point 9.

Now the drawing appears as shown below:

![Diagram of the drawing](image)

8 Notice that the north indicator (referred to as the USCICON), at the lower left, displays the rotation.

9 Now select Twist Point Attributes, under the Points menu, to twist the point descriptions and point numbers back to a left-to-right rotation.

**Twist by** [<Twist screen>/Azimuth/Entity segment/Follow polyline]? press Enter

Enter angle relative to current twist screen <0.0>: press Enter

Select points from screen, group or by point number [<Screen>/Group/Number]? press Enter

Select Carlson Software points.

Select objects: ALL press Enter

The points then twist back orthogonal to the screen, reading once again left-to-right.

9 The remaining descriptions associated with the points can be used in the final drawing, but they should be moved slightly for a better appearance. For example, the tree descriptions would look better if they were not inside the tree canopies.

Under the Points menu, select Move Point Attributes - Single. The steps of the command are: pick text, pick the new text position, press Enter, press Enter. Then the command repeats. Notice how the text "ghosts" as it moves, which helps you place it in the best position. Try to duplicate this result:
10 Because of the earlier Twist Screen command, the E's in the electric utility polyline are upside down. Choose the Text command, from the Edit menu, and select the Flip Text option. Select the text to flip.

Select objects: pick the upside down E's individually while holding down the Shift key

11 To label the dimensions of the building automatically, you must first activate the Auto Label Closed Polyline Exterior function. To make this a permanent setting, under the Settings menu, select Configure, then Survey Settings, and then Survey Text Defaults. Change the dialog box as shown below:

![Auto Label Closed Polyline Options]

Click OK, and Exit back out. Select Building Dimensions from the Annotate menu, which is under the Survey Text command. Pick on the house. If the text overwrites the inside corner of the house, use the Move command (under the Edit menu, or type M for Move at the command prompt) and move the 30' dimension beneath the line.

12 To automatically annotate bearings and distance, as well as arcs, select the Auto Annotate command from the Annotate menu. When the dialog box appears, under the Lines tab, select the options you would like so that the bearings and distance labels appear as you would like. Then pick the three polylines that fully define the perimeter: the fence line, the polyline containing the arc, and the lower polyline, which is still the western polyline although you have twisted the screen so that it runs along the lower portion of the drawing. Use the Move command to move the bearing and distance labels to avoid overwriting other features.

When you move the lower distance label, 404.90' to the left, you want to move perfectly level to the screen, since this was the line you used to twist the screen, and it runs perfectly left-to-right. To do this, press the function key F8 to activate Ortho. Then pick 404.90' and move it to the left, picking its final position. Repeat this for the S 17°05'38'' E bearing. After you move these items, press F8 again to turn off Ortho. Sometimes you will load a drawing from another client or source, and the Ortho setting has been left on. This may initially confuse you during the Move commands. Press F8 to deactivate Ortho. Notice that F8 works even with Twist Screen active.

13 Auto Annotate typically centers the arc annotation above and below the arc, which causes the arc data to overwrite
the surveyed edge-of-pavement (EOP) polyline. You want to erase both the arc annotations, and use the Label Arc option of the Annotate Arc command to force both the arc length and radius to be drawn beneath the arc.

At the command line, enter E for Erase.

**Select objects:** enter WP, then pick as shown below

*Press Enter* when the selection set is complete. There is no "close" option for window polygon and crossing polygon selections.

For the new annotation, under the Annotate menu, select the Annotate Arc command, then the Label Arc option. Then select the arc from the screen. The Label Arc Settings dialog box appears:
You want to locate the arc text inside the arc, on positions 1 and 2. Position (Row) 1 is just under the arc, and 2 is under 1. Be sure they are both Inside. Fill out the dialog box as shown above, and click OK.

The new arc text might overwrite the 8'' Pine, so, if it does, use the command Move Point Attributes - Single, in the Points menu, to relocate the 8'' Pine description.

With the annotations placed in new positions, your drawing should be similar to the one shown below. Move your annotations to match this drawing.
14 To label the area of the lot, first select the *Area Defaults* command from the Area/Layout menu. Set the Square Units (s.f.) to the nearest whole unit (no decimals) and the Other Area Labels to 2 decimal places. Then click OK to exit the dialog box. Select the *Area by Lines & Arcs* command from the Area/Layout menu, and pick the three polylines individually, while holding down the Shift key, that define the property perimeter. Press enter, and locate the text to the left of the 12" Pine.

15 Before completing the final formatting of your drawing, you need to do some minor cleanup, using procedures you learned in Lesson 2.

You don't want point 16, the PL point, to show in the final drawing. Use the *Layer ID* command, under the Inquiry menu, to verify the layer of point 16, which should be MISC. Freeze MISC using the *Freeze Layer* command on the View menu, and pick point 16. Freeze the point numbers using the *Layer Control* command on the View menu, and freeze the layer PNTNO.

16 To insert an A1, 8-1/2 x 11 border and title block, with the orientation landscape (not portrait), select the *Title Block* command from the Settings menu. You will see this dialog box.

![Create Title Block dialog box]

Be sure these above selections match your own. Click OK. For the insertion point, select a point at the very lower-left of the screen, so that your drawing plan entities fit inside the border and somewhat nearer to the top. Pick your screen location. You will then be prompted for the attributes of the title block. Fill them in and click OK.
If you prefer, you can use the Move command, pick the title block and two border perimeters, and move them. Never move the drawing, because you will change the coordinates if you do. Move the drawing only if changing the coordinate locations does not matter.

17 Select the Draw Legend command, under the Annotate menu, select the Existing tab, choose the .lgd file that you saved in Lesson 2, and click Open. Then select Draw and OK, to close out the dialog boxes that follow, and then click Exit.

Pick an upper-left location point in the available space to the lower-left of the plat. If you did not save a legend in Lesson 2 (or you skipped Lesson 2), follow the steps in that lesson. Use the Scale Point Attributes command, under the Points menu, and scale up the oak tree symbol in the Legend by a factor of 1.5.

Select the Survey Text command from the Annotate menu, then select Survey Text Defaults. Change the Offset Dimension Text alignment to Horizontal. (It may have been set to Parallel in Lesson 2.) Click OK. Now select the Offset Dimensions command from the Annotate menu, under the Survey Text command, and pick the lower right corner of the building, then the lower-most property line (in the current twist screen position). This labels the offset dimension horizontal to the current twist screen.

Pick the Draw North Arrow command, under the Annotate menu, and select and find the north arrow symbol that is shown in the figure below. Change the Symbol Size Scaler, if necessary, and click Specify Rotation On-Screen. Click OK. Then pick an appropriate location and press Enter. Note how the arrow draws due north, respecting the twist screen.

Choose the Draw Barscale command, under the Annotate menu, and pick a location near the lower-left portion of the drawing.

Your drawing should now look similar to this:
Select the **Hatch** command from the Draw menu.

Select the SOLID pattern from the pulldown list, then click the Select Objects button. Pick the house and the shed, and press Enter twice.

To offset the EOP Polyline, first try using the **Standard Offset** command under the Edit menu, and try offsetting the edge-of-pavement polyline that runs roughly parallel to the sewer line. You will see an error message because that object is a 3D Polyline, created by the **Draw Field to Finish** command.
To offset a 3D Polyline, you must use a command specifically designed to offset 3D Polylines. Under the Edit menu, select 3D Polyline Utilities, and slide over to Offset 3D Polyline.

**Enter the offset method [<Interval>/Constant/Variable]:** press Enter
**Vertical/Horizontal offset amount**: 30
**Percent/Ratio/Vertical offset amount <0>:** press Enter

**Select a polyline to offset (Enter for none):** pick the EOP polyline

**Select side to offset:** pick out and away from parcel, for the other side of the road

20 Before you add a title to the drawing, create a text style for the title. Choose Set Style in the Draw menu, found under Text.

![Text Style](image)

Click New, and name the style Title. Choose the font named romant.shx, and then change the oblique angle to 10 degrees as shown. Click Apply, then click Close. Now, to create the title, type Dtext at the command line. Make sure that TITLE is the current text style.

**Specify start point of text or [Justify/Style]:** C
**Specify center point of text:** pick a point near the top-right of the screen

**Specify height <8.00>:** 20

**Specify rotation angle of text <E>:** pick a point to right of first point with <Ortho on>, dynamically stretch right

**Text:** Farmer Survey

**Text:** August 15, 2006

**Text:** press Enter

Select the Text Enlarge/Reduce option of the Text command under the Edit menu. Enter a Scaling Multiplier of .8 and pick the date you just entered.

21 Verify your drawing scale using the Drawing Setup command under Settings. Your drawing should have a
Then label the house "2-Story", "Farm House" (2 lines of labeling), select the Leader with Text command under the Annotate menu.

**Options/Pick Arrow Location:** pick near or on the left side of the house
**To point:** pick off to the left
**Next point (Enter to end):** press Enter

Text: 2-Story  
Text: Farm House  
Text: press Enter

Pick anywhere on the leader. You see two grip squares (usually yellow), one on the left side and one of the right side. Pick on the right grip nearest the house. Move your cursor. Note how the arrow moves. Pick again for the new location, and note how the arrowhead and leader are now located and angled to your specifications.

22 Select the Triangulate & Contour command from the Surface menu. The Contour tab of dialog box should be filled out as shown below:

![Triangulate and Contour dialog box](image)

Click on the Selection tab and fill out to match the following:
Click on the Labels tab and match the following dialog:

Click OK.

Select the Inclusion perimeter polylines or ENTER for none.
Select objects: press Enter
Select the Exclusion perimeter polylines or ENTER for none.
**Select objects:** *Pick the house and the shed.* Since these objects have now been filled, the selection may be a little more tricky. We could (actually should) have placed the solids on their own layer and froze the layer before beginning the contour command. But we can use the fact that Carlson is filtering the objects to get around the problem. When prompted to select the objects, issue the C (for crossing) option, then pick a box that crosses the edge of the filled polylines. Carlson will accept the polyline but reject the fill.

**Select the points and breaklines to Triangulate.** Select a right-to-left window of the property. A right-to-left selection behaves as a crossing, which means that any object that is touched by the window or included inside the window is selected. (A left-to-right selection is a window selection, which means that only objects that are fully enclosed by the window are selected.)

**Select objects:** *pick Window location*
**Other corner:** *pick other location*
**Select objects:** *press Enter to end*
Pick the coordinate file that contains the points, plat3.crd, and click Open.

**Reading points ...**
**Range of Point Numbers to use [<All>/Group]:** *press Enter*
**Wildcard match of point description:** *press Enter*

If the triangulation lines and faces were drawn, freeze them now. Next, pick the lower-left elevation "502" contour near the end. The grips are displayed. The grips near the contour end can be used for stretching. Straighten out the end of this contour line.

** **STRETCH** **
**Specify stretch point or [Base point/Copy/Undo/eXit]:** *pick a grib and pick a point*

** **STRETCH** **
**Specify stretch point or [Base point/Copy/Undo/eXit]:** *pick another grib and pick a point*

Press Enter. Clicking the right button on your mouse is the equivalent to pressing enter.

The final drawing will look similar to this:

---

This completes this Lesson 4 tutorial titled Field to Finish for Faster Drafting.
Lesson 5: Intersections and Subdivisions

1. Click the icon for Carlson and start up Carlson Software from Windows. Once in the program, exit the Startup Wizard if it appears.

2. Once in Carlson, click *Open* under the File pulldown menu. Look for the file Plat4.dwg and click on it. When it lights up blue, as shown below, it will appear in the Preview Window at right. It should look like the open-sided property shown here. Plat4.dwg is found within the WORK folder of Carlson. You search for the file as you typically would in Windows, clicking the yellow "Up one level" button to go to the parent folder of the current folder, or by clicking the adjacent down arrow to find the desired path in the full tree of folder locations.

![Select File](image)

Now click Open to select and open the file Plat4.dwg.

3. Enter & Assign a Starting point for the Street Centerline. Select *Draw-Locate Points*, found under the Points pulldown, and obtain the dialog shown below:

![Select File](image)
Click off the prompting and labeling for Descriptions, Elevations and Locate on Real Z Axis (make them blank as shown). Up top, change the symbol to SPT10 by picking Select at the very top of the dialog, and choosing symbol SPT10 from the dialog of symbol choices (not shown here). Also, verify that Automatic Point Numbering is clicked on, that the Starting Point Number is 1, that the layer is PNTS. Match these entries (which are mostly the default conditions) and click Enter and Assign at the lower left.

Prompting will appear at the bottom of the screen. We will enter the starting point as follows:

**Enter North (y):** 4809.17

**Enter East (x):** 4391.28

The program will recognize that you have not yet started a coordinate file, so click the New tab and enter the File Name as Plat4.crd (which should be the default). If you enter Plat4, you do not need to enter the extension .crd. The program will add extensions automatically. You will see this:
Click Open. You will be prompted again:

**Enter North(y): press Enter** (for no more points; we are done)

4 Traverse from PI to PI (to the two endpoints of our centerline). Select *Traverse* under the COGO menu, or alternately just enter T at the command line. (T is a hot key. Other hot keys are I for Inverse and SS for Sideshot). Reply to the prompts as follows:

**Traverse, Line OFF, RAW FILE OFF**

**Exit/Options/Arc/Points/Line/SideShot/Inverse/Angle-Bearing Code <7>: 1**

**Enter Bearing Angle (dd.mmss) <90.0000>:** 58.1848

**Points/<Distance>:** 736.73

**N: 5196.15 E: 5018.19 Z: 0.00**

**Exit/Options/Arc/Points/Line/SideShot/Inverse/Angle-Bearing Code <1>: E (to exit)**

You could keep on traversing, but we will stop here to review. You have created point 2, traversing NE from point 1. To review, code 1 is for NE, 2 for SE, 3 for SW, 4 for NW, 5 for Azimuth, 6 for Angle Left, 7 for Angle Right, 8 for Deflection Left and 9 for Deflection Right. This is the standard way that traverses and sideshots are entered in Carlson with a code entry (followed by Enter), then the angle or bearing entry (followed by Enter). Lesson 1, the Entering a Deed lesson, presented another method, where the angle and bearing are together in the form of 158.1848. That is a rare form, designed to save keystrokes, and used primarily only in *Enter Deed Description*. Now you have been exposed to both!

5 **Line On/Off.** Click *Line On/Off*, under the COGO menu, to turn on simultaneous linework with traversing. This command toggles on and off each time you click it, with the On status indicated by a check mark. Now repeat the Traverse command. Try T for Traverse this time, entered at the command line.

**Traverse, Line ON, RAW FILE OFF**

**Exit/Options/Arc/Points/Line/SideShot/Inverse/Angle-Bearing Code <1>: 2**
Enter Bearing Angle (dd.mmss) <58.1848>: 75.0627
Points/<Distance>: 553.69
N: 5053.85 E: 5553.28 Z: 0.00
Exit/Options/Arc/Points/Line/SideShot/Inverse/Angle-Bearing Code <2>: E (to exit)

6 Draw a Polyline from Point 1 to Point 2, and connect the segments with Join Nearest. We could have turned linework with traverse on before we got started, but now we will do it after-the-fact. So choose 2D Polyline under Draw. Some users like to simply type in 2DP at the command line that starts the Polyline command, also.

[Continue/Extend/Follow/Options/<Pick point or point numbers>]: 1
[Arc/Close/Distance/Follow/Undo/<Pick point or point numbers>]: 2
[Arc/Close/Distance/Extend/Follow/Line/Undo/<Pick point or point numbers>]: press Enter (to end)

Now we have two line objects. The first, from point 2 to point 3 is a pure Line. The second, from point 1 to point 2, is a true Polyline (even though it is only one segment long). It is officially a LWPOLYLINE, a lightweight polyline. This can be verified by picking it using the List command under Inquiry. Polylines are linked combinations of one or more line segments that behave as one unit. We encourage use of polylines versus lines because they offset as a unit, will take on a thickness or width, are easier to select and have superior editing capabilities. A line can be turned into a polyline by picking Polyedit under Edit, picking the line, and answering Y to the question "Do you want to turn it into one? <Y>". To join the polyline and line objects into a single polyline, choose the very useful command Join Nearest, found under Edit.

The defaults are good. Just click OK. Now pick the polyline from 1 to 2 and the line from 2 to 3, and then hit Enter for no more.

Now, see the grips on the new polyline by picking it with the cursor. See how the whole thing highlights? That is proof that it is joined up as a polyline.

7 Design a Curve with a 500' Radius. Under Draw, pick Arc and slide over to 2 Tangents,Radius.

Radius of Arc <0.00>: 500
[nea] Pick Point on 1st Tangent Line: Pick on the 1st polyline segment closer to point 2
[nea] Pick Point on 2nd Tangent Line: Pick on the 2nd polyline segment close to point 2

The arc draws in, and the centerline remains a polyline, now with 3 segments.

8 I for Inverse. Entering I for Inverse, at the command line, is a handy way to get on a point to begin another traverse. Practice inversing. Enter I. Inverse from point 1, then to point 2, then to point 3 then back to 1. But you can also
inverse (go to) a snapped position on a line or polyline, such as the midpoint of an arc. Let's do that, because we want to traverse south from the midpoint of the arc. Enter I, for Inverse.

**Calculate Bearing & Distance from starting point?**

- **Traverse/SideShot/Options/Arc/Pick point or point number:** MID (for midpoint snap) of Select the arc
- **Traverse/SideShot/Options/Arc/Pick point or point number:** T (for traverse)
- **Traverse, Line ON, RAW FILE OFF**
- **Exit/Options/Arc/Points/Line/SideShot/Inverse/Angle-Bearing Code <2>:** press Enter

- **Enter Bearing Angle (dd.mmss) <75.0627>:** 10.11
- **Calculated Bearing (Qdd.mmss):** 210.1100
- **Points/<Distance>:** 400

**Exit/Options/Arc/Points/Line/SideShot/Inverse/Angle-Bearing Code <2>:** E (to exit traverse)

Notice that you can transition from inverse, to traverse, to sideshot, etc. with these COGO options. We were in inverse, but we did T for traverse, and could have done I for inverse to return to inverse. This cuts down on keystrokes, and adds to the sense of fluidity of the software.

9 Turn a Line into a Polyline with Polyedit. The command Offsets & Intersections requires pure polylines, not lines, to execute. So, since we had Line On with the last traverse, we have created a line. To use this in street design, we need to convert it into a polyline. Select Polyedit under the Edit pulldown menu.

- **Select polyline or [Multiple]:** Pick the side road line
- **Object selected is not a polyline**
- **Do you want to turn it into one? <Y> press Enter**
- **Enter an option [Close/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype gen/Undo]:** press Enter

10 Offsets & Intersections. Under the Area/Layout menu, select Offsets & Intersections.

- **Select all PRIMARY road polylines.**
- **Select objects:** Enter (we will consider both these subdivision streets secondary)
- **Select all SECONDARY road polylines.**
- **Select objects:** Hold down the Shift key and pick the main centerline
- **Select objects:** With shift key still down, pick the side road
- **Select objects:** Enter (for no more)
The street intersections are presented in a dynamic dialog as shown above. Try experimenting with different radii under the Secondary Roads column, then clicking Calculate. The streets will re-draw in the upper graphical area. But after experimenting, change the four values under Secondary Roads to those shown (ignore Primary Roads – those don’t apply here), and click Calculate. Then click Finish 2D. Note the drawn-out street intersection.

Now select Layer ID under the Inquiry menu. Pick on the outside polyline (it is layer ROW). Pick on the next polyline in from the outside (it is layer EOP). For example, if you had clicked off EOP under the Draw column in the above dialog, the edge-of-pavement polyline would not have drawn.

11 Standard Cul-de-Sac. Under Area/Layout, select Cul-de-Sacs. You may want to zoom into the area of the bottom center, near point 4. When finished with the procedure below, zoom back out.

Prompting:

Select all offset polylines to end with cul-de-sac.
Select objects: Do a crossing selection from right to left across the lower side road, selecting all 5 polylines (ROW-L, EOP-L, CL, EOP-R, ROW-R)
Select objects: press Enter (for no more)
Pick cul-de-sac center projection onto centerline: END (type end for endpoint snap)
Pick near the endpoint of the centerline of the lower side road near point 4. However make sure the pick is on the centerline polyline, or the routine will say the centerline not found.

This brings up the following dialog:
Again, you can change the Fillet Radius and the Outside Radius on the EOP or ROW, hit Calculate, and check out its effect. (Don’t make the Outside radii too small or it will fail Calculate if there is no workable solution). Set values as shown above. Then click on Finish 2D.

12 Teardrop Cul-de-Sac. Now select the *Cul-de-Sacs* routine again, under Area/Layout.

**Select all offset polylines to end with cul-de-sac.**

**Select objects:** *Do a crossing selection* pick from right to left across the right main road, selecting all 5 polylines (ROW-L, EOP-L, CL, EOP-R, ROW-R)

**Select objects:** *Enter* (for no more)

**Pick cul-de-sac center projection onto centerline:** END for endpoint snap *Pick endpoint of the centerline* of the lower side road near point 3

For a teardrop cul-de-sac, fill out the dialog as follows, then click on Calculate and Finish 2D.
Teardrop cul-de-sacs allow moving vans and other large vehicles more turning room, and have been popular in the Cincinnati area, for instance. Our drawing now appears as shown below, with the exception of the filled reference dots.

13 Let's make a layer called LOTS using Layer Control found under View. It's a good idea to create a layer and set it current before beginning the design process. Select Layer Control and obtain the following dialog:
Click on for New layer. When Layer1 highlights, as shown at bottom of list, type over it with LOTS, then click under the Color column and change the color to Magenta. Then click the (Set) Current button up top to make this layer current. Then click OK to exit the dialog.

Next, we will use *Break at Selected Point*, found in the Edit menu.

The *Lot Layout* routine under Area/Layout works nicely with reasonable polylines that run roughly parallel. Our goal is to make 1-acre lots. Lots of zigs, zags, and jogs in the polylines cause the perpendicular offset logic to fail to find a solution (lots will radiate perpendicular from the front polyline in Lot Layout). Not only should the front and back lines run opposite each other, but they should end at some point before the calculation runs into difficulty with impossible math.

The outer R-O-W polyline currently runs left-to-right, goes around both cul-de-sacs and returns right-to-left in one, connected polyline. We need to break it near where the filled dot is pointing. It should be easy to lay out lots along the upper portion of the subdivision, as long as we stop to break the R-O-W polyline before it turns and runs back through the lower, more complex frontage and back property portions.

Under Edit, select *Break*, and slide over to *At Selected Point*. You will select using the filled dots, shown on the plan above, as references.

**Select Line, Arc, or Polyline at break point:** *Pick* near the filled dot on the outer boundary polyline.

Repeat the command for the ROW polyline.

**Select Line, Arc, or Polyline at break point:** *Pick* the far right end of the Teardrop cul-de-sac R-O-W polyline.

To prove you have broken the polylines in two, click on the R-O-W polyline on the south side (only the south portion should highlight), then click on the north R-O-W polyline (which we will use as our frontage polyline in the command Lot Layout). Then press the ESC key twice, which gets rid of the grips, as does zooming or panning.

14 Select Lot Layout under Area/Layout. A dialog appears:
Fill out as shown. In particular, click off Apply Remainder Equally to All Lots (if it is on) so that we force 1.000 acres lots and don't just get equal lots of some size such as 1.0017 (because the remainder lot that would not fit was added onto all lots).

Making Closed Polylines means that our side lines will be doubled up, each lot sharing a side line. Click OK.

Select front polyline: Pick north R-O-W
Select back polyline: Pick northernmost polyline the back property line.

The 1.00 acres lots are laid out as far as is possible. You may get a small lot at the end of the row, which you would erase.

15 Applications of Reverse Polyline. We can get one more lots from Lot Layout, by doing the lower R-O-W at the left side of the drawing, and picking the southern back polyline. Let's try. Select Lot Layout under Area/Layout. Use same dialog entries. Select the front polyline as the southern edge of the road R-O-W, near the left side of the drawing. Select the back polyline as the southern property line. Oops! Nothing drew. It was unable to calculate. It turns out that the direction of the polyline is important. The southern R-O-W polyline starts way off to the right, so the program was not even considering where we were looking! We need to reverse the direction of the southern R-O-W polyline so it starts on the left side. Select Reverse Polyline, found under the Edit pulldown, sliding over from Polyline Utilities. It prompts:

Select polyline or line to reverse: Pick the southern R-O-W polyline.

The polyline now reverses direction, goes left-to-right, and shows phantom direction lines (which are automatically removed when the command ends). Now repeat the Lot Layout command as outlined in the beginning of Step 15, and we get one new lot out of the exercise, as shown below. If you get a second wedge shaped lot, erase it.
16 Break at Intersection. The lower back property line is still continuous. We can work with it in small pieces rather than as one big polyline. Say we want to break it as the inside corner identified by the arrow above. To do this, select Edit pulldown, Break, sliding over to At Intersection. Prompting:

Select Line, Arc, or Polyline to Break: Pick the south property line
[app on] Pick Intersection to break at: Move the cursor to the intersection point indicated above, look for the INT snap to appear as you approach the exact corner (which is an intersect), then click there.

17 Draw a Polyline from the corner indicated by the filled dot to the beginning of the R-O-W arc, also indicated by a filled dot in the previous graphic. Select 2D Polyline under Draw.

Pick point or point numbers: End (type in end for the endpoint snap)
of ..Pick the inner back property corner
Undo/Arc/Length/<Pick point or point numbers>: End (type in end for the endpoint snap)
of ..Pick the beginning of the Arc (it will show endpt when you get close to the true start of arc)
Undo/+/-/Arc/Closed/Length/<Pick point or point numbers>: Enter (to end)

18 Area by Interior Point. We have just created a new lot, but the lot is not defined by one, single, closed polyline. If we want to verify its area, however, we can still use the command Area by Interior Point. Select Area by Interior Point under Area.

Pick point inside area perimeter: Pick inside our new lot

SQ. FEET: 40997.2 SQ. YARDS: 4555.2 SQ. MILES: 0.0
ACRES: 0.9412 PERIMETER: 830.5026

Pick area label centering point: Press Enter here to avoid labeling.

The lot is less than one acres. We will set as a goal to extend its lower boundary to the right to obtain one acre. That is accomplished by using the command Hinged Area. But Hinged Area works best if we have a nice, closed polyline for the new lot. We can get one using the command Boundary Polyline.

19 Boundary Polyline. At the command line, type in BPOLY (or BOUNDARY). When the dialog appears, pick
Then pick all the polylines that surround our new lot. Then after you hit Enter to Select objects, this same dialog returns. Then you select Pick Points and pick inside the lot. This creates a new closed polyline, in the current, LOTS layer (magenta).

20 Select Hinged Area under the Area/Layout pulldown.

Define area by points or closed polyline [Points/<Linework>]? press Enter (for linework)
Select polyline segment to adjust: Pick on the right-side line
Select hinge point [endp]: Pick on the upper right hinge point (see arrow)
Keep existing polyline [Yes/<No>]? N
Area: 40997.20 S.F, 0.9412 Acres
Remainder/Acres/<Enter target area (s.f.)>: A (for acres)
Remainder/SF/<Enter target area (acres)>: 1.0

The new lot draws, as shown below:
21 Next, use the Erase command to remove the segment that is pointed to above with the text Click on This Side.

22 Make 2 More Lots with Polyline command. Instead of using Draw, 2D Polyline, we will use the straight AutoCAD polyline command. At the command line, enter PL.

**Specify start point:** END (type in the endpoint snap)
of Pick the endpoint (which is the lower right corner of the new lot).

**Current line-width is 0.00**

**Specify next point or [Arc/Halfwidth/Length/Undo/Width]:** PER (type in the perpendicular snap)
to Pick on the R-O-W polyline to the right.

**Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]:** press Enter (to end)

Now for the second lot. Referring to the drawing below, repeat the PL command, and answer as follows:

**Specify start point:** NEA (enter the nearest snap)
of Pick on the property line anywhere near the circled point 1 (no need to be exact)

**Current line-width is 0.00**

**Specify next point or [Arc/Halfwidth/Length/Undo/Width]:** PER (type in the perpendicular snap, which when intersecting arcs means radial to the arc)
to Pick on the R-O-W polyline near circled point 2.

**Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]:** ENTER (to end)

The drawing appears below:
23 Issue the *Break at Intersect* command, and break the back property polyline and the cul-de-sac R-O-W polyline at the intersections with our newly drawn polyline from step 22. Repeat this command, and break the back property polyline at the filled dot to the right of the "Sliding Side Area" label below.

24 Repeat *Lot Layout* with the same entries as before. The front and back polylines to select are shown below, along with the results. This gives us 2 more usable lots.

Next, use the 2D *Polyline* command to generate a segment (above the "Sliding Side Area" label below) that runs from the ENDpoint of the corner to a point PERpendicular to the R-O-W line. Then use BPOLY to create a closed boundary inside it.

Erasing the original segment you placed is a little tricky since the newly formed polyline is on top. When two pieces of geometry lie on top of each other, Carlson will take the one created last. Issue the *Erase* command, then hold down the control key while picking the segment above the "Sliding Side Area" label. When the single segment highlights, press enter to erase it, leaving the boundary polyline.
25 Sliding Side Area. Because we have a small closed polyline, we can investigate another area command, the Sliding Side Area. As shown in the graphic above, we want to slide the north side of the last, smaller lot parallel to its current bearing such that the lot will contain 1.00 acres. Select Sliding Side Area under the Area/Layout pulldown.

Define area by points or closed polyline [Points/<Linework>]?
press ENTER
Select polyline segment to adjust: Pick the north side of the lot above (shown here containing the words Sliding Side Area)
Keep existing polyline [Yes/<No>]?
press ENTER
Area: 20375.30 S.F, 0.4678 Acres
Remainder/Acres/<Enter target area (s.f.)>: A (a for acres)
Remainder/SF/<Enter target area (acres)>: 1.0
26 Complete the remaining Lots. Using the 2D Polyline command, under Draw, use endpoint snaps and perpendicular snaps (end and per) to draw the final 3 polylines, shown below marked 1, 2 and 3 for reference.

It may not be the most aesthetic subdivision, but we applied a lot of tools making it. But we're not done. There's some real automation ahead.

27 Create Points from Entities. We have designed a subdivision, in effect, without point numbers. This is the beauty of CAD. But we need to make point numbers in order to stakeout the subdivision. To do this, select Create Points from Entities, under COGO. The following dialog appears:

Set the starting point number to 5, verify the dialog as shown, and click OK. A second dialog, covering what entities to capture, appears next. Stick with the default settings and click OK.
When it asks, Select objects, type in All. Press Enter for no more selections, and Enter again. All the point numbers for stakeout are created.

Number the lots, clockwise from the upper left, using the command *Sequential Numbers*. Under Draw, select *Sequential Numbers*. This dialog appears:

Choose the circled text and click OK.

Set the text size (height) to 16 and the starting text value to 10, as shown. Then click OK.

**Pick point at center of label or type Polyline to label:** Pick near the center of the first upper left lot. **Pick point for label alignment:** Press F8 for <Ortho on> Pick to the right.

Now pick near the center of all of the lots, going clockwise.

When done, and back to the command line, press F8 again to set Ortho off.

The resulting drawing, with point numbers, is shown below:
Lot File by Interior Text. Official lot files can be created whenever a lot number or name exists within a lot as the sole text (other text may be present but could be frozen). So we will play it safe and first freeze the point number layer. Before we do, take note of the point number assigned to the NW corner of Lot 10. In our case, it is point 64 (it may be different in your case, depending on how you selected the objects in the command Convert Entities to Points).

Under View, select Freeze Layer and pick on one of the point numbers. Now go to the Area/Layout pulldown, select Create Lots and slide over to select Lot File by Interior Text.

A dialog box will appear. Be sure that is says Block Name 1. Click OK.

Select lot lines, polylines and text.

Select objects: Pick the lots and the lot numbers

The Lot Files will be created. Before we look at the Lot Files, let's finish up and do area annotation on the upper lots, by the command Area by Interior Point.

Note: If we had not made points at all lot corners, using Convert Entities to Points, the Lot File by Interior Text would make point numbers. This is the reason for the prompt: Starting point number. If points are found, no new ones are created. Lot files must have points at all the corners.

Area by Interior Point. Select Area Defaults, under Area/Layout, and cancel the square feet plot, leaving only the area plot to 3 decimal places. Set as shown below:
Now choose *Area by Interior Point*, under the Area/Layout pulldown menu, and pick inside Lots 10 through 16, as shown below:

31 Select *Lot Manager*, under Area/Layout, and the following Lot Editor dialog appears:
Pick on Lot 10 and click Report. This will lead to the Lot Report dialog box.

Be sure that your setting are as shown above, and then click Lot Report.
This dialog is typical of the many Carlson Standard Report Viewer dialogs, first introduced in Carlson CES. You can click on 1 or more lines, highlight them and hit the delete key on the keyboard, and these lines will delete. You can edit lines directly in the dialog. You can also save the report to disk with the Save icon shown above. To exit, click the Exit icon.

32 The Edit Current (lot) option within the Lot Editor dialog box can be used to describe a lot by different point numbers, or to assign a lot to a different block. This is explained here and shown below for reference purposes only.

Click Lot Manager under the Area/Layout pulldown menu. You will see the Lot Editor dialog as shown in Step 31. First, make sure that a .lot file is open. If it is not, open one. Then, under Selection, select a lot to edit. Click Edit Current. You will get this dialog. Note the graphic display in the lower half, which map the Points listed above.
33 Re-Drawing Lots after Editing Points. Let's assume you actually changed the point numbers that define Lot 10. That would cause the lot to draw differently. Also, you could simply alter the coordinate values of a point in the current lot file. That would also cause the lot to draw differently. Let's take the latter approach. Remember point 64? It is the NW corner of lot 10 (in our case your's may be different as stated above). So select Edit Points under the Points pulldown menu. A spreadsheet appears. Scroll down to point 64 (or whatever point is your NW corner of Lot 10).
Click on the Northing and edit it to 5050. This is for illustration purposes. In reality, you might be fine-tuning your subdivision design points. As long as the same points define the lots, you are, in effect, making a ready-made new drawing. Now select at the top of the dialog File, then Save and Exit.

34 Draw the Lot File. Before we draw the lot file, save your drawing by selecting Save under the File pulldown menu. Then choose New, exit the Startup Wizard (if it appears), and go straight to Lot Manager, found under the Area/Layout pulldown menu. Lot Manager provides the tools for drawing lot files to the screen.
Click the Existing tab. Select the plat4 lot file and click Open. Now select your existing crd file that you created earlier. In the next dialog, called Lot Editor, shown below, choose all lots by clicking Select All. Then click Draw.
Accept the defaults and click OK to the Draw Lots dialog box. This leads to the Auto-Annotate dialog, shown below. Use the settings shown here. Click OK.

Next comes the Area Defaults dialog, as seen in Step 30. Fill out exactly as shown in Step 30.
Click OK and then Exit. This leads to the plot shown below, created entirely from stored Lot Files, and showing our revision of Lot 10.

This completes this Lesson 5 tutorial titled Intersections and Subdivisions.

**Lesson 6: Contouring, Break Lines and Stockpiles**

1. Click the icon for Carlson and start-up AutoCAD/Carlson from Windows.
2 Once in Carlson, exit out of the Startup Wizard (if it appears) and click Open under the File pulldown menu. Look for the file Mantopo.dwg and click on it.

3 Select Triangulate & Contour from the Surface pulldown menu (within the Survey module). Click the Contour tab. Let’s target contours at a 1-unit interval, and contour the area of points. You will see this dialog:

![Triangulate and Contour dialog box](image)

Make all settings as shown (most of them are the default). We want to make sure that the Contour Interval (top right) is set to 1. Also, be sure to set the Index Interval to 5. Click OK.

Select the points and breaklines to Triangulate.
Select objects: Do a bottom right to upper left crossing selection by picking just to the left of the small, stockpile contour map, near the bottom of the screen, and then picking the upper left of the screen (capturing all points).
Select objects: Enter (for no more)
A dialog box appears. Select Mantopo.crd as your crd file. Click Open and the points will be read from the crd file.
Range of Point Numbers to use [<All>/Group]: Enter (to accept All)
Wildcard match of point description <*>: Enter

Contours are drawn, but notice the unacceptable wavy look around the perimeter an area which is meant to be a ditch.
Type in U for Undo and press Enter until the new contours (at left) disappear and you are back at the command prompt.

4 Field-to-Finish: From within the Survey module, under the Survey pulldown menu, select **Draw Field-to-Finish**.

You will be prompted for the CRD file to process. Choose the Existing tab, then select MANTOPO.CRD, which resides in Carlson's data folder, and click Open. The Draw Field to Finish dialog appears.

At the lower left of the Draw Field to Finish dialog, click Edit Codes/Points. The Field to Finish dialog appears.
On the left side of the Field to Finish dialog, under the heading Code Table, there is an option called Code Table Settings. Click on it. You will see this dialog:

As you can see at the top of the Code Table Settings dialog, the default Field to Finish code definition (.FLD) file is Carlson.fld. We want to make a new code table because the coordinate file for the field survey includes special coding (17 and 18) for ditch lines and top of banks.

You can react and adjust to whatever a field crew uses by making a new field-to-finish table that can load up the codes right from whatever descriptions were used in the field. To do this, click Set at the upper-right of the Code Table Settings dialog, then choose the New tab (for new file) and you might name it Mantopo, as shown below:
Click Open. You will be taken to the previous dialog.

Notice how `\DATA\Mantopo.fld` is now listed at the top. Click OK. You will return to the main Field to Finish table, completely empty, as shown below:
Now, jump start the table by choosing the option Code Table by CRD (located in the lower left of the dialog). Choose Append.

In this lesson, we only care about code 17 and 18, so highlight all of the others (by holding the CTRL key down and picking them), then choose Cut. Now highlight both 17 and 18 as shown below.
Pick the middle Edit button. Another dialog appears.

Click the Entity button for yet another dialog, shown below. Make all settings as shown in this box. We will turn them both into 3D polylines (which will act as break lines or barrier lines for contouring). Accept the 3D Polyline choice by clicking OK, then hit Exit, which will take you back to the Field to Finish dialog.
The last steps are to first to save the Field-to-Finish (.FLD) file Mantopo by clicking the Save button. Then click Draw (lower right) to draw the 3D polylines. You will see the following dialog which allows you to control the details of what to draw. Make sure lines is the only entity to be drawn, not points or symbols. Take a quick look at Additional Draw Options by clicking that button. Make sure that the Point Label Settings are set so that you can see the points properly. Click OK to both dialog boxes.
The following drawing is created. All the ditch lines and top of bank lines, because they were coded 17 and 18, are drawn in one quick procedure.

Because the field crew did not use start and stop logic (e.g. appending 7 or some agreed upon code to a description could end a polyline and start another), some polylines connect that should not. In particular, the line pointed to near the NW corner is clearly crossing the ditch line. It must be removed. Choose the Edit pulldown, then Polyline Utilities, Remove Polyline, then Remove Polyline Segment.
Break polyline at removal or keep continuous [<Break>/Continuous]? Enter
Select polyline segment to remove: Select the polyline segment to the right of point 127. You will recognize this as a long segment running from point 127 to point 50.
Select polyline segment to remove: Enter (for no more)

6 Return back up to the Surface Menu, pick Triangulate & Contour, and set the standard contour interval to 1 (as before), but specify Draw Index Contours. Set the index interval to 5. Then do a right-to-left crossing selection as before (avoiding the stockpile at the lower right). Select the Mantopo.crd file again.

Now we get excellent contours, with a sharply defined ditch. Under View, do Freeze Layer and pick on a point. The points will freeze.

Here is the improved drawing, helped out by 3D polylines, which, if selected, act as break lines, which were produced by Draw Field-to-Finish.

7 Delete Layer. Let's say that now you don't want the break lines on there. You don't want to even freeze them, you want to fully delete them. There is a command for that under Edit. Pick Erase, sliding over to Erase by Layer. This dialog appears.
If you know the layer names, you can just type them in. If you know where they are but not their names, then click on Select Layers from Screen. If you'd recognize the layer name if you saw it in a list, click Select Layers by Name. Click on Select Layers by Name and pick 17 and 18, then OK twice. Notice the change in the drawing.

8 Explode. Inserted Drawings need to be exploded. Do a View pulldown, option Window and window in on the stockpile at the lower right of the drawing. If you type E to Erase, and try to erase any aspect of the stockpile, the whole stockpile will erase all features. That is because the Stockpile was another drawing inserted into this drawing. Sometimes other drawings that are inserted are referred to as Blocks. In any case, this stockpile block, or inserted drawing, needs to be exploded. Explode just breaks it up into its unit objects which then start to behave normally. Select Explode under Edit and slide over to Standard Explode. Then pick the stockpile. It is now a set of normal objects.

It's also worth noting that while the block has been exploded, it still exists in the drawing as a block definition. This means that now that it's exploded it is taking up twice the amount of storage space in the drawing. As such, you should purge the drawing of the unused block, or turn on the explode toggle when inserting one drawing into another. As a basic rule, if it's a symbol, don't turn on the explode toggle; if it's a complete dialog, turn it on.

9 Change Elevations. Let's assume our stockpile drawing is too high and should be lowered in elevations by 540 units. To best see the effect of this command, bring back the points by selecting Thaw Layer, under View. Now select the Edit pulldown, then Change, then Elevations.

Ignore zero elevations [<Yes>/No]? Enter
Type of elevation change [Absolute/<Differential>]: D
Change Layer for changed entities [Yes/<No>]: Enter
Positive number increases, negative number decreases elevation.
Scale/Elevation difference <0.00>: -540
Hit Enter twice.
Select objects: Do a lower right pick to upper left pick (automatic crossing) selection.
Select objects: Enter (for no more)

Notice in the drawing below how everything has change elevation, including the points, but with the exception of the contour text.
Do the command *List Elevation* under the Inquiry pulldown, pick on an index contour, and notice how the elevation has indeed changed. Repeat step 7 and delete the layer Ctext, so as to remove the 5 index contour elevations, which are no longer accurate.

10 Volumes by Layer. One of the signature commands of Carlson, *Volumes by Layer* will produce accurate volumes without making any files. The only prerequisite is that the existing and final surfaces exist on the drawing in separate, distinct layers. It is also very important to have a drawn inclusion perimeter to pick and define where the volumes are being calculated. In our example, the original ground will be the 3D polyline connecting points 1 through 15, and everything else above will be the final ground (including the 3D perimeter itself).

Select *Volumes by Layers*. This command is found under the Grading menu, within *Volumes by Grid Surface*.

**Pick Lower Left limit of surface area**: *Pick below and to the left* of the stockpile, but as close as possible to the stockpile without clipping it in the window. You want to totally include it, but with little wasted margin.

**Pick Upper Right limit of surface area**: *Pick above and to the right* of the stockpile.

A dialog appears:
We will stick with the defaults, as shown. Notice that we are using 50 grid cells within our window, and since our window was not a perfect square, the cell sizes are not whole numbers. (In this example it is 6.88 x 5.77. You my have slightly different sizes). Seeing this, if we wanted 5 x 5 cell size, we could click the Dimensions of a Cell option and set the size to 5 x 5. Hundreds or thousands of cells in both directions will increase calculation time. You can experiment with more cells, or if you prefer, smaller cells (which makes more cells), and see when you get diminishing returns in terms of accuracy changes. After a while, tighter, smaller cell sizes don't add any value to the precision of the calculation. Click OK.

Then pick the layers that define the existing ground (Perimeter) and the layers that define the final ground (Perimeter, Barrier, Ctr, Ctrindex).

![Volumes by Layer](image)

Then click OK. Notice how the Perimeter layer is common to both. If you want to be a master of volumes, remember this as a mantra: The perimeter should be a 3D polyline in a distinct layer, common to both surfaces. A stockpile is just a special case in that sometimes the 3D perimeter is all you know about the base surface.

When asked to Select objects, do a right-to-left (crossing) selection of the entire stockpile area. Lastly, you will be asked for the inclusion perimeter (pick the white perimeter polyline) and the exclusion perimeter (none). This leads to a flexible reporting and output dialog:

![Volume Report Options](image)

Elevation Zone Volumes, for example, would produce volumes in any desired increment from the base of the stockpile going up. If the stockpile consists of coal (80 lbs/c.f.), then Report Tons can be clicked on and a Density value entered.

Click OK, and the basic report is produced, as seen below. We did not include the points in the final layer. Since
there is a high point, for example, the top of the stockpile, the points would lift the volumes up slightly.

Click the Exit icon to return to the command prompt.

11 Stockpile Volumes. Our Stockpile is naturally well-suited for applying the simplest volume command of all Stockpile Volumes. It requires that the 3D perimeter polyline for the stockpile be placed in a layer called Perimeter which ours is. So let's try it.

Select Calculate Stockpile Volume found under the Grading pulldown menu.

Material density lbs/ft$^3$ (Enter for none): 80
Ignore zero elevations [<Yes>/No]? Enter
Reading points ...
Select Stockpile perimeter polyline: Crossing select (right-to-left picks) the entire stockpile area.

The grid resolution dialog (note that it is still at 50x50) appears again. Click OK. Done. A report is generated.

This completes the Lesson 6 tutorial: Contouring, Break Lines and Stockpiles.
AutoCAD Overview

This chapter explains the essentials of using AutoCAD including command entry, selection sets and layers. Since Carlson Software is built on the AutoCAD OEM engine, it is helpful to know the AutoCAD basics. Several of the Carlson Software command are native AutoCAD commands and many others have an AutoCAD style user-interface.
Issuing Commands

Virtually all commands in Carlson Software have three or more ways they can be initiated. The two most common are the menu and the toolbar, but the command line can many times be a very easy method of working through commands. Using the menu and toolbar should be second nature to Windows users, so this section will mainly focus on the command line usage in Carlson Software.

Command Line Prompt-Command:

Carlson Software has a command line prompt where commands are "issued" and the status of a command is reported. When you select a command from the menu or toolbar, that command name is sent to the command line and is executed. Before most commands can begin, all other commands must be terminated. The exceptions are referred to as transparent commands. The easiest way to see if no commands are running is to look at the command line. If it displays Command: no commands are currently in progress.

Enter

When you are required to press the Enter key in Carlson Software, you can use the Enter key on the keyboard or you can press the spacebar or click the right mouse button.

Pressing the Enter key will perform different operations depending on your location within Carlson Software. If you are in the process of running a command, the Enter key will end the command (if there are no available options) or it will select one of the options available (see below). If you are at the command line Command: prompt, pressing the Enter key will repeat the last command.

Right Mouse Button

As mentioned above, the right mouse button can be used as enter. However, you can set the right mouse button to perform different functions. The control for the Right Mouse Button behavior is in the Mouse Click Settings command. When you click the right mouse button, you will get a drop down list of the options and can select the desired one. Move the cursor the desired option and click on it with the left mouse button.

Getting Out of a Command-Esc

For commands that provide no options, the Enter key (or spacebar or right mouse button) will end the command you are using. Also, when a command is issued in Carlson Software, this action will also automatically end the previous command. However, there are exceptions to these two rules.

To avoid any problems with using the above methods to end a command, you can press the Escape (Esc) key. For example, if the command line displays something other than Command: or if a command you want to run does not start because you are using another command, you will want to end the command and return to the command prompt. Using the Escape (Esc) key will accomplish this every time.

Note: Some commands have several optional levels which will require the escape key to be pressed more than once.

If you accidentally select a location on the screen and start a selection window, the command prompt will prompt for another corner. Either select another point on the screen to finish the selection (not advised) or press the Esc key to return to the Command: prompt.

Commands Option
When any command is issued, the command line acts as a status bar that will show the available options and "ask" for input from you.

When there are options for the command you are currently running, these options will be shown on the command line with capital letters in the option name. To use one of the options, type the capital letter(s) at the prompt. For example, if you issue the Zoom command, the command prompt will show All/Center/Dynamic/Extents/...<Realtime>: To select the Dynamic option, type D at the command line, then press the Enter key. If you do not input an option and just hit enter, you will be selecting the option that appears in the <> brackets. For the example shown, that is the Realtime Zoom option.

**Transparent Commands**

Several commands in Carlson Software can be run transparently. This means that they can be performed while another command is running. For example, if you are in a command and are trying to select something in the drawing but it is too small to see, you can use the zoom command transparently. Zoom to the area where the object is, then select the object without ending the initial command. The most commonly used commands are the View commands of Zoom and Pan, and the Properties commands including the Layer dialog box.

To issue a transparent command, type an ' (apostrophe) before the command name. For example, 'Z would be transparent zoom. Note that many commands will automatically be assumed to be transparent if they are issued from the toolbar while another command is running.

When you are in a command that is running transparently, this will be indicated with a >> at the far left of the command line preceding any options or other text. When a transparent command is complete, you will return to the command you were previously running. If you are in a transparent command and want to end the command to get back to the command prompt, you will need to press the Esc key twice.

**Note:** If you select a View command while running another command, the other command will not end. You will be running the View command transparently. This is one of the exceptions to the rules for ending a command. If you do not want to run the View command transparently, you need to complete the other command or end it by pressing the Esc key.

**General Commands**

**Enter**

When you are required to press the Enter key in Carlson Software, you can use the Enter key, the spacebar on the keyboard or click on the right mouse button.

**Repeating Commands**

When you press the Enter key at the command line Command: prompt, you will repeat the last command.

**Cancel**

The Escape key (Esc) key can be used to cancel any command. Some commands may require pressing the Escape key more than once.

**Command Options**
The command line changes as a command is running. When there are options available for the command you are running, they will display at the command line. To select one of the options, type the capital letter(s) in the name of the option and press the Enter key.

**Selection of Items**

Most commands in Carlson Software require the selection of objects. When you need to select objects, the command line will prompt Select objects:. When you are at this prompt, your next step will be to create a selection set. While creating the selection set, the prompt Select Objects: repeats and you can continue to select objects until you press the Enter key, at which time the command you are using will continue and use the objects selected. If you are selecting object for an Eagle Point Software command, the objects selected will be then used for that command.

**Selection Sets**

There are several ways to create a selection set from the Select objects: prompt. With all selection methods, the number of objects selected will be displayed in the command line along with any objects that were duplicated. Following are the most commonly used methods for creating a selection set:

**Single**

A single selection is made when you move the object selection target to an object on the screen and click on it. The selected object will highlight and the select objects prompt will return. The cursor changes to a small square when the command line displays Select objects:.

**Window**

A Window will select all objects completely inside of the rectangle drawn. Create a window by selecting a point on the view screen and then moving the cursor right. The window will display as a solid rectangle. You can also create a window by typing W at the select objects prompt. In this case you can move the cursor to the left to create the window.

**Crossing**

A crossing will select all objects within the rectangle as well as those touched by the rectangle. If you select a point on the view screen and move the cursor to the left, you are creating a crossing. The crossing will display as a dashed rectangle. You can force a crossing by typing C at the select objects prompt, allowing you to move the cursor to the right and create the crossing.

**Previous**

After you select several objects, they will be temporarily stored as a selection set. Should you want to re-use the same objects that were selected by the last command, you can type P at the Select objects: prompt.

**Remove**
If you select incorrect objects, you can type **R** to remove objects from the selection set. When you are in Remove mode, the prompt will be Remove objects:. Click on the objects that you do not want to include in your selection. To return to select or add mode, type **A** at the command line.

**Grips**

Objects may also be selected before issuing the command and receiving the **Select objects:** prompt. This selection will turn on Carlson Software "grips." Grips appear as small blue squares in the drawing. All objects with grips will be used when a command is issued. Grips are turned on similar to selecting objects as described in the previous section, but with the command line at the **Command:** prompt, not the **Select Objects:** prompt. You can select single objects by clicking on an object with the standard cursor or you can select multiple objects by clicking in the view where there are no objects, then creating the window (right) or crossing (left). To remove grips, press the **Esc** key twice.

**Using Grips**

Grips can also be used to edit or change the location of objects in the drawing. Move your cursor to a grip and click. You should notice the cursor "snap" to the grip. The grip will turn from blue to red. The object grip is now attached to the cursor so you can move the object to the desired location and release it by clicking again.

**Properties and Layers**

Properties define how an object in Carlson Software is stored. One of the most common properties is the Layer. Layers can be turned off or frozen so the objects on that layer are hidden from the view of the drawing. Layers that are turned off can still be selected while frozen layers are essentially removed from the working set of the drawing. After layers are turned off or on, a redraw (which is done automatically) will update the view. A redraw of a file is a rather quick process. After a frozen layer is thawed, a regeneration may be required to update the view. Regenerations on large files may take a considerable amount of time depending on your hardware.

**Layer Dialog Box**

The Layer dialog box provides control of the drawing layers. You can turn layers on, off, freeze or thaw them, change the layer color and linetype, set the current layer, add new layers, delete layers, etc. To perform any of these functions, click on the **Layers** button .

In the Layer dialog box, you can highlight several individual layers to perform actions on at once by holding down the Control key and clicking on the desired layers. You can also highlight a continuous range of layers by highlighting one layer, holding down the Shift key, and clicking on another layer. All layers between the two will be selected. To select all of the layers, hold down the CTRL key and press A on the keyboard.

**Layer Drop List**

To turn layers on/off or freeze/thaw, you can also use the drop list on the toolbars. When you click on the symbols in the list, the layer’s status will be changed appropriately.

**Setting Current Layer**

The current layer will be the one shown in the Layer drop list box. You can change the current layer by selecting the desired current layer from the drop list. You can also use the Set Current Layer button and select an object on the
layer. The layer the object is on will become the current layer. Finally, you can highlight a layer in the Layer dialog box and click on the Current button to make the highlighted layer current.

You cannot freeze the current layer, but you can turn that layer off (not recommended).

**Changing Properties**

To change the properties of an object in the drawing, use the Properties button on the toolbar or the Change command from the command line. This command will allow you to change the layer an object is on, the color or linetype of the object. The color and linetype can be set to bylayer or to a specific setting. Bylayer means that when the property for a layer is changed, so does the property for the object. For example, the specific setting of an object may be the color blue. No matter what color you set for the layer the object is on, that object will be blue.

**Properties Toolbar**

![Properties Toolbar Image]

If this toolbar (or any toolbar) is not displayed, you can open it using the Toolbars dialog box. Type `toolbars` at the command line.

**Layer**

The Layer dialog box is used to modify layers properties (color or linetype) or status (on/off, freeze/thaw).

Key-in: `LA` or `ddlmodes`

Toolbar: ![Layer Button]

**Current Layer**

The Current Layer is the layer that you are on and will be working with. The Current Layer is the one shown in the Layer drop list. For example, in the above toolbar illustration, the Current Layer is Water.

Toolbar: ![Current Layer Button]

**Change**

The Change command allows you to modify the properties of an object, such as layer and color.

Key-in: `CH`

Toolbar: ![Change Button]
File Menu

The Carlson Software programs share some of the same pull-down menus, such as File, Edit, View, Draw, Settings and Points. Within each program, the other pull-down menus, typically, are specific to that program. The common pull-down menus contain general commands that are applicable within all programs. Many of these commands are AutoCAD commands which are described in your AutoCAD Reference manual. The Carlson commands located in the more common pull-down menus are explained in the next sections.

All the options on the File menu not described here are AutoCAD commands, which are discussed in the AutoCAD Reference Manual.
New

This command allows you to create a new drawing file. This routine defines the settings for a new drawing. You can start a new drawing file by selecting New, and then picking a template file. SURV.DWT is the default template file for use in Carlson Survey. After choosing the template, click the Open button at the lower-right. Next, you will either see the New Drawing Wizard dialog box or you will be taken to a blank screen. Should you use the wizard, a new drawing name will need to be chosen in order to get to the next step.

There are two methods that you can use to create a new drawing. One is this New command. The other is Open, also under the File pulldown menu. If you need to open an existing drawing, use the OPEN command, under File, then choose an existing file name.

The opening dialog, Select Template, lists all template files that currently exist in the drawing template file location. Choose a file to use as a starting point for your new drawing. A preview image of the selected file is displayed to the right. If the wizard is in use, the following options will be available to you in the New Drawing Wizard dialog. The New command starts a new drawing using default settings defined in either the surv.dwt or surviso.dwt template, depending on the measurement system you've chosen. You cannot modify the surv.dwt or surviso.dwt templates. To start a new drawing based on a customized template, see Use a Template.
English: This option starts a new drawing based on the Imperial measurement system. The drawing is based on the surv.dwt template, and the default drawing boundary (the drawing limits) is 12 × 9 inches.

Metric: This option starts a new drawing based on the metric measurement system. The drawing is based on the surviso.dwt template, and the default drawing boundary (the drawing limits) is 429 × 297 millimeters.

The New command creates a new drawing using the settings defined in a template drawing you select. Template drawings store all the settings for a drawing and may also include predefined layers, dimension styles, and views. Template drawings are distinguished from other drawing files by the .DWT file extension. They are normally kept in the template directory. Several template drawings are included with Carlson Survey. You can make additional template drawings by changing the extensions of drawing file names to .DWT.

Pulldown Menu Location: File

Keyboard Command: new

Prerequisite: None

Open

Function

This command allows you to open an existing drawing file. Carlson TakeOff displays the Select File dialog box (a standard file selection dialog box). Select a file and click Open.

Prerequisite: None

Keyboard Command: OPEN

Close

Function

This command allows you to close the current drawing. Carlson TakeOff closes the current drawing if there have been no changes since the drawing was last saved. If you have modified the drawing, the program prompts you to save or discard the changes. You can close a file that has been opened in Read-only mode if you have made no changes or if you are willing to discard changes. To save changes to a read-only file, you must use the SAVEAS command.

Prerequisite: None
Keyboard Command: CLOSE

Save

Function

If the drawing is named, Carlson TakeOff saves the drawing without requesting a file name. If the drawing is unnamed, the program displays the Save Drawing As dialog box (see SAVEAS) and saves the drawing with the file name you specify. If the drawing is read-only, use the SAVEAS command to save the changed file under a different name. This command allows you to save the drawing under the current file name or a specified name.

Prerequisite: None

Keyboard Command: SAVE or QSAVE

Save As

Function

This command allows you to save an unnamed drawing with a file name or renames the current drawing.

Carlson TakeOff displays the Save Drawing As standard file selection dialog box. Enter a file name and type. You can select any of the following file types:

- Carlson Software 2002/AutoCAD 2000 (*.dwg)
- AutoCAD R14/LT 98/LT 97 Drawing (*.dwg)
- AutoCAD R13/LT 95 Drawing (*.dwg)
- Drawing Template File (*.dwt)
- Carlson Software 2002 DXF (*.dxf)
- AutoCAD R14/LT 98/LT 97 DXF (*.dxf)
- AutoCAD R13/LT 95 DXF (*.dxf)
- AutoCAD R12/LT2 DXF (*.dxf)

Carlson TakeOff saves the file under the specified file name. If the drawing is already named, the program saves the drawing to the new file name. If you save the file as a drawing template, the program displays the Template Description dialog box, where you can provide a description for the template and set the units of measurement.

Saving a drawing in Release 14/LT 98/LT 97 format is subject to the following limitations:

- Hyperlinks are converted to Release 14 attached URLs.
- Database links and freestanding labels are converted to Release 14 links and displayable attributes.
- Database attached labels are converted to MText and leader objects, and their link information is not available. Attached labels are restored if you open the drawing in AutoCAD 2000 or later.
- Lineweight information is not available. Lineweights are restored if you open the drawing in AutoCAD 2000 or later.

Saving a drawing in Release 13/LT 95 format is subject to the following limitations:

- Lightweight polyline and hatch patterns are converted to R13 polylines and hatch patterns.
• Raster objects are displayed as bounding boxes. Raster objects are restored if the drawing is opened in AutoCAD 2000 or later.
• Draw order information is not applied for display or print.
• Xrefs that have been clipped with a boundary box are displayed in full as attached xrefs because Release 13 does not support xref clipping. Clipping is restored if the drawing is opened in AutoCAD 2000 or later.

Saving a drawing in Release 12/LT 2 DXF format is subject to the following limitations:
• Lightweight polylines and hatch patterns are converted to R12 polylines and hatch patterns.
• All solids, bodies, regions, ellipses, leaders, multilines, rays, tolerances, and xlines are converted to lines, arcs, and circles as appropriate.
• Groups, complex linetypes, OLE objects, and preview images are not displayed.
• Many objects are lost if you save a drawing as Release 12 and open it later in AutoCAD 2000 or later.

**Prerequisite:** None

**Keyboard Command:** SAVEAS

---

**Page Setup**

**Function**

This command allows you to configure your drawing for plotting. The Page Setup dialog box has the same options as the Plot dialog box. See the PLOT command below for a detailed description of options.

**Menu Location:** File

**Prerequisite:** None

**Keyboard Command:** PAGESETUP

---

**Plot Preview**

**Function**

This option displays the drawing as it will appear when plotted on paper. To exit the print preview, right-click and choose Exit. This command is the same as the Full Preview option under Plot.

**Menu Location:** File

**Prerequisite:** None

**Keyboard Command:** PREVIEW

---

**Plot**

**Function**

This command allows you to plot a drawing to a plotting device or file.

Carlson TakeOff displays the Plot dialog box. Choose OK to begin plotting with the current settings and display the Plot Progress dialog box.
The Plot dialog box includes the tabs, Plot Device and Plot Settings, and several options to customize the plot.

- **Layout Name:** This option displays the current layout name or displays “Selected layouts” if multiple tabs are selected. If the Model tab is current when you choose Plot, the Layout Name shows “Model.”
- **Save Changes to Layout:** This option saves the changes you make in the Plot dialog box in the layout. This option is unavailable if multiple layouts are selected.
- **Page Setup Name:** This option displays a list of any named and saved page setups. You can choose to base the current page setup on a named page setup, or you can add a new named page setup by choosing Add.
- **Add:** This option displays the User Defined Page Setups dialog box. You can create, delete, or rename named page setups.

2. Under the Plot Device Tab you can specify the plotter to use, a plot style table, the layout or layouts to plot, and information about plotting to a file.

- **Plotter Configuration:** This field displays the currently configured plotting device, the port to which it's connected or its network location, and any additional user-defined comments about the plotter. A list of the available system printers and PC3 file names is displayed in the Name list. An icon is displayed in front of the plotting device name to identify it as a PC3 file name or a system printer.
- **Properties:** The option displays the Plotter Configuration Editor (PC3 Editor), where you can modify or view the current plotter configuration, ports, device, and media settings.
- **Hints:** This option displays information about the specific plotting device.
- **Plot Style Table (Pen Assignments):** This option sets the plot style table, edits the plot style table, or creates a new plot style table.
- **Name:** This option displays the plot style table assigned to the current Model tab or layout tab and a list of the currently available plot style tables. If more than one layout tab is selected and the selected layout tabs have different plot style tables assigned, the list displays “Varies.”
• Edit: This option displays the Plot Style Table Editor, where you can edit the selected plot style table.
• New: This option displays the Add-a-Plot-Style-Table wizard, which you can use to create a new plot style table.
• Plot Stamp: This option places a plot stamp on a specified corner of each drawing and/or logs it to a file.
• On: This option turns on plot stamping.
• Settings: This option displays the Plot Stamp dialog box, where you can specify the information you want applied to the plot stamp, such as drawing name, date and time, and plot scale.
• What to Plot: This field defines the tabs to be plotted.
• Current Tab: This option plots the current Model or layout tab. If multiple tabs are selected, the tab that shows its viewing area is plotted.
• Selected Tabs: This option plots multiple preselected Model or layout tabs. To select multiple tabs, hold down CTRL while selecting the tabs. If only one tab is selected, this option is unavailable.
• All Layout Tabs: This option plots all layout tabs, regardless of which tab is selected.
• Number of Copies: This option denotes the number of copies that are plotted. If multiple layouts and copies are selected, any layouts that are set to plot to a file or AutoSpool produce a single plot.
• Plot to File: This option plots output to a file rather than to the plotter.
• File Name: This option specifies the plot file name. The default plot file name is the drawing name and the tab name, separated by a hyphen, with a .plt file extension.
• Location: This option displays the directory location where the plot file is stored. The default location is the directory where the drawing file resides.
• [...] This option displays a standard Browse for Folder dialog box, where you can choose the directory location to store a plot file.

3 Under the Plot Settings Tab you specify paper size, orientation, plot area and scale, offset, and other options.
• Paper Size and Paper Units: This field displays standard paper sizes available for the selected plotting device. Actual paper sizes are indicated by the width (X axis direction) and height (Y axis direction). If no plotter is selected, the full standard paper size list is displayed and available for selection. A default paper size is set for the plotting device when you create a PC3 file with the Add-a-Plotter wizard. The paper size you select is saved with a layout and overrides the PC3 file settings. If you are plotting a raster image, such as a BMP or TIFF file, the size of the plot is specified in pixels, not in inches or millimeters.

• Plot Device: This field displays the name of the currently selected plot device.

• Paper Size: This field displays a list of the available paper sizes.

• Printable Area: This field displays the actual area on the paper that is used for the plot based on the current paper size.

• Inches: This option allows you to specify inches for the plotting units.

• MM: This option allows you to specify millimeters for the plotting units.

• Drawing Orientation: This option specifies the orientation of the drawing on the paper for plotters that support landscape or portrait orientation. You can change the drawing orientation to achieve a 0-, 90-, 180-, or 270-degree plot rotation by selecting Portrait, Landscape, or Plot Upside-Down. The paper icon represents the media orientation of the selected paper. The letter icon represents the orientation of the drawing on the page.

• Portrait: This option orients and plots the drawing so that the short edge of the paper represents the top of the page.

• Landscape: This option orients and plots the drawing so that the long edge of the paper represents the top of the page.

• Plot Upside-Down: This option orients and plots the drawing upside down.

• Plot Area: This option specifies the portion of the drawing to be plotted.

• Layout: This option plots everything within the margins of the specified paper size, with the origin calculated from 0,0 in the layout. Available only when a layout is selected. If you choose to turn off the paper image and layout background on the Display tab of the Options dialog box, the Layouts selection becomes Limits.

• Limits: This option plots the entire drawing area defined by the drawing limits. If the current viewport does not display a plan view, this option has the same effect as the Extents option. Available only when the Model tab is selected.

• Extents: This option plots the portion of the current space of the drawing that contains objects. All geometry in the current space is plotted. TakeOff may regenerate the drawing to recalculate the extents before plotting.

• Display: This option plots the view in the current viewport in the selected Model tab or the current paper space view in the layout.

• View: This option plots a previously saved view. You can select a named view from the list provided. If there are no saved views in the drawing, this option is unavailable.

• Window: This option plots any portion of the drawing you specify. If you select Window, the Window button becomes available. Choose the Window button to use the pointing device to specify the two corners of the area to be plotted or enter coordinate values.

• Plot Scale: This option controls the plot area. The default scale setting is 1:1 when plotting a layout. The default setting is Scaled to Fit when plotting a Model tab. When you select a standard scale, the scale is displayed in Custom.

• Scale: This option defines the exact scale for the plot. The four most recently used standard scales are displayed at the top of the list.

Chapter 4. File Menu 181
• Custom: This option creates a custom scale. You can create a custom scale by entering the number of inches or millimeters equal to the number of drawing units.

• Scale Lineweights: This option scales lineweights in proportion to the plot scale. Lineweights normally specify the linewidth of printed objects and are plotted with the linewidth size regardless of the plot scale.

• Plot Offset: This field specifies an offset of the plotting area from the lower-left corner of the paper. In a layout, the lower-left corner of a specified plot area is positioned at the lower-left margin of the paper. You can offset the origin by entering a positive or negative value. The plotter unit values are in inches or millimeters on the paper.

• Center the Plot: This option automatically calculates the X and Y offset values to center the plot on the paper.

• X: This field specifies the plot origin in the X direction.

• Y: This field specifies the plot origin in the Y direction.

• Plot Options: This field specifies options for lineweights, plot styles, and the current plot style table. You can select whether lineweights are plotted. By selecting Plot with Plot Styles, you plot using the object plot styles that are assigned to the geometry, as defined by the plot style table.

• Plot object lineweights: This option plots lineweights.

• Plot with Plot Styles: This option plots using the plot styles applied to objects and defined in the plot style table. All style definitions with different property characteristics are stored in the plot style tables and can be easily attached to the geometry. This setting can replace pen mapping in earlier versions of AutoCAD.

• Plot Paperspace Last: This option plots model space geometry first. Paper space geometry is usually plotted before model space geometry.

• Hide Objects: This option plots layouts with hidden lines removed for objects in the layout environment (paper space). Hidden line removal for model space objects in viewports is controlled by the Viewports Hide property in the Object Property Manager. This is displayed in the plot preview, but not in the layout.

• Full Preview: This option displays the drawing as it will appear when plotted on paper. To exit the print preview, right-click and choose Exit.

• Partial Preview: This option quickly shows an accurate representation of the effective plot area relative to the paper size and printable area. Partial preview also gives advance notice of any warnings that you might encounter when plotting. The final location of the plot depends on the plotter. Changes that modify the effective plot area include those made to the plot origin, which you define under Plot Offset on the Plot Settings tab. If you offset the origin so much that the effective area extends outside the preview area, the program displays a warning.

Prerequisite: None

Keyboard Command: PLOT

Import Xref to Current Drawing

Function

This command allows you to import external reference files (Xrefs) into the current drawing. Before Xrefs are imported, the drawing data from the Xrefs can be viewed but not modified. This import routine has a simpler method for importing than the Xref Manager command. A list is shown of the Xrefs that are attached to the current drawing. If the Xref file is not found, you can pick the Set Path button to locate the drawing file. To import an Xref, highlight the file name and Pick Import.
Prerequisite: files to import

Keyboard Command: import_xref

**Xref Manager**

**Function**

Attaches, overlays, lists, binds, detaches, reloads, unloads, renames, and modifies paths to external references (Xrefs) in the current (or host) drawing. Displays the Xrefs in the drawing in a tree view or a list view. You can use the F3 and F4 keys to switch between list view and tree view.
List View: Displays a flat listing of the attached Xrefs and their associated data. You can sort the list of references by name, status, type, file date, file size, or the saved path and file name.

Reference Name: Lists the names of the Xrefs as stored in the definition table for the drawing. Status: Shows whether the Xref is loaded, unloaded, unreferenced, not found, unresolved, orphaned, or marked for unloading or reloading.

- Loaded: Currently attached to the drawing.
- Unloaded: Marked to be unloaded from the drawing once the Xref Manager is closed.
- Unreferenced: Attached to the drawing but erased.
- Not Found: No longer exists in the valid search paths.
- Unresolved: Cannot be read by AutoCAD.
- Orphaned: Attached to another Xref that is unreferenced, unresolved, or not found.

Size: Shows the file size of the corresponding reference drawing. The size is not displayed if the Xref is unloaded, not found, or unresolved.

Type: Indicates whether the Xref is an attachment or an overlay.

Date: Displays the last date the associated drawing was modified. This date is not displayed if the Xref is unloaded, not found, or unresolved.

Saved Path: Shows the saved path of the associated Xref (this is not necessarily where the Xref is found).

Tree View: Displays a hierarchical representation of the Xrefs, displaying the relationships between Xref definitions. Tree view shows the level of nesting relationship of the attached Xrefs, whether they are attached or overlaid, and whether they are loaded, unloaded, marked for reload or unload, or not found, unresolved, or unreferenced.

Attach: Displays the External Reference dialog box if an external reference is selected or displays the Select Reference File dialog box if no external reference is selected.

Detach: Detaches one or more Xrefs from your drawing, erasing all instances of a specified Xref and marking the Xref definition for deletion from the symbol table. Only the Xrefs attached or overlaid directly to the current drawing can be detached; nested Xrefs cannot be detached. Carlson TakeOff cannot detach an Xref referenced by another Xref or block.

Reload: Marks one or more Xrefs for reloading. This option rereads and displays the most recently saved version of the drawing.

Unload: Unloads one or more Xrefs. Unloaded Xrefs can be easily reloaded. Unlike detaching, unloading does not remove the Xref permanently. It merely suppresses the display and regeneration of the Xref definition to improve performance.

Bind: Displays the Bind Xrefs dialog box Xref. The Bind option makes the selected Xref and its dependent symbols (such as blocks, Xref styles, dimension styles, layers, and linetypes) a part of the current drawing.

Found At: Displays the full path of the currently selected Xref. This is where the Xref is actually found and is not necessarily the same as the saved path.

Browse: Displays the Select New Path dialog box (a standard file selection dialog box), in which you can select a different path or file name.

Save Path: Saves the path, as it appears in Xref Found At, to the currently selected Xref.
Prompts

Command: _Xref
Overlay Xref "example1": ..\..\..\..\Program Files\Carlson TakeOff 2004\WORK\example1.dwg
"example1" loaded: G:\oem4\src2\work\example1.dwg

Specify insertion point or [Scale/X/Y/Z/Rotate/PScale/PX/PY/PZ/PRotate]:
Command: Specify opposite corner:
Select objects: Enter

Prerequisite: multiple files

Keyboard Command: Xref

Import LandXML File

The Import LandXML File routine provides a mechanism where land-based data from other software applications (including Carlson Software) can be brought into a project and used for analysis and/or design purposes. To import a LandXML file, a series of dialog boxes are presented:

Select LandXML File: Specify the name of a LandXML file you wish to import.

LandXML Units: Indicates the Units of Measure associated with the incoming LandXML file (see the Unit Differences item below).
**Point Protection:** When enabled, you are prompted for a course of action if an existing LandXML file you've selected contains COGO points that have the same number(s) as those that already exist in the drawing. When disabled, existing point data in the project is updated with the values from the LandXML file.

**Destination File Method:** This option allows you to indicate how the incoming data file(s) are named as they are imported.

**Load Surfaces into Surface Manager:** When enabled, this option will automatically add surface model (TIN) data into the Surface Manager and graphically represents (draws) the surface model/contours according to the current settings found in the Triangulate & Contour command.

**Use Old FLT Triangulation File Format to Import Surface Data:** When enabled, the older ASCII-based Carlson *.FLT file format will be used in place of the newer and more efficient *.TIN file format.

**Save All Existing Ground Profiles from One Centerline to the Same File:** When enabled, collections of existing ground profiles associated with a particular centerline are combined into a single *.PRO file.

**Change Directory:** This option allows you to adjust the folder location where the new data files will be written.

**Import from LandXML:** Enable or disable various entries that should used to produce the data files found within the LandXML file.

---

**Unit Differences:** If the Units of Measure specified in the LandXML file are different than those found in Drawing Setup, you will be prompted for a course of action.

**Manning's "n":** If you are importing sewer data from a LandXML file and if the LandXML file does not carry Manning’s "n" values, you will be prompted to specify a default Manning’s "n" value for all incoming sewer entities that don't already have a Mannings "n" value.
Import Structures: If you are importing sewer data from a LandXML file and structure values specified in the LandXML file do not exist in the Structure Library, you will be prompted to indicate the structure(s) that should be imported into the Structure Library. Use standard Windows click, shift+click and/or ctrl+click functionality to select multiple structures at the same time.

Note:

- The LandXML initiative is being driven by the land development industry as an acceptable means to share and transfer land data rather than the traditional graphical representation of that data. It also provides an effective means for transferring a variety data (points, centerlines, profiles, surface models, sewer data, etc). Another advantage of LandXML is that the LandXML data structure is CAD and software vendor neutral (meaning you don’t have to own or use the CAD or software product used by your data provider).

Pulldown Menu Location(s): File → LandXML

Keyboard Command: landxml_import

Prerequisite: A LandXML file to import

Export LandXML File

The Export LandXML File routine provides a mechanism where data can be sent from Carlson Software into a LandXML file for use in other applications that support the LandXML data specification. To generate a LandXML file, a series of dialog boxes are presented:

Export to LandXML: This option allows you to individually select the desired Carlson Software data file(s) that should be included in the LandXML file.
**Project Data Files:** This option allows you to quickly select the various data files associated with, and defined by a Carlson Project (*.prj) file.

**Select LandXML File:** Specify the name of a LandXML file you wish to create.

![Export to LandXML File dialog box]

**Include Files Referenced in Select Files:** When enabled, this option will automatically add other files that are referenced by the selected file. As an example, the file produced by the Carlson RoadNet command references TINs, Centerlines, Profiles, etc., and adding the single RoadNet file will also add the referenced file(s) into the Export to LandXML File dialog box.

**Export to LandXML File:** Add, remove (using standard Windows **click**, **shift+click** and/or **ctrl+click** functionality) or otherwise organize the data file(s) that is to be incorporated into the LandXML file.

**Change Directory:** This option allows you to adjust the folder location from where selected data files should be referenced (often used for project revision purposes).

**Report:** Create a report (suitable for file transmission or archivale purposes) of the file(s) selected to be incorporated into the LandXML file.
LandXML Units: Specify the desired Units of Measure that reflect the outgoing data.

Point Protection: When enabled, you are prompted for a course of action if an existing LandXML file you've selected contains COGO points that have the same number(s) as those being selected for the LandXML file. When disabled, point data you've selected for the LandXML file are automatically written to (or updated into) the existing LandXML file.

Exported Element Protection: When enabled, you are prompted if existing data (such as a centerline) in a LandXML file should be updated with data of the same name that you have selected for the LandXML file.

Precision: Set the desired level of precision for each of the various measurement categories.

Note:

- The LandXML initiative is being driven by the land development industry as an acceptable means to share and transfer land data rather than the traditional graphical representation of that data. It also provides an effective means for transferring a variety data (points, centerlines, profiles, surface models, sewer data, etc). Another advantage of LandXML is that the LandXML data structure is CAD and software vendor neutral (meaning you don't have to own or use the CAD or software product used by your data provider).

Pulldown Menu Location(s): File → LandXML

Keyboard Command: landxml_export

Prerequisite: Carlson project data files to convert

**Write Polyline File**

This command creates a polyline file that contains the point data of the select polylines. The objects supported by this tool include polylines, arcs and lines. If you want to include text, you must use the Text Explode To Polylines command found in the Edit menu to convert the text to polylines before running this command. Several different
output formats are supported.

The Carlson format (.PLN) is a text file format that is used by some Carlson commands and by machine control (Carlson Grade, Dozer 2000, GradeStar) for the plan view. Each polyline begins with a line of "POLYLINE, Color number". Then the points for the polyline are listed on separate lines in X,Y,Z format. Here is a list of the available color numbers:

<table>
<thead>
<tr>
<th>Color Number</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Black</td>
</tr>
<tr>
<td>1</td>
<td>Blue</td>
</tr>
<tr>
<td>2</td>
<td>Green</td>
</tr>
<tr>
<td>3</td>
<td>Cyan</td>
</tr>
<tr>
<td>4</td>
<td>Red</td>
</tr>
<tr>
<td>5</td>
<td>Magenta</td>
</tr>
<tr>
<td>6</td>
<td>Brown</td>
</tr>
<tr>
<td>7</td>
<td>Light Gray</td>
</tr>
<tr>
<td>8</td>
<td>Dark Gray</td>
</tr>
<tr>
<td>9</td>
<td>Light Blue</td>
</tr>
<tr>
<td>10</td>
<td>Light Green</td>
</tr>
<tr>
<td>11</td>
<td>Light Cyan</td>
</tr>
<tr>
<td>12</td>
<td>Light Red</td>
</tr>
<tr>
<td>13</td>
<td>Light Magenta</td>
</tr>
<tr>
<td>14</td>
<td>Yellow</td>
</tr>
<tr>
<td>15</td>
<td>White</td>
</tr>
</tbody>
</table>

The DTM and Idan formats create linework files for the DTM and Idan programs.

The Google option creates a KML file that can be imported into Google Earth. The coordinate system for the drawing must be defined in Drawing Setup before running this function.

The MicroStation format (.txt) can be imported into MicroStation. This format has the coordinates as space delimited for each polyline point. There is an extra column with a 1 or 0 where 1 specifies the start of a new polyline.

The Moss format creates a INP file for the MX/MOSS Genio program. There is a translation table for converting the CAD layers to MX codes.

The Peabody format is a company specific format for Peabody Energy.

The Topcon format creates a Topcon LN3 file.

**Prompts**

Polyline file format [<Carlson>/DTM/Google/Idan/MicroStation/MOSS/Peabody/Topcon]? press Enter for Carlson format

Specify File to Write dialog create a new file or append to existing

Polyline file for Grid File Utilities macro [Yes/<No>?] press Enter The option will write a polyline file that can be used with Grid File Utilities for inclusion/exclusion perimeters.

Include Z coordinate in polyline file [Yes/<No>?] press Enter This option controls whether the polyline vertices are written in 2D or 3D.

Specify Exclusion/Warning Polylines [Yes/<No>?] press Enter This option applies to machine control for warning areas.
Specify WorkZone Polylines [Yes/<No>]? press Enter This option applies to machine control for working areas.
Reduce Polyline Vertices [<Yes>/No]? press Enter This option applies Reduce Polyline to the polyline vertices before writing the file.
Enter reduce offset cutoff <0.1>: press Enter
Decimal places for coordinates <2>: press Enter
Select polylines, lines and arcs to write.
Select objects: pick the entities to process
Done.

Sample Polyline File:

POLYLINE,15
47639.82,74540.11,0.00
47670.49,74565.79,0.00
47701.08,74591.49,0.00
49375.61,76358.47,0.00
50066.86,76846.75,0.00
POLYLINE,15
47633.24,74547.97,0.00
47663.90,74573.65,0.00
etc...

Pulldown Menu Location: File->Polyline File
Keyboard Command: polywrite
Prerequisite: Polylines in the drawing

Draw Polyline File

This command draws polylines from the selected polyline file. These polylines are drawn in the current layer. This command supports the following formats: Carlson (.PLN), Idan (.DIS), MicroStation (.TXT), MOSS (.INP, .PRN) and Topcon Pocket 3D (.TXT).

Prompts

Polyline file format [<Carlson>/DTM/Idan/MicroStation/MOSS/Topcon]? press Enter to accept Carlson
Polyline File to Read Dialog select existing .PLN file
Pulldown Menu Location: File->Polyline File
Keyboard Command: polydraw
Prerequisite: A polyline file
File Name: \lsp\scadutil.arx

Clipboard

Function

This command allows for different cut, copy, and paste options.

Cut
To cut objects to the Clipboard.
- Select the objects you want to cut.
- From the Clipboard command, choose Cut.

The objects are available to be pasted into other Windows applications.

**Copy**

To copy objects to the Clipboard.
- Select the objects you want to copy.
- From the Clipboard command, choose Copy.

**Copy with Base Point**

To copy objects to the Clipboard. When the objects are pasted into a drawing, the program places them relative to the specified base point.
- Select the objects you want to copy.
- From the Clipboard command, choose Copy with Base Point.
- Specify the base point.

**Paste**

The objects currently on the Clipboard are pasted into the drawing at the specified insertion point.
- From Clipboard command, choose Paste.

**Paste as Block**

The objects currently on the Clipboard are pasted into the drawing as a block at the specified insertion point.
- From Clipboard command, choose Paste as Block.

**Paste to Original Coordinates**

The objects currently on the Clipboard are pasted into the drawing using the coordinates from the original drawing.
- From Clipboard command, choose Paste to Original Coordinates.
Drawing Cleanup

The Drawing Cleanup dialog box allows you to perform many functions that fix common errors, and it removes unnecessary data found in many drawing files. It also converts incompatible data into useful entities. This command offers many filters that audit the drawing file and allows you to select which options and settings you want to use. A report of the cleanup results will be displayed upon completion. Always save your file when the drawing cleanup routine is complete.

Set User Coordinate System (UCS) to World Coordinates: This sets the UCS (user coordinate system) to the world coordinate system (WCS). Carlson works exclusively in the world coordinate system and there is no way to change this setting. In CAD, it is possible to change the coordinate system from WCS. If you receive a drawing in which the coordinate system is not set to world, click this on to restore the UCS.

Convert Architectural Inches Units to Decimal Feet: When enabled, this option will convert an architectural inch-based drawing into a decimal foot unit.

Import Xrefs to Current Drawing: If available, externally referenced drawings will be merged into the current drawing.

Remove Layers With No Entities: Drawings work with a "LAYER" concept meaning that layer definitions define the drawing. For example, the layer named EOP might be used to display polylines at the Edge Of Pavement in the drawing. Many times extra layers are created by a user but not contain any objects. This function removes any layers defined in the drawing that are not being used.

Remove Unused Blocks, Linetypes and Styles: This functions removes this unused blocks, linetypes and text styles from the drawing.

Remove Duplicate Linework: This function finds any duplicate linework in the drawing and removes all but one set.

Remove Overlapping Polyline Loops: Polylines that completely overlap themselves are broken into two different polylines.
Join Linework With Same Endpoint: This function finds common endpoints on linework on common layers with common elevations and joins the linework into a continuous polylines. This is very helpful for future selection sets.

Convert Splines, Multilines and Regions Into Polylines: Some CAD applications utilize Spline Object Definitions and Regions whereas Carlson utilizes basic polyline/polygon definitions. This function finds any Splines and/or Regions defined in the drawing and re-defines them as simple polylines or polygons.


Convert LDD-AEC Contours and Points Into Carlson Format: Drawings created in the Land Development Desktop CAD program can contain special objects known as LDD-AEC contours that define their topographic contour display. This function locates those special objects and re-defines them as simple 2D polylines retaining their elevation values.

Convert Entities With Extrusion To World Coordinates: This function converts entities that have an extrusion direction that is other than the "World" direction into World coordinates. A common example includes arcs that are drawn in a user coordinate system to mimic a "3D" arc (an arc with varied elevations).

Erase Blank Text Entities: Text definitions in the drawing that do not contain any text characters will be removed when this option is enabled.

Erase Hatch Entities: Carlson offers many hatch display options, however hatch entities have no 3D value. This function removes all hatch entities in the original drawing to help reduce the size and clutter of the drawing file.

Remove Zero Length and Fragment Linework & Length Cutoff: This function seeks out and removes any linework definitions that have a length shorter than the Length Cutoff. Point nodes are not removed.

Remove Arcs From Polylines & Offset Cutoff: This function replaces arcs in polylines with a series of short chord segments. The purpose is to prepare the polylines for modeling since arcs need to be converted into segments to be part of the triangulation model. The density of chord segments is controlled by the offset cutoff. This cutoff represents how much the polyline can move horizontally. A smaller cutoff will result in more chord segments. The option for 3D Only controls whether only polylines at zero elevation or both zero and elevated polylines get processed. Sometimes you may want to leave the arcs in zero elevation polylines when these polylines represent road alignments and are not part of the surface model.

Reduce Polyline Vertices & Offset Cutoff: This function utilizes a pre determined offset amount and removes unnecessary polyline vertices that fall within the offset amount.

Set Elevations Outside Range to Zero & Elevation Range: This function comes with a “Scan DWG” option that audits the elevation range in the drawing file. Once the minimum and maximum elevation range has been set, manually or by a scan, all objects that fall outside the set range are moved to elevation zero allowing them to be easily ignored by the Triangulate & Contour routine.

Entities To Process: This allows you to run the command for the entire drawing or for a selected set.

Clear: This option disables all options allowing you to enable only the few that you wish to process.
Defaults: This allows you to return to the Carlson Drawing Cleanup options to default settings.

Final Report: This example report displays the results of drawing cleanup. Like all reports in Carlson, this report can be saved to a text file, sent directly to your printer, or pasted onto the screen as text entities.

Audit Function

This command scans your current drawing and looks for any corruption and has the option to fix any errors.

Prerequisite: none

Keyboard Command: audit

Recover Function

This command opens a drawing file and scans it for errors. Use this command if Carlson TakeOff crashes while using the regular Open command.
Remove Reactors

This command removes the reactor links from the selected points, text, polylines and lines. This disables the links for points to the coordinate (.CRD) file, annotation with linework and linework with points. Note that in General Settings there is a section called Object Linking. This is the specific section that contains the options for creating these reactors to the drawing entities. Reactors can be turned off for entities created later by clicking off the four link options in General Settings. To get to this dialog go to Settings > Configure > General Settings.

Prompts

Select entities to remove reactors from:
Select objects: pick the entities
Pulldown Menu Location: File > Drawing Utilities
Keyboard Command: delreact
Prerequisite: Entities with reactors
File Name: \lsp\crdutil.arx

Remove Groups

This command is used to "ungroup" selected entities that, prior to using this command, were part of a group. For our purposes, we might more specifically be referring to Carlson's Point Entity Grouping feature. A group is a named selection set of objects. This routine removes selected entities from groups. It is especially useful when dealing with our Carlson points.

More on Point Entity Grouping: As mentioned in the Points chapter, remember that for each point, the point attribute block, node, and symbol can be bound together. This means that if you choose to use the Move command (or other CAD tools) the entire collection moves together. This is done using the grouping functionality in AutoCAD or IntelliCAD. To disable this system altogether, go to Configure, choose General Settings, and turn off the toggle for Group Point Entities. If you need to temporarily disable grouping in a drawing, you can use the AutoCAD toggle for grouping, which is Ctrl-A. Holding down the Ctrl key, and pressing the letter A on the keyboard, activates this two-way toggle, with the current status echoed to the command prompt area.

Prompts

Select entities to remove from groups.
Select objects: select entities
Pulldown Menu Location: File > Drawing Utilities
Keyboard Command: rmgroup
Prerequisite: Entities in group(s)
File Name: \lsp\poly3d.arx
Remove XData

This command removes the xdata (Extended Entity Data) from the selected entities. Many Carlson routines add xdata to entities in order to add extra program specific information to them. Carlson programs use the xdata to make entities more intelligent. For example, when you draw a centerline (.cl) as a polyline, xdata is attached to the polyline that stores the reference of the .cl file name. Then if you double-click the polyline, then the program can read the xdata to know the polyline is a centerline and launch the centerline editor. By removing the xdata, the entities revert to regular CAD entities which is useful if you want to detach these entities from the program links.

Prompts

Select entities to remove extended entity data from.
Select objects: pick the entities

Pulldown Menu Location: File > Drawing Utilities
Keyboard Command: xxdata
Prerequisite: Entities with xdata

Purge

Function

Displays a tree view summary of all named objects that can and can't be purged in the current drawing. The View Items You Can Purge and View Items You Cannot Purge options toggle the dialog box display, showing different options and tree view summaries.
**Items Not Used in Drawing**: Displays a tree view of all named object categories (blocks, layers, and so on) in the current drawing. A plus sign appears next to the object category names that you can purge. Clicking the plus sign or double-clicking an object category expands the tree view, displaying all unused named objects that exist for the category. To purge all unused named objects, select All Items in the tree view, and choose Purge All. To purge a specific named object category, select the category in the tree view, and choose Purge.

**Confirm Each Item to Be Purged**: Displays the Verify Purge dialog box when you purge an item.

**Purge Nested Items**: Removes all unused named objects from the drawing even if they are contained within or referenced by other unused named objects. The Verify Purge dialog box is displayed, and you can cancel or confirm the items to be purged.

**Prerequisite**: None

**Keyboard Command**: purge
In addition to powerful CAD engine editing commands, the Carlson Edit menu has the additional commands which are explained in this section. Commands that are pure AutoCAD or IntelliCAD are not detailed here. They can be found in the CAD manual.
Undo

Function
This command allows you to reverse the effect of previously issued commands.

Prerequisite: None

Keyboard Command: U

Redo

Function
This command allows you to reverse the effects of the previous UNDO command.

Prerequisite: None

Keyboard Command: REDO

Erase Select

Function
This command allows you to remove objects from a drawing.

Prerequisite: None

Keyboard Command: ERASE, E

Erase by Layer

This command will ERASE all the entities on the specified layers but will not delete these layers from the drawing. The command prompts for the layer name to erase and then erases all entities on that layer. In addition to typing in the layer name, you can also specify a layer to delete by picking an entity on that layer. To select layers by picking, first click the Select Layers from Screen button and then select the entities on the layers to be deleted. The Select Layers by Name button allows you to choose a layer name from a list of layers in the drawing. You can also specify which types of entities to erase. For instance, if you have both linework and points on the same layer and you want to erase only the linework, you can click off All and check Line and Polyline.
Pulldown Menu Location: Edit > Erase

Keyboard Command: ldel

Prerequisite: Something to erase

File Name: \lsp\dellayr.lsp

Erase by Closed Polyline

This tool is used to clean up drawing geometry at the extents of a polyline boundary. It provides options to erase adjacent geometry as well as trim geometry crossing the fence of the polyline.

First, select the boundary polyline. Only one can be selected. Designate the desired options in the following dialog. The top section of the dialog allows you to toggle which object types should be affected by the operation. Note that some of the objects, such as text and inserts, cannot be trimmed.
In the middle of the dialog is a toggle that determines whether to prompt for objects to process. If you want to isolate the drawings contents to that of the selected polyline, turn this toggle on. Note that all geometry in the drawing is effected, even geometry that is outside of the current viewport. Many users will prefer to turn this toggle off, so that they can be prompted to manipulate the geometry.

The bottom row allows you to choose whether to erase all the entities on the inside or outside of the polyline.

**Pulldown Menu Location:** Edit > Erase
**Keyboard Command:** erasepline
**Prerequisite:** Entities and a closed polyline
**File Name:** `\lsp\poly3d.arx`

Erase Outside

This command erases all the entities outside of a user specified window. This can be useful if you somehow place entities way outside your drawing limits and want to easily erase them.

**Prompts**

**Pick 1st corner of window to erase outside of:** *Pick point location*
**Pick 2nd corner:** *Pick second point location*

**Pulldown Menu Location:** Edit > Erase
**Keyboard Command:** eraseout
**Prerequisite:** Entities to erase
**File Name:** `\lsp\surv1.lsp`

Temporary Erase

This command erases the selected entities while keeping track of their data to allow restoring them. To unerase the entities, simply run the command again. The program keeps track of the erased data only during the current drawing session. If you exit the drawing, the entities cannot be restored when the drawing is opened again.
Prompts

Select entities for temporary erase.
Select objects: pick entities to erase

Pulldown Menu Location: Edit > Erase
Keyboard Command: terase
Prerequisite: Entities to erase

Move

Function

This command allows you to displace objects a specified distance in a specified direction.
Prerequisite: None
Keyboard Command: MOVE, M

Standard Copy

Function

This command copies all objects you select to the Clipboard. You can paste the contents of the Clipboard into a document or drawing as an OLE object.

You can also use CTRL+C to run this command. If the cursor is in the drawing area, Carlson TakeOff copies the selected objects to the Clipboard. If the cursor is on the command line or in the text window, the program copies the selected text to the Clipboard.
Prerequisite: None
Keyboard Command: COPY

Copy To Layer

This command is used to copy a selected entity or entities and put the copy in a specified layer. Once copied to the chosen layer the entity or entities will take on the characteristics of that layer (color, linetype, etc.).
Prompts

Select entities to copy.
Select objects: select entities
Select Layer dialog select a layer from list and click OK

Pulldown Menu Location: Edit > Copy
Keyboard Command: copy2layer
Prerequisite: Entities to be copied
File Name: \lsp\surv1.lsp

Copy Polyline Section

This command is used to copy a portion of a polyline, at specified points, and put the copied portion onto another layer. The portion of existing polyline that is being copied still remains as part of the original entity (with no break), while the new portion, with its chosen layer designation, is a new polyline.

Prompts

Select polyline to copy: Pick a polyline
Select first break point along polyline: Pick location on the polyline
Select second break point along polyline: Pick the second location on the same polyline
Layer name <CTR>: wall

Pulldown Menu Location: Edit > Copy
Keyboard Command: copy_pl
Prerequisite: Polyline to be copied

Standard Offset

Function
This command creates a new object at a specified distance from an existing object or through a specified point. Offset does not support 3D polylines. Use Offset 3D Polyline to offset these entities.

Prompts
1 Specify offset distance or [Through] <Through>: Press Enter

The Through option allows you to screen pick the location of the offset. You can also enter a value for the interval of the offset.

2 Select object to offset or <exit>: select entity

3 Specify through point: pick point

Menu Location: Edit

Prerequisite: None

Keyboard Command: OFFSET

### Variable Offset

This is a command to offset a polyline, with different offset amounts for each polyline segment of the same polyline. The offset distances can be variable, and you choose between a Line or a Point method at the command line.

Prompts

Vary offsets by line segments or at points [<Line>/Point]? press Enter

Select a polyline to offset (Enter for none): pick polyline

Select side to offset: pick a point on the side to offset to

As you go from segment to segment, you can enter in different offset values for each line segment.

Enter the segment horizontal offset <0.000>: 56

Enter the segment horizontal offset <56.000>: 33

Select a polyline to offset (Enter for none): press Enter

Pulldown Menu Location: Edit > Offset

Keyboard Command: VOFFSET

Prerequisite: A polyline to offset

### Offset To Layer

This is a command to offset a polyline and put the offset polyline into a separate layer from the original polyline.

Prompts

Offset to layer <0>: ROW

Enter the offset amount: 20

Select object to offset: pick a polyline to offset

Specify point on side to offset: pick a point
Offset to Area

This command offsets a polyline by a distance that results in creating the specified target area. The source polyline should represent the frontage on the area. There is an option to connect the sides between the source and offset polylines to make a closed polyline.

Prompts

Pick line or polyline to offset: pick a polyline
Select side to offset: pick a point on the offset side
Keep existing polyline [Yes/No]? press Enter
Create closed polyline [Yes/No]? press Enter
Acres/<Enter target area (s.f.)>: 90000

Multiple Offsets

This command applies the same offset multiple times in series from the original polyline.

Prompts

Specify offset distance <20.0000>: 25
Enter Number of Repetitions <1>: 3
Select object to offset or <exit>: pick a polyline to offset
Specify point on side to offset: pick a point

Pulldown Menu Location: Edit > Offset
Keyboard Command: offset_area
Prerequisite: polyline to offset
Buffer Offset

This command offsets a polyline, and maintains a fixed distance from the original polyline by placing an arc on convex corners. The standard Offset command can actually have a distance greater than the offset at corners. In the example shown, the distance between the corners of the original and offset polylines is 70.01, while the offset distance is 50.0. Buffer Offset makes an offset polyline that doesn't exceed the offset distance. This is useful when you want an offset that goes no further than the offset distance, such as wetland offsets. Later versions of AutoCAD can achieve the same effect using the standard Offset command by changing the system variable OFFSETGAPTYPE to 1.

Prompts

Enter the offset amount: 50
Select object to offset: pick the original polyline
Specify point on side to offset: pick a point on the side to offset to

Regular Offset
Buffer Offset

Pulldown Menu Location: Edit > Offset
Keyboard Command: boffset
Prerequisite: A polyline to offset
File Name: \lsp\crdutil.arx

Standard Explode

Function

This command allows you to break a compound object into its component objects.
Results differ depending on the type of compound object you're exploding. The following is a list of objects that can be exploded and the results for each.

- **All Explodable Objects**: Produces object geometry that may look the same, but the color, linetype, and lineweight of the object may change.
- **Block**: Removes one grouping level at a time. If a block contains a polyline or a nested block, exploding the block exposes the polyline or nested block object, which must then be exploded to expose its individual objects.

Blocks with equal X, Y, and Z scales explode into their component objects. Blocks with unequal X, Y, and Z scales (nonuniformly scaled blocks) might explode into unexpected objects.

When nonuniformly scaled blocks contain objects that cannot be exploded, they are collected into an anonymous block (named with a "*E" prefix) and referenced with the nonuniform scaling. If all the objects in such a block cannot be exploded, the selected block reference will not be exploded. Body, 3D Solid, and Region entities in a nonuniformly scaled block cannot be exploded.
Exploding a block that contains attributes deletes the attribute values and redisplay the attribute definitions.

- **2D and Lightweight Polyline**: Discards any associated width or tangent information.
- **Wide Polyline**: Places the resulting lines and arcs along the center of the polyline. TakeOff discards any associated width or tangent information.
- **3D Polyline**: Explodes into line segments. Any linetype assigned to the 3D polyline is applied to each resulting line segment.
- **Text Explode to Polylines**: Explodes polylines depending on the font used for various annotations, this can make the resulting polylines more efficient in terms of vertex count.
- **Leaders**: Explodes into lines, splines, solids (arrow heads), block inserts (arrow heads, annotation blocks), Mtext, or tolerance objects, depending on the leader.
- **Mtext**: Explodes into text entities
- **Multiline**: Explodes into lines and arcs.
- **3D Solid**: Explodes planar surfaces into regions. Nonplanar surfaces explode into bodies.
- **Region**: Explodes into lines, arcs, or splines.
- **Body**: Explodes into a single-surface body (nonplanar surfaces), regions, or curves.
- **Polyface Mesh**: Explodes one-vertex meshes into a point object. Two-vertex meshes explode into a line. Three-vertex meshes explode into 3D faces.
- **Circle Within a Nonuniformly Scaled Block**: Explodes a circle within a nonuniformly scaled block into ellipses.
- **Arc Within a Nonuniformly Scaled Block**: Explodes an arc within a nonuniformly scaled block into elliptical arcs.

**Prerequisite**: None

**Keyboard Command**: EXPLODE, X

**Block Explode**

This command retains the values of attributes when a block is exploded. The standard *Explode* command changes the attribute values back to the attribute type. For example, using *Explode*, a Carlson point block would become PNTNO, PNTELEV, PNTDESC. *Block Explode* would keep the point attribute values, such as 10, 1000.0, EP. The layer names of the exploded block attributes can be either the insert layer of the parent block or the original attribute layers from the block definition.

**Pulldown Menu Location**: Edit

**Keyboard Command**: explode2

**Prerequisite**: A block to be exploded

**File Name**: \lsp\blkattex.lsp

**Trim**

**Function**
This command allows you to trim objects at a cutting edge defined by other objects.

**Prompts**

1 Select cutting edges ...
Select objects: **pick entity**

2 Select object to trim or shift-select to extend or [Project/Edge/Undo]: **select entity to be trimmed**
   - **Project**: You can project the object to be trimmed in order to trim objects that do not intersect.
   - **Edge**: You can project the trimming edge in order to trim objects that do not intersect.
   - **Undo**: This option allows you to undo the above projections.

**Prerequisite**: None

**Keyboard Command**: TRIM, TR

---

**Extend To Edge**

**Function**

This command allows you to extend an object to meet another object.

**Prompts**

1 Select boundary edges ...
Select objects: **pick entity**

2 Select object to extend or shift-select to trim or [Project/Edge/Undo]: **pick entity**
   You have the option of trimming or projecting objects and edges.

**Prerequisite**: None

**Keyboard Command**: EXTEND

---

**Extend to Intersection**

This command extends the end points of two lines and/or polylines, at the same time, to their intersection point.

**Prompts**

Select first line or polyline to extend: **pick a line or polyline**
Select second line or polyline to extend: **pick another line or polyline**
Extend Arc

This command extends an arc entity.

Prompts

Pick arc to extend: select an arc entity
Break Arc at Extension [Yes/<No>]? N Answering Yes will create a new arc starting at the end of the existing arc.
Enter or pick the distance to extend: 5 This extends the arc 5 units
Enter or pick the distance to extend ('U' to Undo): press Enter to end

Extend by Distance

This command extends a line or polyline, or creates new lines or polylines off of an existing one. By specifying a distance, a new segment of the line or polyline can be drawn from the current position. The current position and direction along the line or polyline is indicated by an arrowhead. Extend by Distance starts by selecting an existing line or polyline. Initially, the current position will be the closest vertex to where the line or polyline was selected. Extending from the endpoint of a polyline will add a new point to that polyline, while extending from any other point will create a new polyline.

There are two modes of operation: draw mode (D) and move mode (M). When in draw mode, extending will draw line or polyline segments. In move mode, the current position arrowhead can be moved without drawing segments. The orientation of the current position arrowhead can be changed with the Right, Left, and Angle commands.
The second prompt for this command offers numerous options in the form of key letters. These key letters are listed below along with their full names and actions. The list of the Extend by Distance commands are:

# - **Number**: Distance to draw or extend
A# - **Angle change**: Rotates pointer by specified number of degrees
A - **Align**: Rotates pointer to align with segment
B - **Bearing**: Sets pointer direction by bearing in format: Qdd.mmss with Q- quadrant, d-degrees, m-minutes, s-seconds (e.g. 130.1005 is NE 30 degrees, 10 minutes, and 5 seconds)
C - **Close**: Closes the polyline
D - **Draw Mode**: Actions draw or extend the line or polyline
E - **Extend to Edge**: Extends to intersection with a selected line or polyline
I - **Input mode**: Toggles distance input between decimal feet and feet-inches
L - **Left rotate**: Rotates counterclockwise 90 degrees
M - **Move Mode**: Actions only move the pointer
N - **Next**: Moves pointer forward to next point
O - **Open**: Opens the polyline
P - **Previous**: Moves pointer backward to previous point
R - **Right rotate**: Rotates clockwise 90 degrees
S - **Switch**: Reverses pointer direction
T# - **Total distance**: Sets current segment to specified distance
U - **Undo**: Undo the last Extend by Distance command
Z - **Zoom mode**: Toggles auto-zoom between on/off
? - **Info**: Displays lengths of current polyline

**H - Help**: The Help option also displays this Extend by Distance Commands list.
**Press <Enter>:** Ends the routine
The result of using the Info (?) feature

Prompts

**Select line or polyline to extend:** *select line or polyline near the place to extend*

**Enter or pick distance to draw (A,B,C,E,I,L,M,N,O,P,R,S,T,U,Z,?,Help):** 50 The line is extended by 50 units. Use the Pick option to pick a distance.

**Pick/Horizontal Distance to Extend ([Enter] for new line):** *R* Rotate right 90 degrees.

**Enter or pick distance to draw (A,B,C,E,I,L,M,N,O,P,R,S,T,U,Z,?,Help):** 50 The line is extended by 50 units. Use the Pick option to pick a distance.

**Enter or pick distance to draw (A,B,C,E,I,L,M,N,O,P,R,S,T,U,Z,?,Help):** press *Enter*

**Extend another (<Yes>/No)?** No

Note: R50 and L10 can be used to go right 50, left 10, etc.
The result of using the Help (H) option

Pulldown Menu Location: Edit > Extend
Keyboard Command: extender
Prerequisite: An existing line or polyline with at least one segment from which to start.
File Name: \lsp\scadutil.arx

Break by Crossing Polyline

This tool is used to break drawing geometry at the edge of a polyline boundary. It provides options to change the layers of the interior and exterior geometry after it is broken.

First, select the boundary polyline. Only one can be selected. Then select the polylines and lines to be clipped. You will be prompted for options on specifying the layers for the newly broken geometry. Respond with a "Y" if you want to specify a new layer, then enter the new layer name. If the layer name does not exist, it will be created.

Prompts

Select the clip edge polyline: pick a closed polyline
Select the polylines and lines to be clipped.
Select Objects: pick the entities to break
Specify layer names for Inside segments (Yes/<No>)? Yes
Enter a layer name for the Inside segments <0>: press Enter
Specify layer names for Outside segments (Yes/<No>)? Yes
Enter a layer name for the Outside segments <0>: Final
Break Polyline at Specified Distances

This command allows you to pick a polyline and break it at a specified distances along the polyline. Following the prompts below, the beginning of the polyline in the illustration was broken into three 55-foot segments.

Prompts

Select polyline to break: select polyline
Total Distance: 779.429 This is the length of the polyline reported.
Distance Along Polyline For Break: 55.0
Distance Along Polyline For Break (Enter to end): 110
Distance Along Polyline For Break (Enter to end): 165
Distance Along Polyline For Break (Enter to end): press Enter
3 polyline breaks created.
**Break at Intersection**

This command will break a line, arc or polyline at the intersection of another line, arc or polyline. In many cases this command is used in conjunction with the *Area by Lines & Arcs* command. In order to get the correct area of a figure, it is often necessary to break it from adjoining lines.

**Prompts**

*Select Line, Arc, or Polyline to Break*

**Select object:** select object to break

* [int on] Pick Intersection to break at: pick intersection point

**Pulldown Menu Location:** Edit > Break

**Keyboard Command:** breakat

**File Name:** \lsp\surv1.lsp

---

**Break, Select Object, 2nd Point**

> 

**Function**

This command allows you to break an object by selecting the object, then the second break point. The first break point is the point where you select the object.

**Prompts**

1. **Select object:** select entity to break
2. **Specify second break point or [First point]:** select second break point

---

**Break, Select Object, Two Points**

**Function**

This command allows you to break an object by selecting the object, then two points. First select the object, then the program will prompt you to select two points that define where the object will be broken.

**Prompts**

1. **Select object:** select entity to break
2. **Specify second break point or [First point]:** First
3. **Specify first break point:** pick first point
4. **Specify second break point:** pick second point

---

**Break, At Selected Point**

**Function**

---
This command allows you to break an object by selecting the object. Only one pick is necessary since TakeOff both selects the object and treats the selection point as the break point.

**Prompts**

1 Select object: select entity to break

Select an object to break

**Prerequisite:** None

**Keyboard Command:** BREAK

**Change Properties**

**Function**

This command allows you to change certain properties of existing objects.

1 In the Change Properties dialog box, you must choose the properties to modify.

- **Color:** This option allows you to change the color of the object.
- **Layer:** This option allows you to change the layer of the object.
- **Linetype:** This option allows you to change the linetype of the object.
- **Linetype Scale:** This option specifies the linetype scale factor for the new linetype.
- **Thickness:** This option specifies the distance to extrude the object above or below its elevation.

Note: The Properties command allows you to modify entity specific properties such as the radius of a circle or the height of a text entity.

**Prerequisite:** None

**Keyboard Command:** DDCHPROP

**Change Elevations**

This command will change the elevation of selected entities. It can move the entity to a specified elevation from it's current elevation (absolute) or do a differential change by adding or subtracting a value from it's current elevation. If Carlson points are selected, their attribute text and z axis coordinate are changed.
Prompts

Ignore zero elevations (<Yes>/No)? press Enter
If you answer No, then entities with elevation 0 will be changed.
[A]bsolute or [D]ifferential Change <A>: A
Elevation to change to: 125
By using the Absolute option all entities selected are changed to the elevation 125.
Select Entities for elevation change.

Select objects: C
First corner: pick a point
Other corner: pick a point
Select objects: press Enter

If Carlson points are selected, the command warns:
This command DOES NOT change the elevations in the Coordinate file!
Use Coordinate File Utilities menu option F to update the file.

Pulldown Menu Location: Edit > Change
Keyboard Command: chgelev
Prerequisite: Something to change
File Name: \sp\scadutil.arx

Change Attribute Style

This command will globally change the text style of attributes on the drawing. This can be very useful if all the label styles (such as the point symbol attribute labels) on a drawing must be changed to accommodate a different plotting specification. The default STYLE used for the point symbol attributes is PTXT.

Under Existing Style, select the style that is currently applied to the attributes you want to change. If you are unsure of the existing text style, select the Pick Attr button, then pick an existing attribute on the screen. When the dialog returns, the text style applied to that attribute will be selected in the list.

Select the New Style that you want to apply to the attributes.

Enter a New Height for the attributes. An entry of zero (0) will not modify the existing height.

Pulldown Menu Location: Edit > Change
Keyboard Command: chgattr
Prerequisite: You may want to use the LIST command to check the current Text size.

File Name: \ lsp\ chgattr.lsp

**Change Style**

This command will globally change the style and height of text on the drawing. This can be very useful if all the text sizes on a drawing must be changed to accommodate a different plotting scale.

Under **Existing Style**, select the style that is currently applied to the text you want to change. If you are unsure of the existing text style, select the **Pick TEXT** button, then pick an existing text entity on the screen. When the dialog returns, the text style applied to that text entity will be selected in the list.

Select the **New Style** that you want to apply to the text.

Enter a **New Height** for the text. An entry of zero (0) will not modify the existing height.

![Change Style](image)

**Pulldown Menu Location**: Edit > Change

**Keyboard Command**: chgstyl

**Prerequisite**: Text entities

**File Name**: \ lsp\ chgstyl.lsp

**Change Block/Inserts Rotate**

This is a command to set the angle of blocks by various methods. This command optionally can change the rotation of a block by twist screen angle, azimuth, entity segment or by follow polyline. It will work with Carlson point symbol blocks, or any block. For example, you may receive a drawing from another firm, insert it in, and then want to change the rotation.

**Prompts**

Twist by [ Twist screen ]/Azimuth/Entity segment/Follow polyline]? press Enter

Enter angle relative to current twist screen <0.0>: 30

Select Symbols to Rotate. pick symbol

Chapter 5. Edit Menu
Select objects: 1 found

Pulldown Menu Location: Edit > Change > Block/Inserts  
Keyboard Command: TWISTSYM  
Prerequisite: None

Change Block/Inserts Substitute

This command is used to replace selected block(s) with a different block. The command optionally can change the size and rotation angle. This command will work with Carlson point symbol blocks, or any block. For example, you may receive a drawing from another firm and want to replace certain inserts with inserts of your own specification. In the dialog shown, we are replacing the block named NASTAR with a block named COHNORTH, which will be inserted at 50 scale and zero rotation.

![Change Block/Inserts Substitute dialog]

**Existing Block:** Select the block name to be replaced. If the block name is unknown, choose the Select from Screen button, then select the block from the current drawing.

**Replace With:** Select the block that will replace the existing block. You may choose from the list of defined blocks, select an existing block from the current drawing, choose a point symbol from the standard Carlson point library, or select a drawing file.

**Retain Size and Rotation:** When checked, the new block will retain the size and rotation values from the old block.

**New Size:** Available if Retain Size and Rotation is not checked. Enter the size for the new block.

**New Rotation Angle:** Available if Retain Size and Rotation is not checked. Enter the rotation angle for the new block.

Pulldown Menu Location: Edit > Change > Block/Inserts  
Keyboard Command: chgblk  
Prerequisite: None  
File Name: \lsp\chgblk.lsp

Chapter 5. Edit Menu
Change Block/Inserts Resize

This command resizes blocks inserts while maintaining their insertion position. When prompted to select objects, choose the inserts to resize. Note that this routine does not rescale attributes that may be associated with the selected inserts.

Prompts

Scaling Multiplier <0.5>: Enter the size scale factor.
Select symbols and blocks to scale.
Select entities

Pulldown Menu Location: Edit > Change > Block/Inserts
Keyboard Command: sizeblk
Prerequisite: block/inserts in drawing
File Name: \lsp\sizeblk.lsp

Pivot Point Rotate by Bearing

This command allows you to rotate the selected entities from the drawing. The rotation angle is defined by the difference between a reference line and an entered bearing or azimuth. The reference line is defined by two points that can be picked on the screen or entered by point number.

Prompts

Select entities to rotate.
Select the entities
Base pivot point ?
Pick point or point number: 2 The program then reads the coordinate value for pt#2 from the current CRD file.
Reference Bearing point ?
Pick point or point number: pick a point
Reference Bearing N 44d31'1'' E The program then displays the reference bearing defined by the two points selected.
Azimuth/<Bearing (Qdd.mmss)>: 245.3030 Enter an A to input an Azimuth or enter the bearing. The above response is a bearing of South 45 degrees, 30 minutes, and 30 seconds East. The program then rotates the database to the new bearing.

If Carlson Points are selected the program warns:
This command DOES NOT change the coordinates in the CooRDinate file!
Use CooRDinate File Utilities menu, Update CRD from Drawing.
This warning applies if the points entities are not linked to the CRD file. This link option is set in the Configure command.

Pulldown Menu Location: Edit > Rotate
Keyboard Command: brot
Prerequisite: None
File Name: \lsp\scrot.lsp
Rotate by Pick

Function

This command allows you to move objects about a base point using a point as a rotation reference.

Prompts

1 Select objects: pick entities
2 Specify base point: pick point on screen as reference
3 Specify rotation angle or [Reference]: rotate to desired location

Prerequisite: None
Keyboard Command: ROTATE

Entity Insertion Point Rotate

This command allows you to rotate the selected entities from the drawing where they will follow one of the following alignments: Twist screen, Azimuth, Entity Segment, Follow or Pick.

Prompts

Rotate by [Twist screen>Azimuth/Entity segment/Follow/Pick]? F
Select polyline to follow: pick a polyline
Select Entities to Rotate.
Select objects: pick entities to rotate
Flip text for twist screen [Yes/<No>]? Y
Rotating ....

Pulldown Menu Location: Edit > Rotate
Keyboard Command: ss_twist
Prerequisite: None
File Name: \lsp\scrot.lsp

2D Scale

This command will scale the selected entities using specified scale factor and base point. This 2D Scale function is the same as the standard Scale function except that this 2D Scale function only scales the entities in the x,y coordinates and does not change the elevations of the entities. One application of this routine is to convert a drawing from architectural to decimal units when the architectural units have the drawing x,y coordinates in inches and the elevations in feet. In this case, 2D Scale can be used to apply a 1/12 scale factor (0.08333333) to convert the inches to feet for the x,y coordinates and leave the elevations unchanged.

Prompts

Select entities to scale.
Select objects: pick entities to process
Specify base point: 0,0
Specify scale factor: 0.0833333333

Pulldown Menu Location: Edit > Scale
Keyboard Command: scscale
Prerequisite: None
File Name: \lsp\surv1.lsp

Scale

Function

This command allows you to enlarge or reduce selected objects equally in the X, Y, and Z directions.

Prompts

1 Select objects: pick entities
2 Specify base point: pick point on screen as reference
3 Specify scale factor or [Reference]: scale to desired size

Prerequisite: None
Keyboard Command: SC

Edit Text

Function

This command allows you to edit text and attribute labels.

1 Select Text to Edit: select the text

You can modify text in provided text field.

Prerequisite: Text
Keyboard Command: EDITXT

Text Enlarge/Reduce

This command will scale text entities up or down in size. The routine prompts for a scale multiplier and a selection set of text objects. If you want to enlarge the text enter a value greater than one. If you want to reduce text enter a decimal fraction such as .5. This would reduce the text size by 50%. This command is very useful if you have set up your drawing for one plotting scale and decide to change to a new plotting scale. The Change Text Size command can alternatively be used to set the text size to a specific value.

Pulldown Menu Location: Edit > Text
Prerequisite: Text entities to be changed
Keyboard Command: txtenl
File Name: \lsp\surv1.lsp
**Rotate Text**

This command sets the rotation of the selected text to the current twist screen, an entered azimuth, or to align with a line or polyline. The text keeps the same insertion point and justification. The *Twist Screen* option sets the text rotation to align horizontal with the current twist screen. With the *Azimuth* option you can enter the angle or pick two points to define the text rotation. The *Entity segment* aligns the text with a selected line or polyline segment. The *Follow* option aligns the text with the closest polyline segment.

**Prompts**

Rotate by (<Twist Screen>/Azimuth/Entity segment/Follow/Pick)? press Enter
Enter angle relative to current twist screen <0.0>: 23
Select Text to rotate.
Select objects: select the text

**Pulldown Menu Location:** Edit > Text
**Keyboard Command:** twisttxt
**Prerequisite:** Text
**File Name:** \lsp\twisttxt.lsp

**Change Text Font**

This command can change multiple text entities to a user specified style. The routine prompts for a selection set of TEXT and/or MTEXT objects. Once the selection is made, the Select Style dialog appears. You can then select a text Style Name, such as MONO or ROMANS, that you would like to change to. Click OK. To the right on Style Name, you can enter a style name that does not exist. If you do, it will be created for you using the font with the same name.

**Pulldown Menu Location:** Edit > Text
**Keyboard Command:** chgtxtstyle
**Prerequisite:** Text entities to be changed
**File Name:** \lsp\chgtxtstyle.lsp
Change Text Size

This command will change the size of the selected text objects to the user specified size. The Text Enlarge/Reduce command also changes text size. The difference is that this routine sets the text to an absolute size whereas Text Enlarge/Reduce scales, or relatively changes, the text size.

Prompts

Select the text to size.
Select objects: select the text
Enter new text size: enter value

Pulldown Menu Location: Edit > Text
Keyboard Command: chgtxtsize
Prerequisite: Text entities to be changed
File Name: \lsp\surv1.lsp

Change Text Width

This command changes the width of the selected text entities, after a new width factor is entered. The insertion point of each text entity is maintained as the routine lengthens or shortens the text.

Effect of different width factors on the same text line

<table>
<thead>
<tr>
<th>Width Factor</th>
<th>Text Width</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>1</td>
</tr>
<tr>
<td>0.75</td>
<td>0.75</td>
</tr>
<tr>
<td>1.5</td>
<td>1.5</td>
</tr>
</tbody>
</table>

Prompts

Select the text to change.
Select objects: select text entities
Enter new width factor <1.0>: enter new width factor

Pulldown Menu Location: Edit > Text
Keyboard Command: chgtxtwidth
Prerequisite: Text entities to be changed
File Name: \lsp\surv1.lsp
Change Text Oblique Angle

This command allows you to change the text oblique angle on existing text in the drawing. The oblique angle for a specific text style is defined during the creation of the style. The default value for the oblique angle for text styles is 0 until defined to another value by the user. When changing the oblique angle, a minus (-) sign in front of the angle indicates a backward slant and a positive value results in a forward slant. Remember that the reference base point for the oblique change is always 0 degree. This means that if an existing text string has an oblique angle of 20, changing the oblique angle to 25 will not add 25 degrees to the existing 20 degree oblique resulting in a text oblique angle of 45 degrees, but rather a 25 degree oblique will be established by referencing 0 oblique as the base, and then slanting the text to 25 degrees. This works the same for slanting text backward as well as forward. Below is an example showing original text created with the default oblique angle of zero, then changed to a backward slant of 20 and a forward slant of 25 degrees.

Prompts

Select the text to change.
Select objects: Select text to change oblique angle on. Note that one or more text strings can be selected. When all desired text has been selected, press Enter.
Enter new oblique angle <0.0>: Enter the desired oblique angle.

Iron Pin

Iron Pin

Iron Pin

Oblique Angle = 0
Oblique Angle = -20
Oblique Angle = 25

Pulldown Menu Location: Edit > Text
Prerequisite: Text entities to be changed
Keyboard Command: chgtxtoblique
File Name: \lsp\surv1.lsp

Flip Text

This command will change the alignment of text entities by 180 degrees.

Pulldown Menu Location: Edit > Text
Keyboard Command: fliptext
Prerequisite: Text entities to be changed
File Name: \lsp\surv1.lsp

Split Text into Two Lines

This tool allows you to break a single line of TEXT into two separate lines. First, select the text string you would like to break. The Text Break dialog then appears. Initially, the slider is all the way to the right. Begin dragging it
toward the left until it reaches the point where the split is at the desired position. Then choose OK to complete the break operation.

**Text Break**

This should be a paragraph break.

Result

This should be a paragraph break.

OK  Cancel

**Pulldown Menu Location:** Edit > Text  
**Keyboard Command:** txtbrk  
**Prerequisite:** Text entity to break  
**File Name:** \lsp\txtbrk.lsp

**Text Explode To Polylines**

This command converts the selected text into polylines. This function is generally used when preparing a plan view file for machine control, before using the *Write Polyline File* command.

**Prompts**

Select text to be EXPLODED.  
Select objects: *select the text*  
Substitute With Simple Font [<Yes>/No]? Y  
1 text object(s) have been exploded to lines.  
The line objects have been placed on layer 0.  
Reading the selection set ...  
Joining ...  
Converting ...

**Pulldown Menu Location:** Edit > Text  
**Keyboard Command:** textexp  
**Prerequisite:** Text  
**File Names:** \lsp\textexp.lsp, \lsp\poly3d.arx

**Add Prefix/Suffix To Text**

This command simply adds a prefix and/or suffix to the selected text entities. The strings to add are specified in a dialog. Then you select the text entities to update.
Prompts

Add Prefix/Suffix To Text dialog
Select text to process.
Select objects: pick the text entities
Pulldown Menu Location: Edit > Text
Prerequisite: Text entities to be changed
Keyboard Command: txtwrap

Remove Spaces From Text
This command removes leading and/or trailing spaces from the selected text entities.

Prompts

Trim all spaces from text on [Right/Left/<Both>]: press Enter
Select text to process.
Select objects: pick the text entities to process
Trimmed spaces from 1 text entities.

Pulldown Menu Location: Edit > Text
Keyboard Command: txtrmspace
Prerequisite: Text entities

Line Up Text
This command lines up the selected text entities along either a horizontal or vertical line position.

```
19.80TC  19.80TC
19.30FS  19.30FS
```
Before and after Line Up Text

Prompts

Line up text on [Horizontal/<Vertical>]: press Enter for Vertical
Pick vertical position: pick a point
Select text to process.  
Select objects: select the text to process

Pulldown Menu Location: Edit > Text
Keyboard Command: txtlineup
Prerequisite: Text

Join Text Entities

This command combines two text entities by appending the second text to the first. The Words join method puts a space between each text. The Letter join method appends without a space.

Prompts

Select first text line: pick a text entity
Select text to add to first text line: pick a text entity
Join type as [Words/<Letters>]: press Enter

Pulldown Menu Location: Edit > Text
Keyboard Command: txtjoin
Prerequisite: Text entities

Replace Text

This command will replace one text string with another. For example, if the text LEGEL is on a drawing, you could use this command to replace it with LEGAL. In AutoCAD 2000 and later, the command Find and Replace Text includes more options, including replacing partial strings and searching attributes and MTEXT.

Pulldown Menu Location: Edit > Text
Keyboard Command: chgtext
Prerequisite: Text entities to be changed
File Name: \lsp\chgtext.lsp

2D Align

This command will align (translate, rotate and scale) the selected objects using two pairs of source and destination control points. The difference between the first source point and first destination point determines the translation amount. The difference between the angle and distance from the first and second source points compared to the angle and distance from the first and second destination points determines the rotation and scale. The scale part of the alignment is optional. This 2D Align function is the same as the standard Align function except that this 2D Align function does not use elevations so that the alignment is always in 2D. The control points can be screen picked or entered by point numbers.
Prompts

Select entities to align.
Select objects: *pick entities to process*
First Source Point?
Pick point or point number: *pick point 84*
First Destination Point?
Pick point or point number: *pick point 18*
Second Source Point?
Pick point or point number: *pick point 85*
Second Destination Point?
Pick point or point number: *pick point 19*
Scale factor: 1.00434258
Scale objects based on alignment points [Yes/<No>]? Y
This command DOES NOT change the coordinates in the CooRDinate file!
Use Coordinate File Utilities menu, Update CRD File from Drawing.
Pulldown Menu Location: Edit > Align
Keyboard Command: scalign
Prerequisite: None
File Name: \lsp\scalign.lsp

**Standard Align**

**Function**

Aligns objects with other objects in 2D and 3D

You use ALIGN to move, rotate, or scale objects into alignment with other objects. Add source points to the objects you want to align, and add destination points to the objects to which you want the source objects to align. You can add up to three pairs of source and destination points to align an object.

The first set of source and destination points defines the base point for the alignment. The second set of points defines the angle of rotation.

When you select three point pairs, you can move and rotate the selected objects in 3D to align with other objects.

If you use two source and destination points to perform a 3D alignment on nonperpendicular working planes, you get unpredictable results.

After you enter the points, Takeoff prompts you to scale the object. The program uses the distance between the first and second destination points as the reference length to which the object is scaled. Scaling is available only when you are aligning objects using two point pairs.

**Prompts**

1 Specify first source point: **pick point**
2 Specify first destination point: **pick point**
3 Specify second source point: **pick point**
4 Specify second destination point: **pick point**
5 Specify third source point or <continue>: **Press Enter**
6 Scale objects based on alignment points? [Yes/No] <N>: **Press Enter**

Prerequisite: None
Keyboard Command: ALIGN

**Fillet**

**Function**

This command allows you to round and fillet the edges of objects. You can enter a radius for rounding (default radius is 0). You can also trim an object that extends beyond the intersection.
FILLET rounds or fillets the edges of two arcs, circles, elliptical arcs, lines, polylines, rays, splines, or xlines with an arc of a specified radius. FILLET trims the intersecting lines to the endpoints of the fillet arc. If the selected lines do not intersect, Carlson Survey extends or trims them so that they do. FILLET also rounds or fillets the edges of 3D solids.

If both objects you want to fillet are on the same layer, the program creates the fillet line on that layer. Otherwise, the program creates the fillet line on the current layer. The same is true for the fillet color, linewidth, and linetype.

You can fillet line segments of a polyline that are adjacent, nonadjacent, intersecting, or separated by one segment. If they are nonadjacent, the polyline segments are extended to accommodate the fillet. If they are intersecting, the polyline segments are trimmed to accommodate the fillet. To create a fillet, the polyline segments must converge within the drawing limits when limits checking is on.

The result is a single polyline that includes the fillet as an arc segment. All the properties of this new polyline, such as its layer, color, and linetype, are inherited from the first polyline selected.

Filleting an associative hatch whose boundary is defined by lines removes hatch associativity. Carlson Survey maintains associativity when the boundary is a polyline.

Prompts
1 Select first object or [Polyline/Radius/Trim]: select entity
2 Select second object: select entity

Menu Location: Edit
Prerequisite: None
Keyboard Command: FILLET

**Mirror**

**Function**

This command allows you to create a mirror image copy of objects. The two specified points become the endpoints of a line about which the selected objects are reflected. In 3D, this line orients a mirroring plane perpendicular to the XY plane of the user coordinate system (UCS) containing the mirror line.

Prompts
1 Select Objects: select objects to be mirrored
2 Specify first point of mirror line: pick point
3 Specify second point of mirror line: pick point
4 Delete source objects? [Yes/No] <No>: Press Enter

Menu Location: Edit
Prerequisite: None
Keyboard Command: MIRROR

Properties Manager

Function

Carlson Survey displays the Properties window. The Properties window is the main method for viewing and modifying properties of AutoCAD objects.

There are some general properties common to all objects. These include Color, Layer, Linetype, Linetype Scale, Plot Style, Plot Style Table, Lineweight, and Thickness. All other object properties are specific to the type of entity. In the example below, a line has been selected. In addition to the properties mentioned above, you may modify the X, Y, and Z coordinate for each endpoint. Notice that you may not directly modify the delta, length or angle. These are read-only properties. Obviously, modifying either end point will cause these values to change.

![Properties window example](image)

The Properties window can be docked in the drawing area. Right-click the Properties window and choose Allow Docking or Hide to undock or hide it.

You can enter commands and work in Carlson Survey while the Properties window is open.

When you select an object in the drawing area, the Properties window displays the properties of that object. If you select multiple objects, the Properties window displays all the properties they have in common.

Object properties are displayed either alphabetically or by category, depending on the tab you choose. To modify properties using the Properties window select the object whose properties you want to change and use one of the following methods:

- Enter a new value
- Select a value from a list
- Change the property value in a dialog box
• Use the Pick Point button to change a coordinate value

The Select Objects button in the Properties window provides access to the full complement of selection methods, such as Fence and Crossing Polygon, from the Command prompt. You choose Select Objects, select the desired objects using any selection method, and press ENTER. The properties common to the selected objects are displayed in the Properties window. You can then modify the properties of the selected objects in the Properties window or you can make other changes to the selected objects by entering an editing command.

In the next example, 3 circles have been selected. Each circle has a different radius, color and linetype. Notice that these three fields do not show a default value. Remember, when multiple objects are selected, only their common properties are shown.

This last illustration shows how the properties window can be docked inside the main application window.
Entities to Polylines

This command converts selected lines, arcs, circles, 3DFaces, ellipses, splines, multilines, regions and solids into individual polylines. Use Join Nearest to convert adjoining lines and arcs into continuous polylines.

Prompts

Select lines, arcs, circles, 3DFaces, ellipses, splines, multilines, regions and solids to convert.
Select objects: select entities

Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: topline
Prerequisite: lines, arcs or other entities to convert
File Name: \lsp\poly3d.arx

Reverse Polyline

This command reverses the order of the line and/or arc segments of a POLYLINE. This can be useful in conjunction with the commands Station Polyline, MXS by Polyline, Profile from Surface Model or CL File from Polyline, since
the polyline must be plotted in the direction of increasing stations. If it is more convenient to draft a polyline in one direction do so and then use the *Reverse Polyline* command to change it’s order. Temporary arrows along the polyline are drawn to graphically show the new polyline direction.

**Prompts**

**Select the Polyline to Reverse:** *pick a point on polyline*

**Pulldown Menu Location:** Edit > Polyline Utilities

**Keyboard Command:** revpline

**Prerequisite:** A polyline

**File Names:** \lsp\revpline.lsp, \lsp\poly3d.arx

**Reduce Polyline Vertices**

This command removes points from a polyline, without significantly changing the polyline. The offset cutoff is the maximum amount that the polyline can move horizontally and vertically when removing a point. For example, in a polyline with three points in a straight line, the middle point can be removed without changing the polyline. This command is explained further in the *Triangulate & Contour* command.

**Prompts**

**Enter the offset cutoff <0.1>:** .5

**Select polylines to reduce.**

**Select objects:** *pick polylines*

**Processed polylines:** 1

**Total number of vertices:** 10

**Number of vertices removed:** 1

**Pulldown Menu Location:** Edit > Polyline Utilities

**Keyboard Command:** reduce

**Prerequisite:** A polyline

**File Name:** \lsp\tri4.arx

**Densify Polyline Vertices**

This command adds vertices to the selected polylines at the specified interval. These points are interpolated between existing points in the polyline. This command is the opposite of Reduce Polyline Vertices.
Prompts

Select polylines to densify.
Select objects: select polylines
Point interval <10.0>: press Enter
Testing Entity > 1
Added 17 points to 1 polyline.

Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: densepl
Prerequisite: A polyline
File Name: \lsp\poly3d.arx

Smooth Polyline

This command smooths the selected polylines using a modified Bezier method that makes the smooth polyline pass through all the original points and only smooths between the original points. The looping factor controls smoothing amount. A higher factor gives more looping. This command is explained further in the Surface menu section.

Prompts

Enter the looping factor (1-10) <5>: 7
Enter the offset cutoff <0.05>: press Enter This is the same reducing filter described above.
Select polylines to smooth.
Select objects: pick polylines
Smoothed 1 PolyLines
Total original vertices: 9 Total final vertices: 50

Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: smoothpl
Prerequisite: A polyline
File Name: \lsp\tri4.arx

Draw Polyline Blips

This command will draw temporary markers, "blips", at each polyline vertex. This allows you to identify the actual location of each vertex. The Blips are temporary. Any change to the viewport (pan, zoom, regen) will make the blips disappear. In later versions of AutoCAD, you can also click on the polyline to activate the grips which will remain visible during and after viewport changes.
Prompts

Select polylines to draw blips.
Select objects: select polyline(s)
Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: plblip
Prerequisite: A polyline
File Name: \lsp\poly3d.arx

Add Intersection Points

This command adds points into lines or polylines where there are intersections. This can be useful for other commands such as Auto-Annotate. For example in the drawing shown, Add Intersection Points adds points to the boundary polyline where the lot lines intersect. Then Auto Annotate for the boundary polyline will label the boundary distance along each lot. This routine does not add intersection points on arcs.

Prompts

Select lines and polylines to check.
Select objects: pick lines or polylines
Reading the selection set ...
Adding intersection points ...
Added 3 intersection points.
Add Polyline Vertex

This command adds points into a polyline. First you select the polyline to modify. The existing polyline vertices are marked and then you can pick or enter the coordinates for the new point(s). A new point is inserted into the polyline at the nearest polyline segment. On a 3D polyline, the elevation of the new vertex will be calculated for you. You can continue to pick points to add. Press Enter when you are done.

Prompts

Select polyline to add to: pick a polyline
Pick or enter point to add: pick a point
Select polyline to add to: press Enter to end

Add Polyline Arcs

This command replaces a series of short chord line segments in a polyline with an arc segment. This applies where you want to have a true arc instead of a series of line segments. In some cases, the CAD drafting has the arcs drawn
as a series of short chords. Another application is to create an arc out of a series of connected survey points along the curve. The routine works by searching for a series of polyline vertices that fit within the specified tolerance with a best fit curve.

The options dialog allows you to set the layer for the new polylines. Otherwise the original polyline layer is used. There is an option whether to keep or erase the original polylines. The Snap Tolerance is the maximum offset allowed between the original points and the arc.

Prompts

Add Arcs to Polylines dialog
Select polylines to process.
Select entities: pick the polylines

Pulldown Menu Location: Edit > Polyline Utilities > Edit Polyline
Keyboard Command: addplarc
Prerequisite: polyline

Add Point by Two Slopes
This command inserts a vertex into a 3D Polyline between two points based on the slopes specified for these two points on polyline.

Prompts

Select polyline to process: select a polyline
Select first point on polyline: select a point on polyline
Enter percent slope from first point: -1.0
Select second point on polyline: select a second point on polyline
Enter percent slope from second point: -1.0

Pulldown Menu Location: Edit > 3D Polyline Utilities
Keyboard Command: plzslopes
Prerequisite: 3D Polylines
File Name: \sp\poly3d.arx
Edit Polyline Vertex

This tool allows you to make changes in the coordinates of vertices on all polyline types. Upon execution, you will be asked to select a polyline to edit. Upon selection, a temporary marker will be placed at all of the vertices of the polyline, making them easy to distinguish. You must then pick near the vertex you wish to edit. The following dialog appears.

At the top of the dialog it identifies the type of polyline as being 2D or 3D. In the case of 2D polylines, it allows you convert the polyline. You have the ability to type in new northing, easting or elevation values. You can also determine the 3D coordinate position by using distances and slope to/from adjacent points. As you change the values in the dialog, new values for derivatives are being calculated. For example, if you change the horizontal distances, the coordinates will change.

![Edit Polyline Vertex Dialog](image)

Prompts

Select polyline to edit: *pick a polyline*
Pick point on polyline to edit: *pick a point to be modified*
Edit Polyline Vertex dialog *click "Pick Position"*
Pick vertex position: *pick a new location for the vertex*
Edit Polyline Vertex dialog *click OK*

Make changes as needed. You will see the polyline vertices relocated based upon the new picked positions and coordinate changes. Use Previous and Next to move along the polyline. Note the dialog values changing.

Select polyline to edit (Enter to end): *press Enter to end*

Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: editpl
Edit Polyline Section

This command revises a segment of a polyline. Begin by picking a point on the polyline where you want to start editing. Then pick new points for the polyline. When finished picking new points press Enter, and then pick a point on the polyline to connect with the new points. The polyline segment between the start and end points is then replaced with the new points.

Prompts

Select polyline to edit: pick the polyline at the place to start editing
Pick intermediate point (Enter to End): pick a point
Pick intermediate point ('U' to Undo, Enter to End): pick a point
Pick intermediate point ('U' to Undo, Enter to End): press Enter
Pick reconnection point on polyline: pick the polyline at the place to join

Edit this contour by picking new points

Contour with segment replaced with new points

Pulldown Menu Location: Edit > Polyline Utilities > Edit Polyline
Keyboard Command: editpl2
Prerequisite: Polylines
File Name: \lsp\poly3d.arx
Remove Duplicate Polylines

This command analyzes the selected polylines and erases any duplicate polylines found. They must be exactly the same for one to be deleted.

Prompts

Select lines, arcs and polylines to process.
Select objects: select linework to process
Reading the selection set ...
Removed 1 duplicate linework entities.

Pulldown Menu Location: Edit > Polyline Utilities > Remove Polyline
Keyboard Command: rmduplwork
Prerequisite: Polylines that have duplicates
File Name: poly3d.arx

Remove Polyline Arcs

This command replaces arc segments in polylines with chords. Removing arcs is a prerequisite to some Carlson commands that don't handle arcs, such as Break by Closed Polyline and Make 3D Grid File. This process can add many vertices to the polyline. The Offset cutoff is the maximum any point on the arc will be allowed to shift.

Prompts

Select polylines to remove arcs from.
Select objects: pick polylines
Offset cutoff <0.5>: press Enter

Pulldown Menu Location: Edit > Polyline Utilities > Remove Polyline
Keyboard Command: rmarc
Prerequisite: polyline with arcs
File Name: \lsp\poly3d.arx

Remove Polyline Segment

This command removes the user specified segment from a polyline. A polyline segment is the section between two vertices of the polyline. There are two options for removing the segment. Either the two vertices of the removed segments are averaged together to keep polyline continuous, or the segment is left missing in the polyline, which creates two separate polylines. The keywords Continuous and Break respectively identify these two options. The first image is of the Original Polyline. The second is with the Continuous Removal option. The third is using the Break Removal option.
Prompts

Break polyline at removal or keep continuous (Break/<Continuous>)? press Enter
Select polyline segment to remove: pick point on polyline
Select polyline segment to remove: press Enter to end
Pulldown Menu Location: Edit > Polyline Utilities > Remove Polyline
Keyboard Command: removepl
Prerequisite: A polyline
File Names: \lsp\removepl.lsp, \lsp\poly3d.arx

Remove Polyline Vertex

This command removes vertices from a polyline. First you select the polyline to modify. The existing polyline vertices are marked and then you pick near the vertex you wish to delete. You can continue to pick vertices to delete, press Enter when you are done.

Prompts

Select polyline to remove from: pick point on polyline
Pick point to remove: pick point
Pick point to remove (Enter to end): press Enter to end

Pulldown Menu Location: Edit > Polyline Utilities > Remove Polyline
Keyboard Command: rmvertex
Prerequisite: A polyline
File Name: `\lsp\poly3d.arx`

Create Polyline ID Labels
This command labels the selected polylines with either the entity "Handle", which can be seen with a list, or with unique text numbers, such as 1, 2, 3, 4, etc.. When using the Text option, the following window appears to choose the text settings.

![Sequential Numbering Options](image)

Prompts

Select Polylines to label.
Select objects: *pick polyline*
Label polylines by Text or Handles [Handles/<Text>]? *press Enter*
Change Polyline Width

This command sets the width of the selected polylines. In later versions of AutoCAD, the command \textit{PEDIT} can also modify the width of multiple polylines.

Prompts

\texttt{New width <1.0>: 2}
\texttt{Select Polylines/Contours to change width of:}
\texttt{Select objects: pick polylines}

Set Polyline Origin

This command sets the starting vertex of a closed polyline. Simply pick the polyline and then pick near the point to set as the starting point.

Prompts

\texttt{Select Polyline: pick a polyline}
\texttt{Pick Near New Origin Point: pick a point on the polyline to be the starting point}
\texttt{Processing ...}
\texttt{Select Polyline: press Enter}

Remove Polyline Arcs

This command replaces arc segments in polylines with chords. Removing arcs is a prerequisite to some Carlson commands that don't handle arcs, such as \textit{Break by Closed Polyline} and \textit{Make 3D Grid File}. This process can add many vertices to the polyline. The Offset cutoff is the maximum any point on the arc will be allowed to shift.

Prompts

\texttt{Select polylines to remove arcs from.}
\texttt{Select objects: pick polylines}
\texttt{Offset cutoff <0.5>: press Enter}
**Change Polyline Elevation**

This command changes the elevations of polylines and can be used to set the elevations of contour polylines. The routine begins at a specified elevation and prompts for a selection set of polylines to set to the elevation. Then the routine repeats using the last elevation plus the elevation increment. Enter an empty selection set to exit the routine.

**Prompts**

Starting elevation <0.0>: 500.0
Contour interval (negative for down) <1.0>: 5.0
Select polylines to set to elevation 500.0.
Select objects: pick the polylines
Select polylines to set to elevation 505.0.
Select objects: pick the polylines
Select polylines to set to elevation 510.0.
Select objects: Press Enter

Keyboard Command: setcelev
Prerequisite: polylines

**Check Elevation Range**

This command analyzes a selection set of polylines, and highlights the ones that fall outside of a specified elevation range. There is an option to set the polylines that are outside of the range to zero. Every polyline vertex that is outside of the range will be highlighted with an X.

Prompts
Enter elevation range minimum: 0
Enter elevation range maximum: 4900
Select polylines to check.
Select objects: pick polylines to process
Found 1 polylines outside of elevation range.
Set polylines outside elevation range to zero elevation [Yes/<No>]? N

Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: checkpl
Prerequisite: Polylines with elevations
File Names:

Highlight Non-Tangent Polylines
This command highlights selected polylines that have non-tangent lineworks. For every non-tangent polyline, an arrow is pointed to the first non-tangent point, and the non-tangent angle and the coordinates of the point are reported at the command line.

Prompts
Select polylines to check.
Select objects: 1 found
Select objects: 1 found, 1 total
Select objects: press Enter to end
Polyline non-tangent by 32°15'26" at 1540.41,-182.05
Highlighted 1 non-tangent polylines.

Pulldown Menu Location: Edit > Polyline Utilities > Check Polylines
Keyboard Command: highlight_nontangent
Prerequisite: Polylines

**Highlight Crossing Plines**

This command highlights selected polylines that are crossing in the drawing and have different elevations at the crossing. Every intersection point where the polylines cross are marked with a temporary X. A report is provided at the end where the X and Y of the intersection points are displayed with the two Z values and the Z difference. The command has the ability to repair crossing polylines by inserting a vertex in each polyline at the intersection and assigning a common elevation at this intersection.
Prompts

Select polylines to check.
Select objects: pick polylines to process
Ignore zero elevations [<Yes>/No]? press Enter for Yes to filter out polylines at zero elevation
Reading points ... 1677
Finding points on breaklines ...
19 crossing polylines are highlighted.
Use Report Formatter [Yes/<No>]? press Enter for No. Use the Report Formatter to customize the report layout or export to Excel.
Minimum delta Z to report <0.0>: 2
Add polyline vertices at intersections [Yes/<No>]? Y
Set 3D polyline to crossing contour elev or average elevs [Set/<Average>]? press Enter for Average. The Set option applies to crossing polylines where one polyline is a 3D polyline with varying elevations and the other polyline is a contour polyline with a fixed elevation. For this case, the Set method will hold the elevation of the contour polyline and set the 3D polyline elevation to match the contour. The Average method sets the elevation of the intersection point as the average of the crossing polyline elevations at that point.
Maximum delta Z to average <1.0>: press Enter. This option will only add the intersection point with the averaged elevation if the elevation difference is less than this tolerance.

Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: xing_plines
Prerequisite: Polylines with elevations

Highlight Unclosed Polylines

This tool will evaluate polylines you select and highlight those that are open. It also provides options to close all or selected polylines from those found.
First select all polylines to evaluate. The tool will then display those that are open in a highlighted appearance. You will be offered an option to close all or selected polylines. If you wish to close all the open polylines, choose the All option. If you choose the Selected option you will be prompted to pick which polylines you want to close. As you pick each polyline it will be closed.

Prompts

Select the polylines to check.
Select objects: pick polylines to process
Open polylines are highlighted.
Close all or selected polylines [All/<Selected>]? S
Pick polyline to close: press Enter to end or select polylines

Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: unclosed
Prerequisite: A polyline
File Name: \lsp\surv1.lsp

Offset 3D Polyline

This command allows you to offset a 3D polyline entity in both the horizontal and vertical directions. There are five offset methods. The Interval method applies one horizontal and one vertical offset to all the vertices of the polyline. The Constant method has a horizontal offset and sets the elevation of the polyline to one constant elevation. The Variable method allows you to specify each horizontal and vertical offset individually either by polyline segment or for each point. The vertical offset can be specified by actual vertical distance, percent slope or slope ratio.

The surface method allows to offset/project a 3D polyline entity on to a surface (tin;flt;grd) based on cut and fill outslope ratio.

The multiple method allows multiple offsets of a 3D polyline with separate layers. User can add, insert and delete offsets rows and set individual layers. The option Progressive Offsets draws offsets progressively, i.e. successive offsets uses last drawn offset as base.
Prompts

Enter the offset method [<Interval>/Constant/Variable/Surface/Multiple]: press Enter
Vertical/<Horizontal offset amount>: 15
Percent/Ratio/Vertical offset amount <0>: 10
Select a polyline to offset (Enter for none): select a 3D poly
Select side to offset: pick a point
Select a point on the graphics screen that is in the direction of the side of line to offset.
Select a polyline to offset (Enter for none): press Enter

Pulldown Menu Location: Edit > 3D Polyline Utilities
Keyboard Command: offset3d
Prerequisite: Plot the 3DPoly lines to use for selection.
File Name: \lsp\poly3d.arx

Fillet 3D Polyline

This command fillets two segments of a 3D polyline with the given radius. The standard FILLET command does not support 3D Polyline entities. Since 3D polylines cannot have arcs, this command draws the fillet arc as a series of short chords. The elevations along the curve are interpolated from the 3D polyline.
Prompts

Fillet corner of a polyline or intersection of two polylines [Corner/Intersection]? press Enter
Enter fillet radius <10.00>: press Enter
Select a corner point on polyline: pick 3D polyline near meeting point of two segments
Select a corner point on polyline: pick 3D polyline near meeting point of two segments
Select a corner point on polyline: press Enter (to end command)

Pulldown Menu Location: Edit > 3D Polyline Utilities
Keyboard Command: fillet3d
Prerequisite: 3D polyline
File Name: \lsp\poly3d.arx

Join 3D Polyline

This command joins 3DPOLY entities into a single 3D polyline entity.

Prompts

Select the 3D polyline to join: pick a 3D polyline
Select the other 3D polyline to join: pick a 3D polyline that has a common endpoint with the first
3 segments added to the polyline.

Pulldown Menu Location: Edit > 3D Polyline Utilities
Keyboard Command: join3d
Prerequisite: Plot the 3DPoly lines to use for selection
File Names: \lsp\join3d.lsp, \lsp\poly3d.arx

Add Points At Elevation

This command inserts vertices into a 3D Polyline at a specific elevation, or elevation interval, by interpolating between existing elevations in the polyline.

Prompts

Add single elevation or elevation interval [Single/Interval]? press Enter
Enter Elevation Interval: 50
Select 3D polylines to process. pick 3D polyline(s)
Select objects: 1 found
Select objects: Processing polylines ...
Added 10 points to polylines.

Pulldown Menu Location: Edit > 3D Polyline Utilities
Keyboard Command: addplz
Prerequisite: 3D Polylines
File Name: \lsp\poly3d.arx
3D Polyline by Slope on Surface

This command creates a 3D polyline at a user-specified slope. The user picks the starting point and then the polyline continues along the surface at the slope until it reaches a point where the maximum slope at the point is less than the design slope. The surface is defined by a grid or TIN file which must be created before running this routine. Applications for this command include designing haul roads or ditches.

Prompts

Enter the polyline layer <SLOPE ROAD>: press Enter
Select the Grid File dialog
Reading row > 51
Extrapolate grid to full grid size (Yes/No)? Y
Limiting length for polyline (Enter for none):
Pick origin point of 3D polyline: pick a starting point
Direction of 3D Polyline (<Up>/Down)? press Enter The slope must go either uphill or downhill.
Direction of 3D Polyline facing up slope (<Left>/Right)? R Imagine facing uphill. Do you want the polyline to go to the left or right?
Enter the design slope: 10 This value is in percent slope.

Pulldown Menu Location: 3D Data
Keyboard Command: surfpl
Prerequisite: Existing surface file
File Names: \lsp\slope_rd.lsp, \lsp\cntr_grd.arx
Join Nearest

This command joins lines, arcs and/or polylines together. While the *PEDIT-Join* command requires the endpoints to match, Join Nearest will allow you to join entities whose endpoints do not exactly meet. You specify the maximum separation distance to join, along with other options, in the dialog box shown below. Also you can join many entities at once.

![Join Nearest Options dialog box](image)

**Max Separation to Join:** Entities whose endpoints are spaced apart greater than this value will not be joined. You may use the pick button to specify this value by picking two points on the screen.

**Max Deflection Angle (degrees):** This option will not join any lines if the angle between them is greater than this angle in degrees.

**Connection Method:** Determines how to connect the endpoints. See the illustration below.

1. **Average Endpoints Together:** New vertex will be located at midpoint between two original endpoints (see illustration below on left).
2. **Directly Connect Endpoints:** Original endpoints are connected with new segment (see the middle illustration below).
3. **Fillet with Radius Zero:** Same as the *FILLET* command using zero radius (see the illustration on right).

**Convert Lines and Arcs Into Polylines:** When checked, automatically converts lines and arcs into polylines. If not checked, lines and arcs are joined but remain separate entities.

**Join Across Intersections:** This option applies to cases where more than two linework endpoints come together such as a Y intersection. In these cases, there are multiple possible connections. When this option is on, the program will automatically choose one of the possible connections. Otherwise, the program will not connect any of them.

**Join Only Identical Layers:** When checked, only entities on the same layer will be joined.

**Join Only Common Elevations:** When checked, only endpoints located on the same elevation will be joined.

**Different Layer Prompt:** When Join Only Identical Layers is off, then this option will prompt for which layer to use when it finds a connection between two different layer names.

**Different Elevation Prompt:** When Join Only Common Elevations is off, then this option will prompt for which elevation to use when it finds a connection between two different elevations.
Pullown Menu Location: Edit
Keyboard Command: nearjoin
Prerequisite: Lines or polylines to be joined
File Names: \lsp\nearjoin.lsp, \lsp\poly3d.arx

3D Entity to 2D

This command changes a 3D Line, Arc, Circle, Polyline, Insert or Point to 2D, i.e. an entity with the elevations of the endpoints at the same Z coordinate. When the program detects a 3D polyline with all vertices with the same elevation, there is an option to convert to a 2D polyline with this elevation. Otherwise, the entered elevation here is used.

Prompts

Select/<Enter Elevation <0.00>: press Enter
Select Lines, Arcs, Circles, Polylines, Inserts and Points for elevation change.
Select objects: pick a 3D polyline
3D POLY to 2D POLYLINE
Number of entities changed > 1

Pulldown Menu Location: Edit
Keyboard Command: 3dto2d
Prerequisite: None
File Name: \lsp\3dto2d.lsp

Select by Filter

This command can be used to build a selection set of objects inside a drawing based on layer and entity type. There is a dialog to define the filters. Select the layer(s) on the left you wish to select, then turn on the toggle(s) for the entity types to consider. There is an option to filter by entity color. Also, the size and style filters can be used for text entities. The program then builds a selection set of those objects that resides on those layers. Then to use this selection set in other commands, enter "P" for previous at the "Select objects:" prompt.
Pulldown Menu Location: Edit > Selection Sets
Keyboard Command: fsel
Prerequisite: None

Select by Elevation

This command builds a selection set of entities that are greater than, less than or in between a specified elevation that you enter in on the command line. Entities selected, based upon this elevation criteria, go into a selection set. With the Window selection method, the entities must be entirely inside of the inclusion area to be included in the selection set. With the Crossing selection method, an entity is added to the selection set if any part of the entity is inside the inclusion area.

Prompts

Select by greater, less or between elevations [<Greater>/Less/Between]? press Enter
Enter elevation for greater than: 19
Ignore zero elevations [<Yes>/No]? press Enter
Select objects to build selection set. pick objects
Processing selection set ...
Built selection of 120 objects for elev more than 19.00.
To use type 'P' at Select objects: prompt.

Pulldown Menu Location: Edit > Selection Sets
Keyboard Command: zselect
Prerequisite: Entities
File Name: \lsp\volcalc.arx
Select by Area

This command builds a selection set using inclusion and/or exclusion closed polylines. Entities within the inclusion polylines are selected and entities within the exclusion polylines are not selected. With the Window selection method, the entity must be entirely inside the inclusion area and entirely outside the exclusion area to be included in the selection set. With the Crossing selection method, an entity is added to the selection set if any part of the entity is inside the inclusion area.

Prompts

Select the Inclusion perimeter polylines or ENTER for none:
Select objects: pick the closed polyline
Select objects: press Enter
Select the Exclusion perimeter polylines or ENTER for none.
Select objects: press Enter
Type of selection (Window/<Crossing>)? press Enter
Select objects to build selection set.
Select objects: All These selected objects are checked with the inclusion/exclusion polylines.
Select objects: press Enter
Built selection set with 43 objects.
Command: Erase
Select objects: P To use previous selection set created by Select by Area.
43 found
Select objects: press Enter

Pulldown Menu Location: Edit > Selection Sets
Keyboard Command: ssgetarea
Prerequisite: Closed perimeter polylines
File Name: \lsp\volcalc.arx

Select Similar

This command creates a selection set of all entities in the drawing with properties that match the selected entity. The properties filter uses the entity type and layer name. To use this selection set in other commands, enter "P" for previous at the "Select objects:" prompt.

Pulldown Menu Location: Edit > Selection Sets
Keyboard Command: selectsim
Prerequisite: None

Image Frame

Function

This command controls whether TakeOff displays the image frame or hides it from view.

Because you select an image by clicking its frame, setting the image frame to off prevents you from selecting an image.
Prompts

1 Enter image frame setting [ON/OFF] <current>: enter an option or Press Enter
   • On: Displays image frames so you can select images.
   • Off: Hides image frames so you cannot select images.

Prerequisite: None

Keyboard Command: IMAGEFRAME

Image Clip

Function

This command allows you to create new clipping boundaries for an image object.

Prompts

1 Select image to clip: select the edge of an image
2 Enter image clipping option [ON/OFF/Delete/New boundary] <New>: enter an option or Press Enter
   The boundary you specify must be in a plane parallel to the image object.
   • On: Turns on clipping and displays the image clipped to the previously defined boundary.
   • Off: Turns off clipping and displays the entire image and frame. If you reclip the image while clipping is turned off, the program automatically turns clipping back on. The program prompts you to delete the old boundary even when clipping is turned off and the clipping boundary is not visible.
   • Delete: Removes a predefined clipping boundary and redisplays the full original image.
   • New Boundary: Specifies a new clipping boundary. The boundary can be rectangular or polygonal, and consists only of straight line segments. When defining a clipping boundary, specify vertices within the image boundary. Self-intersecting vertices are valid. Rectangular is the default option. If you use the pointing device to specify a point at the Enter Clipping Type prompt, the program interprets the point as the first corner of a rectangle.
3 Enter clipping type [Polygonal/Rectangular] <Rectangular>: enter P or Press Enter
   • Polygonal: Uses specified points to define a polygonal boundary.
     Specify first point: Specify a point
     Specify next point or [Undo]: specify a point or enter u
     Specify next point or [Undo]: specify a point or enter u
     Specify next point or [Close/Undo]: specify a point, or enter c or u
     You must specify at least three points to define a polygon.
     If the image already has a clipping boundary defined, TakeOff displays the following prompt:
     Delete old boundary? [No/Yes] <Yes>: enter N or Press Enter
     If you choose Yes, the program redraws the entire image and the command continues; if you choose No, the command ends.
   • Rectangular: Specifies a rectangular boundary by its opposite corners. TakeOff always draws the rectangle parallel to the edges of the image.
Specify first corner point: **specify a point**
Specify opposite corner point: **specify a point**

Prerequisite: None

Keyboard Command: IMAGECLIP

## Image Adjust

### Function

This command controls the display of the brightness, contrast, and fade values of images.

The Image Adjust dialog box controls how the image is displayed by adjusting the brightness, contrast, and fade settings of the selected image. Adjusting these values changes the display of the image but does not change the image file itself.

- **Brightness**: Controls the brightness, and indirectly the contrast, of the image. Values range from 0 through 100. The greater the value, the brighter the image and the more pixels that become white when you increase contrast. Moving the slider to the left decreases the value; moving the slider to the right increases the value.

- **Contrast**: Controls the contrast, and indirectly the fading effect, of the image. Values range from 0 through 100. The greater the value, the more each pixel is forced to its primary or secondary color. Moving the slider to the left decreases the value; moving the slider to the right increases the value.

- **Fade**: Controls the fading effect of the image. Values range from 0 through 100. The greater the value, the more the image blends with the current background color. A value of 100 blends the image completely into the background. Changing the screen background color causes the image to fade to the new color. In plotting, the background color for fade is white. Moving the slider to the left decreases the value; moving the slider to the right increases the value.

- **Image Preview**: Displays a preview of the selected image. The preview image updates dynamically to reflect changes to the brightness, contrast, and fade settings.

- **Reset**: Resets values for brightness, contrast, and fade to default settings (50, 50, and 0, respectively).

Prerequisite: None

Keyboard Command: IMAGEADJUST
View Menu

In addition to powerful CAD display and view commands, the Carlson View menu has some additional commands. The commands in the top section effect the screen display size and location, and the bottom section commands change layers.
Redraw

Function

This command refreshes the display in the current viewport.

Prerequisite: None

Keyboard Command: R

Regen

Function

This command regenerates the drawing and refreshes the current viewport.

Prerequisite: None

Keyboard Command: REGEN

Zoom - Window

Function

This command zooms to display an area you specify by two opposite corners of a rectangular window.

Prerequisite: None

Keyboard Command: ZOOM, W

Zoom - Dynamic

Function

This command zooms to display the generated portion of the drawing using a view box. The view box represents your viewport, which you can shrink or enlarge and move around the drawing. Positioning and sizing the view box pans or zooms the viewport, filling it with the image inside the view box.

Prerequisite: None

Keyboard Command: ZOOM, D

Zoom - Previous

Function

This command zooms to display a previous view. You can restore up to 10 previous views.

Prerequisite: None

Keyboard Command: ZOOM, P
Zoom - Center

Function

This command zooms to display a window you define by picking a center point and a magnification value or height. A smaller value for the height increases the magnification. A larger value decreases the magnification.

Prompts

1 Specify center point: pick a point
2 Enter magnification or height <226.66>: enter a value

Prerequisite: None
Keyboard Command: ZOOM, C

Zoom - Extents

Function

This command zooms to display the drawing extents. You can use Zoom Extents transparently, but it always regenerates the drawing.

Prerequisite: None
Keyboard Command: ZOOM, E

Zoom IN

Function

This command increases the zoom factor of the current viewport by a factor of 2.0.

Prerequisite: None
Keyboard Command: ZOOM, 2.0x

Zoom OUT

Function

This command decreases the zoom factor of the current viewport by a factor of 0.5.

Prerequisite: None
Keyboard Command: ZOOM, 0.5x
Zoom Selection

This command zooms the display to fit the selected entities. For example, if you run Viewpoint 3D and your viewport only shows two small dots of entities that are far apart, then you can use Zoom Selection to select the entities of one of these dots and quickly zoom the display to these entities.

Prompts

Select objects to zoom onto:
Select objects: select entities

Pulldown Menu Location: View
Keyboard Command: zoom_on
Prerequisite: Entities
File Name: \lsp\mineutil.arx

Zoom Points

This command centers the screen to a user-specified point. The point can be specified by either the point number or description. The command searches the current coordinate (.CRD) file. Besides centering the screen, the magnification can also be changed. The default value is the current magnification. To zoom in, enter a smaller value and to zoom out, enter a greater value.

Prompts

Find by point number or description [<Number>/Desc]? N
Point number or range of point numbers to find <1>: 2079
We want to find point number 2079
Magnification or Height <179.50>: press Enter
Accept the default zoom magnification

Pulldown Menu Location: View
Keyboard Command: zoompnt
Prerequisite: A .CRD file
File Names: \lsp\fpoint.lsp, \lsp\crdutil.arx

Pan

Function

This command moves the drawing display in the current viewport. The cursor changes to a hand cursor. By holding down the pick button on the pointing device, you lock the cursor to its current location relative to the viewport coordinate system. The drawing display is moved in the same direction as the cursor.

hand cursor

When you reach a logical extent (the edge of the drawing space), a bar is displayed on the hand cursor on the side where the extent has been reached. Depending on whether the logical extent is at the top, bottom, or side of the drawing, the bar is either horizontal (top or bottom) or vertical (left or right side).
When you release the pick button, panning stops. You can release the pick button, move the cursor to another location in the drawing, and then press the pick button again to pan the display from that location.

To stop panning at any time, press Enter or ESC.

**Prerequisite:** None

**Keyboard Command:** P

### 3D Viewer Window

This command views in 3D, the selected 3D faces, polylines, lines and points. This routine uses the OpenGL graphics library for rendering, which gives it superior performance. Some of its features include the ability to zoom in and out, pan, rotate around the X,Y,Z axis and shade in user-positioned lighting. Press the right mouse button and drag to zoom the display.

![3D Viewer Window](image)

### View Control

- **Ignore Zero Elevations:** When checked, the 3D viewer ignore entities at zero elevation.
- **Color By Elevation:** This will color the contours or 3D faces by elevation. The elevation scale legend is displayed on the left of the window.
- **Vert. scale:** Sets the vertical scale factor for the 3D viewer. Relatively flat surfaces can be exaggerated by increasing the vertical scale.
This control represents position of the sun in the sky if looked from above. Therefore, the position of the sun in the center means that the sun is in a zenith, and position near the edge of the circle means that the sun is near the horizon. To move the sun, simply drag it to a new location, or click on the new location. The slide bars on the sides are the intensity and brightness of the display.

- Zoons IN.
- Zoons OUT.
- Switch to Dynamic Zoom mode.
- Switch to Pan mode. Click and drag to pan.
- Switch to Rotation mode.
- Switch to initial view.
- Toggles shading on and off.
- This is an inquire tool. Point the arrow to any entity to display entity data including the layer, type, elevation and length.
- Resets the 3D view to plan.
- This function outputs the image to a report. The report format (PDF or DWF) is specified Settings->Configure->General Settings.
- This function exports the graphic display to an image file. Several different image file formats are supported including bmp, png, jpg, xpm and gif. There is a Export Image Selections dialog to choose the image resolution and color depth.
- Exit the 3D viewer window.

- **Clip Plane**: This slider will clip the image based on the location of the slider. When the slider is all the way to the left, the entire image is displayed. Moving the slider to the right will clip the image, going deeper as the slider is moved to the right. This is useful to view items that are hidden behind something else.
- **Scroll Bars**: Use X,Y,Z scrollbars near the bottom to rotate the view. The range of these scrollbars is -180 to +180 degrees with middle being 0 which is the default position when the viewer starts. When the cursor is near the middle of the window, the XY icon will allow for rotating the image with the mouse, while holding
the left mouse button. Move the cursor to the edge, and the icon switches to Z. This allows for rotating around the Z axis with the mouse, while holding the left mouse button.

- **Fixed Views:** This selection list sets a pre-defined view. Plan View sets the view to look straight down. The other views look from a low angle from the NE, SE, SW or NW.

**Advanced Tab**

- **Block Model Objects:** This option has three choices when loading block model entities. 1. To leave as points. 2. To Render and 3. To prompt each time. If render is selected, it will apply to all face objects such as a TIN or GRD.
- **Block Model layers:** This will display the block color scheme. Colors of the blocks can be turned on or off to view blocks in the middle.
- **Shading Mode:** There are 3 shading modes to render 3D faces. They are 1. Shade Front, 2. Shade Both, and 3. Shade Back. This will render the top and bottom of the faces if desired.
- **Display Axis Icon:** This controls whether to show the X/Y/Z axis icon in the lower left of the graphic window.
- **Display Bounding Box:** This controls whether to display a 3D box around the limits of the data.
- **Display Vertical Scale:** This controls whether to display the current vertical scale in the graphic window.

Sets the drawing view to match the view shown in the 3D viewer window.

- **Saved Views:** This option allows for naming and saving a 3D view. These can be selected from the pulldown. They can be deleted from the list.
**Surface 3D Viewer**

This command is identical to the 3D Viewer Window, except that this one loads a Carlson Grid GRD, TIN or FLT file. After the file is selected, the same viewer documented in *3D Viewer Window* appears.

**Surface 3D FlyOver**

This command allows you to view a self guided animation of following a path through a 3D surface model. There are two variations to this command. When the command is started, you must specify whether you want to use a surface model from file or screen entities.

**Surface model from file:** Using this method, you can select either a triangulation (.TIN) file or a grid (.GRD) file, then you have the option of following a polyline or following a "free" path. If you choose the polyline method, then the animation is limited to following the polyline. If you choose the "free" path method, you first specify two points to obtain a starting direction, the while inside the viewer you can point the animation in any direction.
Screen entities: Using this method, you must select a 3D polyline to follow. The animation is limited to following the polyline.

After making the above selections, the 3D graphics window is opened. The main window is for the animation, the smaller upper right window shows you the overall plan view, and the smaller window located at middle right shows you the current elevation, slope and azimuth. While following a "free" path, you will have a 3rd small window located at lower right which shows you the amount of roll at your current position.

![3D Flight Viewer](image)

This button raises the elevation of your viewing position.

This button lowers the elevation of your viewing position.

This button turns your viewing position to the left.
This button turns your viewing position to the right.

This button allows you to zoom in and out.

This button allows you to rotate the main animation window in any X, Y or Z direction.

This button allows you to pan.

This button toggles shading on and off.

This button starts the animation in the main window.

This button stops the animation.

This button exits the 3D Surface FlyOver command

Control for position of the light source, viewed from above.

**Prerequisite:** Surface Model and optionally a 3D Polyline  
**Keyboard Command:** flyby

**Viewpoint 3D**

**Function**

This command allows you to define 3D view settings.
1 Under Set Viewing Angles, you must set the direction of the view relative to either the world coordinate system (WCS) or a user coordinate system (UCS).

- **Absolute to WCS**: This option sets the view direction relative to the WCS.
- **Relative to UCS**: This option sets the view direction relative to the current UCS.

2 You must specify the viewing angles.

- **X Axis**: This field specifies the angle from the X axis.
- **XY Plane**: This field specifies the angle from the XY plane. You can also use the sample image to specify viewing angles. The black arm indicates the new angle. The red arm indicates the current angle. Specify an angle by selecting the inner region of the circle or half-circle. Selecting the bounded outer regions rounds off the angle to the value displayed in that region.
- **Set to Plan View**: This option sets the viewing angles to display the plan view relative to the selected coordinate system.

**Prerequisite**: None.

**Keyboard Command**: DDVPOINT

---

**Twist Screen: Standard**

This command will twist the screen orientation to where something other than the north direction is toward the top of the screen/drawing. It does not do a coordinate rotation, the drawing coordinates remain unchanged. Use commands on the *Points* menu, such as *Rotate Points* and *Translate Points*, if you want to do a coordinate rotation or translation.

**Prompts**

This routine prompts for the twist angle then adjusts the screen and cross-hairs to that angle. This is a modification of the *DVIEW* command. The twist angle is always measured counterclockwise with 0 degrees being to the east/right.

**Pulldown Menu Location**: View > Twist Screen

**Keyboard Command**: twist1
**Twist Screen: Line Pline or Text**

This is a variation of the previous command that allows you to select a line, polyline, or text in your drawing that you want to be aligned parallel to the east-west direction of the graphics screen. Think of the entity you select as a pointer or arrow that will point in the east direction of the screen after you select it. Select the line, polyline, or text closest to the end point which you want to be the horizontal or east direction of the screen.

**Prompts**

*Pick a line, polyline or text to make horizontal: pick a line or polyline*

**Twist Screen: Surveyor**

This is another variation of twisting the screen that allows you to input an angle/azimuth that you want to be aligned parallel to the east-west direction of the graphics screen.

**Prompts**

*Angle to set to horizontal: 0* This would align due north with respect to real world coordinates to the east or horizontal direction of the graphics screen.

**Pulldown Menu Location:** View > Twist Screen

**Keyboard Command:** twist2

**Prerequisite:** None

**File Name:** \lsp\scadutil.arx
**Keyboard Command:** twist3  
**File Name:** \lsp\scadutil.arx

### Restore Due North

This command twists the screen to make due north vertical.

**Pulldown Menu Location:** View > Twist Screen  
**Keyboard Command:** twist4  
**Prerequisite:** None  
**File Name:** \lsp\surv1.lsp

### Display Order

**Function**

This command allows you to change the display order of objects by repositioning an entity from either the background to the forefront of the drawing view or from the forefront to the background of the drawing view.

**Prerequisite:** None  
**Keyboard Command:** draworder

### Layer Control

**Function**

This command allows you to manage layers and layer properties.
This Layer Properties Manager dialog box makes a layer current, adds new layers to the layer name list, and renames an existing layer. You can assign properties to layers, turn layers on and off, freeze and thaw layers globally or by viewport, lock and unlock layers, set plot styles for layers, and turn plotting on and off for layers. You can filter the layer names displayed in the Layer Properties Manager, and you can save and restore layer states and properties settings.

1 Under Named Layer Filters, you determine which layers to display in the list of layers. You can filter layers based on whether they're xref-dependent, or whether they contain objects. You can also filter layers based on name, visibility, color, linetype, lineweight, plot style name, whether they are plotted, or whether they are frozen in the current viewport or in new viewports.

- ![button]: This button displays the Named Layer Filters dialog box.
- **Invert Filter:** This option displays layers based on the opposites of the criteria you select when you are using a named layer filter. Layers that fit the inverse criteria are displayed in the layer name list.
- **Apply to Object Properties Toolbar:** This option displays in the Object Properties toolbar only layers that match the current filter. The layer list tooltip on the Object Properties toolbar displays the filter status of layers in the drawing. (To display the layer list tooltip, position the pointing device over the layer list on the Object Properties toolbar.)
- **New:** This option creates a new layer. After you choose New, the list displays a layer named LAYER1. You can edit this layer immediately. To create multiple layers quickly, you can select a layer name for editing and enter multiple layer names separated by commas. If you create a new layer, the new layer inherits the properties of the currently selected layer in the layer list (such as Color, and On/Off state). To create layers with default settings, make sure that there are no selected layers in the list or that you select a layer with default settings before beginning layer creation.
- **Current:** This option sets the selected layer as the current layer. The CLAYER system variable stores the layer name.
- **Delete:** This option deletes selected layers from the drawing file definition. You can delete only unreferenced layers. Referenced layers include layers 0 and DEFPOINTS, layers containing objects (including objects in block definitions), the current layer, and xref-dependent layers. Layers that don't contain objects (including objects in block definitions), are not current, and are not xref-dependent can be deleted by using the PURGE command. Be careful about deleting layers if you are working on a drawing in a shared project or one based on a set of layering standards.
- **Show/Hide Details:** This option controls whether the Details section is displayed in the Layer Properties Manager.
- **Save State:** This option displays the Save Layer States dialog box, in which you save layer state and layer properties settings of all layers in a drawing. You can choose which layer states and properties you want to preserve. You save a layer state by assigning it a name.
- **Restore State:** This option displays the Layer States Manager, in which you can manage named layer states.

2 The Layer Properties Manager dialog box displays all layers and their properties. To modify a property, click its icon. To quickly select all layers, right-click your pointing device and use the shortcut menu. The following are the layer properties you can modify:

- **Name:** This field displays the names of the layers. You can select a name, and then click and enter a new name.
- **On/Off:** This field turns layers on and off. When a layer is on, it is visible and available for plotting. When a layer is off, it is invisible and not plotted, even if Plot is on.
- **Freeze/Thaw in All Viewports:** This field freezes and thaws layers in all floating viewports. A frozen layer is invisible and excluded from regeneration, hiding objects, rendering, and plotting. A thawed layer is visible and
available for regeneration, hiding objects, rendering, and plotting.

You can freeze layers to speed up ZOOM, PAN, and many other operations, improve object selection performance, and reduce regeneration time for complex drawings. TakeOff does not display, plot, or regenerate objects on frozen layers. Objects on frozen layers do not hide objects and are not rendered.

You can freeze layers in all viewports, in the current viewport, or in new viewports.

Freeze layers that you want to be invisible for long periods. When you thaw a frozen layer, the program regenerates and displays the objects on that layer. If you switch between visible and invisible states frequently, use the On/Off setting.

- **Lock/Unlock**: This field locks and unlocks the layers. You cannot select or edit objects on a locked layer. Locking a layer is useful if you want to view information on a layer for reference but do not want to edit objects on that layer.

- **Color**: This field changes the color associated with the selected layers. Clicking the color name displays the Select Color dialog box.

- **Linetype**: This field changes the linetype associated with the selected layers. Clicking any linetype name displays the Select Linetype dialog box.

- **Lineweight**: This field changes the lineweight associated with the selected layers. Clicking any lineweight name displays the Lineweight dialog box.

- **Plot Style**: This field changes the plot style associated with the selected layers. If you are working with color-dependent plot styles (the PSTYLEPOLICY system variable is set to 1), you cannot change the plot style associated with a layer. Clicking any plot style displays the Select Plot Style dialog box.

- **Plot/Don't Plot**: This field controls whether the selected layers are plotted. If you turn off plotting for a layer, the objects on that layer are still displayed. Turning off plotting for a layer affects only visible layers in the drawing (layers that are on and thawed). If a layer is set to plot, but is currently frozen or off in the drawing, TakeOff does not plot the layer. Turning off plotting for layers containing reference information such as construction lines can be useful.

**Prerequisite**: None

**Keyboard Command**: LAYER

---

### Set Layer

This command allows the user to change the current layer to a different layer by picking an entity on that layer.

**Pulldown Menu Location**: View

**Keyboard Command**: lset

**Prerequisite**: None

**File Name**: \lsp\picklayr.lsp

---

### Change Layer

This command allows you to change the layer of a group of entities by selecting the group of entities. The layer name to assign can be either typed in or read from an existing entity by picking an entity that is on the layer that you want to change the group to.

---

*Chapter 6. View Menu*
Prompts

Select entities to be changed.
Select objects: pick entities
The Select Layer dialog appears select a layer from the list, or select Screen Pick
If Screen Pick is chosen,
Pick entity with layer to change to: pick another entity This assigns the selected entities to the layer of this entity.
or
Enter new layer name or pick entity with layer (Enter/<Pick>)? E
Enter new layer name: FINAL This assigns the selected entities to the FINAL layer.

Pulldown Menu Location: View
Keyboard Command: lchg
Prerequisite: None
File Name: \lsp\chglayr.lsp

Freeze Layer

This command will freeze layers by picking entities on that layer.

Pulldown Menu Location: View
Keyboard Command: loff
Prerequisite: None
File Name: \lsp\loff.lsp

Thaw Layer

This command thaws the layers frozen by the Freeze Layer command.

Pulldown Menu Location: View
Keyboard Command: lon
Prerequisite: None
File Name: \lsp\lon.lsp
**Isolate Layer**

This command freezes all the layers except the ones you select an entity on. The program prompts to see if you would like to retain the POINT layers which keeps the Carlson point layers from freezing. By default, these layers include PNTNO, PNTMARK, PNTDESC, and PNTELEV.

**Prompts**

- **Select objects on layers to isolate.**
- **Select objects:** *pick entities*
- **Retain POINT layers [Yes/No]?** *Press Enter*

![Isolate the wall layer by picking one wall line]

**Pulldown Menu Location:** View  
**Keyboard Command:** isolate  
**Prerequisite:** None  
**File Name:** \lsp\isolate.lsp

**Restore Layer**

This command thaws the layers that were frozen by the Isolate Layer command.

**Pulldown Menu Location:** View  
**Keyboard Command:** restore  
**Prerequisite:** None  
**File Name:** \lsp\restore.lsp

**Thaw/On All Layers**

This command turns on and thaws all layers in the drawing.

**Pulldown Menu Location:** View  
**Keyboard Command:** loa  
**Prerequisite:** None
Lock Layers

The Lock Layers command will lock the layers for the layers of the selected entities.

The Unlock Layers command will unlock the layers for the layers of the selected entities.

Pulldown Menu Location: View
Keyboard Command: laylock, layunlock
Prerequisite: None

Save/Restore Layer State

The Save Layer State command stores to a file all the layers in the drawing and their current status of color, freeze/thaw, on/off, and linetype. The layer state file has a .LAY extension. Later versions of AutoCAD include the ability to save and restore layer states, found in the layer dialog box.

The Restore Layer State command sets the drawing layers and their status from the layer information in a layer state file (.LAY file). If a layer from the layer state file does not exist in the drawing, the program will create the layer. Besides the Carlson format, the Land Desktop layer state format, which is also uses a .LAY extension, is supported by this command.

Pulldown Menu Location: View
Keyboard Command: savelay, restlay
Prerequisite: None
Draw Menu

Many of the Draw Menu commands are CAD commands for creating entities in your drawing. Carlson commands that are part of the Draw menu are documented here. Any items not appearing in the Carlson manual are CAD commands that can be referenced in the AutoCAD or IntelliCAD manual.
Line

Function

This command allows you to draw a line entity by picking points on the screen or by supplying the coordinate values using the point number and associated coordinates stored in the current coordinate file. The Line command links the line with the points when the line is drawn using point numbers if the Link Linework with Points option is turned on. This option is set under General Settings in the Configure command in the Settings menu. With links active, changing a point with a command like Move Points automatically updates the line. This command always draws 2D lines with a zero elevation.

Prompts

1 Pick point or point numbers: 1-3
   You may enter a single point number or a range of point numbers
2 Undo/Distance/<Pick point or point numbers>: 16
3 Undo/+/-/Close/Distance/<Pick point or point numbers>: 35
4 Undo/+/-/Close/Distance/<Pick point or point numbers>: +
   The + or - activates an additional prompt option that allows you to plot line segments at a 90 degree deflection angle from the last line.
5 Perpendicular Distance Right: 80
6 Undo/+/-/Close/Distance/<Pick point or point numbers>: -
   The + or - activates an additional prompt option that allows you to plot line segments at a 90 degree deflection angle from the last line.
7 Perpendicular Distance Left: 105.12
8 Undo/+/-/Close/Distance/<Pick point or point numbers>: D
   The distance option allows you to input a distance for the next line segment. The position of the cursor determines the angle.
9 Enter distance: 174.32
10 Undo/+/-/Close/Distance/<Pick point or point numbers>: C
   The close option draws a line segment back to the original starting point

Prerequisite: None

Keyboard Command: 2DLINE

2D Polyline

A polyline is a series of line and/or arc segments joined together in one entity or object. In addition to the regular CAD Draw Polyline command (PL), there is this Carlson command that has several key features and options. This command allows you to draw a polyline entity in a variety of ways, including: Continue, Extend, Follow, Arc, Direction, Close, Pick point or point numbers. This dialog shown below automatically appears when you run the command.
The **Show Options on Startup** dialog will appear every time the command is run, unless this is turned off. If you do not want it to come up, then toggle it off. In this dialog you can set the elevation of the polyline, as well as the layer it will appear on.

**Offset from centerline** allows you to make another choice. First, a unique command line appears.

[Continue/Extend/Follow/Offset/Options/\(\text{Pick point or point numbers}\);]

**Auto-Zoom mode** regenerates the screen as you draw your polyline, to give you the best view as you are working. **Always** means it will always regenerate the screen. **Proximity** regenerates the screen according to the **Proximity Zoom Level %** value. **Never** toggles off this feature. The **Elevation** of the polyline can be set here. The default is 0. If it is off, then the last settings will apply. To get the box back, choose **O** for Options on the command line.

If **Use Current Drawing Layer** is on, the layer of the new polyline will be the current layer. If the current layer is not used, the **Layer** option allows you to select from a list or pick from the screen.

There are three options under **Auto-Zoom Mode**. **Never** will not zoom to the last point picked. **Proximity** will zoom to the percent proximity set below. **Always** will always zoom center on every point.

If the **Proximity** Auto-Zoom mode is checked, the percent of the proximity is set in the box on the right.
Annotate closed pads, when checked, will make available the Settings button on the right side. When Settings is chosen, the Annotate pad dialog appears. Here is where you can enter in values that will result in annotation for the closed polyline.

With regards the options available on the command line, they are explained as follows:

**Continue** allows you to run Arc, Direction, Close, Extend, or Follow for an existing polyline.

**Extend** allows you to extend an existing polyline by picking or entering in a distance.

**Follow** allows you to match the path of your polyline with an existing polyline. You are prompted to select the point in which your polyline first intersects with the existing polyline and the point in which it exits. If the existing polyline is a closed polyline than you will be prompted to approve the direction in which your polyline follows the existing closed polyline.

**Options** brings up the Polyline 2D Options dialog that appears when you first run the command, unless Offset from centerline is checked, in which case the letter indicates this feature, and a centerline will be requested.

**Pick point** allows you to pick a point on the screen to start your polyline.

**Point numbers** allows you to enter in coordinates to start your polyline.

**Arc** allows you to draw an arc by Arc length/Chord/Radius/Second point in your polyline. The + or - activates an additional prompt option that allows you to plot line segments at a 90 degree deflection angle from the last line. This is useful for plotting buildings.

**Distance** for an angle code, a backsight point, an angle (dd.mmss), and a distance to draw your polyline.

**Close** will connect the ends of your polyline making it a closed polyline.

**Prompts**

```
[Continue/Extend/Follow/Options/<Pick point or point numbers>]: pick a point
Segment length: 0.00, Total length: 0.00
[Arc/Close/Direction/Extend/Follow/Line/Undo/<Pick point or point numbers>]: pick a point
Segment length: 3.83, Total length: 3.83
[Arc/Close/Direction/Extend/Follow/Line/Undo/<Pick point or point numbers>]: pick a point
Segment length: 2.94, Total length: 6.77 press Enter to end
```

**Pulldown Menu Location:** Draw

**Keyboard Command:** 2DP

**Prerequisite:** None

**File Names:** \lsp\poly3d.arx

### 3D Polyline

In addition to the regular CAD Draw 3D Polyline command, there is this Carlson command that has several options.
The **Show Options on Startup** dialog will appear every time the command is run, unless this is turned off. If it is off, then the last settings will apply. To get the box back, choose O for Options.

**Prompt for Elevation/Slope** controls whether the elevation of each picked point will be entered in, or hit S for slope to draw a slope line.

**Use Surface Model from File** will use a grid or triangulation file as a surface model. Wherever the points are picked on the surface, the elevation of the surface will be assigned to the polyline.

If **Use Current Drawing Layer** is on, the layer of the new polyline will be the current layer.

If the current layer is not used, the **Layer** option allows you to **Select** from a list or **Pick** from the screen.

There are 3 options under **Auto-Zoom Mode**. Never will not zoom to the last point picked. Proximity will zoom to the percent proximity set below. Always will always zoom center on every point.

If the Proximity Auto-Zoom mode is checked, the percent of the proximity is set in the **Proximity Zoom Level %** box.

**Prompts**

[Continue/Extend/Follow/Options/<Pick point or point numbers>]: *pick a point*

**Elevation <0.00>:** 435

*Z: 435.00, Hz dist: 0.00, Slope dist: 0.00, Slope: 0.0% Ratio: 0.0:1*

[Arc/Direction/Close/Follow/Undo/<Pick point or point numbers>]: *pick a point*

**Slope/Ratio/Interpolate/Degree/<Elevation> <0.00>:** 444

*Z: 444.00, Hz dist: 3.67, Slope dist: 9.72, Slope: 245.3% Ratio: 0.4:1*

[Arc/Direction/Close/Extend/Follow/Undo/<Pick point or point numbers>]: *pick a point*

**Slope/Ratio/Interpolate/Degree/<Elevation> <0.00>:** 399

*Z: 399.00, Hz dist: 3.16, Slope dist: 45.11, Slope: -1425.2% Ratio: -0.1:1*

[Arc/Direction/Close/Extend/Follow/Undo/<Pick point or point numbers>]: *press Enter to end*

**Pulldown Menu Location:** Draw

**Keyboard Command:** 3DP

**Prerequisite:** None
Circle

Function

This command allows you to draw a circle.

Prompts

1 Pick center point or point number or [3P/2P/TTR]: pick point or specify option
   • 3P: This option draws a circle based on three points on the circumference.
   • 2P: This option draws a circle based on two endpoints of the diameter.
   • TTR-Tangent, Tangent, Radius: This option draws a circle with a specified radius tangent to two objects.

2 Specify radius of circle or [Diameter]: enter a value

Sometimes more than one circle matches the criteria specified in the command. The circle whose tangent points are closest to the selected points is drawn.

Prerequisite: None

Keyboard Command: SCIRCLE

3 Point

This command draws an arc between three points. The first point is the PC, the second is a point on the arc and the third is the PT. The points can either by picked on-screen or specified by point number.

Prompts

Pick PC point or point numbers: 101 (For point number 101.)
Pick Second point or point number: 102
Pick PT point or point number: 103

Pulldown Menu Location: Draw > Arc
Keyboard Command: 3PA
Prerequisite: None
File Name: \lsp\3ptarc.lsp

PC, PT, Center

This command draws an arc between the PC point, radius point and PT point. The points can either by picked on-screen or specified by point number. Given these points, the arc can be drawn clockwise or counterclockwise. The program shows one direction and asks if it is correct. If you need the arc to go the other direction, enter No.

Prompts

Pick PC point or point number: 101
Pick Radius point or point number: 102
Pick PT point or point number: 103
Is the direction of this arc correct? No/Yes: N

Pulldown Menu Location: Draw > Arc
Keyboard Command: pca
Prerequisite: None

PC, PT, Tangent

This command fits a curve between beginning and end points (PC, PT) given a tangent-in. The tangent-in is specified by selecting a line entity. The PC and PT points are screen picked.

Prompts

Pick tangent-in: pick a line entity
Pick point PC: pick a point
Pick point PT: pick a point

PC, Radius, Chord

This command draws an arc, given the PC point, radius length, chord length and chord bearing. The PC point can either by picked on-screen or specified by point number. Given these points, the arc can be drawn clockwise or counter-clockwise. The program shows one direction and asks if it is correct. If you need the arc to go the other direction, enter No.

Prompts

Radius of Arc <40.00>: 500
PC Start Point?
Pick point or point number: pick a point
Chord bearing or chord endpoint (<Bearing>/Point)? Press Enter
Enter Bearing (Qdd.mmss) <90.0000>: 145.1041 (for NE 45d10'41")
Chord Length <200.46>: 200
Is this arc in the correct direction (<Yes>/No)? Press Enter
PC, Radius, Arc Length

This command draws an arc given the PC point, radius length, and arc length. The PC point can either be picked on-screen or specified by point number. Given these points, the arc can be drawn clockwise or counterclockwise. The program shows one direction and asks if it is correct. If you need the arc to go the other direction, enter No.

Prompts

Pick PC Point or point number: *pick a point*
Pick Radius point or point number: *pick a point*
Arc length <5.00>: 150
Is this arc in the correct direction (<Yes>/No)? *press Enter*

2 Tangents, Radius

This command fits a curve between two tangent lines by entering a known radius. It prompts for the radius and then prompts to pick points on the two tangent lines.

Prompts

Radius of Arc <300.000>: *press Enter*
[nea] Pick Point on 1st Tangent Line: *pick a point*
[nea] Pick Point on 2nd Tangent Line: *pick a point*

2 Tangents, Arc Length

This command fits a curve between two tangent lines and a known arc length. It prompts for the arc length then pick the P.I. (intersection of tangent lines) and points on the two tangent lines.

Prompts

Arc Length <100.00>: *press Enter or enter distance*
[int on] Pick P.I. of curve: *pick intersection of tangent lines*
[nea on] Pick pnt on 1st Tangent Line: pick a point
[nea on] Pick pnt on 2nd Tangent Line: pick a point

Pulldown Menu Location: Draw > Arc
Keyboard Command: 2tanlal
Prerequisite: Tangent lines should be drawn before execution
File Name: \lsp\2tanlal.lsp

2 Tangents, Chord Length

This command fits a curve between two tangent lines and a known chord length. It prompts for the chord length, the P.I. and points on the two tangent lines.

Prompts

Chord Length <100.00>: press Enter
[int on] Pick P.I. of curve: pick a point
[nea on] Pick Point on 1st Tangent Line: pick a point
[nea on] Pick Point on 2nd Tangent Line: pick a point

Pulldown Menu Location: Draw > Arc
Keyboard Command: 2tanlcl
Prerequisite: Tangent lines should be drawn before execution
File Name: \lsp\2tanlcl.lsp

2 Tangents, Mid-Ordinate

This command fits a curve between two tangent lines and a known middle ordinate. It prompts for the middle ordinate length, the Point of Intersection and points on the two tangent lines.

Prompts
Middle Ordinate \(<50.00\>): press Enter
[int on] Pick P.I. of curve: pick a point
[nea on] Pick Point on 1st Tangent Line: pick a point
[nea on] Pick Point on 2nd Tangent Line: pick a point

Pulldown Menu Location: Draw > Arc
Keyboard Command: 2tanlmo
Prerequisite: Tangent lines should be drawn before execution
File Name: \lsp\2tanlmo.lsp

2 Tangents, External
This command fits a curve between two tangent lines and a known external secant distance. It prompts for the P.I. and points on the two tangent lines then the external distance.

Prompts

[int on] Pick P.I. of curve: pick a point
[nea on] Pick Point on 1st Tangent Line: pick a point
[nea on] Pick Point on 2nd Tangent Line: pick a point
External Distance \(<50.00\>): press Enter

Pulldown Menu Location: Draw > Arc
Keyboard Command: 2tanlex
Prerequisite: Tangent lines should be drawn before execution
File Name: \lsp\2tanlex.lsp

2 Tangents, Tangent Length
This command fits a curve between two tangent lines and a known curve tangent length. It prompts for the tangent length, P.I. and points on the two tangent lines.

Prompts

Tangent Length \(<50.00\>): press Enter
[int on] Pick P.I. of curve: pick a point
[nea on] Pick Point on 1st Tangent Line: pick a point
[nea on] Pick Point on 2nd Tangent Line: pick a point

Pulldown Menu Location: Draw > Arc
Keyboard Command: 2tanltl
Prerequisite: Tangent lines should be drawn before execution
File Name: \lsp\2tanltl.lsp

2 Tangents, Degree of Curve
This command fits a curve between two tangent lines by entering a known degree of curve. It prompts for the degree of curve and then prompts to pick points on the two tangent lines.
**Prompts**

**Degree of Curve (ddd.mmss) <5.0000>: press Enter**
Define by [C]hord or [A]rc length <A>: press Enter
[nea on] Pick Point on 1st Tangent Line: pick a point
[nea on] Pick Point on 2nd Tangent Line: pick a point

Pulldown Menu Location: Draw > Arc
Keyboard Command: 2tanldo
Prerequisite: Tangent lines should be drawn before execution
File Name: \lsp\2tanldo.lsp

**2 Tangents, Through Point**

This command creates an arc by tangents in/out plus a pass through point on the arc.

![Arc with tangents and point](image)

**Prompts**

Pick tangent-in: pick a line entity
Pick tangent-out: pick another line entity
Pick point on the arc: pick a point

Pulldown Menu Location: Draw > Arc
Keyboard Command: 2tanpt
Prerequisite: 2 tangent lines

**Tangent, PC, Radius, Arc Length**

This command draws a curve from a perpendicular tangent line with a known radius and arc length. It prompts for the radius, the arc length and then to pick the P.C. start point of the curve (endpoint of previously drawn tangent line) and a point along the tangent line.

**Prompts**

Precede radius with - sign for curve to the right.
Radius of Arc <15.00>: 55
Arc Length <25.00>: 30
PC Start Point?
Pick point/<point Number>: 14
PtNo. North(y) East(x) Elev(z) Desc
14 4869.06 4390.3 10.00
[nea on] Pick point along perpendicular tangent line: pick a point on tangent line
Radius Point Coordinates: (4355.2 4911.4 0.0)

Pulldown Menu Location: Draw > Arc
Keyboard Command: sral
Prerequisite: Tangent lines should be drawn before execution
File Name: \lsp\sral.lsp

Tangent, PC, Radius, Tangent Length

This command draws a curve from a perpendicular tangent line with a known radius and tangent length. It prompts for the radius, the tangent length and then to pick the P.C. start point of the curve and a point along the tangent line.

Prompts

Precede radius with - sign for curve to the right.
Radius of Arc <300.0000>: press Enter
Tangent Length <236.0000>: press Enter
PC Start Point ?
Pick point or point number: pick a point
[nea on] Pick point along perpendicular tangent line: pick a point
(5270.39 4840.36 0.0)
Radius Point Coordinates: (5251.37 4534.71 0.0)
Pulldown Menu Location: Draw > Arc
Keyboard Command: srtl
Prerequisite: Tangent lines should be drawn before execution
File Name: \lsp\srtl.lsp

Tang, PC, Radius, Chord Length

This command draws a curve from a perpendicular tangent line with a known radius and chord length. It prompts for the radius, the chord length and then to pick the P.C. start point of the curve and a point along the tangent line.
Prompts

Precede radius with - sign for curve to the right.
Radius of Arc <300.0000>: press Enter
Chord Length <25.0000>: press Enter
PC Start Point ?
Pick point or point number: pick a point
[nea on] Pick point along perpendicular tangent line: pick a point
(5142.38 4911.57 0.0)
Radius Point Coordinates: (5221.51 5209.63 0.0)

Pulldown Menu Location: Draw > Arc
Keyboard Command: SRCL
Prerequisite: Tangent lines should be drawn before execution
File Name: \lsp\srcl.lsp

Tang, PC, Radius, Delta Angle

This command draws a curve from a perpendicular tangent line with a known radius and delta angle. It prompts for the radius, the delta angle and then to pick the P.C. start point of the curve and a point along the tangent line.

Prompts

Precede radius with - sign for curve to the right.
Radius of Arc <300.0000>: press Enter
Enter Delta Angle <90.00>: press Enter
PC Start Point ?
Number/<Pick point>: pick a point
[nea on] Pick point along perpendicular tangent line: pick a point

Pulldown Menu Location: Draw > Arc
Keyboard Command: srda
Prerequisite: Tangent lines should be drawn before execution
File Name: \lsp\srda.lsp

Compound or Reverse

This command draws a compound or reverse off an existing curve. It prompts whether the curve is reverse or compound, for the P.C. start point (endpoint of an existing arc) and the known radius. Then the user selects the other known from the choices of tangent length, arc length, chord length or delta angle and enters that value. This command can be confused and malfunction if there is another entity such as a point symbol at the P.C. (If this happens, freeze the PNTMARK layer or temporarily erase the point symbol.)
Reverse curve off an existing curve

Prompts

[<end on>] Select ARC at PC Start point of the curve: pick a point
Type of curve [<Compound>/Reverse]: press Enter
Enter the Radius: 300
Define arc method [Tangent/Chord/Delta/<Length>]: press Enter
Enter the arc length: 236

Pulldown Menu Location: Draw > Arc
Keyboard Command: srcr
Prerequisite: Tangent arc should be drawn before execution
File Name: \lsp\srcr.lsp

3-RADIUS Curve Series

This command is used to best fit a series of three curves with different radii between 2 tangents. The "Offsets from the Tangents" is the distance perpendicular to the tangent from both ends of the second curve.
Offset from the tangents is the x value

**Prompts**

Please pick two tangents...
Pick first tangent: *pick a point*
Pick second tangent: *pick a point*

Pulldown Menu Location: Draw > Arc
Keyboard Command: 3curves
Prerequisite: Two tangents

**Best Fit Curve**

This command draws an arc between endpoints with a radius that is derived from sampling points and averaging the radius of an arc that passes though these points.

**Prompts**

Starting Point ?
Pick point or point number: *pick a point*

Ending point ?
Pick point or point number: *pick a point*

Select points from screen or by point number [<Screen>/Number]: *press Enter*
Select Points to sample.

Select objects: W Use window to select a group of points. After selecting all the points to sample, end selection by pressing Enter.

Pulldown Menu Location: Draw > Arc
Keyboard Command: bfitcrv
Prerequisite: Points for sampling should be drawn before execution.
File Name: \lsp\bfitcrv.lsp

**Curve Calc**

This Curve Calculator command displays a dialog box with a series of edit boxes that are filled in with the values of a curve. You can input two known values and the program calculates the other values. One of the known values must be the radius or the delta angle. The 3 Points option allows you to simply select three on-screen point locations. All of the fields will immediately be filled in after the picking of the third point. Optionally, you can also input point numbers from a coordinate file.
Roadway or Railroad: Allows you to choose which type of curve you would like information on. Toggling between the two, after data is entered, will reveal different values.

Select: Allows you to select an arc from the drawing. The information for the selected arc is displayed in the dialog box.

3 Points: Allows you to specify three points on the screen to define an arc. The information for this defined arc is displayed in the dialog box.

Plot: Allows you to plot the currently defined arc in the drawing.

Clear: Clears all edit boxes in the dialog.

Prompts

Curve Calculator dialog Enter at least two values, as described above
The dialog box first pops up without any data in the fields. The above dialog graphic is a result of entering in the radius and the arc length values of a known curve, then the Enter or Tab key.

Pulldown Menu Location: Draw > Arc
Keyboard Command: curvcalc
Prerequisite: None
File Names: \lsp\curvcalc.lsp, \lsp\scadcfu.dcl

Spiral Curve

This command plots a spiral curve. The user must provide the P.I. (point of intersection), the length of spiral and the radius length of the simple curve. The command will plot a symmetrical spiral or a spiral in or spiral out (choose the S option for the first prompt if you only want to plot a spiral out). If you have an unsymmetrical spiral then plot a spiral in using the T or P option then use the S option to plot the spiral out. The command plots a polyline to represent the spiral as line segments at the resolution specified by the user. You can use the Calculate Offsets, Station Polyline/Centerline or Offset Point Entry commands, found in the Centerline menu, to calculate points and/or stations and offsets from the spiral.
Prompts

Spiral method [TS/ST/<PI>] press Enter
PI Point ?
Pick point or point number: pick intersection of tangent lines
TS Direction point (tangent in) ?
Pick point or point number: pick point along tangent in line
ST Direction point (tangent out) ?
Pick point or point number: pick point along tangent out line
Tangent in direction= N 56d24'9'' E Azimuth= 56d24'9''
Tangent out direction= S 65d9'1'' E Azimuth= 114d50'59''
Overall Delta= 58d26'50''
Point calculating distance resolution <10.0>: press Enter
Length of Spiral <350.0>: press Enter
Radius of simple curve (precede with - sign if curve to left) <954.93>: 954.93
Degree of curve: 60d0''
Theta of Spiral= 0.18325951 (radians) 10d30'0'' (dd.mmss)
Distance along tangent line from TS to SC= 348.82
Distance offset from tangent line to SC= 21.33
(k) Shift along tangent line of PC= 174.80
(p) Shift offset from tangent line of PC= 5.34
Distance from PI to TS= 712.00
North(Y) of TS= 4583.08 East(X) of TS= 4244.46
North(Y) of SC= 4758.34 East(X) of SC= 4546.82
North(Y) of Offset PC= 4675.36 East(X) of Offset PC= 4393.02
[P]lot spiral or
[I]ntermediate distances for staking (deflection angle calc) <P>: press Enter
Point calculating distance resolution <10.0>: 5 Enter the resolution at which you would like the line segments of the representative polyline plotted.
North(Y) of Radius Pt= 3879.96 East(X) of Radius Pt= 4921.44
<press [Enter] for symmetrical spiral out>/[D]elta of simple curve: press Enter If you want a spiral in only enter D then input the delta angle of the curve.
Simple Curve Delta= 37d26'50'' Length of Arc= 624.12
North(Y) of CS= 4805.10 East(X) of CS= 5158.11
Pull down Menu Location: Draw > Arc
Keyboard Command: spiral
Prerequisite: For a symmetrical spiral, draw the tangent in and tangent out lines. For spiral in or out only, draw the tangent line in or out.
File Name: \lsp\spiral.lsp

Draw Box Around Text

This command draws a rectangle to enclose the selected text. This rectangle is drawn as a polyline in the current layer.
Prompts

Select text: pick the text to box

Pulldown Menu Location: Draw > Text
Keyboard Command: textbox
Prerequisite: Text entity

White Solid Behind Text

This command draws a white solid rectangle to highlight the selected text. The display order for the solid is set behind the text and the solid is drawn on the current layer. This command is only useful when the text itself is not white.

Prompts

Select text: pick the text to highlights

Pulldown Menu Location: Draw > Text
Keyboard Command: txtwhite
Prerequisite: Text entity

Trim Linework Through Text

This command trims linework that crosses text. After selecting the text to trim with and entering a buffer offset around the text, the program automatically finds any crossing linework and trims.

Prompts

Select text: pick the text to trim with
Enter gap <0.5>: press Enter

Pulldown Menu Location: Draw > Text
Keyboard Command: txttrim
Prerequisite: Text entity and linework

Insert Symbols

This command inserts symbols from the symbol library into the drawing. The symbol library may be edited using the Edit Symbol Library command.
In the Insert Symbols options dialog, choose a symbol by entering the Symbol Name or by picking the Select button which brings up the Select Symbol dialog. The default Symbol Category choices are Points, Trees and Map Symbols. You may select a category by choosing the Symbol Category dropdown list. Within each category, use the scroll bar to view all of the symbols. The Prompt For Rotation option will add a prompt for each symbol rotation. The Rotate By Centerline option will prompt to select linework and then rotate the symbols to make them parallel to the nearest linework. The Symbol Rotation Angle is applied relative to horizontal of the current twist screen or to the nearest linework angle when Rotate By Centerline is active. The Erase Existing Symbols options apply if you specify a symbol location that already has a symbol on it. There are also settings for the symbol layer name and size.

After the options dialog, the program prompts at the Command line for the symbol locations. The locations can be specified by picking points, specifying point numbers in the current coordinate (.CRD) file or by entering the northing and easting. Using the Select entities option, symbols can also be placed on arcs, faces, points, text, lines and polylines. Selecting the Enter coords option allows you to insert the symbol by entering a easting, northing and elevation in x,y,z order.
Chapter 7. Draw Menu

Appears at start of command

Appears when Select (symbol) is chosen
Prompts

**Insert Symbols dialog** Choose parameters and click OK
Options/Select entities/Enter coords/<Pick point or point numbers>: pick a point
Options/Select entities/Enter coords/<Pick point or point numbers>: 5-10 Inserts symbols at points 5-10 from the current coordinate file.
Options/Select entities/Enter coords/<Pick point or point numbers>: S
Insert Symbols dialog
Select arcs, faces, points, text, lines and polylines. select objects
Options/Select entities/Enter coords/<Pick point or point numbers>: press Enter to end

Pulldown Menu Location: Draw > Symbols
Keyboard Command: ptsym
Prerequisite: None

**Insert Multi-Point Symbols**

This command allows you to locate symbols using multiple insertion points. Up to three insertion points can be defined for an individual symbol. When defining only two insertion points for a particular symbol, the symbol will be scaled and rotated. With three insertion points defined, the symbol is rotated and scaled in both the X and Y directions. The two point insertion definition will aid in the drawing of tree symbols with a specific drip line width. For instance, a surveyor could locate the tree and then locate the drip line, two shots for each tree, and allow the program to size the tree symbol accordingly so that the map will have various tree symbol sizes that reflect the actual field conditions.

The multiple insertion points are defined in the Field to Finish codes. The *Insert Multi-Point Symbols* command reads the Field to Finish code table and finds all of the codes with multi-point symbol definitions. Then you can select from these codes for the symbol to draw. Both the two and three point insertion definitions can aid with the insertion of concretes and buildings symbols during final drawing preparations and design phases of a project.

Here are the various steps to define two point and three point insertion point symbols. First, you must decide on the symbol to use for the desired code, as well as the specific placement points for the symbol. Once a symbol has been chosen, open the desired symbol drawing. To do this, identify the symbol name and then locate the symbol by its drawing name under the SUP sub-directory found under the Carlson installation directory. Next, determine the placement points for the symbol. As shown below, the placement points for the BLD code symbol, which will be explored later in this section, were determined by identifying X and Y values of the desired placement points by using the id command and specifying the end points of the lines.
Next, the symbol insertion points must be defined in the Field to Finish code table (.FLD) file. To do this, open your FLD file by choosing Draw Field to Finish under the Survey pulldown. Then select a particular code from the list of codes displayed in the Field to Finish dialog box. Edit it by highlighting the code and picking the Edit button, or define a new code with the Add button. Either choice will display the Edit Field Code Definition dialog. In the Edit Code Definition dialog, choose the desired symbol for the code by pressing the Set Symbol button and selecting the desired symbol. Next, select the Symbol Pts button. This brings up a dialog called Define Symbol Placement Points. Here is where you define the symbol by three points. You do this by entering an X and Y coordinate and a description for the symbol. Enter the X and Y values for each placement point into the appropriate fields. The description fields are used as the prompts when placing the symbol in the drawing. A two insertion point symbol is defined in the same way. An example is the Symbol Pts definition for the code TREE. The placement points for the Tree code symbol were determined by opening the symbol drawing and finding the X and Y values at the insertion points. The center of the large circle was chosen for Point 1 and the East Quadrant was chosen for point 2. In both cases osnaps were used in picking the points.

Now that we have the codes defined, lets go through the Insert Multi-Point Symbol command and see the results. The command starts with a dialog that lists all the codes with Multi-Point Symbols defined. At this point you can select the symbol to draw. The symbol size applies only to using one point to place the symbol. When two or more points are used, the symbol is scaled to fit the points. Lets look at the BLD code three point insertion definition. Shown below are three points that represent a building pad. We want the building to be exactly the same dimensions defined by the point locations.

The three point PAD and the tree with drip line examples follow. We start by specifying the building pad codes.

**Prompts**

**Insert Multi-Point Symbol Dialog**
Choose a symbol to draw. In this example, the Pad symbol is a 3 point multi-symbol.

Specify LTFNT PAD point.
Pick Point or Point Number (Enter to End): 15
Specify LT REAR PAD point.
Pick Point or Point Number (Enter to End): 16
Specify RT REAR PAD point.
Pick Point or Point Number (Enter to End): 17
Insert another BLD symbol [<Yes>/No]? N

**Insert Multi-Point Symbol Dialog**
Choose a symbol to draw. In this next example, the Tree symbol is a 2 point multi-symbol. Now specify the location of the trunk and the drip line by point number.

Specify Trunk Location point.
Pick Point or Point Number (Enter to End): 1
Specify Drip Line Point.
Pick Point or Point Number (Enter to End): 13
Insert another TREE symbol [<Yes>/No]? N
From the Field to Finish routine
Two points symbol placement for TREE

Three points for building PAD

Two point tree with drip line

**Pulldown Menu Location:** Draw > Symbols

**Keyboard Command:** multsym

**Prerequisite:** Field to Finish file (.FLD) with codes defined with Multi-Point Symbols

**File Name:** \lsp\finish.arx

## Hatch

### Function

This command allows you to fill an enclosed area or selected objects with a hatch pattern.

The Hatch command first defines the boundaries of the area you want to hatch, either by computing a region or polyline boundary from a specified point within an enclosed area, or by using selected objects as boundaries. It then fills the boundaries with a hatch pattern or a solid color. You can create an associative hatch, which updates when its boundaries are modified, or a nonassociative hatch, which is independent of its boundaries. You can preview any hatch and adjust the definition.

Due to the large number of combinations of geometry that you can hatch, editing hatched geometry can produce unexpected results. In this event, delete the hatch object and rehatch.
The Boundary Hatch dialog box defines the boundary, pattern type, pattern properties, and attributes for hatch objects. Use the Quick Tab to work with hatch patterns and quickly create a hatch. Use the Advanced Tab to customize how TakeOff creates and hatches boundaries.

1 Under the Quick Tab you define the appearance of the hatch pattern to be applied.
   - Type: This field sets the pattern type.
   - Pattern: This field lists the available predefined patterns. The six most recently used predefined patterns appear at the top of the list. The Pattern option is available only if you set Type to Predefined.
   - [...]: This button displays the Hatch Pattern Palette dialog box, in which you can view preview images for all predefined patterns at once to help you make a selection.
   - Swatch: This field displays a preview of the selected pattern. You can click the swatch to display the Hatch Pattern Palette dialog box.
   - Custom Pattern: This field lists the available custom patterns. The six most-recently used custom patterns appear at the top of the list. The Custom Pattern option is available only if you set Type to Custom.
   - Angle: This field specifies an angle for the hatch pattern relative to the X axis of the current UCS.
   - Scale: This option expands or contracts a predefined or custom pattern. This option is available only if you set Type to Predefined or Custom.
   - Relative to Paper Space: This option scales the hatch pattern relative to paper space units. Using this option, you can easily display hatch patterns at a scale that is appropriate for your layout. This option is available only from a layout.
   - Spacing: This option specifies the spacing of lines in a user-defined pattern. This option is available only if you set Type to User Defined.
   - ISO Pen Width: This option scales an ISO predefined pattern based on the pen width you choose. This option is available only if you set Type to Predefined and set Pattern to one of the available ISO patterns.

2 Under the Advanced Tab you define how TakeOff creates and hatches boundaries.
Island Detection Style: This option allows you to specify the method for hatching objects within the outermost hatch boundary. If no internal boundaries exist, specifying an Island Detection style has no effect. Because you can define a precise set of boundaries, it's often best to use the Normal style.

The illustrations that accompany each style show how the program hatches a group of three nested boundary objects in each case.

Normal

Hatches inward from the outer boundary. If the program encounters an internal intersection, it turns off hatching until it encounters another intersection. Thus, areas separated from the outside of the hatched area by an odd number of intersections are hatched, and areas separated by an even number of intersections are not.

Outer

Hatches inward from the outer boundary. The program turns hatching off if it encounters an internal intersection. Because this process starts from both ends of each hatch line, the program hatches only the outermost level of the structure and leaves the internal structure blank.

Ignore

Ignores all internal objects and hatches through them.

Hatching concave curves with the Outer and Ignore styles can cause hatching discrepancies.
The Normal, Outer, and Ignore options are also available from a shortcut menu by right-clicking in the drawing area while you specify points or select objects to define your boundaries.

- **Object Type:** This option allows you to specify whether to retain boundaries as objects, and specifies the object type TakeOff applies to those boundary objects. Object Type controls the type of the new boundary object. TakeOff creates the boundary as a region or a polyline. This option is available only if you select Retain Boundaries.
- **Retain Boundaries:** This option adds the temporary boundary objects to the drawing.
- **Boundary Set:** This field defines the set of objects TakeOff analyzes when defining a boundary from a specified point. The selected boundary set has no effect when you use Select Objects to define a boundary. By default, when you use Pick Points to define a boundary, the program analyzes all objects visible in the current viewport. By redefining the boundary set, you can disregard certain objects when defining boundaries without having to hide or remove those objects. For large drawings, redefining the boundary set can also produce the boundary faster because the program examines fewer objects.
- **New:** This option prompts you to select the objects that define the boundary set. When you choose this option, the dialog box temporarily closes, prompting you to select objects. TakeOff includes only the hatchable objects you select when it constructs the new boundary set. TakeOff discards any existing boundary set, replacing it with the new boundary set defined by the objects you select. If you don't select any hatchable objects, the program retains any current set. Until you exit the Hatch command or create a new boundary set, TakeOff ignores objects that do not exist in the boundary set when you define your boundaries using Pick Points.
- **Island Detection Method:** This option allows you to specify whether to include objects within the outermost boundary as boundary objects. These internal objects are known as islands.
  - **Flood:** This option includes islands as boundary objects.
  - **Ray Casting:** This option runs a line from the point you specify to the nearest object and then traces the boundary in a counterclockwise direction, thus excluding islands as boundary objects.

3 In the Boundary Hatch dialog box, you set the options that define the selection set.

- **Pick Points:** This option determines a boundary from existing objects that form an enclosed area. How TakeOff detects objects using this option depends on the selected Island Detection Method on the Advanced tab. For example, if the Island Detection Method is Flood, the program detects objects within the outermost boundary as islands and includes them in the boundary definition. The Island Detection Style (which you also set on the Advanced tab) then determines how to hatch the detected islands. When you choose Pick Points, the dialog box closes temporarily, and the program prompts for point specification.
- **Select Objects:** This option allows you to select specific objects for hatching. The dialog box closes temporarily, and the program prompts you for object selection. When you define your boundaries using Select Objects, the program does not detect interior objects automatically. You must select the objects within the selected boundary to hatch those objects according to the current Island Detection Style (which you set on the Advanced tab). Each time you choose Select Objects, the program clears the previous selection set. While selecting objects, you can right-click at any time in the drawing area to display a shortcut menu. You can undo the last or all selections, change the selection method, change the island detection style, or preview the hatch.
- **Remove Islands:** This option removes from the boundary definition any of the objects that the program detects as islands when you use Pick Points. You cannot remove the outer boundary.
- **View Selections:** This option temporarily dismisses the dialog box and displays the currently defined boundaries with the hatch settings that you last previewed. This option is unavailable when you have not yet specified points or selected objects.
- **Inherit Properties:** This option hatches specified boundaries using the hatch properties of one object. After selecting the associative hatch object whose properties you want the hatch to inherit, you can right-click in the
drawing area and use the shortcut menu to toggle between the Select Objects and Pick Internal Point options to create boundaries.

- Double: For user-defined patterns, this option draws a second set of lines positioned at 90 degrees to the original lines, creating a crosshatch. This option is available only if you set Type to User Defined on the Quick tab.

- Associative: This option creates an associative hatch, meaning that the hatch is updated when you modify its boundaries.

- Nonassociative: This option creates a nonassociative hatch, meaning that it is independent of its boundaries.

- Preview: This option temporarily dismisses the dialog box and displays the currently defined boundaries with the current hatch settings. This option is not available when you have not yet specified points or selected objects to define your boundaries.

**Prerequisite:** None

**Keyboard Command:** BHATCH

### Raster Image

**Function**

This command allows you to manage raster images.

! The Image Manager dialog box lists all the image files attached to the current drawing. You can view the parameters and details for selected images. You can attach new image files and detach, locate, reload, and unload existing images.

- List View: This button lists the image definitions attached to the drawing. Each image name appears only once regardless of how many times you attach (insert) the image. You can sort the list of images by name, status (loaded, unloaded, or not found), size, type (TIFF, for example), date, or the saved path and file name. By default, TakeOff displays the list alphabetically by image name.

To select multiple images, hold down SHIFT or CTRL while selecting items.

To sort the list alphabetically or numerically by a specific column, click that column's heading.
To change the width of the column, drag the line between the column headings to the right or left. The program saves and restores the settings when you reopen the dialog box.

To change an image name, select it and then click it again, or select it and then press F2. You cannot edit names of images that reside in external references (xrefs). Image names can include up to 255 characters and can contain letters, digits, spaces, and any special characters not used by Microsoft® Windows® or TakeOff. The image name can be identical to the file name, but changing the image name does not change the file name.

- **Tree View**: This button displays all the image definitions and the levels of nesting of images within xrefs. The top level of the tree view shows images that you attached directly to the drawing, images nested in block references, and the names of externally referenced drawings containing images. The names of the images attached to the externally referenced drawings appear nested within the drawing at the next tree level. To insert a copy of an already attached image, select it, and then choose Attach.

Tree view lists the image names only (not file names) and lists the image name just once, regardless of how many times you attach (insert) the image.

You can edit an image name by selecting it and then clicking it again, or by selecting it and then pressing F2. However, you cannot select more than one image at a time.

- **Attach**: This option displays the Select Image File dialog box. When you unload and then reload an image, the program draws that image on top. Images remain loaded or unloaded from one drawing session to the next.
- **Detach**: This option removes the selected image definitions from the drawing database and erases all the associated image objects from the drawing and from the display.
- **Reload**: This option loads the most recent version of an image or reloads an image that was previously unloaded. Reloading does not control whether the image is displayed, but it ensures display of the most current image.
- **Unload**: This option unloads image data from working memory without erasing the image objects from the drawing. It is recommended that you unload images no longer needed for editing to improve performance. An unloaded image cannot be displayed or plotted. You can selectively load and unload individual images from a working list of images associated with the drawing file.
- **Details**: This option opens the Image File Details dialog box, which displays the image name, saved path, active path, file creation date and time, file size and type, color system, color depth, width and height in pixels, resolution, default size in units, and a preview image.
- **Image Found At**: This field shows the path of the selected image. If you select multiple images, this field remains blank. The path shown is the actual path where the image resides.
- **Browse**: This option opens the Select Image File dialog box (a standard file selection dialog box). The path you select appears under Image Found At.
- **Save Path**: This option stores the new path information. Press ESC while editing the path to restore the old path. If the program cannot find the referenced image in the new path, the image's status changes to Not Found. If you do not choose Save Path after editing the path, the program uses the original image path the next time you load the drawing.

2 Under the Image dialog box, you can attach an image.
3 In the Image dialog box, you must first identify the image and the path.

- **Name:** This field identifies the image you have selected to attach, either from the Select Image File dialog box (an unattached image) or from the list of previously attached images. To add another instance of an image file that is already attached, select the image name from the list and choose OK.

- **Browse:** This option opens the Select Image File dialog box (a standard file selection dialog box). If Show Preview is selected, the program displays a preview of the selected file.

- **Retain Path:** This option saves the path of the image file with the image definition. If Retain Path is not selected, only the image name is saved and TakeOff searches the Support File Search Path.

4 Under Insertion Point, you must specify the insertion point for the selected image. **Specify On-Screen** is the default. The default insertion point is 0,0.

- **Specify On-Screen:** This option directs input to the command line or the pointing device. If Specify On-Screen is cleared, enter the insertion point in X, Y, and Z.

- **X:** This field sets the X coordinate value.

- **Y:** This field sets the Y coordinate value.

- **Z:** This field sets the Z coordinate value.

5 Under Scale, you must specify the scale factor of the selected image. **Specify On-Screen** directs input to the command line or the pointing device. If Specify On-Screen is cleared, enter a value for the scale factor. The default scale factor is 1.

6 Under Rotation, you must specify the rotation angle of the selected image. If Specify On-Screen is selected, you may wait until you exit the dialog box to rotate the object with your pointing device or enter a rotation angle value on the command line. If Specify On-Screen is cleared, enter the rotation angle value in the dialog box. The default rotation angle is 0.

**Prerequisite:** Raster image

**Keyboard Command:** IMAGE

---

**Place Image by World File**

**Function**
This function allows you to insert Geo-Referenced TIF files into AutoCAD drawings. This process requires the presence of an accompanying TFW file. The TFW file contains information about the location and scaling of the actual raster image TIF file. This eliminates the guesswork in inserting, moving, and rotating raster images to the project area. You begin by selecting the TFW or JGW file to process. If the related TIF file is present in the same directory, the image will be inserted into the proper coordinates.

Prompts

Select World File: choose existing .TFW or .JGW file
Keyboard Command: geotiff
Prerequisite: None

Draw Standard Item

Overview Draw Standard Items
The Draw CAD Standards feature in Carlson Software is a collection of commands allowing you to create, manage and draw standardized Symbols, Linework and Annotation entities that are stored in a Standards Database file (.sdb). All of the commands can be found under the Item sub-menu of the Draw menu or on the Draw Item toolbar.

The Draw Item toolbar, shown below, has icons for the Draw Item, Set Data Source and Exit Drawing Standards commands. In addition, these commands are all accessible from the Draw menu.

The Item Standards Manager command is only accessible through the Draw menu.

The Item Standards Manager command launches the Standards Draw Manager palette. This palette has a right-click shortcut menu allowing you to Insert, Modify, Delete and otherwise manage Items stored in the Standards Database file (.sdb). Other than the shortcut menu, this palette is identical to the Standards Draw palette.

The first time you launch the Item Standards Manager in a drawing session, you will be prompted to "Select Drawing Standards Data Source". Carlson includes two Standards Database files (.sdb) with the installation: the Carlson_NCS_SurveyCivil.sdb which is a fully populated database based on the US National CAD Standard and empty.sdb which is a functional, but empty, database with which to start a new Standard Database.
Using the **Draw Standard Item** command, the CAD User can access the **Standards Draw** palette and place standardized Symbols, Linework and Annotation in the drawing. Prior to adding Standard Items to the drawing, the CAD User will load the appropriate Standards Database file (.sdb) using the **Set Data Source** command.

**Draw Standard Item**

The **Draw Standard Item** command activates the **Standards Draw** palette. This palette is essentially the same as the **Standards Draw Manager** palette except that it does not have the Standards management commands available in the right-click shortcut menu.

The first time you launch the **Draw Standard Item** command in a drawing session, a dialog box will prompt you to "Select Drawing Standards Data Source".

The Standards Data Source can be loaded by specifying a Universal Data Link file (.udl) or a Standards Database file (.sdb). Carlson includes two Standards Database files (.sdb) with the installation: the **Carlson**
son_NCS_SurveyCivil.sdb which is a fully populated database based on the **US National CAD Standard** and empty.sdb which is a functional, but empty, database with which to start a new Standard Database.

After specifying the data source, the **Draw Standard Item** command is automatically issued. If you wish to Draw a Standard Item in your drawing at this time, you can specify the Standard Item to be drawn either by typing its QuickKey in at the Command: Line or by selecting a similar Standard Item currently existing in the drawing.

If you do not know the QuickKey of the Standard Item you wish to draw and do not have a similar Item in the drawing, press the **Enter** key to finish the command and return to the Command: prompt. You can now access the **Standards Draw** palette by hovering over the **Draw Standard Item** icon on the **Draw Item** toolbar.

By default, the **Standards Draw** palette automatically hides within the **Draw Standard Item** icon. Hovering over this icon will display the palette. Once displayed, the palette may be dragged to a new location and re-sized. Since the palette is fully transparent, it can be "parked" in the drawing area and not interfere with other drafting tasks. The palette is also "transparent" with regards to command execution in that other commands are able to run while the palette remains open and available for use.

Items in the **Standards Draw** palette are organized into Folders and given commonly referred-to, descrip-
tive names. Defining these Items and other management tasks are done through the **Items Standards Manager**.

A Standard Item can include any one or a combination of 3 types of entities: Symbols, Linework and Annotation (with or without a Leader). Next to each Item in the palette is an icon graphic that indicates the type of entities defined for that Standard Item.

This icon, ★ is shown for a Standard Symbol Item.

This icon, → is shown for a Standard Linework Item.

This icon, ● is shown for a Standard Annotation Item.

You may also see one of these icons representing a combination of entity types: ★ → ●

Because many Standard Items will be sized based on the scale of the drawing, it is important to set the "Horizontal Scale" in the **Carlson Drawing Setup** dialog box before drawing Standard Items into your drawing. If Standard Items are drawn and scaled according to the "Horizontal Scale", the "Horizontal Scale" setting is saved with the entity. In other words, changes to the "Horizontal Scale" of the drawing will not affect existing entities. This is true of Symbols, Annotation and Leader components.

There are 3 methods you can use to place Standard Items in your drawing:

- **Select Object** - This option is enabled when starting the **Draw Item** command from either the Draw Item toolbar or the Draw menu. When prompted at the Command: Line, you can select any Standard Item that has been previously drawn in the drawing and will then be able to place a new instance of that Item.

- **Quick Key** - This option is enabled when starting the **Draw Item** command from either the Draw Item toolbar or the Draw menu. When prompted at the Command: Line, type in the QuickKey shortcut for the Standard Item you wish to draw.

- **Standard Draw palette** - After the Data Source has been loaded, you can access the **Standard Draw** palette by hovering over the Draw Item icon.

To Draw a Standard Item using the Item menu in the palette, navigate through and left-click the Standard Item to be drawn. Assuming the Standard Item has a Symbol, Linework and Annotation component, you will see, generally, the following series of prompts. Note that, depending on the various options that have been set for each Item, the prompts may vary.

**Start Point:** Using the left-mouse button, select the location for the first Symbol component. This point will also be the first endpoint of the Linework for this Item. If you do not wish to have a Symbol inserted at this point and only wish to draw the associated Linework, hold the ALT key when specifying the Start Point to proceed on to the next Endpoint.

**Rotation Angle:** If you have placed a Symbol, specify its Rotation Angle. If you have set the Symbol Rotation option to "Fixed", you will not be prompted for this Rotation Angle.

If you Insert a Symbol having non-Constant attribute values, you will be prompted through a dialog box to define the attribute values:
Halfwidth/Width/CLose/Length/Open/Undo/Arc Endpoint of line: Select the next Endpoint of the line segment or specify one of the other Polyline command options before picking the Endpoint. If you do not want to draw a Linework segment at this time, press Enter to skip this step and continue on to place Annotation.

Rotation Angle: Specify the Rotation Angle for the next Symbol. Again, depending on the Symbol Rotation options you have set, you may or may not receive this prompt.

The prompts will continue to alternate between "Rotation Angle" and "Endpoint of Line" until you have reached the end of your Linework. When you have specified your final Endpoint and the Rotation Angle of your final Symbol, right-click to continue on to place Annotation.

Displacement/Identify or <\P> key in alternative text: This is the prompt for your first Annotation entity. The Item's Label is used for default Text content. To override the default Text, simply type in the alternative Text at the Command: Line. If you need a 2nd line of Text, use "\P" to designate the 2nd line of text. For instance, entering "TWO STORY\PWOOD FRAME" would result in the following Text string in the drawing:

```
TWO STORY
WOOD FRAME
```

Also, left-clicking on any other Text entity will update your current Text value to match the Text that was selected. And, holding the ALT key while left-clicking on any other Text entity will add the value of that Text entity as a 2nd line of Text to your current Text value.

Once you have finished entering the Text, press Enter to finish Text entry. Left-click in the drawing to place the Text.

Rotation angle/Identify or <\P> key in alternative text <0.0000>: Type in a Rotation Angle for the text or left-click to specify the desired angle.

Leader Start Point: Left-click to specify the location of the arrowhead part of the Leader. If you do not want a Leader, you can right-click to skip the Leader and proceed on to place the next Text entity.
**Next Leader Point:** Left-click to specify the next Endpoint of the Leader. You will continue being prompted for "Next Leader Point:" until you right-click or **Enter** to finish drawing the Leader.

After you have finished drawing the first Annotation entity (with or without a Leader), you will continue to be prompted to place additional Annotation and Leaders. Right-click or press **Enter** to finish the command.

**Pulldown Menu Location(s):** Draw → Item  
**Keyboard Command:** drawitem  
**Prerequisite:** Populated Standards Database file (.sdb)

---

**Set Drawing Standards Data Source**

The **Set Drawing Standards Data Source** command allows you to browse to and associate a Standards database file with your active drawing. Doing so enables you to use the **Draw Item** command to place Standard Items into your drawing.

This command will accept selection of either a Standards Database file (.sdb) or Universal Data Link file (.udl) that points to the .sdb file. Carlson includes two Standards Database files (.sdb) with the installation: the **Carlson_NCS_SurveyCivil.sdb** which is a fully populated database based on the **US National CAD Standard** and **empty.sdb** which is a functional, but empty, database with which to start a new Standard Database.

This command is available from the **Draw** menu and the **Draw Item** toolbar as shown below.

[Image: SetDataSource.png]

**Pulldown Menu Location(s):** Draw → Item  
**Keyboard Command:** setitem  
**Prerequisite:** Standards Database File (.sdb)

---

**Item Standards Manager**

The **Item Standards Manager** command launches the **Standards Draw Manager** palette. This palette has a right-click shortcut menu allowing you to Insert, Modify, Delete and otherwise manage Items stored in the Standards Database file (.sdb). Other than the shortcut menu, this palette is identical to the **Standards Draw** palette.

The first time you launch the **Item Standards Manager** in a drawing session, a dialog box will prompt you to "Select Drawing Standards Data Source".

The Standards Data Source can be loaded by specifying a Universal Data Link file (.udl) or a Standards Database file (.sdb). The .udl file is a file that "points" to an .sdb file. CAD Managers may prefer to allow users access to the database through the Universal Data Link file (.udl). This allows the CAD Manager to limit access to the Standards Database file (.sdb) by storing it in a non-shared location. The CAD Manager can set "read only" or "read/write" permissions for the .udl file so as to limit editing access to the protected data stored in the .sdb file.

Carlson includes two Standards Database files (.sdb) with the installation: the **Carlson_NCS_SurveyCivil.sdb** which is a fully populated database based on the **US National CAD Standard** and **empty.sdb** which is a functional,
but empty, database with which to start a new Standard Database.

After specifying the data source, the CAD Standards feature is launched in "CAD Management" mode and the Draw Standard Item command is automatically issued. If you wish to place a Standard Item in your drawing at this time, you can simply continue the Draw Standard Item command as usual. However, if you need to perform any management tasks to the database, use the Enter key to finish the command and return to the Command: prompt. You can then access the Standards Draw Manager palette by hovering over the Draw Standard Item icon on the Draw Item toolbar.

By default, the Standards Draw Manager palette automatically hides within the Draw Standard Item icon. Hovering over this icon will display the palette. Once displayed, the palette may be dragged to a new location and re-sized. Since the palette is fully transparent, it can be "parked" in the drawing area and not interfere with other drafting tasks. The palette is also "transparent" with regards to command execution in that other commands are able to run while the palette remains open and available for use.

Once displayed, right-clicking inside the Standards Draw Manager displays a menu containing the Standards Database management commands.

Use this command to create a new folder or sub-folder in which to store Standard Items.
Name: The common name for Items in this Folder. The Folder Name is limited to 32 characters.

Description: Additional descriptive information about this Folder. The Folder Description is limited to 32 characters.

Characteristic: Distinguishing characteristic of this Folder. The Folder Characteristic is limited to 32 characters.

The "Name", "Description" and "Characteristic" of each new Folder can be organized and named using any consistent naming convention that makes sense for your office. The dialog also allows you to specify a "Prefix" and "Suffix" for both the "Description" and "Characteristic" of each new Folder. The "Prefix" and "Suffix" values shown in the example above have been set as parentheses ( ) and brackets [ ]. You can set the Default values for "Prefix" and "Suffix" in Item Database Preferences.

Label: This is a read-only value defined by combining the Folder Name, Description and Characteristic.

Quick Key: This value is not used or set for Folders.

Scale: This read-only value displays the current "Horizontal Scale" as specified in Carlson Drawing Setup.

This command allows you to import a collection of blocks into the database as Standard Symbol Items. Default Scale, Attribute Properties and Rotation can be set for all symbols when importing to the database. For this command, all blocks should be saved out to individual Drawing files (.dwg) in a common blocks folder. And, contrary to accepted CAD practice, the blocks should be drawn on their standard layer instead of layer 0.

For instance, according to our standard, symbol SSWR-08 should reside on layer V-SSWR-STRC. If I intend to import this symbol into the database using the Import Symbol Library command, the symbol SSWR-08 should reside in its own drawing file named SSWR-08.dwg and should be drawn on layer V-SSWR-STRC in that
Except as noted above with regard to layers, all Symbols should be drawn according to the guidelines set forth in the Best Practices section of this document.

Scale: Because the default X, Y and Z scale factors correspond to the current "Horizontal Scale" setting in Carlson Drawing Setup, these values should all be set to "1" when defining Standard Symbol Items to the database.

Select the "Fixed" options for X, Y and Z Scales if you wish to manage the Symbol size solely by these values. Do NOT select the "Fixed" options if you want the Symbol size to vary depending on the "Horizontal Scale" setting of the drawing.

Properties: For blocks having defined attributes, use the settings here to Allow Moving, Rotating and Masking of attributes.

Rotation: Default Rotation for Symbols can be specified as "First", "Fixed", "Mean" and "Previous". The "First" option will prompt for a Rotation angle for the first Symbol and then will automatically Rotate all subsequent Symbols to the same angle as the first. The "Fixed" option will use the Rotation angle as specified for the original Symbol. The "Previous" option will prompt for the Rotation angle of each Symbol that is placed, but will default to the Rotation angle of the previously placed Symbol.

Browse for Folder: Browse to and select the folder containing the Symbols to be imported. After importing Symbols from a folder, the database will automatically add the folder to the list of "Additional Support Paths" as specified in the Item Database Preferences. In order to insert the Symbol into other drawings in the future, the source drawing file containing the original Symbol/Block definition must be found in a Support Path.

Use this command to export all layers and associated properties (color, linetype, etc.) to a Layer Library file (.la).

Use this command to export all Standard Items to corresponding field codes in a Field to Finish file (.fld).

Use this command to define a Standard Item to the Standards Database file (.sdb). If you wish to store the new Standard Item in a Folder, you must first select and highlight the Folder, then right-click and select Insert Item from the shortcut menu. If you do not want the new Standard Item saved in a Folder, simply right-click anywhere in
the palette and select **Insert Item**. Once Items have been created, you can simply "drag and drop" Items from one Folder to another as needed.

A Standard Item, when defined to the database, can include any one or a combination of 3 types of entities: Symbols, Linework and Annotation (with or without a Leader). If more than one of any type (2 Symbols, for instance) are selected, you will be prompted to select the ONE entity to be used for the Standard Item definition.

Prior to Inserting a new Standard Item, all entities should be drawn according to the guidelines set forth in the Best Practices section of this document.

---

**Select Objects:** Select the entities that comprise the new Standard Item to be defined.

**Name:** The common name for this Item. The Item Name is limited to 32 characters.

**Description:** Additional descriptive information about this Item. The Item Description is limited to 32 characters.

**Characteristic:** Distinguishing characteristic of this Item. The Item Characteristic is limited to 32 characters.

The "Name", "Description" and "Characteristic" of each new Item can be organized and named using any consistent naming convention that makes sense for your office. The dialog also allows you to specify a "Prefix" and "Suffix" for both the "Description" and "Characteristic" of each new Item. The "Prefix" and "Suffix" values shown in the example above have been set as parentheses ( ) and brackets [ ]. You can set the Default values for "Prefix" and "Suffix" in Item Database Preferences.

**Label:** This is a read-only value defined by combining the Item Name, Description and Characteristic.
Quick Key: This is a nickname for the Standard Item. The Quick Key is used with the Draw Item command and allows you to specify the Standard Item to be drawn from the Command: line.

Scale: This read-only value displays the current "Horizontal Scale" as specified in Carlson Drawing Setup.

Symbol tab

Scale: Because the default X, Y and Z scale factors correspond to the current "Horizontal Scale" setting in Carlson Drawing Setup, these values should be set to "1" when defining Standard Symbols to the database.

Select the "Fixed" options for X, Y and Z Scales if you wish to manage the Symbol Size solely by these values. Do NOT select the "Fixed" options if you want the Symbol Size to vary depending on the "Horizontal Scale" setting of the drawing.

Properties: For blocks having defined attributes, use the settings here to allow Moving, Rotating and Masking of attributes.

Rotation: Default Rotation for Symbols can be specified as "First", "Fixed", "Mean" and "Previous". The "First" option will prompt for a Rotation angle for the first Symbol and then will automatically Rotate all subsequent Symbols to the same angle as the first. The "Fixed" option will use the Rotation angle as specified for the original Symbol. The "Previous" option will prompt for the Rotation angle of each Symbol that is placed, but will default to the Rotation angle of the previously placed Symbol.

Linework tab
Linetype: This read-only value reflects the Linetype of the Linework element. Using a "ByLayer" value allows for maximum flexibility in the future.

Scale and Width: The Scale and Width settings shown here reflect the Linetype Scale and Width of the entity selected. These values can be modified and can also be specified as "Fixed".

Select the "Fixed" option for "Scale" if you wish to manage the Linetype Scale of the entity solely by this value. Do NOT select the "Fixed" option if you want the drawing's LTSCALE setting to control the Linetype Scale of each entity.

Note: The "Fixed" option here applies to the Current Entity Linetype Scale and not the global LTSCALE that we are accustomed to changing based on the scale of the drawing. For the LTSCALE to behave in its traditional fashion, it requires the Current Entity Linetype Scale value be set "Fixed" to "1".

Select the "Fixed" option for "Width" if you wish to manage the Width of the entity solely by this value. Do NOT select the "Fixed" option if you want the Width of the linework to be scaled by the "Horizontal Scale" of the drawing.

Closed: Select this option if the Linework is to be forced to be a "Closed" polygon.

Offset Items - Insert: This button can be used to draw multiple Linework Items parallel to one another. When defining Offsets, you will Insert one Linework Item to the database and then specify the other Linework Items to be drawn parallel to the original Item. The Offset Linework Items do not have to be drawn at the correct Offset. After each Offset Item has been selected, you will be prompted to specify the Offset distance from the original Item.

For instance, in addition to defining separate Standard Items for "Back of Curb", "Gutter Line" and "Edge of Pavement", you might also define a Standard Item named "Standard 30" Curb" that combines all three Standard Items.

First, use the Insert Item command and select the "Back of Curb" Item as the first Item.

Next, pick the Offset button and select a "Gutter Line" Item that has been previously drawn in the drawing. You'll be prompted at the Command: Line to specify the Offset Distance from the original Item. This value can also be added or changed in the dialog box. The Offset Distance for the "Gutter Line" would be 0.5, representing a 0.5'
wide curb.

Next, pick the Offset button again and select an "Edge of Pavement" Item that has been previously drawn in the drawing. Again, you'll be prompted at the Command: Line to specify the Offset Distance from the original Item. The Offset Distance for the "Edge of Pavement" would be 2.5, representing a 2.5' wide curb with gutter.

After being added as Offsets, both of these values should be marked as "Fixed" because their Offset values should not change based on the "Horizontal Scale" of the drawing.

**Offset Items - Delete:** After selecting an Offset, pick this button to delete the Offset from the Standard Item.

---

**Annotation tab**
**Style:** This read-only value reflects the Text Style of the Annotation element.

**Height and Width Factor:** The Height and Width Factor settings shown here reflect the Text Height and Width Factor of the entity selected. While both the Height and Width Factor can be modified, the Width of the text is a read-only, computed value. You also have the option of specifying the Height as "Fixed".

Select the "Fixed" option for "Height" if you wish to manage the Height of the entity solely by this value. Do NOT select the "Fixed" option if you want the Height to vary depending on the "Horizontal Scale" setting of the drawing.

**Rotation:** Default Rotation for Annotation can be specified as "First", "Fixed", "Mean" and "Previous". The "First" option will prompt for a Rotation angle for the first Annotation entity and then will automatically Rotate all subsequent entities to the same angle as the first. The "Fixed" option will use the Rotation angle as specified for the original Annotation entity. The "Previous" option will prompt for the Rotation angle of each Annotation entity that is placed, but will default to the Rotation angle of the previously placed entity.

**Leadered:** Select this option if you wish to have the ability to place a Leader with each instance of your Annotation. The Leader option is only available if you selected both a Text/MText entity and a Leader entity when Inserting the Item to the database. The read-only value to the right reflects the Dimension Style of the Leader entity selected.

**Mask:** Select this option if you wish to have each instance of Annotation "masked" using a WIPEOUT entity. If selected, the "Height Offset" option becomes active allowing you to control the size of the WIPEOUT.

Right-click on any Item or Item Folder and select **Modify Item** to make changes.

Right-click on any Item or Item Folder and select **Delete Item** to remove the Item from the database.

Right-click in the palette and select this command to manage Item Description and Characteristic Prefix and Suffix values and also to Add or Delete "Additional Support Paths".
Item Standards Manager - Best Practices

Once Standard Items have been defined to your Standards Database, many properties of those Items cannot be modified. For instance, if you have defined an Annotation entity having a Left justification to your database and later realize it should have Center justification, it cannot be changed. To correct it, you must first delete the Standard Item from the database, create a Text entity with the correct justification and then re-Insert the Item to the database.

Therefore, it is recommended that you create a "Source Drawing" to help you plan, set up and define the Standard Items to be added to your Standards Database.

The Source Drawing should contain small clusters of entities organized according to the Standard Items to be defined. For each Standard Item to be defined, all of the Symbol, Linework and Annotation entities comprising that Item should be drawn or inserted into the Source Drawing.

The Symbols, Linework and Annotation entities used to define Standard Items should be drawn at 1:1 and should have Color and Linetype set to "ByLayer". These entities should reside on their standard layers and be drawn with the appropriate text styles, text heights, text justification, linetypes and dimension styles. Only one type of Standard entity can be defined for a Standard Item. For instance, only one Symbol can be defined per Standard Item.

Before drawing or inserting the components of the Standard Items into the Source Drawing, set the "Horizontal Scale" in Carlson Drawing Setup to 1:1. This ensures that new "Horizontal Scale" settings will be applied correctly when these Standard Items are drawn into new drawings.

A representative sample of a Source Drawing is shown below. A few notes:

- A new Item named "Exis Sanitary Sewer" will be created and will have a Symbol, Linework and Annotation component. The Symbol resides on layer V-SSWR-STRC. The Linework resides on layer V-SSWR-PIPE. The Text and Leader reside on layer V-SSWR-TEXT. Text/MText entities and their associated Leaders are considered ONE Annotation entity when defining to the standards database.

- Notice that the Symbol does not have to be positioned at the endpoint of the Linework when defining as Standard Items. The Symbol will automatically be placed at each vertex of the Linework when it's drawn into the drawing.

- All Text except for that on layer V-SSWR-LABL is drawn with a height of 0.08 and is Left justified. The Text on layer V-SSWR-LABL has a height of 0.12 and is Center justified.

- There are 3 different Symbols to be defined as Items to the database. One may be named, "Exis Manhole", another "Exis Cleanout" and the other "Exis SS Manhole". All 3 Symbols reside on layer V-SSWR-STRC. Note that the same block, the "MH" Symbol, will be defined to the database twice as a component of two different Standard Items - "Exis Sanitary Sewer" and "Exis Manhole".
When being defined, Symbol entities should be drawn at 1:1 (plotted text height).

The Layer of the Symbol entities will be defined to the Standards database; however, because the Color and Linetype of the Symbol were defined as "ByLayer", when placed into a new drawing on the defined layer, the new Symbol Item will follow the Color and Linetype settings of that layer in the new drawing.

Symbols can be defined with or without a Leader.

Symbols and their associated Leaders are considered ONE Annotation entity when defining to the standards database.

Make sure to use the QLEADER command to ensure Symbol and Leader associativity.

The Dim Style of the QLEADER entity will be defined to the Standards database.

Standard Symbol components can be defined having a "Fixed" size or the size can be scaled according to the "Horizontal Scale" of the drawing.

If Symbol components are drawn and scaled according to the "Horizontal Scale", the "Horizontal Scale" setting is saved with the entity. In other words, changes to the "Horizontal Scale" of the drawing will not affect existing entities. This is true of Symbols and Leader components.

When defining Symbols/Blocks, it is helpful to include a WIPEOUT entity behind the Symbol so that underlying Linework is hidden without changing its geometry.

Symbol/Block definitions can contain Text and/or Attributes.
When creating a Standard Symbol Item containing Attributes, you can select the options for "Allow Move" and "Allow Rotate" to easily move and rotate each Attribute independently of the other block entities.

Using Attributes inside of Symbol/Block definitions allows for additional data storage in each block. For instance, when Attributes are used, data that is valuable to a GIS can be stored with each Block/Symbol.

When defining Attributes inside Symbol/Block definitions, set the "Constant" flag to keep the Default Value for the Attribute. If the "Constant" flag is not set, you will be prompted for a new Attribute Value each time the Symbol is inserted.

When defining Attributes inside Symbol/Block definitions, use the pipe symbol "—” to provide a drop-down box with optional Attribute Values. For instance, a Sanitary Sewer Structure may have a label defined by an Attribute having Default Value, "MH—CO—SS". Note that this does not work if the "Constant" flag is set for the attribute.

Upon insertion, you are given a dialog prompting you to Define Attribute Values by selecting from the available options:
The Layer of the Linework entities will be defined to the Standards database; however, because the Color and Linetype of the Linework entities were defined as "ByLayer", when placed into a new drawing on the defined layer, the new Linework Item will follow the Color and Linetype settings of that layer in the new drawing.

To manage Linetype Scale using the **LTSCALE** command, the Scale value of "1" must be set to "Fixed" during the **Insert Item** or **Modify Item** commands.

Using the Offset option, you have the ability to draw multiple Linework Items parallel to one another.

Annotation elements may be defined using **DTEXT** or **MTEXT** commands but will always be placed as **MTEXT** entities in the drawing.

When being defined, Text or MText entities should be drawn at 1:1 (plotted text height).

The Text Style, Height and Justification of the Text or MText entities will be defined to the Standards database.

The Layer of the Text or MText entities will be defined to the Standards database; however, because the Color and Linetype of the Annotation were defined as "ByLayer", when placed into a new drawing on the defined layer, the new Annotation Item will follow the Color and Linetype settings of that layer in the new drawing.

Annotation elements may be defined with Leaders or without.

Text/MText entities and their associated Leaders are considered ONE Annotation entity when defining to the standards database.

Make sure to use the **QLEADER** command to ensure Annotation and Leader associativity.

The Dim Style of the **QLEADER** entity will be defined to the Standards database.

Standard Annotation components can be defined having a "Fixed" Height or the Height can be scaled according to the "Horizontal Scale" of the drawing.

If Annotation components are drawn and scaled according to the "Horizontal Scale", the "Horizontal Scale" setting is saved with the entity. In other words, changes to the "Horizontal Scale" of the drawing will not affect existing entities. This is true of Text and Leader components

**Exit Drawing Standards**

The **Exit Drawing Standards** command closes the **Standards Draw** palette and the Standards Database file (.sdb).

This command can be accessed from the **Draw** menu and the **Draw Item** toolbar as shown below.
**Pulldown Menu Location(s):** Draw → Item  
**Keyboard Command:** exititem  
**Prerequisite:** Active Standards Database file (.sdb)

---

**Draw By Example**

This command prompts you to pick an entity and then starts the appropriate draw command to begin creating another one of the selected type of entity. The properties such as layer and color of the original entity are used for creating the new one. For example, if you pick a polyline, this command will start the *Pline* command. Likewise if you pick text, this command will begin the *Text* command using the layer and style of the selected text.

**Prompts**

**Pick Object for Command:** *pick an entity*  
The remaining prompts depend on the type of the selected entity.

---

**Sequential Numbers**

This command draws a text label and then increments to the next value for additional labels. The label can optionally be placed inside a circle, square or other symbol. The size of the symbol adjusts to fit the label size.

In the dialog, specify the *Text* label. The text *Prefix* and *Suffix* are optional. The *Text Size Scaler* is the text size in paper units that gets multiplied by the horizontal scale from Drawing Setup to set the text drawing size. The Justification setting controls the text justification mode. When *Auto Increment Labels* is checked, the value entered in the Text field will be incremented by the value in the *Increment* field. The *Group Label With Symbol* option will make a group of the label text and symbol. When *Prompt for Alignment Every Time* is checked, you will be prompted for the alignment angle for each label, otherwise the alignment from the first label is automatically used for the other labels.

The label is drawn by combining the Prefix, Text and then Suffix into one text label. When placing multiple labels, the text portion of the label will increment by the value in the Increment field. For example, this command could be used to quickly label a series of boundaries by setting the Prefix to "Perimeter" and the Text field to the starting number. Then pick points inside the boundaries to label as "Perimeter 1", "Perimeter 2", etc.
Prompts

Select Symbol for Numbers dialog select your symbol
Sequential Numbering Options dialog make your choices
Pick point at beginning of label: pick a point
Pick point for label alignment: pick a point to the right of the first point
Pick point at beginning of label: press Enter to end the routine

Pulldown Menu Location: Draw
Keyboard Command: numbers
Prerequisite: None

Arrowhead

This command draws an arrowhead at the end of the selected line or polyline.

Prompts

Enter the arrow size <5.00>: press Enter
Pick a line or pline to add arrow: pick a line or polyline
Pick a line or pline to add arrow (Enter to End): press Enter

Pulldown Menu Location: Draw
Keyboard Command: arrowhd
Prerequisite: None
File Name: \lsp\scadutil.arx

Curve - Arrow

Curve - Arrow can be used to draw a section of contour line or create leader pointer lines. Curve - Arrow draws a Bezier curve through user specified points. After choosing endpoints, each time an intermediate points is picked...
the curve will be redrawn through all the points. There is an option to draw an arrowhead at the starting point. The arrowhead size is determined by the CAD system variable "DIMASZ". In order to change this size, type DIMASZ at the command prompt. This routine also has a Zorro option which creates a Z leader curve.

Prompts

Create a Zorro (Yes/<No>)? N
Include an arrow (Yes/<No>)? Y
Enter the arrow head size <4.00>: press Enter This defaults to the DIMASZ system variable.
Pick a starting point: pick a point
Pick an ending point: pick a point
Pick an intermediate point (U to Undo): pick a point
Pick an intermediate point (U to Undo): press Enter

Examples of Curve - Arrow

Leader With Text

This command will draw a straight leader between two points, with an arrow at one end and optional text at the other. The arrow size is determined by the Symbol Plot Size setting, found in the Drawing Setup command. On the command line, selecting O for Options will provide you with more customizing choices to make.

Prompts

Options/Pick Arrow Location: pick a point
Text location: pick a point
Text: Leader With Text
Text: press Enter

Leader With Text
Pulldown Menu Location: Annotate
Keyboard Command: LDR
Prerequisite: None
File Name: \lsp\leader.lsp

Special Leader
This command draws a curved leader line like the one shown. With this routine you can also choose to enter in multiple lines of text, not just a single line. The arrow size is determined by the Symbol Plot Size setting, found in the Drawing Setup command. On the command line, selecting O for Options will provide you with more customizing choices to make.

Prompts
Options/Pick Arrow Location: pick a point Pick point where leader arrow will start.
Text location: pick a point
Text: Monument
Text: press Enter
Callout Leader

This command draws a triangle shaped leader and a label inside a box. There is a dialog to enter the label string, style, size and colors. The leader is drawn in the current layer.

Prompts

Callout Leader Settings dialog
Pick callout point: pick a point for point of leader
Pick textbox corner: pick a point for position of label

Pulldown Menu Location: Draw > Leader
Keyboard Command: callout
Prerequisite: None
**Bold Curve Leader**

This command draws a thick curved leader with an arrowhead. This leader is created by picking three points.

![Bold Curve Leader Image]

**Prompts**

Starting point: *pick a point*
End of arrowhead: *pick a point*
Pick end point of leader: *pick a point*

Pulldown Menu Location: Draw > Leader
Keyboard Command: site_leader
Prerequisite: None

**Flow Leader**

This command draws a wavy leader line with an arrowhead. The size of the arrowhead is set by the symbol size scaler in Drawing Setup.

![Flow Leader Image]

**Prompts**

Starting point: *pick a point for arrow end of leader*
Ending point: *pick a point for tail end of leader*

Pulldown Menu Location: Draw > Leader
Keyboard Command: flowline
Prerequisite: None

**Boundary Polyline**

This is a streamlined analog of the AutoCAD command *Boundary*. The Carlson version is faster and works in many cases where *Boundary* fails. *Boundary Polyline* supports a snap tolerance, which means that you may specify a maximum gap to close when creating a closed polyline.

To create closed polylines from any existing linework, simply select all entities you would like to use and specify desired snap tolerance. Then click inside openings you would like to trace and the routine will generate corresponding closed polylines. The duplicate polylines are detected and not created, so that clicking more than once in the
same area does not change anything. These new polylines are always created in the current layer. Layers of the original linework do not matter.

**Prompts**

**Select polylines:** *pick an entities to be used*

**Enter snap tolerance or press Enter for none:**

**Pick an internal point:** *pick the points to enclose*

These three polylines are created from original linework by clicking at shown locations

**Pulldown Menu Location:** Draw

**Keyboard Command:** boundpl

**Prerequisite:** Entities

**File Names:** `\lsp\scbpoly.arx`

**Shrink-Wrap Entities**

This command creates a closed polyline which encloses a given set of entities. The resulting polyline is created in the current layer. The program works on either point entities or polylines. For points, the program creates a closed polyline through the points around the perimeter of the area defined by the points. For polylines, the shrink-wrap polyline follows the outside border of the selected polylines. The polylines that are processed have to be connected to be shrink-wrapped. The snap tolerance is the maximum gap that will be joined to make the closed polyline. For open polylines, as in the bottom figure, the Gap method works better, as it jumps across the gaps and connects the end points.
Prompts

Shrink-wrap across gaps or bounded linework only [Gap]/Bound? G
Shrink-wrap layer <FINAL>:
Select points and linework to shrink-wrap.
Select objects: select entities to process
Reading points... 46
Inserted 46 points.
Inserted 23 breakline segments
Perimeter reduction level 0-3 (0-None, 3-Most) <2>: 2
Reduce Perimeter Pass: 1 Removed: 5
Reduce Perimeter Pass: 2 Removed: 3
Reduce Perimeter Pass: 3 Removed: 4
Reduce Perimeter Pass: 4 Removed: 2
Reduce Perimeter Pass: 5 Removed: 1
Reduce Perimeter Pass: 6 Removed: 0
Create 2D or 3D Polyline [<2D>/3D]? 2D

Pulldown Menu Location: Draw
Keyboard Command: swplines
Prerequisite: Entities
File Name: \lsp\scbpoly.arx

Polyline by Nearest Found

This command draws a polyline by connecting points using a nearest found method. The points to connect can be specified either by entering point numbers or picking POINT entities on the screen. The nearest found method
draws a polyline by starting at one of the points and then connecting to the closest of the remaining points. Then a remaining point that is closest to one of the polyline end points is added until all points are part of the polyline.

**Prompts**

Create 2D polyline at zero elevation or 3D polyline [2d>/3d]? press Enter
Select point from screen or by point number (<Screen>/Number)? press Enter
Select points.
Select objects: pick points

**Pulldown Menu Location:** Draw

**Keyboard Command:** plnear

**Prerequisite:** None

**File Names:** \lsp\crdutil.arx

**Drawing Block**

**Function**

This command allows you to create a block definition from objects you select.
In the Block Definition dialog box, you must first name the block. The Name field, names the block. The name can have up to 255 characters and can include letters, numbers, blank spaces, and any special character not used by Microsoft® Windows® and Carlson Survey for other purposes. The block name and definition are saved in the current drawing. You cannot use DIRECT, LIGHT, AVE_RENDERER, RM_SDB, SH_SPOT, and OVERHEAD as valid block names.

2 Under Base Point, you must specify a base point for the block. The default value is 0,0,0.

- X: This field specifies the X coordinate value.
- Y: This field specifies the Y coordinate value.
- Z: This field specifies the Z coordinate value.
- Pick Point: This option allows you to temporarily close the dialog box so that you can specify an insertion base point in the current drawing.

3 Under Objects, you specify the objects to include in the new block and whether to retain or delete the selected objects or convert them to a block instance after you create the block.

- Retain: This option retains the selected objects as distinct objects in the drawing after you create the block.
- Convert to Block: This option converts the selected objects to a block instance in the drawing after you create the block.
- Delete: This option deletes the selected objects from the drawing after you create the block.
- Select Objects: This option dismisses the Block Definition dialog box temporarily while you select the objects for the block. When you finish selecting objects, press Enter to redisplay the Block Definition dialog box.
- Quick Select: This option displays the Quick Select dialog box, which defines a selection set.
- Objects Selected: This option displays the number of selected objects.

4 Under Preview Icon, you determine whether to save a preview icon with the block definition and specify the source of the icon.

- Do Not Include an Icon: This option specifies that no icon is created.
- **Create Icon from Block Geometry**: This option creates a preview icon to be saved with the block definition from the geometry of the objects in the block.

5 In the Block Definition dialog box, you must describe and link the block.

- **Insert Units**: This field specifies the units to which the block is scaled when it is inserted.
- **Description**: This field specifies the text description associated with the block definition.
- **Hyperlink**: This button opens the Insert Hyperlink dialog box, which you can use to associate a hyperlink with the block definition.

**Menu Location**: Draw

**Prerequisite**: Drawing entities.

**Keyboard Command**: BLOCK

## Write Block

### Function

This command allows you to write objects or a block to a new drawing file.

![Write Block dialog box](image)

The Write Block dialog box displays different default settings depending on whether nothing is selected, a single block is selected, or objects other than blocks are selected. For example, if you have a single block selected when you open the Write Block dialog box, the Source radio button is set to Block.

1 Under Source, you write selected blocks and objects out as a file, and specify insertion points.

- **Block**: This option specifies an existing block to save as a file. Select a name from the list.
- **Entire Drawing**: This option selects the current drawing as a block.
• Objects: This option specifies objects to be saved as a file.

2 Under Base Point, you must specify a base point for the block. The default value is 0,0,0.

• X: This field specifies the X coordinate value.
• Y: This field specifies the Y coordinate value.
• Z: This field specifies the Z coordinate value.
• Pick Point: This option allows you to temporarily close the dialog box so that you can specify an insertion base point in the current drawing.

3 Under Objects, you specify the objects to include in the new block and whether to retain or delete the selected objects or convert them to a block instance after you create the block.

• Retain: This option retains the selected objects as distinct objects in the drawing after you create the block.
• Convert to block: This option converts the selected objects to a block instance in the drawing after you create the block.
• Delete from drawing: This option deletes the selected objects from the drawing after you create the block.
• Select objects: This option dismisses the Block Definition dialog box temporarily while you select the objects for the block. When you finish selecting objects, press Enter to redisplay the Block Definition dialog box.
• Quick Select: This option displays the Quick Select dialog box, which defines a selection set.
• Objects Selected: This option displays the number of selected objects.

4 Under Destination, specify the name, location, and unit value used for the objects in the file.

• File Name: This field specifies a file name that the block or objects will be saved to.
• Location: This field specifies the drive and directory path for the file.
• Insert Units: This field specifies the unit value to be used when the new file is inserted as a block. Enter 0 (zero) if you do not want to scale the drawing to a specific value as you insert it.

Prerequisite: Drawing entities

Keyboard Command: WBLOCK

Insert

Function

This command allows you to place a named block or drawing into the current drawing.
1 In the Insert dialog box, you specify the block to insert and define the position for the inserted block. The last block you insert during the current editing session becomes the default block for subsequent uses of this command.
   • Name: This field specifies the name of a block to insert or the name of a file to insert as a block.
   • Browse: This button opens the Select Drawing File dialog box (a standard file selection dialog box) where you can select a block or a file to insert.

2 Under Insertion Point, you specify the insertion point for the block.
   • Specify On-Screen: This option specifies the insertion point of the block using the pointing device.
   • X: This field sets the X coordinate value.
   • Y: This field sets the Y coordinate value.
   • Z: This field sets the Z coordinate value.

3 Under Scale, you specify the scale for the inserted block. Specifying negative values for the X, Y, and Z scale factors inserts a mirror image of a block.
   • Specify On-Screen: This option specifies the insertion point of the block using the pointing device.
   • X: This field sets the X coordinate value.
   • Y: This field sets the Y coordinate value.
   • Z: This field sets the Z coordinate value.
   • Uniform Scale: This option specifies a single scale value for X, Y, and Z coordinates. A value specified for X is also reflected in the Y and Z values.

4 Under Rotation, you specify the rotation angle for the inserted block.
   • Specify On-Screen: This option specifies the rotation angle of the block using the pointing device.
   • Angle: This field sets a rotation angle for the inserted block.

5 You can explode the block and inserts to the individual parts of the block. When you select Explode, you specify only an X scale factor.

Prerequisite: None

Keyboard Command: DDINSERT
Inquiry Menu

Shown here is the Carlson Inquiry menu. The top section contains detailed inquiry commands. The lower section of the menu includes report and file editing commands.

- List
- Point ID
- Layer ID
- Layer Report
- Layer Inspector
- Drawing Inspector On/Off
- Last Elevation
- Standard Distance
- Bearing & 3D Distance
- Find Point(s)
- Curve Info
- Polyline Info
- Display Edit File
- Display Last Report
- Load Saved Report
**List**

**Function**

This command lists the object type, object layer, and X,Y,Z position relative to the current user coordinate system (UCS) and whether the object is in model space or paper space.

The List command reports color, linetype, and lineweight information if these items are not set to BYLAYER. The thickness of an object is displayed if it is nonzero. Z coordinate information defines the elevation. If the extrusion direction of the entry differs from the Z axis (0,0,1) of the current UCS, the List command also reports the extrusion direction in UCS coordinates. The List reports additional information related to the specific object selected.

**Prompts**

Command:
LIST
Select objects: 3 found, 1 group

Select objects:

**BLOCK REFERENCE Layer: "PNTS"**
Space: Model space
Handle = 1F3D
Group = *A1
"SPT4"
at point, X=6135023.7190 Y=2190074.2098 Z= 800.0000
X scale factor 5.0000
Y scale factor 5.0000
rotation angle 0d0'0"
Z scale factor 5.0000

**BLOCK REFERENCE Layer: "PNTS"**
Space: Model space
Handle = 1F4D
Group = *A1
"SRVPNO1"
at point, X=6135023.7190 Y=2190074.2098 Z= 800.0000
X scale factor 5.0000
Y scale factor 5.0000
rotation angle 0d0'0"
Z scale factor 5.0000

**ATTRIBUTE Layer: "PNTNO"**
Space: Model space
Handle = 1F4E
Style = "PTXT"
Font file = TXT
center point, X=6135023.7190 Y=2190077.9598 Z= 800.0000
height 5.0000
Point ID

This command reports complete information pertaining to a Carlson point. Although similar in function to the AutoCAD ID command, this routine is much more detailed. With this command, you are given the point number, as well as the northing, easting and elevation coordinates. You also are given the point description, and you are shown the name and the location of the coordinate file for the point.

Prompts

Pick point or point number: 255

PointNo. Northing(Y) Easting(X) Elev(Z) Description
255 4379.83 4265.48 19.01 GROUND/SHOT
N: 4379.83 E: 4265.48 Z: 19.01
PT#: 255 CRD File: c:\Carlson2008\data\mantopo.crd

Pulldown Menu Location: Inquiry
Keyboard Command: PT_ID
Prerequisite: None
File Name: lsp\pt_id.lsp

Layer ID

This command reports the layer name of the selected entity.

Prompts
Layer Report

This command generates a report containing all the layers defined in the drawing. Along with the layer names, the report includes the number of entities on each layer, and the color, linetype and lineweight for each layer.

Layer Report
Drawing: C:\sample\example1

<table>
<thead>
<tr>
<th>Layer Name</th>
<th>Entity Count</th>
<th>Color</th>
<th>Linetype</th>
<th>Lineweight</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>5</td>
<td>White</td>
<td>CONTINUOUS</td>
<td></td>
</tr>
<tr>
<td>AREA_PERIM</td>
<td>0</td>
<td>White</td>
<td>CONTINUOUS</td>
<td></td>
</tr>
<tr>
<td>AREATXT</td>
<td>0</td>
<td>Magenta</td>
<td>CONTINUOUS</td>
<td></td>
</tr>
<tr>
<td>BL</td>
<td>8</td>
<td>White</td>
<td>DASHED</td>
<td></td>
</tr>
<tr>
<td>BL-LAB</td>
<td>76</td>
<td>Red</td>
<td>CONTINUOUS</td>
<td></td>
</tr>
</tbody>
</table>

Layer Inspector

This command is used to inspect and work with layers in the drawing. This command is ideal when you are working on a very dense and complex drawing which has many layers and you want to review the entities on different layers. In some cases, there will be layers that you would want to erase. Another scenario might be that you’d like to highlight a layer that is hard to find and see.

The Layer Inspector command has a dialog that docks to the bottom of the drawing window which keeps the drawing window visible while running the command. On the left of the dialog is a list of all the layers in the drawing. To inspect a layer, highlight the layer name from this list. You can inspect multiple layers at a time by selecting multiple layers in the list using the Shift and Ctrl keys while picking in the list. When a layer is selected, the Entity Count reports how many entities in the drawing are set to that layer. The Zoom toggle will zoom the drawing window to the extents of the entities on the layer. The Isolate toggle will freeze all other layers. The Highlight toggle will highlight all the entities on the layer. The Restore View On Exit will set the drawing window to the original position when Layer Inspector was started. The magnify and arrow buttons are used to zoom in/out and pan the drawing window. The Rename button allows you to rename the layer. The Erase Entities button will erase all the entities on the layer. The Purge button will purge the layer from the drawing which is only available when there are no entities on the layer. The Current button sets the layer as the current layer for the drawing.

Layer Report
Drawing: C:\sample\example1

<table>
<thead>
<tr>
<th>Layer Name</th>
<th>Entity Count</th>
<th>Color</th>
<th>Linetype</th>
<th>Lineweight</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>5</td>
<td>White</td>
<td>CONTINUOUS</td>
<td></td>
</tr>
<tr>
<td>AREA_PERIM</td>
<td>0</td>
<td>White</td>
<td>CONTINUOUS</td>
<td></td>
</tr>
<tr>
<td>AREATXT</td>
<td>0</td>
<td>Magenta</td>
<td>CONTINUOUS</td>
<td></td>
</tr>
<tr>
<td>BL</td>
<td>8</td>
<td>White</td>
<td>DASHED</td>
<td></td>
</tr>
<tr>
<td>BL-LAB</td>
<td>76</td>
<td>Red</td>
<td>CONTINUOUS</td>
<td></td>
</tr>
</tbody>
</table>
Prerequisite: None
File Name: \lsp\contour4.arx

**Drawing Inspector**

This command reports object properties to you as you move the cursor over an entity. You can simply move the pointer over an entity and the selected property will be displayed either in a pop-up window next to the pointer and/or on the status bar, depending on the selected option. Drawing Inspector is a transparent command that can run while other commands are running. Once Drawing Inspector is started, it will stay active even while running other commands until you turn it off. To turn off Drawing Inspector, run the command again to toggle it off by picking Drawing Inspector from the Inquiry pull-down menu or from the toolbar or by typing the command name, or right-click and choose Turn off Drawing Inspector. The options for this command are set in the menu that pops up by clicking the right mouse button. The available properties are: Layer Name, Elevation, Azimuth-Distance, Bearing-Distance, Point Data, Text Data, Curve Data, 3D Face Data, Polyline Data and Polyline Blips.

In the *Drawing Inspector* menu, you can choose one or more properties to display.

**Display Layer Name:** Allows you to display the layer name of the entity.

**Display Entity Type:** Allows you to display the type of the entity (i.e. TEXT or POLYLINE).

**Display Elevation:** Allows you to display the elevation of the entity.

**Display Azimuth-Distance:** Allows you to display the azimuth and distance of a line.

**Display Bearing-Distance:** Allows you to display the bearing and distance of a line.

**Display Point Data:** Allows you to display the coordinate data of point.

**Display Text Data:** Allows you to display the attributes of text.

**Display Curve Data:** Allows you to display the radius, arc length, chord length and delta angle of a curve.

**Display Polyline Data:** Allows you to display the end point elevations, horizontal distance, slope distance and slope ratios.

**Display 3D Face Data:** Allows you to display the Z elevations at the face corners.

**Display Polyline Blips:** Allows you to display temporary blip plus marks at the vertex locations of polylines.

**Display Polyline Direction:** Allows you to display temporary arrows to show the direction of polylines.

In the *Drawing Inspector* menu, you can also choose how the property information is reported.
Enable Highlighting: Allows you to highlight the object that the Drawing Inspector is reporting.  
Enable Tag Display: Enables you to view the information next to the cursor on the screen.  
Show Data On Status Bar: Enables you to view the information on the status bar, in the lower corner of the screen.  
Use Default Cursor: When enabled, only the drawing cursor shows. When disabled, the mouse pointer is also shown.  
Report In High Precision: When enabled, displays 8 decimals on distance and 4 decimal seconds on angles.

Example of Drawing Inspector reporting Bearing-Distance using the Tag Display

Pulldown Menu Location: Inquiry  
Keyboard Command: inspector  
Prerequisite: None

List Elevation

Function

This command displays the elevation of a polyline or line. With a 3D polyline, the elevation of the 3D polyline at the pick point is reported along with the elevation of each vertex. See also, the Drawing Inspector command on the *Inq-Set* menu.  
Prerequisite: an entity

Keyboard Command: LSTELEV

Bearing & 3D Distance

This command reports the slope distance, slope ratio, bearing, azimuth and vertical angle between two 3D points. Pick or enter the coordinates of two points or select a line or polyline segment to calculate between the segment endpoints.

Prompts
Specify bearing-distance from (Line/PLine/<Points>)? press Enter
Pick point or enter point number: pick a point
Pick second point or enter point number: pick a point
Horiz Dist: 233.4 Slope Dist: 233.4 Elev Diff: 0.0 Vert Ang: 0d0'0"
Slope: 0.0% 0.0:1 Bearing: S 71d15'37'' W Azimuth: 198d44'23''

Pulldown Menu Location: Inquiry
Keyboard Command: 3DIST
Prerequisite: None
File Name: \lsp\3dist.lsp

Find Point

This command can be used to find a point in the current CRD file with a certain point number or description. For example, if you entered RAD* the command would plot a preview arrow at all the points that have the letters RAD as part of the description. i.e. RADPT1, RADPT2, RADPT3, etc. This command is not case sensitive (test is considered the same as TEST). Matching points are highlighted on the graphics screen with the preview arrow and listed on the text screen.

Prompts

Find by point [N]umber or [D]escription <N>: press Enter
Point number or range of point numbers to find <1>: 8*10
  8 4856.75 4747.20 0.00
  9 4909.25 4648.37 0.00
  10 4223.30 4545.46 0.00 RADPT

If you respond with D for the first prompt the program prompts:
Conforms to AutoCAD's wild card matching.
Point Description(s) text to search for <>: rad*
Searching file C:\Carlson\DATA\LOT.CRD for point descriptions matching RAD* ...
  7 4817.02 4662.73 0.00 RADPT
  10 4223.30 4545.46 0.00 RADPT
Point(s) found 2

Pulldown Menu Location: Inquiry
Keyboard Command: fpnt
Prerequisite: None
File Name: \lsp\fpoint.lsp

Curve Info

This command displays information about a curve/arc. The curve can be defined by an arc entity or polyline arc segment or by selecting three points on the arc. The three points can be defined by point number or picked on the screen. The curve data is displayed in the text window with an option to be displayed in the Standard Report Viewer. Click Exit to return to the graphics window.

Prompts

Define arc by, Points/<select arc or polyline>: select the arc entities
Endpoint: (4923.81 5193.15 0.0)
Other Endpoint: (5168.27 5274.03 0.0)
Radius Point Coords: (5126.6 4990.09 0.0)
Chord Bearing: N 71d41'33'' E
Chord Azimuth: 71d41'33''
Delta angle in radians: 0.9304628295
RoadWay Degree of Curve: 19d57'56''
RailRoad Degree of Curve: 20d4'4'' Chord Crv Length: 265.66 Excess: 1.36
External: 34.13 Mid Ord: 30.50 Tangent: 144.06
Delta: 53d18'42''
Chord: 257.49
Length: 267.02
Radius: 286.97
Display curve data in report viewer [Yes/<No>]?

Pulldown Menu Location: Inquiry
Prerequisite: None
Keyboard Command: cinfo
File Name: \lsp\curvinfo.lsp

Polyline Info

This command reports the length and elevation of the selected polyline or line.

Prompts

Pick Polyline or Line: pick a polyline or line
Polyline length: 7702.75 Slope distance: 7702.75 Avg elev: 1700.00 Avg slope: 0.00%

Pulldown Menu Location: Inquiry
Keyboard Command: polylen
Prerequisite: None

File Name: \lsp\polylen.lsp

Angle Info

This command reports the interior and exterior angles defined by two joining line segments or by three points. The coordinates, angles and distances of the line segments are also reported. The report is display in the standard report viewer.

Angle Information

<table>
<thead>
<tr>
<th>Point#</th>
<th>Northing</th>
<th>Easting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>11</td>
<td>4728.73</td>
</tr>
<tr>
<td>Corner</td>
<td>12</td>
<td>4684.89</td>
</tr>
<tr>
<td>End</td>
<td>13</td>
<td>4664.02</td>
</tr>
</tbody>
</table>

Bearing  Distance

First Side: S 38°40'56'' W 56.16
Second Side: S 72°21'16'' E 68.85
Interior: 68°57'48''
Exterior: 291°02'12''

Prompts

Define angle by, Points/<select line or polyline>: P for points

1st Point?
Pick point or point number: 11

2nd (Corner) Point?
Pick point or point number: 12

3rd Point?
Pick point or point number: 13

Interior: 68°57'18'' Exterior: 291°02'42''

Angle Info Report Viewer

1st Point (Enter to end)?
Pick point or point number: press Enter
Display-Edit File
This command allows you to edit or review an ASCII/text file. Files are displayed in the Standard Report Viewer section of this manual.

Pulldown Menu Location: Inquiry
Keyboard Command: ainfo
Prerequisite: None

File Name: \lsp\scedit.lsp, \lsp\scadutil.arx, \lsp\scedit.dcl

Display Last Report
This brings up the last report generated by any Carlson command that uses the standard report viewer.

Pulldown Menu Location: Inquiry
Keyboard Command: report_up
Prerequisite: A previously viewed report
File Name: \lsp\quickkey.lsp

Load Saved Report
This brings up the Report Formatter for the report data file saved previously by the Report Formatter.

Pulldown Menu Location: Inquiry
Keyboard Command: load_report
Prerequisite: A saved report
File Name: \lsp\scadutil.arx
Shown here is the Carlson Software Settings menu. The top section contains the commands most important for setting up the drawing. You should run *Drawing Setup* prior to beginning your drawing. Additional setup and settings features are found in the middle section. The last section of the menu includes AutoCAD settings commands, including the *System Variable Editor*. 
**Drawing Setup**

This command allows you to specify drawing parameters, including the plotting scale, size of symbols, label annotation size, and the angle mode.

- Specify **English 1in=?ft** or **Metric 1m=?m** as the unit mode to use. This affects the prompting and reports. When you are working on a drawing in English units, one unit equals one foot. In metric, one unit equals one meter.
- Specify the **Horizontal Scale** of the drawing. For example, if the horizontal scale is set to 50, then 1" = 50' is your drawing scale.
- The **Symbol Plot Size** value is a scaler that represents the size on the plot. The Drawing Units are determined by multiplying the scaler by the horizontal scale. In English mode the scaler represents the plotted size in inches. In Metric mode, this value is the plotted size in centimeters. The **Drawing Units** field shows the result of the Symbol Plot Size value (the scaler) multiplied by the horizontal scale.
- The **Text Plot Size** value is a scaler that represents the size on the plot. The Drawing Units are determined by multiplying the scaler by the horizontal scale. In English mode the scaler represents the plotted size in inches. In Metric mode, this value is the plotted size in centimeters. The Text Plot Size is not entered in Drawing Units. The **Drawing Units** field shows the result of the Text Plot Size value (the scaler) multiplied by the horizontal scale.
- The **Line Type Scaler** option sets the linetype scale by multiplying this scaler by the horizontal scale.
- **Angle Mode-Bearing** sets reporting to bearing mode for any of the inquiry commands. (Modifies the settings in the AutoCAD \textit{UNITS} command.)
- **Angle Mode-Azimuth** sets reporting to north based azimuth mode for any of the inquiry commands. (Modifies the settings in the AutoCAD \textit{UNITS} command.)
- **Angle Mode-Gon** sets reporting to gon mode for any of the inquiry commands. (Modifies the settings in the AutoCAD \textit{UNITS} command.)
- **Angle Mode-Other** lets the user determine angle mode by using the AutoCAD \textit{UNITS} command.
• **Coordinate System** is an optional setting to define the drawing coordinate system. The coordinate system settings are used in commands like List Points and Label Lat/Lon to report geodetic coordinates from the drawing coordinates. The Grid System setting applies to drawing coordinates that are in a grid projection system such as state plane coordinates. The Projection list selects the grid projection from the list of supported projections. Along with the Projection, there are selections for the zone and datum to use with the projection. When the drawing setup is in English mode, there is a projection setting for whether the feet are in US Feet or International Feet units. The Local System setting applies to all other coordinate system beside grid projections. The Define Localization button has settings to define the transformation from local coordinates to grid coordinates. With a localization defined, you can work in a drawing in local coordinates and still report lat/lon. The localization definition contains pairs of local and grid coordinates that define the transformation. See the section on Localization under the Coordinate File Utilities command for more information.

• **Distance Scale Factor for Labels and Reports** is used to show distances in a second system besides the drawing units. For example, this factor can be used to report distances in meters when the drawing is in feet, or it can be used to report grid distances when the drawings is in a ground coordinate system. This factor is applied in commands that have an option to label/report a second scaled distance such as the Inverse command and Annotate Defaults that applies to the angle/distance label routines. The scale factor can be entered directly into the edit box or calculated using the Calculate button which has feet-meters conversions as well as combined scale factor calculations for grid-ground factors. See the Scale Points command for more information on calculating the combined scale factor.

• The **Set Paper** button allows you to draw a rectangle on the screen that represents the edge of your paper. After you have set the horizontal scale, press the Set Paper button and the Set Paper dialog appears.

![Set Paper Dialog](image)

- The **Layout** option lets you specify landscape or portrait paper orientation. Landscape layout is where the width of the page is greater than the height of the page. Portrait layout is the opposite.
- The **Paper Size** option allows you to specify the paper size. The numbers in parenthesis represent drawing units and will be multiplied by the horizontal scale to determine the rectangle to be drawn. If you select the Other option, you will be prompted on the command line for the horizontal and vertical sizes of the paper.
Prompts (for Set Paper)

Pick or Type lower left corner point for border \<(5000.00 5000.00 0.0)\>: pick a point
Erase existing Set Paper boundary [<Yes>/No]? Y This prompt only appears if there is an existing paper boundary in this drawing.
Set Limits [Yes/<No>]? Y If you answer Yes to Set Limits, drawing limits are enabled, and AutoCAD restricts the coordinates you can enter to within the paper boundary. Drawing limits also determines the area of the drawing that can display grid dots, and the minimum area displayed by the Zoom All command on the View menu. To turn drawing limits off, type in LIMITS on the command line and set to Off.

Drawing Setup also sets the AutoCAD dimension scale (DIMSCALE) and linetype scale (LTSCALE) to the Horizontal Scale.

Pulldown Menu Location: Settings
Keyboard Command: setup
Prerequisite: None
File Names: \lsp\survsset.lsp, \lsp\scadenvr.dcl

Set Project/Data Folders

This command sets the project work folder, the data folder and the settings folder to use as the default folders for your Carlson drawing and data files. The PROJECT folder is the top-level folder for all the data sub-folders with all the files for the project. The DATA folder contains project specific data files such as coordinate (.CRD), profile (.PRO) and centerline (.CL) files. The SETTINGS folder contains program settings files that can apply to multiple projects such as Field-To-Finish Code Tables (.FLD) and Draw Profile Settings (.PFS). These folders are the defaults where the file selection dialogs will start in. When selecting files, you can change to another folder at any time.
Data Folder Setup: This grouping of controls provides varying levels of sophistication towards how data files associated with a given project are stored and organized on your computer system. Three options are provided:

- **Project Folder** - Data files are organized and stored (by default) into a user-definable sub-folder structure and this option is often used by larger organizations that have teams of employees working on a project. Selecting this option enables the Project Sub-Folders Setup and Data Type Sub-Folders buttons.
- **Drawing Folder** - Data files are stored (by default) into the same folder where the current project drawing has been directed and this option is often used by mid-sized or smaller organizations who seek only basic data organization.
- **Fixed Folder** - Data files are stored (by default) into a single folder and might be used by smaller organizations who do not require any type of data organization.

Project Sub-Folders Setup: Click this button to create a folder structure (see the sample below) that is created when a new project is created. The list of project folders can be customized at any time but modifications to the folder structure will only occur on projects that are created after the modification(s) to the Project Folder list.

Data Type Sub-Folders: Clicking this button allows the various types of data files produced by Carlson to be assigned to a folder identified with the Project Sub-Folders Setup command as illustrated below. File types that are not assigned to a sub-folder are stored (by default) in the current project folder. The following controls allow you to organize your data file types:
Control Action

- Creates a new data type sub-category.
- Removes the selected data type sub-category. Any data types that have been assigned to the sub-category are subsequently migrated into the Misc Data-Types category.
- Allows the selected data type sub-category to be renamed.

**Category Controls**

**Move To:** Associates the selected data type(s) with a data type sub-category. Use standard Windows click, shift+click and/or ctrl+click functionality to select multiple data types at the same time.

**Assign Folder:** Assigns the selected data type(s) to a project sub-folder. Use standard Windows click, shift+click and/or ctrl+click functionality to select multiple data types at the same time.

**Load:** Loads a previously saved Data Type Sub-Folder (.DSF) file.

**Save As:** Saves the current Data Type Sub-folder configuration to a Data Type Sub-Folder (.DSF) file.

**Report:** Allows the contents of the current Data Type Sub-folder configuration to be sent to a report.

**Edit Sub-Folders:** Initiates the Project Sub-Folders Setup command.

**Startup Project/Data Folder:** Indicate or use Set button to assign the start-up (or default) Project Folder location (when using the Project Folder option) or the start-up Data Folder location when using either the Drawing Folder or Fixed Folder option.

**Current Project Folder:** This setting is the top-level project folder for the current drawing.

**Current Data Folder:** This setting is the default data folder for the current drawing.

**Reassign Data Folder:** This function shows a list of all the folders used for data files associated with the current drawing. You can select a folder from this list and switch to another folder location which re-associates the data files. This function applies to projects that have been moved in the file system.

**Clear Data Folder History:** This function removes the association of all data files with the current drawing. The effect is to go back to defaults for data file selections.

**Use Data Folder For Settings:** When enabled, this option sets the Settings folder to match the Data folder which, in effect, combines the Settings and Data folders into one folder.

**Startup Settings Folder:** This folder is the default Settings folder for new drawings.
Current Settings Folder: This folder is the Settings folder for the current drawing.

Project File: Indicate or use Set button to specify the Project Settings (.PRJ) file associated with the current drawing. The Project Settings file is a collection of drawing names (e.g. BaseMap.dwg, Roads.dwg, Parcels.dwg, Sewers.dwg, etc) that belong to the same project. This collection of drawings is used by Project Explorer to manage the drawings and data files for the current project and must be specified if the Carlson Data Depot service is to be used. If the current drawing is not associated with a project, then this setting will be blank.

Data Depot Type: The Carlson Data Depot is a document management system to allow tracking of the changing states of files and projects over time and merge the contributions from multiple users providing data integrity, productivity and accountability for the managed products. Carlson Software supports the following version control systems:

1. Subversion - a free, open-source version control system.
2. ProjectWise - software developed and produced by Bentley Systems.

Setup: Before proceeding, refer to the Carlson Data Depot section for information on how to install and properly prepare your preferred document management system. Once this has been completed, click this button to complete the Data Depot Settings.

Server Location (Subversion): Indicate the path for the appropriate location (often a shared server drive) where the file edits and updates are tracked (e.g. file:///C:/svnrepo). For Windows users, note the triple-slash convention. For a more extensive write-up on available options, refer to Subversion in Action - Chapter 1. Fundamental Concepts.
Server Location (ProjectWise): Indicate the ProjectWise server and datasource where the file edits and updates are tracked (format is server-name followed by a colon ":" , followed by the datasource name, e.g. esri:pwtest). See your ProjectWise Administrator for the name of your ProjectWise servers and datasources.

Automatic Check-Out on Startup: This option will checks for any updates for the project and associated file on the server while opening the drawing. If there is a new version of a file is found it is automatically updated to match the current version on the server. User will be prompted if an older version or conflicting versions of file are found.

Automatic Check-In Changes: If any file under project is updated or edited, it will be automatically checked-in to the repository.

Automatic Upgrade Read-Only to Edit: If a file is checked-in by the current user, the file is upgraded to Edit Mode (locked) for that user for further editing opportunity.

Revert to Read-Only After Upgrade from Edit: If a file is checked-in by the current user, the file is reverted to Read-only Mode (unlocked) so that other users can further edit the file.

Once the Data Depot has been configured, you can assign a project to the Data Depot via the Project Explorer command.

Pulldown Menu Location(s): Settings

Keyboard Command: settmpdir

Prerequisite: None

Drawing Explorer

The Drawing Explorer command presents a list of all Carlson data files that are made in association with a drawing and are tracked in DrawingName.ini. If a drawing was not made in Carlson or does not have a companion .INI file, then Drawing Explorer will not display any files. The Drawing Explorer will also not show any data files if the drawing is not saved. Once data files are created such as a coordinate (.CRD) file, then Drawing Explorer will track these files. Drawing Explorer helps manage drawing-related data.

The Drawing Explorer is shown as a docked dialog on CAD window with files shown as *tree view* under different categories. These file categories are fully customizable and can contain multiple file types. The drawing name is shown as root of the tree view with file categories as its children. The file types associated with a category are listed as children of that category. The data files used with the drawing are listed under respective file type or in subfolders of the project folder specified using the Set Project/Data Folders command. The data files used as current files are shown with bold font.
The Drawing Explorer allows user to view/manage data files associated with the currently opened drawing by allowing him to add, remove, report, and change directory of these files. A mouse right-click can also be used to add and remove any data file/file type/file category from the Explorer.

### Control

- **Action**

  - **Add button** allows adding a file under the category or file type that is currently selected in the tree view. If the drawing file name is selected, the user is allowed to add any type of file to the Explorer and file will be added to the corresponding category.

  - **Remove button** removes the selected file(s) along with any "child" (subordinate) files from the drawing. The underlying file(s) are not physically deleted or removed from the hard-drive, they are merely removed from the Drawing Explorer.

  - **Change Directory** option allows you to instruct Carlson Software to re-direct the location for files from an old folder location to a new folder location. This option is helpful if project data files are manually moved to a new folder location.

  - **Settings button** allows you to create Categories of file types and assign data files to a particular Category and assign how project data files are presented in the Project Explorer.

### Action

The Add button allows adding a file under the category or file type that is currently selected in the tree view. If the drawing file name is selected, the user is allowed to add any type of file to the Explorer and file will be added to the corresponding category.
The Refresh button re-reads the current Project file along with the various Drawing file settings and updates the Project listing appropriately.

Exits from the Project Explorer command.

Displays the on-line help.

Project Explorer Controls

The option to show preview allows user to see the preview of currently selected data file in a small preview window at the bottom of the Explorer dialog.

The List Data Files settings are used in Project Explorer to list files according to drawing files in the project of by project.

**Right-Click Command Execution:** The Drawing Explorer also allows execution of functions associated with a file type. Right-clicking on any file type or data file brings up menu for the commands associated with that file. If the command requires the file during execution, the selected data file will be used to run that command. For example, in the figure below, \textit{Example1.grd} will be used to run the Draw 3D Grid File command and the program will not prompt for the grid file to be drawn.
**Pull down Menu Location(s):** File → Project  
**Keyboard Command:** dwgxplore  
**Prerequisite:** None

**Project Explorer**

This tool is used for management of a complete project. A project can contain multiple drawings, and each drawing within that project can contain multiple associated data files.

Think of the Project Explorer as the trunk of the hierarchical tree structure that develops into a project as illustrated below:

As you work in a drawing, Carlson keeps track of the files that you create (such as TIN and coordinates files). These are related to the drawing and you can use the Drawing Explorer to manage them. The Project Explorer is used to manage multiple drawings. In the following illustration, two views of the same Project are displayed:
• *By Drawing* - shown on the left.
• *By Project* - shown on the right.

Control

Action

Adds a drawing and its data file(s) into the project.

Removes the selected file(s) along with any "child" (subordinate) files from the project. Note that removing a data category or file at the "project" level also removes the category or file at the "drawing" level.

Creates a report through the Report Formatter Options dialog box. The Report Formatter can be used to move to the Available entries on the left to the Used area on the right. When coupled with the Up/Down options to control the order, highly customized reports can be generated and saved for subsequent use. Click the Display to obtain the report.

The Change Directory option allows you to instruct Carlson Software to re-direct the location for files from an old folder location to a new folder location. This option is helpful if project data files are manually moved to a new folder location.

The Settings button allows you to create categories of file types and assign data files to a particular category and assign how project data files are presented in the Project Explorer.

The Refresh button re-reads the current Project file along with the various Drawing file settings and updates the Project listing appropriately.

Exits from the Project Explorer command.
Project Explorer Controls

Linking a project to the Carlson Data Depot requires that you properly configure the Data Depot through the Set Project/Data Folders command and then open a drawing and assign it to a Project (.PRJ) file. If a project is not linked to the Data Depot, a question mark is overlayed on all the files and folders under that project as shown:

To link a project to the Data Depot, perform the following steps:

1. Right click on the Project File name (the "trunk" of the Project Explorer tree) and select Link to Data Depot command:
2. This will bring up the "Project to Link to" window. This window shows the existing project under the repository, if any. A new project folder can be created under Carlson Data Depot Repository by using the Create Folder button. Sub-folders can be created by using the the Create Folder button while top folder selected. Select the folder you want to create the project under and click OK:

3. This will prompt you to Add to Data Depot window where you can enter a log message to identify what you are doing. Click OK to start adding files to the project repository:
4. A status window will appear showing the message for files that have been tasked to be added to the repository:

5. Once the files are linked to the Data Depot, the status/icon in the tree view is changed:
When new files are created inside the project, they are shown as not linked to the Data Depot (using the question mark icon) and can later be linked to the Data Depot by right clicking and using the Add to Data Depot command.

The following shows the icons used in the Project Explorer tree for representing the state of files in the Data Depot:

```
Add to Data Depot: Incorporates the selected new file(s) into the Data Depot.
Update from Data Depot: Gets the last committed version of the selected file(s) from the Data Depot.
Commit to Data Depot: Incorporates the selected file(s) that are already part of the Data Depot into the Data Depot.
Edit Mode: Locks the selected file(s) for local editing and prevents others from modifying the file(s).
Read-Only Mode: Unlocks the selected file(s) so that they may be edited by others.
History: Displays the history log of changes made to the selected file.
```

Once the project has been added to the Data Depot, it can be quickly re-opened and be ready for use via the Open from Data Depot command.

**Pulldown Menu Location(s):** File \acirc;\dagger; Project

**Keyboard Command:** prjxplore

**Prerequisite:** None

### Data Depot

The Carlson Data Depot is a document management system to allow tracking of the changing states of files and projects over time and merge the contributions from multiple users providing data integrity, productivity and accountability for the managed products. Also, having a central project repository helps with data back-up eliminating the fear of losing data due to local drive failures. The Carlson Data Depot protects against productivity loss due to re-implemented work, not only avoiding losses of data, but also making each user's work readily available to other users on the project. The general process for implementing your preferred document management system is:

1. Install and initialize one or more of the version control software products listed below.
2. Instruct Carlson Software to utilize one of these services by establishing the needed settings in the Set Project/Data Folder command.
3. Assign a project to the Data Depot through the use of the Project Explorer command.
4. Subsequently open any Data Depot projects through the use of the Open from Data Depot command.

Carlson Software supports the following *version control systems*:

- Subversion - a free, open-source version control system.
- ProjectWise - software developed and produced by Bentley Systems.

Carlson Software supports Subversion release 1.5.6. The Windows MSI installer with the basic win32 binaries can be downloaded at:

http://subversion.tigris.org/files/documents/15/45937/Setup-Subversion-1.5.6.msi
Running this installation file installs the required binaries to create the Subversion repository on the server or local machine under "C:\Program Files\Subversion" using the default options.

Creating a Subversion Repository

To create the Subversion repository:

1. Click the Windows Start &acirc;dagger; Run and then type cmd into the resulting dialog box as shown below and click OK:

A DOS-style window appears as shown below:

2. At the DOS prompt, navigate to the Subversion install directory by typing:
   cd "C:\Program Files\Subversion" and press the Enter button to complete this step as shown above.
3. To create the Subversion repository under the "C" drive, type:
   svnadmin create c:\svnrepo and press the Enter button to complete this step as shown above. This will create a "svnrepo" folder under the "C" drive (c:\svnrepo); see the Notes section below for important information. The path and the name of the repository could be path to a network drive as well. For setting up a Subversion Repository on the server, refer to the http://subversion.tigris.org documentation.
4. Type the word exit and press the Enter button to dismiss the DOS window and complete the command as shown above.

Accessing Subversion through a GUI Client

Chapter 9. Settings Menu
There are various graphical-user interface (GUI) client applications available for accessing the SVN repositories on the Internet for free:

- RapidSVN
- TortoiseSVN
- ViewVC
- WebSVN

Once a supported document management system has been properly installed and configured for each computer work-station, continue with the Data Depot configuration by initiating the Set Project/Data Folder command.

Please see your ProjectWise Administrator for instructions on configuring ProjectWise Datasources.

Note:
- Once you have created a Subversion Repository, do not add, delete, or modify files in the Repository folder unless you know how to avoid corrupting the repository.

Pulldown Menu Location(s): None  
Keyboard Command: None  
Prerequisite: None

**Store Project Archive**

This command will zip and archive an entire project. The archive contains the current drawing file (.dwg) and all the associated data file such as the surfaces. The data files associated with the current project can be reviewed with the Drawing Explorer command. Besides project data files, images and xref's attached to the dwg are also included. The format of the archive file is a standard .zip file which can be used by WinZip. This file can be sent to someone who can unzip it and use all the same files. The current dwg must have a name before running this command.

Pulldown Menu Location: Settings > Project  
Keyboard Command: zip_project
Prerequisite: A named dwg

Extract Project Archive

This command will unzip an archive file that has been previously created with the command Store Project Archive. It prompts for the directory to unzip to. If any of the files already exist in the folder it is extracting to, there is a window prompting to overwrite the files.

Pulldown Menu Location: Settings > Project
Keyboard Command: unzip_project
Prerequisite: A project file that has been zipped (ZIP)

Preferences

Function

This command opens the Options dialog box where you can customize the settings in CSI related to the CAD engine. Some settings are available in this command that are not applicable to CSI, these settings are not documented below.
Files Tab

Under the Files Tab, you specify the directories in which the program searches for support, driver, menu, and other files. Generally, you will never need to modify any of the settings found here. Advanced users may want to view/modify the following:

- **Automatic Save File Location**: This is the location that CSI will save drawings when it performs an automatic save.
- **Temporary Drawing File Location**: This is the location that CSI writes and stores any temporary drawings during the current drawing session.
Display Tab

Under the Display Tab, you specify settings related to the graphics and text display.

1 Window Elements

- **Display scroll bars in drawing window**: Specify weather or not to show the scrollbars in the drawing window.

**Colors**: Use this command to change colors for items such as drawing background, and text background.

**Fonts**: Use this command to change the font for text displayed on the command line and in the text window.

2 Display resolution

- **Arc and circle smoothness**: Controls the smoothness of circles, arcs, and ellipses. A higher number produces smoother objects, but CSI requires more time to regenerate, pan, and zoom the objects. The default setting is 100, and the maximum setting is 20000

- **Segments in a polyline curve**: Sets the number of line segments to be generated for each polyline curve. The default setting is 8.

3 Display performance

- **Apply solid fill**: Specify whether or not to show fill for hatches and wide polylines.

- **Show text boundary frame only**: Displays the frames for text objects instead of displaying the text objects

4 Crosshair size: Specify the crosshair size in percentage of screen size.

5 Layout elements: These options are not applicable to CSI
Open and Save Tab

1 File Save

- **Save as**: Specify the file formats used when saving a file with SAVE and SAVEAS.
- **Save a thumbnail preview image**: Specifies whether an image of the drawing should be displayed in the Preview area of the Select File dialog box.
- **Incremental save percentage**: Sets the percentage of potential wasted space in a drawing file. When the specified percentage is reached, CSI performs a full save instead of an incremental save. Full saves eliminate wasted space. If you set Incremental Save Percentage to 0, every save is a full save.

2 File Open

- **Number of recently used files to list**: Controls the number of recently used files that are listed in the File menu for quick access. Valid values are 0 to 9.
- **Display full path in title**: Displays the full path of the active drawing in the drawing's title bar, or in the CSI title bar if the drawing is maximized.

3 File Safety Precautions

- **Automatic save**: Saves a copy of your drawing automatically at the interval you specify. See Automatic File Save Location above to specify where the drawing should be saved.
- **Minutes between saves**: Specifies how often the drawing is saved when using Automatic Save
- **Create backup copy with each save**: Specifies whether a backup copy of a drawing is created when you save the drawing. The backup copy is created in the same location as the drawing
- **Maintain a log file**: Specifies whether the contents of the text window are written to a log file. To specify the location and name of the log file, use the Files tab in the Options dialog box
• File extension for temporary files: Specifies a unique extension for the current user to identify temporary files in a network environment. The default extension is .ac$.

4 External References: (These options apply to external referenced drawings, you cannot create external references with CSI, but you can open drawings that have external references).

• Demand Load Xrefs: Controls demand loading of xrefs.
• Retain changes to Xref layers: Saves changes to layer properties and states for xref-dependent layers.

Plotting Tab

1 Under Default Plot Settings For New Drawings, you control default plotting settings for new drawings.

• Use As Default Output Device: Sets the default output device for new drawings. The list displays any plotter configuration files (PC3) found in the plotter configuration search path and any system printers that are configured in the system.

• Use Last Successful Plot Settings: Sets the plotting settings according to the settings of the last successful plot.

• Add or Configure Plotters: Displays the Autodesk Plotter Manager (a Windows system window). You can add or configure a plotter with the Autodesk Plotter Manager.

2 Under General Plot Options, you control options that relate to the general plotting environment.

• Keep the Layout Paper Size If Possible: Uses the paper size specified on the Layout Settings tab in the Page Setup dialog box under the File menu as long as the selected output device can plot to this paper size. If the selected output device cannot plot to this paper size, the program displays a warning message and uses the paper size specified either in the plotter configuration file (PC3) or in the default system settings if the output device is a system printer.

• Use the Plot Device Paper Size: Uses the paper size specified either in the plotter configuration file (PC3) or in the default system settings if the output device is a system printer.
- **OLE Plot Quality**: Determines the quality of plotted OLE objects. The values are Line Art, Text, Graphics, Photograph, and High Quality Photograph.

- **Use OLE Application When Plotting OLE Objects**: Launches the application used to create the OLE object when plotting a drawing with OLE objects. You can use this option if you want to optimize the quality of plotted OLE objects. This setting is saved in the drawing. You can also control this option by using the OLESTARTUP system variable.

- **Hide System Printer**: Controls whether Windows system printers are displayed in the Plot and Page Setup dialog boxes under the File menu. This option hides standard Windows system printers only. You can control the size of the list of devices in the Plot and Page Setup dialog boxes by moving a device's PC3 file out of the Plotters directory and its subdirectories.

3 Under Default Plot Style Behavior, you control options related to plot style behavior in all drawings. Changing the default plot style behavior using the Options dialog box does not affect the current drawing.

- **Use Color Dependent Plot Styles**: Uses color-dependent plot styles in both new drawings and drawings created in earlier versions of Autodesk products. Color-dependent plot styles use the numbers from the color index to create a plot style table with a .ctb file extension. Each color is defined by a name or number ranging from 1 to 255. You can assign each color number to a different pen on a pen plotter to achieve different property settings in the plotted drawing. If this option is selected, a plot style is created for each color setting. If you want to change the default plot style behavior for a drawing, select this option or Use Named Plot Styles before opening or creating a drawing. Changing the default plot style behavior using the Options dialog box affects only new drawings or drawings created in an earlier release of an Autodesk product that have never been saved in CSI 2000 format. This setting is saved with the drawing. Once a drawing is saved with either setting, it cannot be changed.

- **Use Named Plot Styles**: Uses named plot styles in both new drawings and drawings created in earlier versions of Autodesk products. CSI plots the drawing according to the property settings you specify in the plot style definition. The plot style is defined in the plot style table attached to the layout or viewport. Named plot style tables are files with the file extension .stb.

- **Default Plot Style Table**: Specifies the default plot style table to attach to new drawings. A plot style table is a file with a .ctb or an .stb extension that includes and defines plot styles. If you are using color-dependent plot styles, this option lists all color dependent plot style tables found in the search path as well as the value of None. If you are using named plot styles, this option lists all named plot styles tables.

- **Default Plot Style for Layer 0**: Sets the default plot style for Layer 0 for new drawings. The list displays the default value Normal and alphabetically displays any plot styles defined in the currently loaded plot style table.

- **Default Plot Style for Objects**: Sets the default plot style that is assigned when you create new objects. The list displays a BYLAYER, BYBLOCK, and Normal style, and it alphabetically displays any plot styles defined in the currently loaded plot style table.

- **Add or Edit Plot Style Tables**: Displays the Autodesk Plot Style Table Manager (a Windows Explorer window). You can create or edit plot style tables with the Autodesk Plot Style Table Manager.
System Tab

1 Current Pointing Device can only be set to Current System Pointing Device. Do not change this setting.

2 General Options include the following:

- **Single-drawing compatibility mode**: Allows CSI to work with one drawing at a time. Leave this checked.
- **Display OLE properties dialog**: Controls the display of the OLE Properties dialog box when inserting OLE objects.
- **Beep on error in user input**: Specifies whether CSI should sound an alarm beep when it detects an invalid entry.
- **Allow long symbol names**: If this is checked, symbol names such as layers can be 255 characters long.
User Preferences Tab

1 Windows Standard Behavior
   • Windows standard accelerator keys:
   • Shortcut menus in drawing area:
   • Right-click Customization:

2 Priority for Coordinate Data Entry
   • Running object snap: Specifies that running object snaps override coordinate entry at all times. Not Recommended
   • Keyboard entry: Specifies that coordinate entry overrides running object snaps at all times.
   • Keyboard entry except scripts: Specifies that coordinate entry overrides running object snaps, except in scripts.

3 Object Sorting Methods determines the sort order of objects. Generally speaking, objects are displayed in the order they were created. This means that newer objects will display on top of older objects. Use the Display Order commands on the View menu to change the display order.
Drafting

1 AutoSnap Settings

- **Marker**: Controls the display of the AutoSnap™ marker. The marker is a geometric symbol that displays the object snap location when the crosshairs move over a snap point on an object.

- **Magnet**: Sets the AutoSnap magnet on or off. The magnet is an automatic movement of the crosshairs that locks the crosshairs onto the nearest snap point.

- **Display AutoSnap tooltip**: Controls the display of the AutoSnap tooltip. The tooltip is a text flag that describes which part of the object you are snapping to.

- **Display AutoSnap aperture box**: Controls the display of the AutoSnap aperture box. The aperture box is a box that appears inside the crosshairs when you snap to an object.

2 Tracking Settings

- **Display polar tracking vector**: Sets polar tracking behavior on or off. With polar tracking, you can draw lines along angles relative to a drawing command From or To point.

- **Display Tracking tooltip**: Controls the display of the AutoTrack tooltip. The tooltip is a text flag that displays the tracking coordinates.

3 AutoSnap Marker Size allows you to set the display size for the AutoSnap marker. Values range from 1 to 20 pixels.

4 Aperture Size allows you to set the aperture size. The size of the aperture determines how close to a snap point you can be before the magnet locks the aperture box to the snap point. The smaller the aperture, the closer you must be to the snap point to activate the magnet.
Selection Tab

1 Selection Modes

- **Noun/verb selection**: Allows you to select an object before starting a command.
- **Use Shift to add to selection**: Adds or removes an object to the selection set when you press SHIFT and select an object.
- **Press and drag**: Draws a selection window by selecting a point and dragging the pointing device to a second point.
- **Implied windowing**: Initiates the drawing of a selection window when you select a point outside an object.
- **Object grouping**: Selects all objects in a group when you select one object in that group. Control-A also toggles this setting.
- **Associative Hatch**: Determines which objects are selected when you select an associative hatch. If this option is selected, boundary objects are also selected when you select an associative hatch.

2 Grips

- **Enable Grips**: Controls whether grips are displayed on an object after you select it.
- **Enable Grips within blocks**: Controls how grips are displayed on a block after you select it
- **Unselected grip color**: Determines the color of an unselected grip.
- **Selected grip color**: Determines the color of a selected grip.

3 Pickbox Size controls the display size of the pickbox. The pickbox is the object selection tool that appears in editing commands. The default size is set to 3 pixels; values range from 0 to 20.

4 Grip size controls the display size of grips. The default size is set to 3 pixels; values range from 1 to 20.
Configure

This command allows you to set up the default settings that are used each time you start a new drawing, or load an existing drawing. These settings are stored in files called Carlson.INI, COGO.INI, SCTPRO.INI, DTM.INI, HYDRO.INI, and MINE.INI in the Carlson USER directory. Configure will restore the current drawing settings to these default settings. These global settings can be saved and loaded on a new computer, or for a new installation of Carlson.

The settings for the modules apply to the commands within those modules. Refer to the associated manual chapters for additional descriptions of these settings. Under General Settings there are options that apply to all modules. Many of these options are only accessed in Configure, and will be described here.

Use Startup Wizard: The Use Startup Wizard controls whether this wizard appears when creating a new drawing.
Generate Report Log: When the Generate Report Log option is on, output from several commands will be accumulated in a report buffer. Commands that output to the report log include Inverse, Traverse, Curve Info, etc. Also any report that is displayed in the standard report viewer is also added to the report log. While activated, the report log resides in the lower left corner of the desktop as a minimized title bar that shows how many lines are in the report buffer. To view the report log, pick on the maximize icon on this title bar. You can also view the report log by running the Display Report Log function in the Misc menu. The report log can be edited, saved to a file or printed. To quickly turn the report log on and off, you can type REPORT at the command prompt. This function toggles the report log on/off.

Save Drawing INI Files: Save Drawing INI Files will create an .INI with the same name as the .dwg file to store the project data files for the drawing.

Auto Zoom Center for New Points: This option zooms the display to center the new, located point. If it is off, the screen does not center the new point.

Ignore Zero Elevs: This option will ignore any entities with a zero elevation. It is used for many commands, such as Triangulate and Contour or Make Grid File.

Use South Azimuth: Turning on this option will use a South Azimuth instead of a North Azimuth, which is the default.

Use Dview Twist Angle: This will use the screen Twist Angle defined with the command DVIEW. This is similar to Twist Screen.

Set Dimscale to Drawing Scale: This will set the dimension scale to match the drawing scale. By default, it is set to 40.0.

Set PDSIZE to Symbol Size: This will set the PDSIZE scale to match the symbol size defined in Drawing Setup. By default, it is set to 4.0.

Set INSUNITS to Unitless: This will set the INSUNITS (Insertion Units) AutoCAD system variable to Unitless when the drawing is opened.

Point Layer: This is the default layer to draw any new points.

Coordinate Report Order: You can choose the traditional north-east format, or reverse these in reports with east-north.

Date Format: You can control the display of dates in Carlson reports with this dropdown menu. The default is 'Windows Setting' which allows you to control it with Windows Control Panel. Several other common formats are available.

Report Viewer: This option chooses between the Carlson Report Viewer, Windows Notepad and Microsoft Word for the viewer to use for reports that the Carlson commands generate.

Formatted Document Type: This setting controls whether to use PDF or DWF documents for formatted reports such as Calculate Total Volumes in Takeoff and the 3D Viewer Window print function.

AutoCAD Menu: This option chooses which AutoCAD menu to load when picking the AutoCAD menu from the Carlson Menus toolbar or from the Settings->Carlson Menus pull-down menu. When AutoCAD Map is installed, there are different layouts of the Map menu to choose from. When Autodesk LandDesktop is installed, those menus are available.

Object Linking: The Object Linking section contains options for creating reactors to the drawing entities. The Link Points with CRD File option will attach a reactor to the Carlson point entities so that any change to the entities such as MOVE or ROTATE will update the coordinates in the CRD file. The Link Linework with Points option will attach reactors to line and polyline entities that are drawn by point number so that moving the points will automatically
move the linework. The Link Labels with Linework applies to bearing/distance annotation. This link with update the annotation when the linework is modified. The Group Point Entities option joins the three entities of a Carlson point (attribute block, symbol, node). For each point, selecting any one of these entities selects all three entities for the point. See the Points Menu Commands and Dynamic Annotation sections of the manual for more information about linking.

**Database Format:** The Database Format chooses between Microsoft® Access 97 or 2000 (and higher) format. This database format applies to creating new database (.MDB) files in the GIS module, the drillhole database and the Export to Microsoft® Access option in the Report Formatter.

**CRD File Pt# Format:** Carlson can run live on any of these coordinate file formats. The CRD File Pt# Format option sets point number format for coordinate files as one of the following. Here are the options:

- **Carlson Numeric:** This is the default format upon installation. Point numbers cannot contain letters and must be in the range from 1 to 99999.
- **Carlson Alphanumeric:** This native Carlson format allows letters in the point numbers, and the point name can be up to 9 characters. Any combination of letters and numbers is acceptable.
- **C&G Numeric:** This format of the C&G division supports up to 5 digits, with a 65000 point limit.
- **C&G Alphanumeric:** This format of the C&G division supports up to 10 characters, with no limit to the number of points.
- **Simplicity ZAK:** This is the Simplicity Systems coordinate file format.
- **LDT Points.mdb:** This is a Microsoft Access database used by Autodesk Land Desktop. The file is typically named "points.mdb" and is typically found in a Land Desktop project \COGO subdirectory. The point identifier limitation is established by the database structure, which has a default of 255 characters.

**Digitizer Puck Layout & View:** There are two main formats for the digitizer puck. They are numbered 1 and 2. Selecting the View button brings up the window showing the two formats.

![Digitizer Puck Layouts](image)

**Use Mouse:** This option allows you to use the mouse instead of the digitizer puck for the digitize commands.

**Auto Tablet On for Digitize Commands:** This option will activate the auto tablet when using the digitize commands.

**Drawing Setup:**
The settings under *Drawing Setup* are very similar to the AutoCAD Drawing Setup, which is also shown below for comparison. There are a few additions, such as Vertical Scale, Point Prompt-Label Settings, Point Number Settings
There is also the ability to maintain two different sets of defaults (English and Metric). The user can maintain a comfortable set of settings for either unit system, especially if they constantly switch back and forth. Also added was support for meters/metres, tons/tonnes and various date representation. This dialog is accessed from the Configure menu choice, using the Localization Settings button.

**Survey Settings:**

**CG Survey Menu** controls whether to add-on the C&G Survey pulldown menus to the standard Carlson Survey menus. The Compact mode has all the C&G commands in a single pulldown menu. The Expanded mode has all eight C&G pulldown menus that C&G standalone used to have.
**Initial Traverse/Sideshot Angle Mode** sets the default angle mode for these COGO commands.

**Show Occupy and Backsight Points on Status Bar** is an option for the COGO Inverse command.

**Automatic Raw File On** is equivalent to toggling on the COGO->Raw File On/Off automatically when the drawing is opened.

**Automatic Line On** is equivalent to toggling on the COGO->Line On/Off automatically when the drawing is opened.

**Automatic Point Object Snap On** is equivalent to toggling on the Settings->Point Object Snap On/Off automatically when the drawing is opened.

**Surface Settings:**

![Surface Settings dialog box](image)

Most of the Surface commands will remember the settings and parameters used from drawing to drawing. There are some in this screen that will be used for gridding and modeling.

**Inverse Distance/LeastSquares Modeling Parameters:** The modeling methods of Inverse Distance and Least Squares are similar ways to create a grid from datapoints or drillholes. It is not recommended to use these methods for gridding contour or breaklines. Triangulation is better for that. These methods need a search radius defined. Anything past this distance from one data point to the next will be ignored for influence. The Max Samples are the number of data points that will be used to influence each data point. The area is broken into 4 quadrants. The Min and Max Quadrant are the numbers of data points that will be used in each quadrant.

**Specify Grid Resolution As:** There are two ways to create a grid file. Once the boundary has been selected, the cells need to be determined. Number of Cells in X and Y will divide the boundary up into the specified number of cells. These will then be odd shaped rectangles, with the size calculated by the boundary dimensions and the number of cells. The Dimensions of Cells is the more commonly used method. This will allow for a set cell size for the X and Y directions. Most of the time the grid cells should be square, where you set the size.

**Grid Precision:** This is the number of decimals that are stored in the grid file.

**Draw Contours Max Number of Rechecks for Crossings:** Routines that generate contours check for any crossings that can occur from smoothing or reduction options. When a crossing is found, the smoothing or reduction factors are reduced and then the contours are rechecked in case that adjustment causes a new crossing. This option can be used to decrease the number of rechecks in case your dataset is large and you don’t want to take the time for these checks.
Section-Profile Settings:
This configuration box is used mainly for text and drafting settings. Items such as text size scalers and station types are set here and will apply to the current and/or future drawings. These are very self explanatory and are up to the user to set if something other than the defaults is desired.

![Section-Profile Settings](image)

Hydrology Settings:
This section contains only three configuration settings. The first is the format of the stage-storage capacity file. The second is the location of the HEC program files. The third is the SEDCAD directory location, if it is installed on the computer.

![Hydrology Settings](image)

Mine Note Options:
These options are settings for prompting when entering the mine notes. They are simply turned on or off for customized mine note entry.

![Mine Note Options](image)
Mine Settings:
This is the configuration screen for default settings used with the Mining Modules. Each item is detailed below.

Inverse Distance/Least Squares Search Radius, Samples and Quadrants: The modeling methods of Inverse Distance and Least Squares are similar ways to create a grid from datapoints or drillholes in that they use the same settings. It is not recommended to use these methods for gridding contour or breaklines. Triangulation is better for that. These methods need a search radius defined. Anything past this distance from one data point to the next will be ignored for influence. The Max Samples are the number of data points that will be used to influence each data point. The area is broken into 4 quadrants. The Min and Max Quadrant are the numbers of data points that will be used in each quadrant.

SDPS Directory: This is the directory that the SDPS program (Subsidence Deformation Prediction System) is installed in, if it is on the computer.

Fill in Missing Strata Above/Below Existing Strata (Seam Stacking/Conformance): This important setting is used for gridding and modeling from drillholes. It does two things. The first item it controls is to fill in missing strata. For example, if a drillhole does not go deep enough to penetrate a deep seam, or a drillhole is drilled down in a valley or low spot, it will either fill in (carry the seam through the hole) or pinch it out at the hole. None will not fill it in, meaning it will pinch the seam out at the shallow or partial hole. All will not pinch the seams out at the shallow or partial hole. Seam-Specific will use the Define Strata settings where the marker and target beds are
defined there. The second modeling concept this controls is conformance. In these same partial holes where certain seams are not encountered, when it fills them in, it controls how it behaves. None will let each seam do want they want, independent of any other seam. All has all the seams looking at each other and they all conform to each other. Seam-Specific will use the Define Strata settings where the marker and target beds are defined there. The marker bed is the "main" seam and other seams will conform to it. There can be more than one marker seam. There is also a hierarchy for conformance, so if the main marker seam is not present, then the next marker seam in line will prevail.

**Calculate Strata Pinchout and slide bar:** This setting determines if the thickness of a seam is pinchout when it does not occur in a drillhole. Turn it on to activate pinchout. If a seam is not present, it will pinch it out using that drillhole. If it is off, it will carry the seam through the hole where the seam is not encountered. The slide bar determines the distance between the drillholes for pinchout. Near zero will pinch the seam closer to the hole where it does not appear. Non-zero will pinch the seam closer to the drillhole where it does appear. Most of the time, the best "guess" is to leave it in the middle, where it will pinch the seam half way between the holes. It is also recommended to have the pinchout turned on when making thickness grids. This will model the thickness properly. But, when modeling the bottom elevation of a seam, turn OFF pinchout. If it is on, many times it will bring the elevation of the seam up to the next seam to pinch it out. Turning the off for elevation grids will keep them down where they belong. Then just add the thickness and the bottom elevation to obtain the roof elevation grid.

**Process Only Strata with Beds:** This setting is used mostly when duplicate strata appear in a drillhole. It will only model with strata that have a bed name, ignoring those that don't. This useful in a situation where only the KEY strata have a bed name. It will ignore all the NONKEY strata, and just model the KEY strata. This can be used when modeling geology such as lignite or bentonite, where thin seams have bed names and the overburden, partings and interburdens do not.

**Prompt for Advancement Pline for Quantities:** When running the quantity routines in the standard mining module, turning this on will prompt for the Advancement pline for quantities.

**Composite Bed Qualities by Density:** When modeling the quality attributes from drillholes, and they are sampled at multiple intervals, by default, they are averaged by thickness and that one value will be used for gridding. This option will weight the quality attribute by a Density value instead of thickness. the Density attribute needs to be in each drillhole and the name is entered in the box to the right. It is usually DENSITY, and is in pounds per cu. ft or kg/cu m.

**Use Strata Limit Lines:** When using Strata Limit Polylines for modeling, this needs to be turned on or the program will not use them, even if they are on screen. If just this one is on, then you will be prompted to select them for all commands.

**Auto Select All Strata Limit Lines:** Turning this on will automatically select all the Strata Limit Polylines for all commands that use them. They will not have to be selected each time.

**Use 0 Values for Blank Entries in Coal Sections:** When using the Coal Sections in the standard mining module, if a value is blank, this option will assign a 0 value instead of a blank or Null value.

**Report Format for Quantities by Avg/Grid Methods:** This setting determines the report format from the quantity commands in the standard mining module. Standard is the regular text editor. Column puts them in columns in the editor and Formatter will use the powerful Report Formatter.

**Key Material Name:** This is the name of the KEY material you are mining. Enter in COAL or LIMESTONE or GOLD, or whatever ore you are mining.

**Include Strata Name in Bed Composite:** This will add the strata name to the bed name when running the bed composite commands, such as Split Bed by Parameters.

**Startup Options:**
These options are used for starting Carlson. Defaults are set here, and will be used at the beginning of each session.
**Template Name:** This is the drawing template file that will be used when starting a new drawing. The Browse button allows for selecting a new file.

**Carlson 2010 Folder:** This is the folder where Carlson is installed. The Browse button allows for selecting a new file.

**Carlson 2010 Launch Folder:** This is the folder where Carlson will initially look for, and save a drawing file. The Browse button allows for selecting a new file.

**Profile Name:** This is the AutoCAD/IntelliCAD Profile that will be used when working in Carlson.

**AutoCAD command switches:** This turns off the AutoCAD "splash" screen upon launching the program. The /nologo takes the splash screen out of the start up procedure.

**AutoCAD product to run:** This is the AutoCAD version and flavor (Map or LDT, etc.) that Carlson is installed for, and will run with.

**Localization Options:**
There are literally hundreds of default settings that can be set with this dialog. The categories that can be selected from are:

```
Annotate Defaults
Area Defaults
Cogo Design
Drawing Setup
DTM and Contour
General
Line/Curve Table
Minimal Length To Label
Section Profile
Text Label Arc
Survey Text Defaults
```

The Settings for each Category will display all of the items that can be setup for default values. The Default value is set in the Configuration Default Value box. The corresponding Metric or English default values are set here, allowing for easy switching between the two systems.
Pulldown Menu Location: Settings
Keyboard Command: config_scad
Prerequisite: None

Carlson Settings Explorer

The Carlson Settings Explorer dialog box allows you to view, manage and report the values for all settings in all commands in all Carlson Software programs.

The left-side of the dialog is a tree-view showing "Carlson Software" as the top item in the tree. Then, each Carlson Program or module is included as a sub-item under "Carlson Software". The Menus are then displayed as sub-items under each Carlson Program. And then the Commands in each Menu are listed as sub-items of the Menu.

The right-side is a spreadsheet view and is populated depending on the item(s) selected and highlighted in the tree-view. Selecting and placing a checkmark next to an item at one of the upper levels of the tree structure will select that item and all its sub-items.

The spreadsheet view shows the following columns for a command:

- Setting - Prompt for the settings in the dialog or at Command: line
- Value - Current value
- Default - Default value for the setting
- Ini Name - Carlson internal file name for the command
- Data Type - Description of the value for this setting
Select/Unselect: If you pick and highlight an item in the tree-view that is un-checked, this button displays "Select". If the selected item is already checked, this button displays "Un-Select". After an item is selected and highlighted, picking the "Select" or "Unselect" button will place or remove the checkmark next to that item and all its sub-items.

Select All: Use this button to place a checkmark next to all items and sub-items in the tree-view.

Clear All: Use this button to clear checkmarks from all items and sub-items in the tree-view.

Show Selected Only: Select this option to display - in spreadsheet view - only those settings that have checkmarks next to them in the tree-view.

Filter: Using a Filter will display only those settings containing the text string specified as the Filter. For instance, Filtering with the word "elevation", returns the following results:
Find: Use this option to search for a string of text. First, enter the text to be found and then pick the button to the right to execute the search.

Show Modified Only: Select this option to display only those settings whose current value, as shown in the "Value" column, is different from the default value shown in the "Default" column.

Show Layers Only: Select this option to display only those settings whose value in the "Data Type" column is specified as "Layer".

Report: Use this button to prepare a report of all selected settings using Carlson’s Report Formatter.

Load: Use this button to Load settings from a Carlson Configuration File (.cfg).

Save: Use this button to Save settings to a Carlson Configuration File (.cfg).

Restore: Use this button to Restore selected settings to their Default value.

Pulldown Menu Location(s): Settings
Keyboard Command: setxplore
Prerequisite: None

**Settings File Manager**

The Settings File Manager provides an organized view of all Carlson Software Settings files that have been saved in a specified "Settings" folder. By default, the initial folder displayed is the "Startup Settings Folder" as specified in the Project Setup dialog box.

The various Settings files are displayed in a tree structure based on their corresponding Carlson Software program. If the current Settings for any command match the Settings found in a Settings file, the file name will
show up in a **Bold** font. Because Configuration Files (.cfg) are collections of many Settings files, they cannot be set Current and will not show up in Bold font.

**Set Current**: After selecting one of the various Settings files, use this button to set that file current. Files that have been set "Current" will show up in a **Bold** font. Only one file of any Setting type can be set Current at one time. And, because Configuration Files (.cfg) are collections of many Settings files, they cannot be set Current and will not show up in Bold.

**Change Settings Folder**: Use this button to browse to and select a folder in which Carlson Software settings have been stored.

**Pulldown Menu Location(s)**: Settings

**Keyboard Command**: setmanager

**Prerequisite**: None

**Mouse Click Settings**

This command can be used to make custom mouse click preferences. It allows you to set the preferred functionality of your mouse wheel and mouse buttons.

The Middle Button Click options apply to a 2-button wheel mouse (with the wheel acting as the middle button) or a 3-button mouse. Choose between using the middle mouse wheel for real-time pan, or to show an Object Snap pop-up menu. The mouse wheel can also be clicked and depressed for panning, and it can be used for zooming in and out by scrolling with the wheel.
In the lower section of the dialog, you can determine how the right mouse button will operate. For the right button, there are different levels of pop-up menus that can be activated. With all these menus off, the right button will be used like Enter on the keyboard.

**Pulldown Menu Location:** Settings  
**Keyboard Command:** clickset  
**Prerequisite:** None

**Toolbars**

This command allows you to display and hide toolbars. Click on a toolbar name and press the Show or Hide button.

- **Show:** Turns on the selected toolbar. If the toolbar is already visible, then this does nothing.  
- **Hide:** Turns off the selected toolbar. If the toolbars is already hidden, then this does nothing. If the toolbar is floating, you can also turn it off by clicking the x in the upper right corner.  
- **Exit:** Exits this command

**Pulldown Menu Location:** Settings  
**Keyboard Command:** TBARCFG  
**Prerequisite:** None
**Edit Symbol Library**

This command allows you to customize the symbol library.

Categories are a way for grouping symbols by type for your own convenience in symbol selection. A new category is added by clicking on the "Add Category" button. An edit field then appears in the tree view on the left and waits for you to enter the category name. The input is finished by pressing the Enter key.

The category may be populated by creating a new symbol from selected entities in the drawing, by specifying drawing (.DWG) files, or by moving existing symbols from one category to another.

To create a new symbol, open a drawing which has the entities to be used in the symbol. The symbol should be drawn at unit size (scale 1:1) because Carlson will scale the symbol by the current drawing scale when the symbol is used. Highlight the category for the symbol and click on the "Create Symbol" button. A dialog appears for entering the new symbol name. Next, specify the file name for the symbol. The file name has a .DWG extension and would usually reside in the Carlson SUP directory, but you may use another path. Then the program will prompt you to select the entities from the drawing for the symbol. An insertion point for the symbol must also be picked.

The "Import Symbols" button brings up a file selection dialog which allows you to select multiple files to be added to the current category (to select multiple files use Shift or Control keys along with the mouse). If the files you select are not in the Carlson SUP directory, the program will offer an option of copying them there. There are also Import Library and Export Library buttons.

By default, the symbol description is the same as file name. The description for the symbol or category name may be changed by highlighting that name and clicking on "Rename" button, the name being edited is then placed into edit mode. To move a symbol into a different category, select the symbol to be moved on the tree and click an "Up" or "Down" button as many times a needed to reach the desired category. The symbols are sorted alphabetically within each category, while categories are remaining in the order placed to allow the more frequently accessed categories be on top.

Note: The symbol library is stored in an ASCII file named symbols.dta in the Carlson \USER directory.
Layer Library

This command allows management of layer standards into user specified categories. In many commands such as Draw 2D Polyline, the layer selection has the option to pick the layer from the layer library. The Draw->Item Standards Manager can export layers from the items database to the layer library.

The user interface has two main groups, Layer Categories as a tree view and Layers as spread sheet view.

Layer Categories: Layer categories are showed as a tree view. User can Add, Remove, Edit and Move these categories as they are created. This tree view also allows dragging and dropping a category to another category. Each category can consist of multiple layers. The layers within a category can be viewed in spread sheet view on the right by selecting that category.

Layers: All the Layers under a category are shown in a spread sheet view. This view contains the layer Name, Description, Color, Line Type, Line Weight and Plot Style as default column fields. Extra fields can also be defined using Extra Fields button. A new layer can be added using the Add button and existing layer could be removed using Remove button. The Move To button allows to move selected layers from one category to another category. The layers can be sorted by any column by clicking on the header column.

Save As and Load buttons can be used to save and load layer library settings to *.LA files. The current layer library definitions are stored in the USER folder in layerstd.dta.
Clear All removes all the layer definitions.

Extra Fields allows user to define ten extra text fields for a layer. These fields can then be used in the Report function.

Report: All the layers can be reported using standard report formatter.

Create makes the layers from the library into the drawing.

Import button allows user to import layers using accii files as well as already defined drawing layers into layer libart.

Compare DWG button can be used to compare existing drawing layers with library layers. If different settings i.e. color, linetype, line weight, plot style are found for two matching layer names, these settings are reported using standard report.

Match DWG can be used to match drawing layers with the standard layer settings in the library. This command updates the settings for existing drawing layer to the library settings for that layer.

Pull-down Menu Location: Layer Library
Keyboard Command: layerlib
Prerequisite: None

Title Block
This command draws a border and title block for the selected sheet size. At the top of the dialog, choose your horizontal scale and sheet size. The *other* choice at the bottom of each list will allow you to add your own scale or size if yours is not listed. Anything added to these lists will be retained for future use. Next, choose either "landscape" or "portrait" format. A blue rectangle next to this choice shows you the difference. Below this, you can choose what layer to draw the border and title block on. The margins to use are specified next at the bottom of the dialog. On the right hand side of the dialog, you can choose from several title blocks. As you choose each one, a preview will be shown below this list. This routine looks for all drawings named "tblock" in the \SUP directory. If you want to add your own title block, simply create a new drawing (or copy an existing one) in the \SUP directory and give it a name that starts with tblock. Example: tblock22.dwg and tblock-Jones.dwg are both valid names for this routine, but "MyTitleblk.dwg" is not. After you have made all your decisions in the dialog box, press OK. Depending on your current zoom level, your drawing may be zoomed out to allow you to see the entire area that will be covered by the drawing border. At this point, you have the border attached to your cursor and it is waiting for you to pick a point for insertion. As soon as you do this, a secondary dialog will appear for you to fill out the attributes associated with the particular title block you selected.
Chapter 9. Settings Menu
Pulldown Menu Location: Settings
Keyboard Command: tblock
Prerequisite: Set horizontal scale in Drawing Setup
File Names: \lsp\title.lsp, \lsp\title2.fas, \sup\tblock*.dwg(s)

**Mortgage Block**

This command draws a personalized title block for a mortgage survey. You may select an 8½" x 11" sheet, an 8½" x 14" sheet, or define your own sheet size. The dialog box allows the user to edit all block information and input unique data for every layout. The mortgage block drawing is called from the mortgage.dwg file located in the \sup directory and can be easily opened and edited within AutoCAD, allowing for the user to alter the size, text, or any other aspect of the drawing to fit the user's particular needs. However, this is usually unnecessary since the original .dwg file places this block for a standard 8 ½ x 11 ratio drawing. In addition to the block, the user can include the inputs and prescribed text for a Flood Note, which is placed in the bottom left hand corner of the drawing. You may also select a custom drawing file for your flood note. All inputs are saved and recalled from a mortgage.ini file located in the \User directory.

The LIMITS of the drawing can be set to the lower left and upper right corners of the border. After the title block is drawn, the contents can be edited using the Attribute Edit command under the Edit menu.
Rescale Drawing

This command globally resizes selected text, symbol and block entities within the drawing by comparing the existing drawing scale factor to a new scale factor. Entities are scaled from their individual insertion points. Lines and polylines are not scaled.

Prompts

Old Horizontal Scale: 20
New Horizontal Scale: 30
Select text, symbols, dimensions and blocks to scale.
Select objects: select objects by window, crossing or by typing "all" at the command prompt, and press Enter
41 found
Select objects: press Enter
Number of symbols and blocks changed > 7
Testing Entity > 41
Number of text entities changed > 20
Pulldown Menu Location: Settings
Keyboard Command: scaledwg
Prerequisite: Drawing entities to be scaled

Set/Reset X-Hairs

Set X-Hairs sets the crosshairs either to align with the selected line or polyline or to a user-specified slope. Reset X-Hairs restores the crosshairs alignment to horizontal.

Pulldown Menu Location: Settings > Crosshairs
Keyboard Commands: setxhairs, resetxhairs
Prerequisite: Line entity
File Names: \lsp\xlsp, \lsp\rh.lsp

Tablet Calibrate

This command executes the routine to perform calibration of the digitizer tablet to the drawing. There are two methods of calibration: Known Reference Points, and Drawing Scale with New Reference Points, which are explained in detail below. The Calibrate routine must be used prior to using the Digitize Contours command.

Before proceeding, please refer to the Settings menu, then go to Configure and General Settings. Then look at the Digitizer Puck Layout section for the selection of the correct puck layout.

Tablet Calibration

Known Reference Points uses two known coordinates for reference points on the drawing. When this option is selected, the fields for coordinate info activate. Enter the known northing and easting values for the reference points from the info on the drawings in the appropriate fields and pick the Pick button. Pick the points from the drawing on the tablet. Furthermore, Carlson saves the coordinates of the two reference points for future calibrations and displays them on the Tablet Calibration Dialog the next time it is accessed, so if you are working in the same drawing, you can use the Known Reference Points method with the saved coordinates to digitize back to your previous coordinates. For greater calibration accuracy, choose two points that are farther apart rather than closer.
Drawing Scale with New Reference Points is very convenient when you don't know the precise coordinates of the entities on your drawing. The user must specify the drawing scale from the plan. This method establishes a coordinate system relative to the position of the plan on the digitizer board. In addition to the drawing scale, you are required to enter a random coordinate for the first reference point, the default coordinate is (1000,1000). You then pick the Pick button and pick the point on the drawing to assign the specified coordinate to. The program will compute the coordinate of the second reference point that you pick based on the first point. The coordinates of these two reference points would be saved and will be display in the Tablet Calibration Dialog as Known Reference Points the next time you calibrate the tablet, so you can digitize back to the previous coordinates if you are working on the same drawing, even though you may have moved or rotated your drawing on the digitize board.
Prompts

Tablet Calibration Dialog
Specify the Calibration Methods. If you select Drawing Scale method, enter the drawing scale and the coordinate of the first reference point. Otherwise enter the exact coordinates of the first and second reference points.

Pick first reference point: *pick a point*
Pick second reference point: *pick another point*

Pulldown Menu Locations: Settings > Tablet Calibration
Keyboard Command: digsetup

Prerequisite: Affix a drawing to your digitizer tablet. Have a digitizer board and a puck connected to your computer, and have Wintab driver installed. The digitizer has been correctly set up. Select the puck layout in Configure.

File Name: \lsp\digsetup.lsp

Save/Load Tablet Calibration

A common problem with calibrating maps on a large format digitizer is that if you leave the current drawing session, AutoCAD forgets the tablet calibration. Tablet save can be used to save the calibration when a drawing is taped down properly. This calibration file can be restored at any time later and be accurate so long as the drawing did not move on the tablet.

Save Configuration Procedure:
1) Command: TABSAVE
2) Designate filename (*.TCF) to save configuration into.

Restore Configuration Procedure:
1) Command: TABREST
2) Select filename (*.TCF) to restore configuration from.

Pulldown Menu Location: Settings > Tablet Calibration
Keyboard Commands: tablet1, tablet2
Set UCS to World

Function

This command sets the UCS (user coordinate system) to the world coordinate system (WCS). Carlson TakeOff works exclusively in the world coordinate system and there is no way to change this setting. In AutoCAD, it is possible to change the coordinate system from WCS. If you receive a drawing in which the coordinate system is not set to world, use this command to restore the UCS.

Prerequisite: None

Keyboard Command: UCS_WORLD

Units Control

Function

The Drawing Units dialog box controls coordinate and angle display formats and determines precision.

1 Under Length, you specify the current unit of measurement and the precision for the current units.
   • Type: This field sets the current format for units of measure. The values include Architectural, Decimal, Engineering, Fractional, and Scientific. The Engineering and Architectural formats produce feet-and-inches displays and assume that each drawing unit represents one inch. The other formats can represent any real-world unit.
   • Precision: This field sets the number of decimal places for the current units display.

2 Under Angle you specify the current angle format and the precision for the current angle display.
   • Type: This field sets the current angle format.
   • Precision: This field sets the precision for the current angle display.
TakeOff uses the following conventions for the various angle measures: decimal degrees appear as decimal numbers, grads appear with a lowercase g suffix, and radians appear with a lowercase r suffix. The degrees/minutes/seconds format uses d for degrees, ' for minutes, and " for seconds, for example:

123d45'56.7"

Surveyor’s units show angles as bearings, using N or S for north or south, degrees/minutes/seconds for how far east or west the angle is from direct north or south, and E or W for east or west, for example:

N 45d0'0" E

The angle is always less than 90 degrees and is displayed in the degrees/minutes/seconds format. If the angle is precisely north, south, east, or west, only the single letter representing the compass point is displayed.

- **Clockwise:** This option calculates positive angles in the clockwise direction. The default direction for positive angles is counterclockwise.

When the program prompts for an angle, you can point in the desired direction or enter an angle regardless of the setting specified for Clockwise.

3 Under Drawing Units for TakeOff DesignCenter blocks, you can control the unit of measurement used for block insertions. A block created in units that differ from the units specified in this option is scaled and inserted in the specified units. Select Unitless to insert the block as is and not scale the block to match the specified units. Source content units and Target drawing units settings in the User Preferences tab of the Options dialog box under the Settings menu are used when Insert Units are not defined.

4 Sample Output displays an example of the current settings for units and angles.

Direction displays the Direction Control dialog box described below.

A The Base Angle determines where 0 degrees is located when the program calculates angles. The base angle sets the direction of the base angle. These options affect the entry of angles, object rotation angles, the display format, and the entry of polar, cylindrical, and spherical coordinates. Choose East, North, West, or South, or choose Other to indicate an alternative direction. The default direction for the zero angle is East. In TakeOff, the base angle is relative to the orientation of the user coordinate system.

- **East:** Sets the base angle to east (default is zero degrees).
- **North:** Sets the base angle to 90 degrees north.
- **West:** Sets the base angle to 180 degrees west.
- **South:** Sets the base angle to 270 degrees south.
- **Other:** Sets a direction different from the points of the compass.
• **Angle**: Sets the angle. Available only when Other is selected.

• **Pick an Angle**: Uses the pointing device to define the angle based on the angle of an imaginary line connecting any two points you specify. Available only when Other is selected.

**Prerequisite**: None

**Keyboard Command**: UNITS

### Point Object Snap

When this toggle is turned on, you can move your cursor near a Carlson point and snap to the actual coordinates of the point without having to use the AutoCAD NODE snap. Point Object Snap can be used alone to display the point information or it can be turned on and used during other commands. In the example illustration, the 2DP command (2D polyline) has been started and the first point picked was point number 2074. As the cursor nears point number 2067, the point snap marker appears and the point information is displayed, click the mouse and the next polyline vertex will snap to the coordinates of point 2067.

**Pulldown Menu Location**: Settings

**Keyboard Command**: `pointsnap`

**Prerequisite**: None

**File Name**: `\lsp\scadutil.arx`

### Aperture Object Snap

**Function**

The Drafting Settings dialog box sets object snap modes.
1 Under Object Snap, you set object snaps.

- **Object Snap On**: This option turns running object snaps on and off. The object snaps selected under Object Snap Modes are active while object snap is on. This setting is also controlled by the OSMODE system variable.

- **Object Snap Tracking On**: This option turns object snap tracking on and off. With object snap tracking the cursor can track along alignment paths based on other object snap points when specifying points in a command. To use object snap tracking, you must turn on one or more object snaps.

2 Under Object Snap Modes, you turn on running object snaps.

- **Endpoint**: Snaps to the closest endpoint of an arc, elliptical arc, line, multiline, polyline segment, spline, region, or ray or to the closest corner of a trace, solid, or 3D face.

- **Midpoint**: Snaps to the midpoint of an arc, ellipse, elliptical arc, line, multiline, polyline segment, solid, spline, or xline.

- **Center**: Snaps to the center of an arc, circle, ellipse, or elliptical arc.

- **Node**: Snaps to a point object.

- **Quadrant**: Snaps to a quadrant point of an arc, circle, ellipse, or elliptical arc.
• **Intersection**: Snaps to the intersection of an arc, circle, ellipse, elliptical arc, line, multiline, polyline, ray, spline, or xline. Intersection snaps to the edges of regions and curves, but does not snap to the edges or corners of 3D solids. Extended Intersection snaps to the imaginary intersection of two objects that would intersect if the objects were extended along their natural paths. Carlson Survey automatically turns on Extended Intersection when you select the Intersection object snap mode. You might get varying results if you have both the Intersection and Apparent Intersection running object snaps turned on at the same time. Intersection and Extended Intersection work with edges of regions and curves, but not with edges or corners of 3D solids.

• **Extension**: Causes a temporary extension line to display when you pass the cursor over the endpoint of objects, so you can draw objects to and from points on the extension line.

• **Insertion**: Snaps to the insertion point of an attribute, a block, a shape, or text.

• **Perpendicular**: Snaps to a point perpendicular to an arc, circle, ellipse, elliptical arc, line, multiline, polyline, ray, solid, spline, or xline. Carlson Survey automatically turns on Deferred Perpendicular snap mode when the object you are drawing requires you to complete more than one perpendicular snap. You can use a line, arc, circle, polyline, ray, xline, multiline, or 3D solid edge as an object from which to draw a perpendicular line. You can use Deferred Perpendicular to draw perpendicular lines between such objects. When the aperture box passes over a Deferred Perpendicular snap point, the program displays a Snaptip and marker.

• **Tangent**: Snaps to the tangent of an arc, circle, ellipse, or elliptical arc. Carlson Survey automatically turns on Deferred Tangent snap mode when the object you are drawing requires you to complete more than one tangent snap. For example, you can use Deferred Tangent to draw a line that is tangent to two arcs, polyline arcs, or circles. When the aperture box passes over a Deferred Tangent snap point, the program displays a marker and Snaptip. If you use the From option in conjunction with the Tangent snap mode to draw objects other than lines from arcs or circles, the first point drawn is tangent to the arc or circle in relation to the last point selected in the drawing area.

• **Nearest**: Snaps to the nearest point on an arc, circle, ellipse, elliptical arc, line, multiline, point, polyline, spline, or xline.

• **Apparent Intersection**: Apparent Intersection includes two separate snap modes: Apparent Intersection and Extended Apparent Intersection. You can also locate Intersection and Extended Intersection snap points while running Apparent Intersection object snap mode is on. Apparent Intersection snaps to the apparent intersection of two objects (arc, circle, ellipse, elliptical arc, line, multiline, polyline, ray, spline, or xline) that do not intersect in 3D space but may appear to intersect in the drawing display. Extended Apparent Intersection snaps to the imaginary intersection of two objects that would appear to intersect if the objects were extended along their natural paths. You might get varying results if you have both the Intersection and Apparent Intersection running object snaps turned on at the same time. Apparent and Extended Apparent Intersection work with edges of regions and curves but not with...
edges or corners of 3D solids.

• **Parallel:** Draws a vector parallel to another object whenever Carlson Survey prompts you for the second point of a vector. After specifying the first point of a vector, if you move the cursor over a straight line segment of another object, the program acquires the point. When the path of the object you create is parallel to the line segment, the program displays an alignment path, which you can use to create the parallel object.

• **Clear All:** This option turns off all object snap modes.

• **Select All:** This option turns on all object snap modes.

**Menu Location:** Settings  
**Keyboard Command:** OSNAP  
**Prerequisite:** None

### System Variable Editor

The AutoCAD/IntelliCAD engine stores the values for its operating environment and some of its commands in system variables. Each system variable has an associated type: integer, real, point, switch, or text string. This command allows you to list or change the values of system variables.

- **List Box:** Contains a list of the variables associated with the currently running version of AutoCAD. There are more items than will display on the list box, use the scroll bar to move up and down through the list. Picking on an item in the list box makes it the current item, causing the information about the item to be displayed, and can be affected by most of the edit commands explained below.

- **Edit Field:** When an item on the list box is picked, its current setting is displayed in the edit field. If you intend to make changes in an item, use standard editing procedures including the use of arrow keys and/or pointer movements
to make changes. Once changes have been made, you must use the CHANGE options explained below to effect changes. Pressing enter at the edit field will have no effect on the item in the list. If the item selected is a read-only variable, the edit field will be grayed-out and will not allow input.

- **Description:** When an item on the list box is picked, its definition is referenced and displayed in this field. This can be a benefit in learning the uses of the assorted system variables. This is a display only field, so you can't change the description given.

Under Type Group, the type of variable will be displayed indicated by one of the radio buttons. Each of these types are explained below for your benefit. For additional information on variable types used by AutoCAD, obtain and consult a source of AutoCAD documentation.

- **Integer:** Defined as a whole number in the range from -32767 to +32768, no decimal value accepted.
- **Real:** Defined as a real number in the range from -1.797E+308 to +1.797E+308, with extreme decimal accuracy maintained. Some real variables have a smaller range than previously stated.
- **String:** Defined as a sequential array of characters in the range from 0 to 65535 characters, with a range of ASCII (0-255). Numbers can be included in strings, even though they have no mathematical significance.
- **2D Point:** Defined as a list of two real numbers in the range from -1.797E+308 to +1.797E+308 separated by a comma, having extreme decimal accuracy maintained. Always maintain the X,Y format, one (and only one) comma must be used, separating the X and Y.
- **3D Point:** Defined as a list of three real numbers in the range from -1.797E+308 to +1.797E+308 separated by commas. While editing a 3D point, you must always maintain the X,Y,Z format, two (no less or no more), commas must be used, separating the X and Y and Z values.

Under Range Group, the variable displayed will usually have a range displayed. The FROM value indicating the minimum, and the TO value being the maximum value accepted.

Under the Store Group, depending on the type of variable, AutoCAD may store the value in the drawing or the configuration file, or it may not be stored. Each of these types are explained below for your benefit.

- **Not Stored:** Some variables, such as PLATFORM and CDATE, are not stored because they are system interdependent.
- **In Drawing:** Most variables are stored in the drawing, making the drawing format more personal than just a database of objects. This allows you to open a drawing and have it behave just as though you had never left it.
- **In Config:** These are variables that remain the same regardless of the drawing opened. APERTURE and PICK-BOX are just two examples of variables stored in the configuration file.

Under Access Group, depending on the type of variable, AutoCAD may not allow you to make changes to it. Each of these types are explained below.

- **Read Only:** Some variables, such as PLATFORM and CDATE, are read-only and therefore cannot be changed. Read-Only variables are marked and the edit field will be grayed indicating that you can't change the variable.
- **Read/Write:** Most variables are read/write and can be changed. These variables are marked and the edit field will be active so you can change the variable.

Under Binary Group, depending on the type of variable, the value may be off or on, yes or no. If the variable type is not binary, this group will be grayed out entirely.

- **Off (0):** Indicate an off condition. Some variables, such as ATTREQ, are simply on or off toggles. You may change a binary item by clicking in this group to change the variable, or changing the value in the edit field.
- **On (1):** Indicate an on condition. Binary variables are simply on or off toggles. Their range is from 0 to 1. You may change a binary item by clicking to change the variable, or changing the value in the edit field.
Control Buttons - These buttons are the main controls in the use of the Variable Editor. Each button's purpose is explained below.

- **OK**: Used to accept the changes made during the variable editing process, returning you to the command prompt with changes in effect.
- **Cancel**: Used to cancel the changes made during the variable editing process, returning you to the command prompt without the changes in effect.
- **Load**: Used to load a saved set of system variables. This allows you to create a drawing, save the system variables, open a second drawing, and load those variables into that drawing. Read-only variables are skipped.
- **Save**: Used to save the current system variables to a disk file. All system variables are stored to the file, even those that are marked as read-only.
- **Print**: Used to print the current system variables. After choosing this option, you will be prompted for an output filename, then the program will proceed to write the system variables to the file. This file can be loaded into any editor or word processor, edited and printed.

Variable Buttons - These buttons are used to control the changes in variables, while using the Variable Editor. Each button's purpose is explained below.

- **Change**: Used to execute the changes typed into the edit field. You must use this button, simply pressing enter will not make the change.
- **Restore**: Used to cancel the changes typed into the edit field. If you make a mistake or change your mind while making changes in the edit field, press this button to restore the edit field to the value before editing.
- **Status**: Used to determine if the program will echo the status of changes being made to the command area. If this toggle is on, any changes made from the dialog will echo the change. Also, if a stream of change commands is being read from a file, and the toggle is on, the changes taking place will be displayed.

Note: This command displays many more system variables than are found in the Systems Variable Chapter, which contains a list of supported system variables. Modification of any system variable other than the supported ones found in the Systems Variable Chapter is done at your own risk, and may result in program errors requiring a re-installation of Carlson.

**Pull-down Menu Location**: Settings
**Keyboard Command**: VAREDIT
**Prerequisite**: None
Points Menu

All of the routines in this menu operate on points in a Carlson coordinate (.CRD) file. Coordinate (.CRD) files are binary files that contain point numbers, northings, eastings, elevations and descriptions. Alternately, C&G CRD & CGC files, LandDesktop MDB files or Simplicity Systems ZAK files can be used in place of the Carlson CRD file. All routines in this menu will read from, and write to, these types of point data files. At any given time, there can only be one (1) coordinate (.CRD) file set current. If a command is initiated that requires a coordinate (.CRD) file, and there is not one set, Carlson will prompt for a coordinate (.CRD) file name. From that point on, this is the current coordinate (.CRD) file. Another coordinate file can be used by choosing Set Coordinate File, or Open CRD File in Coordinate File Utilities.

Whenever asked for point numbers you can enter any combination with commas and dashes or All to use all points. For example 1-3,7,20-23 would use 1,2,3,7,20,21,22,23. Coordinate files have either numeric or alphanumeric point numbers. Alphanumeric point numbers consist of nine or less digits and letters (i.e. point# 7A). The type of point number format is set when the coordinate file is created. This setting is found under General Settings in Configure. This setting only affects new coordinate files.

Each point is drawn by three entities: point block, point node and symbol. The point block is an INSERT entity with PNTNO, PNTELEV and PNTDESC attributes. These attributes represent the point number, elevation and description respectively. The point node is a POINT entity and is used for picking the point with the NODE snap. The point node is also used as the X, Y, Z coordinate in surface modeling in the Civil Design module. The symbol
can be any symbol defined in the Symbol Library. (Use SPT0 for no symbol). Since points use Carlson point symbols, the CAD system variables PDMODE and PDSIZE should usually be set to 0.

Point Links

The points in the drawing can be linked to their coordinates in the coordinate file. The link updates the coordinate file when a point is modified in the drawing. For example, when points are moved with the Rotate command, their coordinates will be automatically updated in the coordinate file. To update the coordinate file without this automatic link, you can run the command Update CRD File from Drawing in Coordinate File Utilities. This option is called Link Points with Coordinate File and can be set in Configure under General Settings. This setting does not affect points currently in your drawing, only points drawn after you change this setting.

Point Notes

Each point in the coordinate file has room for a 32 character description. To have a longer description, an associated point note file can be used. The note file has the same file name as the coordinate file with a .NOT extension and is stored in the same directory. For example, survey.not would be the note file for survey.crd. The note file is a text file that stores a point number together with the additional description for the point. There is no limit to the length of the note. Notes can be added to points using the command Input-Edit Point found in Coordinate File Utilities. The List Points command can be used to print out the notes.

Point Entity Grouping

For each point, the point attribute block, node, and symbol can be bound together. This means that if you choose to use the Move command (or other CAD tools) the entire collection moves together. This is done using the grouping functionality.

To disable this system altogether, go to Configure, choose General Settings, and turn off the toggle for Group Point Entities. If you need to temporarily disable grouping in a drawing, you can use the AutoCAD toggle for grouping, which is Ctrl-A. Holding down the Ctrl key and pressing the letter A on the keyboard activates this two way toggle, with the current status echoed to the command prompt area.

Extended Point Information

Carlson points include additional information on each element that makes up the point collection (attribute block, node and symbol). This information allows Carlson to know such things as which coordinate (.CRD) the point came from. Commands like Drawing Inspector can then display the point information for the point entities. This also makes it easier for Carlson to identify which drawing objects belong to a point, making commands like Edit Point Attributes a single pick instead of a selection set.
Point Defaults

This command sets Carlson point options.

**Descriptions:** Specify whether you are prompted for a point description when creating points and whether the point descriptions are labeled in the point block.

**Elevations:** Specify whether you are prompted for a point elevations when creating points and whether the point elevations are labeled in the point block.

**Locate on Real Z Axis:** When checked, points are located at their actual elevation, otherwise points will be located zero elevation.

**Attribute Layout ID:** Controls the location of the point number, elevation and description. These attribute layouts are defined in drawings that are stored in the Carlson SUP directory with the file name of SRVPNO plus the ID number (i.e. SRVPNO1.DWG, SRVPNO2.DWG, etc.). If you want to change the attribute positions for a layout ID, then open and edit the associated SRVPNO drawing.

**Symbol Name:** Enter the default symbol name to use. You may also pick the Select Symbol button to select a symbol from the symbol library.

**Prompt for Symbol Names:** When checked, you will be prompted for each symbol name instead of using the default symbol.

**Point Numbers:** When this toggle is OFF, no point number will be created and no points will be stored in the coordinate (.CRD) file.

**Automatic Point Numbers:** When this toggle is OFF, commands that locate a point will prompt for a point number. Otherwise, point numbers are numbered sequentially. If the Start Point Number field is set to 0, no point will be plotted. An exception to this is when you use the *Draw-Locate Points* command and use the Range option, then a point entity is plotted.
The following table illustrates the effects of elevation settings:

<table>
<thead>
<tr>
<th>Elevation Settings</th>
<th>Real Z</th>
<th>Picked Point Label</th>
<th>Point Number Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>No</td>
<td>Labels point, Prompts for elevation, uses 0 for z coordinate</td>
<td>Labels point, No Prompt, uses 0 for z coordinate</td>
</tr>
<tr>
<td>Yes</td>
<td>Yes</td>
<td>Labels point, Prompts for elevation, uses z coordinate from file</td>
<td>Labels point, No Prompt, uses z coordinate from file</td>
</tr>
<tr>
<td>No</td>
<td>No</td>
<td>No Label, No Prompt, uses 0 for z coordinate</td>
<td>No Label, No Prompt, uses 0 for z coordinate</td>
</tr>
<tr>
<td>No</td>
<td>Yes</td>
<td>Labels point, No Prompt, uses z coordinate of picked point</td>
<td>Labels point, No Prompt, uses z coordinate from file</td>
</tr>
</tbody>
</table>

**Start Point Number**: Specify the next point number to use.

**Vertical Angle Mode**: Specify how Carlson should prompt you for vertical angles. None means no prompt. Applies to creating points with commands such as Traverse. The vertical angle is used to calculate the point elevation.

**Separate Layers**: Specify settings for point attribute layers.

- **None**: The point symbol, point number, elevation and description use the layer names PNTMARK, PNTNO, PNTELEV and PNTDESC.
- **Points**: The point number, elevation and description layers are composed by concatenating the point layer and the string NO, ELEV, and DESC respectively. For example, if the point layer is UTIL then the attribute layers will be UTILNO, UTILELEV and UTILDESC.
- **Symbols**: The point symbol layer is composed by concatenating the point layer and the string MARK. For example, if the point layer is UTIL then the symbol layer will be UTILMARK.
- **Both**: The point symbol, point number, elevation and description layers are composed by concatenating the point layer and the string MARK, NO, ELEV, and DESC respectively. For example, if the point layer is UTIL then the symbol/attribute layers will be UTILMARK, UTILNO, UTILELEV and UTILDESC.

**Layer for Points**: Specify the layer name for Carlson points.

**Auto Zoom**: When checked, the drawing will perform a Zoom—Center around new points to keep the display centered around current working area. This only applies during commands such as Traverse. This setting is also available in Configure under General Settings where it is called Auto Zoom Center for New Points.
**Use Field to Finish For:** Allows you to use the code definitions from Field to Finish for the Point Symbols, Layers, Descriptions, Attribute Layout IDs and whether to locate the point on the "Real Z" and whether to Separate Attribute Layers when creating new points. For example, when creating a point with description "EP", Carlson would look up "EP" in the Field to Finish table and will use the field code definitions to establish the point instead of the definitions defined in Point Defaults.

**GIS File:** This option lets you specify a GIS file to be used when creating new points. The GIS file contains a list of fields to prompt for. For each point that is created, the program will prompt for these fields and store the results to the note file (.not) associated with the current CRD file.

**Pulldown Menu Location:** Points  
**Keyboard Command:** ptsetup  
**Prerequisite:** None  
**File Names:** \lsp\ptsetup.lsp, \lsp\scadenvr.dcl

## Draw-Locate Points

The Draw-Locate Points dialog box allows you to insert either new or existing points into the drawing. You can create new points either by picking points on the screen, or by entering northing and easting coordinates. You can also place existing points by entering point numbers which reference the current coordinate file. You are prompted to choose a coordinate file if no coordinate file is current.

The name of the symbol file is displayed in **Symbol Name**. You can choose a different symbol by clicking Select. The selected point symbol is displayed on the right.

**Symbol Rotation Azimuth** is the rotation angle that is used for the point symbols. This angle is used in a counterclockwise direction relative to the current twist screen.
**Layer by Desc** inserts the points in the layer named by the point description. Using Layer by Desc organizes the points by description and allows for layer management. For example, you can use the Isolate Layers command to show only points on a certain layer. If you include an invalid layer character in the description, the layer name stops at the bad character. A point description of "UP / 105" would use layer "UP", for example. The Layer Prefix is added to the beginning of the layer name. For example, a Layer Prefix of "PT_" and a point with the description "EP" would use the layer "PT_EP". Layer Prefix is optional. It allows all the point layers to be grouped.

**Draw Nodes Only** inserts only a point entity (the node) and not the point block and symbol. This option is most useful when you have a lot of points to insert, because inserting only the nodes is faster than inserting nodes with the point block and symbol. Commands such as Triangulate & Contour and Make 3D Grid File can use these points, and do not need the point block and symbol.

Selecting **Elev Text Only** draws text of the point elevation without the point block, symbol, or node. The decimal place of elevation text is placed at the northing and easting point location.

**Locate within Polyline** inserts only the points that are inside a closed polyline. The command prompts you to select a closed polyline. All the points in the current coordinate file are checked. Any points that are located within the closed polyline are drawn.

**Locate within Distance** inserts only the points that are within a specified distance from a reference point. The command asks you for the reference point and the search distance. All the points in the current coordinate file are checked. Any points that are located within the search distance of the reference point are drawn.

**Locate within Window/Coord Range** inserts only the points that are within the specified window or range of northing, easting, and elevation. The command prompts for the minimum and maximum northing, easting, and elevations. These values default to the actual minimum and maximum in the coordinate file. Then the command prompts for the point number range of points to check. The points that fall in both the point number range and the coordinate range are drawn.

Under **Point Prompt-Label Settings**, you determine attributes for which you will be prompted.

**Descriptions** determines whether you are prompted for descriptions for each point when creating new points. When you are placing both new and existing points, Descriptions determine whether this attribute is labeled with the point inserts.

**Notes** works with the note file (.not) associated with the current coordinate file. The note file contains unlimited point descriptions in addition to the fixed 32-character point descriptions in the coordinate file. When you create points with Notes on, the command will prompt for point notes to be stored with the point. When you draw existing points with Notes on, any notes for the points are drawn as text entities below the point description.

**Elevations** determines whether you are prompted for elevations for each point when creating new points. When you are placing both new and existing points, Elevations determine whether this attribute is labeled with the point inserts.

Use '+\*' labels the positive elevations with a leading '+'. For example, "+159.43".

Use '-\*' labels the negative elevations with a leading '-'.

**Locate on Real Z Axis** determines if the points are placed at their elevations or at zero elevation.

**Label Zeros** will label points with zero elevation when the Elevations option is on. Otherwise only points with nonzero elevation will be labeled.

**Elevation Prefix/Suffix** set the prefix and suffix labels to apply for the elevation labels.

**Elevation Integers** controls the number of digits to display to the left of the decimal point for the elevation label. The All setting will show the full elevation digits. The other settings allow you to limit the number of digits to display for the purpose of reducing the amount of space the elevation labels take up in the drawing. For example, if
a site is in the 4000 foot elevation range, then this setting could be set to three digits (000) and an elevation of 4321 would be labeled as 321.

**Elevation Decimals** sets the number of decimals to the right of the decimal places for the elevation labels.

Under **Point Number Settings**, you determine how points will be numbered.

**Point Numbers** determines whether the complete point block is drawn or just the symbol and node. When you create new points with Point Numbers off, no points are stored in the current coordinate file, and only the point symbol and node are drawn. When you draw existing points with Point Numbers off, the point attribute block is not drawn and only the point symbol and node are drawn.

**Automatic Point Numbering** applies to creating new points. With this option active, the command will use the **Starting Point Number** for the first new point. The next point number is automatically incremented. Before storing the point, the command checks whether the point number is used. If the point number is used and point protect is on (set in the Coordinate File Utilities command), then the command will prompt for another point number or to overwrite the point. With Automatic Point Numbering off, the command will prompt for the point numbers.

Determine how the points are to be displayed and in what layer.

With **Wildcard match of pt description**, you can display only points with specific descriptions. This can be thought of as a filter. For example, entering IP would display only points that are labeled with the description IP, or Iron Pin. The default is the asterisk (*). This will display all points regardless of description.

**Layer Name** allows you to designate a layer for the points to be displayed. You can enter a new name, CLAYER, or choose an existing layer by clicking **Select Layer**. Entry of CLAYER selects the current layer. A Carlson Survey point consists of a block insert with attributes, a point symbol, and a point entity. The point entity is used for picking the point by OSNAP Node in other commands. The block insert includes a point number, elevation, and description. These attributes are in the PNTMARK, PNTNO, PNTELEV, and PNTDESC layers. The points are also in an overall layer as specified in this dialog box. This layer setup allows you to freeze a group of points by the main layer name or freeze point attributes for all the points in the drawing. For example, freezing layer "PNTS" would freeze all the points in this layer. Freezing layer "PNTELEV" would freeze the point elevation attribute for all the points.

The **Erase Duplicates** option will erase existing point entities that match the point numbers currently being drawn.

**Fix Overlapping Point Attributes** will detect point number, elevation and description attributes that overlap with other points. Rules can be applied to rearrange the point attributes to avoid the overlaps. A point overlap manager then steps through each overlap for review or manually moving the attributes.

**Draw Range** will draw existing points from the current coordinate file. The Draw Range button will prompt for the point numbers to draw.

**Draw All** will draw all the points in the coordinate file, and then zoom the extents of the display to show the points.

**Draw Point Group** will draw a point group with settings that are established in the Point Group Manager.

**Enter and Assign** can be used to create new points using the point northing and easting.

**Screen Pick** allows you to create points by picking the point coordinate on the screen. For example, you could set the Object Snap to EndPoint and pick the end point of a building polyline to create a point at the building corner.

**Prompts**
To create a new point:

**Draw-Locate dialog** choose Screen Pick

**Pick point to create:** pick a point

**Select/<Enter Point Elevation <0.00>:** Enter elevation Press S to select text to set elevation.

**Enter Point Description <>:** Enter

N: 5106.57 E: 4901.96 Z: 0.00

**Enter/<Select text of elevation>:** Select text entity that defines elevation of point.

To locate a point in the coordinate file (point number 3 in this example):

**Draw-Locate Point dialog** choose Draw Range

**Point numbers to draw:** 3

**Points Drawn > 1**

Locates point 3.

**Point numbers to draw:** 1-2

**Points Drawn > 2**

Locates a range of points. From 1 to 2.

**Point numbers to draw:** Enter

**Keyboard Command:** lpoint

**Prerequisite:** A CRD file and you may want to execute Drawing Setup (see the Setting menu) to set the scale and size.

**File Names:** \lsp\lsp, \lsp\crdutil.arx

## List Points

This command generates a report of point numbers, northings, eastings, elevations and descriptions.

**Selection Method-Range** allows you to specify the points to list by point number range
Selection Method-Area allows you to select a closed polyline to list all of the points inside of that polyline.

Selection Method-Selection Set allows you to specify the points to list by selecting them from the drawing.

Range of Points: If you are using the Range method, specify the range of points to list here. To quickly specify all points, click the All button.

Point Group allows for the selection of a specified group or multiple groups for listing. Standard windows selection tools, ctrl and shift keys, can be utilized for selecting groups.

Description Match: Can be used to filter the point list. For example, entering "EP" for the Description Match would only list those points with a description of "EP". An asterisk (*) is the default setting, it matches any character sequence, meaning no filtering occurs.

Report Coordinate Range: When checked, the point list will include the minimum and maximum northing, easting and elevation.

List Point Notes: When checked, any additional point notes assigned to the points will be included in the point list. Point notes can be entered using the Input-Edit Point command found in Coordinate File Utilities.

Use Report Formatter: When checked, you may customize the fields and layout of the point report using the Report Formatter. The Report Formatter can also be used to export the point report to Excel or Access.

Double Space Between Points: When checked, the report will be double spaced.

The point list report is displayed in the Standard Report Viewer which can print, draw and save the report file. This report viewer cannot be used to edit the coordinate file. Instead use the Edit Points command in the Points menu.

Example of List Points Report:

List Points Report
File> C:\Carlson2008\DATA\POINTS.CRD
Job Description>
Job Number> 0.000  Job Date> 06/01/2002
Point No. Northing(Y) Easting(X) Elev(Z) Description
1  5355.240  5000.000  91.8  CP2
2  5000.000  5000.000  90.0  CP2
1000 5355.236  5000.000  91.8  CK
1001 4941.911  4622.029  91.4  FPC
1002 4952.629  4642.818  90.6  FH
1003 4959.931  4634.440  89.8  TOE1

Pulldown Menu Location: Points
Keyboard Command: listpt
Prerequisite: Points in a coordinate file or on the screen
File Name: \lsp\crdutil.arx

Import Text/ASCII File

This command converts point data from an ASCII text file into the current Carlson coordinate (.CRD) file. Each line of the text file can contain any combination of point number, northing, easting, elevation and description. All point information should be on one line with the values separated by a comma, space or other delimiter. Under the Source File Format setting you can choose from some specific formats or User-Defined. For User-Defined, the format of the text file is specified in the Coordinate Order field where the value identifiers are listed with the appropriate delimiters. For example:

For a text file with northing, easting, elevation and comma delimiters:
5100.0,5150.5,485.1
5127.1,5190.3,487.3
The Coordinate Order would be:
Y X Z

For a text file with point number, easting, northing, elevation, description and space delimiters:
1 5000.0 5000.0 490.3 TRAV
2 5030.4 4930.5 495.5 TRAV
The Coordinate Order would be:
P X Y Z D

Common formats can be selected from the Common Format List. All the lines in the text file should contain only point data and any header lines should be removed. To read the text file, pick the Select Text/ASCII File button and choose the file to read. Then the selected file is displayed in the Preview Window to help with filling out the Coordinate Order. When the Coordinate Order is set, click OK to read the text file. The Wild Card Descriptions Match allows for only point with matching descriptions to be imported. With Point Protect active, the program will check if a point number already exists in the CRD before importing the point. If a point conflict is found, you can either assign a new point number or overwrite the old point. The Value to Add to Point Numbers allows you to renumber the points as they are imported. The Header Lines to Skip value is the number of lines not to be processed at the start of the text file. The Point Group To Assign option will create a point group with the specified name for the coordinate file containing the point numbers imported with Import Text/ASCII File.

Multiple files can be imported at once. To do this toggle on the Enable Process Multiple Files option. After selecting the Text/ASCII Files button, you can select multiple files by using the Shift or Ctrl keys while picking files. You can also run Select Text/ASCII Files multiple times allowing for selection of files located in different locations. The files to import are listed in the top scroll display window. The point data from all the import files can be stored to the current CRD file or to separate files for each import file. The separate file option will name the resulting CRD files with the same name as the import file with a .CRD file extension. For example, the import file job125.txt
would create job125.crd. The CRD file will be created in the same location as that of the selected text file to import.

The special formats of Leica .gsi files, TDS .cr5 files, Geodimeter .obs/.raw files, Laser Atlanta .txt files, Trimble .pos files, Zeiss .txt files, Traverse PC .trv files, Maptech, Benchmark .dat files and Cadvantage .cog files can be directly imported by choosing that File Format at the top of the dialog.

Pulldown Menu Location: Points
Keyboard Command: readpt
Prerequisite: A text file to read
File Name: \lsp\crdutil.arx
**Export Text/ASCII File**

This command outputs point data from the current Carlson coordinate file to an ASCII text file formatted according to a variety of options presented in the form of a general dialog.

**Format.** Specify the type of file to write from the drop down list. There are several variations on point number, northing, easting, elevation and descriptions as well as specific formats for Leica, Geodimeter, Zeiss, Maptech, D45, Cadvantage, Multiplane and SDMS CTL formats. In addition there is a User-Defined Format option to define the order of the fields output. When using the User-Defined format, after selecting OK, the User-Define Export Format dialog will appear. On this dialog, specify the order of the fields by defining a number sequence in each field. You can skip fields and omit data in the output file by leaving None in the sequence field for this data:

**Selection.** There are three Selection Methods provided for the data to export. Notes associated with the points may be included in the export by enabling the check box. Specify either Range, Screen Points or Screen Entities in the Selection Field. A Range selection is a user specified range such as 1-10,30-50. A Screen Points selection is made by selecting points from the screen area. The Screen Entities option allows for selection of polylines, lines, arcs, points, faces, inserts and text to export point data from. When the Screen Entities option is selected, the following dialog box will display allowing for the specification of the type of entity to export data from:
Delimiter. Select the desired field delimiter of the export file as either Comma or Space from the drop down list. If a header line is to be included, enable the check box.

Number of Decimal Places. Select the desired number of digits to be included in the mantissa of all output ordinates.

Wild Card Descriptions Match. A description filter is also available for exporting only points from the range or selection set with certain descriptions.

Export Multiple Crd Files. Enable this check box to specify multiple CRD files to apply the selection criteria against. If enabled, an additional dialog will be presented from which you can browse, select, and remove as many CRD files as desired.

Point Group. Displays the Point Group manager dialog from which you may define, modify, and select one or more Point Groups to define the points to be included in the export.

After selecting the OK button, a final dialog appears that allows you to specify a new file or to append data into an existing file. The standard file selection dialog allows you to specify the export file name.

Pulldown Menu Location: Points
Keyboard Command: writept
Prerequisite: A Coordinate File (.CRD)
File Name: \lsp\crdutil.arx

Set Coordinate File

This command allows the user to set the name of the active coordinate file. This file is used by different commands that compute, store and recall point coordinates. Carlson coordinate (.CRD) files are binary files that contain point numbers, northings, eastings, elevations and descriptions. Alternately, C&G CRD & CGC files, LandDesktop MDB files or Simplicity Systems ZAK files can be used in place of the Carlson CRD file. These files are stored by default in the configured data subdirectory. When prompted for the name, if you type in a path name the file will be stored in the specified path. If you don't specify a path then the default path that is configured in the Configure command, found under Settings, will be used.

When executed, the command defaults to the Existing tab for selection of an existing file. You may select a file from the list of Recent Folders, or choose the Browse button to go to a specific location on your computer. To create
a new file, select the New tab and enter the name of the file in the file name field provided. Use the Browse button to specify the desired location to save the file.

Pulldown Menu Location: Points
Keyboard Command: setcrd
Prerequisite: None
File Names: \lsp\pcrdfile.lsp, \lsp\scadfile.dcl

CooRDinate File Utilities

This command allows you to manipulate the coordinates stored in a coordinate (.CRD) file. One of the most important commands is the Update CRD File from Drawing which allows you to update the file after editing the drawing with commands such as Erase, Move, Rotate or Change Elevations. Another handy option is the Draw Entities by Point Number which allows the user to input point number ranges and plot Lines, Arcs, Polylines or 3D polylines. Coordinate files have either numeric or alphanumeric point numbers. Alphanumeric point numbers consist of nine or less digits and letters (i.e. point number 7A). The type of point number format is displayed at the top title bar of the main dialog.

In addition to running the routines through the dialog, many routines have command names that you can enter at the Command: prompt, create a Quick Key, or put into a toolbar. Here are these command names and their corresponding dialog button names:

setcrd: Open CRD File
listpt: List Points

Chapter 10. Points Menu
delpt: Delete Points
readpt: Import Text/ASCII File
writept: Export Text/ASCII File
scalept: Scale Points
transpt: Translate Points
rotatept: Rotate Points
alignpt: Align Points
cfuelev: Elevation for Points
cfureport: Point Number Report
cfuduplicate: Duplicate Points
cfucompare: Compare Points
cfuhistory: Point History
cfuquiry: Copy/Merge CRD File
cfuupdatedwg: Update Drawing from CRD File
cfuupdatecrd: Update CRD File from Drawing
cfudesc: Description for Points
cfutransform: Coordinate Transformation

**Open CRD File**: Allows the user to switch to another file. When you exit Coordinate File Utilities this will be the current file that you work with in Carlson.

**Copy/Merge CRD File**: This command allows for the copying of entire CRD files, or parts of CRD files, to a new or existing files. This can be used to make a backup of your coordinate file, and it can also be very valuable in coordinate file manipulation. For example, if a certain range of points from one CRD file was also required in the active CRD file, this command would be used to simply copy the required range into the active CRD file. There are two options when first executing the command. These options are whether to import points from another file to the current (active) CRD file, or to export the current (active) coordinate file to another file.
Once this option has been decided, a prompt for the file to copy From or TO, will be displayed. Here simply specify the correct file.

Next there's a dialog to specify the range of points to transfer and some options. Here specify the points to copy. Point numbers and ranges can be entered together, for example, 1-3,10,15 would result in points 1 through 3 and points 10 and 15 being copied. The Description Match can be used to filter the points to transfer only the points with matching description. The default of * will transfer all the points in the range. The Store Non-Conflicting Point Automatically will set the transfer action as Store for all transfer points that don't have a point protect conflict. The Skip Merge Dialog If No Conflicts will skip the next dialog when there are no point protect conflicts.
Next there's the Merge Points Manager dialog that shows the Source Coordinate File on the left (where the point data is being copied from) and the Target Coordinate File on the right (where the point data is being written to). Conflict cases are when the same point number exists in both files with different coordinates. The action choices for conflicts are to Overwrite, Skip or Renumber. For renumber, you can either renumber with the next available point number in the target file or to the highest point number in the target file plus one. Non-conflict cases are when the source point number does not exist in the target file. The action choices for non-conflicts are to Store or Skip. You can assign actions by picking on the Action field in the spreadsheet or by entering in a Point Range to apply and picking an action button. The Show Matching Points toggle will show points with matching point data in both files. Otherwise only point with differences are shown. The Next Conflict button will highlight the spreadsheet and set the Point Range to the next point that needs an action assigned. Similarly, the Previous Conflict sets focus to a lower point number that needs an action. The History button shows the point history for the selected point. The Report button creates a list points report. The Current Merge Status reports the number of unresolved and resolved points. When all the unresolved points are resolved by assigning actions, you can pick OK.

**Convert CRD File Format:** This allows you to convert the current CRD file from numeric format to alphanumeric format or visa versa. This routine will also change crd files to and from different software formats. These formats include C&G, AutoDesk Land Desktop, and Simplicity. The current format of the active coordinate file will be displayed as well as the options for the new file format. This command only changes the format of the active coordinate file.
**Map Points from 2nd File:** This routine adds point to the current CRD file from points stored in a second CRD file. The points to copy are specified by numbers one at a time. Prompts for the destination point number (number to create in current crd file) and source point number (point number to be copied from second crd file) will be displayed.

**Import Text/ASCII File:** This routine converts point data from a text file into the current coordinate (.CRD) file. See the *Import Text/ASCII File* command in this chapter for more information.

**Export Text/ASCII Text File:** This routine outputs point data from the current coordinate (.CRD) file to a ASCII Text file. See the *Export Text/ASCII File* command in this chapter for more information.

**Edit Header:** Enter or edit the job information associated with the coordinate file. The fields include Job Description, Job Number and Job Date. This information will appear on the List Point report. Non-digit characters are not allowed in the Job Number field.

**Compress CRD File:** Removes unused point numbers by renumbering high point numbers into the unused spaces. For example, for an original file with points 1,2,105,107,108,109 would be compressed to 1,2,3,4,5,6.

**Coordinate Transformation:** Transforms coordinates between local, state plane 27, state plane 83, latitude/longitude, and Universal Transverse Mercator (UTM). Works on individually entered coordinates, by range of point numbers and with on-screen entities. For converting between state plane 27 and 83, Carlson calls upon NADCON from the National Geodetic Survey to apply the latitude/longitude adjustment. The NADCON program, ndcon210.exe, is stored in the Carlson EXEC directory.
The Transformation Type is used to define the Source Coordinate and Destination Coordinate formats. Settings for Lat/Long Datum, Lat/Long formats (dd.mmss or dd.dddd), Projections, State Plane Zones and coordinate units are defined in the Transformation Type dialog. The format of this dialog will change depending upon the type of transformation requested.

Example Lat/Long to Grid dialog

For all Transformation types, there are three options for inputting the data to be transformed. Data can be selected from the screen by using the Screen Entities. If a range of points or a particular point is desired, the Point Numbers option would be used. Manual entry of coordinates to transform one at a time is accomplished with the Enter Coordinates option. The coordinates can be typed in or use the Input Point Number option. Output Point Number is an option to store the results in the coordinate file.
For all transformations there are two output options when using point numbers as the input data. **Overwrite Existing Coords** replaces the original coordinate values with the new coordinate values after transformation. **New Point Numbers** will retain the original coordinate data and point numbers and create new point numbers with the revised coordinate data after transformation.

When transforming a **Local Coordinate System**, there are two options for defining the transformation as shown in the next dialog.

The **Align by Two Pairs of Points** option uses two pairs of source and destination coordinates. The first pair defines the translation as the difference between the source and destination northing and easting.
This destination point is also the pivot point for rotation. Rotation can be entered directly or defined by a second pair of points where the bearing between the first and second source points is rotated to align with the bearing from the first and second destination points. There is an option to also apply scaling. The scaling holds the angle between points and adjusts the distances by the scale factor. The scale factor is calculated for each point as the elevation factor at the first source point times the grid factor at the first destination point averaged with the elevation factor at the transform point times the grid factor at the transform point.

The **Least-Squares Best-Fit** option is used when there are more than two pairs for translation points. Since two pairs of points are sufficient to define the translation and rotation, more than two pairs of points provides more than enough information.
Over Determination by Plane Similarity is used to find the least squares best fit transformation for all the given source and destination points. Besides doing a translation and rotation, this option will also scales the points during the transformation. The Rigid Body Transformation also does a best fit least squares transformation, but applies only translation and rotation with no scale. The Helmert 7-Parameter method can also be used for local transformations. The 7-Parameter Values can be calculated from control points or entered by the user.

The Add button is used to define the source and destination coordinates for the points that define the transformation. Pressing this button brings up the following dialog box.

The Edit button is used to edit existing data.

The Delete button removes the source and destination pairing from the transformation setup.
The **Process On/Off** button allows source and destination pairings to be turned on and off. This is useful when wanting to inspect different results using different pairings.

The **Optimize** option chooses which point pairings would yield the best transformation results by turning off the processing of pairings with higher residuals. This minimizes the average residual for the control points.

The **Report** option displays a report of the transformation point pairings, their residuals, processing status, transformation scale and avg. residual.

The **Load** and **Save** options allow for saving and recalling local coordinate transformation pairings and settings.

**Draw Entities by Point ID:** Draw Lines, Arcs, 3DLines, Polylines or 3DPolys by defining a range of point numbers.

**Prompts**

**Plot Entities by Point Number**

Type of entity, Arc/Polyline/3d polyline/2d line/Exit/<Line>: P This response causes the program to plot polylines.

Example: ‘1*4-7-10*12-5-8′ would draw lines from point number’s 1 through 4 then to 7, to 10 through 12, then to 5 to 8. (limit 132 characters)

Undo/<Enter point numbers or ranges>: 1*10-20*30

The program draws a polyline from point number 1 through 10 to point number 20 through 30.

**New Last Point Number:** This option sets the highest point number in the CRD file. All points above this number are erased.

**Swap Northing-Easting:** This option allows you to swap northing and easting coordinates for any selected range of points. What was the northing of an existing coordinate point, or range of points, becomes the easting. And the easting(s) becomes the northing(s).

**Point Entry CRD File Links Manager:** When points are created in the drawing, the program records the source coordinate file for the points. The coordinate file names assigned to the point entities links the point entities back to the coordinate file. These links are used by routines that process the point entities and then need to reference the coordinate file such as Move Point which selects a point entity and updates the coordinate file. This routine checks all the point entities in the drawing and lists all the linked coordinate files. You can use the Assign button to set the...
coordinate file assigned to point entities which is useful when the coordinate file has been moved after the points were drawn. Use the Unlink button to remove the link.

**Update Drawing from CRD File:** This function updates the position of Carlson points in the drawing to match the position stored in the coordinate file. This command also has options to erase and draw points. For the erase option, points are erased from the drawing if the point number does not exist in the coordinate file. For the draw option, if a point number in the CRD file does not exist in the drawing, then this point is drawn using the settings from the dialog. The number of points modified, erased and drawn is reported at the end of the command.

**Update CRD File from Drawing:** This function allows you to select all or some of the points in the drawing and add or update them to the .CRD file. The points can be filtered with AutoCAD's Select Objects: selection mechanism and/or wild card matching of the point descriptions. The Update Point Descriptions option determines whether the point descriptions from the drawing will be stored to the CRD file. Use this command to update the file after a global edit such as Move, Rotate, Renumber Points, Change Elevations, Erase, etc. This routine directly reads Leica
(Wildsoft), Softdesk, Geodimeter, InRoads, Land Development Desktop, and Eagle Point point blocks.

**List Points:** List the points stored in the .CRD file. See the List Points command in this chapter for more information.

**Delete Points:** Deletes points in the coordinate (crd) file by point number or description.

**Screen Pick Point:** Pick a point on the graphics screen and it's coordinate values are added to the coordinate (crd) file. Prompts for point number, elevation and description will be displayed. This command does not plot a point, point attributes or point symbol. Use the command Draw-Locate Points command to do this.

**Scale Points:** This option multiples the point northing, easting, and elevation by the scale conversion factor. You can use this routine for metric-English conversion. See the Scale Points command in this chapter for more information.

**Translate Points:** This option translates a range of points based on entered delta x and delta y, entered coordinates or translation point numbers. See the Translate Points command in this chapter for more information.

**Rotate Points:** This option rotates a range of points based on entered degrees or rotation, entered azimuths, entered bearings or rotation point numbers. See the Rotate Points command in this chapter for more information.

**Align Points:** This option does a translate based on a source point and destination point and then rotates to align the first source point and a second source point with the first destination point and a second destination point. See the Align Points command in this chapter for more information.

**Description for Points:** This routine modifies the point description field with the user-specified text for a range of point numbers. There is an option to update the description attributes of the points in the drawing in addition to updating the coordinate file.

**Elevation for Points:** This routine modifies the elevation of the specified points. The Absolute method sets the elevations to the specified value. The Differential method adds the value to the current elevations. The Scale method multiplies the current elevations by the value.
**Point Number Report:** This routine lists the used and the unused point numbers in the CRD file.

**Duplicate Points:** This function searches the CRD file for points with the same northing, easting and elevation. The tolerances for considering points to have the same coordinate are set in the dialog separately for northing/easting and elevation. To be counted the same coordinate, both the northing/easting and elevation must be within the tolerance distance. The duplicate points can be erased or only reported. For the erase option, the first point number is kept and any higher point numbers with duplicate coordinates are erased from the CRD file.

**Compare Points:** This function compares the coordinates in the .CRD file with either the coordinates for the matching point numbers in the drawing file, with matching point numbers from another CRD file or with different point numbers from the same CRD file. A report is created for any differences that shows the point numbers and the differences. The difference can be reported as a bearing and distance between the two points, as distance North/South and East/West or as the delta-X and delta-Y. There is an option whether to include the point coordinates in the report.
Example Bearing-Distance format Compare Points Report

**Renumber Points:** This option rennumbers points in the user-specified range starting from a new point number. The old point numbers are erased. The condense points will renumber such that there are no unused point numbers in the renumbered range. Otherwise the spaces between the points is maintained. In the example shown, renumbering 1-25 with points 1,2,24,25 to starting point number 101 will result in points 101,102,103,104 if condense is on or 101,102,124,125 if condense is off.

**Input-Edit Point:** Enter or edit the coordinate values or the description of a point. The Notes section is for adding optional point notes which are additional point descriptions. The standard description field is limited to 32 characters. Under notes, any number of lines of text can be assigned to the point. A list box shows the lines of notes. To add a note line, pick a blank line in the list box and then type in the note in the edit box belong the list box and press Enter. To edit a note, highlight the line in the list box and edit the text in the edit box.
Point History: All changes to the coordinate file will record the commands performed on this coordinate file and the status of the points themselves. This makes up the coordinate file history. The history can then be reported by point number or by command. All of the changes can be rolled back. It is important to note that if maintaining such a history file is your objective, in the Settings > Configure > General Settings dialog you must make sure that Maintain CRD History File is checked.
The Disable History Feature button at the top of the dialog shown above is a toggle device. It should be clicked if you prefer not to build the point history file. Clicking it a second time changes it back to saying Enable History Feature. You can also choose Delete History File to delete the file altogether. By clicking any point from the list, as shown in the Points tab example above, and then selecting History, you will be given the history for that specific point. Double-clicking on any command shows the details. Clicking on Details also shows the selected command’s details. Undo thru Selected will undo the effect of all of the commands up through and including the selected command. The changes from the undo command are themselves then added to the command list and can be undone in the future.

Point Protect Toggle: This option, located at the bottom-left of the main Coordinate File Utilities dialog, toggles point protection on and off. With this option on, when attempting to store a point with a point identifier (point number) that already exists in the current coordinate file, the following dialog will be displayed.
**Overwrite with new coordinates** will update the existing point number with the new location of the point.

The **Use Another Number** field displays the point number that will be used if the Use Another Number option is selected. This number will depend upon the option chosen from the **Another Number From** settings. If **Next Available** is chosen, the next available number will be displayed in the Use Another Number Field. If there are number gaps in the coordinate file this number will not be the next highest number in the file. For example if points 1-10 and 20-30 exist in the crd file leaving a gap from 11-19, the Next Available number would be 11. If the desired point number, in this example, is 31, then the option of **End of File** would be selected.

The **Overwrite All** and **Renumber All** options apply when more than one point with the same number exists in the coordinate file. These options are helpful when importing points into existing CRD files.

**Pulldown Menu Location:** Points  
**Keyboard Command:** cfu  
**Prerequisite:** None

---

**Point Group Manager**

This command is used to create point groups based on inclusion and exclusion filters. The manager can perform various functions on these point groups. Also point groups can be referenced by group name in other commands such as Field to Finish and Data Collection.

**Groups Pulldown**

**Create Point Group:**  
This routine creates point groups. When selected, the New Point Group dialog box is displayed.
**Group Name** is the name of Point Group to create.

**Description** is the description of Point Group to create.

Use the **Include Tab** to define the filters to be applied when creating the point group. Inclusion rules are applied before the exclusion rules.

When **Include All** is toggled on, all points in the coordinate file will be included in the selection.

When **Point List** is toggled on, an option of defining the point list must be selected.

**DWG: Select** allows for manual selection of the points to include from the drawing. The points must be drawn on the screen prior to using this option. All standard AutoCAD selection tools are available for selection of the points.

**DWG: Add Within Circle** allows for selection of the points to include by a user defined circle. The circle is defined by specifying the center and radius of the circle. The radius can be defined by entering in a numeric value or by picking on the screen. Points must be drawn to the screen prior to using this option.

**DWG: Add Within Polyline** allows for the selection of points to include by referencing a closed polyline. All points located within the closed polyline will be included in the selection. Prompts for the inclusion polyline and the exclusion polyline will display. The inclusion polyline limits of the selection area. The exclusion polyline defines the area to exclude within the inclusion polyline. Points must be drawn to the screen prior to using this option.

**CRD: Select** allows for manual selection of the points to include from a point list. Standard window selection tools are available for selecting the points to include.
**CRD: Add Within Circle** allows for selection of the points to include by a user defined circle. The circle is defined by specifying the center and radius of the circle. The radius can be defined by entering in a numeric value or by picking on the screen. The points do NOT have to be drawn to the screen prior to selection.

**CRD: Add Within Polyline** allows for the selection of points to include by referencing a closed polyline. All points located within the closed polyline will be included in the selection. Prompts for the inclusion polyline and the exclusion polyline will display. The inclusion polyline limits of the selection area. The exclusion polyline defines the area to exclude within the inclusion polyline. The points do NOT have to be drawn to the screen prior to selection.

**Elevation Range** allows for the selection of points within a specified elevation range to be included in the group. The minimum and maximum elevations can be entered manually in their respective data fields. The minimum and maximum values can also be specified by the Set By Selection and Set From List options.

**Set By Selection** allows for selection of points to include in the group from the drawing. The points must be drawn to the screen prior to using this selection method. Standard AutoCAD selection methods are available.

**Set From List** allows for selection of points to include in the group from a point list. Standard Windows selection tools are available with this option.

The **Description** option allows for a selection of points to include based upon the description of the point. The description to filter for can be entered in the data field or by using the Set By Selection and/or the Set From List options described above.

The **Exclude Tab** allows for defining rules that pertain to the points to be excluded from the Inclusion selection. After defining the inclusion rules for the group, the options on the Exclude tab can be used to filter for points to exclude from the group. For example, if the inclusion rules call for all points within the elevation range of 8 to 12, an exclusion rule can be set to exclude the points on elevation 9 or with the description tree. The options on this tab work exactly like the options on the Include tab. Please refer to the Include tab definitions for further instruction.

**Save Changes** saves the point group to the group name specified based upon the Inclusion and Exclusion rules specified.

**Cancel Changes** discards specified rules and changes and goes back to the Point Group Manager dialog.
**Edit Point Group:**
This function allows for editing of existing point groups. From the list of available groups, highlight the group or groups to edit. When complete with the first group, if more than one is selected, selecting the Save Changes option will save the changes to the active group and switch to the next group in the selection set.

From the Groups pulldown, select Edit Groups, the Edit Group dialog box will now appear.
See Create Point Groups for further definitions of the available options.

**Delete Point Group:**
This deletes specified groups for the existing group list. One or more groups can be deleted at one time.

**Copy Point Group:**
This routine creates a new point group by copying the currently highlighted group. This allows you to modify an existing group definition and create a new group.

**Import Point Groups:**
This allows for importing filters from point group manager settings of other coordinate files. This is a useful option when coordinate files are going to contain same point group names with the same filters. This option only brings in the filters into the point group manager, it does not import actual points into the coordinate file by group name. Existing points in the active coordinate file that meet the filter definitions of the imported point groups will automatically be added to the corresponding group.

**Points Pulldown**

**Insert into Drawing:**
This routine draws the points in the group in the drawing. Individual points or point ranges can be selected from the group to be erased from the drawing. For example points 264-275 and point 298 contained in group Wet Lands are tagged to be erased from the drawing in the following figure.

The symbol to be used and the attribute layout are determined by the Point Default Settings. The symbol size and the point attribute size are determined by the settings in the Drawing Setup routine.
**Erase from Drawing:**
This erases specified point group/groups or specified points from within the group from the drawing.

**Erase from Coordinate File and Drawing:**
This erases the points in the specified group/groups or specified points from within the group from the drawing and will also permanently delete the points from the CRD file. You will be prompted with a warning as follows:

![Warning dialog box]

Selecting **Yes** will complete the command and erase the points from the screen and also the coordinate file. Selecting **No** will cancel the command leaving the drawing and the coordinate file unchanged.

**Report:**
The routine will generate a point list of the points contained in the selected group/groups or specified points from within the group.

**Highlight:**
This routine highlights the specified objects in the drawing. This makes them distinguishable from the other points on the screen.

**Freeze:**
This routine freezes the points like the Points->Freeze Points command.

**Thaw All:**
This routine thaw the points like the Points->Thaw Points command.

**Draw 2D Line:**
This routine draws a 2d polyline between the points contained in the group/groups or between specified points in a group.

**Export:**
This command exports the selected group/groups or the specified point(s) or range of points from within the group to various formats. The available formats are ASCII/Text, Carlson Software CRD and C&G CRD files.

When **ASCII/Text** is selected, the Export Text/ASCII File dialog box will be displayed. Please refer to the Export Text/ASCII File section of the manual for more information.
The **CRD-Carlson software** command writes the selected group/groups or the specified point(s) or range of points within the group to a new Carlson formatted CRD file.

Specify the file name of the CRD file to create and press save.

**CRD-C&G** writes the selected group/groups or the specified point(s) or range of points within the group to a new C&G formatted CRD file.

Specify the file name of the CRD file to create and press save.

### Button Functions

The series of buttons at the bottom of the main dialog do the same functions as the routines in the Groups pull-down menu except the Move Up and Move Down which are only available as these buttons. The Move Up/Down simply change the display order of the groups in the list.

**Pulldown Menu Location:** Points  
**Keyboard Command:** pgm  
**Prerequisite:** A coordinate file

### Edit Points

This command edits point data in the current coordinate file or within a point range. The current coordinate file can be set with the Set Coordinate File command. Edit Points shows all the points in the coordinate file. New points
can be added and points can be deleted by using the Insert and Delete keys.

The Group option allows you to edit subset collection of points as defined by Point Group Manager. This Group method is a way to filter the points by point range, elevation range or description.

This tool also lets you edit notes associated with each point. While the standard point description is limited to 32 characters, the drawing notes are not. When you click on a given point, you can add numerous lines of notes about that point in the bottom of the dialog. Keep in mind that these notes are stored in a separate file with the extension ".not" having the same name as the CRD and residing in the same folder.

**Pulldown Menu Location:** Points  
**Keyboard Command:** editpt  
**Prerequisite:** None

### Erase Points

This command erases Carlson points inserts from the drawing. The points to erase can either be selected from the screen or specified by point number, point number range or by point group. Erasing a Carlson point will erase the
three entities that make up a Carlson point: the point symbol, point attributes, and point node. There is an option to skip erasing the point symbol in case you want to leave the symbols in the drawing. The points may optionally be erased from the coordinate file. As long as the points are not deleted from the coordinate file, they can be redrawn with Draw-Locate Points or Field-to-Finish.

Prompts

Select points from screen, group or by point number [Screen/Group/ <Number>]? press Enter
Point numbers to erase: 1-5
Delete points from coordinate file [Yes/<No>]? press Enter
Delete point symbols [<Yes>/No]? press Enter
Erasing Carlson Points ....
Number of points erased > 5

Pulldown Menu Location: Points
Keyboard Command: DELPT
Prerequisite: Carlson points to be erased

Freeze Points

This command freezes Carlson points to hide them from view without erasing them. Use the Thaw Points command to show the points again. This command works similar on points as Freeze Layers works on layers. The points to freeze can be selected by point number range, point group, inclusion/exclusion perimeter polyline areas, or screen selection. There is a dialog to choose the method and specify a description match filter.

Pulldown Menu Location: Points
Keyboard Command: freezept
Prerequisite: Carlson points to freeze
File Name: \lsp\crdutil.arx

Thaw Points

This command thaws Carlson points that were frozen with the Freeze Points command to show the points in the drawing again. This command works similar on points as Thaw Layers works on layers.
Translate Points

This command translates points in a coordinate file from one coordinate position to another. The delta X, Y, and Z can be entered directly or calculated from original and destination coordinates. The original and destination coordinates can be entered directly, specified by point number, selecting the point number from a point list by selecting the list icon, or selected from the screen by selecting the pick icon. Once these points have been specified, the Delta X, Y, Z, if Process Elevations is checked ON, fields will be filled in with their calculated values. Any points in the drawing will be updated automatically in addition to updating the coordinate file.

Define Translation By Angle/Distance requires a specified direction, Northeast (NE), Southeast (SE), Southwest (SW), Northwest (NW) or Azimuth (AZ) along with a specified distance in order to perform a translation. Once the direction and distance are entered, the Delta X, Y, Z will be calculated. This is a useful command when you know that the job needs to shift, for example, to the Northeast 25 degrees for a distance of 100 feet. Here you would simply type in 25 in the Angle (dd.mmss) field, choose NE in the Type field and then enter the distance of 100 in the Distance field.
With **Process Elevations** checked, all elevations will be translated by the specified or calculated Delta Z value. This option is very useful in correcting point elevations after performing a survey with assumed elevations and then later surveying into a benchmark with known true elevation. In this case only the Delta Z value, use (-) to indicate a lower correction, and the range of points to translate would be required for a translation. For example if the entire job needed to be lowered by 5', the Delta Z would be defined as -5 and the Range of Points defined as ALL.

**Ignore Zero Elevations** is only available when Process Elevations has been chosen. With this option checked ON, all points with an elevation of 0 will be ignored resulting in no translation taking place on these points.

With **Translate Screen Entities** checked ON, after specifying the point range or group to translate and selecting OK on the dialog box the following command line prompt is displayed:
Select objects to rotate (points excluded):
At this prompt select the objects on the screen, polylines, lines, arc, etc., to also translate and press enter. The translation of the points and screen entities will be completed.

Various **Output Options** for the translated points are available.

**Overwrite Existing Coordinates** will overwrite the existing coordinate points with the new translation coordinates thus changing the coordinate values in the existing crd file.

**New Point Numbers** will assign new point numbers to the translated coordinate points and leave the original coordinate points unchanged and present in the coordinate file. When using this option, on the Range of Points to Translate dialog, there is a Value to add to point numbers field. In this field, enter the value to add to the point numbers. For example if the existing point numbers are 1-20, and the value to add is 100, the resulting new point numbers will begin at 101 and end at 120.

**New CRD File** will place the translated coordinates in a new crd file. After selecting OK to the range of points to translate dialog, the Coordinate File to Create dialog will appear. On this dialog enter the name of the new crd file and select save. The original crd file will remain unchanged and the new file will contain the points with the translated coordinates.

Specifying the points to be translated is accomplished either by specifying a **Range of Points** (1-20,33,36-40,...) or by **Point Groups**. If using the Point Group option, the Select Point Group(s) dialog box will be displayed allowing for the selection of the Group(s) to rotate.

The **Description Match** option only translates points with the description(s) specified in this field.

**Undo Last Translation** restores the points to their previous location before translation. It is important to note that if Translate Screen Entities has been checked to restore the translated objects to their previous location will require the use of the undo command located in the Edit pulldown.

The AutoCAD command **MOVE** can be used to translate points on the screen but this does not update the coordinate file unless you have the option Link Points with CRD File turned ON in **Configure**. (Note: This toggle must have been turned ON prior to locating the points). If you do use the **MOVE** command and the CRD file needs updating, run the command **Update CRD file From Drawing** found in **Coordinate File Utilities**.

**Pulldown Menu Location:** Points  
**Keyboard Command:** transpt  
**Prerequisite:** points in a coordinate file  
**File Name:** \sp\crdutil.arx
Rotate Points

This command rotates points in a coordinate file. The degrees of rotation can be entered directly or calculated from original and destination bearings or azimuths.

The Rotation Point will remain unchanged while the points specified for rotation rotate around it. This point can be specified by using the List button to pick from a list of points contained in the coordinate file, or from the screen by using the Pick button. The rotation point can also be defined by a coordinate value by manually entering in the X and Y values of the point. This point must be defined before the rotation will take place.

The Original Bearings/Azimuths and Destination Bearings/Azimuths can be entered directly or specified by point numbers. If using a pair of points to define the original bearing and then specifying the destination bearing by entering in the desired Bearing/Azimuth, the From and To Pt# fields should be left blank in the destination bearing/azimuth settings. Use the From and To Pt# fields in the Destination Bearing/Azimuth when you want to make a direction or Bearing/Azimuth between two existing points match the Bearing/Azimuth between two other existing points within the file. For example, to make the bearing between points 10-12 match the bearing between points 25-26, the Original Bearing/Azimuth could be defined as From Pt#10 To Pt#12 with the Destination Bearing/Azimuth defined as From Pt#25 To Pt#26.

With Rotate Screen Entities checked ON, after specifying the point range or group to rotate and selecting OK on the dialog box the following command line prompt is displayed:
Select objects to rotate (points excluded).:
At this prompt select the objects on the screen, polylines, lines, arc, etc., to also rotate and press enter. The rotation of the points and screen entities will be completed.

Various Output options for the rotated points are available.

Overwrite Existing Coordinates will overwrite the existing coordinate points with the new translation coordinates thus changing the coordinate values in the existing crd file.
**New Point Numbers** will assign new point numbers to the translated coordinate points and leave the original coordinate points unchanged and present in the coordinate file. When using this option, on the Range of Points to Translate dialog, there is a Value to add to point numbers field. In this field, enter the value to add to the point numbers. For example if the existing point numbers are 1-20, and the value to add is 100, the resulting new point numbers will begin at 101 and end at 120.

Specify the points to be rotated is accomplished either by specifying a Range of Points (1-20,33,36-40,...) or by Point Groups. If using the Point Group option, the Select Point Group(s) dialog box will be displayed allowing for the selection of the Group(s) to rotate.

The **Description Match** option only rotates points with the description(s) specified in this field.

The points that have been specified for rotation that are present in the drawing will be graphically updated to their new location in addition to an automatic update of the coordinate file.

**Undo Last Rotate** restores the points to their previous location before rotation. It is important to note that if Rotate Screen Entities has been checked to restore the rotated objects to their previous location will require the use of the undo command located in the Edit pulldown.

**Pulldown Menu Location:** Points  
**Keyboard Command:** rotatept  
**Prerequisite:** points in a coordinate file  
**File Name:** \lsp\crdutil.arx

### Align Points

This command translates a specified Range of Points or Points Group(s) based on a source point and destination point and then rotates to align the first source point and a second source point with the first destination point and a second destination point. The command basically combines the Translate and Rotate Point commands. To specify a Range of Points to align, enter the range to align or select a point group(s) by selecting the Point Group button. Each of the Translation and Rotation points, both Source and Destination points, can be entered manually or picked
from the point list by selecting the List button.

When **Align Screen Entities** is checked, after specifying the point range or group to align and selecting OK on the dialog box the following command line prompt is displayed:

**Select objects to rotate (points excluded):** At this prompt select the objects on the screen, polylines, lines, arc etc., to also align and press Enter. The alignment of the points and screen entities will be completed.

When **Ignore Zero Elevations** is checked, all points with an elevation of 0 will be ignored in the alignment.

**Undo Last Align** restores the points to their previous location before alignment. It is important to note that if Align Screen Entities has been checked to restore the aligned objects to their previous location will require the use of the undo command located in the Edit pulldown.

**Pulldown Menu Location:** Points
**Keyboard Command:** alignpt
**Prerequisite:** Points in a coordinate file
**File Name:** \lsp\crdutil.arx

### Scale Points

This command scales points in a coordinate file. The northing, easting and optionally the elevation are multiplied by the specified scale factor. You can use this routine for Metric-English conversion or a specific conversion by choosing the Use Customized Scale Factor option and specifying the desired Scale Factor in the edit box.
Specify the **Range of Points** to scale by entering in a range or group to scale. You can access the group dialog box by typing "group" in the range of points field.

The **Description Match** option only scales points with the description(s) specified in this field.

The **Scale Factor** is to be entered in manually when using a customized scale factor. If converting from standard measurement units, feet to meters, meters to feet, US Feet to International Feet, etc., the scale factor will be calculated and entered automatically. If a combined scale factor is required for converting from ground to grid and grid to ground coordinates, this value can be calculated by using the **Calculate Combined Factor** option. This calculation process begins with the Calculate Scale Factor dialog shown below.
The **Projection Type** must be specified as either State Plane 83 or State Plane 27 as well as what state plane **Zone** is required.

The available **Coordinate Units** are Metric, US Feet and International (Intl) Feet. The correct unit must be specified before calculating the combined scale factor.

The **Range of Numbers** to Process should be used to select the points to be used in order to calculate the combined scale factor. This does not specify what points are going to be scaled by the resulting scale factor. These points can be selected from a list by selecting the **List** button.

**Scale Direction** determines which way the scale factor will be calculated. A scale for **Ground to Grid** or **Grid to Ground** can be calculated and applied.

Pressing the **Calculate** button will calculate and then display the combined scale factor on the dialog box. To accept this value as the customized scale factor to use to scale the points in the coordinate file, press the **OK** button.

The **Report** option displays a report showing specified information. This information is specified by using the report formatter found throughout the program. Simply choose the information you wish to display and the order to be displayed. For further instruction and information on the Report Formatter please refer to the Report Formatter section of this manual.
With **Align Scale Entities** checked ON, after specifying the point range or group to scale and selecting OK on the dialog box the following command line prompt is displayed:

Select objects to scale (points excluded):
At this prompt select the objects on the screen, polylines, lines, arc, etc., to also scale and press enter. The points and screen entities will be now be scaled and updated graphically and in the active coordinate file.

With **Use Customized Scale Factor** Off, various conversions can be performed by specifying the Source Coordinate units and the Destination Coordinate units. This is a quick and easy way to perform Metric/English conversions.

**Pulldown Menu Location:** Points  
**Keyboard Command:** scalept  
**Prerequisite:** points in a coordinate file  
**File Name:** `\sp\crdutil.arx`

**Move Points**
This command allows you to move Carlson points, one at a time by selecting any part of the point. Each Carlson point is made of three entities: a POINT entity, a symbol, and a point attribute block with the point number, elevation and description. All these parts of the point are moved together with this routine. Any point moved using this command will result with the original source coordinate file (which is not necessarily the current coordinate file) updated with the new position of the point.

**Pulldown Menu Location:** Points  
**Keyboard Command:** mpnt  
**Prerequisite:** Carlson points  
**File Name:** `\sp\mpnt.lsp`

**Edit Point Attributes**
This command will edit the attributes of a Carlson point, such as the symbol type, point number, elevation and description. When this command is invoked, the command line will prompt the user: **Select point to edit (Enter to end).** At this point, you can select any part of the point including the symbol, elevation, point number or the description. Next, a dialog will appear as shown.
To change the symbol, either type in a new symbol name in the edit box, or choose the "Select Symbol" button where you can choose from a list of symbols. To change any of the other properties of the point, simply change or replace the contents of the edit box with the new information. Both Drawing Description and CRD File Descriptions are displayed. When a change to the Drawing description is made, this change will not be reflected in the coordinate file. This allows the change of a description that is defined in the Field to Finish (fld) table for a particular code. If a change is made in the CRD File description, it will be reflected in the coordinate file. Take note that if the CRD file description is changed, running Field to Finish will change the definitions for the point(s) changed. If you change the point number to a number that already exists in the current CRD file, and point protect is ON, you will be prompted [O]verwrite w/new coordinates, overwrite [A]ll, or use number <1000>:. You can choose to use the next available point number in the CRD file (this is the default), or overwrite the point number. The properties that you modify, with the exception of Drawing Description, will update the current CRD file. All modifications will update screen entities. Selecting the History button will bring up another dialog box that displays the point history of the point chosen. A history of the point will be listed, but only if, under General Setting, the Maintain CRD History File had been set to ON (selected) for the coordinate file that you are working with. With the CRD History feature of Carlson, all point changes can be rolled back.

You may also choose to use the AutoCAD DDATTE command to change the attributes of a point. If you do this, then the CRD file will not be updated and if you change the elevation attribute, the point will not change its current Z location.

**Pulldown Menu Location:** Points  
**Keyboard Command:** editpnt  
**Prerequisite:** Carlson points  
**File Name:** \lsp\editpnt.lsp


**Edit Multiple Pt Attributes**

This function allows you to modify the properties of multiple point attributes at the same time. This command gives you complete control over the Carlson point attributes that are present in the drawing. Changes can be made to each attribute – the point number, elevation, description or symbol – all in one motion. For example, you could rotate the elevation text of some points to 45 degrees, change the height of the description text for all the points in the drawing, or change the layer for a particular attribute. Once this command is chosen, the entry Edit Multiple Points dialog, a smaller box, appears. Here you can determine your point selection method. There is also an option for description matching.

![Edit Multiple Points dialog](image)

After the selection of the points to change, click OK, and the subsequent, larger Edit Multiple Points dialog boxes will appear. The number of points selected will be shown at the top of the dialog boxes.

**Edit Multiple Points dialog**

For each attribute, you can change any number of the properties, including the layer, height and rotation. These dialogs will reflect the current status of each attributes properties. If, for example, you select 10 points, and 5 of them have the elevation rotation set at 45 degrees, and the other 5 are set at 0 (zero) degrees, then the rotation edit field will say *varies* to let you know that the properties of the points you selected are not the same. Here is an example of the dialog box.

---

*Chapter 10. Points Menu*
The **X location** refers to the distance in the X direction from the center (or insertion point) of the point symbol. The **Y location** refers to the distance in the Y direction from the center (or insertion point) of the point symbol.

The **Layer** refers to the layer of the individual attribute, not the entire attribute block. To change the layer of the entire attribute block, use the **Attribute Block Layer** option. The **Height** is expressed in real units (generally feet or meters), not plotted size. The **Rotation angle** is expressed in absolute decimal degrees. The **Point Entity Layer** refers to the layer that the node of the point resides. The required layers can either be typed in manually, or the Select button can be used to pick from the existing layers in the drawing. If a new layer is desired, simply type in the name of the new layer and it will be created automatically. Use the layer property manager to edit the properties of this new layer, if required.

To change a point symbol, check on the **Symbol** option and use the select button to choose the desired symbol. The **Attribute Layout ID** refers to the attribute layout style defined in Point Defaults or Field to Finish code definitions. This option allows you to change the particular layout with one of the other available styles or to a customized style if defined. The Pick buttons allow you to pick two points to define a distance (or angle in the case of Rotation). If you want to select a line to define a distance or angle, select two points on the line with the appropriate OSNAP.

Each change to an attribute is defined separately except for the lower **Items to Change** group explained below. Select the attribute to edit, make the necessary changes to this attribute and then move on to the next attribute if required. Changes made to the attributes are remember individually, which allows for switching back and forth though the attributes until the command is completed. After completion the new settings for the point attributes will be retained until changed or redrawn on the screen.

**Example sequential use of Edit Multiple Points dialog**

Again, the number of points selected will be shown in the dialog title. Let's now define the changes for each attribute individually. In the following example, suppose we want to rotate the elevation text to a 45 degree angle, move the X and Y location, change the layer, and change the symbol.
description to the right and change the symbol. First, click on the Elevation for the Attribute to Edit. Now, select the Rotation option and type in 45. The dialog box should be as below.

Now, select the Description option for the Attribute to Edit. Select the X location from the Items to Change. Enter 1.50 in the box. This value makes the description line up better with the rotated elevation. The dialog should be as below:
Now, for the final change, select the Symbol for the Attribute to Edit. We want to actually change the point symbol. To do this, toggle on the option to change the symbol by clicking in the box beside the word Symbol. Next, press the Select button and select symbol SPT5. The dialog should be as below:

![Edit Multiple Points Dialog](image)

At this point we are ready to select the OK button to perform the changes. The following image shows the points before and after the changes.

![Before and After Changes](image)

**Example global use of Edit Multiple Points dialog (Lower Items to Change group)**

The lower group of Items to Change options apply globally to all selected points regardless of the current Attribute to Edit setting at the top. The Point/Attribute/Symbol Layer sets the layer associated with the enclosing block for all attributes and all selected points. The text height of all of the enclosed attributes of all selected points may be set...
directly with the Attribute/Symbol Height option. As an example, to set the layer of all enclosing point blocks to PNTALL and the all enclosed attribute text heights to 2.5, complete this area of the form as shown in the following:

Pulldown Menu Location: Points
Keyboard Command: modpnts
Prerequisite: Points drawn on the screen
File Name: \lsp\crdutil.arx

Move Point Attributes Single

This command allows the user to move Carlson point attributes (including the point number, elevation or description) one at a time.

Prompts

Select Point Number, Elevation, or Description to Move: select point attribute
Pick new location: pick point
Pick new angle: pick new angle or press Enter

Pulldown Menu Location: Points
Keyboard Command: movepnt
Prerequisite: Carlson points
File Name: \lsp\surv1.lsp
Move Point Attributes with Leader

This command allows the user to move Carlson point attributes (including the point number, elevation or description), and to draw a dynamic leader to the point node. Leaders and arrowheads may be customized by selecting Options at the command line. The attributes are always justified left or right depending on which side the leader starts.

Prompts

Select Point Label to Move (O for Options, R for Restore): select point attribute
Pick label position: pick point
Select another Point Label to Move (O for Options, R for Restore, Enter to End): O

Minimum Leader Length Scaler: Specifies the minimum length, in terms of multiples of the attribute block's height, that the leader must be.
Draw Horizontal Leader Tick: Specifies whether or not to draw a terminating tick (a short horizontal line segment sometimes referred to as a "hook line").
Draw Arrowhead: Specifies whether or not to draw an arrowhead at the end of the leader that points to the point entity.
Minimum Leader for Arrow Scaler: Specifies the minimum length of the leader, in terms of multiples of the attribute block's height, that the leader must be before an arrowhead is placed on it.
Arrow Size Scaler: A scale factor to apply to resize the arrowhead symbol.
Leader Offset Scaler: A distance indicating the desired offset from the point node to the tip of the leader.
Use Separate Leader Layer: Specifies whether or not to use a layer other than that of the identified point for the leader. Use the Select button to choose an alternative layer for the leader.

Select another Point Label to Move (O for Options, R for Restore, Enter to End): R
Select Point Label to Restore: pick label

Pulldown Menu Location: Points
Keyboard Command: movepntleader
Prerequisite: Carlson points
Scale Point Attributes

This command will scale point attribute text (number, elevation and descriptions) and point symbols up or down in size. The routine prompts for a scale multiplier and a selection set of objects. If you want to enlarge, enter a value greater than one. If you want to reduce, enter a decimal fraction such as .5. This would reduce the text size by 50%. This command is very useful if you have set up your drawing for one plotting scale and decide to change to a new plotting scale. This command has the added benefit that it will adjust the point attributes and symbols to a new screen twist angle.

Prompts

Scaling Multiplier <0.500>: 2.5 This response would enlarge the point attributes and symbols by 250 percent.
Scale symbols only, point labels only or both [Symbols/Labels/<Both>]? press Enter
Select points only, point labels only or both [Symbols/Labels/<Both>]? press Enter
Select Carlson Software points, pick a point
Select objects: Specify opposite corner: pick a point
Scaling Carlson Software Point Attributes ....
Number of entities changed> 174

Pull-down Menu Location: Points
Keyboard Command: pntenl
Prerequisite: Carlson points
File Name: \lsp\pntenl.lsp

Erase Point Attributes

This command allows you to erase point attributes like the number, elevation or description individually by picking on the attribute to erase.

Prompts

Select Point No., Elev, or Desc to Erase: select point attribute

Pull-down Menu Location: Points
Keyboard Command: erasepnt
Prerequisite: Carlson points
File Name: \lsp\surv1.lsp

Twist Point Attributes

This command will rotate the orientation of the text of Carlson point attributes (point #, elevation, description) and point symbols. The Twist Screen option aligns the point attributes to appear horizontal in the current twist screen. The Azimuth option allows you to enter an azimuth or pick two points to align the point attributes. The Entity Segment option aligns the point attributes by the selected line or polyline segment in the direction the entity is drawn. The Follow Polyline option aligns the point attributes by the polyline segment that is closest to the point.
Prompts

Twist by [<Twist screen>/Azimuth/Entity segment/Follow polyline]? F
Select reference polylines to follow. pick a polyline
Select objects: 1 found
Select objects:
Select points from screen, group or by point number [<Screen>/Group/Number]? select Enter
Select Carlson Software points.
Select objects: pick the Carlson point inserts

Point attributes aligned by Follow Polyline option of Twist Point

Pulldown Menu Location: Points
Keyboard Command: twistpts
Prerequisite: None
File Name: \lsp\twist.pt.lsp

Resize Point Attributes

This command sets the size of the selected point attributes (point number, elevation, description) and point symbols. This command is similar to Scale Point Attributes, but instead of scaling the size by a factor, all the select points are set to the same specified size. Points can also be chosen based upon Point Groups.

Prompts

Enter point attribute and symbol size <4.0>: press Enter
Scale symbols only, point labels only or both [Symbols/Labels/<Both>]? press Enter
Select points from screen, group or by point number [<Screen>/Group/Number]? press Enter
Select Carlson Software points.
Select objects: pick the point entities
Finding Carlson Software Point Attributes ....
Number of entities changed> 10

Pulldown Menu Location: Points
Keyboard Command: sizepnt
Prerequisite: Carlson points
File Name: \lsp\sizepnt.lsp
**Fix Point Attribute Overlaps**

This command is to be used to adjust point attribute labels to avoid overlapping labels. It applies adjustment methods based upon user-specified ordering and tolerances. The command steps you through any remaining overlaps in an Overlap Manager, which includes the capability to manually move labels. This point overlap feature is also available within the Draw-Locate Point and Field To Finish commands.

![Overlap Manager]

**Methods:** There are different methods of automatically solving a point attribute overlap. The methods will be applied in order from top to bottom on the Used Methods list. Unused methods appear on the Available Methods list. The methods are:

- **Alternate Layout ID 0-9**
  These methods will simply apply the specified attribute layout ID and then check to see if the attributes of the point in question still overlap. The different attribute layout IDs can be seen in the *Point Defaults* command on the Points menu.

- **Flip Individual Attributes**
  This method tests each attribute (point #, description, and elevation) by flipping it or mirroring it the other side of the point. The mirror is the vertical axis of the text that goes through the point entity. This method is not applied to points that have a leader.

- **Slide Individual Attributes**
  This method tests each attribute (point #, description, and elevation) by sliding it back and forth. The maximum distance the attribute will be moved is the horizontal length of the text. This method is not applied to points that have a leader.
Rotate (If Only One Attribute)
This method is applied if there is only one point attribute, either point #, description, or elevation. The one attribute is rotated around the point entity to see if the point overlap can be fixed.

Offset Attribute Block
This method is arguably the most powerful method and can solve any overlap by moving the attribute block far enough. See Offset Options below for a description of the options that can be used with this method.

Offset Options: These are the options that apply to the Offset Attribute Block method of automatically solving point attribute overlaps.
Maximum Offset Scaler: This specifies the maximum distance, in terms of multiples of the whole attribute block's height, that the attribute block may be offset from the point entity.
Use Leader: Specifies whether or not a leader should be drawn when offsetting the attribute block.
Minimum Leader Length Scaler: Specifies the minimum length, in terms of multiples of the height of an attribute's text, that the leader must be.
Draw Arrowhead: Specifies whether or not to draw an arrowhead at the end of the leader that points to the point entity.
Minimum Leader for Arrow Scaler: Specifies the minimum length of the leader, in terms of multiples of the height of an attribute's text, that the leader must be before an arrowhead is placed on it.
Arrow Size Scaler: Specifies a scale factor to be applied to control the size of the arrowhead if drawn.
Leader Offset Scaler: Specifies the length, in terms of multiples of the height of an attribute's text, that the leader arrowhead should be offset from the point.
Use Separate Leader Layer: If enabled, allows the user to define a different layer on which to place the resultant leader.

Use Selection Set for Points: Check this checkbox to be given the option of selecting which points in drawing to fix overlaps with. If not checked, then all the points in the drawing are used.

Avoid Linework Conflicts: Check this checkbox to prevent point attributes from overlapping linework in addition to other point attributes.

Review Remaining Overlaps: Check this checkbox to have the Overlap Reviewer dockable dialog come up after the automated process finishes. The Overlap Reviewer allows for reviewing the automated fixes as well as tools for manually fixing any remaining overlaps. See Overlap Reviewer below for more information.

Skip Resolved Overlaps: Check this checkbox to skip overlaps that were automatically resolved and to only review unresolved overlaps. If not checked, then both resolved overlaps and unresolved overlaps will be available for review. This option only applies if Review Remaining Overlaps is on.

Overlap Reviewer
The Overlap Reviewer will come up after automatic overlap fixing if the Review Remaining Overlaps checkbox was checked. This tool displays how many points were found, how many overlaps were fixed, which overlap is currently being viewed, how many overlaps there were total, and the point # of the current overlap. Use the First, Last, Back, and Next buttons to navigate forwards and backwards through the list of overlaps. Use the Move Block and Move Attrs buttons to manually move either the entire attribute block or individual attributes.
Pan and Zoom Controls: Use the buttons on the top to help zoom in and out and pan the drawing around. You can also use the standard mouse controls for panning and zooming.

First, Last, Back, and Next: These buttons allow you to step through each overlap or to jump to the first or the last.

Status: This drop-down list indicates the status of the current overlap. open means that the overlap has not been fixed yet. resolved means that the overlap has been fixed. ignore can be chosen by you to remove the overlap from the list.

Restore: Restores the attributes of the current point to their original location and rotation from before the Fix Point Attribute Overlaps command was run.

Move Block: Allows you to move one or more attribute blocks in the drawing. See the documentation for Move Point Attributes with Leader command in the Points menu.

Erase Attrs: Allows you to erase selected point attributes.

Move Attrs: Allows you to move and rotate one or more individual attributes in the drawing. See the documentation for Move Point Attributes command in the Points menu.

Auto-Zoom: Check this checkbox to automatically zoom and pan the view as each overlap is viewed.

Prompts

The following prompt will be displayed if the Use Selection Set for Points checkbox is on and OK is pressed. Select the points to fix overlaps with: pick the Carlson point inserts
Trim by Point Symbol

This command will trim lines and polylines that pass through the selected point symbols such that the lines do not appear within the symbol. This should be a last step because this routine explodes the points and modifies the lines and polylines by trimming which makes these entities unusable by some of the other COGO routines.

Prompts

Select Carlson Software point symbols to trim against.
Select objects: select the point symbols

Change Point Layer Color

This command changes the layer and optionally the color of Carlson points. The points are initially put in the layer set in Point Defaults. The symbol, point number, elevation and description are in the layers PNTMARK, PNTNO, PNTELEV, and PNTDESC. To change the point attribute colors, this routine creates new attribute layers based on the new layer name. For example if the new layer name was TRAV, then the resulting layers would be TRAVMARK,
TRAVNO, TRAVELEV and TRAVDESC. These new layers can be given different colors. To select an attribute color, pick on the color button. To permanently change attribute colors, edit the drawing SRVPNO1.DWG in the Carlson SUP directory. To permanently change a symbol color, edit the symbol drawing itself.

The selection of the points to change can be accomplished in three ways. A number range selection would require the input of the range of points to change. An example would be 1-20,25,30,32-36. Points groups can also be used as a selection method. Simply specify the point group name to change, when prompted, and all the points included in that group will be changed. The final selection method is that of Pick Points. Using this method a prompt to select objects is displayed. When prompted select the points to change from the screen.

Pulldown Menu Location: Points
Keyboard Command: pntchg
Prerequisite: Carlson points displayed in the graphic drawing window
File Name: \lsp\pntchg.lsp

Renumber Points
This command will edit the point number attributes of a group of Carlson points. The command prompts for the user to enter the point number difference. Enter the positive or negative amount you would like to have added/subtracted from the current value. After selecting the point to change, a prompt to delete the old point number is displayed. If yes is chosen the old point number is deleted from the CRD file, if no is selected the old and new point numbers are retained in the file. This results in one coordinate position represented by two point numbers.

The following illustrates number changes from point 4, 5 and 6 to 104, 105 and 106. This prompt sequence retains both numbers in the CRD file. If the intent is to renumber and delete the original points 4, 5 and 6, then Yes would be selected when prompted to Delete old point numbers.

Prompts

Positive number increases, negative number decreases Point number.
Point Number difference <1>: 100 This response would add 100 to the current point number value.

Chapter 10. Points Menu 467
Select Carlson Software Points for Point Number change.

Select objects: select a point number or a group of points by window or crossing

Delete old point numbers from file [ <Yes >/No]? Choose correct response. In this example the response was N, leading to the following.

PT#: 6 changed to PT#: 106..
PT#: 5 changed to PT#: 105..
PT#: 4 changed to PT#: 104..
Number of entities changed: 3

Pulldown Menu Location: Points
Keyboard Command: renumpt
Prerequisite: Carlson points
File Name: \sp\renumpnt.lsp

Explode Carlson Points

This command can be useful if you need to send your drawing to another firm who does not have AutoCAD/Carlson. Drawing transfer problems occur when the recipient does not have the same block/inserts defined or available. This command explodes all blocks and replaces the Carlson point attributes with TEXT entities of the same value. After the points have been selected, a prompt for the layer name for each point attribute will be displayed. Point Numbers, Point Elevations and Point Descriptions can be put on user specified layers, or the default for each prompt can be selected. Caution: After using this command, the link between the points and the coordinate file are destroyed and you can no longer extract the attributes from the drawing. If you want to use this command but retain your point information, follow these steps:

1. Save your drawing
2. Run this command to explode the points
3. Execute the SAVEAS command and save the drawing as a different name (you can also choose DXF format if you wish).
4. Exit the drawing without saving.

Prompts

This command will explode selected Carlson Software point blocks and replot the attributes as Text entities! The resulting points will NOT be usable by most Carlson Software commands!!!!

Select Carlson Software Points to Explode. select points
Layer Name for Point Numbers <PNTNO>: press Enter
Layer Name for Point Elevations <PNTELEV>: press Enter
Layer Name for Point Descriptions <PNTDESC>: press Enter
Number of entities changed> 345

Pulldown Menu Location: Points
Keyboard Command: explode_scad
Prerequisite: Carlson points
File Name: \sp\scexp.lsp
Convert Surveyor1 to CRD

This command will convert a Surveyor1 coordinate file to the current Carlson format.

**Pulldown Menu Location:** Points > Convert Point Format

**Keyboard Command:** SURVEYOR2CRD

**Prerequisite:** A Surveyor1 coordinate file

Convert CRD to TDS CR5/Convert TDS CR5 to CRD

These commands convert coordinate file formats between a Carlson CRD file and a TDS CR5 file. Both of these file formats are binary which require these special routines. These commands will prompt for the file names to process.

**Pulldown Menu Location:** Points

**Keyboard Commands:** crd_cr5, cr5_crd

**Prerequisite:** A CRD or CR5 file

**File Name:** \lsp\cogoutil.arx

Convert CRD to Land Desktop MDB

This command converts a Carlson CRD file into an Autodesk Land Development Desktop (LDD) point database file in Access MDB format. The LDD point database always has the file name of POINTS.MDB. So, to specify the LDD file to create, you only need to specify the directory/path and not the file name. This path corresponds to the LDD project directory. The conversion program has point protect, so that if a point number from the CRD file already exists in the LDD file, you then will be prompted to skip or replace the point. Once the command is executed, the following dialog is displayed. On this dialog, specify the Carlson CRD file to convert as well as the LDD (MDB) file to append, if existing, or create if creating a new LDD (MDB) file.

**Pulldown Menu Location:** Points > Convert Point Format

**Keyboard Command:** crd_ldd

**Prerequisite:** A .CRD file

**File Name:** \lsp\gisutil.arx

Convert Land Desktop MDB to Carlson Points

This command converts an Autodesk Land Development Desktop (LDD, also referred to as LDT) point database file into a Carlson CRD file. The LDD point database always has the file name of POINTS.MDB and is stored in
the LDD project directory. Once the command is executed, the following dialog is displayed. On this dialog, specify the LDD file to convert as well as the Carlson CRD file to append, if existing, or create if creating a new CRD file.

![Convert LDD(MDB) Points to Carlson Software CRD File]

Pulldown Menu Location: Points > Convert Point Format
Keyboard Command: LDD_crd
Prerequisite: An LDD point database file
File Name: \lsp\gisutil.arx

Convert Civil 3D to Carlson Points

This command converts Civil 3D point entities into Carlson format point entities. When running in AutoCAD, the Civil 3D Object Enabler from Autodesk is used to read the Civil 3D point entities. This object enabler must be installed before running this routine. The installation for the object enabler is located under Support at www.autodesk.com. When running in IntelliCAD, this routine uses a conversion program from the Open Design Alliance to read the Civil 3D point entities.

Pulldown Menu Location: Points > Convert Point Format
Keyboard Command: c3d_crd
Prerequisite: Civil 3D points in the drawing

Convert Carlson Points to Land Desktop

This command converts a Carlson CRD file into a Land Desktop point file. To do this, you must specify the existing Carlson CRD points to convert. You have the option of selecting all points, or selecting on-screen the specific points you'd like to convert.

Prompts

Convert all or selected points [All/<Selected>]? press Enter
Select Carlson Software Points to convert:
Select objects: pick first point for window selection method
Convert Softdesk to Carlson Points

This command converts Softdesk point blocks in the drawing to Carlson point blocks. These point block formats are similar and converting only requires reordering and renaming the attributes. Softdesk points can also be read into the current CRD file by using the command Update CRD File from Drawing in Coordinate File Utilities, this updates the CRD file without modifying the screen entities.

Pulldown Menu Location: Points > Convert Point Format
Keyboard Command: 2surv
Prerequisite: Softdesk points
File Name: \lsp\2surv.lsp

Convert Carlson Points to C&G

This command converts a Carlson CRD file into a C&G Point file.

Specify the existing Carlson CRD to convert by selecting the Open Carlson CRD File button. Specify the existing C&G CRD file to write to, or the new C&G CRD file to create, by selecting either Open C&G CRD file or Create C&G CRD file. Press OK and the conversion is completed.

Pulldown Menu Location: Points > Convert Point Format
Keyboard Command: crd2cg
Prerequisite: A Carlson CRD file

Convert C&G to Carlson Points

This command converts C&G Points into a Carlson CRD file.
Specify the existing C&G File to convert by selecting the Open C&G CRD File button. Specify the existing Carlson CRD file to write to, or the new Carlson CRD file to create, by selecting either Open Carlson CRD File or Create Carlson CRD File. Press OK and the conversion is completed.

**Pulldown Menu Location:** Points > Convert Point Format  
**Keyboard Command:** cg2crd  
**Prerequisite:** A C&G point file

### Convert Carlson Points to Simplicity

This command will convert Carlson points to Simplicity.

Select Carlson CRD file to convert by selecting the Open CRD file button.  
Specify the existing Simplicity file to write to, or the new Simplicity file to create, by selecting either Open Simplicity File or Create Simplicity File. Press Export and the conversion is completed.

**Pulldown Menu Location:** Points > Convert Point Format  
**Keyboard Command:** crd_zak  
**Prerequisite:** A Simplicity point file
Convert Simplicity to Carlson Points

This command converts Simplicity Points into a Carlson CRD file.

Specify the existing Simplicity File to convert by selecting the Open Simplicity File button. Specify the existing Carlson CRD file to write to, or the new Carlson CRD file to create, by selecting either Open CRD File or Create CRD File. Press OK and the conversion is completed.

Pulldown Menu Location: Points > Convert Point Format

Keyboard Command: zak_crd

Prerequisite: A Simplicity point file

Convert Leica to Carlson Points

This command converts LisCad or Leica point blocks in the drawing to Carlson point blocks. These point block formats are similar and converting only requires reordering and renaming the attributes. Leica points can also be read into the current CRD file by using the command Update CRD File from Drawing in Coordinate File Utilities. This updates the CRD file without modifying the screen entities.

Pulldown Menu Location: Points > Convert Point Format

Keyboard Command: 2surv3

Prerequisite: Leica points

Convert Geodimeter to Carlson Points

This command converts Geodimeter point blocks in the drawing to Carlson point blocks. These point block formats are similar, and converting only requires reordering and renaming the attributes. Geodimeter points can also be read into the current CRD file by using the command Update CRD File from Drawing in Coordinate File Utilities. This updates the CRD file without modifying the screen entities.

Pulldown Menu Location: Points > Convert Point Format

Keyboard Command: 2surv4

Prerequisite: Geodimeter points
Convert Carlson Points to Ashtech GIS

This command converts Carlson point blocks in the drawing to Ashtech GIS point blocks. After executing the command, you will be prompted to select the points to convert. When using this command, the setting "Group Point Entities", found under General Settings of the Configure command (Settings menu) should be unchecked (turned off).

**Pulldown Menu Location:** Points > Convert Point Format

**Keyboard Command:** 2ashtech

**Prerequisite:** Carlson Points

Convert Carlson Points to Softdesk

This command converts Carlson point blocks in the drawing to Softdesk point blocks. These point block formats are similar, and converting only requires reordering and renaming the attributes.

**Pulldown Menu Location:** Points > Convert Point Format

**Keyboard Command:** 2soft

**Prerequisite:** Carlson points

**File Name:** \lsp\2soft.lsp

Convert PacSoft CRD to Carlson CRD

This command converts a PacSoft CRD file to a Carlson CRD file. PacSoft stores the point descriptions to a separate coordinate descriptor file having an extension of PTD. This file should be present in the same directory as the CRD file to convert. Prompts for the PacSoft CRD file to convert, and the Carlson CRD file to create, will be displayed. Once both files have been specified, the following dialog box will be displayed.

The **No Coordinate Conversion** option converts the file format while leaving the coordinate values unchanged.

**Convert From Meters to Feet** will assume the coordinates in the selected PacSoft crd file are metric, and will convert the coordinate values to US Feet.

**Pulldown Menu Location:** Points > Convert Point Format

**Keyboard Command:** pacsoft2crd

**Prerequisite:** PacSoft crd file
Convert Carlson Points to Eagle Point

This command converts Carlson point blocks in the drawing to Eagle Point point blocks. A prompt for the Eagle Point version to convert to will be displayed.

Specify the appropriate version and then select the OK button. You will then be prompted to select the Carlson points to convert. These point block formats are similar, and converting only requires reordering and renaming the attributes.

**Pulldown Menu Location:** Points > Convert Point Format  
**Keyboard Command:** 2eds  
**Prerequisite:** Carlson points

Convert Eagle Point to Carlson Points

This command converts Eagle Point point blocks in the drawing to Carlson point blocks. These point block formats are similar, and converting only requires reordering and renaming the attributes. Eagle Point points can also be read into the current CRD file by using the command *Update CRD File from Drawing*, found in *Coordinate File Utilities*. This updates the CRD file without modifying the screen entities.

**Pulldown Menu Location:** Points > Convert Point Format  
**Keyboard Command:** 2surv2  
**Prerequisite:** Eagle Point points  
**File Name:** \lsp\2surv2.lsp
This chapter provides information on using the commands from the Survey pulldown menu, in order to download data from data collectors, process raw data and prepare plats. The first sections of the pulldown provide information on working with data collectors, editing and processing raw data and drawing Field to Finish. Carlson SurvNET is Carlson's Network Least Squares Reduction (NLSA) program. Below that there are complex deed creation and linework commands. The bottom portion of this menu provides features for creating cut sheets, polyline data and other survey important requirements.
**Data Collectors**

This command does two main functions for a variety of popular data collectors. First, this command transfers (uploads and downloads) data between the data collector and Carlson. Second, this command converts data formats between the data collector format and the Carlson format. So, if you already have the data file on the computer, you can skip the transfer function and just perform the conversion function.

The transfer function does the conversion at the same time. In most cases, the download from the data collector produces a raw (.RW5) file (field notes) and/or a coordinate (.CRD) file (coordinate points). Several of the download programs have an option to automatically run the *Edit-Process Raw Data File* command after downloading raw data. You can also send, or upload, a coordinate (.CRD) file. The dialog shown here appears when the menu command is selected.

---

**Carlson SurvCE:** For Carlson Software data collection programs SurvCE and SurvStar. This button produces the SurvCOM dialog and program.

**CG Field:** For CG Field programs.

**Magellan/Thales FastSurvey:** For Magellan and Thales FastSurvey data collectors.

**Surveyors Assistant:** For data collectors running Surveyors Assistant software (Corvallis MC2, MC5 and Pentax SC5).

**Sokkia SDR:** For SDR2 through SDR 33 and other collectors that have a SDR format like the Trimble.

**Sokkia G2:** Specifically for the SDR2.

**TDS:** For data collectors that use TDS software (Ranger, HP48, HP95, Husky FS-2 & FS-3, Corvallis MC-V and TOPCON FS2, FC95 and FC48).

**SMI:** For SMI data collectors on the HP48.

**Leica:** For Leica GIF-10 module and Leica instruments.

**Nikon:** For Nikon DTM and DR-48 total stations.

**Geodimeter:** For the Geodimeter Geodat collector.

**Topcon 210/310/220/GPT2000:** Supports these Topcon models.

**MDL Laser:** For MDL Laser instruments.

**General Kermit Transfer:** For general transferring using Kermit.

---

**Carlson SurvCE**
Note: In the following text, the term SurvCE will apply to SurvCE, SurvStar, and Sokkia G2

Connect the serial cable. Select Data Transfer from the on the handheld. Choose Carlson/Carlson Survey Download. This leads to a File Transfer screen on SurvCE, which says "Awaiting Connection". All the action is on the PC side. There is no time delay in this handshake. It will wait for the PC program to catch up. When you connect the cable from SurvCE to the PC, Microsoft ActiveSync may interfere and say "Connect to PC?" If you get this question, say No or otherwise terminate the Microsoft ActiveSync linkage. Start the Carlson portion of this link by choosing Survey, Data Collectors, then the SurvCE option. If connection is automatically established, SurvCE will display, "Connected to PC".

If only the left side of the screen displays data, then you do not yet have a connection. Press the Connect button located at the bottom left of the file transfer dialog. The transfer program will respond with Retrieving File List. Once the file list has been retrieved, the left side of the dialog box will show files located in the specified path on the PC and the right side of the dialog displays the files located in the designated path on the remote. You can change directories by scrolling to the top of the file list and choosing Up One Level (just like in Windows).

To transfer one or more files, simply select or highlight the desired files and select the transfer button. More than one file can be transferred from the remote to the PC or from the PC to the remote during the transfer process. Standard Windows selection options apply. For example, selecting one file and then while pressing the shift key on the PC, selecting another file deeper on the list will select all the files in between the first and last selected. You can also select the first file to transfer and press and hold down the shift key and use the down arrow to specify the range of files to transfer. Pressing and holding the control key on the keyboard allows for the selection of multiple files in any selection order, by picking the files with the left mouse button.

After the files have been selected, press the transfer button. When the transfer is complete, the program will return a "Transfer Complete" message, and will then proceed to update the file lists on the PC and the Remote.
**Connect:** After selecting Data Transfer in SurvCE, press this button to start the connection. Once connection is made, the status line on the file transfer utility dialog box will show Connected to the remote machine.

**Transfer:** Pressing this button transfers selected files from either the Remote to the PC, or the PC to the Remote.

**Set Path:** This option allows for the specification of the desired source and destination drives and folders for both the PC and the Remote device. For example, if you were downloading, or copying files from the Remote device to the PC, to specify a source path on the remote device, select the Remote Machine toggle and then type in the desired path in the path field. To specify a destination path on the PC, select the Local PC toggle and type in the desired path the path field. When a change to either path is made, the transfer utility will retrieve a new file list from the specified paths.

![Set Path](image1)

**Make dir:** This option allows for creation of directories on both the PC and the Remote device. Specify the hardware on which to create the directory and then enter the directory name.

![Make dir](image2)

**Delete:** This option allows you to delete the tagged files. To delete a file, select the file to delete by clicking on the file, press the delete button at the bottom of the dialog. Confirm deletion by selecting the appropriate response on the Delete File dialog.

![Delete](image3)
Rename: To rename a file, click on the file to rename and select the rename button at the button of the dialog. On the dialog that displays type in the new name and press the OK button.

Options: This command allows you to set various options for data transfer. The dialog shown below will appear.

Com Port: You must select which com port on the PC to use.

If you are transferring data via a USB port, set the com port to ActiveSync, see the Options section below for procedures to change com ports. To transfer data using an USB port a connection between the Remote and PC using ActiveSync is required. In ActiveSync verify that the "Connect Settings" have been set to "Allow serial cable or infrared connection to this Com port" and Allow USB connection with this desktop computer. This will allow for connection using an USB port or a COM port connection. Both will use ActiveSync to transfer data between devices.
File Mask: You must select a file filtering syntax. This filter allows for the setting of specific file types to display. For example if you only wanted to see CRD files the filter would be *.CRD.

Directory Sort: You must select how to sort the list of files.

Display Special Files: Toggle whether or not you should see special files.

Confirm Overwrite: Check this to confirm before overwriting files.

Baud Rate: You must choose the baud rate for transferring data.

Protect Remote Files: Check this to protect files on the mobile device.

Archive RW5 Files: With this option set to YES, when downloading rw5 files, a second copy of the file will be made with a .SC5 extension to serve as an archive of the original rw5 file.

Geoid: This command will carve out a portion of the Geoid 99, EGM96, Canadian CGC2000, Canadian HT2.0, Canadian HT 1.01, Australian GDA94, Great Britain OSG-MO2 and Geoid 2003 grid files, and send it to SurvCE. Since these geoid grids are very large, this carves out a precise portion of it and avoids overloading the memory on the remote device running SurvCE. You will be prompted for the directory on the PC of the source Geoid grid file,
the approximate latitude and longitude of the job, and the size of the area desired in miles, kilometers or degrees of latitude and longitude. To define a Geoid area, make sure that this criteria is met:

1. Specify the location of the geoid grid files.
2. Specify the geoid type.
3. Enter the latitude and longitude near the center of the job area.
4. Specify the Grid size either in miles, km (kilometers), or deg (degrees).
5. Name the grid file.

The file will be transferred to the data collector and placed in the appropriate place for use.

**F2F conv:** This converts the more thorough and detailed Carlson field code file (for field-to-finish work, *.FLD) to the more simplified Feature Code List that runs in SurvCE (*.FCL). The Feature Code List in SurvCE (not SurvStar or Field) handles Linework (on or off), Line Type (2D or 3D), Layer (= Code) and Full Text (Description). Select the Carlson field code (*.FLD) to convert, the conversion takes place and the file is transferred and located in the correct location for use in the data collector.
**Send Pnts:** This option allows for the uploading of a user specified point number range out of the selected crd file to unload. Use the Select button to specify the crd file to upload. The Remote File Name will default to the name of the crd file selected to upload. You can change this name if needed. Specify the Point Range to Send and select the OK button.

![Send Range of Points dialog box](image)

**Exit:** This command will exit the File Transfer Utility

The following information describes the buttons on the Data Collection Programs dialog box that come after the Carlson SurvCE button, moving from left to right and then from top to bottom. The command/button name is on the far left margin, in bold:

**CG Field**

To transfer data to and from data collectors using CGField software, first make sure that the Baud Rate is set to 9600 and the Parity is set to NONE then follow the steps outlined below.

**Receiving a Coordinate File from CGField**

CGField:

1) Go to the UTILS menu and select Option 1, C&G Transfer.
2) Select Option 4, "Send Coords"
3) Select the Coordinate file to send.
Stop here in CGField and go to Carlson.

Carlson:

Leave the FILE fields blank.
Press the "Download Coordinates" button to ready Carlson to receive the file.
Stop here in Carlson and go back to CGField to complete the transfer process.

CGField:

Select the points to send
1) For All points
2) To select Blocks of points.
3) From .PTS file (the set of points in a Batch Point File).

The coordinates will be transferred. After the transfer is complete, you will be asked for the CRD file name. The C&G CRD file will automatically be converted to a Carlson CRD file. With Point Protect on, the routine will check the coordinate file for existing point data before downloading the point from the data collector.

**Receiving a Raw Data File from CGField**

**CGField:**

1) Go to the UTILS menu and select Option 1, C&G Transfer.
2) Select Option 2, "Send Raw Data". Stop here in CGField and go to Carlson.

**Carlson:**

Leave the FILE fields blank.

Press the "Download Raw" button to ready Carlson to receive the file. Stop here in Carlson and go back to CGField.

**CGField:**

Select the raw data file to be sent. The transfer will begin.

The C&G .RAW file will be transferred and saved in the data folder. After the transfer is complete, you will be asked for the RW5 file name. The RAW file will be automatically converted to a Carlson RW5 file.

**Receiving an ASCII file from CGField**

This will allow you to transfer a C&G report file (RPT) or an ASCII NEZ file to Carlson.
CGField:
1) Go to the UTILS menu and select Option 1, C&G Transfer.
2) Select Option 6, "Send ASCII". Stop here in CGField and go to Carlson.

Carlson:
Leave the FILE fields blank.
Press the "Download ASCII" button to ready Carlson to receive the file. Stop here in Carlson and go back to CGField.

CGField:
Select the ASCII file to send.
After the transfer is complete, you will see the file in the Carlson editor. You can then select FILE and SAVE (or SAVEAS) to save the ASCII file.

**Sending a Coordinate File to CGField**

CGField:
1) Go to the UTILS menu and select Option 1, C&G Transfer.
2) Select Option 3, "Receive Coords" to ready the data collector. Stop here in CGField and go to Carlson.

Carlson:
Leave the FILE fields blank.
1) Press the "Upload (Send Carlson File)" button.
2) Select the Coordinate file.
3) Select the points to send.
4) Press the "Start Transfer" button.

CGField:
Carlson will send the file name to CGField and a coordinate file with the same name will be automatically created or opened in CGField.
If the file exists you will be asked how you want to handle duplicate points:
1) Overwrite
2) Don't Overwrite
3) Ask for each Point
The point transfer will begin.

**Convert CG .RAW to Carlson .RW5**

This utility allows you to convert a C&G raw data file to a Carlson raw data file. Select the C&G .RAW file to convert. Then enter the file name of the destination Carlson RW5 file.

**Thales/FastSurvey** You will be taken directly to the SurvCOM dialog, similar to the Carlson SurvCE process.

**Surveyor's Assistant**

**Download**
From the Surveyor's Assistant data collector, go to the Transfer routine from the main menu. Fill out the transfer screen as follows:
You should also check the settings under the PORT menu. Typical port settings are baud=9600, parity=none, data=8, stop=1 and handshake=XON/XOFF. Now in Carlson, run Data Collection in the Survey menu and choose Surveyor's Assistant. Check that the COM port and baud rate are set correctly. Then click the Download button and within 10 seconds go back to Surveyor's Assistant and press GO. The file transfer should now go. If the All Data option is used, then the Leitz format will contain both coordinate and raw data. The coordinate data is converted to a Carlson coordinate (.CRD) file and the raw data is converted to a Carlson raw data (.RW5) file. When the transfer is complete, the program will ask you for the Carlson coordinate (.CRD) file to create if you haven't already specified a file name in the dialog. With Point Protect on, the routine will check the coordinate file for existing point data before downloading the point from the data collector.

Upload
Point data from the Carlson coordinate (.CRD) file can be uploaded into the Surveyor's Assistant. First go to the Transfer routine on the main menu. Fill out the screen as follows:

Direction: INPUT
Format: LEITZ
Port: COM1 or COM2
Protocol: NONE

Go back to Carlson and choose Surveyor's Assistant from the Data Collection command in the Survey menu. Check that the COM port and baud rate are set correctly. In the Carlson dialog, pick the Select File button next to the Carlson coordinate (.CRD) File edit box and choose the coordinate (.CRD) file to send. Then click the Upload button. A dialog now allows you to specify the range of point numbers to upload. Before clicking the OK button for range of points, go to the Surveyor's Assistant and hit the GO function key. The Surveyor's Assistant is now waiting to receive so return to Carlson and click OK on the range of point dialog. The file transfer should now go.
Sokkia SDR

This routine applies to the Sokkia SDR-20, SDR-22, SDR-31 and SDR-33 as well as other collectors that have SDR format transfer such as the Trimble and C & G.

Download
From the SDR data collector, go to the Communications routine from the main menu. Choose Data Format SDR. Next hit the Send function key. Then choose Select Jobs. From the list of jobs, highlight the job to transfer and set it to Yes with the arrow keys. Now in Carlson, run Data Collection in the Survey menu and choose Sokkia/SDR. Check that the COM port and baud rate are set correctly. Then click the Download button and within 10 seconds go back to SDR and press OK. The file transfer should now go. The SDR format contains both coordinate and raw data. The coordinate data is converted to a Carlson coordinate (.CRD) file and the raw data is converted to a Carlson raw data (.RW5) file. The original SDR transfer file is stored on the computer as a RAW file. When the transfer is complete, the program will ask you for the Carlson coordinate (.CRD) file to create if you haven't already specified a file name in the dialog. With Point Protect on, the routine will check the coordinate file for existing point data before downloading the point from the data collector.

The SDR-33 has different modes for storing and transferring data. In coordinate mode, the download will create points in the coordinate (.CRD) file and the raw data (.RW5) file will only contain some basic header lines. In the raw data mode, the download will create all the measurement data in the raw file and no points will be created in the coordinate (.CRD) file. For this raw data mode, you will need to run Edit-Process Raw Data File in the Survey menu to calculate the points from the raw data. The third mode in the SDR-33 creates both raw data in the raw data (.RW5) file and points in the coordinate (.CRD) file. The Include Time Stamps in Notes option sets whether all the date-time records for each point are put in the raw data (.RW5) file as description records. The Include Point Attributes in Notes option will store SDR code 13(AT) codes to the point note (.NOT) for the coordinate (.CRD) file.

Chapter 11. Survey Menu
Upload
Point data from the Carlson coordinate (.CRD) file can be uploaded into the SDR. First go to the Communications routine on the SDR main menu. Choose Data Format SDR. Go back to Carlson and choose Sokkia/SDR from the Data Collection command in the Survey menu. Check that the COM port and baud rate are set correctly. In the Carlson dialog, pick the Select File button next to the Carlson CRD File edit box and choose the coordinate (.CRD) file to send. Then click the Upload button. Then a Sokkia Options dialog appears for setting the job parameters for the file to be created on the collector. Be sure to choose the Distance Unit that matches your coordinate (.CRD) file (meters, US feet or international feet). Click OK and the next dialog now allows you to specify the range of point numbers to upload. Before clicking the Start Transfer button for range of points, go to the SDR and hit the Receive function key. The SDR is now waiting to receive so return to Carlson and click Start Transfer on the range of point dialog. The file transfer should now go.

Communication Settings
Besides matching the baud rate between Carlson and the collector, make sure that the collector is set to word length of 8 and 1 stop bit under the communication settings.

Print File
The Receive Sokkia Print File downloads a print report from the SDR33 data collector. This file is only used for printing report purposes in Carlson. This file is not used by Carlson to generate coordinate (.CRD) files or raw files. The first step is to choose Data format=Printed in the Communications menu of the SDR33. Next pick the Receive Print File button in Carlson. Then on the SDR33 choose the Send function and select a job to send. At this point the file is transferred. After downloading, the job report is displayed in the Carlson standard report viewer.

Example of Sokkia Printed Format:

SDR33 V04-04.25 (C) Copyright 1998 Sokkia May-29-80 23:39 01/29/1999
Angle Degrees     Dist Feet
Sokkia G2 This routine takes you directly to the SurvCOM dialog, similar to the Carlson SurvCE process.

**TDS**

**Download [HP-48 and Husky]**
In the TDS program, go to the File Transfer routine. Choose the type of data to transfer (CRD or RAW). Next pick the Send function key. Stop here on the TDS and go to Carlson to run *Data Collection* in the Survey menu and pick TDS. Make sure that the COM port and baud rate are set correctly. Then pick the Download button. The Carlson program will now wait to receive the TDS file. Within 10 seconds select the file to send on the TDS. The file should be transferred now. When the transfer is complete, the program will ask you for the Carlson file to create if you haven't already specified a file name in the dialog. With Point Protect on, the routine will check the coordinate file for existing point data before downloading the point from the data collector.

**Download [Ranger and Windows CE]**
In the TDS program, go to the Transfer routine and pick the Send File function. Set the "Connecting To" field to HP-48. Make sure that the COM port, baud rate and parity are set correctly and then pick OK. In the Type field of the file selection dialog, choose Coordinate Files or Raw Files. Stop here on the TDS and go to Carlson to run *Data Collection* in the Survey menu and pick TDS. Make sure that the COM port and baud rate are set correctly. Then pick the Download button. The Carlson program will now wait to receive the TDS file. Within 10 seconds select the file to send on the TDS and pick OK in the TDS dialog. The file should be transferred now. When the transfer is complete, the program will ask you for the Carlson file to create if you haven't already specified a file name in the dialog. With Point Protect on, the routine will check the coordinate file for existing point data before downloading the point from the data collector.
Upload [HP-48 and Husky]
A Carlson coordinate (.CRD) file can be converted to a CR5 file and uploaded into TDS. Start in the TDS program, by going to the File Transfer routine. Then move back to Carlson and run Data Collection in the Survey menu and pick TDS. In the Carlson dialog, enter a TDS File name. This name should not include the drive and directory path or file extension. For example, if the coordinate (.CRD) file is c:\scadxml\data\simo2.crd then the TDS File name could be just SIMO2. Next pick the Select File button next to the Carlson coordinate (.CRD) File edit box and choose the coordinate (.CRD) file to send. Check that the COM port and baud rate are set correctly. Now pick the Carlson Upload button. A dialog now allows you to specify the range of point numbers to upload. Enter the range of points but before clicking the Start Transfer button go to TDS and hit the Receive function key. Within 10 seconds go back and click the OK button on the range of points. The file should then transfer.

Upload [Ranger and Windows CE]
A Carlson coordinate (.CRD) file can be converted to a CR5 file and uploaded into TDS. Start in the TDS program, by going to the Transfer routine and pick the Receive File function. Set the "Connecting To" field to HP-48. Make sure that the COM port, baud rate and parity are set correctly and then pick OK. Then move back to Carlson and run Data Collection in the Survey menu and pick TDS. In the Carlson dialog, enter a TDS File name. This name should not include the drive and directory path or file extension. For example, if the coordinate (.CRD) file is c:\scadxml\data\simo2.crd then the TDS File name could be just SIMO2. Next pick the Select File button next to the Carlson coordinate (.CRD) file edit box and choose the coordinate (.CRD) file to send. Check that the COM port and baud rate are set correctly. Now pick the Carlson Upload button. A dialog now allows you to specify the range of point numbers to upload. Enter the range of points and click the Start Transfer button.

SMI
Download
To send point data from the SMI data collector, go to the file transfer routine by typing [More] [NXT] [TOPC] [COMM]. In SMI version 6 or later, type [Job][KERM][SEND]. Also in version 6, make sure that the first function key reads [NE] and not [XY] in the [Job][KERM] screen. Otherwise the coordinate northing and easting will be reversed. The [NE] stands for North-East coordinate order which is the format that Carlson expects.
In the [Job][KERM] screen, make sure that the second function key reads [COMM] and not [SPACE]. The [COMM] stands for comma separators. Then enter the first point to send followed by the last point to send but before pressing Enter for the last point go to Carlson. Run Data Collection in the Survey menu and choose SMI. Check that the COM port and baud rate are set correctly. Then click the Download button and within 10 seconds go back to SMI and press Enter for the last point to send. The file transfer should now go. When the transfer is complete, the program will ask you for the Carlson coordinate (.CRD) file to create if you haven’t already specified a file name in the dialog. With Point Protect on, the routine will check the coordinate file for existing point data before downloading the point from the data collector. To send raw data, use the [Print][Raw] routine in SMI along with the same Carlson procedure used for point data.

**Upload**

From the SMI data collector, go to the file transfer routine by typing [More] [NXT] [TO48] [COMM]. In SMI version 6 or later, type [Job][KERM][RECV]. Also in version 6, make sure that first function key reads [NE] and not [XY] in the [Job][KERM] screen. Otherwise the coordinate northing and easting will be reversed. Then enter the first point to send followed by the last point to send. Next enter the job name but before pressing Enter go to Carlson and run SMI under Data Collection in the Survey menu. In the Carlson dialog, specify the same job name as entered in SMI. Next pick the Select File button next to the Carlson CRD File edit box and choose the coordinate (.CRD) file to send. Check that the COM port and baud rate are set correctly. Then click the Upload button. A dialog now allows you to specify the range of point numbers to upload. Enter the same range of points as entered on the SMI. Go back to SMI and hit Enter for job name followed by clicking the OK button for range of points in Carlson. The file transfer should now go.

**Leica**

There are two types of Leica transfers: GIF-10 and GeoCom for all other Leica instruments. The type is set in the Equipment Type field on the main dialog. For transferring with the Leica instruments, the GeoCom program shows a dialog of the available COM ports on your computer. On the first time that you transfer to an instrument, you will
need to pick the Instruments button and register the instrument from the list. Pick the Port Settings button to make sure that the communication settings match the instrument.

To download a file with GeoCom, make sure that the instrument is ON and connected to the computer by serial cable. The instrument also needs to be in GeoCom mode. Then pick the Download in the Carlson dialog. In the GeoCom program, open the computer COM port that the instrument is connected to by picking the ‘+’. Then open the Memory Card and GSI folders. Next select the file to transfer and click the OK button. With Point Protect on, the routine will check the coordinate file for existing point data before downloading the point from the data collector.

To upload a file with GeoCom, specify the file name to be created on the instrument in the Leica File field and pick the Upload button in the Carlson dialog. Then the program will prompt for the range of points to transfer. Fill out the range and pick the Start Transfer button. Then the GeoCom program will start. Open the computer COM port by picking the ‘+’. Then open the Memory Card folder and highlight the GSI folder and click OK.

The upload and download file transfer works with the GIF-10 data collector. The GIF-10 communication settings should be the following:

Baud: 9600
Parity: NONE
Protocol: NONE
Stop Bit: 1
End Mark: CR/LF
Connected As: Some computers use DCE and others use DTE
Download
From the GIF-10, go to the file transfer routine. Then go to Carlson and run *Data Collection* in the Survey menu and choose Leica. Check that the COM port and baud rate are set correctly. Then click the Download button and within 10 seconds go back to GIF-10 and select the file to send. The file transfer should now go. When the transfer is complete, the program will ask you for the Carlson coordinate (.CRD) file to create if you haven’t already specified a file name in the dialog. With Point Protect on, the routine will check the coordinate file for existing point data before downloading the point from the data collector.

Upload
From the GIF-10 data collector, go to the file transfer routine. Then go to Carlson and run Leica under *Data Collection* in the Survey menu. In the Carlson dialog, specify the job name in the Leica File field. Next pick the Select File button next to the Carlson coordinate (.CRD) File edit box and choose the coordinate (.CRD) file to send. Check that the COM port and baud rate are set correctly. Then click the Upload button. A dialog now allows you to specify the range of point numbers to upload. Before clicking the OK button for range of points, go to GIF-10 and start the receive by highlighting Receive and pressing the Run button. The GIF-10 now shows the available job numbers. Choose a job to receive the transfer using the arrow buttons and then press the Run button.

Converting
Carlson supports raw and coordinate data collected using three different Leica Operation Codes: Wildsoft and 10-20-30-40 as well as the newer LISCAD. Moreover, data could be in the GSI8 format or the newer GSI16 format. Some example files are shown here.

**GSI8 format data file using LISCAD Operation codes:**
WILD GIF-12
410149+00000001 42....+00005003 43....+00005.42 44....+00005.25 45....+00005000
110150+00005000 21.324+35959480 22.324+09238590 31..01+0028271

---

Chapter 11. Survey Menu
Leica raw files usually have a .RAW or .GSI extension. The primary difference in the GSI8 and GSI16 formats is that information is contained in data blocks of 16 characters in the GSI16 format, while it is contained in blocks of 8 characters in the GSI8 format. Leica instruments make it possible to have both the GSI8 as well as GSI16 data formats in the same raw file. However, lines with the GSI16 format data will always start with an asterisk (*) character, to distinguish them from the GSI8 format. There is no distinction between Leica raw files collected in the Wildsoft and LISCAD operation codes.

Supported Wildsoft codes:
1: Start Job
11: Assign Coords
12: Coord Offset
13: Target Height
14: Add to Tgt Ht
15: Add to Meas Dist
2: Occupy Point
Supported LISCAD codes:
1: New instrument setup
2: New target height
3: Sets of directions
4: Fixed azimuth
5: Feature code
6: Measured offset
8: Line creation for sub-codes 1 (straight string), 2 (curved string) and 6 (arc by 3 points)
9: Fixed coordinates
11: Close string
14: Additional description
20: Start of job
27: Feature code
90: Split feature code
100+: Descriptions

The Convert button can be used to convert any Leica format file into a Carlson format file. For example, if you have a Leica PCMCIA card then there is no serial cable transfer to do. Instead use the Convert routine to make the Carlson raw data (.RW5) and coordinate (.CRD) files. Since there is no distinction between Wildsoft and LISCAD files, the user must know in advance which format has been used in the file. Then, select that particular option (Wildsoft, 10-20-30-40 or LISCAD) under the "Coding System" option at the bottom of the dialog box, as shown in the previous page. Another option that the user needs to choose is the order in which foresight-backsight readings have been recorded in the raw file, BFFB or BFBF, as explained in the dialog box. Then, the user can simply pick the "Convert" button and the program prompts for the input" Wild/Leica File" (raw file), and the output" Carlson RW5 file" and "Carlson CRD file", if they are not already filled.

Nikon

Download
First choose the equipment and data type under the Transfer Type list. Also check that the communication and data format settings match your collector. Then click the Download button and follow the on-screen directions. When the transfer is complete, the program will ask you for the Carlson coordinate file (.CRD) and raw file (.RW5) to create if you haven't already specified a file name in the dialog. With Point Protect on, the routine will check the
coordinate file for existing point data before downloading the point from the data collector. The original data from the collector is stored in a file name with the same name as the coordinate file except with a .TRN extension. For example, job5.crd would have job5.trn.

**Upload**

Pick the Select File button next to the Carlson CRD File edit box and choose the CRD file to send. Check that the COM port and baud rate are set correctly and then click the Upload button. A dialog now allows you to specify the range of point numbers to upload. Set the points and then click the Start Transfer button. The file transfer should now go.

**Convert Nikon to Carlson**

The Convert button will translate the Nikon raw file format (.TRN or .RAW) into Carlson coordinate (.CRD) and raw (.RW5) files.

**Portion of typical Nikon file format:**

```plaintext
MP,1,,5000.0000,5000.0000,0.0000,T/1
ST,1,,2,,0.0000,0.00000,0.00000
SS,3,0.0000,152.1510,359.59590,90.44100,11:43:38,T/2
SS,4,0.0000,127.5560,0.06040,90.40110,11:44:45,CON
SS,5,0.0000,97.1820,2.19580,90.52460,11:45:43,CON
```

**Geodimeter**

**Download**

From the Geodimeter data collector, go to the file transfer routine by pressing the PRG (Program) key and entering
program 54. Then choose Imem (option 1) as the source. Next choose the file type to send as either Job (measurement data) or Area (point data). The Geodimeter will then prompt for the job name. Next enter Serial (option 3) as the destination. A confirmation screen appears showing the serial port settings. Here are some typical settings:

COM=1,8,0,9600

Before pressing enter (ENT key), go to Carlson and run *Data Collection* in the Survey menu and choose *Geodimeter*. Then click the Download button and within 15 seconds, go back to the Geodimeter and press Enter. The file transfer should now go. When the transfer is complete, the program will ask you for the Carlson coordinate file and raw file to create if you haven't already specified a file name in the dialog. With Point Protect on, the routine will check the coordinate file for existing point data before downloading the point from the data collector.

**Upload**

In Carlson, run Geodimeter under *Data Collection* in the Survey menu. Pick the Select File button next to the Carlson CRD File edit box and choose the CRD file to send. Check that the COM port and baud rate are set correctly and then click the Upload button. A dialog now allows you to specify the range of point numbers to upload. Enter the points to send but before clicking OK, go to the Geodimeter data collector. Start the file transfer routine by pressing the PRG key and entering program 54. Then choose Serial (option 3) as the source. The Geodimeter will display the serial port settings. Check these values and press enter. Next choose Area (option 2) as the destination. Then enter the job name. The Geodimeter is now listening for data. Quickly go back to Carlson and click OK on the points to send dialog. The file transfer should now go.

**Convert**

The Convert button will translate the Geodimeter raw file format (.OBS) into Carlson coordinate (.CRD) and raw (.RW5) files.

**Communication Settings**

If the Geodimeter is not communicating with Carlson, run function 79 on the Geodimeter and make sure that it is
set to 4. This setting is for the transfer message end of sequence format.

**Supported Geodimeter Codes**
The following Geodimeter codes are processed when converting the Geodimeter raw file. All other codes are recorded as descriptions in the Carlson rw5 file.

0=Info
1=Data
2=Station No
3=Instrument Height
4=Point Code
5=Point Number
6=Signal Height
7=Horizontal Angle
8=Vertical Angle
9=Slope Distance
11=Horizontal Distance
17=Horizontal Angle
18=Vertical Angle
21=Horizontal Reference Angle
30=Atmospheric Correction
37=Northing
38=Easting
39=Elevation
40=Delta North
41=Delta East
42=Delta Elevation
45=Correction To Bearing
46=Standard Deviation
50=Job Number
51=Date
52=Time
53=Operator
54=Project Id
55=Instrument Id
56=Temperature
60=Shot Id
61=Activity Code
62=Reference Object
70=Entered Radial Offset
71=Entered Angle Offset
72=Calculated Radial Offset
73=Calculated Angle Offset
74=Air Pressure

**Portion of typical Geodimeter file format**
5=108
4=13POC
6=5.000
7=238.0708
8=89.2236
9=440.39
37=767.42
38=4626.07
39=699.795

**Topcon 210/310/220/GPT2000**

This command supports these above Topcon models.

---

**MDL Laser**

The MDL Laser outputs a raw file of angles, distances and codes as one long string of data which can be converted into a Carlson raw data (.RW5) file. There is no coordinate data in the MDL raw file. So you need to run *Edit-Process Raw File* to calculate coordinates from the raw data. The Download button will transfer the MDL raw data from a BDI logger.
Kermit

Kermit can be also used for transferring files with accuracy. The dialog looks like this:

**Pulldown Menu Location:** Survey

**Keyboard Command:** datacolt

**Prerequisite:** None

**File Name:** \lsp\cogoutil.arx
**Edit-Process Raw Data File**

This program reads or creates a raw data (.RW5) file that contains various lines of data (records) that could be likened to a surveyor's field book. You can specify point coordinates, job information, notes, and the angles and distances that make up traverse or sideshots records. Once the raw data is created or read it can be processed/reduced to coordinates that are stored in the current coordinate (.crd; .cgc; .mdb; .zak) file.

The raw file can also be created or appended using the *Locate Point, Traverse, Sideshot, and Inverse* commands on the COGO menu. To store the data inputs from these commands into a raw file, first toggle on the *Raw File ON/OFF* command on the COGO menu. It is possible to always have the raw data file open to store data inputs. To enable this option, choose Configure from the Settings menu, then choose Survey Module, then choose General Settings. Turn on the Automatic Raw File toggle in this dialog.

The raw files created by TDS data collector programs are also compatible without conversion. The command *Data Collectors* on the Tools menu has options for reading other data collectors native file formats and converting them to raw data (.RW5) format. Within the raw data editor, the File menu includes an import menu for converting raw data from other formats.

When you select the *Edit-Process Raw Data File* command you are prompted to specify the name of the raw data (.RW5) file. The current coordinate file is used automatically. To change the current coordinate file, use the Set Coordinate File command in the Points menu before starting this command. If no coordinate file is current, the program will prompt you to set the current coordinate (.CRD) file.

*Edit-Process Raw Data File* uses a spreadsheet for editing the raw data as shown. Each row of the spreadsheet is represented by a number located at the far left side of the editor. Various messages and reports often reference possible problems with the data by this row number. Each row of the spreadsheet represents one record of data. There are 14 types of data records. The type of data record is shown in the first column. Different record types use different numbers of columns. Whenever the data record type changes between rows, a record header is added to the spreadsheet that describes each column of data in the following row. To edit the raw data, simply highlight the cell and type in the new value. To change the type of record, pick on the down arrow in the first column and choose a new data type from the list. To delete a row, highlight any cell in the row and hit the Delete key or choose Delete Row from the Edit menu. Records can be added pressing the Insert key, pressing the down arrow key from the last line in the spreadsheet, or by choosing one of the add records from the Add menu.
The different record types are described below.

**TR (Traverse)**
The traverse record contains the occupied point number, foresight point number, angle mode, horizontal angle, distance, vertical angle and description. When processed, this record will calculate and store the coordinates for the foresight point. Traversing also moves the setup by making the traverse foresight point the next occupied point and the traverse occupied point becomes the next backsight point. The different angle codes are NE for northeast bearing, SE for southeast, SW for southwest, NW for northwest, AZ for azimuth, AL for angle left, AR for angle right, DL for deflection angle left and DR for deflection angle right. To set the angle code, pick on the Code down arrow and choose from the list. The horizontal and vertical angles should be entered as dd.mmss. For example, 45.2305 is 45 degrees, 23 minutes and 5 seconds. The vertical angle can be shown as vertical angle (0 degrees level), zenith angle (90 degrees level) or elevation difference. The vertical angle mode is set in the Display menu. The distance mode is also set in the Display menu as either slope or horizontal distance. The description field is used as the foresight point description.

**SS (SideShot)**
The sideshot record is the same as the traverse record except that sideshot does not move the setup.

**HI (Instrument and Rod Height)**
This record sets the instrument and rod heights used in elevation calculations. This record should precede any traverse and sideshot records that you want the heights applied to.

**BK (BackSight)**
The backsight record contains the occupied point number, backsight point number, backsight azimuth and the set azimuth. This record should precede any traverse and sideshot records that use this setup. If no backsight point is entered, the program uses the backsight azimuth to turn angles from. The Set Azimuth is the circle reading of the instrument when sighting the backsight. A Set Azimuth of zero is the default.

**PT (Store Point)**
The store point record consists of a point number, northing, easting, elevation and description. When processing, this data will be stored as a point in the coordinate file. If the first Occupied point and/or the initial Backsight point
are not defined in the coordinate file set for processing to, both points will need to be added to the rw5 file as PT (Store Point) records.

**DS (Description)**
The description record is an additional note that appears in the spreadsheet editor and printouts. This record can contain various information that is recorded in data collectors during field operations. This data can vary from user, temperature and general data to each line of data associated with "Set Collection". When "Sets" of data collected using various brands of data collection software is converted/imported into the raw editor, the actual measurements made during the spinning of the angles and distances are recorded as DS records and the mean value of the angle and distance is recorded as a SS record. DS records are not used in processing.

**CL (Closing Shot)**
The closing shot record is the traverse record where the foresight point is the closing point for the traverse. This record is used by the adjustment commands in the Process menu. There should be only one CL record in each Traverse loop (Name Record) in the raw file. If there is no CL record, the process adjustment routines will prompt for which shot is the closing shot. The closing shot can also be defined in the field by using special codes defined in the Open Settings found under the File pulldown within the editor. Please refer to the "Open Settings" documentation below for more information on these codes.

**AB (Angle Balance)**
The Angle Balance record is the measurement data observed that closes the angles of the traverse. Typically this record is the measurement data recorded from the closing shot to the initial backsight point. The backsight could be either external or internal to the traverse. Angle Balance routine in the Process menu uses this record and compares the angle between the occupied point and foresight point of this record with a user-specified reference angle. There should be only one AB record in the raw file. If there is no AB record, then the Angle Balance routine will prompt for which shot to use as the angle balance.

**CL + AB (Closing Shot and Angle Balance)**
This record is used as both the closing shot and angle balance records.

**FD (Foresight Direct)**
The foresight direct is a traverse record used in a direct and reverse set. When the program finds one the of direct-reverse measurement records, it will look for the other three records to complete the set.

**FR (Foresight Reverse)**
The foresight reverse is a traverse record used in a direct and reverse set.

**BD (B backsight Direct)**
The backsight direct is a traverse record used in a direct and reverse set.

**BR (Backsight Reverse)**
The backsight reverse is a traverse record used in a direct and reverse set.

**EL (Elevation Only)**
This record sets the elevation in the CRD file for the specified point number. Often used when an existing point with good vertical control is being traversed through. Using this record type for the point would keep the elevation from changing on the existing point regardless of the measurement data.

**AZ (Azimuth Only)**
Applies to SurvNET, the optional Network Least Squares analysis and adjustment routine.

**CSE (Control Standard Error)**
Applies to SurvNET, the optional Network Least Squares analysis and adjustment routine.
**SSE (Set-up Standard Error)**
Applies to SurvNET, the optional Network Least Squares analysis and adjustment routine.

**MSE (Measurement Standard Error)**
Applies to SurvNET, the optional Network Least Squares analysis and adjustment routine.

**NAME (Traverse Name)**
This record acts as an identifier for the group of records that make up a traverse. All the records after the NAME record belong to that traverse up to the next NAME record or the end of the file. This record allows you to have multiple traverses in one raw file. When running one of the Process commands, the program will bring up a list of all the traverse names. Simply choose which traverse to process. If you have only one traverse in the raw file, then you don't need the NAME record.

**GPS**
This record contains the Latitude and Longitude of a point as measured by GPS surveying equipment using Carlson SurvCE data collection software. This record has additional information tied to it such as localization files, geoid files, coordinate projection systems etc. This record has its own processing routine in the Process pulldown within the editor. Processing procedures are discussed in the Process (Compute Pts) pulldown documentation.

**Raw Data Editor Pulldown Menus**

**File Menu**

![Menu](image.png)

**Open RW5 File**
This command prompts for a rw5 file to load into the editor.

**New RW5 File**
This command clears the editor spreadsheet.

**Save RW5 File**
This saves the rw5 file. If the file hasn't been named you will be prompted for the file name and the location to
save the file. After you perform the first save, this command acts as a quick save and saves the file to the name and location specified during the initial saving of the file.

**Save RW5 As**
This command saves the raw editor data in the spreadsheet to a rw5 file and always prompts for file name and location to save.

**Open CRD File**
This command prompts for an existing coordinate file to set as the active coordinate file for the raw editor.

**New CRD File**
This command prompts for a new coordinate file to set as the active coordinate file for the raw editor. The coordinate data will be initialized as empty.

**Save CRD File**
This command saves the current coordinate data in the raw editor to the current coordinate file.

**Save CRD As**
This command saves the current coordinate data to a specified coordinate file name.

**Report/Print**
There are three types of reports: Raw Data, Coordinates and Summary. A sample of the raw data report is shown below. This report shows the data from the raw editor spreadsheet. The Coordinates report lists the point data (point number, northing, easting, elevation, description) from the current coordinate file. The summary report groups the traverse, sideshot and store point numbers along with a list of the setups and the shots from each setup.

Raw File> c:\data\survey.rw5
CRD File> c:\data\survey.crd

Note
Survey Example
PntNo Northing Easting Elevation Desc
1 5000 5000 100 START
OcPt BsPt SetAzi
1
InstHgt RodHgt
5.32 6.0
OcPt FsPt HorzAngle SlopeDist ZenithAng Desc
TR 1 2 AR 268.5330 711.420 89.4050 P2
InstHgt RodHgt
5.43 6.0
OcPt FsPt HorzAngle SlopeDist ZenithAng Desc
TR 2 3 AR 262.5448 457.760 89.3236 P3
InstHgt RodHgt
5.4 6.0
OcPt FsPt HorzAngle SlopeDist ZenithAng Desc
TR 3 4 AR 208.5710 201.310 89.1803 P4
TR 4 5 AR 247.1657 497.120 88.5235 P5
TR 5 6 AR 277.4835 223.980 90.2926 P6
TR 6 7 AR 92.4113 233.880 90.2746 P7
InstHgt RodHgt
5.42 6.0
OcPt FsPt HorzAngle SlopeDist ZenithAng Desc
TR 7 8 AR 261.2756 387.250 91.4405 CLOSE
SS 7 19 AR 289.3456 112.450 91.3423 SS1

Chapter 11. Survey Menu
Report/Print Settings
This dialog has settings for the report functions.

Import
These routines convert raw data from other formats into the current Carlson RW5 format. The converted raw data will be added to the end of any existing data in the editor. In many cases, the raw data file to import can be downloaded directly from the data collector or instrument using the Data Collectors command. The following supported formats (along with their standard file extension) are listed here. Some Sample File Formats are listed at the end of this section.

C&G (.CGR; .RAW; .TXT; *)
CalTrans (.DMP)
Carlson (.RW5)
EFB (.RAW; .OBS)
Fieldbook (.FBK): From Softdesk, Land Development Desktop or Civil 3D.
Geodimeter (.OBS; .RAW; job; *)
LandXML (.XML)
Leica (.GSI; .RAW; GRE): This reads the Leica raw file in Wildsoft, Liscad, 10-20-30-40, C&G, or GeoComp format. There are options to specify direct-reverse shot order if any and to convert from International Feet to Leica US Feet.

Maptech (.FLD)
MDL Laser (.CDS)
Nikon (.TRN; .RAW)
When downloading a rw5 file from SurvCE using SurvCOM, there's an option to copy the rw5 file to a sc5 file as a read-only backup.

Export
These routines convert the Carlson raw data (.RW5) file to other formats. The following file formats are supported.

CalTrans (DMP)
Fieldbook (.FBK): This export routine provides an option to "Setup Fieldbook Codes". This allows the user to substitute the raw description contained in the rw5 file with the fieldbook code used in AutoDesk Land Desktop or Civil 3D.

FL DOT (.OBS)
GPS Data (.TXT;*)
LandXML (.XML)
Leica (.GSI)
MOSS (.MOS)
RMGeo (.txt)
SDMS (.PRJ) This export routine provides an option to "Setup SDMS Codes". This allows the user to substitute the raw description contained in the rw5 file with the SDMS codes used in SDMS program.
Sokkia (.SDR)
TDS (RW5;RAW)
Topobase (PO)
VA Dot (TOP)

*Open/Save Settings*
This option allows for defining codes that represent the closing shot and angle balance shot of a traverse. These codes can be entered in the description of a point while in the field. When the rw5 is opened in the raw file editor, the measurement data containing the closing shot code will be set to a CL record and the measurement data containing the angle balance code will be set to an AB record. This allows for quick processing of the survey data and saves the time spent setting up the file for processing.

*Exit*
Exits the raw file editor.

*Edit Menu*
Undo: This command undoes the last data entry or the last copy, cut or delete command performed on keyboard entered data only. This will not undo a change to the Type or Code columns, nor a cut or copy command to a row.

Cut: Standard windows cut command. Removes data from editor and places it in the windows clipboard.

Copy: Standard windows copy command. Copies selected data to windows clipboard.

Delete: Deletes selected data or row of data. Will not delete headers if data is present below the header.

Find: Tool to search and find a particular word, letter, numeric value or a combination of all. Provides options to Match whole word only and/or case. Allows for a up or down directional search from the active cell in the editor. The Point Number Search allows you to search for occupy or foresight point numbers.

Replace: Tool to search and replace a particular word, letter, numeric value of a combination of all. Options to Match whole word only and /or case is provided for the search criteria. Provides further options to Replace individual items one at a time or to Replace All.
**Go To:** Tool to advance the focus of the active cell to a specified line number.

**Delete Row:** This command deletes the row containing the active cursor or cell. You can delete a row by placing the cursor in any of the cells in the row that you wish to delete, or by picking on the row number at the far left of the editor.

**Modify Measurements:** This option allows for a change in distance, horizontal angle or vertical angle by a specified amount for the entire file or for a specified point number or line number range. To modify a measurement, choose which field to modify, enter the change in either distance or angle in dd.mmss format. The Distance Factor method multiplies the distances by the specified value which can be used to convert distance units between feet and meters or to apply a scale factor. Next choose how to apply the modification. If all is selected, the change will be applied to all records in the specified field. If By Point Number is chosen, enter the point number or range of numbers in the Range of Points field. If by Line Number is chosen, then define the area for the change by specifying the Starting and Ending line.

**Convert Points To Notes Records:** This function converts point (PT) records to note (DS) records. This leaves the
information of the point coordinates in the rw5 file as display only and without having the point coordinates stored to the coordinate file when the file is processed. The point data in the DS records can be converted back to PT records by picking the Code field in the spreadsheet and switching DS to PT.

*Edit Coordinate File:* This option allows for editing and/or listing of the coordinate data in the active coordinate file. The active coordinate file is displayed in the Header of the raw data editor. This routine brings up the edit point dialog and allows editing of the points one at a time.

![Edit Assign Point Dialog](image)

**Display Menu**

*Angles:* This option chooses the angle format between degrees/minutes/seconds (dd.mmss) and Gons-400 decimal degree circle (dd.dddd). This setting applies to the angles in the spreadsheet editor as well as the angle format for reports.

*Vertical:* The options contained in this menu allow for specifying the type of vertical measurement information you will input or is contained in the rw5 file. The Vertical Angle selection assumes the barrel or scope of the instrument is
level when reading 0 (zero). With this setting, the vertical component of a measurement record will have a header of VertAng. The Zenith Angle selection, most commonly used, assumes the barrel/scope to be level when reading 90. Using this setting results in a header of ZenithAng. Elevation difference displays the elevation difference between the occupied and foresight points. If the Distance option is specified as Slope, this elevation difference will be used to calculate the horizontal distance of the measurement. The header for this record is ElevDiff. The None selection assumes all distances are horizontal distances and removes the vertical component for a measurement from the editor. Switching modes can be performed at any time.

### Distance:
This option controls the display of either Slope or Horizontal Distances. Changing the display results in the distance data adjusting to reflect the correct value for the selection made. The Vertical data, VertAng, ZenithAng or VertDiff, is used to convert the distance value when changing this display option.

### Graphics:
The Raw Data Editor uses an optional graphics window to display the points and traverse lines in real time. As data is entered or edited, the graphics window will be updated to show the configuration or new configuration of the traverse. The option of whether to show sideshots is also available. When a cell is selected, the traverse or sideshot line in the display window will change to the color yellow for a graphical reference. The graphics window is toggled on or off from the Display — Graphics Window menu inside the raw file editor.

- **Graphics>On:** Turns the graphics window on.
- **Graphics>Off:** Turns the graphics window off.
- **Graphics>Show Sideshots:** Controls the display of the sideshot data in the graphics window. Figure 1 shows the graphics window with sideshots on. Figure 1A shows the graphics window with sideshots off.
Graphics>Zoom Mode: Within the graphics window, real time zoom is available. To zoom in press and hold the left mouse button and drag in the direction of the + symbol. To zoom out, press and hold the left button and drag in the direction of the - symbol.
**Graphics > Pan Mode:** Real time pan is available within the graphics window. To pan, set the graphics window to pan mode, then press and hold the left mouse button and then drag to desired position.

**Graphics > Resize Text:** With this option on the text becomes smaller/larger in the view when you zoom in/out.

**Graphics > Fixed Text Size:** With this option on, the text stays a fixed size while zooming in and out.

**Spreadsheet Colors:** This option allows for the assignment of colors to record types. To change/define the color for a particular record, select Spreadsheet Colors from the Display pulldown within the raw editor. From the Color Settings dialog select the record to edit by clicking on the select button next to the desired record.

The color slide beside the select button shows the current setting for the record. After selecting the record, the Select Color dialog box will be display. Select the Set button next to the desired color for the record.
**Display > Hide Row:** This option allows for hiding single or multiple rows. This could be used to prevent crucial information from being accidentally altered during editing of data or data entry. Hiding a record does not exclude it from processing. To hide a record click on the row number at the far left of the editor. The entire row of data will highlight, now select the Hide Row option. Multiple rows or data can be selected by selecting the first row of data to hide then while holding down the shift key on the keyboard, select the last row to hide. All rows in between these two selections will be highlighted, now select Hide Row. When a row or rows of data are hidden, the row numbers will reflect the hidden rows. For example, Figure 2 below shows a multiple selection of rows 10-17 to hide. Figure 2A shows the editor with the rows hidden. Notice that the row numbers indicate hidden rows by showing a gap from rows 9-18.
Show Row: This option shows rows that have been hidden. To show hidden rows, the row above the first hidden row and the row below the last hidden row must be selected by using the shift key selection method described in Hide Row above. After selecting the appropriate rows, select the Show Row option. Figure 2B shows the selection of rows 9 & 18 in order to show the hidden rows 10-17. Figure 2C shows the editor after the Show Row option has been selected.
Hide Description Records: This option controls the visibility of the Description records contained in a rw5 file. The description record is an additional note used to store useful information in addition to typical point data. Sometimes these records clutter the raw file and make it hard to review actual survey data. The ability to control the description record visibility is a useful tool when reviewing survey data.

Show Description Records: This option shows (unhides) description records contained in the rw5 file.

Hide Record Headers: This option hides the in-line headers such as the PntNo, OcPt, FsPt, etc. The editor contains "Smart Headers" that changes with the type of data that is in the active row. These headers are not in-line and are always displayed at the top of the editor. Figure 2D shows the editor with the record headers hidden and the Smart Header active. Row #21 contains the active cell, the automatic header at the top of the editor shows traverse (TR) record headers.
Add Menu

**Traverse:** Adds a traverse record (TR) to the spreadsheet editor. The new record will be inserted above the row that contains the active cell unless this row is the last row in the file. If so, you will be prompted to insert above or below the current row.

**SideShot:** Adds a sideshot record (SS) to the spreadsheet editor. The new record will be inserted above the row that contains the active cell unless this row is the last row in the file. If so, you will be prompted to insert above or below the current row.

**Backsight:** Adds a backsight (BK) to the spreadsheet editor. The new record will be inserted above the row that contains the active cell unless this row is the last row in the file. If so, you will be prompted to insert above or below the current row.
**Instrument Height**: Adds an instrument height (HI) record to the editor. This record contains both the instrument and rod height setting.

**Point**: Adds a point (PT) record to the editor. Provides options to either add a Blank Point Record or Import From Coordinate File.

Inserting a blank record allows for manual input to define the coordinates for the point. Import From Coordinate File imports the coordinate values from an existing point or range of points contained in the coordinate file. Enter the point number or range of points and select OK. The points will be read into the rw5 file at the top of the file.

**COGO Command**: Adds COGO Command (CC) record with a field to specify the command (Translate, Rotate, Scale or Align) and a field for entering the parameters. The COGO commands are executed in sequence as the rw5 file is processed from top to bottom by any of the process methods in the Process menu. The COGO commands are all transformation commands that are applied to the points in the current coordinate file. The following list is the syntax of the COGO commands:

- **Translate**: Range Dx Dy Dz Process_Zero_Z
- **Rotate**: Range Angle Base_Y Base_X
- **Scale**: Range Scale Base_Y Base_X Use_Z
- **Align**: Range From1 To1 From2 To2

All the parameters are entered into one spreadsheet cell next to the COGO function. The parameters use space separators. The following list is the parameter definitions:

- **Range**: point numbers
- **Dx**: delta easting (X)
- **Dy**: delta northing (Y)
- **Dz**: delta elevation (Z)
- **Process_Zero_Z**: toggle for whether to process points with elevation of zero (0=No, 1=Yes)
- **Angle**: rotation angle in dd.mms format
- **Base_Y**: base point northing
- **Base_X**: base point easting
- **Scale**: scale factor
- **Use_Z**: toggle for whether to scale the elevations (0=No, 1=Yes)
- **From1**: point number of first source point
- **To1**: point number of first destination point
From2: point number of second source point  
To2: point number of second destination point

For example, to translate points 1-10 by a delta Z of 6.0 while filtering out zero elevation points, set the parameters for the COGO Translate record as "1-10 0 0 6.0 0".

**Elevation:** Adds an elevation (EL) record to the editor. The new record will be insert above the row that contains the active cell unless this row is the last row in the file. If so, you will be prompted to insert above or below the current row.

**Note:** Adds a note (DS) record to the editor. Note records are for information display and do not effect processing except for two special notes which are:
- Elevation: 2D
- Elevation: 3D

These special notes set the elevation mode for processing for the records that follow the note. The raw editor starts in 3D mode. The "Elevation: 2D" note will switch processing to 2D mode and the "Elevation: 3D" note will switch the mode back to 3D. In 2D mode, the processing will not set the elevations in the coordinate file.

**Data On/Off:** Adds a data on/off (DO) record to the editor. This record toggles the raw data between processing on and off modes. The raw data starts in processing on mode. Working from top to down, when a DO record is reached, the processing mode is turned off. Then next DO record will turn processing back on, and so on. Data records that are in processing off mode and skipped when running the routines in the Process menu.

**Traverse Name:** Adds a traverse name (Name) to the editor. The new record will be insert above the row that contains the active cell unless this row is the last row in the file. If so, you will be prompted to insert above or below the current row.

**GPS:** Adds a GPS record to the editor. The new record will be insert above the row that contains the active cell unless this row is the last row in the file. If so, you will be prompted to insert above or below the current row.

**Reference Azimuth:** Applies to SurvNET, the optional Network Least Squares analysis and adjustment routine.

**Control Standard Error:** Applies to SurvNET, the optional Network Least Squares analysis and adjustment routine.

**Setup Standard Error:** Applies to SurvNET, the optional Network Least Squares analysis and adjustment routine.

**Measurement Standard Error:** Applies to SurvNET, the optional Network Least Squares analysis and adjustment routine.

**Process (Compute Pts) Menu**
This menu contains tools to process raw data by various methods. The calculated coordinates, and notes if specified, are stored to the active specified coordinate file. The coordinate file can be specified using Set Coordinate File, under the Points pulldown within the drawing screen, or from the Tools menu of the editor, discussed later in this section. The options for processing are specified within either the Process Options dialog box or the Closure Options dialog box, depending upon . This dialog box is displayed before processing data, using any of the available methods, with the exception being the Least Squares method.
Multiple Measurements To Same Point: This option sets the method of how to handle multiple measurements to the same point. There are three available options, Use Last, Average or Use First. Use last uses the last measurement to calculate the position of the point. Average uses the average of all the measurements for the position calculation and Use Last takes the last measurement to the point as the data to use.

Use Backsight Reciprocals: The Backsight Reciprocal options treat reciprocal measurements "special". A foresight to point 15 from a setup on 14, followed by a backsight from 15 to 14, makes a pair of "reciprocal" measurements. The backsight "reciprocal" measurement can be ignored for its impact on recalculating the occupied point (None Option), or the elevation of component of the reciprocal measurements can be averaged (Average Elevation option), or both the elevation and distance can be averaged (Average Elev & Dist) to recalculate the setup (occupied point) coordinates.

Calculate Elevations: This option determines whether the elevations of the points will be calculated and written to the coordinate file. Options of whether to calculate All elevations or just the Sideshots Only are provided.
Direct-Reverse Vertical Angles: Specify whether to balance all or process the direct-reverse shots and use only the foresight direct shot.

Report Angle Format: Specifies the angle format for the report. The By File option makes the report use the angle format in the raw data (.RW5) file.

Calculate Elevations: This option controls which point elevations will be calculated. For example, if the traverse point elevations have already been adjusted and you need to recalculate the sideshot elevations, then use the SideShots Only option.

Report SideShots: Specify whether to include the sideshot data in the process results report.

Point Protect: This option will check the coordinate (.CRD) file for existing point data before processing. If the foresight point number for any traverse or sideshot record already is a stored coordinate in the coordinate (.CRD) file, then the program shows a list of conflicting point numbers. You can either continue processing and overwrite the coordinate (.CRD) file coordinates with the calculated raw file coordinates or cancel the processing to go back to the editor to change foresight numbers.

A report of the conflicting point numbers can be generated to the standard report viewer in Carlson by selecting the Report option on the Point Protect dialog box. From the report viewer, the report can then be printed, sent to the screen or saved to a file.
Create Point Notes: This option will generate a note (.NOT) file named after the coordinate file. The note file contains additional descriptions for points. With this option active, the text from all note records (DS records) will be stored to the note file for the foresight point number preceding the note records.

Calculate Grid Scale Factor at Each Setup: This option will calculate a scale factor for each TR and SS record. This scale factor is calculated as the average of the scale factors at the occupied and foresights points. At these points the scale factor is calculated as the projection grid factor multiplied by the elevation factor which is the earth radius divided by the elevation plus the earth radius \[SF = \text{Grid Factor} \times \left(\frac{\text{Earth Radius}}{\text{Elevation} + \text{Earth Radius}}\right)\]. In order to calculate these projection grid factors, the traverse coordinates must be in grid coordinates. When this option is selected, the program will prompt for the projection and zone to use. The elevation for the scale factor can be adjusted by the geoid height using the geoid specified in the Geoid To Apply list. The geoid height is added to the point elevation to adjust the elevation value used in the scale factor equation. The geoid surface files are not installed by default due to the large size of these files. To install the geoids to use with this option, go to the Carlson Software webpage and download the Geoid Grid Files from the Support->Downloads section.

Report Each State Plane Scale: This option becomes available if the Calculate State Plane Factor at Each Setup has been selected. With this option on, the scale factor at each point will be shown in the process results report.

Scale Factor: This value is multiplied by the slope distance for the traverse and sideshot records.

Correct for Earth Curvature: This option adjusts the calculated points for the effect of the Earth's curvature. Typically this adjustment is small and adjusts the elevation more than the horizontal.

Report Angle Format: This option controls the angle format displayed on the process result report. The option of By Raw File will display the angles in the format that is contained in the raw file. The Bearing option will display the angle in a bearing format. The Azimuth option will display the azimuth of the measurement and the Angle Right option will display the angle right measurement of the observation.

Decimal Places for Report: This option controls the number of decimal places for the reported data.
**Report Closure:** This option determines whether the closure report will be displayed after processing. If processing a topo survey where the traverse has not been closed, then turn this toggle off for quick processing.

**Report Sideshots:** Controls whether the sideshot data is shown on the process report.

**Reference Closing Point:** This is an optional field for entering the coordinates to compare the ending traverse point with. This reference closing point is used to calculate the closure. Without using this option the program will by default use the starting coordinate as the reference closing point.

**Report Output:** There are three report output options contained in the raw editor, the *Standard Report Viewer*, the *Custom Report Formatter* and the *Tabular Report Viewer*. Each is documented below.

The *Standard Report Viewer* is the default report viewer throughout the program. Any routine that generates a report has this option and the data contained in the report depends upon the routine executed. The report viewer is also a text editor. It allows for addition and deletion of text in order to customize the report for printing or for saving to a particular format for a file. Options to print, send to the screen in the drawing window as text or save to a file are available.

The *Custom Report Formatter* allows for customization of the process results by selecting the fields and the layout of the fields to display. The settings can be saved to a format name and recalled when needed. Options to Delete, Export and Import saved Formats are also available.
To create a report, select data from the Available list and then select the Add button. This will populate the Used field with the selected data. Standard window selection methods can be used when selecting the data to report. Holding the ctrl key while selecting data allows for making random selections. Holding the shift key while selecting data will select the first item picked, last item picked and all items between.

The **Tabular Report Viewer** displays a report viewer consisting of tabs. Each tab organizes and displays different data depending upon the process option chosen. The process results using the No Adjust method results in three tabs the Report Header, Unadjusted Data and the Store Points tabs. Each of these tabs display different information which corresponds to the tab title. Using an adjustment method results in five tabs. In addition to the three listed above, an Angle Balance and Compass Closure tab is added. From the Tabular Report Viewer, the Standard Report Viewer can be switched to by pressing the Report option at the bottom of the dialog. This is useful when wanting to combine all tabs into one report for printing or saving to a file. An example of a Tabular Report for a compass rule adjustment is shown below.
Processing Methods

No Adjust: No Adjust means that no angle balance or traverse adjustment will be applied. Options are specified in the Process Options dialog. After picking OK for the process options dialog, a Traverse Points dialog appears for entering the starting and ending point numbers.

The program reads the raw file to set the defaults for these point numbers which are used to calculate the closure. The difference between the ending point and the reference closing point is the closure error and the sum of the traverse distances from the starting to the ending point is used as the total distance traversed. After picking OK for the second dialog, the program starts processing the raw file from the top record down. The result is displayed in the Standard Report Viewer which can save, print or draw the report.

Angle Balance: This process method applies an angle balance to the traverse lines when calculating the coordinates. The angle balance takes the angular error divided by the number of traverse lines and adjusts the angle of each
traverse line by this amount. The angular error is the difference between the angle balance shot and a reference angle. The angle balance shot is specified as a type AB or CL+AB record in the raw file. If no AB record is found in the raw file, then the program will prompt for which traverse shot to use as the angle balance shot. The angle from the angle balance shot is calculated as the angle from the occupied point to the foresight point. The reference angle can be specified as a bearing, azimuth or by two point numbers in the dialog shown.

The angle balance report shows the unadjusted points, the unadjusted closure, the angular error, the adjusted points and then the adjusted closure. Typically but not always, applying the angle balance correction will improve the traverse closure.

**Compass, Crandall, Transit:** These process methods apply the selected rule to the traverse lines when calculating the coordinates. After adjusting the traverse, the sideshots are also recalculated. The closure error is calculated as the difference between the closing shot and a reference point. The closing shot is specified as a type CL or CL+AB record in the raw file. If no CL record is found in the raw file, then the program will prompt for which traverse shot to use as the closing shot. The foresight point is used as the closing coordinate. The reference point can be specified by point number or by entering the northing, easting and elevation. The process results report shows the unadjusted points, closure error, adjustments to each traverse point and adjusted point.

**Prepare Least Squares Data:** From the raw file data, this routine makes initial calculations for the coordinate points in the traverse.
This data, along with the control point coordinates and the angle and distance measurements, is stored to a data file with the same name as the current RW5 file except with a .LSQ extension (ie: survey.lsq goes with survey.rw5). The constraints of the routine are:

**All angle readings must be in angle right mode.**

**The coordinates of the starting and the ending points must be known.**

The routine begins with a dialog for specifying the reference closing coordinates and any scale factors to apply to the distance measurements. The Reference Closing Point is the last point in the traverse, whose coordinates must be known. If an angle balance shot is used in the traverse, the Reference Angle Balance Angle must also be specified, either as a value or as the angle between known points.

Since angles and distances have errors of different magnitudes, they are normalized using weights, based on the accuracy and confidence with which these quantities have been measured. There is a dialog for specifying the estimated measurement errors. The Reading Error is the horizontal angular error in the instrument. For example, for a "5-second" instrument this error would be 5. The Pointing Error accounts for several factors in the horizontal angle reading including accuracy lining up the crosshairs on the target, the target size and the optical quality of the instrument. The Target and Instrument Centering Errors are the distance off the point due to faulty centering. The EDM Constant Error is the accuracy of the instrument distance measurements. The EDM Scaler Error is entered in parts per million for the increased error in longer measurements. These settings can be saved and loaded as a way to store settings for different equipment.

The program will calculate the weights for each distance and angle measurement using these measurement errors.
The control points, points to adjust, distance and angle measurements with weights are reported. You can edit these measurements and weights using the Edit Least-Squares Data routine or go directly to the Process Least-Squares Data routine.

**Edit Least Squares Data:** This routine edits the points, measurements and weights stored in the .LSQ file associated with the current RW5 file. The editor works through the dialog shown. You can edit, add or remove the control points, adjust points, angle measurements or distance measurements. The program does not check that the editing is valid. So you need to make sure that your changes keep a good set of least-squares data (i.e. don't delete a needed control point). The Distance Error button allows you to set the distance standard error weights for all the distance measurements to the same value. Likewise the Angle Error button sets the standard error weights for all the angle measurements.

**Least-Squares Input Data:**

<table>
<thead>
<tr>
<th>Control Points</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point# Northing Easting</td>
</tr>
<tr>
<td>1 5000.000 5000.000</td>
</tr>
<tr>
<td>8 5000.000 5000.000</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Distance Observations</th>
</tr>
</thead>
<tbody>
<tr>
<td>From To Distance StdErr</td>
</tr>
<tr>
<td>1 2 711.409 0.018</td>
</tr>
<tr>
<td>2 3 457.745 0.017</td>
</tr>
<tr>
<td>3 4 201.295 0.017</td>
</tr>
<tr>
<td>4 5 497.024 0.018</td>
</tr>
<tr>
<td>5 6 223.972 0.017</td>
</tr>
<tr>
<td>6 7 233.872 0.017</td>
</tr>
<tr>
<td>7 8 387.073 0.017</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Angle Observations</th>
</tr>
</thead>
<tbody>
<tr>
<td>From At To Angle StdErr</td>
</tr>
<tr>
<td>1 1 2 268.5330 15.18443&quot;</td>
</tr>
<tr>
<td>1 2 3 262.5448 13.68265&quot;</td>
</tr>
<tr>
<td>2 3 4 208.5710 30.36335&quot;</td>
</tr>
</tbody>
</table>

**Chapter 11. Survey Menu**
<table>
<thead>
<tr>
<th>Point</th>
<th>Point</th>
<th>Point</th>
<th>Point</th>
<th>Point</th>
<th>Point</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>1</td>
<td>2</td>
<td>268d53'30''</td>
<td>7.617''</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>3</td>
<td>262d54'48''</td>
<td>6.869''</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>4</td>
<td>208d57'10''</td>
<td>15.194''</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>4</td>
<td>5</td>
<td>247d16'57''</td>
<td>14.222''</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>6</td>
<td>277d48'35''</td>
<td>12.262''</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>6</td>
<td>7</td>
<td>92d41'13''</td>
<td>15.818''</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>7</td>
<td>8</td>
<td>261d27'56''</td>
<td>12.991''</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>S</td>
<td>0</td>
<td>01d59'18'' E 0.001''</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Process Least Squares Data**

This routine applies a least-squares adjustment to the data stored in the .LSQ associated with the current raw data (.RW5) file. The closing errors are distributed among the other points, using the "Method of Least Squares" (Ref: Wolf, P.R. and Ghilani, C.D., 1996, "Adjustment Computations", John Wiley and Sons, NY, Third Edition). After the adjustment, the rest of the raw file is processed to recalculate the sideshots. There is an option to draw standard error ellipses around the adjusted points. The ellipse axes are multiplied by Ellipse Scale Factor to make the ellipse larger for easier viewing.

![Process Options](image)

The least-squares process report shows the input data and the results. For each point, the amount adjusted and the standard error in X and Y are reported. The Reference Standard Deviation is based on the sum of the residuals and the initial estimated standard errors. The Chi-Squares test is a goodness-of-fit test that checks the reference standard deviation with the least-squares model. If this test fails, there may be a blunder in the measurement data or the initial estimated standard errors were too low or too high.

**Stadia Processing Method:** Provides functionality to process Stadia surveying notes. Stadia sighting depends on two horizontal cross-hairs, known as stadia hairs, within the telescope. These hairs are parallel to the horizontal cross-hair and are equally spaced above and below it. The distance between the two stadia hairs is known as the intercept. The distance from the instrument to the rod is 100 times the intercept. For example, an intercept of 3.10 would represent a distance of 310 (3.10 X 100). For entering in stadia notes, you would enter the horizontal angle, the distance (entered as the intercept X 100) and the vertical angle.

**GPS:** The process GPS routine allows for reduction of GPS records that reside in a raw (.RW5) file from latitude, longitude and WGS84 Ellipsoid Height to State Plane or local coordinates. When selected, the GPS Settings dialog will appear as shown below.
GPS Projection Type:
Defines the datum coordinate system to be used for converting the latitude, longitude and WGS84 ellipsoid height collected from the GPS receiver into Cartesian coordinates. The supported projection types are State Plane 83, State Plane 27, UTM, Lat/Long, Great Britain-OSGB36, Australia, New Zealand-NZGD2000, New Zealand-NZGD49, and France NTF-GR3DF97A. A User-Defined option is also available for defining a user projection.

The supported geoids include: Geoid99 (USA), Geoid03 (USA), EGM96 (World), GDA94 (Australia), CGG2000, HT 2.0, HT HT 1.01 (Canada) and )SGM02 (Britain). GeoUser-Defined projections are supported. To define a new projection select the Define Projection option. This will bring up the following dialog.
Enter a name for your system (e.g. PRVI for Puerto Rico/Virgin Islands), then select a Projection type and enter the appropriate parameters. Note that all latitude and longitude values are in Degrees Minutes and Seconds (dd.mmss) and False Northing and False Eastings are always presented in meters. Define a Datum shift by selecting the Select Datum radial button. You may select a predefined Ellipsoid or set your own parameters by typing in a new ellipsoid name in the Ellipsoid field and entering values for a and 1/f. When you enter in a new Ellipsoid name, the Datum name field will be blank. The values for Dx, Dy, Dz, Rx, Ry, and Rz and scale are "to WGS84". If the values you have are "from WGS84", simply reverse the sign of each value (positive becomes negative and vice versa).

You may save your system to a "udp" file. To Load a user defined coordinate system from a file, select the Load radial button. A list of user defined systems will be displayed. Select the desired system and press OK.

**GPS>Zone:** for State Plane projections, you must select the correct state zone that you are working in. For UTM, the Automatic Zone option will have the program automatically use the correct UTM zone for your location. Otherwise for UTM, you can manually set a specific UTM zone. This manual option applies to working on the border between zones and you want to force the program to always use one of those zones.

**GPS>Use Alignment File For Localization:** With this option toggle on, a prompt for the Alignment File to Process will be displayed. This file is typically created by SurvCE (Carlson's Data Collection System) using the Localization routine or by Carlson Field Using the Align to Local Coordinates routine. This file (*.DAT) contains the parameters to transform the derived State Plane coordinates to the defined local coordinates.

At the end of the process, the coordinates will be written to the current coordinate (*.crd) file and a report will be presented in the Carlson editor for saving or printing purposes.

**GPS>Transformation:** The transformation in the align Local Coordinates command can either be by plane similarity or rigid body methods. The difference is that the rigid body method does a transformation with a translation and rotation and without a scale The plane similarity does a rotation, translation and scale. This option only applies when two or more points are used in Align Local Coordinates or the Localization routine in SurvCE.

**GPS>One Point Alignment Azimuth:** This option applies to the rotation when using one point in Align Local Coordinates or the Localization routine in SurvCE. For this alignment method, the state plane coordinate is translated to the local coordinate. Then the rotation can use either the state plane grid or the geodetic as north. No scale is applied in this transformation. The state plane and geodetic true north diverge slightly in the east and west edges of the state plane zone. This option allows you to choose which north to use.

**GPS>Two Point Alignment Method:** There are two option when using this method, Fit & Rotate and Rotate Only. Fit & Rotate will use the second point in the localization file for direction and scaling. The Rotate Only option allows you to use the second point in the localization file for direction but not for scaling. When using the Rotate Only option, any scale factor entered in the Project Scale Factor will be used.

**GPS>Project Scale Factor:** For most applications, the Scale Factor should be set to 1.0. The scale factor represents the "combined" grid/elevation factor that reduces ground distances to grid. After converting the LAT/LONG from the GPS records to state plane coordinates and applying the coordinate alignment (Localization) file, the Project Scale Factor is applied as the final adjustment to the coordinates. This adjustment is used on the X, Y, and not the Z. The Project Scale Factor is applied by dividing the distance between the coordinate and a
base point by the Project Scale Factor. The coordinate is then set by starting from the base point and moving in the direction to the coordinate for the adjusted distance. The base point is the first point in the alignment (Localization) file. If there are no points specified in the alignment file, then 0,0 is used as the base point. If using an alignment file (Localization File) this value will be automatically calculated and displayed. Manual entry of a scale factor is also permitted and is often used with the Two Point Alignment Method when a scale factor is known.

**GPS>Geoid to Apply:** The supported geoids include: Geoid99 (USA), Geoid03 (USA), EGM96 (World), GDA94 (Australia), CGG2000, HT 2.0, HT HT 1.01 (Canada) and SGM02 (Britain).

This option will account for the geoid undulation in determining the orthometric elevation of the measurement. The definition of the geoid model as currently adopted by the national Geodetic survey is the equipotential surface of the Earth's gravity field which best fits, in a least squares sense, global mean sea level. Orthometric elevation measurements are used in survey calculations. In order to convert ellipsoid heights (He) as measured by GPS into orthometric elevations (E0), you must provide for a correction between the GPS-measured ellipsoid (reference ellipsoid) and a constant level gravitational surface, the geoid. This corrections is the geoid undulation (Ug). The formula is $H_e = E_0 + U_g$.

Carlson applies the Geoid model by subtracting the Geoid undulation from the GPS elevation. The resulting elevation is then used and displayed. In practice, the Geoid model is most applicable to two types of alignment scenarios. One of these types is when setting up the base over a know point and having no alignment control points. The other is when there is one alignment control point. When using multiple alignment control points, the Geoid model is not as important because Carlson can model the elevation difference which can generally pick up the local Geoid undulation.

**GPS>Units:** Coordinates can be reduced into one of three available units, Metric, US Feet or International Feet.

**Process>Process Settings:** This option allows for the setting of user preferences and tolerances to be used during processing and generation of reports.
**Multiple Measurement Settings:** These options provide control for managing how multiple measurements to the same point are handled and reported.

**Distance Tolerance Horizontal and Vertical:** Allows for user input of desired tolerance values for multiple measurements. Exceeded tolerances will be displayed on the process results report. With the Report Residuals option ON, the residual values of the measurements will be shown on the process results report.

The data to be averaged can be either the **Distance Measurements** or the **Coordinates**.

**Backsight Orientation Settings:** This option will take multiple backsight measurements for an occupation and computes a least squares orientation for the instrument. There is also an option to compute and correct for the instrumental collimation error from the available measurements if both direct and reverse readings to one or more stations in the same set have been recorded. The program uses the BD (backsight direct) and BR (backsight reverse) records to identify the measurements to process. You can backsight different targets. The targets do need to have known coordinates either as points in the current coordinate file or as SP records in the raw file. The measurements can be complete with angles and distance, and they can be partial with only angles or only distance. When this option is active, the calculated backsight orientation will override the SetAzi field in the BK (backsight) record for the setup. The process report will include all the measurements used, the residuals and the resulting backsight orientation. The least-squares routine will also calculate the occupied station coordinate by resection if possible from the measurements and the report includes this calculated position along with the reference position and residuals. This calculation of the occupy point is used only for a check for the report and does not effect the occupy coordinate for processing. Note that if the occupied station position is unknown, there must be sufficient measurements to at least three known reference stations to support the resection and orientation solution. Here is an example of the raw data and the report.

<table>
<thead>
<tr>
<th>Raw Data</th>
<th>Northing</th>
<th>Easting</th>
<th>Elevation</th>
<th>Desc</th>
<th>InstHt</th>
<th>RodHt</th>
</tr>
</thead>
<tbody>
<tr>
<td>71</td>
<td>4998.1900</td>
<td>5199.8200</td>
<td>125.0000</td>
<td>PK</td>
<td>5.000</td>
<td>1.000</td>
</tr>
<tr>
<td>22</td>
<td>4770.1200</td>
<td>5192.5000</td>
<td>90.0000</td>
<td>PK</td>
<td>5.000</td>
<td>1.000</td>
</tr>
<tr>
<td>2</td>
<td>4900.2700</td>
<td>5007.3100</td>
<td>75.0000</td>
<td>PK</td>
<td>5.000</td>
<td>1.000</td>
</tr>
<tr>
<td>53</td>
<td>5345.8600</td>
<td>4799.0400</td>
<td>150.0000</td>
<td>PK</td>
<td>5.000</td>
<td>1.000</td>
</tr>
<tr>
<td>1</td>
<td>5000.0000</td>
<td>5000.0000</td>
<td>100.0000</td>
<td>PK</td>
<td>5.000</td>
<td>1.000</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>OcPt</th>
<th>BsPt</th>
<th>Azi</th>
<th>SetAzi</th>
<th>InstHt</th>
<th>RodHt</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0°00'00''</td>
<td>0°00'00''</td>
<td></td>
<td>5.000</td>
<td>2.000</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>OcPt</th>
<th>FsPt</th>
<th>HorzAngle</th>
<th>SlopeDist</th>
<th>ZenithAng</th>
<th>Desc</th>
<th>InstHt</th>
<th>RodHt</th>
</tr>
</thead>
<tbody>
<tr>
<td>BD 1</td>
<td>71</td>
<td>0°31'09''</td>
<td>200.930</td>
<td>84°00'06''</td>
<td>PK</td>
<td>5.000</td>
<td>2.000</td>
</tr>
<tr>
<td>OcPt</td>
<td>FsPt</td>
<td>HorzAngle</td>
<td>SlopeDist</td>
<td>ZenithAng</td>
<td>Desc</td>
<td>InstHt</td>
<td>RodHt</td>
</tr>
<tr>
<td>BD 1</td>
<td>22</td>
<td>50°03'22''</td>
<td>300.120</td>
<td>92°29'02''</td>
<td>PK</td>
<td>5.000</td>
<td>3.000</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>OcPt</th>
<th>FsPt</th>
<th>HorzAngle</th>
<th>SlopeDist</th>
<th>ZenithAng</th>
<th>Desc</th>
</tr>
</thead>
<tbody>
<tr>
<td>BD 1</td>
<td>2</td>
<td>85°48'25''</td>
<td>103.580</td>
<td>105°06'37''</td>
<td>PK</td>
</tr>
<tr>
<td>OcPt</td>
<td>FsPt</td>
<td>HorzAngle</td>
<td>SlopeDist</td>
<td>ZenithAng</td>
<td>Desc</td>
</tr>
<tr>
<td>BR 1</td>
<td>53</td>
<td>59°50'31''</td>
<td>403.001</td>
<td>276°58'56''</td>
<td>PK</td>
</tr>
</tbody>
</table>

Chapter 11. Survey Menu
BR 1 2 AR 265°48'38'' 103.581 254°53'23'' PK
InstHt RodHt
5.000 2.000
OcPt FsPt HorzAngle SlopeDist ZenithAng Desc
BR 1 22 AR 230°03'39'' 300.121 267°30'58'' PK
InstHt RodHt
5.000 1.000
OcPt FsPt HorzAngle SlopeDist
ZenithAng Desc
BR 1 71 AR 180°31'16'' 200.931 275°59'54'' PK
Multiple Backsight Orientation
OcPt BsPt Azimuth SetAzi
1 00°00'00'' 269°59'57''
Orientation Standard Deviation: 0.000
Instrument Height: 5.000

Occupy Point Northing Easting Elevation
Reference 5000.000 5000.000 100.000
Calculated 5000.000 4999.999 100.000
Delta 0.000 0.001 -0.000
Standard Dev 0.003 0.003 0.000

Target Points Northing Easting Elevation Rod Height
71 4998.190 5199.820 125.000 1.000
22 4770.120 5192.500 90.000 2.000
2 4900.270 5007.310 75.000 3.000
53 5345.860 4799.040 150.000 4.000

Measurement Hz Angle Residual Zenith Hz Dist Residual
71 0°31'09'' -0°00'04'' 84°00'06'' 199.830 -0.001
22 50°03'22'' 0°00'01'' 92°29'02'' 299.838 -0.003
2 85°48'25'' -0°00'02'' 105°06'37'' 99.999 -0.002
53 239°50'24'' 0°00'03'' 83°01'04'' 400.011 -0.006
53 59°50'31'' -0°00'04'' 276°58'56'' 400.012 -0.007
22 265°48'38'' -0°00'15'' 254°53'23'' 100.000 -0.003
71 180°31'16'' -0°00'11'' 275°59'54'' 199.831 -0.002

Check Point Settings: These options provide user controls for survey check points. With Report Check Points ON, any point coded as a check point in the raw data file, will be reported. When selected the Check Point Code and Distance Tolerance fields become active and allow for editing. The Check Point Code is a user specified code entered in during the survey that tells the program to check the coordinates of a particular point with the coordinates of another point. This code is configurable by the user. An example of a point description coded as a Check Point would be as such, "trav =8". This description tells the program that the description of the point is "trav" and to check the coordinates of the this point with that of point #8. The Distance Tolerance Horizontal and Vertical are user specified tolerances for the check point. If either of these tolerances is exceeded it will be reported on the process results report.

Instrument/Rod Height Ranges: These settings are used to check the instrument and rod heights when the raw file is processed. The program will report warnings if there are any heights that exceed the specified min/max ranges.

Angle Only Measurements: The Combine Elevations Method applies to points calculated from Angle Only measurements. Angle Only points are calculated as part of the processing for the No Adjust, Compass, Crandall, Transit and Angle Balance process methods. To calculate points from Angle Only measurements, there needs to be

Chapter 11. Survey Menu 535
multiple SS records with horizontal and vertical angles and no distance with the same target foresight point number from setups at different occupy points. The elevations can be set as the average from the multiple measurements, using the highest measured elevation, or using the lowest measured elevation. For example, to survey the top of a tree, you could have a SS to foresight point 99 from occupy point 1 with a horizontal and vertical angle and another SS to foresight point 99 from occupy point 2 with a horizontal and vertical angle. Then point 99 can be calculated by angle-angle intersect which determines the horizontal distances from 99 back to occupy points 1 and 2. These distances are then used with the vertical angles and occupy point elevation to calculate the elevation at point 99.

**Store Point Records:** These options control how any store point (PT) record is handled during processing of the raw data file. There are three options for storing Store Point (PT) records, *Never*, *Always*, and *When CRD Empty*. *Never* prevents any Store Point (PT) Record Report in the raw file from being written to the crd file. With this option on no existing point in the crd file would be overwritten. *Always* will write to the coordinate file and will overwrite any existing point with the same number of the Store Point (PT) records. The *When CRD Empty* option will only write Store Point (PT) records to the coordinate file when it is empty. *Report Store Points* displays all store points in the process results report. The *Hold Store Points* option will hold the coordinate values for the store point record when measurements are taken to the store points. This will prevent the coordinates of the point from changing if measurements to the point dictate a change in coordinate position.

**Direct-Reverse Settings:**

**Direct-Reverse Vertical Angles:** This option determines how to handle direct-reverse vertical angle measurements when processing. *Balance Direct-Reverse* will take the mean of the direct-reverse measurements and use this value when processing the file. *Direct Only* will only use the direct measurement to the point for processing.

**Foresight-Backsight Measurements:** Balance Foresight-Backsight allows for averaging in the Foresight and backsight measurements when using direct-reverse sets. The Foresight Only option will average the foresight measurements only of a direct-reverse set.

**Horizontal Angle Tolerance (Seconds):** This is the tolerance that the angle measured by the direct measurements and the angle measured by the reverse measurements in a direct-reverse set must fall within.

**Flip Angle Tolerance (Seconds):** User specified value for the acceptable difference in measured horizontal angles determined from the direct (BD-FD) and reverse (BR-FR) observations.

**Distance Tolerance:** User specified tolerance for the difference in distance measurements to the same points. When this value is exceeded on a measurement, it will be displayed on the process results report.

**Measurements To Control Points:** The *Store To Current Coordinate File* option applies when a control coordinate file is used in addition to the active coordinate file. When processing the raw file, measurements to point numbers that are in the control coordinate file will not be stored into the active coordinate file when this option is on.

**Drawing Points and Linework:** This option controls the drawing of points and linework using Field to Finish. It differs from the draw traverse and sideshot lines under the Tools Menu of the Raw Editor by using a field to finish code table (*.fld) to define how the points and linework are to be drawn and layerized. There are three settings for this option, Manual, Auto and Prompt. Manual means that the file will not be processed using the field to finish codes and no points or linework will be drawn upon existing the raw editor. The Auto option will use the current or
last used field to finish file (*.fld) to draw the points and lines on the drawing screen when the raw editor is existed. The option of Prompt will give the option to draw the points and lines to the screen. With this setting specified, the following prompt will be displayed when exiting the editor.

![Field To Finish dialog box](image)

**Tools Menu**

**Direct-Reverse Report:** This routine creates a report of direct and reverse shots along with the resulting averaged shots. Any tolerance specified in the Process Settings > Direct-Reverse Settings section, that is exceeded will be displayed in this report. The residuals are the difference between the measurement and the final average. If the current spreadsheet display mode for distances is set to horizontal, then the report will show horizontal distances. Otherwise, the report uses slope distances.

**Reduce Direct-Reverse:** This routine processes the direct and reverse shots and simplifies the raw file by replacing the sets of direct and reverse shots with the resulting average traverse record.

**Update Raw from Points:** This routine is used to update the raw data based upon the coordinates of the points contained in the coordinate (*.crd) file. For example if the raw data has been processed using the compass rule adjustment method, the points in the crd file are now adjusted. However the raw data remains unchanged. If a record of the rw5 file reflecting the angles and distances between the points after an adjustment has been run is desired, this routine can be run thus updating the raw data to reflect the adjusted angles and distances. Another application for this routine is that of building a rw5 file for future processing and adjustment. For example if a point file or text file has been received from another engineering firm or fellow surveyor and you would like to build a rw5 file for future reference and processing this option can also be used to accomplish this. The rw5 file would be set up with the occupied points, foresight points and the desired angle type to use specified for the traverse. This would be all the manual entry of the data necessary. After creating the "shell" of the traverse then run the update raw from points routine and the raw data, as contained in the coordinate file, will be imported into the rw5 file thus filling out the horizontal angle, distance and vertical components specified.
**Find Bad Angle:** This routine prompts for another raw data (.RW5) file which is read and the data added to the end of the existing raw data (.RW5) file. For example, if you are editing the raw file from the first day's work and have a separate raw file with a second day's work, you can use this routine to add the second raw data to the first raw file.

**Draw Traverse-Sideshot Lines:** This routine draws lines for all the traverse and sideshot records. Sideshot Traverses are traverses that do not lead to the closing or ending point. There are different layers so that the lines can be drawn with different colors. This command does not process the raw file. Instead it reads the raw file and for each traverse and sideshot record, the program looks up the coordinates for the occupied and foresight points in the CRD file. So it may be necessary to run Process>No Adjust before running this routine. With the Erase Previous Traverse-Sideshot Lines toggled on, any previous linework drawn using this method will be erased from the drawing screen before drawing the lines again.

**Renumber Points:** This routine renames points in the raw file. This applies to all point numbers including: TR, SS, and PT records.

**Range of Points to Renumber:** Enter in the range of points to change, i.e., 1-4.

**Line Number to Begin Renumbering:** This corresponds to the line number located at the far left or the raw data editor. Enter the line number to begin the renumbering.

**Line Number To End Renumbering:** This also corresponds to the line number located at the far left on the raw data editor. Enter the line number to end the renumbering. If the range of numbers specified does not occur between the beginning line number and the ending line number, no changes will be made.

**Numbers to Add to Point Numbers:** Enter in the value to add. This number will be added to the existing point number to create the new point number. For example, if the number to add is 10 and the existing point numbers 1 and 6, the new renumber points will be 11 and 16.

**Point Groups:** This option can be used to organize the survey data into point groups. There are three options for the creation of point groups, **Create All Point Group**, **Create Traverse Point Group** and **Create...**
Sideshot Point Group. The Create All Point Group option, creates a user specified group containing all of the points defined in the rw5 file. Create Traverse Point Group creates a user specified group containing only the points defined in the traverse records (TR) of the rw5 file. The Create Sideshot Point Group creates a user specified group that contains only the points defined in the sideshot records (SS) of the rw5 file.

Format of the raw data (.RW5) file
The Carlson raw data format is a comma delimited ASCII file containing record types, headers, recorded data and comments. The format is based on the RW5 raw data specification, with the exception of angle sets. Angle sets are recorded as BD, BR, FD and FR records to allow reduction of all possible combinations. Essentially, these records are identical to a sideshot record.

Backsight Record
Record type: BK
Field headers:
OP Occupy Point
BP Back Point
BS Backsight
BC Back Circle
Sample(s):
BK,OP1,BP2,BS315.0000,BC0.0044

Line of Sight Record
Record type: LS
Field headers:
HI Height of Instrument
HR Height of Rod*
*GPS heights may be recorded to phase center or ARP depending on GPS make.
Sample(s):
LS,HI5.000000,HR6.000000
LS,HR4.000000

Occupy Record
Record type: OC
Field headers:
OP Point Name
N Northing (the header is N space)
E Easting (the header is E space)
EL Elevation
– Note
Sample(s):
OC,OP1,N 5000.00000,E 5000.00000,EL100.000,–CP

Store Point Record
Record type: SP
Field headers:
PN Point Name
N Northing
E Easting
EL Elevation
– Note
Sample(s):
SP,PN100,N 5002.0000,E 5000.0000,EL100.0000,–PP

 Traverse / Sideshot Record / Backsight Direct / Backsight Reverse / Foresight Direct / Foresight Reverse
Record type: TR / SS / BD / BR / FD / FR
Field headers:
OP Occupy Point
FP Foresight Point
(one of the following)
AZ Azimuth
BR Bearing
AR Angle-Right
AL Angle-Left
DR Deflection-Right
DL Deflection-Left
(one of the following)
ZE Zenith
VA Vertical angle
CE Change Elevation
(one of the following)
SD Slope Distance
HD Horizontal Distance
– Note
Sample(s):
TR,OP1,FP4,AR90.3333,ZE90.3333,SD25.550000,–CP
SS,OP1,FP2,AR0.0044,ZE86.0133,SD10.313750,–CP
BD,OP1,FP2,AR0.0055,ZE86.0126,SD10.320000,–CP
BR,OP1,FP2,AR180.0037,ZE273.5826,SD10.315000,–CP
FD,OP1,FP3,AR57.1630,ZE89.4305,SD7.393000,–CP
FR,OP1,FP3,AR237.1612,ZE270.1548,SD7.395000,–CP

GPS
Record type: GPS
Field headers:
PN Point Name
LA Latitude (WGS84)
LN Longitude (WGS84, negative for West)
EL Ellipsoid elevation in meters*
– Note
*GPS heights may be recorded to phase center or ARP depending on GPS make.
Sample(s):
GPS,PN701,LA42.214630920,LN-71.081409184,EL-21.8459,–C
P /Brass Disk
Alphabetical listing of Record Types
BD Backsight Direct
BK Backsight
BR Backsight Reverse
FD Foresight Direct
FR Foresight Reverse

Chapter 11. Survey Menu
GPS GPS Position in Lat (dd.mmss) Lon (dd.mmss - Negative for West) and WGS84 Ellipsoid Elevation in meters

**Alphabetical listing of Field Headers**
AD Azimuth Direction ( 0 for North, 1 for South)
AL Angle-Left
AR Angle-Right
AZ Azimuth
BC Back Circle
BP Back Point
BR Bearing (this field will be recorded as N123.4500W)
BS Backsight (when back point is not defined)
CE Change Elevation
DL Deflection-Left
DR Deflection-Right
DT Local Date (MM-DD-YYYY)
E Easting (the header is E space)
EC Earth Curvature (0 for off, 1 for on)
EL Elevation (GPS value is ellipsoid elevation in meters)
EO EDM Offset
FE Foresight Elevation
FP Foresight Point
HD Horizontal Distance
HI Height of Instrument
HR Height of Rod
LA Latitude
LN Longitude
N Northing (the header is N space)
OC Occupy Point Coordinates
OP Occupy Point
PN Point Name
SD Slope Distance
SF Scale Factor
TM Local Time (HH:MM:SS)
UN Distance Unit (0 for feet, 1 for meter, 2 for US feet)
VA Vertical Angle
ZE Zenith
– Note

**Traverse Examples**
This first example is a closed traverse with an internal backsight of azimuth 178°0'42".

Use the functions under the Add menu to create and fill out the raw file as shown here.

Notice that the record from point 7 to 8 is set as a CL+AB record. This tells the program that point 8 is the closing point and that the angle from 7 to 8 is the closing angle. For traverse adjustment, the closing reference point is 1 and the closure error is the difference between point 1 and point 8. For angle balance, the reference closing angle is
358d0'42" (178d0'42" + 180). The angle balance error is the difference between this reference angle and the angle from points 7 to 8.

Now let's process using Compass adjustment with Angle Balance. Choose Compass under the Process menu and fill out the dialogs as shown.

First half of process report:

Process Results 05/23/2002 10:06
Raw file> c:/scadxml/data/example.rw5
CRD file> C:/scadxml/DATA/example.crd

Scale Factor: 1.00000000
Correct for Earth Curvature: OFF
Starting Point 1: N 5000.00 E 5000.00 Z 100.00
BackSight Azimuth: 178°00'42''

<table>
<thead>
<tr>
<th>No.</th>
<th>Description</th>
<th>Angle</th>
<th>Zenith</th>
<th>Slope</th>
<th>Inst</th>
<th>Rod</th>
<th>Northing</th>
<th>Easting</th>
<th>Elev</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>AR268.5330</td>
<td>89.4050</td>
<td>711.32</td>
<td>5.32</td>
<td>6.00</td>
<td>5038.43</td>
<td>5710.27</td>
<td>103.29</td>
<td></td>
</tr>
<tr>
<td></td>
<td>P2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>AR262.5448</td>
<td>89.3236</td>
<td>457.76</td>
<td>5.43</td>
<td>6.00</td>
<td>4587.89</td>
<td>5791.20</td>
<td>106.36</td>
<td></td>
</tr>
<tr>
<td></td>
<td>P3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>AR208.5710</td>
<td>89.1803</td>
<td>201.31</td>
<td>5.40</td>
<td>6.00</td>
<td>4397.30</td>
<td>5726.43</td>
<td>108.22</td>
<td></td>
</tr>
</tbody>
</table>
Closure Results (Before Angle Balance)

Starting Point 1: N 5000.00 E 5000.00 Z 100.00

Closing Reference Point 1: N 5000.00 E 5000.00 Z 100.00
Ending Point 8: N 5000.09 E 4999.97 Z 100.06
Azimuth Error : 341°38'22''
North Error : 0.09061
East Error : -0.03007
Vertical Error: 0.05953
Hz Dist Error : 0.09547
Sl Dist Error : 0.11251
Traverse Lines> 7
Side Shots> 1
Horiz Dist Traversed: 2712.29
Slope Dist Traversed: 2712.62
Closure Precision: 1 in 28409

Remainder of process report:

Compass Closure
Adjusted Point Comparison

<table>
<thead>
<tr>
<th>Original</th>
<th>Adjusted</th>
</tr>
</thead>
<tbody>
<tr>
<td>Northing</td>
<td>Northing</td>
</tr>
<tr>
<td>Point#</td>
<td>N</td>
</tr>
<tr>
<td>2</td>
<td>5038.445</td>
</tr>
<tr>
<td>3</td>
<td>4587.914</td>
</tr>
<tr>
<td>4</td>
<td>4397.319</td>
</tr>
<tr>
<td>5</td>
<td>4363.044</td>
</tr>
<tr>
<td>6</td>
<td>4586.509</td>
</tr>
<tr>
<td>7</td>
<td>4613.178</td>
</tr>
<tr>
<td>8</td>
<td>5000.017</td>
</tr>
</tbody>
</table>

Max adjustment: 0.097
Starting Point 1: N 5000.00 E 5000.00 Z 100.00
BackSight Azimuth: 178°00'42''

Point Horizontal Zenith Slope Inst Rod Northing Easting Elev
No. Angle Angle Dist HT HT
Description
2  AR268.5326 89.4050 711.34 5.32 6.00 5038.44 5710.29 103.29
P2
3  AR262.5434 89.3236 457.76 5.43 6.00 4587.91 5791.26 106.36

Chapter 11. Survey Menu 544
Shown above is the resulting process report. The angle balance had an error of 39 seconds which was divided among the 7 traverse sides. The Compass Closure shows how each traverse point was adjusted and then the resulting adjusted angles and distances.

Here is another layout of the last example that shows an external backsight setup. In this case there are two known points. Point 1 is the starting point and point 21 is the initial backsight. The setup could also use a backsight azimuth (ie north azimuth for example) instead of a backsight point number.
The closing record setup has changed from the last example. In this example, the shot from 7 to 8 is the closing shot with point 8 as the closing point. The closing reference point is still point 1. The angle balance shot is from 8 to 9 and the reference angle is from 1 to 21.

Example of an open traverse

The traverse starts from the known point 1 and ends at the known point 14. In this case there is no angle balance shot. The closing shot is from 3 to 4 with point 4 being the closing point. Point 14 is the closing reference point.
The closing record setup has changed from the last example. In this example, the shot from 7 to 8 is the closing shot with point 8 as the closing point. The closing reference point is still point 1. The angle balance shot is from 8 to 9 and the reference angle is from 1 to 21.

Here is an example of an open traverse.

**Compass Report from Open Traverse example:**

**Compass Closure**

Adjusted Point Comparison

<table>
<thead>
<tr>
<th>Point</th>
<th>Original</th>
<th>Northing</th>
<th>Easting</th>
<th>Distance</th>
<th>Bearing</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>5013.76</td>
<td>5711.18</td>
<td>5013.78</td>
<td>0.047</td>
<td>N 63d21'19'' W</td>
</tr>
<tr>
<td>3</td>
<td>4560.69</td>
<td>5776.42</td>
<td>4560.72</td>
<td>0.078</td>
<td>N 63d21'19'' W</td>
</tr>
<tr>
<td>4</td>
<td>4372.46</td>
<td>5705.08</td>
<td>4372.50</td>
<td>0.091</td>
<td>N 63d21'19'' W</td>
</tr>
</tbody>
</table>

The traverse starts from the known point 1 and ends at the known point 14. In this case there is no angle balance shot. The closing shot is from 3 to 4 with point 4 being the closing point. Point 14 is the closing reference point.
Portion of typical Sokkia/SDR raw data file:
00NMSDR20 V03-05 Jan-22-98 19:14 122211
10NWM970709A
13CPS Sea level crn: N
02TP00015000.000005000.0000085.63500005.22000000PK-FD
08K10003500.00005192.920081.74500000MN-SET
07TP0001000390.0000000.0000000
09F100010003193.0000092.40416660.00000000MN-SET
09F100010100003193.0000000.00000000MN-SET

Portion of typical Wild/Leica raw data file:
410001+000000SB 42....+00000000 43....+00000000 44....+00000000 45....+00000000 110002+00000002
21.124+35959590 22.104+08748240 31...1+00000000 51..0.+0012+000 110003+00000000
21.124+00000000 21.104+08748240 31...1+00267075 51..0.+0012+000 110004+00000000
21.124+00420390 22.104+08702570 31...1+00168234 51..0.+0012+000 110005+00000000
21.124+26029130 22.104+09311370 31...1+00206133 51..0.+0012+000 410006+00000000
31...1+00106228 51..0.+0012+000 110008+00000007 21.124+27151500 22.104+09312240 31...1+00106066
51..0.+0012+000

Portion of typical SMI raw data file:
CM Definitions: SS: Side Shot; TR: Traverse; OC: Occupied Coordinates;
PC: Point Coordinates; CM: Comment; OS: Occupied Station;
TS = time stamp; e = electronic; m = manual; CM TS TUE 04/09/91 09:41:25P
PC 1 5000.00000 5000.00000 0.00000
SS e HI:4.000 HR:5.000 PIPE/F
0 1 2 BAZ:0.00000 AR:0.00040 ZA:91.24330 SD:92.020
SS e HI:0.000 HR:0.000 BC/BR FRAME 1ST
0 1 3 BAZ:0.00000 AR:28.47220 ZA:91.20250 SD:65.240

Portion of typical PC COGO raw data file:
* NEW SET UP INST. AT 1 359 59 59 ON 4
L ANG 1000 4 1 77 18 52 4.44 * 1000 WALL# 283.22
L ANG 1001 4 1 55 44 28 9.8 * 1001 WALL# 283.28
L ANG 1002 4 1 38 37 8 15.89 * 1002 WALL# 283.48
L ANG 1008 4 1 27 18 34 123.82 * 1008 WALL# 287.75

Portion of typical Nikon raw data file:
MP,NOR,,5000.0000,5000.0000,0.0000,1
ST,NOR,,1,,5.0000,0.0000,0.0000
SS,1,5.0000,131.0605,91.3744,88.4935,10:36:15,CL1
SS,2,5.0000,137.6770,90.2923,88.5236,10:36:50,CL1

Portion of typical MDL/Laser raw data file:
D052097F04P52I494P01P02
H32473V -0639R016202P03
H03840V-0483R017380

Portion of typical Geodimeter raw data file:
Portion of typical Survis raw data file:

_OCCUPY_PNT_
621 616 5.140
148.36076
10255015.7245 3790987.2398 87.6695 ir
10255535.8009 3790669.8100 100.3900 ir

_COMMENT_
Thu Apr 08 08:14:14 1999

_BACKSIGHT_
0.00000 90.33400 609.4200 11.900 ir

_SIDESHOT_
1 0 0
18.47550 90.55000 17.4200 5.300 TP: gps1

Portion of typical Fieldbook raw data file:

NE 32 10696.4141 10043.5613 "SN-SET"
AZ 32 27 0
STN 32
BS 27
AD 27 0.00000 NULL "SN-SET"
AD 33 183.23250 183.660 "SN-SET"

Portion of typical SurvCOGO raw data file:

19100 , 0 , 19101 , 5 , 5.25 , 4.7 , 35.15 , 550 , 91.23 , START
19101 , 19100 , 19102 , 5 , 5.15 , 4.7 , 35.15 , 120.23 , 88.34 ,
19102 , 19101 , 19103 , 5 , 5.2 , 4.7 , 125.1444 , 180.41 , 90 ,
19103 , 19102 , 19104 , 5 , 5.2 , 4.7 , 125.15 , 240.03 , 90 ,
19104 , 19103 , 19105 , 5 , 5.3 , 4.7 , 315.15 , 305.5 , 90 , IRON PIN
19105 , 19104 , 19106 , 5 , 5.4 , 4.7 , 215.15 , 140.35 , 90 , IRON PIN
19106 , 19105 , 19107 , 5 , 5.05 , 4.7 , 215.15 , 200 , 90 , TACK IN FENCE
19107 , 19106 , 19108 , 5 , 5.2 , 4.7 , 300.23 , 400 , 90 ,

Pull down Menu Location: Survey
Keyboard Command: rawedit
Prerequisite: None

Edit-Process Level Data

This command is for entering and calculating level data. It has a spreadsheet editor for entering the level measurements, and the level calculations are updated as the data is entered. There is also a processing and reporting feature.

Carlson Software supports two level file formats:
**LEV Files:** The .LEV file is the old format. You can still edit and process files in this format. The LEV format only supports differential levels, single and three-wire. The LEV file has 5 record types:

1) SR - Start Record. Contains the starting benchmark measurement.
2) TP - Turning point record, contains the backsight and foresight to the turning point.
3) LV - Side Shot (or level) record. Contains the foresight measurement to the point.
4) ER - End Record, contains the measurement to the ending benchmark.
5) Note/Comment - starts with two dashes

**TLV Files:** The TLV file format can contain Differential and/or Trig-Level data. This is Carlson's new format and is supported by SurvCE (Carlson data collection program). The TLV file has the following record types:

1) H1 - First header record contains project information
2) H2 - Second header record contains date, time, temperature and pressure information
3) BM - Benchmark record, contains the point number, elevation and description of the benchmark.
4) LS - Rod height, only used with TRIG-LEVEL data.
5) BS - Backsight measurement. This record contains the backsight point number and measurement:
   a) Differential data: VD and HD - Vertical Difference (rod reading) and Horizontal Distance
   b) Trig data: SD/ZE - Slope Distance and Zenith Angle
6) FS - Foresight measurement. This record contains the foresight point number and measurement:
   a) Differential data: VD and HD - Vertical Difference (rod reading) and Horizontal Distance
   b) Trig data: SD/ZE - Slope Distance and Zenith Angle
7) Note/Comment - starts with two dashes

This routine runs the *.TLV / *.LEV file editor and file report functions.

**LEV File Editor:**
If you are creating a new .LEV file, you must choose either single-wire or three-wire for your level format data entry preference.

Three Wire leveling, or precise leveling, is a process of direct leveling wherein three cross hairs, or threads, are read and recorded rather than the single horizontal cross hair. Note below, in the sample three-wire editor graphic, the additional columns representing top and bottom readings.

The commands starts by asking you, with a dialog box, to select an existing level file (.LEV) to process or to select a name for a new level file. The below examples are using existing files. Once this choice is made the small, Level Format dialog appears.

Regardless of whether you choose Single or Three Wire, the Level Editor appears in its own window. Below we see
the editor displaying the contents of two existing files of level information. One is single wire and the other is three wire. The pulldown menus are the same for both, as described below in detail.

In the spreadsheet, the background color of the cells indicate the data type. White cells are for user-specified values. Blue cells are program calculated values. Black cells are data fields that aren’t used by the level record for that row.
Level File Editor - sample Three Wire data

File- >Settings

**File:** Standard File routines - Open, Save, Save As, Settings, Print and Exit. Settings brings up a dialog where you can adjust the 3-wire tolerance and distance values. Open will allow you to open up another existing .LEV file.

**File- >Import:** This routine imports Leica level data in GSI or XML format and Trimble DAT format into the level editor.

**Edit:** Cut, Copy, Paste and Go To. Go To will take you to the row of your choosing.

**Add:** These options provide the standard level run routines. Details on each and a graphic of the pulldown follow.

**Tools:** This pulldown is for adjusting and storing elevations.

The Add and Tools pulldowns at the top of the editor provide the following features:

**Level Start (SR):** Starts the level run, usually with a know starting elevation or benchmark.

**Level Turning Point (TP):** Turning point procedure for leveling.

**Level Side Shot (LV):** For entering leveling side shots.

**Level End (ER):** Enter your value.

**Note:** You can add a note, or comments, into the editor as you move through the level run.
Level Editor - Tools pulldown menu

**Adjust Elevations:** This function will do a simple adjustment of your level data and place the adjusted elevations in the Adjusted Elevation column. If you are running 3 wire level loop the corrections will be inversely proportionate to the distance between the measurements. If you are running a single wire level loop, the corrections will be averaged by the number of turns.

**Store Elevations to Coordinate File:** It is important that the point numbers in the level file match the point numbers in the coordinate file. If you have an active coordinate file passed to the level editor, this option will be available to you. The elevations calculated in the level file will be stored in the active coordinate file by matching point numbers. The point must exist in the coordinate file before an elevation will be stored. After the elevations have been stored, a report will show which points were stored and which ones were not. If adjusted elevations have been calculated, they will be stored. If not, the unadjusted elevations will be stored.

Selecting Print (editor File menu) provided this Level File Report sample

**Editor Columns:**

**Type:** These are small pulldown menus with two-letter level procedure choices. The two letters are abbreviations as indicated in the next dialog. These steps may be made with the Add pulldown or with this method. The options are SR, TP, ER, LV and DS. DS stands for description shot.

**Point #** - Point number of measurement.

**BS** - Backsight rod reading

**HI** - Calculated height of instrument

**FS** - Foresight rod reading

**Elevation** - Elevation of point

**Code:** The code is used by SurvNet for network least-squares processing of networked level loops. The code can be either EL or FE where EL is for calculated elevations and FE is for fixed elevations. FE should only be assigned to a START or END record (where you can enter the value for the adjusted elevation). If FE is assigned to an
intermediate record it is ignored. Here is how the FE records are used. Say you run from one benchmark to another (point 1 to point 10). Point 1 and point 10 are the START and END records of the first loop and both are FE records. Then you start another loop at point 5 (halfway between 1 and 10). This is not a benchmark and can be adjusted so it should be assigned an EL code. Point 5 is the START record for the second loop. You run from point 5 to point 20 which is a benchmark. Point 20 is the END record and is assigned an FE code. When SurvNET processes the file, it will hold points 1, 10 and 20, allowing all others to be adjusted, including point 5 (even though it is a START record).

**Adjusted Elevation** - Adjusted elevation of point

**Description** - description of point

**TLV File Editor:**

TLV files can contain trig-level and/or differential level data. The editor will allow both type records in the same file.

Below is a sample Trig-Level TLV file:

Below is a sample Differential-Level TLV file:
Menu Options:

File Menu:
Open - Open an existing .TLV file.

New - Creates a new TLV level file.

Save - Save changes

Save As - Save as different file name

Settings - Not used with TLV files.

Import - You can import the following level file formats: Leica GSI format, Leica XML format, and Trimble DAT format.

Print - get hard copy printout of data.

Exit - Exit Level Editor Program

Edit Menu:
Clipboard: Cut, Copy, Paste

Go To - "Go To" will take you to the row of your choosing. Enter the row number.

Add Menu:
Add: These options allow you to add or insert a new record into the level editor.

Benchmark Record (BM): Point with known elevation.

Backsight Record (BS): Differential-level measurement to the backsight point.

Foresight Record (FS): Differential-level measurement to foresight point.

Backsight Record (BT): Trig-level measurement to the backsight point.

Foresight Record (FT): Trig-level measurement to foresight point.

Note: You can add a note, or comments, into the editor as you move through the level run.

Tools Menu:

Adjust Elevations: This function will do a simple adjustment of your level data and place the adjusted elevations in the Adjusted Elevation column. If you have distances, either HD or SD for all your measurements, the corrections will be inversely proportionate to the distance between the measurements. If you are running a single wire level loop (VD but no HD), the corrections will be averaged by the number of turns.
Store Elevations to Coordinate File: It is important that the point numbers in the level file match the point numbers in the coordinate file. If you have an active coordinate file passed to the level editor, this option will be available to you. The elevations calculated in the level file will be stored in the active coordinate file by matching point numbers. The point must exist in the coordinate file before an elevation will be stored. After the elevations have been stored, a report will show which points were stored and which ones were not. If adjusted elevations have been calculated, they will be stored. If not, the unadjusted elevations will be stored.

Editor columns

Measurement records will have the following columns:

**Trig Level Record:**
- **Type** - Two character abbreviation that shows the record type:
  - BM - Benchmark
  - BS - Differential-level backsight record
  - BT - Trig-Level backsight record
  - FS - Differential-level foresight record
  - FT - Trig-Level foresight record
  - DS - Note or Comment
- **Point #** - Point number of measurement.
- **RodHt** - Rod reading
- **Zenith** - Zenith angle
- **S.Dist** - Slope Distance
- **HI/Elev** - Elevation of HI if a backsight record, or the foresight point if a foresight record
- **Adjusted Elevation** - Adjusted elevation of foresight point
- **Description** - description of point

**Differential Level Record:**
- **Type** - Two character abbreviation that shows the record type, same as above.
- **Point #** - Point number of measurement.
- **V.Diff** - Rod Reading
- **H.Dist** - Horizontal Distance
- **HI/Elev** - Elevation of HI if a backsight record, or the foresight point if a foresight record
- **Adjusted Elevation** - Adjusted elevation of foresight point
- **Description** - description of point

Pulldown Menu Location: Survey
Keyboard Command: diglevel
Prerequisite: .LEV (level) file to process
File Name: \sp\rawedit.arx

**Edit Process SDMS File**

This command processes SDMS format raw data from PRJ files. There is a spreadsheet editor with the data tag, value and description for each of the records. The processing functions are the same as the Edit Process Raw Data command. See that section of the manual for a description of the processing functions. The Edit Process SDMS command allows you to work with the SDMS raw data in its native format. Alternatively, you can run Edit Process Raw Data and convert the SDMS PRJ file into a Carlson RW5 file.
**Pulldown Menu Location:** Survey  
**Keyboard Command:** sdmsedit  
**Prerequisite:** None

---

**Draw Field to Finish**

This command turns data collector field notes into a final drawing by matching the descriptions of the field points with user-defined codes. The points are brought into the drawing with attributes defined by the code, including the layer, symbol, size and linetype. Draw Field to Finish also uses an improved coding method.
Example drawing results using the example points and example code definitions

Two files are used in Draw Field to Finish - a coordinate file and a field code definition file. The coordinate file consists of x,y,z points with text description fields. The description fields contain codes for the Draw Field to Finish processing. The coordinate file can be a Carlson coordinate (.CRD) file, C&G CRD file, C&G CGC file, Land Desktop MDB file or Simplicity Systems ZAK file. An ASCII data file can be converted into a coordinate file using the Import Text/ASCII File command. The field code definition file defines the layer, symbol, size and other actions to apply with each code. These file names are displayed at the top line of the Draw Field to Finish dialog box.

Draw Field to Finish can translate the field points into Carlson points (also called coordinate geometry points or cogo points) with a symbol, layer, and size defined by the code. The point settings of whether to label the description, point number, and elevation and whether to locate the point at zero or at the real Z can be found in the Additional Draw Options of the Draw Field to Finish dialog box. The Draw-Locate Points command has these point settings stored separately in the Point Defaults menu. Draw-Locate Points provides a simpler method for drawing points compared with Draw Field to Finish.

There are two different methods for connecting linework. One method creates line work by connecting points with the same code. The linetype is defined by the code as either points only (no line work), lines, 2D polylines, both 2D and 3D polylines, or 3D polylines (breaklines). Distinct lines with the same code are defined by adding a group number to the end of the code name in the data file. With this method, all points with the description CODE1 will be one line while points with CODE2 will be another line. Both CODE1 and CODE2 use the definition for CODE. For example, the code EP could be a code for edge of pavement that is to be connected as 3D polylines. If there are two separate edge of pavement lines on the left and right sides of a road, all the points for the left side could have the description EP1 and the points on the right side could be EP2.

The second method is the PointCAD format. This method also connects points with the same code. The difference is that instead of using a number after the code for distinct lines, you use the same code with an additional code for starting and ending the line. For example, +0 is used to start a line and -0 to end. So the coding for a segment of edge of pavement could be EP+0, EP, EP, EP-0. Another special code that has been added to Field to Finish is +7, -7. This 7 code will use the linetype definition of line, 2D polyline or 3D polyline defined by the Draw Field to Finish code. For example, if EP is defined as a 3D polyline, then the coding EP+7, EP, EP, EP-7 will create a 3D polyline. Otherwise codes like +0, -0, which is defined as start and end line, will draw EP as a line. Other PointCAD special codes are: +4 starts a curved 2D polyline, +4 starts a closed curved 2D polyline, +1 begins a 3-point arc, +5 starts a 3D polyline, +5 starts a closed 3D polyline, +6 starts a 2D polyline, +6 starts a closed 2D polyline, +7 starts a line whose type is specified by the field code definition, -05 starts a curved 3D polyline section, -50 ends that section, +8 starts a 2D and 3D polyline combination, +8 starts a closed 2D and 3D polyline combination, -08 starts a 2D and 3D polyline combination curved section, -80 ends that section. //, followed by a field code, concatenates that field code's description on to the point's description. For example, OAK//04 might become LIVE OAK TREE 4" if the field code OAK translates to LIVE OAK TREE and the field code 04 translates to 4".

The advantage to the PointCAD method is that you don't have to keep track of line numbers. For example, if you are surveying 50 curb lines, the first method would require you to use 50 distinct curb numbers. The advantage to the first method is that you don't have to use the start and end codes. Also the Nearest Found connection option applies to the first method.

Draw
Range of Points: Specify the range of points to draw.

Point Group: Specify the point group(s) to process.

Entities To Draw: The Points option draws only the points and point attributes. The Lines option draws only the linework and the Symbols draws only the symbols. Any combination of these options can be processed as well as individual processing of each entity.

Point Label Settings: Specify whether you want Draw Field to Finish to label the Point Numbers, Descriptions, and/or Points Notes which are contained in the note (.NOT) file that is associated with the coordinate (.CRD) file.

Elevation Label Settings: Specify the elevation labeling options. The Label Zeros option will label the elevations of points with $z=0$. Use Parentheses will place parenthesis around the elevation text. Use ‘+’ and Use ‘-’ will place the appropriate symbol in front of the elevation.
**Locate Points on Real Z Axis:** Choose between locating all the points at real Z elevation, all at zero elevation or to use the real Z setting as defined in the individual codes.

**PC-PT Curve Type:** Sets the method for drawing curves with more than 3 points. The Bezier option draws a smooth polyline through all the curve points. The Sequential Arcs method draws multiple arcs with arc end points at each of the curve points. These arcs are tangent to the preceding line segment. The Best Fit method creates a single best-fit curve for all the curve points between the PC and PT.

**Layer Prefix:** Optional layer prefix added to all entities drawn with Draw Field to Finish.

**Erase Existing Draw Field to Finish Entities:** When checked, this option will erase from the drawing any old entities created by previous Field-To-Finish runs before drawing the new entities.

**In Range:** This option only erases and redraws those Draw Field to Finish entities that are within the specified range of points to process.

**Creating Point Groups:** Point Groups can be created in one or two different ways. Each field code definition can specify Point Group(s) that all point numbers that use that code will be added to. Multiple field codes can use the same Point Group name. Check the By Code Definition checkbox for that option. The second method is to automatically create Point Groups for each code that is processed. Check the Automatically By Code checkbox for that option. Ignore Code Suffix, if checked, will cause the codes to be considered after removing the numeric suffix.

For example, points with the EP10 and EP11 codes will both be automatically added to the Point Group named EP.

No matter how the Point Group is created, the Group Name Prefix can be used to add a prefix to the group name. Note: if the Point Group already exists, it will be erased first before being created again by either of these two methods.

Creating Point Notes: These options append point notes to the coordinate file data for some of the data fields processed by Field-to-Finish. These notes can then be used by other commands like List Points to report these fields. For example, this enables List Points to report both the point coordinate file description as well as the point drawing description as generated by Field-to-Finish.

**Pause on Undefined Codes:** When checked, Draw Field to Finish will pause if it encounters a description that is not defined in the code table.

**Abort without drawing anything:** This stops the command. Run Draw Field to Finish again to correct the code table.

**Use the default settings for this point:** This option draws a point in the "MISC" layer with no linework. To set your own default, define a code called "SC_DFLT".

**Use default settings for all undefined codes:** This option will draw all undefined codes in the "MISC" layer by default or a user specified layer as defined in the "SC_DFLT" code. A good way to check the data file for unmatched...
descriptions is to use the Print Table command and choose the Data Points and Distinct Code options. This command will print the different codes in the data file and identify any undefined codes.

**Preview Only:** When checked, this option will temporarily draw the points and linework and allow you to review it with zoom and pan.

**Auto Zoom Extents:** When checked, this will force a zoom extents after Draw Field to Finish is done.

**Report Codes/Points:** This routine prints the code table or the data file to the screen, file, or printer. A useful option here is to print the data file (CRD Points) and choose Sort by Codes which will group the data points by distinct codes.

![Report Codes/Points](image)

**Edit Codes / Points:** The Field to Finish dialog box allows you to load the coordinate and field code definition files, view and edit the code definitions, view and edit the coordinate file, view reports, and then return to the Draw Field to Finish dialog box to process the files. The top section displays the code definitions. The bottom section has three columns of functions each pertaining to controls for different elements of the command. The Code Table section provides controls for settings, sorting and reporting of codes. The Code Definitions section provides tools for the creation and editing of codes. The Coordinate File section provides controls for coordinate files and points. It also contains the Draw controls which starts the processing of the data using Draw Field to Finish.

The code table editor has a list of categories and a spreadsheet of codes. The spreadsheet shows the codes for the currently highlighted category. The category toolbar buttons allow you to add, remove, edit the names and change the order of the categories. There are two fixed categories. The Unassigned category shows any codes with blank categories. The All category shows all the codes. You can control which fields are visible in the spreadsheet by using the Column Options button. You can make edits to the fields in the spreadsheet or highlight a row and pick the Edit button to bring up a dialog to edit the code.
**Code Table**

**Code Table Settings:** These options provide tools for defining the coding method to be used for processing of the point data. Various import tools allow for the importing of codes from different software packages. Controls for handling multiple codes are located on this dialog. All special codes can be replaced to other characters defined by the user. The special codes are listed and edited on this dialog.

**Set:** Choose this button to specify a new code table. The name of the current table is shown in the field to the right of this button.

**Process Carlson Coding:** When checked, this option interprets and processes coordinate files based upon the Carlson Coding method and data collection method.
**Process Eagle Point Coding:** When checked, coordinate files are processed based on the Eagle Point Data Collection method. When selected the *Eagle Point Codes* button becomes available for selection and displays the following dialog. This dialog allows for customization of the eagle point special designators.

Currently the supported designators include, "Field Code", "Point-On-Curve", "Close Line", "Line End", "Insert Description" and "Bearing Close". Also supported is the ability to recognize overwriting of descriptions just as Eagle Point does by using the space separator instead of the "Insert Description" designator. Examples of supported coding are as follows:

- **.TC** Places a node and or line per the field code library.
- **TC** Places a node and or line per the field code library.
- **-TC** Specifies a point on a curve.
- **TC-** Specifies a point on a curve.
- **..TC** Stops the line.
- **TC!** Stops the line.
- **.TC+** Closes the line back to the starting point.
- **TC+** Closes the line back to the starting point.
- **.TC#** Typically coded on the third corner of a rectangle to close the figure with having to locate the fourth corner.
- **TC#** Typically coded on the third corner of a rectangle to close the figure with having to locate the fourth corner.
- **WV.W1** Places a node as specified by the code "WV" in the field code library and then begins a line as specified by code "W" in the field code library.
- **.TC.EP .FL** Results in three lines coming together.
- **TC1.TC2.TC3** Results in three lines coming together. All three lines are specified by the definition of the single code "TC" in the field code library.
- **TC.TC1** When used in conjunction with the "Draw Field Codes Without a Suffix as Points Only" toggle, "TC" will be recognized as the node and "TC1" will be recognized as the line so that if the code "TC" in the field code library is defined as a polyline, line or 3D polyline, duplicate lines will not be unintentionally placed when this shot only pertains to a single element. Keep in mind that all line work must have a numeric suffix when using this toggle.
- **TREE * OAK** Result on screen would be: TREE OAK
- **TREE OAK * Result on screen would be: OAK TREE**
- **TREE OAK** Result on screen would be: OAK
- **TC1.TC2.-VLT6#** Stops "TC1", continues "TC2" as a point on a curve and closes VLT6 as a rectangle using the "Bearing Close" code.

**Note:** The use of the "Use Multiple Codes for Linework Only" toggle is recommended when using Eagle Point Coding.

**Process CAiCE Coding:** When checked, coordinate files are processed based on the CAiCE Data Collection method. Examples of supported coding are as follows:

- **169** is just the code 169.
- **145C10** is the code 145 and line #10.
- **169C25C** is the code 169, line #25, and the point is on a curve.
Process SDMS Coding: This option processes coordinate files based upon SDMS coding method. When active, the program will prompt for an SDMS .PRJ file to process.

Split Multiple Codes:

Multiple codes are defined by including each code in the point description field separated by a space. A single data point can be used in different lines by assigning it multiple codes. For instance, a point might be part of both a curb line and a driveway line with a description of "CURB DRW". Field-to-Finish uses spaces as the delimiter for multiple codes. You should avoid spaces in the descriptions except for where multiple codes are intended or after the "/" character. For example, a code for light post should not be "LGT POST" but instead should be "LGTPOST".

There are three options for the handling of multiple codes when encountered. The **All** option will split all multiple codes and process each code based upon their code definition. When **None** is selected both codes will be processed based upon their code definition. If the **Prompt** option is checked on, when Field-to-Finish detects multiple codes on a point the following dialog will be displayed with options for handling the codes.

![Possible Multiple Codes Found](image)

Import Land Desktop Desc Key: This option imports and converts a Land Desktop Description Key into a Carlson Draw Field to Finish (fld) code definition file. The Land Desktop Description Key file is a mdb file and is found in the Land Desktop Project file path. It is located in the under the COGO/DescKey directory.

Import TDS Codes: This option imports TDS codes into the Carlson Field to Finish (fld) code definition file.

Import Eagle Point Codes: This option imports Eagle Point codes into the Carlson Field to Finish (fld) code definition file.

Import C&G Description Table: This option imports C&G code tables (tbl) into the Carlson Field to Finish (fld) code definition file.

Import Text/ASCII Codes: This option imports code definitions from a user-defined format. Each row in the text file should represent one code. The program will prompt for the delimiter (ie. comma separated) that is used in the text file and then for the field type for each of the columns (ie. "Layer" or "Description").

Import SurvCE Codes: This option imports a SurvCE Feature Code List (fcl) into a Carlson Field to Finish (fld) code definition file.

Export SurvCE Codes: This option creates a SurvCE Feature Code List (fcl) from the current a Carlson Field to Finish (fld) code definition file.

Draw Field Codes Without a Suffix as Points Only: This option is useful for when wanting to use a field code sometimes for linework and sometimes for just points but it is preferred to number the lines rather than using start
and stop codes. For example, if the field code EP is defined to use the Line Entity type, then EP25 will be drawn as a Line, however if just EP is used, no linework will connect to that COGO point.

Use Multiple Codes for Linework Only: When checked, and multiple codes are detected, only linework will be drawn for the secondary codes. Points are only created based on the primary code. If you want symbols for all multiple codes, then this setting should not be checked.

Max Delta-Height for Linework: Use this option to specify the maximum elevation difference that Draw Field to Finish should draw any section of linework. This option is for use with 3d polylines and lines.

Max Length for Linework: Specify the maximum length that Draw Field to Finish should draw any section of linework.

Substitution Codes: This option defines a lookup table for translations of the raw point descriptions. This translation is done as a pre-processing step before the regular Field-to-Finish processing. For example, if you had a substitution setup for "25" = "EOP", then a point description of "25" would get translated to "EOP" and then this "EOP" would be processed with Field-to-Finish.

Special Codes: This section allows you to substitute the existing predefined special codes and characters with your own. Draw Field to Finish recognizes several special codes. A special code is placed before or after the regular code with a space separating the code and special code. Here is a listing of the default special codes and characters.

**Special Characters**

The characters (*, -, +, /, and _) can be used and substituted in Draw Field to Finish. The way these characters are used is that when the file is processed the description field is searched for these characters. If the "+" symbol was changed to "-" then the program would look for "-" and change it to "+". This is useful when a particular data collector may not have all the symbols available. With these substitutions you can make a character that is provided on the data collector generate the symbol needed. Multiple characters can also be used. For example "-" can be used to in order to produce a "/" character or any of the characters listed above.

**Special Codes**

![Image of Special Codes dialog box]

Table: Special Codes

<table>
<thead>
<tr>
<th>General Special Codes</th>
<th>Point Symbol/Attribute Special Codes</th>
</tr>
</thead>
<tbody>
<tr>
<td>For Blk Code (No Elev)</td>
<td>For B1 Code (Blk Code)</td>
</tr>
<tr>
<td>For MULT Code (Multiple Field Codes)</td>
<td>For Blk Code (Blk Code)</td>
</tr>
<tr>
<td>For Character</td>
<td>For B1 Code (Blk Code)</td>
</tr>
<tr>
<td>For Character</td>
<td>For B1 Code (Blk Code)</td>
</tr>
<tr>
<td>For Character</td>
<td>For B1 Code (Blk Code)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Linework Special Codes</th>
<th>3D Face Special Codes</th>
</tr>
</thead>
<tbody>
<tr>
<td>For Blk Code (Begin Linework)</td>
<td>For Face</td>
</tr>
<tr>
<td>For Blk Code (End Curved)</td>
<td>For Edge</td>
</tr>
<tr>
<td>For Blk Code (Close)</td>
<td>For Edge</td>
</tr>
<tr>
<td>For Blk Code (Close Last)</td>
<td>For Edge</td>
</tr>
<tr>
<td>For Blk Code (Open Last)</td>
<td>For Edge</td>
</tr>
<tr>
<td>For Blk Code (Open Last)</td>
<td>For Edge</td>
</tr>
<tr>
<td>For Blk Code (Open Last)</td>
<td>For Edge</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>3D Face Special Codes</th>
<th>3D Block</th>
</tr>
</thead>
<tbody>
<tr>
<td>For Face Hole</td>
<td>For Face Wall</td>
</tr>
<tr>
<td>For Face HOLE</td>
<td>For Face WALL</td>
</tr>
</tbody>
</table>
Carlson points in the drawing have point attributes including a description. When Field-to-Finish draws the points, the point description from the coordinate file is processed to match a code. The code then defines the description that is drawn with the point. For example, consider a code of "UP" with a description of "POLE" and a data point with the description "UP". The data point description "UP" would be matched with the code "UP" and the point would end up being drawn with the description "POLE". A special character "/" (the forward slash or divide key) can be used for an unprocessed description to append. Everything after the "/" is added directly to the point description and is not considered a code and no further substitution is done on it. For example, a data point with the description "UP / 150" with the same code "UP" definition above would be drawn with the description "POLE 150".

This special code takes the part of the description after the "\" and puts it as the prefix before the point description. For example, a data point with the description "TR \ 24ft" and a "TR" code definition with a description of "Tree" would be drawn with a description of "24ft Tree".

This special code causes text after the "//" to be interpreted as a field code. That field code's description is then appended to the first field code's description. For example, if the field code 02 has the description 2" and the field code OAK has the description oak tree, then 02//OAK will result in the point having the description of 2" oak tree. If the "/" character has been replaced with a different character, for example with a & character, then the "//" code would become "&&".

This special code is the same as "//" except that field code's description is then prefixed instead of appended to the first field code's description.

MULT

This code applies when the Split Multiple Codes under Code Table Settings is set to None and you want to override this setting and explicitly split selected codes. Multiple codes apply to points with dual code definitions for drawing two different style points or for connecting different linework to the same point. For example, if a point is both a sidewalk and driveway corner, then the point description could be "SW MULTDR".

PC

This code begins a three point arc or a curved line when used with the "PT" code (see below). The point with this special code is the first point on the arc. The next point with the code is considered a point on the arc, and third point with the code is the arc endpoint. For example (in point number, X, Y, Z, description format),

10, 500, 500, 0, EP PC - start curve
11, 525, 527, 0, EP - second point on curve
12, 531, 533, 0, EP - end point of curve

PT

This is a special code that can be used with "PC" to define a curve with more than three points or a tangent two-point curve. Starting at the point with the "PC", the program will look for a "PT". If the "PT" is found, all the points between the "PC" and "PT" are used for the curve which is drawn as a smoothed polyline that passes through all points and only curves the polyline between points. If no "PT" is found, then the regular three point arc is applied as explained above. If no points are found between the "PC" and "PT", then the point prior to the "PC" and the point
after the "PT" are used to create tangents for the resulting curve.

**CTOG**
This special code toggles curve mode on and off. Instead of using PC to start a curve, you can use CTOG. Likewise, instead of using PT to end a curve, you can use CTOG.

**CLO**
This code forces the lines drawn between a series of points with the same code to close back to the first point with the same code. For example, shots 1-4 all have the BLD description with the exception of point 4. Its description is BLD CLO. This will force the linework drawn for the BLD code to close back to point 1 which is the first point with the description of BLD.

**GAP**
This special code makes a single segment break in the current linework. For example, if you have a curb polyline that you want to break to skip over a driveway, then you could add the GAP code at the start of the driveway and continue the curb as normal on the other side.

**NE**
This code represents no elevation. A point with this special code is located at zero elevation.

**NOS**
This code indicates that the point should be "non-surface"; that is, that it should be ignored when contouring or creating surfaces. This can also be controlled per-field code by turning on the Non-Surface toggle in the Edit Field Code Definition dialog box.

**Offsets: OH, OV, OFL, OFB**
The codes "OH" and "OV" stand for offset horizontal and offset vertical. These offset codes apply to 2D and 3D polylines. A single set of offset codes can be used to offset the polyline a set amount. For example,

```
10, 500, 500, 100, EP OH2.5 OV-.5
11, 525, 527, 101, EP
12, 531, 533, 103, EP
```

This would create a polyline connecting points 10,11 and 12 and an offset polyline with a 2.5 horizontal and -0.5 vertical offset. The direction of the horizontal offset is determined by the direction of the polyline. A positive horizontal offset goes right from the polyline direction and a negative goes left. The horizontal and vertical offset amounts apply starting at the point with the offset codes until a new offset code or the end of the polyline. Only one horizontal and vertical offset can be applied to 2D polylines. For 3D polylines, multiple offset codes can be used to make a variable offset. For example,

```
10, 500, 500, 100, EP OH2.5 OV-.5
11, 525, 527, 101, EP OH5.5 OV-.75
12, 531, 533, 103, EP OH7.5
```

This would offset the first point horizontal 2.5 and vertical -0.5, the second point horizontal 5.5 and vertical -0.75 and the third point horizontal 7.5 and vertical -0.75.

When there are multiple "OH" codes for the same point, the polyline is offset multiple times.

The "OFL" code stands for offset left horizontal. The only difference with the "OH" code is that you don't have to enter the "." to go left.
The "OFB" code stands for offset both left and right horizontal. For example, if the points follow the center of a ROW, the OFB code can be used to create the left and right edges of the ROW.

**SZ**

This code is used to set a different symbol size. The value of the new symbol size is specified after the SZ (example SZ2). This value is the actual size in drawing units. Two dimensional scales can be accomplished by using an 'X' between the horizontal and vertical scales (e.g., "SZ0.2X3.5"). If no number follows the SZ special code, then the next point with the same field code as the current point will be used to determine the size.

**ROT**

This code is used to set the rotation of the point symbol. If a point number follows the ROT code, then angle from the current point to this point number is used for the rotation. For example, "ROT45" would rotate the symbol towards point number 45. If there is no point number after the ROT code, then the rotation point is the next point number with the same code as the current point. ROT can also be used to rotate towards an angle clockwise from north by using '+' or '-' in front of the number. For example ROT+45 rotates the point symbol to the northeast and ROT-90 rotates the point symbol to the west.

**SMO**

This code is used to smooth the polyline.

**AZI & DIST**

The AZI and DIST codes are used together to locate an offset point. The AZI sets the offset azimuth and DIST sets the distance. The values should directly follow the code. For example, AZI25 DIST4.2 would draw the point offset 4.2 at an azimuth of 25 degrees.

**JOG**

The "JOG" special code allows for additional points to be inserted into the line work at perpendicular or straight offsets. Only offsets should follow the JOG code. Positive numbers indicate a jog to the right and negative numbers indicate a jog to the left. Alternatively, "R#" and "L#" can be used where # is the distance to either the right or the left. Finally, "S#" can be used to make an offset straight ahead by using a positive # or behind by using a negative #. For example, "BLDG JOG S10.1 R5 L12.2 L5 L12.2" or equivalently "BLDG JOG S10.1 5 -12.2 -5 -12.2" advances 10.1 units and then draws a closed rectangle on the right hand side of an existing line. The offsets are always done in the X-Y plane. If the current line is vertical, an offset to the right is along the positive X-axis.

**JPN**

The "JPN" (Join to Point Name) special code joins to the point named immediately after the code. For example, "JPN205" causes a line to be drawn from the current point to the point "205".

**NEAR**

This special code sets the current polyline to Nearest Found connection order. This applies to codes that have the Connection Order set to Sequential and you want to override this setting to Nearest Found for the current polyline.

**RECT**

The "RECT" special code causes a rectangle to be formed on a 2D or 3D polyline using one of two different methods. If a number follows "RECT" (e.g., "RECT10"), a rectangle will be drawn 10 units to the right of the last two points ending on the point with the "RECT" code. Use a negative offset to place the rectangle on the left side (e.g., "RECT-2.5"). For example if locating the left side of a 10’ rectangular concrete pad using the code conc for concrete, the description of the two left points would be (conc) for the first point and (conc rect10) for the second. If no number
follows "RECT", then the polyline will be closed by shooting right angles from the first point of the polyline and the
current point and creating a new point where those two lines cross. This method requires three points be established
on the pad.

**LTF**

The "LTF" (LineType Flip) special code switches the side for the linetype. This option applies to non-symmetrical
linetypes like the treeline or guard rail for when you want the linetype to face the other way.

**CIR**

The "CIR" special code stops the linework on the previous point and causes this point to create a circle in one of
three different ways. The first way uses just the current point as the center with the CIR special code followed
immediately by the radius. For example "CIR5.0" will create a circle centered on this point with radius 5 and at
the elevation of the current point. The second method uses two points, the first point specifying the center and the
elevation, and the second point specifying the radius. The third method uses 3 points that specify the perimeter of
the circle in 2D with the first point specifying the elevation. The "CIR" code can be used with all of the linetypes
including "points only". The circles are always parallel to the X-Y plane.

**For Multi-Point 2ND Code**

When used on the first point of a multi-point symbol, the "2ND" code indicates that the second point of the sequence
(i.e., the next point after the current one) should be used as the second symbol insertion point for a multi-point
symbol. Please refer to Symbol Pts in the Edit Field Code Definition section below.

**For Multi-Point 3RD Code**

When used on the first point of a multi-point symbol, the "3RD" code indicates that the third point of the sequence
should be used as the third symbol insertion point. The "3RD" code should be used with the "2ND" code. Please
refer to Symbol Pts in the Edit Field Code Definition section below.

**3D Special Codes**

Below are the special codes that can be used for the easy creation of 3D surfaces. The resulting 3D face entities can
be viewed in the Carlson 3D viewer by entering "cube" on the command line.
FACE3D

Makes a triangle mesh of 3D face entities by triangulating points starting with the current point and continuing until the line ends or another 3D special code is found. The points must be ordered along the perimeter. Although the mesh will be built if the points are clockwise or counterclockwise along the perimeter, the visible side in the Carlson 3D viewer, "cube", is the clockwise side by default. On the Advanced tab, the shading mode may be set to Shade both or Shade back if you would prefer to see both sides or just the counter-clockwise side.

HOLE3D

Makes an exclusion area within the triangle mesh identified by the point number following this code (e.g., "HOLE3D101" will start a hole in point # 101). If no point number is given ("HOLE3D"), the exclusion area is applied to the last mesh or if there is a mesh in the process of being constructed by the current sequence of points, it is ended and the hole is applied to it. Note that a hole can only be applied to a mesh that was created by FACE3D (not BLOCK3D or WALL3D). Note also that it can be difficult to predict what the "last mesh" was if it used a different field code since the points of the coordinate file are processed by order of field code first and then point number. There is no limit to how many holes can be applied to a FACE3D mesh. The points of the hole itself are not added to the FACE3D mesh; they are projected on to the best plane that contains the FACE3D mesh and then the hole is cut-out.

Example 1:
2500 HOUSE1 FACE3D/front of house
2501 HOUSE1
2502 HOUSE1
2503 HOUSE1
2504 HOUSE1
2505 VENT1 HOLE3D2500/applies 2505-2508 as a hole to last mesh that uses point #2500. So any point in the range 2500-2504 would have the same effect.
2506 VENT1
2507 VENT1
Example 2:
2500 HOUSE1 FACE3D /front of house
2501 HOUSE1
2502 HOUSE1
2503 HOUSE1
2504 HOUSE1
2505 HOUSE1 HOLE3D/stops the above mesh and applies 2505-2508 as a hole
2506 HOUSE1
2507 HOUSE1
2508 HOUSE1

Example 3:
2500 HOUSE1 FACE3D /front of house
2501 HOUSE1
2502 HOUSE1
2503 HOUSE1
2504 HOUSE1
2505 WINDOW1 FACE3D HOLE3D2503/applies 2505-2508 as a hole to above mesh 2500-2504 and starts a new mesh using the WINDOW field code.
2506 WINDOW1
2507 WINDOW1
2508 WINDOW1

Example 4 (same result as Example 3):
2500 HOUSE1 FACE3D /front of house
2501 HOUSE1
2502 HOUSE1
2503 HOUSE1
2504 HOUSE1
2505 WINDOW1 FACE3D /starts a new mesh using the WINDOW field code.
2506 WINDOW1
2507 WINDOW1
2508 WINDOW1

/block3d

Makes a set of 3D faces to make a 3d block using the height value entered after the code (e.g., "BLOCK3D2.3" with height 2.3). Heights can be positive or negative. With 3 points, makes a parallelogram base that is extruded up (or down if height is negative) to form a 6-sided block, including top and bottom. With 4 or more points, makes a closed polygon for the base that is then extruded by the height. The points can be laid out in clockwise or counterclockwise order around the perimeter. The perimeter or base does not have to be a convex polygon.

/wall3d

Makes a set of 3D faces above the polyline using a height value entered after the code (e.g., "WALL3D2.3" with height 2.3). The height can be negative if the points on the top of the wall have been shot. If no parameter exists, then the height is determined by the distance from the current point to the next point. This is a signed distance so the surveyor can shoot either the top of the wall or the bottom of the wall. Both sides of the wall will have triangles and so both sides will always be visible in the Carlson 3D viewer "cube".
Example 5 – 6’ high wall shot along the bottom:
2000 1000.000 1060.000 100.000 WALL1 WALL3D6.0 /wall 6’
2001 1100.000 1060.000 100.000 WALL1
2002 1100.000 1160.000 100.000 WALL1

Example 6 – 6’ high wall, height specified by 1st to 2nd point, shot along the top:
2020 1100.000 1160.000 100.000 WALL2 WALL3D /height by 2nd pt
2021 1100.000 1160.000 106.000 WALL2
2022 1000.000 1160.000 106.000 WALL2

**Code Table (continued)**

**Sort Table** - This sorts the code table by either code name or layer.

**Report Codes/Points** - This routine prints the code table or the data file to the screen, file, or printer. A useful option here is to print the data file (CRD Points) and choose Sort by Codes which will group the data points by distinct codes.

![Code Table](image)

**Code Table by CRD** - This command will create code table definitions based on the coordinate file field descriptions. This is useful when creating a code table from scratch.

**Save**: Saves the Draw Field to Finish field code definition (.FLD) file.

**Save As**: Reacts the same as Save but allows for specification of file name and location to save to.

**Code Definitions**

**Edit**: If only one field code is selected, then this command opens the Edit Field Code Definition dialog box. If multiple field codes are selected (by holding down the control key or shift key and clicking on the rows), then the Multiple Set dialog box will open.
Field-to-Finish will layerize the points and linework according to the code definitions. If the layers to use are not already defined, Field-to-Finish will create the necessary layers and assign different colors. To have the same colors for these layers in all your drawings, define the layers in the prototype drawing. The prototype drawing is the default drawing that is loaded whenever a new drawing is created. To define layers in the prototype drawing, save your current drawing and then start a new drawing with the New command. Don’t give the new drawing a name, just click OK. Then define the layers as desired with the Layer command. When you are done creating layers, use the Save As command and change to Drawing Template (.DWT) under Save as Type. The default drawing template that is used is named Carlson09.DWT. This template name will correspond to the version of AutoCAD that is being used. You can overwrite this default template or make a new drawing template. If you make a new one, you may want to edit the Carlson icon to use the new one. To edit the icon, highlight the icon with one click and then click the right mouse button. Choose Properties and then Shortcut and change the drawing template name.
Category: This is an optional field that can be used to help organize your codes. A category is not used for processing and only is useful in viewing and printing.

Processing ON: This toggle controls whether this code will be processed.

Sequence: This specifies a sequence type code. Sequences are a way to simplify field entry of a sequence of codes. For example, a road cross-section could be SHD1 EP1 CL EP2 SHD2. Instead of entering these different descriptions, one sequence definition can store these descriptions in order. Then just the sequence code (such as RD) is used in the field. The cross-section can be shot in left to right then left right order, right to left then right to left order, or alternating left to right then right to left order. The alternating method is known as the Zorro style. The one restriction is that the shots always start from a right or left edge.

To set up a sequence, choose the Sequence toggle in the Edit Code dialog. Then pick the Define Code Sequence button. This brings up a dialog for entering the sequence codes in order. These sequence codes should be defined as normal codes somewhere else in the Draw Field to Finish code table (ie SHD as a 3D polyline). In the field, the one template code is used for all the cross-sections shots (ie RD for all the points). Then Draw Field to Finish will substitute this template code with the sequence codes (ie substitute RD with SHD).
Resulting points and linework showing Zorro style template

**Define Code Sequence:** This sets the code names that make up the sequence.

**Point Groups:** This field is for the name of the point group that all points with this code will be added to. If the points for this code belong to multiple point groups, you can specify multiple point group names in this field separated by commas. Under Draw in Additional Draw Options, there is an option whether to automatically use the code name as the point group name or to use the name defined in the code definition.

**Companion Codes:** This option allows different codes to connect when defined as line, polyline or 3D polyline. For example, a main line power pole code may be defined as PP while a service utility pole may be defined as UP. When processing Draw Field to Finish, it may be desired to connect all PP and UP codes together. This could be accomplished by defining a companion for UP as PP and a companion code for PP as UP. Each code needs to reference the other as a companion code.

**Fixed Parameters:** This option is a coding method where you specify a sequence of parameters that follow the main code. There can be up to three parameters and these parameters can be an additional description or special codes Size, Rotate, Azimuth, Distance or Offsets. The purpose for Fixed Parameters is to save keystrokes by not having to enter the special code prefix. For example, for a code TR for Tree along with a size 12 feet and description
of Oak, the special code description would be "TR SZ12 // OAK". With Fixed Parameters of Size and Description, the description would be "TR 12 OAK".

**Code:** This is the key name that identifies the code and is matched with the field data descriptions. It is important to note that the * character, used in this field, is regarded as a wildcard or "match anything" code. For example, a field code definition with the code defined as TREE* will be used for any raw description of TREE. Raw descriptions of TREEA, TREE12, TREE, etc. will match the TREE code definition. This will always be the case unless there is a more specific code is found. For example is there was a code TREEA in the code definition file, then that code would be used instead of the TREE code.

**Full Name:** This is an optional field that describes the code for viewing.

**Layer:** The point and line work for the code will be created in this layer.

**Description:** This value is assigned to the point description attribute when the point is drawn. This description can be different than the field description. An additional description can be added to a point by entering it after a forward slash in the data description field.

**Use Raw Description:** This option turns off the Description field described above. Instead the points will be drawn with their original unprocessed descriptions.

**Dual 3D Polyline Layer:** Displays the layer that the 3d polyline will drawn on when using an Entity Type of 3D and 2D. The layer name can be typed in this field.

**Set 3D Layer:** Sets the layer that the 3d polyline will drawn on when using an Entity Type of 3D and 2D. The layer can be selected from the list or typed in at the bottom of the dialog box.

**Set Linetype:** Line work can be drawn in any of the special linetypes or with the linetype for the layer ("BYLAYER"). There are three types of pre-defined linetypes: CAD, Entity and Continuous. The type is shown as part of the linetype names in the list. The CAD linetypes are the default linetypes available in AutoCAD and IntelliCAD. The Entity linetypes insert text or symbol entities at the linetype interval. These linetypes are the same as used with the Annotate->Polyline To Special Line command. The Continuous linetypes define a special linetype in CAD and create continuous polylines with that special linetype. These linetypes are the same as with the Annotate->Change Polyline Linetype command. Besides these pre-defined linetypes within Field-to-Finish, you can also use any linetype that is defined in the drawing by entering that linetype name in the linetype edit box or by picking the Select From Drawing button within the Set Linetype dialog. The spacing and size of the special linetypes is determined by the CAD LTSCALE system variable and by the field code settings Line Type Spacing Scaler and Line Type Text Scaler. The special linetype "hedge" is drawn with a user specified width. You will be prompted for this information when you select that linetype. The special linetype "userdash" is drawn with user specified distances for the length of the dash and the length of the gap between dashes.
**Set Symbol:** This is the point symbol for the code. The dialog allows you to select from the symbols defined in the Symbol Library which is setup with the Settings->Symbol Library command. Besides the symbols from the symbol library, you can also use any symbols that are defined as blocks in the current drawing by entering the block name in the symbol edit box. To have a point without a symbol, use the Carlson symbol named SPT0 which represents "no symbol".

**Symbol Pts:** For each code definition, the symbol insertion points can be defined with up to three points. To define the symbol insertion points, choose the Symbol Pts button in the Edit Code Definition dialog box. By default, the symbol insertion is defined by one point at the symbol center (0,0). A one point insertion definition can be used to insert a symbol offset from the center. With a two insertion point definitions, the program will rotate and scale the symbol. For example, two insertion points can be used to insert a tree symbol to size the tree, where the first point is for the tree center and the second is for the drip line. With three insertion point definitions, the program will rotate and scale the symbol in both X and Y. For example, three points can be used to insert a car symbol with the first point being the front drivers side, the second point as the back driver side (to rotate and scale the length) and the third as the back passenger side (to scale the width). Besides the insertion point coordinates, you can define a description for each point which is used for the drawn point description and is used for prompting in the Insert Multi-Point Symbol command and in Carlson Field data collection.

![Define Symbol Placement Points](image)

<table>
<thead>
<tr>
<th>Point</th>
<th>X</th>
<th>Y</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>10.20</td>
<td>2.90</td>
<td>Front Driver Side</td>
</tr>
<tr>
<td>2</td>
<td>-7.40</td>
<td>2.90</td>
<td>Back Driver Side</td>
</tr>
<tr>
<td>3</td>
<td>7.40</td>
<td>2.90</td>
<td>Back Passenger Side</td>
</tr>
</tbody>
</table>

Three Point Symbol Drawing

The coordinates for the insertion point definitions are for the symbol at unit size. To figure these coordinates, you will need to open the symbol drawing (.DWG) file. By default, the symbols are located in the Carlson SUP directory. For example to make an insertion point for the tree drip line, open the tree symbol drawing and find the coordinate...
at the edge of the tree symbol (in this case 0.5,0.0).

Two Point Symbol Drawing

Not all of the symbol insertion points need to be used when drawing the points. If a code definition has a three insertion points, it is possible to use just the first two or first one. There are special codes to associate multiple points to the same symbol. The first code point is used as the first symbol insertion point. The "2ND" code is used to specify the second symbol insertion point. A point number can follow the "2ND" to identify a specific point. Otherwise without the point number, the program will use the next point with the current code. The "3RD" code is used to specify the third symbol insertion point and similar to the "2ND" code, a point number after the "3RD" is optional. The "2ND" and "3RD" codes should be assigned to the first point. For example, consider a code of "CAR" with a three point symbol insertion definition. If point #1 has a description of "CAR 2ND 3RD", then point #1 will be used as the first symbol insertion point and the next two points with the "CAR" description will be used as the second and third symbol insertion points.
Multi Point Symbol Drawing

**Custom Attributes:** This feature allows you to use customized blocks that have customized attributes (the tag/value pairs). This feature works for both point attribute blocks and symbols. For attribute blocks, Field-to-Finish looks for attributes with the tags "PT#", "ELEV2", and "DESC2". The custom attributes feature allows you to define up to an additional 5 attributes in their custom blocks on a per-field code basis. For example, the custom block could have an attribute with the tag "TREE_SPECIES" and there's a separate field code for each species of tree. Each of those field codes can specify the value that should be assigned to the attribute that has the TREE_SPECIES tag. Then when the points are drawn, the tree species is shown. Note that the custom attributes must have their Constant and Preset properties set to "no". The custom attributes settings in F2F should not use those tags that the software already handles (PT#, ELEV2, and DESC2), or the setting will be ignored.

**Set Color:** The line work will be drawn in this color. The default is BYLAYER.

**Text Size Scaler:** This is a scaler value that is multiplied by the horizontal scale to obtain the actual size.

**Symbol Size Scaler:** This is a scaler value that is multiplied by the horizontal scale to obtain the actual size in the drawing. The horizontal scale can be set in *Drawing Setup.*
**Line Width:** This controls the width for the linework. Only applies to 2D polylines.

**Line Type Spacing Scaler:** This is a scaler value that is multiplied by the CAD LTSCALE system variable to give the distance between symbols in the line.

**Line Type Text Scaler:** This is a scaler value that is multiplied by the CAD LTSCALE system variable to give the size of the text in a line.

Line Type Text: This is the text that is used for the user-defined linetype. First use Set Linetype to either Other_E or UserDef_C. Then this text will be used for the linetype. For example, if you have a code for a 8'' PVC pipeline, then you could set this text to 8'' PVC.

Flip Linetype: This option switches the side for the linetype which applies to non-symmetrical linetypes like the treeline or guard rail.

**Unit Symbol:** This option will draw the point symbol at unit (1:1) scale. For example, this option could be used for a symbol that is already drawn to actual dimensions such as a car symbol.

**Set Template:** For 3D polyline codes, this option allows you to assign a template (.TPL) file to the code. The code points act as the centerline for the template and the program will draw parallel 3D polylines for each break point (grade ID) in the template. The template file is defined in the Civil Design module.

**Entity Type:** This defines the line entity to be created. Points only does not create any line work. 3D Polyline can be used for breaklines. 3D and 2D entity type selection creates a 3d polyline in the layer specified in the Dual 3d polyline layer setting and a 2d polyline in the layer identified in the Layer setting. Since 3d polylines do not display linetypes, this is useful when needing linework in 3d for design work while also needing to display linetypes for final plotting of the drawing. This provides an easy and quick way to turn off all 2d polylines or all 3d polylines by using the layer control dialog or the appropriate toggles in the Draw Points dialog.

**Attribute Format:** This chooses the type of point entities to create. The Attribute Block format creates the Carlson point entity which is block with attributes for point#, elevation and description. The Text Attribute format creates text entities for each of the point attributes. When the Text Attribute format is selected, the Set button is available where you can control which attributes to draw as text and the position, decimals, style, prefix, suffix and layer for each attribute.

![Point Attributes as Text Settings](image)

**Separate Attribute Layers:** This controls the layers of the point and symbol attributes. With "None" the point layers are the standard layers, "PNTNO", "PNTELEV" and "PNTDESC", and the symbol layer is "PNTMARK".

---

Chapter 11. Survey Menu 580
With "Points" or "Both" the point attribute layers begin with the layer for the code followed by the attribute type. For example, the "DWL" code shown in this dialog has a layer name "DRIVEWAY". The point attributes would then be "DRIVEWAYNO", "DRIVEWAYELEV" and "DRIVEWAYDESC". With "Symbols" or "Both" the symbol attribute layer begins with the layer for the code followed by "MARK".

**Hard Breakline:** This will tag the 3D polylines created with this code as hard breaklines. In *Triangulate & Contour*, contours are not smoothed as they cross hard barriers.

**Smooth Polyline:** This applies a modified Bezier smoothing to the polyline. The smoothed polyline will pass through all the original points.

**Connection Order:** The points of a distinct code can be connected in their point number order or by nearest found which makes the line by adding the next closest point.

**Tie:** When checked the linework drawn with this code will always close. For example if you have points 1, 2, 3, and 4 with the code BLDG and Tie is checked on for the code BLDG, then the linework will be drawn from point 1 to 2 to 3 to 4 and then back to point 1, closing the figure.

**Elevation Integers:** This controls the number of digits to display to the left of the decimal point for the elevation label. The All setting will show the full elevation digits. The other settings allow you to limit the number of digits to display for the purpose of reducing the amount of space the elevation labels take up in the drawing. For example, if a site is in the 4000 foot elevation range, then this setting could be set to three digits (000) and an elevation of 4321 would be labeled as 321.

**Elevation Decimals:** This controls the display precision for the elevation label.

**Elevation Prefix/Suffix:** These set the prefix and suffix for the elevation label per code. In the Draw function under Additional Draw Settings, there is an override to set the elevation prefix/suffix for all the codes.

**Attribute Layout ID:** Controls the location of the point number, elevation and description. These attribute layouts are defined in the drawings that are stored in the Carlson SUP directory with the file name of SRVPNO plus the ID number (i.e. SRVPNO1.DWG, SRVPNO2.DWG, etc.). If you want to change the attribute positions for a layout ID, then open and edit the associated SRVPNO drawing.

**Locate Pts on Real Z Axis:** This option will draw the points at the actual point elevation. Otherwise the points are drawn at zero elevation. For example, you could turn this option off for the FH for fire hydrant code to drawn them at zero. Then the GND code could have this option on to draw the ground shots at their elevations.

**Random Rotate:** This option will randomly rotate the symbol. For example, this option could be used for tree symbols to have the trees drawn in various orientations.

**Random to Line:** This option applies to points that are part of Field-to-Finish linework. This option will align the point attributes and symbol to the associated linework.

**Distinct Point Layer:** When this toggle is selected, the line work is created in the layer defined in the Layer field and the points are created in the specified distinct point layer. For example, you could have DRIVEWAY for linework and DRIVEWAY_PNT for the points.

**Select All:** This option selects all the codes. This can be used when only wanting to process a couple of codes. For example, use the select all option to select all the codes and then turn them off. Now select the codes for processing and turn them on. Also it can be used to make a global change to all the codes.

**Add:** The new code definition is inserted in the list in the position after the currently selected one. If none are selected for positioning, the new code is placed at the top. Only one code definition may be highlighted before running this routine.

**Copy:** This option copies the definition of a selected code. It opens the Edit Field Code Definition dialog and copies the definition of the selected code to the appropriate settings. It does not copy the name of the code. It is a time saving tool to use when creating codes that are similar with only a couple of differences.

*Chapter 11. Survey Menu* 581
Cut: This command will remove the highlighted code definitions from the list and puts them in a buffer for retrieval with Paste.

Paste: This command will insert the code definitions put in the buffer by the Cut command. These codes will be inserted after the row of the currently highlighted code or at the top.

Search: Allows you to search for a specific code in the list.

Coordinate File
Set CRD File: This command allows you to specify a coordinate (.CRD,.CGC,.MDB,.ZAK) file to process.

Edit Points: This command opens the Edit Points spreadsheet editor. See Edit Points for more details.

Draw: This command returns to the Draw Field to Finish dialog box.

PointCAD Coding
Field-to-Finish supports an early Carlson style of linework coding called PointCAD. The PointCAD codes use numbers with +,-,* symbols as follows:
+0 Starts a regular 2D line (not a polyline) that is open.
*0 Starts a regular 2D line that is closed.
+4 Starts a curved 2D polyline that is open.
*4 Starts a curved 2D polyline that is closed.
+1 Begins a 3-point arc.
-0 or -1 or -3 or -4 or -5 or -6 or -7 Ends a line.
+5 Starts a 3D polyline that is open.
*5 Starts a 3D polyline that is closed.
+6 Starts a 2D polyline that is open.
*6 Starts a 2D polyline that is closed.
+7 starts line whose type (2D line, 2D polyline, 3D polyline) is specified by the point's field code definition. If the field code definition is to use points, then a 2D line is started.
+2 Middle point of 3 point arc
-05 starts a curved 3D polyline section.
-50 ends a curved 3D polyline section.
+8 starts a 2D and 3D polyline combination that is open.
*8 starts a 2D and 3D polyline combination that is closed.
-8 ends a 2D and 3D polyline combination.
-08 starts a 2D and 3D polyline combination curve that is open.
-80 reverts back to a straight 2D and 3D polyline combination.
PointCAD linework coding examples

**Pulldown Menu Location:** Survey  
**Keyboard Command:** fld2fin  
**Prerequisite:** A data file of points with descriptions

### Field to Finish Inspector

This command reviews entities in the drawing created by Field To Finish. Point descriptions can be edited and the drawing is updated for both the point symbols and linework, using the Field To Finish coding.

Field to Finish Inspector docks a control panel dialog at the bottom of the screen which leaves the drawing view at the top.

**Code:** Lists the field codes that were found in the drawing. Clicking on a code causes the Instance list to show all of the linework and points that use the selected code.

**Instance:** Lists the linework and points of the currently selected code.

**Point:** Lists the points that make up the currently selected linework or point in the Instance list.
Go to Point#: Type in the point # to see in the drawing and then press this button to bring the point # into view. If the point # is not in the drawing, then a message will be printed at the top of the dialog box. If the Zoom toggle is on, then the point # will be brought to the center of the screen even if it was already visible on the screen. Likewise, if Isolate or Highlight are on, then those options will be applied, too.

Zoom: Check this checkbox to make the Field to Finish Inspector automatically zoom and pan the drawing so that the selected items in the above lists are viewable. Zoom is used on the Code and Instance lists. Pan is used for all three lists.

Isolate: Check this checkbox to make the Field to Finish Inspector only display the selected items in the above lists.

Highlight: Check this checkbox to make the Field to Finish Inspector highlight the selected items in the above lists.

Restore View On Exit: Check this checkbox to make the Field to Finish Inspector restore the zoom and pan values when you exit.

Desc: This edit box will display the description field from the coordinate file used on the given point(s). If the points do not all have the same description in the coordinate file, *varies* is displayed instead. If you type in a new description and then click on Apply, the new description will be applied to the coordinate file and Field-to-Finish will be used to process the coordinate file and update the drawing, including linework. Press the Code button to place an existing field code into this Desc edit box.

Code: Press this button to select a field code from the current field code definition (FLD) file. The following dialog box is an example of what you will see. The Categories on the left are the categories that are defined in the current field code definition file. The list on the right is all of the field codes in the selected category. Select (all categories) to see all of the codes in all of the categories. The selected field code will be placed in the Desc edit box.
Apply: Press this button to apply the modified description that is in the Desc edit box to the currently selected points. The below dialog box will come up that lists exactly what will be changed. Optionally, the raw file that was used to create the coordinate file will be updated as well. Press OK to continue. The description will be updated in the coordinate file and then Field-to-Finish will be used to process that coordinate file and finally the drawing will be updated to reflect the changes.

Pulldown Menu Location: Survey
Keyboard Command: f2f_inspect
Prerequisite: Entities created by Field-to-Finish
File Name: \lsp\finish.arx

Enter Deed Description

This command lets you enter line and curve data which is drawn and annotated as entered. When entering in data, the bearing quadrant and bearing value is input on the same line. For example, a bearing of N45-10-30E would be entered as 145.1030, where (1) represents the NE quadrant. The numeric codes for the quadrants are 1-4 beginning with NE as (1) and continuing sequentially in a clockwise direction to the NW quadrant (4). Distance data can be entered in Varas, Meters, Poles, Chains or US Feet. Curve data can be entered for Non-Tangent, Reverse-Tangent and Tangent curves. Data used to define curves includes but is not limited to Tangent Out Bearing, Radius data, Chord Bearing, DeltaAng and Tangent Length. Prompting for curve data it determined by what curve definition data is used. When you are finished, the closure and area of the figure is reported. The program has the option to Undo the previous data entry in case you need to re-enter values. Also, the program auto-saves the data entered during the
command so that if the command is canceled and restarted, there's an option to resume entering data. The command starts with the dialog shown here.

![Image of the dialog box](image)

**Line and Curve Layer**: Specify the layer name for lines and arcs.

**Annotations Layer**: Specify the layer name for the annotation text.

**Points Layer**: Specify the layer name for the points.

**Traverse by**: Select between entering bearings, azimuth, gons or point numbers. The points option recalls points from the current coordinate (.CRD) file.

**Point Format**: Choose between creating Carlson points in the coordinate (.CRD) file at each point in the figure, drawing descriptions only or having no point labels.

**Line-Curve Annotations**: Specify whether the annotation should be drawn on the lines and arcs or should be added to line and curve tables.

**To Table Scaler**: Used only when the above setting is set to On Lines. If the line or arc length is less than this value multiplied by the horizontal scale, then that annotation will be entered in the line or curve table. For example, if the horizontal scale is 50 and you enter a table scaler of 1.5, then all short curve and line annotation less than 75' (1.5*50) will go to the table.

**Deed Name**: Specify the beginning deed name. Only available when Store to Deed File is checked on.

**Draw Linework**: Specify whether or not to draw linework, if this is disabled then all annotation options are disabled also.

**Prompt for Descriptions**: Specify whether or not the program should prompt you for point descriptions. If this is not checked, then point descriptions are blank.
Prompt for Elevations: Specify whether or not the program should prompt you for point elevations. If this is not checked, then point elevations are set to zero.

Plot Point Symbols: If the Point Format is set to Descriptions Only or None, this option is available. It will place point symbols without creating points in the coordinate (.CRD) file.

Create Radius Points: When checked, radius points will be created for arcs. Radius points are given the description RADPT.

Store to Raw Data (.RW5) File: When checked, data entered will also be written to a raw data (.RW5) file that can be opened using the Edit-Process Raw Data File command. This file can be used to perform coordinate adjustments. The compass rule, crandall rule, transit rule, angle balance adjustment and least square adjustment routines are all available. See Edit-Process Raw Data File for more information.

Store to Deed File: When checked, data entered will be written to a deed (.PDD) file. This file can be processed later to correct errors, create deed reports or to redraw the deed. To use this option, set the deed file name by picking the Specify File Name button. Also set the Deed Name field.

Specify Deed File Name: Before specifying the deed (.PDD) file name, choose New or Append/Revise from the Deed File Parameters below. Only available when Store to Deed File is checked on.

Prompts

Pick point or point number: 1

PtNo. North(y) East(x) Elev(z) Description
1 8000.00 12000.00 0.00

In this example the coordinate for point number one has already been stored in the current coordinate (.CRD) file with the Draw-Locate Points command.

Undo/Exit/Curve/<Bearing (Qdd.mmss)>: 145.3035
Varas/Meters/Poles/Chains/<Distance(ft)>: 210.5 Enter P to input a distance in Pole format or C for Chains format.

Undo/Exit/Curve/<Bearing (Qdd.mmss)>: C Enter C to traverse through a curve.

Tangent-out/Radius: R

Radius: 1103.5

Curve direction (Left/<Right>)? press Enter for right

Non-tangent/Reverse-tangent/Chord/Delta angle/Tangent/<Arc length>: N If the curve is tangent to the previous leg then enter the arc length, enter C for a chord length, D to enter the delta angle or T to enter the tangent distance. In this example we have a non tangent curve so we entered N.

Curve direction input [<Chord>/Radial]?: C

Chord Bearing (Qdd.mmss): 245.2341

Length of Chord: 201.22

Undo/Exit/Curve/<Bearing (Qdd.mmss)>: 345.3218
Varas/Meters/Poles/Chains/<Distance(ft)>: 209.28

Undo/Exit/Curve/<Bearing (Qdd.mmss)>: 445.2348
Varas/Meters/Poles/Chains/<Distance(ft)>: 200.54

Undo/Exit/Curve/<Bearing (Qdd.mmss)>: E Enter E to end the prompting and calculate the closure error.

Closure error distance > 1.35251089 Error Bearing > N 70d41'35'' E

Closure Precision > 1 in 607.63 Total Distance Traversed > 821.82
Deed Reader

This command is used to extract deed line and curve data from the text of a deed. It shows the deed data in a spreadsheet and also graphically. The deed data can be saved to a deed file, drawn and reported. A blank Deed Reader dialog box appears as soon as the command is chosen.

The Text section is for entering in ASCII/TXT data for the deed. This can be accomplished by using the Paste button at the bottom of the dialog, or loading a filing using the Load button. You can also type information directly into this screen. Reader Warnings indicates irregularities in the deed text. The Result section is below that. This section will give you a detailed, editable spreadsheet of the deed, which can be saved. At the very bottom of the dialog is a section called Summary. Here is where you will see the mathematical and closure data for this deed displayed.

Paste: This is for pasting in copied information.
Load: This option will load an existing deed text (.TXT) file. Here is an example.
Quick Settings: This option allows you to set up, in a speedy fashion, the detailed criteria for this Deed Reader command.

Settings: A more formal settings feature, which is more methodical and dialog box driven.
**Draw**: This option will provide you choices as to how the date will be translated to the drawing screen.

It is in the Draw Options dialog that you can make decisions as to how detailed and involved your drawing will be. The Points section is key if you desire to have points created to a new coordinate file, or if you want to append an existing one. In the Annotations section, if Label Lines and Arcs is clicked on, the next dialog that you see, after choosing a point of origin, will be Auto-annotate. Finally, click OK.

**Prompts**

**Deed Reader dialog**: enter in or load the deed text

**Pull-down Menu Location**: Survey

**Keyboard Command**: read_legal

**Prerequisite**: Deed text
Process Deed File

This command contains several functions for deed (.PDD) files. A deed file consists of one or more deed descriptions. Each deed description includes a deed name, starting coordinate and line/curve data. This deed data can be created with the Enter Deed Description command. This command begins with the Process Deed File dialog.

**Edit** opens the Edit Deed dialog where you can view or modify the deed name, starting coordinates, or line/curve data. Within this dialog the following commands are available.

**Add** opens the Edit Deed dialog where you can add a new deed.

**Remove** removes the currently highlighted deed.

**Export** saves the selected deed data (pdd) in raw file format (rw5) that can be used with Edit-Process Raw File.

**Report** generates a report for the currently highlighted deed. The report is displayed in the Standard Report Viewer.

**Draw** draws the currently highlighted deed in the drawing and returns to the main dialog. The actual geometry will not appear in the drawing until you exit Process Deed File. Use the Auto-Annotate command to label the deed.

**Save** saves the currently loaded deed (.PDD) file.

**Save As** allows you to save the currently loaded deed (.PDD) file to another file name.
List selects the starting coordinate from a point selection list from the current coordinate file.
Pick allows you to screen pick the starting coordinate.
Order allows you to set the sequence of the columns in the spreadsheet editor.
Add allows you to add a new deed call (line or curve).
Remove removes the highlighted deed call.
Move Up/Down change the list order of the data records for the currently highlighted row.
Angle Format chooses between using one spreadsheet cell for the angle in dd.mmss format or using three cells with dd, mm and ss in separate cells.

Pulldown Menu Location: Survey
Keyboard Command: deed
Prerequisite: None

Deed Linework ID
This command is used to report the deed name associated with selected linework. Since the Carlson deed commands that draw deeds attach the deed name to the linework, this command will extract that information and list it out. You can choose to select more than one deed linework entity before ending out of the command.

Prompts

Select deed linework to identify: select deed linework
Deed Name: Out Lot3 - Carlson Property
Select deed linework to identify (Enter to end): select Enter

Pulldown Menu Location: Survey
Keyboard Command: deed_id
Prerequisite: A deed name assigned to the entity

Deed Correlation

This command takes a set of field and design/deed points and creates an inverse report, such as radial stakeout, for each pair of points. It includes a routine to find the best point to hold and the best point to rotate to. This command provides tools for the correlation of surveyed points with that of deed input points. Different points can be specified as hold points, or rotation points, and provide a report showing the bearing and distance of all sides of the traverse/deed, based upon the hold and rotation points. This allows for the review of different scenarios based upon hold and rotation points. Perhaps two points in the field are in good shape, and seem to meet all the descriptions thereof. You decide to hold these two points as good, but you would like to see what holding these points will do to each side/call of the tract/description. This is what this routine is designed to do. In addition to allowing user specified trials of different hold and rotation points, the routine also provides a Find Minimum Rotation option that will report which points specified as the hold and rotation points will result in the minimum rotation of all sides of the tract/description. All points must be contained in the same coordinate file, and the points to be used in the correlation must be specified as either Survey points or Deed points.

Edit: This button allows for editing of the highlighted/selected Survey and Deed point. Once selected the dialog above is displayed allowing for changes to be made.

Add: Click this button to specify the points as either Survey or Deed points. Then fill out the Edit Points dialog as desired.

Remove: This button will remove the highlighted/selected Survey and Deed points from the correlation setup. This does not delete the points from the coordinate file.

Inverse Report: This generates a report showing the inverse data from each point, both survey and deed, to every other point specified in the correlation set up. For example if there were four points in the survey points (1-4) then the report would show inverse data from 1 to 2, 3,4; from 2 to 1,3,4; from 3 to 1,2,4 and from 4 to 1,2,3. This would be the same for the corresponding deed points.
**Compare Before Align:** This option compares the survey information to the deed information.

**Check Align:** This option allows for user specified hold and rotation points, and then reports the inverse data of each side of the tract/description. The hold point and rotation point must be points from the specified survey point group.

**Find Min Align:** Determines the hold and rotation points that would result in the minimum rotation to each side of the tract/description. When selected the Minimum Deed Rotation Report is displayed.

**Apply Alignment:** This option can be issued after the Min Align criteria is set.

**Save:** Performs a quick save if the file has previously been saved.

**Save As:** This option prompts for a user specified file name and allows for a user specified location to save the file. The file extension for the deed correlation file is dcf. When executing the program you have the option of using an existing file or creating a new file for the deed correlation.

**Exit:** This button end the routine.

**Help:** This button displays the help topics relating to the Deed Correlation routine.

After specifying the hold and rotation points, the deed correlation report will display again, showing the bearing and distance of each side of the tract/description.
Chapter 11. Survey Menu

Check Deed Rotation

Hold Pivot Point
Survey: 6  Deed: 1
Rotation Point
Survey: 7  Deed: 2
Translate X: -2.956 Y: -1.310
Rotation: 0°03'10"

Survey Pt Deed Pt  Bearing     Distance
7    2    S 62°38'22" W 3.009
8    3    S 78°33'32" W 2.766
9    4    S 62°16'06" W 2.134
10   5    S 71°43'06" W 2.658

Minimum Deed Rotation Report

Hold Pivot Point
Survey: 10  Deed: 5
Rotation Point
Survey: 7  Deed: 2
Translate X: 0.052 Y: -0.214
Rotation: 0°02'58"

Survey Pt Deed Pt  Bearing     Distance
6    1    N 71°35'09" E 2.693
7    2    S 10°40'01" W 0.587
8    3    N 31°02'38" W 0.298
9    4    S 73°20'09" E 0.675
Pulldown Menu Location: Survey
Keyboard Command: deed_align
Prerequisite: A coordinate file (.CRD)
File Name: cogoutil.arx

**Legal Description Writer**

The *Legal Description Writer* gives you the ability to create a detailed legal description from a polyline. This description consists of calculated calls, point descriptions from Carlson points, and numerous user defined terms. The programs values for these terms are easily replaced, and are stored as defaults with each use.

In addition to this command that works by polylines, you can also generate legal descriptions by point numbers with the Report function within the Lot File Manager command.
Legal Description Writer Dialog
This initial and primary dialog box is shown above, and described below.

Pick Boundary Polyline: This button is used to designate the polyline boundary used. The boundary should be a closed polyline. Tools are provided in the Edit menu if you need to reverse the polyline or change its origin point. You can also select multiple polylines to process at the same time by entering M for Multiple at the Select Boundary Polyline prompt in this routine.

Pick Inside Boundary: This button is another way to designate the polyline boundary. With this method, the boundary can be defined by multiple linework entities. You pick inside the boundary area and the program will figure the boundary perimeter from the surrounding linework. This method uses the same technique as the Draw->Boundary Polyline command. The boundary perimeter that the program finds is highlighted for visual confirmation.

Pick Reference Lines: Used to select lines that tie into the polyline boundary used for the legal description. These should be LINE objects that have one endpoint exactly the same as the beginning point of the boundary polyline. If a Carlson point exists at the end of the line away from the boundary, the routine will pick up its description, otherwise you will be prompted for the description. You can choose any number of reference lines, simply press enter to conclude the selection of reference lines.

Header File: This button and edit field are used to designate the optional header text file. If a valid file is selected it will be written into the top of the output.

Footer File: This button and edit field are used to designate the optional footer text file. If a file is selected it will be written at the end of the output.

Output Options allows you to select where Legal Description Writer should send the output.

Report Viewer: The output is sent to the report viewer specified under Configure Carlson->General settings: Carlson Standard Report Viewer, Windows Notepad or Microsoft Word.
Text File: The output is sent to an external text file as designated in the output file section described below.

Mtext Object: This creates a mtext object in the current drawing. Upon choosing OK you will be prompted for a starting point (which is the upper left corner) and well as a second point that determines the width and angle. By default ortho is turned on for this second point. Press the F8 key to toggle its status.

Output File: This button and edit field are used to designate the necessary output text file. This file can then be brought into your word processor and finalized. Note that the appearance of the output file can be affected by the status of the 'Use Paragraph Format' toggle in the Legal Description's General settings.

Angle Specifications
This section is used to establish the appearance of the bearings that are output with the description, and allows detailed control over each aspect.
**Bearing Format:** Designate the character or word used in each bearing direction. Standard values are the letters N, S, E, or W. One possible option is the entire words NORTH, SOUTH, EAST, and WEST. It is important to keep in mind that spaces are literal, meaning that if you don't have a literal space after N/S, and before E/W, a space will not be formatted into the bearing. To use Azimuth, place a check in the Use Azimuth box and the General Prefix will be set to AZ.

**1-Words Quads:** For example bearings that are due NORTH, the default is to generate N 00’ 00” E. If the 1-Word Quads toggle is turned on, the program will substitute the single word (which you can change) for the direction, these usually being NORTH, or DUE NORTH.

**Symbols:** This section allows you to designate the precision for bearings, as well as the symbols used. Turn on/off the toggles for degrees, minutes, and seconds to control the precision. For example, if you wish to round to the nearest minute, simply clear the toggle from the second field. For each field (degrees, minutes, seconds), you can supply the character or word to be used. You can quickly fill in these fields with the two buttons to the right.

**Line Segment Specifications**
This section is used to establish the terms used when the course of a call is a line segment, as is often the case. Simply supply the beginning and ending terms for these line calls.

**Curve Segment Specifications**
This large dialog is used to establish the terms and options used when creating the course of a curve. Basic options
include beginning and ending terms, as well as the words for left and right if chosen. In the large table of curve options, you can choose the items you wish to report, in the order you want them to appear. Simply place a number in the sequence field indicating the items you wish to report, making sure that there are no duplicate numbers. In the example below, the program would output the curve direction, arc length, radius length, chord bearing, and chord length, radius length, chord bearing, and chord length, and in that order. Each field can also have a unique prefix/suffix. There are four different possible phrases for the start of the curve description for whether the curve is tangential, non-tangential, compound or reverse. The Radial In/Out for Non-tangent Only option applies to the Radial In/Out fields and tell the program to only use these fields when the curve is non-tangent. Otherwise, these fields are always used when the Radial In/Out fields are in the sequence.

Distance Specifications
This subdialog is used to establish the terms and precision used when creating a distance for the course of a call. The precision and suffix apply to curves as well. Simply choose the desired distance precision from the popdown, and supply the beginning and ending terms for the line calls.

Note the availability of dual distance reporting. If you would like to report dual distances such as feet/metric, turn on the toggle in the lower left corner of the dialog. Note that the primary units are the units set in the Settings menu, Drawing Setup. If you have English set as your units in Drawing Setup, then the alternate units will be metric. The opposite also applies. If your units in Drawing Setup is set to metric, then the alternate units will be English.
Description Specifications
In the process of following the polyline definition for a boundary, the legal description writer can look for descriptions of the points at the endpoints of the polyline. These can be extracted by setting the data source to the corresponding point from the coordinate (.CRD) file, meaning the points do not have to be plotted on the screen. A second option is point block, in which the program will read the information from the drawing, and not require the presence of a coordinate (.CRD) file.

Prefix: General term applied before the actual description.
Suffix: General term applied after the actual description.
Unknown: The text designated here will be placed in the description if the program does not find a valid description at that coordinate location. The words ‘Unknown Point’ may be used.
Tolerance: The point must be within this distance of the polyline vertex to use the description.

General Specifications
This dialog controls general specifications which can affect the entire description. Each group of items are explained in detail below.
**Body of Description**: Enter the beginning and ending terms for the description.

**String Case**: Choose the button corresponding to the string case conversion desired. If you want no changes made, choose none. Choosing upper, lower, or proper case conversion will affect the case of all text throughout the description, except bearing letters.

**Report Sequence**: This option controls the sequence to report the boundary segments either in the direction of the polyline, clockwise or counter-clockwise.

**Spell Out Numbers**: This option writes numbers as words instead of digits. For example, a distance of 123 would be written as one hundred twenty three.

**Append Lines Output Format**: If this toggle is on, the program will output the description without carriage returns after each line. This approach makes a nice paragraph style when brought into a word processor with word wrap. If the toggle is cleared, the program will place carriage returns at the end of each call.

**Area**
The legal description writer can output several types of areas. Basic options include beginning and ending terms. In the large table of area options, you can choose the items you wish to report, in the order you want them to appear. Simply place a number in the sequence field indicating the items you wish to report, making sure that there are no duplicate numbers. You can edit the prefix/suffix for each and control decimal precision of each field output.
Reset: This option will reset all settings to their original default values.

Save: This option saves the legal description settings to a file. The file will be saved with an extension of (LGL).

Load: This option loads previously saved legal description (*.LGL) files.

Pulldown Menu Location: Survey
Keyboard Command: legal
Prerequisite: Polyline boundary

Closure by Point Numbers

This command allows for traverse entry by point numbers, reports the closure and supports traverse adjustments. Using an existing coordinate file, the traverse is defined by a series of point numbers. The angle and distance for each traverse segment is calculated using the coordinates of the points. The traverse can be processed using all adjustment routines. Refer to the Edit-Process Raw Data File command for more detail on adjustment procedures. After selecting Closure By Point Numbers from the Survey menu, the Closure By Point Numbers dialog will appear.
In this dialog shown above, add the point numbers that make up the traverse. This can be done by entering the point number, a range of points, or a point group into the Point Number(s) field. You can also choose points from a list by clicking the List button. Once each point, or group of points, is entered, click the Add button. Continue in this fashion until all of the point numbers are entered in. Clicking the Process button will display the Choose Process Method dialog. Choose the desired process method.
After selecting the process method for any of the adjustment methods, the dialogs and prompts will follow. They all start out with an "options" dialog box. These dialogs are titled either Process Options or Closure Options, depending on which process method you chose. The prompts that follow for any of the methods are subset of, and are very similar to, the prompting found in the Edit-Process Raw Data File command. After you have made your selections within these dialog boxes, click OK.

When you choose No Adjust of Angle Balance

When you choose Transit, Compass or Crandall
Each of the process methods will display a report that details the closure before the adjustment, and after the adjustment. Options to save and print this report are available. After a review of the report, pressing Exit will remove the report from the screen. At this point a Process Results dialog, prompting whether to Update points in CRD file with adjusted coordinates, will appear. If you choose Yes, the active coordinate (.CRD) file will be updated with the adjusted coordinates. Choosing No will leave the active coordinate (.CRD) file in its existing state, with the coordinates unchanged. It is important to remember that the starting and ending point in this routine must be a different point number. For example, if the traverse starts at point 1 and ends at point 1, then another point number should be used for the tie in shot to point 1. This logic is different in Edit-Process Raw Data File, where the starting and ending point can be the same point number.

Pulldown Menu Location: Survey
Keyboard Command: ptrawedit
Prerequisite: Coordinate (.CRD) file
File Name: \lsp\rawedit.arx

Map Check by Pnts

This command allows you to check the closure of a figure and produce a report. The points used for the map check should already be stored in a coordinate (.CRD) file, by using commands such as Traverse, Locate by Bearing, Curves menu, Locate by Angle – or perhaps a file from an electronic data collector.

Prompts

Table Description: Description
Beginning Point Number: 903
PointNo. Northing(Y) Easting(X) Elev(Z) Description
903 4940.73 2490.40 0.00
eXit/Curve/<point number>: 904

PointNo. Northing(Y) Easting(X) Elev(Z) Description
904 4850.89 2388.01 0.00
BEARING> S 48d43'58'' W Hz DIST> 136.21
eXit/Curve/<point number>: 905

PointNo. Northing(Y) Easting(X) Elev(Z) Description
905 4699.39 2423.32 0.00
BEARING> S 13d07'04'' E Hz DIST> 155.56
eXit/Curve/<point number>: 906

PointNo. Northing(Y) Easting(X) Elev(Z) Description
906 4653.59 2582.19 0.00
BEARING > S 73°55'04" E Hz DIST > 165.34
eXit/Curve/<point number>: 910

PointNo. Northing(Y) Easting(X) Elev(Z) Description
910 4941.88 2492.50 0.00

BEARING > N 17°16'54" W Hz DIST > 301.93
eXit/Curve/<point number>: X

Closure error distance > 2.39476609 Error Bearing > N 61°10'45" E
Closure Precision > 1 in 316.96 Total Distance Traversed > 759.04

SQ. METERS: 30403.0 SQ. KILOMETERS: 0.03
HECTARES: 3.04 CUERDAS: 7.74 PERIMETER: 759.04

Pick area label centering point: pick point on screen for label text
Erase Polyline Yes/No <Yes>: N

Typical Map Check Report:
04/19/2006 13:14

COURSE BEARING DISTANCE PT# NORTING EASTING DESCRIPTION
903-904 S 48°43'58" W 136.21 904 4850.89 2388.01
904-905 S 13°07'04" E 155.56 905 4699.39 2423.32
905-906 S 73°55'04" E 165.34 906 4653.59 2582.19
906-910 N 17°16'54" W 301.93 910 4941.88 2492.50

Closure error distance > 2.39476609 Error Bearing > N 61°10'45" E
Closure Precision > 1 in 316.96 Total Distance Traversed > 759.04
327253.1 SQ. FT.
7.51 ACRES

Chapter 11. Survey Menu
Map Check by Screen Entities

This command allows you to check the closure of a figure, and produce a report from the Distance and Bearing labels in the drawing. The Deed Reader command is used here also, for extracting the deed line and curve data from the text of the deed. The deed data can then optionally be saved to deed file.
Prompts

Select linework to process: select the figure
Select sample text: select a label
Pulldown Menu Location: Survey
Keyboard Command: textdeed
Prerequisite: Distance and Bearing labels
File Name: \lsptextdeed.lsp

Cut Sheet

This command creates a report of the elevation difference between points and a design elevation which can be defined by a grid file, triangulation file, 3D polyline, section file, note file, road template file, runway airway clearance or design points. The station and offset of the points can also be reported, if a centerline is specified.

Note the Report Formatter option in the dialog box below. This option can be used to customize the report layout, and to output the report data to Microsoft® Excel or Microsoft® Access. The standard report can be formatted to allow for the Cut/Fill difference to be reported in Feet-Inches, and for user specified decimal place setting for X/Y
and Z values. These options are available from the main Cut Sheet Report dialog box shown here.

The **Points** option reports the horizontal distance and cut/fill between two points. The points to compare can be in the same coordinate (.CRD) file or separate files. The Output Options for the cut sheet report include **Bearing-Distance** which reports the bearing and distance difference, if any, between the points selected. The **DeltaX-DeltaY** reports and labels positional difference of the reference and selected points in x, y values. The same can be said of the **North-South-East-West** option. This option will report the positional difference of reference and selected points to compare but will label the differences as either North-South-East-West. With the None option selected only cut/fill values will be reported. If the Report Coordinates option is checked, the coordinate values of the points will be shown on the cut sheet report.

When comparing points in the same file, the Points to Compare dialog appears as shown below. The goal in this

---

**Chapter 11. Survey Menu**  
610
dialog is to establish in the upper window all the point pairings that you wish to compare for the cutsheet.

The selection of the points to compare is accomplished in 4 ways:

1) By manually specifying what points are to be compared by picking the survey and design points and then pressing the add button to add them to the selected points field at the top of the dialog. This allows for the assigning of multiple design points to the same survey point if needed. With this method each pair is selected and added individually to the list.

2) By specifying a range of survey and design points to be compared. This is accomplished by entering in the range of points in the Survey Range of Points field and the Design Range of Points field and then pressing add. With this option the points will be compared sequentially for each range. For example, if points 2000-2004 made up the survey range, and points 2001-2005 made up the design range, point 2000 will be compared with point 2001 and so on.

3) By point group. This option will compare the points of the defined survey group with that of the defined design group. The points will be compared sequentially in the same manner as comparing ranges of points described in item 2 above. Once the groups are specified, press the add button to verify the selection of the groups. If points in the coordinate file have been categorized by groups to define surveyed and design surfaces, this option makes it very quick to calculate cut and fill data.

4) By matching points that are within a distance tolerance from each other, using Match by Tolerance. This option can be a time-saver, particularly when office personnel are not familiar with the pairings to analyze. When comparing points, there is an option to flag points in the report that exceed the specified distance tolerance.
The pairs, ranges or group of points to compare can be saved for later recall and further cut/fill analysis by selecting the Save button. The file to be saved will have a prf extension. To recall a comparison set of points for a cut sheet report press the Load button and specify the desired *.prf file.

For the separate file option, the point numbers are used to match points between the files. If point numbers are missing in the comparison (e.g. points 1 to 3 in the current coordinate (.CRD) file are being compared to points 1 and 3 in the design coordinate (.CRD) file), then there is an option for reporting the missing points, as seen in the Compare Points dialog.

When using a **3D Polyline** for the grade elevation, the program calculates the elevation along the 3D polyline at the position perpendicular from the point selected. This calculated elevation is then compared to the point(s) selected to determine the cut/fill values. For **Grid** and **Triangulation** surface files, the design elevation is determined by the elevation of the surface file at the point selected. With **Section Files**, the grade elevation is interpolated from the offset-elevation data in the section file based on the station-offset of the point along the centerline. When using this method, a centerline file (*.cl) must be specified for station-offset data.

The **Note File** option reads the grade elevation from the note (.NOT) file that is associated with the current coordinate file. For example, if the current coordinate (.CRD) file is job3.crd then the note file name is job3.not. In Carlson Software's data collection programs (SurvCE and Field), there is an option to store stakeout data to the note file under the Stakeout options. When storing a point in the stakeout routines (using SurvCE or Field), the target point number, coordinates and elevation can be stored to the note file. This results with the as-staked coordinate stored in the coordinate (.CRD) file and the target coordinate stored in the associated note file. The Cut Sheet report can
display this stakeout data using the Stakeout Point Comparison report option. The horizontal difference between the staked point and the target point can be reported in Bearing-Distance, Delta X-Y or North-South-East-West format. Also, in SurvCE and Field, the elevation difference routines can record the design grade elevation and station-offset to the note file when a point is stored to the coordinate (.CRD) file. This grade data can be reported using the Grade Elevation Report option. The note file records that the Cut Sheet report uses are TARGET_X, TARGET_Y, TARGET_Z, TARGET_DESC, TARGET_PT, STATION, OFFSET, VOFF1 and VOFF2.

The **Runway Clearance** option defines the target surface as the airway clearance around a runway. This method is for clearance reports for tree and building tops by comparing points to this runway clearance surface. The runway surface is built from a 3D perimeter polyline of the runway along with slopes for the approach lanes and runway sides. The runway sides are offset level from the runway perimeter for the specified distances before starting the slopes. The parameters for the runway are defined in the dialog and illustrated in the graphic shown here. The Write Runway Clearance Surface File creates a triangulation surface file that you can draw or inspect for verification of a correct target surface.

The **Template Design** option defines the grade elevation using road design files. For each point, the program finds the station-offset for the point along the centerline and then applies the road design at that station to determine the grade elevation. **Grade to Process** is used to define the surface to use for the cut sheet comparison. These grades are defined as Top Surface, usually final grade, or subgrades and correspond to the defined grades and subgrades within a template file. The required design files include a centerline (.CL) file, a template (.TPL) file, and a profile (.PRO) file. There are also several optional design files such as Superelevation, Template Point Profile and Template Point Centerline. The design files are created in the Civil Design module. Using the design files in **Cut Sheet** is similar to the Process Road Design command.
This leads to the following report:

If the **Station-Offset** method is selected as an Input Method, then only the final grade elevations are produced in the report. This is useful for writing final grades on the stakes prior to taking field shots. You are first prompted for the desired offset and starting station, as shown in the Station Offset dialog. Specify left offsets with the negative sign (-).
After filling out the Station-Offset dialog with the desired information, selecting the OK button will result in the following report showing only the final grade elevations of the specified station-offsets.

Examples of Cut Sheet reports comparing points are shown next.
Example 1: Cut Sheet Report comparing points from the Current Coordinate File and with the Use Feet-Inches For Cut/Fill options on.

Example 2: Cut Sheet Report comparing points from Another Coordinate file, reporting coordinates for the points.

Example 3: Steps for Comparing Points in Current Coordinate file and using Report Formatter Option to customize report output to user preference.

2) Specify points to compare by one of the four methods described above for comparing points within the current coordinate file.
3) Select report content by highlighting the desired data from the Available list on the left side of the dialog box and then pressing the Add button to place the selected data in the Used list. Standard window selection methods using the Ctrl and Shift keys can be used to select more than one item at a time. After moving the selected data to the Used window it may be necessary to move data up or down to obtain the desired order of your report. To do this use the up and down arrows located on the left of the Used window.
4) When the desired data has been specified in the Used window press the Display button at the bottom left of the dialog. For more detailed information on using the report formatter see the Report Formatter section of this manual.

Pulldown Menu Location: Survey
Keyboard Command: cutrprt
Prerequisite: A coordinate (.CRD) file
File Name: \lsp\cutrprt.lsp

Set Point Elevations by Surface Model

This command assign elevations to points by surface model. For for each of the points, the routine looks up the elevation from the surface model at the point x,y location.

Prompts

Choose Grid or Tmesh file to process dialog choose existing GRD, TIN or FLT file
Select points from screen, group or by point number [Screen>/Group/Number]? press Enter
Select points to elevate.
Select objects: pick the points to elevate
Elevating points...
Elevated 10 points.

Pulldown Menu Location: Survey
Keyboard Command: 3dpts_tin
Prerequisite: A surface model

Set Point Elevations by 3D Polylines

This command assign elevations to points by referencing 3D polylines. The station-offset is calculated for each point to the nearest reference 3D polyline. The point must be within the specified Max Offset Tolereance in order to be elevated. The elevation is calculated from the elevation of the reference 3D polyline at the station combined with the specified percent slope times the offset plus the vertical offset.

Prompts

Maximum Offset Tolerance <1.0>: press Enter
Percent slope from reference polyline <0.0>: press Enter
Vertical Offset <0.0>: press Enter
Select points from screen, group or by point number [Screen>/Group/Number]? press Enter
Select points to elevate.
Select objects: pick the points to elevate
Select reference 3D polylines.
Select objects: pick the reference 3D polylines
Elevating points...
Elevated 10 points.

Pulldown Menu Location: Survey
Keyboard Command: 3dpts_3dp
Prerequisite: 3D polylines
Polyline Report

This command generates a report of angle-distance and curve data for all the points along the selected polyline. The closure can be reported between the starting and ending points of the polyline. The polyline area can also be reported. After starting the command, by pressing O for options various report options can be selected.

Polyline Report

Northing  Easting  Bearing  Distance
4657.495  5452.844  N 40°45'51'' E 84.323
4721.362  5507.902

Radius: 175.795  Chord: 249.282  Degree: 32°35'33''  Dir: Right
Length: 277.088  Delta: 90°18'35''  Tangent: 176.747
Chord BRG: N 85°55'08'' E  Rad-In: S 49°14'09'' E  Rad-Out: S 41°04'26'' W
Radius Point: 4606.577,5641.050

4739.102  5756.552  S 24°29'28'' E 122.817
4627.336  5807.466  S 74°29'33'' W 199.062
4574.114  5615.650  N 62°53'05'' W 182.885
4657.470  5452.866

Closure Error Distance> 0.03419  Error Bearing> N 41°22'21'' W
Closure Precision> 1 in 25333.8  Total Distance> 866.174
Polyline Area: 47735.6 sq ft, 1.1 acres

Prompts
Options/Select polyline to report: *pick a polyline*

**Standard Report Viewer** Displays the report for the selected polyline.

Options/Select polyline to report (Enter to End): *press Enter*

**Pulldown Menu Location:** Survey > Polyline Tools

**Keyboard Command:** plreport

**Prerequisite:** A polyline

**File Name:** \lsp\cogoutil.arx

---

**Polyline to RW5 File**

This command generates a raw data (.RW5) file for the selected polyline. This file can be opened using *Edit Process Raw Data File*, which allows you to process the raw data (.RW5) file to generate coordinate points, calculate closure and perform coordinate adjustments by the compass, crandall, transit and least squares adjustment routines.

**Prompts**

**RW5 File to Write (Standard Windows File Selection Dialog):** *choose file location and name*

**Select Polyline To Process:** *select polyline*

**Done.**

**Pulldown Menu Location:** Survey > Polyline Tools

**Keyboard Command:** pl2rw5

**Prerequisite:** a polyline

**File Name:** \lsp\cogoutil.arx

---

**4 Sided Building**

Often only one or two sides of a building are surveyed in the field. This routine completes the building by drawing the other sides. *4 Sided Building* creates a parallelogram given two connecting lines, or given a polyline with two segments. With two lines, there is an option to make the parallelogram as a polyline or as four lines. When only one side is defined, the program will prompt for the building width. Besides using linework to define the sides, you can use points by entering P at the prompt to switch to points mode.

**Prompts**

**Options/Points/<Pick a line or polyline>:** *pick a line*

**Pick another side (Enter for none):** *pick a line*

**Convert the lines into a polyline [<Yes>/No]?** *press Enter*

**Options/Points/<Pick a line or polyline>:** *press Enter*

Entering 0 for options lets you choose whether or not to be prompted to set the new polyline width, and for whether to default the width to make a square building with one sided input.
Pulldown Menu Location: Survey
Keyboard Command: 4sided
Prerequisite: A polyline with two segments or two adjoining lines
This chapter provides information on using the commands from the COGO menu to perform coordinate geometry operations in your drawing. The top section provides basic COGO routines, with optional quick keys. The bottom section provides numerous survey functions, including the easy-to-use Visual COGO and also Numeric Pad COGO.
Draw-Locate Points

This command is described in the Points chapter of this manual. Go there for full details. Within Carlson Software, this important command is located in both the COGO menu and the Points menu, near or at the top.

Inverse

This command reports the bearing/azimuth and horizontal distance between two points. The command prompts for a series of points. Use the appropriate object snap mode to select the points from the screen, or use the point numbers to reference coordinates stored in the current coordinate (.CRD) file. The results are then displayed. This command is also used in conjunction with the Traverse and Sideshot commands to occupy and backsight two points. The last two points you Inverse to are the Backsight and the Occupied point for the Traverse and Sideshot commands. An attractive feature of Inverse is that you can enter T or SS within the command and go directly to Traverse or Sideshot. Even a single S will transmit to Sideshot. Hotkeys are not case sensitive. Press [Enter] at the point prompt to end the command.

You can also inverse around an arc by inversing to the PC, and then entering an A for Arc option. The program will ask for the radius point, the curve direction left or right and the PT point. The curve data is then reported. There is an unequal PC-Radius and PT-Radius distance check. The tolerance for this is set in the Area Label Defaults command.

After picking the first point, there is a keyboard option for Multiple which will prompt for a range of point numbers to report as a sideshot inverse.

There are several input options for Inverse that are set by entering O for Options on the command line. Sideshot inverse holds the current occupied point and calculates the bearing/distance to each entered point. The Pairs option reports the bearing/distance between pairs of points and not for every entered point. For example, if points 1,2,11,12 were entered, the bearing/distance would be reported for 1,2 and 11,12 but not 2,11. The Auto Increment option uses the next point number by just pressing Enter. To exit the routine with Auto Increment active, End must be entered.

The Auto Zoom settings under Inverse Options will zoom the display as needed to have the occupied point or both the occupied and backsight points visible.

There are also several angle output options that are set at the second prompt in Options. The angle can be reported as either Bearing, Azimuth, Gon or Angle Right. You can also specify to report angles with decimal seconds. The distance settings include the number of decimals for distances, whether to report slope or horizontal distance and whether to report distances in feet and inches format. The Report Elevation Difference option will report the delta Z between the pairs of points. The Report Second Scaled Distance option will report a second distance value that is scaled from the first distance value using the scale factor defined in Drawing Setup. When the Second Scaled Distance option is on, there are settings for the suffix to use for both the first and second distance to help identify them separately in the report.

For instruction on how to insert either new or existing points into the drawing, see Draw-Locate Points in the Points Commands section of the General Commands chapter.

Prompts
Calculate Bearing & Distance from starting point?
Traverse/SideShot/Options/Arc/Multiple/Pick point or point number: pick a point
Traverse/SideShot/Options/Arc/Multiple/Pick point or point number: 9

PtNo. Northing(Y) Easting(X) Elev(Z) Description
9  4909.25  4648.37  0.00

Bearing:  N 81d8'54''  E Azimuth: 81d8'54''
Horizontal Distance:  261.17407461

Pulldown Menu Location: COGO
Keyboard Commands: inverse, i
Prerequisite: None

**Occupy Point**

This command sets the occupied point and backsight angle for other COGO commands such as Traverse. For setting the occupied point, you have the option of picking a point on the screen, entering coordinates at the command line or typing in a point number that will be read from the current coordinate (.CRD) file. Four options are available for determining the backsight direction: Azimuth, Bearing, None and Point. For the default Point option, you may pick a point on the screen, input coordinates, or type a point number that will be read from the current coordinate file. For the Azimuth and Bearing option, you enter the backsight angle in the selected format. The None option sets the backsight to an azimuth of 0 (zero) or North. You can also set the occupied point by using the Inverse command. If you inverse from point 3 to point 1, you have set point 1 as the occupied point and point 3 as the backsight. For more information, see the Inverse command.

The current occupied point and backsight are shown in the lower right hand corner of the AutoCAD status bar just below the command line.
Prompts

Set Occupied Point
Pick point or point number: pick a point (5000 5000 0.0)
Set backsight method [Azimuth/Bearing/None/<Point>]? press Enter
Set Backsight Point
Pick point or point number: pick a point (5184.76 5381.3 0.0)

For instruction on how to insert either new or existing points into the drawing, see Draw-Locate Points in the Points Commands section of the General Commands chapter. This feature can be found in the Points pulldown of all menus.

Pulldown Menu Location: COGO
Keyboard Commands: occpoint, op
Prerequisite: None
File Name: \lsp\occupypt.lsp

Traverse

This command allows the user to input any combination of turned angles, azimuths or bearings to define a traverse or figure. The command prompts for an Angle-Bearing Code which defines the angle or bearing type. This command always occupies the last point it calculated and backsights the point before that.

Codes 1 through 4 define the bearing quadrants:
1 = Northeast
2 = Southeast
3 = Southwest
4 = Northwest

The remaining codes define as follows:
5 = a north based azimuth
6 = an angle turned to the left
7 = an angle turned to the right
8 = a deflection angle left
9 = a deflection angle right

For both the Angle-Bearing Code and the Distance prompt, the user can enter point-defined responses: two points separated by an asterisk, as in 2*3 for the bearing (or distance) defined by 2 to 3. You can also add math expressions. For angles, 2*3+90 would deflect 90 degrees right from 2 to 3. For distance, 2*3/2 would mean half the distance of 2 to 3. You do not need to enter N before entering a number-defined distance. Just bring up the number inverse prompt.

The command draws lines between located points (if the Line On/Off in the COGO menu is set to on) and plots the points calculated and stores them in the current coordinate (.CRD) file if point numbering is On. The point settings are defined in the Point Defaults command. If Point Protect is turned on, Traverse checks if the point numbers are already stored in the file. Point Protect is set in the Coordinate File Utilities command.

There are Angle-Bearing code input options for Traverse that are set by entering O for Options. The Angle Right option prompts for the angle right and skips the angle-bearing code prompt. The Azimuth option prompts for the azimuth and skips the angle-bearing code prompt.
**Prompts**

**Occupied Point?**
**Pick point or point number:** *pick a point*
You will only be prompted for the occupied point the first time you use the command.
Use the *Inverse* command to set the occupied and backsight points.

**Exit/Options/Side Shot/Inverse/Enter Azimuth (dd.mmss) <+>: 0**
Angle prompt angle right or azimuth only [Right/Azimuth/Prompt]? *p*

**Exit/Options/Arc/Points/Line/Side Shot/Inverse/Angle-Bearing Code <+5>:** press Enter Pressing Enter uses the default angle right code.

**Enter Angle (dd.mmss) <+90.0000>:** 88.1324 You can also enter L or R to define an angle 90 degrees Left or Right.

**Backsight Point?**
**Pick point or point number:** *pick a point*
**Number inverse/<Distance>:** 100

---

**Select Coordinate (.CRD) File** This dialog only appears if there is not a current coordinate (.CRD) file.

**Exit/Options/Line/Side Shot/Inverse/<Angle-Bearing Code <+7>:** 14*9-45.2045 Uses the bearing defined by point numbers 14 & 9 and subtracts the angle 45 degrees, 20 minutes, and 45 seconds. You can use a + or - in this type of entry.

**Number inverse/<Distance>:** *N* (note: you can enter 14*9/2 here, as well)
**Point number inverse (i.e. 10*20):** 14*9/2 This causes the command to recall the distance from point number 14 to 9 and divide it by 2.

**Exit/Options/Line/Side Shot/Inverse/<Angle-Bearing Code <+7>:** *L*

**Select Line or Polyline that defines Bearing:** *select line that defines bearing*

**Number inverse/<Distance>:** 100

**Exit/Options/Line/Side Shot/Inverse/<Angle-Bearing Code <+7>:** *E* Enter E to end the command. Enter S or SS to execute the *Side Shots* command or I to execute the *Inverse* command.

For instruction on how to insert either new or existing points into the drawing, see *Draw-Locate Points* in the Points Commands section of the General Commands chapter. This feature can be found in the Points pulldown of all menus.

**Pulldown Menu Location:** COGO
**Keyboard Commands:** T, Traverse
**Prerequisite:** None
**File Name:** \lsp\trav.lsp
Side Shots

This command allows the user to input any combination of turned angles, azimuths or bearings while remaining on an occupied point. The command prompts for an Angle-Bearing Code which defines the angle or bearing type. Codes 1 through 4 define the bearing quadrants; 1 being North-East, 2 South-East, 3 South-West, and 4 North-West. Code 5 is a north-based azimuth, 6 an angle turned to the left, 7 an angled turned to the right, 8 a deflection angle left and 9 a deflection angle right. The command plots the points calculated and stores them in the current coordinate (.CRD) file if point numbering is On. If Point Protect is turned On, Side Shots checks if the point numbers are already stored in the file. All points calculated radiate from the occupied point. Use the Traverse, Inverse, or Occupied Point commands explained previously to define the occupied and backsight points. Options allows you to select your angle entry method.

Prompts

Occupied Point ?
Pick point or point number: screen pick a point or enter a point number
Exit/Options/Traverse/Inverse/Enter Azimuth (ddd.mmss) <A>: O for options
Angle prompt angle right or azimuth only [Right/Azimuth/Prompt]? P for prompt
Exit/Options/Points/Line/Traverse/Inverse/<Angle-Bearing Code <7>: 6 Code 6 for angle turned to left.
Pick point or point number: pick a point
Enter Angle (dd.mmss) <6>: 22.3524 Angle of 22 degrees, 35 minutes, 24 seconds.
Points/<Distance>: 120.91
Enter Vertical Angle (dd.mmss) <0.0000>: 88.2548

These prompts only come up if you have Instrument and Rod height prompting turned on.
Instrument Height <5.000>: 5.12
Rod-Target Height <5.120>: press Enter
Enter Point Description <->: Topo Shot
Exit/Options/Points/Line/Traverse/Inverse/<Angle-Bearing Code <6> E

For instruction on how to insert either new or existing points into the drawing, see Draw-Locate Points in the Points Commands section of the General Commands chapter. This feature can be found in the Points pulldown of all menus.

Pulldown Menu Location: COGO
Keyboard Commands: sideshot, ss
Prerequisite: None
File Name: \sp\sideshot.lsp

Enter-Assign Point

This command creates a point at the user-entered coordinates. The point is both stored to the current coordinate (.CRD) file and drawn on the screen. The program will prompt for the northing and easting. This routine will prompt for point number, elevation and description, depending on the settings in the Point Defaults command. Point Defaults also allows you to set the point symbol and layer. Point Defaults is found under the Points pulldown.

Prompts

Enter North(y): 5000
Enter East(x): 5000
Select/<Enter Point Elevation <0.00>: Enter 100 for elevation, or press S and enter to select text to set elevation.
Enter Point Description <<: START
N: 5000.00 E: 5000.00 Z: 0.00
Enter North(y): press Enter to end

For instruction on how to insert either new or existing points into the drawing, see Draw-Locate Points in the Points Commands section of the General Commands chapter. This feature can be found in the Points pulldown of all menus.

Pulldown Menu Location: COGO
Keyboard Commands: eapoint, ea
Prerequisite: None
File Name: \lsp\eapoint.lsp

Raw File On/Off

This menu selection toggles raw file (.RW5) creation. When this option is active, commands such as Traverse create entries in the current raw data (.RW5) file. If Raw File is turned on, the pulldown menu option will have a check mark character in the menu. A dialog will appear, allowing you to create a New, Append an existing, or Close the .RW5 file.

To begin this routine, select the COGO pulldown and observe the Raw File (On or Off) toggle for check. Click the command and the dialog appears.

New: Allows you to create a new raw traverse file (.RW5).
Append: Allows you to append an existing raw traverse file.

Pulldown Menu Location: COGO
Keyboard Command: openraw
Prerequisite: None
File Name: \lsp\openraw.lsp
**Line On/Off**

This menu selection toggles line plotting on and off for the commands such as *Traverse, Locate by Line Bearing*, etc.. If line drawing is turned on, the pulldown menu option will have a check mark character to the left of the command.

Command: set_lonoff

Line ON

Command: set_lonoff

Line OFF

Pulldown Menu Location: COGO

Keyboard Command: set_lonoff

Prerequisite: None

File Name: \lsp\surv1.lsp

**Visual COGO**

This command contains COGO routines for Inverse, Occupy Point, Traverse, Side Shots and Enter-Assign Point. Choosing Visual COGO from the COGO menu provides you with quick access to any one of five main features of the Visual COGO interface.

A dialog for command input docks on the side of the graphic window when any of the five options from the pulldown menu are selected. Points are drawn to the screen as they are created. Linework can also be drawn. CAD and Carlson commands can be activated with the Visual COGO dialog active. This allows for quick switching between Visual COGO commands and any other command. You can also switch between Visual COGO commands within the dialog by entering the 2 character function name in any edit box. For example, from Visual COGO Inverse, you can enter SS in the point number field to switch to Side Shots.

The function names OC, EA, IN, TR and SS are also available as function buttons across the top of the dialog. The second row of buttons are functions for zooming in/out and panning. The final button brings up Visual Cogo options. The **Use Sound** option is for whether to have sounds cues. The Prompt for **Bearing/Azimuth Rotation** adds an additional angle input in the Sideshot and Traverse functions. This angle is added to the bearing or azimuth angle input and is a way to handle North rotation where the orientation of the angles that your entering is different than the target coordinate system.
Prompts

When in Visual COGO, you will have a very different user interface from other areas of Carlson. This user-friendly screen will guide you through various COGO data entry procedures such as Inverse, Occupy Point, Traverse, Side Shots and Enter-Assign Point. You will still be able to follow the command on the command line at the bottom of your Carlson screen. Using Visual COGO is an alternative and easy method to entering in such information. The top half of the COGO pulldown menu offers you the more traditional Carlson data entry method. Your results will be the same.

**IN** (Inverse): This command reports the bearing/azimuth and horizontal distance between two points. The points can be entered manually or by picking from a point list by picking on the list button. The resulting report of bearing/azimuth is dependent upon the Angle Mode setting in the drawing setup options.

**OC** (Occupy Point): Used to specify the point number of the instrument setup point. The point can be specified by manually entering in the point number in the Occupied Point data field, or by selecting the List button and choosing from the list of points contained in the coordinate file.

Backsight Method can be either by Point Number or by Azimuth. If angle right/left or deflection right/left is being used for traverse or sideshot entry, a backsight method must be specified. If using Bearing or Azimuth entry, no backsight method is required. The Backsight Point can be specified by manually entering in the point number in the Backsight Point data field, or by selecting the List button and choosing from the list of points contained in the coordinate file.

**Instrument Height:** Use this field to set the height of the instrument.

**Accept (F2):** Selecting this button or pressing the F2 function key accepts the data entered in the fields above. After accepting the data, until changed, the points specified will remain the occupied and backsight points. If the dialog is exited without Accepting the settings the Occupied and Backsight points will have to be specified when the OC dialog is revisited.

**Exit:** Cancels the command

**TR** (Traverse): This command allows data entry using any combination of turned angles, deflections, azimuths or bearings to define a traverse or figure. This command always occupies, moves up to, the last point it calculated and backsights the point before, or the previous occupied point.

**Point Number:** This is the number of the point to be created.

**Rod Height:** Height of target to be located.

The horizontal angle component can be input in various formats. The format label will change with the option chosen. Choose the format by selecting the down arrow and picking from the list.

NE=Northeast
SE=Southeast
SW=Southwest
NW=Northwest
AZ=Azimuth
AL=Angle Left  
AR=Angle Right  
DL=Deflection Left  
DR=Deflection Right  

The vertical angle component can be input in various ways (the format label will change with the option chosen). Choose the format by selecting the down arrow and picking from the list.

VA=Vertical Angle. Zero (0) degrees is level.
ZE=Zenith Angle. Ninety (90) degrees is level.
DZ=Elevation Difference. The difference in elevation either plus or minus from the instrument setup to the target.

The distance component can be entered as either Slope or Horizontal Distance. Choose the format by selecting the down arrow and picking from the list.

SD=Slope Distance  
HD=Horizontal Distance  

Distance can be defined by Point Numbers by selecting the calculator button to the far right of Angle Right and Slope Distance.

Additional mathematical calculations of addition, subtraction, multiplication and division can be performed on the input distance by selecting the appropriate button and filling out the function dialog.
For example to add 25 to the Slope distance value on the traverse dialog, select the + button, enter 25 and then select Done. The same steps apply to any of the other mathematical functions.

**Side Shots:** This command works in the same way as the traverse command. All the available options contained in the traverse command are available in this command. The only difference in the commands is that the side shot command does not move the setup point to last shot input. Refer to the traverse command for further details.

![Visual COGO Command](image)

**Desc:** Defines the description for the point to be created.

**Create Point:** Option whether to store the point to the CRD file and draw a point.

**Draw Line:** Option to draw line to the traverse point.

**Preview (F2):** Previews the traverse point location, without storing the point to the coordinate file.

**Store (F3):** Stores the traverse point based upon the entered data to the coordinate file.

**Undo:** After storing the point, the point can be deleted from the screen and coordinate file by selecting the undo button.

**Exit:** Exits the Visual COGO command and closes the dialog box.

**EA (Enter Assign):** Use this function to enter and assign coordinate values for new and existing points.
Zooming and panning functions are also available from the Visual COGO dialog box:

**Plus (+) magnifier:** Zooms the display window in. Use to view an area up close.

**Minus (-) magnifier:** Zooms the display window out. This shows more of the drawing.

**Left arrow:** Pans the display window to the left.

**Right arrow:** Pans the display window to the right.

**Up arrow:** Pans the display window up.

**Down arrow:** Pans the display window down.

**Pulldown Menu Location:** COGO

**Keyboard Commands:** vcogo_inverse, vcogo_setup, vcogo_traverse, vcogo_sideshot, vcogo_store

**Prerequisite:** Coordinate file to process

---

## Locate by Line-Bearing

This command calculates and plots a line (if the Line On/Off is set to Line On) and point from an occupied point. The bearing can be defined by picking two points, selecting a line, inputting two point numbers, or typing in a bearing or azimuth. The command always occupies the last point calculated.

### Prompts

Press [Enter] to use preview point/or select occupied point.

**Pick point or point number:** 14

<table>
<thead>
<tr>
<th>PointNo.</th>
<th>North (Y)</th>
<th>East (X)</th>
<th>Elev (Z)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>14</td>
<td>4869.06</td>
<td>4390.31</td>
<td>0.00</td>
<td></td>
</tr>
</tbody>
</table>

Pick points that define bearing.

**Define Bearing by, Line/Bearing/Numbers/\(<pick 1st point>\):** B

At this prompt the default is to pick the first point that defines the bearing. If you pick a point, you are then prompted for a second point. You can input B to type in a bearing or azimuth or L to select a line or polyline that defines the bearing, or N to input two point numbers that define the bearing.
[A]zimuth/<Bearing (Qdd.mmss)>: A
Azimuth (ddd.mmss): 45.2349
Number inverse/<Distance>: 188.27
Enter Vertical Angle (dd.mmss) <0.0000>: press Enter
The horizontal distance is given.
Enter Point Description <stk>: press Enter
The coordinates are given.

Pulldown Menu Location: COGO > Locate by Bearing-Ang
Keyboard Command: locbrg, lb
Prerequisite: None
File Name: \sc\lsp\locbrg.lsp

Locate by Turned Angle
This command locates a point by turned angle and distance.

Prompts

Define occupied & backsight points by [L]ine or [P]oints <P>: L
Select Line or Polyline near end point that defines occupied point: select line
Occupied point: (4078.44 4610.89 0.0)
Backsight point: (4390.31 4869.06 0.0)
Enter Angle (ddd.mmss) <45.2349>: 22.5632
Pick or Type Distance <188.27>: 40.32
Enter Vertical Angle (dd.mmss) <0.0000>: hit Enter

Pulldown Menu Location: COGO > Locate by Bearing-Ang
Keyboard Commands: turnang2, ta
Prerequisite: None
File Name: \lsp\turnang2.lsp

Locate by Azimuth
This command locates points by azimuth and distance. The AutoCAD text screen provides the horizontal distance and coordinates.

Prompts

[Enter] to use preview point/ or Select occupied point ?
Pick point/<point Number>: _endp of (pick a point)
Enter Azimuth (ddd.mmss) <22.5632>: 277.1259
Enter or pick Distance <40.32>: 104.39
Enter Vertical Angle (dd.mmss) <0.0000>: Enter

Pulldown Menu Location: COGO > Locate by Bearing-Ang
Keyboard Commands: locazi2, az
Prerequisite: None
File Name: \lsp\locazi2.lsp

Chapter 12. COGO Menu 634
**Locate by Bearing**

This command locates points by bearing and distance. Additionally, the AutoCAD text screen provides the horizontal distance and coordinates.

**Prompts**

[Enter] to use preview point or Select occupied point?
Pick point/<point Number>: 24

<table>
<thead>
<tr>
<th>PointNo.</th>
<th>Northing(Y)</th>
<th>Easting(X)</th>
<th>Elev(Z)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>24</td>
<td>4922.37</td>
<td>4544.81</td>
<td>0.00</td>
<td></td>
</tr>
</tbody>
</table>

Enter Bearing (Qdd.mmss) <277.1259>: 435.2317
Enter or pick Distance <104.39>: 200
Enter Vertical Angle (dd.mmss) <0.0000>: Enter

**Pulldown Menu Location:** COGO > Locate by Bearing-Ang
**Keyboard Command:** locbrg2, lg
**Prerequisite:** None
**File Name:** \lsp\locbrg2.lsp

**Pick Intersection Points**

This command locates points at screen picked intersections. The object snap mode is set to intersection. This routine is similar to the Locate Point command, with an additional check that makes sure there is an intersection at the picked point. If there is not an intersection at the picked point, then no point is created.

**Prompts**
Pick Intersections Points dialog
APParent intersection on [<Yes>/No]: Y
This first prompt is very important. Apparent Intersection snaps to the apparent intersection of two objects (arc, circle, ellipse, elliptical arc, line, multilinie, polyline, ray, spline, or xline) that do not intersect in 3D space, but may appear to intersect in the current view. This allows you to locate a point at the theoretical intersection of two 3D entities. You should answer No to this prompt if you want to ignore theoretical 3D intersections.

[app on] Pick intersection Point: pick a point
[app on] Pick intersection Point: press Enter to end

Pulldown Menu Location: COGO > Locate at Intersect
Keyboard Command: pickint
Prerequisite: Intersection of two entities
File Name: \lsp\pickint.lsp

Linework Intersection Points
This command is used to create points at all of the intersections between selected linework entities.

Prompts
Select lines and polylines to process.
Select objects: Specify opposite corner: pick objects

Pulldown Menu Location: COGO > Locate at Intersect
Keyboard Command: ADDINTPTS
Prerequisite: None

Chapter 12. COGO Menu
Bearing-Bearing Intersect

This command locates a point at the intersection of two lines. The lines can be defined by picking two points, selecting a line or typing in a bearing. After the lines are defined a point symbol is located at the point of intersection.

Prompts

[Enter] to use preview point or select 1st Base point?
Options/<Pick point or point number>: press Enter
Define 1st angle by (Line/Points?Right/Azimuth/Bearing) <Bearing>: L
Select Line or Polyline that Defines 1st Bearing: select
Enter 1st Offset Distance <0.0>: press Enter
2nd Base point?
Pick point or point number: pick a point
Define 2nd angle by (Line/Points/Right/Azimuth/Bearing) <Line>: P
[Enter] to use preview point/or pick 1st point that defines 2nd bearing.
Pick point or Point number: pick point
2nd point that defines 2nd bearing?
Pick point or Point number: pick a point
Enter 2nd Offset Distance <0.0>: press Enter
Enter/<Select text of elevation>: select
The point is then located at the computed point of intersection.

Pulldown Menu Location: COGO > Locate at Intersect
Keyboard Command: bb
Prerequisite: None
File Name: \lsp\bbint.lsp
**Bearing-Distance Intersect**

The Bearing-Distance Intersect command prompts the user for a base point from which the known bearing intersects. It then defines the bearing by one of three methods. The bearing can be defined by picking two points, selecting a line with the same bearing or by typing in the bearing in the form of Qdd.mmss (similar to the Locate by Bearing command). Next the user is prompted for a base point from which the known distance radiates. After entering the known distance a circle is drawn radiating from the selected base point, and a line defined by the bearing is extended to intersect the circle. The user then picks the correct point for the solution desired and a point symbol is located at the selected intersection. The command then erases the temporary circle and line. The Options choice allows you to be prompted for angle method or for offsets, or both.

**Prompts**

[Enter] to use preview point or select known Bearing base point
Options/Pick point or point number: pick point
Define 1st bearing by (Line/Points/Azimuth/Bearing)<.Bearing>: l
Select Line or Polyline that Defines Bearing: pick entity
Enter 1st Offset Distance <0.0>: press Enter
Known distance base point.
Pick point or point number: pick point
Points/<Enter Distance> 40.41
Enter 2nd Offset Distance <0.0>: press Enter
[int on] Pick Intersection point ([Enter] to cancel): pick point
Enter Point Number <55>: press Enter This prompt appears only if Automatic Point Numbering is turned off. See Point Defaults
Enter Point Symbol Number <4>: press Enter This prompt appears only if point symbol prompting is turned on. Symbol number 4 is located at the computed coordinate and labeled point number 55.
When Options (O) is selected

**Pulldown Menu Location:** COGO > Locate at Intersect

**Keyboard Command:** bdint

**Prerequisite:** None

**File Name:** \lsp\bdint.lsp

### Distance-Distance Intersect

This command creates a point at the distance-distance intersection from two base points. The program prompts for two distances and two base points. The two possible intersections (A,B) are shown on the screen. You can either pick near the desired intersection or type in the letter A or B. The A intersection is clockwise from the first point. The Options choice brings up a small dialog that allows you to be prompted for angle method or for offsets, or both.

### Prompts

- **Select 1st base point**
  - Options/<Pick point or point number>: 1
  - Points/<1st distance>: 46.72
  - Enter 1st Offset Distance <0.0>
- **Select 2nd base point**
  - Pick point or point number: 2
  - Points/<2nd distance>: 38.96
  - Enter 2nd Offset Distance <0.0>: press Enter
  - Pick near solution or Enter [A] or [B]: pick a point
Pulldown Menu Location: COGO > Locate at Intersect
Keyboard Command: DD
Prerequisite: None
File Name: \lsp\ddint.lsp

2 Point - 2 Point Intersect

This command is similar to Bearing-Bearing Intersect except that in this command bearings are defined by specifying two point numbers. In the example shown below, the first two points specified are 3838 and 3839, the second pair are 3841 and 3840. Point 3842 is located at the intersection.

Prompts

Specify 1st base point.
Pick point or point number: 3838
Specify 2nd point that defines 1st direction.
Pick point or point number: 3839
Specify 2nd base point.
Pick point or point number: 3841
Specify 2nd point that defines 2nd direction.
Pick point or point number: 3840
Select/<Enter Point Elevation>: Enter value
Pulldown Menu Location: COGO > Locate at Intersect

Keyboard Command: bbint2

Prerequisite: None

File Name: \lsp\bbint2.lsp

Create Points from Entities

This command will create Carlson points on selected entities. The points are stored in the current coordinate (.CRD) file and drawn on the screen. For arcs and polylines with arc segments, points are created at the radius points of the arcs as well as the PC and PT.

In the first options dialog, there are settings for the point attributes. To have points obtain their elevation from the selected entities, unselect the Prompt for Elevations toggle and select the Locate on Real Z Axis toggle. After you have specified the point options, a secondary dialog appears which allows you to specify the entity types to process. Under the Description Settings, Prompt for Description At Each Point will prompt you at the command line for a description for each individual point. Prompt Per Entity will ask you for a description per each highlighted entity. Use Entity Layer for Description will assign the layer name to the description. When Entity Layer for Description is checked, the layer name of the entity will be used as the description for the created point. Same Description For All Points will prompt you for a single description for all points.

The second options dialog has processing settings. When Avoid Duplicates with Existing Pts is checked, this routine will not create a point if a point with the same coordinates already exists in the current coordinate (.CRD) file.
Routine begins with this dialog

After clicking OK on the first dialog

**Prompts**

Create Points From Entities Dialogs Choose settings
Select arcs, circles, faces, points, text, lines and polylines.
Select objects: *pick entities*
Before and after using Create Points from Entities. Points are created at each endpoint and radius point.

**Pulldown Menu Location:** COGO  
**Keyboard Command:** autopnts  
**Prerequisite:** drawing entities  
**File Names:** \$\backslash $isp\crdutil.arx, \$\backslash $isp\autopnts.lsp

### Resection

This command calculates point coordinates given the angle and distance from two or three reference points. The Z coordinate can also be calculated in addition to the X,Y. If you only need the 2D solution, then enter the instrument and rod heights as 0.0, the zenith angle as 90 and the distance as the horizontal distance. The reference points are specified by point number. These reference points need to be stored in the current coordinate (.CRD) file before running this command.

After entering the reference point, there is a dialog to enter the horizontal angle, zenith angle and slope distance. The horizontal angle is the horizontal azimuth or angle right from the unknown point to the reference point. In the example, the backsight azimuth is 0 (due north), but this is not a requirement since the backsight can be any angle. The program calculates the coordinate by averaging the distance-distance and angle-angle solutions. Since there is redundant data, the final calculated coordinate will differ slightly from the individual measurements. For example, in a 3-point resection, there are two different distance-distance solutions (between the first-second point and between the second-third points). The program reports the difference between the final coordinate and the individual solutions as the residuals which act as an indicator whether the data is good. High residuals suggest a problem with the input data. In the dialog that displays the final coordinates and residuals, there is a button to store the coordinates to the current coordinate (.CRD) file with a specified point number.

In the first Resection dialog box, you can choose to use two or three reference points.
In the second Resection dialog box, you assign the reference point.

**Point:** You must enter the point number of your reference point. These reference points need to be stored in the current coordinate file before you run this command.

**Inst. Height:** You must enter the instrument height.

**Target Height:** You must enter the target height.

If you need only the 2D solution, then enter the instrument and target heights as 0.0.

In the Manual Read dialog box, you must specify parameters for the calculation.

**Horizontal Angle:** You must enter a horizontal angle from the resection to the reference points. The horizontal angle is the horizontal azimuth, or angle right, from the unknown point to the reference point.

**Zenith Angle:** You must enter a zenith angle. For a 2D solution, set the zenith angle to 90 degrees.

**Slope Distance:** You must enter a slope distance from the reference points to the resection.

You are prompted for additional reference points and parameters.

The Resection Calculation dialog box that displays the final coordinates and residuals. You can select the option to store the coordinates in the current coordinate file with a specified point number.
Pulldown Menu Location: COGO > Locate at Intersect
Keyboard Command: cresection
Prerequisite: Two or three reference points
File Name: \ls\cogoutil.arx

**Benchmark**

This command is similar to the data collector routine, where a measurement with a total station is taken from an unknown elevation to a known elevation foresight. The unknown elevation of the occupied point is then calculated based on the measurement. Either the Occupied Elevation or the Instrument Height can be calculated. Note that a check box is located at the bottom of the dialog box to "Store Elev To Occupied Pt". This will automatically change the elevation of the occupied point.
Prompts

Coordinate File to Process dialog If required, this dialog will appear and you must select a file.
Benchmark dialog Fill in variables, click Calculate

Pulldown Menu Location: COGO
Keyboard Command: benchmark
Prerequisite: None
File Names: \\lsp\cogoutil.arx

Numeric Pad COGO

Using only the keys on the numeric pad, this command does several COGO commands. The program cycles through six prompts. Only respond to the prompts that apply and the program will perform the correct action. The prompts are: First point? First angle? First distance? Second point? Second angle? Second distance?

To inverse, give a first point and second point.
To traverse, give a first point, first angle and first distance.
To do bearing-bearing intersect, give a first point, first angle, second point and second angle.
To do bearing-distance intersect, give a first point, first angle, second point, and second distance. Or give a first point, first distance, second point, and second angle. The point is calculated at the closer intersection.
To do distance-distance intersect, give a first point, first distance, second point, and second distance. The point is calculated at the first intersection going clockwise from the first point's distance circle.

Points can be screen picked or entered as point numbers that reference the current coordinate file. The last point is used as a default when you press Enter at the prompt for the first point. Which point is being used is indicated by a ghost arrow pointer.

Angles can be specified by picking two points or entering an angle code which begins with a single digit code followed by the degrees and the minutes and seconds after a decimal point. The digits codes are (1 - Northeast, 2 - Southeast, 3 - Southwest, 4 - Northwest, 5 - Azimuth). For example, Northwest 50d10'2'' would be 450.102.

Distances can be specified by picking two points or entering the distance value.

Prompts

Enter coords/Quit/<Pick 1st point or point number>: 5
Pick or Type 1st Direction by 2 Points: 145.0135 (Northeast 45d1’35’’)
Pick or Type 1st Distance by 2 Points: 50.0
A point is created from the values for this traverse. The prompts for the second point don't appear because all the information for this action is entered.
Enter coords/Quit/<Pick 1st point or point number>: press Enter to use the point created by the traverse.
Pick or Type 1st Direction by 2 Points: 50.0
Enter coords/Quit/<Pick 1st point or point number>: 4
Enter/Pick 2nd Direction by 2 Points: press Enter
Enter/Pick 2nd Distance by 2 Points: 75.0
This creates a point by distance-distance intersect.

Enter coords/Quit/\Pick 1st point or point number\>: Q

Pulldown Menu Location: COGO
Keyboard Command: ccogo
Prerequisite: None
File Name: \lsp\cc.lsp

### Point on Arc

This command locates a point on an arc. You can select an arc entity, an arc polyline segment or enter three points to define an arc. After the arc is defined, the screen preview arrow shows the occupied point and the distance to solve for is entered. The command then displays the curve information and locates/inserts a point symbol at the computed point. When prompted for the distance, use a positive value if the distance is from the 1st endpoint (PC the one highlighted by the screen preview arrow) and a negative value if from the 2nd endpoint (PT).

**Prompts**

**Define arc by, Points/\select arc or polyline\>:** *pick arc or polyline arc segment* Pick a point on the arc somewhere near it’s midpoint. The preview arrow points to the 1st endpoint.

**Precede distance with minus sign if distance from 2nd endpoint.**

**Distance along arc from 1st point:** 100

The command then plots a point at the computed distance.

**Pulldown Menu Location:** COGO > Interpolate Points
**Keyboard Command:** ptarc
**Prerequisite:** None
**Filename:** \lsp\loconarc.lsp

### Divide Between Points

This command divides the distance between two points and inserts one of the point symbols at the specified distances. It can also interpolate elevations (to interpolate the elevations, the points picked must be at their real Z axis elevation).

**Prompts**
Interpolate elevations [Yes/<No>]? hit Enter
Point to divide-interpolate from?
Pick point or point number: 1

PointNo. Northing(Y) Easting(X) Elev(Z) Description
1  4252.76  4158.32  0.00

Point to divide-interpolate to?
Pick point or point number: pick a point
Number of Segments-Divisions: 3
Enter Point Description <>: hit Enter
The command then locates two points.

Pulldown Menu Location: COGO > Interpolate Points
Keyboard Command: divlin
Prerequisite: 2 points
File Name: \lsp\divlin.lsp

Divide Along Entity
This command locates points along an entity such as a line, polyline, spline or arc. You must specify the number of divisions.

Prompts

Interpolate Elevations [Yes/<No>]: press Enter
Select Entity to Divide: pick point on entity
Number of Divisions/Segments: 15
The command then locates 14 points.

Pulldown Menu Location: COGO > Interpolate Points
Keyboard Command: divent
Prerequisite: 2 points if you want to interpolate elevations
File Name: \lsp\divent.lsp
Interval Along Entity

This command creates points at a specified distance along an entity such as a line, arc, spline or polyline. The points are listed out on the text screen, stored in the current coordinate (.CRD) file and drawn on the screen. For example, you might use this command to locate lot corner points along a frontage line. When Break Entity at Points is checked, the selected entity will be broken at every located point. When Create Point at Endpoint is checked, points will also be located at the endpoints of the selected entity. Horizontal Distance Between Points allow you to specify the distance between located points. There is also an option to create points on curved portions of the centerline at a different interval than on tangent portions (to reduce chord lengths, a shorter interval may be suitable for curves).

For improved descriptions on the points, there is an option, in this main dialog, allowing you to determine whether or not to label elevations on the new points. And for the purposes of describing the points, there is an option that allows you to set the same description to all of the points. For more options related to points, see Point Defaults under the Points pulldown.

Create Points at Endpoints turned on
Prompts

Select entity near endpoint which defines first station.
[nea on] Select Entity to Interpolate Points: select entity
[nea on] Select Entity to Interpolate Points: Locating 13 Points
The command locates points along the selected entity.

Pulldown Menu Location: COGO > Interpolate Points
Keyboard Command: ptint
Prerequisite: An entity
File Name: \lsp\ptatint.lsp

Create Points from Entities

This command will create Carlson Survey points on selected entities. The points are stored in the current coordinate (.CRD) file and drawn on the screen. For arcs and polylines with arc segments, points are created at the radius points of the arcs as well as the PC and PT.

In the first options dialog, there are settings for the point attributes. To have points obtain their elevation from the selected entities, unselect the Prompt for Elevations toggle and select the Locate on Real Z Axis toggle. After you have specified the point options, a secondary dialog appears which allows you to specify the entity types to process. Under the Description Settings, Prompt for Description At Each Point will prompt you at the command line for a description for each individual point. Prompt Per Entity will ask you for a description per each highlighted entity. Use Entity Layer for Description will assign the layer name to the description. Same Description For All Points will prompt you for a single description for all points.

The second options dialog has processing settings. When Entity Layer for Description is checked, the layer name of the entity will be used as the description for the created point. When Avoid Duplicates with Existing Pts is checked, this routine will not create a point if a point with the same coordinates already exists in the current coordinate (.CRD) file.
Prompts

Create Points From Entities Dialogs
Choose settings
Select arcs, faces, points, text, lines and polylines.
Select objects: pick entities
Before and after using Create Points from Entities. Points are created at each endpoint and radius point.

Pulldown Menu Location: COGO
Keyboard Command: autopnts
Prerequisite: drawing entities

Line by Angle-Distance

This command draws a line from an occupied point at a given angle and distance, where the angle format supports the standard 1-9 angle-bearing codes. It holds the current occupied point and calculates a line by angle-distance to each entered point. As for the angle formats, the Options choice allows for angle right, azimuth only or prompt entry (Right/Azimuth/Prompt) methods. The Prompt method allows you to enter the 1-9 angle-bearing codes.

Prompts

Occupied Point ?
Pick point or point number: pick point
Exit/Options/SideShot/Inverse/Enter Azimuth (ddd.mmss) <90.0000>: 112.3024
Points/<Distance>: 290
Exit/Options/SideShot/Inverse/Enter Azimuth (ddd.mmss) <112.3024>: O
Angle prompt angle right or azimuth only [Right/Azimuth/Prompt]? R
Exit/Options/SideShot/Inverse/Enter Angle (dd.mmss) <112.3024>: 88
Points/<Distance>: 300
Exit/Options/SideShot/Inverse/Enter Angle (dd.mmss) <88>: O
Angle prompt angle right or azimuth only [Right/Azimuth/Prompt]? P
Exit/Options/Points/Angle-Bearing Code <7>: Enter
Enter Angle (dd.mmss) <88>: 31.4340
Points/<Distance>: 419
Exit/Options/Points/Angle-Bearing Code <7>: E
Tangent Line from Circles

This command draws a line that is tangent to two circles. The circles are defined by picking the radius point and entering the radius. The tangent line can be drawn to either outside on the left or right side, or across the middle between the circles from left to right or from right to left. The line and the circles are drawn in the current layer.

Prompts

Pick center point of first circle: pick a point
Pick first radius: 25
Pick center point of second circle: pick a point
Pick second radius: 35
Left or Right tangent [<Left>/Right/LtoR/RtoL]? L

Building Offset Extensions

This command is used to calculate building corner offset points that are extensions of the building faces. This command uses building perimeters that are drawn as closed polylines. The point are stored to the current coordinate file and draw on the screen. There is a dialog for setting the parameters. The Offset Amount is the distance that the offsets are extended past the end of the building line. The Starting Point Number is the point number to begin storing from. The Point Description and Elevation are assigned to all the new points and the Point Layer is used for all the drawn points. Offset points are always created as extensions of the building lines at the corners. Offset points can optionally be created at the diagonals of corners and across to the other side of the building for inside corners. In the
example show here, points 101, 103, 104, 106, 107, 109, 110, 112, 115, 117, 118 and 120 are corner extension offset points. Points 102, 105, 108, 111, 116 and 119 are diagonal points. Points 113 and 114 are across building points.

![Building Offset Extensions dialog](image)

Prompts

**Building Offset Extensions dialog**

Select building perimeter linework.  
Select objects: *make selection*

**Pulldown Menu Location:** COGO  
**Keyboard Command:** bldg_pnts  
**Prerequisite:** A polyline perimeter that represents a building  
**File Name:** \lsp\poly3d.arx

**Radial Stakeout**

This command creates a radial stakeout report using the current coordinate (.CRD) file. The program calculates the azimuth, angle right, horizontal distance and/or slope distance for a range of points relative to an occupied point and a backsight point.
Occupied Point Number: Specify the occupied point number X and Y values will fill in automatically.
Backsight Point Number: Specify the backsight point number X and Y values will fill in automatically.
Maximum Hz Distance: This is the maximum horizontal distance from the occupied point that the program will include in the report.
Range of points to Compute: Enter the range of points to be included in the stakeout report If you check Select Points from Screen, this option is unavailable.
Select Points from Screen: This option allows you to select from the screen the points to be included in the stakeout report.
Number of Decimal Places: Specify the display precision for the report.
Report Options: Specify the direction format that the report should use.
Report Slope Distance: When checked, the slope distance is included in the report in addition to the horizontal distance.
Use Cut Sheet Format: When checked, adds columns to the report for Description, Hub Elev, and Elevation.

Results from clicking the List (point) button
Sample radial stakeout report:

Radial Stakeout
Occupied Point
2 7137.7248 9016.1417 500.000

Backsight Point
1 7075.7408 8875.7884 500.000
Backsight Azimuth= 246.1021

PtNo. Azimuth AngRight HzDist North(y) East(x) Elev(z)
3 261.0258 14.5237 74.061 7126.2022 8942.9830 500.000
4 262.4347 16.3327 113.032 7123.4208 8904.0181 500.000
5 281.1809 35.0748 137.858 7164.7435 8880.9572 500.000
6 301.4512 55.3452 82.296 7181.0342 8946.1639 500.000

Pulldown Menu Location: COGO
Keyboard Commands: radstake, rs
Prerequisite: A coordinate file (.CRD file) with points

Section Subdivision

This command calculates and stores unknown corners that can be calculated given the data specified.
The Section number, Township and Range must be entered first.
Next, specify the point IDs of corners that have been located in the field.

Note: The choices in the Specify Field Located Corners section of the dialog merely make it more convenient to
enter the Section & Quarter corners and the 1/16th corners. This choice allows you to enter the corners in order
by just typing the point ID of a corner then just press enter to move to the next corner. You may enter any type of
corner located in the field by changing the types of corners selection in the Specify Field Located Corners section.

Next, enter the government chainages as required.

The calculated points will be plotted on the screen and saved to the coordinate file.

For each calculated corner, the Saving Point dialog box will be displayed. Depending on the point default settings,
this dialog may allow you to accept or change the default point ID. Also, Depending on the point default settings,
the description and elevation may also be changed or accepted.
Pulldown Menu Location: COGO > Section Corners
Keyboard Command: cg_section_subd
Prerequisite: Coordinate File

**GLO Corner Proportioning**

The GLO Corner Proportioning commands calculate section and 1/4 section corners by one, two, three or four way control. GLO plats are the official plats of the U.S. Government Land Office (GLO) executed after July 1946. The Department of the Interior, Bureau of Land Management (BLM) is the successor agency to the GLO.

**One Way Control**

This routine calculates section and 1/4 section corners by one way control. First, enter the point number for Point A. This number can be entered in manually or picked from the screen by selecting the Pick radial button at bottom right. In a like manner, the Bearing from A to B can be entered manually or by using the Pick radial button to pick from the screen. The distance from A to X can be specified in the same manner as above. After selecting OK, a dialog box will display where the Point number, description and elevation can be edited. The point default settings determine the available data for editing. For example, if the option for Automatic Point Numbering is turned off in the Point Defaults, then the field for the point number will be grayed out. If elevations are turned off in the point defaults, then the elevation field will be grayed out. This also applies to the description of the point as well.
Prompts

GLO Proportioning One Way Control dialog

Saving Point dialog

Pull down Menu Location: COGO > Section Corners > GLO Corner Proportioning

Keyboard Command: cg_glo_one_way

Prerequisite: A coordinate file
**Two Way Control**

This routine calculates section and 1/4 section corners by two way control. Enter the point numbers for Point A and B. These numbers can be entered in manually or picked from the screen by selecting the Pick radial button at bottom right. In a like manner, the Record Chainages from A to X and from A to B can be entered manually or by using the Pick radial button to pick from the screen. After selecting OK, a dialog box will display where the Point number, description and elevation can be edited. The point default settings determine the available data for editing. For example, if the option for Automatic Point Numbering is turned off in the Point Defaults, then the field for the point number will be grayed out. If elevations are turned off in the point defaults, then the elevation field will be grayed out. This also applies to the description of the point as well. GLO is an acronym for Government Land Office.

**Prompts**

GLO Proportioning Two Way Control dialog

![GLO Proportioning Two Way Control dialog](image)

Saving Point dialog

![Saving Point dialog](image)
Pulldown Menu Location: COGO > Section Corners > GLO Corner Proportioning
Keyboard Command: cg_glo_two_way
Prerequisite: A coordinate file

Three Way Control

This routine works as the previous GLO Proportioning methods described. Fill out the required data fields on the dialog box and select OK. After selecting OK, a dialog box will display where the Point number, description and elevation can be edited. The point default settings determine the available data for editing. For example, if the option for Automatic Point Numbering is turned off in the Point Defaults, then the field for the point number will be grayed out. If elevations are turned off in the point defaults, then the elevation field will be grayed out. This also applies to the description of the point as well. GLO is an acronym for Government Land Office.

Prompts

GLO Proportioning Three Way Control dialog
Pulldown Menu Location: COGO > Section Corners > GLO Corner Proportioning
Keyboard Command: cg_glo_three_way
Prerequisite: A coordinate file
Four Way Control

This routine works as the previous GLO Proportioning methods described. Fill out the required data fields on the dialog box and select OK. After selecting OK, a dialog box will display where the Point number, description and elevation can be edited. The point default settings determine the available data for editing. For example, if the option for Automatic Point Numbering is turned off in the Point Defaults, then the field for the point number will be grayed out. If elevations are turned off in the point defaults, then the elevation field will be grayed out. This also applies to the description of the point as well. GLO is an acronym for Government Land Office.

Prompts

GLO Proportioning Four Way Control dialog

![GLO Proportioning Four Way Control dialog](image)

Saving Point dialog:
Pulldown Menu Location: COGO > Section Corners > GLO Corner Proportioning
Prerequisite: A coordinate (CRD) file
Keyboard Command: cg_glo_four_way

Solar Observations

This feature calculates true north and/or grid north bearings by solar observation. It uses the Local Hour Angle (LHA) method. The routine calculates Ephemeris data, thus alleviating the necessity of obtaining a Solar Ephemeris. The True North option calculates the true north bearing to mark. This option requires no zone/ellipsoid information. The True North & Grid North option calculates both true north and grid north bearings to north. The convergence angle is also shown.

Note: There is a description of solar observation field procedures at the end of this section.

True North Prompts

Calculate true north, or true north and grid bearing (<True north>/Grid Bearing: type T, press Enter
Choose field method (Leading edge/Trailing edge/<Center>): choose method, press Enter
If a Roelofs prism is being used, the Center Method should be selected. If not, select one of the other options. The Trailing Edge Method is the more popular of the two remaining methods.
Date of observation as MM/DD/YY or MM-DD-YYYY: For example 04/08/03.
Enter latitude of instrument point as DD.MMSS: For example 36.0545
Enter longitude of instrument point as DD.MMSS:

The following input loop will begin:

Obs. #1 - Time of observation as HH.MMSS: For example 15.3030
Enter angle to mark as DD.MMSS: Angle in the instrument when backsighting the mark.
Enter angle to sun as DD.MMSS: Clockwise angle from mark to sun.
The angle to the mark always has a default value of the last entered Angle to Mark. Each observation is numbered and the true bearing to the mark will be calculated. There is not limit as to the number of observations that can be made from a setup. After data entry is complete, press Enter.

The following options appear:

[Edit/Ok/Quit] <O>:

If you choose Edit, you will have the following options:

**ADD/Change/Delete/eXit:**

**Add:** Allows for addition observation data entry.

**Change:** Allows editing of existing data. When selected a prompt for Enter observation to change will be displayed. Choose which observation number to edit. You will then be prompted with the initial input prompts for the observation again. The original input values will be the default values for each prompt. To change the value, simply enter new data.

**Once Delete:** This will delete the specified observation data. Choose the observation number to delete.

**eXit:** This exits the change routine.

If you type 0 and Enter or just enter for OK, the bearings from all the observations will be averaged and shown as well as the True Bearing. For example:

**No. Time Angle-@-Mark Angle-to-Sun True-Brg-to-Mark**

1 12.3030 0°00'00'' 20°00'00'' N 73°05'43''E
2 12.4456 0°00'00'' 21°00'00'' N 74°17'15''E
Average True Bearing: N 73°41'29''E

**True North & Grid Bearing Prompts**

Type of calculation [True-north/true-north-and-Grid-bearing] <T>: G

The following dialog will be displayed.

![Solar Observations - State](image)

Select the state in which the observations were made. All fifty states are available, as well as PR for Puerto Rico and UTM for Universal Transverse Mercator.

If the state is divided into zones, you will be prompted for the zone you are working in.
**Enter zone (N,S):** Enter the zone.

If you are using a UTM, you will see the following prompt:

**Enter ellipsoid to use [GRS-1980/Other] <G>:**
Type "R" and Enter or just Enter for Reciprocal flattening, "S" and Enter for Semi-minor axis, or "E" and Enter for ellipsoid ECC squared.

If you typed O and Enter for Other, you will see the following prompt:

**Ellipsoid constant [Reciprocal flattening/Semi-minor axis/ellipsoid ECC squared] <R>:**
Depending on what was entered at the last prompt you will see one of the following prompts:

- **Enter reciprocal flattening constant:** Type the constant.
- **Enter semi-minor axis:** Enter the axis.
- **Enter ellipsoid ECC squared constant:** Enter the constant.

After entering the zone and ellipsoid information (if applicable) the date, latitude, longitude and time input loop will begin (as described above for the True North calculation).

After data entry is completed the [Edit/Ok/Quit] <O>: prompt will be displayed (see the True North section for more details on this prompt).

If you type 0 and Enter of just Enter for Ok, the information for all the observations is displayed along with the Average True Bearing, Average Grid Bearing and the Convergence Angle as follows:

**No. Time Angle-@-Mark Angle-to-Sun True-Brg-to-Mark**
1 12.2222 0°00'00'' 20°00'00'' N 72°57'31''E
2 12.4444 0°00'00'' 22°00'00'' N 74°20'51''E

**Average True Bearing:** N 73°39'11''E
**Average Grid Bearing:** N 72°15'12''E
**Convergency Angle:** 1°23'59''

**Field Procedures for the Local Hour Angle (LHA) method**

This section explains Universal Time and then explains two ways of pointing, Trailing Edge Tangency and Roelofs Prism.

**Universal Time**
The Universal Time can be obtained on certain radio bands. On the radio channel there will be a signal beep every minute. Set a watch to the Universal Time or, when in the field, start a stopwatch at the beep (for a known Universal Time).

In order for the solar observation method to produce accurate results, it is essential that you record the precise Universal Time for an observation. Thus, when making the field observations, record the stopwatch elapsed time in order to calculate the Universal Time or, if you set your watch to Universal Time, record the time directly.

**Trailing Edge Tangency**
While pointing at the ground mark, set the horizontal circle to read about 00-00-30, perfect pointing. With the scope direct, record the horizontal circle reading to the mark.
Attach the eyepiece filter and sight the sun. After locating the sun, do the following:
Set the horizontal reticle line near the center of the sun's image with the vertical reticle line leading the trailing edge of the sun (slightly right for a direct image).
Clamp the horizontal motion and watch the image of the sun as the trailing edge approaches tangency with the vertical reticle line.
Stop the timer at the time of tangency.
Record the time and the horizontal circle reading.
Repeat the pointing for a total of four pointings in the direct position.
Unclamp the horizontal motion, rotate the instrument 180 degrees, plunge the scope, and then obtain data for four reverse readings.
Unclamp the horizontal motion, point at the ground mark with the instrument reverse and record the horizontal circle.
The timer must be checked-in on a radio signal. Some quartz regulated electronic watches are accurate for extended periods of time, allowing several hours of check-in to check-out on the radio. Otherwise, most timers should be started and stopped on a radio signal at the beginning and ending of the observation set.

**Roelofs Prism**
Attach Roelofs prism and sight the sun (you can center the shadow of the telescope between the standards as an aid in locating the sun). Be sure that the hinged tube is closed when pointing at the sun. After locating the sun through the scope, do the following:
Rotate the prism until the four overlapping images of the sun are symmetrical with the instrument's reticle lines.
Point on the ground mark with the instrument direct and the Roelofs prism tube swung open, perfect pointing on the ground mark. Record the horizontal circle reading to the mark.
Point at the sun with the prism closed. After locating the sun, do the following:
Set the horizontal reticle line near the center of the sun's pattern with the vertical reticle line leading the center of the moving pattern (slightly to right of the sun for direct optics).

Clamp the horizontal motion and watch the pattern move to the point of coincidence. This is the intersection of the vertical reticle line with the apex of the small dark square formed in the center of the pattern by the overlapping parts of the four images formed of the sun.
Stop the timer at the moment of coincidence.
Record the time and the horizontal circle reading.
Repeat the pointing for a total of four readings in the direct position.
Unclamp the horizontal motion, rotate the instrument 180 degrees, plunge the scope, and then obtain data for four reverse readings.
Unclamp the horizontal motion, point on the ground mark with the instrument reversed and record the angle on the horizontal circle.
The timer must be checked-in on a radio signal. Some quartz regulated electronic watches are accurate for extended periods of time, allowing several hours of check-in to check-out on the radio. Otherwise, most timers should be started and stopped on a radio signal at the beginning and ending of the observation set.

**Pulldown Menu Location:** COGO
**Keyboard Command:** cg_solar_obs
**Prerequisite:** None

**Triangle Solutions**
Triangle Solutions solves for the remaining sides and angles of a triangle given the known side and angles. The upper case letters A, B and C represent the distances. The lower case letters a, b and c represent the angles. Distance A is the leg of the triangle opposite the angle 'a'. Likewise, distance B and C are the legs opposite the angles of 'b' and 'c', respectively. Enter any three known values of the six possible parameters and the three unknowns will be calculated and displayed. If you enter three angles, you will be shown proportional distances since there is an infinite number of distances that would solve a three angle triangle.
In this example, the sides A & B are known as is angle ‘a’. After entering the three parameters, press the Solve button and the remaining three will be calculated and shown. The area in acres or hectares and feet or meters will also be calculated and shown. Press clear to enter data on a new triangle after the triangle has been solved. The solution for each triangle area is then displayed at the command line. You may press F2 to display the command line window and view the results.

Side A Side B Side C Angle a Angle b Angle c
45.00 85.00 88.40 30°00'00'' 70°48'43'' 79°11'17''

Area = 1878.550 sq. ft. (0.043 acres)

Pull-down Menu Location: COGO

Keyboard Command: trianglesolutions

Prerequisite: None

File Name: \sp\cgsc.arx

Best Fit Circle

This command draws a least-squares best-fit circle based on points on the perimeter. The program handles four or more perimeter points. A design point for the circle center can optionally be specified as a reference to compare with the best-fit center in the report. The report shows the residuals for each point, the residuals standard deviation, the difference between the design point and the circle center, and the circle parameters. The residuals are calculated as the perpendicular distance from the point to the circle. The best-fit circle can be calculated in 2D or 3D. In 2D mode, the elevation of the points is not used. In 3D mode, a best-fit plane is calculated for the points. Then the points are projected onto the plane and the best-fit circle is calculated on this plane. Then the resulting circle is projected back into world coordinates and drawn as a 3D polyline with short chords to represent the 3D circle since CAD doesn't support a 3D circle entity. Applications for 3D circles are tunnel sections and architectural arches.
After specifying the points, the program calculates the best-fit circle and shows the results in the dialog shown here. You can toggle each point for whether to include in the calculations. You can also modify the radius.

Prompts

Create 2D or 3D circle [ <2D>/3D ]? press Enter
Select points from screen or by point number [ <Screen>/Number ]? N
Point numbers: 2-6
Point numbers (Enter to continue): press Enter
Enter design center point# (Enter for None):

Sample Report:

Source Coordinates
Point# Northing Easting Residual
2 5253.198 5070.233 0.126
3 5246.623 5084.077 0.045
4 5232.963 5078.608 -0.131
5 5235.610 5065.105 0.217
6 5247.392 5064.165 -0.264
Residuals Standard Deviation: 0.174

Circle Center: 5242.678, 5073.785 Radius: 10.977
Design Center Point#: 1
Design Center: 5242.718, 5073.688
Center Distance Difference: 0.105
Best Fit Circle

Pulldown Menu Location: COGO
Keyboard Command: bfitcir
Prerequisite: Four or more points
File Name: \lsp\crdutil.arx

**Best Fit Line by Average**

This command will fit a line from a starting point by sampling a group of points. The routine averages the coordinates of the sampling group then draws the best-fit line. The program generates a report of the residuals, standard deviation, line bearing and line distance. The perpendicular distance from each point to the line is reported as the residual.

Screen selection of lines almost in line with one another
Prompts

Starting point?
Pick point or point number: pick starting point
Select points from screen, group or by point number [<Screen>/Group/Number]? press Enter
Select points.
Select objects: select group of points Select points using Window or Crossing. The line is then drawn to the computed point.

Pulldown Menu Location: COGO
Keyboard Command: bfitlin
Prerequisite: points to sample
File Name: \lsp\bfitlin.lsp

Best Fit Line by Least Squares

This command will sample a group of points by screen selection or point number range, and then compute the best fitting line by least squares. There are options to best fit with nothing held (None), to best fit by holding a point, and to best fit by holding a bearing. All three options are shown below in the graphic. When holding a point, you are prompted to enter the weight for the point. In this example, a weight of 1000 caused the line to pass to within 0.025 of point 111. With a weight of 5000, the line passed to within 0.005 of point 111. Increase the weight accordingly to obtain the desired precision. When holding a bearing such as N45E, you are prompted to enter the bearing in the form QDD.MMSS (e.g. 145.0000 or just 145). The program generates a standard report. The residual for each point is the perpendicular distance from the point to the best-fit line.

After specifying the points, the program calculates the best-fit line and shows the results in the dialog show here. You can toggle each point for whether to include in the calculations.
Prompts

Select points from screen, group by point number [<Screen>/Group/Number]? S

Select Carlson Software Points.

Select objects: pick the five points

Point numbers (Enter to continue): press Enter

Parameter to hold [<None>/Point/Bearing]: P

Enter point number to hold: 111

Enter weight for point: 5000

Sample Report:

Best Fit Line By Least Squares

Holding point 111: (5227.721, 5149.482)

Coordinate File > c:\data\interval.crd

Source Coordinates

<table>
<thead>
<tr>
<th>Point#</th>
<th>Northing</th>
<th>Easting</th>
<th>Residual</th>
</tr>
</thead>
<tbody>
<tr>
<td>109</td>
<td>5103.542</td>
<td>5182.098</td>
<td>10.050</td>
</tr>
<tr>
<td>110</td>
<td>5114.634</td>
<td>5191.928</td>
<td>6.921</td>
</tr>
<tr>
<td>111</td>
<td>5149.482</td>
<td>5227.721</td>
<td>0.005</td>
</tr>
<tr>
<td>112</td>
<td>5178.703</td>
<td>5268.237</td>
<td>0.400</td>
</tr>
<tr>
<td>113</td>
<td>5201.666</td>
<td>5312.602</td>
<td>8.129</td>
</tr>
</tbody>
</table>

Residuals Standard Deviation: 6.559

Bearing: N 53°44’07’’ E

Distance: 163.266

Pulldown Menu Location: COGO

Keyboard Command: bfitlinelq

Prerequisite: Group of points to sample

File Name: \lsp\bfitlr.lsp
Centerline Menu

The Centerline menu provides commands for designing and editing centerlines and centerline files. Tools for stationing, labeling and offsetting centerlines, along with Right of Way features, are also provided in this menu. Additionally, there are many import and export conversion options to select from when you pick Centerline Conversion.
Design Centerline

This command draws a centerline polyline and writes the centerline data in a centerline file. The first step is to specify a centerline (.CL) file name. Next in the Design Centerline dialog you can specify several options. Centerline Layer is the layer name for the polyline. Tangents Layer is the layer name for the tangent lines drawn from the centerline to the curve center. Max superelevation is used for determining the minimum recommended radius. Setting the Prompting mode to Existing skips design questions such as design speed.

After the Design Centerline dialog, the program cycles through curve prompting until End is selected. There are PC and PI modes for curve entry. In PC mode the arc’s PC points are entered followed by the curve data. The PC points can be specified by either picking the point, entering a distance or entering a station. In PI mode, the arc’s PI points are entered. Once the PI points determine two tangents, the program prompts for curve data for the previous PI. Spirals can only be entered in PI mode. You can switch between arc and PI mode between curves on the polyline. The arc curvature can be specified by degree of curve or radius. The minimum recommend radius is based on AASHTO. The arc length can be specified by PT station, tangent length or arc length.

The Store Points in CRD File will create points in the current coordinate file for each design point on the centerline. This option is also used for creating the SMI chain file within Centerline Utilities, since the SMI chain file requires point numbers. To specify the coordinate file, choose Set Coordinate File in the Points menu.

Prompts

**Centerline file to design** Enter the .CL file name to create.

**Design Centerline Dialog** Choose your options and click OK.

**Pick Point or Point number:** pick a starting point or enter the starting point coordinates

For PC mode design:

- **Bearing/PI/End/Undo/<Pick Point or Point number>:** pick the PC point
- **Bearing/PC/PI/End/Undo/<Pick Point or Point number>:** PC
- **Enter Design Speed for curve <55.00>:** 40
- **Minimum Recommended Radius = 426.67**
- **View/Point/Degree of Curve/<Radius>:** 500
- **Curve direction (Left/<Right>):** press Enter for right
- **Length to use (Station/Tangent/<Arc>):** press Enter for arc
- **Point/Station/Tangent/<Arc Length>:** 200
- **Reverse/Compound Curve (Yes/<No>):** press Enter
- **PI/Distance/Station/<Pick PC or Point number>:** D for distance
Point/Enter Distance: 180
Bearing/Line/Undo/End/<Continue PC>: press Enter
Enter Design Speed for curve <40.00>: press Enter
Minimum Recommended Radius = 426.67

Example of PC mode centerline design

View/Point/Degree of Curve/<Radius>: 500
Curve direction (Left/<Right>): press Enter
Point/Station/Tangent/<Arc length>: 300
Reverse/Compound Curve (Yes/<No>): press Enter
PI/Distance/Station/<Pick point or Point number>: D for distance
Point/Enter Distance: 140
Bearing/Line/Undo/End/<Continue PC>: E to end
For PI mode design:
Bearing/PI/End/Undo/<Pick Point or Point number>: pi
Pick Point or Point number (PI)<5098.50,3509.11>: pick the first PI point
Type of curve [Spiral/<Circular>]: S for spiral
Enter Design Speed for curve <55.00>: 40
Minimum Recommended Radius = 426.67
View/Point/Degree of Curve/<Radius>: 500
Enter Number of Lanes <2>: 
View/Enter Spiral Length In <204.8000>: 210
View/Enter Spiral Length Out <210.0000>: press Enter
Bearing/Pick next Point or Point number (PI): pick the next PI point
TS: 1+33.280
SC: 3+43.280
CS: 6+39.364
ST: 8+49.364
Bearing/Line/PC/Undo/End/<Continue PI>: press Enter
Type of curve [Spiral/<Circular>]: press Enter for circular
Enter Design Speed for curve <40.00>: press Enter

Chapter 13. Centerline Menu
Example of PI mode centerline design

Minimum Recommended Radius = 426.67
View/Point/Degree of Curve/<Radius>: 500
Bearing/Pick next Point or Point number (PI): pick the last PI
PC : 9+35.900
PT : 16+34.283
Reverse/Compound Curve [Yes/<No>]? press Enter
Bearing/Line/PC/Undo/End/<Continue PI>: E to end
EndPoint : 18+37.121
Stations are printed for every PC, PT and end point in the design process.

Pulldown Menu Location: Centerline
Keyboard Command: centerln
Prerequisite: None
File Name: \lsp\eworks.arx

Input-Edit Centerline File

This command can be used to input a new centerline or edit an existing centerline (.CL) file. It is a dialog-based alternative to Design Centerline and has the advantage of accepting whatever information you have on your centerlines (coordinates, stationing, length of tangents and arcs, etc.). For creating a new centerline, it is ideal for entering data straight from highway design plans. For editing, this command allows you to change any of the geometric properties of any of the elements of the centerline (lines, curves, spiral-only and symmetrical spiral-curve-spiral elements), including the starting coordinates and station.

Starting this command launches the Centerline Input-Edit main dialog box. To edit an existing Centerline, you can either pick the Load button and pick the .CL file, or pick the Screen Pick button and pick the polyline in the drawing that represents the Centerline. The Centerline is then displayed in the graphics window of the dialog box. The highlighted segment in the text window is also highlighted in the graphics window.

Chapter 13. Centerline Menu 675
Drag Action (Zoom and Pan): In the graphics window, hold the left mouse button down and move mouse to Pan, roll the wheel to Zoom.

Add: Adds a new element after the highlighted element. Prompts you for the type of the element to be added, Line, Curve, Spiral-Only or Spiral-Curve-Spiral.

Edit: Allows you to edit the highlighted segment.

Remove: Removes the highlighted element from the centerline.

Up/Down: Moves elements in the table Up and Down in the list. For example, if this centerline ended with a tangential line from the last curve, then was followed by a non-tangential line at 45 degrees NE, moving the last element up would create a line at 45 degrees after the curve (non-tangential), and the formerly tangential line will remain tangential and therefore continue at NE 45 degrees.

Load: Loads an existing centerline (.CL) file for review or editing. After loading a centerline, the listbox in the dialog shows a list of all the elements in the centerline, identifying them as either a line, curve, spiral only or full spiral-curve-spiral element and reporting the ending station, northing and easting of the element.

Screen Pick: Allows user to pick a CL off the screen in the drawing to load into the editor.

Reverse: Reverses direction of Centerline.

Draw: This button draws the centerline in the drawing on the specified layer.

Save: Saves the currently loaded centerline to a file, or will prompt you for a name if no name has been set.

SaveAs: Prompts you for a file name for the saved file.

Help: Goes to the Help screen for the Input-Edit Centerline command.

Fit Curve: Fits a circular curve element into the centerline after the line element that is currently selected.
Fit Spiral: Fits a spiral curve element into the centerline after the line element that is currently selected.

**Point Numbers:** This will create Carlson points along the elements of the centerline and store them to the current CRD file. The new points will be numbered in sequence beginning with the first available point number in the CRD file.

**Station Equations:** At any number of locations on a centerline, you can set the back station and forward station for

---

Chapter 13. Centerline Menu 677
the re-stationing of the centerline. The station equation dialog appears below:

If the Station Back is lower than the Station Ahead, then a "gap" is inserted in the centerline, where the stations jump forward. If the Station Ahead is less than the Station Back, then an overlap occurs, where the common station range is repeated.

**Exit:** Exits this routine, prompting to save changes if necessary.

The dialog for every type of element shows the point ID, the northing, easting and station of the start point of the element. It then allows the user to modify or define the parameters specific to the type of element. The following are some of the things to remember about data entry in the centerline editor. These are valid for lines, curves and spirals.

- Wherever length of the element is to be entered, entering an expression of the type \(123.5 - 93.7\) would evaluate the difference of the values. This is particularly convenient where only the stations of the start and end points of the element are known.

- When the station is specified, the program takes the length of the element as the difference between the station of the start point of the element and the station specified.

- All bearings should be specified by entering the angle between 0 and 90 degree (in dd.mmss format) and selecting the quadrant.

- When entering the delta angle of a curve, only the absolute value (between 0 and 360 degree) is to be entered. The direction of the curve is to be explicitly set as right or left, the default being left. All angles are entered in (dd.mmss) format.

- Point numbers, when used, access their coordinates in the current .CRD file. If the point number specified has no coordinates stored in the coordinate file, the point number is remembered for that particular location (say the radius point of a curve or the SC point of a spiral). Then, when the .CL file is saved, the program creates points for that location and stores them to the .CRD file with the specified point number.

The dialog for a Line allows the user to specify the line primarily by its length or station and its bearing. The line can also be defined by its end point number or its coordinates. The bearing of a line can be changed if the Tangential to the Previous Element toggle is not checked. By default, any line which follows a curve element is defaulted to be tangential to it. To use a bearing different than that of the previous element, uncheck this toggle and enter the bearing.

The dialog for the Curve allows the user to define the curve primarily by its radius and delta angle or arc length.
The other parameters of the curve that can be edited are the bearing of tangent-out and the "Station to", which also defines the arc length. The curve can also be specified by entering the coordinates or point numbers of its end point (PT) and the radius point. Another way to specify the curve would be to enter the chord length or PT point station and chord bearing. If the central PI point and a point on the forward tangent are known, then the curve can be defined by entering both of these points and at least one other property of the curve (like radius, arc length, delta angle). The point on the forward tangent can be any point that defines the tangent out direction including the next PI point. If only the central PI point is known, then the tangent-out can be entered by bearing instead of by forward tangent point. Central PI and forward tangent points are not displayed from the .CL file. They have to be entered by the user and are valid only for that particular edit session; that is, they are not remembered the next time the file is loaded. Curves are assumed to be tangent to the last element unless the Tangential to the Previous Element checkbox is cleared.

The Curve Edit Mode option defines how the curve is accepted in the centerline. If the Hold PC point is checked on, the radius is taken as fixed and the delta angle of the curve is calculated based on some additional parameter. Hence, the extent of the curve is unlimited. However, if the Hold PI points option is checked on, the bearing of tangent-out of the curve is taken as fixed and the radius is calculated based on some other parameter. In this case, the curve is completely restricted within the central PI point and the bearing of tangent out. Hence, when the Hold PI points option is checked on, the above parameters should also be defined to carry out the calculations.

The dialog for the Spiral-Curve-Spiral element allows the user to define the spiral by entering either the various parameters of the spiral (like the angles and lengths) or the coordinates or point numbers of its defining points: the TS (Tangent-to-Spiral), SC (Spiral-to-Curve), Radius point, CS (Curve-to-Spiral), ST (Spiral-to-Tangent) and end point (optional). While defining the spiral by its geometric properties, the program will accept the data even if the information for the simple curve is given with zero spiral lengths. In this method, however, the central PI point of the spiral MUST be specified (that is, it is always in Hold PI Points mode). The tangent out can be defined by entering bearing or by specifying a point on the forward tangent. This forward tangent point can be the next PI coordinates. The direction of the spiral-in and spiral-out elements would be the same as the direction of the simple curve (left or right).

The spiral can be defined by several different parameters and the order that you enter data into the spiral dialog can be important. There are two main sequences for entering data. The method to use depends on the spiral data that you have. The first method is to enter the radius of the simple curve, the spiral in and out lengths, the tangent bearing out and the PI station. The second method is to make a Line segment coming up to the TS (tangent to spiral) point. This Line segment should be added before creating the Spiral element. Then with the Spiral In point set to the TS point, enter the radius of the simple curve, the spiral in and out lengths, the curve direction (left or right) and the arc length of the simple curve. Then the rest of the spiral points will be calculated.

The Spiral Only element allows for flexible transitions from curve to spiral to curve or line to spiral to curve or between any combination of curve and line elements. The Spiral-Curve-Spiral element, for example, can be entered as Line, Spiral Only, Curve, Spiral Only and Line, producing the same results.

Once all the elements of the centerline are defined, the file can be saved and then plotted using the Draw Centerline File command.

**Example**

Here is an example of a highway interchange ramp that involves a starting tangent and a spiral curve that goes abruptly into a simple curve and then a final tangent. Here is the starting dialog.

You start by entering a starting Northing and Easting and starting Station. The Start Point# is optional. Then the concept is that you click Add to add each subsequent element (line, curve, spiral-curve-spiral or spiral only).
Line (Tangent) Segment: We want to enter the tangent segment length up to the TS (tangent to spiral). Enter in the length (200.0), bearing (88.0732) and then the bearing quadrant (NW). Since the next spiral-curve-spiral element can be based on a PI station, it is not necessary for this line segment to go up to the TS point. The purpose of this line segment is to establish the tangent-in direction.

When OK is clicked, the routine will add the Line element as the first in the list of complete centerline elements. Next up is Curve-Spiral-Curve. Click Add.
Spiral Segment: Though the dialog is complex (for total flexibility), the key on a typical symmetrical spiral curve is to enter four things: (1) the radius of the simple curve, (2) the spiral in and out lengths, (3) the tangent-out bearing and (4) the PI station (1835.67). Everything else will calculate when you press Enter for the PI station.

Curve Segment: Add the next element and select curve. The Curve dialog appears. The key is to enter the Radius Length (255), the Arc Length (150) and the Curve Direction. Everything else will calculate.

Final Line Segment: All you need to enter in the final dialog for the line (tangent) segment is its length. All other
items will calculate when you press Enter.

The completed centerline will appear as shown in the dialog and each element can be edited. Pick the Save button to store this centerline data to a .CL file.
Polyline to Centerline File

This command writes a centerline (.CL) file from a polyline in the direction the polyline was drawn. The Northing and Easting for each vertex of the polyline is written to the centerline file and each arc in the polyline becomes a circular curve.

In addition to being used as roadway/corridor "baselines," a .CL file can also be used as the horizontal control for a Template Point Centerline.

Note:

- To convert lines and/or arcs into a polyline, use the Entities to Polylines command or the Join Nearest command.
- To reverse the direction of a polyline, use the Reverse Polyline command.

Prompts

**Centerline file to Write dialog** Enter the .CL file name to create

**Beginning station** <0+00>: Press Enter to accept the default station value specified or Type in the beginning station then press Enter

**Select polyline that represents centerline:** Pick the polyline that represents your centerline

**Pulldown Menu Location(s):** Civil → Centerline, Survey → Centerline, Field → Roads

**Keyboard Command:** cledit

**Prerequisite:** A CRD file to put points or take points from

Draw Centerline File

This command reads a centerline (.CL) file and plots it as a 2D polyline in the drawing at the proper coordinates. First you are prompted for the layer name for the polyline to be created. There is also an Options choice that allows you to specify whether to draw PI lines, and specify the length of same.
Next you are prompted for the file name of the centerline to plot.

The .CL file can be made with the following commands on the Design menu: Polyline to CL File, Input-Edit Centerline or Design Centerline. Drawing the centerline file is a way to check the .CL file data graphically for correctness. If a spiral exists in the .CL file, the spiral will be represented by polyline segments.

**Prompts**

**Options/Layer Name for Centerline <CLINE>:** press Enter
Enter the layer name to plot the polyline on.

**Centerline File to Plot file selection dialog**
Select the .CL file name to read and plot.

**Keyboard Command:** cl2pline

**Prerequisite:** a centerline file

**File Name:** \lsp\clpline.lsp

**Centerline Report**

This command reads a centerline file and creates a report in the standard report viewer which can be written to a file, a printer, or to your drawing. If the centerline file contains point numbers, then the report will include these point numbers. If station equations are found, they are noted at the top of the report. The options dialog has settings for the report format and type of the centerline. The Use Profile for Elevations Report option will prompt you for a profile (.pro) file to add elevations to the report. The Report At Interval option will report stations, northing and easting at the specified station interval.
Here is an example report:

Centerline Report
Centerline File:  C:\sample\setback_3.cl

Station Northing Easting Bearing Distance
0+00.000 4033.165 4379.271
N 13°07'20'' W 92.076'
0+92.076 4122.836 4358.367 PC
Radius:  4196.621 4674.880 Radius Length:  325.000'
PI: 4159.044 4349.926 1+29.254 Tangent:  37.178'
Arc Len:  74.035' Delta:  13°03'07'' Right Degree:  17°37'46''
Chord Len:  73.875' Chord Brg:  N 06°35'47'' W
Radial-In: N 76°52'40'' E Radial-Out:  N 89°55'47'' E
Tangential-In Tangential-Out
1+66.110 4196.222 4349.881 PT

Pulldown Menu Location:  Centerline
Keyboard Command:  clreport
Prerequisite:  A centerline (.CL) file

Centerline ID

Centerline ID reports the centerline file name and location that is associated with an alignment polyline. The subject polyline must have been created with either Design Centerline, Input/Edit Centerline, or Polyline to Centerline File. When the routine is initiated and an alignment polyline is selected, the file associated with that polyline is reported at the command line. Additional alignment polylines may be selected without re-entering the command, or Enter may be pressed to exit the command.

Prompts

Select centerline polyline to identify:  pick the polyline
Centerline Name:  D:\SAMPLE.CL
Select centerline polyline to identify (Enter to end):  press Enter

Pulldown Menu Location:  Centerline
Keyboard Command:  CL_ID
Prerequisite:  A polyline created from a Design Centerline, Input/Edit Centerline, Polyline to Centerline File, or Centerline File to Polyline.
File Name:  \lsp\surv1.lsp

Station Polyline/Centerline

This command will station a polyline or centerline file at a given interval distance. The options for this command are set in the dialog shown below. After setting the options, click OK on the dialog and then pick the polyline or select the centerline file. All settings can be saved as (.STA) files and loaded for reuse, and for storing multiple stationing schemes. Polyline/Centerline station labels are also dynamic, and so will update when changes are made in the geometry.
**Distance for Stations** is the primary interval for stationing.

**Distance for Intermediate Stations** is the intermediate interval for stationing.

**Beginning Station** is the beginning station of the centerline for stationing.

**Locate Even Stations** labels the stations at the distance interval (i.e. 2+00, 3+00, etc.).

**Locate Odd Stations** labels the non-interval stations at the polyline/centerline end points and PC and PT points.

**Locate User-Entered** prompts you for individual stations to label.

Without the **Increment Station Labels from Beginning Station** option, the program increments the station labels from zero. For example, if the station interval is 100 and the polyline starting station is 145, then the program will label 2+00, 3+00, etc. With this option active, the station labels are incremented from the starting station. In this example, the program would then label 2+45, 3+45, etc.

**Label Deflection Angles** adds this annotation to the stationing. Settings for this are specified in the **Label Deflections Setup**, accessed by the **Deflections Setup** button.
When **Specify Start/End Stations** is checked, only the stations between and including the specified starting and ending stations will be labeled. If locate centerline points and offset points are toggled on, only points within the specified stations will be located.

When **Erase Previous Station Labels** is checked, previous station labels are erased when new ones are generated.

The **PC/Spiral Setup** button accesses the **PC/Spiral Setup** dialog, where settings are controlled for lines and/or symbols and/or labels at the starting and ending (PC and PT) stations of an arc of the centerline as well as for the spiral special stations (TS, SC, CS, ST).

**Draw PC Lines** controls whether lines are drawn from the PC and PT points.

When **Label PC On Centerline** is checked, the station of the PC and PT will be labeled on the centerline as well as the PC and PT lines. When not checked only the PC and PT lines will be labeled.

**Draw PC Symbols** controls whether symbols are placed at these locations. If checked, the desired symbol is selected by picking on the box to the right.
Label PC Radius controls whether this point is labeled.
Max Length controls the maximum length for the PC lines to be drawn described above.

Back in the main Station Polyline/Centerline dialog box:

Draw PI Lines draws a 2 segment polyline in both tangent directions from the PI as a marker for the PI.

When Label PI Stations is checked, the PI station is labeled at the PI point.

When Locate PI Points is checked a point will be created at the PI of a horizontal curve graphically and written to the active coordinate file.

When Label Station Text is checked, this command places station text along the polyline at the angle of the corresponding segment. After toggling this option on, the Label Setup button will become available for selection. Select it to configure the label settings as desired. Select the Marker Setup options to modify the size of the markers for certain types of stations. See definitions following the dialog box.

Also under PC/Spiral Setup is Curve Table Setup which controls whether to draw data tables for the curves and spirals. When this option is on, the program creates a data table with the selected fields for each curve and automatically places each table to the outside of the curve.
**Label Setup**

- **Text Layer** is the user-specified layer for text labels to be drawn on.
- **Text Style** is the user-specified text style for labels.

- **Decimals** determines the number of decimal places of the stationing labels to be drawn for the odd stations and user entered stations only.

- **Text Size Scaler** determines the size of the station labels. This value multiplied by the horizontal scale setting in Drawing Setup results in the size of the label. For example, if the horizontal scale is set to 100 and the text size scaler is set to 0.10, the station labels will be 10 units.
- **Text Offset Scaler** works like text size scaler above controlling the distance the text labels will be offset from the centerline.

- If the **Flip Text For Twist Screen** setting is checked and the drawing has been twisted using the twist screen command, the label text will be flipped to read in the proper direction of the stationing.

- **Label Intermediate Stations**: If the intermediate distance is the same as the station distance then no intermediate station ticks or labels will be drawn. For example, with the above entries and 0+00 for the first station the stations will be labeled with descriptions as follows: 0+00 0+50 1+00 1+50, etc.

- **Station + at Tick Mark** labels the station text along the polyline with the '+' of the station text at the station's location on the polyline. See Marker Set up for marker size manipulation settings.
- **Horizontal Offset** shifts the station label along the centerline.
- **Station Prefix** adds to the front of the station labels.
- **Remove Zeros** removes the specified number of least significant digits from the station label if these digits are all zero.

- **Label Northing/Easting of Starting Point** adds this label information, including prefixes and/or suffixes as specified.

- Use **Label Stations** to specify whether to label the stations perpendicular or parallel to the centerline.
• Specify the **Position** of the station labels, either above or below the centerline. This is only available when labeling stations using the parallel option.

• **Align** determines the alignment of the station label, either left or centerline, centered along the centerline or to the right of the centerline. This option is only available when using the perpendicular option for station labels.

The **Marker Setup** options control the size of markers for different station types as well as the layer the markers will be drawn on. The Half Size Main Marker option draws a perpendicular tick mark on only one side of the centerline for the main station interval like the intermediate station markers. Otherwise a full marker is drawn that goes of both sides of the centerline.

![Marker Setup dialog box](image)

Specify whether to define the **Centerline By** picking a 2D polyline or 3D polyline in the drawing or selecting a centerline (.CL) file.

- Using a **2D Polyline** will result in horizontal distance stationing along the polyline.
- Using a **3D Polyline** will result in the slope distance stationing along the polyline.
- Using a **CL File** will result in horizontal distance stations as with the 2D Polyline option only a prompt for the centerline to use will display.

Use **Station Type** to specify the stationing format to use.

Use **Type of Curves** to specify whether you are labeling a roadway curve (arc definition) or railroad curve (chord definition).

**Locate Centerline Points** will locate points and store them in the current CoorDinate file.

**Locate Radius Points** will locate the radius points of any arc segments.

**Starting Point Number** determines the starting point number for the points to be located.

There are two ways to **Set Elevations** for the centerline points and offset points to be created.
• The **3D Polyline** option gets the elevation of the point from a specified 3D Polyline within the drawing.

• The **Profile** option will determine the elevation of the point based upon the same station in the profile file. You will be prompted for the profile file to read for the elevation reference.

• With the **None** option selected, no elevations will be determined for the points.

When **Include Station in Description** is checked, the station along the centerline will be included in the resulting offset point.

**Description Prefix** is an optional user-specified prefix to be added to the point description.

**Description Suffix** is an optional user-specified suffix to be added to the point description.

When **Label Sta Equations** is checked on any station equation, contained in a centerline (*.cl) file will be labeled. This option is only available when stationing a centerline file (*.cl).

**Locate Offset Points** will create points at the specified left and right offset distances from the centerline. Options for setting the elevations and descriptions of the points are available from the Offset Setup dialog.

• When **Use Slopes** is on, it makes available the Percent Slopes fields for defining the slope from centerline both right and left for determining the elevations of the offset points.

• Enter the desired **Offsets** left and right.

• Enter the desired **Percent Slopes** from centerline to the left and right offset points.

• The **Vertical Offset** is added to the elevation of the offset points.

**Prompts**

**Station Polyline Dialog**
Polyline should have been drawn in direction of increasing stations.
Select polyline that represents centerline: select a polyline
Closeup of Station + at Tick Mark option

Labels with Label PC on Centerline checked on

Labels set to perpendicular and Max Length of PC lines set to 75.0
Pulldown Menu Location: Centerline
Keyboard Command: stapl
Prerequisite: A polyline or CL file

Label Station-Offset

This command will compute and label the station(s), offset(s) and elevation(s) of a selected point or group of points or entities. Additional labels for the name(s) of the reference alignment(s) and description(s) can also be specified and placed to further annotate the point(s) that are selected.

A common usage for using dual alignments and profiles typically involves the alignment and profile of a road coupled with the alignment and profile of a pipe/utility.
1st/2nd Alignment: Specify the criteria for either one or two alignments that will be used for the label(s) that will be placed into the drawing.

Use 2nd Alignment: Enable this toggle if multiple alignments are to be used for the label(s) that will be placed into the drawing.

Name: Supply a label-friendly value for the name of the alignment (e.g. "King Street" or "Water Main"). The value(s) specified get assigned to the Alignment Label Field.

Use Elevation: Enable this toggle if an elevation is to be calculated and available during label placement.

Centerline: Indicate the source (Polyline or Centerline File) for the reference alignment. If the Polyline option is selected, you will be prompted to select the polyline(s) after the OK button is pressed. If CL File option is selected, supply a valid path and filename for the centerline file or navigate to the file using the "File Picker" button shown below. The Beginning Station will be determined from the selected Centerline File.

Beginning Station: Specify the beginning station of the centerline. The polyline should be drawn in the order of increasing stations. This control is not used when you use a centerline (.CL) file to define the centerline as the starting station of the centerline is stored in the .CL file.

Vertical Reference: Indicate the source (3D Polyline, Profile File or Road Network) for the reference elevation. With 3D Polylines, there will be an additional Slope Station available under the Label Fields in addition to the regular horizontal distance station. If the Profile option is selected, supply a valid path and filename for the profile file or navigate to the file using the "File Picker" button shown above. For the Road Network, specify the road network (.rdn) file with the "File Picker". With the Road Network method, the program will find the road design surface elevation for the specified points using all the road network design files including profiles, templates and transitions.

Cross Slope (%): Indicate the slope as a percentage to "travel" from the Vertical Reference. A value of 0 (zero) will not apply any cross slope from the reference elevation. Positive values will decrease the calculated elevation(s) and negative values will increase the calculated elevation(s).
**Vertical Adjustment:** Indicate the desired amount of vertical displacement that should be applied to the calculated elevation. This is useful when deriving elevations for back or face of curb.

**Label Options:** Specify whether to place the information as a label or add the information to the description of an existing point.

**Label Alignment:** Specify whether the labels should be Horizontal on the screen, Vertical on the screen, Parallel to the Centerline, Perpendicular to the Centerline, or user-specified by Picking.

**Text Size Scaler:** Determines the size of the labels. This value multiplied by the horizontal scale setting in *Drawing Setup* results in the size of the label. For example, if the horizontal scale is set to 100 and the text size scaler is set to 0.10, the labels will be 10 units.

**Text Style:** Specify the desired text style for the label.

**Leader Segments:** Specify the desired number of leader segments that should be allowed when constructing the label.

**Use Relative Leader:** Indicate whether successive labels placed into the drawing should re-use the geometry of the initial leader placed with the command.

**Draw At Fixed Position:** After you pick the first label position, the rest of the labels will be placed at this same level. This option applies to the Vertical and Horizontal Label Alignment methods.

**Label Fields:** Use the green arrow buttons to specify the items that are to appear in the labels. As labels are "moved" from Available to Used, a Label Format dialog box particular to the label will appear that will allow for more precise display control. To subsequently edit each item, use the Format Editor button as shown below.

![Label Format Dialog Box](image)

**Note:**

- The Row Number value is specified as the row starting closest to the leader with subsequent rows moving further from the leader as shown in the figure below. Row 2 below the leader has been illustrated with the Draw Box option enabled.
Layers: Specify the layer of each item that comprises the label.

Max Offset to Calc: Specify the maximum offset to calculate.

Station Type: Specify the stationing format to use.

Flip Text for Twist Screen: When this option is enabled, the label(s) will be flipped as necessary to adjust for the use of Twist Screen.

Type of Curve: Specify whether the centerline is for a roadway or railroad. Stationing for Roadway Curves is measured along the curve length itself whereas stationing for Railroad Curves is measured along chord segments.

Save: Allows the current settings to be saved to a Station-Offset Settings (*.sos) file.

Load: Allows settings from a previously saved Station-Offset Settings (*.sos) file to be recalled for use.

Prompts

Polyline should have been drawn in direction of increasing stations.
Select Polyline Centerline (Alignment-1): Pick the polyline centerline This prompt will not appear if the Centerline File option was specified.
Select 3D Polyline Profile (Alignment-2): Pick the polyline profile This prompt will not appear if the Profile File option was specified.
Pick point or point numbers (SS for Selection Set, G for Group, Enter to End): Pick a point
Pick point to label: Pick a leader vertex point
Pick label alignment: Pick angle for the label This prompt will only appear if the Pick option was specified.
Pick point or point numbers (SS for Selection Set, G for Group, Enter to End): Press Enter

Real-time display of Station and Offset as you move the cursor.
A sample label with a 2-segment leader.

**Pulldown Menu Location:** Centerline
**Keyboard Command:** offsta
**Prerequisite:** A polyline or centerline file.

### Offset Point Entry

This command creates points along a centerline at specified stations and left and right offsets. The centerline can be defined by a polyline, centerline (.CL) file or two points.
The **Store Points to Coordinate File** option will store any points the current coordinate (.CRD) file. This includes centerline points and offset points.

When **Locate Points on Centerline** is checked, the program will locate points along the centerline, otherwise just the offset points will be created.

When **Label Stations & Offsets** is checked, the program will label the station-offset as the point description attribute.

When **Locate Intersection Points At Line Corners** is checked, the program will locate points along the centerline at the intersection points of selected lines with that of the centerline. This routine is to be used along with Locate Points on Centerline. This is a good option to use when the exact station of where the offset points are to be created is not known but is referenced by an existing line on the drawing.

The **Include Station-Offset In Description** option will add the station and offset of the point into the point description.

**Beginning Station:** Enter the Beginning Station of the Centerline.

Use **Centerline from** to specify whether to define the centerline by picking a polyline in the drawing, selecting a centerline (.CL) file, or using 2 points.

Use **Reference Elevation** to assign elevations to the points created when locating points on the centerline of offset points. When using a 3D Polyline for the elevation reference, points will be created at the station entered and the offsets specified with the elevation of the same station along the 3D polyline. The Profile option will do the same as the 3D Polyline option only it will use a profile file for the elevation reference. You will be prompted for the profile to use for the elevation reference. None simply creates 2d point data on elevation zero. The Reference Elevation option is good for creating points along the centerline for final grade elevation points. **Profile to 3D polyline** can be used to transfer the profile data to the polyline before calculating the final grade points.

**Cross Slope %:** This option is used to alter the elevations of the new points by applying either a Cross Slope calculation or a Delta Z variable.

The Manual Entry option in **Input Station-Offset from** will prompt for the station and offset distances. The Read File option will read the stations and offsets from a text file. The text file format is comma delimited with point number, station, offset and elevation. The station should be just the station number without the '+' (i.e. 250 instead of 2+50). The elevation is optional. The Read File option is a quick routine to convert a station-offset data file into coordinates.

When **Offset Prompt** is set to Both Left-Right, the program will prompt for left and right offsets. If you respond to an offset prompt with zero (0), no offset point is created. The Single Offset option will prompt for one offset per station. Enter a right offset with a positive value and a left offset as a negative value.

Use **Station Type** to specify the stationing format to use.

Use **Type of Curve** to specify whether the curves are for a roadway or railroad.

**Prompts**
Offset Point Settings Dialog
Polyline should have been drawn in direction of increasing stations.
Select Polyline near endpoint which defines first station.
[nea on] Select Polyline to Station-Measure: select a polyline
(5309.0 4845.0) Station: 0.00
(5526.0 4917.0) Station: 228.63
Distance from beginning station along centerline (Enter to end): 110
Starting Segment Station: 0.0 Ending Segment Station: 228.633
Working Line segment ...(5413.4 4879.6 0.0)
Left offset distance < 10.0 >: 15
Right offset distance < 15.0 >: 20
Distance from beginning station along centerline (Enter to end): press Enter

Keyboard Command: offpts
Prerequisite: A centerline (.CL) file, polyline, or two points
File Name: \lsp\offpnts.lsp

Calculate Offsets
This command calculates the station and offsets of point coordinates relative to a centerline. The points to calculate can be stored in a coordinate (.CRD) file or picked on the screen. As the crosshairs are moved, the station and offset of the current position are displayed in real-time in a small window (see example).
**Beginning Station:** Specify the beginning station of the centerline. The polyline should be drawn in the order of increasing stations. Not available when you use a centerline (.CL) file to define the centerline.

**Maximum Offset to Calc:** This is the maximum distance from the Centerline for which offsets are calculated.

**Report Offsets Ahead/Behind Centerline:** When checked, this option shows offsets for points or picked points located before the beginning station and after the ending station of the centerline.

**Label Station and Offsets:** When checked, the station offsets will be labeled in the drawing.

**Sort Report by Stations:** When checked, this option will report the station-offsets in station order no matter what order the points were calculated.

**Report Point Coordinates:** When checked, this option will include the point northing and easting in the report.

**Report Point Notes:** When checked point notes will be included on the calculate offset report.

**Create Point Notes:** When checked, the station and offset of the offset point will be created as notes and written to a note file (*.not). This note file will have the same name as the crd file.

**Use Report Formatter:** When checked, the output of this command is directed to the Report Formatter which allows you to customize the layout of the report fields and can be used to output the data to Microsoft® Excel or Microsoft® Access. You must check this option on in order to use the Report Grade Elevation From option.

**Round Stations:** When checked, this option will round the stations for the selected points on the report to the Rounding Interval specified. For example if an offset point is located at station 1+01, and the rounding interval is set to 10, then the report will show the offset point at station 1+00.

**Store Station Text to CRD File:** When checked, the station offset text is appended to point numbers that are selected.

**Report Grade Elevation From:** When checked, this option will calculate an elevation for each point from a 3D polyline, grid file (.grd) or triangulation (.flt) file. To Use this option, the Report Formatter must be toggled on. The grade elevation is reported and compared with the point elevation to report the cut/fill. For the 3D polyline option, the grade elevation is calculated by finding the elevation at the point on the 3D polyline that is the nearest perpendicular position from the offset point. The 3D polyline that is used for elevations does not need to be the same polyline that is used as the centerline for the station-offset calculations.

**Define Centerline by:** Specify whether to define the centerline by picking a polyline in the drawing, selecting a centerline (.CL) file, or using 2 points. The polyline mode can be either 2D or 3D for horizontal or slope distance stationing.

**Station Type:** Specify the stationing format to use.

**Decimals:** Specify the display precision for the stations and offsets.

**Type of Curve:** Specify whether the curves are for a roadway or railroad.

**Prompts**
Calculate Offset Settings Dialog
Polyline should have been drawn in direction of increasing stations.
Select Polyline near endpoint which defines first station.
[nea on] Select Polyline Centerline: select polyline centerline

(5309.0 4845.0) Station: 0.00
(5526.0 4917.0) Station: 228.63
PtNo.  North(y) East(x) Elev(z) Description
140 4889.13 5410.25 0.00 1+10.00L10.00
Station on Line> 1+10.00 Offset> 10.00 Left
PtNo.  North(y) East(x) Elev(z) Description
141 4870.15 5416.55 0.00 1+10.00R10.00
Station on Line> 1+10.00 Offset> 10.00 Right
+ before station denotes point is ahead of line segment, - denotes beyond.

Pick point or point numbers (Enter to End): 22-28

Pick point or point numbers (Enter to End): press Enter

Keyboard Command: calcoff
Prerequisite: A centerline (.CL) file, polyline or two points
File Name: \lsp\pstaoff.lsp

Centerline Conversions

There are twelve Import options available in Carlson Civil to convert other applications' centerline files to Carlson Civil centerline files (.CL), and seven Export options to convert Carlson Civil centerline files (.CL) to other applications' formats. Each Import option prompts for the file to convert and the name of the new .CL file to create, each Export option prompts for .CL file to convert and a file name for the new file. The import formats include Geodimeter, GeoPak, Leica, MOSS, SDMS, Softdesk, Sokkia, ISPOL, CLIP, TDS RD5 and Terramodel. The export formats include Leica, SMI, Softdesk, Sokkia, Topcon RD3, TDS RD5 and TDS PL5.

Pulldown Menu Location: Centerline > Centerline Conversion

Keyboard Commands: geod2cl, geopak2cl, geopak2rd, wildcl2, moss2cl, sdms2cl, dcacl2, sdr2cl, ali_to_cl, pla_to_cl, importrd5, tm2cl, wildcl1, smicl1, dcacl1, cl2sdr, cl_to_rd3, export_rd5, tdsc1
This chapter provides information on using the commands from the Area/Layout menu to calculate and label areas, and also to set and define lots. Commands for designing and drawing more complex configurations, such as cul-de-sacs and intersections, are available here as well.
Area Defaults

This command allows you to specify default settings for area labeling. The Area Defaults dialog is divided into 3 tabs. The first is the Label Fields and Settings tab. The top portion of the Label Fields and Settings tab contains two listboxes which are used to control which of the possible ten area fields will be used for area labeling. You use the Add and Remove buttons to control which fields will be included in area labels. You can also add to the Used Fields list by double-clicking on items in the Available Fields list. The area label will include the values in the order as specified in the Used Fields listbox. To change the order you use the Move Up and Move Down buttons.

Field Settings Dialog: To control the appearance of the fields in the drawing, use the Edit button to edit the highlighted item in the Used Fields list, or double click on a field in the same list. This will call up the Field Settings Dialog.

User Defined: The Field "User Defined" can be added to place a custom fixed label in all areas. To control the value and appearance of the custom label in the drawing, use the Edit button to edit the "User Defined" item in...
the Used Fields list, or double click on a field in the same list. This will call up the Field Settings Dialog. In this case the "Value" setting becomes the custom label.

**Scaled labels:** The "Scaled Sq. Feet", "Scaled Sq. Meters", "Scaled Acres" and "Scaled Perimeter" fields can be used to include area labels that are scaled based on Drawing Setup "Report Scale Factor".

![Field Settings Dialog](image)

**Text Style:** This allows you to set a text style for the area labels. You can enter the name manually or use the Select Style button to call up a dialog which presents a list of known text styles.

**Text Size:** This value is multiplied by the horizontal scale to obtain the actual text size.

**Text Layer:** This allows you to assign a layer for the area text. You can enter the name manually or use the Select Layer button to call up a dialog which presents a list of known layers.

**Text Color:** This allows you to assign a color for the area text. Use the Select Color button to call up the standard color picker dialog. To use the default for the Text Layer, select ByLayer.

**Prefix and Suffix:** Although most area labeling uses the suffix, as in 1.25 Acres or 3.515 Hectares. But for those who prefer a prefix, as in Ac: 1.25, this routine can create that area labeling style automatically (see below for example of results of using a prefix with square feet and acres).

**Justification:** Use this to control whether the label field is left, centered or right justified.

**+/−:** This allows you to display + or - in the Prefix or Suffix of the area labels, or choose None.

**Precision:** Choose precision level for the currently selected field.

Below the Available and Used Fields lists the following items for further controlling area label generation:

**Use Commas in Labels:** This allows you to use commas in the area labels.

**Use MText:** Check this box to turn on the use of MText for area labels. If this is checked all area labels will be grouped into as few MText entities as possible. Area labels with different text styles, justification or layers will not be combined into the same MText entity.

**Erase Previous Labels:** When checked, previous area labels for the area being relabelled will be erased.

**Label Placement:** When auto placement of area labels is used, the labels can be placed either at the centroid of area or at the rear side. This is accomplished by selecting either the Center or Rear Side radio button, respectively. When Center is selected the user can choose to have the labels oriented according to the side lines of the area by checking the Align By Sides checkbox. When either Align By Sides or Rear Side is selected, the checkbox Flip Text for Twist Screen can be selected to have the label rotated 180 degrees to present it in the best reading orientation relative to the current Twist Screen rotation setting.

**Draw Symbol Around Lot Description:** When the Lot Description field is included in the Used Fields list, the user can check this checkbox to have a symbol drawn around the Lot Description field. When this box is checked, you specify the symbol name in the Symbol Name field or click on the current symbol (drawn to the right) to graphically choose the desired symbol. You specify the layer by entering the name in the Layer box or by clicking on the Select button to choose from a dialog that presents all known layers.
Symbol Buffer Offset: By default, the symbol will be automatically scaled according to the text length and size of the Lot Description value for the area. For additional control of symbol scaling, the user can enter a number in text size units in the Symbol Buffer Offset box. This value will be added to the automatically generated default scaling value.

Avoid Label Overlap: If this box is checked the area labels will be checked for overlaps after they are generated. Please see the Overlap Manager documentation for more information.

Overlap Settings: Click this button to go to the Avoid Label Overlaps dialog where you can review or modify the Overlap Manager settings. Please see the Overlap Manager documentation for more information.

Table Process Settings Tab:
Use Area Tables: Use this control to determine whether area labels are sent to a table or not. Options are "Never", "Always" or "By Scaler".

To Table Area: When the user has selected "By Scaler" in the "Use Area Tables" list this item is enabled. When "By Scaler" is selected and the area is less than this minimum, the area label is sent to a table.

Area Reference Numbering: There are three different methods for setting the reference number: Next Available will automatically use the lowest available number. Specified With Prompt will prompt you for a number for each area. Specified with Auto Numbering will automatically use the lowest available number starting with the specified number.

Auto Place Table References: When checked, will automatically place the area reference label according to the settings for the area labels as specified in the Label Field and Settings tab (see above). Otherwise you will be prompted to pick each label location manually.
**Area Commands Tab:**

**Max gap to join:** You use this option during *Area by Lines & Arcs* command. When connecting lines and arcs that define the perimeter, the program will join endpoints if the distance between the two points is less than the specified gap. Otherwise the program will report an error and will not report an area.

**Prompt whether to retain polylines created by Area by Interior Point:** When checked the user will be asked whether to retain the polylines created by the "Area by Interior Point" command.

**Polyline Layer:** Will be enabled when "Prompt whether to retain polylines created by Area by Interior Point" is checked to allow the user to select the layer that any such created polylines will be placed in.

**Load/Save:** These buttons save and recall all the Area Default settings to a .ARS settings file.

**Tip:** Keep in mind that changes in Area Defaults, if changed from the Area/Layout pulldown menu, only apply to that work session. If changed within the Configure command, the changes apply to all new work sessions as well.
The results of using a prefix with square feet and acres

**Pulldown Menu Location:** Area/Layout

**Keyboard Command:** defarea

**Prerequisite:** None

## Inverse with Area

This command generates a report of the angle and horizontal distance between a series of points, and calculates the area of the closed figure defined by the points. Curve data can also be entered and reported. The points can be either picked on the screen, or entered by point number. You can also enter a range of point numbers (i.e. 1-9). The closure is reported using the total distance inversed, and the difference between the starting and ending points, as the closure error.

At the first command prompt, you can enter O for Options to bring up the command options. The Different Radius Tolerance checks that the distance between the PC and radius point and the PT and radius point match for curves. There is an option to report the distances in both feet and meters. The Use Report Formatter chooses between the standard report or customizing the report. You can also set the decimal precisions for the report and whether to report stations for the distances along the perimeter.
The area can be labeled in the drawing using the settings from the *Area Defaults* command. If you don't want to label the area, press Enter at the pick label point prompt. This command creates a polyline of the figure which can be erased or kept in the drawing.

**Prompts**

*Options/<Pick Starting point or point number>*: *pick a point*

*Pick point or point numbers (R-RADIUSPt,U-Undo,Enter to end)*: *pick a point*

*Pick point or point numbers (R-RADIUSPt,U-Undo,Enter to end)*: *R* for radius

*Radius point number or pick point*: *pick a point*

*Curve direction [Left/<Right>]?:* press Enter

*Pick End of Arc or point number (U-Undo,Enter to end)*: *pick a point*

*Pick point or point numbers (R-RADIUSPt,U-Undo,Enter to end)*: *pick a point*

*Point number (R-RADIUSPt,U-Undo,Enter to end)*: *pick a point*

*Point number (R-RADIUSPt,U-Undo,Enter to end)*: *pick a point*

*Point number (R-RADIUSPt,U-Undo,Enter to end)*: *press Enter*

*SQ. FEET: 27247.4 SQ. YARDS: 3027.5 SQ. MILES: 0.0 ACRES: 0.63 PERIMETER: 668.35*  

*Pick area label centering point*: *pick a point*

*Erase Polyline Yes/No <Yes>:* *press Enter* The command plots a polyline that represents the figure you defined if you want to keep the polyline respond with No.

---

**Inverse with Area**

CRD File: \data\newplat.crd

PNTNO BEARING DISTANCE NORTHING EASTING STATION DESC

---

*Chapter 14. Area/Layout Menu*
Area by Lines & Arcs

This command allows you to calculate the area of a perimeter or lot defined by lines, arcs, or polylines. Default settings for this command are set in `Area Defaults`. One of these settings is Max gap to join. If there is a gap greater than this value, the area is not reported, and the program will show where the gap is with a temporary X symbol. The area data shows up on the text screen. You can then choose to plot the area information to the drawing, or, by hitting `Enter`, just read it from the text screen.

Prompts

**Select lines & arcs or polylines of perimeter for area calculation.**

**Select Objects:** select lines and arcs or polylines

Lines and arcs are then joined together and the area calculated.

**Pick area label centering point (Enter for none):** pick a point

The area is then plotted at the point selected.
Area by Interior Point

This command calculates and labels the area of the perimeter surrounding a picked interior point. The Boundary Polyline command is used to find the perimeter. Generally, this command will only work on closed or overlapping objects. Use Area by Lines & Arcs for other applications. The settings for the area label and for whether to prompt to create a closed polyline for the area are under the Area Defaults command.

Prompts

Pick point inside area perimeter: pick a point
Pick area label centering point (Enter for none): pick a point
The area is then plotted at the point selected.

Pulldown Menu Location: Area/Layout
Keyboard Command: ptarea
Prerequisite: Set Area Defaults

Area by Closed Polylines

This command will calculate and report the area of single area and multiple area closed polylines. In the case of multiple areas, the user can choose to have the areas totaled (Total Multiple Areas) into a single result or to generate data for each area separately. Area by Closed Polyline will also automatically find special Carlson attributes attached to the polyline, in addition to capturing the area itself. These attributes will appear in the report, which can be the standard report or which can be presented in the Report Formatter, which itself links to Excel and Access. For example, property names and owner names, as applied to a polyline using the Mine modules, will report out automatically using Area by Closed Polyline. The command "Draw Lots from File..." will apply "extended entity data" to the lot polylines, which includes the lot name, and this will also report out when using Area by Closed Polyline. In addition, lot names, or any interior text whatsoever, can be captured and included in the report. The plot of the area on-screen can be canceled if only the report is desired.
Prompts

Select Area Polyline: select the area polyline
SQ. FEET: 64862.9 SQ. YARDS: 7207.0 SQ. MILES: 0.0
ACRES: 1.5 PERIMETER: 1018.7
Pick area label centering point (Enter for none): pick a location

When auto-placing labels at the rear of lots or when aligning labels by the sides of the lot the user will also be prompted to pick one or more centerlines (Select the Centerline Polylines). The routine will find the closest centerline and use this to determine the location of the front and back corners of the area.

When additional interior text is selected, the standard report will include that text:

Polyline Area 11/17/2004 12:49
Polyline Area: 43560.0 sq ft, 1.00 acres
Polyline Perimeter: 838.35 ft
Text: 16 Sf: 43560.0; Ac: 1.00

In this case, the "16" refers to Lot 16, and appears in the report because the lot number and existing area labeling were selected along with the polyline for the lot.
**Pulldown Menu Location:** Area/Layout  
**Keyboard Command:** plarea  
**Prerequisite:** Set Area Label Defaults  
**File Name:** `\lsp\ptarea.lsp`

### Digitize Areas

This command allows for digitizing areas. This routine includes an option for drawing perimeter polylines.

![Digitize Areas window](image)

**Pulldown Menu Location:** Area/Layout  
**Keyboard Command:** dig_area  
**Prerequisite:** A digitizer  
**File Name:** `\lsp\dig_area.lsp`
Label Last Area

This command will label the last area calculated with one of the Area commands in the manner defined in the Area Defaults dialog. The command prompts for a point where the label will be centered.

Prompts

SQ. FEET: 50265.3  SQ. YARDS: 5585.0  SQ. MILES: 0.0
ACRES: 1.2  PERIMETER: 889.4
Lot Description <2>: 1

Pick area label centering point (Enter for none): pick a point

New Area Table

This command draws the column header labels for the Area Table commands. When prompted for the starting point, the user may enter a coordinate or pick a point on the screen. This table becomes the active area table. Any new area table entries will be added to this table until another table is created or the active table is changed with the atabset command (menu item Area/Layout> Area Tables> Set Active Table).

| Area | Perimeter | Sq. Feet | Acres | Lot Description |

Prompts

Starting point of area table: pick point
**Set Active Area Table**

This command allows the user to change the active area table. The table selected becomes the active area table. Any new area table entries will be added to this table until another table is created or the active table is changed with another invocation of this command.

**Prompts**

**Select active Table:** *pick area table*

**Edit Area Table Properties**

This command allows the user to edit the properties of an area table.

**Prompts**

**Select an area table to modify:** *pick an area table*

After picking an area table the Area Defaults dialog will be displayed. Here you can change the settings of the selected table. The changes will be reflected once the user selects the OK button.
The Table Fields tab contains the Available Fields and Used Fields listboxes which are used to control which of the possible ten area fields will be used in the area table. You use the Add and Remove buttons to control which fields will be included in the table. You can also add to the Used Fields list by double-clicking on items in the Available Fields list. The area label will include the values in the order as specified in the Used Fields listbox. To change the order you use the Move Up and Move Down buttons.

**Field Settings Dialog:** To control the appearance of the fields in the table, use the Edit button to edit the highlighted item in the Used Fields list, or double click on a field in the same list. This will call up the Field Settings Dialog.

**Column Title:** This will be the tile name used for the field's column in the area table.
**Text Style:** This allows you to set a text style for the area labels. You can enter the name manually or use the Select Style button to call up a dialog which presents a list of known text styles.
**Text Size:** This value is multiplied by the horizontal scale to obtain the actual text size.
**Text Layer:** This allows you to assign a layer for the area text. You can enter the name manually or use the Select Layer button to call up a dialog which presents a list of known layers.
**Text Color:** This allows you to assign a color for the area text. Use the Select Color button to call up the standard color picker dialog. To use the default for the Text Layer, select ByLayer.

**Prefix and Suffix:** Although most area labeling uses the suffix, as in 1.25 Acres or 3.515 Hectares. But for those who prefer a prefix, as in Ac: 1.25, this routine can create that area labeling style automatically.

**Justification:** Use this to control whether the label field is left, centered or right justified.

**+/−:** This allows you to display + or - in the Prefix or Suffix of the area labels, or choose None.

**Precision:** Choose precision level for the currently selected field.

**Column Width/Auto:** The default behavior is that the column width is automatically set for best fit. The user can override this value by unchecking the Auto checkbox and setting the column width in text size units.

The **Table Settings** tab brings up the Table Settings panel shown below.

![Table Settings Panel](image)

**Total Area on Last Row:** Select this to have a total row placed at the bottom of the table which will contain the sum of all relevant table fields.

**Label Layer:** Use this to control the layer that the area table reference will be placed in. Use the Select button to pick from a list of all known layers.

**Label Color:** Use this to control the color of the area table reference. Use the Select button to pick from a color picker dialog. Select ByLayer to use the default color of the label layer.

**Area Label Prefix:** Use this to control the prefix of the area table references. Add a space after the prefix to have the prefix and the reference number separated by a space if desired.

**Label Text Style:** Use this to set the text style of the area table reference. Use the Select button to pick from a list of all known text styles.

**Table Layer:** This allows the user to set the layer that the table will be placed in. Use the Select button to pick from a list of all known layers.

**Table Color:** This allows the user to set the color of the grid lines of the table. Use the Select button to pick from a color picker dialog. Select ByLayer to use the default color of the table layer.
Area Table Title: To add a title row as the first row of the area table, enter a table title here.
Title Text Color: This allow the user to set the color of the table title. Use the Select button to pick from a color picker dialog. Select ByLayer to use the default color of the table layer.
Title Text Style: Use this to set the text style of the table title. Use the Select button to pick from a list of all known text styles.
Title Text Size: Use this to control the size of the table title text.
Background Colors: The area table is broken into 5 zones in respect to background color. Each zone can have its own unique background color. The zones are Title, Header, Contents1, Contents2 and Total. To set a background color for each zone, first the respective "Use Table...Background Color" box must be checked. This enables the Select button, which is used to pick the respective background color from a color picker dialog. For the Contents zone all contents rows can either have the same background color, or by setting up an "Alternating Background Color", rows will have alternating colors.
Load/Save: These buttons save and recall all the Area Default settings to a .ARS settings file.
Tip: Keep in mind that changes made here only apply to the selected table. If properties are changed within the Configure command, the changes apply to all new work sessions as well.

Pulldown Menu Location: Area/Layout> Area Tables> Edit Properties
Keyboard Command: atabedit
Prerequisite: An area table

Remove Area Table Rows
This command allows the user to remove rows from an area table. The routine will remove both the table row and the table reference label from the drawing.

Prompts
Select a table row to delete: pick area table row
Consolidate table [<Yes>/No]? If consolidation is chosen, row numbers will be renumbered to close up the gap created by this deletion. Consolidation will also update all relevant area table references in the drawing. If the user chooses not to consolidate the table at this time, the atabfix command (menu item Area/Layout> Area Tables> Consolidate Table) can be used at any time to perform consolidation.

<table>
<thead>
<tr>
<th>Area</th>
<th>Perimeter</th>
<th>Sq. Feet</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1</td>
<td>470.70</td>
<td>9157.63</td>
</tr>
<tr>
<td>A2</td>
<td>629.20</td>
<td>15572.47</td>
</tr>
<tr>
<td>A3</td>
<td>542.18</td>
<td>16810.50</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td>41540.60</td>
</tr>
</tbody>
</table>

The drawing above shows the table before row removal. In the drawing below, row 2 has been deleted without table consolidation.
The drawing below shows the results of deleting the same row 2, only this time the user has chosen to perform table consolidation.

<table>
<thead>
<tr>
<th>Area</th>
<th>Perimeter</th>
<th>Sq. Feet</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1</td>
<td>470.70</td>
<td>9157.63</td>
</tr>
<tr>
<td>A3</td>
<td>542.18</td>
<td>16810.50</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td>25968.13</td>
</tr>
</tbody>
</table>

The drawing below shows the results of consolidating this table.

<table>
<thead>
<tr>
<th>Area</th>
<th>Perimeter</th>
<th>Sq. Feet</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1</td>
<td>470.70</td>
<td>9157.63</td>
</tr>
<tr>
<td>A2</td>
<td>542.18</td>
<td>16810.50</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td>25968.13</td>
</tr>
</tbody>
</table>

**Pulldown Menu Location:** Area/Layout> Area Tables> Remove Row

**Keyboard Command:** atabel

**Prerequisite:** None

**Consolidate Area Table**

This command allows the user to renumber area tables to eliminate numbering gaps left as the result of row deletions or other means.

**Prompts**

**Select a table to consolidate::** *pick area table*

Row numbers will be renumbered to close up the gaps in the selected area table. Consolidation will also update all relevant area table references in the drawing.

The drawing above shows the table before row removal. The drawing below shows the results of consolidating this table.
### Tag Area Descriptions

This command is used to assign a description to a closed polyline. The description is stored with the polyline in the drawing. This description is used for reports in routines like Area By Closed Polylines.

**Prompts**

Select polyline for area description: _pick a polyline_
Area description <AREA1>: _West Pond_

### Identify Area Descriptions

This command reports area descriptions for the selected polylines. There are two methods. The Pick method reports the area description for one selected polyline at a time. The Search method scans the whole drawing and highlights polylines with area descriptions.

**Prompts**

Pick polylines to check or search drawing [Pick/Search]: _press Enter_
Select area description polyline: _pick a polyline_
Description: _West Pond_
Select area description polyline (Enter to end): _press Enter_

---

<table>
<thead>
<tr>
<th>Area</th>
<th>Perimeter</th>
<th>Sq. Feet</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1</td>
<td>470.70</td>
<td>9157.63</td>
</tr>
<tr>
<td>A2</td>
<td>542.18</td>
<td>16810.50</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td>25968.13</td>
</tr>
</tbody>
</table>

**Pulldown Menu Location:** Area/Layout > Area Tables > Consolidate Table  
**Keyboard Command:** atabfix  
**Prerequisite:** None

**Pulldown Menu Location:** Area/Layout > Area Descriptions  
**Keyboard Command:** tag_area_desc  
**Prerequisite:** A closed polyline.

---

Chapter 14. Area/Layout Menu
Untag Area Descriptions

This command removes an area description that has been assigned to a polyline.

Prompts

Select polylines to remove area description from.
Select entities: pick area polylines
Cleared 10 area descriptions.

Pulldown Menu Location: Area/Layout > Area Descriptions
Keyboard Command: untag_area_desc
Prerequisite: A polyline with a tagged description.

Hinged Area

This command can be used to determine the dimensions of a figure when the area is fixed and three or more sides are known. The figure can be defined by a closed polyline or by picking the known points and curves. The command then prompts for the area to be solved for (in square units and acres).

Prompts

Define area by points or closed polyline [Points/<Linework>]? press Enter
Select polyline segment to adjust: select a polyline segment
Select hinge point [endp]: Move the cursor around to find a hinge point.
Keep existing polyline [Yes/<No>]? N
Area: 47104.31 S.F, 1.0814 Acres
Remainder/Acres/<Enter target area (s.f.)>: 48000

Polyline method

Pulldown Menu Location: Area/Layout
Keyboard Command: harea
Prerequisite: A closed polyline or at least one known side. Two direction lines should be drawn.
File Names: \lsp\harea.lsp, \lsp\cogoutil.arx
Sliding Side Area

This command adjusts one side of a polyline to meet a specified area. The existing area can be defined by a closed polyline or by picking each point in the perimeter. The desired area can be entered in either square feet or acres. The area to adjust must be represented by a closed polyline. The program moves the selected segment of the polyline in or out. The original direction of the segment is maintained.

Prompts

Define area by points or closed polyline [Points/<Linework>]? press Enter
Select polyline segment to adjust: pick a point on a closed polyline
Keep existing polyline [Yes/<No>]? press Enter
Area: 176044.14 S.F, 4.0414 Acres
Remainder/Acres/<Enter target area (s.f.)>: 17800

Linework Polyline method:
Original perimeter polyline on left, adjusted perimeter on right

Points method

Pulldown Menu Location: Area/Layout
Keyboard Command: ssarea
Prerequisite: A closed perimeter polyline
File Name: \lsp\sarea.lsp
Area Radial from Curve

This command swings a line radial from a curve to reach a predetermined area. The existing area can be defined by polylines or by picking each point on the perimeter. For the point method, the curve to radiate from should be the last entity selected when defining the figure. For the polyline method, front and back polylines are used. The computed line goes perpendicular from the front polyline and intersects the back polyline. This line is moved to find the target area. Both ends of the front and back polylines are connected to close the area. The options for the polyline method are set in the dialog shown.

Prompts

Define area by points or closed polyline [Points/<Linework>]? press Enter
Area Radial from Curve dialog Make choices and click OK.
Select curve to radiate from: pick the curve
Select back polyline: pick the back polyline
Lot Area: 9000.00 S.F., 0.2066 Acres

![Area Radial from Curve dialog](image)

Point Method
Polyline Method

Pulldown Menu Location: Area/Layout
Keyboard Command: arearc
Prerequisite: An existing area defined by points or polylines
File Names: \lsp\sareac.lsp, \lsp\lotlay2.lsp, \lsp\cogoutil.arx

Bearing Area Cutoff

This feature allows you to cut a predetermined area from a closed figure using a cut-off line having a specified bearing. The boundary intersected by the cut-off bearing line can be either a straight line or arc.

Enter area in ACRES [Sq. Feet/Done] <0.000000>: Enter the number of acres contained within the cut-off area.

To change from acres to square feet, type S and <Enter>.
Note: if units are set to meters, the prompt will be:
Enter area in HECTORS [Square meters/Done].

Enter bearing of cutoff line <100.000000>: Enter the bearing of the cut-off line through the property using Qdd.mmsss format.
where:
Q = quadrant (1 = NE, 2 = SE, 3 = SW, 4 = NW)
da = degrees
mm = minutes
sss = seconds (The third s indicates that, if desired, you can optionally specify seconds to the nearest 0.1 second)

Note: Trailing zeros need not be entered.
Place area to right or left of bearing line [Right/Left] <R>:?
"Looking" in the direction of the cut-off bearing allows you to determine which side is left or right. Type R and <Enter> or just <Enter> for right. Type L and <Enter> for left.

**Method of defining the overall area to be divided [C&G Point-group/Manual-entry] <M>:**
Type "P" and Enter if you wish to use a point group to specify the overall area or type "M" and Enter (or just press Enter) to specify the overall area interactively.

**Defining the overall area using a C&G Point Group:**
If you have a C&G Point Group that defines the area to be divided and you choose to use the point group option, you will then be asked to use a file dialog to browse to the point group file and select it.

**Defining the overall area manually:**
If you choose to type or pick the points defining the overall area individually, you will see the prompt:

**Enter point ID or pick graphically [cLockwise/ccW/Polyline]:** Specify a point ID or begin a curve by typing L or W. Type P and enter to pick a polyline.
**Note:** if you choose to pick a polyline, it must be a closed polyline and all its vertices must have coordinates matching points found in the coordinate file.

When specifying individual points, move around the parcel and pick or type in the points, in order, to define the overall area involved.
After all points have been entered, press Enter to end point input.

**Calculate the Cut-off Line**
No matter which method you use to specify the property being divided, once the overall tract is specified, the cut-off line is calculated and the points at which the cut-off line intersects the tract boundaries are saved.

The **Saving Point** dialog (below) will be shown for each intersection point.

Click the **OK** button to save the intersection point.

Depending on your settings for **Auto Line Plot** and **Auto Point Plot** on the **Graphics** tab of the **C&G Options** dialog box, you may see both the points and the cut-off line drawn on the screen.

This process can be repeated as many times as is necessary to further divide the overall area or to divide another area.
Press <Esc> or "D" at the **Enter area...** prompt to end the command.

**Prompts**
Enter area in ACRES [Sq. Feet/Done] <0.000000>:
Enter the number of acres contained within the cutoff area or type "S" and Enter to use square feet or "D" and Enter when done.

Enter bearing of cutoff line <100.000000>: Enter the bearing of the cut-off line through the property.

Place area to right or left of bearing line [Right/Left] <R>:
Type "R" and Enter or just Enter for right of line. Type "L" and Enter for left. The direction of the cut-off bearing determines which side is left or right.

Method of defining the overall area to be divided [C&G Point-group/Manual-entry] <M>:
Type "P" and Enter if you wish to use a point group to specify the overall area or type "M" and Enter (or just press Enter) to specify the overall area interactively.

for Manual entry:
Enter point ID or pick graphically [cLockwise/ccW/Polyline]: Specify the point ID or begin a curve by typing L or W. Type P and enter to pick a polyline.
Pulldown Menu Location: Area/Layout
Keyboard Command: baco
Prerequisite: Coordinate file.

Lot Layout

This command draws lots based on a front and back polyline. Starting from the front polyline, the program calculates two lot side lines perpendicular from the front polyline that intersect the back polyline and create the specified lot size. Lots are created along the front polyline in the order that the front polyline is drawn. If the front polyline needs to be reversed, use the Reverse Polyline command found on the Edit menu. The direction of the back polyline does not matter. The lots can be drawn as closed polylines or just the lot sides can be drawn. There is also an option to automatically create all the possible lots at the specified area between the front and back polylines or to prompt for each 0.4 acre lot.

In prompt mode, the program reports the remaining area between the front and back polylines and then asks for the lot size. The lot size can be specified either by area or frontage along the front polyline.

The lots are sized to meet the specified area and also meet the minimum frontage and backlot distances. The program starts by checking the lot area at the minimum distances. If this area is greater than the target, then the lot is drawn at the minimum distance and the resulting lot area will be greater than the target area. Otherwise the program will increase the frontage until the lot reaches the exact target area. The Use Frontage Setback Polyline option allows you to use another polyline besides the actual frontage polyline for the minimum frontage indicator. Typically, this Frontage Setback Polyline would be offset a set amount from the actual frontage polyline.
Prompts

Lot Layout dialog
Select front polyline: *pick a polyline*
Select back polyline: *pick a polyline*
With prompt for each lot active:
Area remaining: 160326.88 S.F, 3.6806 Acres
Quit/Frontage/Enter lot area (Acres) <1.2269>: 1
Area remaining: 116766.88 S.F, 2.6806 Acres
Quit/Frontage/Enter lot area (Acres) <1.0000>: F
Enter Frontage <50.00>: 75
Lot Area: 37807.50 S.F, 0.8679 Acres
Area remaining: 78959.38 S.F, 1.8127 Acres
Quit/Area/Enter frontage <50.00>: A
Quit/Frontage/Enter lot area (Acres) <1.0000>: *press Enter*
Area remaining: 35399.38 S.F, 0.8127 Acres
Quit/Frontage/Enter lot area (Acres) <1.0000>: Q

Polylines for Lot Layout
The Front Polyline goes from right to left
Offsets & Intersections

This command takes a set of centerline polylines and calculates the series of offset polylines using the user defined offset and fillet radius values. The function recognizes primary and secondary roadways which allows for different offsets and fillet radii to be specified for each. Up to seven sets of offsets and radii can be defined for different features such as edge of pavement, right-of-way, sidewalk, etc.. Each set also has a layer name and description. The Pick button lets you set the layer name by picking an entity with that layer in the drawing. The description is for your own information and is not used by the program.

Multiple centerline polylines can be processed together which allows for the creation of an entire set of roadway offset polylines in one step. Intersections are calculated based on the centerlines selected and the fillet radii are applied at the intersections. The Smooth Interior and Exterior Corner options will fillet bends in the offset polylines. Otherwise turns without an arc in the original centerline will become straight corners in the offset polylines. The results of the calculations for the given parameters may be previewed in the dialog. Zoom and pan are available by clicking and dragging mouse on the preview image (zoom or pan mode is selected by a toggle). Once the satisfactory offsets are calculated, they are inserted into the drawing by clicking on Finish2D button. The Finish 3D button opens the *Elevate 2D Polylines* command, described in this chapter.

If it is preferable to handle intersections manually, you may run the command multiple times on non-intersecting centerlines. Another alternative is to use the *Offset* command in the Draw menu and the *Fillet* command in the Edit menu.
Prompts

Select all PRIMARY road polylines.
Select objects: select polylines
Select objects: Enter
Select all SECONDARY road polylines.
Select objects: select polylines
Select objects: Enter
Calculating offsets for layer EOP...
Calculating offsets for layer ROW...

Pulldown Menu Location: Area/Layout
Keyboard Command: wayint
Prerequisite: Centerline polylines
File Names: \lsp\wayint.lsp, \lsp\poly3d.arx

Cul-de-Sacs

This command uses a polyline centerline and the offset polylines to create a cul-de-sac. These offset polylines can be generated by the Offsets & Intersections command, or with the standard Offset command. The layer names of the offset polylines must match the layer names set in the dialog.

To run this command, pick a set of polylines and point on roadway centerline where the cul-de-sac center is. For cul-de-sacs with an offset center, pick a projection of that center onto the centerline and specify an offset distance (positive value is offset to the right, negative - to the left). Like the Offsets and Intersections command, a preview is shown of the cul-de-sac being designed. Any of the cul-de-sac parameters may be modified and reviewed before the cul-de-sac is applied and the drawing is modified with the Finish 2D button. The Finish 3D button opens the Elevate 2D Polylines command described in this chapter.
Bend cul-de-sacs are created by selecting offset entities on one side of the centerline.

Prompts

Select all offset polylines to end with cul-de-sac.
Select objects: make selections
Pulldown Menu Location: Area/Layout
Keyboard Command: stdcul
Prerequisite: A set of offset polylines and roadway centerlines.
File Names: \lsp\stdcul.lsp, \lsp\poly3d.arx

Elevate 2D Polylines

This command allows to assign elevations to a selection of polylines based on elevations along supplied 3D centerline and user-defined slopes. This routine calculates a distance from each vertex of 2D polyline to a specified 3D reference polyline and uses that distance and slope to calculate a 3D offset to a corresponding point on 3D polyline.

You can specify either the original centerline to be a reference 3D polyline or use another set of offset polylines. For example, you could specify the edge of pavement elevation to be relative to the curb elevation, while curb elevation is calculated based on the centerline elevation. You can view the resulting road/intersection design in 3D, making changes and updating picture on-the-fly. Local sink points can be reported instantly by evaluating a resulting triangulation to predict low points in the design leading to water retention.
Prompts

Select all offset polylines for the intersection.
Select objects: select entities
Select all 3D profile polylines.
Select objects: select entities

Pulldown Menu Location: Area/Layout
Keyboard Command: 3dintersect
Prerequisite: A set of offset polylines and roadway centerlines
Parking

This command draws a series of parking stalls. The command prompts for stall width and length, stall parking angle, and side for stalls. Stalls can be located by the number of stalls in a direction, as many as fit between two points, or along a polyline.

Stall Layout Method: Indicate the method of stall creation whether it be a desired number of stalls or as many stalls as can be fit on an alignment.

Min Stall Width: Indicate the minimum width a stall can be when the Fit on Alignment option is specified.
Max Stall Width: Indicate the maximum width a stall can be when the Fit on Alignment option is specified.
Stall Width: Indicate the stall width when the Number of Stalls option is specified.
Number of Stalls: Indicate the desired number of stalls when the Number of Stalls option is specified.
Stall Length: Indicate the desired length of each stall.
Side for Stalls: Indicate the side to which the stall lines should be placed.
Stall Placement Method: Indicate the method by which the stall direction should be determined whether it be between two picked points or along an existing graphical alignment.
Layer: Specify the layer on which parking lines should be placed or click the Set button to choose an existing layer.

Prompts

Starting Point?
Pick point or point number: Pick a point
Ending Point?
Pick point or point number: *Pick a point
Created 10 stalls.

Pulldown Menu Location(s): Civil → Area/Layout → Layout Utilities, Survey → Area/Layout → Layout Utilities
Keyboard Command: parking
Prerequisite: None.

**Set Back Measure-Move**

This command can be used to measure the perpendicular distance of 1 or 2 points to 1 or 2 lines. This can be helpful in placing buildings for proper setback from lot lines. After selecting the lot lines and the building, the command allows you to drag the building while a real time display on the side-bar menu shows the perpendicular distances to the lot lines. After experimenting you can press T to type in the values to move to. The second line and point are optional.

**Prompts**

Select 1st Lot line to measure perpendicular from.
Select object: *select line
Select 2nd Lot line to measure perpendicular from ([Enter] for none).
Select object: *select line
Select entity to move at 1st point to measure from:
Select object: ENDPOINT of (Pick a point on polyline.)
Pick a 2nd point on entity to measure from ([Enter] for none). END of (Pick a point.) Pick another endpoint of the polyline representing the building.

Drag-Pick new Location or [T]ype in Move distance(s) [C] to Cancel: T Either drag the building to a location and press the pick button on your pointing device or press T to enter the distances.

You may have to use a negative distance to move to the proper side of lot line!
Distance from 1st line: 10
Distance from 2nd line: 20
The building is then moved to your specification.

**Draw Lot Setback**

This command draws closed polylines inside lots to represent the building setback offsets. Before running this command, the lots need to be draw as closed polylines. The command starts with a dialog for entering the setback offsets and the layer for the new setback polylines. The Front to CL Max Offset is used to determine which lot edges are frontage. The program will prompt to select CL reference polylines and lot edges that are within this offset from these CL polylines are considered frontage edges. The Front Setback is applied to the lot frontage edges. The Side Setback offset is applied to lot edges that have only one of their ends within the frontage offset. The Back Setback offset is applied to all other lot edges.

File Name: `\lsp\bfitlin.lsp`
Prompts

Lot Setback Polylines dialog
Select reference centerline polylines.
Select objects: pick the polylines
Select lot polylines to setback.
Select objects: pick the polylines

Pulldown Menu Location: Area/Layout
Keyboard Command: lot_setback
Prerequisite: Lot and CL polylines
File Name: \lsp\contour4.arx

Fit Structure

The purpose of the Fit Structure feature is to place a structure (or the footprint) within a bounding polygon. For example, a house foundation - the footprint - within the limits of the setback lines of a lot - the bounding polygon.

The user can easily insert a structure footprint within a lot or bounding polygon near its final location.
footprint then it can then be conveniently rotated and/or translated, in user definable increments, to the exact position desired.

Footprint Templates

The template, a full scale definition of a structure's footprint, must be defined prior to placing it within the bounding polygon. Templates are not AutoCAD drawings but they can be imported from AutoCAD drawings. The data specifying the dimensions of a template is stored in a binary format and cannot be manipulated without using the Template Manager. Once a template is placed in the drawing, it becomes a C&G footprint polyline. Since it is a C&G polyline, it can be queried and manipulated using ordinary AutoCAD and CGSurvey commands.

Template Manager
The Template Manager is used to manage the templates for the various projects you work on. For example, the various house footprints used in a given subdivision can be defined as templates. The templates can then be placed in a lot in an "as" or "reverse" orientation and reused as many times as necessary. You can use the Template Manager to define templates directly or import the templates from existing AutoCAD drawings.

The Template Manager allows you to organize your templates within projects. You can name the projects in a meaningful way then import the templates into the project "folder".
When you choose the Fit Structure feature from the Cogo menu for the first time, a dialog warns you that you have no templates defined then brings up the Template Manager.

In the dialog below you will notice that there is nothing listed under the Projects item. This means that you will have to either create a template or import one from an existing drawing.

Creating a Template:

To create a new template, click the Create button. This brings up a dialog that allows you to configure the simple drawing in which you will create a template. This dialog allows you to specify the name of the project, the name of the template and asks about the approximate overall size of the template. If the structure template is made up of right angle segments you may want to specify a snap grid to aid you in laying out the template. You should be aware that the create template method should only be used for very simple templates and that it does not allow you to edit the structure once it is added to the Template Manager.

When you are done configuring the create template drawing interface, click OK and you will be see a empty AutoCAD screen upon which you can draw the template. The template is merely a closed polyline. The C&G Polyline by Points interface is used but in this case there will only be normal AutoCAD points picked (also known as graphic points designated as GR-PT). The polyline must be closed - so use the C for Close command line option for the last line segment in the template. Once you enter the Close option keyword for the polyline you are working
on, the drawing window closes and the template is imported into the Template manager as shown below.

**Note**: You must click on the template name in order to see its shape in the window on the right and to choose it as the current template.

**Importing a Template**

The Create template method is only useful for very simple templates. For more complicated templates and projects with multiple structures, it is recommended that you use the Import method. To import a template you must create a separate drawing, then draw all of your templates at full scale on the layer specified for templates (see **Fit Structure Setup**).

**Create a separate template drawing**

Begin the importing of a template by creating a new drawing file as a repository for all the structure template drawings used in a specific project. For this example we will create a new drawing named Mitchell Estates bldgs.dwg. This file will only contain the structure template drawings for this project.

Select the CAD File menu then select the menu **New** item.

You may be asked to choose a drawing template (not to be confused with the structural template polylines you are about to create). It is generally easiest to use the default acad.dwt drawing template but you may also specify one of your own choosing.

In this new drawing create a layer having the name specified in **Fit Structure Settings** and make this layer current. You can accomplish this by using the CAD Layer Manager. To open the Layer Manager, from the Format menu choose the Layer menu item.

In the new drawing, draw the templates (house footprints for example) you will be using in your project. A structure template must be a closed polyline and may contain arc segments.

Draw the individual house footprints. It is recommended that you use either the C&G **Polyline by Points** feature or use the standard CAD PLINE command - on the Draw menu choose 2D Polyline.

You could also use the C&G **Quick Traverse** feature to traverse around the building However, if you use **Quick Traverse** to create the footprint you must then convert the C&G lines created by Quick Traverse to polyline. To do this you can use a utility on the CGTools menu, Join Nearest.

Once you have created the templates needed, close and save the template drawing file. You can come back to this drawing at anytime and add or modify templates as needed.
Note: If you change a template in the original template drawing, you must be re-imported using the Template Manager. First, use the Template Manager's Delete feature to delete the old template, then re-import the changed template from your template drawing file.

Placing a Footprint:

Return to the original drawing into which you wish to insert the footprint. In this example Mitchell Estates.dwg will be used to place structure footprints within lot setbacks.

Select the Fit Structure menu item.

If this is the first time you have run the command and no templates have been specified, you will be informed of this by a warning dialog. Click OK in the warning dialog and the Template Manager will come up.

If you have inserted a template prior to running this command, the following prompt will be seen at the command line:

Choose a structure template [Set template/Current-template (Wilson)/Mirror-current/Done] <C>:

Select "S" for Set template to bring up the Template Manager.

The Template Manager

As mentioned earlier, the Template Manager is used to manage the structure templates you use for your various projects. In the left hand pane the projects and their associated templates are arranged similar to the directories in the Windows Explorer. On the right pane is a drawing showing an unscaled representation of the shape of the currently highlighted template. The highlighted template becomes the current template when you Close the Template Manager. The following describes the Template Manager functions in more detail.

Delete button: This allows you to delete a Project or an individual template.
Create button: This allows you to generate a template "on-the-fly" while in the current drawing file. This method of creating templates should only be used for the simplest of templates. In most cases it is recommended that you import pre-drawn templates from other existing drawings.

When the Create button is selected, the Add A Template dialog appears (shown earlier).

Name of Project: enter a new name or press the down arrow to select from existing projects.

Name of Template to Add: enter a new name or press the down arrow to select from existing projects.

Approximate Overall Dimensions of Template: enter an approximate length and width. Make sure this overall dimension will include the entire template so you will be given enough room to draw the template - too large is better than too small.

Grid: If you wish to have a snap grid as a drawing aid when you create a template, check the Use grid to aid in drawing the template checkbox and set the grid interval. You need not use a grid but it is useful in creating simple
rectangular templates.

Click **OK** to begin creating the template. To create the template merely pick the desired locations for the various building corners. Be sure to close the structure perimeter by typing C and Enter. After closing the template polyline you will be returned to the **Template Manager**.

**Import button:**
clicking this button allows you to import the template from another drawing file. As described earlier, you should create a separate template drawing. In that drawing draw the required templates as closed polylines. The templates may contain arcs.

When you select the Import button a dialog (shown earlier) comes up asking you to enter or select a **Project Name** and to specify the **Name of Template to Add**.

The **Project Name** can be anything you wish but is often the name of the subdivision or the client name. The template name can also be anything you wish. It should generally reflect the type or style of structure the template represents.

After filling out the project and template names and clicking **OK**, a file dialog will be displayed. Choose the drawing file you created earlier containing the template(s) you wish to import.

After closing the file dialog the template drawing will be shown and you will be asked to choose the template polyline. When you pick the template polyline its geometry is stored in a special file reserved for template information and you will be returned to the **Template Manager**.

If you highlight the newly imported template on the left hand pane it becomes the current template and you should see it displayed in the right hand pane.

If you wish to import another template just repeat these steps as many times as necessary.

By highlighting the template name it is made the current template. You may choose to mirror the current template on the Y axis by checking the Mirrored checkbox. All you need do now is click the **Close** button to close the **Template Manager** and place the footprint in the drawing.

**Fit Structure Example**

The following file names will be used when describing the following example:

- Coordinate File: Mitchell Estates.crd
- Drawing File: Mitchell Estates.dwg
- Template Drawing File: Mitchell Estates bldg.dwg

**Note:** The template drawing file may have several templates in the same drawing file. For example you may have a subdivision with many different house footprints.
**Import the templates**

Open the subdivision drawing file, in this case; Mitchell Estates.dwg, and the associated coordinate file: Mitchell Estates.crd.

The subdivision drawing should already exist and you should have already defined the bounding polygons within which the structures are to be placed. These bounding polygons can be defined either by polylines (arcs are allowed) or lines and arcs. The lots and setbacks (bounding polygons) can also be defined using a C&G Point Group or Groups.

Once the subdivision drawing is open and has been prepared for the placement of structures choose **Fit Structure** from the menu.

If you have not run the **Fit Structure** command and set a current template in this drawing session, the **Template Manager** dialog will appear.

The first task will be to create a project and import templates from the template drawing file, Mitchell Estates bldg.dwg.

Select the Import button and fill in the project name and template name.

In this example the subdivision name is Mitchell Estates and the house model being added to the template list is the Wilson.

Next a drawing file dialog will be displayed. Highlight the template drawing file (in this case Mitchell Estates bldg.dwg) and click the **Open** button and use the cursor to choose the polyline representing the template to be imported.

After choosing the template polyline, you will be returned to the **Template Manager**. You will notice that the template you just chose has been added to the template manager under the project you selected. To see its shape and make it the current template, click the template name under the current project.

You may continue to add templates as required. Click **Close** to begin placing the template in the subdivision drawing.

After the Template Manager closes you will return to the main drawing and see the following prompt:

**Pick the lot within which the structure will be placed [cg-Point-group/Done] <pick>:**

Pick a polygon or a series of lines that define a closed lot boundary or setback within which you wish to place the structure. Type P and Enter to use a C&G point group file to define the bounding polygon.

**Place the structure in the bounding polygon**

Once you have specified the bounding polygon you will be asked to place the structure near its final location in the bounding polygon. Move the structure near its desired location using the mouse and click the left mouse button to place it at that location. Once you have picked the approximate location for the structure you will then be allowed to rotate and move the structure to its exact final location.

**Note:** If you need to adjust a template further once it has been placed within the bounding polygon and you have exited the Fit Structure command, you can run the Fit Structure command again and pick the existing structure instead of using a template.

**Adjust the structure**
After placing the structure in the bounding polygon you will see the following prompt at the command line:

**Adjust structure [Move/Step-move/step-Rotate/roTate/rot-Ninty/Parallel/On-boundary/setUp/Done] <D>:**

You are now at the stage were the structure can be adjusted to its final desired location with relationship to the setback lines and its orientation with respect to the street and other features.

In all the commands used to adjust the structure, the distances to the bounding polygon may be displayed at the appropriate corners of the template (see example below). You may turn this distance display on or off or view or change other fit structure parameters using the setUp option (type U and Enter at various the prompts).

**Move:**
Type M and Enter to "drag" the structure around using the mouse cursor - similar to when you first placed the structure in the bounding polygon. This option is only meant for moving the structure in a gross, imprecise way and thus allow you to place it near its final location. After using this option the structure can be more finely adjusted using one of the other options described here.

**Step-move:**
To move the structure up, down, left or right, using the arrow keys on the keyboard, type S and Enter. The following prompt will appear:

**Press arrow keys to move 1.000 dwg units [setUp/Done] <D>:**

Now you can use the arrow keys on your keyboard to move the structure by steps in the X and Y directions. The distance moved per keystroke is indicated at the command line - in this case the structure moves 1 unit each time you press an arrow key. To change the per step increment, type U for setUp. This brings up the **Fit Structure Setup** dialog, allowing you to change the **Translation Step** setting (see below).
Click **OK** to return to the **Adjust Structure** command line.

**Step-Rotate:**
If you type R and Enter for **step-Rotate** you can then use the up and down arrow keys on the keyboard to rotate the structure by small rotational steps.
The following prompt will appear:
**Use down/up arrow keys to rotate 10°00'00'' clockwise/ccw [setUp/Done] <D>:**

**Rotate:**
To rotate the structure, type R and Enter. The following prompt will appear:
**Rotate structure to desired orientation: [setUp] <pick>:**

Use this option to rotate the structure by moving the mouse. Left clicking will place the structure at the current rotated orientation. This method of rotation is not precise and is thus useful only for gross rotational movements.

**rot-Ninty:** Type N and Enter to rotate the structure 90 degrees in a clockwise direction.

**Parallel:**
Type P and Enter to rotate the structure so that one of its sides is parallel to a specified line segment on the bounding polygon.
First, select the side of the bounding polygon that you wish to be parallel to a selected side of the structure.
Next, select the side of the structure that is to be parallel to the previously selected line on the bounding polygon.
After picking the side on the structure the structure will be rotated into position.

**Note:** If the rotating the structure about its geometric center to make the selected sides parallel to one another will cause an encroachment, an error message will be displayed, no changes will be made, and you will return to the **Adjust Structure** ... prompt.

**On-boundary:**
Type O and Enter to choose a point on the structure that is to touch a selected point on the bounding polygon. This is accomplished by translation only.

**Pick the point on the bounding polygon where you want the structure to touch:** Pick the point where the structure touches the bounding polygon.

**Choose the point on the structure that you want to touch the bounding polygon:** Pick the point on the structure that touches the bounding polygon.

If choosing a structure corner as the point to touch the bounding polygon, you should use the end point snap. If you do not use end point snap, the translation of the point picked to the bounding polygon will likely cause the corner of the structure to encroach. You can specify end point snap when picking the point on the structure by typing in "end" and Enter at the prompt, then you merely need to pick a point on the structure near the desired corner to actually specify the corner point.

**Note:** If the translating the structure to make the selected point touch the bounding polygon at the selected...
point would cause an encroachment, an error message will be displayed, no changes will be made, and you will return to the Adjust Structure ... prompt.

Completing the adjustment process

Once you are satisfied with the location of the structure type D and Enter and you will see the following prompt:

Creating structure coordinate points:
Enter description for structure corner points <footprint_pt>:

You can accept the default description shown in brackets by pressing Enter or you may type in a description that will help you identify this particular structure and lot. The corner and any radius points for the current location of the structure are stored in the current coordinate file and, if Auto plot points is ON, the points are drawn.

After storing the points for the previously placed structure you will see the following prompt:

Choose a structure template [Set template/Current Template/Mirror current/Done] <C>:

Press Enter or C and Enter if you wish to repeat the process and place the current structure template in the same or another bounding polygon. If you wish to place a mirrored ("reverse") version of the current structure template in a bounding polygon, type M and Enter. If you wish to place a different structure in a bounding polygon, type S and Enter to bring up the Template Manager, allowing you to pick a new template. If you are done placing templates for now, type D and Enter for Done.

At any time you may adjust an existing structure by choosing Fit Structure. If there are existing structures in the drawing, it will be detected and the following the prompt will appear at the command line:

Pick existing structure to adjust or choose a structure template.
[Set-template/Current-template(Wilson)/Mirror-current/Done] <C>:

At this prompt you can use the mouse to pick an existing structure to adjust. You can now use any of the adjustment methods described above to further refine the location of the structure. After the adjustment process is complete the coordinate file is updated to reflect the adjusted locations of the structure's corner and radius points.

Note: When you pick an existing structure, any plotted corner point point symbols are temporarily removed to facilitate the adjustment process. Once you are done adjusting the existing structure, these points are re-plotted at their new adjusted locations.

At this prompt you may also choose to place a new structure in a bounding polygon. To use a different template, type S and Enter to bring up the Template Manager and allow to choose the desired template. If you have already placed a template in the current drawing session, the prompt will indicate the current template. By typing C and Enter or just pressing Enter you can choose to place the current template in a bounding polygon or you can type M and Enter to place a mirrored version of the current template:

Prompts

Template Manager dialog: create or choose a template to place within a bounding polygon (a lot)
Add a Template dialog: Used in conjunction with the Template Manager dialog to add a template to a given project.
if you have already specified a template to use but no templates have been placed in the drawing:

Choose a structure template

[Set template/Current template (Wilson)/Mirror-current/Done] <C>: Type "S" and Enter to bring up the Template Manager dialog. Type "C" and Enter or just Enter to use the current template. Type "M" and Enter to mirror the current template. Type "D" and Enter when done placing templates.

if a structure/template exists in the drawing or you have already specified a template to use:

Pick existing structure to adjust or choose a structure template.  
[Set-Template/Done] <S>: To adjust an existing structure pick it on the screen. Type "S" and Enter or just Enter to bring up the Template Manager dialog to choose a new template. Type "D" and Enter when done.

after you set a new template or chose to use the current one:

Pick the lot within which the structure will be placed [c&g-Point-group/Done] <pick>: pick the polyline or a series of lines that define a closed polygon within which the structure template will be placed. Type P and Enter to specify the bounding polygon using a C&G Point Group file.

Place the structure near its final location in the bounding polygon <pick>: Drag the structure template to the desired location and click the left mouse button to place the structure.

after you place a template or pick one to adjust:

Adjust structure [Move/Step-move/step-Rotate/rot-Ninty/Parallel/On-boundary/setUp/Done] <D>: Type "M" and enter to move the structure. Type "S" and Enter to use the arrow keys to move the structure in predefined steps. Type "T" and Enter to use the cursor to rotate the structure. Type "R" and Enter to rotate the structure template a predefined number of degrees using the up and down arrow keys. Type "N" and Enter to rotate the structure 90 degrees clockwise. Type "P" and Enter to translate and rotate the structure template parallel to a side of the bounding polygon. Type "O" and Enter to move the structure template so a chosen point on the structure touches a chosen point on the bounding polygon. Type "U" and enter to use the Setup dialog to change the step sizes, layer names and other configuration items for the fit structure command.

when saving the structure coordinate points:

Enter description for structure corner points <footprint_pt>: Specify a description for the structure template corner points to be saved in the coordinate file or just press Enter to use the default description.

Pulldown Menu Location: Area/Layout > Layout Utilities
Keyboard Command: cg_fit_structure
Prerequisite: coordinate file, pre-drawn bounding polygon (lines and arcs or a polyline)

Lot Network Settings

This command displays a dialog for the current Lot Network Settings which specifies the lot network name, road network name, label settings, setback settings, hatch settings, building placement settings, lot type settings and lot area tolerance.
Lot Network: Click Select for the Lot Network name and choose the Lot Network file (.ltn).

Road Network: Click Select for the Road Network name and choose the Road Network file (.rdn).

Starting Lot Name: Indicate the starting Lot Name. As Lots are created, the trailing digit will be incremented by a value of 1.

Lot Area Tolerance: Specify the tolerance level at which the area computations will go to be considered correct.

Automatic Label Updates: Enable this option if Lot labels should automatically update themselves if a Lot is altered or adjusted.

Edge Direction: Select an option to have new Lot lines drawn either Away From Frontage or Toward Frontage.

Default Lot Type: Settings in this section of the dialog box will be applied to all new Lots created using the "Default" Lot type.

Lot Line Layer: Specify a new layer or click Select to choose an existing layer for newly created Lot lines.

Label Lines and Arcs: Enable this option if you want this routine to label the newly created lines and arcs at the time new Lots are generated. For Line/Curve Label Settings, you can click Select to specify the Auto Annotate settings file (.aan) or click Edit to make changes to the Auto Annotate settings. For General Label Settings, you can click Select to specify the Annotation General Settings file (.adf) or click Edit to make changes to the Annotate Defaults settings.

Label Areas: Enable this option if you want this routine to label the areas at the time new Lots are generated. For Area Label Settings, you can click Select to specify the Area Defaults file (.ars) or click Edit to make changes to the Area Defaults settings. For Area Table Settings, you can click Select to specify the Area Table Settings file (.atb) or click Edit to make changes to the Area Table Defaults settings.
**Draw Setbacks:** Enable this option if you want this routine to draw Setback lines at the time new Lots are generated. Click Settings to adjust the Setback Settings as desired.

![Lot Setback Polyline Window](image)

**Draw Hatch:** Enable this option if you want this routine to draw a Hatch pattern inside Lots at the time new Lots are generated. Click Settings to adjust the Hatch Settings as desired.

![Hatch Settings Window](image)

**Building Placement Settings:** Click the Building Placement Settings button to specify the values that should be followed when building pads are placed using the Lot Network routines.
Lot Setback Parameters: Adjust the front, side and back Setbacks as desired.

Draw Building Pads: Enable this option to draw building pad polylines.

Building Polyline Layer: Specify the layer on which building pad polylines should be drawn or click the Select button to choose an existing layer.

Draw Building Symbols: Enable this option to draw building symbols (blocks).

Building Symbol Layer: Specify the layer on which building pad symbols should be placed or click the Select button to choose an existing layer.

Symbol: Click the Select button to specify the name of the building symbol.

Building Pad Width: Specify the width of the building pad polyline.

Building Pad Depth: Specify the depth of the building pad polyline.

Building Pad Setback: Specify the distance behind the Setback line at which to place building pad polylines. Enter "0" to have building pad polylines placed directly on the Setback.

Additional Building Pads: Click the Add button to create additional building pads, the Edit button to modify existing building pads and the Remove button to delete building pads.

Note:

- When building pad creation is enabled, the initial Building Pad dimension will be attempted. If the initial building pad cannot be placed due to Lot size/placement restrictions, subsequent building pads in the Additional Building Pad list will be attempted.
LotNet sample showing setbacks and examples of varying building sizes.

LotNet sample showing 3D building symbol.

**Additional Lot Types:** Settings established in this section of the dialog box allow you to create additional types of Lots in order to apply different Line/Curve, Area, Area Table, Setback, Hatch and Building Placement Settings according to their specified Lot Type. Additionally, running a Lot Network Report will break out Lot data based on Lot Type and Lot Network Inspector will display Lot Type.
Add, Edit and Remove: Use these buttons to create additional Lot types, edit or remove existing Lot types.

Pulldown Menu Location: Area/Layout
Keyboard Command: lotnet_config
Prerequisite: None.

Lot Network Boundary

These are a collection of commands to assign and verify the site boundary for lot network.
Sets the site boundary. It must be a closed polyline.

Indicates the boundary to the user by highlighting it.
Indicates the boundary to the user by hatching it.
Erases the hatched boundary for the user.
Deletes the boundary designation from the polyline.

Pulldown Menu Location: Area/Layout
Keyboard Command: lotnet_limit, lotnet_highlight_limit, lotnet_hatch_limit, lotnet_hatch_erase, lotnet_untag_limit
Prerequisite: None
File Name: \lsp\eworks.arx

Tag Sub-Area

This command provides the ability to establish "exclusion" areas (such as wetlands or drainage ponds) that limit where Lots or Lot Setbacks from the Lot Network routines can be created.

Prompts
Select polyline for sub-area: Pick a closed polyline that defines the sub-area.
Area Category: Provide the name of a general category for the sub-area.
Area Description: Provide a more specialized description for the sub-area.

Note:

- If a Sub-Area is created after a Lot Network has been processed, the existing Lot lines are kept and any associated setback lines are updated to honor the Sub-Area.
- If a Lot Network is processed after a Sub-Area has been created, the newly created Lots will honor the Sub-Area(s).

Pulldown Menu Location(s): Civil → Area/Layout → Lot Network Sub-Areas, Survey → Area/Layout → Lot Network Sub-Areas
Keyboard Command: tag_subarea
Prerequisite: A closed polyline.

Untag Sub-Area

This command removes the from the selected polyline(s) the Sub-Area Category and Description information placed with the Tag Sub-Area command.

Prompts

Select sub-area polylines to remove sub-area tag.
Select objects: Pick the polyline(s) whose Sub-Area information you wish to clear and press Enter when complete.
Pulldown Menu Location(s): Civil → Area/Layout → Lot Network Sub-Areas, Survey → Area/Layout → Lot Network Sub-Areas
Keyboard Command: untag_subarea
Prerequisite: A closed polyline with appropriate Sub-Area data.

Identify Sub-Area

This command displays the Sub-Area Category and Description information found on polylines tagged with the Tag Sub-Area command and reports it to the Command prompt.

Prompts

Pick polylines to check or search drawing [<Pick>/Search]: Press Enter to individually select Sub-Area poly-lines or Type S and press Enter to search the entire drawing.
Select sub-area polyline: Pick the polyline whose Sub-Area information you wish to identify and press Enter when complete.
Pulldown Menu Location(s): Civil → Area/Layout → Lot Network Sub-Areas, Survey → Area/Layout → Lot Network Sub-Areas
Keyboard Command: id_subarea
Prerequisite: A closed polyline with appropriate Sub-Area data.
Report Sub-Area

This command displays the Sub-Area Category and Description information found on polylines in the drawing that have been tagged with the Tag Sub-Area command and reports the information to the standard Report Viewer.

Pulldown Menu Location(s): Civil → Area/Layout → Lot Network Sub-Areas, Survey → Area/Layout → Lot Network Sub-Areas
Keyboard Command: report_subarea
Prerequisite: A closed polyline with appropriate Sub-Area data.

Hatch Sub-Areas

This command places a hatch pattern into polylines in the drawing that have been tagged with the Tag Sub-Area command.

Prompts

Hatch Name: Type in the name of a valid hatch pattern. A sample of the pattern will appear near the "Select Pattern" control.

Automatic Hatch Scale: Disable this toggle to manually control the size/density of the hatch pattern.

Hatch Scale: Specify the size of the hatch pattern. Larger Scale values create a less dense pattern.

Select Pattern: Use a visual dialog box approach to select a hatch pattern. The name of the hatch pattern selected displays in the Hatch Name control.

Select Color: Use a visual dialog box to specify the color of the hatch pattern.

Note:

- Any previous hatch patterns placed by the Hatch Sub-Areas command are first erased from the drawing.
- Hatch patterns are placed onto the LOTNET_HATCH_SUBAREA layer.

Pulldown Menu Location(s): Civil → Area/Layout → Lot Network Sub-Areas, Survey → Area/Layout → Lot Network Sub-Areas
Keyboard Command: hatch_subarea
Prerequisite: A closed polyline with appropriate Sub-Area data.

Erase Sub-Areas Hatch

This command removes the hatch pattern(s) placed with the Hatch Sub-Areas command.
Label Sub-Areas

This command displays the Sub-Area Category and Description information found on polylines tagged with the Tag Sub-Area command and uses the current text style to place the information as text into the drawing.

Prompts

Text Size <4.00>: Press Enter to accept the specified text size or Type an alternate numeric text size and press Enter.
Label area size [Yes/<No>?] Choose whether or not the area of the Sub-Area(s) should be labelled in the drawing.
Layer name <LOT_SUBAREA>: Press Enter to accept the layer name specified or type in the desired layer name and press Enter when complete.

Note:

• To remove Sub-Area Labels from the drawing, use the Lot Network Settings command.

Input-Edit ROW Offsets

This command defines the ROW offsets for the Road Network for Lot Networks. The ROW offsets are for the frontage polylines to the left and right of the centerlines. Besides the ROW, you can also define additional offset polylines to be drawn. These additional offset polylines do not effect the lot network.

Pulldown Menu Location: Area/Layout
Keyboard Command: lotnet_row
Lot Network Road Network

This command develops the linework, geometry and labeling for subdivision, commercial and industrial sites by using the familiar RoadNet interface and pre-defined settings. The program docks a dialog on the left of the screen identifying the geometry settings and all road files and leaves an active CAD screen and command line. You can save drawings and run virtually any standard AutoCAD command while within the docked dialog. Once you identify centerlines for the road network, the program detects intersections and end segments suitable for cul-de-sacs, and through input of design parameters for offset criteria, cul-de-sac dimensions and intersection transitions, the program will process the complete geometry layout, with output options including creating Lot files for later reference and a variety of labeling options for such items as Areas, Distances and Bearings. The road network settings are saved in a .RDN file.

Before running the Road Network, use the following procedure to setup the lot labeling settings and site boundary.

1. Click the Lot Network Settings button. Note that you can use the Area/Layout Menu pulldown to access these commands as well. Select or create a lot network settings file.

2. Next, select the Set Boundary icon. Select a closed polyline for the boundary around your site.

3. Next select the Road Network icon. When prompted, select the .RDN file from the Existing tab. This is where the centerlines involved for the subdivision will be defined and added to the Road Name area of the panel. These centerlines are standard Carlson .CL files. Click a centerline and choose Edit. If a CRD file is requested choose or create a .CRD file. The Edit Road dialog appears. The centerline can be selected here and these
centerlines can be edited on the fly if needed. For ROW Offsets, we are using the Row-OFF-a.Row file. Click Edit. The ROW offsets dialog displays. Use the defaults of 45' left and right and note that additional graphics can be automatically generated by hitting Add and entering additional values, names and layers. Hit Exit.

Note also that Optional Input files can be attached to the process for roadway widenings based on the standard Carlson Road design tools of the same name. This is where a polyline indicating where the roadway template ID's should be tapered or widened is developed into a Centerline file and attached to the roadway template involved. Refer to the Road Design documentation for this information. Hit OK to close the Edit Road dialog. These settings can be set and altered for each road in the network.

Next click on one of the intersections you may have and select Edit Intersection. In the Edit Intersection dialog, the intersection's radii can be set. Click on the Front Left or Front Right to verify this. Hit OK when ready.

The program can also develop cul-de-sacs for the subdivision, although this example doesn't require one. To see how it works, click Add under Cul-de-sac's area of the panel. The Select Road for Cul-de-sac dialog appears. Select the road for the Cul-de-sac and the Edit Cul-de-sac dialog opens. Then as shown in the figure, choose whether the cul-de-sac occurs at the beginning or ending of the roadway, provide a cul-de-sac radius and filet radius and any other criteria to develop the graphics as desired. Since we do not have a cul-de-sac in this example we will skip this step.
Next select Settings at the bottom of the RoadNet panel. Use a radius of 25.0 and turn on the Create Lots toggle and click Settings. Set the values as shown in the Create Lot Settings dialog below. Then hit OK and OK to exit.
In the RoadNet panel click Save or Saveas to save these settings for your own experimentation.

Now Click Process to begin the lot layout. You will notice the ROW’s and EOP’s being generated, followed by the lot lines. Then areas are labeled and setbacks are created. Finally, the lotlines are labeled with distances, bearings and arc data.

**Pulldown Menu Location:** Area/Layout  
**Keyboard Command:** lotnet_rdn  
**Prerequisite:** centerlines and a site boundary polyline
Lot Network Linework

The following commands allow for the Lot Network to be manipulated after the processing. The commands allowing this are:

Adds a ROW polyline into the model. By clicking this command, the software asks for the user to select the new ROW polyline. It then reprocesses the site based on this new ROW data and relocates the EOP for this portion of the roadway.

This command adds a lot edge to the model. The software may request a Lotnet Settings file and if so create or select it. The software prompts with: Select Edge linework to add to model: Select the polyline you drew in the lot representing the new lot edge. The software reprocesses the site based on this new data and redevelops the lot layout accordingly.

This takes a property line out of the model. Select the edge in question when prompted.

This command allows for adding a new property corner to an existing lotline. Simply select the lot edge in question and then pick the point to be added using a snap or other means.

This command allows for moving a lot corner.

This command allows for eliminating a lot corner. Simply select the lot edge in question and then the corner to be removed.

Pulldown Menu Location: Area/Layout
Keyboard Command: Lotnet_Add_Row, Lotnet_Add_Edge, Lotnet_Remove_Edge, Lotnet_Point_Add, Lotnet_Point_Edit, Lotnet_Point_Remove
Prerequisite: None
File Name: \lsp\eworks.arx

Lot Network Subdivide Area

This command subdivides an area into smaller parcels. The command displays the Create Lot Settings dialog. Once all settings are values have been entered, click on the OK button.

Next you are prompted to Pick inside area to subdivide:

Next, the right-of-way adjacent to your area to subdivide is highlighted. You are prompted to Pick end of frontage to start lots: . Use your left mouse button to pick a point near one end of the highlighted right-of-way. New lots will be created starting from this end of the right-of-way.

Note: All previously created lots will be re-drawn and re-labeled if the setting for "Automatic Label Updates" has been toggled ON in the LotNet Settings dialog box.
**Prompt for Each Area:** Enabling this setting will prompt you to specify the area for each Lot as it's created.

**Target Lot Area:** This setting establishes the minimum lot area for each lot created using this command. Target Lot Area can be specified using Acres or Square Footage.

**Minimum Frontage:** This setting establishes the minimum width, along the front Right of Way, of the newly created lots.

**Use Setback for Minimum Frontage** Enabling this option measures the minimum frontage at the setback location instead of along the front Right of Way.

**Frontage Setback:** This setting establishes the distance off the front right-of-way for the front setback.

**Minimum Lot Depth:** This setting establishes the minimum depth of new lots created with this routine.

**Maximum Lot Depth:** This setting establishes the maximum depth of new lots created with this routine.

**Minimum Back Distance:** This setting establishes the minimum width of the rear lot line. Setting this to "0" allows for a pie-shaped lot.

**Interior/Back Reduce Offset:** This setting establishes the maximum distance interior or back lot lines can be shifted or trimmed in order to meet other setback rules.

**Edge Method:** This setting establishes the angle between the front right-of-way and new lot lines. You are able to specify that new lot lines be drawn: Perpendicular to ROW, Perpendicular to Back Lot Line or at a Specific Angle.

**Remainder:** This setting allows you to distribute the area that is left over after creating new lots. The remaining area can be distributed using one of several methods: Apply Equally to all Lots, Create Separate End Lot, Add to Last Lot and Create Back Lot Edge.

**Lot Type:** This setting allows you to specify the Lot Type for new lots created using this routine. Lot Types are defined in the LotNet Settings dialog box.

**Check Building Placement:** This setting allows you to establish front, side and back setback distances for building placement along with a minimum allowable area for front setback. Building sizes are defined in the LotNet Settings.
Pulldown Menu Location: Area/Layout
Keyboard Command: lotnet_subdivide_area
Prerequisite: None

Size Lot by Frontage

This command provides the ability to resize a Lot associated with the current Lot Network .LTN file based on a user-specified amount of Lot Frontage.

Prompts

Pick inside lot to adjust: Identify the interior portion of a Lot whose Frontage is to be adjusted.
Select lot edge to adjust: Choose a side Lot edge that is common to two Lots. The Current Area and Current Frontage of the selected Lot is reported.
Frontage (ft): Type in the new Frontage amount and press the Enter button.

Note:

- To specify an alternate .LTN file, use the Lot Network Settings command.

Pulldown Menu Location(s): Civil → Area/Layout → Lot Network Areas, Survey → Area/Layout → Lot Network Areas
Keyboard Command: lotnet_sssfront
Prerequisite: A processed set of Lots and their graphical entities created by the Lot Network routines.

Lot Network Sliding Side Area

In this routine a lot side can be altered to reflect a new target area. It will hold its angle and slide along the front and back lot lines until it has achieved the desired area. When running the routine, Select the lot in question when asked to pick inside lot to adjust and then select the lot edge to adjust. Then the prompt asks Acres/<Enter Target Area(sf)>: Type in the desired area you are trying to obtain and the system computes it.

Pulldown Menu Location: Area/Layout
Keyboard Command: lotnet_sssarea
Prerequisite: None
File Name: \lsp\eworks.arx
**Lot Network Hinged Area**

In this routine a lot side can be altered to reflect a new target area. It will hold a lot corner and pivot, or rotate until it achieves the desired area. The procedure is as follows:

- **Pick inside lot to adjust:** Select a point inside the lot to modify.
- **Select lot edge to adjust:** Select the edge that will move.

The routine will report the current area to you and then ask for your desired area.

Current Area: 22494.5 SF 0.516 Acres

Acres/<Enter Target Area (sf)>: 10000

- **Pulldown Menu Location:** Area/Layout
- **Keyboard Command:** lotnet_harea
- **Prerequisite:** None
- **File Name:** \lsp\eworks.arx

**Lot Network Labels**

These are a collection of commands to draw lot network area, line and arc labels.

Deletes the labels in the model and re-labels the linework based on the LTN file settings.

Deletes the labels in the model and re-labels the linework.

- **Pulldown Menu Location:** Area/Layout
- **Keyboard Command:** lotnet_update, lotnet_redraw
- **Prerequisite:** None
- **File Name:** \lsp\eworks.arx

**Lot Network Report**

This command generates a summary report of the areas and number of lots in the lot network model. For a detailed report of the lot data, output the lot network to a .lot file and run the Report function inside Lot File Manager.

Lot Network Report

- **File:** C:\Carlson Projects\Clearwater Oaks.ltn
  - Total Area: 20.520 acres, 893839.8 sf
  - Lot Area: 17.600 acres, 766648.4 sf
  - ROW Area: 2.920 acres, 127191.3 sf
  - Other Area: 0.000 acres, 0.0 sf
  - Number of Lots: 50

- **Pulldown Menu Location:** Area/Layout
- **Keyboard Command:** lotnet_report
- **Prerequisite:** None
- **File Name:** \lsp\eworks.arx
Lot Network Inspector

This command shows a dynamic report of the lots as the cursor passes over them. The program has a small dialog that shows the lot number, area, perimeter, frontage and Lot type.

Pulldown Menu Location: Area/Layout
Keyboard Command: lotnet_inspector
Prerequisite: a lot network

Check Lot Network Parameters

This command compares area and frontage of Lots associated with the current Lot Network file (.ltn) against user-specified area and frontage values.

Enabling the "Check ROW Offsets" option will also check for proper right-of-way distances using a specified centerline file (.cl) or (.rdn) file.

A detailed report is generated that displays the Lots that meet or do not meet the area and frontage minimums along with the coordinates of points along Lot frontage that violate the right-of-way value specified.

Minimum Lot Area: Specify the smallest acceptable area a Lot can be to "pass the test" and the appropriate unit of measure.

Minimum Frontage: Specify the smallest allowable amount of street frontage the Lot must have in order to "pass the test."

Check ROW Offsets: This setting allows you to specify the full right-of-way width for the road defined by the centerline file (.cl) you specify.

Note:

• To specify an alternate .LTN file, use the Lot Network Settings command.
• To "browse" over lots already in a drawing, use the Lot Network Inspector command.

Pulldown Menu Location: Area/Layout &circ;&dagger;' Lot Network Utilities
Keyboard Command: lotnet_check
Prerequisite: A processed set of Lots created by the Lot Network routines.
Find Lot Name

This command displays a temporary indicator in the drawing showing the location of a Lot associated with the current Lot Network .LTN file.

Note:

- To specify an alternate .LTN file, use the Lot Network Settings command.
- To "browse" over lots already in a drawing, use the Lot Network Inspector command.

Prompts

Lot Network File to Process dialog Locate an existing .LTN file
Lot name to find: Type in the Name (usually the Lot Number) of the Lot you wish to locate and press Enter

Pulldown Menu Location(s): Civil → Area/Layout → Lot Network Utilities, Survey → Area/Layout → Lot Network Utilities
Keyboard Command: lotnet_find
Prerequisite: A processed set of Lots created by the Lot Network routines.

Lot Network Renumber Lots

This command allows you to renumber the lot number for selected lots. The program prompts for the Starting Lot Name: where the new value can be types, such as 200 for the new starting number. It then says Pick point inside lot to start renumbering: so you would pick inside the desired lot. The routine then asks for the Next direction point for renumbering: and you must pick into the next lot to continue or cross over several lots in one pick to include all of those lots in the renumbering process.

Pulldown Menu Location: Area/Layout
Keyboard Command: lotnet_renum
Prerequisite: a lot network
File Name: \lsp\eworks.arx

Lot Network Output To Lot File

This command will develop a .LOT file containing the points to define the lots. The points are stored into the current coordinate file. The .LOT file by the collection of Lot File commands including Lot File Manager.

Pulldown Menu Location: Area/Layout
Keyboard Command: lotnet_lotfile
Prerequisite: a lot network
File Name: \lsp\eworks.arx

Set Lot File

This command sets the lot (.LOT) file name that other lot routines will automatically reference. The lot (.LOT) file stores a list of lots with each lot being a list of point numbers which reference coordinates stored in a coordinate (.CRD) file.
Design Lot

This command creates lot definitions that are stored in a lot (.LOT) file. The lots are defined by entering a sequence of point numbers. The point numbers reference coordinates from the current coordinate (.CRD) file. Each lot has a lot name and block name. The lots are not required to be closed perimeters and can also be used to represent other linework such as centerlines. Curves are entered by first specifying the PC point number, then type R for radius and enter the radius point number followed by the PT point number.

Prompts

Lot Name <1>: 105
Block Name <1>: press Enter
Lot Starting Station <0.0>: press Enter
If the figure that you are entering is a centerline, then you could use this as the starting station of the centerline.
Starting point number: 17
Point number (R-RadiusPt,U-Undo,Enter to end): 18
Point number (R-RadiusPt,U-Undo,Enter to end): 19
Point number (R-RadiusPt,U-Undo,Enter to end): R
Radius point number: 20
Use large included angle for curve (Yes/<No>)? press Enter
End of curve point number (R-RadiusPt,U-Undo,Enter to end): 21
Point number (R-RadiusPt,U-Undo,Enter to end): 22
Point number (R-RadiusPt,U-Undo,Enter to end): 17
Point number (R-RadiusPt,U-Undo,Enter to end): press Enter
Enter another lot (<Yes>/No)? N
**Pulldown Menu Location:** Area/Layout > Create Lots  
**Keyboard Command:** mklot  
**Prerequisite:** Points in a coordinate (.CRD) file  
**File Name:** \sp\cogoutil.arx

## Polyline to Lot File

This command will create lot (.LOT) files from selected polylines. The lots are defined by the series of point numbers. This command will create point numbers in the current coordinate (.CRD) file for each point in the polylines. Before creating a point number, the program will check to see if the point coordinates are already in the coordinate (.CRD) file and will use the existing point number if found. Each lot has a lot name and block name. Lots are not required to be closed perimeters and can also be used to represent other linework such as centerlines.

![Polyline To Lot File Options Dialog](image)

### Prompts

**Polyline To Lot File Options Dialog** *enter in values*

After entering in the Starting Point Number, points will be automatically numbered starting from this value.

Select lot polyline: *pick a polyline*

Select lot polyline:
Lot Name `<LOT 19>`:

Created 3 lot points.
Select lot polyline (Enter to end):
Lot Name `<LOT 20>`:

Created 3 lot points.
Select lot polyline (Enter to end):
Lot Name `<LOT 21>`:

Created 3 lot points.
Select lot polyline (Enter to end):  
Select lot polyline: *pick a polyline*

**Lot Starting Station `<0.0>`:** *press Enter*  
Lot Name `<106>`: *press Enter* This defaults to the next available name.
Block Name <1>: press Enter
Lot Starting Station <0.0>: press Enter
Created 7 lot points.
Select lot polyline (Enter to end): press Enter

Pulldown Menu Location: Area/Layout > Create Lots
Keyboard Command: pl2lot
Prerequisite: A polyline
File Name: \lsp\cogoutil.arx

Lot File by Pick Interior
This command is used to create a lot by picking a point, and having the program figure the enclosing linework.

creates lot definitions from the selected polylines and text. For each text entity, the program finds the bounding polyline around the text. The text is used as the lot name. The polylines do not need to be closed themselves but selected together they should define closed areas. Multiple lots can be created at once with this command. All the lots will have the same block name as entered and all lots will be assigned a starting station of 0.0.

The lots are defined by the series of point numbers. This command will create point numbers in the current coordinate (.CRD) file for each point in the bounding polylines. Before creating a point number, the program will check to see if the point coordinates are already in the coordinate (.CRD) file and will use the existing point number if found.

This command works well in conjunction with Draw Lot File. Once a lot (.LOT) file containing 1 or more lots is created, all lots can be redrawn automatically, with annotation, using Draw Lot File. Furthermore, since the lots are drawn from point numbers, if the point numbers for the lot corners are moved, the lots can be redrawn to the new point positions using Draw Lot File. If a point number is at the corner of four lots, moving that one point number will cause Draw Lot File to draw differently all four lots.

Prompts
Starting point number <8>: press Enter Points will be automatically numbered starting from this value.
Select lot polyline: pick a polyline
Block Name <1>: press Enter
Select lot lines, polylines and text.
Select objects: select the polylines and text
Select objects: press Enter
Created 3 lots.
Lot File by Interior Text

This command creates lot definitions from the selected polylines and text. For each text entity, the program finds the bounding polyline around the text. The text is used as the lot name. The polylines do not need to be closed themselves but selected together they should define closed areas. Multiple lots can be created at once with this command. All the lots will have the same block name as entered and all lots will be assigned a starting station of 0.0.

The lots are defined by the series of point numbers. This command will create point numbers in the current coordinate (.CRD) file for each point in the bounding polylines. Before creating a point number, the program will check to see if the point coordinates are already in the coordinate (.CRD) file and will use the existing point number if found.

This command works well in conjunction with Draw Lot File. Once a lot (.LOT) file containing 1 or more lots is created, all lots can be redrawn automatically, with annotation, using Draw Lot File. Furthermore, since the lots are drawn from point numbers, if the point numbers for the lot corners are moved, the lots can be redrawn to the new point positions using Draw Lot File. If a point number is at the corner of four lots, moving that one point number will cause Draw Lot File to draw differently all four lots.

Prompts

Starting point number <8>: press Enter Points will be automatically numbered starting from this value.
Select lot polyline: pick a polyline
Block Name <1>: press Enter
Select lot lines, polylines and text.
Select objects: select the polylines and text
Select objects: press Enter
Created 3 lots.
Lot Manager

This command combines input, edit, draw and report lot capabilities into one command.

Main Dialog

In the main dialog, there is a spreadsheet list for the lot names along with the block name, lot type and group assignment for each lot. You can edit these values directly in the spreadsheet. There are also function buttons as follows:

- **Open**: selects another Lot File to process.
- **Save**: saves the lot data to the current lot file.
- **SaveAs**: prompts for another file name to save the lot data to.
- **View**: The View options control drawing effects when you highlight lots in the spreadsheet list.
  - **Zoom Current**: zooms the display view to include the selected lot.
  - **Highlight Current**: highlights the perimeter of the selected lot as a dashed line.
  - **Hatch Current**: fills in the selected lot with a hatch.
  - **Restore View on Exit**: on leaving Lot Manager, this option sets the display to the original position before running Lot Manager.

- **Lot Selection**: Many of the functions such as Draw process only the lots that are in selected mode. You can toggle which lots are selected with the buttons in the Selection spreadsheet column. You can also use the buttons in the Selection section to select the lots to process.
  - **Select All**: marks all the lots as selected.
  - **Clear All**: unselects all the lots.
  - **Invert Selection**: flips currently selected lots to unselected status and currently unselected to selected status.
  - **Load Selection**: sets the current selection status from a .LSS file.
  - **Save Selection**: saves the current selection status to a .LSS file.

- **Add**: creates a new lot. The new lot name is automatically generated by incrementing from the highest lot name.
Remove: deletes the currently selected lots.
Copy: creates new lots as copies of the currently selected lots.
Edit Current: brings up a dialog editor for the highlighted lot (see below).
Move Up/Down: changes the order of the highlighted lot in the list.
Sort By Block: sorts the lots by block name order first and then by lot name within each block.
Sort By Lot: sorts the lots by lot name only without using the block name.
Draw: draws the selected lot perimeters and annotation (see below).
Report: reports the selected lots (see below).

Original Coordinates Utilities: has methods for tracking lot coordinate transformations of the current coordinates relative to the original coordinates.
Export: output selected lots to a new lot file as a way to make a subset lot file.

Edit

This dialog allows you to edit the lot name, block name, group, coordinate file, starting station, ending station and the point numbers that define the lot. A curve is specified by the PC, radius point and PT point numbers. The Large Arc option indicates a curve with an included angle greater than 180 degrees. The Select button allows you to specify a new name or location for the coordinate file associated with the lot.
Add: adds a new point to the lot.
Remove: removes the highlighted point from the lot.
Move Up/Down: changes the order of the highlighted point in the list.
Reverse: reverses the order of the points.
Set POB: sets the point of beginning, starting point, to the currently highlighted point.
Draw

The Draw routine allows you to draw polylines for the lot perimeters as well as annotate the lot linework and areas. **Draw Lot Polylines:** The layer for the polylines is set by the Lot Type which is defined in Define Lot Attributes. If the Lot Type is not defined, then the polyline are drawn in the current layer. **Label Lines and Arcs:** Labels the bearing, distance, and curve data using the Auto-Annotate command. See Auto-Annotate for more details. **Label Areas:** Labels the area, and optionally the name of the selected lots using the Area Settings dialog. See Area Defaults for more details. **Erase Previous Entities:** Erases lot polylines and labels from earlier runs of Draw to avoid duplicates.

Report

The Report routine has several types of reports.

**Report Areas Only:** When checked only the lot name, block name, and area are included in the report. **Report Stations:** Controls whether to report the distance along the lot perimeter. **Report Elevations:** Controls whether to report the elevation from the coordinate file for each lot point. **Report Point Descriptions:** Controls whether to report the description from the coordinate file for each lot point. **Add Page Break between Lots:** Formats the report so that each lot definition begins on a new page when printed. **Use Report Formatter:** When checked, the report is output to the Report Formatter where it can be customized as well as exported to Microsoft® Excel or Microsoft® Access. See Report Formatter in for more details. **Report Closure By:** If the Start/End Coordinates method is used, closure error distance is typically 0 (perfect closure-you end where you start). If the Angle/Distance Precision method is used, then the actual bearings and distances (computed from the coordinates) in the report are used, and due to the rounding used to present the bearings and distances, minute closure errors will occur which will be reported. **Report Precision:** Specify the decimal precision for reporting coordinates, distance and angles on the report. The precision for the areas is defined in the Area Defaults command. **Unequal Radius Tolerance:** When reporting the curve data for a lot, the two radial lengths are compared. If the difference in their length is more than this value, it is noted on the report. **Check Lot Report:** Checks that the area for all the lots assigned to a Group Block-Lot add up to the area of the area of the enclosing group lot. **Lot Report:** Creates a report using the report settings. **Legal Description Report:** Writes a legal description using the same routine as the Legal Description Writer command. See the Legal Description Writer section of the manual for more details.
Lot Report
Lot File: C:\sample\CivilDemo.lot
CRD File: C:\sample\CivilDemo.crd

LOT 55 OF BLOCK 1, TYPE: LOT
PNT# Bearing Distance Northing Easting Station
36 3374.827 4631.668 0.000
Radius: 642.845 Length: 85.660 Chord: 85.597 Delta: 07°38'05"
Chord BRG: S 60°07'05'' W Rad-In: N 33°41'58'' W Rad-Out: N 26°03'53'' W
Radius Pt: 8 3909.649,4274.994 Tangent: 42.894 Dir: Right
Tangent-In: S 56°18'02'' W Tangent-Out: S 63°56'07'' W
Non Tangential-Out
41 3332.181 4557.451 85.660
36 3374.827 4631.668 498.001
Closure Error Distance> 0.00032 Error Bearing> N 70°14'59'' E
Closure Precision> 1 in 1550913.7 Total Distance> 498.001
LOT AREA: 12950.1 SQ FT OR 0.3 ACRES

Pulldown Menu Location: Area/Layout
Keyboard Command: editlot
Prerequisite: None

Chapter 14. Area/Layout Menu
768
Lot Inspector

This command activates a small pop-up window that when you place your pointer into a lot file area, the details of that lot file will be displayed in the Lot Inspector window.

![Lot Inspector window]

Prompts

Move pointer inside lots (Pick to edit, Enter to End) *hover crosshairs above lot(s)*

Pulldown Menu Location: Area/Layout

Keyboard Command: lotinspector

Prerequisite: None

File Name: lisp\cogoutil.arx

Define Lot Attributes

This command allows the user to define the Lot Type, Lot Attributes and Point attributes. With the use of the opening Lot Attribute Definitions dialog box, shown below, this routine allows you to edit, add, remove or reposition all of these definition types. You can save the selected data to a new Lot Attribute Definition file (LTD). You are also able to load an existing LTD file to work with.

The Lot Types section of the dialog lists out the Lot Type and the layer associated with it.
You can set up different lot types and a layer. When the lots are drawn, the layer name is used per lot type. Also, Lot Types are used in the lot report. There are also Lot Attributes, which are additional fields that you can define for the lots, such as deed number. And there is also Point Attributes.

**Edit/Add:** Both the Edit and the Add buttons bring up the same Lot Type dialog, shown here. You can edit an existing lot or add a new one.

The **Lot Attributes** section asks for the Name and to enter the Data Type.

**Edit/Add:** Edit or add the name of the lot attribute. Choose from one of the four options for Data Type: Real, Integer, String or Document.

Similarly, the **Point Attributes** section also asks for the Name and to enter the Data Type.
Remove: Any of the Remove button will remove a lot type, lot attribute or point attribute from the list above it, depending upon which Remove button you use.

Up/Down (all three): Types and attributes can be repositioned.
Track Original Coordinates: This option will track the original coordinates of the lot so that this record may be kept for your future usage and needs.
Load: A Lot Attribute Definition file (LTD) can be loaded.
SaveAs: A new Lot Attribute Definition file (LTD) can be saved.

Pulldown Menu Location: Area/Layout
Keyboard Command: lotattr
Prerequisite: None
File Name: \lsp\cogoutil.arx

Import Lot File From MDB Database
This command will import a lot file from a Microsoft Access database file (.MDB) format.

Prompts

Database File to Import dialog select existing .MDB file
Lot File to Write dialog select existing or create a new .LOT file

Pulldown Menu Location: Area/Layout > Lot File Utilities
Keyboard Command: lotimport
Prerequisite: A lot (.LOT) file
File Name: \lsp\cogoutil.arx

Export Lot File to MDB Database
This Lot File Utilities command will export a lot file to a Microsoft Access database file format.

Prompts

Lot File to Export dialog select existing .LOT file
Database File to Write dialog select existing or create a new .MDB file

Pulldown Menu Location: Area/Layout > Lot File Utilities
Keyboard Command: lotexport
Prerequisite: A lot (.LOT) file
File Name: \lsp\cogoutil.arx
Export Lot File To Old SurvCADD

This Lot File Utilities command will export a Carlson lot file to SurvCADD .LOT file format.

Prompts

**Source Lot File to Export dialog** select existing .LOT file
**Destination Lot File To Write dialog** create a new .LOT file

**Pulldown Menu Location:** Area/Layout > Lot File Utilities
**Keyboard Command:** lotexport2
**Prerequisite:** A lot (.LOT) file
**File Name:** \lsp\cogoutil.arx

Set CRD File for Lot Files

This command allows you to set the coordinate (.CRD) file that is associated with any number of lot (.LOT) files. This can be useful if the name or location of the coordinate (.CRD) file is changed. In the Set CRD for Multiple Lots dialog, press the Select .LOT files button to select any number of lot (.LOT) files. They are added to the list. Next, press the Select .CRD file button. After you have selected the files, press the Process button.

**Pulldown Menu Location:** Area/Layout > Lot File Utilities
**Keyboard Command:** lotscrd
**Prerequisite:** Existing lot (.LOT) file(s)
**File Name:** \lsp\lotscrd.lsp

Lot File to Centerline

This command creates a centerline (.CL) file from a lot (.LOT) file. Since the lot definitions contain a series of points and a starting station, the lot (.LOT) file contains the necessary data to create a centerline. The Select Lot to Convert dialog lists the available lot names in the current lot (.LOT) file. Select a single lot to process, then specify
the centerline (.CL) file name to create.

**Prompts**

**Centerline File to Write dialog** enter new centerline (.CL) file name
**Select Lot to Convert dialog** select a lot from the list

**Pulldown Menu Location:** Area/Layout > Lot File Utilities
**Keyboard Command:** lot2cl
**Prerequisite:** None
**File Name:** \lsp\cogoutil.arx
Annotate Menu

These menus include commands for labeling lines with bearing/azimuth and distances, special lines, coordinates, curves, curve tables and line tables. The precision of labeled distances and coordinates are set and controlled with the Annotate Defaults command.
Annotation Defaults

This command sets the defaults for the annotation menus and controls the way various annotation commands work. Some of these defaults can be changed globally by running Configure command, which changes the file COGO.INI so that every time you start Carlson, the new defaults are set. When this menu option is selected the Annotate Defaults dialog appears.

This dialog is broken into 5 tabs: General, Angle, Distance, Serial Lines and Parallel Lines.

General Tab:

This tab is used for settings that apply to all annotation types.

- **Horizontal Scale:** This is the horizontal scale for the current drawing. This value can also be set by using the Drawing Setup command on the Settings menu.

- **Text Size Scaler:** This value is multiplied by the horizontal scale value to set the text size units.

- **Text Offset Scaler:** This value multiplied by the horizontal scale defines the distance that an annotation label is placed from its defining line.

- **Line Type Spacing:** Specifies the distance between the symbols on special line types.

---

**Chapter 15. Annotate Menu** 775
**Line Type Text Scaler:** This value multiplied by the horizontal scale specifies the size of the symbols of special line types.

**Arc Length Label:** Specifies the prefix label for arc length labels.

**Arc Text Spacing Factor:** This variable controls how close letters will be spaced when labeling arcs. The lower the number, the closer the spacing. The higher, the farther apart. (The suggested range between 0.8 and 1.5)

**Use MText:** This option creates the labels as MText instead of standard Text entities.

**Label Flip Tolerance (degrees):** Gives extra tolerance for label flipping for readability. Labels draw in the north-west quadrant that are within this number of degrees to due-north will be drawn upside down.

**Previous Labels:** Specifies if previous labels for the for the set of linework being annotated are kept or deleted. Setting values are Retain, Erase, Prompt Before Erasing.

**Draw Leaders to Endpoints on Lines:** This option creates leader lines (crow's feet) between the distance annotation and the line segment endpoints as shown below. These leaders are used to help identify the endpoints that were used to create the distance label.

**Distance Labels Only:** When checked, leaders will not be drawn unless the label includes a distance.

**Leader Size Scaler:** This option determines the maximum length for leaders. The size in drawing units will be the Leader Size Scaler multiplied by the Horizontal Scale (for example, 0.5x50=25). If the line segment is too short, the leader is shortened to fit.

**Offset Scaler:** This option controls the distance between the line endpoints and the leader endpoints.

**Leader Style:** This option determines which of the five styles of endpoint leaders to use. The five styles are: Arrow-Arc, Arc-Arrow, Arc-Only, Dash-Dot and Dashed.

**Leader Layer:** This option determines the layer for drawing the leader.

**Draw Leaders to Endpoints on Arcs:** This option creates leader lines (crow's feet) between the arc segment endpoints as shown below. These leaders are used to help identify the endpoints that were used to create the arc label.
Leader Size Scaler: This option determines the maximum length for leaders. The size in drawing units will be the Leader Size Scaler multiplied by the Horizontal Scale (for example, 0.5x50=25). If the arc segment is too short, the leader is shortened to fit.

Offset Scaler: This option controls the distance between the arc endpoints and the leader endpoints.

Leader Style: This option determines which of the five styles of endpoint leaders to use. The five styles are: Arrow-Arc, Arc-Arrow, Arc-Only, Dash-Dot and Dashed.

Leader Layer: This option determines the layer for drawing the leader.

Report Delta Angle as 1/2 Actual Angle: The angle value in the label will be 1/2 the actual angle.

Angle Tab:

This tab is for settings that apply to angle labels:
**Angle Layer:** This specifies the layer to be used for angle labels.

**Angle Text Style:** This specifies the text style to be used for angle labels.

**Bearing Prefix and Suffix:** Specifies the prefix and suffix text for azimuth labels.

**Azimuth Prefix and Suffix:** Specifies the prefix and suffix text for azimuth labels.

**Bearing Annotation Precision:** Specify the display precision for bearing labels.

**Angle Separator:** Choices are Symbol, Hyphen, Space, Other. When Other is chosen the Deg. Min. and Sec. fields are enable to allow the user to enter custom angle separators.

**Bearing Direction Method:** Choose the orientation of the bearing. This controls how lines selected for bearing or azimuth annotations will be referenced.

**Toward Picked End:** If this option is chosen, the line will be labeled in the direction of the endpoint that is closest to the point where you selected the line.

**Away from Picked End:** This labels the line in the direction away from the closest endpoint.

**North Only:** This option controls whether bearing annotations will always be labeled in the north quadrants (NE or NW) and never in the south quadrants.

**East Only:** This option controls whether bearing annotations will always be labeled in the east quadrants (NE or SE) and never in the west quadrants.
**By Linework:** This option labels the line in the direction that the line was drawn.

**Strip Spaces in Bearing Labels:** This option causes the spaces in bearing labels to be removed.

**Add Spaces in Bearing Labels:** This option puts spaces between the degree, minutes, and seconds numbers.

**Strip Zero Minutes and Seconds:** This option shortens the label by dropping either seconds and or minutes and seconds when they are equal to zero.

**Label Cardinal Angles by Name:** When checked, the user is allowed to enter the labels that will be used for each of the four cardinal angles.

**Draw Bearing Leaders:** This option creates a direction arrow with the bearing annotation as shown below.

```
N 87°06'01" E
```

**Position Leaders To Side:** This option draws the bearing leader to the right side of the bearing label. Otherwise the leader is drawn above the label.

**Distance Tab:**

This tab is for settings that apply to distance labels:
**Distance Layer:** This specifies the layer to be used for distance labels.

**Distance Text Style:** This specifies the text style to be used for distance labels.

**Distance Suffix:** This specifies the suffix that is appended to distance annotations.

**Dist. Units:** This specifies the units used for distance labels. Choices are Decimal, "Feet and Inches" and Both. Decimals is used to set the number of decimal places in decimal based distance labels. Dist. In Inches is used to control the precision of the fractional portion of the inch label, from 1/2 to 1/256th of an inch.

**2nd Scaled Distance Options:** This option labels determines if a 2nd scaled distance is included in distance labels. This 2nd distance is scaled by the Report Scale Factor set in the Drawing Setup dialog. Choices for this option are "Label 1st Only" (label distances in current drawing units only), "Label 1st and 2nd" (label distances in both current drawing units and scaled by the Report Scale Factor) and "Label 2nd Only" (label distances scaled by the Report Scale Factor Only).

**Decimals:** This option sets the number of decimal places for the second scaled distance label.

**Label:** This variable will be assigned as a suffix to the second scaled distance label.
**Use Brackets:** This labels the second scaled distance value inside [brackets].

**Drop Trailing Zeros in Distances:** This option allows you to drop trailing zeros on distance labels.

**Series Lines Tab:**

This tab is for settings that apply to Series Lines labels (See the section "Auto Annotate" for a detailed description of series line handling).

**Text Size Scaler:** This value is multiplied by the horizontal scale value to set the text size units for serial lines.

**Text Offset Scaler:** This value multiplied by the horizontal scale defines the distance that an annotation label is placed from its defining line for serial lines.

**Angle Layer:** This specifies the layer to be used for angle labels on serial lines.

**Angle Text Style:** This specifies the text style to be used for angle labels on serial lines.

**Distance Layer:** This specifies the layer to be used for distance labels on serial lines.
**Distance Text Style:** This specifies the text style to be used for distance labels on serial lines.

**Parallel Lines Tab:**

This tab is for settings that apply to Parallel Lines labels (See the section "Auto Annotate" for a detailed description of parallel line handling).

![Annotate Defaults Dialog](image)

**Text Size Scaler:** This value is multiplied by the horizontal scale value to set the text size units for parallel lines.

**Text Offset Scaler:** This value multiplied by the horizontal scale defines the distance that an annotation label is placed from its defining line for parallel lines.

**Angle Layer:** This specifies the layer to be used for angle labels on parallel lines.

**Angle Text Style:** This specifies the text style to be used for angle labels on parallel lines.

**Load/Save:** Choose these options to load an existing annotation defaults file (.ADF) or save a new one, which will contain your current selections.

**Pulldown Menu Location:** Annotate

**Keyboard Command:** LDEF
Auto Annotate

This command allows you to select a group of lines, arcs and/or polylines to be labeled. It allows for any combination of line and distance labeling, and also any combination of arc labeling.

You can position the features of the labels, once in the Auto-Annate dialog, by using the Row, Side, Order, Orientation and Position Types options, all found under Lines tab. For Arcs, you can select the Arcs tab and determine the type of auto-annotating you would prefer for arc entities. As you select different options, you can see the changes in the preview display of the entry dialog. You will select the Angle Format in terms of Bearing, Azimuths and Gons and there is an important feature that allows you to avoid label overlaps. This is done by applying specific, user-defined settings. When labeling arcs, there are options to set the label prefixes for curve annotation. The Settings button will bring you to the Annotation Defaults dialog, as explained in a previous section. Defaults will restore the prior settings.

Apply Label Settings by Layer brings up another dialog box which allows you to import from file, or load, predetermined configurations. There is an option to have different label settings applied by layer. Apply Label Settings By Layer allows you to set, load, and save your preferred variables.

The Avoid Label Overlap option can bring up a special dialog called the Overlap Manager. This screen, which contains extra tools for, as an example, sliding or stacking the labels that are overlapping and conflicting with drawing entities, gives you the real-time ability to move along the plan and make your corrections. This also will help you to avoid overlapping with other labels, text, symbols and linework – including fence and utility lines. In this Overlap Manager, docked on the left side of the screen, it is recommended that you use the Back and Next button frequently in order to review, adjust and correct your drawing.

Auto-Annate dialog starts with the Lines (tab).
Angle/Distance: Allows you to enter the what row the Angle label is on, what side and the order of the label on the linework. The same applies for Distance labels. Notice the preview display changing.

Row: Using numbers (1 or 2), or choosing None, you can determine the order and appearance of the descriptions. Note the change in the preview display.

Side: Choose inside or outside of the line.

Order: If you determine that the annotations are to be on the same row and same side of the line, then you must pick the order in which they will appear, from left to right.

Orientation: This offers this choice between parallel or perpendicular with regards to the labels' orientation to the line being labeled.

Justification: This option gives the ability to left or right justify labels at ends of line or center justify the labels.

Position Types: Determined how each label is placed in relationship to the line and the other label.

Angle Format: Bearing, azimuths or gons are the choices.

Combine Common Angles: This allows the user to reduce label clutter by minimizing labelling of serial and parallel linework. Choices are Off, Serias, Parallel and "Serias and Parallel". Serias common angles are those where serially connected linework share the same angle. Common serias angles are labelled at the mid-point of the serias of connected line segments. When series common angles are selected they may be drawn stacked on the same side as the distance labels or on the opposite side from the distance labels. Also, for serial common angles the total distance may be included in the label. Parallel common angles are those where adjacent areas share parallel lines that include the line that bisects the areas. In this case, only the outer-most lines of the set of parallel lines will be labelled with the angle.

The common angle labels have separate settings for layer, style, size and offset. Please see the section "Anote Defaults" for information on how to control these settings.

The following example shows the results of combining common serial labels, including totalling of the distances:
The following example shows the results of combining common serial and parallel labels:

**Compress Labels for Short Lines:** When angle and distance labels are being placed on the same side and row, this feature allows the user to place the label on different rows in the case that the label will not fit on the line otherwise. The options are Off, "Angle Above, Distance Below", "Distance Above, Angle Below", "Stacked Angle-Distance" and "Stacked Distance-Angle".

**Add Space Between Angle and Distance Labels:** When angle and distance labels are being placed on the same side and row, this feature allows the user to have the angle and distance labels spread apart from each other as allowed by the length of the line being annotated.

**Use Line Tables:** Line tables are sometimes preferred as they keep the drawing linework clean and free of labeling. Choices are Always, Never or By Scaler. If By Scalar is chosen "To Line Table Scaler" is enabled.

**To Line Table Scaler:** If the length of the line is less than this minimum, the line is labeled as a line table entry. The To Line Table Scaler is relative to the current horizontal scale and represents the length of the line in plotted inches.

**Starting Table Number:** User choice. You might change this because perhaps you have another group of line labels, in table form, in the drawing. Line table entries are numbered sequentially beginning at the line Starting Table Number. The location for the line table can be picked if there is no current table. Otherwise, Auto Annotate will add to the end of the current line table. To set the location for the current line table, run the Table Header command in the Annotate > Line/Curve Table menu.
Auto-Annotate dialog box, by selecting the Arcs tab, displays the options for auto-annotating arcs. The columns are described, followed by the rest of the options.

Label: Here you might alter slightly the defaults by entering a letter or acronym that will represent to type of calculation. Or you could leave it alone.
Row: Using numbers, or choosing None, you can determine the order of the descriptions, and determine whether or not some might be left off altogether.
Side: Choose inside or outside of the arc.
Order: If you determine that the annotations are to be on the same row and same side of the curve, then you must pick the order in which they will appear, from left to right.
Label Chord Angles in: Bearing, azimuths or gons are the choices.
Type of Curve: Choose between Road and Rail.
Flip Text on Arcs that Open to the North: Clicking here might make for a easier to read finished plan. User preference.
Use Symbol for Delta Angle Label: The popular and traditional triangle-shaped symbol can be used, instead of the letter D, or any other letter(s).
Combine Common Radii: This allows the user to reduce label clutter by minimizing labelling of connected arc segments that share a common radius and center point. When selected, only one radius label will be generated for such arc segments. The following shows an example where a curve made of three arc segments is labelled with only one radius label. The radius label is placed offset to the mid-point of the combined arcs.
Use Arc Tables: Curve tables are sometimes preferred as they keep the drawing linework clean and free of labeling. Choices are Always, Never or By Scaler. If By Scalar is chosen “To Curve Table Scaler” is enabled.

To Curve Table Scaler: The To Curve Table Scaler applies when the Type of Arc label options is not set to Curve Table. If the length of the arc is less than this minimum, the arc is labeled as a curve table entry. The To Curve Table Scaler is relative to the current horizontal scale and represents the length of the arc in plotted inches.

Starting Table Number: The Starting Table Number is the starting number for the first line entered in the Curve Table. Curve Table entries are numbered sequentially from the curve Starting Table Number. The location for Curve Tables can be picked if there is no current table. Otherwise, Auto Annotate will add to the end of the current Curve Table. To set the location for the current Curve Table, run the Table Header command in the Annotate > Line/Curve Table menu.

Stack Labels: Stacked labels are sometimes preferred as they can help reduce label overlapping. Choices are Always, Never or By Scaler. If By Scalar is chosen “To Stack Scaler” is enabled.

To Stack Scaler: When Stack Labels is set to "To Stack Scaler" this control is enabled. If the length of the arc is less than this minimum, the arc is labeled as a stacked label. The To Stack Scaler is relative to the current horizontal scale and represents the length of the arc in plotted inches. The Stack Settings button is enabled when Stack Labels is set to Always or By Scaler. This button brings up the Stack Arc Labels which displays the options for creating stacked arcs labels. The columns are described, followed by the rest of the options.
**Label**: Here you might alter slightly the defaults by entering a letter or acronym that will represent to type of calculation. Or you could leave it alone.

**Row**: Using numbers, or choosing None, you can determine the order of the labels, and determine whether or not some might be left off altogether.

**Label Chord Angles in**: Bearing, azimuths or gons are the choices.

**Side**: Choose inside or outside of the arc.

**Type of Curve**: Choose between Road and Rail.

**Flip Text on Arcs that Open to the North**: Clicking here might make for a easier to read finished plan. User preference.

**Use Symbol for Delta Angle Label**: The popular and traditional triangle-shaped symbol can be used, instead of the letter D, or any other letter(s).

**Draw Leader for Stacked Labels**: When checked, a leader will be drawn from the stacked label to the mid-point of the arc.

**Stack Label Offset**: This value multiplied by the horizontal scale defines the distance that an annotation label is placed from its defining arc.

**Align Text With Chord**: Determine whether the stacked label is oriented horizontally (unchecked) or in the direction of the chord (checked).

Auto-Annotate dialog commands, common to both Lines and Arcs.

**Apply Label Settings By Layer**: See the Label By Label Settings dialog and details below.

**Avoid Label Overlap**: See dialog and details below.

**General Settings**: Brings you to the Atte Defaults dialog.

**Layer Settings**: Apply Label Settings By Layer option must be clicked in order to activate. You will then see the Label By Layer Settings dialog.

**Overlap Settings**: Avoid Label Overlap option must be clicked in order to activate. Brings up the Avoid Label Overlap dialog.

**Reset to Defaults**: This returns you to the default label values.
**Load**: You can load an existing .AAN file.

We will now say, for example, that with linework only to label in the drawing we run this routine. We first decide to go without the Avoid Label Overlap feature. This can be done by unclicking this option in the Auto-Annotate dialog. We will say that there is a fence line cutting through our property line, the property lines being the lines that we want to auto-annotate. In going without Auto Annotate's overlap protection, we perform Auto Annotate and we see that there is an overlap, with the labels running into the property lines and the fence line.

Panning and zooming the screen shows the problems we confront. Now, run Auto annotate again, but this time click ON the Avoid Label Overlap feature. Then click Overlap Settings button which brings up a dialog as shown below. This program and this specific dialog box has many different methods for fixing the overlaps. We will choose the different methods to apply.

First, we will choose Slide. This slides the labels along the linework. We can even choose a maximum amount of slide and other related parameters. We will also turn on the Stack method. The Avoid Linework Conflicts feature pertains to that fence line we have. Finally, click OK. Now can pick the linework. Note that you do not need to erase the existing auto annotate labels ahead of time. This command will remember that those labels were created with this command. It will simply replace the entire group of labels with the new auto annotate labels.

The result, with overlap detection on, is that this routine fixed 7 out of 7 of the conflicts. It slid some of the labels over and stacked others. You can also run Auto Annotate Overlap with manual mode. To do this, remove the automatic options (such as Stack, Slide, etc.) and click View Remaining Overlaps After Applying Rules ON. Say OK. It docks the Overlap Manager on the left side of the screen.

You can then fix the conflicts with this Overlap Manager by using the different methods presented in this new window. This manager will highlights the conflicts, it will, for example, slide to the next conflict and allow you to pick a new position. Hit the Next several times. Again, stack one, slide another over, and perform other changes. Then choose Close.

Also, remember that depending on the linework layer, you can even have different annotation styles. There is also an option to have different label settings "by layer". These decisions are made by using the Label By Layer Settings dialog options. To get to this dialog, click on the Layer Settings button at the bottom of the Auto-Annotate dialog.

**Label By Layer Settings option and dialog.**

**Layer**: Select a layer from the existing list of layers. If the linework you select and to be labeled is on this layer, the parameters that you set in this dialog will be reflected in all labels.

**Auto-Annotation Settings**: Select an existing Annotation Settings file (AAN) by clicking the File button on the right. Or stick with the defaults.

**Auto-Defaults Settings**: Select an existing Default Settings File (ADF) by clicking the File button on the right. Or stick with the defaults.
Load: Select this option in order to load an existing layer file (LAY) to load.

Avoid Label Overlap option and dialog.

Available Methods: Your choices. Pick from these.

Used Methods: Different ways in which this routine attempts to resolve the label overlaps. The overlap resolution attempt methods are applied in the order listed here.

Slide: If this is selected then the labels will be moved parallel to your linework until they do not overlap. The labels will not move past the end of the linework or the Max Slide which you determine.

Offset: will move your labels perpendicular to your linework as far as you set the Max Offset.

Table: Replaces your labels with a numbers and create a table of the numbers with the corresponding labels.

Reorient: If chosen, the labels will change orientation in the plain view to avoid overlapping.

Flip: It will flip your label onto the other side of the linework.

Stack: It will stack or unstack the text of your labels to avoid overlapping.

Move Area Labels: This method, which only applies to area labels, will attempt to move the area label to the closest place within the area that doesn't overlap with any other labels. You can control the move interval (distance between move attempts) and total number of move attempts by setting the values "Interval (multiples of text height)" and "Max Move Attempts" in the "Move Area Labels Parameter" section:

You can use any combination of these commands by using the add/remove button. You can also determine the order in which the command tries a method by using the Move Up and Move Down buttons. If a solution is not found by using the first method then the next method is used in descending order.

Add/Remove: Some methods you might prefer not to use.

Slide/Offset Parameter (multiples of text height): These are variable that help you to slide or offset the label(s) in question.

View Remaining Overlaps After Applying Rules: This option will help you to see what still needs treatment.

Overlap Settings dialog
**View Last Overlap File:** When it is checked, the Overlap Manager will return to the previous labels that were under review.

**Skip Resolved Overlaps:** When it is unchecked, the Overlap Manager will display all the labels that were moved by the command as a final check to you.

**Restore Original Zoom:** This will restore the zoom you were previously at before running the command.

**Avoid Linework Conflicts:** This is an extra precaution for when linework conflicts exist.

If there is a conflict, the following Overlap Manager dialog appears on the screen. It zooms to the conflict and provides you with the necessary tools to resolve the issues that need to be addressed. Many of the choices selected in the earlier dialog boxes can be modified yet again in the Overlap Manager, in your quest for a clean looking drawing. Within this special window you can zoom, pan, move to the next conflict, and perform many other tasks.

The **Overlap Manager** screen appears as a docked dialog window to the left of the main screen.

The Overlap Manager can be used to manually check and change label overlaps. The current overlap item will be have a yellow box drawn around it to help make it clear which item is the one currently being worked on. If you check on "View Remaining Overlaps After Applying Rules" then any remaining overlaps will be zoomed in on and you will have the ability with the Overlap Manager to flip through and fix or ignore the unresolved labels. When the current overlap item is an area label, only the Move and Table button will be enabled as these are the only two manual methods that can be applied to these types of labels. For line and curve labels, all methods will be enabled.

**Prompts**

**Auto Annotate Dialog** Choose settings and click OK.
Select Lines, Arcs, and/or Polylines to Annotate.
**Select Objects:** pick entities. Select the group of lines, arcs and/or polylines you want to annotate.

**Pulldown Menu Location:** Annotate

**Keyboard Command:** autoann

**Prerequisite:** Lines, arcs or polylines to annotate

**File Name:** \lsp\crdutil.arx

### Custom Label Formatter AD

This command allows you to customize the labeling for lines and polylines. You are first prompted to select a line or polyline to label, given the existing defaults currently set. The linework is shown as labeled on the screen. The command line, shown below, also offers you an important choice called Options. When you type 'O' for options the below dialog box appears. In this dialog, there are three columns at the top of the dialog, along with other features. On the command line, there is also a choice called Format (F), which allows you to enter quick-key style keywords for quickly changing the label format. See below for these

![Custom Label Formater AD dialog box](image)

**Row:** This column allows you to stack the data in different ways. You can place more than one item in the same row. If *None* is selected, then that item will not be displayed.

**Side:** This column allows you to place each item either inside or outside of the line or polyline.

**Order:** This column determines the order of items when they are placed in the same row.

**General Settings:** This button brings you to the Annotate Defaults dialog, see 'Annotate Defaults' for more.

**Reset To Defaults:** This button restores the default settings shown above.

**Load/Save:** You may also Load and Save different label configurations with the corresponding buttons.

### Prompts
Options/Format/Points/<Select line or polyline>: select entity
Options/Format/Points/<Select line or polyline>: O
Custom Line Label dialog choose your preferences and click OK
You can decide to go into the Option dialog at the start of the command, or after your initial labeling. If you use the Format command line option, you will be asked to enter the Format command. The choices are:

B = bearing
A = azimuth
G = gon
D = distance
R = next row
_ = switch side of line

Pulldown Menu Location: Annotate > Angle/Distance
Keyboard Command: annline
Prerequisite: An arc to label
File Name: \lsp\crdutil.arx

**Draw End Point Leaders**

These three commands draw a pair of leaders (crow's feet) at the ends of the line or polyline segment. The segment can be selected from a line, polyline or pair of points. The leaders are drawn above or below the line or polyline, or you can pick a side, depending on which Endpoint Leader command is run. The Pick Side command gives you the ability to place the crow's feet on a selected side of the line or polyline. Controls to customize the look of the endpoint leaders are accessed through the Annotate Defaults command in the Annotate menu. The Leader Size Scaler determines the maximum length of the leader. If the line segment is too short, the leader is shortened to fit. The actual length of the leader in drawing units is calculated by multiplying the leader scaler by the drawing horizontal scale (i.e., 0.5*40=20). The Offset Scaler sets the distance that the leader head is off the line endpoint. There are four leader styles to choose from: Arc with Arrow, Arc Only, Dash-Dot-Dash and Dashed. Endpoint leaders can be drawn together with bearing/distance annotation by having the Draw Leaders to Endpoints option on under Annotate Defaults. This Draw End Point Leaders command allows you to add the leaders as another step.

<table>
<thead>
<tr>
<th>Pick Side</th>
<th>Above Line</th>
<th>Below Line</th>
</tr>
</thead>
</table>

**Prompts**

**Define line by [Points/<select line or polyline>]: Select a line or polyline.**
If you wish to define by points, enter "P" at this prompt and pick points on the screen, or type in point numbers. If a coordinate (.CRD) file has not been previously loaded, a dialog will open to allow you to select a coordinate (.CRD) file to process. While using the Point selection method, the last point picked in the selection is stored in default brackets. So if you are working around a boundary, simply press enter to accept the defaults for the first point and move ahead to the next point.
Dynamic Annotation Note

Bearing and distance annotations can be linked to the linework, such that the annotations will automatically update if the linework is changed. For example, if a line is moved with the AutoCAD Move command, the bearing label will update. This link can be found, and toggled on and off, under Object Linking in Configure > General Settings. Configure is in the Settings menu. The link is established between the label and the line, or polyline, when the label is created by commands such as Auto Annotate, Line Table or Bearing Distance. There are no links for annotation created using the Points option. To update bearing annotation without using the dynamic annotation, use the Global Reannotate command in the Annotate menu. To remove the links between the annotation and the linework entities, use the Remove Reactors command, found under File > Drawing Utilities.
Switch Bearing/Azimuth Quadrant

This command switches the Bearing quadrant label or adds 180° to an Azimuth label. For example, N90°32'16"E would be replaced with S90°32'16"W or AZ 78°17'18" would be replaced with AZ 258°17'18". This routine changes bearing text to read as if the bearing were in the opposite direction.

Prompts

Pick Bearing or Azimuth Text: *pick text*
Pick Bearing or Azimuth Text: *press Enter to end*

Examples of switch bearing/azimuth quadrant

Pulldown Menu Location: Annotate > Flip Labels
Keyboard Command: brgquad
Prerequisite: bearing or azimuth label
File Name: \lsp\scogo1.lsp

Mirror Selected Labels

This command rotates a group of text 180 degrees and maintains the same text position. Use this command to rotate any text. Ignores all entities in the selection set except text.

Before Mirror Labels

After Mirror Labels

Pulldown Menu Location: Annotate > Flip Labels
Keyboard Command: flipset
Prerequisite: Text to rotate
File Name: \lsp\flipset.lsp
Mirror and Flip Selected Labels

This command mirrors the label to the other side of the labeled segment. At the new location, it then flips the label back to its original orientation. Use this command to manipulate any text. It ignores all entities in the selection set except text.

Before Mirror & Flip Labels

After Mirror & Flip Labels

**Pulldown Menu Location:** Annotate > Flip Labels >

**Keyboard Command:** MFLIP_LABELS

**Prerequisite:** Text to rotate

Flip Last Label

This command flips the last text drawn 180 degrees. Use this command to rotate your last annotation.

**Pulldown Menu Location:** Annotate > Flip Labels

**Keyboard Command:** flip

**Prerequisite:** Text to flip

**File Name:** \lsp\flip.lsp
Flip Selected Labels

This command rotates a group of text 180 degrees. Use this command to rotate any text. The command ignores all entities in the selection set except text.

Flip On/Off

When activated, the bearing and distance text will be rotated 180 degrees when drawn.

Move Label with Leader

This command allows the user to make a leader label out of a selected angle/distance label.

Prompts:

Select Label to Move (O for Options, R for Restore): pick an angle or distance label.
Pick end point for move: pick the end point of the move (end of leader).
Select another Label to Move (O for Options, R for Restore, Enter to End): pick another angle or distance label if desired.
Before Move

While moving the label, the user is shown where the leader and label will be drawn.
After Move is Completed

Select Label to Move (O for Options, R for Restore): O
When Options is chosen the "Move Label With Leader Options" dialog allows the user to customize the leader and label drawing settings:

**Move Label With Leader Options**

- **Minimum Leader Length Scaler**: If the distance of the move is less than this value, a leader will not be drawn.
- **Draw Horizontal Leader Tick**: When checked, a horizontal leader tick will be drawn from the end of the leader towards the annotation.
- **Leader Offset Scaler**: This is used to set the distance from the end of the leader and the annotation.
- **Use Separate Leader Layer**: This allows the user to place the leader on a separate layer from the annotation.
- **Align Label to Linework**: When selected the orientation of the label will be parallel to the linework. Otherwise the

**Chapter 15. Annotate Menu**
label is oriented horizontally.
NOTE: The leader scaler units (Minimum Leader Length Scaler and Leader Offset Scaler) are multiplied by the current horizontal scale value, which was set in the auto annotation dialog.

Select Label to Move (O for Options, R for Restore): R
Select Label to Restore: pick an angle or distance label that had been moved with the "Move with Leader" command previously. The selected label will be restored to its previous state.

Pulldown Menu Location: Annotate > Annotate with Leader
Keyboard Command: annlead
Prerequisite: Angle or distance label to move.

**Bearing with Leader**

This command places the bearing of a line or polyline segment at a point, then plots a user specified leader line to point to the defining line or polyline. There is the ability for multi-segment leaders, and the option to align the label horizontal to the current view or parallel to the linework.

**Prompts**

Options/Points/<Select line or polyline>: select entity
Pick point to start leader: pick a point near the entity
Label Position: pick a point/Select the point where to place the label.
Options/Points/<Select line or polyline>: O

When Options (O) is chosen

Pulldown Menu Location: Annotate > Annotate with Leader
Keyboard Command: bglead
Prerequisite: None
File Name: lsp\bglead.lsp
Distance with Leader

This command labels the distance of a line or polyline segment at a point then draws a user specified leader line to point to the defining line. There is the ability for multi-segment leaders, and the option to align the label horizontal to the current view or parallel to the linework.

Prompts

Define distance by, Points/<Select line or polyline>: select a line
Pick point to start leader: pick a point near the line
Label Position: pick a point
Define distance by, Points/<select line or polyline>: press Enter to end

Bearing-Distance with Leader

This command places the bearing and distance of a line or polyline at a point and then plots a user specified leader line which points to the defining line or polyline. There is the ability for multi-segment leaders and the option to align the label horizontal to the current view or parallel to the linework.

Prompts

Options/Points/<Select line or polyline>: select entity
Pick point to start leader: pick a point near the entity
Label Position: pick a point
Select the point where to place the label.
Options/Points/<Select line or polyline>: O
Azimuth-Distance with Leader

This command places the azimuth and distance label of a line or polyline at a point, and then plots a user specified leader line which points to the defining line or polyline. There is the ability for multi-segment leaders and the option to align the label horizontal to the current view or parallel to the linework.

Prompts

Options/Points/<Select line or polyline>: pick entity
Pick point to start leader: pick point
Label Position: pick location
Options/Points/<Select line or polyline>: O
Label Leader Settings dialog make selection

When Options (O) is chosen

Pulldown Menu Location: Annotate > Annotate with Leader
Keyboard Command: azilead
Fix Label Overlaps

This command allows you to fix label overlaps, where a conflict exists, for lines, arcs and polylines. You are immediately taken to the Avoid Label Overlap dialog. Here you can realign your labels by using a variety of optional methods. When the setting are to your liking, click OK. The command line then prompts you to select the entities for which to resolve annotation conflicts. Once you have selected your entities and hit Enter, this routine finds the conflicts and fixes the label overlaps.

If Slide is selected then the labels will be moved parallel to your linework until they do not overlap. The labels will not move past the end of the linework or the Max Slide which you determine.

Offset will move your labels perpendicular to your linework as far as you set the Max Offset.

Table will replace your labels with a numbers and create a table of the numbers with the corresponding labels.

If Reorient is selected then the labels will change orientation in the plain view to avoid overlapping.

Flip will flip your label onto the other side of the linework.

Stack will stack or unstack the text of your labels to avoid overlapping.

Move Area Labels will attempt move overlapping area labels to the closest place to the oringial position that does not overlap with other labels. The distance between move attemps and the number of move attempts is controlled.
by the Interval and Max Move Attempts settings of the Move Area Labels Parameter section.

You can use any combination of these commands by using the add/remove button. You can also determine the order in which the command tries a method by using the Move Up and Move Down buttons. If a solution is not found by using the first method then the next method is used in descending order.

The Overlap Manager can be used to manually check and change label overlaps. If you check on "View Remaining Overlaps After Applying Rules" then any remaining overlaps will be zoomed in on and you will have the ability with the Overlap Manager to step through and fix or ignore the unresolved labels. When the current overlap item is an area label, only table and move buttons will be enabled as these are the only methods that apply. For line and curve label overlaps, the buttons for all methods will be enabled. Once a label is moved with the "Move with Leader", only Table, Default and "Move with Leader" will be enabled. The Default button can be used to restore the label back to its original state.

When View Last Overlap File is checked, the Overlap Manager will return to the previous labels that were under review.

When Skip Resolved Overlaps is unchecked, the Overlap Manager will display all the labels that were moved by the command as a final check to you.

Restore Original Zoom will restore the zoom you were previously at before running the command.

![Overlap Manager](image)

Prompts

Select Lines, Arcs, and/or Polylines for which to resolve annotation conflicts:

Select objects: select entities
Global Reannotate

This command updates bearing and/or azimuth labels for when the lines and polylines associated with the labels have been rotated after the bearings and/or azimuths were labeled.

Prompts

Select One Bearing/Azimuth Text Before Rotation:  *pick a bearing or azimuth label*
Pick line associated with old bearing/azimuth:  *pick the line or polyline for the selected label*
Select All or specific objects to reannotate (<All/Objects)?  *press Enter to update all text*

Survey Text Defaults

This dialog box routine sets up the defaults for the Building Dimensions, Offset Dimensions and Adjoiner Text commands.
**Building Dimensions** allows you to set text specifications for building dimensions.

- **Layer:** Allows you to set the layer for the building text.
- **Text Style:** Allows you to set the text style for the building text.
- **Text Size Scaler:** This value multiplied by the horizontal scale determines the actual text size.
- **Decimal Places:** Allows you to set the display precision for the building dimensions.
- **Drop Trailing Zeros:** Allows you to truncate trailing zeros from dimensions.
- **Characters To Append:** Allows you to set characters to add to reported dimensions.
- **Offset From Line:** Allows you to set the offset distance from the line to the dimension text.
- **Auto Label Closed Pline:** allows you to choose between automatically labeling the Interior or Exterior or closed polylines. You may also choose none.

**Offset Dimension Text** allows you to set text specifications for offset dimensions.

- **Layer:** This option allows you to set the layer for the offset text.
- **Text Style:** This option allows you to set the text style for the offset text.
- **Text Size Scaler:** This value multiplied by the horizontal scale determines the actual text size.
- **Arrow Size Scaler:** This option allows you to set the arrow scaler to determine arrowhead size.
- **Decimal Places:** This option allows you to set the precision for the offset dimensions.
- **Drop Trailing Zeros:** This option allows you to truncate trailing zeros from dimensions.
- **Label as Feet and Inches:** This option allows you to use feet and inches.
- **Characters To Append:** This options allows you to set characters to add to reported dimensions.
- **Offset From Line:** This option allows you to set the offset distance from the line to the dimension text.
- **Text Alignment** allows you to align text either parallel to the line or horizontally in the drawing.
- **Position** allows you to determine if you are to pick the location of the text, or if the text is automatically positioned in the drawing.

**Adjoiner Text** allows you to set text specifications for adjoiner text.

- **Layer:** Allows you to set the layer for the adjoiner text.
- **Text Style:** Allows you to set the text style for the adjoiner text.
- **Text Size Scaler:** Allows you to set the text scaler to determine text size.
- **Justification:** Allows you to set the text justification. See the AutoCAD Reference Manual for details on each justification choice.

**Dimension Line Type** allows you to determine the line style to use for dimensions.

- **Single Arrow Line:** Draws a line with an arrowhead from the dimension text to the figure.
- **Dual Arrows Line:** Draws dual arrowhead.
- **Standard Line:** Draws a line with no arrowhead from the dimension text to the figure.
- **Curved Leaders:** Draws a curved line with an arrowhead from the dimension text to the figure.
- **Dimension Only:** Draws the dimension text with no line.

**Pulldown Menu Location:** Annotate > Survey Text  
**Keyboard Command:** svtextdf  
**Prerequisite:** None  
**File Names:** `\lsp\svtextdf.lsp, \lsp\svtextdf.dcl`
Offset Dimensions

This command labels the perpendicular distance between a point and a line or polyline. The point can be a building corner or other object. The endpoint snap is on by default for picking this point, although you may choose another snap mode manually. There is also an option for arrow only on end of line. The text layer, size, style and the dimensioning method are set in the *Survey Text Defaults* command, found in Settings > Configure > Survey Settings.

**Prompts**

[end on] **Pick Bldg/Object Corner:** *pick a point*

**Pick Line To Offset From:** *pick a line or polyline*

![Offset Dimensions showing perpendicular distances from corners to property lines](image)

**Pulldown Menu Location:** Annotate > Survey Text  
**Keyboard Command:** dimentxt  
**Prerequisite:** Line or polyline  
**File Name:** \lsp\dimentxt.lsp

Building Dimensions

This command labels the length of line and polyline segments. The label is located in the middle of the line or polyline segment. The options for Building Dimensions are set in the *Survey Text Defaults* dialog. This dialog is found in Settings > Configure > Survey Settings. One option in *Survey Text Defaults* labels all the segments of a closed polyline with one pick of the polyline. Otherwise, the procedure is to pick a line or polyline segment and then choose an alignment. Depending where the alignment point is picked, the label is drawn either perpendicular or parallel, above or below the line.
Prompts

Pick Line or Polyline: pick line or polyline segment to label
Pick Alignment: pick point as shown

Pull down Menu Location: Annotate > Survey Text
Keyboard Command: bldgtext
Prerequisite: Line or polyline
File Name: \lsp\bldgtext.lsp

Adjoiner Text

This command draws text that is aligned with the selected line or polyline segment. The layer, style, size and justification for the text is set in the Survey Text Defaults command, found in Settings > Configure > Survey Settings. To align text that is already drawn, use the Rotate Text command found in the Edit menu.

Prompts

Pick Line or Polyline: pick a line or polyline for alignment
Starting point: pick a point to start the text
Text: MAIN STREET
Adjoiner Text aligns text with a line or polyline

**Pulldown Menu Location:** Annotate > Survey Text

**Keyboard Command:** adjntext

**Prerequisite:** Line or polyline

**File Name:** \lsp\adjntext.lsp

## Draw Grid

This command will plot a plan view grid at a user specified distance and optionally label the northing and easting coordinates of the grid. This command takes in consideration the current screen twist angle in which case it prompts for three corner points. After selecting the corner points the dialog below will appear. The title block is assumed right justified to the lower right corner of the grid definition points. After changing any of the settings select the **OK** button to plot the grid.

![Draw Plan View Grid Dialog](image)

**Grid Interval:** 100.00

**Grid Line Layer:** GRID

**Grid Format:** Full Grid

**Grid Type:** Nothing/Easting

**Grid Text Settings:**
- **Label Grid**
- **Use Split Coordinates Layout**
- **Text Size Scaling:** 0.08
- **Offset Scaling:** 0.10

**Title Block Extension:**
- **Avoid Title Block Area**
- **Set Title Block Corner:**
- **X Dimension Scaling:** 1.00
- **Y Dimension Scaling:** 1.00

**Label Prefix North:** N

**Label Prefix East:** E

---

**Chapter 15. Annotate Menu**

809
Grid Interval: The distance between each grid line.
Horizontal Scale: Reports the scale of the current drawing. This can also be set using the Drawing Setup command in the Settings menu.
Grid Format: The Ticks Only option will draw tick marks instead of grid lines. Selecting the Ticks Only option activates the Tick Size option for sizing the tick marks. There is also a Full Grid and Perimeter option.
Layout of Ticks: This option places the ticks throughout the interior of the grid work or just on the perimeter of the grid boundary.
Use '-' for Negative Coordinates: This option labels the negative grid coordinates with a '-'
Label Grid: Selecting this Grid Text Setting option labels the grid coordinates.
Use Split Coordinates Layout: Puts the thousands digits above the grid line and the hundreds digits below the grid line
Text Size Scaler: This scaler, multiplied by the Horizontal Scale, determines text size.
Offset Scaler: This scaler, multiplied by the Horizontal Scale, determines the offset for text.
Avoid Title Block Area: This Title Block Exclusion option will allow you to not draw grid lines or tick marks in the title block area. It is for making sure that the grid does not overwrite the title block.
Pick Title Block Corner: This option prompts you to pick the corner of the title block to determine where the grid lines and ticks will be omitted.
X Dimension Scaler: This is the horizontal dimension of the title block. This option is automatically filled in when the Pick Title Block Corner option is selected.
Y Dimension Scaler: This is the vertical dimension of the title block. This option is automatically filled in when the Pick Title Block Corner option is selected.
Label Prefix North: This option is for assigning a prefix to the northing grid line and tick mark coordinates.
Label Prefix East: This option is for assigning a prefix to the easting grid line and tick mark coordinates.

Prompts

Pick or Type Lower Left Corner Point: endp of (pick point)
Pick or Type Upper Right Corner Point: endp of (pick point) Select the corners of your border in which you want the grid plotted.
Draw Plan View Grid Dialog

Pulldown Menu Location: Annotate
Keyboard Command: dgrid
Prerequisite: None
File Names: \lsp\grid.lsp, \lsp\scadarea.dcl
**Draw Legend**

This command draws a legend based on a legend definition file. After choosing the legend definition (.LGD) file to use, a dialog displays the current definitions. The legend definition file consists of descriptions assigned to symbols, linetypes and hatch patterns. The default legend that is included with Carlson is called legend.lgd.

![Legend Definitions](image)

**Edit** edits a definition, select it and then click on the Edit button. This brings up the Symbol Definition dialog box.

![Symbol Definition](image)

- **Symbol Name** designates the symbol to draw in the legend. You can either type in the symbol name or choose it from a slide library by picking the appropriate Select button.
- **Description** is the name of the symbol.
- The **Hatch Scale and Color** options are used if the symbol uses a hatch pattern.
- **Include in Legend**: This option corresponds to the Include column on the Legend Definitions dialog box. Not all the defined entries need to be drawn. An entry will be drawn (shown as Yes) if the Include in Legend box in the Symbol Definition dialog box is checked.
- **Select Point Symbol**: This option displays a slide library of point symbols to choose from.
• **Select Drawing Linetype:** This option displays a linetype name list to choose from.
• **Select Library Linetype:** This option displays a slide library of linetypes to choose from.
• **Select Hatch Pattern:** This option displays a slide library of hatch patterns to choose from.

**Add** inserts a new definition to the definitions. To insert a new definition, pick an existing definition and click on the Add button. The new definition is added immediately following the existing definition.

**Add from Drawing** adds entries to the legend table for each different symbol that is selected from the drawing.

**Remove** removes the selected definition.

**On** switches the Include field in the selected definition to Yes.

**Off** switches the Include field in the selected definition to No.

**On/Off by Drawing** prompts you to select symbols from the drawing. Symbols found will be turned on, all others will be turned off. This helps you create a legend that includes only symbols found in the drawing.

**Description by Field-to-Finish** uses the description from the Field-to-Finish code definition for symbols that match the code symbol.

**Sort** sorts the definitions alphabetically and numerically.

**Draw** draws the included definitions as a legend.

**Move Up:** This option moves the selected definition up one row. Legend entries are drawn in the order that they are defined.

**Move Down** moves the selected definition down one row. Use the Move Up and Move Down buttons to change the order that the symbols will be drawn.

**Save** saves the legend file as its original file name.

**Save As** saves the legend file to a new file name.

**Quit** exits the command back to the drawing window.

**Draw** opens the Draw Legend dialog.

```
Chapter 15. Annotate Menu
```

- **Text Size** sizes the text in the legend. It defaults to the value from Drawing Setup in the Setting menu.
- **Symbol Size** defaults to the value from Drawing Setup in the Settings menu.
- **Hatch Size** sizes the hatch pattern scaler.
• Line Size sizes the lines in the legend.
• Layer Name defines the layer for the legend.
• Draw Legend Title draws the following text "Legend: These standard symbols will be found in the drawing."

Prompts

Specify Legend Definition File Dialog choose the file to process
Legend Definitions Dialog
Draw Legend Dialog
Enter or pick upper left point for legend: pick a point

Sample legend created by Draw Legend

Pulldown Menu Location: Annotate
Keyboard Command: legend
Prerequisite: None
File Name: \lsp\cogoutil.arx

Draw North Arrow

This command inserts a north arrow symbol. You can select from several styles of arrows, and you can add your own by using the Edit Symbol Library command on the Settings menu.

Prompts
**Draw North Arrow Dialog** choose an arrow symbol, layer and other variables

Specify insertion point: pick a point

X scale factor <1> / Corner / XYZ: press Enter

Y scale factor (default=X): press Enter

Rotation angle <0d0'0'0'": press Enter

---

**Pulldown Menu Location:** Annotate  
**Keyboard Command:** narrow  
**Prerequisite:** None  
**File Name:** `\lsp\scadutil.arx`

---

**Draw Barscale**

This command draws a barscale at the user-specified scale.

---

**Prompts**
Create Point Table

This command draws a table of the coordinate data of the points from the current coordinate (.CRD) file using different methods displayed at the top of the dialog. The command displays the dialog shown below for setting all of the point table options. At the top of the dialog enter the range of point numbers to label, do a Screen Pick or select a Point Group(s). You can also specify the order and format of the table columns. If you do not want to include a data type, set the Sequence number to blank.

Prompts

Point Table Generator Dialog
Building Data List ... Done.
Table Upper Left Corner: pick a point
Generating Table... Done.
Typical Point Table

Pulldown Menu Location: Annotate > Point Table
Keyboard Command: pointtbl
Prerequisite: A coordinate (.CRD) file
File Name: \lsp\pointsch.lsp

Update Point Table

This command prompts you to select an existing point table. The program then reads the settings from this table and displays these settings in the same dialog used in Create Point Table. You can change any of the table format options. The program will also update the table to reflect any changes to the coordinate (.CRD) file.

Prompts

Select existing point table: pick anywhere on the point table or select points from the screen

Point Table Generator Dialog

Pulldown Menu Location: Annotate > Point Table
Keyboard Command: pointtblupd
Prerequisite: An existing point table, .CRD file
File Name: \lsp\pointsch.lsp

Table Defaults

This command sets the format for line and curve tables. Text Layer and Text Style determine the layer and style of the line/curve table text. The distance for line tables can be labeled in horizontal or slope distance. The Automatic Table Update option will automatically insert the entry into the line or curve table. The auto update will renumber the other table entries and the associated labels in the drawing. For example, if a line table had lines #1-5 and a line #4 was added, then the new line #4 would be inserted into the table and the previous lines #4 and #5 would be updated to #5 and #6. The L4 and L5 labels on the lines would also be updated to L5 and L6. Without the automatic update option, the entry location must be picked and the labels updated manually. The Label Alignment determines the orientation of the L# or C# that is labeled on the line or curve. Horizontal will make the label horizontal to the current twist screen and Parallel will draw the label parallel with the line or curve chord. The Line and Curve Label Prefix sets the text before the number that is drawn in the table and on the line or curve (i.e. "L3" or "Line3"). The Curve Options specifies which curve data to include in the table and the order. You specify the label and table attributes in the Line/Curve Table Defaults dialog.
Label Text Layer: determines the layer of the line/curve text.
Label Text Style: determines the style of the line/curve text.
Label Text Size: determines the size of the line/curve text.
Line Label Prefix: determines the prefix for each line.
Line Table Title: draws a title row at the top of the line table with this string.
Table Text Layer: determines the layer of the line/curve table text.
Table Text Style: determines the style of the line/curve table text.
Table Text Size: determines the size of the line/curve table text.
Curve Label Prefix: determines the prefix for each curve.
Curve Table Title: draws a title row at the top of the curve table with this string.
Prompt for Label Location: prompts you to pick the location to label each line or curve. If this is not selected, the location is chosen automatically.

Under Line Table Distance, the method for measuring distance is specified.
Horizontal: The distance measured is only horizontal, even if the line is a 3D polyline.
Slope: The distance measured is the slope distance, used mostly for 3D polylines to get their true length.

Under Label Angles in, the type of angle is selected.
Azimuths: The angles are reported as azimuth.
Bearings: The angles are reported as bearings.
Gons: The angles are reported as gons.

Under Automatic Table Update, the option automatically inserts the entry into the line or curve table. The auto update renumbers the other table entries and the associated labels in the drawing. For example, if a line table contained lines #1-5 and a line #4 was added, then the new line #4 would be inserted into the table, and the previous lines #4 and #5 would be updated to #5 and #6. The L4 and L5 labels on the lines would also be updated to L5 and L6. If you set the Automatic Table Update to Off, you must manually pick the entry location and update the labels. If Automatic Table Update is set to On, the table is updated automatically whenever the line is modified.
Label Alignment determines the orientation of the L# or C# that is labeled on the line or curve. Horizontal will make the label horizontal to the current screen alignment, Parallel will draw the label parallel to the line or curve chord. Under Curve Options, you specify which curve data to include in the table and the order.

Use Table Entity: will use single block for the whole table. Otherwise, each row is a separate block.

Combine Equal Rows: will use the same line or curve number when the data exactly matches an existing row in the table. For example, if two line segments have the same bearing and distance, then they would both get the same line# (ie. "L5").

Display First Row With Table Reference: When there is room on the line or arc, this option will label both the number and the first column data value from the table on the line or arc. For example, if the first curve table column is for radius and the arc length is big enough to fit the label, then the program would label both the curve # and the radius (ie. "C5 R=100.0").

Selecting "Set Line Table Labels" will lead you to the Line Table controls, as "Set Curve Table Labels" (see graphic at end of this command page) leads to the Curve Table controls. For fields that apply to the Report Scale Factor from Drawing Setup, there is a second Scaled Label name for the table header. This scale factor can be used for reporting both grid and ground or both english and metric distances. The options in "Set Line Table Labels" are shown below:

<table>
<thead>
<tr>
<th>Field</th>
<th>Label</th>
<th>Scaled Label</th>
<th>Width</th>
<th>Justification</th>
<th>Precision</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line Number</td>
<td>LINE</td>
<td>6.250</td>
<td>LEFT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bearing</td>
<td>BEARING</td>
<td>14.000</td>
<td>LEFT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Azimuth</td>
<td>AZIMUTH</td>
<td>14.000</td>
<td>LEFT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>GON</td>
<td>GONS</td>
<td>14.000</td>
<td>LEFT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Horiz Distance</td>
<td>DISTANCE</td>
<td>11.500</td>
<td>RIGHT</td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td>Slope Distance</td>
<td>SLOPE DIST</td>
<td>11.500</td>
<td>RIGHT</td>
<td>0.00</td>
<td></td>
</tr>
</tbody>
</table>

With the above settings, for example, the Line Table appears as shown below. For improved "aesthetics", you might prefer to change the Bearing justification to "Center", for example.

<table>
<thead>
<tr>
<th>LINE</th>
<th>BEARING</th>
<th>DISTANCE</th>
</tr>
</thead>
<tbody>
<tr>
<td>L1</td>
<td>S 58°18’48” W</td>
<td>87.33’</td>
</tr>
<tr>
<td>L2</td>
<td>S 75°06’27” E</td>
<td>148.57’</td>
</tr>
<tr>
<td>L3</td>
<td>N 88°27’07” E</td>
<td>63.44’</td>
</tr>
<tr>
<td>L4</td>
<td>N 58°40’01” W</td>
<td>63.44’</td>
</tr>
</tbody>
</table>
To save space, you can reduce the size of the "Distance" column from 11.5 to 10. Note that using the Line Label Prefix option, L1 and L2, for example, can read Line1 and Line2, and for that, you may want to expand the "Width" setting for the Line column. The prefix flexibility, and the fact that the text used for the column header can be changed, means that line tables and curve tables can be plotted in any language. In Puerto Rico, for example, surveys are typically conducted in bearings, in meters and in Spanish. For that location, the table could be reconfigured as shown here:

This would lead to the following line table:

<table>
<thead>
<tr>
<th>LINEA</th>
<th>RUMBO</th>
<th>DISTANCIA</th>
</tr>
</thead>
<tbody>
<tr>
<td>L1</td>
<td>S 58°18’48” W</td>
<td>87.33m</td>
</tr>
<tr>
<td>L2</td>
<td>N 88°27’07” E</td>
<td>63.44m</td>
</tr>
<tr>
<td>L3</td>
<td>N 58°40’01” W</td>
<td>63.44m</td>
</tr>
</tbody>
</table>

Note that changing the distance suffix to "m" (or omitting any suffix by making it blank) is accomplished in the more general command Annotation Defaults.

Finally, below we see the dialog that appears when you choose Set Curve Table Labels.
Table Header

This command draws the column header labels for the Curve Table and Line Table commands. When prompted for the starting point, the user may enter a coordinate or pick a point on the screen. The starting point location that the curve or line table command defaults to is one row below the start of the header labels.

```
<table>
<thead>
<tr>
<th>Field</th>
<th>Label</th>
<th>Scaled Label</th>
<th>Width</th>
<th>Justification</th>
<th>Precision</th>
</tr>
</thead>
<tbody>
<tr>
<td>Curve Number</td>
<td>CURVE</td>
<td></td>
<td>8.000</td>
<td>LEFT</td>
<td></td>
</tr>
<tr>
<td>Radius</td>
<td>RADIUS</td>
<td>RADIUS2</td>
<td>8.000</td>
<td>LEFT</td>
<td>0.00</td>
</tr>
<tr>
<td>Arc Length</td>
<td>ARC LENGTH</td>
<td>ARC LENGTH2</td>
<td>14.000</td>
<td>LEFT</td>
<td>0.00</td>
</tr>
<tr>
<td>Chord Length</td>
<td>CHORD LENGTH</td>
<td>CHORD LENGTH2</td>
<td>14.000</td>
<td>LEFT</td>
<td>0.00</td>
</tr>
<tr>
<td>Chord Bearing</td>
<td>CHORD BEARING</td>
<td>CHORD Bearing</td>
<td>15.000</td>
<td>LEFT</td>
<td></td>
</tr>
<tr>
<td>Chord Azimuth</td>
<td>CHORD AZIMUTH</td>
<td></td>
<td>15.000</td>
<td>LEFT</td>
<td></td>
</tr>
<tr>
<td>Chord GONS</td>
<td>CHORD GONS</td>
<td></td>
<td>15.000</td>
<td>LEFT</td>
<td></td>
</tr>
<tr>
<td>Delta Angle</td>
<td>DELTA ANGLE</td>
<td>TANGENT2</td>
<td>15.000</td>
<td>LEFT</td>
<td>0.00</td>
</tr>
<tr>
<td>Tangent</td>
<td>TANGENT</td>
<td></td>
<td>10.000</td>
<td>LEFT</td>
<td></td>
</tr>
<tr>
<td>Degree Of Curve</td>
<td>DEGREE OF CURVE</td>
<td></td>
<td>17.000</td>
<td>LEFT</td>
<td></td>
</tr>
<tr>
<td>Radial Bearing in</td>
<td>RADIAL BEARING IN</td>
<td></td>
<td>15.000</td>
<td>LEFT</td>
<td></td>
</tr>
<tr>
<td>Radial Bearing out</td>
<td>RADIAL BEARING O</td>
<td></td>
<td>15.000</td>
<td>LEFT</td>
<td></td>
</tr>
</tbody>
</table>
```

Table header (C option)

Prompts

Type of table [Line/<Curve>]? C
Starting point of Curve table text <(6585.0 -704.0 0.0)>: pick point

Chapter 15. Annotate Menu 820
Set Table Position

This command sets the position for adding line table entries. The next line table rows will start from this point. To add to an existing table, pick a point at the lower left of the existing table.

Pulldown Menu Location: Annotate > Line/Curve Table
Keyboard Command: set_tbl
Prerequisite: None
File Name: \lsp\set_tbl.lsp

Curve Table

This command will compute curve data and draw it in tabular form using the settings specified in Table Defaults. The program computes the curve data from an arc entity, an arc segment of a polyline or from specified points on an arc. The curve data includes radius, length of curve, chord length, chord bearing, tangent and delta or included angle. The current curve table numbers are remembered between drawings. The user is prompted for curve number (default is sequential starting with 1) and the starting point of the table. The curve is labeled with a C#, where # is the sequential curve number. After picking the starting point of the table, the placement point for the other table entries will default to the next position and you can just press Enter unless you want to relocate the table. The Auto Annotate command can also create curve tables. Use the Table Header command to draw the column header of the curve data names.

Prompts

Define arc by, Points/Select arc or polyline>: pick an arc
Enter curve number <1>: press Enter
Starting point of curve table text <(5000,5000)>: pick a point in a clear area of the drawing
Define arc by, Points/Select arc or polyline>: pick another arc
Enter curve number <2>: press Enter
Starting point of curve table text <(4030,4490)>: press Enter to use next position
Define arc by, Points/Select arc or polyline>: press Enter to end

<table>
<thead>
<tr>
<th>CURVE</th>
<th>RADIUS</th>
<th>ARC LENGTH</th>
<th>CHORD LENGTH</th>
<th>CHORD BEARING</th>
<th>DELTA ANGLE</th>
<th>TANGENT</th>
</tr>
</thead>
<tbody>
<tr>
<td>C1</td>
<td>85.44</td>
<td>50.73</td>
<td>59.57'</td>
<td>≤ 70°32'5.3&quot; W</td>
<td>38°54'14&quot;</td>
<td>31.69'</td>
</tr>
<tr>
<td>C2</td>
<td>162.68</td>
<td>75.80</td>
<td>74.93</td>
<td>h 71°36'14&quot; E</td>
<td>49°41'57&quot;</td>
<td>39.95'</td>
</tr>
<tr>
<td>C3</td>
<td>170.51</td>
<td>94.26</td>
<td>91.45'</td>
<td>s 63°4'28&quot; L</td>
<td>46°58'35&quot;</td>
<td>50.24'</td>
</tr>
</tbody>
</table>

Pulldown Menu Location: Annotate > Line/Curve Table
Keyboard Command: arctabl
Prerequisite: None
Line Table

This command will compute line data and draw it in tabular form, using the settings specified in Table Defaults. The program computes the bearing and distance from a line, polyline segment or between points. The current line table numbers are remembered between drawings. The line is labeled with a L#, where # is the sequential number of the line picked. The bearing and distance will then be drawn in tabular form similar to the previous Curve Table command. The Auto Annotate command can also create line tables. Use the Table Header command to draw the column header of the line data names.

<table>
<thead>
<tr>
<th>LINE</th>
<th>BEARING</th>
<th>DISTANCE</th>
</tr>
</thead>
<tbody>
<tr>
<td>L1</td>
<td>N 22°33'19&quot; E</td>
<td>31.9873'</td>
</tr>
<tr>
<td>L2</td>
<td>S 89°00'57&quot; W</td>
<td>353.8667'</td>
</tr>
<tr>
<td>L3</td>
<td>N 31°35'59&quot; E</td>
<td>37.0750'</td>
</tr>
</tbody>
</table>

Pulldown Menu Location: Annotate > Line/Curve Table  
Keyboard Command: linetabl  
Prerequisite: None  
File Name: \lsp\linetabl.lsp

Railroad Curve Table

This command is exactly like Curve Table, except the curve data is calculated for Railroad curves. See the Curve Table command for more details.

Pulldown Menu Location: Annotate > Line/Curve Table  
Keyboard Command: rr_curvetbl  
Prerequisite: None

Delete Table Elements

This command erases rows from line or curve tables. The table entries following the removed rows are automatically repositioned and renumbered. The line or curve labels on the linework in the drawing are also updated.

Pulldown Menu Location: Annotate > Line/Curve Table  
Keyboard Command: del_tbl  
Prerequisite: Line or curve tables  
File Name: \lsp\cogoutil.arx

Label Arc

This command labels the arc data along the arc between the endpoints of the arc. The curve information is also displayed. The format for the label is set in the dialog shown here. For each arc data value, you can specify the label, the row number, and the side of the arc it will appear on. If a row number is left blank, then that value is not
labeled. There is a choice of labeling inside or outside of the arc. Annotation is drawn as a block. The advantage of this is that the characters, rather than being individual entities, are plotted as a single entity that can be moved and edited as a unit. You would need to explode the "blocked" text in order to edit the text. A toggle button determines whether the user wants to flip the text on arcs that open to the top of the drawing.

**Prompts**

**Define arc by, Points/</select arc or polyline>: select arc**
After selecting the arc or polyline arc segment the command displays the dialog below. Select the OK button and the arc is labeled with the current settings of the dialog.

![Label Arc Settings Dialog](image)

Examples of Label Arc (above and below)
Example of Stack Label Arc

**Pulldown Menu Location:** Annotate > Annotate Arc  
**Keyboard Command:** labarc  
**Prerequisite:** Arc or polyline should be drawn before execution

### Stack Label Arc

This command draws a small table of curve data. Unlike the command *Label Arc*, instead of fitting the text on the arc, this command lines the data up in rows. After selecting the command, the dialog below appears. For each type of arc value, you can specify the label and the sequence number. Under Label Options, the Stack Label Arc data table will display the values in the order by sequence number. If the sequence number is left blank, then that data value is not labeled. The text and sequence is set. If a row number is left blank, then that value is not labeled. There are also settings to justify label left or right.
Under Label Options, the data table will display the values in order based upon sequence number. 

**Arc Length**: Select a label prefix and a sequence number.

**Radius**: Select a label prefix and a sequence number.

**Delta Angle**: Select a label prefix and a sequence number.

**Chord Angle**: Select a label prefix and a sequence number.

**Chord Length**: Select a label prefix and a sequence number.

**Tangent**: Select a label prefix and a sequence number.

**Degree of Curve**: Select a label prefix and a sequence number.

**External**: Select a label prefix and a sequence number.

The **Use symbol for Delta Angle** option uses a delta triangle symbol for the prefix.

Label Chord Angles in allows you to set how the angle is labeled.

**Azimuth**: The angles are reported as azimuths.

**Bearings**: The angles are reported as bearings.

**Gons**: The angles are reported as gons.

The **Type of Curve** option determines the type of curve.

**Roadway**: The length is determined as the true length of the curve.

**Railroad**: The length is adjusted based on 100-foot chord segments.

**Prompts**

**Define arc by, Points/<select arc or polyline>:** P The P option causes the command to prompt for points on the arc. This can be useful for labeling sub-arcs such as lot corners of a cul-de-sac.

**Pick Points in a Clockwise direction.**

**Pick Endpoint of arc: pick a point**

[nea on] **Pick point between endpoints on arc: pick a point**
Pick Other Endpoint arc: *pick a point*

Starting point of label: *pick a point*  The labels are then drawn left justified from the point picked.

Define arc by, Points/<select arc or polyline>: *press Enter*  Pressing Enter causes the program to end.

\[ L = 243.4246' \]
\[ R = 161.4800' \]
\[ \Delta = 86^\circ 22' 16'' \]
\[ C_{LEN} = 221.0219' \]
\[ BRG = S \ 85^\circ 37' 04'' \ W \]

Pulldown Menu Location:  Annotate > Annotate Arc

Keyboard Command:  slabarc

Prerequisite:  an arc entity or arc points

File Name:  \lsp\slabarc.lsp

**Custom Label Formatter**

This command allows you to customize the labeling for arcs. You are first prompted to select an arc to label, given the existing defaults currently set. The arc is shown as labeled on the screen. The command line, shown below, also offers you an important choice called Options. When you type 'O' for options the below dialog box appears. There are four columns at the top of the dialog along by other features.

![Custom Label Formatter Dialog Box](image)
**Label:** This first column allows you to set the prefix that will go before your arc data.

**Row:** This column allows you to stack the data in different ways. You can place more than one item in the same row. If *None* is selected then that item will not be displayed.

**Side:** This column allows you to place each item either inside or outside of the arc.

**Order:** This column determines the order of items when they are placed in the same row.

**Flip Text on Arcs that Open to the North:** When this is checked text will be orientated according to the open side of your arcs instead of being orientated according to the plain view.

**Use Symbol for Delta Angle Label:** Allows you to use the triangle symbol for delta as the label instead of plain alphabetic or numeric representation.

**General Settings:** This button brings you to the Annotate Defaults dialog, see 'Annotate Defaults' for more.

**Reset To Defaults:** This button restores the default settings shown above.

**Load/Save:** You may also Load and Save different label configurations with the corresponding buttons.

### Prompts

**Options/<Select arc>:** *select entity*

**Options/<Select arc>:** *O*

**Custom Arc Label dialog** *choose your preferences and click OK*

You can decide to go into the Option dialog at the start of the command and after your initial labeling.

**Pulldown Menu Location:** Annotate > Annotate Arc

**Keyboard Command:** annarc

**Prerequisite:** An arc to label

**File Name:**

### Draw Text On Arc

This command draws text that aligns with an arc or polyline arc segment. Each letter of the text is drawn as a separate text entity that is rotated to align with the arc at that point. These text letters are automatically grouped together as an anonymous block. This command starts with the Create Text on Arc dialog. This command draws text that aligns with an arc, beginning at a picked point. Each letter of the text is drawn as a separate text entity that is rotated to align with the arc. These text letters are automatically grouped together as a block. The text string, text height, and text style are set in the Create Text on Arc dialog box.
Text String: Specify the text to label on the arc.
Text Height: Specify the text height. The default value is obtained from the text height specified in Drawing Setup. The value set here is retained throughout the drawing session.
Text Style: Choose an existing text style from the list of defined styles.
Select text offset on screen: When checked, the program will prompt you for offset. You can set the text offset from the arc by graphically picking the offset point on the screen. When this option is not checked, the Text Offset field described below becomes available to specify a known offset distance.
Text Offset: If the above setting is not selected, specify the Text Offset here. A positive value denotes an offset distance inside the arc, while a negative value denotes an offset distance outside the arc.
Is base of text towards radius point?: This option determines whether the base of the text should face the radius point of the arc. It orients the text to the curve. Examples showing the results of different settings follow.

Example 1 - Offset distance specified on screen and base of text away from radius point.
Select Arc or Polyline segment: pick Arc or Polyline segment to place text on.
Select Text Offset: pick the desired offset distance from arc
Select Text Placement: pick a point, select the desired position to draw the text. Note that the text remains visible on the screen and attached to the "rubber banding cursor" so that various positions can be inspected before specifying the placement point. The graphic below shows this aspect of the command.

Note that the ghosted text is located along the mid point of the arc. If no offset distance is specified or picked from the screen, the text will be placed at this point. An offset of zero puts the text directly on the arc.
Example 2 - Offset distance specified in dialog and base of text towards radius point.

Select Arc or Polyline Arc Segment: **pick Arc**
Select Text Placement: **pick point**

Note that the prompt for offset distance was skipped because the offset distance was input on the dialog box. Simply select the text placement point resulting in the graphic below.
Draw Text on Tangent

This command is identical to **Draw Text on Arc**, except that the text is not curved to fit the arc. You are presented with this dialog box. Fill in the text, decide on the other options, click **OK**, and then follow the prompts.

Edit Text on Arc or Tangent

This command allows you to edit text created by the **Draw Text on Arc** or **Draw Text on Tangent** command. You can change the text string, text height and text style. The program prompts you to select the Text on Arc entity, then displays the same dialog used in **Draw Text on Arc**.
Fit Text Inside Arc

This command fits text between two points picked along an arc. Text is curved to fit the arc using individual text entities, which can only be edited one at a time. The Draw Text on Arc command creates an text entity that can be edited using Edit Text on Arc or Tangent. It will optionally display information about the selected arc. If you choose to display the curve data, you will be prompted to pick the endpoints of the arc in a clockwise manner. When prompted, enter the text you want drawn inside the arc.

Prompts

Pick points in a clockwise direction.
[nea on] Start Point on arc for text: pick point on arc to start text Notice that the Nearest snap is turned on by default.
[nea on] End Point on arc for text: pick point on arc to end text Notice that the Nearest snap is turned on by default.
Enter text for inside of arc: MEADOWVIEW LANE

Fit Text Outside Arc

Same as the previous command except this command fits text on the outside of the arc.

Pulldown Menu Location: Annotate > Annotate Arc
Keyboard Command: oarct
Prerequisite: An arc entity
File Name: \lsp\oarct.lsp

Change Polyline Linetype

This command changes the linetype of polylines or lines to the linetype selected from the dialog. True AutoCAD linetypes are created and applied to the selected entities, compared to other commands, such as Polyline to Special Line and Special Line/Entity, which break the polyline into segments. The spacing between linetype symbols and the symbols size are controlled by the Line Type Spacing and Symbol Sizer Scaler settings in the dialog. The Gap Size Scaler controls the size of the break in the line for the linetypes that have a break like UserDef and Arrow_B. To select a linetype from the dialog, pick on the linetype image. Use the Next button to see more linetypes. At the end
of the list of linetypes, there are two special choices. The UserDef choice lets you enter your own text string into a linetype, and the Wingdings choice lets you insert any Wingdings font character into a linetype. Consult Windows® documentation for a listing of Wingdings characters.

**Prompts**

*Select Linetype dialog* select linetype and adjust other variables

*Select items to change.*

*Select objects:* pick the polylines
Linetype styles available using Change Polyline Linetype

**Pull down Menu Location:** Annotate > Line Types  
**Keyboard Command:** pltype2  
**Prerequisite:** Polylines  
**File Name:** \lsp\ltype.lsp

## Polyline to Special Line

This command converts polylines into special lines by adding the appropriate symbol onto the polyline, such as railroad, hedge, stonewall or telephone lines. Carlson has defined several line types as shown below. You can create custom lines by selecting the ? or another line type, which then prompts you for the text symbol to use. The size and spacing are set by the *Annotate Defaults* routine. This routine breaks the polyline in order to fit in the symbol. Broken polylines cannot be used by the *Area* command, and are difficult to edit. Consider using this command towards the end of your project.

*Change Polyline Linetype* command creates actual AutoCAD linetypes that are applied to the selected entities.
Prompts

Select Carlson Linetype dialog
Select the polyline(s) to convert.
Select objects: *pick the polylines*

Pulldown Menu Location: Annotate > Line Types
Keyboard Command: ptyle
Prerequisite: Polylines
File Names: \lsp\linetype.lsp, \lsp\cogoutil.arx

**Polyline to Tree Line**

This command changes a polyline into a series of semicircles for representing a tree line.

Prompts

Side for arcs on polyline direction? (*<Left>*/*Right*) *press Enter*
Enter the segment distance <10.0>: *press Enter*
Select the polylines to convert.
Select objects: *pick one or more polylines*
Add Zig to Polyline

This command draws a [not-to-scale] style zig to a polyline. First pick the polyline and then pick a position on the polyline to draw the zig.

Prompts

Zig size <4.0>: press Enter
Select polyline to add zig: pick a polyline
Pick or enter point to add zig: pick a point along the polyline
Select polyline to add zig: press Enter to end

![A zig in a polyline](image)

Add Culvert to Polyline

This command adds culvert style brackets to both ends of the selected polylines.

Prompts

Culvert symbol size <4.0>: 12
Select polyines to add culvert symbols.
Select objects: pick the polyines

![Culvert symbols added to polyline](image)
Prerequisite: Polyline
File Name: \lsp\poly3d.arx

**Sketch Tree Line**

This command draws a tree line as you move the cursor. At the first prompt, you can type O for Options and set the Interval Scaler which controls the spacing of the bubbles. Also at the first prompt, you can type P for Polyline and then select an existing polyline to convert into a tree line. At the end, there is an option to flip the side for the bubbles in case they came out on the opposite side.

The resulting tree line after you pick point to end

**Prompts**

Pick First Point [Options/Polyline]: pick a point
Sketch treeline (pick point to end): slowly move the cursor and pick a second point to end the routine
Reverse direction [Yes/<No>]? press Enter

Pulldown Menu Location: Annotate > Line Types
Keyboard Command: treeline
Prerequisite: None

**Special Line/Entity**

This command breaks a line, arc orpline and inserts a string of text or a block in the breaks. It can be used to draw fence lines, utility lines, tree lines or any line which can be constructed by inserting a text or block entity. The command prompts to select an entity near its endpoint then the distance between inserts. Next, the user selects whether to insert text or a block, and whether to enter the distance or length to be broken out of the entity. If the user enters a 0 distance for the break distance, then the entity is not broken. If a distance greater than 0 is entered, then this distance is divided in half and broken out of the entity on both sides of the point at which the insert distance measures the entity.

If the user elects to insert text, the command prompts for the text to be inserted. Next, choose whether you want the text Middle or Center aligned, and whether you want to have the text flipped so it does not appear upside down. See the AutoCAD Reference Manual for more information on justification options.

If the user elects to insert a block, the command prompts for the block name. The size of the block is controlled by the symbol size setting in *Drawing Setup*. Considering that almost anything can be made into a block, such as
raster images, wipeout entities, etc., this is a very powerful command. Alternatives to this command are *Polyline to Special Line* and *Change Polyline Linetype*.

**Pulldown Menu Location:** Annotate > Line Types  
**Keyboard Command:** speent  
**Prerequisite:** None  
**File Name:** `lsp\speent.lsp`

### Guard Rail

This command adds box symbols along a polyline to generate a guard rail. See the command *Change Polyline Linetype* also.

**Prompts**

**Pick Polyline/Last:** pick a polyline  
**Left/Right:** L for Left  

**Pulldown Menu Location:** Annotate > Line Types  
**Keyboard Command:** grail  
**Prerequisite:** Polyline  
**File Name:** `lsp\grail.lsp`

### Label Angle

This command will label and report the interior and exterior angles between two directions. The angles can be defined by three points, or by two line or polyline segments that have a common endpoint. An example of labeling interior and exterior angles is shown below. The Both option will label interior and exterior angles simultaneously.

**Prompts**

**Define angle by, Points/<select line or polyline>:** pick a polyline segment  
**Select adjoining line or polyline:** pick another polyline segment  
**Interior:** 72°39′46″ **Exterior:** 287°20′14″  
**Angle to label (<Interior>/Exterior/Both/None)?** press Enter  
Typing B for Both labels both the interior and exterior angles.  
**Define angle by, Points/<select line or polyline>:** press Enter to end
**Pulldown Menu Location:** Annotate  
**Keyboard Command:** labang  
**Prerequisite:** None  
**File Name:** \lsp\angle.lsp

### Label Coordinates/Elevation

This command will label a coordinate on the screen. You can choose to label the northing and easting, the Z elevation, or all three properties. The point can be picked on screen, or specified by point number from the current coordinate (.CRD) file. Options include drawing a box around the label, labeling both feet and meters, setting the layer name for the label, setting the display precision, deciding whether or not to use a leader and selecting a change in the symbol used to mark the point. You can also set the text prefix and suffix for the label. Additionally, you can locate a label on Real Z Axis.
There is also an option to label the Delta X, Y and/or Z between two points, which is called Label Delta Between Two Points. When this option is clicked on, and after the prompt, you will first click two points locations. The label, with the delta value(s), will then be placed precisely in between these two pick locations. If, for example, the North, East and Elevation button is chosen, the resulting label will show the N, E and Z delta values.
Prompts

Label Coordinates/Elevation dialog
Point to Label ?
Pick point or point number: pick a point
Point to Label (ENTER to End)?
Pick point or point number: press Enter

Pulldown Menu Location: Annotate
Keyboard Command: labcoor
Prerequisite: None

Label Lat/Long

This command will label the latitude and longitude of a selected point. The program will convert the northing and easting of the input points to latitude and longitude. The coordinate system for the drawing coordinates must be defined in Drawing Setup before running this command. First, the program displays a dialog box with options to set the label prefixes, to set the display precision, to draw a box around the label and to change the symbol used to mark the point. Then the program prompts for the points to label.

Prompts

Label Latitude / Longitude dialog
Pick point or point number: pick a point
Pick point or point number: press Enter to end
Pulldown Menu Location: Annotate
Keyboard Command: lablat
Prerequisite: Define coordinate system in Drawing Setup

Label Curb/Flow Elevations

This command labels top of curb and/or bottom of curb (flowline) elevations with a leader along an alignment. The data to label comes from Carlson points and alignment is defined by a selected polyline. The program reads all the points in the drawing and then you select which descriptions to use the the top of curb labels and which to use for the bottom of curb labels.

There are separate settings for the top and bottom to control the label prefix, suffix and decimals. The Tolerance setting is the maximum distance between a point to label and the polyline. The Leader Angle is applied: Relative adds the angle to the alignment polyline and Absolute means based on the orientation of the screen. The Text Horizontal Offset Scaler controls the distance between the alignment polyline and the label. The Text Vertical Offset Scaler controls the buffer offset between the leader line and the label. The User Leader Entities option chooses between drawing the leaders as polylines or as leader entities. The Elevate Annotations setting controls whether the labels are created at their elevation or at zero.
Prompts

**Top Curb Descriptions** pick descriptions to label for top of curb
**Bottom Curb Descriptions** pick descriptions to label for bottom of curb
Pick a polyline to annotate (Enter to End): *pick a polyline*
Pick side for flowline (Enter to End): *pick a side*

**Pull down Menu Location:** Annotate
**Keyboard Command:** cflelev
**Prerequisite:** points with elevations and descriptions, and alignment polyline
**File Name:** \lsp\cogoutil.arx

**Replot Descriptions**

This command will create user specified text entities at the location of selected point descriptions.

**Prompts**

This command will Search for a certain Point Description and plot
New text on the current layer with current style.
**Attribute Text to Search for <>:** *STK*
**New Text to plot <>:** *Stake Fnd*
**Select objects:** *Select Carlson points*
**Select objects:** *press Enter*
**Number of Text Entities Plotted:** 4
Points with description STK

Found four STK descriptions and created four text entities

**Pulldown Menu Location:** Annotate  
**Keyboard Command:** plotdesc  
**Prerequisite:** Points with descriptions must be plotted. Set the layer and text style that you require.  
**File Name:** \lsp\speent.lsp

**Leader With Text**

This command will draw a straight leader between two points, with an arrow at one end and optional text at the other. The arrow size is determined by the Symbol Plot Size setting, found in the *Drawing Setup* command. On the command line, selecting $O$ for Options will provide you with more customizing choices to make.

**Prompts**

**Options/Pick Arrow Location:** *pick a point*  
**Text location:** *pick a point*  
**Text:** *Leader With Text*  
**Text:** *press Enter*
Pulldown Menu Location: Annotate
Keyboard Command: LDR
Prerequisite: None
File Name: \lsp\leader.lsp

Special Leader

This command draws a curved leader line like the one shown. With this routine you can also choose to enter in multiple lines of text, not just a single line. The arrow size is determined by the Symbol Plot Size setting, found in the Drawing Setup command. On the command line, selecting O for Options will provide you with more customizing choices to make.

Prompts

Options/Pick Arrow Location: pick a point Pick point where leader arrow will start.
Text location: pick a point
Text: Monument
Text: press Enter
Pulldown Menu Location: Annotate  
Keyboard Command: sleader  
Prerequisite: None  
File Name: \lsp\al.lsp

**Text Box**

This command allows you to draw a shaded, shadow text box around a selection of Text or Mtext. The size of the shading and the optional leader are determined by the height of the text that is selected.

Pulldown Menu Location: Annotate  
Keyboard Command: textbox  
Prerequisite: Text or Mtext entities  
File Name: \lsp\textbox.lsp

**Label Offset Distances**

This command labels the distances of a point to one or two lines. The first distance is between the point and an east-west line. This distance is labeled as either north or south of the line. The second distance is between the point and a north-south line. This distance is labeled as either east or west of the line. The distances are labeled with a leader and a description of the point.

**Prompts**

Pick 'E-W', Left to Right Property Line (if any)  
Pick Line or Polyline (Enter for None): pick the polyline  
Pick 'N-S', Top to Bottom Property Line (if any)  
Pick Line or Polyline (Enter for None): pick the polyline  
Pick Offset Point, (N) for Number, <E> to Exit: pick a point
Pick point to start leader at: pick a point at or near the offset point
To point: pick an alignment point for the label
To point: press Enter
Pick Offset Point, (N) for Number, <E> to Exit: press Enter to End

Pulldown Menu Location: Annotate
Keyboard Command: offlab
Prerequisite: Polyline or Line
File Name: \sp\offlab.lsp

Label Elevations Along Polyline
This command labels point elevations and aligns with a polyline based on settings shown in the dialog. These settings can be divided into five groups.

Label Settings: The Source of Elevations are read from Carlson points drawn on the screen, polyline vertices, elevations of grade break vertices and can also be picked on the screen. The Side for Labels is relative to the direction the polyline is drawn. Labels can be aligned horizontally, parallel or perpendicular to the polyline or according to the picked alignment. The Offset distance scalar offsets the label from the actual point.

Text Settings: The labels will be drawn on Layer with selected Style. The Text size scalar is relative to the current horizontal scale, which is set in Drawing Setup. These scalers are multiplied by the horizontal scale to obtain the actual drawing units. The number of Integers and Decimals can also be specified along with Prefix and Suffix for the main elevation label.

Leader Settings: The Leader Settings are used to Draw Leader with Arrowhead on the leader Layer with length of leader equal to Leader Scaler. The option Draw text above leader extends the leader tick to the length of the label.

Additional Settings: Draw box around label draws box around the elevation label. Flip text for twist screen changes the text direction if the text is drawn upside down. If the option Ignore zero elevation is on zero elevation labels will be ignored. The Carlson points or picked points are beyond Maximum offset to use will be ignored.

Additional Offset Settings: If the Additional offset is other than 0, it will be labeled with Prefix and Suffix using the other text settings on the next line of main elevation label.

The overlapping labels can be moved using Move Elevation Labels command to remove the overlap.
Prompts
Label Elevations Along Polyline dialog
Select alignment polyline: pick a polyline
Select points to label.
Select objects: pick the points
The alignment polyline with points to label is shown.

**Pulldown Menu Location:** Annotate

**Keyboard Command:** elevlab

**Prerequisite:** Polyline and points

**File Name:** `\lsp\elevlab.lsp`
The Surface menu, shown below, has many commands for triangulation, contouring, volumes, profile design and much more.
**Triangulate & Contour**

This command provides a complete set of functionality for contouring, labeling, and creating tin surface models. Given data entities that represent the surface, this command creates a final contour map with labeled, smoothed, and highlighted contours and/or a surface model that can be saved to a file (to be used in other areas of the program) or drawn on the screen as triangles or faces. Eligible data entities include points, inserts, lines, 2d polylines, 3d polylines, elevation text, 3d faces, and points from ASCII or coordinate (.CRD) files.

*Triangulate & Contour* has many options which are defined in the exhibits shown in the following pages. With this command, you can do any combination of drawing the triangulation network lines, drawing the contours, drawing triangulation network 3D Faces or lines, writing a triangulation file and storing a surface file.

In order to force *Triangulate & Contour* to correctly interpolate elevations between two points that define a grade break in the surface (such as points on a ridge, wall, or road), a breakline must exist between the points. A breakline line can be specified as a 3D polyline or line. In fact, all 3d polylines and lines with elevation are treated as breaklines.

If *Triangulate & Contour* reports zero points found and fails to do anything when you're using Carlson points, then those points are probably located at zero elevation. To fix this problem, make sure that Carlson Point Inserts is toggled on in the Selection tab. This will enable *Triangulate & Contour* to read the elevation from the elevation attribute of the point.

**Triangulate Tab**

![Triangulate and Contour dialog box](image)

When **Draw Triangulation Lines** is turned on, the program will draw the triangulation as simple line entities with elevation. Specify the layer for these lines in the box to the right.

When **Draw Triangulation Faces** is turned on, the program will draw each triangle in the triangulation network as a 3D Face. These 3D Faces can then be used in AutoCAD's modeling routines such as *HIDE* and *SHADE* or in Carlson routines such as *3D Viewer Window, 3D Surface FlyOver and Slope Zone Analysis*. Specify the layer for
these 3DFaces in the box to the right.

**Draw Slope Arrows** creates slope arrows pointing downhill within the surface triangles. Under Setup is the dialog shown here with controls for the layer and size of the slope arrows. You can also choose to label the slope percent with controls for the label suffix and decimals. The **Min Area to Label** will skip drawing slope arrows for triangles with an area less than this amount.

![Draw Slope Arrow Settings](image)

**Write Triangulation File** stores the triangulation surface model as an .flt or a .tin file. The .flt file format is a text file depicting the edges in the triangulation network. The .tin file is a new binary file format depicting the triangulation network. The .tin file is much faster and more efficient than the previous .flt file format. The triangulation file(s) can be used by several commands such as **Volumes By Triangulation, Spot Elevations, and Profile from FLT File**. Either type in the file name to create or press the Browse button to select a file name.

When **Use Inclusion/Exclusion Areas** is activated, the program will prompt you for inclusion and exclusion polylines. These are used to define the area of activity for triangulation and contouring. The inclusion and exclusion polylines must be closed polylines and must be drawn before using **Triangulate & Contour**. The command line display must be set to show at least two lines to see the prompting for the selection of the Inclusion/Exclusion perimeters.
Only the parts of the contour lines and triangles that are within the inclusion polylines will be drawn. For example, an inclusion could be the perimeter of the site. The parts of contour lines that are inside the exclusion polylines are not drawn. Exclusion polylines can be used for areas where you don't want contours such as within buildings. When **Ignore Zero Elevations** is activated, this setting will filter out all data points at an elevation of zero from the data set.

If you would like to manually set the range over which to contour, select one of the **Specify Input/Output Elevation Range** options, one for source data and one for contour output. The program will automatically contour from the lowest elevation in the data set up to the highest at the increment specified in Contour Interval.

When **Erase Previous Contour Entities** is activated, this setting will erase previously drawn contour entities.

The triangulation network is based on the x,y position of the points. **Pick Reference Plane** allows you to contour an overhang or cliff by changing the reference plane to a side view. The reference plane can be specified by first using the **Viewpoint 3D** command and then using the View option, or you can specify three data points on the cliff (two along the bottom and one at the top).

**Highlight Breaklines** highlights breaklines in the triangulation network by drawing the triangulation lines along breaklines in yellow.

**Interpolate Ridges and Valleys** creates additional triangulation in a ridge or valley situation to more accurately define the feature during surface modeling operations. This option would commonly be used when creating a surface model from existing contours, since it replaces the need to manually draw 3D polylines along ridges and valleys.

**Interpolate Summits and Pits** creates additional triangulation in a summit or pit situation to more accurately define the feature during surface modeling operations. This option would commonly be used when creating a surface model from existing contours.

**Simplify Surface** is designed to reduce the digital size of a surface, without significantly compromising the integrity or accuracy of the surface. The most common application is for surfaces derived from very large datasets, such as smoothed contours. Its use is less applicable to design surfaces or surfaces based on surveyed points, but it can still be utilized. **Simplify Surface** reduces the size of the surface file by analyzing the difference in elevation between each vertex of the TIN and the vertices directly surrounding it, assigning a numerical weight or value to each vertex. If it is determined that the calculated weight for a particular vertex is less than the **Tolerance** factor, the vertex is a candidate for removal. The number of vertices removed is directly proportional to the **Tolerance** factor, so the higher the **Tolerance** factor, the more vertices are removed, the lower the **Tolerance** factor, the fewer vertices are removed.

If **Simplify Surface** is selected, the **Preserve Breaklines** option is activated. **Preserve Breaklines** further analyzes the TIN by focusing on the edges, calculating the angular difference between adjacent triangular faces. If the angular difference between edges is greater than the specified **Breakline Angle**, it is considered to be a breakline, and it is preserved. If it's angular difference is determined to be below the **Breakline Angle**, it becomes a candidate for removal. In that case, the **Weight** factor is applied to the corresponding vertex, adjusting its original value. If the resulting value is still below the **Tolerance**, it is then removed. The number of vertices removed is inversely proportional to the **Weight** factor, so the greater the **Weight** factor, the fewer vertices that are removed, the lower the **Weight** factor, the more vertices that are removed.

A good rule of thumb that can be used when deciding whether or not to use these options is: if the surface contains no man-made features, use **Simplify Surface** only, if it contains man-made features, such as roads, use both **Simplify Surface** and **Preserve Breaklines**.
Before: Surface made from an existing contour map. Note the flat spots in the bottom of the valley (bottom center of the image) when Interpolate Ridges and Valleys is disabled.

After: The same surface with Interpolate Ridges and Valleys enabled. Note the smooth flowline at the bottom center of the image.

The Max Triangle Mesh Line Length value limits the length of the triangulation network lines. Any triangulation line that exceeds this limit will not be drawn or included in contouring. This allows you to avoid abnormally long triangulation lines where you have relatively too few data points and on the outskirts of your data points. The Exterior value applies to triangulation lines around the perimeter of the triangulation area and the Interior value applies all the other triangulation lines. Generally you would have the exterior value larger than the interior.

An Error Log is generated if the Triangulate and Contour routine finds a vertical conflict between breaklines or other surface entities, opening the following dialog box. Three types of conflicts are reported; Crossing Breaklines, Vertical Edges, and Breakline T-Intersections. Crossing Breaklines indicates that the intersection of two entities does not have a common elevation. Vertical Edges indicates that two entities or vertexes of differing elevations have
the same x-y location, thus forming a vertical plane. Breakline T-Intersections indicates that a 3d entity is abutting another entity, but the second entity doesn't have a vertex at the point of intersection. Each type of conflict is listed in its own category.

Clicking to the "plus" sign beside a category will display the individual conflicts within that category. When a line item error is selected, a highlighted arrow is temporarily placed in the drawing to indicate the exact location of the specific conflict. Zoom functionality allows the user to more closely inspect the specific problem area, and if needed a marker can be drawn or a report generated for an individual conflict or conflicts.

**Zoom**  pans the drawing to move the selected conflict to the center of the screen. The zoom functions are only active when a single line item is selected.

**Zoom In**  zooms in on the highlighted area for closer inspection. Multiple picks on the zoom button will increase the magnification.

**Zoom Out**  zooms out away from the highlighted area.

**Report All/One**  toggles between One and All depending whether a single line item conflict or a category is selected from the error log. An error report is generated listing the x-y position and the elevation difference of the entities in conflict.
**Draw All/One** toggles between One and All depending whether a single conflict or a category is selected from the list. This option draws an "X" symbol at each selected conflict. The layer and size of the symbol is controlled in the fields below.

**Continue** closes the Error Log and proceeds with the contouring operation.

**Layer Name** specifies the layer name for the "X" entities drawn with Draw One/All. This also sets the layer name for the "Draw Lines" option.

**Symbol Size** specifies the size of the "X" symbol that is drawn to delineate the selected errors. This will determine the actual size of the symbol in the drawing. This value is not multiplied by the horizontal drawing scale.

In the case of crossing polylines, **Draw Lines** will trace over the polylines responsible for the conflict. The polylines will be created in the layer specified in the layer field.

**Contour Tab**
When the **Draw Contours** box is checked, the program will draw contour lines after triangulating. Otherwise, only the designated triangulation operations are performed. Specify the layer for contours in the edit box to the right.

**Contour by Interval** or **Contour an Elevation** determines whether to contour by interval (ie: every 10 feet) or to contour a certain elevation. The elevation option allows you to contour specific values. For example, if you want just the 100ft contour, then select elevation and enter 100. The default mode is by interval.

Use **Contour Interval** to specify the interval to contour. **Note:** If the previous option is set to Contour an Elevation, then this field is used to specify the elevation to contour.

Contour lines whose total length is less than the **Min Contour Length** value will not be drawn.

**Reduce Vertices** attempts to remove extra vertices from the contour polylines which has the advantages of a faster drawing and smaller drawing size. Default is **ON**

When the Reduce Vertices option is enabled, the **Offset Distance** value is the maximum tolerance for shifting the original contour line in order to reduce vertices. The reduced contour polyline will shift no more than this value, at any point, away from the original contour line. A lower value will decrease the number of vertices removed and keep the contour line closer to the original. A higher value will remove more vertices and allows the contour line to shift more from the original.

When activated, the **Hatch Zones** option will create hatching between the contours based on elevation zones. The following dialog will open allowing the user to specify the hatch type and color for each elevation zone. The entire elevation range of selected data is displayed under Current Values.
Clear clears the all of the Elevation fields in the dialog.

Load loads previous settings from a saved .pat file.

Save saves the current setting configuration to a .pat file.

Auto opens the following dialog, allowing for automatic configuration of the range of elevations in each zone, assigning of colors and hatch patterns, and the scale.

Starting Zone sets the zone with which to begin the application of the setting defined in this dialog. For Instance, if the Starting Zone was set to 10, the settings definitions applied here wouldn't affect Zones 1-9, but would start at Zone 10.

Set Values enables the Starting Value and Value Interval fields, which allow the user to specify the starting elevation for the given zone and set the zone increment.

Starting Value sets the elevation of the beginning zone to define.

Value Interval sets the elevation increment for subsequent zones.
Set Colors enables the Starting Color and Color Increment fields.

Starting Color sets the starting color number, based on the CAD standard color chart.

Color Increment sets the color number to increase for subsequent zones. So if the increment was set to 5, and the starting color was 60, the next color would be 65, 70, and so on.

Set Pattern sets the hatch pattern for the defined zones.

Set Scale enables the Scale option.

Scale sets the scale for the selected hatch pattern.

Draw Index Contours creates highlighted contours at a specified interval. When enabled, the fields for Index Layer, Index Interval and Index Line Width are activated.

Use Contour Smoothing Method to select the type of contour smoothing to be performed. Bezier smoothing holds all the contour points calculated from the triangulation and only smooths between the calculated points. Polynomial smoothing applies a fifth degree polynomial for smooth transition between the triangulation faces. The smoothing factor described below affects the smoothing bulge.

Bezier Smoothing Factor The contour preview window shows you an example of how much smoothing can be expected at each setting. Sliding the bar to the left results in a lower setting which have less looping or less freedom to curve between contour line points. Likewise, moving the slider to the right results in a setting that increases the looping effect. Note that too much smoothing applied in some situations can result in crossing contours.

Subdivisional Surfaces / Subdivisions Generation causes each triangle in the triangulation surface model to be subdivided into an average of three smaller triangles per subdivision generation, with the new temporary vertices raised or lowered to provide smoother contours. More generations increases the smoothness of the algorithm at a cost of increased processing time. If Straight Lines are chosen as the contouring drawing method, then the contours are guaranteed never to cross. The original points of the surface model are always preserved. These modifications to the surface model are only for contouring purposes and are not written to the triangulation (.FLT) file or inserted into the drawing. If some contour movement is too small for appearance’s sake, consider enabling Reduce Vertices.

Labels Tab
When **Label Contours** is activated, contours will be labeled based on the settings below.

**Label Layer** specifies layer name for intermediate contour labels.

**Index Label Layer** specifies layer name for index contour labels.

**Label Style** specifies the text style that will be used for the contour label text.

**Label Text Size Scaler** specifies the size of the contour labels based on a multiplier of the horizontal scale.

Contours whose length is less than the **Min Length to Label** value will not be labeled.

When **Break Contours at Label** is checked, contour lines will be broken and trimmed at the label location for label visibility. When enabled, the Offset box to the right activates. The Offset determines the gap between the end of the trimmed contour line and the beginning or ending of the text.

When **Draw Broken Segments** is checked, segments of contours that are broken out for label visibility will be redrawn as independent segments. Specify the layer for these broken segments in the box to the right of this toggle.

For contouring roads, you can use the **Label At Centerline Offset** to position the labels at a fixed offset from a centerline. When this option is on, the program automatically uses any polylines in the drawing that are tagged at centerlines. To check whether a polyline is a centerline, use the Centerline ID command. To create a centerline polyline from a centerline file, use the Draw Centerline File command.

When **Label Contour Ends** is checked, contour ends will be labeled.

When **Draw Box Around Text** is checked, a rectangle will be drawn around contour elevation labels.

When **Label Index Contours Only** is checked, only the index contours will be labeled. This option is active only when "Draw Index Contours" has been selected in the Contour tab of the main dialog.

**Hide Drawing Under Labels** activates a text wipeout feature that will create the appearance of trimmed segments at the contour label, even though the contour line is still fully intact. This feature provides the user with
the best of both worlds; you have clean looking contour labels, yet the contour lines themselves remain contiguous. This feature will also hide other entities that are in the immediate vicinity of the contour label.

When **Align Text with Contour** is checked, contour elevation labels will be rotated to align with their respective contour lines. This option also activates the Align Facing Uphill feature explained below.

When **Align Facing Uphill** is checked, contour elevation labels will still be rotated to align with their respective contour lines, but the labels will be flipped in such a manner that the top of the text label will always be toward the uphill side of the contours. So as the labels are read right side up, the contours will be progressing uphill.

Use **Internal Label Intervals** to choose between Label Intervals or Distance Interval. Label Intervals will label each contour with a set number of labels. Distance Interval lets you specify a distance between labels.

The **Draw On Real Z Axis** chooses between creating the text entities at the elevations of the contours or at zero elevation.

The **Use MText** chooses between using MText or DText entities for the labels.

**Selection Tab**

![Triangulate and Contour dialog box](attachment:image.png)

When **Specify Selection Options** is checked, you can control what type of entities **Triangulate & Contour** uses. This is an excellent method of "filtering out" unwanted entity types.

Points, 3D Polylines, 2D Polylines, Lines, Inserts are standard CAD entities types.

Carlson Point Inserts refer to Carlson points which include the block SRVPNO* with the point number, elevation, and description attributes.
Spot/Bottom Elevation Inserts include text entities that start with 'X'.

From File allows you to triangulate from the points in a coordinate (.CRD) or ASCII file. This option also provides access to the use of Point Groups as a data source.
Contours without triangulation network. The contours are smoothed, reduced, drawn at an interval of 2, and highlighted at an interval of 10 with labeling on the index contours.

**Pulldown Menu Location:** Surface  
**Keyboard Command:** tri  
**Prerequisite:** Data entities in the drawing, including points, inserts, lines, 2D polylines, 3D polylines, elevation text, 3D faces, and points from ASCII or coordinate (.CRD) files.

**Contour from TIN File**

This command creates contours directly from a TIN file (.flt or .tin) without the need to have the TIN drawn on the screen. The routine starts by opening the dialog for *Triangulate and Contour*, allowing the user to specify triangulation, contour and label settings. After pressing *OK* on the initial dialog, a second dialog opens, allowing for the selection of the TIN file from which to create the contours.

See the *Triangulate and Contour* section in the manual for a detailed description of each of the settings.
Prompts

Fill out the Triangulate and Contour Dialog information with the desired options. Select the desired TIN file and choose Open.

Loading edges...
Loaded 1994 points and 5944 edges
Created 3936 triangles
Removed 9 disconnected edges.
Reading points... 0
Contouring elevation 497
Inserted 1926 contour vertices.

The user may be prompted for additional information depending on settings used in the Triangulate and Contour dialog box.

Pulldown Menu Location: Surface >> Contour from...
Keyboard Command: cntrTIN
Prerequisite: A TIN file (.flt or .tin)

Draw Triangular Mesh

This command draws a triangulation (.flt or .tin) file as either 3D LINES or 3DFACEs. Since 3DFACE entities can be shaded within the 3D Viewer Window or 3D Surface FlyOver, or with the AutoCAD 3D Orbit command, this is an excellent tool for visual surface inspection. 3D Lines cannot be shaded.

Triangulation (.flt or .tin) files can be created by Triangulate & Contour.

Prompts
Select TMESH File to Draw
Choose a triangulation (.flt or .tin) file from the file selection dialog. You are then prompted for options:

If using Inclusion/Exclusion Perimeters, you will be prompted to select them as the routine executes.

Loading edges...
Loaded 198 points and 234 edges

This Triangulation mesh was drawn as 3DFaces with the Draw Triangular Mesh command, and then colorized by elevation within 3D Viewer Window

Pulldown Menu Location: Surface >> Draw Surface
Keyboard Command: drawtri
Prerequisite: A triangulation (.flt or .tin) file
File Name: \lsp\contour4.arx
Contour Elevation Label

This command can be used to simultaneously create elevation labels on a group of contour polylines at elevation. First the command starts with a dialog with the label options. Then to place the labels, pick two points crossing the contour polylines at the desired label location. The program will find all the contour polylines that intersect the picked line (defined by the two picked points) and will place labels at the intersection point of each contour. A second crossing line can be initiated immediately, so multiple areas can be quickly labeled while remaining in the command. Alternatively, you can type P for Polyline at the Command prompt and select a polyline. Then the program finds all the intersections between the selected polyline and the contours and places labels at these intersections. The actual “z” elevation of the contour line determines the label value.

![Contour Label Options](image)

<table>
<thead>
<tr>
<th>Option</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label Layer</td>
<td>CTXT</td>
</tr>
<tr>
<td>Label Style</td>
<td>STANDARD</td>
</tr>
<tr>
<td>Horizontal Scale</td>
<td>100.00</td>
</tr>
<tr>
<td>Text Size Scaler</td>
<td>0.1000</td>
</tr>
<tr>
<td>Label Prefix</td>
<td></td>
</tr>
<tr>
<td>Label Suffix</td>
<td></td>
</tr>
<tr>
<td>Decimals</td>
<td>0</td>
</tr>
</tbody>
</table>

- **Label Layer** specifies layer name for the contour labels that will be created.
- **Label Style** specifies the text style to be used for labels.
- **Horizontal Scale** is used in conjunction with the Text Size Scaler to determine unit height of the contour labels.
- **Text Size Scaler** is a scaler that will be multiplied by the horizontal scale to set the actual text height of the labels in AutoCAD units.
- **Decimals** sets the decimal precision for the labels to be created.
- **Label Position** determines the label position in relation to the contour polyline.
• **On Contour** centers the label on the contour line.

• **Above Contour** places the label above the contour line. If this option is used, the options for Break Contours at Label and Draw Broken Segments become inactive.

**Ignore Zero Elevation Polylnes** enables the routine to filter out all entities with an elevation of zero.

**Hide Drawing Under Labels** activates a text wipeout feature that will create the appearance of trimmed segments at the contour label, even though the contour line is still fully intact. This feature provides the user with the best of both worlds; you have clean looking contour labels, yet the contour lines themselves remain contiguous. This feature will also hide other entities that are in the immediate vicinity of the contour label.

When **Align Text with Contour** is checked, contour elevation labels will be rotated to align with their respective contour lines.

When **Break Contours at Label** is checked, the contour lines will be broken and trimmed at the label location for label visibility.

When **Draw Broken Segments** is checked, segments of contours that are broken out for label visibility will be redrawn as independent segments. Specify the layer for these broken segments in the box to the right of this toggle.

**Label By Distance** places the labels by distance along the contour. The user is not prompted for screen picks of contour crossing when this option is used.

• **Interval** sets the distance interval to be used between labels on each contour.

When **Draw Box Around Text** is checked, a rectangle will be drawn around the elevation labels. The Offset Scaler controls the size of the rectangle.

The **Draw On Real Z Axis** chooses between creating the text entities at the elevations of the contours or at zero elevation.

The **Use MText** chooses between creating MText and DText label entities.

**Label Index Only**: When checked, only Index contours are labeled.

**Prompts**

**Contour Label Options Dialog Opens** Select the desired options and press OK.

Define a line which slices the contours at the desired label locations.

Pick 1st point (P-Polyline, Enter to end): *pick a point*

Pick 2nd point: *pick a point*
By selecting two points the contour lines that cross the line defined by the two points are labeled.

**Pulldown Menu Location:** Surface >> Contour Labels  
**Keyboard Command:** gclabel  
**Prerequisite:** polylines with elevation (contour polylines)

## Move Label Along Contour

This command slides an existing contour label along a contour, maintaining its alignment with the contour. After moving the label, you can type F for Flip at the Command prompt to rotate the label orientation by 180. The label must have originally been created with the *Break Contours at Label* option *Off*. If the option to *Hide Drawing Under Labels* was used when the label was created, the wipeout will move with the label when using this command.

**Prompts**

*Select contour label to move:* *Pick label*  
*Pick new contour label position:* *Move mouse to relocate label*  
*Flip last/<Select contour label to move (Enter to end)>:* *press Enter*

**Pulldown Menu Location:** Surface >> Contour Labels  
**Keyboard Command:** move_ctr_label  
**Prerequisite:** generated contour labels

## Volumes By Triangulation

Volumes By Triangulation is a volume method that compares two triangulation networks. This method is different from the grid based volume routines (*Volumes By Layer, One Surface Volumes, Two Surface Volumes, Stockpile Volumes, etc.*) and the cross section volume routine (*Calculate Section Volume*). Volumes by Triangulation calculates faster in most cases than the other methods, and it is the most accurate because it uses true TIN to TIN prismoidal volumes. This added accuracy in general is very small. The grid resolution is usually sufficient to model the surface for the grid based volumes. The Volume By Triangulation accuracy applies well when there is a feature like a 5 foot...
wide ditch. Then the grid resolution would need to be less than 5 feet to model the ditch which might be difficult on a large site.

The disadvantage to this routine is that it lacks the output options that help the analysis of the volume such as Difference Contours. Also Volumes by Triangulation does no extrapolation and stops calculating volume at the perimeter of the smaller of the two triangulation networks. Volumes By Triangulation is better when used with point data instead of contour data because contour data requires triangulating all the contour polylines as breaklines which creates a large triangulation network and is slower.

The triangulation networks to compare are defined in .tin or .flt files that are created by Triangulate & Contour with the Write Triangulation File option. Note that while both file formats are supported, the newer binary triangulation file format (.tin) is twice as fast to load and save, and half the size, of the .flt triangulation file format. For this reason, the .tin file format is recommended. Before using this command, run Triangulate & Contour twice to create an triangulation (.TIN or .FLT) file for each surface. The volume calculation is limited by either the extent of the triangulation networks or by an inclusion/exclusion perimeter(s). These perimeters must be closed polylines.

Output data includes area, tons by density, average thickness, shrink and swell, ratio, and total volume.

**Shrink/Swell Factors**

An optional aspect of the Volumes by Triangulation routine is the ability to supply either a Cut "Swell" Factor and/or a Fill "Shrink" Factor to the results of the volume calculation. Having a solid understanding on the ramifications of each factor is important for determining how (and when) the values should be used for earthwork considerations.

The factors are commonly expressed as decimal differences from the "factor neutral" value of 1.00. In most cases, surface models are representations of what currently exists in the field or what is desired to exist after construction. Consider the following examples:

**Cut Swell Factor > 1 (example 1.15)**

Supplying a Cut Swell Factor greater than 1 would usually be taken to mean "How much volume will my 1,000 below?" usually be taken to mean "How much volume will my 1,000 below?" With a 15% swell factor (1.15) applied, the 1000 C.Y. of excavated material would now occupy 1,150 C.Y. of space.

**Cut Swell Factor < 1 (example 0.85)**

Supplying a Cut Swell Factor less than 1 would usually be taken to mean "How much volume will 1,000 C.Y. of material occupy when it has been compacted?" With a 15% compaction factor (0.85) applied, the 1000 C.Y. of material getting compacted would now occupy 850 C.Y. of the hole space.

**Fill Shrink Factor > 1 (example 1.10)**

Supplying a Fill Shrink Factor greater than 1 (see NOTE below) would usually be taken to mean "How much volume will this 1,000 C.Y. of material occupy if it were picked up and deposited elsewhere?" With a 10% swell of stockpile material would now occupy 1,150 C.Y. of space. With a 10% swell of excavated material would now occupy 1,150 C.Y. of factor (1.10) applied, the 1000 C.Y. of stockpile material would occupy 1100 C.Y. of space.

**Fill Shrink Factor < 1 (example 0.90)**

Supplying a Fill Shrink Factor less than 1 would usually be taken to mean "How much volume will 1,000 C.Y. of material occupy when it has been compacted?" With a 10% compaction factor (0.90) applied, the 1000 C.Y. of material getting compacted would now occupy 900 C.Y. of the hole space.

**Impacts/Usages of Cut/Fill Factors**

**Note:**

- In a design Fill scenario (such as a berm), often it is desired to know how much material would need to be brought in at a given compaction factor to occupy the design fill. To determine this value, use the following
equation:

\[
\text{Fill Factor} = \frac{100.0}{100.0 - \text{shrink \_percentage}}, \text{ using 15\% shrink as an example,}
\]

\[
\text{Fill Factor} = \frac{100.0}{100.0 - 15.0} = 1.17647
\]

**Prompts**

**Select EXISTING Surface Triangulation File**  *Choose an .flt or .tin file*

**Select FINAL Surface Triangulation File**  *Choose an .flt or .tin file*

**Select Inclusion polylines.**

**Select objects:** *select objects* that form a perimeter around the area of study

**Select Exclusion polylines.**

**Select objects:** *select objects* that form an exclusion area within the area of study

**Cut Swell Factor:** Supply an appropriate factor by which the calculated Cut volume should be multiplied.

**Fill Shrink Factor:** Supply an appropriate factor by which the calculated Fill volume should be multiplied.

**Use Report Formatter:** Choose between customizing the report and using the standard report.

**Volume Units and Area Units:** Choose the units to include in the report.

**Report Tons:** Enable this option to report the tonnage of Cut material and Fill material based on the material density.

**Density:** Indicate the average material density.

**Write TIN Difference:** Enable this option to create a TIN based on the elevation difference between the EXISTING surface and the FINAL surface.
Pulldown Menu Location(s): Civil &acirc;&dagger;; Surface &acirc;&dagger;; Volumes by Triangulation, Survey &acirc;&dagger;; Surface &acirc;&dagger;; Volumes by Triangulation

Keyboard Command: trivol
Prerequisite: Two .flt or .tin files

### Triangulation File Utilities

This command allows you to modify TIN surfaces in a variety of different ways, then allows for 3d viewing and shading of the modified surface and finally for saving the file with a choice of output formats. The focus of the routine is to elevate or lower the TIN or selected areas within the TIN, merge TINs with other surfaces, or use data from other TIN files to apply to the current TIN. Operations can be performed on the entire TIN or just on user selected Inclusion and/or Exclusion areas. The routine will automatically rework the TIN network for conformation to a selected boundary, say a building outline. In the case of said building, a value of 10 could be subtracted from the building outline. This will drop all of the triangulation within the outline by 10', thus creating a model of the excavated area for the building. The modified TIN can then be saved to a new file, which could be used to compute an excavation volume with Volumes by Triangulation. This routine does not allow for manual reconfiguration of the TIN network. This is performed under Surface Tools, also in the Contour pulldown menu. This routine also includes conversions to and from TIN files, DXF files and 3D Face entities.

Begin with the dialog shown here. First select a TIN model. You may choose between an .flt or .tin file, a DXF file (that includes 3DFACE entities), or 3DFACE entities in the current drawing. Specify the subject area by choosing inclusion or exclusion perimeters, then press the next button.

**Load TIN File:** Allows you to specify a triangulation (.flt or .tin) file to load.

**Load DXF File:** Allows you to specify a DXF file to load. Only loads 3DFACE entities from the selected DXF file.

**Select 3D Faces:** Allows you to select 3DFACE entities from the current drawing. This also includes rectangular 3d faces from a plotted grid.

**Pick Bounding Polylines:** Allows you to select any inclusion/exclusion perimeter(s). When this button is selected,
the user is taken back to the drawing and prompted to select the perimeters. Press Enter when the selections are finished to return back to the dialog.

**Fast TIN Intersect:** When checked, this command will perform a simple and fast check for overlapping triangles, so is the preferred choice in most cases. However, if problems with the TIN are suspected, this option should be unchecked, so that a complete and thorough check and repair of the TIN is performed.

**Fill-in-holes:** When checked, any missing triangulation or gap in the surface will be automatically filled in with additional triangles. This option has to be set before loading the TIN file to take effect.

**Region Mode:** This option deals with nested or overlapping boundaries. When checked, AutoCAD hatch pattern logic is applied, in which all nested boundaries are used in an alternating fashion, so that an Inclusion Boundary within an Exclusion Boundary is still recognized. If this option is not checked, everything within an Exclusion Boundary is ignored.

**Next:** Press this button to proceed to the next dialog after all selections have been made.

The next dialog allows you to perform mathematical operation(s) on the loaded TIN. Each operation is described below. Keep in mind that generally these operations are to be performed on an area inside your inclusion perimeter (but excluding anything inside your exclusion perimeters). If you do not specify any perimeters, the desired operation/s will be performed on the entire TIN.

![TIN Utility Interface](image-url)
Add Value: Prompts for a value to Add to the subject area of the TIN.

Subtract Value: Prompts for a value to Subtract from the subject area of the TIN.

Multiply Value: Prompts for a value to Multiply to the subject area of the TIN.

Divide Value: Prompts for a value to Divide to the subject area of the TIN.

Add TIN: Raises the subject area of the current TIN by the elevation value from a second user selected TIN file. This function is most applicable to applying a strata thickness TIN.

Subtract TIN: Lowers the subject area of the current TIN by the elevation value from a second user selected TIN file.

Min TIN: This does a comparison between the current TIN and a second user selected TIN file, and applies the lower value of the two TINs to the subject area.

Max TIN: This does a comparison between the current TIN and a second user selected TIN file, and applies the higher value of the two TINs to the subject area.

Merge TIN: Merges the current subject TIN into a second user-specified TIN file. There are three methods:
- Current TIN inside/Second TIN outside boundary: This method is only available when Bounding Polylines are selected in the first Triangulation File Utilities dialog. The current TIN will be used inside the boundary polylines and the second TIN is used everywhere else. The current TIN file should be the smaller of the two surfaces since the subject file will be joined or merged into the second file. For example, to merge a pad design into existing ground with this method, choose the pad design as the current TIN, pick the pad perimeter as the bounding polyline and use existing ground as the second TIN.
Second TIN inside/Current TIN outside boundary: This method uses the second TIN inside the boundary and the current TIN everywhere else. The outline of the second TIN is used as the boundary if no bounding polylines where selected in the initial dialog. For example, to merge a pad design into existing ground with this method, choose the existing ground as the current TIN and choose the pad design as the second TIN.

Wipe, combine and repair Current TIN where overlaps Second TIN: This method removes triangles from the current TIN for areas that overlap the second TIN. Then the second TIN is added into the current TIN surface and the gap between the current and second TINs is triangulated to stitch them together. This method is useful when the two TINs don't have matching have elevations on their common boundary. Then this method will create a transition zone between the TINs.

Enhance Flats: This routine eliminates flat triangles by adding a data point inside the triangle at a different elevation to subdivide the triangle. The elevation of this point is calculated based on the slopes of the neighboring triangles.

Offset: Performs a perpendicular offset (from the face/s) to the TIN surface by the specified amount.

Simplify: Causes edges within the Tin mesh to be collapsed to reduce the number of triangles, edges, and points within the mesh while having a minimal impact on the overall shape of the mesh. There are two methods. Elevation Difference looks at the effect of removing a point from the Tin. The point is removed if the elevation difference between the original point and the updated Tin is less than the tolerance. The Edge Cost method looks at the effect of removing an edge from the Tin.

Tolerance: This setting is used by the Simplify command described below. Specify the maximum average distance that any point can be moved outside of the plane of any triangle that connects to that point. Values might range from .01 to .1 for most purposes.

Passes: For elevation difference, this is the number of times the program will check through all the points.

Hold Breaklines: Further analyzes the TIN by focusing on the edges, calculating the angular difference between adjacent triangular faces. If the angular difference between edges is greater than the specified Breakline Angle, it is considered to be a breakline, and it is preserved. If it's angular difference is determined to be below the Breakline Angle, it becomes a candidate for removal. In that case, the Breakline Weight factor is applied to the corresponding vertex, adjusting it's original value. If the resulting value is still below the Tolerance, it is then removed. The number of vertices removed is inversely proportional to the Breakline Weight factor, so the greater the Breakline Weight factor, the fewer vertices that are removed, the lower the Breakline Weight factor, the more vertices that are removed.
TIN Statistics: Generates a report of the TIN statistics, including number of points, edges, and triangles, and minimum and maximum Z value.

Subdivide: Subdivides triangles to make them more equalateral.

Set New Elev: Sets all TIN faces in the subject area to the elevation specified.

Set NULLs to Elev: Sets all NULL values in the subject area to the elevation specified.

Set Elev to NULL: Sets all of the elevation values in the subject area to NULL.

Set Elev by Surface: Sets all TIN faces within the subject area to the elevations from a second surface file within the same area. You will be prompted to select a second TIN file or grid file. Only areas common to both surfaces will be applied to the subject TIN.

Output Options: The following three options determine what part or parts of the TIN modifications that will be saved to the new TIN file. If the entire TIN is to be saved, all three options should be toggled on.

- **Insides:** If this is the only option checked, only changes made to the TIN within the inclusion perimeter will be saved. TIN entities outside of the perimeter will not be saved to the named file.
- **Border:** When the routine re-works the TIN to fit around a perimeter, a small horizontal offset is automatically applied to prevent the formation of vertical faces. The Border function will save changes made to TIN in this offset area.
- **Outsides:** If this is the only option checked, TIN entities inside of the inclusion perimeter will not be saved to the named file. Everything outside of the perimeter will be saved.

Save As TIN: Saves the current TIN as an .flt or .tin file.

Save As DXF: Saves the current TIN as a .dxf file. This format can be used by many other CAD programs.

Draw As 3DFaces: Draws the current TIN as 3D Faces in the current viewport. The Layer window is used to specify the layer that the faces will be created in.

Converts the left mouse button to a zoom function. Hold the button down and move the mouse up or down to zoom in and out.

Converts the left mouse button to a rotate function. Hold the button down to rotate the view in any X, Y or Z direction. When the XY appears in the window, the rotation will occur relative to the XY axis. When the mouse
is moved toward the outer perimeter of the window, the XY will change to a Z. Holding the button down while the Z is visible will rotate the drawing on the Z axis. Converts the left mouse button to a pan function. Hold down on the button while moving the mouse to pan. Holding down the mouse wheel will also serve as a pan function in any of the above modes.

Toggles shading on and off. Restores the graphics to plan view. Reverses the effects of all operations performed on the TIN and reverts it back to its original status. This icon exits the routine. If the TIN has been modified, you will be prompted to save.

**Pulldown Menu Location:** Surface  
**Keyboard Command:** TINUTIL  
**Prerequisite:** 3D Faces, a TIN file or a DXF file.

### Surface Manager

The *Surface Manager* toolkit allows the user to modify pre-defined triangulated surfaces, making real-time modifications and updates to contours and associated TIN (Triangulated Irregular Network) definitions. Functionality includes swapping TIN lines, adding breaklines to the surface, adding or removing points, adjusting point elevations, removing TIN lines, drawing or removing contour lines and labels, re-contouring at a different interval or with different label settings, etc. Contour lines are automatically updated to reflect any changes made to the TIN. A surface must be named and saved by one of the surface modeling routines (in the Triangulate tab) as a prerequisite to using the *Surface Manager* tools.

![Surface Manager](image)

All of the tools available in the *Surface Manager* are also available in the *Surface > Triangulation Surface Manager* fly-out menu, as shown in this figure. Their functions are identical but require a surface to be set current. Changes made apply only to the current surface.
The Surface Manager dialog box contains the following options:

**Set Current** designates a surface as current for editing with various surface tool functions, such as modifying TIN lines, setting a new contour interval, labeling contours, etc.

**Add** allows you to add a surface by selecting a surface model file (.TIN or .FLT).

**Remove** allows you to remove a surface from the list of stored surfaces.

**Rename** allows you to rename a surface.

**Copy** creates a copy of the TIN file and adds the copy as a new entry.

**Edit** allows you to perform various TIN-related modifications to the current surface. Using the *Edit* function will activate the command line, where the user will be prompted with the following options:

**Add Point (AP)** adds a triangulation point to the network by picking a point from the screen. The pick must be inside an existing triangle. The elevation for the selected point is interpolated from the surrounding TIN network. This is a good method for adding additional triangulation to the surface in a sparse area. Also, a new elevation can be specified for the picked point. This function does not create Carlson points, and the point will not be saved to the .CRD file.

**Remove Point (RP)** removes an existing triangulation intersection from the TIN network. The affected triangulation re-adjusts to compensate for the missing intersection. Contours update accordingly.

**Move Point (MP)** is a combination of removing a point and adding it at a new location.

**Add Breakline (AB)** adds a breakline to the surface by picking beginning and ending points on the screen. The endpoint snap automatically turns on. Only one breakline can be created at a time. The TIN network will reconfigure to follow the new breakline and update the contours. This does not create 3d polylines in the drawing.

**Add Entities (AE)** adds a number of points and breaklines into the selection set by selection of existing entities into the current surface.

**Swap Edge** edges (SW) swaps common TIN edges to create two different triangles from the original triangle configuration. Contours automatically update to reflect changes made to the TIN. Some common edges may not be swapped because of the orientation of the two triangles.

**Set Elevation (SP)** sets a new elevation for a specified TIN intersection. The affected TIN is adjusted and the contours are updated.
Remove Tri (RT) removes a TIN line from the surface by picking a TIN line or selecting an interior point. Contours are removed from the affected area.

Hide Tris (ST) turns the TIN network on and off.

Point addition/removal and elevation-related changes made to the TIN are only reflected in the surface file and the contours resulting from that surface file. Point changes are not saved to the .CRD file and 3D linework is not updated in the drawing. Use traditional methods to update these entities if desired.

**Prompts**

The command line will prompt as follows:

Add Pnt(AP), Remove Pnt(RP), Move Pnt(MP), Set elev(SP), Add Breakline(AB),
Add Entities(AE), SWap edge(SW), Remove Tri(RT), Show/Hide Tris(ST), Press Enter when done.

**Adding points, Pick point or enter keyword**: Type in the two letters of the function to be performed and press enter.

**Add Points**

Add Pnt(AP), Remove Pnt(RP), Move Pnt(MP), Set elev(SP), Add Breakline(AB),
Add Entities(AE), SWap edge(SW), Remove Tri(RT), Show/Hide Tris(ST), Press Enter when done.

**Adding points, Pick point or enter keyword**: Press Enter to accept the default mode of Adding Points. Pick a point inside the TIN model at the desired location. The default elevation will be interpolated from the TIN model.

**Enter the elevation of new point [559.112171]: 560**

The surface will be recalculated using the input data.

---

Remove Points

Add Pnt(AP), Remove Pnt(RP), Move Pnt(MP), Set elev(SP), Add Breakline(AB),
Add Entities(AE), SWap edge(SW), Remove Tri(RT), Show/Hide Tris(ST), Press Enter when done.
Adding points, Pick point or enter keyword: *RP* Pick close to the area that you want an elevation point removed.

Add Breakline
Add Pnt(AP), Remove Pnt(RP), Move Pnt(MP), Set elev(SP), Add Breakline(AB),
Add Entities(AE), Swap edge(SW), Remove Tri(RT), Show/Hide Tris(ST), Press Enter when done.

Adding points, Pick point or enter keyword: *AB*
Pick near the 1st point of breakline: *Pick a point*
Pick near the 2nd point of breakline: *Pick a point* When adding a breakline, OSNAP Endpoint will default on.

Swap Triangle Edge
Add Pnt(AP), Remove Pnt(RP), Move Pnt(MP), Set elev(SP), Add Breakline(AB),
Add Entities(AE), Swap edge(SW), Remove Tri(RT), Show/Hide Tris(ST), Press Enter when done.
Adding points, Pick point or enter keyword: *SW*
Please select an internal edge to swap: Select desired edge.
Set Point Elevation
Add Pnt(AP), Remove Pnt(RP), Move Pnt(MP), Set elev(SP), Add Breakline(AB), Add Entities(AE), SWap edge(SW), Remove Tri(RT), Show/Hide Tris(ST), Press Enter when done.

Adding points, Pick point or enter keyword: SP
Pick near the point to have elevation set: Pick near point 34.
Enter new elevation of the point [597.200000]: 600

Remove TRI Line
Add Pnt(AP), Remove Pnt(RP), Move Pnt(MP), Set elev(SP), Add Breakline(AB), Add Entities(AE), SWap edge(SW), Remove Tri(RT), Show/Hide Tris(ST), Press Enter when done.
Adding points, Pick point or enter keyword: RT
To conclude the Surface Edit mode, press *Enter* at the end of the internal command sequence. This will return to the Surface Manager dialog. If user presses Escape key instead, the following dialog is displayed:

```
Choose Exit Option
Would you like to keep the surface changes?

[ ] Discard changes  [ ] Save the surface  [ ] Stay in the command
```

this prevents accidental data loss in case of unintentional use of Esc key.
**Properties** allows the user to alter the drawing display properties for TIN lines, contours and labels for the selected surface. Applicable dialogs from Triangulate and Contour are used to provide a full set of options. When accessed, settings for the current surface display configuration are set. To make a modification, simply specify the desired change and press ok. For instance, if Draw Triangulation Lines was checked on, unchecking the box and pressing ok will redraw the surface without the TIN lines. If the contours were drawn at 1 foot intervals, setting the interval value to 2 and pressing OK will redraw the contours at 2 foot intervals. Refer to the *Triangulate and Contour* section of the manual for a more detailed explanation of the options below.
Done exits the Surface Manager and saves any modifications performed to the surface/s updating the .flt or .tin file.

**Pulldown Menu Location:** Surface >> Triangulation Surface Manager  
**Keyboard Command:** surface mgr  
**Prerequisite:** A triangulated (non-grid) surface
Make 3D Grid File

This command creates a grid (.GRD) file which serves as a surface model for use in many of the other Surface routines. The program internally makes a triangular network of the data points (if Triangulation is selected as the modeling method) and then interpolates the elevation values of a rectangular grid at the specified grid resolution. Data points can be either points, inserts, lines, or polylines. Lines and polylines are treated as breaklines in the triangulation.

Gridding as a means of modeling surface features is generally less favorable than triangulating as the surface is defined only at the intersection of the grid lines. This can lead to inaccuracies around local features such as ditches or curb lines, since the grid resolution must be small enough to adequately capture the changes in these local regions. Contrast this with Triangulated Networks which carry all this information at every point along the features. Gridding can, however, be useful for modeling large sites in general trends such as watershed analyses and large-scale volume computations.

Grid superimposed over triangulated features

The grid location is specified by first picking a lower left corner and then an upper right corner. The screen cannot be twisted when this is done because grids always run north-south and east-west.
The dialog box sets the range of elevations to process, modeling method and grid resolution. Each of these items is described below.

- **Source Data:** This option selects the type of data to use for gridding. The Screen Entities option processes selected 3D entities from the drawing including points, lines, polylines, 3D faces and inserts. The Coordinate File and Text File options read point data from the selected file. These methods are useful for large datasets that would take extra memory and time to draw as points in the drawing. For the Text File, the program will prompt for the order of the fields and the delimiter. The Triangulation File option will interpolate the grid elevations from the selected triangulation surface.

- **Range of Elevations/Values to Process:** Entities with elevations or values outside the range to process are ignored and will not be used for the gridding.

- **Modeling Method:** The modeling method almost always should be triangulation for surface topographic grid files. Polynomial, inverse distance, kriging and linear least squares apply to random data points for surfaces like underground features, usually sourced by such methods as drillholes, data tables, etc.

- **Triangulation Mode:** When using Triangulation and Polynomial methods, there are four triangulation modes: AutoDetect, Triangulation Only, Intersection with Triangulation and Intersection Only.
  - **Auto Detect** method automatically chooses between the Triangulation Only and Intersection with Triangulation methods. If the selected surface entities are primarily made of polylines, then the Intersection with Triangulation method is used. Otherwise the Triangulation Only method is used.
  - **Triangulation Only** method builds a triangulation surface out of all the selected points, lines and polylines. All lines and polylines are treated as breaklines. Grid node elevations are calculated based on the triangulation.
  - **Triangulation with Subdivision** method uses the subdivisional surfaces modeling method. This option causes each triangle in the triangulation surface model to be subdivided into an average of three smaller triangles per subdivision generation. This gives a much smoother surface model, where instead of one triangle, there are now three or more.
  - **Intersection Only** method goes directly to the Steepest Intersection method using the selected lines and
The Steepest Intersection method is used to assign the grid node elevations from the linework of the triangulation lines and the selected lines and polylines. The triangulation step is skipped and any selected point data is not used. This method can be used for making grids out of polylines such as a contour map as long as the surface is defined just by contour polylines without needing spot elevation points. Skipping the triangulation step makes this method a lot faster especially for large files.

- **Use Inclusion/Exclusion Areas:** This option will prompt for inclusion and/or exclusion perimeter polylines and will only assign grid cell elevations within these areas and leave the rest of the grid cells as Null.

- **Grid Resolution:** The grid resolution is specified by either the number of grid cells or by the size for each grid cell. It is usually best to set the Dimensions of a Cell to a known size, and the program will calculate the "number of cells in X and Y." While the program can handle really large grids with no limit, a general rule of thumb is to keep the total number of grids cells under 500,000 (about 700 by 700 cells) to limit the processing time. The grid location and resolution can also be specified by using the position/resolution from an existing grid file. In this case, the location and resolution of the new grid will match those of the selected grid file which is useful for routines that require two grid files with identical locations and resolutions.

No elevations are calculated on grid cells that extend beyond the extent of the data. The figure shows an example of how the grid is calculated to the limits of the data points. Extrapolation can be used to calculate elevations for the grid cells that are beyond the data limits. When there are grid cells with no elevation in a grid (.GRD) file, many routines will prompt *Extrapolate grid to full grid size?* Extrapolation fills in all the grid cells. The method to extrapolate uses a safe calculation that tends to average out or level the extrapolated values. So extrapolated grid areas are not as accurate as grid areas within the limits of the data. *Grid File Utilities* can be used to apply and save extrapolation to a grid file. The *Plot 3D Grid* command can then draw the grid file so that you can see the extrapolation.

A Carlson grid (.GRD) file has the following format:

- **Line 1** is the lower left Y coordinate
- **Line 2** is the lower left X coordinate
- **Line 3** is the upper right Y coordinate
- **Line 4** is the upper right X coordinate
- **Line 5** is the X direction grid resolution
- **Line 6** is the Y direction grid resolution

The rest of the lines are the Z values of the grid intersects starting from the lower left moving in the left to right direction and ending at the upper right. If the intersect has no value, the letter 'N' is saved instead of the Z value for Null values. An example is shown in the Display-Edit Report dialog.
Griding from Contour Maps

A grid file can be created from contours represented as polylines with elevation. The program calculates the elevation of each grid corner by looking for contour intersections in eight directions (N, S, E, W, NE, SE, SW, NW) and then interpolating the elevation between the two steepest intersections.

To accurately model the surface, it might be necessary to add entities in addition to the contour polylines. For one, spot elevation points can be added for the high and low points. Otherwise the grid model might plateau at the last contour. Also 3D breaklines need to be added on long narrow ridge and valley contours because in these areas the program will find the same contour when it looks for intersections in the eight directions. When all eight intersections are the same contour, the interpolated grid elevation equals the contour elevation instead of rising up the ridge or dipping in the valley. The 3D breaklines force interpolation along the ridge or valley. To draw these polylines, set the OSNAP to Nearest and run the 3D Polyline command. Then draw the polyline by picking the contour polylines where the breakline crosses them. Another way to quickly create breaklines is to first draw 2D polylines. Then convert these polylines into 3D polylines with the Screen option in the 2D to 3D Polyline by Surface Model command found on the 3Dpoly menu. There is also an automatic way to draw these breaklines. Under 3D Data, use the command: Create Ridge polylines from Contours.

Prompts

Grid File to Create File Selection Dialog
Enter a name for the grid file.
Use position from another file or pick grid position [<Pick>/File]?
Pick Lower Left grid corner <8111.88,3985.08>: pick a point for the lower left limit of the grid
Pick Upper Right grid corner <8366.88,4195.08>: pick a point
Make Grid File dialog box
In this dialog, you specify the grid resolution and whether or not to include data points with zero elevations. You can specify the resolution by entering the number of grid cells in the X and Y directions. By the Dimensions option, you to set the X and Y size for each grid cell.
Reading points ...
Select points, lines, polylines and faces to grid from.
Select objects: Specify opposite corner: 1075 found
Select objects:
Reading points ... 980
Finding points on breaklines ...
Ignored 2729 duplicate points.
Inserting breaklines 3480 ...
Triangulating points ... 980
Assigning grid values > 1800
Writing grid file: C:\Carlson 2008\WORK\example1.grd
Pick the Lower Left grid corner: pick a point for the lower left limit of the grid
Pick the Upper Right grid corner: pick a point
Pulldown Menu Location: Surface
Keyboard Command: mkgrid
Prerequisite: Entities that define the surface

Draw 3D Grid File

This command draws the 3D grid mesh of the chosen grid (.GRD) file. Each grid cell can be drawn as a 3D Face entity, Polyface mesh, Text or temporary lines. 3D Faces and Polyface Meshes can be viewed/used in the following commands: 3D Viewer Window, Viewpoint 3D, Hide, Shade, 3D Surface FlyOver, and Slope Zone Analysis.

If Use Vertical Exaggeration is checked, grid elevations are multiplied by the value specified.

Exaggeration Method specifies whether to use an Absolute exaggeration method or Relative to Base, which uses the specified base elevation.
Specify the type of entities to draw in **Draw Method**. 3D Faces are described above. The Preview Only option draws the grid using temporary vectors. This method provides a much faster way to view the grid. However, these temporary vectors are erased when the viewport is modified. This means as soon as you execute zoom, redraw, regen or plot, this grid will disappear. You can quickly redraw the grid by typing in VG for View Grid at the command prompt. Polyface Mesh is similar to 3D Faces except it is a single entity. The Text option will label the grid elevation at the grid corner. The text is placed center justified over the grid corner. To reduce clutter, there is an option to skip rows and columns.

Specify the layer for the grid entities in **Layer Name**.

Specify the initial viewing direction in **View**.

When **Color by Elevation** is checked, the grid will be colored based on a table of user-defined elevation ranges and the assigned colors. There is also an option to subdivide the grid cells at the color zone transitions. This is similar to the Elevation Zone Analysis command. Use the Specify Elevation Zones command to define ranges and colors.

When **Draw Side Faces** is checked, the program will draw vertical faces around the perimeter of the grid. The side faces will be drawn vertically from the grid perimeter to the Sides Base Elevation. You may optionally specify the Sides Base Elevation; it defaults to 0.00.

When checked, **Reverse Face Order** changes the direction of the points for a grid cell from clockwise to counterclockwise. The order applies to shading the grid cell in 3D render viewers such as the 3D Viewer Window command. The grid cell will only appear shaded when viewing the grid cell from the clockwise side. Viewing from the other side will show a wire frame. The default is to show the shaded side from the top-down view. This option allows you to draw the grid so that the underside of the grid is shaded.

When checked, **Draw Corners Only** will draw the side lines only at the grid corners. Otherwise side lines are drawn down each perimeter grid cell.

When checked, **Extrapolate Grid to Full Size** draws the entire rectangular surface of the grid.

When **Use Inclusion/Exclusion Perimeters** is checked, it allows you to select inclusion and exclusion areas. Only grid cells inside the inclusion polylines will be drawn. Grid cells inside the exclusion polylines will not be drawn.

When checked, **Subdivide Grid Around Inclusion Perimeter** subdivides grid cells that are partially inside and outside the perimeter into smaller resolution grid cells.
Two Surface Volumes

Two Grid Surface Volumes calculates the cut and fill volumes between two surfaces modeled by grid (.GRD) files. These two grid files must have the same location and resolution. To create the grid files, use the Make 3D Grid File routine. When creating the second grid file, choose Use position of another file and select the first grid file. Using the position of the first grid file sets the location and resolution of second grid to match the first.

There are several other routines that calculate volumes based on grid files. Grid based volumes can be calculated by One Grid Surface Volumes, Volumes by Layer, Stockpile Volumes, and Pond/Pit Volumes. These routines have special prompting and calculate the grid surfaces and volume in one step.

Volumes by Two Surface Volumes has three steps:

1. Creating the first grid file with Make 3D Grid File
2. Creating the second grid file with Make 3D Grid File
3. Running Two Grid Surface Volumes

One advantage to this command is that you have more output options to help analyze volumes.

Besides grid based volumes, volumes can also be calculated between triangulation surfaces using the Volumes by Triangulation commands. Cross section end area is another volume method that is used by the Calculate Sections Volume command in the Civil Design module.

There are also options to specify inclusion and exclusion areas. When inclusion areas are specified, only the volume within this inclusion area is calculated. Important: Whenever possible you should use a polyline that represents the limits of disturbed area as the inclusion perimeter. Volumes within an exclusion area are not included in the calculations. Inclusion and exclusion areas are represented by closed polylines and must be drawn prior to calling this routine.

If the grid contains grid cells that have no elevations, you have the option to extrapolate elevations from the grid cells with elevations. When you choose not to extrapolate, no volume is calculated for the grid cells left without elevations. In general, extrapolation is not very accurate and should be avoided whenever possible. Sometimes you may get small amounts of cut in stockpiles that should only be fill, or small amounts of fill in pits that should only be cut. These extraneous quantities are due to extrapolation at the border and should be small enough to be ignored. When inclusion or exclusion polylines are used, the program will automatically extrapolate the grids. In addition to writing a volume report to the file, printer or screen, there are several volume report options.
Write Difference Grid File creates a grid (.GRD) file of the elevation difference of the two grid files.

Draw Difference Contours creates a contour map of the difference or depth between the two grid files.

Draw Elevation Difference in Each Cell plots the elevation difference at the grid corners which is the same as the Elevation Difference routine.

Draw Volume in Each Cell plots the calculated volume for each grid cell and is an excellent way to verify the volume calculation. If a cell contains both cut and fill, both values will be plotted.

Calculate Elevation Zone Volumes calculates the cut and fill between different elevation ranges.

Draw Cut/Fill Color Map fills each grid cell with different shades based on the average cut or fill in the cell. Red shades are used for cut and blue for fill. There is an option to draw a color legend. You can subdivide the grid cells at zone transitions. Also, there is an option to control the zone intervals and range.

Use Report Formatter allows you to customize the report by choosing the fields to report and their order. Also the report formatter can be used to output the report data to Microsoft® Excel or Microsoft® Access.

Process Another Area with Current Grids runs Two Surface Volumes again using the same grid files but different inclusion/exclusion polylines. This option saves the step of reloading the grid files to calculate volumes from the same grids for multiple areas.

The Cut Swell Factor value is multiplied by the cut volume in the report.

The Fill Swell Factor value is multiplied by the fill volume in the report.

Report Tons allows you to enter the material density and the program will report the cut and fill tons in addition to volume.

Given two accurate grid (.GRD) files, this routine will calculate accurate volumes. To verify the volume calculation, it is a good idea to check the grid (.GRD) files either by drawing them with Draw Surface >> Draw 3D Grid File and viewing them with the 3D Viewer or by contouring the grids with the Contour Grid File command.
Contours from the Draw Depth/Difference Contours option. Cut contours are red, fill contours are blue, daylight contours are green. This is a good way to check that both surfaces are modeled correctly and to verify the volumes.

Sample Two Surface Volumes report:

Volume Report

Comparing Grid: C:\scad2006\data\simo.grd
and Grid: C:\scad2006\data\final.grd
Lower left grid corner : 186551.67,57624.98
Upper right grid corner: 186828.81,57897.09
X grid resolution: 75, Y grid resolution: 75
X grid cell size: 3.70, Y grid cell size: 3.63
Total inclusion area: 37016.71 sq ft, 0.850 acres
Cut to Fill ratio: 1.14
Cut (C.Y) / Area (acres): 3642.35
Fill (C.Y) / Area (acres): 3182.70
Cut vol: 83570.89 cubic ft, 3095.22 cubic yards
Fill vol: 73024.56 cubic ft, 2704.61 cubic yards

Prompts
Select the Inclusion perimeter polylines or ENTER for none:
Select objects: pick a closed polyline for the limits of disturbed area
Select objects: press Enter
Select the Exclusion perimeter polylines or ENTER for none:
Select objects: press Enter
Specify Base Grid File Selection Dialog
Choose a grid (.GRD) file to process.
Extrapolate grid to full grid size (Yes/<No>)? press Enter If you enter Yes to this prompt, surface elevations will be computed for any grid cells that have null elevations.

Sample report from the Calculate Elevation Zone Volumes option:
(Calculates the cut and fill in different elevation ranges at a user-specified interval and beginning at a user-specified starting elevation.)

Volumes by elevation zone
Zone 20.00 to 30.00
Cut volume : 0.30 cubic ft, 0.01 cubic yards
Fill volume: 107.90 cubic ft, 4.00 cubic yards
Zone 30.00 to 40.00
Cut volume : 4.88 cubic ft, 0.18 cubic yards
Fill volume: 73021.14 cubic ft, 2704.49 cubic yards
Running total:
Cut volume : 5.18 cubic ft, 0.19 cubic yards
Fill volume: 73129.05 cubic ft, 2708.48 cubic yards
Zone 40.00 to 50.00
Cut volume : 65044.26 cubic ft, 2409.05 cubic yards
Fill volume: 0.25 cubic ft, 0.01 cubic yards
Running total:
Cut volume : 65049.44 cubic ft, 2409.24 cubic yards
Fill volume: 73129.29 cubic ft, 2708.49 cubic yards
Zone 50.00 to 60.00
Cut volume : 17786.85 cubic ft, 658.77 cubic yards
Fill volume: 0.00 cubic ft, 0.00 cubic yards
Running total:
Cut volume : 82836.29 cubic ft, 3068.01 cubic yards

Specify Final Grid File Selection Dialog
Choose a grid (.GRD) file to process.
Extrapolate grid to full grid size (Yes/<No>)? press Enter
Volume Report Options dialog
This shows a grid drawn by Plot 3D Grid File and volume values drawn by the Draw Volume in Each Cell option of the Two Surface Volumes routine. Cut appears as negative and fill as positive. Notice that cells bordering cut and fill regions contain a little of both.

**Pulldown Menu Location:** Surface >> Volumes By Grid Surfaces

**Keyboard Command:** volcalc2

**Prerequisite:** Two grid files

### Volumes By Layer

This is the easiest yet still equally accurate method for calculating volumes. For this command, volumes are calculated in one step by a simple window of the area, selecting the items, and calculate.

First, you must specify the grid location and resolution. The grid location should enclose the area for volume calculations. Next the program asks for the layer names of the entities for the base and final surfaces. You designate the layers to use for each surface either by typing the layer names or by picking from the screen, then during the routine you select the entities to use. You may safely use the keyword ALL to select the entities, since you have pre-defined the layers to use, and all those entities not on the specified layers will be filtered out. These entities, for use in modeling the surfaces, can be points, lines (such as triangulation lines), 2D polylines (such as contours), and 3D polylines (such as breaklines).

Inclusion and exclusion perimeters may optionally be specified to limit the volume calculation area on the grid. An inclusion perimeter should be used if there is a closed polyline for the limit of the disturbed area. Then the program internally generates grids of the surfaces from the entities on the corresponding layers and then calculates and reports the volume. The main disadvantage to this routine is that it doesn't have the special output options of Two Grid Surface Volumes such as Depth Contours.
Prompts

**Command:** layervol

**Pick Lower Left limit of surface area:** pick lower left corner of grid

**Pick Upper Right limit of surface area:** pick upper right corner of grid

You are then prompted to designate layers:

![Volumes by Layer window](image)

- Press **Select Layers from Screen** to show the routine which layers to use by selecting sample objects from those layers.

**Select entities on layers of Existing surface. select sample object(s)**

**Select objects:** Specify opposite corner: 3 found

**Select objects:** press Enter to conclude selection.

**Select entities on layers of Final surface. select sample object(s)**

**Select objects:** Specify opposite corner: 10 found

**Select objects:** press Enter to conclude selection.

**Reading points ...**

**Select surface entities on corresponding layers.**

**Select objects:** all filters out those objects not on designated layers

85 found

**Select objects:** press Enter to conclude selection.

**Reading points ...** 9396

**Assigning grid values > 5300**

**Pass > 28 Null Z values left > 0**

**Writing grid file:** C:\Documents and Settings\..\USER\grid1.grd

**Assigning grid values > 5300**

**Pass > 43 Null Z values left > 0**

**Writing grid file:** C:\Documents and Settings\..\USER\grid2.grd

**Select the Inclusion perimeter polylines or ENTER for none:** select inclusion perimeter

**Select objects:** 1 found

**Select objects:** press Enter to conclude selection.

**Select the Exclusion perimeter polylines or ENTER for none.**

**Select objects:** press Enter for none.
Pass 28 Null Z values left 0
Pass 43 Null Z values left 0
Pre-processing grid cells ....
Processing cells ...
Select point for color legend (Enter for None): press Enter

**Pulldown Menu Location:** Surface >> Volumes By Grid Surfaces

**Keyboard Command:** layervol

**Prerequisite:** Entities that define both the base and final surfaces.

**File Names:** \lsp\layervol.lsp, \lsp\makegrid.arx

### Spot Elevations By Surface Model

This command will calculate the Z coordinate of any point that falls within the surface model. Use this command to calculate the elevations for points of a design for slope staking or for putting spot elevations on a topography map. The calculated points can be stored in the current coordinate (.CRD) file. A surface model is either selected from a grid (.GRD) or triangulation (.TIN or FLT) file or internally calculated from the existing entities on the drawing.

Spot elevations can be calculated at various user-specified points or at a specific interval. For random spot elevations, the user picks or enters the X,Y coordinates for each spot elevations. The elevation at the current position of the crosshairs is displayed in real-time in a small window. For interval spot elevations, the alignment for the intervals is defined by a polyline that must be created before starting this routine.

**Prompts**
Source of surface model (File/<Screen>)? press Enter Use the File option to select a grid (.GRD) or a triangulation (.TIN or .FLT) file.

Layer for points <POINTS>: press Enter

Add spot points to Coordinate File (Yes/<No>)? Yes This option stores any points created in this routine to a .crd file and draws Carlson point entities.

Draw nodes only (Yes/<No>)? press Enter This prompt only appears if Add points to Coordinate File is off. This option either draws only POINT entities or an X mark and elevation text.

If you specified the use of a file for the surface model, you are then prompted to select the surface model file.

If you specified the use of Screen entities, you are prompted for:

Pick Lower Left limit of Surface area:
Pick Upper Right limit of surface area:

then the following dialog box appears with the settings to make a 3D Grid file:

For picked point spot elevations:

Random spot elevations or interval along pline (<Random>/Interval)? press Enter

Enter or pick point (Enter to end): pick a point
Enter or pick point (Enter to end): press Enter

For spot elevations along a polyline:

Random spot elevations or interval along pline (<Random>/Interval)? Interval
Pick the centerline polyline: pick a polyline
Interval along polyline <50.0>: 25
Number of left offsets <0>: 1
Enter left offset interval <25.0>: 10
Number of right offsets <0>: 2
Enter right offset interval <10.0>: press Enter

\[ \begin{align*}
41.48 & \\
39.71 & \\
45.33 & \\
41.75 & \\
50.44 & \\
\end{align*} \]

Spot Elevations with Add to Coordinate File off and Draw Nodes Only off
Interval spot elevations for points 1-32
"Random" spot elevations for points 33-37

Pulldown Menu Location: 3D Data
Keyboard Command: spotelv
Prerequisite: Surface entities or a grid (.GRD) file
File Names: \lsp\flatpond.lsp, \lsp\pond.arx

Tag Hard Breakline Polylines

This command tags polylines with a description so that Triangulate & Contour can identify these polylines as hard breaklines. The tag is invisible and doesn't change the polyline. Triangulate & Contour will not smooth the contours as they cross these hard breaklines, even with contour smoothing turned on. For example you could tag 3D polylines that represent a wall or a curb so that the contours go straight across without smoothing curves. If contour smoothing is turned off, this tag had no effect.

Prompts

Select hard breakline polylines. (For no smoothing in Triangulate & Contour)
Select objects: Select breaklines to tag
Select objects: press Enter to conclude selection
Set 14 polylines as hard breaklines.

Pulldown Menu Location: 3D Data >> Hard Breaklines
Keyboard Command: hardbrk
**Untag Hard Breakline Polylines**

This command removes hard breakline description tags from polylines. These tags are used by Triangulate & Contour to identify polylines as hard breaklines. Contours are not smoothed as they cross these hard breaklines, even with contour smoothing turned on. This routine untags polylines so that contours are smoothed across them. If contour smoothing is turned off, hard breaklines have no effect.

**Prompts**

Select polylines to remove hard breakline tag from.
Select objects: select polylines
Pulldown Menu Location: 3D Data >> Hard Breaklines
Keyboard Command: softbrk
Prerequisite: Polylines with hard breakline tag
File Name: \lsp\softbrk.lsp

**Design Pad Template**

This command creates design slopes from a perimeter polyl ine at specified cut/fill slopes to reach existing ground. This routine can be used to design building pads, pits, roads, ditches, stockpiles, etc. The design is drawn as 3D polylines for the cut/fill slopes and for the daylight perimeter where the design meets existing ground.

Before beginning this routine, you must have drawn the polyl ine representing the outside edge of the feature to model. The edge is drawn as a polyl ine which can be either a 2D or 3D closed or open polyl ine. For a 2D polyl ine, the program will prompt for an elevation for the pad perimeter. With a 3D polyl ine, the pad perimeter is set to the elevations of the 3D polyl ine. For an open polyl ine, the program will prompt for the side for the design. With a closed polyl ine, the program designs the slopes either outward or inward depending on the settings in the dialog.
Under **Source of Slope Target Surface Model**, choose between a Surface File (.GRD, .FLT, .TIN), Screen Entities, or a specific Elevation. If using Screen Entities, the routine internally calculates a gridded model, the limits of which are specified by screen picks. Make sure that the grid area covers the entire area for the pad including room for the cut/fill slopes.

For closed pad perimeters, there is a **Slope Direction from Closed Plines** option to draw the slopes inward or outward from the perimeter. The outward method starts the slopes at the design elevation of the perimeter and projects out to intersect the existing surface. The inward method projects the slopes inside to reach the grid surface or a set elevation. Outward sloping would be used for such things as building pads, parking lots, etc. where the interior remains as a defined surface. Inward sloping would be used for such things as the top edge of an excavated pit or pond where the interior side slopes project downward at the specified slopes until reaching the original ground surface.

The **Slope Projection Perpendicular To** option applies to sloping pad perimeters. The Pad Polyline method creates the user-specified slope perpendicular to the pad perimeter. The Slope Direction method accounts for the slope of the pad perimeter and makes the final surface to match the user-specified slope. For example, if the pad perimeter is at a 10% slope and the fill slope is at 2:1, then the Pad Polyline method would create fill slopes that are 2:1 perpendicular to the pad while slightly steeper (1.96:1) for the actual slope that goes in the slope direction with the effect of the sloping pad perimeter. For the same case except with the Slope Direction method, the resulting slope perpendicular to the pad is less steep (2.04:1) while the actual slope in the slope direction is exactly 2:1.

Under **Design Slope Format**, choose between **Ratio**, **Percent**, or **Template**. The use of a Template allows for complex slopes to be applied, and is also an alternative approach to road design. The template (.TPL) file is created in the **Design Template** routine in the Roads menu. When using a template, the pad perimeter represents the centerline. One way to create the pad perimeter for the template is to use the **Profile to 3D Polyline** command which converts a 2D centerline to a 3D polyline using a design profile. With a template, the program uses not only the cut and fill slopes from the template file but also draws all the template grade points such as edge of road, curb.
and ditch. The subgrade, superelevation and template transition options of the template file are not used in this command. These options are only applied in the Process Road Design command. The grade points are drawn as 3D polylines parallel with the centerline. Cross section 3D polylines that include the grade points are also drawn at the specified interval.

The Process Multiple Pad Polylines option allows you to process multiple pad perimeter polylines at a time instead of a single pad perimeter. The program will prompt for a selection set of pad perimeter polylines and then cycle through and run the design on each one. There will be one final report for the earthworks for all the pads. The Setup function allows you to specify different cut/fill slopes by layer and also to set the processing order by layer. For example, in the case of processing both building pads with a shallow slope and ditch polylines at a steeper slope, you could set up the processing order to do the building pad first and the ditch last so that the ditch cut slopes will carve out any overlap with the building fill slopes. These pad layer slope and order assignments can be saved and loaded from a .PAD file.

**Use Another Surface for Pad Interior** will bring up a prompt for another Surface file (.GRD, .FLT, .TIN) to use for the design surface within the starting pad perimeter. Otherwise the program will model the pad interior by straight interpolation from the starting pad perimeter elevations. For example, if a building pad has a starting pad perimeter at a set elevation and the pad is supposed to be flat, then this option is not needed. This option is needed in a case where you are designing a pit and the starting pad perimeter is a 3D polyline that follows an undulating pit bottom surface. The pad design will model the pit side slopes. In order to model the undulating bottom of the pit, you need the Use Another Surface for Pad Interior option to select a surface that models the pit bottom.

**Use Different Slopes for Separate Sides** allows you to specify different slopes for different sides of your pad polyline. If this is toggled ON, the Assign Pad Cut/Fill Slopes dialog is invoked, where you can create multiple Slope Groups along the Pad Template polyline and set the Cut and Fill design ratios for each.
Use Slope Pad Design allows you to set a cross slope amount for the top of the pad. You will be prompted to screen pick two points that designate the slope direction. For automatic balancing of cut/fill quantities, you will be prompted to find the optimal slope and slope direction.

Draw Slope Direction Arrows draws an arrow on the outslopes that points in the downhill direction. Arrows on fill slopes are drawn as solid filled.

Solid Cut Arrows allows you to choose between drawing the cut arrows as solid filled or as wire frame.

Round Exterior Corners holds the outslopes around the corners. Otherwise the side outslopes stay straight until they meet at the corners as shown in the figure.

Erase Previous Pad Entities erases drawing geometry created with this command previously.

When Draw Side Slope Polylines is ON, Design Pad Template will draw 3D polylines perpendicular to the pad perimeter from the pad to the catch point.

Color Side Polylines assigns different colors to Cut and Fill Side Polylines to make them easier to distinguish.
Example of pit design for option of Use Another Grid for Pad Interior

Pad corner without round corners option

Pad corner with round corners option

**Side Polyline Spacing** specifies the interval at which to draw the Side Slope Polylines. Besides at the interval, side slope polylines are also drawn at grid corners.
**Corner Delta Angle** is the delta angle in degrees between side slope polylines to span the delta angle around exterior corners.

Cut volume is multiplied by the **Cut Swell Factor** in the final volume report.

Fill volume is multiplied by the **Fill Shrink Factor** in the final volume report.

You must specify the **Pad Layer Name** that the pad 3D polylines will be drawn on.

There is an option to calculate volumes for the pad design. The volumes are calculated by comparing the existing surface with the pad design. The inclusion perimeter for the volume calculation is the daylight perimeter polyline which represents the limits of disturbed area. The existing surface model is defined by the existing surface file (.GRD, .FLT, .TIN) or screen entities selected at the beginning of the command. The pad design surface is calculated by making a surface from the pad 3D polylines including the starting pad perimeter, the side polylines and the daylight perimeter.

Besides calculating the volumes in the **Design Pad Template** routine, you can also calculate the volumes with the **Two Surface Volumes** command, or the **Volumes by Triangulation** command. Two Surface Volumes works with two grid files, Volumes by Triangulation works with two TIN files. The design surface for Two Surface Volumes can be the final output surface from Design Pad or you can create a design surface with **Make 3D Grid File** using the 3D polylines created in **Design Pad**. You could also create a TIN surface of the design surface using **Triangulate and Contour**. Some of the reasons to use either the Two Surface Volumes command or the Volumes by Triangulation command are that these volume routines have more output options (cut/fill color maps, etc.) and you can check the volumes by plotting or contouring the surface files. Also, you can combine several pads and other final surfaces by running **Make 3D Grid File or Triangulate and Contour** and then use these volume commands to calculate the overall site volumes.

The design is drawn as 3D polylines and the earthwork volumes are calculated. Before ending, the program allows you to adjust the design by changing the pad elevation, slopes and offset. The program can find the cut/fill balance by automatically adjusting the pad elevation. If adjustments are specified, the pad polylines are redrawn and the volumes recalculated. At the end, there is an option to trim existing contours inside the disturbed limits of the pad. Then there is an option to draw contours on the pad. If contouring is selected, a dialog lets you set the contouring options. Usually you should specify a new contour layer and turn off smoothing.

**A few Key things to note:**

1. If the Source of Slope Target Surface Model is set to a Surface File, and the surface file used is a grid file, then the surface produced from the designed pad will be a grid surface and a grid file (.GRD).
2. If the Source of Slope Target Surface Model is set to a Surface File, and the surface file used is a TIN file, then the surface produced from the designed pad will be a triangulated surface and a TIN file (.TIN).
3. If the Surface used as a Target Surface is listed in the Surface Manager, the prompt seen in the **Design Pad Template** command is whether or not to Update the Surface, which is the Target Surface, so if you say "Yes," your Existing Ground Surface will now essentially contain the designed pad. So if you want to maintain an unedited version of Existing Ground, you may want to start with a copy of the Existing Ground Surface.
4. If the Surface used as a Target Surface is not listed in the Surface Manager, the prompt seen in the **Design Pad Template** command is whether or not to create a new surface of the combined surfaces.
5. If you respond "Yes" to the prompt about whether to contour the designed pad, the contouring dialog box has an option of whether to write the designed pad as a new surface, which will be only the area within the limits of the new design, not the entire Target Surface and design pad surface combined.
Prompts

First you are presented with the Design Pad Template dialog box.

If the Source of Slope Target Surface Model is set to a Surface File, you will first be asked to:
**Pick the top of pad polyline:** *select perimeter polyline*
Then the Select Slope Target Surface dialog box is presented. Choose the Slope Target Surface file, pick Open. You then proceed to enter the slope parameters of the pad...

If the Source of Slope Target Surface Model is set to a Screen Entities, you will first be asked to:
**Pick Lower Left limit of pad disturbed area:** *pick lower left*
These prompts appear for the Screen Entities surface model method.
**Pick Upper Right limit of pad disturbed area:** *pick upper right* Be sure to pick these limits well beyond the area of the top of pad polyline in order to make room for the outslopes.
**Make Grid File Dialog** After selecting the limits of the disturbed area the program will generate a 3D grid that represents the surface. Specify the grid resolution desired and select OK.

Then, **Pick the top of pad polyline:** *select perimeter polyline*
Then proceed to enter the slope parameters of the pad...

**Enter the fill outslope ratio <2.0>:** 2.5
**Enter the cut outslope ratio <2.0>:** 2.5 After entering outslopes slope ratios, a range of elevations along the pad top will be noted.
**Enter the pad elevation <29.54>:** 39
**Calculate earthwork volumes (<Yes>/No)?** press Enter
**Adjust parameters and redesign pond (Yes/<No>)?** press Enter
**Write final surface to grid file (Yes/<No>)?** press Enter This option will output a grid file using the elevations of the pad within the disturbed area polyline and using the original ground surface everywhere else.
**Trim existing contours inside pad perimeter (Yes/<No>)?** press Enter
**Contour the pad (<Yes>/No)?** press Enter

Existing contours with top of pad perimeter polyline
Pad template with contours

3D view of pad with DTM of surface and triangulation faces of pad

Template to apply in Design Pad Template
Existing surface with 3D polyline centerline

Result of Design Pad Template showing template grade polylines, cross section polylines, cut/fill slopes, and final contours

Viewpoint 3D view of Design Pad Template
Design Pad Template can also handle self-intersecting side slopes

Viewpoint 3D view of intersecting side slopes

**Pulldown Menu Location:** Surface  
**Keyboard Command:** pad  
**Prerequisite:** A pad perimeter polyline and surface entities or a surface file for an intercept target.

## Convert LDD Contours

This command allows you to convert Autodesk Land Desktop contours (known as AECC_CONTOUR objects) into polylines. You must have the AEC Object Enabler installed before using this command. If you do not have the object enabler installed, download the latest version from [http://www.autodesk.com](http://www.autodesk.com).
Note: If no object enabler is installed, opening a Land Desktop drawing with contours will display large boxes for each contour, essentially outlining the extents of each one. In this case you will need to download the object enabler. If the object enabler is installed, contours will appear normally, and you can use this command to convert them to standard lwpolylines or you can use the *Explode* command. The Carlson *Convert LDD Contours* command is preferable only in the fact that it will search the drawing for AECC_CONTOUR objects and convert only those, while an *Explode* command could inadvertently explode other entities that you do not wish to be exploded.

You can use the *List* command to determine if contours are polylines or AECC_Contour objects. Here is an example listing:

**AECC_CONTOUR Layer: "CONT-MJR"**
- Space: Model space
- Handle = 429
- Major Contour Interval
- Elevation: 1005.00
- Smoothing: None
- Number of Vertices: 48
- Open
- Length: 560.25
- Constant width: 0.00
- Style Name: Standard

**Prompts**

Select AEC Contours to convert
Select objects: *pick the AEC contour entities*

Pulldown Menu Location: Surface >> Import/Export
Keyboard Command: aec_cntr
Prerequisite: AEC Contours to convert
File Name: \lsp\dtm1.fas

**Export Topcon Grid or TIN File**

This command writes a Topcon TIN file (.TN3) from 3d Faces, TIN lines, or triangulation files (.TIN, .FLT). If you choose to export from an existing surface file (.TIN or .FLT), you are only prompted to specify the file to read and the name and location for the Topcon file (.TN3) to create. If you specify the use of Screen entities for the source data, the following prompts are presented.
Choose Type of Export

- **Triangle Faces**: Triangulation networks that consist of edge matched 3D faces defined by three points.
- **Triangle Edges**: Triangulation Networks that consist of edges drawn with Lines defined by two points.
- **Triangulation File**: A Carlson triangulation file (.FLT only).

**Source Units**: Select the appropriate unit type of the entities to be exported, then press NEXT.

If the Triangulation File option is chosen, a standard windows file selection dialog will open to allow for the selection of the .flt file.

If Triangulation Edges or Faces are used for the export, you must select the entities to be exported from the screen. The following dialog opens:

**Manually Select** allows on-screen selection with any of the various methods (Window, Crossing, Crossing Polygon, etc.)
**All on a Selected Layer** allows selection of a single entity. The command then selects all Lines or 3DFaces on the layer of the selected entity for export, filtering entities not on selected layer.

Generally, you can select any entities drawn on the screen without special care. The command filters out all types except Lines or 3DFaces depending on the type selected.

When Processing Lines: Crossings, crossing polygon, and fence selection sets can often result in "spikes" around the edges. The command generally discards these spikes, or reconnects them. In any case, better results are developed with clean selections of drawing entities.

Pressing NEXT will open the following dialog:

![TopCon TN3 Export dialog](image)

**Other Features to Export:** Often, landmark lines, or other features will assist in orientation to the user when using the TN3 file in the field. For example, property lines, project centerlines, or other well established reference lines. These features may be added and displayed on the TN3 by choosing them at this prompting. The Other Features dialog opens with all three Source Formats.

Selections are made as described above.

Once the selections are made and the dialog reappears, press NEXT.

**Naming the TN3 File:** After all the triangulation and feature items are selected from the graphics screen, the command requests a name for the output file. Once a name is given, the following dialog reviews all the selections made. A description for the job can be added at this time. Press Finish when ready to proceed.
The program will process the selected entities and/or files and report as shown here:

![Image of TopCon TN3 Export window](image)

The program will process the selected entities and/or files and report as shown here:

![Image of TopCon TN3 Export window](image)

To view the final output, press the Run Simulation button, or press Exit to return to the Carlson program.
Slope Zone Analysis

This command calculates the surface area of a site in different slope zone ranges. This command can use either a surface model file, (.TIN, .GRD, or .FLT), or 3D Face drawing entities, which can be generated by the Plot 3D Grid File command, the Draw Triangular Mesh command, or the Draw Triangulation Faces option of Triangulate & Contour. For each slope zone, the 3D Faces can be hatched with any AutoCAD hatch pattern, including the SOLID pattern, or left empty with the NONE pattern.

This command can also generate contours of the slope zones based on the calculated slope at each point of the 3D Faces. The slopes can vary greatly between neighboring points. When contoured directly, these slope data
points produce incoherent contours. Instead this routine applies a filtering algorithm that reduces the noise. There is another option to output a grid file of the slope values.

There are also options to specify inclusion and exclusion areas. When inclusion areas are specified, only the slope area within the inclusion polyline is calculated. Slope area within an exclusion polyline are not included in the calculations. Inclusion and exclusion areas are represented by closed polylines and must be drawn prior to calling this routine. Without inclusion and exclusion polylines, all the slope area of each selected 3D Face is used.

**Prompts**

**Source of surface model:** [File/Screen]? F for File

**Slope Zone Options dialog box.** Choose whether to Draw Slope Zone Contours, whether to Output Grid File of Slope, and Slope Format. Pick OK

Select surface model file.

**Define Ranges dialog.** Specify the slope zones, colors and patterns from lowest to highest. Pick OK.

Select the Inclusion perimeter polylines or ENTER for none: select perimeter(s) or press Enter

Select the Exclusion perimeter polylines or ENTER for none: select perimeter(s) or press Enter

Report is generated.

If you choose to draw Slope Zone Contours, the Contour Options dialog box is presented.
Note: If you choose to use Screen entities instead of a surface model file, you are prompted whether to:

- Apply hatch patterns to grid cells [Yes/<No>]?
- Freeze grid layer after processing [Yes/<No>]?
Surface contours

3D Faces from a grid surface model

3D Faces created by *Triangulate & Contour* with the Draw Triangulation Faces option
Slope zone contours that follow the surface contours using the triangulation 3D Faces.
Quick Profile

This command allows you to create a profile in one step. The alignment for the profile can be defined using picked points, a centerline file or a polyline. The surface for the profile can be defined by 3D screen entities, 3D polyline or surface files (grid or triangulation).

**Screen Entities:** The program creates the profile by finding the intersections of the centerline with 3D linework entities in the drawing. There's an option for whether to ignore entities at zero elevation.

**3D Polyline:** Creates a profile using a selected 3D polyline. The polyline vertex elevations are used for the profile elevations and the profile stations are from the lengths of the polyline segments.

**Surface File:** This option allows you to use one or two grid or triangulation surfaces. There's also an option to Show Pipe Crossings which will find and display pipe crossings from sewer networks and 3D polylines tagged as pipes. The sewer network can be created in the Hydrology module. To tag a 3D polyline as a pipe, use the Assign Pipe Data To Polyline command.

Since picked points are the default for the horizontal alignment, the command is as quick as select surface type (screen or file), then *Pick, Pick, Enter* and view. The resulting profile is displayed in a graphic dialog box with real time data reporting. As the crosshairs are moved across the profile in the window, the station, elevation and slope data corresponding to the current crosshair location appear in the lower right of the window. A second crosshair on the plan view corresponds to crosshair movement along the profile so the user knows exactly where
the current profile point is on the plan view. Also the Adjust Alignment function allows you to drag a horizontal alignment point and update the profile in real-time.

**Quick Profile Options**

- **Source Of Surface Model**: Select Screen Entities, 3D Polyline, or Surface File.
- **Ignore Zero Elevation Linework**: Check to ignore zero elevation linework.
- **Show Pipe Crossings**: Check to display pipe crossings.
- **Surface File(s)**: Select files.

**Quick Profile**

**Vertical Exaggeration**: Determines the amount of vertical exaggeration for the profile in the window.

**Drag Action**: Determines whether the right mouse button functions as "Zoom" or "Pan" in the profile window.

**Grid Ticks Only**: Instead of the full graph as shown above, Grid Ticks only plots only ticks along the horizontal and vertical axis near the station and elevation text.

**Adjust Alignment**: Allows you to pick a horizontal alignment point and while moving it, the profiles are updated in real-time. You can also select a horizontal alignment segment and move the whole alignment position. The Adjust Alignment function is only available when surface files are used as the source of the surface model.

**Save**: Writes the current profile data to a .PRO file.

**Draw**: This draws the profile with grid in the drawing. The user has options for horizontal and vertical scales and the layer of the profile. The Draw Profile command includes more options for drawing the profile. In order to use this command, you must first create a .PRO file using the Save command described above.

**Print**: This makes a graphic report of the profile in either PDF or DWF format as selected under Settings->Configure.

**Exit**: Exits this command.

**Help**: Opens on-line help.
Note that the Draw option will exit the Quick Profile command after the drawing is complete. A typical completed drawing, in this case with two surfaces, is shown below. Note also that the horizontal stationing text offset follows the setting in the Draw Profile command itself.

![Graph showing a completed drawing with two surfaces.](image)

**Prompts**

**Pick starting point (CL-Centerline, P-Polyline):** screen pick alignment points for profile  
Pick second point: pick next point  
Pick next point (Enter to end): press enter to end  
Tested 58 of 58 Entities Intersects found > 33  
Dialog Box

- **Pulldown Menu Location:** Profiles  
- **Keyboard Command:** quickpro  
- **Prerequisite:** 3D screen entities or surface file

**Profile from Surface Entities**

Profile from Surface Entities creates a profile from contours, triangular mesh, and other 3D drawing entities. The method is to draw a polyline as the profile centerline. Then the profile is derived from the intersections of this polyline with the 3D entities. For added accuracy in pulling the profile, include the triangular mesh as well as the contours.
**File:** Displays the name of profile to be created.

**Beginning Station:** Specify the beginning station for the profile.

**Interpolate Endpoint Elevations from Beyond Profile Extents:** When checked, the program will look past the ends of the centerline for additional intersections with 3D entities. These additional intersections will then be used to interpolate the elevation at the starting and ending station of the centerline.

**Extrapolate Endpoint Elevations to Extents of Profile:** This option uses the slope of the last two elevation points of the profile and calculates the elevation of the endpoint from this slope.

**Station by another reference centerline:** When checked, the program will prompt you to pick another centerline polyline. The intersection points along the first centerline are then projected onto the second centerline. The profile then stores the elevation of the intersection with the station along the second centerline.

**Breakpoint Descriptions from Layers:** When checked, breakpoint descriptions are assigned based on layer name of surface entities. These descriptions are used in routines such as Input-Edit Profile and Profile Report.

**Ignore Zero Elevation Lines in Surface Model:** When checked, any zero elevations selected in the surface model are ignored.

**Profile Offsets:** Specify optional offset profiles. Enter offsets separated by a space. Example: 30 -30 (to create 30’ left and 30’ right offset profiles). After entering the offset values, press TAB to select file options described below.

**Offset Profiles to:** Specify whether offsets profiles should be created as separate profile (.PRO) files, or included in a single profile (.PRO) file. Only available if you specify Profile Offsets above. Offset profiles are automatically named by combining the profile name and the offset. For example, if the profile is named NATGRD.PRO and you create a 30’ right offset profile, it will be named NATGRD30.PRO.

### Prompts

**Profile File to Write dialog** Specify a new profile file (.PRO) name to create.

**Profile from Surface Model dialog** Make choices, click OK.

**Polyline should be drawn in direction of increasing stations.**

**CL File/<select polyline which represents the profile centerline>:** pick the centerline (Do not press Enter.)

**Select Lines, PLines, and/or 3DFaces that define the surface for profiling.**

**Select objects:** C (for crossing and window everything the centerline crosses) or All (to select all objects on the drawing)
Keyboard Command: prosm
Prerequisite: A polyline centerline and surface lines and polylines.
File Names: \lsp\scadprof.dcl, \lsp\proflap.lsp, \lsp\plinsct.arx

Profile from Grid or Triangulation Surface

This command creates a profile (.PRO file) from a centerline polyline and a surface model stored in a 3D grid file (.GRD) or triangulation file (.TIN or .FLT). The polyline defines the alignment of the profile and the grid defines the surface.

After selecting the reference surface file, there is a Profile Options dialog with these options:

**Link Profile To Triangulation:** This option will update the profile whenever the reference triangulation is modified.

**Type of Centerline:** This setting chooses the type of stationing for centerline curves.

**Station by Another Reference Centerline:** This option option uses a second reference centerline for the stationing of the profile. The main centerline is used to find the elevations on the surface and then these main centerline positions are projected onto the reference centerline to get the stationing. The reference centerline needs to extend along the full range of the picked polyline in order to project correctly and capture offsets along the entire length of the picked centerline.

**Profile Offsets:** In addition to creating the profile along the centerline, you can also create profiles offset left and right.

![Profile Options dialog](image)

**Prompts**

**Choose Grid or Triangulation file to process** Select existing .GRD, .TIN, or .FLT file.
**Profile Options dialog.**
**Choose PROfile file to Write dialog** Enter a profile file (.PRO) name to write.
**Polyline should have been drawn in direction of increasing stations.**
**CL File/<Select polyline that represents centerline>: select a polyline**
**Polyline should have been drawn in direction of increasing stations.**
**CL File/<Select Reference centerline polyline>: select a polyline**
**CL File/<Select Reference centerline polyline>: press Enter**
Reference CL starting station <0.0>: press enter

Pulldown Menu Location: Profiles > Create Profile From ...
Keyboard Command: progrid
Prerequisite: A .GRD grid file, .TIN, or .FLT tmesh file

Profile from Points on Centerline

This command creates a .PRO file from points and a centerline that is represented by a polyline or centerline file. The elevations of the profile are derived from the elevation of the points and the stationing for these profile points is calculated from the distance along the centerline. The points must be within the offset distance from the polyline in order to be included in the profile. The profile is created by projecting the points perpendicular onto the alignment to determine the station and the elevation comes from the point elevation. The polyline or centerline should be drawn (or defined) in the direction of increasing stations. The points can be selected from point entities in the drawing (Screen), by point numbers from the current coordinate file (Numbers), or by point group as defined by the Point Group Manager (Group).

Prompts

PROfile file to Write dialog box: Enter a new profile file name to write.
CL File/<Select polyline that represents centerline>: pick a polyline or choose C for Centerline
Select Centerline file if Centerline option is used. If the desired points are further from the centerline, enter a larger maximum offset tolerance.
Note: for all selected points, the points should be located on the real Z axis.
Select the Carlson points along the centerline.
Select objects: Select the point entities.

Keyboard Command: profpts
Prerequisite: A polyline centerline and points
File Names: \lsp\profpts.lsp, \lsp\regrade.arx
**Input/Edit Profile File**

Similar to the Input/Edit Road Profile command, this command features a spreadsheet type editor and handles a variety of profile (.PRO) configurations. Besides editing a profile, this routine can be used to just view the contents of a profile.

The command starts by prompting for the profile file to edit. Alternately, you can run Input/Edit Profile by double-clicking on a profile polyline that is drawn on a profile grid.

The opening dialog below shows the layout of this editor. At the top of the dialog, you can dynamically see the profile and vary its appearance by using zoom and pan. The station, elevation and slopes are also shown at the lower left of the dialog which update/track with the movement of the cursor. There are between five and nine possible data fields in a profile depending on the type of profile that has been selected.

---

**Profile Name:** This name is optional and often used when multiple profiles are stored in a profile (.PRO) file and graphically generated using the Draw Profile command.

**Add Row:** Adds a new row into the profile after the current row.

**Remove Row:** Removes the current row.

**Type of Profile:** There are 6 types of .pro files and the spreadsheet columns will change to match the data fields for the selected profile type:

- **Generic** - Generic profiles have station, elevation and description fields.
- **Road** - Road profiles include the Generic controls and adds a vertical curve field.
- **Sewer** - Sewer profiles include the Generic controls and adds step up, pipe size, pipe thickness, manhole elevation and manhole ID fields.
- **Pipe** - Pipe profiles include the Generic controls and adds a pipe size field.
- **Crossing** - Crossing profiles are for pipe crossings along the centerline. Besides station and elevation, the crossing data points also have the pipe size. The crossing elevation is for the bottom elevation of the pipe. The crossing profile data points are not connected.
• **Circular** - Circular profiles are the same as Road profiles except the vertical curve is circular instead of parabolic.

**Select:** Selects a reference profile and displays it in the profile graphic view immediately.

**Sag-Crest Points:** When editing a road profile, its sag/crest points are shown here.

**Through Pt:** This button lets user to make the road profile pass through a certain point.

**Vertical Exaggeration:** Changes the look of the profile.

**Check Stations:** Reports profile information at the specified stations. The Check Stations are not stored in the profile; they are merely used as a design/analysis tool for viewing the elevations at certain stations while adjusting the profile data.

**Speed Tables:** This button is enabled only when you edit a road profile. Please refer to the documentation on Input-Edit Road Profile for the information on Vertical Speed Tables.

**Next:** Used for navigation when editing a .PRO file containing multiple profiles, loads the next profile.

**Previous:** Used for navigation when editing a .PRO file containing multiple profiles, loads the previous profile.

**Load:** Used for loading another, existing .PRO file for editing.

**Save:** Saves the profile using the current profile file name. The current profile file name is displayed in the top title bar of the dialog box.

**SaveAs:** Allows you to save the profile under a different profile file name.

**Report:** Creates a report of current profile.

**Undo:** Reverts the last action in the editor.

**Settings:** Opens the settings dialog.

![Input-Edit Profile - Settings](image)

**Hold Next Slopes:** When editing a profile elevation, this option will maintain all the slopes after the edit point by adjusting the elevations. Otherwise, the elevations for the rest of the profile points are held and the slope from the edit profile point to the next profile point is adjusted.

**Hold Current Elevation:** When you change a PVI's station or elevation, if this toggle is on, its slope out will be changed and the elevation of the next PVI is held, otherwise its slope out is held and the elevation of the next PVI will be changed.

**Use K-Value:** Toggles between displaying K-Value and Sight Distance in the fifth column for road profiles.
Show Slope When Zoom In: This option allows to display the slopes on the long enough profile segments when zoom in.

Grid Ticks Only: Toggles between displaying the grid and grid ticks in the graphic box.

Set Grid Interval: This option allows you to control the elevation grid spacing in the graphic preview. When this option is off, the program automatically figures the elevation grid interval.

Enable Additional Invert-In Fields for Sewer Profiles: When editing a sewer profile, this option allows you to display an extra invert-in column for in-coming pipes. The invert-in elevations are separated by commas.

Enable Cradle Fields for Sewer Profiles: When editing a sewer profile, this option allows to display cradle above and cradle below columns.

Grid Mode: The **Dynamic** option will update the grid interval labels when you zoom in or out of the profile image. The **Static** option will keep the grid interval labels static.

Tools: Opens the Tools dialog.

**Translate:** Globally adds or subtracts value to stations and/or elevations within the specified range of stations. while Scale will apply the specified scale factor to stations and/or elevations within the specified range of stations.

**Scale:** Applies the specified scale factor to stations and/or elevations within the specified range of stations.
**Reduce**: Reduces the profile points by the Offset Cutoff value.

![Reduce Profile](image)

**Reverse**: Reverses the direction of the stationing for the profile.

**Cradle Setup**: Sets up the cradles for sewer profiles. The cradle parameters are different with different pipe sizes and are defined in the Pipe Size Library. You can either use library data or specify new values here.

![Profile Cradle Setup](image)

**Pulldown Menu Location(s)**: Profiles  
**Keyboard Command**: profedit  
**Prerequisite**: None

**Draw Profile**

*Draw Profile* is a flexible routine for drawing a profile anywhere in the drawing. The profile may be drawn with or without a grid or with just tick marks. The vertical curve annotations for a road profile and manhole annotations for a sewer profile, may also be drawn. Draw Profile uses the profile information that is stored in .PRO files. Once the profile is drawn using Draw Profile, the design and labeling routines of the Profiles dropdown are applicable to the profile.
The first step in Draw Profile is to choose the profile (.PRO) file(s) you want to draw. The graphic window shows the highlighted profile in the list. The Set button allows you to indicate a "primary" centerline that is used as the basis for stationing when creating Plan & Profile sheets. Add and Remove buttons allow you to select more profile files to the list and remove the highlighted profile from the list. The Clear button removes all the profiles. When a highlighted profile file has multiple profiles, the Multiple Profile button is enabled, which opens a dialog for choose which profile to draw. The Open Set and Save Set buttons are used to load or store the profile selection to a .PST file. Click OK button to go to the next step. The Draw Profile dialog box appears, and contains all of the settings for creating the profile.

This option will draw a grid and axis elevations for the profile. Pick Setup to access Grid Setup dialog.
**Horizontal Grid:** Enter a value of how often grid lines should be displayed to coincide with the station values along the horizontal axis of the grid.

**Horiz Major Grid:** Enter a value of how often major (or "heavy") grid lines should be displayed to coincide with the station values along the horizontal axis of the grid.

**Station Text:** Indicate how often station text labels should appear along the horizontal axis of the grid.

**Vertical Grid:** Enter a value of how often grid lines should be displayed to coincide with the elevation values along the vertical axis of the grid.

**Vert Major Grid:** Enter a value of how often major (or "heavy") grid lines should be displayed to coincide with the elevation values along the vertical axis of the grid.

**Elevation Text:** Indicate how often elevation text labels should appear along the vertical axis of the grid.

**Grid Direction:** Profiles can be drawn Left to Right (the default) or Right to Left. Although most profiles are drawn left to right, if you have a road that runs East to West and you wish to draw the profile stationing beneath the actual road stationing, then choosing a Right to Left profile may be appropriate.

**Vertical Grid Adder to Top:** This adds the specified amount of grid to the top of the profile.

**Vertical Grid Adder to Bottom:** This adds the specified amount of grid to the bottom of the profile.

**Grid Style:** This selects the type of Grid to generate. The choices are Grid Lines, Ticks Only, Ticks and Dots, Ticks and Checks.

**Label Scale:** Click on this option and you obtain a scale drawn at the lower left corner of the profile. Click the Setup button to establish desired Scale labels and placement values.

**Label Stations:** Disable this option if you do not want station labels to be placed along the grid.

**Label Station Equations:** Disable this option if you do not want station equation labels to be placed along the grid.

**Station Type:** Indicates the preferred style of station formatting.
**Station Text Orientation:** This option allows you to specify the orientation of the station text shown along the bottom of the profile. The example below shows both options:

![Station Text Orientation Diagram](image)

**Use Partial Labels for Intermediate Stations:** Enable this toggle if the "full station" content to the left of the "+" symbol should be omitted at intermediate stations. This is useful for large station values where intermediate station labels are desired. When enabled (assuming 100' station values), an intermediate station such as 1023+50 would simply be annotated as +50.

**Increment Station Text from Beginning Station:** Enable this option if you wish to have the station text labels be relative to the starting station value. For example, if the starting station value is 0+23.68 and the Station Text interval is 50, station labels of 0+73.68, 1+23.68, 1+73.68, etc, would be generated.

**Label Elevations:** Disable this option if you do not want elevation labels to be placed along the grid.

**Draw Elevation Bar:** Click on this option if you desire to have a vertical barscale displayed. It will run up and along the left-most vertical grid line of the profile.

**Draw Elevation Labels Only On Left Side:** Enabling this option eliminates elevation labels on the right side of the profile.

**Elev Text Vertical Justify:** Indicate vertical justification for the elevation labels.

**Offset Elevation Text:** This option offsets the left-side vertical axis text using the specified Offset Scale.

**Offset Station Text:** This option offsets the horizontal axis Station text by the specified Offset Scale, allowing the insertion of elevation or other information above the stationing. It is often used in conjunction with the Label Horizontal Axis options.

**Stack Profile Grids:** This option allows to stack profile grids for multiple profiles. In the Setup dialog, all profiles in the multiple profile file are listed and you can choose which one goes to first grid, which one is second and so on.

![Stack Profile Grids Setup](image)

**Grid Vertical Spacer:** Indicate the amount of vertical space between successive grids.
Plan Only, Profile Only, or Plan and Profile sheets can be created. The options within Sheet Setup become available when this toggle is checked on. Pick Setup to access the Sheet Setup dialog.

![Sheet Setup Dialog](image)

**Choose Space:** Indicate whether sheets are to be drawn to Paper Space (also known as a Layout) or to **Model** Space.

**Layout Name:** Enter a name for the paper space "tabs" to be assigned to each layout for each sheet. The program will automatically divide the plan view and the profile view into sheet layouts, and if the length of the profile extends beyond a single sheet, then multiple layouts are created, with the layout name ID incremented by 1.

**Note:**

- The "Tile Sheets" toggle needs to be disabled for the auto-incrementing functionality.
- If either the **Start Station in Layout Name** or the **End Station in Layout Name** options are enabled, the Layout Name field will be disabled as the Layouts will get named automatically.

If you enter "ms" to go to model space within a Layout tab, you can pan to alter the plan view position. However, it is best to zoom in/out and edit within the Model tab. The Layout tabs appear at the bottom of the screen, along with the "Model space" tab to go back to standard plan view:

```
Model | Layout1 | LAYOUT2
```

**Start/End Station in Layout Name:** These options allow you to include starting and ending station in the Layout Names.

**Block Name:** This is the drawing name for the plan and profile sheet to be inserted. Carlson provides a standard plan and profile border in the form of profile.dwg located in the working folder of %AppData%\Carlson Software\...\Sup. You may wish to revise profile.dwg and add your company logo, and re-save it as profile1.dwg. Alternatively, you could add your own complete version of a Plan and Profile sheet block/border. Be aware that the **Draw Right to Left** option in Draw Grid is superseded when Draw Sheet is enabled. Note that the Sheet mode will re-orient the centerline left to right, which may cause text (such as the stationing) to plot upside down, until you use the Flip Text command.
Sheet Width: This is the profile width, in inches, on the sheet.

Lower Left Offset X/Y: Indicate the offset value(s) for the insertion point of the sheet in CAD units. This option allows user-defined Block Names to be properly positioned relative to the remainder of entities placed through the Draw Profile command.

Draw Profile Grid Lines: Enable this option if your Block Name does not contain profile grid lines and if you want profile grid lines to appear on the sheet.

Draw Plan/Grid to Full Sheet Width: Enable this option if you want to have "partial" sheets (typically found at the end of a Plan & Profile Sheet run) occupy the full width of the sheet.

Sheet Contains: This drop list allows the selection of which type of sheet to generate. The choices are Plan and Profile, Plan Only or Profile Only.

Plan View Lower Y: This sets the lower position of the paper space window for the plan view. With Lower Y set to 9 (inches above the base of the sheet) and Top Y set to 21, there is a 12 inch vertical window, running the full Sheet Width (typically 30 to 32). This window for the plan view can be expanded or reduced with these settings.

Top Y: This sets the top vertical limit for the plan view window, measured in inches from the bottom of the plan and profile sheet.

Plan/Profile Gap: Indicate the amount of vertical separation between the Plan portion of the sheet and the Profile portion of the sheet.

Draw North Arrow in Plan View: This draws a North Arrow in plan view. Click the North Arrow Settings button to establish the desired North arrow and placement information.

Draw Layout Plan View Borders in Model Space: This draws the borders in Model Space which can be useful or orienting text and other labels to the orientation of the sheet.

Plot at 1:1: With this clicked on, the sheet will be paper size, designed to be plotted at 1:1. A 30-inch profile sheet will measure 30 units, even though the centerline and profile may be 1500 feet in length. If the Scale 1:1 option is turned on, then you cannot check the distances of features using commands such as Bearing and Distance on the Inquiry menu, because the distances will be scaled down by a factor equal to the drawing scale (for example, at 1"=50', the reduction in scale factor is 1/50 or 0.02). You can set the absolute starting coordinate for the 1:1 scaled plot by setting the Sheet Lower X and Sheet Lower Y values. With this clicked off, the profile will drawn full size, with a 1500-foot profile measuring 1500 feet.

Fit Each Vertical: With this option turned on, the command will recognize the lower and upper vertical elevations of the profile and set the vertical axis elevation range to enclose the actual elevation limits of the profile. With this option turned off, you can enter the lower vertical elevation range, dropping it down further to increase the lower margin. Whether or not the Fit Each Vertical option is turned on or off, you are always prompted for the top elevation range.

Tile Sheets: If clicked on, only one Layout is created in paper space, and all sheets appear in this single Layout as tiles of individual sheets, much like the tiles mode of viewing files within Windows Explorer.

Label Match Line: When clicked on and multiple sheets are plotted with plan view option on, a match line will plot in the plan view.

Overlap STA: In multiple plan and profile sheet plotting, after the first sheet, all subsequent sheets will have the first 2 stations in common with the last 2 stations on the previous sheet, if the Overlap Station option is turned on. For example, if the last 2 stations are 3+10 and 3+20 on sheet 1, then sheet 2 will start with 3+10, then 3+20, with this option turned on. With this option turned off, if the first sheet ends with 3+20, then the second sheet would begin with 3+20.
This option creates elevation labels along the horizontal axis. Pick Setup to access the Horizontal Axis Elevations settings dialog.

**Horizontal Label Text Interval:** Indicate how often the profile elevation labels should be placed along the horizontal axis of the sheet.

**Existing/Final Grade:** Indicate the appropriate profile, precision, text scale, layer, style and color for the text labels.

**Text Layout:** Indicate whether the text labels should be oriented vertically or horizontally.
**Label Offset Scale:** Indicate the distance from the horizontal axis for the labels. If the value is negative, the labels are placed above the horizontal axis.

**Elevation Difference Options:** If both existing grade and final grade are to be drawn, you may choose to also label the Cut/Fill depth value that separates the existing and final profiles at each station.

This option draws a boxed area underneath the profile. It is best used in standard Draw Grid mode, with Draw Sheets clicked off. Pick Setup to access the Horizontal Label Box Setup dialog. An example of the resulting plot is shown here:

![Horizontal Label Box Setup dialog](image)

When enabled, this option allows you to detail additional slope information onto selected profiles.
Indicate the desired profile(s) whose slope annotation you'd like to control and click on the Setup button for expanded criteria.

When enabled, this option will label station values along the profile line above each break point in the profile. Pick **Setup** to access the Break Point Station Setup dialog.
When enabled, this option will label elevation values along the profile line at each break point in the profile. Pick Setup to access the Break Point Elevation Setup dialog.

When enabled, this option will label descriptions along the profile line at each break point in the profile. Pick Setup to access the Break Point Description Setup dialog.
When enabled, this option will label elevation difference values along the profile line at each break point in the profile relative to a reference profile (e.g. existing grade). Pick Setup to access the Break Point Elevation Difference Setup dialog.

Reference Profile: Indicate the profile that should be used as the point of comparison for the break point locations.

Decimal Shift Right: Indicate the number of places to shift the decimal point to the right. For example, if a traditional elevation difference was calculated to be 1.234 and the Decimal Right Shift value is set to 1 (a factor of 10), the reported elevation difference would be shown as 12.34.

Click this button to establish if it desirable to have a leader and/or break point symbol used in conjunction with the Draw Break Point Sta and/or Draw Break Point Elev options.
When enabled, this option will label the location(s) of any road(s) from an identified RoadNet™ that intersect the main road.

<table>
<thead>
<tr>
<th>Link To Files: This setting controls the linkage of the plotted profile(s) to the actual profile file(s) (.PRO), determining how changes to the file affect the plotted profile(s):</th>
</tr>
</thead>
<tbody>
<tr>
<td>• <em>Off</em> - Changes to an underlying profile file do not trigger a change to its drawn profile.</td>
</tr>
<tr>
<td>• <em>Prompt</em> - Changes to an underlying profile file trigger a prompt if its drawn profile should be updated.</td>
</tr>
</tbody>
</table>
• **Auto** - Changes to an underlying profile file result in an automatic change to its drawn profile.

**Match Line Elevations:** For high relief profiles that might otherwise extend up and into the plan view portion of the drawing, the Match Line Elevations option can be used to break the profile and redraw the remaining portion vertically shifted to remain in the profile portion of the sheet.

**Elevation Range:** This is the range of elevations that is used in conjunction with the Match Line Elevation option. If the range is exceeded (that is, if the range greater than 40), the program will break the profile and draw the remainder with a separate vertical axis range.

This button opens Vertical/Circular Curve Settings dialog. From a wide variety of available labels, you are able to create your own label selections very conveniently. Each label can be edited individually through the Setup button. You can specify the prefix, suffix, symbol style, decimal places, text orientation and position, *etc.*, in the Edit Label dialog.
**Draw PVI 'V':** You can choose to draw either a full tangents style PVI 'V' point, or a partial tangents style, or nothing.

**Label Placement:** This setting determines where to place the vertical curve labels. There are six options: Pick Single Row, Pick Individual Position, Auto Place Above Highest PVI Point, Specify Offset from Grid Top, Offset from Curve - Aligned, Offset from Curve - Horizontal.

**Label Offset from Grid/Curve:** Indicate the distance from the Grid or Curve when the **Label Placement** option is set to Offset from Grid Top or Offset from Curve, respectively.

**Draw Vertical PVC & PVT Lines:** This option draws vertical lines emanating from the PVC and PVT of all vertical curves.

**Label PVI When VC=0:** When vertical curve length is 0, no label is created unless you choose this option and then the PVI label would be shown.

**Draw Slope Direction Arrow:** Draws an arrow to indicate slope direction.

**Arrow Direction:** You can choose from Profile Direction, Uphill Slope Direction and Downhill Slope Direction.

**Draw Vertical Interval Labels:** This option labels the intervals of the vertical curve section. In its setup dialog, you can specify the intervals, distance from the vertical curve to put the labels, decimal places to display the interval stations and elevations, symbol settings and label settings.

Here is an example of a road profile.
EOP Profile Setup

This button allows you to establish the criteria for drawing and labeling Edge of Pavement (EOP) profiles:

**Begin/End Front Curb Return:** Enter a description for the front curb return.

**Begin/End Back Curb Return:** Enter a description for the back curb return.

**Include Road Name:** Enable this control if you'd like the road name included with the edge of pavement profile.

**Draw VC Labels for EOP Profiles:** When enabled, this option will label vertical curves found in edge of pavement profiles.

**Draw Curb Return Length Label:** When enabled, this option will label the length of curb returns. Use the Setup button to specify and control the display settings.

**Draw Curb Return Elevation Labels:** When enabled, this option will label the elevations of curb returns. Use the Setup button to specify and control the placement and display settings.

This button opens Pipe Crossing and Link Label Options dialog, which contains all the settings for drawing a pipe crossing type or profile, or the pipe crossings when pipes or sewer networks in the drawing are intercepted by a profile to be drawn.
Pipe Symbol: Options to show pipe crossing in either circle or square.

Text Rotation: Labels can be drawn either horizontally or vertically. This option becomes disabled when the Draw Annotations with Leader option is enabled.

Label Prefix/Suffix: Indicate labels that should precede and/or follow the pipe information.

Label Decimals: Decimal places of the labels.

Label Station/Elevation/Size/Name: Options to label the parameters or not.

Station Crossings By Another Centerline: This option will make new stations by referencing the profile to another centerline, for example a road centerline.

Draw Pipe Crossing On-The-Fly: When this option is chosen and there are pipes or sewer networks drawn in the drawing, the program will prompt to select a reference centerline that represents one of the profiles to be drawn to detect the pipe crossings. Any pipe crossings found would be drawn with other profiles.

Draw Parallel Pipes Within a Swath Width: When this option is chosen and there are pipes or sewer networks drawn in the drawing, the program will prompt to select a reference centerline that represents one of the profiles to be drawn to detect if there’s any pipe segments that are within a swath width along the profile. Any pipe segments found would be drawn with other profiles.
Draw Annotations with Leader: When enabled, this uses a leader in conjunction with pipe labels.

Link Label Settings: Settings to determine how to draw link labels.

An Example of Pipe Crossings On-The-Fly
An Example of Parallel Pipes Within a Swath Width
This button opens Draw Sewer Options dialog.

General Tab

The sewer profile labels can be drawn in the following four styles:

**Draw Horiz Axis Annotations:** Labels sewer profile along the horizontal axis.

**Draw Annotations At Manholes:** Creates sewer profile labels at the top of manholes.
**Draw Annotations with Leader from Rim Position:** Creates sewer profile labels with a leader from manhole’s rim position.

**Draw Annotations with Leader from Invert Position:** Creates sewer profile labels with a leader from manhole’s invert position.

Each style has a setup dialog to specify which labels are to be created and in what order. For labels with leaders, you can setup the leader styles.

![Sewer Label Settings](image)

**Label Invert Elev w/ Vert. Line:** Draws a line from the invert elevation to the profile grid and creates the invert label along the vertical line.

**Tick Mark for Station:** Draws a tick mark at every station.

**Project Invert In/Out Elev at Manhole Center:** The Invert In/Out elevations are not the actual values, but are projected elevations to the manhole center.

**Station Manholes by Another Centerline:** This option will make new station for each manhole by referencing the profile to another centerline, for example a road centerline.

**Draw Sump:** When enabled, specify the height of the sump to be drawn into the sewer profile.

**Draw Base:** When enabled, specify the base height to be drawn into the sewer profile.

**Label Precision:** Click on the Label Precision button to set the amount of precision used for sewer station, elevation, length and slope labels.

**Manhole Tab**

On this tab, you are able to specify how to label the manhole name and how to draw the manholes.
Draw Manhole Name: Enable this option and select the desired geometric shape that shall circumscribe the manhole name.

Draw Manhole Sides Down To Invert: Closes the manhole at pipes.

Manhole Rim Elevation Prompt: Ignores the manhole's rim elevation and prompts to enter new values.

Manhole Rim Offset Prompt: Prompts to enter the offset value and adds the offset to the manhole's rim elevation.

Manhole Width Prompt: Enable this option to prompt for the top width of the manhole.

Manhole Bottom at Pipe Slopes: Enable this option to prompt for the bottom width of the manhole.

Draw Manhole Separate from Pipe Polylines: Enable this option to draw the shape of the manhole as a separate polyline from that of the pipe.

Manhole Name Prefix/Suffix: Indicate any type of label that should be pre-pended or appended to the manhole name.

Draw Vertical Line Through Manhole Center: Draws a vertical line through the manhole center from rim to bottom of profile grid.

Manhole Name Prefix/Suffix: Indicate the desired prefix and/or suffix to be applied to the manhole name.

Drop Across Manhole: Adds a step up to the invert-in elevation.

Taper Format, Manhole Dimensions: When drawing from a profile file created with the Design Sewer/Pipe Profile command, these parameters are used to define the manhole shape and dimension. When drawing from a profile created with the Export to Profiles command, these settings are ignored.

Pipe Tab

Here you can choose to label pipe in a very flexible order. Each label has a setup function which specifies the label prefix and suffix, decimal places, row number and etc.
Pipe Label Position: Indicate the preferred location for pipe labels.
Labeling Method: Indicate the preferred method for determining the length of the pipe.
Pipe Material: Indicate the type of material used for the pipe.
Label Pipe Distance as Station Along Horiz Axis: This option creates pipe distance labels as the station style along the horizontal axis. Click the Setup button to access the labeling method and style.

Draw Flow Arrows: Indicate if arrows should be drawn illustrating the direction of flow.
Draw Cradle Lines: If the sewer profile contains cradle data, this option would draw cradle lines above and below the pipe segments.
Draw Outside Dimension of Pipe: When enabled, the outside dimension of the pipe will be labeled.
Draw Pipe Label as MTEXT: When enabled, text labels will be drawn as a multiline text (MTEXT) entity.
Fit Pipe Label Between Structures: When enabled, this option will ensure that pipe labels will fall within a structure-to-structure distance.
Pipe Labels

This button opens Pipe Label Options dialog. Pipe Profile Labels are very similar to Sewer Profile Labels; the difference is that Pipe Profile Labels don't have manhole information. There are fewer settings for Pipe Profile Labels than for Sewer Profile Labels since the Pipe Profiles are less frequently used.

Horizontal Scale: Supply the horizontal scale. This value is used to set the "zoom level" for the Plan portion of a Layout. The horizontal scale factor is also used to determine text sizes. If a given text scalar is 0.1 and the horizontal scale is 50, then text size will be $0.1 \times 50 = 5$.

Vertical Scale: This scale sets the vertical exaggeration of the profile. If the horizontal scale and vertical scale are the same, then the vertical is not exaggerated. Profiles are often plotted with a 5 or 10 vertical exaggeration. For example, the horizontal scale may be 50, but the vertical scale may be 5.

The Layers, Colors, Text Styles/Sizes and Linetypes buttons provide access to settings for each of these features of the profiles.
Back: Allows you to return to the previous dialog box to alter or adjust the information it provides.

Load Settings: Loads a saved collection of Draw Profile settings, saved in a (.PFS) file.

Save Settings: Saves all Draw Profile settings in a (.PFS) file.

When OK is clicked at the base of the dialog box, the prompting at the command line continues.
Prompts (may vary based on Settings)

Polyline should be drawn in direction of increasing stations.

CL File/<Select pipe crossings on-the-fly or parallel pipes centerline>: Pick a polyline upon which to base the stationing or Type C to select an existing Centerline .CL file and then press Enter

Centerline Starting Station <0.0>: Press Enter to accept the default station value specified or Type in the beginning station then press Enter

Pulldown Menu Location(s): Civil → Profiles, Survey → Surface, Field → Roads

Keyboard Command: drawprof

Prerequisite: A profile .PRO file

Profile to 3D Polyline

This command converts a 2D polyline centerline into a 3D polyline that follows the elevations of the profile. Horizontal and vertical curves are represented as a series of polyline segments since 3D polylines cannot contain arcs.

Profile to 3D Polyline can be combined with other commands for plan-view road design as follows:

1. Draw 2D polyline centerline.
2. Profile from Surface Model - to create existing surface profile.
3. Design Road Profile - to design the final profile with vertical curves.
4. Profile to 3D Polyline - create a 3D polyline of the road centerline.
5. Offset 3D Polyline - offset the 3D polyline centerline left and right by the horizontal and vertical distances.
6. Design Pad Template - run twice for left and right polylines of road to tie into surface at specified cut and fill slopes. This creates the limits of the disturbed area. Or use Join Nearest, Direct Connect Endpoints, to create a closed loop pad with one run of Design Pad Template for simple ramps, driveways and access roads.
7. Triangulate & Contour - draw final contours using road 3D polylines.
8. Volumes - use any of the volumes commands to calculate cut and fill volumes.

Prompts

Layer Name for 3D Polyline <3DPROF>: press Enter
Select profile centerline polyline: pick a polyline
Station by another reference centerline [Yes/<No>]? N for no. This option will prompt for a second centerline to use for stationing.

Enter the starting station <0.0>: press Enter
Select Profile File
Starting station of centerline <0.0>: press Enter
Erase centerline (Yes/<No>)? Y This option will erase the original 2D polyline centerline.
Example of road design in plan-view with Profile to 3D Polyline

**Keyboard Command:** proto3dp

**Prerequisite:** A .PRO file and a centerline polyline

**File Name:** \lsp\profedit.arx

**Profile To Points**

This command creates Carlson points along a horizontal alignment polyline using a profile file to compute the point elevations. The created points are stored in a coordinate (.CRD) file and can also be drawn on screen in the layer specified by the user. Station text, profile name, and special points (vertical and horizontal PC’s and PT’s) can be stored in the point description depending on user settings.
Create points at Profile special points: Includes vertical PC and PT points.
Create points at Centerline special points: Includes horizontal PC and PT points.
Create points at Station Intervals: Allows you to specify intervals for point creation.
Interval On Line Segments: Specify station interval for line segments.
Interval On Curve Segments: Specify station interval for curve segments.
Station to Begin Intervals: Specify station to start intervals.
Prompt For Additional Odd Stations: Any station can be entered to create additional points with elevations derived from the profile.
Create Points on Centerline: When checked, points will be created on the centerline.
Create Left Offset Points: When checked, left offset points will be created. Specify the offset in the edit box.
Create Right Offset Points: When checked, right offset points will be created. Specify the offset in the edit box.
Vertical Offset of Profile: Specify the vertical offset. Enter zero for no vertical offset.
Plot Points: When checked, points will be plotted in the drawing, otherwise points are only added to the current coordinate (.CRD) file.
Include profile name in point descriptions: When checked, the profile name will be used as the prefix on the point description. For example, if the profile name is DESIGN.PRO, then the point description might be DESIGN 0+63.37.
Decimal Places: Specify the display precision for points that are plotted in the drawing. This setting does not affect the coordinates stored in the CRD file.
Centerline by: Click either Polyline or CL File.
Type of Centerline: Click either Roadway or Railroad.
OK: Specify files.

Prompts

Select Coordinate File to Process
If the current coordinate is set, it is used automatically without this prompt.
Select profile centerline polyline: pick a polyline
Station by another reference centerline [Yes/No]? N for no. This option will prompt for a second centerline to use for stationing.
Starting station of centerline <0.0>: press Enter
Choose Profile to Process dialog Specify a profile name.
Starting point number <1>: press Enter This defaults to the point number after the highest one currently in the CRD file.
Station for additional point (ENTER to end): press Enter This option will create a point at the specified station. Prompt occurs only if option is specified in dialog.
Points created along profile centerline using elevations from the above road profile

**Keyboard Command:** pro2pts  
**Prerequisite:** A .PRO file and a centerline polyline  
**File Name:** \lsp\profedit.arx

**Profile Conversions**

There are eleven Profile Conversion commands, all of which are listed below. The first nine in the list are Import Profile commands. These commands allow you to convert a single profile file from their respective program to the Carlson profile (.PRO) format. For each, you are prompted to select the file to be imported, then provide a Carlson profile file name. Underneath each of the nine brief descriptions shown are, in bold, the prompts that you see in dialog box form and/or on the command line.

The last two commands listed below are Export Profile commands. They allow you to convert a single Carlson profile (.PRO) file to Softdesk (.TXT) format, or a single Carlson profile (.PRO) file to Leica (.GSI) format. You are prompted to select the Carlson profile file, then provide a name for the Softdesk or Leica file.

**Import Columnar Text**

Allows you to Import a comma or space delimited text file to create a profile (.PRO) file.
Import CAiCE Profile

Allows you to convert a single CAiCE (.KCP) profile file to the Carlson profile (.PRO) format. You are prompted to select the CAiCE file, then provide a Carlson profile file name.

Pulldown Menu Location: Profiles > Profile Conversions
Keyboard Command: caice2pro
File Name: \lsp\profedit.arx

Import Leica Profile

Allows you to convert a single Leica profile (.GSI) file to the Carlson profile (.PRO) format. You are prompted to select the Leica file then provide a Carlson profile file name.

Choose Leica/Wild File to Readdialog Select existing file.
Choose Profile to Writedialog Select file name.

Pulldown Menu Location: Profiles > Profile Conversions
Keyboard Command: wildpro2
File Name: \lsp\profedit.arx

Import MOSS Profile

Allows you to convert a single MOSS profile (.INP) file to the Carlson profile (.PRO) format. You are prompted to select the MOSS file then provide a Carlson profile file name.

Choose MOSS Profile File to Readdialog Select existing file.
Choose Profile to Writedialog Select file name.

Pulldown Menu Location: Profiles > Profile Conversions
Keyboard Command: moss2pro
File Name: \lsp\profedit.arx

Import Softdesk Profile
Allows you to convert a single Softdesk profile (.TXT) file to the Carlson profile (.PRO) format. You are prompted to select the Softdesk file then provide a Carlson profile file name.

**Pulldown Menu Location:** Profiles > Profile Conversions  
**Keyboard Command:** dcapro2  
**File Name:** \lsp\profedit.arx

**Import Sokkia/SDR Profile**

Allows you to convert a single Sokkia/SDR (.SDR or .RAW) profile file to the Carlson profile (.PRO) format. You are prompted to select the Sokkia/SDR file, then provide a Carlson profile file name.

**Pulldown Menu Location:** Profiles > Profile Conversions  
**Keyboard Command:** sdr2pro  
**File Name:** \lsp\gisutil.arx

**Import Spanish ALZ Profile**

Allows you to convert a single Spanish ALZ profile (.INP) file to the Carlson profile (.PRO) format. You are prompted to select the Spanish ALZ file and then provide a Carlson profile file name.

**Choose CLIP File to Read** dialog Select existing .ALZ file.  
**Choose Profile to Write** dialog Select file name.

**Pulldown Menu Location:** Profiles > Profile Conversions  
**Keyboard Command:** alz_to_pro  
**File Name:** \lsp\eworks.arx

**Import Spanish RAS Profile**

Allows you to convert a single Spanish RAS profile (.RAS) file to the Carlson profile (.PRO) format. You are prompted to select the Spanish RAS file and then provide a Carlson profile file name.

**ISPOL File to Read** dialog Select existing .RAS file.  
**Choose Profile to Write** dialog Select file name.

**Pulldown Menu Location:** Profiles > Profile Conversions  
**Keyboard Command:** ras_to_pro  
**File Name:** \lsp\eworks.arx

**Import Terramodel Profile**

Allows you to convert a single Terramodel (.RLN) profile file to the Carlson profile (.PRO) format. You are prompted to select the Terramodel file, then provide a Carlson profile file name.

**Pulldown Menu Location:** Profiles > Profile Conversions  
**Keyboard Command:** tm2pro  
**File Name:** \lsp\gisutil.arx

**Export Softdesk Profile**
Choose Profile File to Read dialog Select existing .PRO file.
Choose Softdesk File to Write dialog Enter new Softdesk file name.

Pulldown Menu Location: Profiles > Profile Conversions
Keyboard Command: dcapro1
File Name: \lsp\profedit.arx

Export Leica Profile

Choose Profile File to Read dialog Select existing .PRO file.
Choose Wild File to Write dialog Enter new .GSI file name.
GSI file format [<8>/16]? press Enter

Pulldown Menu Location: Profiles > Profile Conversions
Keyboard Commands: wildpro1
File Names: \lsp\cogoutil.arx
The GIS menu shown below has commands for managing and reporting data attached to drawing entities.
GIS Database Settings

This command sets the current Template and Output MDB files. The Template MDB file defines the GIS codes and the field names for each code. The Output MDB file is the database file where any new data will be stored. The MDB files for the Template and Output MDB files can be set up as either new MicroSoft® Access ’97 or new Microsoft® Access 2000 database format files, or part of an existing MDB file. Either existing or new MDB files may be chosen or created for this GIS Database Setting routine.

Prompts

GIS Setting dialog Click both file buttons and select new or existing files.

Pulldown Menu Location: GIS Data
Keyboard Command: gis_config
Prerequisite: None
File Name: \lsp\gisprtlsp

Define Template Database

This command prepares the fields for prompting to attach data to objects. The prompts are stored in the form of an .MDB file. A feature, such as a manhole, can have several prompts, such as Number of rungs, Type of material, Number of inlets, etc. Features can be organized into Categories: Utilities, Roads, Properties. The Category designation is an arbitrary way of organizing the features. Features and the prompts can be imported from Object Data found within the drawing in AutoCAD Map, or from tables within standard MDB database files, or from the Carlson .GIS files that are used by SurvStar, Carlson Field and other Carlson products to generate prompts. A Carlson GIS file works by triggering prompts when a description such as "mh", for manhole, finds a corresponding MH.GIS file.
with pre-defined prompts and default responses. But the most common way to develop features, and the associated prompting, is to enter them directly here in Define Template Database, rather than using the three import options. From a database standpoint, features are the same as tables.

To create GIS prompting for ASCII and MDB GIS features, you need to input the following fields in the dialog box:

1) The first field to set is the Template Database, or MDB file. All MDB GIS prompting is stored in one template Microsoft® Access MDB file named here. To create a new MDB, choose the Template Database pulldown from the top of the Define Template Database dialog, then New, and then select which type of new MDB file you would like to create. Your choices are New Access '97 format or New Access 2000 format. You can also load an existing MDB Template file by choosing Open under the same pulldown.

2) The next field is the Category Name, found within a pulldown called Category. GIS feature codes can be categorized (e.g. STRUCTURES, UTILITIES, ROAD FEATURES, etc.). At least one category must be created. This is because in order to Export a GIS File to the Template MDB file, this routine requires a category to export the GIS code under. After selecting New and inputting a category name, click OK to create this category in the template MDB file.

3) The next field is Feature, which has a pulldown as well. A category such as UTILITIES might have features such as manholes, light poles, fire hydrants, water valves, etc. The GIS feature name needs to be input by selecting New. This GIS feature name is very important because it identifies the group of data fields.

4) You can upload features to SurvCE, GISCE or FAST Survey using a GIS File pulldown option. Using this option you will be able to choose a .FLD file.

5) The GIS prompting is input under ATTRIBUTE (abbr), ATTRIBUTE (full name), LIST VALUES, REQUIRED and TYPE. Once values are specified, only these values can be used. Values are entered by typing them under the List column and hitting Enter, then typing another, hitting Enter and continuing until complete. The default value is the one displayed when the GIS Code is stored to the MDB template file using Save As in the Feature pulldown. Fields, when created, can be designated Char, Int or Real. Fields with pre-set responses will default to Char type. To add a new attribute, click on the first available blank cell in the first Attribute row of the list, shown in the Define Template Database dialog, and click Insert.

6) To store the new prompts and field names, click Save As under Feature.

7) To use this dialog to “back-door” create a GIS File for the ASCII method of prompting (the .GIS file method), click Export under the GIS File pulldown at the top of dialog. This ASCII .GIS file will then be available to SurvStar for field prompting.

8) To import the attributes and jump start the completion of attribute full names, attribute prompts and other table elements, you can use Import under the GIS File pulldown. This will read a Carlson .GIS file.
Automatic versus Prompted Values

It is possible to assign data to objects automatically, without any prompting. The automatic items are pre-set responses the program knows, such as date, time, currently configured instrument, etc. When the cursor is located in the List Values column, press the down arrow on the right side of one of the cells. You will see the available known data fields. Here you can select variable. The list may expand with new builds of Carlson.
Feature pulldown: Import option dialog box

Pulldown Menu Location: GIS Data

Keyboard Command: def_template

Prerequisite: None

File Name: \lsp\gisprt.arx

Input-Edit GIS Data

This routine creates, reviews and appends GIS data linked to entities stored in the drawing.

The GIS Smart Prompting dialog has a spreadsheet format for editing the data fields. The GIS table to process is selected in the pull-down list in the upper right of the dialog. The GIS tables that are available depend on the tables that are defined in the current template database. Use the GIS Database Settings and Define Template Database commands to setup the tables. Once you select a table to process, the fields for that table are displayed in a spreadsheet format. If a field is related to a field in another table in the database, a '+' character is shown next to the field name. Picking the '+' will open another dialog box with the related data in the other table. The data in this related table is not editable, only the data in the initial linked table.

The bottom portion of the dialog has features for attaching images to the entity. Existing image files (BMP, JPG or GIF) can be linked by choosing the New option. The Update option will replace the current image with a newly selected image. The Delete option will remove the current, attached image. The Capture button will take a shot in the field using a configured camera and then attach the image to the entity. Different digital cameras can be used by picking Pick or Set Camera.

The Input-Edit GIS Data command is an excellent way to simply review the data associated with an entity. If the entity has GIS data, the banner line at the top of the dialog will display "Entity has GIS Data". If not, the banner line will display "Entity has no GIS Data". Even when the entity has no data, the default values for the prompts will appear. Pressing OK will assign this data to the entity. To avoid assigning data to the entity (if it has none), press Cancel. Alternately, you can use the commands GIS Inspector Settings, followed by GIS Data Inspector, to review the data with no possibility of editing or inputting data in the process.

There are three methods for selecting the drawing entities to process: S for Select, P for Pick and N for Number:

Select Object method: With this method, you pick the drawing entity to process the data attached to that entity.
When selecting a Carlson point, the point number is used to link to the database.

**Pick method:** For this method, you pick inside a closed polyline to process the data attached to that polyline.

**Number method:** Here you simply input the point number from the current CRD file to process.

**Prompts**

**Select object (Number/Pick/＜Select＞):** P

**Pick a point inside polygon (Select/Number/＜Pick＞):** pick a point

**GIS Smart Prompting dialog make selections**

**Pulldown Menu Location:** GIS Data

**Keyboard Command:** gisdata

**Prerequisite:** MDB GIS prompting must be created in *Define Template Database* and points or entities must exist to link GIS information to.

**File Name:** \lsp\gisprt.arx

---

**GIS Inspector**

This command displays all or portions of the data attached to drawing entities in real-time. How much of the attached data is displayed is set by the command GIS Inspector Settings. When you move the cursor over an entity with GIS data, selected fields are displayed in a tooltip box next to the cursor. For data attached to closed polylines, you can move the cursor anywhere inside the polyline to show the data. Polylines that are closed will highlight with a solid fill as you inspect each one. Open polylines, such as road centerlines, will highlight with a solid fill generated along the length of the polyline. The solid fill color for all highlighting is set in GIS Inspector Settings.

The routine starts by prompting you to select entities. The entities that you select will be used by GIS Inspector. In the case of a large drawing, this selection allows you to limit the entities for inspector to a local area instead of having to process the whole drawing. Then after reading the entities, you can move the cursor around the drawing to inspect the GIS data. You can also use the arrow, page up and page down keys to pan and zoom the display. Pressing enter ends the routine.

**Prompts**

**Select objects:** select entities with attached data

Arrow keys=Pan; PageUp/Down=ZoomOut/In;
Pulldown Menu Location: GIS Data
Keyboard Command: gis_inspector
Prerequisite: MDB GIS Prompting must be created in Define Template Database and entities must have linked GIS information.
File Name: \lsp\gisview.arx

GIS Inspector Settings

This command sets up the fields to be displayed when using GIS Data Inspector. Each GIS table code can have different display options stored in the GIS Inspector Settings command.

GIS Inspector Settings reads all the points and entities with GIS information currently linked in the drawing and displays a list of the linked data tables under the Available GIS Table column. When a GIS Table code is highlighted (i.e. 0001 or Road), the fields for this GIS table are displayed to the right in the Select Fields column. Up to 6 fields or lines of GIS data can be defined for display for each GIS code table, including one picture. To add a field to the display list, double-click on the field name. To remove a field from the display list, highlight the GIS table to remove from and then use the Clear Settings buttons. The Last Option button will remove the last field to display from the current GIS table. The Picture Name will remove the image from the display list. The Entire Line button removes all the fields from display for the current GIS table.
Pulldown Menu Location: GIS Data
Keyboard Command: set_inspector
Prerequisite: MDB GIS Prompting must be created in Define Template Database and points or entities must have linked GIS information.
File Name: \lsp\gisview.arx

GIS Query/Report

This command applies a user-defined query on a data table or related tables with the database. Records in the table that pass the query can be reported or the associated entities can be highlighted in the drawing. The Query Using option in the main dialog box sets the source of the data table to process as either GIS data attached to selected drawing entities or from the current Output MDB file.

The query is defined in the dialog shown here. To add a query, enter a new query name in the in the space underneath Current Query. If there is already a name there, just highlight and type over it with a new name, then hit Clear all to clear out existing query lines and get full access to all Table Names. Set the Current Output MDB. Under Table Name, a list of all tables in the Current Output MDB with GIS links is available. Choose the table for the initial query. Once a table is selected, add a parameter is created and added, the Table Names list becomes unavailable because any additional query parameters must come from that table, or relate through that primary table.

The top portion of the dialog contains a list of the query parameters. To add a parameter, select a table name from the Table pop-up list. The available tables will either be all the tables found in the GIS links of the drawing or all the tables from the Output MDB file depending on the Query Using option. Once the table is specified, the Field Name pop-up list contains all the available fields in the table. Choose a field from this list. Next choose the operator (=, >, etc.) from the operator list. The Value pop-up list contains all the different values for that field that are found in the current data set. You can either select one of these values or type in another value into this field. If a Field Name relates to another Table, when you select that Field, an additional button will appear allowing you to add a
query parameter from the related table.

When all the parameter values are set, pick the Add Parameter button.

When all the parameters are defined for the query, you can save these settings by filling out a name Current Query field and then picking the Save Query button. This query can be recalled later by highlighting the query name and clicking the Load Query button.

Pick the Execute button to process the query. With the Generate Report option, the program will bring up the Report Formatter which allows you to choose the fields to include in the report and the report format. If the Highlight Screen Entities option is on, then the program will highlight the entities with GIS data that pass the query. Point entities are highlighted by drawing a box around the point and polylines are highlighted by solid fill. Shown here is the report for all manholes with a Condition of Good.
Pulldown Menu Location: GIS Data
Keyboard Command: gis_query
Prerequisite: MDB file with data or entities with linked GIS information
File Name: \lsp\gisview.arx

Label GIS Polyline: Closed Polyline Image

This command draws images inside the selected closed polylines with attached GIS image files. Images can be assigned to polylines by the Input-Edit GIS Data command.

The program starts by selecting closed polylines in the drawing with GIS data. Then a dialog appears for specifying the image to draw. This dialog displays a list of all the GIS table names found in the selected polylines. First choose a table to process. Then the image fields defined for this table are displayed in the lower list. Only one image can be drawn inside the polyline. The Erase Images button will erase any existing images inside the selected polylines. The settings can be saved to and recalled from a GIS settings file (.gsf) using the Save and Load buttons. Once all the settings are ready, pick the Draw button to draw the images. The images are drawn in the centroid of the polylines.
Example of images drawn inside closed polylines

**Pulldown Menu Location:** GIS > Label GIS Polyline  
**Keyboard Command:** display_polygon_image  
**Prerequisite:** Closed polylines with linked GIS images  
**File Name:** \lsp\gislab.arx
**Label GIS Polyline: Closed Polyline Data**

This command draws text labels for the specified fields inside the selected closed polylines with attached GIS data. The program starts by selecting closed polylines in the drawing with GIS data. Then a dialog appears for specifying the fields to label. This dialog displays a list in the upper left of all the table names found in the selected polylines. First choose a table to process. Then the fields defined for this table are displayed in the lower left list. To add a field to the label, highlight the field name and pick the > button. The fields names in the lower right list are the fields to be labeled in order. Use the Up and Down buttons to change the field order. The Erase Labels option will erase any existing field labels inside the selected polylines. The settings can be saved to and recalled from a GIS settings file (.GSF) using the Save and Load buttons. Once all the settings are ready, pick the Draw button to create the labels. The labels are drawn center justified in the centroid of the polylines.
Label Closed Polyline Data result of country name and population fields

Pulldown Menu Location: GIS > Label GIS Polyline
Keyboard Command: display_polygon_image
Prerequisite: Closed polylines with linked GIS information
File Name: \lsp\gislab.arx

**Label GIS Polyline: Open Polyline Data**

This command draws text labels for the specified fields along the selected polylines with attached GIS data. The program starts by selecting polylines in the drawing with GIS data. Then a dialog appears for specifying the fields to label. This dialog displays a list in the upper left of all the table names found in the selected polylines. First choose a table to process. Then the fields defined for this table are displayed in the lower left list. To add a field to the label, highlight the field name and pick the > button. The fields names in the lower right list are the fields to be labeled in order. Use the Up and Down buttons to change the field order. The Erase Labels option will erase any existing field labels for the selected polylines. The settings can be saved to and recalled from a GIS settings file (.GSF) using the Save and Load buttons. Once all the settings are ready, pick the Draw button to create the labels. The labels are drawn along the polylines.
Example of text labels along polylines with GIS data

**Pulldown Menu Location:** GIS > Label GIS Polyline  
**Keyboard Command:** label_arc_text  
**Prerequisite:** Polylines with linked GIS information  
**File Name:** \lsp\gislab.arx
Create Links

This command makes GIS links between blocks in the drawing and a database table using a key field that is in both the block attributes and the database table. Both the block entities and database records must exist before running this routine.

The routine starts by prompting you to select the block entities to process. Then a dialog appears for choosing the block attribute and table to link. The current template and output database file names are shown at the top of the dialog. Use the GIS Database Settings command to set these file names before running Create GIS Links. The dialog lists all the block names that were found in the entity selection. Choose a block name to process. Then in the lower left of the dialog, there is a list of the attributes for the selected block. Highlight the attribute name that contains the point ID key field for the blocks and then pick the Select First Key Value button. For each block entity, the program will use the value of this attribute to link to the record in database table. This value is matched to the database record using the PT_ID database table field. For example, a block with an attribute value of 402 for the specified attribute name will be linked to the database record with a value of 402 in the PT_ID field.

Next, the database table needs to be specified to either one fixed table name or to table names defined by a block attribute. A list of the available tables in the current output database is displayed. To link all the blocks to one table, highlight the table name from the list and pick the Select Second Key button. Or to link the blocks to various table names based on a block attribute, highlight the attribute name and pick the Select Second Key button. This attribute value for the blocks will then need to contain the database table name. For example, consider a block for electric utility data with two attributes: ID and TABLE. The ID is a number to use as the first key and the TABLE is the table name (i.e. POLE, BOX). Once the key fields are set, pick the OK button to create the links.

Pulldown Menu Location: GIS Data
Keyboard Command: create_links
Prerequisite: Block entities with attribute IDs and a database table with matching IDs.
File Name: \isp\gisprt.arx
**Erase Links**

This command removes all the GIS links from the selected entities (polylines, blocks, etc.).

**Pulldown Menu Location:** GIS Data  
**Keyboard Command:** erase_links  
**Prerequisite:** Entities with GIS links  
**File Name:** \lsp\gisprt.lsp

**Audit Links**

This command checks the GIS links for the selected entities in the drawing to make sure that the template database, output database and table exist. Any invalid links can be erased from the entities or be fixed by selecting another database or table. For example, if a database file (.mdb) has moved to another directory, then you can use this command to specify the new location.

The routine starts by prompting you to select the entities to check. If no errors are found, then the routine is done. When there are errors, a dialog box appears. Each GIS link is defined by a template database, output database and table. For each combination of these three settings that have an error, this dialog displays the template database, output database and table name from the entities. The number of GIS link combinations with errors is shown in Table Used for Links field (i.e. 1 of 2). The template database is shown at the top. If the template database link is broken, then use the Select New Template MDB button to assign another template database file. The output database also has a Select New Output MDB to set the output database file. In the lower left of the dialog is a list of the table names from the output database. You can choose the table to use for the link from this list. The Fix Links for Current Table button will assign the template database, output database and table name from the dialog to all the selected entities. The Erase Links from Table button will remove these broken links from the entities. The Go to Other Table button will process the next GIS link combination with errors.

**Pulldown Menu Location:** GIS Data  
**Keyboard Command:** audit_links
Prerequisite: Entities with GIS links
File Name: \lsp\gisprt.arx

Import SHP File

The Import SHP File command converts ESRI SHP files into Carlson drawing entities and can also optionally write the available attribute data to an external Access MDB file and create GIS links between the drawing entities and the records in the database. Use the Geometry with GIS Data Import Option to accomplish this. Use the Geometry Only Import Option to just draw the linework. If you don't need the data, this option is much faster.

The Import SHP File dialog displays the Output MDB file to add data to and the source SHP file to be imported. SHP files are similar to entities in one layer in CAD. You must specify the table name to store the data in the MDB database and the layer name for the entities to be created. Typically these names are the same or near equivalent as the SHP file name. Once these names are entered, the Import Polylines from SHP button becomes available. Pick this button to import the SHP files entities and database. You can also assign elevations by a specified data attribute.

There are primarily three types of ESRI SHP files: Points, Arcs and Polygons. Each will provide different options on Import. Once the SHP file is selected, Carlson detects the data contents of the file and sets the dialog options for importing either polygons, arcs or points. Carlson GIS also supports the use of three other types of SHP files: PointM, PolylineM and PolylgonM.

Both Arc and Polygon SHP files are brought into Carlson as polylines in the drawing, with attribute data stored in an external Access .MDB database file if that option is selected.

Point SHP files are imported in a three step process. The first step uses the Import SHP File command to create a coordinate file (.crd) for the points in the SHP file and a corresponding table in the output MDB file for the points database. The second is to use Draw Locate Points to draw the points from the CRD file into the drawing. The third step uses Create Links to select the points in the drawing and link the database to these plotted points.
Note: If the SHP file you are Importing is in a different Projection or Units than that specified in the Drawing Setup, then a transformation will occur during Import, as long as the (.PRJ) Projection file is present with the SHP set of files. If there is no (.PRJ) file with the SHP, then no transformations will occur.

Chapter 17. GIS Menu
Export SHP File

This command creates a SHP file from the selected entities in the drawing. After selecting entities to be converted, a dialog shows the number of Points, Polylines (Arcs) and Closed Polylines (Polygons) found in the drawing selection set. Those Points, Arcs and Polygons with database information linked are displayed with their database table names. Any Points, Arcs and Polygons without linked database information display as unknown.

Highlight the Point, Arc and Polygon tables to output or selects Export All to select all entities including the UNKNOWN entities to export into SHP files. The Export SHP File commands outputs all entities selected into SHP files with the same name as their table name into a subdirectory selected. Also Points can be stored in the ESRI Arcview database as 3D X, Y and Z coordinates when Include Z Coordinates is toggled on. SHP files do not have arc entities. So the export routine will convert arcs and polyline arcs into a series of small chords segments. The Offset Cutoff field sets the maximum horizontal shift allowed between the original arc and the chord segments.

These SHP files can be imported into ESRI's Arcview product. Database GIS links in Carlson are converted to SHP files by storing the GIS database information into DBF files for ESRI's Arcview product to read and link to.

Prompts

Specify Name for SHP File dialog select .SHP file name
Select objects select entities
Export Carlson Entities to SHP File dialog choose settings, click OK

Pulldown Menu Location: GIS Data
Keyboard Command: export_shp

Chapter 17. GIS Menu
Image Inspector

Function

This command views images attached to entities. At the start, the program highlights all entities that have attached images. When you move the cursor over these entities, the attached image is displayed in a window. If you click within the image window, the program will start the image application editor that is setup for your system. This application, such as Microsoft Internet Explorer, depends on your Windows system setup. Also while moving the cursor over drawing entities, you can use the arrow, page up and page down keys to pan and zoom the display.

Prompts

Arrow keys=Pan; PageUp/Down=ZoomOut/In; Pick Image Box = Open Image!
Move pointer over entity with image (Enter to End): press Enter

Car image displays in upper-left of drawing when cursor is over car symbol

Pulldown Menu Location: Images
Keyboard Command: view_image
Prerequisite: drawing entity with attached image
File Name: /lsp/gisutil.arx

Place Camera Symbol/Image

Prompts

Image File To Process: choose .TIF file
**Import MrSID Images**

This command allows you to select one or more image files in the MrSID format (.SID) and have it/them converted to either a (.TIF) or (.JPG) file format. Corresponding World files are also created.

![MrSID Import Dialog Box](image)

**Place Image by World File**

This routine is intended for users of Carlson products that do not have the AutoCAD Map platform. If you have the Map extension available, it is recommended that you use the tool provided.

This function allows you to insert Geo-Referenced TIF files into the drawings. This process requires the presence of an accompanying TFW file. The TFW file contains information about the location and scaling of the actual raster image TIF file. This eliminates the guesswork in inserting, moving, and rotating raster images to the project area. You begin by selecting the TFW or JGW file to process. If the related TIF file is present in the same directory, the image will be inserted into the proper coordinates.

**Prompts**
**Select World File:** choose existing .TFW or .JGW file

**Pulldown Menu Location:** GIS Tools

**Keyboard Command:** geotiff

**Prerequisite:** None

**File Name:** \lsp\gis1.lsp

### Attach Image to Entity

#### Function

This command attaches an image file to a drawing entity. The possible image file formats are .bmp, .jpg and .gif. Any type of drawing entity can be used such as polyline, points or symbols. To run the command, first pick an entity on the screen. Then a dialog appears for selecting the image. First set the image directory and then highlight the image file name. A graphic of the image should appear in the preview window. Then click OK.

The Capture Image button can be used to trigger an attached digital camera to take an image. The Pick Camera and Set Camera buttons can be used to configure the camera to use.

The View Image button will display in the preview window any image already attached to the entity. Also any image already attached to the selected entity is displayed in the Current Image field at the top of the dialog.

#### Prompts

**Select object to attach symbol to:** pick an entity

Attach Image to Object Dialog

Done.

**Select object to attach symbol to:** press Enter
Define Note File Prompts

This command allows the user to create a .GIS file for use in several other routines in Carlson GIS and other Carlson Software products, such as SurvCE or SurvStar.

The program starts with the main Define Note File Prompts dialog, as shown below. The Load button allows the user to load an existing GIS file for editing or review. The list box shows the various data capture items in the GIS file, showing the field name, the prompt, the default value and the various options for that field. The Edit button allows the user to edit the highlighted field. The Add button allows the user to add new fields after the highlighted field. The Move Up and Move Down allow the user to change the order in which fields appear in the GIS file, while the Remove button completely removes the highlighted field. The Save button saves the GIS file that is currently being edited, while SaveAs allows the user to save the current GIS file under a different name. The Quit button checks to see if the current GIS file is saved and quits the routine.

When the Edit or Add button is clicked, the dialog box shown here appears, allowing the user to enter and edit data with respect to a particular field in the GIS file. The Field Name is a unique identifier of the field in the GIS file and hence a GIS file cannot have repeated field names. The Prompt is what appears at the command prompt while waits for user input. The Default Value is the value that would be used among various options, if the user presses Enter at the command prompt without typing anything in response to the prompt. The list box, Options for value, contains a list of options that can be selected for the particular field. A new option can be added to the list or removed from the list by clicking the appropriate button. The Add Option button brings up a small dialog and accepts the option to be included in the list. Press OK to accept the values set here. At the minimum, the Field Name and Prompt must be specified.
Pulldown Menu Location: GIS Data
Keyboard Command: defnote
Prerequisite: None
File Name: \sp\cogoutil.arx

Database File Utilities

This command is designed to import GIS data from SurvCE, GISCE and FAST Survey files, as well as from user-defined text/ASCII file fields. It also exports data from Carlson Note files (.NOT or .VTT) to Microsoft® Access (.MDB) database tables. The .NOT extension is used when data transfers from desktop. The .VTT extension files are data transfers from data collector.

Note files are associated with Coordinate files (.CRD) and contain additional data for point numbers. For example, the Coordinate file for a manhole point could contain the point number, northing, easting, elevation and 32 character description, while the corresponding note file for that point contains additional data on the manhole such as diameter, depth, condition, etc. A Carlson Note file for a Coordinate file will have the same name as the Coordinate file, except with a .NOT or .VTT extension instead of the .CRD extension (e.g. PARK.NOT goes with PARK.CRD). The Carlson Note file is a text file which consists of a point number (PT_ID) followed by field names with values. This group of point number and fields can also have a GIS_FILE name, which is used to identify this group of fields. This GIS_FILE name comes from the Note file prompting definition file (.GIS), which defines the field names for the group and is created in the Define Note File Prompts command.

You can select the Note file to process by using the Import Note File button. The program will then list all the GIS_FILE names that were found in the Note file. If a set of data for point number does not have a GIS_FILE name, then this group will appear in the list as UNKNOWN.

The name of the Microsoft® Access database to add the data to is the output database file, listed at the top-left of the Database File Utilities dialog. You can change the output database by using the Open Database button and selecting an existing database, or by clicking New Database to create a new database. The database tables will automatically have the same name as the GIS_FILE. This dialog also allows you to preview and edit a spreadsheet editor, which in turn allows you to modify values in the table. Each set of note file data for a point is displayed on one row with the
corresponding record from the database shown on the next row. You can export the Note file data and create a new Access database .MDB file, in Access '97 format or in Access 2000 format, by doing a SAVEAS into .MDB format. You can rename and delete a table as well.

Database File Utilities can be combined with the Create Links command to make GIS links between the point entities in the drawing and the Microsoft® Access database records. The point entities can be drawn with the Draw/Locate Points or Field to Finish commands.

![Database File Utilities dialog box]

**Initial dialog at start of command with primary functions**

**Available Table from Output Database:** Selection list. Pick a table from the Output Database.

**Import Note File:** Imports a Carlson Note File (.NOT).

**Import SurvCE/GISCE/FastSurvey GIS File:** Imports a SurvCE/GISCE/FastSurvey Note File.

**Import ASCII File:** Imports ASCII file.

**Open Database:** Opens Access database .MDB file.

**New Database:** Creates a new Access database .MDB file in Access '97 format or in Access 2000 format.

**Preview/Edit Table:** Displays a spreadsheet editor, allowing you to preview/edit values from table.

**Rename Table:** For renaming a table as needed.

**Delete Table:** For deleting a table as needed.

**Current Table:** Displays the selected table from above list.
Dialog seen after choosing Import ASCII File and selecting file name

**Pulldown Menu Location:** GIS Data

**Keyboard Command:** noteutil

**Prerequisite:** A note file (.NOT from desktop or .VTT from data collector)

**File Names:** `\lsp\gisprt.arx`
**CGFile**

**Current Information**

The Current Information Dialog Box contains information on:

Drawing: displays the current drawing file Path, Name, Scale, and Units

Coordinate File: displays the current coordinate file path and names.

![Current Information Dialog Box](image)

**File Type:** This will display the current Coordinate file type.

The file types are:

- C&G Numeric (.CRD) (PT #: 126)
- C&G Alpha-Numeric (.CGC) (PT #: RW126)
- Carlson Numeric (.CRD) (PT #: 126)
- Carlson Aloha-Numeric (.CRD) (PT #: RW126)

**Description Length:** Numbers of character in the description

**Total Points:** Total number of points in the file

**High Point:** The highest point number stored

**Points Used and Points Available:** displays the block or blocks of points used or available in the coordinate file currently open.

**Other Files:** Displays the files that are currently open:

- Data Path: displays the current default path and coordinate file name
- Description Table: displays the current default path and description table
- Print: displays the current default path and Print file name
- Raw: displays the current default path and RAW file name
Map Check: displays the current default path and Map Check file name
Cross Section: displays the current default path and Cross Section file name
TIN: displays the current default path and TIN file name

Pull-down menu Location: CG-Survey > File
Keyboard Command: INF, cg_current_info
Prerequisite: None

Coordinate Files
Opening Closing and Saving

Choose Coordinate Files from the CGFile pull-down menu.

Pull-down menu Location: CG-Survey > File
Prerequisite: None

New
The New allows you to create a new coordinate file.
Prompts

Follow these steps: CGFile > Coordinate Files > New Coordinate File

Save in: Browse to folder location

Enter the name of the coordinate file you wish to create: File Name: Hickory farms

Press enter or press Save Button

NOTE: The directory displayed is the Data Path is the directory as set from the tool bar:
CG-Tools > CG Options > Data Path Options

NOTE: The description length for the new file just created will be set based on the current description length setting in the:
CG-Tools > CG Options > General

NOTE: You will not be able to change the description length once the new file is created. You must set the description length prior to creating the new file. You can however move the points to another file that has a longer description length

Pulldown Menu Location: CG-Survey > File > Coordinate Files
Keyboard Command: OPNC, CG_NEWCOORD
Prerequisite: None
Open
The Open menu item allows you to open an existing .CRD or .CGC file. Only one coordinate file can be open at a time in a given drawing.

Prompts
To open an existing coordinate file follow these steps:

In the file dialog box (Shown below),
**Browse to folder location**
select or Highlight the coordinate file you wish to open by clicking on it
**Click the Open button**

![Open Coordinate File dialog box]

NOTE: The default directory is the “Data” directory below the directory where CG-SURVEY was installed. You can change the default directory by choosing:
CG-Survey > Tools > CG Options... - Data Path tab.
**Close**

To close an open coordinate file

**Pulldown Menu Location:** CG-Survey > File > Coordinate Files  
**Keyboard Command:** OPC, CG_OPEN_COORD  
**Prerequisite:** Coordinate File Open

**Save As**

As new points are stored in a coordinate file, the file is automatically updated. If you are concerned that the changes to be made to the coordinate file may not be correct, you should use the Save As option to make an extra copy of the file before making any changes. This option allows you to save the open coordinate file under a different name. The new file becomes the current file. The original file will remain unchanged.

**Prompts**

To **Save As the open coordinate file under a new name, select:** > CGFile > Coordinate File > Save As

**Browse to Folder Location:** The Save Coordinate File As dialog box will display the default directory as set in the Data Path Options,

**Enter the name:** of the new file for the coordinates to be saved to.

**Press Save Button:** Save or Press enter
Pulldown Menu Location: CG-Survey > File > Coordinate Files
Keyboard Command: SCF, CG_FILE_SAVEAS
Prerequisite: None

Export Coordinates to ASCII
This menu item allows you to export coordinate files to an ASCII (American Standard Code for Information Interchange) file format. ASCII files are a simple text format and can be read by almost all word processors and text editors.

Prompts

To export coordinates to an ASCII file, follow these steps: > CGFile > Coordinate File > Export Coordinates to ASCII File
If a coordinate file is not currently open, the Open Coordinate File dialogue box will appear, select the file.
You will be prompted at the command line to select the points you wish to export:

Add points from coordinate file. (Enter When Done) (All/Block/Code/Desc/Elev/ Pt-group/Limits/Radius/Select):
After choosing the set or sets of points you wish to export, press until the following dialogue box appears:

Enter a new file name or select an existing ASCII file and click the Save button.
Next, select an ASCII file format (see the ASCII File Formats section of this chapter for an explanation of each format):

Select the OK button to export your coordinate points.
ASCII FILE CONVERSION FORMATS

NOTE: In the following formats the point code can be placed in the first two characters of the description field, followed by a semicolon. The description will follow the semicolon. You can export and import ASCII files in the following formats:

STANDARD (Point #, North, East, Elevation,"Desc")
2,5054.76393,9777.75761,103.70000,"gs"
3,5098.69743,9783.82411,105.20000,"gs"
4,5158.78043,9773.74111,105.67000,"gs"
5,5205.11493,9777.40661,106.25000,"gs"

CLM (PNT Point # Easting Northing)
PNT 2 9777.75761 5054.76393
PNT 3 9783.82411 5098.69743
PNT 4 9773.74111 5158.78043
PNT 5 9777.40661 5205.11493

Autocogo (Point # Easting Northing Elevation Desc)
2 9777.75761 5054.76393 103.70000 gs
3 9783.82411 5098.69743 105.20000 gs
4 9773.74111 5158.78043 105.67000 gs
5 9777.40661 5205.11493 106.25000 gs

MTI (Point #, Easting, Northing, Elevation,"Desc")
2,9777.75761,5054.76393,103.70000,"gs"
3,9783.82411,5098.69743,105.20000,"gs"
4,9773.74111,5158.78043,105.67000,"gs"
5,9777.40661,5205.11493,106.25000,"gs"

Standard (without description quotes) (Point #, North, East, Elevation, Desc)
2,5054.76393,9777.75761,103.70000,gs
3,5098.69743,9783.82411,105.20000,gs
4,5158.78043,9773.74111,105.67000,gs
5,5205.11493,9777.40661,106.25000,gs

Abacus/MTI (Point #, Northing, Easting, Elevation)
2,5054.76393,9777.75761,103.70000,"12;gs"
3,5098.69743,9783.82411,105.20000,"12;gs"
4,5158.78043,9773.74111,105.67000,"12;gs"
5,5205.11493,9777.40661,106.25000,"12;gs"

Surv-A-Soft (Code Northing Easting: Desc/Elevation")
6 0 "VER 2"
-1 0.00000 0.00000 ""
2 5054.76393 9777.75761 "103.70000"
2 5098.69743 9783.82411 "105.20000"
The Surv-A-Soft file structure is as follows:
The first line of the file is a header line with the following information:
The total number of points is placed in the code field.
Zero (0) is placed in the northing field.
"VER 2", etc. is placed in the easting field.

After the header line each line specifies a coordinate point. The line number minus one is the point number.
The code field has three possible values:

Value Explanation
-1 no coordinate point
2 elevation (in description field)
1 description (in the description field)

Since .CRD and .CGC files can have both an elevation and description, when converting them to an ASCII
Surv-A-Soft file one of the following will occur depending on the elevation value:

If the point has an elevation it will be placed in the description field. If there is no elevation, the description
will be placed in the description field.

Star*Net (Point # Northing Easting Elevation Desc)
2 5054.76393 9777.75761 103.70000, gs
3 5098.69743 9783.82411 105.20000, gs
4 5158.78043 9773.74111 105.67000, gs
5 5205.11493 9779.12911 110.47000, gs

USER DEFINED

Upon selecting User Defined format, the following dialog box will appear:
As the name implies you can create a format specific to your conversion needs.

Using an Existing User Defined Format To select an existing User Defined format, do the following: Press the Read File button. Select an existing user defined format from the dialog. The fields in the dialog box will automatically be updated. Select OK to accept the format.

Creating a User Defined Format: There are 5 basic pieces of information that can be defined in a user defined format. Point number Northing (required) Easting (required) Elevation Description (Code can also be part of the description field) There are two types of user defined formats " Character Separated Fields Character Separated Fields means that each field of information is separated by a character, often times a comma, but any ASCII character can be used. Fixed length Fields Fixed length fields means that you define the number characters for each field item. The fields can be in any order

Field Order
Point Number 4
North 3 (required)
East 2 (required)
Elevation 1
Description 5

NOTE: Coordinate values will be rounded based on the setting in the Rounding Options dialog box.
If the point number field is not assigned a value, the line number will be the point number. Select the Field Type (Character Separated or Fixed Length) and follow the appropriate instructions below:
Character Separated User Define Export File

>Go to CGFile >Select Coordinate files >Select Export to ASCII At the command line you will be prompted to select points:
Add points from coordinate file. (Enter when Done) (All/Block/Code/Desc/Elev/ Pt-group/Limits/Radius/Select):
After selecting the point set or sets to export press return

Select or name the file to store the converted points.

Set the conversion format to "User Defined Format" The following dialog box allows you to define the attributes of the points being converted.
For this example Character Separated Fields has been chosen as the Field Type.

Points........... -> 1
North........... -> 2
East............. -> 3
Elevation..... -> 4
Description -> 5

So the line data will be: Point #, North, East, Elevation, Description

**Empty Field Values:** It's necessary to distinguish between a field that has no value and a field that has "0" as a value. In coastal areas "0" is a valued elevation and in some cases "0" could actually be a coordinate value. By defining empty field values with a value that cannot be misunderstood for a valid value, a conversion process will not produce invalid data.

**Character Values:**

1st & 2nd Field Separators, these are the ASCII characters that define the fields within a line.
1st & 2nd Line Terminator; these are the ASCII characters that define separate lines
Description Markers; An ASCII character that surrounds the description such as quotation marks.
Code Separator; Allows you to designate the ASCII character that separates the Code information from the Description information. In the example above the Character values are set as follows:
1st Field Separator: 44 (which is a comma)
2nd Field Separator: -1 (none used)
1st Line Terminator: 13 (carriage return)
2nd line Terminator: 10 (line feed)
This example would read as follows: 1,5000.0000,10000.0000,954.63,MH
The following is a list of all of the ASCII codes and the respective values.

2nd Field Separator: You may however define two separators. For example, you can use a carriage return and line feed if you wish to have each field on its own line:

NOTE: Do not use a character as a separator if it appears in any of the fields. For example, if your record looks like this:

Then the period (.) character cannot be used as a separator because it is used in the northing, easting and elevation fields. Pressing the View ASCII Codes button will show you the 256 valid characters that can be used in an ASCII file. The table shows each character, with its integer value to the left of it.

NOTE: Character number 26 cannot be used as a field separate because it marks the End of File (EOF).
Fixed Length Field User Define Export File:

>Go to CGFile >Select Coordinate files
> Select Export to ASCII Select points. (Enter When Done) (All/Block/Code/Desc/Elev/ Pt-
group/Limits/Radius/Select):

At the command line you will be prompted to Select Points After selecting the point set or sets to export
press return Select or name the file to store the converted points.

Set the conversion format to "User Defined Format"

The dialog box below allows you to define the attributes of the points being converted.
For this example Fixed Length Fields has been chosen. In this case the order is set at:
Points........... -> 1
North........... -> 2
East.............-> 3
Elevation..... -> 4
Description -> 5

So the line data will be:

Point # - North-East-Elevation-Description

But unlike Character Separated Fields, the information sets will be defined by their placement on the text line, rather than a separating character.

Empty Field Values: It is necessary to distinguish between a field that has no value and a field that has "0" as a value. In many cases around coast lines "0" is a contour elevation and in some cases "0" could actually be a coordinate value. By defining empty field values with a value that cannot be mis-understood for a valid value, any conversion process will not produce questionable data.
Character Values: 1st & 2nd Field Separators, do not apply, separators are defined by spacing.

1st & 2nd Line Terminator; do not apply, separators are defined by spacing.

Description Markers: An ASCII character that surrounds the description such as quotation marks.

Code Separator; Allows you to designate the ASCII character that separates the Code information from the Description information. In the example above the Character values are set as follows:

1st Field Separator: Do not apply
2nd Field Separator: Do not apply
1st Line Terminator: 13 (carriage return)
2nd line Terminator: 10 (line feed)
Description Marker: -1 (none used)
Code Separator: -1 (none used)

This example would read as follows:
1 5000.0000 10000.0000 954.63 MH <CR> <LF>
The first 8 spaces are reserved for the point number The next 16 are reserved for the northing The next 16 are reserved for the easting The next 16 are reserved for the elevation The next 20 are reserved for the description Then a (carriage return) and a (line feed)

The following is a list of all of the ASCII codes and the respective values.

```
<table>
<thead>
<tr>
<th>ASCII Code</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x0-0x1F</td>
<td>0-31</td>
</tr>
<tr>
<td>0x20-0x7F</td>
<td>32-127</td>
</tr>
<tr>
<td>0x80-0xFF</td>
<td>128-255</td>
</tr>
</tbody>
</table>

NOTE: Do not use a character as a separator if it appears in any of the fields.

Description Markers: If you have a description field, you may wish to use a Description Marker. This is a character that surrounds the description. For example, a description surrounded by quotes:
23,1056.789,2345.769,982.345,"MH"<CR> <LF>

Chapter 18. CGSurvey Module

1000
If you are not using a description marker, enter -1 in the Description Marker box

**Code Separator:** If you have a description field, and want the first characters of the description field to be a C&G point code, you can enter the decimal value of the character that separates the point code from the description. This allows you to transfer both the point code and the description to an ASCII file. For example, using a semicolon as a code separator: 23,1056.789,2345.769,982.345,"MH; Inv Elev -9.23"<CR><LF>
If you are not using a code separator, enter -1 in the Code Separator box.

**No Northing Value and No Easting Value**

If the ASCII file does not have a point number field, the No Northing and No Easting values are mandatory. The record number will be used as the point number. This means that skipped point numbers will be filled with false northing, easting and elevation values.

Here is an example of a file with a record that has no point number field (assume you entered -999999 in the No Northing, No Easting and No Elevation boxes):

<table>
<thead>
<tr>
<th>Northing</th>
<th>Easting</th>
<th>Elevation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1056.789</td>
<td>2345.769</td>
<td>982.345</td>
<td>MH&lt;br&gt;Point 1</td>
</tr>
<tr>
<td>-999999</td>
<td>-999999</td>
<td>-999999</td>
<td>No Point 2</td>
</tr>
<tr>
<td>2356.679</td>
<td>2455.645</td>
<td>992.678</td>
<td>MH&lt;br&gt;Point 3</td>
</tr>
<tr>
<td>2786.799</td>
<td>5645.789</td>
<td>984.234</td>
<td>MH&lt;br&gt;Point 4</td>
</tr>
</tbody>
</table>

**No Elevation Value** You must place a value in this box. When converting a C&G point to an ASCII point, this value will be placed in the elevation field of the ASCII point if a C&G point with "No Elevation" is encountered. When converting an ASCII point to a C&G point, if "No Elevation" is encountered in the ASCII point then "No Elevation" will be placed in the elevation field of the C&G Point.

**Pulldown Menu Location:** CG-Survey > File > Coordinate Files

**Keyboard Command:** EXC, CG_EXPORT_COORDS

**Prerequisite:**

---

**Import ASCII File into Coordinates**

This option allows you to import the contents of an ASCII file into a coordinate file.

**Prompts**

Follow these steps: > CGFile > Coordinate Files > Import ASCII File Into Coordinates
If a coordinate file is already open, the ASCII file will be imported into it, if a coordinate file is not open you will be prompted to open an existing file or create a new coordinate file.

Select the ASCII format that is being imported and how to handle duplicate points.
The points will be imported and displayed on the screen.

**Pulldown Menu Location:** CG-Survey > File > Coordinate Files  
**Keyboard Command:** IMC, CG_IMPORTCOORDS  
**Prerequisite:** None

---

**Close Raw File**  
To close the current raw data file, select CGFile from the main menu and then select Close RAW File.
Prompts

Pick Close Raw File

Pulldown Menu Location: CG-Survey > File
Keyboard Command: CLR, CG_CLOSE_RAW
Prerequisite: Raw File OPEN

Close Map Check File

To close the current map check file, select CGFile from the main menu and then select Close Map Check File.
Prompts

Select Close Map Check File

Pulldown Menu Location: CG-Survey > File
Keyboard Command: CLM, CG_CLOSE_MAP
Prerequisite: Mapcheck file Open

Close Cross Section File
To close the current cross section file, select CGFile from the main menu and then select Close Cross Section File.

Prompts

Select Close

Pulldown Menu Location: CG-Survey > File
Keyboard Command: CLX, CG_CLOSE_XS
Prerequisite: Cross section File Open

CGDos Drawings
Before opening a CGDOS drawing you must choose the "setup" option to provide information needed for opening the PL!/PL2 files.
This feature allows you to import a CGDOS PL1/PL2 file and convert it to a standard CAD drawing. This is similar to a DXF conversion, but in addition to simple converting the graphics, this feature also retains the C&G data. That means that after the conversion is finished the drawing file is still referenced to the coordinate file. If you query a line it tells you what coordinate file the graphic was created from, the points that line is drawn from, the layer and line stop information just like query did in the CGDOS. This means you can continue working on the job after the conversion in a manner that is familiar to you as it was in CGDOS.

**Pulldown Menu Location:** CG-Survey > File  
**Keyboard Command:** None  
**Prerequisite:** CGDos Drawings > Setup

### Open Dos Drawing

If the current drawing file you are in has any graphics the following dialog box will appear. This is meant to prevent you accidentally placing the PL1 drawing on top of another existing drawing file.

![Dialog Box](image)

Selecting will bring up the following dialog box that will allow you to select the PL1 file to be converted to a standard CAD drawing.
After selecting the file to be converted, if you look at the command line you will see that the program is going through the PL1 file and converting the drawing entities one at a time to make them conform to the C&G format. This means all of the C&G data is maintained so the new drawing is still linked to the coordinate file it was created from. Also during this conversion process any of the CGDOS *.INS files (inserts) will be converted to standard CAD blocks and be added to the CG list of available inserts. Meaning all of the inserts you were accustomed to using in the CGDOS product will now be a part of the CG Survey program.

**Prompts**

Select a *.PL1 drawing file from browse file dialog box: Select file & click on OPEN button

Pulldown Menu Location: CG-Survey > File
Keyboard Command: None
Prerequisite: CG-Survey > File > CGDos Drawings > Setup completed properly
Setup DOS Dwg

The first dialog asks you to give the path to the CGDOS Program Files and the path to CGDOS Inserts.

When this is set properly, any Insert used in the DOS PL1 file will be converted to a block and stored in the C&G symbols folder: These inserts will also be listed in the insert library when you go to: CGDraw > Drawing Settings > Active Symbol NOTE: Currently those inserts converted from the CGDOS PL1 files will not be shown graphically in the CGSurvey Active Point Symbol dialog box but they will appear in the symbols list and thus can be selected for use from the list.

Prompts

Select a Location for CGSurvey Program from browse file dialog box: Pick Browse button
Select a Location for Insert files from browse file dialog box: Pick Browse button

Pulldown Menu Location: CG-Survey > File
Keyboard Command: None
Prerequisite: None

Convert Old CG Dos Level File to New Format

This option converts old C&G DOS level files (files with a .LEV extension) to the new CGSurvey level file format (files with a .LEV extension).
Prompts

Select CGFile from the main menu.
Select Convert Old C&G DOS Level File to new Format from the pull-down menu.
From the file dialog box, select the file to convert:
Click the OPEN button to convert the file.

Pulldown Menu Location: CG-Survey > File
Keyboard Command: CVL, CG_CONVERT_DOS_LEVEL_FILE
Prerequisite: None

Convert Old CG Dos Raw File to New format
This option converts old C&G DOS raw files (files with a .RAW extension) to the new CGSurvey raw file format (files with a .CGR extension).
Prompts

Select CGFile from the menu bar.
Select Convert old C&G Raw File to new format from the pull-down menu.
From the file dialogue box, select the file to convert:
Click the OPEN button to convert the file.

Pull down Menu Location: CGFILE
Keyboard Command: CVR, *CG_CONVERT_RAW
Prerequisite: None

Convert Old CG Dos Cross Section File to New Format
This option converts old C&G DOS Cross Section files (files with a .EW extension) to the new CGSurvey earthwork files format (files with a .CEW extension).
Prompts

Select CGFile from the menu bar.
Select Convert Old C&G Cross Section File to new format from the pull-down menu.
From the file dialog box, select the file to convert: Click the OPEN button to convert the file.

Pulldown Menu Location: CG-Survey > File
Keyboard Command: CVX, CG_EW_CONVERT_FILE
Prerequisite: None

Convert Old CG Dos Template File to New Format

This option converts old C&G DOS Template files (files with a .TPL extension) to the new CGSurvey earthwork files format (files with a .CTP extension).
Prompts

Select CGFile from the menu bar.
Select Convert Old C&G Cross Section File to new format from the pull-down menu.
From the file dialog box, select the file to convert:
Click the OPEN button to convert the file.

Pulldown Menu Location: CG-Survey > File
Keyboard Command: CVT, CG_EW_CONVERT_TEMPS
Prerequisite: None

Empty Print File

Choosing this menu item will remove all the text now in your print file.
You should empty the print file periodically so that it does not use too much of your disk space and become difficult to view and print.

Note: If user wishes to change the Printer.Txt file name or choose a different location. see CG-Survey > CG Options... - Output Tab

Pulldown menu Location: CG-Survey > File
Keyboard Command: EPF, cg_df
Prerequisite: Set print file name and path in CG-Survey > CG Options... - Output Tab
Print View Print File

While computations are taking place a Print File is being maintained showing all computations. This file is saved in the text file specified in the Output Options dialog box below.

![Print File Dialog Box](image)

This text file may be edited, printed or viewed from any text editor or any word processor. (Note: For further explanation on Output Printing Settings please consult CGTools Menu)

After choosing the Print/View Print File menu item, the print file will be opened using the Windows text editor WordPad. To print the whole file, use the printer icon or the Print menu item on the WordPad File menu. To print a portion of the print file, you must highlight the portion you wish to print, then choose File > Print. On the General tab of the Print dialog box click the Selection radio button then click the Print button to print the highlighted text.

**NOTE:** Print Preview is also available on the WordPad File menu.

You can choose whether to use the Windows Notepad or Wordpad to view and print the print file by going to the CG-Survey > CG Options... menu and clicking the Output tab then clicking on either the Notepad or Wordpad radio buttons in the Print File Viewer section of the dialog (shown below).

![Print File Viewer Dialog Box](image)

**Pulldown menu Location:** CG-Survey > File  
**Keyboard Command:** VPF, CG_VIEW_PRINT_FILE  
**Prerequisite:** Set print file name and path in CG-Survey > CGOptions... - Output Tab
CGTrav

Quick Traverse

This feature allows you to utilize the keyboard and the mouse to perform a traverse using points and data found in the drawing and the coordinate file. There is no raw data entry associated with Quick Traverse. The Quick Traverse feature has no ability to adjust the resulting traverse. If you wish to adjust coordinates, you could create a raw data file using the CGEditor - on the CGTrav menu - then use the Reduce Traverse feature, also on the CGTrav menu.

NOTE: If you wish to check the closure of a plat from bearing and distance data, use the CGEditor to create a map check file, then use the Reduce Map Check File feature on the CGTrav menu.

Prompts

During the process of entering data for the Quick Traverse feature you will see the prompt:

[aZimuth/Bearing/Deflection/Side shot/curve/Closure/horiz. distaNces]

At this prompt you may:

Change the type of angular input between Horizontal Angle, Azimuth and Bearing modes at any time.

Change how distances are specified as either slope distance and vertical angle or horizontal distance and vertical distance.

Turn the vertical angle input on or off.

Traverse around tangent and non-tangent curves.

Switch from Traverse to Side shot mode.

Traverse mode: automatically occupy the foresight point.

Side shot mode: continue to occupy the current instrument point until you change to

Traverse mode: and thus occupy another point.

Note: There are several settings found in the C&G Options dialog box that should be set or checked prior using the Quick Traverse feature:

The default values for the initial traverse input modes are set in the Traverse Options.

If you wish to calculate or enter elevations, check the Elevations: ON checkbox and choose Enter Elev. Or Calculate Elev. as desired in the Global Options tab. If you are calculating elevations, make sure the Vertical Angles ON checkbox is checked on the Traverse Options tab.
Quick Traverse Example

In this example the mode is set to traverse and elevations are on and are to be calculated.

After choosing Quick Traverse from the CGTrav menu you will be asked to enter the following information:

**Instrument point:** for the example enter 1 (assuming that the currently open coordinate file has a point in it with a point ID of 1).

**Backsight point:** for the example enter 2.

[aZimuth/Bearing/Deflection/Side shot/cUrvce/Closure/slope distaNces.]

Enter horizontal angle <0.0000>:

**Since elevations are on and set to calculate so you will be prompted for the following:**

If you selected H.I. as Plus-Up on the Traverse Options tab, the coordinates and elevation of the instrument point will be read from the file and you will be prompted for the instrument height (H.I).

If no elevation is found, you will be prompted to enter the ground elevation at the instrument point and then the H.I.

If you selected H.I. as Elevation in the Traverse Options dialog box, you will be asked to enter the actual elevation of the instrument scope.

**Backsight Point:** If you are turning angles or deflection angles instead you will be prompted for the backsight point.

**Rod Height:** With Calculate Elevations on you are prompted to enter the prism height.

You will be prompted for the horizontal angle (or deflection angle)

If you need to change the prism height <esc> and you will be prompted for a new prism height, if you <esc> again you will be prompted for a new instrument point.

**Angle data entry**

**Instrument point:** 1

**Back site:** 2

[aZimuth/Bearing/Deflection/Side shot/cUrvce/Closure/slope distaNce.] S

Enter horizontal angle <0.0000>:

When you are entering Quick Traverse data you have the options to change the angular input method. To change the angular input mode, enter the upper case letter seen in the prompt for the method of entry you want to change to and press <Enter>. The prompt should then change to reflect your choice.

Note: You need not use the shift and type a capital letter to choose a command line option. For example, to change to Side shot mode you can type either s or S.
The method that is currently set will not be shown as an option in the command line prompts. For example, if you type s and <Enter> for Side shot mode, the prompt will change to include Traverse and Side shot will no longer be available since you have chosen it as the current mode.

**Traversing a curve**

The Traverse routine allows you to traverse both reverse and compound curves.

Note: You will not be allowed to traverse around a curve if calculate elevation is selected.

**If you type U and <Enter> for cUrve, the following dialog box appears:**

![Image of Traverse dialog box]

**Enter any two of the curve components.**

**Identify the curve bearing as Chord if the angle, deflection, bearing or azimuth about to be entered is to the PT.**

**Identify the curve bearing as Radius if the angle, deflection, bearing or azimuth about to be entered is to the radius point.**

Click the Clockwise box if the curve is clockwise. If this box is not checked, the curve is considered to be counterclockwise.

If there is a previous traverse leg, check the Tangent Curve checkbox if the curve is tangent to the previous leg. If this checkbox is not checked, the curve is assumed to be non-tangent.

**When you have entered the required data:** click the OK button.

The input multiplication factor is applied to the curve data you enter (radius, arc length, chord, etc.).
At the next prompt, if the curve is a non-tangent curve, enter the angle, deflection, bearing or azimuth from either the PC to the PT or the PC to the radius point (depending on whether you set Curve Bearing to Chord or Radius). If the curve is tangent to the previous traverse line you will not be asked for the angle and distance.

The curve data will be calculated and shown at the command line:
- Bearing and distance from the PC point to the radius point.
- Bearing and distance from the radius point to the PT point.
- Bearing and distance from the PC point to the PT point.

**Other curve information.**
The radius and PT points will be stored in coordinate file using the STORING POINT prompt.

**Closure**

At the prompt: Azimuth/Bearing/Deflection/Side shot/Curve/Closure/slope distance.

Enter horizontal angle <0.0000>:

Type C and <Enter> to view closure information for the traverse to the current foresight.

**Slope/Horizontal Distance Data Entry**

If you have selected Slope Dist/Vert. Angle in the Traverse Options tab or switched to slope distances by typing N and <Enter> at the command line, enter the slope distance. Otherwise, enter the horizontal distance.

Note: The following steps are required only if Vertical Angles ON is checked on the Traverse Options tab or if Calculate Elev. was selected on the Global Settings tab.

**For slope distance - vertical angle:**
Enter the vertical angle.
Depending on the settings in the Traverse Options tab enter one of the following:
- Zenith (zero up)
- Nadir (zero down)
- Transit (zero level)

Transit vertical angles can be full circle (0 - 360), or positive for up and negative for down.

**For horizontal distance - vertical distance:**
Enter the vertical distance.

**Pulldown Menu Location:** CGTrav
**Keyboard Command:** QTR, CG_QTRAV
**Prerequisite:** Open Coordinate File
**Edit Raw File**

The Edit Raw File feature allows you to use the CGEditor to create a new raw data file, append to an existing raw data file, or edit an existing raw data file. For further and complete information on using the Edit Raw File see the chapter on CGEditor in the Tools section.

**CGEditor General Information**

The CGEditor is an integral part of preparing files for use in C&G applications. The CGEditor is a very powerful tool. You can open multiple data files of any supported file type and edit the files as needed. The CGEditor has a full complement of tools for searching and replacing and navigating within a file. It will also allow you to cut or copy records from one file and paste them into another file in order to merge files, move data between phases of a job, etc.

**The CGEditor can create and/or edit six types of data files used by C&G:**

**Raw Data Files**

Raw data files contain information pertaining to a field traverse. Raw data files are typically downloaded from the data collector and converted to the C&G raw data file format. These files have the extension .CGR.

**Map Check Files**

Map Check files contain bearing, distance and curve information and are typically used to calculate the closure of a deed description. These files have the extension .CGM.

**Cross Section Files**

Cross Section files contain one or more cross sections identified by their station along the alignment. Each cross section record has the percent grade defined for its left and right slopes. Following the "Station" record are several "Point" records containing the elevations and offsets of the points along the cross section. Cross section files consist of a pair of files; the main data file has the extension .CEW and the index file has the extension .CEX.

**Template Files**

Template files are merely cross section files that represent a standard cross section and can be used to generate other cross section files. However, unlike cross section files, template files use an integer ID instead of a station to uniquely identify each template. Like cross section files, the percent grade is defined for the left and right slopes of each template and there are a set of "Point" records specifying the template elevation at a given offset. The centerline elevation at offset 0.00 is typically set to 0.00. Template files consist of a pair of files; the main data file has the extension .CTP and the index file has the extension .CTX.
**Point Group Files**

Point Group Files (formerly called batch point files) are simply a list of point numbers that can define a group of points, a lot/parce of landl, or an alignment. These are ASCII files and have a .PTS extension.

**Coordinate Files**

CGSurvey supports many different coordinate file formats:

- C&G .CRD/.IDX - C&G numeric coordinate files
- C&G .CGC/.CGX - C&G alpha-numeric coordinate files
- Carlson .CRD - Carlson coordinate file format, numeric and alpha-numeric
- Simplicity .ZAK - Simplicity coordinate file
- LDT - MDB - Land Desk Top coordinate file

**Pulldown Menu Location:** CGTrav\Edit Raw File
**Keyboard Command:** ET, CG_EDIT_RAW
**Prerequisite:** Open Raw File

---

**Data Collector Transfer**

The Data Collector Transfer program allows transfer of data to and from the data collector. The program may also be used to convert raw data and coordinate files to the supported formats.

There are two variables that affect the interaction between your data collector and CGSurvey. One is the data collector itself and the other is the software you use in the data collector. This section provides information on the use of data collectors and software that will interact with CGSurvey.

**NOTE:** This manual is not a substitute for your data collector manual.

**GENERAL INFORMATION ON USING DATA COLLECTORS**

Before using the data collector program, make sure the correct data collector, communication port and communication parameters have been selected in the Settings dialog box.
**Direction of Transfer:**

Choose either "Data Collector to Computer" or "Computer to Data Collector".

**Data Collector and Computer Transfer Options**

**Instructions:** Press the STEP 1 button. Depending on the type data collector, type file and direction of transfer, this option will give you step by step directions on how to proceed.

The Transfer dialog is divided into two sections, left and right. The left part of the dialog box pertains to "Data Collect Options" such as file source, file format and the file being transferred. The right part of the dialog box pertains to the Desk Top "Computer Options". Below are instructions for setting both.

**Data Collector Options**
Pressing the triangle to the right of the edit box will bring up the list of data collectors to choose. From the list select the type of data collector being used.

![Data Collector Options]

**Use Data Collector:**

Check this box to transfer data to/from the data collector. You can also transfer to/from a file in the selected data collectors format.

**Use Disk File:**

Check this box if the data is in computer file. The data file must be formatted for the data collector selected.

**File Name:**

If you are importing from a file, or exporting to a file, or are connecting to a data collector that requires a file name for transfer, the File Name edit field will be active. To select the file path click on browse. In the file dialog box specify the path and file name of the file to be opened. select or enter the path and file name of the file desired file.
Transfer Coordinates with Raw:

Some field software allows unadjusted coordinates to be carried in the raw file as the field data is collected. This checkbox gives you the option to transfer this data or not. If you do not want approximate coordinates that were calculated in the field to be confused with control when processing the raw data, leave this box unchecked.

Computer Options

- **File type**: Choose the file type you are transferring/converting. Example: Raw Data, Coordinate, ASCII, etc.
- **File Format**: C&G will import and export several types of file formats for both Raw and Coordinate files.

Supported Raw Data File Formats:
New CGR ..................... *.cgr
Old C&G ..................... *.raw
OBS.......................... *.obs
Geolab ....................... *.iob
StarNet ....................... *.dat
SDR2x ....................... *.dat
SDR33 ....................... *.dat

Supported Coordinate File Formats:

C&G AlphaNumeric .......... *.cgc / cgl
C&G ......................... *.crd / idx
Carlson AlphaNumeric ........ *.crd
Carlson Numeric ............... *.crd
ASCII ....................... *.nez
ASCII ....................... *.asc
Geolab ....................... *.neo
StarNet ....................... *.pts
SDR2x ....................... *.dat
SDR33 ....................... *.dat
Simplicity ..................... *.zak
LDT.......................... *.mdb

Description Table:

To use a description table check "Use Description Table" box.

You have the ability to use multiple description tables. Examples of that might be:

State DOT
Boundary
As-Built
Topography

Each of these could have different codes and descriptions and this option would allow you to choose which description table to use for the reduction of this file.

To change the description table click the "Browse" button and select the TBL file.

Below is an example of a description table:
When using a description table, any INTEGER numbers in the description field of the data coming from the data collector will be replaced by the description in the table. For example, if your description is "13 5", the description put in the coordinate or raw data file will be “CL CMP”.

Transfer

Instructions: The instructions window will guide you step by step through the transfer routine. It will tell you what to do on the data collector, and in what order.

Transfer: Once all of the settings are set correct, clicking on the TRANSFER button will begin the transfer between the data collector/file and the desktop.

The Current Status window at the bottom of the Transfer Dialog will indicate the status of the transfer.

Settings
At the bottom middle of the main screen is the "Settings" button. The settings control communications, data units and output data path.

![Data Collector settings dialog box]

**Data Collector**

The Data Collector dialog box allows you to select a short-list of data collectors you are transferring to and/or from.

![Data Collector dialog box]

**Chapter 18. CGSurvey Module**
When you select the down button to the right of the data collector shown and the "Show Defaults only" box is unchecked, you will see the complete list of all the data collectors that C&G interfaces with.

You also can create a Default List. This default list should consist of the various data collectors your company may have and/or interface with on a daily basis.

You can use the Show Defaults only check box to limit the data collectors which may be selected from the Data Collector list on the main Data Collector Transfer Screen. If this box is checked, only those data collectors you have specified for the default list will be show.

To add a data collector to the default data collector list:
First make sure the Show Defaults only box is unchecked.
Next select a data collector from the list by scrolling up and down the list using the arrow keys.
When the new data collector is selected, make sure the communication parameters are correct to the data collector.
Once the settings are correct, click Add DC button
Now click the Save List to save the changes to the list.

When through setting all of the typical data collectors you may use, check the Show defaults only check box and only those instruments and settings will be displayed for your selection.

To remove a data collector from the default list:
Make sure the Show Defaults only is checked.
Highlight the data collector you wish to remove from list
Click on the Remove DC
Click on the Save List button
Chose OK and verify that the data collector is no longer in the default listing.

Communications

The Communication box allows you to set the following parameters:

Port
Baud rate
Parity
Word length
Stop bits

When a data collector is selected, C&G reads a list of default settings and compares it to the settings currently shown. If the current settings are different than those recommended the defaults will be displayed and a Set Recommended button will be displayed. This allows you to automatically set the recommended communication parameters for your data collector.

The Measurement portion of the Settings dialog box pertains to the units of Raw and Coordinate data input.
Angle Mode........................ Degrees or Grads
Direction Mode.................... Bearing or Azimuth
Azimuth Direction:............ North or South
Vertical Input.................... Zenith, Nadir or Horizontal
Distance............................. Foot or Meter
Foot Definition.................. U.S. or International
Coordinate Position........... North-East or East-North
Description Length.......... 1 to 100 characters

The Description Table portion of the Settings dialog allows you to select the default description table.

As mentioned earlier you can have multiple description tables, here is where you would select the description table to use.
The Use Description Table option, when checked, will replace any integer description found in the raw data file with corresponding description found on the description table. When this check box is not checked data will be transferred without translation.

Default Path for Output Files

Allows you to set the default location for storing transferred files

Receiving Coordinates from Data Collectors:

There is a point protection feature in place when bring coordinates into an existing coordinate file from a data collector. If the point already exists, and if the coordinate values are different, you will see the following dialog box.
You will have the following options:

**Cancel:** Terminate transfer  
**Overwrite:** overwrite existing point  
**Do Not Overwrite:** skip point  
**Overwrite, Do Not Ask Again:** Overwrite all existing points  
**Do Not Overwrite, Do Not Ask again:** Bring in only new points  

**Transfer Options**

Depending on the type of data collector that you are using, you will be able to perform some of the following functions:

- Receive raw data from the data collector or file.  
- Send raw data to the data collector or file.  
- Receive coordinates from the data collector or file.  
- Send coordinates to the data collector.  
- Send a program to the data collector.  
- Execute a program on the data collector.  
- Delete files on data collector.  
- View and/or Select files on data collector.  
- Format data area on the data collector.  

As data is received from a particular data collector or file, it is converted to a .CGR or .CRD file (or other supported format).
Data that is sent to the data collector is converted from the .CGR or .CRD format to the data collector format.

When data is received from a data collector, a read-only file in the data collector's native format is created and stored on the computer. If it is a raw data file, it has a .R$$ extension. If it is a coordinate file, it has a .C$$ extension.

**Select Points**

When transferring coordinates to the data collector you may choose which points are to be transferred. The default is ALL points. When you click on the Select Points button the following dialog box comes up.

![Select Points Dialog Box](image)

**Change file select from:** Click the file button to select the coordinate file that you want to transfer coordinates from.

**Choose Points:** This option allows you to select groups of points to be included from the file you have opened, using the C&G selection options.

**All Points:** All Points in the file will be selected.
**Block:** select blocks of Points.

![Define Block](image)

**Desc:** select points by their description.

**Match Case:** Case sensitive compare.

**Match Whole Word Only:** If your description is BOC this box is NOT checked, points with the descriptions BOC, BOC1, BOC2, etc. would all be included. If the box were checked, only points with the description BOC would be included.

**Code:** select points by Code

![Specify Code](image)

**Match Case:** Match the case of the text
**Match Whole Word Only:** If checked, in the above example, only AB would be selected. Descriptions of AB1, ABC and ABB would not.

**Elevation:** select points by elevation

**Low Value:**
Point ID: Point Number
Elevation: elevation at point

**High Value:**
Point ID: Point Number
Elevation: elevation at point

If a point number is entered in the point ID box the elevation for that point will be used for either the high or low elevation. You may however enter an elevation only.

**In Radius:** select all the points within a given radius.

If a point number is entered in the point ID box, the northing and easting of that point will be used for the center of the search circle.
To manually enter a northing and easting, leave the Point ID box empty and enter the values for the northing and easting of the circle.
Enter the radius for the search circle.

**In Rectangle:** Select all the points within a given rectangle.

If a point number is entered in the point ID box, the northing and easting of that point will be used for that corner of the rectangle.
To manually enter a northing and easting, leave the Point ID box empty and the northing and easting values. The two points defined the diagonal corners of the rectangle.

**Choice:** This option allows you to choose to include or exclude points previously in the C&G select point dialog box.

**Example:**

*In the choose points dialog box:* select by Desc
*Then type:* GS as the description
*in the choice dialog box:* select Exclude
Any point that has "GS" in the description field will be removed from the selection set.

*Total selected Points:* the total number of points selected is shown in the lower right hand corner of the dialog box.

*Default Column Width:* The columns have a default width. If you have changed the width of a column, say NORTHING, you may press this button to go back to the default widths.

**The remainder of this section discusses specific data collectors and software.**

**CG-Field & FieldPlus Data Collectors**

Establish a connection between the data collector and desktop computer with a standard 9-Pin serial cable, USB cable, Bluetooth, etc. Check the settings as shown above.

**Download a Description Table**

You can transfer the desktop description table directly to the CG-FieldPlus data collector. The table will be placed in the data collector's DC_DESC.TBL file. CG-Field will let you use codes without a description table. Simply delete the DC_CODES file from the data collector and use the code numbers to enter descriptions. When you transfer the file to the desk top, the codes will automatically be replaced with the appropriate description. (This allows you to combine codes.) For example, if you enter [1 20 30], in the description field on the data collector when the transfer takes place these numbers will be read from the desk top description table and converted to the corresponding description, such as [BL* TC SW].
Receiving Raw Data from CG-Field

NOTE: When uploading raw data from a data collector using CG-FieldPlus, a read-only file in the original CG-Field format is created on the computer (in the data directory) with a .R$ extension.

On the desk top data collection transfer dialog box, set the following:

Set transfer method to Data Collector to Computer.
Data Collector Type: CGFIELD+
Use Data Collector:
Transfer Coordinates with raw: -yes or no (your choice)
File Type: Raw Data
File Format: C&G (*.cgr)
File Name: enter the path and name where the file is to be stored or click on the "Browse" button and select the path.
Description Table: enter the path where the Description Table is stored or click on the "Browse" button and select the path
Select Transfer when all settings are correct.

On the data collector Utils menu, select:
1:C&G Transfer
2:Send Raw Data
Enter or select the raw data file
The file will be transferred.

NOTE: CG-Field uses only 2-character point codes. If you have CGSurvey set for 4-character point codes, the CG-Field file will be converted to a 4-character format but it will still have the correct 2-character code. If you download the same file back to the data collector, the downloaded file will be correct if you did not add any codes that actually consist of 4 characters.

Receiving Coordinate File from CG-Field

On the desk top data collection transfer dialog box, set the following:

Transfer Data Collector to Computer
Data Collector: CGFIELD+
Use Data Collector:
File Type: Coordinate
File Format: C&G (*.crd) or C&G (*.cgc)
File Name: enter the path where the file is to be stored or click on the "Browse" button and select the path.
Description Table: enter the path where the Description Table is stored or click on the "Browse" button and select the path
Press Transfer when all settings are correct.
On the data collector Utils menu, select:
1:C&G Transfer
3:Send Coords
Select Points
All points
Blocks of points
From points file
The file will be transferred.

NOTE: In any transfer routine it is important to prepare and have ready the device that will be receiving data first.

### Sending Coordinate File to CG-Field

On the data collector Utils menu, select:
1:C&G Transfer
3:Receive Coords

On the desk top data collection transfer dialog box, set the following:
Transfer: Computer TO Data Collector
Data Collector: CGFIELD+
Use Data Collector:
File Type: Coordinate
File Format: C&G (*.crd) or C&G (*.cgc)
File Name: enter the path where the file is to be stored or click on the "Browse" button and select the path.
Check the Select Points settings:
This tool allows you to select what group or groups of coordinates are transferred to the data collector.
Press Transfer: when all settings are correct.

NOTE: You should not download a file containing a 4-character code to your data collector. You will be warned that the last 2 characters of the code will not be sent. This means that a code of 1584 will be received as 15.

### Receiving ASCII File from CG-Field

On the desk top data collection transfer dialog box, set the following:
Transfer Data Collector to Computer
Data Collector: CGFIELD+
Use Data Collector:
File Type: ASCII
File Name: enter the path where the file is to be stored or click on the "Browse" button and select the path.
Select Transfer when all settings are correct.

On the data collector Utils menu, select:
1:C&G Transfer
6:Send ASCII
File Name With Extension
Sending ASCII File to CG-Field

On the data collector Utils menu, select:
1:C&G Transfer
5:Receive ASCII

On the desk top data collection transfer dialog box, set the following:
Transfer Computer to Data Collector
Data Collector: CGFIELD+
Use Data Collector:
File Type: ASCII
File Name: enter the path where the file is to be stored or click on the "Browse" button and select the path.
Select Transfer when all settings are correct.

The following are examples of typical data collection transfer settings. There will be cases with certain models or manufactures where special instructions will be required and C&G will provide those as needed.
There are three different dialog boxes involved with data collection transfer:

C&G Data Collection Transfer (shown above)
Settings
Description Table Editor.

The function and settings for each of these is described in detail in the previous pages.

The examples shown on the following pages show transfers directly from and to data collectors. These same transfer routines will also work with files that have been downloaded to the desktop computer.

**File Conversion Utility**

To convert data from files check the Use Disc File box and either hand enter the path and name or click on "Browse" and search for the file location.

These files need to be in the correct data file format.

Receiving Raw Data
On the desk top data collection transfer dialog box, set the following:

Select Data Collector to Computer
Data Collector: (select data collector from list)
Check Use Data Collector:
Transfer Coordinates with raw: -yes or no (your choice)
File Type: Raw Data
File Format: C&G (*.cgr)
File Name: enter the path where the file is to be stored or click on the "Browse" button and select the path.
Press Transfer: when all settings are correct.
Begin transfer from data collector

Receiving Coordinate Data
On the desk top data collection transfer dialog box, set the following:

**Select Data Collector to Computer**
- **Data Collector:** (select data collector from list)
- **Use Data Collector:**
- **File Type:** Coordinate
- **File Format:** C&G (*.crd) or C&G (*.cgc)
- **File:** enter the path to store the file or click on the Browse button and select the path.
- **Description Table:** enter the path where the Desc Table is located or click on the Browse button and select the path.
- **Press Transfer:** when all settings are correct.
- **Begin transfer from data collector**

**NOTE:** In any transfer routine it is important to prepare and have ready the device that will be receiving data first.

**Receiving ASCII Data**
On the desktop data collection transfer dialog box, set the following:

**Select Data Collector to Computer**

**Data Collector:** (select data collector from list)

**Use Data Collector:**

**File Type:** Coordinate

**File Format:** ASCII (*.nez)

**File:** enter the path to store the file or click on the Browse button and select the path.

**Description Table:** enter the path where the Desc Table is stored or click on the File button and select the path.

**Select Transfer:** when all settings are correct.

**Begin transfer from data collector**

---

**Sending Coordinate Data**
Prepare Data collector to receive Coordinate file
On the desktop data collection transfer dialog box, set the following:

**Select Computer to Data Collector**

**Data Collector:** (select data collector from list)

**Use Data Collector:**

**File Type:** Coordinate

**File Format:** C&G (*.crd) or C&G (*.cgc)

**File:** enter the path to file or click on the Browse button and file

**Check the Select Points setting:**

**Press Transfer:** when all settings are correct.

---

**Sending ASCII File**
On the desk top data collection transfer dialog box, set the following:

**Select Computer to Data Collector**

**Data Collector:** (select data collector from list)

**File Type:** ASCII

**File:** enter the path to store the file or click on the bROWSE button and select the path

**Press Transfer:** when all settings are correct.

**Sending Description Table**
On the desk top data collection transfer dialog box, set the following:

**Select Computer to Data Collector**

**Data Collector:** (select data collector from list)

**File Type:** Description Table

**File:** enter the path to store the file or click on the File button and select the path

**Press Transfer:** when all settings are correct.

---

**SurvCE Data Collector**

You can receive coordinates and raw data from the data collector, or send coordinates to the data collector. Make sure SurvCE is selected as the data collector.

---

**Recieve Coordinates from SurvCE**
On the desktop, click on "Data collector to Computer": select SurvCE as the Type data collector.

Set FILE TYPE to Coordinate: and select the desired File Format.

On the Data Collector, Select FILE > DATA TRANSFER: Choose Carlson/C&G Transfer.

On the desktop, select BROWSE button next to the FILENAME field: You will see the coordinate files that are on SurvCE.

Select the File you wish to download: and press OK.
Press the Transfer button. If you do not have a destination FILE NAME selected, you will see the following dialog:

In this case, the file already exists. If you press OK the coordinates will be written to the existing file. Point Overwrite Protection will allow you to select which points you wish to bring in. You can decide individually whether you want to overwrite a point or not, or you can select overwrite ALL points, or you can select to bring in ONLY new points.

A file with the same name and a C$$ extension will also be created with the data that came directly from survCE in survCE’s format. This file is ready-only and can be archived for legal purposes.
Recieve Raw Data from SurvCE

On the desktop, click on "Data collector to Computer": select SurvCE as the Type data collector. Set FILE TYPE to Raw Data: and select the desired File Format. 

On the Data Collector, Select FILE > DATA TRANSFER: Choose Carlson/C&G Transfer. 

On the desktop, select BROWSE button next to the FILENAME field: You will see the raw data files that are on SurvCE.
Select the File you wish to download: and press OK.

The selected raw data file will be transferred and converted to the selected format. A file with the same name and a R$$ extension will also be created with the data that came directly from survCE in SurvCE's format. This file is read-only and can be archived for legal purposes.

Send Coordinates to SurvCE
Select Computer to Data collector. Make sure the Data Collector TYPE is set to SurvCE: select the file to be set to SurvCE (N_DRUIDH.crd). If you do not select a destination name, it will be sent to the same named file as the source.

If you do not want to send ALL the points, but need to select specific point: press the SELECT POINTS button and choose the point to transfer.

On the data collector select FILE > DATA TRANSFER: Choose Carlson/C&G Transfer

On the Desktop, Press the TRANSFER BUTTON: The selected coordinates will be transferred.

If the file already exists on SurvCE, ou will see the following dialog:

You have the following choices:
Overwrite the existing file
Skip the file (do nothing)
Rename the file
Merge the points.

If you select the Merge option, you will see Carlson’s standard merge dialog:

![Merge Points Manager dialog](image)

This dialog allows you to fix all conflicts prior to transferring the points.

**TOPCON DATA COLLECTORS**

Use Topcon cable A-5 if your computer has a 25-pin serial port, or Topcon cable A-16 if your computer has a 9-pin serial port.

When uploading raw data from a Topcon/TDS data collector, a read-only file in the original data collector format is created on the computer (in the data directory) with a .R$$ extension.

When you send the description table to a Topcon/TDS data collector, only the first 999 descriptions will be sent.

**FC1 DATA COLLECTOR**

For the transfer program to be able to access any data in the FC1, it must be stored in the FC1 using the Program 2 supplied with the FC1 transfer software.
First locate the necessary cables to connect the FC1 to your computer. (your dealer should be able to help you with this).

**NOTE:** Currently, the only programs that are supported are ET1 and GTS3, which are supplied with the system.

Follow these instructions:
Select either ET-1 or GTS-3 when prompted.
Once you have loaded Program 2 into the FC1, you may enter your field data in either of two ways. The first way, is by connecting the FC1 to your total station and let the total station record angular and distance measurements for you by using the ET1 (GTS3) section of the FC1 program. The other way is to use the Manual Entry section of the program to store all of your field data directly through the FC1's keyboard.

**Collecting Data using the FC1**

(The following steps will be followed no matter which data entry method you use):

1) Set up data recording mode in the FC1.
2) Enter job information: job name, operator, instrument number, date, temperature, pressure.
3) Enter instrument point information: point number, H.I., backsight point, angle in instrument to backsight.
4) Enter foresight point information: point number, rod height, horizontal and vertical angles, distance.
5) If there are other foresights from the same instrument point, repeat step 4; or if you have another instrument setup, go to step 3; or if you are through, go to the end of the program.

**NOTE:** Never press the <skip> key when the FC1 is asking for data. Only use the <skip> key to by-pass "go to" options (see step 5 below).

**Automatic Recording of Data**

1) To set up the recording mode, have the FC1 connected to the ET1 (GTS3), and turned on. Wait until the left side of the display says READY.
   If the right side of the display says PRG>2, then you are ready for step 1A.
   Otherwise, press these keys: <func>, <#>, <Enter> and then go to step IB below.
   A) Press the <F1> key.
   B) When the display says GOTO 7 ET1-PROG? ("GOTO 7 GTS3-PRG"), press the <Enter> key.
2) Enter any name you want for the job-id:
   Enter the name of the operator.
   Enter the instrument number.
   Enter the date, temperature, and pressure.
3) Sight the backsight point with the instrument:
   Enter the instrument point number.
   Enter the instrument height (H.I.).
   Enter the backsight point number.
   Press <Enter> for the rod height.
   Press <Enter> when the display says REC MODE 2 (REC V/H< MODE? on GTS3).
   When the display says MODE>, press <2> and the ET1 should send angular information to the FC1.
4) Turn to the foresight.
Steps on Manual Recording of Data

1) To set up the recording mode, have the FC1 turned on. Wait until the left side of the display says READY. If the right side of the display, says PRG > 2 then you are ready for step 1A.

Otherwise press these keys: <func>, <#>, <Enter> and go to step 1B.

A) Press the <F1> key.

B) When the display says GOTO 7 ET1-PROG? (GOTO 7 GTS3-PRG): press the <skip> key.

When the display says GOTO 30 MANUAL?: press the <Enter> key.

2) Enter any name you want for the job-id:

Enter the name of the operator:

Enter the instrument number:

Enter the date, temperature, and pressure:

3) Enter the instrument point number:

Enter the instrument height (H.I.).

Enter the backsight point number:

Enter the rod height if desired:

Enter the angle in the instrument: when the backsight was taken.

Enter the vertical angle and distance: if desired.

4) Turn to your foresight. Enter the foresight point number, and press <Enter>.

Enter a description for the foresight and press <Enter>.

Enter the foresight rod height and press <Enter>.

Enter the horizontal angle, slope distance, and vertical angle to the foresight.

5) After step 4, then you should see this message in the display: GOTO 43 FS. PT#?

If you wish to turn more angles from the current instrument point, then press <Enter>, and go back to Step 4.

- or -

Press <Skip>. The next message will be GOTO 36 INST.PT? If you want to record another instrument set-up, then press <Enter>.

- or -

Press <Skip>. The next message is, GOTO 31 OPER.? To change operators, press <Enter>, and go to step 2.

- or -

Press <Skip>. The next message is GOTO 1 MENU? To go to the menu for another job, press <Enter>.

- or -

Press <Skip>. The next message is END. Press <Enter> to end entry for this session.
**Receive Data from FC1**

Once you have your data stored in the FC1, you must upload it to the computer.

Select the Receive Raw Data function. If you have already dumped the data stored on the FC1 to a computer file (in the Topcon format), you may choose to receive the data from the file. Enter the file name that contains the data, and the file name for the .CGR file.

**NOTE:** To power your FC1 while sending data to the computer, you must plug the power cable into the signal port at the top of the FC1 and toggle the FC1’s power switch to EXT.

**TOPCON PROPAC DATA COLLECTOR**

To enable the Propac to collect raw data in a format suitable for CG-Survey's data transfer program, the CG program must be installed on the 71B. To load the software: connect the Propac to the computer com port.

Follow the directions to download.

You may store the CG program in a freeport on the 71B. This has several advantages, the main one being it will not be lost if the batteries die.

Under the Propac options choose Load CG Program Into Propac.

**On the 71B:**

Type Freeport(.01) and key <Endline>.

Type COPY CG TO :PORT(.01) and key <Endline>.

**For ROM Versions Prior to 1.75**

Type DEF KEY 'f7','"USER @ RUNCG": and key <Endline>.

**For ROM Versions 1.75 or Later**

Type DEF KEY 'f7','"USER @ CONT PRGM2": and key <Endline>.

This will set up the raw data collection program to run on the Propac when the yellow function key and the <7> key are pressed. Unless something happens to the 71B, you should not need to reinstall the CG-Field program again.

Now delete the CG-Field program from the main memory of the Propac by typing PURGE CG:MAIN and key <Endline>. The program is still stored in the freeport.

To use the CG-RAW data program, turn the Propac on and type RUN PRO then key <Endline>. From the KEYS prompt press the yellow function key then the <7> key. This will start the CG program, then just follow the prompts.

The CG raw data program is the only one needed on the Propac other than the Propac options already available. If you are collecting coordinates and elevations instead of raw data, simply follow the Propac instructions.

To transfer the collected data to and from the computer, choose the Propac option you wish and follow the
directions on the screen.

If you have already downloaded the data stored on the Propac to a computer file (in the Propac format), you may choose to receive the data directly from the file. Enter the file name that contains the data, and the file name for the .CGR file (raw data file) or .CRD file (coordinate file).

**FC-4 DATA COLLECTOR**

The C&G data collector transfer program can accept data that was collected from the FC-4 in either the traverse mode or topo mode. It can receive coordinates from the FC-4 and also send coordinates to the FC-4 for stakeout. The CG data collector transfer program supports most the valid methods of collecting data in the traverse or topo mode of the FC-4 (including the ability to collected direct and reverse angles).

Refer to the FC-4 users manual to learn the different methods of data collection supported by the FC-4.

**Special Features - When translating the FC-4 file to a raw data file using the C&G data collector transfer program:**

1) If an FC-4 record is not used, the record will be placed in the raw data file as a comment with the message Not Used appended. No FC-4 record will be ignored. For example, *123 Not Used
2) Remarks ("R" records) will be placed in the raw data file as a comment record.
3) Coordinates will be placed in the raw data file as a coordinate record, (C 23 10000.0000 10000.0000 923.24 'TP).
4) When using the FC-4 Benchmark function, the following will be placed in the raw data file:
   A) The benchmark coordinates.
   B) The measurements to the benchmark as a foresight point.
5) When using the FC-4 Angle-Offset function the following will be placed in the raw data file:
   A) A comment line saying the next line is an angle/offset and showing the 1st and 2nd angle recorded to the point.
   B) A foresight record combining the first distance measurement and the 2nd angle measurement.
6) When using the FC-4 Distance-Offset function the following will be placed in the raw data file:
   A) A comment line saying the next line is a distance/offset and showing the slope distance, vertical angle and offset distance measured to the base point.
   B) A foresight record with a new slope distance and vertical angle calculated from the above information.
7) When using the FC-4 Perpendicular-Offset function the following will be placed in the raw data file:
   A) The foresight record to the base point.
   B) A comment line saying the next line is a perpendicular offset and showing the offset forward/backward, the offset left/right and the offset up/down.
   C) A foresight record with a new horizontal angle, slope distance and vertical angle calculated from the above information.

**NOTE:** If there is no left/right offset, data will not convert correctly to a CG-SURVEY raw data record. For example, if the Perpendicular Offset routine is used to locate a point away from the instrument but on the same line, the resulting data record will use the wrong horizontal angle.

8) Backsight azimuths are transferred to the .CGR file as reference azimuths.
When a file is first created on the FC-4 the user will be prompted for some header information. When the data is transferred to the computer, the C&G data collection transfer program will use the job-id as the file name for the raw data file created on the computer.

To prepare the data collector and computer for data transfer, connect the A-5 or A-16 cable to the serial port of the FC-4 and to the appropriate serial port of the computer. Make sure the correct data collector comm port has been chosen in Settings Dialog.

Choose the appropriate menu option on the FC-4, then follow the instructions and answer the prompts as they appear on the screen. Once the raw data has been downloaded into the computer the raw data can be edited, reduced and printed out from the Traverse/Input Edit program.

If you have already downloaded the data stored on the FC-4 to a file on the computer, you can transfer the data using the "Use Disc File” command

**TOPCON and TDS**

**Transferring Data**

On the C&G Data Collector Transfer screen set the data collector option to:

![Data Collector Options](image)

Check Settings to make sure all options are set correctly
Note: See opening section of this chapter for detailed instructions on the Settings dialog box and on sending and receiving files.

Sending Description Table to 48

When sending the description table (DC_CODES file) to the 48, the following occurs:
A new file (DESCRIPT.TXT) is created in the data directory on the computer.

The first 200 descriptions are duplicated from the DC_CODES file.
After that, the first 100 descriptions are reproduced 7 times with the following mapping codes preceding the descriptions:
201 - 300 BL*(DESC)
301 - 400 EL*(DESC)
401 - 500 CL*(DESC)
501 - 600 CF*(DESC)
601 - 700 OC*(DESC)
701 - 800 PC*(DESC)
801 - 900 PT*(DESC)

The DESCRIPT.TXT file is then sent to the 48.

TOPCON CR2 CARD READER
Data collected and stored using the Topcon Card Reader is in the same format as data on the FC-4. All data format rules for the FC-4 apply here.

**Set-Up**

Card Read Preparation. Before using the card reader it is necessary to set the two DIP switches on the bottom of the unit to the settings described below. The direction on the switch which is marked 'OFF' is really a '1'. You should read the attached label, not the switches.

**The CR2 should be set as follows:**

**Baud:** 19200

**Parity:** None

**Stop Bits:** 1

**Word:** 8

**SW1 DIP Switch:** Set the communication parameters

![SW1 Switch Diagram]

**SW2 DIP Switch:** Sets other parameters

![SW2 Switch Diagram]
Use the interface cable supplied with the CR2 unit and plug it into the comm port on the computer. Make sure you select the Topcon CR2 data collector and the correct comm port.

The Card Reader program allows:

1) Receive raw data from the CR2 or from a CR2 file.
2) Receive coordinates from the CR2 or a CR2 file.
3) Send coordinates to the CR2.
4) Send or receive a description table to CR2.
5) Receive description table.
6) Send or receive ASCII files from the CR2.
7) Send an executable (EXE) file to the CR2.
8) Catalog (or directory) of all files on CR2.
9) Delete files on the CR2.
10) Format cards for the CR2.

**Receiving Data from the CR2**

You may receive raw data files (.R), coordinate files (.N), ASCII files or description table from the CR2. All files on the CR2 of the type you wish to receive will be shown on the screen

Raw Data
Coordinates
ASCII
Description Table

**Receiving Data from a CR2 File**

If you have already downloaded the data stored on the CR2 to a file on the computer, you may choose to receive the data from the file.

**Sending Data to the CR2**

You may send coordinate (.CRD) files, ASCII files, EXE files or description table to the CR2. Select the file you wish to send.

You may not send a file to the card reader that already exists on the CR2. You must delete the file first. The.CRD files will be converted to .N files. ASCII files will be transferred without conversion, (make sure the file you are transferring is a true ASCII file).

**EXE files**

Programs with .EXE extensions can be transferred to the CR2. These files will be transferred with a .X extension.

**Note:** See opening section of this chapter for detailed instructions on the Settings dialog box & information on sending and receiving files.
Catalog: The catalog function will show you all existing files on the Topcon Card Reader.
Deleting Files: All files on the CR2 will be shown on the screen. Select the file you wish to delete. Be careful, once the file is deleted it is gone forever.
Format: The format function will allow you to format a card, making it ready to accept (store) data. If the card is already formatted, you will be warned that all information on the card will be lost, be careful.

SOKKIA (LIETZ) SDR2 DATA COLLECTOR

General Information

Use the cable supplied with the SDR2 data collector to plug into your computers serial port.

When uploading or downloading to or from the computer, turn the switch on the cable toward the word PRINTER. If this does not work, turn the switch toward the word COMPUTER and try again. If you still have trouble please call us.

In order to use the Lietz SDR2 data collector with the transfer program, there are 4 areas that you must consider: (1) Entering data into the data collector in a format that can be sent to your computer, (2) the transfer program itself, (3) sending calculated coordinates back to the data collector, and (4) the data collector code conversion table which converts numeric codes for points into English-language descriptions as the data is sent to the computer.

Sokkia (Lietz) data collectors allow you to enter attribute data. To use attribute data with CG-SURVEY, it must be appended to the description records in the following format: DESCRIPTION [attribute name] attribute

For example: PIPE [Diameter] 18"

Entering Data into the Data Collector

Note: that all of the following assume that you have a Getting Started book and Operator's Manual from the Lietz Company.

1) To begin a new job, press <clear> until Select operation appears in the display. Press the <Menu> key. When JOB appears in the display, press <Enter>, and enter the job name and scale factor.

2) To enter field data, press <clear> until Select operation appears in the display. Press the <Prog>. When Traverse appears in the display, press <Enter> and begin traversing.

2a) You may use the TOPO program rather than the Traverse program. If you use this program, you must use the R option when sending data to your computer. The "Transferring Field Data to the Computer" section of this contains more about this.
**Note:** The coordinates that you enter for the first instrument point are for the internal use of the SDR2, and can be changed when your field data gets to the computer.

**Note:** When recording your first backsight information, simply enter an azimuth from the instrument point to the backsight (0.0000 will do). The azimuth information is also only used internally in the SDR2. You can change all of that as you reduce your field notes on the computer.

**Note:** At each instrument setup, the first angle recorded must be to your backsight. Your instrument may be "zeroed" or not, but when the Traverse Reduction program runs, it will subtract the backsight angle from the foresight angles.

### Transferring Field Data to the Computer

If you have already dumped the data stored on the SDR to a computer file (in the SDR format), you may choose option to receive the data from the file. Enter the file name that contains the data, and the file name for the .CGR file (raw data file) or .CRD file (coordinate file).

Before data can be transferred in either direction between the computer and the SDR2, you must set up the transfer parameters in the SDR2. Once these have been set, they will not change, until you change them again. You do not have to set them each time. (The only parameter that you may wish to change is the baud rate.)

In our tests, the computer can receive data from the SDR2 at 4800 baud, its fastest speed, but the SDR2 could only receive points at 1200 baud. For fastest transmissions to and from the SDR2, you might wish to change this parameter in the SDR2.

The SDR-22 and SDR-24 data collectors will send to the computer at 9600 baud and receive data from the computer at 4800 baud.

1) **Set up parameters by pressing** `<clear>` **until the message Select operation appears in the SDR2 display.** Then, press `<Menu>`. Press the up or down arrow until Parameters appears in the display, then press `<Enter>`. You can then go from one parameter to the next by pressing the up or down arrows. When a parameter you wish to change shows on the display, press the `<Edit>` key, and change it. (See the SDR2 operator's manual.)

**These parameters must be in effect:**
Baud: 4800 (or 1200 for sending to the SDR2, see above discussion.)
Parity: not set
Word length: 8
Checksum: N
Coords: N-E-Elev

2) **After the parameters have been set,** simply connect the SDR2 to the computer,
and select the transmission option. (On the Lietz transfer cable, there is a switch that must be set to DTE.)

3) Choose the same baud rate at the computer as you selected in the SDR2 parameters. When the computer says Waiting for data..., press <clear> on the SDR2 until Select operation shows in the display window. Press the <Menu> key. Press an up or down arrow key until Comms output shows in the display, then press <Enter> on the SDR2. Answer <N> if you do not wish to send all jobs. Then enter the job that you do wish to send. (See the SDR2 manual for a complete discussion of this process.)

4) The SDR2 should then send its information to the computer.

Note: As each job record is encountered in the computer will ask you for a file name to store the data in. You may press <Enter> to use the same name as was used in the SDR2 or enter another name. You must use a valid DOS name (all numbers and letters of 8 or less characters will be fine.)

Attribute data collected by the SDR (13AT records) is appended to the descriptions as follows: DESC[Attribute Name]Attribute

Example: PIPE[diameter]18"

Transferring Coordinates to the SDR2

Be careful of the units when transferring coordinates. For example, if the SDR2 is set to Metric Mode, the SDR2 will automatically convert the coordinates from feet to meters. Before you can transfer coordinates to the SDR2, you must first set up the transfer parameters in the SDR2. Refer to the first part of the previous section for details about how to do this. Then:

1) Ready the SDR2 by pressing <clear> until Select operation appears on the display. Press the <Menu> key. Then press the up or down arrows until Comms input appears on the menu. Press <Enter>.

2) Select the Send Coordinates option and press Transfer.

3) Select the coordinate file on the computer.

4) Choose which coordinates to send.

SOKKIA (LIETZ) SDR33 DATA COLLECTOR

The SDR33 works the same as the SDR2. In Equipment Options there are two SDR33 choices, because when creating a new job on a SDR33 the format is determined by setting the Point ID field to Numeric (4) or Alpha (14).
SDR33 4-Pt

To transfer data to CG-SURVEY, select this setting if your SDR33 is set to Numeric (4). The highest point number allowed is 9,999.

SDR33 14-Pt

The C&G *.cgc files allow 10 character Alphanumeric point numbers. While C&G *.crd files allow only 5 digit numeric point numbers.

To transfer a SDR33, set to Alpha (14), the file format setting must be set to *.cgc.

Note: See opening section of this chapter for detailed instructions on the settings dialog box and on sending and receiving files.

LEICA (WILD) GRE3/GRE4 AND GIF-2 INTERFACE

Set Up for GRE3/GRE4
Select the Wild: GIF-2 under Equipment Options. Before transferring data from the GRE3/4 to your computer, you must first set up the transfer parameters in the GRE3. To do this follow these steps on the GRE3/4:

1) \(<\text{Set}> <\text{Mode}> <7> <0> <\text{Run}> <4> <8> <0> <0> <\text{Run}> <\text{Run}>\)
   (Sets the baud rate to 4800. If you wish, you may leave it at 2400, which is the rate the T2000 needs to communicate with the GRE3/4.)
2) \(<\text{Set}> <\text{Mode}> <7> <1> <\text{Run}> <2> <\text{Run}> <\text{Run}>\)
   (Sets even parity.)
3) \(<\text{Set}> <\text{Mode}> <7> <2> <\text{Run}> <1> <\text{Run}> <\text{Run}>\)
   (Use protocol.)
4) \(<\text{Set}> <\text{Mode}> <7> <3> <\text{Run}> <0> <\text{Run}> <\text{Run}>\)
   (\(<\text{CR}>\) only.)
5) \(<\text{Set}> <\text{Mode}> <7> <4> <\text{Run}> <2> <\text{Run}> <\text{Run}>\)
   (ACK/NAK + \(<\text{CR}>\) .)
6) \(<\text{Set}> <\text{Mode}> <4> <0> <\text{Run}> <4> <\text{Run}> <\text{Run}>\)
   (DDD.MMSSS).
7) \(<\text{Set}> <\text{Mode}> <4> <1> <\text{Run}> <1> <\text{Run}> <\text{Run}>\)
   (Feet).
8) \(<\text{Set}> <\text{Form}> <.> <\text{Run}> <\text{Rec}>\)
   (for the T2000)
   -or-
\(<\text{SET}> <\text{FORM}> <+/-> <.> <\text{RUN}> <1> <1> <\text{RUN}> <\text{REC}>\)
   (for the T1000)

Note: The above parameters do not "go away" when the GRE3/4 is switched off. They will stay the same until you change them or re-initialize everything.

Note: See opening section of this chapter for detailed instructions on the Settings dialog box & information on sending and receiving files.

Switch Settings/Cable

Option 1
GIF-2 Switches Cable Configuration
Option 2

GIF-2 Switches Cable Configuration
= X GRE-3/4 Computer
S1 < 2 > 3
S2 < 3 > 2
S7 < 7 > 7
5 <
(Jump 5, 6, 8, 20) 6 <
8 <
20 <

Data Collection Format for GRE3, GRE4, GIF-10

The transfer program expects your data to be in a specific format. To get your data in this format, follow these steps.

1) To begin a new job enter a "CODE 1" block into the GRE3/4.
Example:
RDY [CODE]
CODE [1]
I1 ? [RUN]
your job number (Example: 87001)
[RUN]
I2 ? job date (Example: 091687 for Sept. 16, 1987)
[RUN]
I3 ? [REC]

2) Define the first automatic point number for your first foresight.
Example:
RDY [SET]
SET [NR0]
S NR [2] for point number 2 as first foresight.
[RUN]

3) At each instrument point, enter a "CODE 2" block into the GRE3/4.
Example:
RDY [CODE]
CODE [2]
[RUN]
[RUN]
I2 ? [instrument height] EX: [550] for 5.50 feet.
[RUN]
I3 ? [REC]

Note: Each instrument point "CODE 2" block must be followed by a measurement reading to your backsight. You will probably need to change the point number for the backsight by:

RDY [NR]
NR [point number] EX: 4 for backsighting point 4.
[RUN]
THEN:
RDY [MEAS]
REC [REC]
-or-
ALL on T1000 will store in GRE3/4

4) Record your foresights. If necessary, change the rod height and/or the description of the foresight. Use "CODE 3" or "CODE 4" to do this. Both codes are essentially the same, but one asks for the description first and the other asks for the rod height first, allowing you to skip the second entry by pressing [REC] rather than entering a value (see the third example below). This step may be skipped if you do not wish to change either rod height or description from the previous entry.

Example 1:
RDY [CODE]
CODE [3] Code 3 = description, rod height
[RUN]
I1 ? [0][1] Description = 01 (must be 2 digits)
[RUN]
I2 ? [5][5][0] Rod height = 5.50 feet
[RUN]
I3 ? [REC]
See following section on Setting-up Description Codes.

Example 2:
RDY [CODE]
[RUN]
I1 ? [5][5][0] Rod height = 5.50 feet
[RUN]
I2 ? [1][0] Description = 10 (must be 2 digits)
[RUN]
I3 ? [REC]

Example 3:
RDY [CODE]
CODE [3] Code 3 = description, rod height

I1 ? [1][2] Description = 12 (must be 2 digits)

I2 ? [REC] (leave the rod height the same)

5) Take your measurement (make sure that the point number is correct first):

RDY [MEAS]
REC [REC]

6) Now, go to step 4 for another foresight or to step 3 for another instrument set-up:

Uploading from Data Collector to the Computer

If you have already dumped the data stored on the GIF-2 to a computer file you may choose to receive the data from the file. Enter the file name that contains the data.

After you have collected your field data, connect the GRE3/4 to your computer. Then select the receive option on the computer.

The baud rate in the computer must match the baud rate in the GRE3/4. After selecting the baud rate on the computer, follow the steps on the screen to initiate transmission.

Those steps are:

1) Connect the GRE-3/4 to the computer, turn it on, and wait for RDY to show on the display.
3) Press <GoTo>, press <Run>, and wait for the GRE-3/4 to display DCD.

After the computer detects the end of transmission, it will begin to format the data in a usable form. When each job record is encountered (CODE 1), you will be prompted to give the computer the name that you want to enter the file name for that job.

Sending Coordinates to the GRE-3/4

From the Menu, select the send coordinates option.

The baud rate in the computer must match the baud rate in the GRE3/4. Initiate transmission on the GRE-3/4 by doing the following:

Note: See opening section of this chapter for detailed instructions on the Settings dialog box & information on sending and receiving files.

1) On GRE-3/4, SET MODE 80 <Run> 2 <Run> <Run> to select file 2.
2) On GRE-3/4, SET MODE 81 <Run> <blocks> <Run> <Run> to dimension file 2.
3) Press any key to continue:
4) Next, select the points you wish to send: The transmission will begin.
LEICA (WILD) GIF-10 INTERFACE

Note: (Refer to data collection format GRE3 within this section)

Receiving Raw Data from GIF-10 Interface:

Select the receive raw data option on the computer.
If you have already dumped the data stored on the GIF-10 to a computer file (in the Wild format), you may choose receive the data from the file. Enter the file name that contains the data.

The baud rate in the computer must match the baud rate in the GIF-10. Do the following on the GIF-10:

1) Set the comm parameters as follows:
   Baud: (your choice)
   Parity: EVEN
   Protoc: ACK/NAK
   Stop Bit: 2
   End Mark: CR
   Connected AS: DTE
2) Put the GIF-10 in upload mode by selecting <Send> on the GIF-10.
3) Press <Run> on the GIF-10 and select the file you wish to send.
4) Press <Run> on the GIF-10.

Sending Coordinates to the GIF-10 Interface:

Select the send coordinates option.
The baud rate in the computer must match the baud rate in the GIF-10.
Do the following on the GIF-10:
1) Create receive file in GIF-10 now.
2) Put the GIF-10 in download mode by selecting Receive on the GIF-10.
Select the points you wish to send. The transmission will begin.

Note: See opening section of this chapter for detailed instructions on the Settings dialog box & information on sending and receiving files.

LEICA (WILD) GIF-10/WS

This is a Wild GIF-10 interface that will accept data in the same format as WildSoft. You will be asked for the Observation Pattern when the file is transferred. This pattern can be either BS-FS-FS-BS or BS-FS-BS-FS. As with WildSoft, codes 101 and above will be treated as descriptor codes. Code 100 will be subtracted from the descriptor code and that
description will be read from CG-SURVEY's description table. So 101 is description 1, 102 is description 2, and so forth.

The following table shows acceptable WildSoft data collection codes:

**WildSoft Data Collection Codes**

<table>
<thead>
<tr>
<th>Code</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Start Job</td>
</tr>
<tr>
<td>2</td>
<td>Occupy a Point</td>
</tr>
<tr>
<td>3</td>
<td>FS to Traverse Point</td>
</tr>
<tr>
<td>11</td>
<td>Assign Coordinates</td>
</tr>
<tr>
<td>13</td>
<td>Target Height</td>
</tr>
<tr>
<td>14</td>
<td>Add to Target Height</td>
</tr>
<tr>
<td>21</td>
<td>Occupy Saved Point</td>
</tr>
<tr>
<td>31</td>
<td>FS to Single Point</td>
</tr>
<tr>
<td>32</td>
<td>Radial Sideshots</td>
</tr>
<tr>
<td>33</td>
<td>Sets of Angles</td>
</tr>
<tr>
<td>63</td>
<td>Remark</td>
</tr>
<tr>
<td>101+</td>
<td>Descriptions</td>
</tr>
</tbody>
</table>

**LEICA (WILD) GIF-10/WS2**

This is the exact same interface as the GIF-10/WS except 100 is not subtracted from the descriptor code.

**LEICA (WILD) GIF-10/TOPOS**

This is a Wild GIF-10 interface that will accept data in the same format as the Canadian software TOPOS. To select this format, choose GIF-10/TOP from the data collector choices in the Equipment Options. The following information explains the format.

**These six Wild codes are used:**

<table>
<thead>
<tr>
<th>Code Field</th>
<th>Field 1</th>
<th>Field 2</th>
<th>Field 3</th>
<th>Field 4</th>
<th>Rectype</th>
</tr>
</thead>
<tbody>
<tr>
<td>91</td>
<td>Job Name</td>
<td>Date</td>
<td>Temperature</td>
<td>Pressure</td>
<td>New Job</td>
</tr>
<tr>
<td>10</td>
<td>Label # HI Instrument Pt.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>Label # RH Backsight Pt.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>30</td>
<td>Label # RH Trav. Pt.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>40</td>
<td>Label # RH Side Shot Pt.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Label # RH Offset Angle SS</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1) If RH (rod height) is 999 it will be considered no value (do not calculate elevation for
2) The Label# (point description number) can contain up to eight characters. The first four and last four will be read as separate descriptions. For example, if Label# is 00210034, then description 21 will be pulled from the description table and description 34 will be pulled from the description table. If 21 is BL* and 34 is TC, then the resulting description will be BL* TC.

3) Point numbers are taken from measurement records. A measurement record will follow code 10, 20, 30, and 40 records. For example:
In this example, there is a side-shot record (40), a point label description (71), a rod height (2.150), and a point number (332).

4) If an offset distance is placed in Field 3 of a side-shot record, the measured angle will be shown in a comment line prior to the data record with the newly calculated angle.

5) If a comment is placed in field 4 of a side-shot record, the comment will be appended to the point's description. example: If the label# is 25 and the comment is 150, description 25 (lets say TREE) will be pulled from the description table and the comment will be appended to the description, giving TREE 150 as the description.

Leica Data Pro:
You are allowed to read and write to the Leica Data Pro formatted GSI files. There is no communication directly with the Leica Total stations.

**GEODAT 122/124 DATA COLLECTOR**

In order to use the Geodat 122 or 124 data collector with the transfer program, there are three areas that you must consider: (1) entering data into the data collector in a format that can be sent to your computer, (2) the transfer program itself, and (3) the data collector code conversion table which converts numeric codes to more readable descriptions when the data is sent to the computer. The following section describes how to enter your data into the data collector. The next section will then give you some information about how to transfer the data. The data collector code conversion table can be changed with menu selection E from the program menu.

**Entering Data into the Data Collector**

1) Each individual job stored in the Geodat's memory should begin with a job identifier. To enter a job identifier, follow these steps:
   a) Press the <Info> key.
   b) At the prompt "inFo=" enter a job number, like this:
inFo=87001<Ent> (<<Ent> means to press the <Ent> key.)
   c) At the prompt "dAtA=" enter the date like this:
      Example: dAtA=050187<Ent> (for 05/01/87)

2) For each instrument location, you must enter an instrument point identifier. Follow the following steps to do this:
a) Press the <Stn> key.
b) At the "Stn=" prompt enter you instrument point number like this:
   Stn=1<Ent> (for instrument point 1)
c) At the "iH=" prompt enter the instrument height, like this:
   iH=5.5<Ent> (for 5.5 feet)
d) Next the prompt "PCod=" will appear on the display. At this time, enter your backsight point, just like the foresights in the next step. You may enter "0" (zero) for all of the fields except:
   "Pno=" (enter the backsight point number)
   "Hor=" (enter the angle in your instrument when you take the backsight.)
3) Recording foresights. You are now ready to record a foresight:
   a) At the "PCod=" prompt enter the point code for your foresight like this:
      PCod=10<Ent> (for point code 10)
      Note: The point code will be used to assign a description to your foresight. The description that is associated with each code is up to you. Use the "Edit data collector code table" program to set up your codes before uploading your data to the computer.
   
   b) At the "Pno=" prompt enter your foresight point number like this:
      Pno=2<Ent> (for point number 2)
   c) At the "SH=" prompt enter the rod height of your foresight like this:
      SH=5.5<Ent> (for 5.5 feet)
      The next three fields may be entered manually or may be automatically stored by your instrument.
   d) At the "Hor=" prompt enter the horizontal angle to your foresight like this:
      Hor=65.1253<Ent> (for 65 degrees, 12 minutes, and 53 seconds.)
   e) At the "ELE=" prompt enter the vertical angle to your foresight like this:
      ELE=90.1215<Ent> (for 90 degrees, 12 minutes and 15 seconds)
   f) At the "diSt=" prompt enter the slope distance to your foresight like this:
      diSt=100.128<Ent> (for 100.128 feet)
   
      Now, go to step 2 for a new instrument point, or step 3 for another sight from the current instrument point.
      
      Note: If you have already dumped the data stored on the 122/124 to a computer file (in the 122/124 format), you may choose to receive the data from the file. Enter the file name that contains the data, and the file name for the .CGR file.

Receive Data from Data Collector

Select the receive raw data option.
1) Before you upload your data, make sure that the description table is current.
2) Before you initiate the upload program, you must first define the upload parameters for the Geodat. To do this, follow the steps outlined below.
3) This should not have to be done each time. The values that you enter should stay the same until you change them.
   a) Press the \(<f>\), the \(<1>\), the \(<0>\) and the \(<\text{Ent}>\) keys. (For function 10.)
   b) Answer the baud rate question like this: \(bAud=1200<\text{Ent}>\) (for 1200 baud you can use 300 baud, but it will take longer to transfer your data.)
   c) Make sure that "Eob=" looks like this: \(Eob=0123456789<\text{Ent}>\)
   d) Make sure that the "StArt=" prompt looks like this: \(StArt=035<\text{Ent}>\)
   e) Make sure that the "StoP=" prompt looks like this: \(StoP=000<\text{Ent}>\)
   f) Make sure that the "ErrCodE=" prompt looks like this: \(ErrCodE=037<\text{Ent}>\)
   g) Make sure that the "nuLLS=" prompt looks like this: \(nuLLS=000<\text{Ent}>\)

GEODAT 126, 400, 500 AND INTERNAL MEMORY THEODOLITES

These Geodat data collectors use the following data entry format:

Instrument Point Setup
Labels Explanation
*2 Instrument Point
  3 Height of Instrument
*62 Backsight Point
  21 Backsight Angle
  6 Backsight Rod Height
  7 Horizontal Angle to Backsight
  8 Vertical Angle to Backsight
  9 Slope Distance to Backsight
* Indicates required code

Note: Pcodes (label 4) cannot be used anywhere except in foresight records.

Note: The order of the instrument point setups is not important.

Foresight Points
Labels Explanation
*5 Foresight point
  6 Backsight rod height
  7 Horizontal angle to backsight
  8 Vertical angle to backsight
  9 Slope distance to backsight
  4 Pcode (Description)
* Indicates required code

Note: Foresight points must begin with either a Pcode (label) or a foresight point (code 5). The order of the remaining parameters is not important.

Label 4 (Pcodes) are placed in the description field of the raw data file. If you cannot get the entire point description into a single Pcode, we allow you to use multiple Pcodes for an individual point.
Example: 4 = Manhole,  
4 = Inv. -10.23,  
4 = 12” Conc.Pipe  

The resulting point description is: Manhole, Inv. -10.23, 12” Conc.Pipe  
If the Append Info Records to Pcode toggle is on, info records (label 0=) that directly follow a Pcode (label 4=) will be appended to the Pcode prior to being placed in the point description.  

Example: 4 = Manhole,  
0 = Inv. -10.23,  
0 = 12” Conc.Pipe  
The resulting point description is: Manhole, Inv. -10.23, 12” Conc.Pipe  

GEODAT 126 DATA COLLECTOR  

I. The Cable  

Your cable should be made as follows:  
NC - No connection.  

**Geodat 126 (male) Computer 25 Pin**  
2 .......................................... 2 (TxD)  
3 .......................................... 3 (RxD)  
7 .......................................... 7 (S.GND)  
5-NC —-5 (CTS) jumper 5-6-8-20  
6-NC —-6 (DSR)  
8-NC —-8 (CD)  
20-NC —-20 (DTR)  

**Geodat 126 (male) Computer 9 Pin**  
2 .......................................... 3 (TxD)  
3 .......................................... 2 (RxD)  
7 .......................................... 5 (S.GND)  
5-NC —-8 (CTS) jumper 8-6-1-4  
6-NC —-6 (DSR)  
8-NC —-1 (CD)  
20-NC —-4 (DTR)  

II. Set Protocol 2 and 5; Set Format 2  

Be sure the INT/EXT. switch is set to INT. if you are not connected to an external power source. Be sure the on/off switch is in the on position.  

Set protocol by using program 51 in the Geodat.  

Protocol 2 Protocol 5
Set format by using program 50 in the Geodat.
Format 2
1: 1
2: 80
3: 13
4: 15

III. Data Storage in the Geodat 126

Raw data is gathered into job files using the pre-programmed UDS's in the Geodat 126. Call us if you wish to create others.

To use the existing programs, begin by choosing program #10. This sets up the header information and first instrument/backsight points. For foresights, choose program #0 if you are carrying elevations or program #1 for horizontal locations only. Use program #11 to change instrument set-ups. These programs are explained on page 8:4 in the Geodat manual.

Coordinates are transferred from and into area files.

Special numeric point codes may be used. These codes are converted to alphanumeric descriptions as the data is received from the Geodat 126. The codes are defined in the description table.

IV. UDS Requirements

The initial testing of the Geodat 126 was done using the standard UDS's supplied with the Geodat 126. If you wish to try using your own, these rules apply:
1) A measurement must end with label 9. (See sample UDS’s 0, 1, 2, 3.)
2) Each Job. No. file must begin (1st record) with ADM type data (see sample UDS 10). This sequence must end with label type 74 - Air Pressure.
3) Each instrument station sequence must end with Hz. Ref. (Label 21). See the UDS 11 in Geodat 126 manual for sample.

Select the receive/send option from the computer menu and follow the prompts.
If you have already dumped the data stored on the DR-2 to a computer file (in the DR-2 format), you may choose to receive the data from the file. Enter the file name that contains the data, and the file name for the .CGR file (raw data file) or .CRD file (coordinate file).

GEODAT 400 DATA COLLECTOR

Setting up the Geodat 400 for use with the transfer program:
1) Set protocol 0 (as shown below).
2) Set format 0 (as shown below).

Be sure the on/off switch is in the on position.
Set protocol by using program 51 in the Geodat field instrument.

Protocol 0
1: 9600
2: 0
3: 8
4: 1
5: 10
6: 0
7: 1
8: 17
9: 19
10: 0
11: 0
12: 0
13: 0
14: 1.13
15: 0
16: 1.04

Line 7 implements software handshaking between the 400 and the MS-DOS computer by using a value of 1. When the value of item 7 is 0, then no software handshaking is done.

Line 8 is given a value of 17 which is the Xon value used for the communication handshaking.

Line 9 is given a value of 19 which is the Xoff value used for the communication handshaking.

Set format by using program 50 in the Geodat field instrument.
Format 0
1: 1
Note: It is important that the values above be set as we show them or our software can not communicate with the Geodat 400 Data Recorder.

If you have already dumped the data stored on the 400 to a computer file (in the 400 format), you may choose to receive the data from the file. Enter the file name that contains the data, and the file name for the .CGR file (raw data file) or .CRD file (coordinate file).

**Uploading Raw Data to the Computer**

After you have collected your field data, connect the Geodat 400 to your computer. Select the receive raw data option.

The baud rate in the computer must match the baud rate in the Geodat 400.

Do the following:
1) **Connect the 400 to the computer, turn it off, then on.**
2) **Make certain that you have selected the correct protocol and format.**
3) **Enter name of Geodat job file.**

**Download Coordinates into 400 Area File**

Select the send coordinates option.

Select the points to send.

Ready the 400 with the following steps:
1) **Connect the 400 to the computer, turn it off, then on.**
2) **Make certain that you have selected the correct protocol and format.**
3) **Enter name of Geodat area file.**

The coordinates will be transferred.

**Get Coordinates from 400 Area File**

**Receive coordinates from 400 Area File**

The baud rate in the computer must match the baud rate in the 400. Do the following:
1) **Connect the 400 to the computer, turn it off, then on.**
2) **Make certain that you have selected the correct protocol and format.**
3) **Enter name of Geodat area file.**

The transmission will begin.
Setting up the Geodat 500 for use with the transfer program:
1) Set protocol 0 (as shown below).
2) Set format 0 (as shown below).
Be sure the on/off switch is in the on position.
Set protocol by using program 51 in the Geodat field instrument.

Protocol 0
1: 9600
2: 0
3: 8
4: 1
5: 10
6: 0
7: 1
8: 17
9: 19
10: 0
11: 0
12: 0
13: 0
14: 1.13
15: 0
16: 1.04

Line 7 implements software handshaking between the 500 and the MS-DOS computer by using a value of 1. When the value of item 7 is 0, then no software handshaking is done.

Line 8 is given a value of 17 which is the Xon value used for the communication handshaking.

Line 9 is given a value of 19 which is the Xoff value used for the communication handshaking.
Set format by using program 50 in the Geodat field instrument.

Format 0
1: 1
2: 80
3: 32
4: *

Note: It is important that the values above be set as we show them or our software can not communicate with the Geodat 500 Data Recorder.

The C&G Data collector Transfer dialog box has an additional option for the GEODAT 500 collector, as shown below. the show DC files:
This Option actually reads and displays the data files on the GEODAT 500 data collector. From the display options you can select to view all files, just coordinate files or just raw files.

If you have already dumped the data stored on the 500 to a computer file (in the 500 format), you may choose to receive the data from the file. Enter the file name that contains the data, and the file name for the .CGR file (raw data file) or .CRD file (coordinate file).

You can also delete files from the GEODAT 500. Be careful, once the files is deleted it is gone forever. When you have the files selected, you want to transfer, select exit.
The Geodat 500 program allows:
1) Receive raw data from the Geo 500
2) Receive raw data from a file.
3) Receive coordinates from the Geo 500.
4) Receive coordinates from a file.
5) Send coordinates to the Geo 500.
6) Catalog (or directory) of all files on Geo 500.
7) Delete files on the Geo 500.

Receiving Data from the 500

You may receive raw data files (M=), or coordinate files (I=).
All files on the 500 of the type you wish to receive will be shown on the screen (for example, all I= files for coordinate).
1) Select the file you wish to receive.
Raw Data (Job Files)

2) After the raw data file is transferred, you will be asked to select the file name it will be stored under on the computer. The default value will be the same name with a .CGR extension.
Coordinates (Area Files)

3) After the coordinate file is transferred, you will be asked to select the file name it will be stored under on the computer. The default value will be the same name with .CRD/.IDX extensions.

Sending Data to the 500
You may send coordinate (.CRD) files to the 500. All coordinate files on the computer will be shown on the screen. Select the file you wish to send.

1) You may select the only the coordinates that you wish to send (you do not have to send the entire file).

Catalog
2) The catalog function will show you all existing files on the Geodat 500.

Deleting Files

All files on the 500 will be shown on the screen.
1) Select the file you wish to delete. Be careful, once the file is deleted it is gone forever.
2) Press <Esc> if you do not want to delete a file.

GEODIMETER TOTAL STATIONS WITH INTERNAL MEMORY

You can select Geodat 500 and interface directly with any Geodimeter that has internal memory. To transfer data from a Geodimeter Total Station with internal memory, do the following:

1) In Equipment Options, select Geodat 500 as the data collector and run data collection program.
2) Use Geotronix cable #571136756. Connect RS232 on computer to RS232 on Geodimeter with cable.
3) Power on Geodimeter and turn off compensator with Function 22 as follows:
   Key
   <F> (Function)
   <22>
   <Ent> (Enter)
   <0>
   <Ent>
   Then press <Ent> until P0 is displayed on Geodimeter screen.

4) Set the END character to 4 with Function 79 as follows:
   Key
   <F> (Function)
   <79>
   <Ent> (Enter)
   <4>
   <Ent>

5) Initiate comm port on Geodimeter as follows:
   Key
   <Mnu> (menu)
   <4> (data com)
   <1> (select device)
   <2> (serial)
   <Yes> (serial on)
   <1.8.0.9600> (com=) skip if already set
   <Ent> (enter)
6) You may now select all options on the computer menu for data collection transfer with the Geodimeter. See Geodat 500 instructions for data transfer (disregard formatting procedures).

**SMI 48 ENHANCED DATA COLLECTOR**

The SMI interface routine works only with SMI Enhanced Cards. Use the interface cable supplied with the SMI unit (plugs into the comm port on the computer).

**SMI 48 transfer Versions 5**

**Receiving Data**

If you have already dumped the data stored on the SMI to a file on the computer, you may choose to receive the data from the file.

Receiving Raw Data from the SMI
Select the Receive raw data option on the computer. On the SMI, select TOPC and then RAW. The transfer will begin. The file name will be shown on the screen after the transfer is complete. You may enter a new file name if you wish.

Our reduction program does not allow a raw data file with mixed angle types (for example: azimuths, angles right, deflections, etc.). When you are collecting data on the SMI, stick to one angle type. You can mix distance types if you wish (slope/zenith, horizontal/vertical).

Receiving Coordinates from the SMI

![Image of data collector transfer software]

1) Select the Receive Coordinates option on the computer:
On the SMI select TOPC and then SMI.
2) On the SMI, enter the first and last point numbers you wish to send:
The transfer will begin.

Sending Coordinates to the SMI
1) On the SMI select TD48 and the SMI.
2) Select the Send Coordinates option on the computer. You will be asked if you wish to send descriptions. The answer to this question depends on whether the SMI coordinate file you are sending to is a 15 byte file (no descriptions) or a 30 byte file (descriptions).
3) On the computer, select the points you wish to send. When the selection set is complete, press <T> for transmit. The transfer will begin.

SMI 48 transfer Versions 6, 7 & 8

Receiving Raw Data from the SMI

1) Get the C&G Transfer Program ready to receive raw data: Press Transfer
2) On the SMI data Collector select [PRINT]: set the soft-key to [WIRE]

Receiving Coordinates from the SMI
1) Get the C&G Transfer Program ready to receive raw data and Press Transfer
2) On the SMI data collector select [JOB], then [KERM]: set the soft-key to [NE] and [COMM], select [SEND] and then select the points to transfer.

Sending Coordinates to the SMI

1) On the SMI data collector select [JOB] the [KERM]: set the soft-key to [NE] and [COMM], select [RECV].
2) Configure the C&G Transfer Program to send Coordinates: select the points to be sent and press TRANSFER.

Nilon Data Collection Transfer

Receiving Raw Data from the Nikon Total Station:

1) Get the C&G Transfer Program ready to receive raw data and Press Transfer
2) On the Nikon select [MENU]. Select option [SET] and then option [COMM]. Set "Ext.Comm:" to Nikon.
3) From the Main Menu on the Nikon select "Comms" and "Download": select format: NIKON and Data: RAW
4) Press ENTER to send.
Receiving Coordinates Data from the Nikon Total Station

1) Get the C&G Transfer Program ready to receive raw data and Press Transfer
2) On the Nikon select [MENU]. Select option [SET] and then option [COMM]. Set "Ext.Comm:" to Nikon. Set the communication parameters to match those in the C&G transfer program.
3) From the Main Menu on the Nikon select "Comms" and "Download": select format: NIKON and Data: COORD.
4) Press ENTER to send.

Sending Coordinates Data from the Nikon Total Station

1) On the Nikon select [MENU]. Select option [SET] and then option [COMM], set "Ext.Comm:" to Nikon. Set the communication parameters to match those in the C&G transfer program.
2) From the Main Menu on the Nikon: select "Comms" and "Upload Data". Press ENTER to receive.
3) Configure the C&G Transfer Program to Send Coordinates: select the points to be sent and press TRANSFER.

Pulldown Menu Location: CG-Survey > CGTrav > Data Collector Transfer
Keyboard Command: DC, CG_DATA_COLLECTOR
Prerequisite: Check Cable Connection & Communication Parameters

Edit Level File

This command is for entering and editing level data. It has a spreadsheet editor for entering and adjusting this information, and the level calculations are updated as the data is entered. There is also a processing and reporting feature.

Carlson Software supports two level file formats:

LEV Files: The .LEV file is the old format. You can still edit and process files in this format. The LEV format only supports differential levels, single and three-wire. The LEV file has 5 record types:

1) SR - Start Record. Contains the starting benchmark measurement.
2) TP - Turning point record, contains the backsight and foresight to the turning point.
3) LV - Side Shot (or level) record. Contains the foresight measurement to the point.
4) ER - End Record, contains the measurement to the ending benchmark.
5) Note/Comment - starts with two dashes

TLV Files: The TLV file format can contain Differential and/or Trig-Level data. This is Carlson's new format and is supported by SurvCE (Carlson data collection program). The TLV file has the following record types:

1) H1 - First header record contains project information
2) H2 - Second header record contains date, time, temperature and pressure information
3) BM - Benchmark record, contains the point number, elevation and description of the benchmark.
4) LS - Rod height, only used with TRIG-LEVEL data.
5) BS - Backsight measurement. This record contains the backsight point number and measurement:
   a) Differential data: VD and HD - Vertical Difference (rod reading) and Horizontal Distance
   b) Trig data: SD/ZE - Slope Distance and Zenith Angle
6) FS - Foresight measurement. This record contains the foresight point number and measurement.
   a) Differential data: VD and HD - Vertical Difference (rod reading) and Horizontal Distance
   b) Trig data: SD/ZE - Slope Distance and Zenith Angle
7) Note/Comment - starts with two dashes

This routine runs the *.TLV / *.LEV file editor and file report functions.

**LEV File Editor:**

If you are creating a new .LEV file, you must choose either single-wire or three-wire for your level format data entry preference.

Three Wire leveling, or precise leveling, is a process of direct leveling wherein three cross hairs, or threads, are read and recorded rather than the single horizontal cross hair. Note below, in the sample three-wire editor graphic, the additional columns representing top and bottom readings.

**Prompts**

The commands starts by asking you, with a dialog box, to select an existing level file (.LEV) to process or to select a name for a new level file. The below examples are using existing files. Once this choice is made the small, Level Format dialog appears.

![Level Format dialog box]

**Format choice box**

Regardless of whether you choose Single or Three Wire, the Level Editor appears in its own window. Below we see the editor displaying the contents of two existing files of level information. One is single wire and the other is three wire. The pull down menus are the same for both, as described below in detail.
Level File Editor - sample Single Wire data

Level File Editor - sample Three Wire Data

Menu Options:
File Menu:

Open - Open an existing .LEV file.
New - Creates a new level file. All new files will be in the TLV format.
Save - Save changes
Save As - Save as different file name
Settings - Allows you to set the tolerances for three-wire level loops and the distance between top and bottom hairs.

Settings, under File

Import - You can import the following level file formats:
Leica GSI format
Leica XML format
Trimble DAT format.

Print - get hard copy printout of data.
Exit - Exit Level Editor Program
Edit Menu:

Cut
Copy
Paste
Go To - "Go To" will take you to the row of your choosing. Enter the row number.

Add Menu:

Add: These options allow you to add or insert a new record into the level editor.

Start Record (SR): Starts the level run, usually with a known starting elevation or benchmark.
Turning Point (TP): Turning point measurements, backsight and foresight.
Level Shot (LV): For entering leveling side shots - foresight measurement only.
End Record (ER): Backsight and foresight measurement tying to your ending benchmark.
Note: You can add a note, or comments, into the editor as you move through the level run.

Tools Menu:

Adjust Elevations: This function will do a simple adjustment of your level data and place the adjusted elevations in the Adjusted Elevation column. If you are running 3 wire level loop the corrections will be inversely proportionate to the distance between the measurements. If you are running a single wire level loop, the corrections will be averaged by the number of turns.

Store Elevations to Coordinate File: It is important that the point numbers in the level file match the point numbers in the coordinate file.

If you have an active coordinate file passed to the level editor, this option will be available to you. The elevations calculated in the level file will be stored in the active coordinate file by matching point numbers. The point must exist in the coordinate file before an elevation will be stored. After the elevations have been stored, a report will show which points were stored and which ones were not. If adjusted elevations have been calculated, they will
be stored. If not, the unadjusted elevations will be stored.

![Level Editor - Tools pull down menu](image)

**Editor columns**

A measurement record will have the following columns:

**Type** - Two character abbreviation that shows the record type:
- SR - Start Record
- TP - Turning Point
- LV - Side Shot
- ER - End Record
- DS - Note or Comment

**Point #** - Point number of measurement.

**BS** - Backsight rod reading

**HI** - Calculated height of instrument

**FS** - Foresight rod reading

**Elevation** - Elevation of point

**Code:** Can be either EL or FE using the pull down. This is used by SurvNET, our Network Least Squares Adjustment program. If the elevation is designated FE for Fixed Elevation, it will be treated as a Control Elevation and held fixed. If the elevation is designated with the EL code, it will be allowed to change.

**Adjusted Elevation** - Adjusted elevation of point

**Description** - description of point

**Pull down Menu Location:** CG-Survey > CGTrav > Edit Level File

**Keyboard Command:** LEV, cg_level_editor

**Prerequisite:** None

**TLV File Editor:**

TLV files can contain trig-level and/or differential level data. The editor will allow both type records in the same file.
Below is a sample Trig-Level TLV file:

<table>
<thead>
<tr>
<th>Point#</th>
<th>RodHt</th>
<th>Zenith</th>
<th>S. Dist</th>
<th>HI/Elev</th>
<th>AdjustElev</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>D3</td>
<td>M1, PRT Test Project, OPTest Operator, LPTest Loop</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D3</td>
<td>M2, D76/10/05, TM2:45PM, PRTemperature 112 NE, TP101 F</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Point#</td>
<td>Elev</td>
<td></td>
<td></td>
<td></td>
<td>Description</td>
</tr>
<tr>
<td>5</td>
<td>BM</td>
<td>2</td>
<td>1000.010</td>
<td>1000.010</td>
<td>pt2 desc</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Point#</td>
<td>RodHt</td>
<td>Zenith</td>
<td>S. Dist</td>
<td>HI/Elev</td>
<td>AdjustElev</td>
</tr>
<tr>
<td>7</td>
<td>BT</td>
<td>2</td>
<td>4.500</td>
<td>69.31000</td>
<td>1500.540</td>
<td>991.006</td>
</tr>
<tr>
<td>8</td>
<td>BT</td>
<td>2</td>
<td>4.500</td>
<td>270.29000</td>
<td>1500.530</td>
<td>991.006</td>
</tr>
<tr>
<td>9</td>
<td>Note</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>D3</td>
<td>test</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Point#</td>
<td>RodHt</td>
<td>Zenith</td>
<td>S. Dist</td>
<td>HI/Elev</td>
<td>AdjustElev</td>
</tr>
<tr>
<td>12</td>
<td>BT</td>
<td>2</td>
<td>4.500</td>
<td>69.31000</td>
<td>1500.560</td>
<td>991.005</td>
</tr>
<tr>
<td>13</td>
<td>BT</td>
<td>2</td>
<td>4.500</td>
<td>270.29000</td>
<td>1500.510</td>
<td>991.006</td>
</tr>
<tr>
<td>14</td>
<td>FT</td>
<td>11</td>
<td>4.500</td>
<td>69.31000</td>
<td>1200.540</td>
<td>997.463</td>
</tr>
<tr>
<td>15</td>
<td>FT</td>
<td>11</td>
<td>4.500</td>
<td>270.29000</td>
<td>1200.510</td>
<td>997.463</td>
</tr>
<tr>
<td>16</td>
<td>FT</td>
<td>11</td>
<td>4.500</td>
<td>69.31000</td>
<td>1200.560</td>
<td>997.463</td>
</tr>
<tr>
<td>17</td>
<td>FT</td>
<td>11</td>
<td>4.500</td>
<td>270.29000</td>
<td>1200.510</td>
<td>997.463</td>
</tr>
<tr>
<td>18</td>
<td>FT</td>
<td>12</td>
<td>4.500</td>
<td>69.31000</td>
<td>1300.540</td>
<td>998.331</td>
</tr>
</tbody>
</table>

Below is a sample Differential-Level TLV file:

<table>
<thead>
<tr>
<th>Point#</th>
<th>RodHt</th>
<th>Zenith</th>
<th>S. Dist</th>
<th>HI/Elev</th>
<th>AdjustElev</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>D3</td>
<td>M1, PRT Test Project, OPTest Operator, LPTest Loop</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D3</td>
<td>M2, D76/10/05, TM2:45PM, PRTemperature 112 NE, TP101 F</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Point#</td>
<td>Elev</td>
<td></td>
<td></td>
<td></td>
<td>Description</td>
</tr>
<tr>
<td>5</td>
<td>BM</td>
<td>2</td>
<td>1000.010</td>
<td>1000.010</td>
<td>pt2 desc</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Point#</td>
<td>RodHt</td>
<td>Zenith</td>
<td>S. Dist</td>
<td>HI/Elev</td>
<td>AdjustElev</td>
</tr>
<tr>
<td>7</td>
<td>BT</td>
<td>2</td>
<td>4.500</td>
<td>69.31000</td>
<td>1500.540</td>
<td>991.006</td>
</tr>
<tr>
<td>8</td>
<td>BT</td>
<td>2</td>
<td>4.500</td>
<td>270.29000</td>
<td>1500.530</td>
<td>991.006</td>
</tr>
<tr>
<td>9</td>
<td>Note</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>D3</td>
<td>test</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Point#</td>
<td>RodHt</td>
<td>Zenith</td>
<td>S. Dist</td>
<td>HI/Elev</td>
<td>AdjustElev</td>
</tr>
<tr>
<td>12</td>
<td>BT</td>
<td>2</td>
<td>4.500</td>
<td>69.31000</td>
<td>1500.560</td>
<td>991.005</td>
</tr>
<tr>
<td>13</td>
<td>BT</td>
<td>2</td>
<td>4.500</td>
<td>270.29000</td>
<td>1500.510</td>
<td>991.006</td>
</tr>
<tr>
<td>14</td>
<td>FT</td>
<td>11</td>
<td>4.500</td>
<td>69.31000</td>
<td>1200.540</td>
<td>997.463</td>
</tr>
<tr>
<td>15</td>
<td>FT</td>
<td>11</td>
<td>4.500</td>
<td>270.29000</td>
<td>1200.510</td>
<td>997.463</td>
</tr>
<tr>
<td>16</td>
<td>FT</td>
<td>11</td>
<td>4.500</td>
<td>69.31000</td>
<td>1200.560</td>
<td>997.463</td>
</tr>
<tr>
<td>17</td>
<td>FT</td>
<td>11</td>
<td>4.500</td>
<td>270.29000</td>
<td>1200.510</td>
<td>997.463</td>
</tr>
<tr>
<td>18</td>
<td>FT</td>
<td>12</td>
<td>4.500</td>
<td>69.31000</td>
<td>1300.540</td>
<td>998.331</td>
</tr>
</tbody>
</table>
Menu Options:

File Menu:

<table>
<thead>
<tr>
<th>File Menu Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Open</strong> - Open an existing .TLV file.</td>
</tr>
<tr>
<td><strong>New</strong> - Creates a new TLV level file.</td>
</tr>
<tr>
<td><strong>Save</strong> - Save changes</td>
</tr>
<tr>
<td><strong>Save As</strong> - Save as different file name</td>
</tr>
<tr>
<td><strong>Settings</strong> - Not used with TLV files.</td>
</tr>
<tr>
<td><strong>Import</strong> - You can import the following level file formats:</td>
</tr>
<tr>
<td>Leica GSI format</td>
</tr>
<tr>
<td>Leica XML format</td>
</tr>
<tr>
<td>Trimble DAT format</td>
</tr>
<tr>
<td><strong>Print</strong> - get hard copy printout of data.</td>
</tr>
<tr>
<td><strong>Exit</strong> - Exit Level Editor Program</td>
</tr>
</tbody>
</table>

**Edit Menu:**

<table>
<thead>
<tr>
<th>Edit Menu Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Cut</strong></td>
</tr>
<tr>
<td><strong>Copy</strong></td>
</tr>
<tr>
<td><strong>Paste</strong></td>
</tr>
<tr>
<td><strong>Go To</strong> - &quot;Go To&quot; will take you to the row of your choosing. Enter the row number.</td>
</tr>
</tbody>
</table>
Add Menu:

**Add:** These options allow you to add or insert a new record into the level editor.

**Benchmark Record (BM):** Point with known elevation.

**Backsight Record (BS):** Differential-level measurement to the backsight point.

**Foresight Record (FS):** Differential-level measurement to foresight point.

**Backsight Record (BT):** Trig-level measurement to the backsight point.

**Foresight Record (FT):** Trig-level measurement to foresight point.

**Note:** You can add a note, or comments, into the editor as you move through the level run.

Tools Menu:

**Adjust Elevations:** This function will do a simple adjustment of your level data and place the adjusted elevations in the Adjusted Elevation column. If you have distances, either HD or SD for all your measurements, the corrections will be inversely proportionate to the distance between the measurements. If you are running a single wire level loop (VD but no HD), the corrections will be averaged by the number of turns.

**Store Elevations to Coordinate File:** It is important that the point numbers in the level file match the point numbers in the coordinate file.

If you have an active coordinate file passed to the level editor, this option will be available to you. The elevations calculated in the level file will be stored in the active coordinate file by matching point numbers. The point must exist in the coordinate file before an elevation will be stored. After the elevations have been stored, a report will show which points were stored and which ones were not. If adjusted elevations have been calculated, they will be stored. If not, the unadjusted elevations will be stored.
Editor columns

Measurement records will have the following columns:

**Trig Level Record:**

**Type** - Two character abbreviation that shows the record type:
- BM - Benchmark
- BS - Differential-level backsight record
- BT - Trig-Level backsight record
- FS - Differential-level foresight record
- FT - Trig-Level foresight record
- DS - Note or Comment

**Point #** - Point number of measurement.

**RodHt** - Rod reading

**Zenith** - Zenith angle

**S.Dist** - Slope Distance

**HI/Elev** - Elevation of HI if a backsight record, or the foresight point if a foresight record

**Adjusted Elevation** - Adjusted elevation of foresight point

**Description** - description of point

**Differential Level Record:**

**Type** - Two character abbreviation that shows the record type, same as above.

**Point #** - Point number of measurement.

**V.Diff** - Rod Reading

**H.Dist** - Horizontal Distance

**HI/Elev** - Elevation of HI if a backsight record, or the foresight point if a foresight record

**Adjusted Elevation** - Adjusted elevation of foresight point
Description - description of point

Pull down Menu Location: CG-Survey > CGTrav > Edit Level File
Keyboard Command: LEV, cg_level_editor
Prerequisite: None

List Raw File
This feature allows you to list the data in the current raw data file at the command line and write it to the print file.

Prompts
You can press the F2 key to view the entire listing on the CAD text screen or choose Print/View Print File from the CGFile menu.

Reduce Traverse
The Reduce Traverse feature allows you to reduce a raw data file, with or without adjustment, and thus create a coordinate file or append to an existing coordinate file.

NOTE: Before you reduce a traverse, check the traverse settings on the Traverse Options tab of the C&G Options dialog.

Select the type of adjustment to use: (Compass, Least Squares, etc..)
Adjust Angles: (off/on)
Balance Elevations: (off/on)
If you are adjusting a 3-D traverse, make sure Elevations are turned on: ON
Once the traverse options are set properly you can proceed with traverse reduction.
Select Reduce Traverse from the CGTrav menu.
If a raw data file is already open, it will be used. If not, a dialog box will appear prompting you to open a raw data file.
If a coordinate is already open it will be used. If one is not opened you will be prompted to open one. You can select an existing file or type in the name of a new file to create.

**NOTE:** One coordinate file may be used with many raw data files. For example, you may store the coordinates reduced from an initial boundary traverse (raw data file) in a newly created coordinate file. If you do additional location or traverse work with the control created by the original traverse, this additional work may be placed in new raw data files and reduced to the same coordinate file.

If the raw data file does not have traverse codes (*see the CGEditor chapter*) a dialog will appear asking you which type to use. There are three types of traverses that can be processed. These are shown in the following figure:
The following figures show examples of the three traverse types. The H.I. and rod height entries are optional (if Elevations are on). These are examples of a single distance/angle entry. Each type traverse may be placed in a separate raw data file and reduced into a single coordinate file. However, with the use of special codes you can combine traverses in a single raw data file (See the CGEditor chapter).

**Traverse Reduction Types:**

**Closed Loop Traverse**

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>IP</td>
<td>5.00000</td>
<td>5.00000</td>
<td>5.00000</td>
<td>90.000000</td>
<td>0.000000</td>
<td>0.000000</td>
<td>0.000000</td>
<td>2</td>
<td>TP</td>
</tr>
<tr>
<td>FS</td>
<td>5.20000</td>
<td>5.00000</td>
<td>5.00000</td>
<td>90.000000</td>
<td>0.000000</td>
<td>0.000000</td>
<td>0.000000</td>
<td>2</td>
<td>TP</td>
</tr>
<tr>
<td>IP</td>
<td>5.00000</td>
<td>4.00000</td>
<td>4.90000</td>
<td>90.000000</td>
<td>0.000000</td>
<td>0.000000</td>
<td>0.000000</td>
<td>2</td>
<td>TP</td>
</tr>
<tr>
<td>FS</td>
<td>5.12000</td>
<td>5.00000</td>
<td>5.00000</td>
<td>90.000000</td>
<td>0.000000</td>
<td>0.000000</td>
<td>0.000000</td>
<td>2</td>
<td>TP</td>
</tr>
<tr>
<td>FS</td>
<td>5.15000</td>
<td>5.00000</td>
<td>5.00000</td>
<td>90.000000</td>
<td>0.000000</td>
<td>0.000000</td>
<td>0.000000</td>
<td>2</td>
<td>TP</td>
</tr>
</tbody>
</table>

Closed Loop Traverse Beginning and Ending at Known points
Shows above is closed traverse beginning on two known points (1 and 2) and ending on two known points (4 and 5). With this type of traverse, both a linear and angular closure can be calculated.

**Closed Loop Ending on One Known Point**
Shown above is a traverse that begins on two known points, or a single known point and a back sight azimuth, and ends on one known point.

This situation sometimes occurs when you begin on two known points (or a single known point and a back sight azimuth) and end on one known point. In this case only a linear closure is possible.

In order to reduce this type of traverse you must use the CGEditor to enter data not gathered in the field. Points 2 and 4 are the known beginning and ending points.

Points 100 and 101 do not exist.
We have entered a back sight reference bearing (N 25° 23' 25" E) from 2 to 100.
Line 8 is a dummy setup (we never setup on point 4 and back sighted point 8.
Line 9 shows a dummy angle to the dummy point 101.

Reduce the traverse as a closed Traverse Beginning and Ending on Known Points.

When the traverse is reduced you will have to enter one of the following:
The coordinates of point 101
The bearing from point 4 to 101. Or press <esc> for no angular closure.

If you choose no angular closure, the traverse will be reduced but will report only a linear closure. The adjustment will be made assuming no angular error.

**Open Traverse**

An Open Traverse is either an open ended traverse which ties into no known points or a file containing only side shots. In both cases no adjustment is possible.

Note: The data shown in the CGEditor views accompanying the four illustrations include instrument height (HI) and rod height entries. However, if you have elevations turned off, these entries are optional. Also, the examples use single distance and angle entries but multiple measurements are allowed.
In these figures each traverse has been placed in a separate raw data file. However, with the use of special codes you can combine multiple traverses in a single raw data file.

**Notes on Traverse Types and Reduction**

Closed and Azimuth Traverses: If you are running azimuth traverses, the angle to the side shot is calculated and stored instead of the azimuth. After the traverse has been reduced and adjusted, the angles are used to calculate the side shot coordinates. Thus the side shots are always relative to the instrument point and backsight point used in their location. The first azimuth in the raw data file will be considered a reference azimuth and will be held.

**Reducing Loop Traverses:**

If there is at least one reference bearing in the raw data file being reduced you will not be asked for a starting bearing. If the instrument point coordinates at the first reference bearing exists, you will not be asked to enter the starting coordinates or elevation. The traverse reduction will begin from the first reference bearing in the raw data file, not necessarily the first instrument point.

If you have more than one reference bearing in the raw data file, the angular closure and adjustments will be from one reference bearing to the next. In other words, all reference bearings will be held as correct, and any angle adjustment will be done from one to the next. This feature was designed for those surveyors who perform Solar or Polaris observations at intermediate traverse stations, and wish to hold the observed bearing at those stations (the bearings will of course change when the coordinates are adjusted, unless you use Crandall's Rule which does not change bearings).

**Reducing Open Traverse:**

Any Reference Bearings found in the raw data file for an Open traverse will be ignored (except the starting reference bearing/azimuth to the back sight point).

**Traverse Reduction: Closed Loop**

If the first instrument point in the raw data file does not exist, you will be asked to enter the coordinates for that point.

If the first back sight point in the raw data file does not exist and you do not have a reference bearing/azimuth to the back sight point in the raw data file, you will be given the choice of entering one of the following:

**Back sight point coordinates**
Bearing from the first instrument point to the first back sight point

If you are processing a Closed Traverse that Begins and Ends on known points, and the last (tie) instrument point in the raw data file does not exist, you will be asked to enter the coordinates for that point. If the last foresight point in the raw data file does not exist and you do not have a reference bearing/azimuth to the foresight point in the raw data file, you will be given the choice of entering one of the following:

**Foresight point coordinates**
Bearing from the last instrument point to the last foresight point (the last instrument and foresight point are the tie points necessary for linear and angular closure calculations).

**Note:** The bearing from the first instrument point to the first back sight point, and the bearing from the last (or tie) instrument point to the last (or tie) foresight point will be treated as reference bearings (held fixed). These four points will not be adjusted. If there are any reference bearings in the raw data file, the angular closure and adjustments will be from one reference bearing to the next, just as in Loop Traverses.

Since you may have many foresights from the instrument tie point (side shots), you will be asked to enter which foresight point you will be tying into (unless there are no side shots at the last instrument point).

The traverse will begin by the coordinates found in the coordinate file for the first instrument point and backsight point (coordinate values can be placed directly into the raw data file). The traverse will then be calculated. When the traverse is finished, the coordinates for the last instrument point and foresight point in the raw data file will be read from the coordinate file (or raw data file) in order to calculate the angular, vertical and horizontal closure.

If Elevations are ON you will be shown the elevation control found in the Raw Data and Coordinate files that pertains to your traverse. If no elevation control is found none will be shown and you will have to ADD control. Your elevation control can be anywhere in the traverse. It does not have to be on the first point.

**You will have the following option at the command line:**
Point Elevation
1 500.00
[Add/Change/Delete/Go/aBort]: <G>g

**Select Add to add points to elevation control:** A
**Select Change to change the elevation assigned to a point in the elevation control:** C
**Select Delete to remove a point from the elevation control:** D
Select Go to calculate elevations: G  
Select aBort to quit without calculating elevations B

Select the appropriate option and the elevations will be calculated based upon the supplied information.

At this point you will get two closure reports:

**The first report is before angle adjustment:**

********** Closure Report **********

Total angular error: -0°00'06"
Angular error per point: -0°00'01"
Correct Ending Coordinates, North: 5000.00000 East: 5000.00000
Ending Coordinates, North: 5000.04008 East: 5000.00421
Error, N: 0.04 E: 0.00 Total: 0.04 Brq: S 05°59'43"W
Distance Traversed: 2470.51 Closure: 61308

**The Second Report is after angle adjustment:**

********** Closure Report **********

Total angular error: 0°00'00"
Angular error per point: 0°00'00"
Correct Ending Coordinates, North: 5000.00000 East: 5000.00000
Ending Coordinates, North: 5000.04314 East: 5000.01593
Error, N: 0.04 E: 0.02 Total: 0.05 Brq: S 20°16'08"W
Distance Traversed: 2470.51 Closure: 53721

**Following the angular adjustment the reduced traverse will be displayed:**

Adjusted by Least Squares  

<table>
<thead>
<tr>
<th>Bearing Distance Northing Easting Elevation Pt ID Code Description</th>
<th>5000.00000 5000.00000 500.00 1 1 TP1 2</th>
<th>5000.00000 5000.00000 500.00 1 1 TP1 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>N 00°00'00&quot;E 242.12 5242.12397 5000.00000 496.39 2 1 tpns</td>
<td>N 00°00'00&quot;E 242.12 5242.12397 5000.00000 496.39 2 1 tpns</td>
<td></td>
</tr>
<tr>
<td>N 74°41'24&quot;E 199.78 5294.87495 5192.69243 467.97 3 1 tpns</td>
<td>N 74°41'24&quot;E 199.78 5294.87495 5192.69243 467.97 3 1 tpns</td>
<td></td>
</tr>
<tr>
<td>N 00°22'42&quot;W 148.48 5443.34679 5191.71202 460.90 4 1 tpons</td>
<td>N 00°22'42&quot;W 148.48 5443.34679 5191.71202 460.90 4 1 tpons</td>
<td></td>
</tr>
<tr>
<td>N 04°35'35&quot;W 310.32 5752.67444 5166.86125 458.07 5 1 tpons</td>
<td>N 04°35'35&quot;W 310.32 5752.67444 5166.86125 458.07 5 1 tpons</td>
<td></td>
</tr>
<tr>
<td>S 83°11'32&quot;W 300.98 5716.99780 4868.00744 473.72 6 1 tpons</td>
<td>S 83°11'32&quot;W 300.98 5716.99780 4868.00744 473.72 6 1 tpons</td>
<td></td>
</tr>
<tr>
<td>S 84°09'21&quot;W 290.03 5687.46658 4579.48877 472.10 7 1 tp hole</td>
<td>S 84°09'21&quot;W 290.03 5687.46658 4579.48877 472.10 7 1 tp hole</td>
<td></td>
</tr>
<tr>
<td>S 13°25'02&quot;E 137.70 5553.52582 4611.44085 484.33 8 1 tpons</td>
<td>S 13°25'02&quot;E 137.70 5553.52582 4611.44085 484.33 8 1 tpons</td>
<td></td>
</tr>
<tr>
<td>S 05°29'41&quot;E 234.70 5319.90709 4633.91387 501.54 9 1 tpons</td>
<td>S 05°29'41&quot;E 234.70 5319.90709 4633.91387 501.54 9 1 tpons</td>
<td></td>
</tr>
<tr>
<td>S 12°52'27&quot;E 308.42 5019.23837 4702.63376 517.34 10 1 tpons</td>
<td>S 12°52'27&quot;E 308.42 5019.23837 4702.63376 517.34 10 1 tpons</td>
<td></td>
</tr>
<tr>
<td>S 86°17'54&quot;E 297.99 5000.00000 5000.00000 500.00 1 1 TP1 NAIL</td>
<td>S 86°17'54&quot;E 297.99 5000.00000 5000.00000 500.00 1 1 TP1 NAIL</td>
<td></td>
</tr>
</tbody>
</table>

Sq. Feet: 341547 Acres: 7.8

**Once the traverse is reduced the side shots will be computed and displayed:**
**Side Shots**  
**Angle Distance Northing Easting Elevation Pt ID Code Description**  

| Inst.Pt.: 1 | Bs.Pt.: 10 | 148°15'53'' | 123.43 | 5058.01266 | 5108.95161 | 489.96 | 47 | 3 | ipf1otp |
| Inst.Pt.: 2 | Bs.Pt.: 1 | 97°53'24'' | 46.81 | 5045.85154 | 5009.40500 | 499.25 | 48 | 2 | ip4rb |
| Inst.Pt.: 3 | Bs.Pt.: 2 | 17°33'40'' | 96.60 | 5035.03240 | 4909.97367 | 506.27 | 49 | 2 | ipf4rb |

**Inst.Pt.: 2 Bs.Pt.: 1**  
255°33'17'' | 93.22 | 5265.37939 | 5090.27763 | 480.73 | 25 | 4 | ipf1\(2''\) ctp  
146°29'54'' | 17.38 | 5256.61928 | 4990.40516 | 500.49 | 26 | 4 | ipf1\(2''\) ctp |

**Inst.Pt.: 3 Bs.Pt.: 2**  
97°01'47'' | 18.33 | 5276.92239 | 5188.96820 | 468.73 | 27 | 4 | ipf1#ctp |

**Inst.Pt.: 4 Bs.Pt.: 3**  
10°21'19'' | 65.64 | 5378.69600 | 5180.33917 | 466.55 | 28 | 4 | ipf1ctp |

**Inst.Pt.: 5 Bs.Pt.: 4**  
39°33'59'' | 47.28 | 5713.93615 | 5139.76338 | 458.30 | 34 | 4 | ipf1ctp |

**Inst.Pt.: 8 Bs.Pt.: 7**  
32°47'04'' | 103.73 | 5651.38227 | 4645.83837 | 475.70 | 37 | 9 | nf |

**Inst.Pt.: 10 Bs.Pt.: 9**  
156°21'56'' | 66.78 | 4965.56171 | 4742.36495 | 517.21 | 46 | 9 | stk |

---

**Elevations Calculations - Elevations Adjusted**

Elevations from Points: 1 -> 1  
Vertical Err: -0.01, Distance Traversed: 2470.51

The calculate points will be stored in the coordinate file. There is an overwrite protection built into the software. If a point already exists in the coordinate file you will have the following options:
CANCEL: will terminate the process of storing coordinates.
OVERWRITE: will overwrite the existing point.
DO NOT OVERWRITE: skip to the next point. If you have the "Do Not Ask Again" box checked, OVERWRITE will overwrite all points without asking.
DO NOT OVERWRITE: will only write NEW points to the coordinate file.

**Traverse Reduction: Open Traverse/Side Shots**

When reducing these types of traverses, no adjustments are possible. The coordinates for instrument points and back sight points will be pulled from the coordinate file (or raw data file) and used to calculate and store the foresights. This option allows you to occupy newly created points.

Coordinates of back sight points will be calculated only if a distance has been entered to the back sight point and the back sight point does not exist in the coordinate file.

If you are back sighting a point that does not exist in the coordinate file and the raw data file does not contain a reference bearing or azimuth to the back sight point, you will be given the choice of entering one of the following:

**Coordinates of the back sight point**

**Bearing from the instrument point to the back sight point**

If you choose to enter the bearing and there is no distance to the back sight point in the raw data file (thus making it impossible to calculate its coordinates), and you later occupy that point, you will be asked to enter the real coordinates of the point.
If you are backsighting a point that does exist, and you have a distance measurement to the backsight point in the raw data file, we will show a warning if the inversed distance from the coordinate file does not match the measured distance within the tolerances set in the CGTools->Global Options->Traverse Options dialog.

A table will be printed containing the following:

<table>
<thead>
<tr>
<th>Side Shots</th>
<th>Angle Distance</th>
<th>Northing</th>
<th>Easting</th>
<th>Elevation</th>
<th>Pt ID Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inst.Pt.: 1</td>
<td>Bs.Pt.: 10</td>
<td>148°15'53''</td>
<td>123.43</td>
<td>5058.01266</td>
<td>5108.95161</td>
<td>489.96 3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>97°53'24''</td>
<td>46.81</td>
<td>5045.85154</td>
<td>5009.40500</td>
<td>499.25 2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>17°33'40''</td>
<td>96.60</td>
<td>5035.03240</td>
<td>4909.97367</td>
<td>506.27 2</td>
</tr>
</tbody>
</table>

**Angle Adjustments**

If you have set Adjust Angles in the Traverse Options dialog box, all angles will receive equal adjustment. If there is more than one reference bearing, the angles will be adjusted equally between reference bearings. You will be shown the closures before and after the angle adjustment.

**NOTE:** If you are going to use the Least Squares Adjustment, you should not adjust the angles. Angular adjustment is part of the Least Squares Adjustment process.

**Elevation Adjustment**

If you have set Adjust Elevations in the Traverse Options dialog box, the elevations will be adjusted in proportion to the lengths of the lines (the longer the line, the more the adjustment).

**Least Squares, Crandall's and Compass Rule**

If you select any of these adjustment options the coordinates will be adjusted with the appropriate method.

**Find Bad Angle**

If you have a bad angular closure, select Find Bad Angle in the Traverse Options dialog box instead of an adjustment type. This function will not create or store any coordinate points.

**NOTE:** This option cannot be used with Azimuth Traverses.

**You will see the following report:**

Total angular error: 0°00'07"
Angular error per point: 0°00'01"
Correct Ending Coordinates, North: 10000.00000 East: 10000.00000
Ending Coordinates, North: 10000.05876 East: 9999.95840
Error, N: 0.05876 E: -0.04160 Total: 0.07200 Brg: S 35°17'49"E
Distance Traversed: 1492.10800 Closure: 20725

Instrument point: 1, Error: 0.07200, Closure: 20725
Instrument point: 2, Error: 0.08249, Closure: 18089
In the above example, there were 5 traverse points. The traverse is reduced five times, beginning at each traverse point. The starting instrument point that produces the best closure is shown as having the bad angle. All closures are shown.

OTHER METHODS OF TRAVERSING

Every surveyor has his own unique methods when it comes to traversing. This section describes and shows examples of four additional entry methods.

Notice in the sample traverses there is a distance and vertical angle recorded for each foresight and backsight. This is optional, but you need at least one distance to each foresight.

Where both foresight and backsight distances are recorded, distances will be averaged when reduced.

Side shots may be entered along with traverse information. You may turn more than one angle to side shots if you wish.

A description and/or code only needs to be entered once for a given foresight point.

Single Position with Direct and Reverse Angles

Perform this method as follows:
Shoot the backsight.
Turn to a foresight.
Record the angle and distance.
Plunge the instrument.
Take another reading (reversed) to the foresight. You may do this to traverse points and side shots.
Turn back to the backsight with the instrument reversed.
Record another angle to the backsight.

The final angle in each set for each instrument point must be a reverse reading to the backsight.
The angle in the instrument for the first backsight will be subtracted from the first angle to each foresight. The final (reverse) angle to the backsight will be subtracted from the second angle to each foresight. The two resulting angles will then be averaged to give you an angle to the foresight. All distances recorded will be averaged.
Single Positions with Multiple Direct and Reverse Angles

Entering multiple sets of direct and reverse angles is very much like the preceding example where 1 direct and reverse set was entered. The only thing to remember is that each direct and reverse pair is a set. When another set is entered, it begins with a back sight direct angle (recorded like a foresight), has direct angles and reverse angles to the foresights, and ends with a reverse angle to the back sight. Do not begin a new instrument point for the second set, merely record a new back sight angle and continue with the procedure through each foresight, and end with another reverse angle to your back sight.
Azimuth Traverses

Azimuths are entered into a file with the azimuth to each foresight entered in the Foresight data entry line at the azimuth column.

**NOTE:** If you are running a Closed Loop Traverse, a reference azimuth must be placed at the last instrument point if you wish to adjust the angular error.

The reference azimuth is the correct azimuth from the last instrument point in the raw data file to the first instrument point (or last foresight).

<table>
<thead>
<tr>
<th>Inst.Point</th>
<th>Inst.Height</th>
<th>Backsight</th>
<th>Rod Height</th>
<th>Azimuth</th>
<th>Slope Dist.</th>
<th>Vert.Angle</th>
<th>Foresight</th>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP 1 1</td>
<td>5.20000</td>
<td>5</td>
<td>5.00000</td>
<td>0.00000</td>
<td>279.58000</td>
<td>0.35000</td>
<td>2</td>
<td>MFT</td>
<td></td>
</tr>
<tr>
<td>FS 1</td>
<td>5.00000</td>
<td>108.99100</td>
<td>292.31600</td>
<td>0.35000</td>
<td>2</td>
<td>MFT</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IP 2</td>
<td>5.00000</td>
<td>186.06000</td>
<td>292.31600</td>
<td>0.35000</td>
<td>5</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FS 3</td>
<td>5.00000</td>
<td>186.06000</td>
<td>292.31600</td>
<td>0.35000</td>
<td>5</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FS 5</td>
<td>5.00000</td>
<td>159.81700</td>
<td>292.31600</td>
<td>0.35000</td>
<td>2</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FS 6</td>
<td>5.00000</td>
<td>291.93000</td>
<td>292.31600</td>
<td>0.35000</td>
<td>2</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FS 7</td>
<td>5.00000</td>
<td>188.04100</td>
<td>294.75600</td>
<td>0.37000</td>
<td>5</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IP 2</td>
<td>5.00000</td>
<td>186.06000</td>
<td>292.31600</td>
<td>0.35000</td>
<td>5</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FS 3</td>
<td>5.00000</td>
<td>186.06000</td>
<td>292.31600</td>
<td>0.35000</td>
<td>5</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FS 5</td>
<td>5.00000</td>
<td>159.81700</td>
<td>292.31600</td>
<td>0.35000</td>
<td>2</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FS 6</td>
<td>5.00000</td>
<td>291.93000</td>
<td>292.31600</td>
<td>0.35000</td>
<td>2</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FS 7</td>
<td>5.00000</td>
<td>188.04100</td>
<td>294.75600</td>
<td>0.37000</td>
<td>5</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Traverse with Doubled Angles
Each new instrument setup requires a 0 to the back sight.
The first angle to the foresight is the single angle. This angle is locked into the gun and the back sight is retaken.
The second angle to the foresight is the doubled angle. You can double angles to side shots.

Loop Traverse Beginning and Ending on External Reference Azimuths

This type of traverse occurs frequently. The example below shows a Loop Traverse that begins on an external reference azimuth and ends on an external reference azimuth. Even though this traverse closes on itself, it must be reduced as a Closed Traverse Beginning and Ending at Known Points.

Point 100 is a dummy point on the azimuth line. Line 3 shows a reference bearing from point 1 to 100 (negative means from ip to bs) of S00-00-00E.
Line 16 shows the same reference bearing.
Point number 100 need not exist in the coordinate file and will not be calculated, but a dummy backsight and foresight point number must be entered into the raw data file.

Use Of Reference Bearings and Azimuths

Reference Bearings and Azimuths are entered by Adding or Inserting a Reference Bearing data entry line. For example:
DR 1-2 123.4523
The direction from point 1 to point 2 is N23-45-23E.
Reference bearings and azimuths are optional (except for Closed Loop Azimuth Traverses). If a reference bearing is used, that direction will be held during the reduction process. More than one reference bearing may be used. The
The data below shows a raw data file using multiple reference bearings:

The previous data represents a loop traverse. If you choose to adjust angles, all angles will be adjusted from one reference bearing to the next (angles 1-5, 6-1). Angular closure information will also be shown from one reference bearing to the next. See the Reduction section of this chapter for more specific information on the use of reference bearings with different types of traverses.

Except for an initial reference bearing to the back sight point, reference bearings will be ignored for Open Traverses (no adjustments are available).

### Multiple Traverse Codes in a Single File

This sample is of a raw data file that contains multiple traverse codes in a single file: ET end main loop traverse Scale factors are placed after Instrument Point data entry lines. Any text following a LT, CT, OT or ET marker is used for comments. Notice that the codes MUST precede the first instrument setup that begins the traverse.

The Foresight Tie Point in the previous example is necessary because there is a side shot (point #25) at the end of the Closed Traverse. The reduction routine does not know whether you are tying into point 25 or point 2.

---

**Pull Down Menu Location:** CGTrav\Reduce Traverse

**Keyboard Command:** RT, CG_REDUCE_RAW

---

*Chapter 18. CGSurvey Module*
Prerequisite: Open Raw file *.CGR

Edit Map Check File
The map check program is used to enter or edit deed and map information for checking closures and to assist with evaluating data from other sources for a job you are working on.

Note: for further and complete information on using the Mapcheck editor, see the chapter on CGEditor in the Tools section.

Pull-down Menu Location: CGTrav/Edit Mapcheck File
Keyboard Command: EM, CG_EDIT_MAP
Prerequisite: None

Reduce Map Check File
If a map check file is not open, a file dialogue box will appear, allowing you to open an existing map check file. If you wish the coordinates to be adjusted, select the type of adjustment in the Traverse Options dialog box. If a
coordinate file is not open, a file dialog box will appear allowing you to open one. NOTE You may use the same coordinate file as often as you wish. Make sure the correct coordinate file is open.

**Next Enter Point values:** the starting Point number, Northing and Easting and the ending Northing and Easting:

![CGSurvey for AutoCAD - Reduce Map Check File](image1)

The map data will then be reduced and the coordinates stored in the coordinate file. Overwrite protection is in place in case the points already exist in the coordinate file. If a point already exists in the coordinate file you will have the following options:

![Point Overwrite](image2)
CANCEL: will terminate the process of storing coordinates.
OVERWRITE will overwrite the existing point.
DO NO OVERWRITE: skip to the next point. If you have the "Do Not Ask Again" box checked.
Overwrite will overwrite all points without asking, and Do Not Overwrite will only write NEW points to the coordinate file.

The initial closure information will be shown. For example:

Correct Ending Coordinates, North: 5000.0000 East: 5000.0000
Ending Coordinates, North: 5071.8346 East: 4894.7441
Error, N: 71.83 E: -105.26 Total: 127.43 Brg: S 55°\slash 41'15''E
Distance Traversed: 1308.19 Closure: 10

A full report including acreage may be viewed by pressing the F2 key to view the CAD Text Window. You may also view/print the display file.

---

**Visual Map Check**

This routine allows you to graphically pick the Call Text (Bearings and Distance) from a drawing and perform a...
Map Check Closure.

Prompts

First you will be asked: **Pick Point of Beginning:** You can enter the beginning point number, or graphically pick the point on the screen.

Next: **Pick Bearing Text for Leg 1 (ask Reverse is ON) [Off/Done]**: Graphically pick the text with the Bearing. If "ask Reverse" is turned ON, you will be allowed to reverse the direction of the bearing after it is selected:

![Image of CGSurvey dialog box: Do you wish to use the bearing N 45°00'00" E? (answer 'No' to use the reversed bearing S 45°00'00" W)](image)

Next: **Pick Distance Text for Leg 1:** Graphically pick the text with the distance. You will see:

![Image of CGSurvey dialog box: Are the following values correct? bearing: S 45°00'00" W Distance: 292.212)](image)

If you select YES, you will go to the next leg. If you select NO: you will be asked to pick the Bearing and distance for Leg 1 again.

After selecting all the Calls: press ENTER for DONE. You will have the option:
If you select YES, the information: you selected will be placed in a Map Check File. You will be asked to select the CGM file.

Next: Enter the starting and ending coordinates for the traverse.

The map data will then be reduced and the coordinates stored in the coordinate file. Overwrite protection is in place in case the points already exist in the coordinate file. If a point already exists in the coordinate file you will have the following options:
CANCEL: will terminate the process of storing coordinates.
OVERWRITE: will overwrite the existing point.
DO NO OVERWRITE: skip to the next point. If you have the "Do Not Ask Again" box checked, OVERWRITE will overwrite all points without asking, DO NOT OVERWRITE: will only write NEW points to the coordinate file.

Below is a sample Report:
Correct Ending Coordinates, North: 10000.00000 East: 10000.00000
Ending Coordinates, North: 9586.74896 East: 9586.74832
Error, N: -413.25104 E: -413.25168 Total: 584.42568 Brg: N 45°00'00''E
Distance Traversed: 1492.10700 Closure: 3

Adjusted by Least Squares
Bearing Distance Northing Easting Elevation Point ID

10000.00000 10000.00000 900.00000 1
S 58°19'27''W 146.64772 9922.99352 9875.19793 2
N 05°19'46''W 299.65818 10221.35627 9847.36450 3
N 73°17'06''W 156.24457 10266.29428 9697.72179 4
S 04°35'43''E 226.90862 10040.11507 9715.90113 5
S 64°19'20''E 371.14929 9879.29253 10050.39763 900.00000 1

Sq. Feet: 814183.13568 Acres: 18.69107

Pulldown menu Location: CGTrav
Keyboard Command: VM, cg_visual_mapcheck
Prerequisite: Call Text must be displayed to select
Create StarNet File

This option converts a raw data file to the Star*Net (.DAT) format. The raw data file will be preprocessed. During conversion, multiple distances and angles will be averaged and compared to the maximum ranges set in the Traverse Options dialog box. To use this option properly, you must know how Star*Net works. You should be familiar with all Star*Net codes and commands.

NOTE: This manual is not a substitute for the Star*Net manual.

Below is a sample raw data file that contains three different traverse types. This raw data file can be reduced using CG-SURVEY or written to a Star*Net file for reduction with Star*Net, both without any editing.

<table>
<thead>
<tr>
<th>1</th>
<th>1000</th>
<th>1000</th>
<th>923.56</th>
<th>CONCRETE MONUMENT</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>1205.25</td>
<td>1208.13</td>
<td>931</td>
<td>approx coordinates</td>
</tr>
<tr>
<td>3</td>
<td>1127.73</td>
<td>739.05</td>
<td>930</td>
<td>approx coordinates</td>
</tr>
</tbody>
</table>

LT beginning of main loop traverse

| 5.00 | 109.19170 | 292.310 | 88.35000 | 2 | H&T |
| 5.00 | 280.19300 | 292.310 | 271.25100 | 2 |
| 5.00 | 180.00200 | 290.540 | 271.25100 | 5 |

2 5.20 1

| 5.00 | 0.00000 | 292.310 | 91.31300 | 5 |
| 5.00 | 190.32100 | 52.390 | 90.32550 | 6 |
| 5.00 | 10.32120 | 52.390 | 269.27080 | 6 |
| 5.00 | 96.03560 | 324.260 | 88.51320 | 3 |
| 5.00 | 276.03580 | 324.260 | 271.08300 | 3 |
| 5.00 | 180.00100 | 292.310 | 268.28320 |

3 4.98 2

| 5.00 | 0.00000 | 324.260 | 91.10000 |
| 5.00 | 124.03560 | 275.840 | 92.22400 | 4 |
| 5.00 | 304.03400 | 275.840 | 267.37100 | 4 |
| 5.00 | 179.59500 | 324.260 | 288.50020 | 2 |

OT beginning of open traverse

| 3 | 5.03 | 2 | 0.00000 |
| 5.00 | 185.23560 | 135.260 | 95.23150 | 20 |

20 5.12 3

<p>| 0.00000 | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>5.11</td>
<td>20</td>
<td>0.0000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5.00</td>
<td>182.26450</td>
<td>50.130</td>
<td>91.23450</td>
<td>22</td>
<td></td>
</tr>
<tr>
<td>IPF</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ET end of open traverse</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>5.12</td>
<td>3</td>
<td>0.0000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5.00</td>
<td>93.02130</td>
<td>309.680</td>
<td>89.13000</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>IPF</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5.00</td>
<td>273.02200</td>
<td>309.680</td>
<td>270.47100</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>5.00</td>
<td>180.00100</td>
<td>275.840</td>
<td>272.22000</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>CT Beginning of closed traverse which lies into main loop</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FT 2 last tie angle is to point number 2 in main loop</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>5.00</td>
<td>4</td>
<td>0.0000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5.00</td>
<td>39.26450</td>
<td>130.010</td>
<td>89.00010</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>5.01</td>
<td>192.25400</td>
<td>130.000</td>
<td>271.00000</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>Nail</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5.00</td>
<td>180.00050</td>
<td>0.0000</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5.00</td>
<td>241.56350</td>
<td>126.010</td>
<td>89.30000</td>
<td>11</td>
<td></td>
</tr>
<tr>
<td>5.02</td>
<td>61.35300</td>
<td>126.020</td>
<td>270.30100</td>
<td>11</td>
<td></td>
</tr>
<tr>
<td>Nail</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5.00</td>
<td>56.25100</td>
<td>10.000</td>
<td>90.00000</td>
<td>15</td>
<td></td>
</tr>
<tr>
<td>IPF</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5.00</td>
<td>180.00070</td>
<td>0.0000</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5.00</td>
<td>114.58340</td>
<td>129.423</td>
<td>89.30000</td>
<td>12</td>
<td></td>
</tr>
<tr>
<td>4.99</td>
<td>294.56300</td>
<td>129.430</td>
<td>270.10030</td>
<td>12</td>
<td></td>
</tr>
<tr>
<td>5.00</td>
<td>180.00010</td>
<td>0.0000</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>5.00</td>
<td>11</td>
<td>0.0000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5.00</td>
<td>140.39310</td>
<td>144.700</td>
<td>88.40000</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>5.02</td>
<td>320.39200</td>
<td>144.680</td>
<td>271.20030</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>5.00</td>
<td>180.00020</td>
<td>0.0000</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>5.00</td>
<td>12</td>
<td>0.0000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5.00</td>
<td>325.34320</td>
<td>0.0000</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5.01</td>
<td>145.54300</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5.01</td>
<td>180.00020</td>
<td>12</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

ET end closed traverse
| 5    | 5.15 | 4   | 0.0000 |
| 5.00 | 309.680 | 90.50000 |
| 5.00 | 117.30500 | 290.550 | 91.30300 | 1 |
| IPF  |
| 5.00 | 297.30400 | 290.550 | 268.29300 | 1 |
| 5.00 | 180.00050 | 309.670 | 265.10050 | 4 |

ET end main loop traverse
The coordinate formats (C code) are the same for Star*Net and CG-SURVEY; no translation is necessary.

If a comment line in the raw data file uses a valid Star*Net code or command, it will be used in its original form (as with coordinates); not as a comment. These codes are #, C, A, D, V, B, M, TB, T, TE, SS (followed by a space) and all dot commands. (example: .CURVE, .SCALE, etc...)

Multiplication factors are converted to the .Scale command. The original multiplication factor set in the Global Options dialog box will be placed at the beginning of the Star*Net file. Other multiplication factors will be placed as they occur in the raw data file.

NOTE: You cannot use a multiplication factor for meter/feet conversion in a 3-D traverse in Star*Net 3.2.

Reference bearings/azimuths are converted to the B format.

All traverse points are converted to the M format and side shots to the SS format. Only points used once (as a foresight point) will be considered a side shot. If a point is located from more than one instrument setup, or is used as an instrument point or backsight point, the point will be converted to a M format.
The LT, ET, OT, FT and CT codes are converted to comments. Point codes are combined with descriptions.

**If Elevations are on, the Star*Net file must be adjusted as a 3-D traverse.** The following could occur:

If you input slope distances and vertical angles, all distances will first be reduced to their horizontal/vertical components. Multiple distances will be averaged and then a slope distance and vertical angle will be recomputed from the averaged horizontal/vertical components. This is done so Star*Net can compute corrections for curvature and refraction and vertical divergence (can only be done if vertical angles are used in a 3-D traverse.) A "Delta Off" command will be placed in the Star*Net file.

If you input horizontal and vertical distances, a "Delta On" command will be placed in the Star*Net file. No corrections for curvature and refraction or vertical divergence will be possible.

If Elevations are off in the Options/Global Options dialog box, the Star*Net file must be reduced as a 2-D traverse. The following will occur:

If you input slope distances and vertical angles, all distances will be reduced to their horizontal/vertical components and the vertical components will be thrown away. Multiple distances will be averaged.

No corrections for curvature and refraction or vertical divergence are allowed in a 2-D traverse with Star*Net version 3.2 or earlier.

**Pulldown Menu Location:** CGTrav  
**Keyboard Command:** STN, CG_REDUCE_STARNET  
**Prerequisite:** Open CG Raw file *.CGR

---

**CGCogo**

**General Information**

Menu
General Information:

The Command Line:
Throughout CGSurvey the user will be prompted at the command line for input. Typically the command line is at the bottom of the CAD graphic screen, although the command line can be placed above the graphics screen. To enter a command at the command line use the keyboard, and press the <Enter> key when finished. The F2 hot key can be used at any time to access a full text window that displays user input and history. As point numbers are typed in, or selected on the screen using the mouse, the point number entered is displayed at the command line. When the next point ID is requested the previous point ID is used as the starting point for the command. For example, when inversing from 5 to 7. First you type 5 at the command line and press <Enter>. Command:
[Point group/Reset/sNap on] (last point = <none>): 5
[cLockwise curve/ccW curve/Point group/Reset/sNap on] (last point = 5):

Note that 5 is now displayed as the "Last Point". This means that when 7 is entered at the command line the inverse will be calculated from point 5 to point 7. To clear the last point enter R or "," and <Enter> for Reset. The last point will now be shown as <none>.

Pulldown Menu Location:

Keyboard Command:
Prerequisite:
File Name: CGSurvey.arx
**Inverse**

This command allows you to determine the bearing and distance between the endpoints of a line or a curve by entering the points that define the line or curve.

After choosing the Inverse menu item you are asked to "Enter point sequence". A point sequence is a series of points that define the points being used to calculate the inverse. You may enter one point ID at a time to inverse from point to point. You may enter the two points seperated by a dash (5-7), etc.

Enter point sequence

[Point group/Reset/sNap on] (last point = <none>): 5
[clockWise curve/Ccw curve/Point group/Reset/sNap on] (last point = 5): 7

Note that 5 is now displayed as the "Last Point". This means that when 7 is entered at the command line the inverse will be calculated from point 5 to point 7.

To "Reset" the last point enter R or "." and <Enter> for Reset. The last point will now be shown as <none>.

**Inversing Around Curves Clockwise**

To inverse around a clockwise curve (one curving to the right), enter the PC point ID then enter "L" or "+" to indicate a clockwise curve. Next enter the point ID of the radius point of the clockwise curve and follow with the PT point ID.

For Example:

First enter the PC of the curve. In this example type or pick point ID 2201

Enter point sequence

[Point group/Reset/sNap on] (last point = <none>): 2201

Now type L or "+" and <Enter> for a clockwise curve

Enter point sequence

[clockWise curve/Ccw curve/Point group/Reset] (last point = 2201): L

Next type or pick the radius point ID 2200

Enter radius point for curve [Reset/sNap on]: 2200

You may also use the mouse to pick a C&G Arc. In this case, the arc's radius point will be used

Next type or pick the PT point ID 2202

Enter point of tangency (PT) for curve [Reset/sNap]: 2202

**Inversing Around Curves Counter Clockwise**

To inverse around a curve in a counter-clockwise direction (curving to the left) simply type W or "-" and <Enter> then proceed as with a clockwise curve.

**Inversing between a series of points in the coordinate file**

By entering 2 point numbers separated by a "+" you can inverse through successive point IDs in the order they are found in the coordinate file (either numeric or alphabetic order). For example, if you enter 3+6, inverses will be calculated and displayed from point 3 to 4, 4 to 5 and 5 to 6. You can use the <F2> key to view the information printed at the command line or you can view the print file (CGFile > Print/View Print File).
Inversing using Point Groups:
You can use a Point Group to inverse between a series of points specified by the point group. To specify a point group type a P or '*' and <Enter> at the command line. This will display a dialog box showing the Point Groups currently in the default directory.

Prompts

Enter point sequence
[Point group/Reset/sNap on] (last point = <none>): Enter or pick the first point on a line or the PC of a curve. Type "P" and Enter to use a point group to specify the inversing sequence. Type "R" and Enter to Reset the last point. Type "N" and Enter to turn on CAD snaps (these are turned off when the command starts).
[clLockwise curve/ccW curve/Point group/Reset/sNap on] (last point = 5): Enter or pick the next point ID to inverse to or type "L" and Enter or "W" and Enter to specify the radius point of a curve.
if you are entering a curve:
Enter radius point for curve [Reset/turn Snap on]: Enter or pick the radius point for the curve.
Enter point of tangency (PT) for curve [Reset/turn Snap on]: Enter or pick the PT point for the curve.

Pulldown Menu Location: CG-Survey > Cogo
Keyboard Command: cg_inverse
Prerequisite: coordinate file

Intersects
This feature allows you to calculate intersections based on one of the following methods:

Bearing-bearing
The bearing-bearing intersect is calculated based on a line passing through a point on a given bearing intersecting another line passing through a second point on another specified bearing.

Bearing-distance
This is based on a line passing through a point at a given bearing intersecting a circle at a given distance (radius) from a second point. This intersection by result in 2 points of intersection.

Distance-distance
This is based on intersecting a circle at a given distance (radius) from a point with another circle at another given distance (radius) from a second point. This may also result in 2 points of intersection.

Perpendicular
This is based on calculating the perpendicular distance from a given point to a line that passes through another point at a specified bearing.
**Tangent**
This is based on calculating the tangent points of a line drawn from a given point to a circle having a specified radius and radius point.

**Command line input**
After selecting the Intersects option on the CGCogo pull down menu and the Use Intersects Dialog menu item is not checked you will see the following prompt.

Intersection method: Brng-Brng/Brng-Dist/Dist-Dist/Perp/Tangent or offsets-on
[BB/BD/DD/Perp/Tangent/turn-Offsets-on]:

**Bearing-Bearing Intersections:**

Type "bb", then press <Enter>
At the Enter first Point: prompt type in or pick the point using the mouse
As an illustration, using the example shown in the figure: type or pick point 2203.
At the Enter first bearing: prompt there are 3 options available:
Type the bearing directly using the special C&G notation qddmmss (quadrant, degrees, minutes and seconds)
105.2316 (N 05° 23' 16''E)

Enter the two known C&G points that define the bearing either by typing the two points in with a dash between them or picking the two points one at a time using the mouse.
Or select a C&G line. When you select a line the bearing is computed by inverting between the two points that created the line. The bearing quadrant is based on traversing from the end point of the line farthest from the location where the line was picked to the end point of the line nearest to the point picked.
Enter second point: for the example type or pick point 2204
Enter second bearing: use any of the methods outlined for entering first bearing.
The intersection will then be calculated, the intersection point saved to the coordinate file and the results displayed
at the command line.

When saving the intersection point, depending on your settings on the Global Settings tab of the C&G Options
dialog, you may be asked to either enter or change the point ID, elevation, point code and description.

At each of the STORING POINT prompts there is an option to change settings [Settings]. Pressing S will
bring up the Global Options tab of the C&G Options dialog box, allowing you to change settings prior to saving the
point. (see the CGTools Chapter for a description of the CGOptions dialog box)

**Bearing-Distance Intersection**

Type bd to calculate the intersection of a circle with a line. Generally, the data is entered in the same fashion as for
a bearing-bearing intersection.
Once the data is entered each of the two solutions will be displayed one at a time.
You will be asked if the solution shown is the correct solution.

Is this the correct solution [Yes/No/ESC]:

If the solution is the correct one press Y for <Yes>. If it is not the correct solution press N for <No> and
the second solution will be displayed. If neither solution is correct press <Esc> to cancel and return to the previous
prompt.

**Distance-Distance Intersection**
Type dd to calculate the intersection of two circles: with the distances being the radii of the circles
You will be prompted to enter the first radius point and distance (radius)
You will then be asked to enter the second radius point and distance (radius)
As with the bearing-distance intersection, the two possible solutions will be displayed and you will be asked to
choose the correct one (see dialog below).

If you click the No button the other possible solution will be displayed. If you click the Yes button the intersection
point will be stored. If you click Cancel the point will not be stored.

The routine will continue with additional DD Intersections prompts until you escape [ESC] the routine.
The process will be repeated until the user presses <Esc> twice to end the command.

Perpendicular Intersection
Press P and <Enter> to calculate the point where the perpendicular constructed from a given point to a line intersects the line.
At the Enter first Point <>: prompt, type or pick a point on the line (in the example illustrated in the figure, type or pick point 2514)
At the Enter bearing: <>: prompt, type the bearing of the line or type or pick the two points defining the bearing (in the example, 2514-2513)
You will then be asked if you want to Store Perp. Int. Pt. (Yes/No):
Choose whether to store the calculated point or simply view the data (you may not want to save the resulting intersection point).
Enter second point <>: Type the point ID, or use the mouse to pick the point from which the perpendicular to line is to be constructed (in the example, 2488).
The STORE POINT prompt will indicate the point being stored (in the example it will be 2489). Press <ESC> to cancel point storage.
To exit the Intersect feature, the user must press <Esc> twice or the routine will repeat.

**Tangent Intersection**
Type T and <Enter> to calculate the points at which a line from a given point becomes tangent to a circle. You must choose a radius point for the circle, the radius of the circle, and the external point from which the tangent will start.

At the Enter radius point for circle: prompt, type or pick the center or radius point of the circle (in the example, 2490)

At the Enter radius of circle: prompt, type the radius or type or pick two points that define the radius distance (in this example, 2490-2492, or 69.92’)

At the Second point: prompt, type or pick the point through which the tangent lines must pass (in the example, 2491)

As in some of the other intersection types, you must select the desired solution from the two possible solutions using the dialog shown for the distance-distance intersect. If you click the Yes button, the intersection point will then be saved to the coordinate file and the results displayed at the command line.

To end the command, press <Esc> twice or the routine will repeat.

**Turn-Offsets-on:**
Type O and <Enter> to turn the use of offsets on or off.
An example of an offset intersection would be the easement lines for a sewer line. This routine can calculate the offset intersection say for a 7.5' left offset and a 10' right offset, as shown.
For example:
Enter first offset distance <>: -7.50

Enter Second offset distance <,-7.50>: 10.00
The offset distances are positive if right of the line, as seen looking down the line in the direction of the defined bearing, negative if left of the line.

**Intersects dialog**
If the Use Intersects Dialog menu item is checked you will see the following dialog:
To use the Intersects dialog just set the Intersect Type drop down list to specify the type of intersect you wish to do. Next click on the item you wish to specify. You may type in the information or you can move the cursor over the drawing area and you will be prompted for the information required for the edit box you were last in. To enter the next item, click on that edit box and type the information or, as before, move the cursor over the drawing and you will be prompted for the necessary information for the last edit box you were in. Continue to do this until all information has been entered then click the Compute button to compute the intersection. The results will be printed on the CAD command line and to the print file. If the Store Intersect Point check box is checked the intersection point will be stored in the coordinate file. You may specify offsets by checking the Specify Offsets checkbox and entering or picking the offset distance(s). Click the Reset button to remove all entered data from the dialog.

You may perform any other commands while the Intersects dialog is displayed - the data entered in the dialog will remain for use at any time.

Prompts

Not using Intersects Dialog:

Intersection method: Brng-Brng/Brng-Dist/Dist-Dist/Perp/Tangent or offsets-on

[BB/BD/DD/Perp/Tangent/turn-Offsets-on]: Type the 1 or 2 capitalized letters to specify the type of intersect to calculate or to turn offsets on.

point prompts

Enter point: Type a point ID or pick a point symbol on the screen.
Enter first point: Type a point ID or pick a point symbol on the screen.
Enter second point: Type a point ID or pick a point symbol on the screen.
Enter radius point for circle: Type a point ID or pick a point symbol on the screen.
Enter point on tangent line: Type a point ID or pick a point symbol on the screen.

bearing prompts:

Enter bearing <100.0000>: Type or pick the bearing.
Enter first bearing <100.0000>: Type or pick the bearing.
Enter second bearing <100.0000>: Type or pick the bearing.

distance prompts:

Enter distance <0.000000>: Type or pick the distance.
Enter 1st distance <0.000000>: Type or pick the distance.
Enter radius of circle <0.000000>: Type or pick the distance.

perpendicular intersect prompt:

Store perpendicular intersect point [Yes/No] <N>: Type "Y" or "N" and Enter.

Stopping to allow viewing of intersect point (red X) <Enter to continue> This prompt is displayed if you answered "N" to the previous prompt. Just press Enter to continue.

Intersects dialog: Type or pick the data into the appropriate edit boxes then click the Compute button to view the results and save the intersection point to the coordinate file.

Pulldown Menu Location: CG-Survey > Cogo
Keyboard Command: cg_intersects
Prerequisite: coordinate file
Use Intersects Dialog

When this menu item is checked and you choose the Intersects menu item the Intersects Dialog/Toolbar will appear.

The Intersects Dialog/Toolbar is a convenient way to perform the various types of intersections and enter data.

Below are shown four of the Intersects Toolbar layouts for various intersection types:

When entering data in the Intersects Dialog you may type point IDs, bearings and distances in the edit boxes or use the drawing area to enter the data. If you click on one of the edit boxes then move your mouse cursor over the drawing area you will be prompted for the information needed for the edit box you clicked. Once all the data has been entered, merely click the "Compute" button and the results will be displayed at the command line and, if configured to do so, written to the print file.

Prompts

Intersects Dialog/Toolbar: fill in the dialog data then click the Compute button to calculate and, if the Store Intersect Point checkbox is checked, save the intersection point to the coordinate file.

**Pulldown Menu Location:** CG-Survey > Cogo  
**Keyboard Command:** cg_tog_int_toolbar  
**Prerequisite:** None

Station Offset

In order to use the station offset functions, you must create a Point Group (formerly called a batch point file or point file) defining a centerline alignment. The Coordinate Management > Point Groups > Create section describes how you can create a Point Group.

To illustrate the use of point groups in the various station offset features, the following point group file will be used:

- 7.25+ (Slope in, 1st vert. Curve)
- 1.75- (Slope out, 1st vert. curve & slope in, 2nd vert. Curve)
- 200* (Vertical Curve Length curve 1)
- /123.50 (PVI Elevation curve 1)
- *1300 (PVI Station curve 1)
- 2.00- (Slope out of curve 2)
- *1750 (PVI Station curve 2)
- 300* (Curve Length curve 2)
- 1000 (Subgroup name - also default beginning station)
- 2001 (Point ID at Sta. 10+00)
- 2002 (Point ID at PC of Curve)
-2003 (Radius point ID, '-' indicates counter clockwise)
2004 (Point ID at PT of curve)
2005 (Point ID at PC of curve)
+2006 (Radius point ID , '+' indicates clockwise curve)
2007 (Point ID of PT of curve)
2008 (Point ID of PC of curve)

+2009 (Radius point ID, '+' indicates a clockwise curve)
2010 (Point ID of PT of curve - last entry in subgroup and in file)

NOTE: Information shown in parenthesis are comments used here for explanation and do not appear in the point group file itself.

Alignment used for examples

**Coords From Station Offset**

This feature allows you to calculate and store a coordinate point for any given station and offset along an alignment defined by a point group.

Use the Select a C&G Point Group File dialog to open a point group file
Enter Starting Station [Done] <0.0000> You can Press <Enter> to use the default station shown, or you can enter a new starting station. If you enter a "+" followed by a value, ex. "+50", all stations on a 50 foot interval will be calculated automatically.

Enter Offset <0.00000>: Enter the offset distance from the alignment. The point ID, station, offset, northing, easting, elevation and description will be printed at the command line and written to the print file.

You may repeat the process until you have calculated all the desired stations or press D then <Enter> to exit the command.

**Note:** If Elevations are set to "Calculate" and Elevation is on, (See General tab of the C&G Options dialog) then you will be asked to "Enter constant elevation change for offset points". The constant elevation change will be added to or subtracted from the calculated elevation of each newly created point on the alignment. If there is vertical curve information contained in the point group, this information will be used to calculate the initial elevation of each point. If there is no vertical curve information, the elevation of each new point will be calculated by interpolation between the elevations of the points contained in the point group.

**Prompts**

Enter Starting Station [Done] <0.0000>: You can Press <Enter> to use the default station shown, or you can enter a new starting station.

Enter Station [Interval] <0.000000>: Enter a station expressed as a decimal number. Type "I" and Enter to specify an interval or, alternatively, you can precede the station number with a "+". This will cause stations to be automatically calculated based on the value you specify.

If you choose Interval in the previous prompt:
**Enter interval**: Enter the desired interval for automatic generation of stations.
**Enter offset (+ = right, - = left) <0.000000>:** Enter the offset distance from the alignment.

**Pulldown Menu Location**: CG-Survey > Cogo > Station Offset
**Keyboard Command**: cg crds_from_staoof
**Prerequisite**: coordinate file, point group file defining the alignment

---

**Create Point Group From Station Offset**

This feature allows you create a point group by locating all the points along a predefined alignment at a given offset. It then sorts the points by station and saves the points to a new Point Group.

Select Create Point Group from Station-Offset from the menu.
Use the Select a C&G Point Group File: to open the point group file specifying the points in the alignment.
At the Calculate new points on the control line [Yes/No] <Y> prompt,
If you answer no to this prompt, the points chosen by you in the previous step will be saved in station order to the new point group file.
If you answer yes to the prompt, a new point will be created exactly on the offset line for each point found in the coordinate file that lies within the given range. The elevation of the new point will be set to the elevation of the nearby existing point and the new point IDs will be written to the new point group file instead of the existing point IDs.
Repeat the above steps to specify another offset.
Press D for <Done> to exit.

---

**Prompts**

**At the Enter Offset <0.00000>:** Type an offset if desired or just press enter for no offset. Offsets to the left should be preceded by a ".".

**At the Enter Maximum Range <0.0000>:** Specify the tolerance for points not exactly on the alignment.

**Choose initial points for base selection set from coord file. (Enter when done)**

**[All/Block/Code/Desc/Elev/Pt_group/Limits/Radius/Select]:** Use the various methods available to choose the points to be tested for being within the tolerance from the alignment.

**Calculate new points on the control line [Yes/No] <Y>:** Type "Y" and Enter or just Enter to create new points on the alignment for those points found to be near the alignment and place these new point IDs in the point group being created. Type "N" and Enter to place the existing points in the point group being created.

**Pulldown Menu Location**: CG-Survey > Cogo > Station Offset
**Keyboard Command**: cg_bpf_from_sta
**Prerequisite**: coordinate file, point group containing the points in the alignment

---

**Display Centerline Stations**

This feature allows you to view a list of the centerline stations for a given point group.

In the file dialog select the point group file that defines the alignment.
At the Enter Starting Station [Done] <1000>: prompt you will notice that the subgroup name is used to determine
the starting station default value. To use the default value, press <Enter>. You may also enter a new starting station
for the first point in the point group. For example, 24+34.12 is entered as 2434.12.
The centerline station information will be listed on the command line and written to the print file.

The Enter Starting Station (Done) <0.00000>: prompt will again be displayed at the command line, at this point
you can either enter another point group, or type in another starting elevation.
When done entering data, type D and <Enter> for to end the command.

vNOTE: The first line of the Point Group must be the beginning station of the alignment. In any routine
that computes or requires stationing information the station numbers must be relative to the stationing in the Point
Group file.

Prompts

At the Enter Starting Station [Done] <1000>: Enter the starting station for the alignment as a decimal number.

Pulldown Menu Location: CG-Survey > Cogo > Station Offset
Keyboard Command: cg_display_cl_sta
Prerequisite: coordinate file, point group file defining an alignment

Station Offset From Coords
This feature allows you to calculate the station and offset of selected points in the current coordinate file, based on
the alignment as defined by the Point Group.

Select Station Offset from Coords from the menu.
You will first be asked to open the point group file that defines the alignment.
At the Enter Starting Station [Done] <0.00000>: prompt, enter the station of the first point in the point group. For
example, if the first station is 24+34.12, enter it as 2434.12.
(As an example using the point group listed in the previous section, the starting station must be greater than 1000,
the starting station in the point group, and less than 2016.05, the station of the last point in the point group. If not,
o information will be displayed.)
Enter Maximum Range <0.00000>: The range identifies how far to look left and right of the alignment for points
in the current coordinate file.
Next, you will be asked to select the points to be considered in computing the station offsets

Add points from coordinate file. (Enter when done) [All/Block/Code/Desc/Elev/Pt-group/Limit/Radius/Select]:
At the prompt type A and <Enter> for all the points in the current coordinate file or use the other options to choose
a subset of the points. As indicated by the prompt, press <Enter> by itself to end point selection.

Chapter 18. CGSurvey Module
The station and offset information will be printed in order by station.
The Enter Start Station [Done] <0.0000>: prompt will appear again, you may enter the next starting station or type D and <Enter> to end the command.

**Prompts**

**Enter Starting Station [Done] <0.0000>:** Enter the starting station as a decimal number.
**Enter Maximum Range <0.0000>:** The range defines the distance tolerance left and right of the alignment for points selected from the current coordinate file.
**Choose initial points for base selection set from coord file. (Enter when done)**
[All/Block/Code/Desc/Elev/Pt_group/Limits/Radius/Select]: Use the various methods to select points from the coordinate file to be searched for proximity to the alignment.

**Pulldown Menu Location:** CG-Survey > Cogo > Station Offset
**Keyboard Command:** cg_staoff_from_crd
**Prerequisite:** coordinate file, an existing point group file defining the alignment

**Points on Line**

This feature allows you to calculate and store points along a line at specified distances.
After choosing Points on Line from the menu and, if needed, opening a coordinate file, you will see following prompt:

Pts on line - specify No. of pts & dist., divide line, or place pts at interval [Number and dist/Divide/Interval]:

Choose one of the following:
Number and dist: Type N and <Enter> to specify a number of points at a given interval from the start point on a line.
Divide: Type D and <Enter> to select a line and indicate how many points you wish to create. The program then creates the specified number of points equally spaced along the length of the line.
Interval: Type I and <Enter> to create points at the specified interval along a line defined by 2 points.

**Number and dist**

This option allows you to calculate a given number of points at a fixed distance along a line. For example, you can set the corners for 3 lots at 150’ intervals.
At the Enter start point: prompt, enter a point on the desired line by typing a point ID or picking a point with the mouse.
At the Enter bearing <100.0000>: prompt, use any one of the methods available to enter the bearing of the line on which you wish the points to fall.

At the Enter distance <0.0000>: prompt, use any of the available methods to enter the distance between the points along the line.
Enter number of points: Enter the number of points you want created.
At the STORING POINT: prompt data required will vary depending on your current settings. You can enter a point number and its elevation, description, and code. This prompt will appear for each of the points created along the line.
The Enter start point: prompt will repeat until you press <Esc>.
Pressing <Esc> again will allow you to create points on a line using one of the other methods. Pressing <Esc> a third time to end command.

**Divide**

Choosing this method allows you to create points by dividing a line between two points into a specified number of divisions.

Enter start point: Enter the first point defining the line by picking a point using the mouse or typing a point ID.
Enter end point: Enter the second point defining the line by picking a point using the mouse or typing a point ID.
Enter number of segments: Enter the number of points you want to create.
As the points are saved respond to the STORING POINT: prompt as required.
The Enter start point: will repeat unless you press <Esc>.
After pressing <Esc> once you may choose another method of creating points on a line or press <Esc> once more to end command.

**Interval**

This option allows you to create as many points as possible at a specified interval on a line between two points.
Enter start point: Enter the first point defining the line by picking a point using the mouse or typing a point ID.
Enter end point: Enter the second point defining the line by picking a point using the mouse or typing a point ID.
Enter Distance <0.0000>: Enter the desired distance between the points created along the line. Points will be created along the line at the given distance. As many points as will fit between the end points at the given spacing will be created.

No matter which method is used to create points, the Saving Point dialog (see below) will appear for each of the points created.

Click OK to save the point in the coordinate file.
Repeat from the Enter start point: prompt or press <Esc> to use another method to create points along a line. Press <Esc> once more to end the command.

**Prompts**

Specify: Number of points and distance, divide line or points at an interval

[Number and dist/Divide/Interval]: Type "N" and Enter to create a specified number of points along a line a specified distance apart. Type "D" and Enter to create a specified number of points between 2 points. Type "I" and Enter to create a point a specified distance from the starting point of a line specified by 2 points.

**Enter start point:** Enter the point ID or pick the point symbol for the starting point of the line.

for Number and Dist:

**Enter bearing <100.0000>:** Enter the bearing of the line along which the points are to be created.

**Enter distance <0.000000>:** Enter the distance between the points.

**Enter number of points:** Enter the number of points to be created.

for Divide:

**Enter end point:** Enter the point ID or pick the point symbol for the ending point of the line.

**Enter number of segments:** Specify the number of points to be created on the line between its end points.

for Interval:

**Enter end point:** Enter the point ID or pick the point symbol for the ending point of the line.

**Enter distance <0.000000>:** Enter or pick the distance along the line for creating the new point.

**Pulldown Menu Location:** CG-Survey > Cogo

**Keyboard Command:** cg_pol

**Prerequisite:** coordinate file

**Curves**

Their several possible curve calculations available on the Curves submenu. The available options will be described in the following sections.

**Pulldown Menu Location:** CG-Survey > Cogo

**Keyboard Command:** N/A

**Prerequisite:** None

**Calculate Horizontal**

This feature allows you to calculate the components of a horizontal curve but does not save any points to the coordinate file.

In the dialog enter any two curve components then press OK to calculate the other components.
To use the mouse to pick the two known components press the Pick button and pick the PC, PT and radius points or a C&G or non-C&G arc.
The description field is merely used to identify the curve in the printout.
The Reset button clears all fields.
When done, press the Cancel button to close the dialog.

Prompts

*Horizontal Curve Calculation dialog:* Enter any two curve components then press OK to calculate the other components.

*Pulldown Menu Location:* CG-Survey > Cogo > Curves

*Keyboard Command:* `cg_horz_calc`

*Prerequisite:* None

Curve Between Tangents

This feature allows you to calculate the curve components for a curve between two tangent lines given either the radius, the length of the tangent line or a point through which the arc passes.

At the Enter first point [Done]: prompt, enter or pick a point on one of the tangent lines. The point ID of the point selected will be displayed on the command line.
Enter first Bearing <100.000000>: use any of the available methods to enter the bearing from the point you just selected going toward to the point of intersection (P.I.) of the curve. The bearing entered will be displayed on the command line.
Enter second point: type or pick a point on the other tangent line.
Enter second bearing <100.000000>: enter the bearing of the other tangent.
Offset out <0.000000>: This is an optional entry. It allows you to calculate a point outside the curve (for example, on the right-of-way). Press <Enter> to use the default value or enter another offset. The offset used will be displayed on the command line.
Offset in <0.000000>: 50 This is optional entry allows you to calculate a point inside the curve.
Enter point on arc [Radius mode/Tangent-Distance mode]:
At this prompt there are three options as to how to specify the location of the desired curve:
At this prompt you can type or pick a point on the arc,
Or you can type R and <Enter> to get the prompt:
Specify radius of curve [Tangent-mode/Point-on-arc-mode]:
At this prompt specify the radius of the curve.
Or you can type T and <Enter> to get the prompt:
Specify tangent distance [Radius-mode/Point-on-arc-mode]:
At this prompt enter the distance from the PC or PT to the PI.
The locations of the PC, PI, PT, and radius point are calculated and the Saving Point dialog (see below) will appear once for each.

Depending on the Global Options settings, the calculated points may be drawn. If Auto Line Plot is on, the arc will be drawn as well. The coordinates of points that were created and the curve information will be displayed at the command line.
To end the command type D and <Enter> at the Specify an existing point on the first tangent line [Done]: prompt.

Prompts
Specify an existing point on the first tangent line [Done]: Enter or pick a point on one of the tangent lines.
Specify the bearing of the first tangent line <100.0000>: Enter the bearing or pick 2 points or a line to define the bearing.
Specify an existing point on the second tangent line: Enter or pick a point on the second tangent line.
Specify the bearing of the second tangent line <100.0000>: Enter or pick the bearing of the second tangent.
Offset out <0.000000>: This is an optional entry. It allows you to calculate a point outside the curve
Offset in <0.000000>: This is an optional entry allows you to calculate a point inside the curve.
Specify an existing point on the arc [Radius mode/Tangent_distance_mode]: Enter or pick a point on the arc or change how you define the arc by entering "R" and Enter for the Radius method or "T" for the Tangent-distance method.
Specify radius of curve [Tangent_distance_mode/Point_on_arc_mode]: Enter the radius or change the mode.
Specify tangent distance [Radius_mode/Point-on-arc-mode]: Enter the tangent distance or change the mode.

Pulldown Menu Location: CG-Survey > Cogo > Curves
Keyboard Command: cg_cbt
Prerequisite: coordinate file

**Middle Ordinate Solution**

Allows you to calculate the other curve elements when you can locate the chord and determine the middle ordinate distance in the field.

Follow the prompts below.

**Prompts**

Save coordinates [Yes/No]) <Y>: press Enter or type "Y" and Enter if you want the calculated radius point to be stored in the coordinate file. If not type "N" and Enter. Press Esc key to end the command.
Enter P.C. point: specify the PC point by typing a point ID or picking a point on the screen.
Enter PT point: specify the PT point by typing a point ID or picking a point on the screen.
Middle ordinate: Type in the middle ordinant distance or pick it on the screen.

Pulldown Menu Location: CG-Survey > Cogo > Curves
Keyboard Command: cg_chd_mo
Prerequisite: coordinate file

**Points on Arc**

This feature allows you to create points along an arc. The first point is set at a distance measured along the arc starting at the PC.
Enter PC point or pick a C&G Curve: enter or pick the PC point or pick a C&G curve.
If you picked a C&G Curve, the PC, Radius point, Pt point and arc length will be displayed at the command line.
After picking a C&G Curve, skip the next 2 steps.
Enter PT point: Enter or pick the PT point.
Enter radius point [cLockwise/ccW]: For a clockwise curve either type L or 'L' and <Enter> then pick or type a point ID or type a point ID preceded by a '+'. For a counter clockwise curve either type a W or a '-' and <Enter> then pick or type a point ID or type a point ID preceded by a '-'.
Enter arc length [Occupy/Multiple points] <0.000000>:

Occupy option
In occupy mode the points are located along the arc with the arc length being measured from the previous point. Thus the occupied point moves ahead to the last computed point as calculations proceed. When you type O and <Enter> the prompt becomes:
Enter arc length [do not Occupy/Multiple points] <0.000000>:

Specify the arc length at the prompt.
A point will be created and you will be prompted for the next arc length. Continue entering arc lengths until done then press <Esc> to return to the Enter PC point or pick a C&G Curve: prompt.

Multiple points option
This option allows you to compute multiple points along the arc at a given distance. The specified distance is used to set as many points along the arc as will fit between the PC and the PT. When you type M and <Enter> the prompt becomes:
Enter arc length [do not Occupy/Single point] <0.000000>:

Specify the arc length at the prompt.
A as many points as can be fit between the PC and the PT will be created. You will then be prompted for the next arc length. Continue entering arc lengths until done then press <Esc> to return to the Enter PC point or pick a C&G Curve: prompt.
At the Enter PC point or pick a C&G Curve: prompt you can continue specifying curves or you can press <Esc> to end the command.

Prompts

Enter PC point or pick a C&G Curve: Enter a point ID or pick a point symbol or a C&G Arc on the screen. Press Esc to end the command.
Enter PT point: Enter or pick the PT point.
Enter radius point [cLockwise/ccW]: For a clockwise curve either type "L" (or a plus sign (+)) and <Enter> then pick or type a point ID or type a point ID preceded by a '+'. For a counter clockwise curve either type a "W" (or a minus sign (-)) and <Enter> then pick or type a point ID or type a point ID preceded by a '-'.
Enter arc length [Occupy/Multiple points] <0.000000>: Enter an arc length to create a single point on the arc.
Enter "O" and Enter to "occupy" the calculated point so the next arc length is calculated from that point instead of the PC. Enter "M" and Enter to calculate multiple points along the arc at a specified distance.
Enter arc length [do not Occupy/Single point] <0.000000>: For multiple points enter the desired arc length or change input mode.

Pulldown Menu Location: CG-Survey > Cogo > Curves
Keyboard Command: cg_poa
Prerequisite: coordinate file
Spiral Curve Design

This feature allows you to design a spiral curve. You will be prompted using standard spiral curve component nomenclature.

Follow the prompts described in the Prompts section below and the following Spiral curve data is calculated and displayed at the command line and written to the print file.

Point of Intersection of the spiral (PI for spiral)
Tangent point of the spiral (TS for spiral)
Point where spiral meets simple curve (SC for spiral)
Radius point of the simple curve
Point where simple curve meets outgoing spiral (CS for spiral)
Point where spiral meets tangent on outgoing side (TS for spiral)
For each of the points calculated the prompt
The Saving Point dialog (see below) will appear and allow you to specify the point ID.

Click OK to cause the point to be stored in the coordinate file.

At the Curve Description <enter if done>: prompt you can either enter the description for another curve or press <Enter> to end the command.

Prompts
**Curve description <enter if none>:** This description is optional but is used to identify the information in the results. Press Enter to end the command.

**Enter the first point:** Enter or pick a point on the tangent going into the spiral.

**Enter first bearing <100.0000>:** Enter or pick the bearing from first point to the PI of the spiral.

**Enter second point:** Enter or pick a point on the tangent going out of the spiral.

**Enter second bearing <100.0000>:** Enter the bearing from second point to the PI.

**Enter Radius [Degree of curve] <0.000000>:** Enter or pick the radius or type "D" and Enter to change to degree of curve prompt.

or

**Enter Degree of Curve [Radius]:** Enter or pick the degree of curve or type "R" and Enter to change to radius prompt.

**Enter spiral length in <0.000000>:** Enter or pick the length of the spiral coming from the first tangent into the simple curve. Enter a zero for no spiral in.

**Enter spiral length out <0.000000>:** Enter the length of the spiral from the simple curve out to the second tangent. Enter a zero for no spiral out.

**Pulldown Menu Location:** CG-Survey > Cogo > Curves

**Keyboard Command:** cg_scd

**Prerequisite:** coordinate file

---

**Spiral Curve Stakeout**

This feature allows you to calculate points along a spiral at a given interval and offset for use in staking out the curve in the field.

**Curve Description <enter if done>:** This text description is only used to identify the spiral curve data printed at the command line and written to the print file.

Enter the first point: Enter or pick a point on the tangent line going into the spiral.

Enter first bearing <100.000000>: Enter the bearing going toward the P.I. of the spiral from the first point.

Enter the second point: Enter or pick a point on the tangent line going out of the spiral.

Enter second bearing <100.0000>: Enter the bearing from the tangent point just defined to the P.I. for the spiral.

Enter Radius [Degree of Curve] <0.000000>: Radius option: Entering the radius is the default option as indicated by the wording of the prompt. Degree of Curve option: To change to entering the degree of curve type D and <Enter>.

Once you have chosen the type of data you wish to specify, type or pick the radius of the simple curve between the two tangents or the degree of curve.

Enter spiral length in <0.000000>: enter the length of the spiral from the TS (Tangent to Spiral) to the SC (Spiral to Curve). Enter zero for no spiral in.

Enter spiral length out <0.000000>: enter the length of the spiral from the CS (Curve to Spiral) to the ST (Spiral to Tangent). Enter zero for no spiral out.

Enter P.I. station <0.0000>: Enter the station of the PI. For example: station 460+28.52 is entered as 460 28.52

Enter station interval <0.0000>: Specify the interval at which you wish to stake the spiral. For example, enter 50 to stake every 50 units.

Enter offset from centerline <0.0000>: This can be a positive or negative number depending on whether you want
to set points inside or outside the spiral. If you want to place points on the centerline, simply press <Enter> to use the 0.00 default value.
Odd stations to be staked (6+34.22 as 634.22): You can stake as many odd station locations as needed. When done press <Enter> without entering a station value.
The points will be calculated and stored in the coordinate file. The station and offset will be placed in the description field.
The results will be printed at the command line and in the print file.
Continue to stake another spiral or press <Esc> or <Enter> at the Curve Description <enter if done>: prompt to end the command.

Prompts

Curve Description <enter if done>: This text description is optional and is used to identify the spiral curve in the output
Enter the first point: Enter or pick a point on the tangent line going into the spiral.
Enter first bearing <100.000000>: Enter the bearing going toward the P.I. of the spiral from the first point.
Enter the second point: Enter or pick a point on the tangent line going out of the spiral.
Enter second bearing <100.0000>: Enter or pick the bearing from the second tangent point to the P.I. for the spiral.
Enter Radius [Degree of Curve] <0.0000>: Enter or pick the radius. or, to change to entering the degree of curve, type "D" and Enter.
Enter spiral length in <0.000000>: enter the length of the spiral from the TS (Tangent to Spiral) to the SC (Spiral to Curve). Enter zero for no spiral in.
Enter spiral length out <0.000000>: enter the length of the spiral from the CS (Curve to Spiral) to the ST (Spiral to Tangent). Enter zero for no spiral out.
Enter P.I. station <0.0000>: Enter the station of the PI. For example: station 460+28.52 is entered as 46028.52 Odd stations to be staked (6+34.22 as 634.22): Enter as many odd stations as needed. When done press Enter.

Pull-down Menu Location: CG-Survey > Cogo > Curves
Keyboard Command: cg_scs
Prerequisite: coordinate file

Stakeout Horizontal

This feature allows you to create points for field staking a horizontal curve.

After choosing the Horizontal Stakeout menu item, and opening a coordinate file you will be asked if you want to Save coordinates [Yes/No] <Y>.
If you respond Yes (or press enter), a new point will be saved to the coordinate file for each point to be staked along the curve. No matter how you answer this question, stakeout information will be generated and displayed.
Enter curve description: Enter a description that will allow you to identify the curve in the output.
P.C. station <0.000000>: Enter the station for the P.C. of the curve.
Station interval <0.000000>: Enter an interval for staking the points along the curve.
Odd stations to be staked (6+34.22 as 634.22) [Done]: Enter the station of any odd location along the curve to be staked. For example, you may wish to stake the point on the curve at which a pipe crosses or the point where the extension of a property line intersects the curve. You may enter as many odd stations as required. When done, press <Enter> at the prompt without entering a new odd station or press D and <Enter>.
Offset from C/L <0.000000>: enter a non-zero value here if you must stake points offset from the main alignment - for example: along a curb line, a barrier wall or along a property line.

If the distance is entered as a positive number, the distance will be added to the radius or staked outside the curve. If the number entered is negative, it will be subtracted from the radius or staked inside the curve. To stake the centerline, enter zero.

At the Enter PC point or pick a curve: prompt you can type a point ID for the P.C. or use the mouse to pick a point or a C&G curve on the screen.

If you picked a C&G curve in the previous step, you need not enter the PT point or the radius point so skip the next 2 steps.

Enter PT point: type the point ID for the P.T. or click the point on the screen.

Enter radius point [cLockwise/ccW]: Use any of the available methods of specifying a radius point.

Type the radius point: If the curve is in a clockwise direction from the P.C. to the P.T., enter the point number preceded by a plus sign, e.g. +18. If the curve is in a counterclockwise direction from the P.C. to the P.T., the point ID preceded by a minus sign, e.g. -18.

Pick the radius point with the mouse: If the curve is in a clockwise direction from the P.C. to the P.T., type an L or a '+' and <Enter>, then use the mouse to pick the point on the screen. If the curve is in a counterclockwise direction from the P.C. to the P.T., type either a W or a '-' and <Enter>, then pick the point on the screen.

The report will be printed at the command line and written to the print file.
The command will repeat until you press <Esc> at the Save coordinates [Yes/No] <Y> : prompt to end command.

Prompts

Save coordinates [Yes/No] <Y> : Type "Y" and Enter or just Enter if you wish to save resulting points to coordinate file. Type "N" and Enter if not. Press Esc to end command.

Enter curve description: Enter a description that will allow you to identify the curve in the output.

P.C. station <0.000000> : Enter the station for the P.C. of the curve.

Station interval <0.000000> : Enter an interval for staking the points along the curve.

Odd stations to be staked (6+34.22 as 634.22) [Done]: Enter as many "odd" stations to be staked. Type Enter or "Done" and Enter when all odd stations have been entered.

Offset from C/L <0.000000> : If you wish to stake stations not on the centerline, enter the offset and press Enter or just press Enter to accept the default offset. Positive offset is outside the radius and negative is inside.

Enter PC point or pick a curve: Enter a point ID, pick a point symbol or pick a C&G arc.

if you did not pick a C&G arc:

Enter PT point: Enter or pick the PT point.

Enter radius point [cLockwise/ccW]: Enter "L" or "W" to choose the type of curve then Enter or pick the radius point. You may also enter "+" and Enter then enter or pick a point for the radius point of a clockwise curve or Enter a "-" and enter or pick a point for the radius point of a counter clockwise curve.

Pulldown Menu Location: CG-Survey > Cogo > Curves

Keyboard Command: cg_hcso

Prerequisite: coordinate file

Tangent Between Curves

This feature allows you to calculate the end points of a tangent line joining two curves. This may be used, for example, to layout roads which do not have curve/tangent information.
Follow the prompts noted below and, if a solution is possible, the endpoints of the tangent between the two curves will be calculated. Point IDs will be assigned and coordinates stored for the points of tangency.

Repeat or enter "D" when done

**NOTE:** There are 4 tangent solutions for this problem. The solutions sets differ according to the sign preceding the radius or degree of curve.

**Enter first radius point [Done]:** Enter or pick the center point for one of the curves. Press Enter or type "D" and Enter when done.
**Enter first radius <0.00000>:** Enter the radius of the first curve. Use a "+" sign before the point ID to specify a clockwise curve or a "-" sign to specify a counter clockwise curve.
**Enter second radius point:** Enter or pick the center point for the second the curve.
**Enter second radius <0.00000>:** Enter the radius for the second curve. Use a "+" sign before the point ID to specify a clockwise curve or a "-" sign to specify a counter clockwise curve.

**Pulldown Menu Location:** CG-Survey > Cogo > Curves
**Keyboard Command:** cg_tbc
**Prerequisite:** coordinate file

---

**Vertical Curve Design**

This feature prints a list of station and elevation information for stations along one or more vertical curves.

Use the Odd stations to be staked (6+34.22 as 634.22): prompt to enter any stations along the curve for which you wish elevation information. This permits you to calculate elevations over culverts or at other important locations.

The calculated station and elevation information. The station, tangent elevation, tangent offset and grade elevation will be printed at the command line and in the print file. The high or low point will be marked with an asterisk.

Repeat the process to design another vertical curve or press <Esc> at the Enter curve description: prompt to end the command.

**Prompts**

**Enter curve description:** Description is used to identify the curve in the output.
**Enter slope in <0.00000>:** The slope is entered as a percent. For example: enter -1.5 for a 1.5% downhill slope.
**Enter slope out <0.00000>:** Enter the slope as a percent.
**Enter length of vertical curve <0.00000>:** Enter the length of the vertical curve.
**Enter PVI Station <0.000000>:** Enter the PVI station. For example: Enter 1250.00 for station 12+50.00
**Enter PVI Elevation <0.000000>:** Enter the PVI elevation.
**Enter station interval <0.000000>:** Enter the station interval.
**Odd stations to be staked (6+34.22 as 634.22):** Enter any stations along the curve for which you wish elevation information.
**Area**

There are three features in the Area submenu:

<table>
<thead>
<tr>
<th>Pulldown Menu Location:</th>
<th>CG-Survey &gt; Cogo &gt; Curves</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keyboard Command:</td>
<td>cg_vcd</td>
</tr>
<tr>
<td>Prerequisite:</td>
<td>coordinate file</td>
</tr>
</tbody>
</table>

**Area Summary**

The Area Summary feature allows you to get information on the area and perimeter of one or more parcels and the tract that contains the parcels.

After choosing the Area Summary menu item and, if required, opening a coordinate file, you are asked to specify the type of Area Summary you want:

Type of Area Summary [Complete/Area only/Mapcheck] <C>:

**Complete Area Summary**

Complete summary allows you to get complete information on the area and perimeter of parcels and the tract that contains the parcels.

Source of points defining area [Point group/Manual entry] <P>

If you have a Point Group, enter <P>. Enter <M> if you prefer to manually enter the points.

Once the overall area and parcels have been defined either by using a point group or manually entering the information, the Complete Area Summary is displayed at the command line.

The points used in defining the area are listed first. If there are any arcs involved in the area computation, all of the elements of the curve will be displayed as well. After listing the points defining the area, the area and perimeter summary are reported.

**Area Only**

The data input is the same as for the Complete Area Summary but the report produced contains only the area of each parcel and the accumulated area for the entire tract.

**Mapcheck Area**

The data input is the same as for the Complete Area Summary as is the resulting report except that it also includes closure information. The closure information includes the correct ending coordinates; the actual ending coordinates; the northings, eastings, and bearing and distance of the error; the total distance traversed and the overall closure.
Prompts

Open Coordinate File dialog: If a coordinate file is not open, you will be asked to open one.

Type of Area Summary [Complete/Area only/Mapcheck] <C>: Press "C" and Enter or just Enter for Complete, "A" for Area only, or "M" for Mapcheck.

Source of points defining area [Point group/Manual entry] <P>: Type "P" and Enter or just Enter to use a point group to specify the points defining the tract. Type "M" and Enter to specify the points defining the tract by typing in point numbers or picking from the screen.

Pulldown Menu Location: CG-Survey > Cogo > Area

Keyboard Command: cg_assum

Prerequisite: coordinate file

Bearing Area Cut-off

This feature allows you to cut a predetermined area from a closed figure using a cut-off line having a specified bearing. The boundary intersected by the cut-off bearing line can be either a straight line or arc.

Enter area in ACRES [Sq. Feet/Done] <0.000000>: Enter the number of acres contained within the cut-off area.

To change from acres to square feet, type S and <Enter>.

Note: if units are set to meters, the prompt will be:

Enter area in HECTORS [Square meters/Done].

Enter bearing of cutoff line <100.000000>: Enter the bearing of the cut-off line through the property using Qdd.mmmmssss format.

where:
Q = quadrant (1 = NE, 2 = SE, 3 = SW, 4 = NW)
dd = degrees
mm = minutes
sss = seconds (The third s indicates that, if desired, you can optionally specify seconds to the nearest 0.1 second)

Note: Trailing zeros need not be entered.

Place area to right or left of bearing line [Right/Left] <R>: "Looking" in the direction of the cut-off bearing allows you to determine which side is left or right. Type R and <Enter> or just <Enter> for right. Type L and <Enter> for left.

Method of defining the overall area to be divided [C&G Point-group/Manual-entry] <M>: Type "P" and Enter if you wish to use a point group to specify the overall area or type "M" and Enter (or just press Enter) to specify the overall area interactively.

Defining the overall area using a C&G Point Group:

If you have a C&G Point Group that defines the area to be divided and you choose to use the point group option,
you will then be asked to use a file dialog to browse to the point group file and select it.

**Defining the overall area manually:**

If you choose to type or pick the points defining the overall area individually, you will see the prompt:

**Enter point ID or pick graphically [c]lockwise/[c]cw/[p]olyline:** Specify a point ID or begin a curve by typing L or W. Type P and enter to pick a polyline.

**Note:** if you choose to pick a polyline, it must be a closed polyline and all its vertices must have coordinates matching points found in the coordinate file.

When specifying individual points, move around the parcel and pick or type in the points, in order, to define the overall area involved.

After all points have been entered, press Enter to end point input.

**Calculate the Cut-off Line**

No matter which method you use to specify the property being divided, once the overall tract is specified, the cut-off line is calculated and the points at which the cut-off line intersects the tract boundaries are saved.

The **Saving Point** dialog (below) will be shown for each intersection point.

![Saving Point dialog](image)

Click the **OK** button to save the intersection point.
Depending on your settings for Auto Line Plot and Auto Point Plot on the Graphics tab of the C&G Options dialog box, you may see both the points and the cut-off line drawn on the screen.

This process can be repeated as many times as is necessary to further divide the overall area or to divide another area. Press <Esc> or "D" at the Enter area... prompt to end the command.

**Prompts**

**Enter area in ACRES [Sq. Feet/Done] <0.000000>:** Enter the number of acres contained within the cutoff area or type "S" and Enter to use square feet or "D" and Enter when done.

**Enter bearing of cutoff line <100.000000>:** Enter the bearing of the cut-off line through the property.

**Place area to right or left of bearing line [Right/Left] <R>:** Type "R" and Enter or just Enter for right of line. Type "L" and Enter for left. The direction of the cut-off bearing determines which side is left or right.

**Method of defining the overall area to be divided [C&G Point-group/Manual-entry] <M>:** Type "P" and Enter if you wish to use a point group to specify the overall area or type "M" and Enter (or just press Enter) to specify the overall area interactively.

for Manual entry:
**Enter point ID or pick graphically [cLockwise/ccW/Polyline]:** Specify the point ID or begin a curve by typing L or W. Type P and enter to pick a polyline.

**Pulldown Menu Location:** CG-Survey > Cogo > Area

**Keyboard Command:** cg_baco

**Prerequisite:** Coordinate file.

**Hinge-Radial Area Cut-off**
This command allows the user to cut a specified area from a parcel by projecting a line from a user selected hinge point on the parcel boundary (Hinge Area Cut-Off) or outside the boundary (Radial Area Cut-Off) and projecting it to the far side of the overall area boundary to generate the desired area. If the selected point is outside the boundary the feature automatically subtracts the area outside the boundary when finding the radial cut-off line that creates the desired area.

**Enter area in ACRES [Sq. Feet/Done] <0.000000>:** You are being prompted for the number of acres to be contained within the cutoff area. Enter the area in acres or enter <S> if you want to switch to square feet.

Enter hinge/radial point: Enter, or graphically pick the hinge point, in this case 2529.

Place area to right or left of cut-off line [<Right>/Left]: Enter <R> for right or <L> for left. Right or left is determined as if you were occupying the hinge point (2529) and looking toward the solution point.

Method of defining the overall area to be divided [Point group/Manual entry <P>: Enter the points that define the overall area to be divided using either a point group or by typing or picking the points defining the area manually.
See Bearing Area Cut-off for more details on this.

Radial Area Cut-Off

The Radial Area Cut-Off feature uses a radius point and a line projecting from the point much like the hinge area cut off. The difference is that the Radial area cut-off allows you to subtract a radial area (pie shape) from the Area Cut-Off computation. This difference makes this feature especially useful in subdividing a parcel on a cul-de-sac.

Enter area in ACRES [Sq. feet/Done] <0.000000>: Enter the number of acres to be contained within the cutoff area.

If you wish to enter the area in square feet, type S and <Enter> then enter the area required in square feet.

Enter point ID of hinge/radial point: Type or pick the hinge point. In the example the hinge point is point 2573.

Area to right or left of bearing [Right/Left] <R>: Type R and <Enter> for right or L and <Enter> for left. Right or left is determined as if you were occupying the hinge point (2573) looking toward the solution point.

Use Point Group or manually enter points [Point Group/Manual Entry] <P>: Use a point group or manually type in or pick the points that define the overall area to be divided. See Bearing Area Cut-off for a complete description of these options.

Repeat the process as many times as needed to subdivide the current area or other areas.

When done press <Esc> at the Enter area in ACRES [Sq. feet/Done] <0.000000>: prompt.

Prompts

Enter area in ACRES [Sq. Feet/Done]) <0.000000>: enter desired area in acres or type s and enter to use square feet.

Enter point ID of hinge/radial point: Enter or pick hinge/radial point ID.

Use Point Group or manually enter points [Point Group/Manual Entry] <P>: Press enter to use a point group to specify the boundary points or type "M" and Enter to enter boundary points interactively.

Pulldown Menu Location: CG-Survey > Cogo > Area

Keyboard Command: cg_raco

Prerequisite: Coordinate file and, if desired, a point group to define the overall area or tract.

Roadways

The roadways submenu contains 2 features: Right-of-Way/Easements and Intersections/Cul-de-Sacs and the Intersections/Cul-de-Sacs has a submenu containing several features for each type of intersection or cul-de-sac.

Right-of-Way Easements

The Right-of-Way/Easements feature allows you to compute offsets left and/or right of an alignment.
After the alignment points have been entered, offset points will be created to the left and right of each point you specified in the alignment.

If Auto Point Numbering is on, the calculated points will be stored in the coordinate file. Depending on your settings for Auto Line Plot and Auto Point Plot in the Graphic tab of the C&G Options dialog, the new points and lines may also be drawn. If Auto Point Numbering is off, you will see the Saving Point dialog and can accept or change the default point number and other information associated with the point.

**Prompts**

**Enter offset right**<0.000000>: Enter the offset to the right of the alignment.

**Enter offset left**<0.000000>: Enter the offset to the left of the alignment.

**Method for specifying center line points [Point group/Manual entry]**<P>: To use a point group type "P" and Enter or just Enter and select the point group from a file dialog box. Type "M" and Enter to specify the alignment interactively.

**Pulldown Menu Location:** CG-Survey > Cogo > Roadways

**Keyboard Command:** cg_rw

**Prerequisite:** coordinate file containing points defining the alignment

---

**Intersections/Cul-de-sacs**

**T Intersections**

This feature allows you to calculate the right-of-way intersection points and/or the fillet points and fillet radius points (if fillets are used) at T type intersections. One or both of the roads may have arc centerlines.

The points defining the fillet points will be calculated and stored in the coordinate file.

Repeat as needed or press <Esc> or <Enter> at the Enter C/L intersection point (Enter when done): prompt to end the command.

**Prompts**

**Enter C/L intersection point (Enter when done):** enter or pick the centerline intersection point.

**Enter through road C/L bearing [Arc]**<0.000000>: If the through road is a straight road, enter or pick the bearing for the road. Otherwise type A and <Enter> to switch to Arc mode and enter the radius point of the through road.

**Enter through road width**<0.000000>: Enter the width of the through road.

**Enter 2nd road C/L bearing away from intersection [Arc]**<0.000>: enter the 2nd bearing or press <A> for Arc and enter the radius point. The bearing is away from the intersection.

**Enter 2nd road width**<0.000>: Enter the 2nd road width.

**Enter fillet radius**<0.000>: If you do not want to have fillets, press <Enter> to use the 0.00 default value. Otherwise, enter the fillet radius.

**Pulldown Menu Location:** CG-Survey > Cogo > Roadways > Intersections/Cul-de-sacs
X Intersections

The radius, PC and PT points for each fillet will be calculated and stored. If Auto Line Plot is on, the fillet arcs will be drawn.
Repeat as needed then press Enter or Esc to end the command.

Prompts

Enter C/L intersection point (Enter when done): enter or pick the intersection point of the two road centerlines.
Enter 1st road C/L bearing [Arc]: If first road is straight, enter the 1st bearing. If it is an Arc, enter the 1st radius point.
Enter 1st road width: Enter 2nd road C/L bearing (Arc): If the intersection point for the first road centerline is on a straight segment, enter the bearing of the centerline. If it is on an arc, type A and <Enter> then enter the first road centerline’s radius point.
Enter 2nd road width: Enter the second road width.
Enter 2nd road C/L bearing [Arc]: Enter the second road centerline bearing or type A and <Enter> and specify the centerline radius point for the second road.
Enter fillet radius: Enter the fillet radius or zero, if there are no fillets.

Pulldown Menu Location: CG-Survey > Cogo > Roadways > Intersections/Cul-de-sacs
Keyboard Command: cg_xint
Prerequisite: coordinate file

Y Intersections

The radius, PC and PT points for each fillet will be calculated and stored and if Auto Line Plot is on, the fillet arcs will be drawn.
Repeat as necessary then press <Esc> or <Enter> to end command.

Prompts

Enter C/L intersection point (Enter when done): Enter or pick the intersection point for the three road centerlines.
Enter 1st road C/L bearing away from intersection point: Enter one of the road centerline bearings (going away...
from the intersection point).

**Enter 1st road width:** enter the first road width.

**Enter 2nd road C/L bearing away from intersection point:** Enter another of the road centerline bearings (going away from the intersection.)

**Enter 2nd road width:** Enter the width of the second road.

**Enter 3rd road C/L bearing away from intersection point:** Enter last of the road centerline bearings (going away from the intersection.)

**Enter 3rd road width:** Enter width of third road.

**Enter fillet radius:** Enter radius of fillets or zero for none.

**Pulldown Menu Location:** CG-Survey > Cogo > Roadways > Intersections/Cul-de-sacs

**Keyboard Command:** cg_yint

**Prerequisite:** coordinate file

---

**Bubble Cul-de-Sac**

This type of cul-de-sac is also called a fish-eye cul-de-sac. It is commonly used at sharp turns in roads in subdivisions.

---

Follow the prompts described below. When done the fillet points and radius points will be stored in the coordinate file. These points will be plotted and the fillet arcs will be drawn if the C&G settings call for it.

You may repeat the process as necessary or press <Esc> to end command:

---

**Prompts**

**Enter cul-de-sac radius point (Enter when done):** type or pick the radius point.

**Enter cul-de-sac radius <0.000>:** Enter the radius of the cul-de-sac.

**Enter 1st C/L bearing away from radius point <0.000>:** Enter the bearing along the first roadway centerline away from the cul-de-sac radius point.

**Enter 2nd C/L bearing away from radius point <0.000>:** Enter the bearing along the second roadway centerline away from the cul-de-sac radius point.

**Enter road width <0.000>:** Enter the roadway width.

**Enter fillet radius <0.000>:** Enter the fillet radius or zero for no fillets.

**Pulldown Menu Location:** CG-Survey > Cogo > Roadways > Intersections/Cul-de-sacs

**Keyboard Command:** cg_bcul

**Prerequisite:** coordinate file

---

**Standard Cul-de-Sac**

The standard cul-de-sac is a common feature of most subdivisions.
Enter cul-de-sac radius point (ENTER when done): type or pick the cul-de-sac radius point (in this example, point 2301).
Enter cul-de-sac radius <0.000000>: Enter or pick the radius of the cul-de-sac (60 units in the example).
Enter C/L bearing away from radius point [Arc]: In computing a straight cul-de-sac you must enter the bearing of the road centerline going away from the radius point. For the example the bearing is from point 2301 to point 2302.
Enter point on C/L (NOT radius point): This must be a C&G point on the centerline but cannot be the same as the cul-de-sac radius point. In this case we can use point 2302.
Enter road width <0.000000>: enter the total width of the road right-of-way.
Enter fillet radius <0.000000>: Enter the fillet radius. Remember, you do not have to have a fillet radius, you may enter zero here.
The points needed to define the cul-de-sac and the fillets are calculated and stored in the coordinate file.
If Auto Line Plot is on the lines for the cul-de-sac and the fillets will be drawn automatically.
You may repeat the process as many times as necessary.
When done, press <Enter> at the
Enter cul-de-sac radius point (ENTER when done):

Standard Cul-de-Sac on ARC

The procedure for a cul-de-sac on arc is the same as it is for a straight cul-de-sac, except at the
Enter C/L bearing away from radius point [Arc]: prompt, choose A for Arc, then enter the C/L radius point for the roadway, in this case point 2313.

Offset cul-de-sac:

The procedure for offset cul-de-sac is the same as a straight cul-de-sac except the radius point is the offset point. In the sketch, the point 2324 is the radius point. The bearing is from 2324 toward 2326 and the point on the C/L would be point 2325.

Prompts

Enter cul-de-sac radius point (ENTER when done): type or pick the cul-de-sac radius point. Press Enter when done.
Enter cul-de-sac radius <0.000000>: Enter or pick the radius of the cul-de-sac.
Enter C/L bearing away from radius point [Arc]: Enter or pick a point. For a straight cul-de-sac roadway, this must be a point on the centerline but cannot be the same as the cul-de-sac radius point. Type "A" and Enter to specify information for a cul-de-sac on a curved roadway.
if you chose a curved roadway:
Enter C/L radius point [Line]: Type a point ID or pick a point symbol or type "L" and Enter to switch back to a straight roadway.
Fit Structure

The purpose of the Fit Structure feature is to place a structure (or the footprint) within a bounding polygon. For example, a house foundation - the footprint - within the limits of the setback lines of a lot - the bounding polygon.

The user can easily insert a structure footprint within a lot or bounding polygon near its final location. The footprint then it can then be conveniently rotated and/or translated, in user definable increments, to the exact position desired.

Footprint Templates

The template, a full scale definition of a structure's footprint, must be defined prior to placing it within the bounding polygon.

Templates are not drawings but they can be imported from existing drawings.

The data specifying the dimensions of a template is stored in a binary format and cannot be manipulated without using the Template Manager. Once a template is placed in the drawing, it becomes a C&G footprint polyline. Since it is a C&G polyline, it can be queried and manipulated using ordinary CAD and CGSurvey commands.

Template Manager

The Template Manager is used to manage the templates for the various projects you work on. For example, the various house footprints used in a given subdivision can be defined as templates. The templates can then be placed in a lot in an "as" or "reverse" orientation and reused as many times as necessary. You can use the Template Manager to define templates directly or import the templates from existing drawings.

The Template Manager allows you to organize your templates within projects. You can name the projects in a meaningful way then import the templates into the project "folder".

When you choose the Fit Structure feature from the Cogo menu for the first time, a dialog warns you that you have no templates defined then brings up the Template Manager.

In the dialog below you will notice that there is nothing listed under the Projects item. This means that you will have to either create a template or import one from an existing drawing.

Creating a Template:
To create a new template, click the Create button. This brings up a dialog that allows you to configure the simple drawing in which you will create a template. This dialog allows you to specify the name of the project, the name of the template and asks about the approximate overall size of the template. If the structure template is made up of right angle segments you may want to specify a snap grid to aid you in laying out the template. You should be aware that the create template method should only be used for very simple templates and that it does not allow you to edit the structure once it is added to the Template Manager.

When you are done configuring the create template drawing interface, click OK and you will be see an empty screen upon which you can draw the template. The template is merely a closed polyline. The C&G Polyline by Points interface is used but in this case there will only be normal CAD points picked (also known as graphic points designated as GR-PT). The polyline must be closed - so use the C for Close command line option for the last line segment in the template. Once you enter the Close option keyword for the polyline you are working on, the drawing window closes and the template is imported into the Template manager as shown below.

**Note:** You must click on the template name in order to see its shape in the window on the right and to choose it as the current template.

**Importing a Template**

The Create template method is only useful for very simple templates. For more complicated templates and projects with multiple structures, it is recommended that you use the Import method. To import a template you must create a separate drawing, then draw all of your templates at full scale on the layer specified for templates (see **Fit Structure Setup**).

**Create a separate template drawing**

Begin the importing of a template by creating a new drawing file as a repository for all the structure template drawings used in a specific project. For this example we will create a new drawing named Mitchell Estates bldgs.dwg. This file will only contain the structure template drawings for this project. Select the CAD File menu then select the menu New item.

You may be asked to choose a drawing template (not to be confused with the structural template polylines you are about to create). It is generally easiest to use the default acad.dwt drawing template but you may also specify one of your own choosing.

In this new drawing create a layer having the name specified in **Fit Structure Settings** and make this layer current. You can accomplish this by using the CAD Layer Manager. To open the Layer Manager, from the Format menu choose the Layer menu item.
In the new drawing, draw the templates (house footprints for example) you will be using in your project. A structure template must be a closed polyline and may contain arc segments.

Draw the individual house footprints. It is recommended that you use either the C&G Polyline by Points feature or use the standard CAD PLINE command - on the Draw menu choose 2D Polyline.

You could also use the C&G Quick Traverse feature to traverse around the building. However, if you use Quick Traverse to create the footprint you must then convert the C&G lines created by Quick Traverse to polyline. To do this you can use a utility on the CGTools menu, Join Nearest.

Once you have created the templates needed, close and save the template drawing file. You can come back to this drawing at anytime and add or modify templates as needed.

**Note:** If you change a template in the original template drawing, you must be re-imported using the Template Manager. First, use the Template Manager's Delete feature to delete the old template, then re-import the changed template from your template drawing file.

### Placing a Footprint:

Return to the original drawing into which you wish to insert the footprint. In this example Mitchell Estates.dwg will be used to place structure footprints within lot setbacks.

Select the Fit Structure menu item.

If this is the first time you have run the command and no templates have been specified, you will be informed of this by a warning dialog. Click OK in the warning dialog and the Template Manager will come up.

If you have inserted a template prior to running this command, the following prompt will be seen at the command line:

```
Choose a structure template
[Set template/Current-template (Wilson)/Mirror-current/Done] <C> : 
```

Select "S" for Set template to bring up the Template Manager.

### The Template Manager

As mentioned earlier, the Template Manager is used to manage the structure templates you use for your various projects. In the left hand pane the projects and their associated templates are arranged similar to the directories in the Windows Explorer. On the right pane is a drawing showing an unscaled representation of the shape of the currently highlighted template. The highlighted template becomes the current template when you Close the Template Manager. The following describes the Template Manager functions in more detail.

**Delete button:** This allows you to delete a Project or an individual template.

**Create button:** This allows you to generate a template "on-the-fly" while in the current drawing file. This method
of creating templates should only be used for the simplest of templates. In most cases it is recommended that you import pre-drawn templates from other existing drawings.

When the Create button is selected, the Add A Template dialog appears (shown earlier).

Name of Project: enter a new name or press the down arrow to select from existing projects.

Name of Template to Add: enter a new name or press the down arrow to select from existing projects.

Approximate Overall Dimensions of Template:
enter an approximate length and width. Make sure this overall dimension will include the entire template so you will be given enough room to draw the template - too large is better than too small.

Grid:
If you wish to have a snap grid as a drawing aid when you create a template, check the Use grid to aid in drawing the template checkbox and set the grid interval. You need not use a grid but it is useful in creating simple rectangular templates.

Click OK to begin creating the template. To create the template merely pick the desired locations for the various building corners. Be sure to close the structure perimeter by typing C and Enter. After closing the template polyline you will be returned to the Template Manager.

Import button:
clicking this button allows you to import the template from another drawing file. As described earlier, you should create a separate template drawing. In that drawing draw the required templates as closed polylines. The templates may contain arcs.

When you select the Import button a dialog (shown earlier) comes up asking you to enter or select a Project Name and to specify the Name of Template to Add.

The Project Name can be anything you wish but is often the name of the subdivision or the client name. The template name can also be anything you wish. It should generally reflect the type or style of structure the template represents.

After filling out the project and template names and clicking OK, a file dialog will be displayed. Choose the drawing file you created earlier containing the template(s) you wish to import.

After closing the file dialog the template drawing will be shown and you will be asked to choose the template polyline. When you pick the template polyline its geometry is stored in a special file reserved for template information and you will be returned to the Template Manager.

If you highlight the newly imported template on the left hand pane it becomes the current template and you should see it displayed in the right hand pane.

If you wish to import another template just repeat these steps as many times as necessary.
By highlighting the template name it is made the current template. You may choose to mirror the current template on the Y axis by checking the Mirrored checkbox. All you need do now is click the Close button to close the Template Manager and place the footprint in the drawing.

**Fit Structure Example**

The following file names will be used when describing the following example:

- Coordinate File: Mitchell Estates.crd
- Drawing File: Mitchell Estates.dwg
- Template Drawing File: Mitchell Estates bldg.dwg

**Note:** The template drawing file may have several templates in the same drawing file. For example, you may have a subdivision with many different house footprints.

**Import the templates**

Open the subdivision drawing file, in this case; Mitchell Estates.dwg, and the associated coordinate file: Mitchell Estates.crd.

The subdivision drawing should already exist and you should have already defined the bounding polygons within which the structures are to be placed. These bounding polygons can be defined either by polylines (arcs are allowed) or lines and arcs. The lots and setbacks (bounding polygons) can also be defined using a C&G Point Group or Groups.

Once the subdivision drawing is open and has been prepared for the placement of structures choose Fit Structure from the menu.

If you have not run the Fit Structure command and set a current template in this drawing session, the Template Manager dialog will appear.

The first task will be to create a project and import templates from the template drawing file, Mitchell Estates bldg.dwg.

Select the Import button and fill in the project name and template name.

In this example the subdivision name is Mitchell Estates and the house model being added to the template list is the Wilson.

Next a drawing file dialog will be displayed. Highlight the template drawing file (in this case Mitchell Estates bldg.dwg) and click the Open button and use the cursor to choose the polyline representing the template to be imported.

After choosing the template polyline, you will be returned to the Template Manager. You will notice that the template you just chose has been added to the template manager under the project you selected. To see its shape and make it the current template, click the template name under the current project.

You may continue to add templates as required. Click Close to begin placing the template in the subdivision drawing.

After the Template Manager closes you will return to the main drawing and see the following prompt:

**Pick the lot within which the structure will be placed [cg-Point-group/Done] <pick>:**

Pick a polygon or a series of lines that define a closed lot boundary or setback within which you wish to place the structure. Type P and Enter to use a C&G point group file to define the bounding polygon.
Place the structure in the bounding polygon

Once you have specified the bounding polygon you will be asked to place the structure near its final location in the bounding polygon. Move the structure near its desired location using the mouse and click the left mouse button to place it at that location. Once you have picked the approximate location for the structure you will then be allowed to rotate and move the structure to its exact final location.

Note: If you need to adjust a template further once it has been placed within the bounding polygon and you have exited the Fit Structure command, you can run the Fit Structure command again and pick the existing structure instead of using a template.

Adjust the structure

After placing the structure in the bounding polygon you will see the following prompt at the command line:

Adjust structure [Move/Step-move/step-Rotate/rot-Ninty/Parallel/On-boundary/setUp/Done] <D>:

You are now at the stage were the structure can be adjusted to its final desired location with relationship to the setback lines and its orientation with respect to the street and other features.

In all the commands used to adjust the structure, the distances to the bounding polygon may be displayed at the appropriate corners of the template (see example below). You may turn this distance display on or off or view or change other fit structure parameters using the setUp option (type U and Enter at various the prompts).

Move:
Type M and Enter to "drag" the structure around using the mouse cursor - similar to when you first placed the structure in the bounding polygon. This option is only meant for moving the structure in a gross, imprecise way and thus allow you to place it near its final location. After using this option the structure can be more finely adjusted using one of the other options described here.

Step-move:
To move the structure up, down, left or right, using the arrow keys on the keyboard, type S and Enter. The following prompt will appear:

Press arrow keys to move 1.000 dwg units [setUp/Done] <D>:

Now you can use the arrow keys on your keyboard to move the structure by steps in the X and Y directions. The distance moved per keystroke is indicated at the command line - in this case the structure moves 1 unit each time you press an arrow key. To change the per step increment, type U for setUp. This brings up the Fit Structure Setup dialog, allowing you to change the Translation Step setting (see below).
Click OK to return to the Adjust Structure command line.

**Step-Rotate:**
If you type R and Enter for step-Rotate you can then use the up and down arrow keys on the keyboard to rotate the structure by small rotational steps.
The following prompt will appear:
**Use down/up arrow keys to rotate 10°00'00'' clockwise/ccw [setUp/Done] <D>:**

**Rotate:**
To rotate the structure, type R and Enter. The following prompt will appear:

**Rotate structure to desired orientation: [setUp] <pick>:**

Use this option to rotate the structure by moving the mouse. Left clicking will place the structure at the current rotated orientation. This method of rotation is not precise and is thus useful only for gross rotational movements.

**rot-Ninty:** Type N and Enter to rotate the structure 90 degrees in a clockwise direction.

**Parallel:**
Type P and Enter to rotate the structure so that one of its sides is parallel to a specified line segment on the bounding polygon.
First, select the side of the bounding polygon that you wish to be parallel to a selected side of the structure.
Next, select the side of the structure that is to be parallel to the previously selected line on the bounding polygon.
After picking the side on the structure the structure will be rotated into position.

**Note:** If the rotating the structure about its geometric center to make the selected sides parallel to one another will cause an encroachment, an error message will be displayed, no changes will be made, and you will return to the Adjust Structure ... prompt.
On-boundary:
Type O and Enter to choose a point on the structure that is to touch a selected point on the bounding polygon. This is accomplished by translation only.

Pick the point on the bounding polygon where you want the structure to touch: Pick the point where the structure touches the bounding polygon.
Choose the point on the structure that you want to touch the bounding polygon: Pick the point on the structure that touches the bounding polygon.

If choosing a structure corner as the point to touch the bounding polygon, you should use the end point snap. If you do not use end point snap, the translation of the point picked to the bounding polygon will likely cause the corner of the structure to encroach. You can specify end point snap when picking the point on the structure by typing in "end" and Enter at the prompt, then you merely need to pick a point on the structure near the desired corner to actually specify the corner point.

Note: If the translating the structure to make the selected point touch the bounding polygon at the selected point would cause an encroachment, an error message will be displayed, no changes will be made, and you will return to the Adjust Structure ... prompt.

Completing the adjustment process

Once you are satisfied with the location of the structure type D and Enter and you will see the following prompt:

Creating structure coordinate points:
Enter description for structure corner points <footprint.pt>:

You can accept the default description shown in brackets by pressing Enter or you may type in a description that will help you identify this particular structure and lot.
The corner and any radius points for the current location of the structure are stored in the current coordinate file and, if Auto plot points is ON, the points are drawn.
After storing the points for the previously placed structure you will see the following prompt:

Choose a structure template [Set template/Current Template/Mirror current/Done] <C>:

Press Enter or C and Enter if you wish to repeat the process and place the current structure template in the same or another bounding polygon.
If you wish to place a mirrored ("reverse") version of the current structure template in a bounding polygon, type M and Enter.
If you wish to place a different structure in a bounding polygon, type S and Enter to bring up the Template Manager, allowing you to pick a new template.
If you are done placing templates for now, type D and Enter for Done.
At any time you may adjust an existing structure by choosing Fit Structure. If there are existing structures in the drawing, it will be detected and the following the prompt will appear at the command line:

Pick existing structure to adjust or choose a structure template.
[Set-template/Current-template(Wilson)/Mirror-current/Done] <C>:

At this prompt you can use the mouse to pick an existing structure to adjust. You can now use any of the adjustment methods described above to further refine the location of the structure. After the adjustment process is
complete the coordinate file is updated to reflect the adjusted locations of the structure's corner and radius points.

**Note:** When you pick an existing structure, any plotted corner point symbols are temporarily removed to facilitate the adjustment process. Once you are done adjusting the existing structure, these points are re-plotted at their new adjusted locations.

At this prompt you may also choose to place a new structure in a bounding polygon. To use a different template, type S and Enter to bring up the Template Manager and allow to choose the desired template. If you have already placed a template in the current drawing session, the prompt will indicate the current template. By typing C and Enter or just pressing Enter you can choose to place the current template in a bounding polygon or you can type M and Enter to place a mirrored version of the current template:

**Prompts**

**Template Manager dialog:** create or choose a template to place within a bounding polygon (a lot)

**Add a Template dialog:** Used in conjunction with the Template Manager dialog to add a template to a given project.

if you have already specified a template to use but no templates have been placed in the drawing:

Choose a structure template

[Set template/Current template (Wilson)/Mirror-current/Done] <C> : Type "S" and Enter to bring up the Template Manager dialog. Type "C" and Enter or just Enter to use the current template. Type "M" and Enter to mirror the current template. Type "D" and Enter when done placing templates.

if a structure/template exists in the drawing or you have already specified a template to use:

Pick existing structure to adjust or choose a structure template.

[Set-Template/Done] <S>: To adjust an existing structure pick it on the screen. Type "S" and Enter or just Enter to bring up the Template Manager dialog to choose a new template. Type "D" and Enter when done.

after you set a new template or chose to use the current one:

Pick the lot within which the structure will be placed [c&g-Point-group/Done] <pick>: pick the polyline or a series of lines that define a closed polygon within which the structure template will be placed. Type P and Enter to specify the bounding polygon using a C&G Point Group file.

Place the structure near its final location in the bounding polygon <pick>: Drag the structure template to the desired location and click the left mouse button to place the structure.

after you place a template or pick one to adjust:

Adjust structure [Move/Step-move/step-Rotate/roTate/rot-Ninty/Parallel/On-boundary/setUp/Done] <D>: Type "M" and enter to move the structure. Type "S" and Enter to use the arrow keys to move the structure in predefined steps. Type "T" and Enter to use the cursor to rotate the structure. Type "R" and Enter to rotate the structure template a predefined number of degrees using the up and down arrow keys. Type "N" and Enter to rotate the structure 90 degrees clockwise. Type "P" and Enter to translate and rotate the structure template parallel to a side of the bounding polygon. Type "O" and Enter to move the structure template so a chosen point on the structure touches a chosen point on the bounding polygon. Type "U" and enter to use the Setup dialog to change the step sizes, layer names and other configuration items for the fit structure command.

when saving the structure coordinate points:

Enter description for structure corner points <footprint.pt>: Specify a description for the structure template corner points to be saved in the coordinate file or just press Enter to use the default description.
Fit Structure Setup

The parameters used for translating and rotating are set using the Fit Footprint Setup dialog. To bring up the Fit Footprint Setup dialog, type U and <Enter>

The Honor setback lines checkbox should be checked if you do not want to permit the structure footprint to be moves outside the bounding polygon.
To have instantaneous dimensions shown from each corner of the structure to the nearest side of the bounding polygon, check the Show Setback Dimensions checkbox.

Translate Step: This value defines the amount the structure will move each time you press an arrow key when adjusting the structure using the Small Steps mode.
Rotation Step: This value defines the number of minutes of arc the structure rotates each time the arrow key is pressed while adjusting the structure using the step Rotate mode.

Choose the layer to place the structure on.

Specify the layer that the imported templates will be on.

Specify the default point description to use when footprint corners are saved to the coordinate file.

Stake-Out

The Stakeout feature allows you to calculate the required information for either a radial stakeout or staking out using angles right.

Angles Right

This feature is similar to the Radial Stakeout feature except it allows you select the foresight points one at a time.

If a coordinate file is not open, a file dialog will appear, allowing you to open an existing coordinate file.
After following the prompts outlined below, the angle from the backsight point, the distance, the frontsight point ID, the azimuth and the description are printed at the command line and written to the print file.
You may press <F2> to view the complete listing of angles and distances.
Repeat the prompt sequence as many times as are required.
Press <Enter> or type D and <Enter> when done.

Prompts

Enter the instrument point. [Done]: Type or pick the instrument point.
Enter backsight point. [Done]: Type or pick the backsight point.
Enter foresight point. [Done]: Type or pick the foresight point.

Pulldown Menu Location: CG-Survey > Cogo > Stake-Out
Keyboard Command: cg_ar
Prerequisite: coordinate file

Radial Stake Out
This feature allows you to obtain the angles required to stakeout several foresight points from a single instrument point.

If a coordinate file is not open, a file dialog box will appear, allowing you to open an existing coordinate file. 
After following the prompts outlined below, the angles right from the backsight point, the distances, the foresight point IDs, the azimuths and the descriptions for all the selected points will be printed at the command line and written to the print file.
You may press <F2> to view the complete listing of angles and distances.
Repeat as necessary for as many setups as are required.
When done, press <Enter> to end the command.

Prompts
Choose initial points for base selection set from coord file. (Enter when done)
[All/Block/Code/Desc/Elev/Pt_group/Limits/Radius/Select]: Use one of several methods to specify the points in the coordinate file to be staked out.
Enter the Instrument point [Done]: Type or pick the instrument point.
Enter backsight point [Done]: Type or pick the backsight point.

Pulldown Menu Location: CG-Survey > Cogo > Stake-Out
Keyboard Command: cg_rso
Prerequisite: coordinate file

Best Fit
The best fit feature uses a least squares algorithm to compute the best fit line or circle for the points selected. The user can assign a weight to each point that is between 1 and 15, a point with a weight of 15 acts as if there are 15 of the points at the same location and thus skews the fit closer to that point. This is done to skew the result in favor of certain points. A weight of 0 means do not adjust this point or give it "infinite" weight.

When you choose Best Fit from the CGCogo menu you will see the following prompt:
Enter the type of best fit problem [Line/Arc/Tan-arc-tan] <L>:
Best Fit Line:
Press <Enter> for Line to calculate the best fit line through a series of points. In the example in the figure below, 2075 is an Iron Pin Found that we do not want adjusted, so the weight will be set to 0.
Enter a point ID or pick a point symbol on the line: for the example, type or pick 2075
Enter weight for point 2075 <1>: for the example type 0 (zero) and <Enter>
Enter a point ID or pick a point symbol on the line: for the example, type or pick 2076
Enter weight for point 2076 <1>: for the example, type 8 and <Enter>
Continue entering point ID - weight pairs until done then press <Enter> when asked for the next point ID.
The point locations and weights will be used to compute the best fit line.
The results, a list of the point IDs entered and their offsets from the best fit line and the bearing of the line, is printed at the command line and written to the print file.
Printed output for the line example
Pt.: 2075 Wt.: 0 Offset: 0.000 RT
Pt.: 2076 Wt.: 8 Offset: 5.360 LT
Pt.: 2077 Wt.: 3 Offset: 3.411 RT
Pt.: 2078 Wt.: 6 Offset: 1.915 RT
Pt.: 2079 Wt.: 2 Offset: 6.326 LT
Pt.: 2079 Wt.: 2 Offset: 6.326 LT
Pt.: 2080 Wt.: 4 Offset: 1.093 RT
Pt.: 2081 Wt.: 4 Offset: 0.986 RT
N: 6354.64727 E: 8112.07615 Dir: N 88°30'32"E
N: 6366.14982 E: 8553.96369 Dir: S 88°30'32"W
At the [Edit/Ok/Quit] <0>: prompt:
If you are satisfied with the results, press <Enter> for Ok and the endpoint coordinates will be computed and saved.
For each point saved, the Saving Point dialog (see below) will be shown.

Clicking OK will cause the point to be saved to the coordinate file.
If, on the other hand, you wish to edit the input data, type E and <Enter>. You see the following prompt:

[Add/Change/Delete/eXit]:
Add - add another point to the calculation
Change - change the weight of one of the points
Delete - remove one of the points from the calculation
eXit - when done editing.
If you wish to cancel the command without calculating the line type Q and <Enter>.

Best Fit ARC:
This option allows you to calculate the best fit arc through a series of points. As with the Line option, each point can be weighted from 0 (no adjustment) to 15.
At the the Enter the type of best fit problem prompt, type A and <Enter> to choose the Arc option.
Enter the point ID - weight pairs as in the Line option.
When all the point ID - weight pairs have been entered press <Enter> at the Enter or Pick a C&G point on the line prompt.
A table of the results similar to that for the Line option will be displayed at the command line.

Output for the example in shown in the figure

Pt.: 2083 Offset: 2.862 OUT
Pt.: 2084 Offset: 3.699 IN
Pt.: 2085 Offset: 3.608 OUT
Pt.: 2086 Offset: 6.280 IN
Pt.: 2087 Offset: 5.584 OUT
Pt.: 2088 Offset: 1.393 IN
N: 6369.30690 E: 8269.70677 RAD: 237.282

The [Edit/Ok/Quit] <O>: prompt and its options for editing the input data are explained in the section on the Line option.

If you are satisfied with the results, press <Enter> for Ok and the PC, PT and radius point of the best fit arc will be saved to the coordinate file using the Saving Point dialog.

Tan-arc-tan:
This option allows you to calculate a combination of the best fit tangent line going into a curve, the best fit arc for the curve itself and the best fit tangent line out of the curve through a series of points defining two tangent lines and an arc.

The two tangent lines are calculated using a least squares solution and then the best fit arc is calculated. The method used to find the best fit arc is to calculate a radius and radius point for each point on the arc using a function that calculates a curve between tangents through a known point. Each radius and radius point is weighted based on the central angles between the PC, point-on-arc and PT points. The larger the central angles, the higher the resulting weight will be. All the calculated radii and radius points are then averaged. It is not necessary that you locate the actual PC or PT points in the field.

At the prompt
Enter the type of best fit problem [Line/Arc/Tan-arc-tan] <L>: 
First you must enter the points on the 1st tangent line. At the series of prompts to:
Enter a point ID or pick a point symbol on 1st tangent:
and
Enter weight for point XXXXX <1>: enter the point ID - weight pairs for the tangent going into the curve.
When done entering the tangent line points, press <Enter> when asked for the next point.
Next at the series of prompts:
Enter a point ID or pick a point symbol on the arc:
enter the points for the arc. Weights for these points are calculated by the program.
In the example shown in the figure, there are 2 points defining the first tangent, 3 points defining the arc and 2 points defining the tangent out.

Output for example shown in figure
Pt.: 2210 Wt.: 0 Offset: 0.000
Pt.: 2211 Wt.: 5 Offset: 0.000
N: 6512.07291 E: 8572.91824 Dir: N 45°00'00''E
N: 6567.12692 E: 8627.97226 Dir: S 45°00'00''W
Pt.: 2212 Wt.: 5 Offset: 0.000 LT
Pt.: 2213 Wt.: 1 Offset: 0.000 LT
N: 6585.04757 E: 8796.89599 Dir: S 45°00'49''E
N: 6505.88861 E: 8876.09255 Dir: N 45°00'49''W
Pt.: 2214 Offset: 1.736 OUT
Pt.: 2215 Offset: 3.232 IN
Pt.: 2216 Offset: 2.324 OUT
N: 6492.00101 E: 8721.39653 RAD: 119.183

The [Edit/Ok/Quit] <O>: prompt following the output is explained in the Line option.
If you are satisfied with the results press <Enter> for Ok.
The coordinates for the endpoints of the tangents and PC, PT and radius point of the curve are computed and saved to the coordinate file using the Saving Point dialog.

Prompts

**Enter the type of best fit problem [Line/Arc/Tan-arc-tan] <L>:** Type "L" and Enter or just Enter for a best fit line, "A" and Enter for a best fit arc or "T" and Enter for the best fit of a curve with two straight tangents in and out.

For a best fit line or arc:
**Enter or Pick a C&G point on the line (or Arc):** Type a point ID or pick a point symbol on the screen. Repeats until all points are entered and the user presses Enter at this prompt.
Enter weight for point <###> <1>: Enter a number between 0 and 15 (0 = infinite weight).

For best fit tan-arc-tan:
Enter a point ID or pick a point symbol on 1st tangent: Enter or pick as many points and weights as desired for the first tangent line.
Enter a point ID or pick a point symbol on the arc: Enter of pick as many points as desired for the arc (weights are determined by the program).
Enter a point ID or pick a point symbol on 2nd tangent: Enter or pick as many points and weights as desired for the second tangent line.

[Edit/Ok/Quit] <0>: Type "E" and Enter if you wish to change the weight of a point or add or delete points. Type "O" and Enter or just Enter to calculate the best fit line, arc or line-arc-line and store its defining points in the coordinate file. Type "Q" and Enter to quit without calculating the best fit points.

[Add/Change/Delete/eXit]: if you choose Edit then this prompt allows you to Add a point, Change a weight, or Delete a point. When done editing press "X" and Enter to return to the Edit/Ok/Quit prompt.

Pulldown Menu Location: CG-Survey > Cogo
Keyboard Command: cg_bfit
Prerequisite: Coordinate file.

Resection
The Resection submenu allows you to calculate the location of an unknown point given angles and/or distances from known points to the unknown point.

Pulldown Menu Location: CG-Survey > Cogo
Keyboard Command: None

Angle Resection
An angle resection is used to calculate the location of an unknown point given the angles turned from it to 3 known points.

Is middle known point on near side of line between other two known points? [Yes/No] <Yes>: Answer yes or no. For the example, type N and <Enter> since the third known point (2222) is on the far side of the line in relation to the unknown point.
Enter first known point: for this example enter 2221.
Enter second known point: for this example enter 2222
Enter angle at unknown point turned from first point to second point: for this example enter 30.1112 (for 30°11'12'')
Enter third known point: enter 2223 for the example
Enter angle at unknown point turned from second point to third point:
In the example enter 58.1741 for 58°17'41".
The resulting calculated point is then saved to the coordinate file using the Saving Point dialog shown below.
Click OK to save the point to the coordinate file.

**Prompts**

**Is middle known point on near side of line between other two known points? [Yes/No] <Yes>:** Type "Y" or press Enter or "N" and Enter.

**Enter first known point:** Type the point ID or pick from the screen.

**Enter second known point:** Type the point ID or pick from the screen.

**Enter angle at unknown point turned from first point to second point:** Enter the angle.

**Enter third known point:** Type the point ID or pick from the screen.

**Enter angle at unknown point turned from second point to third point:** Enter the angle.

**Pulldown Menu Location:** CG-Survey > Cogo

**Keyboard Command:** cg_ang_resect

**Prerequisite:** coordinate file

---

**Distance Resection**

Enter point ID for observation #1 [Quit]: for the example enter 2230

Enter distance for observation #1: for the example enter 114.81

Enter vertical angle for observation #1 <90.000000>: For the example press <Enter> to accept the default of 90°00'00''

Enter point ID for observation #2 [Quit]: Enter 2232 for the example

Enter distance for observation #2: Enter 92.84 in this example.

Enter vertical angle for observation #2 <90.000000>: For the example press <Enter> to accept the default of 90°00'00''
Continue entering point ID, distance, vertical angle triplets until all observations have been entered. When done press <Enter> when asked for a point ID.
The standard deviation of the calculated data will be printed at the command line (for this example: Standard Deviation: 0.049)

Prompts

Enter point number for observation #XXX [Quit]: Type a point ID or pick a point symbol on the screen.
Enter distance for observation #XXX: Enter or pick the distance.
If slope distance/vertical angles are on:
Enter verticle angle for observation #XXX <90.000000>: Enter the vertical angle.

Pulldown Menu Location: CG-Survey > Cogo
Keyboard Command: cg_dist_resect
Prerequisite: coordinate file

Triangulation

This feature allows you to calculate the location of an unknown point given the angles at the 3 vertices of the triangle formed by the 2 known points and the unknown point.

Enter the point ID of the first known point then the point ID of the 2nd known point (the backsight) and the measured horizontal angle to the unknown point. Do the same for the 2nd known point backsighting the 1st known point. Next, if available, enter the angle between the 2 known points with the instrument at the unknown point. The standard deviation and other information for the calculation will be printed at the command line and written to the print file.
The calculated point will be saved to the coordinate file using the Saving Point dialog (Shown Below).
Prompts

Enter first instrument point: Enter a point ID or pick a point symbol on the screen.
Enter first backsight point:: Enter a point ID or pick a point symbol on the screen.
Enter first horizontal angle to unknown point: Enter an angle.
Enter second instrument point: Enter a point ID or pick a point symbol on the screen.
Enter second backsight point: Enter a point ID or pick a point symbol on the screen.
Enter second horizontal angle to unknown point: Enter an angle.
Enter horizontal angle at unknown point or <skip> <0.000000>: Enter an angle if available or press Enter to skip.

Pulldown Menu Location: CG-Survey > Cogo
Keyboard Command: cg_triangulation
Prerequisite: coordinate file

NAD83
This feature allows you to convert longitude and latitude to and from NAD83 state plane coordinate systems.
NOTE: Do not use this function for any other coordinate system, i.e. NAD 1927. Make sure the correct state is selected on the General tab of the C&G Options dialog box.

After choosing the NAD83 menu item from the CGCogo menu you will be prompted for the necessary data.
At the Enter zone prompt enter the letter for the appropriate zone for the area where the survey was performed. The
zones allowed may vary by state.

[Coords to longitude-latitude/Longitude-latitude to coordinates] <C>:

**Coords to longitude-latitude**

Pressed <Enter> (or type C and <Enter>)
you will be asked to select the points.
After selecting points a table of longitude-latitude and related data for the points will be printed at the command line

**Longitude-latitude to coordinates**

Type L and <Enter>,
You will be asked to enter the longitude and latitude of the points you wish to calculate
When you have entered the final longitude-latitude pair press <Enter> when asked for the next latitude.
The computed points will be stored in the coordinate file using the Saving Point dialog shown below.

![Saving Point dialog](image)

Click OK to save the point to the coordinate file.

Repeat until done or press <Enter> to end the command.

**Prompts**

**Enter zone (E, W):** enter the letter for the appropriate zone for the area where the survey was performed. The letters allowed will vary depending on the state.

[Coords to longitude_latitude/Longitude_latitude to coords] <C>: Type "C" and Enter or just Enter to calculate coordinates given longitude and latitude. Type "L" and Enter to do the reverse.
if you chose Coords to longitude-latitude:

Choose initial points for base selection set from coord file. (Enter when done)

[All/Block/Code/Desc/Elev/Pt_group/Limits/Radius/Select]: Use the various selection methods to choose the
points for which you wish to calculate longitude and latitude

if you chose Longitude-latitude to Coords:

Enter latitude [<Enter> when done]: Enter the latitude angle for a longitude - latitude pair.
Enter longitude: Enter the longitude angle for a longitude - latitude pair.

Pulldown Menu Location: CG-Survey > Cogo
Keyboard Command: cg_nad83
Prerequisite: coordinate file

Solar Observation
This feature allows you to calculate bearings to a mark based on true north or grid north by solar observation. It
uses the Local Hour Angle (LHA) method. The routine calculates ephemeris data, obviating the need to use a solar
ephemeris.

Note: There is a description of solar observation field procedures at the end of this section.

Before using this feature, select the correct state on the Global Options tab of the C&G Options dialog.
All fifty states are available, as well as PR for Puerto Rico and UTM for Universal Transverse Mercator. If you are
making a UTM conversion, be sure to select the correct hemisphere - also on the Global Options tab.

After choosing the Solar Observation menu item, you will see the prompt:

Type of calculation [True-north/true-north-and-Grid-bearing] <T>:

True-north
This option allows you to calculate the true north bearing to the mark. This option requires no zone/ellipsoid
information.
Type T and Enter or just Enter for True-north.

Field method used [Leading-edge/Trailing-edge/Center] <C>: type C and Enter or just Enter for Center,
L and Enter for Leading edge, or T and Enter for Trailing edge.

Date of Observation (MM/DD/YY or MM-DD-YYYY): enter date in one of the specified formats (for the
example enter 05-23-2004).

Enter Latitude of instrument point: Enter the latitude (for example enter 35.2314).
Enter Longitude of instrument point: Enter the longitude (for example enter 85.124)

Observation 1. Time of observation (hh.mmssss) <Enter when done>: Enter hours using 24 hour clock
(15.462368 - 3:46 and 23.68 sec PM)
Continue entering the longitude, latitude and time of observation until all have been entered.

When all are entered, press Enter when asked for the next longitude.

The example input data will generate the following output at the command line:

No. Time Angle-@-Mark Angle-to-Sun True-Brg-to-Mark
1 10.134300 45°32'16'' 97°21'45'' N 09°02'08''E
2 10.154400 45°32'16'' 97°22'51'' N 09°19'19''E
3 10.180300 45°32'16'' 97°44'36'' N 09°18'29''E
Average True Bearing: N 09°13'19''E

After the input data is displayed on the command line, you will see the prompt:

[Edit/Ok/Quit] <O>:

Type E and Enter to change, remove or add an observation.
Type O and Enter or Enter to print the resulting solar observation data to the print file and end the command.
Type Q and Enter to cancel the command.

**True north and grid bearing**
The True north and grid bearing option calculates both true north and grid bearings to the mark. The convergence angle is also calculated.

After typing G and Enter, you will see the **Solar Observations - State** dialog:

![Solar Observations - State Dialog](image)

After choosing which state the observations were made in, click **OK** or press Enter.

If your state is divided into zones you will be asked to enter the zone you are working in. The possible entries will be shown at the prompt.
For example, in Texas the prompt be:

**Enter Zone (N, NC, C, SC, S):**

If you are using a UTM, you will see the following prompt: **Enter ellipsoid to use [GRS-1980/Other]**
if you typed O and Enter for Other, you will see the following prompt: **Ellipsoid constant [Reciprocal flattening/Semi-minor axis/ellipsoid ECC squared]** <R>:
Type R and Enter or just Enter for Reciprocal flattening, S and Enter for Semi-minor axis, or E and Enter for ellipsoid ECC squared.
Depending on what was entered at the last prompt you will see one of the following prompts: **Enter reciprocal flattening constant**: Type the constant.
**Enter semi-minor axis**: Enter the axis.
**Enter ellipsoid ECC squared constant**: Enter the constant.
From this point on, the data input is the same as for **True-north** outlined above.

**Note**: With the exception of UTM, all calculations are based on the GRS 1980 Ellipsoid.

### Field Procedures for the Local Hour Angle (LHA) method

This section explains Universal Time and then explains two ways of pointing, Trailing Edge Tangency and Roelofs Prism.

**Universal Time**
The Universal Time can be obtained on certain radio bands. On the radio channel there will be a signal beep every minute. Set a watch to the Universal Time or, when in the field, start a stopwatch at the beep (for a known Universal Time).

In order for the solar observation method to produce accurate results, it is essential that you record the precise Universal Time for an observation. Thus, when making the field observations, record the stopwatch elapsed time in order to calculate the Universal Time or, if you set your watch to Universal Time, record the time directly.

**Trailing Edge Tangency**
While pointing at the ground mark, set the horizontal circle to read about 00-00-30, perfect pointing. With the scope direct, record the horizontal circle reading to the mark.
Attach the eyepiece filter and sight the sun. After locating the sun, do the following:
Set the horizontal reticle line near the center of the sun's image with the vertical reticle line leading the trailing edge of the sun (slightly right for a direct image).
Clamp the horizontal motion and watch the image of the sun as the trailing edge approaches tangency with the vertical reticle line.
Stop the timer at the time of tangency.
Record the time and the horizontal circle reading.
Repeat the pointing for a total of four pointings in the direct position.
Unclamp the horizontal motion, rotate the instrument 180 degrees, plunge the scope, and then obtain data for four reverse readings.
Unclamp the horizontal motion, point at the ground mark with the instrument reverse and record the horizontal circle.
The timer must be checked-in on a radio signal. Some quartz regulated electronic watches are accurate for extended periods of time, allowing several hours of check-in to check-out on the radio. Otherwise, most timers should be started and stopped on a radio signal at the beginning and ending of the observation set.

**Roelofs Prism**
Attach Roelofs prism and sight the sun (you can center the shadow of the telescope between the standards as an aid in locating the sun). Be sure that the hinged tube is closed when pointing at the sun. After locating the sun through
the scope, do the following:
Rotate the prism until the four overlapping images of the sun are symmetrical with the instrument's reticle lines.
Point on the ground mark with the instrument direct and the Roelofs prism tube swung open, perfect pointing on
the ground mark. Record the horizontal circle reading to the mark.
Point at the sun with the prism closed. After locating the sun, do the following:
Set the horizontal reticle line near the center of the sun's pattern with the vertical reticle line leading the center of
the moving pattern (slightly to right of the sun for direct optics).

Clamp the horizontal motion and watch the pattern move to the point of coincidence. This is the intersec-
tion of the vertical reticle line with the apex of the small dark square formed in the center of the pattern by the
overlapping parts of the four images formed of the sun.
Stop the timer at the moment of coincidence.
Record the time and the horizontal circle reading.
Repeat the pointing for a total of four readings in the direct position.
Unclamp the horizontal motion, rotate the instrument 180 degrees, plunge the scope, and then obtain data for four reverse readings.
Unclamp the horizontal motion, point on the ground mark with the instrument reversed and record the angle on the
horizontal circle.
The timer must be checked-in on a radio signal. Some quartz regulated electronic watches are accurate for extended
periods of time, allowing several hours of check-in to check-out on the radio. Otherwise, most timers should be
started and stopped on a radio signal at the beginning and ending of the observation set.

Prompts

Type of Calculation [True-north/true-north-and-Grid-bearing <T>]:
Type "T" and Enter or just Enter for True north. Type "G" and Enter for true north and grid bearing.

For True north and grid bearing:
Enter Zone (N, NC, C, SC, S): Enter the zone (this prompt varies by state - example is for Texas).
Enter ellipsoid to use [Grs_nineteen_eighty/Other] <G>: This prompt only appears when using a UTM conversion.

if you choose Other in the previous prompt:
Enter semi-major axis: Enter the value.
Ellipsoid constant [Reciprocal_flattening/Semi_minor_axis/Elipsoid_ecc_squared] <R>: Type "R" and Enter or
just Enter for Reciprocal flattening, "S" and Enter for Semi-minor axis and "E" for ellipsoid ECC squared.

Depending on what was entered at the last prompt you will see one of the following prompts:
Enter reciprocal flattening constant: Type the constant.
Enter semi-minor axis: Enter the axis.
Enter ellipsoid ECC squared constant: Enter the constant.

For both methods:

Field method used [Leading edge/Trailing edge/Center] <C>:
Type "C" and Enter or just Enter for Center. "L" for leading edge method or "T" for trailing edge method.

Date of Observation (MM/DD/YY or MM-DD-YYYY): Type the date of the observation in one of the
two formats specified.

**Enter Latitude of instrument point:** Enter the latitude.

**Enter Longitude of instrument point:** Enter the longitude.

**Observation #. Time of observation (hh.mmssss) <Enter when done>:** Enter the time using 24 hour clock.

[Edit/Ok/Quit] <O>: Type "E" and enter to edit the input data, "Q" to quit the command, or "O" and Enter or just Enter to continue with the calculations

**Pulldown Menu Location:** CG-Survey > Cogo  
**Keyboard Command:** cg_solar_obs  
**Prerequisite:** select the correct state and, if using UTM, the correct hemisphere on General tab of C&G Options dialog

**Public Land Section**  
**Section Subdivision**  
This feature allows you to calculate locations for as many corners as possible given the specified known points.

Choosing the Section Subdivision menu item will cause the following dialog to appear:
First, the Section:, Township: and Range: must be entered.
Next, make sure the radio button in the Specify Field Located Corners area of the dialog is set to Section & Quarter Corners. Then, in the appropriate edit boxes, enter the point IDs for all of the section and quarter section corners that you have located in the field.
If you have field located any 1/16th section corners, then set the radio button in the Specify Field Located Corners portion of the dialog to 1/16th Corners and enter the point IDs of those corners on the section diagram.
When done entering the point IDs of the field located corners, you must specify the Government Chainage for the indicated distances (these will vary depending on the section being entered - in some cases no chainages are required).
When done entering the data, click Ok. If there is insufficient data a dialog will inform you of that and return you to the Section Subdivision dialog.
If the data is sufficient for one or more unknown corners to be calculated, then as many of the unknown corners as possible will be calculated.
The Saving Point (see below) will appear for each newly calculated corner.

In this dialog you can accept the default point ID for each new corner by clicking OK, or you may change them.

**Prompts**

**Section Subdivision dialog:** Enter the information as specified above.

**Pulldown Menu Location:** CG-Survey > Cogo > Public Land Section

**Keyboard Command:** cg_section_subd

**Prerequisite:** coordinate file
GLO-Corner-Proportioning

The features available through the GLO-(Government Land Office)-corner proportioning submenu allow you to calculate Section and 1/4 Section corners using both GLO and field data. There are four methods of performing Government Land Office section corner proportioning:

One Way Control
Two Way Control
Three Way Control
Four Way Control

One Way Control

The calculated point will be stored in the coordinate file using the Saving Point dialog below.

Click OK to save the point to the coordinate file.

Prompts

GLO Proportioning One Way Control dialog: Enter the information and Click OK. Point "X" will be calculated.

Pulldown Menu Location: CG-Survey > Cogo > Public Land Section
Keyboard Command: cg_glo_one_way
Prerequisite: coordinate file

Two Way Control

The calculated point will be stored in the coordinate file using the Saving Point dialog below.

Prompts

GLO Proportioning Two Way Control dialog: Enter the information and click OK. Point "X" will be calculated.

Pulldown Menu Location: CG-Survey > Cogo > Public Land Section
Keyboard Command: cg_glo_two_way
Prerequisite: coordinate file

Three Way Control
The calculated point will be stored in the coordinate file using the Saving Point dialog below.

Click OK to save the point to the coordinate file.

**Prompts**

GLO Proportioning Three Way Control dialog: Enter the information and click OK. Point "X" will be calculated.

**Pulldown Menu Location:** CG-Survey > Cogo > Public Land Section

**Keyboard Command:** cg_glo_three_way

**Prerequisite:** coordinate file

**Four Way Control**

Enter the point IDs for the points A, B, C and D located in the field or click on a point edit box then click the Pick < button to pick the point on the screen.

Enter the indicated *distances in chains* in the edit boxes.
Click OK when the data has been entered.

The unknown point location will be calculated.

The calculated point will be stored in the current coordinate file using the **Saving Point** dialog below.

![Saving Point Dialog](Image)

**Prompts**

**GLO Proportioning Four Way Control Dialog:** fill in the dialog and click **OK**.

**Pulldown Menu Location:** CG-Survey > Cogo > Public Land Section

**Keyboard Command:** cg_glo_four_way

**Prerequisite:** coordinate file

**CGDraw**

**Drawing Settings**

See CG Options... menu item in the Tools menu.
Set Line Type

To use a line type it must be loaded and it must be the current line type. The current line type will be used for any lines or polylines drawn. The Set Line Type feature allows you to load line types from any line type file (*.lin) and to specify the currently active line type. It gives you easy access to the most commonly use line type files while allowing you to access any line type file available to you.

Prompts

Clicking the Set Line Type menu item brings up the Line Types dialog: By default the dialog displays the acad.lin line type file contents (CgSu.lin in the standalone version of CGSurvey).

By clicking the AutoCAD/IntelliCAD ISO button: you can view the acadiso.lin file line types (CgSu-iso.lin in the standalone version of CGSurvey).

By clicking the C&G button: you can view the custom line types created for CGSurvey (in CgLinedefs.lin). You may also use the Browse... button to view and load line types from other line type files.

To load a line type: pick the file the line type is in, highlight the desired line type, then click the Load button. Notice that the status column now indicates that the line type is "Loaded".

To make the highlighted line type current: click the Set Current button. The status column now reads "Loaded (C)", indicating that the line type is loaded and it is the currently active line type.

You can load a line type and make it current: by double-clicking it. If it is already loaded, double-clicking will make it current.

The Cancel button: returns the current line type to what it was before the command was run.

Click the Done button: to close the dialog.

Global Edit

Global Edit allows you to make several changes to one or more entities, in one operation.
Prompts

After selecting Global Edit from the CGDraw menu you will be asked to specify the method of entity selection at the command line:

**Screen:** This option allows you to use any of the standard mouse based CAD selection methods.

**Points:** Allows you to select C&G points using the standard C&G selection methods. Checking a given check box activates that section of the dialog box and allows you to make the desired changes.

**Done:** When finished selecting the entities enter "D" for done this will bring up the Dialog box.

There are five basic sections in this dialog

**All**
checking this checkbox is just a fast way of checking all the checkboxes and thus allows you to edit all of the properties of the selected entities. All of the editable items for the entities selected will have their checkboxes checked.

**CAD properties**

<table>
<thead>
<tr>
<th>AutoCAD properties</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Layer</td>
<td>CG_BREAK_LINES</td>
</tr>
<tr>
<td>Color</td>
<td>ByLayer</td>
</tr>
<tr>
<td>Font/Style</td>
<td>STANDARD</td>
</tr>
<tr>
<td>Text Size</td>
<td>0.14 inches</td>
</tr>
</tbody>
</table>

**Layer**: change the layer of the items selected  
**Color**: Change the color of the items selected  
**Font/Style**: Change the font style to another existing font style.  
**Text Size**: Change the current Text size (this setting is in inches)

**Lines**

<table>
<thead>
<tr>
<th>Lines</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Linetype</td>
<td>CONTINUOUS</td>
</tr>
<tr>
<td>Line Scale</td>
<td>15</td>
</tr>
<tr>
<td>Line Stop</td>
<td>0 inches</td>
</tr>
</tbody>
</table>

**Linetype**: set the linetype for the lines selected. Pressing the down arrow will bring up a list of all of the available linetypes.  
**Line Scale**: This allows you to set the length of the pattern.  
**Line Stop**: This allows you to set the line stop. This item will only be activated if a C&G line was chosen.
Line stop is a C&G parameter that allows you to stop the line short of the point symbol plotted at the point location thus the line can be made to not go through the symbol. For example, if you were plotting 0.10 diameter circles for property corners, you could set the line stop to .10. This would cause a C&G line drawn to the property corner to end .05 plotted units short of the actual corner and thus not cross the property corner point symbol.

**Calls**

![Calls Table]

**Distance precision:** From the pull down select the number of decimal places to be displayed.

**Angle precision:** From the pull down simple select the angle precision you need.
Points

This portion of the Global Edit dialog allows you to change various aspects of point symbols:

Symbol: from the pull down select the new symbol to use.
Symbol Size: set the symbol size (in inches or cm)
Point Label Size: Set the point label size (in inches or cm)
Point Label Position: Displays the point label configuration dialog box, set the options as needed.
Elevation Places Displayed: set the number of places to be displayed.

Pulldown Menu Location: CG-Survey > CGDraw>Global Edit
Keyboard Command: GE, CG_GLOBAL_EDIT
Prerequiste: Coordinate file

Legend

This feature allows you to configure and draw a legend for your drawing.
LEGEND

- IPS
- IFF
- IPF & d. RR
- IFF CMP
- IPF Axe
- CMF
- Property Line
- Fence Line
- Utility Pole
- Guy Wire
- Light Pole
- Water Line
- Fire Hydrant
- Water Valve
- Tree
- Head Wall
- Junction Box
- Well Inlet

Prompts

The first step is to create a new legend or use a saved legend file (*.lgd).
If you choose to create a new file by clicking the New tab, you will be asked to select the directory location and the name of the file you wish to create. Or, you can open an existing file by clicking the Existing tab. Once you have specified a file to open or create, click the Open button.

Legend Definitions

The Legend Definitions dialog box provides tools for generating a legend.

<table>
<thead>
<tr>
<th>Symbol name</th>
<th>Description</th>
<th>Include</th>
</tr>
</thead>
<tbody>
<tr>
<td>C901</td>
<td>IPS</td>
<td>Yes</td>
</tr>
<tr>
<td>C901</td>
<td>IPF</td>
<td>Yes</td>
</tr>
<tr>
<td>C901</td>
<td>IPF # 4 RPR</td>
<td>Yes</td>
</tr>
<tr>
<td>C901</td>
<td>IPF HWP</td>
<td>Yes</td>
</tr>
<tr>
<td>C901</td>
<td>IPF Axle</td>
<td>Yes</td>
</tr>
<tr>
<td>C902</td>
<td>CMF</td>
<td>Yes</td>
</tr>
<tr>
<td>LTYPE (DIVIDE)</td>
<td>Property Line</td>
<td>Yes</td>
</tr>
<tr>
<td>LTYPE (FENCE)</td>
<td>Fence Line</td>
<td>Yes</td>
</tr>
<tr>
<td>C904</td>
<td>plus</td>
<td>Yes</td>
</tr>
<tr>
<td>C902</td>
<td>Utility Pole</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Edit and Add buttons: Clicking either the Edit or Add button will open the dialog box shown here. The edit option will allow you to make changes to an existing definition, add will create a completely new definition.

Symbol Definitions
Symbol Name: designates the symbol to draw in the legend. You can either type in a point symbol name or choose a point symbol, linetype, or hatch pattern by clicking one of the Select... buttons.

Description: is the text that will appear in the legend next to the point symbol, linetype or hatch pattern. The Hatch Scale and Color are used if the symbol is a hatch pattern

Include in Legend: This checkbox corresponds to the Include column entry in the Legend Definitions dialog box.

Note: Not all defined entries must be included in the legend.

Select Point Symbol: this button displays images of the point symbols you may choose from. Note that the Symbol Category, list helps narrow the selection of available symbols.
Select Drawing Linetype button: Clicking this button displays the linetypes already defined in the drawing.

Select Library Linetype button: Clicking this button displays a complete library of linetypes.
Select Hatch Pattern button: Clicking this button displays a library of hatch patterns to choose from.
Once you have specified the contents of the current legend entry, click the OK button to return to the Legend Definitions dialog.

**Add from Drawing:** Allows you to select a block from your current drawing and add it to the legend being built.

**Remove:** Removes the currently selected item from the legend.

**Desc By Field-to-Finish:** uses the description from the Field-to-Finish code definition for symbols that match the code symbol.

**Sort:** this command sorts the legend definition in ascending order based on the Symbol Name.

**Move Up & Move Down:** These buttons allow you to move the currently highlighted item up and down in the list.

**On or Off:** Allows you to turn on or off a drawing symbol in the list by picking the item in the drawing. Turning an item off may be preferable to deleting it from the legend definition since the item will be available in the defined legend for future use.

**On/Off by Drawing:** Allows you to turn on or off items in the list by highlighting the item from the drawing.

**Draw:** Clicking the Draw button brings up the Draw Legend dialog box. Here you can define the overall parameters for drawing the legend:

![Draw Legend dialog box](image)

After all the information is entered correctly select "OK" and you will be asked to "Pick upper left point for Legend:"

**Save:** Saves the current file under the previously specified name

**SaveAs:** Allows you to save the current file to another name and/or directory

**Exit:** exits the routine

**Pulldown Menu Location:** CG-Survey > CGDraw>Legend

**Keyboard Command:** LGD, cg_legend

**Prerequisite:** None
Border
This option allows you to place a border Polyline on your drawing with sheet sizes.

Prompts

Sheet Setup

Sheet Size: The letters A, B, C, etc. refer to ANSI sheet size standards. You also have the option of creating and naming custom sizes.
Rotate 90 Degrees: when checked will rotate the border 90 degrees.
Border Inset: specifies the inset distance for the border. Keep in mind this inset distance is measured from the edge of the plotable area of your plotter. Check the plotter manual for plotter specifications.
Layer: The layer the border will be drawn on.
Line Width: The thickness of the border line in inches (cm).
Press OK button when done and the border polyline will be drawn at the mouse cursor. You can move it to the correct location and left click to place it there.

Pulldown Menu Location: CG-Survey > CGDraw > Border
Keyboard Command: DB, CG_DRAW_BORDER
Prerequisite: None
Coordinate Grid

Choosing the Coordinate Grid item in the CGDraw menu brings up the Grid Configuration dialog. The various areas of the dialog are described below:

Prompts

Grid

Map Grid: is used to provide a visual reference grid to show northings and eastings on a map. A Map Grid can be labeled along its border to show the coordinate values of the grid lines. The Map Grid is oriented North-South East-West whereas a Layout Grid can be oriented at any specified bearing.

Layout Grid: is meant to be used to create points on a regular grid for laying out building columns, a topo grid, etc. A Layout Grid does not allow for a border nor for coordinate labels along the border.

Grid Layer: specify the layer the grid is to be created on. The layer does not need to exist prior to running this command.

Grid Format:

Lines: If selected grid lines will be drawn for the full height and width of the grid dimensions.

Crosses: Only crosses will be drawn at the grid intersections for the full height and width of the grid dimensions.

Cross Height (drawing units): this defines the size of the crosses in drawing units. If your drawing scale is 40 feet and you wish to have crosses that are 0.25 inches when plotted, you must specify cross height as 10 feet.

Draw Border: If checked, a border will be drawn around the perimeter of the defined grid. You can choose a different layer for the border if you wish. This will allow you to set the color, line thickness and/or line type for the border (this option is not available for Layout Grid).

Draw Labels: Label the grid lines or crosses around the perimeter at the same interval as the Baseline and Perpendicular intervals (this option is not available for Layout Grid). If checked you must specify:

Label Interval: This number must be some even multiple of both the baseline and perpendicular intervals. The Label Interval CAN NOT be less than the base or perpendicular interval settings.

Label Decimal Places: Specify the number of decimal places used for the label text.

Label Layer: Specify the layer the labels are to be drawn on.
Grid Layout

Grid Dimensions:

**Baseline Extent:** This is the total width of the grid, East to West (or parallel to the baseline bearing in the case of a Layout Grid).

**Perpendicular Extent:** This is the total height of the grid perpendicular to the baseline.

**Baseline Interval:** This is the distance between the grid lines (or X's) drawn perpendicular to the baseline.

**Perpendicular Interval:** This is the distance between the grid lines (or X's) drawn parallel to the baseline.

Grid Baseline:

**Use Point ID for Baseline Origin:** checking this box allows you to use an existing C&G coordinate for the Grid Origin. This is typically used for a Layout Grid.

Enter the point ID, or select the point from the screen.

**Origin Northing/Origin Easting:** manually enter the Northing and Easting value for the grid origin or pick it on the screen using the Pick Origin button.

**Baseline Bearing:** This is only used when you are drawing a Layout Grid. This is the bearing of the baseline. Use the standard C&G bearing input format qdd.mnss (e.g. 125.3527 for N25°35'27"E or 325.5405 for S25E54'04"W)

**Pick Origin button:** This option allows you to pick the origin graphically on the screen. You do not have to pick a C&G point.

Create Points at Grid Intersections:
Checking this box will cause the default C&G point to be plotted at each grid point or grid line intersection and a corresponding point to be stored in the currently open coordinate file. This is especially useful when creating a Layout Grid.

**Point Description:** enter a point description for the points saved to the coordinate file.

**Exclude Area:** This button allows you to graphically specify a horizontal window within which no grid is to be drawn. This can be used to guarantee that a title block, legend or other area is not obscured by the grid or its labels.

**Preview:** This button allows you to preview the grid as specified. Pressing <Enter> will return you to the Grid Configuration dialog allowing you to make changes if necessary.

**Cancel:** This button exits the command without drawing the grid.

**OK:** This button causes the grid to be drawn.

**Pulldown Menu Location:** CG-Survey > CGDraw>Coordinate Grid

**Keyboard Command:** GRD, CG_DRAW_GRID

**Prerequisite:** Coordinate file.

---

**Text on Arc**

**Create**

Text on arc allows you to create text that follows an arc specified by you. Each word in the text is a separate block and can be moved later as needed.

**Prompts**

You will be prompted to Enter Text to place on arc:

```
Command:
Enter Text to place on arc: Text On Arc
Enter center point for arc:
```

Type the desired text then press <Enter>:

**Enter center point for arc:** using the mouse, select the center point of the arc the text is to follow, this can be a C&G point, or any point in the drawing. You need not actually have an arc drawn.

**Enter Midpoint of text:** select the midpoint of the text, this can be a C&G point, or any point in the drawing.

**Move to desired location:** The text will be drawn at the cursor. Move the cursor to the desired location and left click to place the text.

**Pulldown Menu Location:** CG-Survey > CGDraw>Text on Arc>Create

**Keyboard Command:** TOA, CG_TOA

**Prerequisite:** Coordinate file
**Move**

Allows you to move all the text associated with the selected text-on-arc entity.

**Prompts**

Select entities: select text
Entities in set: 1 item is found and selected
Select entities: press <Enter> to accept entry
Move Text to desired location: move text
Select entities: repeating the selection set
Press <ESC> or <Enter>: to end command

Pulldown Menu Location: CG-Survey > CGDraw>Text on Arc>Move
Keyboard Command: MTA, CG_MOVE_TOA
Prerequisite: Coordinate file

**Edit**

Allows you to edit the text associated with a text-on-arc entity.

**Edit Text On Arc**

![Edit Text On Arc dialog box](image)

Text: Arc=107.6709, R=75.7740

Text Attributes

Text: Arc=107.6709, R=75.7740 (Edit Text )

Text Attributes
Layer: 0 (current)
Text Size: 0.100 inches (Default)
Text color: Bylayer
Set Color Button: select a new color
Text style: Standard text style
Cancel button: cancel routine
OK button: accept entries

Prompts

Select entities: select text
Entities in set: 1 item found and selected
Select entities: repeat selection set
Press <ESC> or <Enter>: to end command

Pulldown Menu Location: CG-Survey > CGDraw>Text on Arc>Edit
Keyboard Command: ETA, CG_EDIT_TOA
Prerequisite: Coordinate file

Delete

Allows you to delete all the text associated with a text-on-arc entity.

Prompts

Select entities: select text
Entities in set: 1 item found and selected
Select entities: repeat selection set
Press <Esc> or <Enter>: to end command

Pulldown Menu Location: CG-Survey > CGDraw>Text on Arc>Delete
Keyboard Command: DTA, CG_DELETE_TOA
Prerequisite: Coordinate file

Label Area

The label area routine will place the lot name you enter and the area in acres and square feet with in a closed figure.

Prompts

Chapter 18. CGSurvey Module
After selecting Lot Area from the menu you will have 2 options to choose from at the command line:

**Manual**

At the command line type M <enter> M
You will be prompted to Pick a point inside the perimeter: using your mouse move the cursor inside the lot to be labeled click the left mouse button.

**Enter the lot description or <Enter> for none:** enter a name for the property or press enter for no name.

**Pick location <Enter for Centered>**: at this point if you move the cursor within the perimeter of the area being labeled the text (lot name, acres, and sq. feet) will follow your cursor, click the left mouse button and the text will be placed centered on your cursor location.

**If you simple hit <Enter>** at the command line without using the cursor the area label will be placed centered in the lot or parcel.

**Point-group:**

At the command line type P <enter> P
The following dialog box will appear: Select a C&G Point Group File from the dialog box.

Once the point group has been selected the Lot Name, Acres and Square Feet will be placed in the center of the lot or parcel's point group. The name of the lot or parcel will be shown as the name of the point group. If the name needs to be edited this can be done using the text editor.
Pulldown Menu Location: CG-Survey > CGDraw > Label Area
Keyboard Command: LBA, CG_LABEL_AREA
Prerequisite: Closed Polygon figure

Draw Mapcheck
This routine will draw a mapcheck file. The settings allow you to plot points, draw lines, and place calls all at the same time.

If a mapcheck file is NOT currently open when you open the map check file routine a dialog box will prompt you to open a mapcheck file. Once a mapcheck file is open the following dialog box will open.

If the mapcheck file displayed at the top of the dialog box is not the file you want to draw you can use the browse button to search for another file.
You also have the option to edit the file which will take you to the mapcheck editor (CGEditor).

Reduce File: If this item is checked there will be a closure report written to the print file and the command line.

Starting/Ending Points: You have the option of entering an existing point number or manually entering the northing and easting. If you enter an existing point number the northing and easting values will be read from the coordinate file and placed in the appropriate edit boxes (see below).
If the starting and ending point are the same point, you need only enter the starting point values.

Clicking the Select Point button will cause the Draw Mapcheck dialog to be hidden thus allowing you to pick the starting and ending points from the screen or use the command prompt:

**Select starting point for mapcheck:**

or

**Select ending point for mapcheck:**

rather than manually entering the point number or coordinate values in the edit boxes.

**Lines:** This portion of the dialog allows you to turn on or off the draw line command as well as select the linetype and layer where the line will be drawn.

**Calls:** This section of the dialog allows you to turn on or off the draw calls command as well as edit the call setup options.

**Point Symbols:** This area of the dialog allows you to turn on or off the draw point symbols command as well as having a button that will take you to the drawing settings dialog. At the drawing settings dialog you can change the symbol, symbol size, label options and more.
OK: Selecting ok will cause the mapcheck file to be drawn, based on the current settings as described above.

Prompts

Select starting point for mapcheck: Select a point symbol or type a point number for the starting point. 
or
Select ending point for mapcheck: Select a point symbol or type a point number for the ending point.

Pulldown Menu Location: CG-Survey > CGDraw>Draw Mapcheck
Keyboard Command: DMP, CG_DRAW_MAPCHECK
Prerequisite: Open Mapcheck file *.cgm

Multi-Draw

This feature allows you to complete several drawing operations at the same time. For example, in one operation you can plot points and generate a coordinate table for the points at the same time. Or you can draw lines by points and place calls on the resulting lines at the same time.
Prompts

When you choose Multi-Draw from the CGDraw menu, the Multi-Draw dialog box is displayed.

Specify Points

Use the radio buttons to indicate how you want to specify the points that will be used for the drawing operations. You can Choose Points Interactively using the standard C&G point sequence command line interface or you can
Use Point Group.

NOTE: If you Choose Points Interactively, you will not have the option of plotting points or creating a coordinate table.
If you click Use Point Group, you must specify a Point Group Name and the point group description for the points you wish to use. You can either type the full path (including the drive letter) to an existing point group file or you can click the Browse button and use the file dialog box to specify the Point Group file.

NOTE: In this context, Description refers to the Point Group description, NOT the description for the individual points as found in the coordinate file.

Drawing Operations
In this area of the dialog box you must specify which drawing operations to perform and, if needed, make the necessary settings changes required for the drawing operations. Any settings changes are saved to the drawing and thus remain in effect after this command is completed.

**Plot Points:** Checking this checkbox will cause the selected points to be plotted.
Point Settings button: selecting this button will bring up the Drawing Settings dialog box allowing you to make changes to the drawing settings.

**Coordinate Table:** Checking this checkbox causes a coordinate table to be created for the points selected.

Table Settings button: will bring up the Coordinate Table Settings dialog box allowing you to make changes to layer, text size and line spacing.

**Draw Lines/Arcs:** Checking this checkbox causes lines and/or arcs to be drawn between the points specified.

Line Settings button: Will bring up the Linetype Manager allowing you to select the linetype.

**Draw Breaklines:** Checking this checkbox causes breaklines to be drawn between the specified points. Breaklines are for use in topographic operations (see CGTopo).

Topo Settings button: displays the CGSurvey Auto Contouring settings dialog box allowing you to make changes to the current topo settings.

**Draw Calls:** When Draw Calls is checked, calls will be drawn between the points specified.

Call Settings button: will display the Call Settings dialog box allowing you to make changes.

If Use Call Table is checked: all call information will be placed in a call table, rather than along the line work. The Call Table Settings button displays the Call Table Settings dialog and allows you to set the layer calls will be placed on, the text size, the line spacing, the first course label, etc.
If Use Curve Table is checked: all curve information will be placed in a curve table, rather than along the line work. The Curve Table Settings button displays the Curve Table Settings dialog and allows you to specify: which components will be shown in the curve table, which layer the table will go on, the text size, the line spacing, the first course label, etc.

The Layer Settings button: displays the Layer Manager dialog. Here you can create any layers you need or set the current layer as required. When you are satisfied click OK.

If you choose Use Point Group: the drawing operations you have selected will be completed immediately.

If you have selected Choose Points Interactively: enter or pick the desired points at the following standard C&G point sequence command line prompt:

Note: When entering the points at the command line, some drawing operations may occur as you enter the points.

Placement of coordinate, call and or curve tables

No matter what point selection method you use, if you specified that any tables be drawn, the coordinate, call or curve table will be placed at the cursor and you will be asked to move the cursor to the desired location. Clicking the left mouse button will place the table in the drawing at the cursor location.

Pulldown Menu Location: CG-Survey > CGDraw>Multi-Draw
Keyboard Command: MD, CG_MULTI_DRAW
Prerequisite: Coordinate File &/or Point Group

Plot Points and Symbols

Plot Points on Screen

Plot Points on Screen: This feature plots the selected points from a coordinate file on the screen.

Prompts

If a coordinate file is not open, a file dialog box will appear allowing you to open one. You will then be asked to select the points to be plotted (for additional information, see Getting Started: Coordinate point selection sets).

Type the Capped Letter to initialize the selection Set
[All/Block/Code/Desc/Elev/Pt_group/Limits/radius/select]: A
Press <Enter>3x when done: The points will be plotted on the screen.

In which layer will the points be plotted?

If the Use Description Table for point plotting parameters checkbox is not checked in the Graphic Options tab in C&G Options dialog: then all points will be plotted on the current layer according to the Drawing Settings dialog.

If the Use Description Table for point plotting parameters checkbox is checked and the Default layer for codes or descriptions not found in description table is specified: point's will be plotted to the layers specified by the description table (for a discussion of description tables see the CGMngmt chapter).

Description matches a description found in the description table: the point and its labels will be plotted as specified in the description table. For a description to match it must be a whole word match, disregarding numbers.

For example:
Table Description Point Description Match
TC TC-.5 to Bc yes
SW SW1 yes
FH TOPFH no

If a point has several different descriptions found in the description table: then that point can be plotted in more than one layer. For example: If the point's description is TC WV, it will be plotted in the layer assigned to the description TC as well as the layer assigned to the description WV.

No match is found in description table: the point will be plotted in the default layer with point labels as specified for the active point symbol.

Pulldown Menu Location: CG-Survey > CGDraw>Plot Points and Symbols>Plot Points on Screen
Keyboard Command: PP, CG_PLOT_POINTS
Prerequisite: Coordinate file.

Remove Points from Screen
This feature allows you to remove/erase specified points from the drawing.
Prompts

If a coordinate file is not open, a file dialog box will appear and allow you to open an existing coordinate file.

Using the standard C&G Select Points commands, select the points to be removed.

Type the Capped Letter to initialize the selection Set

[All/Block/Code/Desc/Elev/Pt_group/Limits/radius/select]: A

Press <Enter> 3X when done: The points will be removed from the screen.

Note: Remove Points from Screen does NOT delete points from the coordinate file.

Pulldown Menu Location: CG-Survey > CGDraw>Plot Points and Symbols

Keyboard Command: RP, CG_REMOVE_POINTS

Prerequisite: Coordinate file

Graphic Scale

This feature allows you to draw a graphic scale. Make sure the correct scale has been specified in the Drawing Settings dialog box.

Prompts

In the CGSurvey Draw Graphic Scale dialog specify the layer for the graphic scale.

Layer: Scale
Once you have specified the layer: press the OK button.

The Graphic Scale symbol will then be drawn at the mouse cursor: You can move the cursor to position the graphic scale then press the left mouse button to place it at the cursor location.

Pulldown Menu Location: CG-Survey > CGDraw>Plot Points and symbols>Graphic Scale
Keyboard Command: GSC, CG_DRAW_GSCALE
Prerequiste: Coordinate file

Text in object

This allows you to draw a geometric object containing the text you specify.

Prompts

When you select the Text in Objects menu item, the CGSurvey Draw Text in Objects dialog box will appear. You can use this dialog to configure the size and shape of the object and its text.
Object Settings:

Object Size: Type the size in inches/centimeters. This is the size of the object as seen on the printed drawing.

Object Type: Select the shape of the object.

There are eight shapes available:
Circle
Box
Hex1 (a hexagon)
Hex2 (Hex1 rotated 60 degrees)
Diamond
Triangle
Text Parameters:

Scale Text to Fit Object: check this checkbox if you want the text to be sized to fit inside the selected object. If this box is not selected the current Drawing Settings text size will be used.

Auto Increment Text: If there are numbers anywhere within the text and this box has been selected, the last number found in the text will increment each time you place an object (e.g., MH1, MH2, MH3, etc.).

If no numbers are found: then the last letter in the text will be incremented. (e.g., texta, textb, textc, etc.) The new value will then be used as the default value in the CGSurvey Draw Text in Objects text field.

When done click the OK button: OK

After closing the CGSurvey Draw Text in Objects dialog box, the object and text will be drawn at the cursor and you will be asked to place the object at the desired location: Move the object to the desired location and press the left mouse button.

Press <Enter> or the right mouse button to return to the CGSurvey Draw Text in Objects dialog box.

You may change items in the dialog box: click OK to place more symbols or click the Cancel button to end the command.

Pulldown Menu Location: CG-Survey > CGDraw>Plot Points and Symbols
Keyboard Command: TIO, CG_TIO
Prerequisite: Coordinate file

Place Symbol

This feature allows you to draw point symbols. These symbols will be sized according to the values specified in the Drawing Settings - Active Point Symbol dialog box.

Prompts

When you choose this menu option you will see the following prompt on the command line:

Pick position or specify position using a point ID. (ENTER to quit) [Setup]:

Selecting <S>: for Setup will bring up the Drawing Settings dialog box under CGOptions here you can check or change the current symbol settings.
Pick a point on the screen or enter a point ID to specify the location of the symbol: If you enter a point ID, the coordinates will be obtained from the coordinate file.

Pulldown Menu Location: CG-Survey > CGDraw > Plot Points and Symbols > Place Symbols

Keyboard Command: PLS, CG_PLACE_SYMBOL

Prerequisite: Coordinate file.

Lines and Polylines

Lines by Point Number

This feature allows you to draw lines and/or arcs based on the points in the coordinate file.

Prompts

If you choose this option and a coordinate file is not open, you will be prompted to open one. You will be prompted at the command line to enter the coordinate point IDs that define a line/arc or a series of lines/arcs. You may type the point IDs at the command line or pick points on the screen.

Enter Point Sequence
(point group/Reset/sNap on) (last point = <72>):
Once a point is selected the command line will change to a new group of options
(cLockwise curve/ccW curve/Point group/Reset/sNap on) (last point = <72>):

Once finished plotting points simple hit<Enter> and the command line will clear.

**Point Input:** When entering a point sequence specifying a line/arc the following input forms are acceptable:

- **34:** Either specifies the starting point of a line or, if this is a continuing series of lines, draw a line from the previous end point to point 34 and occupy point 34.
- **6-9:** Draw a line from point 6 to 9 and occupy point 9.
- **-4:** Draw a line from the previous end point to point 4 but remain at previous end point.
- **L:** Specify a cLockwise curve. The previous end point is assumed to be the PC of the curve. The next point specified is the center or radius point of the curve and the next point entered is the PT of the curve.
- **W:** Specify a counter clockWise curve. The data entry sequence is similar to a clockwise curve.
- **P:** Use a Point group to specify the lines/arcns. You will be asked to pick the point group file using a file dialog box.
- **R:** Reset the "last point" to none
- **N:** Toggles the CAD snap command on or off

If you choose to use a point group file, lines will be drawn from point to point in the order specified in the point group file (see the CGMngmt chapter for information on point group files).

If you do not want to type in the point IDs to define the lines/arcns, you can select the points from points that are plotted on the screen using your mouse. (see Plot Points and Symbols).

**Note:** To specify an arc to be drawn pick the PC point of the curve then enter either **L** <Enter> for clock-wise or **W** <Enter> for counter clockwise curve. When prompted, pick the radius point and then pick the PT.

**Pulldown Menu Location:** CG-Survey > CGDraw>Lines and Polylines>Lines by Point Number

**Keyboard Command:** LBP, CG_LBP

**Prerequisite:** Coordinate file.

---

**Lines by Description**

This feature allows you to connect lines between all the points in a coordinate file having a common description.
Prompts

After choosing the Lines by Description menu item you will see the CGSurvey Draw Lines by Desc dialog.

Layer: Specify the name of the layer the lines are to be drawn on.

Desc: Specify the description of the points you want to connect. Case is ignored and, unless the checkboxes described below are checked, only the leading characters of the point description are considered for a match.

Match text anywhere in desc: If this checkbox is checked, the entire point description field will be searched for the characters specified in the Desc: edit box. For example:
Input Description Point Description Match
MH SanMH Yes

Force match to be whole word: If this box is selected, the match must be a complete word in the point description, not just a portion of a word. For example:
Input Description Point Description Match
RD CL RD Yes (whole word)
RD CLRD No (not whole word)

Connect Mode

Sequential: Connects the points in point ID order.
Closest: Ignores point ID and connects to the closest point with named description.

Pulldown Menu Location: CG-Survey > CGDraw > Lines and Polylines > Lines by Description
Keyboard Command: LBD, CG_LBD
Prerequisite: Coordinate file.
Lines by Codes

This feature allows you to draw lines between the points in the coordinate file having a common point code. The point code is a two to four character field (depending on the type of coordinate file).

![CGSurvey Draw Lines by Code dialog]

Prompts

Choosing the Lines by Code menu item brings up the CGSurvey Draw Lines by Code dialog. With the exception of the Code: field, the items in this dialog are identical to those in the CGSurvey Draw Lines by Desc dialog.

**Code:** field specifies the code for the points you want to connect. Case is ignored.

**Connect Mode**

- **Sequential:** connects line in point ID order
- **Closest:** connect lines in Closet point with named description

**Pulldown Menu Location:** CG-Survey > CGDraw>Lines and Polylines
**Keyboard Command:** LBC, CG_LBC
**Prerequisite:** Coordinate file

Polylines by Point

This feature works very similar to the Lines by Point feature described in the previous pages. In Polyline by Points data entry is similar to Lines by Point except Reset does not apply to a polyline. The C&G Polyline allows you to treat road centerlines and other similar things that would normally be made up of several line segments, as one entity. You can use a C&G polyline to create a point group or you can place calls along it. You could also use a C&G polyline as the bounding polygon in the Fit Structure feature.
**Pull down Menu Location:** CG-Survey > CGDraw > Lines and Polylines > Polylines by Point

**Keyboard Command:** CGP, CG_POLY

**Prerequisite:** Coordinate file.

---

**Fit Polylines**

This feature allows you to use a variety of best fit methods to smooth an existing polyline.

---

**Prompts**

First you must choose the method to use in fitting the selected polylines at the following prompt:

**Type of fit to apply**

[Decurve/Fit/Quadratic spline/cubic spline/Cg spline]<C>:

Next, select the polylines you wish to fit then press the <Enter> key or right mouse button to apply the fit to the selected polylines.

**Decurve:** This will decurve a previously smoothed polyline.

**Fit:** uses CAD fit - a series of interconnected circular arcs.
**Quadratic spline:** Uses a quadratic spline curve fitting algorithm.

**Cubic spline:** Uses a cubic spline curve fitting algorithm.
C&G Spline: Creates a smooth curve that passes through all vertices.

Pulldown Menu Location: CG-Survey > CGDraw > Lines and Polylines > Fit Polyline

Keyboard Command: FITP, CG_FIT_POLY

Prerequisite: Coordinate file.

**Calls**

**Place Calls**

This feature allows you to annotate C&G and CAD lines, arcs and polylines.
Call Setup

Selecting Calls Setup will brings up the Call settings dialog box.

**Desired Call Components:** Specify the desired components for the call.
Bearing and Distance (or Arc and Radius)
Bearing (Arc)
Distance (Radius)
Bearing over Distance (Or Arc over Radius)
If you specify points to form a curve then the components shown in parentheses will be used to form the call text.

**Format and location:** Specify how you want the call placed relative to the line or arc:
Parallel: to the line or Arc
Perpendicular: to the line or arc
At Cursor: means the call text will be drawn horizontally at the cursor and you must move it to the desired location then left click to place it.

**Place Call to Right of Line:** If you are placing a call either parallel or perpendicular to a line or arc, select this box if you want the call placed to the right of the line or arc, assuming you are standing on the line and facing in the direction of the bearing. The call will be centered along the line or arc.

**Use the Foot Abbreviation [ ' ] in Distance Text:** Checking this box will places the [ ' ] mark after the distance (125.36'). Un-checking the box will remove the [ ' ] mark (125.36).

**Line Bearing Direction to:**
Selecting NW,NE: will force all calls to be shown only with NE and NW notation (N 428 35' 12'' E or N 168 25' 31'' W)

Selecting SW,SE: will force all calls to be shown only with NE and NW notation (S 428 35' 12'' E or S 168 25' 31'' W)

If < no preference >: is selected the software will define the bearing based on the direction of the points selected.

Layer Name for Call Text: Specify the layer where you want the calls placed.

Automated Placement of Calls on Specified Layers

Check the Automate Placement of Calls check box making the options in the dialog active. This routine allows you to select one or more layers to scan for the placement of calls. The scan will look for lines only in the layers you specify even though other layers may be currently displayed.

Choose one or more layers to search: this dialog will display the complete list of layers in the drawing file. You can scroll up and down the list and simple click with the mouse those layers you want to search for lines/polylines.

Types of Lines to Annotate:

C&G Lines and C&G Polylines: refer to lines that have been drawn using the CGDraw command, thus being based on the C&G coordinate file.

CAD lines and CAD Polylines: refer to lines that have been drawn using the CAD Draw command and are not based on the C&G coordinate files.

Example Cell: this display shows you the actual layout as it will appear on you drawing.
Prompts

When you choose the Place Calls menu item and a coordinate file is not already open, you will be asked to open a coordinate file. You will then see the following prompt at the command line:

**Enter point sequence**: [Point group/Reset/turn_sNap on/Setup/polYline] (last point = <none>):

**Point Group**: If you press P and <Enter> you will be asked to enter a point group and it will be used to place calls automatically.

**Reset**: Press "R" resets the last point ID to <none>

**sNap on or sNap off**: Press "N" turns the CAD snaps on or off. When the command starts the AutoCAD snaps are off by default.

**The Setup**: Press "S" option brings up the Calls Setup dialog box.

**polYline**: if you Press"Y" and <Enter> you can then pick a C&G polyline and it will be annotated in the order that the vertices were specified when it was drawn.

**Pulldown Menu Location**: CG-Survey > CGDraw>Calls>Place Calls

**Keyboard Command**: CALL, CG_CALLS or CALS, CG_CALLS_SETUP

**Prerequiste**: Coordinate file.

---

Move Calls

Allows you to move call text and once moved it will not go back to its original location when you use Refresh Screen to refresh calls. The calls will move or change if the point numbers that generated the call change but the position of the call relative to the end points will remain approximately the same.

Prompts

**Select entities**: Pick call on screen

Entities in set: 1

Select entities: Pick another call on screen

Move call to desired location.

**Pulldown Menu Location**: CG-Survey > CGDraw>Calls>Move Calls

**Keyboard Command**: MCL, CG_MOVE_CALLS

**Prerequiste**: Coordinate file.

---

Reverse Calls

This feature allows you to reverse the bearing of the call.

Prompts

**Pick a call to reverse**: select call bearing on screen

**Pick a call to reverse**: select another call bearing on screen
Pick a call to reverse: select again if wish to continue or
Press <Esc>: to quit command

Pulldown Menu Location: CG-Survey > CGDraw>Calls>Reverse Calls
Keyboard Command: RCL, CG.Reverse.CALLS
Prerequisite: Coordinate file.

Tables

Coordinates
This feature allows you to draw a table containing information related to specified points in the coordinate file then place the table in the drawing by picking the desired location.

When you pick the Table > Coordinate menu item and a coordinate file is not already open, you will be asked to open one.
Once a coordinate file is open, then the Coordinate Table Settings dialog will appear. Using this dialog you can configure the following settings:

Layer: Specify the layer on which you want the table drawn.
Text Size: Enter the text size in inches or centimeters. The text size is the size the text will appear when printed on a page.
Line Spacing: Enter the space you want between lines in inches or centimeters. The line spacing is the height of the spacing when the table is printed on a page.

Note Northings and Eastings will be rounded based on the values specified in the Rounding Options tab of the C&G Options dialog box.

Note The point ID, northing, and easting will always be part of the coordinate table. If you want elevations, codes and descriptions shown, make sure they are set to "On" on the Global Settings tab of the C&G Options dialog.
Click OK to save the settings and continue the command, this will return the action to the command line. If you click Cancel the command will be canceled.

**Selecting Points for the coordinate table:**
Select the points that will be included in the table using the familiar C&G prompt.

**Choose initial points for base selection set from coord file. (Enter when done)**
[All/Block/Code/Desc/Elev/Pt_group/Limits/Radius/Select]: A

**Prompts**

Choose initial points for base selection set from coord file. (Enter when done)
[All/Block/Code/Desc/Elev/Pt_group/Limits/Radius/Select]: A

Expand base selection set: Choose more points from coord file. (Enter when done)
[All/Block/Code/Desc/Elev/Pt_group/Limits/Radius/Select/Include/eXclude/View]:
Building Point Selection Set...

Press Enter 2 more times to end selection set: <Enter>

When done selecting points just press <Enter>: The table will be drawn at the cursor.

Move Coord Table to desired location: Drag the table to the desired location on the drawing and press the left mouse button to place the table.

<table>
<thead>
<tr>
<th>Point</th>
<th>Northing</th>
<th>Easting</th>
<th>Elev.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>311.54700</td>
<td>156.49800</td>
<td>806.000</td>
</tr>
<tr>
<td>2</td>
<td>195.62300</td>
<td>178.29400</td>
<td>800.000</td>
</tr>
<tr>
<td>3</td>
<td>179.32153</td>
<td>349.22200</td>
<td>804.000</td>
</tr>
<tr>
<td>4</td>
<td>88.73818</td>
<td>482.53484</td>
<td>784.000</td>
</tr>
<tr>
<td>5</td>
<td>94.62829</td>
<td>582.68280</td>
<td>774.000</td>
</tr>
<tr>
<td>6</td>
<td>279.94438</td>
<td>641.39001</td>
<td>806.000</td>
</tr>
<tr>
<td>7</td>
<td>384.00033</td>
<td>644.84940</td>
<td>787.000</td>
</tr>
<tr>
<td>8</td>
<td>451.01870</td>
<td>499.90827</td>
<td>782.000</td>
</tr>
<tr>
<td>9</td>
<td>369.50946</td>
<td>370.96736</td>
<td>782.000</td>
</tr>
<tr>
<td>10</td>
<td>431.06887</td>
<td>262.19309</td>
<td>812.000</td>
</tr>
<tr>
<td>11</td>
<td>399.49010</td>
<td>186.92783</td>
<td>810.000</td>
</tr>
<tr>
<td>12</td>
<td>277.07728</td>
<td>289.70590</td>
<td>786.000</td>
</tr>
<tr>
<td>13</td>
<td>301.70687</td>
<td>505.67936</td>
<td>804.000</td>
</tr>
<tr>
<td>14</td>
<td>221.32480</td>
<td>513.17844</td>
<td>760.000</td>
</tr>
<tr>
<td>15</td>
<td>273.58991</td>
<td>391.24427</td>
<td>803.000</td>
</tr>
</tbody>
</table>

**Pulldown Menu Location:** CG-Survey > CGDraw>Tables>Coordinate

**Keyboard Command:** CRDT, CG_COORD_TABLE

**Prerequisite:** Coordinate file.

*Chapter 18. CGSurvey Module*
Call Table
This feature allows you to place the bearings, distances, etc. in a table instead of along the lines and curves in the drawing. This is especially useful when space along the lines or curves is limited. When you use a call table only the course labels are placed along the line or curve to identify it in the table.

When you choose the Table > Call item from the menu the Call Table Settings dialog appears. As with the coordinate table, this dialog box allows you to enter: the layer, text size and line spacing for the call table.

Drawing Settings
Layer: CG_Template
Text size: 0.100
Line Spacing: 0.075
Use Foot symbol: Checked
This setting will place a Foot symbol < " > if desired.

Course labels
First course label: The course labels will be based on the First course label setting in the Call Table Settings dialog box. The course label will then be determined by incrementing the last character in the previous course label starting with the first course label.
For example: line1 increments to line2, line3, etc. whereas line_a increments to line_b, line_c, or as in the example above L1, L2 L3, etc.
Automatically increment course label: Check or Uncheck box
This setting will automate the process with selecting point sequence

After configuring the settings in the Call Table Settings dialog:
Ok Button: select OK

Prompts

You will be prompted at the command line to enter the point sequence.
Enter the point sequence by typing point IDs or by selecting C&G points and/or lines on the screen.

Enter point sequence: [cLockwise_curve/ccW_curve/Point_group/Reset/turn_Snap_on]

The Reset button: The ‘R’ resets the last point to <None>

When you are done entering calls: press <Enter>
This will end the input process and the call table will be drawn at the cursor.

Move Call Table to desired location: Drag the table and left-click the mouse button to place table on screen. The course description will be placed in the table and on the line or arc in the drawing.

<table>
<thead>
<tr>
<th>Course</th>
<th>Bearing</th>
<th>Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>L1</td>
<td>N 15°04 '36&quot; E</td>
<td>183.84'</td>
</tr>
<tr>
<td>L2</td>
<td>S 85°52 '05&quot; E</td>
<td>170.10'</td>
</tr>
<tr>
<td>L3</td>
<td>S 11°44 '15&quot; E</td>
<td>163.23'</td>
</tr>
<tr>
<td>L4</td>
<td>S 65°53 '25&quot; W</td>
<td>141.06'</td>
</tr>
<tr>
<td>L5</td>
<td>N 66°49 '49&quot; W</td>
<td>132.63'</td>
</tr>
</tbody>
</table>

Pulldown Menu Location: CG-Survey > CGDraw>Tables>Call
Keyboard Command: CALT, CG_CALL_TABLE
Prerequisite: Coordinate file

Curve

This feature allows you to Draw a table containing curve information for specified curves.
You will be prompted to open a coordinate file if one is not already open. Once the coordinate file is open, the Curve Table Settings dialog box will appear. The Curve Table Settings dialog allows you to configure the following settings:

**Curve Components**

Check the checkboxes for the curve components that you wish to appear in the table, Radius, Tangent, Arc Length, Chord Bearing, Delta, Degree and Chord.

**Drawing Settings**

Enter the layer, text size and line spacing, and check or uncheck the Use Foot Symbol checkbox.

- **Layer:** CG_Template
- **Text Size:** 0.100
- **Line spacing:** 0.075

**Curve Labels**

Enter the First Curve Label for the first curve

- **First Curve Label:** C1

**Automatically increment curve label:** check or uncheck the Automatically increment curve label checkbox.
**OK Button:** When done, click OK to begin entering the curve data.

**Prompts**

You will be prompted at the command line to Enter point sequence

**Picked C&G Point [1444]**

**Enter point sequence**

[clockwise_curve/ccw_curve/Reset/turn_Snap_on] (last point = 1444): L

**Enter radius point for curve [Reset/turn_Snap_on]:**

Picked C&G Point [1449]

**Enter point of tangency (PT) for curve [Reset/turn_Snap_on]:**

Picked C&G Point [1448]

**Move Curve Table to desired location:** Drag Table to desired location and Left-mouse click to place on the drawing.

<table>
<thead>
<tr>
<th>Curve</th>
<th>Radius</th>
<th>Tangent</th>
<th>Length</th>
<th>Delta</th>
<th>Degree</th>
<th>Chord</th>
<th>Chord Bear.</th>
</tr>
</thead>
<tbody>
<tr>
<td>CI</td>
<td>42.90'</td>
<td>48.07'</td>
<td>72.28'</td>
<td>90°30'20&quot;</td>
<td>135°33'45&quot;</td>
<td>94°01'</td>
<td>N 73°14'52&quot; E</td>
</tr>
</tbody>
</table>

**Note:** After entering the PT point for any curve, you can continue entering curve data. However, you should be aware that the PT point is shown as the last point.

If the PT point is not the PC of the next curve then you need to enter "R" for Reset. This allows you to begin the next curve at a new PC, then continue on to enter its radius point and PT.

**Pulldown Menu Location:** CG-Survey > CGDraw>Tables>Curves

**Keyboard Command:** CURT, CG_CURVE_TABLE

**Prerequisite:** Coordinate file.

**Auto Map**

Map allows the user to automate the production of a drawing based on special "mapping codes" included in the descriptions found in the coordinate file. Using this feature can save a great deal of time. This allows the lines and points to be placed in the drawing based on mapping codes without user intervention.

**Pulldown Menu Location:** CG-Survey > CGDraw>Auto Map

**Keyboard Command:** MAP, CG_MAP_DRAW

**Prerequisite:** Coordinate file.
Draw
This feature automates the production of a drawing that can contain specific points, lines, arcs and curve fit lines. The draw option also acts as a Cogo function in that it will calculate the PC, PT and radius points of curves and has the ability to calculate points by traversing and intersection.

Prompts
After choosing the Draw command, if a coordinate file is not open, you will be asked to open one.

After opening the coordinate file, you will be asked to select the points you want to map:

Choose initial points for base selection set from coord. file: (Enter when done) [All/Block/Code/Desc/Elev/Plt-group/Limits/Radius/Select]:

Next, you will be asked whether you want to store elevations at calculated PC, PT, and radius points: When locating items like back of curb you may need to note the beginning and ending of curves. The points located are never exact as far as the beginning and ending of the curve, but when noted in the mapping routine the application will compute a PC, PT and Radius using the best fit routine and you can choose to store theses points or not.

Note: If Auto Point Plot is ON as specified in the Graphic Options tab of the C&G Options dialog, points will be plotted and lines, arcs and/or curve fit lines are drawn when indicated by Mapping Codes found in the point descriptions.
Mapping Codes Used by the Draw feature

The map codes used by the Draw feature must be placed in the description field for each point in the coordinate file that is to be "Mapped".

Below is the list of map codes:
BL - Begin Line
EL - End Line (optional)
CL - Close Figure
PC - Begin Curve (tangent to previous line)
OC - Point on Curve (begin/end non-tangent curve)
PT - End Curve (tangent to next line)
RP - Radius Point
CF - Curve Fit (spline fit to irregular curves)
CC - Compound Curve
RC - Reverse Curve

Mapping Codes can be upper or lower case. The map code MUST be followed by an asterisk and a line description for the line that is being drawn. For example: BL*CURB1, where CURB1 is the line description for the line you are beginning. It is OK to have spaces between the code, asterisk and line description, but it is not necessary.

For example:

<table>
<thead>
<tr>
<th>Point ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>BL* CURB1 EL*SW1 WV</td>
</tr>
<tr>
<td>6</td>
<td>CURB1</td>
</tr>
<tr>
<td>7</td>
<td>SW1 PP</td>
</tr>
<tr>
<td>8</td>
<td>PC* CURB1</td>
</tr>
<tr>
<td>9</td>
<td>FH</td>
</tr>
<tr>
<td>10</td>
<td>PT* CURB1</td>
</tr>
<tr>
<td>11</td>
<td>CURB1 SW1</td>
</tr>
<tr>
<td>12</td>
<td>OC* SW1</td>
</tr>
<tr>
<td>13</td>
<td>SW1</td>
</tr>
<tr>
<td>14</td>
<td>SW1</td>
</tr>
<tr>
<td>15</td>
<td>SW1</td>
</tr>
<tr>
<td>16</td>
<td>OC* SW1</td>
</tr>
<tr>
<td>17</td>
<td>CL* SW1</td>
</tr>
<tr>
<td>18</td>
<td>BL* CURB1</td>
</tr>
</tbody>
</table>

Important Note: Mapped lines are connected in ascending order by point ID. The point ID's are always saved in the coordinate file in increasing order. Since the coordinate file is used to perform the Map Drawing and the point ID sequence is produced when the raw data is reduced, it follows that the order of field location of the points will determine point ID sequence order when the lines are mapped.

In the sample sequence above:
Point 5 begins two lines, Curb1 and SW1. Curb1 and SW1 are line descriptions. A line description must be a whole word (no spaces). WV (water valve) is not the beginning of a line because an asterisk does not precede it.

For example:
5 BL*CURB1 BL*SW1 WV
The Curb1 line will be drawn from point 5 to point 6 to point 8. This begins a curve tangent to the line from 6 to 8 continuing to point 10. The curve is tangent to the line from 10 to 11. Since point 18 begins a new Curb1, point 11 is the end of the first Curb1 line (the EL code is not required in order to end a line).

A second line (SW1) will be drawn from 6 to 7 to 11 to 12. At point 12 a non-tangent circular curve begins and continues through points on the curve at 13, 14, and 15. The non-tangent curve ends at point 16 and lines continue from 16 to 17 to 1 (the CL code closes the figure). In creating the non-tangent curve from point 12 through point 16, points 13-15 are used by the Map Draw feature in the calculation of the best fit circular curve.

In addition to the lines drawn, the symbol specified for the WV description in the description table (see CGMngmt) will be placed at point 5 and, at point 7, the symbol specified in the description table for the description PP will be drawn.

As demonstrated in the above example, you may combine multiple codes and line descriptions within a single point description.

For example:

**Point ID Description**

<table>
<thead>
<tr>
<th>Point ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>20</td>
<td>BL* SW1 BL* CURB1 CURB2 EL* CURB3 CL* CURB4</td>
</tr>
</tbody>
</table>

In this example point 20 begins the SW1 line and the CURB1 line. It continues the CURB2 line. It ends the CURB3 line and it closes the CURB4 line.

**The Begin Line Code:**

All lines must start with a BL code. No lines will be connected to a point unless a word in the point description matches a BL* line name.

The Close Line Code: The close line code (CL) causes the Draw Map feature to connect the CL point to the BL point. You can also use the CL command to traverse. Thus you may place dimensions after a CL command. For example:

**Point ID Description**

<table>
<thead>
<tr>
<th>Point ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>20</td>
<td>BL* BLD1</td>
</tr>
<tr>
<td>21</td>
<td>CL* BLD1+10.1+10.2-20.3+50.6 EL* SW1</td>
</tr>
</tbody>
</table>

**Note:** The FC-48 data collector does not allow '+' characters in description field. Because of this, the '/' character can be used instead of the '+' character in all the CL examples.

In the above example a line will be drawn from point 20 to point 21. The following points will then be calculated through a traverse sequence (assume the next point available is 100):

**Occupied Pt BS Pt Angle Distance New Point**

<table>
<thead>
<tr>
<th>Occupied Pt BS Pt Angle Distance New Point</th>
</tr>
</thead>
<tbody>
<tr>
<td>21 20 90 10.1 100</td>
</tr>
<tr>
<td>100 21 90 10.2 101</td>
</tr>
<tr>
<td>101 100 270 20.3 102</td>
</tr>
<tr>
<td>102 101 90 50.6 103</td>
</tr>
</tbody>
</table>

Point 103 will then be connected to point 20 to close the BLD1 line. Please note that point 21 is also the end of the SW1 line.
In a CL mapping code sequence, a negative dimension turns -90 degrees from the back azimuth and a positive dimension turns +90 degrees from the back azimuth. Both the '+' and '-' symbols are required but, as noted above, the '/' symbol can be substituted for the '+' where necessary.

This same figure could also be drawn using the following sequence:

**Point ID Description**

- 20 BL* BLD1
- 21 CL* BLD1+10.1+10.2-20.3+

**Note** that the closing distance was not included in the description sequence. See the following examples.

If you have located two corners of a rectangle, you may use the following shortcut:

**Point ID Description**

- 20 BL* BLD1
- 21 CL* BLD1+50.6+

In the above example a line will be drawn from point 20 to point 21. The following points will then be calculated through a traverse sequence (assume the next point available is 100):

**Occupied Pt BS Pt Angle Distance New Point**

- 21 20 90 50.6 100

Point 101 will be calculated by a bearing-bearing intersection. Then point 101 will be connected to point 20. The first '+' sign determines the direction used to calculate point 100. The description ending in a '+' sign has the same effect as ending in a '-' sign: if there is no dimension after the last '+' or '-' sign, the last point will be calculated by a bearing-bearing intersect.

If you have located three corners of a rectangle, you may use the following shortcut to define the lines to be drawn:

**Point ID Description**

- 20 BL* BLD1
- 21 BLD1
- 22 CL* BLD1+

In the above example lines will be drawn from point 20 to 21 to 22. The missing corner will be calculated using a bearing-bearing intersect and stored. As noted earlier, ending in a '-' sign instead of a '+' sign has the same end result.

**Curve Codes**

Anytime a circular curve is encountered, 3 new points may be calculated and stored in the coordinate file. These points are the PC, PT and radius point of the curve. It is necessary to calculate these points during automated mapping since the field points are only approximations of a perfect curve. They will automatically be assigned point numbers (regardless of the Auto Point Numbering setting). The points calculated during automated mapping of curves will begin with the coordinate files current high point number plus 1.

If the beginning of a line is also the beginning of a curve, one of the following formats must be used:

**Point ID Description**
10 BL*SW1 CF*SW1 (begin a curve-fit line)
or 10 BL*SW1 OC*SW1 (begin a non-tangent circular curve)
or 10 BL*SW1 PC*SW1 (begin a tangent circular curve)

Once a curve has begun, all matching line descriptions will be considered points on the curve until the curve is ended. A curve is ended with either a PT*, OC*, or CF* code.

For Example:

<table>
<thead>
<tr>
<th>Point ID</th>
<th>Correct Sequence</th>
<th>Incorrect Sequence</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>OC*SW1 (Begin SW1)</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>SW1 OC*SW1 (will end SW1)</td>
<td>SW1 OC*SW1 (will end SW1)</td>
</tr>
<tr>
<td>12</td>
<td>SW1 OC*SW1 (will end SW1)</td>
<td>SW1 OC*SW1 (will end SW1)</td>
</tr>
<tr>
<td>13</td>
<td>SW1 OC*SW1 (will end SW1)</td>
<td>SW1 OC*SW1 (will end SW1)</td>
</tr>
<tr>
<td>14</td>
<td>OC*SW1 (End SW1)</td>
<td></td>
</tr>
</tbody>
</table>

The first OC begins the curve. The next OC ends the curve. All the points between them are on the curve. The same is true for curve fit (CF*).

If a curve is either tangent (in), tangent (out) or tangent (in) & tangent (out), you only need two points to define the curve:

<table>
<thead>
<tr>
<th>Point ID</th>
<th>Sample 1</th>
<th>Sample 2</th>
<th>Sample 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>PC*CURB1</td>
<td>PC*CURB1</td>
<td>OC*CURB1</td>
</tr>
<tr>
<td>11</td>
<td>PT*CURB1</td>
<td>OC*CURB1</td>
<td>PT*CURB1</td>
</tr>
</tbody>
</table>

Otherwise you will need at least three points on a curve:

<table>
<thead>
<tr>
<th>Point ID Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>12 CF*CURB1</td>
</tr>
<tr>
<td>13 CURB1</td>
</tr>
<tr>
<td>14 CF*CURB1</td>
</tr>
</tbody>
</table>

**The RP Mapping Code**

If you use the RP code (radius point), it will be used regardless of the number of points on the curve. The radius will be calculated by averaging all the distances from the radius point to the points on the curve.

**Best Fit Circular Curve Calculations**

If you have three or more points on a non-tangent curve, the best-fit curve solution is used to find the radius point. If you have three or more points on a tangent curve (either tangent in, tangent out, or tangent in and out), the best-fit curve solution is used to determine an approximate radius and radius point. A dummy point is then calculated on the curve and a curve is drawn that goes through the dummy point and meets the tangent criteria (the PC and PT points are shifted up/down the tangent lines as necessary). If only three points are located, PC, POC and PT, the curve will always go through the POC point.

If you have only two points (PC and PT) on a tangent curve, the tangent lines from the PC and PT will be intersected to find the PI of the curve. The distance from the PI to the PC and the distance from the PI to the PT will be averaged to obtain a tangent distance. A new PC and PT point will be calculated on the tangent line and the radius point will be calculated based on the tangent and central angle.

**Non-Circular Curves**
You may use the CF* code for a non-circular curve fit (splines). The CF code will start a curve fit line. The curve will continue until a second CF* code is encountered, example:

Point ID Description
11 CF*SW1
12 SW1
13 SW1
14 CF*SW1

Only use CF to start or end a curve. Notice points 12 and 13 do not have automated mapping codes. A smooth curve will be drawn through points 11, 12, 13 and 14. No new coordinate points are generated with the CF code.

Layers and linetypes for mapped lines and curves

The description table determines the layer in which a mapped line will be drawn. For mapped lines and curves, only the description and layer fields in the description table are used. However, if the default layer is not set, no description table lookup is performed and the line is drawn on the current layer.

For example, assume that the default layer has been set and that the description table contains the following entry:

<table>
<thead>
<tr>
<th>Desc. No.</th>
<th>Description</th>
<th>Layer Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>CURB Road</td>
<td></td>
</tr>
</tbody>
</table>

Since layer "Road" is specified for description "Curb", all lines with descriptions "Curb" will be placed in layer "Road". Numbers are not used in the comparisons: Curb1, Curb2, Curb10, etc. are considered a match for the description "Curb" and will therefore be placed in layer "Road".

If a matching description is not found in the description table, the line is drawn on the default layer (as set in the Graphic Options tab of the C&G Options dialog box).

Calculated Points

All coordinate points that are automatically calculated and stored during automated mapping are given a MP point code.

Note: Even though the point description field can contain Mapping Codes, the point code found in C&G coordinate files is separate and distinct from the point description field. All points already having an MP Code are ignored by automated mapping. This avoids re-mapping points that were generated during automated mapping and thus were not points actually located in the field.

Important Note: Consider the MP point code as a reserved code and do not use it for field data collection.

The description (e.g., CURB) used for calculated points is the same as the line description of the points the calculated point is associated with and reflects the type of calculated point that it is.

For Example:
Assuming the line description for the following points is "CURB1" and the points are the PC, PT and radius point of a curve, then the line descriptions will be:

<table>
<thead>
<tr>
<th>New Point ID</th>
<th>Point Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>MP</td>
<td>PC CURB1</td>
</tr>
<tr>
<td>101</td>
<td>MP</td>
<td>RAD.PT CURB1</td>
</tr>
<tr>
<td>102</td>
<td>MP</td>
<td>PT CURB1</td>
</tr>
</tbody>
</table>

**Plotting of Points**

If Auto Plot Points is "On", all the selected points in the coordinate file will be plotted on the screen during the mapping process. If a default layer is set, Each point will be drawn on the layer specified in the description table. The points labels will be configured as specified in the description table. Any point that does not have a description match in the description table will either be drawn on the default layer.

**Pulldown Menu Location:** CG-Survey > Auto Map > Draw  
**Keyboard Command:** MAP, CG_MAP_DRAW  
**Prerequisite:** Coordinate file.

**Erase**

The Map Erase feature will find all line, arc, curve fit and point entities created Using the Map Draw feature and delete them from the drawing. It will also delete any coordinate points from the coordinate file that were created with the using Map Draw (PC, PT, radius points and close line (CL) points or those points having the point code MP).

**Pulldown Menu Location:** CG-Survey > CGDraw > Auto Map > Erase  
**Keyboard Command:** EMAP, CG_MAP_ERASE  
**Prerequisite:** Coordinate file.

**Leaders**

Leaders are used to label features in the drawing. They consist of a line or series of connected line segments with an arrow at one end and a text label at the other end. The arrow size is determined by the symbol size as set in the Drawing Settings - Active Point Symbol dialog.

**Pulldown Menu Location:** CG-Survey > CGDraw > Leaders  
**Keyboard Command:**  
**Prerequisite:** Coordinate file
A text leader allows you to draw a series of lines with an arrow at the starting point then specify the text that is to be drawn at the final endpoint of the leader.

**Prompts**

To draw a text leader:

**Pick start of leader:** Pick the starting position of the leader with the left mouse button:
Picked C&G Point [4]

**To point (Enter to end):** Move the cursor to the next point on the leader and press the left mouse button. The first segment of the leader will be drawn with an arrow placed at the first point picked.

**To point (Enter to end):** As you pick succeeding points, lines will be drawn from the previous point to the current point.

**To point (Enter to end):** When you have picked the final point, press <Enter> or the right mouse button.
**Enter Text for leader:** At the command line, type the text to be placed on the leader and <Enter>.
Sample of Text Leader

**Pick start of leader:** repeats the command

**Pulldown Menu Location:** CG-Survey > CGDraw>Leaders>Text
**Keyboard Command:** TXTL, CG_TEXT_LEADER
**Prerequisite:** Coordinate file.

---

**Coordinate Leader**

This feature allows you to pick a point then draw a leader that is labeled with the coordinates of the point picked.
To draw a Coordinate Leader:
Prompts

Pick the starting point of the leader with the left mouse button: If you pick a C&G point, the coordinates will be read from the coordinate file, otherwise the graphic coordinates will be used.

Move the cursor to the next point for this segment of the leader and click the left mouse button: Repeat until all desired leader segments are drawn.

The coordinates of the first point picked will be drawn near the final point on the leader. The coordinates are rounded based on the rounding specifications in the Rounding Options Tab of the C&G Options dialog box.

Pulldown Menu Location: CG-Survey > CGDraw>Leaders>Coordinate Leader
Keyboard Command: CRDL, CGCOORD_LEADER
Prerequisite: Coordinate file.

Point Label

This feature allows you to label a point using a leader instead of the normal point labels. This feature can only be used with C&G points. The leader will display the point ID and, if Elevation and/or Descriptions are "On", the elevation and description will be displayed as well.
Prompts

It is suggested that you first plot the points on the screen with the point labels turned off by setting their point label
positions to 0 on the Drawing Settings - Point Label Position dialog. Thus only the symbols will be plotted. Next,
in the Drawing Settings tab of the CGOptions dialog box: turn on the items you want to be displayed on the leader.

Now choose the Point Label Leader menu item:

Pick start of leader: Move the cursor to a C&G point and press the left mouse button. Picked C&G Point
[3]
To point (Enter to end): Move the cursor to the end point of the next leader segment and press the left mouse
button. An arrow will be drawn at the first point picked.
To point (Enter to end): When you have picked the end of the last segment of the leader, press <Enter> or the
right mouse button.
To point (Enter to end): The point attributes will be placed near the last point picked for the leader.
(You may repeat the previous step as many times as is necessary)
When done press <Enter> when asked to pick the next C&G point, Press Enter

Pulldown Menu Location: CG-Survey > CGDraw>Leaders>Point Label
Keyboard Command: PTL, CG_POINT_LEADER
Prerequisite: Coordinate file.

Station-Offset

This Leader feature allows you to label points along a predefined alignment with their station and offset.

Prompts

Prior to using this feature you must create a point group that defines the alignment.

Next you will be asked to open a point group file. In the Select a C&G Point Group File dialog box: select
the point group file that defines the horizontal alignment you wish to use.

Enter starting station <0.00000>: 1000
10+00.00
Enter Starting station for the alignment as defined by the point group. If a station is specified for the first subgroup name in the point group file, it will be used as the default station (for more details on this, see the section on point group files in CGMngmt).

**Pick the starting location of the leader:** Picked C&G Point [3]
If a C&G point is not found at this location, the station and offset will be calculated using the drawing coordinates of the picked point. If a C&G point is found, the station and offset will be calculated from the coordinates read from the coordinate file. If a C&G point is found, the point ID will be printed at the command line.

**To point (Enter to end):** Move the cursor to the end point for this segment of the leader and press the left mouse button, An arrow will be placed at the first point picked. Repeat until all the segments of the leader have been specified.

**To point (Enter to end):** When you have picked the end point of the last segment of the leader, press the <Enter> key or right mouse button.
The station and offset label will be placed next to the end point of the leader.

**To point (Enter to end):** Enter

**Pick start of leader:** Repeats the command

**Note:** The station and offset values are rounded based on the values specified in the Rounding Options tab of the CGTools > CGOptions dialog box

**Pull down Menu Location:** CG-Survey > CGDraw>Leaders>Station-Offset
**Keyboard Command:** STOL, CG_STA_OFF_LEADER
**Prerequisite:** Point group must be created

---

**Query**
Selecting Query and then selecting a drawing object will display information related to the following C&G entities:

- Point symbols and labels
- Lines
- Arcs
- Polylines
- Calls
- Structure Footprints
- Coordinate, Call and Curve Tables

---

**Prompts**

**Select entities:** (Pick entity on screen) Entities in set: 1
**Select entities:** (item selected) C&G POLYLINE
Below is an example of a Query listing of a C&G Polyline:

Coordinate File: CGDEMO.CRD (C&G Numeric)
Plotted from Auto Mapping: No
Layer: Boundary
Points defining C&G Polyline: 11-9
Polyline is NOT CLOSED

Pulldown Menu Location: CG-Survey > CGDraw>Query
Keyboard Command: Q, CG_QUERY
Prerequisite: Coordinate file

Drawing Inspector

This feature displays information related C&G and CAD graphical entities.

Prompts

If the Drawing Inspector is turned on and the cursor is held over a C&G point the information for it is displayed at the cursor. The information includes the point ID; the northing, easting, and elevation; the description and the coordinate file that this point was plotted from.

In the case of a C&G Line, the drawing inspector will display the coordinate points used to create the line and the bearing of the line.
If the cursor is over a C&G Arc the drawing inspector will display the PC, PT and Radius point IDs, the chord bearing and distance and the radius.

Pulldown Menu Location: CG-Survey > CGDraw > Drawing Inspector
Keyboard Command: DIN, CG_DRAWING_INSPECTOR
Prerequisite: Clicking the Drawing Inspector menu item current state turns On or Off this switch

Drop C&G Attributes

This feature allows you to strip the C&G attribute from any C&G entity. When the C&G attribute is dropped, the graphic entity becomes standard CAD entity and will no longer be affected by the Refresh Screen feature nor can they be used by C&G commands requiring C&G entities as input.
**Prompts**

Select entities: pick on graphic screen  
Entities in set: 1  
Select entities: pick again on screen  
Entities in set: 4  
Select entities: select another set of entities by window  
Entities in set: 7  
Select entities: Specify opposite corner: 8 total found,  
Entities in set: 8

Pulldown Menu Location: CG-Survey > CGDraw> Drop C&G Attributes  
Keyboard Command: DROP, CG_DROP  
Prerequisite: Coordinate file

---

**re-Associate Coord. file**

This routine allows you to associate the current drawing file with different coordinate file than created the drawing file. An example of this could be a phase of a project. The over all project coordinate file might contain 10,000 to 15,000 coordinates, While working on a phase of the over all project a separate, smaller, coordinate file was created, easier to work with a 1000 points rather than 15,000. Now you want to re-associate this new drawing file with the over all project coordinate file.

---

**Prompts**

After selecting the re-Associate command there will be displayed a Warning dialog box. This box recommends that you create a backup of your drawing file. The danger with using this application is if the coordinates are not managed carefully and the same point ID’s were used in both the overall project file and the out parcel then the graphics will be incorrect. C&G graphics are based on the coordinate file and if the X/Y/Z values change so does the graphics.
Do you wish to Continue? Press <Y> button: Y
Re-associate only those C&G entities plotted using which coord. file [Any_file] <A>: A

An Additional Warning message may also appear indicating conflicts in linked crd files
Do you wish to Continue? Press <Y> button: Y

Pulldown Menu Location: CG-Survey > CGDraw>re-Associate Coord. file
Keyboard Command: Not available
Prerequisite: Coordinate file.

Refresh Screen
Many graphic entities created by CGSurvey contain attributes that tie them to the coordinate file (C&G points,
lines, arcs, calls, etc.). Examples would be point numbers, elevations, and descriptions that are plotted with the node when you plot points. However, once an entity is drawn the user is free to move or edit it. Also, it may be necessary to change the coordinates of the point or points used to create the entity.

If C&G entities are edited or the coordinate values change, you refresh the drawing so that it reflects the current coordinate file values. You can use the Refresh Screen feature to find all C&G entities tied to the coordinate file and read the points from the coordinate file and redraw the entities based on the current coordinate values.

Prompts

Check the appropriate boxes in the list to refresh: Press Ok to continue
Do you wish to retain the point symbol size and Label height of the existing points?: Press <Y> button

Below is example of Refreshed screen entities:
Command: cg_refresh
24 Lines refreshed.
2 splines refreshed.
24 Calls refreshed.
24 Points refreshed.
There were 2 C&G polylines refreshed.

Pulldown Menu Location: CG-Survey > CGDraw>Refresh Screen
Keyboard Command: REF, CG_REFRESH
Prerequiste: Coordinate file.

CGMngmt

Point Manager

The point manager allows the user to perform most of the normal coordinate file management functions. You can perform whole file operations such as renaming the file, copying or moving the file, etc. There are also point operations which allow the user to add, delete, or change individual points or groups of points in a coordinate file.

The C&G Point Manager dialog (shown below) is divided into three sections. These sections are described below.
Current Coordinate File Information

This section gives you basic information on the currently selected coordinate file. The Directory and File Name defaults to the currently active coordinate file but you can choose to perform operations on any one of the supported types of coordinate files by clicking the Browse... button. When you click the Browse... button you will see a file dialog allowing you to choose the coordinate file you wish to work on. The Make Current checkbox allows the user to make the specified file the current file. Thus, when the dialog closes, the file will be used for future commands requiring a coordinate file.

File Operations

This section of the dialog allows you to perform operations that effect the entire coordinate file.

There eight operations that can be performed using this section of the dialog (see descriptions listed below). To perform one of the operations on the file shown in the Current Coordinate File Information section, click on the radio button for the desired operation then click the Perform Operation button.

Apply Desc Table

This operation only applies to C&G coordinate files and will not be available for other file types. When you apply a description table to a coordinate file it translates the numeric codes found in the description field using a C&G description table. For each point in the coordinate file having an integer in the description field the program looks for that integer description number in the description table. If a matching description number is found in the description table, the description found in the description table is placed in the description field for that point and the description number is placed in the code field for that point. The point is then stored back to the coordinate file with the changed field values. If no match is found the point is not changed in any way.
Change Desc Length

This operation only applies to C&G coordinate files and will not be available for other file types. When a C&G coordinate file is created, the user is allowed to specify the length of the description for a given point in the file. The description length may be between 1 and 100 characters. This operation allows the description length to be changed. It can be made smaller or larger. If an existing point in a coordinate file has a description that is longer than the new description length, the description will be truncated. When you click the **Perform Operation** button you will be asked to enter the desired description length (see dialog below).

![Description Length dialog](image)

Change File Type

This operation allows the use to convert among the supported types of coordinate files. The types supported are C&G numeric (*.crd) and alphanumeric (*.cgc), Carlson numeric (*.crd) and alphanumeric (*.crd), Simplicity (*.zak) and AutoCAD Land Desktop (*.mdb). When you select this operation and click the **Perform Operation** button you will see the **Change File Type** dialog:

![Change File Type dialog](image)

In the **Change File Type** dialog choose the type of file you want the current file to be converted into by clicking on
the appropriate radio button.  

**Note:** the radio button for the current file type is greyed out.

After choosing the file type click the **OK** button. Click **Cancel** to cancel the operation.

If you attempt to convert to a file type having point ID length or description length limits that are less than the limits for the file being converted, you will get the following warning:

![Warning dialog](image)

**Copy File**

Performs a basic file copy. **Must be to another directory and/or file name.** When you click the **Perform Operation** button you will be asked to specify the copied file name and directory using a file dialog (see below).

![Copy file dialog](image)
Note: by changing the **Save as type:** this command can change the file type when it copies the file. However, if the type of file being copied has maximum allowable point IDs or descriptions that are greater than one or both of those for the file being copied to, you will receive a warning that point IDs and/or descriptions may be truncated (see Change File Type section above).

**Delete File**

Deletes the file listed in the **Current Coordinate File Information** area of the **C&G Point Manager** dialog along with any of its associated files. Before actually deleting the file you must click the **Yes** button in the following dialog.

![Delete File Confirmation Dialog](image)

**Edit File**

Allows the user to use the CGEditor to edit the coordinate file. You may add and delete points or edit any of the fields for an existing point (see the CGEditor section for more information on using the CGEditor).
Move File

Moves the current file to a new location. You will use a file dialog to specify the new location of the file. When moving a coordinate file you may also change the file type by changing the **Save as type:** The same cautions with regard to possible point ID and description truncation apply here as they do any time you change the file type (see Change File Type section above).

Rename File

Simply renames the file to whatever name the user specifies. You will use a file dialog to specify the new name and location of the file. Thus this command may be used to change the file type and/or move the file to a different directory. To change the file type change the **Save as type:** in the file dialog when you specify its new name. The same cautions with regard to possible point ID and description truncation apply here as they do any time you change the file type (see Change File Type section above).

Point Operations

You may perform several operations that effect one or more of the points in the current coordinate file in this section of the **C&G Point Manager** dialog. Use the **Points used:** and **Points Available:** lists to help you determine which points or ranges of points you wish to work on.

Add/Delete section
You may use the standard CGSurvey interface or the CGEditor to add or delete points. Choose which one to use using the radio buttons on the right side of the Add/Delete portion of the Point Operations area.

**Add Points**

If you chose to use the CGEditor, the CGEditor will come up (as shown above - see the CGEditor section for more information on using the CGEditor).

If you chose to Use the Standard CGSurvey Command, you will see the Manual Coordinate Storage dialog (see below). Fill in the edit boxes as described in Management > Manual Storage

![Manual Coordinate Storage](image)

**Delete Points**

If you chose to use the CGEditor, the CGEditor will come up (as shown above - see the CGEditor section for more information on using the CGEditor).

If you chose to Use the Standard CGSurvey Command, you will see the following prompt at the Command: line:

Choose initial points for base selection set from coord file. (Enter when done) [All/Block/Code/Desc/Elev/Pt-group/Limits/Radius/Select]: use one or more of the available methods to specify which points are to be deleted from the current coordinate file.

**Buttons section**

**Renumber Points**

If you click on the Renumber Points button you will see the Renumber Points dialog:
Fill in the dialog (see the Management > Renumber Points section for more details) and click OK to renumber the specified range of points. If you check the OVERWRITE Existing Points checkbox, you will not be warned of any points that are overwritten during the renumbering process.

**Import Points**

You can use this to copy points from another coordinate file into the current coordinate file. If you click the Import Points button you will be asked to specify the coordinate file from which the points are to be imported. After specifying the import file name, you will use the C&G Select Points from: dialog to select which point are to be imported:
You can select any one of the methods you wish to use to choose the points by clicking one of the methods of point selection in the **Choose Points** section of the dialog. You may also specify whether you wish to **Include** or **Exclude** the points chosen. If you include the points, they will be added to the list from the coordinate file. If you exclude the points, the points chosen will be removed from the list of points previously **Included**. The method of choosing the points is very much like using the

**Choose initial points for base selection set from coord file. (Enter when done)**

[All/Block/Code/Desc/Elev/Pt-group/Limits/Radius/Select]:

prompt. For example, if you choose the **Include** radio button and the **All** radio button then click on the **<Add** button, all the points in the coordinate file will be shown in the list on the left side of the dialog. If you then choose the **Exclude** radio button and the **Block** radio button, fill in the block of points you wish to remain in the list, then all but these points will be excluded from the list when you click the **Remove** button (see the example dialog below).
When the points you wish to import are all in the list on the left, click OK.

**CAUTION:** If the points that are being imported exist in the current coordinate file, they will be overwritten without warning!

**Export Points** - click the **Export Points** button to copy points from the current coordinate file into another coordinate file. You will be asked to specify the file to export the points into, then similar to importing points, use the **C&G Select Points from:** dialog to select the points to be exported. Click **OK** in the **C&G Select Points from:** dialog to export the points.

**CAUTION:** If the points that are being exported exist in the file they are being exported to, they will be overwritten without warning!

**Prompts**

Choose initial points for base selection set from coord file. (Enter when done)
[All/Block/Code/Desc/Elev/Pt-group/Limits/Radius/Select]: use one or more of the available methods to specify which points are to be deleted from the current coordinate file. Note: this prompt is only used if you have the **Use the Standard CGSurvey Command** radio button set.

**Pulldown Menu Location:** CG-Survey > Management > Point Manager
**Keyboard Command:** cg_pt_mngr
**Prerequisite:** One or more Coordinate files.
**Edit Coordinates (CGEditor)**

The user can use the CGEditor to edit an existing coordinate file or create a new one. You can add and/or delete points and edit existing points. The CGEditor has many sophisticated editing tools that make editing fast and relatively easy. Please refer to the CGEditor section of the Tools menu for a detailed explanation of how to use the CGEditor.

**Pulldown Menu Location:** CG-Survey > Management > Edit Coordinates (CGEditor)

**Keyboard Command:** EDC, CG_EDIT_COORDS

**Prerequisite:** None

---

**Auto Create Points**

The purpose of this feature is to create points in the current coordinate file and draw the associated point symbols using coordinate values extracted from existing drawing entities. These drawing entities may or may not have been created with CGSurvey. The user can automatically place C&G point symbols at the vertices, radius points, insertion points, etc. of selected lines, arcs, points, polylines, and point blocks. The coordinates of the newly created points are then saved in the currently open coordinate file.

**Note:** Unless point symbols are picked, the coordinates that are stored will be the coordinates of the CAD entity. In the case of point symbols, the point ID will be read and used to look up the proper coordinates in the current coordinate file.

After picking the Auto Create Points menu item, the Auto Create Points dialog box will appear:

**Entity Types section**

Select the entity types for which you wish to create C&G points. You can check any combination of the available entity types.

When you click the Select Entities button, specifying only certain entities allows you to window a large area but only have points created for the specified types of entities. You may also select individual entities or several groups of entities. After selecting the entities, click the Create Points button to create the points and save them to the current coordinate file.

**Point Blocks**

If you wish to have coordinates created for point blocks (or inserts) and you want the point ID, description and elevation to be set from information contained in the block, the block must have attributes that can be used to obtain these values. When you choose Point Blocks, the following edit boxes in the dialog are activated and must be filled out:

**Block Name:** Specify the name of the blocks you wish to have points created for.

**Point Attribute Tag:** For the block entities chosen, specify the tag name for the attribute of the block contains the
point ID. If no point ID attribute is found then the next sequential point ID will be used.

**Description Tag:** For the block entities chosen, specify which attribute of the block contains the description. If descriptions are ON and no description attribute is found then the default description will be used.

**Elevation Tag:** For the block entities chosen, specify which attribute of the block contains the elevation. If elevations are ON and no elevation attribute is found: if the *Use Z-Value as Elev* is checked, then the Z value of the block insertion point will be used for the elevation of the newly created point; otherwise the specified default elevation will be used.

### Point Creation Information section

**Starting point number:**
Use this to specify the starting point number. Specifying anything other than the next available point in the coordinate file as the starting point makes it possible that one or more existing points could be overwritten. However, whenever a situation arises that a point in the coordinate file may be overwritten, a dialog box will appear warning you of this and allowing you to decide whether to proceed with the overwrite or not.

**Use coordinate point duplication factor:**
If this box is checkbox Coordinate point duplication tolerance edit box is activated and you must enter a tolerance for determining coordinate point duplication. This is used to test if a new point that is about to be created is the same as a point already in the coordinate file. If the new point coordinates are within this tolerance the new point will not be created.

**Use Z-Value as Elev**
Select this box if the entities you select may have a Z value and you want that value used as the point's elevation.

**Default Code**
If point codes are turned ON, then this value is used as the default Code for all newly created points.

**Default Elevation**
If elevations are turned ON, then this value is used as the default Elevation for all newly created points.

**Default Description**
If descriptions are turned ON, then this value is used as the default Description for all newly created points.

**Buttons**

**Select Entities**
Press this button to begin selecting the entities for which you wish to create coordinate points. The dialog box will disappear and you will be asked to use the normal entity selection methods to choose the entities to be used for point creation. Just press Enter at the Select Entities prompt when you are done. You will then be returned to the *Auto Create Points* dialog.

**Create Points**
After the entities have been selected, press this button to create coordinate points using the entities. Any existing C&G lines, arcs or polylines will be ignored since they already have points associated with them. Non-C&G lines, arcs and polylines will be converted to C&G lines, arcs and polylines.

**Cancel**
If you press this button the command will be canceled and not points will be created.
Prompts

Fill in the dialog box as required (see above explanation).
Select Entities: use the normal entity selection methods to select the entities to use for creating points.

Pulldown Menu Location: CG-Survey > Mngmt
Keyboard Command: cg_acp
Prerequisite: Coordinate file.

Manual Storage

This feature allows you to store points in a coordinate file by typing in the values for the point ID, code, northing, easting, elevation and/or description. You also have the option of using the mouse to pick the location coordinates on the screen.

When you choose the Manual Storage menu item:
If a coordinate file is not currently open, you will be prompted to open one.
Next, the following dialog box will appear:

Point

When the dialog box first appears, the point ID (Point) field defaults to the next available point ID as set on the General tab of the C&G Options dialog box. If you enter an existing point number in the point field and click on one of the other fields, the values associated with that point number will be retrieved from the current coordinate file and placed in the other fields. You may edit them if you wish.

Note: If you enter an existing point ID and alter any of the other fields associated with that point then save the point, **NO POINT OVERWRITE WARNING WILL BE GIVEN!**

North, East and Elevation

There are three different ways to enter coordinate values:
1. You can type in the coordinate values and elevation in the appropriate edit boxes.
2. You can duplicate a points values by entering a ‘+’ sign and a point ID (example: +25) in the North field. When you click on another field, the coordinate values for the specified point will be automatically entered in the North, East and Elevation fields.
3. Or you can press the Pick Coords button. When you do this the dialog box disappears and you are prompted to pick a point on the screen. Once you have picked the desired point on the screen, the dialog box reappears with the coordinates of the selected point entered in the North and East fields.

Note: If you pick a C&G point, the coordinate values will be read from the coordinate file.
Note: The elevation field is only activated if Elevation is ON.
**Code and Description**

Enter the desired description in the description edit box.

Enter the point code in the edit box. The point code field is a 4 digit alpha or numeric code only used by C&G. When present it can be used as a sorting tool in addition to the description table.

**As an example:** say that the description table number 25 is defined as 'Sanitary Manhole'. In addition to using 25 from the description table you also have used the code 'AB' for As-Built and 'DS' for design. Now you can build a selection set of all the description 25's, excluding all of the 'AB' codes and the selection set will contain only those points that are Design Sanitary Manholes.

**Note:** If descriptions are ON and Get Description From Table is checked, then if you enter an integer code in either the Code or Description field, that number will be used to lookup a description in the current description table. If a matching number is found it will be used for the code and the associated description will be used for the point's description. If there is no matching number found in the description table all fields will remain as entered.

**Buttons**

**Store Point:** When all the fields are entered, press the Store Point button to store the point in the coordinate file. If Auto Point Plot ON is checked on the Graphics tab in the C&G Options dialog, the point will be plotted as well.

**Reset:** This button clears all the fields in the dialog box and sets the point number to the next available point number.

**Pick Coords <:** click this button to use the mouse cursor to pick the point's coordinates on the screen.

**Cancel:** Press this button when done.

**Prompts**

**Pick coordinates for point 'point ID':** use the mouse cursor to pick the coordinates for the point.

**Pulldown Menu Location:** CG-Survey > Mngmt

**Keyboard Command:** cg_man_coord_store

**Prerequisite:** Coordinate file.

---

**Show Used/Free Points**

**Show Free Points**

This feature lists the groups of point numbers that have not been used in the current coordinate file. It will report the free point IDs for any coordinate file that has all numeric point IDs, even if the coordinate file format would allow alpha characters in point IDs.

**Pulldown Menu Location:** CG-Survey > Mngmt > Show Used/Free Points

**Keyboard Command:** cg.free

**Prerequisite:** Coordinate file.
Show Used Points

This feature lists the groups of point numbers that are in the current coordinate file. It will report the used point IDs for any coordinate file that has all numeric point IDs, even if the coordinate file format would allow alpha characters in point IDs.

Pulldown Menu Location: CG-Survey > Mngmt > Show Used/Free Points

Keyboard Command: cg_used

Prerequisite: Coordinate file.

Delete

This feature allows the user to delete selected points from a coordinate file.

If a coordinate file is not open, you will be prompted to open one.
Select the points you wish to delete, either by picking with the mouse or entering the point sequence at the command line.
When point selection is complete, press Enter.
A dialog box will come up asking if you are sure you want to delete the points.
If you click OK, the points are deleted.

Note: Deleted points CANNOT BE RECOVERED unless point history is turned on. (See Carlson Configure)

Prompts

Choose initial points for base selection set from coord file. (Enter when done)
[All/Block/Code/Desc/Elev/Pt_group/Limits/Radius/Select]: Use any of the point ID selection methods to specify which points you wish to delete from the current coordinate file.

Pulldown Menu Location: CG-Survey > Mngmt

Keyboard Command: cg_delete_coords

Prerequisite: Coordinate file.

Fix Coords

This feature should only be used if you wish to attempt to repair a damaged C&G coordinate file. A file can sometimes become damaged when the computer is shut down prior to closing the file. It is wise to always keep a backup copy of your coordinate files in case a damaged one cannot be fixed.

Before running this command, try to open the file after closing any other C&G softer that may be running.

When you run this command you will first be warned that only C&G files should be fixed:
When the file dialog comes up, browse to the file you wish to attempt to repair.

If the fix is unsuccessful, you will get an error message otherwise the fix was successful.

**Prompts**

Use the file dialog to choose the file to be fixed.

**Pulldown Menu Location:** CG-Survey > Mngmt  
**Keyboard Command:** cg_fix_coords  
**Prerequisite:** Possibly damaged C&G Coordinate file.

**List**

This feature allows the user to list all the information associated with selected points in the current coordinate file. If **Display at command line On** is checked on the Output tab of the C&G Options dialog box, the information for the selected points is displayed at the command line (press <F2> to view it). Otherwise the output is sent to the print file. If a coordinate file is not open, you will see a file dialog allowing you to open one.

**Note:** To print and/or view the print file after listing the coordinates, choose **Print/View Print File** from the CG-Survey > File menu. This will open a text editor with the print file as the current file. You may view the file or print it using the text editor.

**Pulldown Menu Location:** CG-Survey > Mngmt  
**Keyboard Command:** cg_list_coords  
**Prerequisite:** Coordinate file.

**Renumber Points**

This feature allows you to renumber the point IDs of a range of points in the current coordinate file. The point IDs will be renumbered sequentially. If the renumbered points have been previously plotted to the drawing, the points will be redrawn to reflect the changed point IDs.
When you choose this menu item, the following dialog box appears:

**Point ID range to renumber:**
Specify the range of point IDs you wish to renumber. Use the Point IDs Used and Point IDs Available lists to help you determine the appropriate range.

**New Starting point ID:**
Specify the new starting point ID for the range specified. The specified range of points will be renumbered sequentially starting with the New Starting point ID.

**OVERWRITE Existing Points**
If you check this check box and, in the process of renumbering the points, the new point ID is the same as an existing point in the coordinate file, the point will be overwritten. However, if you do not check this checkbox and a possible overwrite is detected, you will be informed of the possible overwrite and required to check this checkbox before proceeding. If you do not wish to overwrite existing points, either re-specify the New Starting point ID or click the Cancel button.

To proceed with the renumbering click the **OK** button.

**Note:** this feature will only renumber points in a coordinate file in which all point IDs are numeric. Thus you can renumber the points in Carlson and C&G alphanumeric coordinate files only if all the point IDs are numeric.

**Prompts**
Fill in the dialog box as specified above.

**Pulldown Menu Location:** CG-Survey > Mngmt
**Keyboard Command:** cg_renumber_pts
**Prerequisite:** Coordinate file.

**Transformations**
**Combined Transformations**
The Combined Transformations feature allows the user to translate, rotate, adjust elevation and/or scale the selected points in a specified coordinate file. The user may also specify whether the transformed coordinates replace the values in the current coordinate file or are saved to another coordinate file.

The **Combined Transformations** menu item brings up the **Transform Points** dialog box. This dialog is used to configure the transformations that will be applied.
To begin the process, in the **Coordinate Files Used** area, choose the coordinate file into which the transformed points are to be stored. If you wish to store them in the current coordinate file, you can go on to the next step. However, if you wish to have the transformed points stored to a coordinate file other than current coordinate file, click the **Browse...** button and use the file dialog to choose the desired destination file.

Next, check the checkboxes for each of the transformations you wish to apply. Then, for each type of transformation to be applied, fill in each item of data in that area of the dialog.

**Translate Points**

To translate the points check the **Translate** checkbox, then fill in the data in the edit boxes in this section of the dialog.

The amount that the selected points are translated in the North and East directions is determined by the difference between the northing and easting of the Reference Point and the coordinates specified in the New Northing and New Easting edit boxes.

**Reference Point** specifies the point in the current coordinate file that is to be used as the reference point for the translation. All the selected points are translated in the same manner as the **Reference Point**. The reference
point will be translated by the difference between its current coordinates and those specified in the **New Northing** and **New Easting** edit boxes. You can fill in the **New Northing** and **New Easting** edit boxes directly or you can enter a point ID in the **New Point** edit box. Assuming the point ID entered is found in the coordinate file, the coordinates read from the coordinate file will be placed in the **New Northing** and **New Easting** edit boxes. You can edit these coordinates or leave them as they are.

**Rotate Points**

If the **Rotate** check box is checked, the selected points will be rotated according to the specifications in the **Rotate Points** area. Rotation defaults to rotation by an angle but can be changed by merely clicking on the **Bearing** or **Angle** radio button.

Use the **Rotate About Point** edit box to specify the point in the current coordinate file about which the selected points will be rotated.

**Rotating by an angle**

To rotate by an angle click the **Angle** radio button. Next, type in the appropriate angle in the **Rotation Angle** edit box or click the **Pick Angle** button and pick the desired angle on the screen.

**Rotating by Bearing**

To rotate by bearing, click the **Bearing** radio button then type in the appropriate values in the **Current Bearing** and **New Bearing** edit boxes or click the **Pick Bearing** button and pick the desired bearing on the screen.

Note: Bearings must be specified using qdd.mm.sss notation, where q is the quadrant (1 = NE, 2 = SE, 3 = SW, 4 = NW), dd is degrees, mm is minutes and sss is seconds. Seconds can be specified to 0.1 seconds if desired.

**Adjust Elevation**

If the **Adjust Elevation** box is checked, the elevations of the points will be adjusted according to the specifications in the **Adjust Elevation** area. The type of elevation adjustment can be specified by clicking on the **Translate** or **Scale** radio button.
To Translate elevations

The elevations of the selected points will be translated by the difference between the Reference Point elevation and the value entered in the New Elevation edit box. When you enter a point ID in the Reference Point edit box and click on another edit box the New Elevation edit box will be filled out with the current elevation of the reference point.

To Scale elevations

The elevations of the selected points will be scaled by the value entered in the Multiplication Factor edit box.

Scale

If the Scale check box is checked the northings and eastings of the selected points will be scaled according to the specifications in the Scale area of the dialog.

Meters to Feet and Feet to Meters

You can scale the coordinates to convert feet to meters or meters to feet by checking the appropriate check boxes. Using this form of scaling disables the other items in this section of the dialog box.

Other types of scaling:

The Point to Hold is a point in the current coordinate file that will be used to obtain the reference coordinates for the application of the specified scaling factor to the selected points.

Simple Scale - if you choose simple scaling it will calculate the scaled differences in northing and easting between the Point to Hold and each of the points selected for scaling. This scaled difference is found by calculating
the difference between the coordinates of the Point to Hold and those of a given selected point and multiplying that times the specified Scale Factor. This scaled difference is then added back to the northing (easting) of the given selected point.

Adjust to Grid - this scaling method uses the Site Elevation (MSL) and the Projection Table Factor to adjust the northings and eastings of the selected points to grid coordinates.

Methods of Specifying Point IDs for the Various Transformations

When specifying a point ID in the transformation data (for example to specify the Reference Point when the Translate checkbox is checked), you may select points using any one of the three options listed below:

1. Type the point ID directly into the edit box provided.
2. Point List: click the Point List button to bring up the Choose Point Blocks dialog. The left pane shows a listing of all the points found in the current coordinate file. Highlight the desired point in the Points Available list then click the Add > button and the point selected will be displayed in the Points Chosen list. In every case you are only allowed to choose a single point. Once you are satisfied with the point chosen click the OK button.
3. Screen Pick: when you click the Screen Pick button the Transform Points dialog disappears and Choose a point: prompt is displayed at the command line. You may type a point ID or pick a point symbol from the drawing.

Selecting Which Points Will be Transformed

At any time prior to clicking the OK button you may choose the points to be transformed. To do this click the Select Points button. The Transform Points dialog will disappear and you will be prompted to choose the points:

Choose initial points for base selection set from coord file. (Enter when done) [All/Block/Code/Desc/Elev/Pt-group/Limits/Radius/Select]: - use any of the available methods to specify the points to be transformed. When done specifying the points press Enter until the Transform Points dialog reappears.

Transforming the points

To transform the selected points, click the OK button. The points will be transformed and saved to the specified coordinate file.

Prompts

Fill out the Transform Points as described above.

When the Select Points button is clicked the following prompt appears:
Choose initial points for base selection set from coord file. (Enter when done) 
[All/Block/Code/Desc/Elev/Pt-group/Limits/Radius/Select]: - use any of the available methods to specify the points to be transformed. When done specifying the points press Enter until the Transform Points dialog reappears.

**Pull-down Menu Location:** CG-Survey > Management > Transformations  
**Keyboard Command:** cg_transformations  
**Prerequisite:** Coordinate file.

### Best Fit Transformation

Best Fit Transformation is used to transform the coordinates in the current coordinate file using a "rubber sheet" method of transformation. 

First the user must .

**Add points from the coordinate file. (Enter when done)** 
[All/Block/Code/Desc/Elev/Pt-group/Limits/Radius/Select]: specify which points are to be transformed using one or more of the available selection methods.

Next, in the **Coordinate Transformation** dialog the user must choose at least 2 points in the coordinate file that are known (or "fixed") points.

![Coordinate Transformation dialog](image)

To specify a fixed point, highlight it in the **Points Available** list then press the **Add** button to copy it to the **Points with Known Coordinates** list on the right. Or, if you wish, you can also specify a known point from the drawing by clicking the **Screen Pick** button and picking a point from the screen or typing a point ID at the command line. After choosing a known point, the following dialog will appear:
The Add Point dialog allows you to change the current coordinates of the known point or accept the current coordinates. When done specifying the coordinates of the known point, click the OK button.

After a point has been placed in the Points with Known Coordinates list on the right, you can edit the values you entered by highlighting the incorrect point and clicking the Edit Point button. Or, if you wish, you can remove an incorrect point from the right hand Points with Known Coordinates list by highlighting it and clicking the < Remove button.

After specifying all the known points, you must specify which coordinate file will be used to store the transformed points. If you wish to use the current coordinate file you need do nothing. If you wish to write the transformed points to a different coordinate file than the one listed in the Store the Transformed Points in the File: edit box, click the Browse... button and use the file dialog (see below) to specify a new or existing coordinate file. When done choosing a coordinate file, click the Open button in the file dialog.
Click the **Transform** button in the **Coordinate Transformation** dialog to cause the transformed coordinates to be calculated and stored in the specified file.

**Prompts**

**Add points from the coordinate file. (Enter when done)**

[All/Block/Code/Desc/Elev/Pt-group/Limits/Radius/Select]: specify which points are to be transformed using the typical C&G Selection method.

Follow the instructions above to fill out the **Coordinate Transformation** dialog box.

**Pulldown Menu Location:** CG-Survey > Mngmt > Transformations
**Keyboard Command:** cg_crd_trns
**Prerequisite:** Coordinate file.

**Copy Coordinates**

This feature allows the user to copy a selected set of points from the current coordinate file to itself or to another coordinate file and, optionally, increase or decrease the point ID by a specified number.

First you must choose the points to be copied:

**Add points from coordinate file. (Enter when done)**

[All/Block/Code/Desc/Elev/Pt-group/Limits/Radius/Select]: use one of the available methods to specify the set of points to be copied.

Next, you must specify what value to add to or subtract from the point IDs to form the new point IDs. If you press `<Enter>` the default is to leave the IDs the same.

**Value to add or subtract from point numbers <0>:** press Enter to leave the point IDs as they are or enter a positive or negative number.

Next you must specify the coordinate file to which the points are to be copied.

**Store coordinates in [Current-file/Existing-file/New-file] <C>:** type "C" and Enter or just Enter to copy the specified points into the current coordinate file. Type "E" and Enter to choose an existing coordinate file into which to copy the points or Type "N" and Enter the copy the points to a new file. If you choose either an existing or new file you will use a file dialog to specify the file to use.

The selected points will then be copied to the specified file.

**Prompts**

---

*Chapter 18. CGSurvey Module*
Add points from coordinate file. (Enter when done)
[All/Block/Code/Desc/Elev/Pt-group/Limits/Radius/Select]: use one of the available methods to specify the set of points to be copied.

Value to add or subtract from point numbers <0>: press Enter to leave the point IDs as they are or enter a positive or negative number.

Store coordinates in [Current-file/Existing-file/New-file] <C>: type "C" and Enter or just Enter to copy the specified points into the current coordinate file. Type "E" and Enter to choose an existing coordinate file into which to copy the points or Type "N" and Enter the copy the points to a new file.

Pulldown Menu Location: CG-Survey > Management > Transformations
Keyboard Command: cg_move_coords
Prerequisite: Coordinate file.

Cut Sheet

The Cut Sheet feature allows the user to compare the coordinates and elevations of two separate coordinate files and create a cut sheet. The idea is to have 2 coordinate files each having at least one group of points that have the same point IDs and are located at about the same coordinates. These points would then represent two surfaces that can then be compared to determine cut and fill depths.

For example, after the site design is completed, you create a coordinate file containing the design coordinates and elevations for the project site. A field crew then goes out to the site and the stakes out the project. Using this rough field data, coordinates can then be calculated, thus allowing you to create a second coordinate file containing the northings, eastings and elevations of the stakes in the field. The field coordinate file can then be compared to the design coordinate file for both horizontal position and elevation.

To compare two coordinate files and create a cut sheet:
If a coordinate file is not currently open, you will be asked to open one.

Note: You should specify the design coordinate file as the current coordinate file.
Next you will be asked to select the coordinate file you wish to compare to the design coordinate file. Choose the field coordinate file
You will then be asked what to compare:

What to compare [Coordinates/coordinates and Elevations]: <E> You can type either C for Coordinates or E for coordinates and Elevations and Enter or, if you want the use the default coordinates and Elevations, just press Enter.

You will then be asked for the Allowable horizontal stakeout tolerance. Any point that exceeds this tolerance is flagged with an asterisk in the printout.

If you selected coordinates and Elevations, in addition to the coordinate comparison, you will also be given a cut and fill report.

To calculate cut and fill, the elevation of the points in the second file will be subtracted from the elevation of comparable points in the first file. A cut is reported as negative number and a fill is reported as positive number. If a point has "No Elevation" in either file, no cut or fill will be shown.
Prompts

What to compare [Coordinates/coordinates-and-Elevations]: <E> To compare elevations and coordinates press Enter or type "E" and Enter. To compare coordinates only, press "C" and Enter.
Specify horizontal tolerance for coordinates: Coordinate points whose locations exceed this value will be stared in the report.
Show all point comparisons or list only those points that are out of tolerance. [All/Out-of-tolerance]: <0> Type either "A" and Enter for All or "O" and Enter or just Enter for Out of tolerance only.

Pulldown Menu Location: CG-Survey > Mngmt
Keyboard Command: cg_cut_sheet
Prerequisite: Two coordinate files: one for "design" coordinates and one for "field" coordinates. These files do not need to specify elevations when doing only a horizontal location comparison.

Description Tables

Description tables have several purposes. They can be used as a shortcut method of using point codes or numeric descriptions to automatically set point descriptions when points are saved to a coordinate file. (Descriptions have a similar functionality when used in conjunction with the CGEditor)

Note: the description table is only used in conjunction with saving points to the coordinate file if Descriptions are ON and Get Description From Table is checked on the General tab of the C&G Options dialog.

Description tables allow the user to specify many details regarding the appearance of a plotted point when using Auto Map > Draw or Trav > Reduce, or anytime points are being plotted.

Note: the description table is only used in conjunction with drawing points if Descriptions are ON and Use description table for point plotting parameters is checked on the Graphics tab of the C&G Options dialog.

A description number acts as an index into the description table.

When saving a point to the coordinate file and a number is used in a description field, the description table will be searched for that number. If that description number is found, the number in the description field will be replaced with the description in the description table. In the case of C&G coordinate files, the number will be moved to the point code field. If no match is found, the number will remain in the description field.

When plotting points, the description for the point being drawn is compared to the descriptions found in the description table. If a match is found then the point is plotted using the parameters specified in that description table entry.

The items in this menu allow you to create and manipulate description tables. You can create a new empty description table and edit it. You can edit an existing description table. You can set or close the current description table and set a different default description table to be used in new drawings.

Pulldown Menu Location: CG-Survey > Mngmt
Keyboard Command: None
Prerequisite: None

Create
This feature allows you to create a new description table. A dialog box will prompt you to name the description table to be created.

Once you have specified the description table to create, you will be allowed to edit the new, empty description table. See Description Table > Edit for a detailed description of how to edit a description table.

Prompts
Use a file dialog to specify the name and location of the new description table and the Edit Description Table dialog to create the table entries.

Pulldown Menu Location: CG-Survey > Mngmt > Description Tables
Keyboard Command: cg_create_desc_table
Prerequisite: None
Edit

This feature allows you to edit an existing description table. The following edit dialog box will appear:

**Note:** Editing a description table does not make it the current description table for the current drawing. To make a description table the current one you must choose the **Set Current** menu item in the **Description Table**.

**Caution for CG-SURVEY for DOS users:** You may open the older format CG-DOS Description Table. However, when opened, the CG-DOS description table will be converted to the current format and once converted, the description table cannot be converted back to or used by the CG-SURVEY for DOS program.

---

**Description Table File:**

Displays the name and location of the description table currently being edited. Pressing the **Browse** button brings up the **Choose a Description Table to Edit** file dialog box allowing you to select a description table to edit.

**Note about the Browse button:** If you are in the editor just after using the create menu item to create a new description table, you should not use the Browse button.

**Descriptions list**

This list contains a list of all the descriptions in the current description table. You may scroll through the list using the scroll bar on the right or use the scroll bar on the bottom to view the complete description. The list contains one description per line. By clicking on a description in the list its properties are displayed to the right of the list.
The list itself contains some of the description's properties but you must click on the specific description you are interested in to view all its specifications. Each row in the list consists of first the description number then the description itself then the symbol and symbol and label height.

**Description section**

**Description Number:** This number acts as an index to the description table.

**Description:** The description you wish to set parameters for.

**Auto Map Line Drawing section**

If you check the **Draw Lines ONLY** checkbox then during Auto Mapping (see Draw > Auto Map > Draw) points with this description will not have the point symbol drawn but will be connected by lines if the line drawing codes are used. The **Line Type to Use** drop down box allows you to choose one of the currently loaded line types for the lines drawn between points having this description.

**Point Symbol section**

**Symbol:** The drawing in the box on the left side indicates which point symbol is currently specified for this description. The text next to the symbol drawing is the name of the symbol minus the .dwg ending. This is the symbol to be used when plotting a point having a description matching that specified in this description entry. You may specify any valid block name by first selecting the type of symbol you wish to use: either Carlson or C&G. You can specify any standard C&G or Carlson symbol supplied with the software or create your own custom point symbols. Custom point symbols must be located in either the users Sup directory with the Carlson symbols or with the C&G symbols in Sup\CGPTSYM generally found under C:\Documents and Settings\<User Name>\Application Data\Carlson Software\<Carlson product name>\<CAD version> directory.

You may press the Change Symbol button to view and/or select the desired symbol.
**Symbol Layer:** The drawing layer that the point symbol will be plotted on for any point having a description matching that specified in this description table entry.

**Point Labels section**

Point Label Positions
The entries in this area refer to the plotting of Point ID, Description and Elevation labels around a point symbol.

Layer
The Point ID, Description and Elevation layer names can be specified. If none is specified then the current layer will be used.

Position
You can assign the Position of the point number, elevation and description labels in relation to the point symbol.

Valid positions are 0 through 9 based on the numeric keypad on your keyboard. Consider 5 as the location of the center of a point symbol. Labels can be placed around the point symbol just as the other numbers surround 5. You identify the location where you want the label to be placed around the point symbol by selecting the number on the numeric keypad that corresponds to that relative location. The relative positions are also indicated in the list and can be picked directly from the list.

Position 0 - indicates that you do not want the label to be plotted.
Position 5 - can only be used for the elevation label. (If you select position 5 for any other label it will be treated as
Position 0). If you select position 5 for the elevation label the whole number portion of the elevation will be plotted to the left of the center of the symbol and the decimal portion of the elevation will be plotted to the right.

Whole Places - can be specified for the elevation label only.
Decimal Places - can be specified for the elevation label only.

Plot Radial
If Plot Radial is checked, the point labels will be plotted radially from the symbol's center at the Position specified.
If plot radial is not selected, point labels will be plotted horizontally.

**Symbol and Label Size section**

**Symbol Size:** The size of the symbol to be plotted for a point having a description matching that specified for this description table entry.

**Label Size:** The height of the point label text. This refers to labeling symbols with point number, elevation and description.

**Units:** Units can be set to **Scale X Symbol Size** or **Literal**.

**Scale X Symbol Size** indicates that the values for **Symbol Size** and **Label Size** will be multiplied by the drawing scale (Specified on the Drawing Settings tab of the C&G Options dialog) to determine the size of the symbol and/or label in actual drawing units.

**Literal** indicates that the specified **Symbol Size** is in actual drawing units and should not be scaled.

**Note:** If the **Units** for a given description is set to **Scale X Symbol Size**, then the symbol size and label height on the printed drawing are interpreted to be in inches if drawing units are set to FEET on the General tab of the C&G Options dialog and centimeters if drawing units are set to METERS or METRES.

**Buttons**

**List:** clicking this button causes the description table to be printed as a report on the command line and to the print file.

**Add/Replace:** click this button to save your changes when you complete a new description or edit an existing description.

**Delete:** click this button to delete the highlighted description. If you delete a description, it cannot be recovered and you will not be allowed to cancel the deletion.

**Exit:** When finished editing, click this button.

**Prompts**

Use the Edit Description Table dialog to enter or modify descriptions and their drawing parameters.
Set Current
Allows the user to select the current description table using a file dialog. The selected description table will be active for the current drawing. When Set Current is used the description table name and location are saved with the drawing settings.

Prompts
Use a file dialog to choose the current file.

Close Current
Closes the current description table. This is saved with the drawing as part of the CG_SETTINGS.

Set Default
Allows the user to select the default description table using a file dialog. The selected description table will be saved to the CGSURVEY.OPT file for the current user and used to set the default settings for any new C&G drawings created by the current user.

Prompts
Use a file dialog to choose the default file.
Convert to SurvCE FCL file

This feature allows you to convert a C&G description table to a SurvCE feature code list or FCL file.

If you are using SurvCE and wish to import your C&G description table for use with SurvCE use this feature to create the FCL file then upload it to the SurvCE data collector FCL directory.

If a C&G description table is not currently open you will be asked to choose which file you wish to convert using a file dialog box.

Next, using file dialog, you will be asked to specify the name of the FCL file to create.

When you click OK after specifying the FCL file name, the conversion will take place.

Prompts

Use file dialog boxes to pick the C&G description table to convert and to specify the name of the FCL file to create.

Pulldown Menu Location: CG-Survey > Mngmt > Description Tables
Keyboard Command: CG_CONVERT_DESC_TO_SURVCE_FCL
Prerequisite: Existing C&G description table (*.tbl) and its index file (*.tbx).

Point Groups

Point groups were formerly called Batch Point Files or point files. These files are text files with the extension pts.

These features allow the user to create or edit a point group. A point group is simply an ASCII text file that contains a list of point IDs that are in a specific sequence. The points in a point group can describe a tract of land, a road centerline, a utility line, a group of lots in a subdivision, etc. - anything that can be defined by a series of points. Point groups can also contain the PC radius point and PT for horizontal curves as well as vertical curve information.

An example of a point group file:

If you view a point group file in a text editor like notepad you will see something like this example

Note: the text in square brackets does not appear in the file itself - it is only used to clarify this example:

LOT 1 [Subgroup description]
  1 [Point 1]
  23 [Point 23, PC]
  +48 [Clockwise radius point 48]
  49 [Point 49, PT]
  50 [Point 52]
  1 [Point 1, back to starting point]
LOT 2 [Subgroup description]
The above example illustrates a point group with two subgroups. Each subgroup defines a lot. The last point in each subgroup is optional - you don't need to close the lot boundary by entering the starting point twice.

Pulldown Menu Location: CG-Survey > Mngmt
Keyboard Command: None
Prerequisite: Coordinate file.

Create

There are two ways to create a new point group: you can use this command or you can use the CGEditor. Previous C&G users may prefer to use this command but the CGEditor allows the user the ability to view and edit the point group as it is being created.

If a coordinate file is not open, you will be prompted to open one using a file dialog.

Once the coordinate file is open, the point group file dialog can be used to specify the name of the point group file you wish to create.

Subgroup description <Enter when done>: Enter the subgroup description.
Specify points for subgroup <filename>: [Block/Code/Desc/Elev/Indiv/limits/Radius/Vertical_curve] <pick polyline>: Use any of the available methods, including picking a polyline in the drawing, to specify the point IDs of the points in the subgroup. Remember that, within a given subgroup, you are defining a specific shape or line and thus the points need to be entered as an ordered sequence that properly defines the lot, alignment, etc.
Repeat the steps outlined above until all subgroups and their points have been entered.
To end the command and create the point group file, press Enter twice after specifying the last point in the last subgroup.

Using a Polyline to specify a group of points

If you pick a polyline, the coordinate file is searched for points having northings and eastings that match the x and y coordinates of the vertices of the polyline. If none of the points in the coordinate file match the polyline vertices, then no points are added to the points in the current subgroup. Any points that match are added to the subgroup points and you are prompted for the next point in the subgroup. You may continue using any of the methods of specifying points, including picking other polylines.

Entering a Curve

First type "I" and enter to enter individual points. As you are specifying the individual points in the subgroup you can specify a curve by entering the radius point ID immediately after entering the ID of the PC. The radius point must be indicated by preceding its point ID with a plus sign for a clockwise curve or a minus sign for a counterclockwise curve. The next point ID you enter is assumed to be the PT.
Vertical Curves

If you are creating a point group to define a road alignment, you may wish to enter vertical curve information so that both the horizontal and vertical alignments are defined.

**Note:** You may find it more convenient to use the CGEditor to enter vertical curve information.

To do this type “V” and Enter at the command prompt. You will see the following prompt:

**Vertical Curve 1**
[Next/slope-In/slope-Out/Length/pvi-Station/pvi-Elevation]:

For the first vertical curve you must enter five curve components. Enter these five components by typing the capitalized letter representing the component that you wish to specify, then press Enter. You will be prompted to enter the component specified.

You must enter a value for each of the following five required fields:
- The **slope-In**
- slope-Out
- Length of the vertical curve
- pvi-Station
- pvi-Elevation.

**Entering succeeding vertical curves**

After entering the information for the first vertical curve, enter <N> for Next. Since the slope in and PVI elevation are determined by the previous vertical curve information, so you need only specify three fields for any additional curves:
- slope-Out
- Length
- pvi-Station

Use Previous and Next to enter and/or change the vertical curve information. You may enter as many as fifty vertical curves. You can press the F2 key at any time to view the prompt history screen, then use the scroll bar on the right to view the entire data entry sequence.

**Multiple Subgroups**

To place more than one subgroup in a single point group, press Enter when asked to select another point for the current subgroup. This ends input for the current subgroup.

At the **Subgroup description <Enter when done>** prompt, enter the name of the next subgroup and go on to enter a new series of points, including both horizontal and vertical curve information as needed. Continue to enter subgroups of points by repeating these steps until all subgroups have been entered. When you have entered all the subgroups, press Enter until you get the Subgroup Description prompt. Press Enter at the Subgroup Description prompt to end the command and create the point group file.
Prompts

Subgroup description <Enter when done>: Enter the subgroup description.
Specify points for subgroup <filename>: [Block/Code/Desc/Elev/Indiv/limits/Radius/Vertical_curve] <pick polyline>: use one or more of the available methods to specify points in the current subgroup.

Vertical Curve 1
[Next/slope-In/slope-Out/Length/pvi-Station/pvi-Elevation]: specify which element of the vertical curve you wish to enter or type "N" and Enter to begin entering the next vertical curve.

Vertical Curve ##
[Next/slope-Out/Length/pvi-Station]: after entering the data for the first vertical curve the following curves are controlled by the initial curve. Thus the prompt changes.

Pulldown Menu Location: CG-Survey > Mngmt > Point Groups
Keyboard Command: cg_create_bpf
Prerequisite: Coordinate file.

Edit

The Edit Point Groups feature allows you to use the CGEditor to edit/create an existing point group file.

CGEditor General Information

The CGEditor is an integral part of preparing files for use in C&G applications. The CGEditor is a very powerful tool. You can open multiple data files of any supported file type and edit the files as needed. The CGEditor has a full complement of tools for searching and replacing and navigating within a file. It will also allow you to cut or copy records from one file and paste them into another file in order to merge files, move data between phases of a job, etc.

The CGEditor can create and/or edit six types of data files used by C&G:

Raw Data Files

Raw data files contain information pertaining to a field traverse. Raw data files are typically downloaded from the data collector and converted to the C&G raw data file format. These files have the extension .CGR.

Map Check Files

Map Check files contain bearing, distance and curve information and are typically used to calculate the closure of a deed description. These files have the extension .CGM.
Cross Section Files

Cross Section files contain one or more cross sections identified by their station along the alignment. Each cross section record has the percent grade defined for its left and right slopes. Following the "Station" record are several "Point" records containing the elevations and offsets of the points along the cross section. Cross section files consist of a pair of files; the main data file has the extension .CEW and the index file has the extension .CEX.

Template Files

Template files are merely cross section files that represent a standard cross section and can be used to generate other cross section files. However, unlike cross section files, template files use an integer ID instead of a station to uniquely identify each template. Like cross section files, the percent grade is defined for the left and right slopes of each template and there are a set of "Point" records specifying the template elevation at a given offset. The centerline elevation at offset 0.00 is typically set to 0.00. Template files consist of a pair of files; the main data file has the extension .CTP and the index file has the extension .CTX.

Point Group Files

Point Group Files are simply a list of point numbers that can define a group of points, a lot or parcel, or an alignment. These are ASCII files and have a .PTS extension.

Coordinate Files

CGSurvey supports many different coordinate file formats:

- C&G .CRD/.IDX - C&G numeric coordinate files
- C&G .CGC/.CGX - C&G alpha-numeric coordinate files
- Carlson .CRD - Carlson coordinate file format, numeric and alpha-numeric
- Simplicity .ZAK - Simplicity coordinate file
- LDT - MDB - Land Desk Top coordinate file

Note: for further and complete information on using the Edit Raw File see the chapter on CGEditor in the Tools section.

Pulldown Menu Location: Management\Point Groups\Edit
Keyboard Command: BPF, CG_EDIT_BPF
Prerequisite: Open Raw File
Refresh Status Line

The status line is found at the bottom of the main CAD window border near the screen coordinate display. It contains the name of the current coordinate file and the number of points in it. Whenever this information is not shown or you want to make sure it is up to date, choose this menu item.

Pulldown Menu Location: CG-Survey > Mngmt
Keyboard Command: cg_status_line
Prerequisite: Coordinate file.

CGTopo

Topographic Settings

Allows you to view or change the Topographic Settings. See the Topography tab section of the CG Options menu item of the Tools menu.

Prompts

None

Pulldown Menu Location: CG-Survey > Topo
Keyboard Command: cg_cont_setup
Prerequisite: None

New Surface

The New Surface feature allows the user to create a new C&G surface based on any coordinate file containing points with elevation data. The surface is stored as a TIN file (*.tin) so, in the sections that follow, the words "surface" and "TIN" will be used interchangeably.

Choose the CG-Survey > Topo > New Surface menu item. If a coordinate file is not open you will be asked to choose one using a file dialog. Next, you will be asked to specify the name of the surface file (*.tin) to create. As illustrated in the following file dialog, you can create a new file by clicking on the New tab or pick an existing file to overwrite by clicking on the Existing tab:
If you choose to overwrite an existing file you will see the following dialog:

Click Yes or No depending on your needs.

Choose initial points for base selection set from coord file. (Enter when done)
[All/Block/Code/Desc/Elev/Pt-group/Limits/Radius/Select]: use any of the available methods to select the points to be used in creating the surface. Press Enter when done.

Note: Any points stored not having an elevation will be automatically filtered from the points selected. Also, if you used the CG-Survey > Draw > Auto Map > Draw feature and curves were created during the process, the PC, PT and radius points may require special consideration. If elevations were ON during the Auto Map Draw process, you were asked if you wanted to assign elevations to the points generated for curves. If you answered yes, then elevations were assigned to these points. Since these are calculated elevations and do not necessarily reflect the ground elevations, you may want to use the code "MP" to exclude these points from the selected points.

Once all the points are selected, the selected points will be scanned for duplicates. This is done to avoid having two or more points at the same location having the same or different elevations (this software does not allow vertical or overhanging topography). If any duplicate points are found, they are displayed at the command line in
the following format:

**Duplicate Point: 234 -&gt; 213**

This indicates that points 234 and 213 have the same northing and easting. When this occurs, the interpolation process will be terminated. You may either edit the coordinate file and/or exclude duplicates and attempt to create the surface again.

If no duplicate points are found, the **Contouring Report** dialog will appear:

![Contouring Report Dialog](image)

The **Contouring Report** dialog displays information about the TIN and how it was formed. Check the information to make sure it is correct. If it is correct, click the **OK** button, if not, click **Cancel**.

If you did not click **Cancel** in the **Contouring Report** dialog, a graphic image of the TIN and contours will be displayed (see below) and the specified TIN file will be created. However, if it is necessary to zoom out to see the entire new surface, the following dialog will appear:

![Zoom Out Dialog](image)

Click **Yes** or **No** according to your needs. If you click **Yes**, the view will be zoomed to show any entities that were visible prior to creating the surface plus the entire surface itself.
This graphic overlay is what you will actually be working with until you are satisfied with the appearance of the topography. Once you are satisfied with the appearance of the topography, the actual creation of the TIN lines and contour polylines in your drawing must be accomplished by choosing the CG-Survey > Topo > Write Surface to DWG menu item.

**Note:** Any time a surface is open and you find that you are unable to see the overlaid image of the TIN and contours, select **Show Surface** from the Topo menu.

### The Finishing Touches

At this point the topography you see on the screen is only a preliminary contour surface. For most jobs, you must refine the TIN by delineating break lines to create the well defined grade breaks noted in the field. Generally, it will also be necessary to define include or exclude boundaries to avoid contours passing through buildings, bodies of water, etc. You will also want to write the contours to the drawing and then label the elevations of the final contours.

### Prompts

**Choose initial points for base selection set from coord file. (Enter when done)**

[All/Block/Code/Desc/Elev/Pt-group/Limits/Radius/Select]: use any of the available methods to select the points to be used in creating the surface. Press Enter when done.

**Pull-down Menu Location:** CG-Survey > Topo  
**Keyboard Command:** cg_new_surface  
**Prerequisite:** Coordinate file with elevations
Open Surface

Open an existing surface file (*.tin) using a file dialog.

If the file opens successfully and it is necessary to zoom to see the entire surface, the following dialog will appear:

![Dialog showing yes or no options]

Click Yes or No according to your needs. If you click Yes, the view will be zoomed to show any entities that were visible prior to opening the surface plus the entire surface itself.

Prompts

None

Pulldown Menu Location: CG-Survey > Topo
Keyboard Command: cg_open_surface
Prerequisite: Coordinate file and C&G surface file (*.tin).

Close Surface

Saves and closes the current surface.
When you close a surface, you will be asked if you wish to write the contours to the drawing.

![Dialog for writing contours]

If you have not already done so, click Yes, otherwise, click No.

Prompts

None

Pulldown Menu Location: CG-Survey > Topo
Keyboard Command: cg_close_surface
Prerequisite: Coordinate file and C&G surface file (*.tin).

Break Lines
After creating a surface, it is necessary to define break lines or topographic grade breaks. For example, if there is a creek on the site and you have points defining the top of both banks and the creek centerline, you do not want the top of bank on one side of the creek directly connected to the top of bank on the other side, eliminating the creek centerline. To avoid this happening, break lines should be created anytime a series of points define a feature that causes an abrupt change in the slope of the ground surface. The topography features cannot make such distinctions without the aid of user specified break lines.

The process of creating break lines is an interactive process, as you create break lines the contours and TIN will change immediately. You may create break lines using one or more of the methods available in the Break Lines submenu.

Pulldown Menu Location: CG-Survey > Topo

By Point Number
When you choose this method you will see the following prompt at the command line:

For the first point entered the following prompt is used:

Enter point sequence
[Point-group/Reset/turn-Snap-on] (last point = <none>):

For all the succeeding points the following prompt is used:

Enter point sequence
[Clockwise-curve/ccW-curve/Point-group/Reset/turn-Snap-on] (last point = 1):

Define break lines by either entering the point IDs directly at the command line, picking them graphically from the screen, or using a point group.

The break lines will be drawn in the order in which they are entered.

Prompts
Enter point sequence
[Point-group/Reset/turn-Snap-on] (last point = <none>): Define break lines by either entering the point IDs directly at the command line, picking them graphically from the screen, or using a point group.

or, for the 2nd or later points
Enter point sequence
[cLockwise-curve/ccW-curve/Point-group/Reset/turn-Snap-on] (last point = 1): Define break lines by either entering the point IDs directly at the command line, picking them graphically from the screen, or using a point group.

Pull down Menu Location: CG-Survey > Topo > Break Lines
Keyboard Command: cg_bl_lbp
Prerequisite: Coordinate file and C&G surface file (*.tin).

By Description
This feature allows you to draw break lines between points having a specific description. When you select the By Description menu item, the Draw Break Lines by Description dialog appears.

By default the break lines will be drawn on the break line layer previously specified on the Topography tab of the C&G Options dialog. If you wish to specify a different break line layer, cancel this command and make the change in the options.

Enter the desired description in the Desc: edit box.

If appropriate, check the Match Text Anywhere in Desc checkbox and/or the Force Match to be Whole Word checkbox. If neither of these checkboxes is checked, the description must must be found in the beginning characters in the description.

For Connect Mode choose either Sequential or Closest from the list.

Sequential mode - the coordinate file will be scanned for points with descriptions matching the description specified in the Desc: edit box and break lines will be drawn from point to point in coordinate ID order.

Closest mode - the coordinate file will be scanned for points with descriptions matching the description specified in the Desc: edit box and break lines will be drawn starting with the first point found and continuing from there based on proximity.

Prompts
None

Pull down Menu Location: CG-Survey > Topo > Break Lines
Keyboard Command: cg_bl_lbd
Prerequisite: Coordinate file and C&G surface file (*.tin).
By Code

This feature allows you to draw break lines between selected points having a specified point code. When you select the By Code menu item, the CGSurvey Draw Break Lines by Code dialog box appears.

By default, the break lines will be drawn on the break line layer previously specified on the Topography tab of the C&G Options dialog. If you wish to specify a different break line layer, cancel this command and make the change in the options.

Enter the desired code in the Code: edit box.

For Connect Mode choose either Sequential or Closest from the list.

Sequential mode - the coordinate file will be scanned for points with codes matching the code specified in the Code: edit box and break lines will be drawn from point to point in coordinate ID order.

Closest mode - the coordinate file will be scanned for points with codes matching the code specified in the Code: edit box and break lines will be drawn starting with the first point found and continuing from there based on proximity.

Prompts

None

Pulldown Menu Location: CG-Survey > Topo > Break Lines
Keyboard Command: cg_bl_lbc
Prerequisite: Coordinate file and C&G surface file (*.tin).

Map Draw

The Map Draw break lines feature provides the most powerful way to create break lines. For a complete description of how the Map features work, please see the Auto Map feature help from the Draw menu.

First choose which point IDs will have their descriptions searched for line drawing codes:

Choose initial points for base selection set from coord file. (Enter when done)
[All/Block/Code/Desc/Elev/Pt-group/Limits/Radius/Select]: Use one or more of the available methods to choose the points.

When done press Enter and the break lines will be added to the TIN between the points selected that have the line draw ("BL", "EL") codes embedded in their descriptions. When using Map Draw keep in mind that break lines cannot be curvilinear, so only straight lines will be generated from point to point around curves.

Note: The break lines will only appear as part of the graphic image of the surface shown on the screen. In
order to actually draw the lines on the break line layer you must choose CG-Survey > Topo > Write Surface to DWG and check the Write Break Lines to Drawing checkbox.

Prompts

Choose initial points for base selection set from coord file. (Enter when done) [All/Block/Code/Desc/Elev/Pt-group/Limits/Radius/Select]: Use one or more of the available methods to choose the points.

Pulldown Menu Location: CG-Survey > Topo > Break Lines
Keyboard Command: cg_bl_map_draw
Prerequisite: Coordinate file and C&G surface file (*.tin).

Map Erase

Automatically erases any break lines created using the Break Lines > Map Draw feature.

Prompts

None

Pulldown Menu Location: CG-Survey > Topo > Break Lines
Keyboard Command: cg_bl_map_erase
Prerequisite: Coordinate file and C&G surface file (*.tin).

From Breakline Layer

This feature allows you to add lines that were previously drawn lines on the break line layer to the TIN file as break lines. The break line layer is specified on the Topography tab of the C&G Options dialog.

Note: ONLY CAD or C&G lines drawn on the break line layer will be recognized by this feature.

Prompts

None

Pulldown Menu Location: CG-Survey > Topo > Break Lines
Keyboard Command: cg_bl_layer
Prerequisite: Coordinate file and C&G surface file (*.tin).
Delete From Tin File
This feature removes the selected break lines from the current C&G surface file (*.tin) but does not delete the lines on the break line layer.

At the prompt Select breakline: Use the standard CAD entity selection methods to select the break lines to be deleted from the TIN file. When you press Enter without selecting a break line, the previously selected break lines will be removed from the TIN file.

Prompts

Select breakline: Use the standard CAD entity selection methods to select the break lines to be deleted from the TIN file.

Pull down Menu Location: CG-Survey > Topo > Break Lines
Keyboard Command: cg_delete_bl
Prerequisite: Coordinate file and C&G surface file (*.tin).

Edit Points
This feature allows you to Add Points or Remove Points from the TIN used to form the current surface.

Adding or removing points may be necessary if point locations and/or elevations have changed or more topographic information has been obtained.

Pull down Menu Location: CG-Survey > Topo

Add Points
This feature allows you to add points to those already being used to form the TIN.

Since adding points can effect how breaklines are interpreted, you will first be asked if you wish to use the breaklines currently defined for the surface:

Note: If any of the points in an include or exclude boundary change, the boundaries must be reprocessed.
Next you will be asked to specify the points to be added:

Choose initial points for base selection set from coord file. (Enter when done)
[All/Block/Code/Desc/Elev/Pt-group/Limits/Radius/Select]: use any of the available methods to select the points to add to the surface then press Enter when done.

After entering points, the surface will be redisplayed.

Prompts

Choose initial points for base selection set from coord file. (Enter when done)
[All/Block/Code/Desc/Elev/Pt-group/Limits/Radius/Select]: use any of the available methods to select the points to add to the surface then press Enter when done.

Pulldown Menu Location: CG-Survey > Topo > Edit Points
Keyboard Command: cg_add_surface
Prerequisite: Coordinate file and C&G surface file (*.tin).

Remove Points

This feature allows you to remove points from those being used to form the TIN.

Since removing points can effect how breaklines are interpreted, you will first be asked if you wish to use the breaklines currently defined for the surface:

![Image of a dialog box with options Yes and No]

Note: If any of the points in an include or exclude boundary change, the boundaries must be reprocessed.

Next you will be asked to specify the points to be removed:

Choose initial points for base selection set from coord file. (Enter when done)
[All/Block/Code/Desc/Elev/Pt-group/Limits/Radius/Select]: use any of the available methods to select the points to add to the surface then press Enter when done.

After entering points, the surface will be redisplayed.
Prompts

Choose initial points for base selection set from coord file. (Enter when done)
[All/Block/Code/Desc/Elev/Pt-group/Limits/Radius/Select]: use any of the available methods to select the points
to add to the surface then press Enter when done.

Pulldown Menu Location: CG-Survey > Topo > Edit Points
Keyboard Command: cg_remove_surface
Prerequisite: Coordinate file and C&G surface file (*.tin).

Swap Triangles

This feature allows you to change the position of a TIN line. If you view two adjacent triangles in the TIN as a
quadralateral with a diagonal, swapping moves the TIN line from its current location on the one diagonal to the
opposite diagonal. Since the contours are interpolated along TIN lines, changing the location of the line will alter
the contours that cross it.

To swap triangles, use the mouse to move the crosshair over the TIN line you wish to swap and left click
on the line. You will immediately see the results of the change. To reverse the swap, merely click on the swapped
TIN line again and it will revert back to the original configuration.

Note: Swapping a triangle actually creates a break line in the background, so you may notice the TIN line
changing color depending on the color specified for the break line layer.

Prompts

None

Pulldown Menu Location: CG-Survey > Topo
Keyboard Command: cg_swap_triangles
Prerequisite: Coordinate file and C&G surface file (*.tin).

Show Surface

On occasion the surface may disappear or appear incomplete, choose Show Surface to update the view on the screen.

Prompts

None

Pulldown Menu Location: CG-Survey > Topo
Keyboard Command: cg_show_surface
Prerequisite: Coordinate file and C&G surface file (*.tin).
Define Boundaries

This feature allows you to define the boundaries of areas of the TIN within which you wish to include or exclude contours. For instance, you may define an exclude boundary around a building so that no contour lines will be drawn through the building. You might also want to define the project limits as an include boundary.

**Note:** You are may delineate boundaries within boundaries but a boundary must not cross another boundary.

You can define boundaries **By Point Number**, **By Description**, and **By Code**.

**Pulldown Menu Location:** CG-Survey > Topo  
**Keyboard Command:** None  
**Prerequisite:** Coordinate file and C&G surface file (*.tin).

By Point Number

This feature allows you to define include and exclude boundaries by specifying a series of point IDs. These boundaries are made up of a series lines forming a closed figure and delineate areas where contour lines are to be drawn (Include) or not drawn (Exclude).

By default the boundary lines will be drawn on the Include/Exclude Boundary Line Layer previously specified on the Topography tab of the C&G Options dialog. The *Include Boundary Line Layer* will be used if you are defining an *Include* boundary and the *Exclude Boundary Line Layer* will be used if you are defining an *Exclude* boundary. If you wish to specify a different include or exclude boundary line layer, cancel this command and make the change in the C&G Options dialog.

When you choose this menu item you will see the following prompts at the command line:

For the first point entered:

**Enter point sequence for EXCLUDE boundary**  
[Point-group/Reset/turn-Snap-on/switch-to-Include] (last point = <none>):

For all the succeeding points:

**Enter point sequence for EXCLUDE boundary**  
[cLockwise-curve/ccW-curve/Point-group/Reset/turn-Snap-on/switch-to-Include] (last point = 1):

or

**Enter point sequence for INCLUDE boundary**  
[cLockwise-curve/ccW-curve/Point-group/Reset/turn-Snap-on/switch-to-Exclude] (last point = 1):

Define the boundary lines by either entering the point IDs directly at the command line, picking them graphically from the screen, or using a point group. If you are currently entering *Exclude* boundaries, you can switch to entering *Include* boundaries by typing "I" and Enter or, if you are currently entering *Include* boundaries, you can
switch to entering **Exclude** boundaries by typing "E" and Enter

The boundary lines will be drawn in the order in which the point IDs are entered.

**Prompts**

Enter point sequence for EXCLUDE boundary
[Point-group/Reset/turn-Snap-on/switch-to-Include] (last point = <none>):

or, for the succeeding points

Enter point sequence for EXCLUDE boundary
[cLockwise-curve/ccW-curve/Point-group/Reset/turn-Snap-on/switch-to-Include] (last point = 1):

Define the boundary lines by either entering the point IDs directly at the command line, picking them graphically from the screen, or using a point group. If you are currently entering **Exclude** boundaries, you can switch to entering **Include** boundaries by typing "I" and Enter or, if you are currently entering **Include** boundaries, you can switch to entering **Exclude** boundaries by typing "E" and Enter

**Pulldown Menu Location:** CG-Survey > Topo > Break Lines
**Keyboard Command:** cg_bndy_lbp
**Prerequisite:** Coordinate file and C&G surface file (*.tin).

**By Description**

This feature allows you to define include and exclude boundary lines between selected points having a specified description. These boundaries are made up of a series lines forming a closed figure and delineate areas where contour lines are to be drawn (Include) or not drawn (Exclude).

When you select the **By Description** menu item, the **Draw Boundary Lines by Description** dialog appears.
By default the boundary lines will be drawn on the Include/Exclude Boundary Line Layer previously specified on the Topography tab of the C&G Options dialog. The Include Boundary Line Layer will be used if Boundary line type: list box is set to Include and the Exclude Boundary Line Layer will be used if Boundary line type: list box is set to Exclude. If you wish to specify a different include or exclude boundary line layer, cancel this command and make the change in the C&G Options dialog.

Enter the desired description in the Desc: edit box.

For Connect Mode choose either Sequential or Closest from the list.

Sequential mode - the coordinate file will be scanned for points with descriptions matching the description specified in the Desc: edit box and the boundary lines will be drawn from point to point in coordinate ID order.

Closest mode - the coordinate file will be scanned for points with descriptions matching the description specified in the Desc: edit box and boundary lines will be drawn starting with the first point found and continuing from there based on proximity.

Prompts

None

Pulldown Menu Location: CG-Survey > Topo > Define Boundaries

Keyboard Command: cg_bndy_lbd

Prerequisite: Coordinate file and C&G surface file (*.tin).

By Code

This feature allows you to define include and exclude boundary lines between selected points having a specified point code. These boundaries are made up of a series lines forming a closed figure and delineate areas where contour lines are to be drawn (Include) or not drawn (Exclude).

When you select the By Code menu item, the Draw Boundary Lines by Code dialog box appears.
By default the Boundary lines will be drawn on the Include/Exclude Boundary Line Layer previously specified on the Topography tab of the C&G Options dialog. The Include Boundary Line Layer will be used if Boundary line type: list box is set to Include and the Exclude Boundary Line Layer will be used if Boundary line type: list box is set to Exclude. If you wish to specify a different include or exclude boundary line layer, cancel this command and make the change in the C&G Options dialog.

Enter the desired code in the Code: edit box.

For Connect Mode choose either Sequential or Closest from the list.

Sequential mode - the coordinate file will be scanned for points with codes matching the code specified in the Code: edit box and the boundary lines will be drawn from point to point in coordinate ID order. Closest mode - the coordinate file will be scanned for points with codes matching the code specified in the Code: edit box and boundary lines will be drawn starting with the first point found and continuing from there based on proximity.

Prompts

None

Pulldown Menu Location: CG-Survey > Topo > Define Boundaries
Keyboard Command: cg_bndy_lbc
Prerequisite: Coordinate file and C&G surface file (*.tin).

Process Boundaries

This feature allows you to process all the boundaries specified for the TIN. After specifying new include and exclude boundaries or removing old ones, without processing you will not see the effects of the boundary changes on the screen. Use this feature any time you are working with boundaries and wish to view the resulting contours.

Prompts

None

Pulldown Menu Location: CG-Survey > Topo
Keyboard Command: cg_process_bndy
Prerequisite: C&G surface file (*.tin).

Write Surface to DWG

This feature allows the user to draw the current surface. This feature is necessary since the TIN and contours related to an open surface are merely an image overlaid on the drawing. Typically, this feature would only be used after you are satisfied that the contours are in their final form.
When you select the **Write Surface to DWG** menu item, the **Write Surface** dialog appears:

![Write Surface Dialog](image)

In this dialog check those items you wish to have drawn and whether you wish to save the surface file for later use.

Once you have written the surface to the drawing, you can close the surface using the **CG-Survey > Topo > Close Surface** menu item. Any components of the surface that are written to the drawing will continue to be visible after the surface is closed.

### Prompts

None

**Pulldown Menu Location:** CG-Survey > Topo  
**Keyboard Command:** cg_write_surface  
**Prerequisite:** C&G surface file (*.tin).

---

### Erase Surface from DWG

When you open a C&G surface (or TIN file, *.tin) it is shown on the screen as a graphic image overlaid on your drawing. You must use the **Write Surface to DWG** feature to actually create contour polylines, TIN lines, etc. If the surface changes due to changes in elevation or location of points you will want to erase the old surface and write the new surface to the drawing. However, once a surface is written to the drawing, it can be a difficult process to pick out all the surface entities in order to erase them from the drawing. This feature makes this an easy, one step operation.

You can use the items in this menu to erase the various topographic features: the TIN, Main Contours, Intermediate Contours, Break Lines, Include Boundaries, and/or Exclude Boundaries or All topo items.

**Note:** To erase contour labels use **CG-Survey > Topo > Label Contours > Delete Labels**

**Pulldown Menu Location:** CG-Survey > Topo
Tin
This feature erases all the C&G TIN entities found on the TIN layer specified on the Topography tab of the C&G Options dialog.

Prompts
None

Pulldown Menu Location: CG-Survey > Topo > Erase Surface from DWG
Keyboard Command: cg_erase_tin
Prerequisite: None

Main Contours
This feature erases all the C&G main contour polyline entities found on the main contour layer specified on the Topography tab of the C&G Options dialog.

Prompts
None

Pulldown Menu Location: CG-Survey > Topo > Erase Surface from DWG
Keyboard Command: cg_erase_main_cont
Prerequisite: None

Intermediate Contours
This feature erases all the C&G intermediate contour polyline entities found on the intermediate contour layer specified on the Topography tab of the C&G Options dialog.

Prompts
None

Pulldown Menu Location: CG-Survey > Topo > Erase Surface from DWG
Keyboard Command: cg_erase_interm_cont
Prerequisite: None
Break Lines
This feature erases all the C&G break lines found on the break line layer specified on the Topography tab of the C&G Options dialog.

Prompts
None

Pulldown Menu Location: CG-Survey > Topo > Erase Surface from DWG
Keyboard Command: cg_erase_break_lines
Prerequisite: Coordinate file and C&G surface file (*.tin).

Include Boundaries
This feature erases all the C&G include boundary lines on the include boundary lines layer specified on the Topography tab of the C&G Options dialog.

Prompts
None

Pulldown Menu Location: CG-Survey > Topo > Erase Surface from DWG
Keyboard Command: cg_erase_include_boundaries
Prerequisite: None

Exclude Boundaries
This feature erases all the C&G exclude boundary lines on the exclude boundary lines layer specified on the Topography tab of the C&G Options dialog.

Prompts
None

Pulldown Menu Location: CG-Survey > Topo > Erase Surface from DWG
Keyboard Command: cg_erase_exclude_boundaries
Prerequisite: None

All topo items
This feature erases all the C&G topo entities found on any of the layers specified on the Topography tab of the C&G Options dialog.
Prompts

None

Pulldown Menu Location: CG-Survey > Topo > Erase Surface from DWG
Keyboard Command: cg_erase_all_topo
Prerequisite: None

Label Contours
The items in this submenu allow you to either label contour lines with appropriate elevations or remove previously placed contour labels.

Pulldown Menu Location: CG-Survey > Topo

Place Labels
This feature allows you to place the appropriate elevation labels at selected locations on C&G contour polylines. The label is a TEXT entity overlaying a WIPEOUT entity. The WIPEOUT entity serves to create a space between the label text and the contour line and to keep the contour line from showing through the text and obscuring it.

If you have not already done so, please review the contour labeling settings by choosing the CG-Survey > Topo > Topographic Settings menu item. The labels will be created on the Main and Intermediate Contour Label Layers. The Labeling Interval determines which contours are labeled. For example, if the Labeling Interval is set to 2.00, then every C&G contour polyline that you choose having an elevation evenly divisible by 2.00 will be labeled. The Label-Contour Separation Distance is the space separating the contour line and the start and end of the label text.

Once you have verified the correct settings, choose the Label Contours > Place Label menu item.

At the prompt (see below) use the left mouse button to pick any point that is on one side of the contour line you wish to label.

Pass a line thru the contours to be labeled.
Pick first point on line. [<ENTER> to quit]:

Now, at the next prompt (see below), drag the rubber band line through one or more of the contours you wish to label and click the left mouse button a second time.

Pick second point [<ENTER> to quit]:

The labeling operation can be repeated as many times as needed, then press Enter to end the command.

Some Trouble Shooting Tips for Labeling Contours:
When a C&G surface is opened it is shown only as a graphic image overlying the drawing. Therefore, before you
can place labels on the contour lines, the surface must be written to the drawing using the **CG-Survey > Topo > Write Surface to DWG** menu item.

If the labels do not appear on the contour lines you chose, verify the elevation on the contour using the **CAD LIST** command.

Also, try changing the **Labeling Interval** setting on the **Topography** tab of the **C&G Options** dialog.

If the labels still do not appear on the contour lines, look at **Drawing Settings** tab of the **C&G Options** dialog and verify that the **Text Size** is set to a value that is large enough to be seen when viewing the contours.

If the elevation labels are created with an incorrect number of decimal places, check the **Elevation Precision** on the **Rounding** tab of the **C&G Options** dialog under **Text in Drawing**. Use the CAD **UNDO** command to undo the previously placed labels and try again.

**Prompts**

**Pass a line thru the contours to be labeled.**  
**Pick first point on line. [ <ENTER> to quit]:** use the left mouse button to pick any point that is on one side of the contour line you wish to label.

**Pick second point [ <ENTER> to quit]:** drag the rubber band line through one or more of the contours you wish to label and click the left mouse button a second time.

**Pulldown Menu Location:** CG-Survey > Topo > Label Contours  
**Keyboard Command:** cg_label_contours  
**Prerequisite:** C&G contour polyline entities in the drawing.

**Delete Labels**

This feature allows you to delete previously placed C&G contour labels. C&G contour labels consist of two entities: a TEXT entity containing the elevation text and a WIPEOUT entity used to hide the contour polyline under the elevation text. While you can delete these using standard CAD commands, it requires several steps and can be tricky. This feature makes deleting these labels a one step operation.

After choosing the **CG-Survey > Topo > Label Contours > Delete Labels** menu item you will see the following prompt at the command line:

**Select contour labels to delete:**  
**Select objects:** use the mouse to pick the label text for the labels to be deleted. Press Enter when done and the labels and their accompanying WIPEOUT entities will be deleted.

**Prompts**

**Select contour labels to delete:**

---

*Chapter 18. CGSurvey Module*
**Select objects:** use the mouse to pick the label text for the labels to be deleted.

**Pulldown Menu Location:** CG-Survey > Topo > Label Contours

**Keyboard Command:** cg_del_cont_labels

**Prerequisite:** None

---

**TIN from 3D Faces**

This feature allows you to create a C&G TIN file (*.tin) using CAD 3D Face entities.

After choosing the **TIN from 3D Faces** menu item, you are asked to specify the layer containing the CAD 3D Face entities:

**Enter name of layer containing 3DFACE entities:** type the layer name then press Enter

If 3D faces are found on the specified layer, they will be processed to form a TIN and the **Contouring Report** dialog will be shown:

![Contouring Report dialog](image)

Click OK and the resulting TIN will be displayed on the screen.

---

**Prompts**

**Enter name of layer containing 3DFACE entities:** type the layer name then press Enter

**Pulldown Menu Location:** CG-Survey > Topo

**Keyboard Command:** cg_convert_3df

**Prerequisite:** None

---

Chapter 18. CGSurvey Module
**3D Faces from TIN**

This feature allows you to create CAD 3D Face entities from a C&G TIN file (*.tin).

After choosing the **3D Faces from TIN** menu item, a file dialog will appear. Choose the C&G TIN file to use.

Once you have specified the TIN file, the 3D faces are created on the current layer.

**Prompts**

None

**Pulldown Menu Location:** CG-Survey > Topo  
**Keyboard Command:** cg_tin_to_3dface  
**Prerequisite:** C&G TIN file (*.tin)

---

**Create Grid File**

This feature allows you to create a Carlson grid file (*.grd) with elevations determined from screen entities or a coordinate file.

When you choose the Create Grid File menu item the following dialog comes up:

![Make 3D Grid File dialog](image)

---

*Chapter 18. CGSurvey Module*
Set the parameters as desired and click OK.

First you will be asked to specify the name of the grid file to create.

You will then be asked to specify the size of the grid by picking the lower left and upper right corners of the grid:

**Pick first grid corner:** use the mouse to pick one corner of the grid.
**Pick opposite grid corner:** use the mouse to pick the opposite diagonal corner of the grid.

If you are creating the grid file from screen entities, you will be asked to select the entities:

**Select points, lines, polylines and faces to grid from.**
**Select entities:** use the mouse to pick the entities whose elevation will be used to create the grid. When done picking, press Enter.

If you are creating the grid file from a coordinate file, a file dialog will come up allowing you to specify the coordinate file to use.

The specified grid file will then be created.

**Prompts**

**Pick first grid corner:** use the mouse to pick one corner of the grid.
**Pick opposite grid corner:** use the mouse to pick the opposite diagonal corner of the grid.

If creating grid file from entities:

**Select points, lines, polylines and faces to grid from.**

**Select entities:** use the mouse to pick the entities whose elevation will be used to create the grid. When done picking, press Enter.

**Pulldown Menu Location:** CG-Survey > Topo
**Keyboard Command:** cg_make_grd_file
**Prerequisite:** None

**Plot Grid File**

This feature allows you to draw an existing grid file.

You will be asked to specify the grid file to plot using a file dialog.

The **Draw 3D Grid File** dialog comes up:
Set up the items in the dialog as desired and click the OK button.

The grid will be drawn as specified.

Prompts

None

Pulldown Menu Location: CG-Survey > Topo
Keyboard Command: cg_plot_grid_file
Prerequisite: Carlson grid file (*.grd)

CGTools

CG Options

The CG Options menu item brings up the C&G Options dialog, allowing you to view or change various CGSurvey settings or save the currently configured settings to be used as the default settings for a newly created drawings. There are nine tabs on the C&G Options dialog. Each tab pertains to a category of settings:

1. **General** tab - settings regarding the coordinate file type for new files, units, scale factors, and other general settings.
2. **Rounding** tab - number rounding settings used for the print file and for text placed in the drawing.
3. **Graphics** tab - specify when CGSurvey draws points and lines, format of bearings and other graphics related settings.
4. **Traverse** tab - settings used by all traverse related features.
5. **Output** tab - specify the name and layout of the print file and how the results of C&G features are displayed.
6. **Data Path** tab - specify the default path to your data files.
7. **Drawing Settings** tab - specify drawing scale, text size, and details of how point symbols and their labels are to be drawn.
8. **Topography** tab - specify contouring parameters along with the layers used for the TIN, countour and other topographic entities.
9. **Calls** tab - specify the components, format and layer for calls (annotations).

Each of these tabs will be covered in the following sections.

This tab contains a wide variety of settings that apply to almost all of the features found in the CG-Survey menus. These are settings such as Next Point ID, Elevations, State, Arc Definition, Bearings/Azimuths, Coordinate order and more.

### Creating New Coordinate Files section

**File Type:** You may select one of the following coordinate file types:

- C&G numeric (*.crd)
  - point ID can be an integer between 1 and 65,536
  - description from 1 to 100 characters

- C&G alphanumeric (*.cgc)
  - point ID can contain up to 10 characters using any combination of letters and numbers.
Carlson numeric (*.crd)
- point ID can be any integer containing up to 9 digits.
- description from 1 to 31 characters

Carlson alphanumeric (*.crd)
- point ID can contain up to 9 characters using any combination of letters and numbers.
- description from 1 to 31 characters

Simplicity (*.Zak)
- point ID can contain up to 8 characters using any combination of letters and numbers.
- description from 1 to 28 characters

Land Desktop Format (*.mdb)
- point ID can contain up to 255 characters using any combination of letters and numbers.
- description from 1 to 255 characters

**Description Length:** This value can only be set for C&G coordinate files. It becomes the default description length for new C&G coordinate and C&G raw data files. It can be set to from 1 to 100 characters.

**Current Coordinate File section**

**Elevations ON** If this checkbox is checked, elevations will be carried on all points computed and/or you will be able to enter an elevation when saving a point.

**Enter Elev.:** If this checkbox is checked, you will be prompted to manually enter elevations.

**Calculate Elev.:** If this checkbox is checked and an elevation can be computed from the data that has been entered during the command, it will be. Otherwise you will be asked.

**Descriptions ON** If the **Descriptions ON** checkbox is not checked, you will not be prompted to enter a description as points are created or edited.

If descriptions are ON, and **Get Description From Table** IS NOT checked, you will be prompted to manually enter a description for each coordinate point created. However, if Descriptions are on and **Get Description from Table IS** checked, when a point is stored and a description table IS NOT open, you will be prompted to select a description table. The description table will then be used to look up any integer number in the description in order to substitute the description in the table for the integer and move the integer to the Code files. (see help under CG-Survey > Management > Description Tables)

**Point Codes ON** If the **Point Codes ON** checkbox is checked, you will be allowed to enter a two to four character code depending on the number of characters in the code type you are using. This code can be used later to group points with the same code for plotting or listing points. When Point Codes are off, you will not be prompted to enter the point codes.

**Automatic Point Numbering ON** If the **Automatic Point Numbering ON** checkbox is checked, as points are created they will automatically be assigned the next available point ID in the current coordinate file. If Automatic Point Numbering is OFF, as points are created you will be prompted to enter their ID. If you enter a point number that already exists in the coordinate file, you will be asked if you want to overwrite the existing point or enter a new point ID.

**Scale Factors section**
**Input:** This allows you to set a scale factor that will be applied to all entered distances and coordinate values during any C&G feature.

**Output:** This allows you to set a scale factor that will be applied to all output. For example, if this factor is set to 2.0 and the inverse distance between two points is 100.00, the output will show the distance as 200.00.

**Apply Scale to Elevation** If the **Apply Scale to Elevation** checkbox is checked, the Input and Output Scale Factors will be applied to elevation values.

**Apply Scale to Coordinate Listings** If the **Apply Scale to Coordinate Listings** checkbox is checked, the Input and Output Scale Factors will be applied to coordinates listed at the command line and in the print file using the C&G feature in menu item CG-Survey > Management > List.

**Units section**

**Angles:** Choose either the **Degrees** or **Gradians** radio buttons.

**Distance:** Choose Feet, Meters or Metres from the list.

**Note:** The only difference in the two metric choices is the spelling used for output.

**Foot Definition:** Choose either the **US** or **International** radio button.

**Location section**

**State:** Specify the state in which the current survey was done.

This is only used in the following features:

**Solar Observation**

NAD83 (to and from longitude and latitude)

**Hemisphere:** Hemisphere can be set to **Northern** or **Southern**.

This is only used in the following features:

**Solar Observation** (Calculating the Convergency Angle)

NAD83 (to and from Longitude and Latitude - UTM only)

**Miscellaneous section**

**Azimuth/Bearing:** Allows you choose between **Bearing** and **Azimuth** for all direction input and output.

**Azimuth Direction:** This sets all azimuth input and output to either **North** or **South** azimuth.

**Curve Definition** The Curve Definition can be set to Arc or Chord.

**Arc:** the most commonly used definition in roadway design. When units are set to Feet, the degree of curve is the central angle of a 100 foot arc length.

**Chord:** is most commonly used in railroad work. When units are set to Feet, the degree of curve is the central angle of a 100 foot chord.

When a curve is added to a Curve Table or the results of calculations are listed at the command line and in the print file, the displayed information will reflect the **Curve Definition** setting.
Coordinate Order: Can be set to North-East or East-North. This sets the order in which coordinates are displayed and input.

Allows you to specify the rounding settings for various types of numbers for the print file text and for the drawing text.

Note: All internal calculations are performed with double precision accuracy. Only the output is rounded.

When you select the Rounding tab, you will see the following dialog:

![Rounding dialog](image)

The Rounding dialog has a section for At Command Line and in Print File rounding settings and a section for Text in Drawing rounding settings. Both sections have similar settings but they apply to different output. At Command Line and in Print File rounding settings effect all output to the command line and the print file. Text in Drawing rounding settings effect numeric text placed in the drawing.

Angular precision can be specified to the nearest:

- Angles in Degrees or Angles in Grads
- 0.1 Second 0.000001 Grad
- Second 0.00001 Grad
- 5 Seconds 0.0001 Grad
- 15 Seconds 0.001 Grad
- 30 Seconds 0.01 Grad
- Minute 0.1 Grad
Distance precision can be specified to the nearest:
Foot (or Meter) 0 (no decimal places)
Tenth of Foot (or Meter) 0.1
Hundredth Foot (or Meter) 0.12
Thousandth Foot (or Meter) 0.123
Ten Thousandth Foot (or Meter) 0.1234
Hundred Thousandth Foot (or Meter) 0.12345
The Graphics tab settings apply only to CGSurvey features that draw points, lines, etc. to the drawing. When you select the Graphics tab, the following dialog will appear:

**Point Drawing section**

Auto Point Plot ON if the Auto Point Plot ON checkbox is checked, points symbols will be drawn as they are calculated and saved to the coordinate file by the various C&G features.

Use Description table for point plotting parameters When this checkbox is checked the description(s) for a given point in the coordinate file will be matched with the descriptions in the description table. If a match is found then the description table information will be used to set the layer, symbol type, symbol size, and label positions of each point plotted. If no descriptions in the description table match then the layer will be set to the layer specified in the Default layer for codes or descriptions not found in description table edit box and the other settings specified in the Drawing Settings tab will be used (see below). If the Use Description table for point plotting parameters checkbox is not checked, the points, symbols and
labels will be plotted on the Current Layer as set in the CAD layer manager.

**Default layer for codes or descriptions not found in description table:** When the **Use description table for point plotting parameters** checkbox is checked, any points plotted that do not have a description or having a description that does not match any of those in the description table, will be plotted on the layer you have specified as the default layer in this edit box.

**Use Elevation as Z Value:** If this checkbox is checked, objects (lines/arcs/points) will be placed in 3-D space with the point elevation serving as the Z-value. C&G features, such as intersects and inverse, ignore the Z-value of lines and arcs. If you inverse a 3-D line, the 2-D distance between the points will be shown. If the **Use Elevation as Z Value** checkbox is not checked, all objects will be placed at zero elevation.

**Note:** 3D lines can cause problems in trimming or editing using CAD functions. 3D lines do not intersect if their elevations are different. Thus two lines may appear to intersect in plan view but do not actually intersect in 3D space.

**Line Drawing section**

**Auto Line Plot ON** If the Auto Line Plot ON checkbox is checked, those features that create points that can be interpreted as a line will draw C&G lines.

The following features can draw lines and curves as the points are calculated:

- **Quick Traverse** (not to side shots)
- **Curve Between Tangents** and **Tangent Between Curves**
- **Bearing** and **Hinge/Radial Area-Cut-Off**
- **Roadways** (Right of Way/Easements and Intersections/Cul-de-Sacs)
- **Middle Ordinate Solution**
- **Best Fit**

**Line Stop Size** This allows you to terminate C&G lines at the edge of the point symbols plotted. If you are drawing lines and/or arcs with a C&G feature that draws lines and you want the line to end before crossing into the symbol, then set the **Line Stop Size** to the symbol size.

**Note:** If you set the line stop to something other than 0.0, the line that is drawn is shorter than the actual distance between the coordinate points. So if you wish to check the true distance of that line, use the **Query** command (on the Draw menu) rather than the CAD LIST command.

**Text section**

**Arc Annotation Prefix**

This is used when annotating arcs when drawing calls. This should be set to the desired prefix for arc length annotation.

Example:

"Arc =" annotation prefix results in the annotation being

Arc = 256.32

"A =" annotation prefix results in the annotation being
A = 256.32

**Radius Annotation Prefix**
This is used when annotating arcs when drawing calls. Similar to **Arc Annotation Prefix**, this should be set to the desired prefix for radius annotation.

**Leading Space in Bearing**
When the **Leading Space in Bearing** checkbox is checked the bearing text has a space between the N or S and the degrees text (eg, N 85°15'30"E). When left unchecked there is no space (eg, N85°15'30"E).

**Miscellaneous section**

**Process Descriptions before Displaying:**
This setting will allow you to specify how descriptions are processed prior to being displayed. It allows the removal of all underscores (_) and/or mapping codes. No change is made to the data in the coordinate file.

**C&G Snap**

*C&G Snap* can be set to:
Off: No snap.
POINTS - Snap to C&G point symbols and labels.
LINES - Snap to C&G lines.
POINTS-LINES - Snap to C&G points and lines.
All C&G functions will use this setting when you are picking point symbols, point labels, lines, and arcs on the screen.

**Curve Fit Type**
When contouring, the contour lines that are created can be smoothed using one of the following methods:
No Fit - Straight line segments between the points.
Fit - Use the CAD program's standard fit method. Contours may not pass through point symbols having the same elevation as the contour.
C&G Spline - Use the C&G Spline Fit algorithm. Contours are guaranteed to pass through point symbols having the same elevation as the contour.
These settings are specific to traverse raw data entry using the CGEditor and the traverse reduction and quick traverse features.
Raw section

Raw Angle Input
This allows you to specify how you want to specify angles when inputing raw traverse data. The options are: Angle, Azimuth or Deflection Angle.

Adjustment Method
You have the following choices for traverse adjustment:
None
Least Squares (NOT network least squares - see SurvNET for that)
Find Bad Angle
Compass
Transit
Crandall

Note: See the Reduce Traverse feature help section for more details on these methods.

If the Backsight Distance ON checkbox is checked and you entering raw traverse data, you must specify the distance to the backsight at each instrument point. These distances will then be used during the reduction process.

If the Adjust Angles ON checkbox is checked, angles will automatically be balanced prior to traverse adjustment. Angular error will be spread equally between all points. Closure information prior to and after balancing
will be displayed at the command line.

If the **Balance Elevations ON** checkbox is checked, the elevations in a 3-D traverse will automatically be balanced during traverse adjustment. The elevations are adjusted proportional to the length of the traverse legs.

**Tolerances section**

**Horz. Angle.**
When comparing multiple angles for a given foresight point from a given instrument point and backsight point, this value will be used as the maximum acceptable angular error. If the difference between any two angles is greater than the acceptable limit, the reduction process will pause and showing the instrument point ID and angle measurements will be displayed at the command line.

**Horz. Dist.**
When comparing multiple horizontal distance components or measurements to a single foresight point, this value will be used as the maximum acceptable distance difference. If the difference between any two distances is greater than this limit, the reduction process will pause and the instrument point ID and the involved distances will be displayed at the command line.

The horizontal distance tolerance is also used as the maximum allowable difference between the two calculated curve radii at the curve end points. If the difference between the distances from the radius point to the PC point and the radius point to the PT point is greater than this value, the calculations will be terminated with an appropriate error message.

**Note:** for curves, if this value is set unreasonably low, many curves will produce this error message. If you change the setting to a larger, more reasonable value, the curve can be recalculated and generated without error.

**Vert. Dist.**
This value is the maximum acceptable elevation difference. It is used when comparing multiple vertical distance components/measurements to a given foresight point from a given instrument point. If the difference between the distances is greater than this limit, the reduction process will pause, showing you the instrument point ID and the involved distances. This only applies to the reduction of a 3-D traverse.

**Quick section**

**Quick Angle Input**
This specifies the default angle input mode for the Quick Traverse Feature. This can be changed when using the Quick Traverse feature.

The angle input modes are:
- **Angle**
- **Deflection Angle**
- **Azimuth**
- **Bearing**

If the **Print Traverse Input ON** checkbox is checked, all raw input data will be displayed along with the traverse output. If this checkbox is not checked, only the traverse output will be printed.
If the **Vertical Angles ON** checkbox is checked you will be asked to enter vertical angles with the traverse distances. This can be changed when using the **Quick Traverse** feature.

**Curve Bearing**
This defines how non-tangent curve bearings will be input and can be set to either **Chord** or **Radius** depending on how you wish to define the orientation of non-tangent curves.
When set to **Chord** and you are traversing around a non-tangent curve, you must enter the bearing or angle from the PC to the PT.
When set to **Radius** and you are traversing around a non-tangent curve, you must enter the bearing or angle from the PC to the radius point.
Curve Tables and printed calculations will reflect this setting.

**Traverse Mode**
Sets the default traverse mode for the **Quick Traverse** feature.
It can be set to **Traverse** or **Side Shot** mode.
**Traverse** mode: as a point is created the new point is occupied and backsight the previously occupied point.
**Side Shot** mode: as a point is created the currently occupied point and backsight will be held.

**Common section**

**Instrument Height (HI)**
The value entered for the HI can be either the actual instrument **Elevation** or the distance from the ground to the instrument (**Plus up**). In the latter case the elevation of the point the instrument is over is read from the coordinate file and the instrument height is added to it to determine the instrument elevation.

**Vertical Angle Input** - can be set to one of the following, depending on the type of instrument used:
- **Zenith**: Zero angle up
- **Nadir**: Zero angle down
- **Transit**: Zero angle level
**Note**: If set to Transit, vertical can either be full circle (0 to 360 degrees; 0 to 400 grads) or positive angle up and negative angle down.

**EDM Offset**
Depending on where your EDM is mounted, enter the vertical difference between the center of the scope of the instrument and the center of the beam of the EDM (+ if EDM is above; - if EDM is below). Do not use an EDM Offset for scope mounted EDM's. This offset should only be applied to yoke or azimuth base mounted EDM's.

**Note**: Use of the EDM offset allows you to turn your vertical angles directly to the target. A correction will be applied to all distances and elevations computed from field entries in the Traverse and Quick Traverse routines. Most total stations today have the EDM coincident with the center line of instrument scope. In this case the EDM Offset should be set to zero.

**Note**: When an offset is entered, it is used on all distances in the traverse. If some distances are chained, the correction will also be applied. These shots should be reduced separately with no EDM Offset.

**Distance Components** - This option can be set to allow either **Slope Distance/Vertical Angle** or **Horizontal Distance/Vertical Distance** data entry.

If the **Curvature and Refraction ON** check box is checked, the horizontal and vertical components of all
slope distances are corrected for curvature and refraction. If your EDM does not already make this correction, it is recommended that this correction be used when carrying elevations using vertical angles and distances. This tab allows you to specify the name and format of the print file and how it is viewed.

### Print File Name section

The final results of calculations and other actions performed during C&G command execution will always be printed to this ASCII text file. New information is always appended to this file and never overwritten. The default file name is PRINTER.TXT. It is recommended that you use a name that corresponds with the project you are working on. This way you will have a record of all calculations throughout the project. Use the **New Print File** button to specify a new print file to create. Use the **Existing Print File** button to specify an existing file.

### Print File Viewer section

You can choose to use Microsoft Notepad or Wordpad when viewing or printing the print file. If you want the viewer to always come up full screen, check the **Force print file viewer to use full screen** checkbox.

### Point Configuration section

If the **Headings On** checkbox is checked, a heading is printed to the command line and/or the print file any time multi-line output is generated by a C&G feature. The heading information contains date, time, feature name,
coordinate file name and input and output scale factors. The header is repeated when the number of lines output by a function exceed the value set for **Lines Per Page**.

If the **Display On** checkbox is checked, the output from CGSurvey features is printed at the command line. Regardless of this setting, output is always sent to the print file.

**Printable Columns**

Use the edit box to specify the maximum number of characters per line to be written to the print file. This allows you to fit the text to the printed page given the font and paper your uses. The acceptable values are 80 through 255.

**Lines Per Page**

This allows you to set the number of lines that will be placed on a page. If headings are on, a header will be printed to the print file and the command line each time this number of lines is exceeded.

On this tab you can specify the path to your data files. The data path is the default directory for file dialogs used in various C&G commands that open or save files.

You can type the path in the **Data Path** edit box or you can use the **Browse...** button to use a file dialog to specify the data path.

On this tab you can specify drawing scale, text size, point symbol type and its format, and point symbol layers.
Drawing Scale section

This sets the horizontal scale. For example, if units are set to feet and you want a horizontal scale of 1” = 20’ then type 20 in the Horizontal (ft/in) edit box. For metric units, if you want a scale of 1m = 500m then enter 500 in the Horizontal (m/m) edit box.

Text Size section

Allows you to set the text size for any text drawn using a CGSurvey feature. The text size is the size of the text as measured on the plotted or printed page. It must be specified in inches if using feet or centimeters if using meters.

Point Symbol Configuration section

Current Symbol section

This section allows you to control the symbol, its size and how it is scaled (called units here).

Type of Point to be Drawn: There are two point symbol libraries to select symbols from, the C&G and the Carlson symbol libraries.

Using symbols from either the C&G or Carlson symbol library both allow you to use all of the associated C&G features for plotting, sorting, line stops, attribute information, selection, etc. If you choose to use Carlson symbols the Label Position section of the dialog changes somewhat. This will be discussed later in this section.

Select Symbol button

Choosing Select Symbol button will bring up the Choose Point Symbol dialog:
Use this dialog to choose the active point symbol. You do this by highlighting the symbol name in the list on the left or by clicking the symbol image on the right. Symbols CG00 and CGDCA are compatible with LDT/LDD points. The CGDCA symbol is the correct size for a true LDT/LDD point, and should be used if you are also using LDT/LDD.

**Symbol Size and Units**

There are two options available for specifying symbol size:

- \( \text{Height} \times \text{Scale} \):
- \( \text{Literal} \)
If **Units** are set to *(Height)x(Scale)*, then the symbol size entered here is specified as *plotted page units* (inches or centimeters - depending on whether feet or meters are being used). In this case, regardless of scale, the symbol will always be the same size when plotted. In example above, the symbol is set to .300''. At 30 scale the symbol height will be 9 feet in the drawing itself, at 40 scale it would be 12 feet. Thus, in either case, its plotted size will be 0.3 inches.

If **Units** are set to **Literal** then the symbol will be drawn *in the drawing* at the size specified. This setting is often used for inserts such as title blocks, north arrows, company logos, standard notes, etc.

**Label Layer Control section**

If you check the Separate Layers check box, you can assign each point label to a specific layer. This allows you to see only the labels you want by turning different layers on or off. If this checkbox is not checked, all the point labels will be drawn on the current layer.

**Label Position section**
C&G Labels:

If the label location is set to Off that label will not be displayed when a point is plotted. Only the elevation is allowed to be at the Center position. If you select Center for the elevation label, the whole number portion of the elevation will be on the left side of the insertion point of the symbol and the decimal portion on the right side (example: the elevation 987.23 will be drawn as 987+23, where the plus sign represents the symbol).

If Plot Radial is checked, the point labels will be plotted radially from the symbol's center. If not selected, point labels will be plotted horizontally.

Label Position for Carlson Symbols

In the Point Symbol Configuration section of the dialog you have the option to plot C&G symbols or Carlson symbols. When the Carlson symbols are used, the Label Position portion of the dialog box changes to display the Carlson method for defining label positions (see below).

These "label positions" are actually pre-defined blocks with a predefined location and orientation for the attributes (or labels). There are ten blocks available. The available blocks are identified by the numbers 0 through 9.

Note: when Carlson point symbols are used, the Sample drawing is only approximate - the actual layout will look slightly different when drawn.

Label Format section
**Label Height**: this is the text size in inches/centimeters when **Units** are set to (Height) x (Scale) or feet/meters when **Units** are **Literal**. The **Label Height** is used for all three labels: point number, point description, and point elevation.

**Number of description characters to show**: Depending on the type of coordinate file being used, here may be as many as 255 characters in the description field. This option allows you to truncate the description at a given number of characters.

**Elevation**: This sets how many characters are displayed before and after the decimal point. On a flat piece of property 2 placed before the decimal may be enough information. On a steep mountain site 3 or 4 decimal places may be needed.

**Topography tab**

The items on this tab allow you to specify contouring parameters and Tin, countour and other topographic entity layer specifications.
This dialog allows you to specify the drawing layers for the various topographic entities, as well as set various parameters for the creation of a new surface and placement of contour elevation labels.

**Layer Names section**

In this part of the dialog you can specify the layers for the various topographic entities. If the layers exist the surface image will be rendered in the color specified for that layer. If the layer does not exist the surface image will use its internal default colors. If the TIN and/or contours are written to the drawing they will be drawn on the specified layers. If a specified layer does not exist, it will be created using the CAD default drawing color. Break lines and Boundary lines will be drawn directly on the specified layer. If the layer does not exist, it will be created.

**TIN Layer:** Specifies the layer on which triangulation network lines or TIN will be drawn.

**Break Line Layer:** The layer on which the break lines will be drawn.

**Include Boundary Line Layer:** The layer on which the include boundaries will be drawn.

**Exclude Boundary Line Layer:** Layer on which the exclude boundaries will be drawn.

**Main Contour Layer:** Layer on which main contours will be drawn.

**Main Contour Label Layer:** Elevation labels for the main or index contour lines will be drawn on this layer.

**Intermediate Contour Layer:** Layer on which intermediate contours will be drawn.

**Intermediate Contour Label Layer:** Elevation labels for the intermediate contour lines will be drawn on this layer.

**Note:** The last two Contour Label Layer names will be used when labeling contours. Labeling of contours is done after creating and refining the contours. (See CG-Survey > Topo > Label Contours > Place Contours)

**TIN and Contour Parameters section**
**TIN Interpolation Range:** The interpolation range determines which points will be joined to form the triangles in the TIN.

The interpolation range must be chosen carefully and should be based on the density of the points shot in the field. In the ideal situation, the triangles in the TIN will be generated in a way that incorporates all the points selected for use. However, no side of a triangle in the TIN can be longer than the interpolation range and no contour lines will be drawn where there are no triangles. A point that is separated from its neighboring points by a distance that is greater than the interpolation range will not be included in any triangles. Thus its elevation information will not be used in the formation of contours. A very large interpolation range will result in TIN lines being extended to widely separated points and will likely result in the contours between the widely separated points not representing the actual ground elevation. Of course, a very small interpolation range would result in no triangles or contours being generated.

**Contour Interval:** Specify the desired contour interval. Decimal intervals are acceptable (e.g. 0.5, 1.5).

**Type of Curve Fit For Contours:** Choose one of three curve fitting methods to smooth contours.

- **CG Spline** - The most accurate for a topographic survey. The contour is guaranteed to pass through any co-ordinate point that is at the same elevation as the contour.

- **AutoCAD** - This type of fit produces a more rounded contour that may misrepresent the actual contour of the land. AutoCAD Fit contours are not guaranteed to pass through all points having the same elevation as the contour.

- **None** - Straight line segments are drawn between the interpolation points on the TIN triangles. By definition, the contours will pass through all points having the same elevation as the contour.

**Note:** If spot elevations are required on the topographical map, it is recommend that the C&G Spline curve fitting method be used. Also, if the contours have already been written to the drawing, you can still smooth the contours using the CGDraw > Fit polylines feature.

**Densify Contours** - If the Densify Contours checkbox is checked, the contour line curvature is more closely controlled, greatly reducing the possibility of contour lines crossing. If the Densify Contours checkbox is **NOT** checked, the contours will look smoother but may cross at tight bends.

**Labeling Parameters section**

**Label Interval:** When labeling contours, only the contours falling on this interval will be labeled. For example, if you enter a 10' interval, only the contours at 900, 910, 920, etc will be labeled.

**Label-Contour Separation Distance:** This is the space between each end of the elevation label text and the contour line being labeled. A separation distance that is too small can make the elevation label hard to read, while a separation distance that is too large may not be visually pleasing. This tab gives you several options for specifying the call or annotation format.
Desired Componants section

The of the dialog allows you to specify what you want displayed for a given call and whether the call text is stacked. The text in perentheses indicate the call items for a curve.

Format and Location section

The allows you to specify whether the call is placed Paralle to Line, Perpendicular to Line or requires the user to pick the location for horizontal call text (At Crosshair). If the Place Calls to Right of Line checkbox is checked the calls will be placed on the right side as determined by standing at the first point picked or the first point in a C&G line and looking toward the second point. You may also specify whether to use the foot symbol when units are feet. If bearings are being used, you may specify whether to limit bearing text to NW, NE only or SW, SE only or <no preference>.

Layer name for call text:

Specify the layer the call text is to be drawn on.

Automated Placement of Calls on Specified Layers section

This section of the dialog sets the parameters for a feature that allows you to place calls on C&G and/or CAD lines and/or polylines found on specified layers. To use this option, check the Automate Placement of Calls checkbox.
Choose one or more layer names from the list of layer names. You can specify multiple layers by holding the Ctrl key down while picking the layers to search.

In the **Types of Lines to Annotate** section, check the types of entities you wish to annotate.

**Example Call section**

The of the tab allows you to see a good approximation of how the call will look when drawn.

**OK** - click the **OK** button to save all the settings and close the dialog.

**Cancel** - click the **Cancel** button to close the dialog and discard any changes.

**Set As Default**

Click this button to save the settings to the CGSURVEY.OPT file. These settings will then be used whenever a new CGSurvey drawing is created.

**Note**: You can set the default settings and not affect any of the settings for the current drawing by clicking the **Cancel** button after clicking the **Set As Default** button.

**Prompts**

None

**Pulldown Menu Location**: CG-Survey > Tools

**Keyboard Command**: cg_options

**Prerequisite**: None

**Triangle Solutions**

This feature allows you to solve for the unknown sides and angles of a triangle given the known sides and angles.

The upper case letters A, B and C represent the length of the sides.

The lower case letters a, b and c represent the included angles.

Distance A is the leg of the triangle opposite the angle a. Likewise, distance B and C are the legs opposite the angles b and c, respectively.

Enter any three known values of the six possible parameters and the three unknowns will be calculated and displayed when you press the **Solve** button. If you press the Solve button then the solution will also be printed at the command line after you close the **Triangle Solutions** dialog. If you click one of the edit boxes after pressing the **Solve** button the values in all the edit boxes will revert back to the values prior to pressing the **Solve** button.

**Note**: Since there are an infinite number solutions when three angles and no sides are specified for a triangle, the solution will be the lengths of the sides as proportional distances.

When you press the **Done** button, the dialog will be closed and the results for all triangles solved will be
Prompts

None

Pulldown Menu Location: CG-Survey > Tools > Triangle Solutions
Keyboard Command: cg_tri_solns
Prerequisite: None

Copy Entity to Layer

This feature allows you to easily copy a single entity or group of entities from one layer to another.

Choose entities to copy:
Select entities: use the standard CAD selection methods to choose one or more entities to be copied. Once you have selected the entities press Enter.

Next use the Layer Name dialog to choose the layer to copy the entities to:

![Layer Name dialog](image)

Prompts

Choose entities to copy:
Select entities: use the standard CAD selection methods to choose one or more entities to be copied.

Pulldown Menu Location: CG-Survey > Tools
Keyboard Command: cg_copyent
Prerequisite: None

Change Entity Layer

This feature allows you to change the layer of a single entity or a group of entities. You will see the following prompts at the command line:
Prompts

Select entities to be changed.
Select entities: select a single entity, or a group of entities using the standard CAD entity selection methods. Press Enter when done selecting entities to change.

Pick entity with new layer or press Enter to choose layer: If you pick an existing entity the previously picked entities will be moved to the chosen entity's layer. If you just press Enter at this prompt without selecting an entity, you will see the following prompt:

Please enter new layer name: Type in the new layer name. It may be an existing layer or a new layer. If the layer does not exist, it will be created.

Pulldown Menu Location: CG-Survey > Tools
Keyboard Command: None
Prerequisite: None

Layer Control
These options allow you to freeze, thaw, restore, turn on and off, and set the current layer without having to open the CAD layer manager.

Prompts

None

Pulldown Menu Location: CG-Survey > Tools
Keyboard Command: None
Prerequisite: None

Pick Layers to Freeze
This feature allows you to freeze layers by picking entities that are on layers you wish to freeze. You may pick as many entities as you wish.

Prompts

Select object on layer to FREEZE.
Select entities: choose objects on the layers you wish to freeze. Press Enter when done.

Pulldown Menu Location: CG-Survey > Tools > Layer Control
Keyboard Command: cg_lfreeze
Prerequisite: None
Pick Layers to Thaw

This feature allows you to thaw frozen layers by picking entities that are on a layer you wish to freeze. All frozen layers are turned on while you pick the entities. You may pick as many entities as you wish.

Prompts

Select object(s) on layers to keep THAWED.
Select entities: choose objects on layers you wish to thaw. Press Enter when done.

Pulldown Menu Location: CG-Survey > Tools > Layer Control
Keyboard Command: cg_lthaw
Prerequisite: None

Freeze ALL Layers

Choosing this menu item causes all layers, except the current layer, to be frozen.

Prompts

None

Pulldown Menu Location: CG-Survey > Tools > Layer Control
Keyboard Command: cg_alfreeze
Prerequisite: None

Thaw ALL Layers

Choosing this menu item causes all layers to be thawed.

Prompts

None

Pulldown Menu Location: CG-Survey > Tools > Layer Control
Keyboard Command: cg_althaw
Prerequisite: None

Pick Layers to turn Off

This feature allows you to turn off layers by picking entities that are on layers you wish to turn off. You may pick as many entities as you wish.

Prompts
Select object on layer to turn OFF. choose objects on layers you wish to turn off. Press Enter when done.

Pulldown Menu Location: CG-Survey > Tools > Layer Control
Keyboard Command: cg_loff
Prerequisite: None

Pick Layers to turn On
This feature allows you to turn on layers by picking entities that are on layers you wish to turn on. All layers will be turned on during the command to allow you to pick the desired entities. You may pick as many entities as you wish.

Prompts
Select object(s) on layers to keep ON.
Select entities: choose objects on layers you wish to turn on. Press Enter when done.

Pulldown Menu Location: CG-Survey > Tools > Layer Control
Keyboard Command: cg_lon
Prerequisite: None

Turn OFF ALL Layers
Choosing this menu item causes all layers, except the current layer, to be turned off.

Prompts
None

Pulldown Menu Location: CG-Survey > Tools > Layer Control
Keyboard Command: cg_aloff
Prerequisite: None

Turn ON ALL Layers
Choosing this menu item causes all layers to be turned on.

Prompts
None

Pulldown Menu Location: CG-Survey > Tools > Layer Control
Keyboard Command: cg_alon
Prerequisite: None
Pick Current Layer

This feature allows you to pick an entity that is on a layer you wish to make the current layer.

Prompts

Set Current Layer - Select entity on the desired layer: pick the entity which is on the layer you want to make the current layer.

Pulldown Menu Location: CG-Survey > Tools > Layer Control
Keyboard Command: cg_lset
Prerequisite: None

C&G Point Scanning

If the C&G Point Scanning menu item is checked then point scanning is turned ON. C&G point scanning should be kept ON under almost all circumstances!

When C&G point scanning is ON, the entire drawing is scanned for point symbols and the point symbols found are recorded in a list. This list is used by many of the C&G features. When running a C&G command, in order to keep this list up-to-date, it is necessary to re-scan if any CAD editing commands have been run that may have removed, added or altered point symbols (for example: COPY, MOVE, UNDO, REDO, DELETE, etc.). If there are a large number of points in the drawing, the scanning process can be slow. This means that, if you are using CAD editing commands along with with C&G commands that are "safe" (do not use point symbols), the repeated scans every time you use a C&G command after a CAD editing command will slow you down considerably. If this occurs, then you may safely turn point scanning off.

WARNING: If C&G Point Scanning is OFF while running a C&G command that uses or plots point symbols (COGO, for example), you may get incorrect results or create duplicate point symbols. This can be avoided by turning C&G Point Scanning back on when it will not slow you down - in other words, when you are not alternating C&G commands and CAD entity editing commands in a drawing that contains a large number of point symbols.

Prompts

None

Pulldown Menu Location: CG-Survey > Tools
Keyboard Command: cg_tog_pt_scan
Prerequisite: None

Elevations

If this menu item is checked, then point elevations are ON. If it is unchecked then point elevations are OFF.
When point elevations are ON and the **Enter Elev.** radio button is set on the **General** tab of the **C&G Options** dialog, you will be prompted to enter an elevation when new points are saved to the coordinate file. When point elevations are ON and the Calculate Elev. radio button is set you will not be prompted to enter an elevation. When point elevations are OFF, no elevation is stored when coordinate points are saved to the coordinate file.

**Prompts**

None

**Pulldown Menu Location:** CG-Survey > Tools  
**Keyboard Command:** cg_tog_elev  
**Prerequisite:** None

**Descriptions**

If this menu item is checked, then point descriptions are ON. If it is unchecked then point descriptions are OFF. Generally, when point descriptions are on, you will be prompted to enter a description when new points are saved to the coordinate file. Also, when descriptions are ON, the description field will be enabled when editing coordinate point values.

**Prompts**

None

**Pulldown Menu Location:** CG-Survey > Tools  
**Keyboard Command:** cg_tog_desc  
**Prerequisite:** None

**Point Code**

If this menu item is checked, then point codes are ON. If it is unchecked then point codes are OFF. Point codes are unique to C&G coordinate files that can be used to filter or group points in various C&G features.

When point codes are ON, you will be prompted to enter a point code when new points are saved to the coordinate file. When point codes are OFF, no code is stored when coordinate points are saved to the coordinate file.

**Prompts**

None

**Pulldown Menu Location:** CG-Survey > Tools  
**Keyboard Command:** cg_tog_code  
**Prerequisite:** None
Auto Point Number

If the Auto Point Number menu item is checked then automatic point numbering is ON. This means that, as points are created they will automatically be assigned the next available point ID in the current coordinate file and will be saved without any user interaction.

When auto point numbering is OFF, as points are created you will be asked to enter the point ID. If you enter a point ID that already exists in the coordinate file, you will be asked if you want to overwrite the existing point or enter a new point ID.

See also: Automatic Point Numbering ON checkbox on the General tab of the C&G Options dialog.

Prompts

None

Pulldown Menu Location: CG-Survey > Tools
Keyboard Command: cg_tog_auto_num
Prerequisite: None.

Auto Point Plot

If the Auto Point Plot menu item is checked, when a point is calculated and stored in the coordinate file it will be plotted in the drawing.

See also: the Auto Point Plot ON checkbox on the Graphics tab of the C&G Options dialog.

Prompts

None

Pulldown Menu Location: CG-Survey > Tools
Keyboard Command: cg_tog_auto_pt_plot
Prerequisite: None

Auto Lines

If the Auto Lines menu item is checked, automatic line plotting is ON. When automatic line plotting is ON, the following COGO features will automatically draw lines and curves using the newly calculated points as they are saved to the coordinate file:

Quick Traverse - but lines will not be drawn to side-shots
Curve Between Tangents and Tangent Between Curves
Bearing Area Cut-Off
Hinge/Radial Area Cut-Off
Roadway (Right-of-way and all Cul-de-Sacs and Intersections features)
Middle Ordinate Solution for curves
Best Fit

See also: Auto Line Plot ON checkbox on the Graphics tab of the C&G Options dialog.

Prompts

None

Pulldown Menu Location: CG-Survey > Tools
Keyboard Command: cg_tog_auto_lines
Prerequisite: None

CG Snap

C&G Snaps are object snaps that are active only during a C&G command. These snaps allow you to pick point symbols and/or C&G lines by clicking near them. They work similar to the CAD snaps but only snap to C&G entities. The C&G snaps work in conjunction with the normal CAD snaps but, when a C&G command is run, the CAD snaps are automatically turned off at the start of the command and the C&G snaps become active. In almost all C&G features you have the option of turning the CAD snaps back on if desired. When both the CAD and C&G snaps are on, the CAD snaps are applied first to determine the x and y screen coordinates of the point on the appropriate CAD entity; these coordinates are then passed to C&G and they are used to apply the C&G snaps and find the nearest appropriate C&G entity.

Note: If CAD snaps are turned on during a C&G command and if C&G snaps are also on, a double snapping process occurs. Because of this double snapping, it is recommended that when C&G Snaps are on, CAD snaps should be left off during C&G commands.

Note: If snapping is desired and C&G snaps are off, then the CAD snaps must be turned on each time a C&G command is run.

Pulldown Menu Location: CG-Survey > Tools
Keyboard Command: None
Prerequisite: None

Off

This turns off all C&G snaps.

Note: This setting applies ONLY to C&G features and is not directly supported by whatever CAD software you are using.

Prompts

None
**Points**

This allows you to pick near and snap to a C&G point symbol whenever a point ID is required for a C&G feature.

Note: This setting applies ONLY to C&G features and is not honored by whatever CAD software you are using.

**Prompts**

None

---

**Lines**

This allows you to pick near and snap to a C&G line whenever a bearing, distance, or pair of points is required for a C&G feature.

Note: This setting applies ONLY to C&G features and is not honored by whatever CAD software you are using.

**Prompts**

None

---

**Points and Lines**

This allows you to pick near and snap to a C&G point or line whenever a point ID, bearing, distance, or pair of points is required for a C&G feature.

Note: This setting applies ONLY to C&G features and is not directly supported by whatever CAD software you are using.

**Prompts**

None
Zoom to Point ID

This feature pans the drawing in order to place the location of the point ID you specify at the center of the screen. It is not necessary to plot the point symbol prior to using this feature.

Prompts

Point ID of point to zoom to: specify the point ID of a point in the current coordinate file.

The drawing will be panned to center the point and a "rubber band" line will extend from the point to your cursor.

Stopping to view point [View another/Done] <D>: Press "D" and Enter or just Enter to clear the rubber band line and return to the CAD command line. Press "V" and enter to specify another point ID.

Windows Calculator

Selecting this menu item will bring up the standard Microsoft Windows ® calculator.

Prompts

None

AutoCAD Calculator

Issues the 'CAL command to bring up the CAD calculator.

Prompts
The features found in the Earthworks menu allow you to create and draw cross sections and profiles, create standardized cross section templates, and calculate volumes.

Cross sections can be used for many purposes. You can compare cross sections from two surfaces to determine the volume between them. You can create templates for use in generating cross sections along an alignment, for example, road or canal templates. Once cross sections have been created for both the existing ground and the proposed grade they can be used to calculate cut and fill volumes.

Pulldown Menu Location: CG-Survey > Earthworks

Edit Cross Section File (CGEditor)

Cross section files are most often created using the Profile feature in the CG-Survey > Earthworks menu or by any of the "Create from ..." menu items found in the CG-Survey > Earthworks > Cross Sections submenu (please refer to the appropriate sections regarding creating cross sections). The CGEditor is more commonly used to edit an existing cross section file (*.cew) or create a template file but it can also be used to create a new cross section file. An example of a cross section file being edited using the CGEditor is shown below:
Cross section files contain data which defines one or more cross sections along an alignment. Each cross section begins with a Station record and is identified by its station along the alignment. Each cross section is then defined by a series of Point records that follow the Station record and specify the offset and elevation of points on the cross section. These Station record also contains the specifications for the left and right slopes. Depending on the application, the left and right slope values can be used to carry the end of a cross section to existing ground (if required). Cross sections can be used to visualize a site, specify design elevations and calculate volumes.

**Note:** For more details on how to edit a cross section file, see the CGEditor section under Tools.

For more information on creating cross sections, see the sections on: Create from TIN; Create from Contours; Create from Templates; Create from Coordinate File; and Create from Overlay in the CG-Survey > Earthworks > Cross Sections submenu and Profiles in the CG-Survey > Earthworks submenu.

**Prompts**

None

**Pulldown Menu Location:** CG-Survey > Earthworks > Cross Sections> Edit Cross Section File  
**Keyboard Command:** EXS, CG_EDIT_XS  
**Prerequisite:** Cross section file (*.cew).
Merge
This feature allows you to merge a specified range of cross sections from one cross section source file into an existing destination file.
Selecting the Merge menu item brings up the Open cross section file to Merge from file dialog, use this dialog to select the source file.
Next, the Open cross section file to Merge to file dialog will appear. Select the destination cross section file into which the cross sections from the source file will be merged.
Next, specify the range of cross section stations from the source cross section file that you wish to merge into the destination file.

Enter starting station to merge <50.000000>:
Enter ending station to merge <300.000000>:

If cross sections exist in the destination file that have the same station numbers as those being merged from the source file, the following warning will be displayed

The specified range of cross sections from the source file will now be merged into the destination file.

Prompts
Enter starting station to merge <50.000000>: Enter the first station in the source file to be merged into the destination file. The default value is the first station found in the source cross section file.
Enter ending station to merge <300.000000>: Enter the last station in the source file to be merged into the destination file. The default value is the last station found in the source cross section file.

Pulldown Menu Location: CG-Survey > Earthworks > Cross Sections
Keyboard Command: cg_merge_x
Prerequisite: Coordinate file.

Copy
This feature allows you to copy cross sections from one cross section file into another new or existing cross section file.

If there is no active cross section file, you will be asked to open one using the Open cross section file to
Copy from file dialog. This is the source file for the cross-section copy.

The file that the cross sections are copied into can either be a new or existing cross section file. You must specify whether the cross section destination file is new or existing using the following dialog:

![Image of dialog]

NOTE: If you choose an existing file and cross sections exist in the file, they will be deleted. If you do not wish to delete the existing cross sections in the cross section file, use the Merge cross section feature instead.

Next you will use either the Open cross section file file dialog to open an existing destination file or the Create new cross section file file dialog to specify the name of a new destination file. You will then be asked to specify the range of stations you want to copy:

Enter starting station to copy <0.00>: Enter the starting station as a decimal number (for example: enter 6 + 92.54 as 692.54).

Enter ending station to copy <0.00>: Enter the ending station as a decimal number

If you are copying to an existing file you will be warned that cross sections in it will be overwritten (see dialog below).

![Image of dialog]

Prompts

Enter starting station to copy <0.00>: Enter the starting station as a decimal number (for example: enter 6 + 92.54 as 692.54).

Enter ending station to copy <0.00>: Enter the ending station as a decimal number
Pulldown Menu Location: CG-Survey > Earthworks > Cross Sections

Keyboard Command: cg_copy_x

Prerequisite: existing cross section file (*.cew).

List
This feature allows you to list all the cross sections or a specified range of cross sections in an existing cross section file.
If there is no cross section file open, you will use a file dialog to choose a cross section file to list.
You will then be asked to specify the starting and ending stations for the listing.
The information for each individual station will be shown on the command line.
Note: To see the resulting output, press F2 to open the command history window.

You may also use the CGEditor to view the file (see the CGEditor section).

Prompts

Enter starting station to list <50.000000>: Enter the first station you wish to list. The default value is the first station in the file.

Enter ending station to list <300.000000>: Enter the last station you wish to list. The default value is the last station in the file.

Create from TIN
This feature allows you to create cross sections from an existing TIN file. The following is a typical example of a portion of a single cross section:

To generate the cross sections, you must first select one of the following alignment sources. Cross sections will be created at right angles to the alignment source at a specified station interval and at designated intermediate stations.

The feature first asks you what the alignment source is:

Select alignment source [Point-group/Polyl ine/Dr ag] <P>: Type "P" and Enter or just press Enter to use a file dialog box to select the point group to be used to define the alignment.
If you type "Y" and Enter you will see the following prompt:

Select polyline to use for alignment: At this prompt you must select a polyline from the screen to define
The Drag option allows you to pick two or more points on the screen. You may pick any locations on the screen or type in point IDs to define the alignment.

To use the Drag option, type "D" and Enter then respond to the following prompts:

**Pick start Point**: Pick the first point in the alignment.

**To point (<Enter> when done) [Arc/Length/Undo]**: continue entering points defining lines and arcs along the alignment. Press Enter when done.

Once you have specified an alignment, you will be prompted for the following information

**Enter station for beginning point <0.000000>**: Enter the beginning station as a decimal number.

**Enter offset from alignment to cross section <0.000000>**: Enter the offset. Precede the offset amount with a "+" for right of alignment, a "-" for left, or press <Enter> for no offset. Left or right is determined by looking along the alignment in the direction of increasing stationing.

**Enter interval for creating cross sections <50.000000>**: Enter the interval along the alignment for the creation of cross sections.

**Enter maximum range to cross section <99999999.000000>**: Specify how far to the left and to the right of the alignment that the cross sections will extend. If you press Enter to accept the large default value, cross sections will be created for the full width of the topography. If you set the maximum range to 50, each cross section will be a total of 100' wide - 50' left and 50' right of the alignment.

**Enter Odd stations (6+34.22 as 634.22) [Done]**: Enter the decimal number for any station along the alignment where you wish to have a cross section created. This prompt will be repeated until you press Enter without specifying a station or you type "D" and Enter.

**Interpolate end points (Yes/No) <Y>**: Type "Y" and Enter or press Enter to interpolate endpoints or "N" and Enter to not interpolate endpoints. If the range has been set to a specific distance, the cross section line may not intersect a contour at that point. If you choose to interpolate end points, the program interpolates an elevation at the maximum range offset.

If a TIN file (*.tin) is not currently open, a file dialog will come up allowing you to open one.

You will then use a file dialog to specify the cross section file to save the new cross sections to. You may choose a new or an existing file name. If you choose an existing file then the following dialog will appear:

At this point the cross section file will be created. To check the resulting cross sections, you can List or Draw the cross sections or you can view and/or edit the file using the CGEditor.
Select alignment source [Point-group/polYline/Drag] <P>: Type "P" and Enter or just press Enter to use a file dialog box to select the point group to be used to define the alignment.

Select polyline to use for alignment: If you selected polYline at the first prompt, At this prompt you must select a polyline from the screen to define the alignment.

If you chose Drag at the first prompt, you will see the next two prompts:

Pick start Point: Pick the first point in the alignment.

To point (<Enter> when done) [Arc/Length/Undo]: continue entering points defining lines and arcs. Press Enter when done.

Enter station for beginning point <0.000000>: Enter the beginning station as a decimal number.

Enter offset from alignment to cross section <0.000000>: Enter the offset. Precede the offset amount with a "+" for right of alignment, a "-" for left, or press <Enter> for no offset.

Enter interval for creating cross sections <50.000000>: Enter the interval along the alignment for the creation of cross sections.

Enter maximum range to cross section <99999999.000000>: Specify how far to the left and to the right of the alignment that the cross sections will extend.

Enter Odd stations (6+34.22 as 634.22) [Done]: Enter the decimal number for any station along the alignment where you wish to have a cross section created. This prompt will be repeated until you press Enter without specifying a station or you type "D" and Enter.

Interpolate end points (Yes/No) <Y>: Type "Y" and Enter or press Enter to interpolate endpoints or "N" and Enter to not interpolate endpoints.

Pulldown Menu Location: CG-Survey > Earthworks > Cross Sections
Keyboard Command: cg_xs_from_tin
Prerequisite: existing C&G TIN file (*.tin).

Create from Contours
This feature allows you to create cross sections from existing contour polylines. The following is a typical example of a portion of a single cross section:
To generate the cross sections, you must first select one of the following alignment sources. Cross sections will be created at right angles to the alignment source at a specified station interval and at designated intermediate stations.

The feature first asks you what the alignment source is:

**Select alignment source [Point-group/polYline/Drag] <P>:** Type "P" and Enter or just press Enter to use a file dialog box to select the point group to be used to define the alignment.
If you type "Y" and Enter you will see the following prompt:

**Select polyline to use for alignment:** At this prompt you must select a polyline from the screen to define the alignment.

The Drag option allows you to pick two or more points on the screen. You may pick any locations on the screen or type in point IDs to define the alignment.
To use the Drag option, type "D" and Enter then respond to the following prompts:

**Pick start Point:** Pick the first point in the alignment.
**To point (<Enter> when done) [Arc/Length/Undo]:** continue entering points defining lines and arcs. Press Enter when done.

Once you have specified an alignment, you will be prompted for the following information

**Enter station for beginning point <0.000000>:** Enter the beginning station as a decimal number.

**Enter offset from alignment to cross section <0.000000>:** Enter the offset. Precede the offset amount with a "+" for right of alignment, a "." for left, or press <Enter> for no offset. Left or right is determined by looking along the alignment in the direction of increasing stationing.

**Enter interval for creating cross sections <50.000000>:** Enter the interval along the alignment for the creation of cross sections.

**Enter maximum range to cross section <99999999.000000>:** Specify how far to the left and to the right of the alignment that the cross sections will extend. If you press Enter to accept the large default value, cross sections will be created for the full width of the topography. If you set the maximum range to 50, each cross section will be a total of 100' wide - 50' left and 50' right of the alignment.

**Enter Odd stations (6+34.22 as 634.22) [Done]:** Enter the decimal number for any station along the alignment where you wish to have a cross section created. This prompt will be repeated until you press Enter without specifying a station or you type "D" and Enter.

**Interpolate end points (Yes/No) <Y>:** Type "Y" and Enter or press Enter to interpolate endpoints or "N" and Enter to not interpolate endpoints. If the range has been set to a specific distance, the cross section line may not intersect a contour at that point. If you choose to interpolate end points, the program interpolates an elevation at the maximum range offset.

You will then use a file dialog to specify the cross section file to save the new cross sections to. You may choose a new or an existing file name. If you choose an existing file then the following dialog will appear:
At this point the cross section file will be created. To check the resulting cross sections, you can List or Draw the cross sections or you can view and/or edit the file using the CGEditor.

**Prompts**

**Select alignment source [Point-group/polyline/Drag] <P>:** Type "P" and Enter or just press Enter to use a file dialog box to select the point group to be used to define the alignment.

**Select polyline to use for alignment:** If you selected polyline at the first prompt, At this prompt you must select a polyline from the screen to define the alignment.

If you chose Drag at the first prompt, you will see the next two prompts:

**Pick start Point:** Pick the first point in the alignment.

**To point (<Enter> when done) [Arc/Length/Undo]:** continue entering points defining lines and arcs. Press Enter when done.

**Enter station for beginning point <0.000000>:** Enter the beginning station as a decimal number.

**Enter offset from alignment to cross section <0.000000>:** Enter the offset. Precede the offset amount with a "+" for right of alignment, a "-" for left, or press <Enter> for no offset.

**Enter interval for creating cross sections <50.000000>:** Enter the interval along the alignment for the creation of cross sections.

**Enter maximum range to cross section <99999999.000000>:** Specify how far to the left and to the right of the alignment that the cross sections will extend.

**Enter Odd stations (6+34.22 as 634.22) [Done]:** Enter the decimal number for any station along the alignment where you wish to have a cross section created. This prompt will be repeated until you press Enter without specifying a station or you type "D" and Enter.

**Interpolate end points (Yes/No) <Y>:** Type "Y" and Enter or press Enter to interpolate endpoints or "N" and Enter to not interpolate endpoints.

**Pulldown Menu Location:** CG-Survey > Earthworks > Cross Sections

**Keyboard Command:** cg_xs_from_contours

**Prerequisite:** existing drawing with contour polylines on specific contour layers (see Tools > CG Options).
Create from Templates

This feature allows you to create a cross section file from a specified template or set of templates. You must first have created the templates to be used.

Template files contain data defining standard cross section templates that can be used to create a cross section file that represents the design cross sections for a proposed alignment. Cross section files created using templates can be overlaid over existing cross sections to allow the computation of cut and fill volumes and to visualize the design alignment. For more information on creating and editing template files see the CGEditor section.

As an example of how template files are used, consider a template file for a proposed roadway. For almost any roadway there would be several different design cross sections or templates through the course of the roadway, for example:
- Template 1 = 4 lanes with no island
- Template 2 = 4 lanes with a 25’ center island
- Template 3 = 4 lanes with a 25’ island and a 12’ right turn lane

The proposed cross section is created by placing templates along the alignment at the appropriate stations.

If a template file is not currently open you will be prompted to open one using the Open cross section template file dialog. This template file may contain only a single template but it is more likely a library of templates as described earlier.

You will then use a file dialog to specify the cross section file to save the new cross sections to. You may choose a new or an existing file name. If you choose an existing file then the following dialog will appear:

Once you have chosen the cross section file to create the following prompt appears at the Command: line.

**Select alignment source [Point-group/polyline/Drag] <P>:** Type "P" and Enter or just press Enter to use a file dialog box to select the point group to be used to define the alignment.

**Note:** If the point group contains vertical curve information, this data will be used to calculate the center line elevations. If the point group contains no vertical curve information, the actual elevations of the coordinate points specified in the point group will be used to determine the center line elevations.

If you type "Y" and Enter you will see the following prompt:

**Select polyline to use for alignment:** At this prompt you must select a polyline from the screen to define the alignment.
The **Drag** option allows you to pick two or more points on the screen. You may pick any locations on the screen or type in point IDs to define the alignment.

To use the **Drag** option, type "D" and Enter then respond to the following prompts:

**Pick start Point:** Pick the first point in the alignment.

**To point (<Enter> when done) [Arc/Length/Undo]:** continue entering points defining lines and arcs along the alignment. Press Enter when done.

Once you have specified an alignment, you will be prompted for the following information

**Enter 1st TEMPLATE number <1>:** 1 (4 Lanes no Island in the example above)

**Enter Station for TEMPLATE 1 <0.00000>:** enter the station in the alignment where the first template starts to be used.

These first two entries define the beginning station and the template being used for portion of the alignment

**Enter 2nd TEMPLATE number <1>:** 1 (4 Lanes no Island in the example)

**Enter station for TEMPLATE 1 <0.00000>:**

This means that, if the two entries for the stations were 10250.0 and 10500.0, between station 10+250 and 10+500 Template 1 will be used.

Continue to enter two pairs of template number/station data for the alignment.

**Enter 1st TEMPLATE number <1>:** 2 (4 lanes with a 25' center island in the example)

**Enter Station for TEMPLATE 2 <0.00000>:** 10550 (example stationing)

Again these first two lines define the beginning station and the template being used for this portion of the alignment.

**Enter 2nd TEMPLATE number <2>:** 2 (4 lanes with a 25' center island in the example)

**Enter station for TEMPLATE 2 <0.00000>:** 10750 (example stationing)

The first set of templates from station 102+50 to 105+00 all used template # 1.
The second set of templates from station 105+50 to 107+50 all used template # 2.
The area between station 10+500 and station 10+550 (50 feet) is a transition area. In a transition area volumes will be calculated using the average end area method.

**Enter offset from alignment to cross section <0.00000>:** Enter the offset. Precede the offset amount with a "+" for right of alignment, a "+-" for left, or press <Enter> for no offset. Left or right is determined by looking along the alignment in the direction of increasing stationing.

**Enter interval for creating cross sections <50.00000>:** Enter the interval along the alignment for the creation of cross sections.
Enter Odd stations (6+34.22 as 634.22) [Done]: Enter the decimal number for any station along the alignment where you wish to have a cross section created. This prompt will be repeated until you press Enter without specifying a station or you type "D" and Enter.

Enter maximum range to cross section <99999999.000000>: Specify how far to the left and to the right of the alignment that the cross sections will extend. If you press Enter to accept the large default value, cross sections will be created for the full width of the topography. If you set the maximum range to 50, each cross section will be a total of 100' wide - 50' left and 50' right of the alignment.

Enter value to add to calculated elevations <0.000000>: At this prompt you can specify an amount to add to or subtract from the calculated elevation, in other words, a vertical offset. Entering this value can allow you a trial and error method of balancing the cut and fill for the alignment. Note: when using a point group to define the alignment, the center line elevation of the cross section is based on any vertical curve information found in the point group file plus the value entered at this prompt.

Once you have entered the above information the cross sections will be calculated and the information will be stored in the specified cross section file.

Prompts

Select alignment source [Point-group/polyline/Drag] <P>: Type "P" and Enter or just press Enter to use a file dialog box to select the point group to be used to define the alignment.

If you type "Y" and Enter you will see the following prompt:
Select polyline to use for alignment: At this prompt you must select a polyline from the screen to define the alignment.

The Drag option allows you to pick two or more points on the screen. You may pick any locations on the screen or type in point IDs to define the alignment. 
To use the Drag option, type "D" and Enter then respond to the following prompts:

Pick start Point: Pick the first point in the alignment.
To point (<Enter> when done) [Arc/Length/Undo]: continue entering points defining lines and arcs along the alignment. Press Enter when done.

Once you have specified an alignment, you will be prompted for the following information
Enter 1st TEMPLATE number <1>: enter the template number.

Enter Station for TEMPLATE 1 <0.000000>: enter the station in the alignment where the first template starts to be used.

These prompts are repeated until you press Esc at the Enter Station for TEMPLATE prompt.

Enter offset from alignment to cross section <0.000000>: Enter the offset.

Enter interval for creating cross sections <50.000000>: Enter the interval along the alignment for the creation of cross sections.
Enter Odd stations (6+34.22 as 634.22) [Done]: Enter the decimal number for any station along the alignment where you wish to have a cross section created.

Enter maximum range to cross section <99999999.000000>: Specify how far to the left and to the right of the alignment that the cross sections will extend.

Enter value to add to calculated elevations <0.000000>: At this prompt you can specify an amount to add to or subtract from the calculated elevation.

Pulldown Menu Location: CG-Survey > Earthworks > Cross Sections
Keyboard Command: cg xs_from_template
Prerequisite: existing template file (*.tpl).

Create from Coordinate File
This feature allows you to create a series of cross sections from a coordinate file. Each point in the coordinate file located on or near a given cross section line reflects an offset/elevation pair for that cross section. This method could be particularly useful for road/sewer work or grided topos.

If no coordinate file is open, you will be asked to choose one using a file dialog. Next you will be asked to select the points in the coordinate file that will be used to create the cross sections:

Add points from coordinate file. (Enter when done)
[All/Block/Code/Desc/Elev/Pt-group/Limits/Radius/Select]: Select the points you wish to use. In this case, you need not be concerned about multiple points resulting in duplicate offsets and elevations: duplicates do not effect the resulting cross section.

Select alignment source [Point-group/polyline/Drag] <P>: Type "P" and Enter or just press Enter to use a file dialog box to select the point group to be used to define the alignment.
If you type "Y" and Enter you will see the following prompt:

Select polyline to use for alignment: At this prompt you must select a polyline from the screen to define the alignment.

The Drag option allows you to pick two or more points on the screen. You may pick any locations on the screen or type in point IDs to define the alignment.
To use the Drag option, type "D" and Enter then respond to the following prompts:

Pick start Point: Pick the first point in the alignment.
To point (<Enter> when done) [Arc/Length/Undo]: continue entering points defining lines and arcs along the alignment. Press Enter when done.

Once you have specified an alignment, you will be prompted for the following information

Enter offset from alignment to cross section <0.000000>: Enter the offset. Precede the offset amount with a "+" for right of alignment, a "-" for left, or press <Enter> for no offset. Left or right is determined by looking along the alignment in the direction of increasing stationing.
Enter interval for creating cross sections <50.000000>: Enter the interval along the alignment for the creation of cross sections.

Enter maximum range to cross section <99999999.000000>: Specify how far to the left and to the right of the alignment that the cross sections will extend. If you press Enter to accept the large default value, cross sections will be created for the full width of the topography. If you set the maximum range to 50, each cross section will be a total of 100' wide - 50' left and 50' right of the alignment.

Field point location to cross section line distance tolerance <5.000000>: The points in the coordinate file are unlikely to fall exactly on cross section lines, thus you must specify a value for the maximum point to cross section line distance tolerance. This distance tolerance is used to determine if a given point should be considered to be "on" the cross section.

Enter Odd stations (6+34.22 as 634.22) [Done]: Enter the decimal number for any station along the alignment where you wish to have a cross section created. This prompt will be repeated until you press Enter without specifying a station or you type "D" and Enter.

You will then use a file dialog to specify the cross section file to save the new cross sections to. You may choose a new or an existing file name. If you choose an existing file then the following dialog will appear:

![Image of cross section file confirmation dialog](image)

At this point the cross section file will be created. To check the resulting cross sections, you can List or Draw the cross sections or you can view and/or edit the file using the CGEditor.

Prompts

Add points from coordinate file. (Enter when done)

[All/Block/Code/Desc/Elev/Pt-group/Limits/Radius/Select]: Select the points you wish to use. In this case, you need not be concerned about multiple points resulting in duplicate offsets and elevations: duplicates do not effect the resulting cross section.

Select alignment source [Point-group/polYline/Drag] <P>: Type "P" and Enter or just press Enter to use a file dialog box to select the point group to be used to define the alignment.

Select polyline to use for alignment: If you selected polYline at the first prompt, At this prompt you must select a polyline from the screen to define the alignment.

If you chose Drag at the first prompt, you will see the next two prompts:
Pick start Point: Pick the first point in the alignment.  
To point ( Enter when done) [Arc/Length/Undo]: continue entering points defining lines and arcs. Press Enter when done.

Enter station for beginning point <0.000000>: Enter the beginning station as a decimal number.

Enter offset from alignment to cross section <0.000000>: Enter the offset. Precede the offset amount with a "+" for right of alignment, a "-" for left, or press <Enter> for no offset.

Enter interval for creating cross sections <50.000000>: Enter the interval along the alignment for the creation of cross sections.

Enter maximum range to cross section <99999999.000000>: Specify how far to the left and to the right of the alignment that the cross sections will extend.

Enter Odd stations (6+34.22 as 634.22) [Done]: Enter the decimal number for any station along the alignment where you wish to have a cross section created. This prompt will be repeated until you press Enter without specifying a station or you type "D" and Enter.

Interpolate end points (Yes/No) <Y>: Type "Y" and Enter or press Enter to interpolate endpoints or "N" and Enter to not interpolate endpoints.

Pulldown Menu Location: CG-Survey > Earthworks > Cross Sections
Keyboard Command: cg_xs_from_coords
Prerequisite: Coordinate file.

Create from Overlay
This feature allows you to create a series of overlay cross sections by lifting or lowering the existing cross section a given amount or to a given elevation. In the following paragraphs the cross sections over which the overlay is created are referred to as the existing cross sections. The cross sections created due to the overlay are referred to as the proposed cross sections.

First, use a file dialog to choose the existing cross sections that the proposed overlay will be applied to.

Next, use another file dialog to specify the cross section file to save the new overlay cross sections to. You may choose a new or an existing file name. If you choose an existing file then the following dialog will appear:
Next, the Open cross section file dialog will appear.

Choose the radio button for **Overlay Value** or **Proposed Elevation**.

Next, enter one of the following values according to the overlay method used:

**Minimum Amount of Overlay** - the distance the overlay cross section is raised or lowered in relationship to the centerline of the existing cross section.

**Proposed Centerline Elevation** - the initial overlay cross section centerline.

**Left/Right Slope** - Slope left or right of the centerline for proposed cross section. Enter slope as the amount of rise or fall per foot of run. Enter a positive value for a rise and a negative value for a fall.

**Left/Right Offset** - Enter the distance left or right of the centerline for the end of the proposed cross section.

**Starting Station** - Enter the station where you wish to start the overlay.

**Ending Station** - Enter the station where you wish to end the overlay.

When done entering stations, click **OK**. The proposed cross sections will be computed and stored in the specified proposed overlay cross section file. The resulting proposed cross section data are displayed at the command line. There will be one line of data for each cross section with each cross section identified by its station.
An example of the type of information displayed is shown below:

<table>
<thead>
<tr>
<th>Station</th>
<th>Exist-Off</th>
<th>Exist-Elev</th>
<th>Min-Ovrly</th>
<th>Overlay</th>
<th>Pro-Off</th>
<th>Pro-Elev</th>
<th>Overlap</th>
</tr>
</thead>
<tbody>
<tr>
<td>10+75</td>
<td>21.5</td>
<td>1029.34</td>
<td>0.8</td>
<td>1.1</td>
<td>23.5</td>
<td>1030.61</td>
<td></td>
</tr>
</tbody>
</table>

The Overlay is the actual minimum overlay for the cross section. The Min-Ovrly is the **Overlay Value** entered in the **Overlay X-Section Data** dialog by the user for this cross section. No overlay will be less than the Min-Ovrly value, but they may be more.

**Note:** If a **Proposed Elevation** has been specified for a given cross section, then the Min-Ovrly column will be blank.

If all the stations in the existing cross section file where not selected, you will be returned to the **Overlay X-Section Data** dialog. You may calculate additional stations or click Cancel when done.

**Prompts**

Follow instructions above to fill in the **Overlay X-Section Data** dialog.

**Pulldown Menu Location:** CG-Survey > Earthworks > Cross Sections  
**Keyboard Command:** cg_overlay_xsection  
**Prerequisite:** existing cross section file (* .cew).

**Templates**

Templates are standardized cross sections that define a shape that can be placed along an alignment to create a set of proposed cross sections using the **Create from Templates** feature (see **Earthworks** > **Cross Sections** > **Create from Templates**). Once a set of cross sections have been created from templates, these cross sections can then be tied to an existing cross section for visualization and/or for use in calculating cut and fill volumes.

A template is merely a set of relative offset distances and elevation changes that define a cross section in relation to the alignment. The slope left and right are also included in the definition of a template in order to allow templates to be used when a cross section is created for the purpose of computing volumes. The slope information allows a template to be extended as needed to meet another existing cross section and thus create a closed figure.

A template file has the extension .CTP and has an accompanying index file having the extension .CTX. A single template file will typically contain several templates. Each template within a template file has an integer identification number specified by the user and used in the **Create from Templates** feature to specify which template in a file is to be used at a given station along the alignment. Thus a single template file may contain all the templates needed for a given job or type of job.

**Pulldown Menu Location:** CG-Survey > Earthworks
You can use the CGEditor to create a new template, or change an existing template. (see the CGEditor section under Tools for details on editing templates)

**Pulldown Menu Location:** CG-Survey > Earthworks > Templates > Edit Template File  
**Keyboard Command:** ETP, CG_EDIT_TEMPLATE  
**Prerequisite:** Template file (*.tpl).

---

**List Templates**

This feature allows you to list the template IDs, the left and right slopes, and the offsets and elevations for each of the templates found in a given template file.

**Prompts**

None

**Pulldown Menu Location:** CG-Survey > Earthworks  
**Keyboard Command:** cg_list_xstemplate  
**Prerequisite:** Template file.

---

**Volumes**

This feature allows you to compute volumes based on the average end area method. The average end area method takes the cross sectional area of cut and fill of two consecutive cross sections, averages the areas, then multiplies those average areas by the distance between the cross sections to compute a volume.

The two files being compared need not have the same number of sections, but one of the files must contain all of the sections that are contained in the other file.

The volume computations will begin with the first station match and end with the last station match. If, between the first and last match, a section is found in one file that does not exist in the other file, it will be assumed that there is no volume difference at that station. Also, for the volume calculations to work properly, one surface must "fit" within the first and last stations of the other surface file.

To begin the volume computations, select the Earthworks > Volumes menu item.

You must now specify the two files to be used for computing the volumes using file dialogs.

After selecting the two files to compare, you will see the following prompts at the command line:

**Use centerline control [Yes/No] <Y>:** Type "Y" and Enter or just press Enter to use centerline control or "N" and Enter to not use it.

You should answer Yes to this prompt if the cross sections were originally created using predefined centerline control that included curves (i.e., roads) and/or sharp breaks (i.e., sewer lines). By answering yes, you guarantee that an accurate distance between cross sections will be calculated from the alignment rather than relying
on the less accurate stationing values.
If you choose to use centerline control and no coordinate file is open, you will be asked to select the coordinate file using a file dialog.
Next, you must specify the alignment source at the following prompt:

**Select alignment source [Point-group/polyLine/Drag] <P>:**

If you want to use a Point-group for centerline control, type "P" and Enter or just press Enter. You then must select a point group using a file dialog.
After choosing the point group to use you will be asked for the beginning station:

**Enter station for beginning point in point group <0.000000>:** enter the beginning station of the alignment, not the beginning station for comparing volumes.

The point group method is particularly useful when computing for roadway and sewer alignments for two reasons.
1. The point group file can contain both horizontal and vertical alignment.
2. The point group file can be used in several other applications throughout the computing and drafting process.

If you wish to use a polyLine for centerline control, type "P" and Enter or just press Enter. Next pick a polyline at the following prompt:

**Select polyLine to use for alignment.**

Next you will see the following prompt:

**Enter station for beginning point of polyLine <0.000000>:** Enter the beginning station of the alignment, not the beginning station for comparing volumes.

If you wish to use the Drag method to specify the alignment control type "D" and Enter. You will then see the following prompts:

*Specify start point:* pick or enter a point ID for the first point in the alignment.
*Specify next point or [Arc/Halfwidth/Length/Undo/Width]:* pick or enter a point ID for the next point or create an arc segment.
Continue entering segments until you have defined the alignment. When you are done entering points for the alignment, press Enter instead of entering a point.
You will then be asked to specify the beginning point station:

**Enter station for beginning point <0.000000>:** Enter the beginning station of the alignment, not the beginning station for comparing volumes.

Once the alignment source and station for beginning point have been established you are then asked to specify the beginning and ending stations to use for volume calculations.

**Enter starting station to compare volumes <10250>:**

**Enter ending station to compare volumes <13500>:**

**Enter beginning taper distance <0.000000>:** Taper distances are used to blend the first and last cross sections into existing ground. If the first sections in both files are the same, enter 0 for the beginning taper.
**Enter ending taper distance <0.000000>:** Taper distances are used to blend the first and last cross sections into existing ground. If the last sections in both files are the same, enter 0 for the ending taper.

**Enter shrinkage factor <0.000000>:** The shrinkage factor is the percent reduction in volume of a loose, uncompacted material that will occur when it is compacted or when its loose volume is compared to the natural in-place volume. Fill volumes in the report represent the volume of the material in its loose, uncompacted state.

**Type of cross section tie [Vertical/End-to-end/eXtend] <V>:** In order to make sure that the end areas created by a given pair of cross sections are closed figures, it is often necessary to tie them together using end ties. End ties connect the end of one cross section to the end of another cross section and create a closed figure.

The descriptions of the various cross section tie methods follow:

- **Vertical:** A vertical line is struck at each end of the narrower section to intersected with the wider section. This is probably the most commonly used method.
- **End-to-end:** End to End ties connect the end points of both sections together. This method is rarely used.
- **Extend:** The narrower section is extended along its current slope until it intersects the other cross section. If no tie is possible, a vertical tie will be used.

After specifying the end tie method, the volumes are calculated. The volumes are displayed in the table in cubic yards or cubic meters depending on the units specified on the General tab of the C&G Options dialog.

The first part of the volume table contains the following columns of information for each station.

- **Station:** station of the cross section.
- **Cut-Area:** The area of cut at this station.
- **Fill-Area:** The area of fill at this station.
- **Cum-Cut-Vol:** The cumulative cut volume up to this station (- volume).
- **Cum-Fill-Vol:** The cumulative fill volume up to this station (+ volume).
- **Net-Vol:** The cumulative net volume up to this station (the sum of Cum-Cut-Vol and Cum-Fill-Vol)

In a second table, the left and right tie point offsets and elevations are displayed for each station. If vertical end ties are not used, the values in this table should be checked. Ties extending too far could lead to inflated volumes.

An example of the report is shown below:
<table>
<thead>
<tr>
<th>Station</th>
<th>Cut-Area</th>
<th>Fill-Area</th>
<th>Cum-Cut-Vol</th>
<th>Cum-Fill-Vol</th>
<th>Net-Vol</th>
</tr>
</thead>
<tbody>
<tr>
<td>0+50.00</td>
<td>-0</td>
<td>12</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1+00.00</td>
<td>-76</td>
<td>399</td>
<td>-71</td>
<td>381</td>
<td>310</td>
</tr>
<tr>
<td>1+50.00</td>
<td>-182</td>
<td>228</td>
<td>-310</td>
<td>962</td>
<td>652</td>
</tr>
<tr>
<td>2+00.00</td>
<td>-200</td>
<td>181</td>
<td>-664</td>
<td>1341</td>
<td>677</td>
</tr>
<tr>
<td>2+50.00</td>
<td>-243</td>
<td>146</td>
<td>-1073</td>
<td>1644</td>
<td>570</td>
</tr>
<tr>
<td>3+00.00</td>
<td>-330</td>
<td>5</td>
<td>-1604</td>
<td>1784</td>
<td>180</td>
</tr>
</tbody>
</table>

Excess Amount of Fill: 180 Cu. Yards

* - Calculations made using Vertical Ties from End Points.

**Prompts**

Use centerline control [Yes/No] <Y>: Type "Y" and Enter or just press Enter to use centerline control or "N" and Enter to not use it.

Select alignment source [Point-group/polyline/Drag] <P>:

when using a point group alignment source:

Enter station for beginning point in point group <0.000000>: enter the beginning station of the alignment, not the beginning station for comparing volumes.

when using a polyline alignment source:

Select polyline to use for alignment.

Enter station for beginning point of polyline <0.000000>: Enter the beginning station of the alignment, not the beginning station for comparing volumes.

for all alignment sources:

Enter starting station to compare volumes <0.000000>: Enter the first station used for volume calculation

Enter ending station to compare volumes <0.000000>: Enter the last station used for volume calculation

Enter beginning taper distance <0.000000>: Enter taper distance. This is used to blend the first cross section into existing ground. If the first sections in both files are the same, enter 0 for the beginning taper.

Enter ending taper distance <0.000000>: Enter taper distance. This is used to blend the last cross section into existing ground. If the last sections in both files are the same, enter 0 for the ending taper.

Enter shrinkage factor <0.000000>: Enter shrinkage factor. This is the percent reduction in volume of a loose, uncompacted material that will occur when it is compacted or when its loose volume is compared to the natural in-place volume.

**Pulldown Menu Location:** CG-Survey > Earthworks

**Keyboard Command:** cg_xs_vol

**Prerequisite:** two C&G cross section files (*.cew).
Draw Cross Sections

The feature allows the user to draw the cross sections. Just as two cross section files can be overlaid to compute volumes, they also can be overlaid and viewed graphically.

Choose **Draw Cross Sections** from the **Earthworks** menu. If a cross section file is not open, you must select a cross section file using a file dialog.

Next, the **Draw Cross Sections** dialog will appear. Use this dialog to configure how the cross sections will appear when drawn on the screen.

The **Draw Cross Sections** dialog

The **Scale** section of the **Draw Cross Sections** dialog

Set both the **Horizontal:** and **Vertical:** scales for the axes of the cross section drawings.

The **X-Section Station Range to Draw** section of the **Draw Cross Sections** dialog

Enter the **Beginning Station:** and the **Ending Station:**. This may not be the full range of sections available in the cross section file, merely the range of sections that you wish to plot now.

---

Chapter 18. CGSurvey Module
X-Section Tie:

If you overlay one set of cross sections over another set of cross sections, the cross section tie specifies how the ends of the overlaid cross sections are to be tied to the previously drawn cross sections.
You have three options for ties:

**End to End** - the end of the overlaid cross section is connected to the matching end of the existing cross section

**Vertical** - the end point is connected by extending a vertical line from the end point of the overlaid cross section until it intersects the existing cross section.

**Extend** - the smaller of the two cross sections will have its beginning and ending segments extended at their current slope until they intersect the other cross section. If no intersection occurs, then a vertical tie is used.

Clicking the Grid Options button brings up the **Draw X-Sections - Grid Options** dialog. Use this dialog to configure the appearance of the grid that is drawn for each cross section.

**Draw X-Sections - Grid Options dialog**

The **Elevation and Offset Major and Minor Grid Parameters** sections of the **Draw X-Sections - Grid Options** dialog

The "Major" grid lines are generally drawn at larger intervals and are typically darker or thicker lines. The "Minor" grid lines are drawn at intermediate intervals between major grid lines and are typically lighter or thinner lines. If you check either the **Draw Major Grid** or **Draw Minor Grid** check boxes these grid lines will be drawn for each cross section. You can specify the following items for both elevation (horizontal) and offset (vertical) grid lines:

**Interval** - the interval for the grid lines in drawing units.

**Line Width** - grid line width in drawing units.

**Layer** - specify the CAD layer for the grid lines

The **Draw Additional Grid section of the Draw X-Sections - Grid Options dialog**

You can add additional grid lines above, below, left and/or right of the grid based on the grid size and limits. Grid size and limits for each cross section are determined using the following calculations. The horizontal and vertical limits of the cross section grid are calculated based on the horizontal and vertical scale. The minimum offset and elevation for a given cross section are rounded down to the next lowest even major grid offset and elevation interval (assuming values where assigned). The maximum offset and elevation are rounded up to the next even major grid offset and elevation interval (assuming values where assigned). The draw additional grid simply adds a grid line above, below, left and/or right of the maximum and minimum values determined above. These additional grid lines outside the maximum and minimum grid limits by the amount specified in the dialog box.

**Grid Label Options** button: Selecting this option brings up the **Draw X-Sections - Grid Labels** dialog shown below.
Draw X-Sections - Grid Labels dialog

This dialog allows you to specify the format of the elevation and offset labels and where they will be located in relation to the grid.

Checking either the Draw Elevation Labels and/or the Draw Offset Labels will enable the edit boxes below each check box:

Interval (Ft/M): the labeling interval along the grid line in feet/meters. Labels do not necessarily have to be drawn for each grid line.
Label Size (In/Cm): Height of label text in inches/cm.
Horizontal Offset (In/Cm): Horizontal distance from the insertion point of the label text to the grid line.
Vertical Offset (In/Cm): Vertical distance from insertion point of the label text to the grid line.
Orientation: The text can be drawn horizontally or vertically.
Justification: Specifies where the insertion point of the text is located in relation to the grid line start point.
Layer: The name of the layer on which the labels are to be placed.

When finished click OK to close the Draw X-Sections - Grid Labels dialog. This returns you to the Draw X-Sections - Grid Options dialog.

When finished with the Draw X-Sections - Grid Options dialog, click the OK button to close the dialog and return to the Draw Cross Sections dialog.

The X-Section Layout section of the Draw Cross Sections dialog

These entries specify the how the cross sections are arranged in relation to each other.
Layer for X-Section: the layer the cross sections are to be drawn on.
Width of X-Section line: the thickness of the actual cross section line.
Number of rows of X-Sections: the number of horizontal rows of cross sections. If you said 5 for example the x-sections will be drawn 5 x-sections high and as wide as needed to show all the sections.
Horizontal Spacing: the distance between columns of cross sections.
Vertical Spacing: the distance between horizontal rows of cross sections.

Clicking X-Section Label Options button opens the following dialog box:

Draw X-Sections - X - Section Labels dialog

Use the items in this dialog to specify how the break points in the cross section line itself are to be labeled.

Label Prefix: the text added before each cross section station.
Label Size: text size for labels
Horizontal Offset: the horizontal distance left (-) or right (+) of the station location on the cross section line to the
insertion point of the label text

**Vertical Offset**: the vertical distance above (+) or below (-) the station location on the cross section line to the insertion point of the label text

**Orientation**: place the text in a vertical or horizontal orientation.

**Justification**: Specifies where the label text is located in relation to the end points of the segments of the cross section line, (see the description of justification under the Draw X-Sections - Grid Labels dialog section.

**Layer**: Layer on which the station labels are to be drawn.

Clicking the **X-Section Break Point Label Options** button brings up the following dialog:

---

**Draw X-Sections - Break Point Labels dialog**

Use the **Draw X-Sections - Break Point Labels** dialog to specify how the break points in the cross section line are formatted and where they are located in relation to the break points.

**The Break Point Elevations and Offsets sections of the Draw X-Sections - Break Point Labels dialog**

**Label Break Point Elevations** checkbox: when checked, makes it so that the elevation of each of the break points along the width of the cross section are labeled.

**Label Prefix**: text prefix for elevation label

**Label Size (In/Cm)**: Height of label text in inches/cm.

**Horizontal Offset (In/Cm)**: Horizontal distance from break point to the label's insertion point.

**Vertical Offset (In/Cm)**: Vertical distance from break point to label's insertion point.

**Orientation**: labels can have an **Horizontal** or **Vertical** orientation

**Justification**: Specifies where the label text is located in relation to the cross section break points, (see the description of justification under the Draw X-Sections - Grid Labels dialog section.

**Insert Symbol @ Break Points section of the Draw X-Sections - Break Point Labels dialog**

If you check the **Place Symbol @ Break Points** checkbox a symbol of your choosing will be placed at each break point.

**Symbol Name (Block)**: You can type in a symbol name or click on the **View Symbol List...** button and select a symbol using the dialog shown below.
Note: The symbols shown are those available according to the Type of points to draw: specified in the Drawing Settings tab of the C&G Options dialog. Click OK to choose the currently selected symbol and return to the Draw X-Sections - Break Point Labels dialog.

Symbol Size (In/Cm): Symbol size.
Layer: Layer the break point symbol is to be drawn on.
Select OK when done and you will be returned to the Draw X-Sections - X - Section Labels dialog.
Select OK again to return to the Draw Cross Sections dialog.

Drawing the Cross Sections after configuring their appearance in the Draw Cross Sections dialog.

After all the settings in the Draw Cross Sections dialog are correct, press the OK button to draw the cross sections.

You will then see the following prompt at the command line:

Select alignment source [Point-group/polyline/Drag] <P>: Type "P" and Enter or just Enter to use a point group.
You must then use the Place Cross Sections dialog to specify how the cross sections will be located in the drawing.
Place Cross Sections dialog

**X-Section Data:** displays the beginning and ending stations that will be drawn.

**Grid Tie - X-Section Tie:** there are two options:

**Drag X-Sections Dynamically** - allows you to "drag" the cross sections using the cursor then clicking to "drop" the cross sections at the current cursor location.

**Note:** the lower left hand corner of the cross sections will be placed at the cursor. If you click OK after choosing to **Drag X-Sections Dynamically**, you will see the following prompt at the command line:

**Move cross sections to desired location:** - move your cursor until you are at the location where you want the cross sections to be drawn and click the left mouse button to draw the cross sections.

**Snap to existing X-Section** - Choose this option if the current cross sections are going to be overlaid on an existing set of cross sections. An example would be placing the proposed grade on top of the existing grade. If you click OK after choosing **Snap to existing X-Section** you will see the following prompt at the command line:

**Existing cross section to tie to [Pick/Manual-entry/Quit] <P>:**
Type "P" and Enter or Enter to "pick" or graphically select an existing cross section to which the new cross sections will be tied.
Type "M" and Enter to manually enter the name of the cross section file used to draw the existing cross section you wish to tie to.
If you choose Manual-entry, you will see the following prompt at the command line:

**Type existing cross section to tie into:** - type in the name of the cross section file used to draw the cross sections you wish to tie to. Just type the file name without the extension. For example, if the file was called topo.cew type in *topo*. If the cross section you specified is found in the drawing, the new cross sections will be overlaid on the existing cross sections.

**Note:** you may not overlay cross sections that were drawn using a cross section file that has the same name as the one used to draw the existing cross sections.

**Prompts**

Use the Draw Cross Sections dialog to specify how the cross sections, and cross section grids and labels will appear in the drawing. (see instructions above)

**Move cross sections to desired location:** use the mouse to "drag" the cross sections to the proper location then click the left mouse button.
Existing cross section to tie to [Pick/Manual-entry/Quit] <P>: Type "P" and Enter or just Enter to "pick" or graphically select an existing cross section to which the new cross sections will be tied. Type "M" and Enter to manually enter the name of the cross section file used to draw the existing cross section you wish to tie to. Type "Q" or Esc to end the command.

Type existing cross section to tie into: - type in the name of the cross section file used to draw the cross sections you wish to tie to.

Pulldown Menu Location: CG-Survey > Earthworks
Keyboard Command: cg_draw_xsections
Prerequisite: one or more cross section file(s).

Profiles
This feature allows the user to plot one or more profiles on a grid.

Selecting Profiles from the Earthworks menu brings up the Draw Profile dialog.

The Draw Profile dialog
The Draw Profile dialog allows the user to specify the appearance of the profile, grid and labels.
**Profile Source:** Specify where the profile data is to be obtained from:
- None - Draw Grid Only
- Point Group File
- Station-Elevation ASCII File
- X-Section File
- Interpolate From TIN
- Interpolate From Contours

The **Scale** section of the Draw Profile dialog

**Horizontal:** Specify the horizontal axis scale.
**Vertical:** Specify the vertical axis scale.

The **Station Range to Profile** section of the Draw Profile dialog

**Profile Range**
- **Entire alignment** - draw the entire range of available stations.
- **Beginning station to end of alignment** - draw from the station specified in the **Beginning Station:** edit box to the end of the alignment.
- **Specify Beginning and Ending Station** - draw from the station specified in the **Beginning Station:** edit box to the station specified in the **Ending Station:** edit box. This allows you to draw the profile for any portion of an alignment.

**Note:** If you enter 0.0 for the beginning and ending stations, the profile will be drawn for the entire length of the alignment. If you enter the same non-zero value for both the beginning and ending stations, the profile will be drawn from that station having that value to the end of the alignment.

The **Grid** section of the Draw Profile dialog

Clicking the **Grid Options...** button brings up the **Draw Profiles - Grid Options** dialog.

The **Draw Profiles - Grid Options** dialog

The **Draw Profiles - Grid Options** dialog allows you configure the grid over which the profile will be drawn.

The profile grid is configured in much the same way as is the cross section grid; with the exception that you cannot plot symbols at the profile break points. See the **Draw X-Sections - Grid Options** dialog section of the **Earthworks > Cross Sections > Draw Cross Sections** chapter for a description of the grid configuration options.

The **Profile** section of the Draw Profile dialog

**Layer For Profile:** Specify the layer on which the profile is to be drawn.
**Width of Profile Line:** Specify the line width for the Profile line in inches/cm.

**Drawing the Profile**
Once the **Draw Profile** dialog settings are completed, click the **OK** button to continue the process of drawing the profile.

Depending on the profile source specified, the step by step method will vary slightly.

**Using a Point Group as a profile source**

After clicking **OK** in the **Draw Profiles** dialog, if a coordinate file is not open, you must specify a coordinate file using a file dialog.

Next, you will be asked to select the point group file (*.pts) from another file dialog.

After specifying the point group file to use, you will see the following prompt at the command line:

**Enter station for beginning point in point group:**  
*<0.000000>*: Enter the decimal value of the starting station for the first point in the point group.

**Enter offset from alignment to profile**  
*<0.000000>*: Specify the offset of the profile from the alignment.

You may press Enter to take the default value and create a profile on the specified alignment.

The **Profile Statistics** dialog be displayed. (see **Final steps for all types of Profile Sources** for the remaining steps in the process).

**Using a Station-Elevation ASCII File:**

This option allows you to use a station-elevation file to create a profile. A station-elevation file is an ASCII text file having an extension of .SE containing station-elevation pairs placed in columns. You can create a station-elevation file using notepad. This file must be formatted so that each station-elevation pair has at least 1 space separating them. Comment lines containing ONLY alphabetical characters and NO NUMBERS are ignored. In the following example the "station" and "elevation" column headers are comments and are therefore ignored. The first column must be the station number, specified as a decimal, and the second column is the elevation.

```
Station Elevation
100 114.26
150 118.45
200 118.24
250 123.78
300 125.20
```

First, you will be asked to specify the station elevation file using a file dialog and, after clicking **OK**, the **Profile Statistics** dialog be displayed. (see **Final steps for all types of Profile Sources** for the remaining steps in the process).

**Using a Cross-Section File**

This option allows you to interpolate a profile from a cross section file. See Earthworks > Cross Sections section for information on how to create a cross section file.

If a cross section file is not open, you must open a cross section file using a file dialog.

Before the profile is drawn, you will see the following prompt:

**Enter offset from alignment to profile**  
*<0.000000>*:

You can profile along any one of the offsets specified for the cross sections in the cross section file.
For example: if the cross sections have offsets from -100 to +100, you can select an offset anywhere between the -100 to +100 or enter a zero to use the centerline.

The Profile Statistics dialog be displayed. (see Final steps for all types of Profile Sources for the remaining steps in the process).

Use Interpolate from Contours

You can use this option to interpolate a profile from contour polylines that exist in the drawing.

After clicking OK in the Draw Profile dialog, you will see the following prompt at the command line:

Select alignment source [Point-group/polyline/Drag] <P>:

If you type "P" and Enter or just press Enter to use a point group to define the alignment, you will be asked to open a point group file (*.pts) using a file dialog.

If you type "Y" and Enter, you will see the following prompt:

Select polyline to use for alignment: pick an existing polyline to use as the alignment

If you type "D" and Enter, you will see the following prompt:

Pick start Point: pick the first point in the alignment or type in a point ID from the current coordinate file.

To point (<Enter> when done) [Arc/Length/Undo]: pick the next point in the alignment.

Continue to enter points defining lines and curves until done, then just press Enter without picking a point.

Next you will see the following prompts at the command line:

Enter station for beginning point <0.000000>: Enter the starting station as a decimal number.

Enter offset from alignment to profile <0.000000>: Press Enter for no offset or specify an offset (use '+' to right and '-' to left)

The Profile Statistics dialog be displayed. (see Final steps for all types of Profile Sources for the remaining steps in the process).

Use Interpolate from TIN

You can use this option to interpolate a profile from either a TIN file.

After clicking OK in the Draw Profile dialog, you will see the following prompt at the command line:

Select alignment source [Point-group/polyline/Drag] <P>: select the alignment source as described above in Use Interpolate from Contours.

You will be prompted to select a surface file if one is not already open. (See the Earthworks > Topo section for information on how to create a surface file.)

Next you will see the following prompts at the command line:

Enter station for beginning point <0.000000>: Enter the starting station as a decimal number.

Enter offset from alignment to profile <0.000000>: Press Enter for no offset or specify an offset (use '+' to right and '-' to left)

The Profile Statistics dialog be displayed. (see Final steps for all types of Profile Sources for the remaining steps in the process).

Final steps for all types of Profile Sources

The Profile Statistics dialog is displayed no matter which profile source is used.
The Profile Statistics dialog

The **Profile Statistics** dialog displays the **Alignment Data** and the **Profile Data**. The **Profile Statistics** dialog also contains the **Snap to Existing Grid/Profile** button. This button allows you to tie the current profile to an existing profile or grid.

If you click the **Snap to Existing Grid/Profile** button, you will see the following prompt at the command line:

**Pick Lower Left of existing Profile Grid:** pick an existing profile or grid to tie to.

After picking the grid or profile the new profile will be overlaid on the profile/grid you picked.

If you select the **OK** button instead of the **Snap to Existing Grid/Profile** button, you will see the **Move Grid to desired location** prompt at the command line and the profile will be drawn at the cursor. You can now "drag" the profile to the desired location. Left-clicking the mouse causes the profile to be drawn at the cursor location.

**Prompts**

Follow the instructions above to configure the way the drawn profile will look using the **Draw Profile** dialog.

- for a point group profile source:
  **Enter station for beginning point in point group:** `<0.000000>`: Enter the decimal value of the starting station for the first point in the point group.

- for point group, TIN and contour profile source:
  **Enter offset from alignment to profile `<0.000000>`:** Specify the offset of the profile from the alignment. You may press Enter to take the default value and create a profile on the specified alignment.
for TIN and contour profile source:

**Select alignment source [Point-group/polYline/Drag]** <P>: Type "P" and Enter or just press Enter to use a pont group to define the alignment. Type "Y" and Enter to pick an existing polyline to use as the alignment source. Type "D" and Enter to pick the alignment points from the screen.

**Enter station for beginning point <0.000000>:** Enter the starting station as a decimal number.

**Enter offset from alignment to profile <0.000000>:** Press Enter for no offset or specify an offset (use ‘+’ to right and ‘-’ to left

if you click the **Snap to Existing Grid/Profile** < button in the **Profile Statistics** dialog:

**Pick Lower Left of existing Profile Grid:** pick an existing profile or grid to tie to.

if you click **OK** button in the **Profile Statistics** dialog:

**Move Grid to desired location.** "Drag" the profile to the desired location using the mouse and left-click to draw the profile at the cursor location.

**Pulldown Menu Location:** CG-Survey > Earthworks

**Keyboard Command:** cg_draw_profiles

**Prerequisite:** depends on method used: coordinate file, TIN file, cross section file, ASCII station-elevation file, and/or point group file.

---

**CGEditor**

**CGEditor**

The CGEditor is an integral part of preparing files for use for C&G applications. The CGEditor is a very powerful tool. You can open multiple data files of any supported file type and edit the files as needed. The CGEditor has a full complement of tools for searching and replacing and navigating within a file. It will also allow you to cut or copy records from one file and paste them into another file in order to merge files, move data between phases of a job, etc.

**Types of data files supported**

The CGEditor can create and/or edit four types of data files used by CGSurvey and Carlson.

**Raw Data Files**

Raw data files contain information pertaining to a field traverse. Raw data files are typically downloaded from the data collector and converted to the C&G raw data file format. These files have the extension .cgr.

**Map Check Files**

Map Check files contain bearing, distance and curve information and are typically used to calculate the closure of a deed description. These files have the extension .cgm.
Cross Section Files

Cross Section files contain one or more cross sections identified by their station along the alignment. Each cross section record has the percent grade defined for its left and right slopes. Following the "Station" record are several "Point" records containing the elevations and offsets of the points along the cross section. Cross section files consist of a pair of files; the main data file has the extension .cew and the index file has the extension .cex.

Template Files

Template files are merely cross section files that represent a standard cross section and can be used to generate other cross section files. However, unlike cross section files, template files use an integer ID instead of a station to uniquely identify each template. Like cross section files, the percent grade is defined for the left and right slopes of each template and there are a set of "Point" records specifying the template elevation at a given offset. The centerline elevation at offset 0.00 is typically set to 0.00. Template files consist of a pair of files; the main data file has the extension .ctp and the index file has the extension .ctx.

NOTE: The CGEditor program sold as part of the stand alone version of SurvNET can only be used to edit raw data files.

The CGEditor can be used to create new files or edit existing files. It uses a multi-document interface, so you can edit or view several files of several different types at the same time. The following sections will describe how to open and edit files.

Opening Existing Files

To open an existing file, click on the File menu then choose Open in the submenu. You can then use the Open file dialog box to browse to the desired file. Check to make sure the Files of Type: is set correctly. Click on the desired file to highlight it, then click the Open button.
Creating Files

To create a new file, use the **File** menu and choose **New** and then click on the type of file you wish to create:
Point Group File

After clicking the menu item for the type of new file you wish to create, a temporary file is created with no data in it and a spreadsheet-like window will open. At this point more menus items will be added to the main menu and, as you will see, the Add menu item will allow you to insert data rows (or records) where you can enter your data.

NOTE: The CGEditor program sold as part of the stand alone version of SurvNET can only be used to edit raw data files.

The CGEditor Menus

File Menu

Many of the following File menu items will be familiar to experienced Windows users:

**New**: Allows you to create a new file.

**Open (Ctrl + O)**: Brings up the Open File dialog box so you can select and edit an existing file.

**Close (Ctrl + E)**: Closes the current data file. If more than one file is open, the file that is currently being worked on will be closed.

**Save (Ctrl + S)**: Saves the current file.

**Save As**: Allows the user to save the current file to a file having a different name.

**Print (Ctrl + P)**: Allows the user to print a copy of the currently active file.

**Print Preview (Ctrl + W)**: Display a preview of the file about to be printed.

**Print Setup (Ctrl + u)**: Printer selection as well as page size and layout.

**Exit (Ctrl + Q)**: Exit the CGEditor application.
Edit Menu

As with the File menu, the Edit menu is typical of most Windows programs. Most of the items in the Edit menu require that either a field within a record, or the entire record itself, be selected (highlighted) before clicking the menu item. To select a an individual data item (or field) in a data record simply click the field. To select a record (row) simply click in the the first field (Type or Row#) for the desired record.

**Undo (Ctrl + Z):** Undoes the most recent editing action. (you need not have anything highlighted for this item)

**Redo (Ctrl + Y):** Reverses the most recent undo action. (you need not have anything highlighted for this item)

**Cut (Ctrl + X):** Cuts the currently highlighted cell or record. You may then use the paste command to put the cut cell or record in another location.

**Copy (Ctrl + C):** Copies the currently highlighted cell or record. You may then use the paste command to put the copied cell or record in another location.

**Paste (Ctrl + V):** Allows you to paste any previously cut or copied cell or record to the currently highlighted location.

If entire records are being pasted and only a field is currently highlighted, the pasted records will be inserted above the current record. However, if one or more entire records are currently highlighted, the pasted records will replace the highlighted records.

**Delete (Delete key):** Deletes the currently highlighted field or record.

**Select All (Ctrl + A):** Selects all the records in the current data file.

**Clear (Ctrl + L):** Removes the data from the selected field or record.

Add Menu

The Add menu allows you to add a record to the current file. The Add menu item appends the record to the end of the file. The types of records that can be added will depend on the type of file being edited, these record types will be described in more detail in later sections for each type of file you can edit.

Insert Menu

The Insert menu allows you to insert a record above the current record. The types of records that can be inserted will depend on the type of file being edited, these record types will be described in more detail in later sections for each type of file you can edit.

View Menu
The View menu allows you to turn tool bars on or off. The items listed in the View menu will differ for different types of files. The individual tool bars will be discussed in the sections pertaining to the various types of files that can be edited.

**Standard Tool Bar**

![Standard Tool Bar](image)

The above figure shows the standard tool bar. The Standard toolbar is the same for all types of files. It allows you to create all the various files that can be edited by the CGEditor. It allows you to open and save files. It allows you to cut, copy and paste and undo and redo as well as print the current file.

**Settings**

![Settings](image)

The Settings Menu will differ depending on the type of file being edited. But generally contains the settings for the file and the record colors.

**Tools**
The Tools Menu contains a variety of spreadsheet tools, such as find, find next, find and replace etc. The menu will vary slightly for each type of data file and will be discussed in the sections pertaining to the various file types.

**Windows**

This menu contains many of the standard Window menu items found in other programs. It allows you to arrange the currently open windows in several configurations. It has the added functionality of the New Window command which allows you to have two or more views of a single file.

**Traverse types**

The raw data file contains data pertaining to one or more traverses.

There are three basic types of traverses:

- **Closed Loop Traverse**
- **Closed Traverse Beginning and Ending at Known Points**
- **Open Traverse and Side Shots**

Figures 1, 2, 3 and 4 show illustrations of each of these traverse types. Below each illustration you will also see the accompanying raw data as seen in the CGEditor.

**Closed Loop**

A closed loop begins and ends on the same two points as shown below in Figure 1.
Closed Loop beginning and ending on known points

Figure 2 shows a closed traverse beginning on two known points (1 and 2) and ending on two known points (4 and 5). With this type of traverse, both a linear and angular closure can be calculated.
Figure 2

Loop beginning on two known points and closing on an azimuth

Figure 3 illustrates a traverse that begins on two known points, or a single known point and a back sight azimuth, and ends on one known point. In this case it is only possible to calculate a linear closure.
Figure 3

Open Traverse

Figure 4 shows an open traverse (side shots).
In these figures each traverse has been placed in a separate raw data file. However, with the use of special codes you can combine multiple traverses in a single raw data file.

### Entering and Editing Traverse Data

In the CGEditor "Raw Data" refers to unadjusted field traverse data, typically downloaded to the PC from a data collector. C&G raw data files have the extension .CGR.

### Creating or Opening a Raw Data File

To create a new file or open an existing file click on the **File** menu then either click on **New** or **Open**. If you click on **New**, another submenu will appear, pick **C&G Raw Data File**. In either case you will then see a file dialog. Browse to the directory where you wish to work and, if creating a new file, type in a file name, or, if opening an
existing file, click on a raw data file (*.cgr). Next, click the **Save** button for a new file or the **Open** button for an existing file.

If you are creating a new file, an empty file will be shown in its own document window within the editor. If you are editing an existing file, the data from the file will appear in a similar document window. It is possible to have multiple documents open at the same time. So you could create a new file and open an existing file in the same editing session and each would appear in its own window in the editor. You can have as many new and/or existing files open as your project demands.

**Settings**

Before entering any data you should check the current settings. Click the Settings menu item then click Raw Data File to review and/or change the current settings. (See Settings Menu section later in this section.)

**Traverse Data Entry**

A line or row in the raw data file is referred to as a record and each item of data in a record is referred to as a field. There are several types of records that you may use in a raw data file:

- Instrument Point
- Foresight
- Foresight Tie
- Reference Bearing
- Coordinate Value
- Standard Errors
- Control
- Measurement
- Setup
- Elevation
- Scale
- Loop Traverse
- Closed Traverse
- Open Traverse
- End Traverse
- Data on/off
- Comment

The type of data required for each of these types of records varies. Some require no data entry and are only "flags" to signify the beginning or ending of a series of records, others require only one field to be filled out, while others require several fields of data.

**Adding and Inserting new records**

When creating a new file, to begin entering data you must select from the **Add** or **Insert** menus to create the first blank record and begin data entry. Depending on what type of record you are editing, when you press `<Enter>` for the last field in the record, the following record will be added automatically.

**Note:** If the **Add** and/or **Insert** toolbars are not showing, click on the View menu then click on the toolbar
you want to turn on.

When you click on one of the Add menu items or toolbar icons, an empty record is added to the end of the file. If you click on one of the Insert menu items or toolbar icons, an empty record is inserted above the currently active record or field. To make a record the currently active record, just click on one of its fields.

Moving from field to field:

While entering data, to move to the next field, press the Enter or the Tab key. To move to the preceding field press the Esc key or both the Shift and Tab keys at the same time.

Insert and Add menus

<table>
<thead>
<tr>
<th>Insert</th>
<th>Ctrl+Alt+P</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inst. Point</td>
<td>Ctrl+Alt+P</td>
</tr>
<tr>
<td>Foresight</td>
<td>Ctrl+Alt+F</td>
</tr>
<tr>
<td>Foresight Tie</td>
<td>Ctrl+Alt+G</td>
</tr>
<tr>
<td>Reference Bearing</td>
<td>Ctrl+Alt+B</td>
</tr>
<tr>
<td>Coordinate Value</td>
<td>Ctrl+Alt+U</td>
</tr>
<tr>
<td>Coords From File</td>
<td>Ctrl+Alt+F</td>
</tr>
<tr>
<td>Standard Error</td>
<td>Ctrl+Alt+S</td>
</tr>
<tr>
<td>Elevation</td>
<td>Ctrl+Alt+I</td>
</tr>
<tr>
<td>Scale</td>
<td>Ctrl+Alt+C</td>
</tr>
<tr>
<td>Loop Traverse</td>
<td>Ctrl+Alt+L</td>
</tr>
<tr>
<td>Closed Traverse</td>
<td>Ctrl+Alt+D</td>
</tr>
<tr>
<td>Open Traverse</td>
<td>Ctrl+Alt+O</td>
</tr>
<tr>
<td>End of Traverse</td>
<td>Ctrl+Alt+N</td>
</tr>
<tr>
<td>Data On/Off</td>
<td>Ctrl+Alt+X</td>
</tr>
<tr>
<td>Comment</td>
<td>Ctrl+Alt+M</td>
</tr>
</tbody>
</table>

Instrument Point records

The first record of a raw data file is often an instrument point. Add or insert a blank record using the menus or toolbars. Fill in the following fields in the new instrument point record:

**Inst. Point:**
Enter the point ID of the instrument point.

**Inst. Height (or HI):**
Enter the instrument height. This may be either the distance from the IP on the ground ("Plus-up") or the actual elevation of the instrument, depending on how the data is to be reduced. This field will only be active if elevations are on. (See the Settings section in the Entering and Editing Traverse Data section of this chapter). If elevations are ON and you leave this field BLANK (zero is a valid height), all measurements taken a this setup will be considered 2D and no elevations will be calculated.

**Backsight:**
Enter the point ID for the backsight.

**Rod Height:**
Enter the rod height. This field will only be active if elevations are on. (See the Settings section in the Entering and Editing Traverse Data section of this chapter).

**Horz. Angle:**
Enter the instrument's initial horizontal angle reading at the backsight. When doing an azimuth traverse, no entry is required here.

**Note:** on doubled angles: Doubled angles require 2 Instrument Point records. Each new instrument setup requires a 0 to the back sight. The first angle to the foresight is the single angle. This angle is locked into the gun and the back sight is retaken. The second angle to the foresight is the doubled angle. You may also double angles to side shots.

**Slope Distance and Vertical Angle or Horizontal Distance and Vertical Distance to the Back sight:**
Enter the appropriate distance and/or angle. A blank is assumed to be a zero.

**Note:** When the Slope Dist/Vert Angle or Horz. Dist/Vert. Dist. column headings are preceded by a "^", it indicates that a record inserted before the current record (or added after the current record) will have the same type of distance entry mode. For example, if the heading shows Dist and Angle and you insert a record, the new record will be in the Slope Dist/Vert Angle distance entry mode. You can change this by clicking on one of the distance headings to remove or add the "^". If the "^" is not present it means that the inserted or added record will have the opposite distance entry mode than does the current record.

If, after entering the data in the last field of a given Instrument Point record, you press the Enter or Tab key, a Foresight record will automatically be created. If you want to change this newly created blank Foresight record into an Instrument Point record, press the Esc key. If you are at the end of the file, pressing Esc again to delete last blank record.

**Foresight Point records**

After entering the data for the last field in the Instrument Point record, press Enter. This will cause a Foresight record to be created below it. This record will contain the following columns (the explanations of several of these columns are as described for Instrument Points, only the differences will be noted here):

**Rod Height:**
This column is only active if elevations are on. If elevations are ON and this field is left BLANK, the point will be considered 2D and an elevation will not be calculated. **Horz. Angle:**
Enter the instrument's horizontal angle reading at the foresight point. Enter a positive value for a clockwise angle and a negative value for a counter-clockwise angle. This entry may be blank if you are entering only the distance readings to the foresight.

**Slope Dist./Vert Angle or Horz. Dist/Vert. Dist.:**
Enter the distance data for the foresight point.

**Foresight:**
Enter the Point ID for the foresight point.

**Code:**
Enter the code for the Foresight Point. This column is only active if Code is on. (See Settings in this section.)

**Description:**
Enter the description for the Foresight Point. The number of characters you are allowed to enter is set in the Settings under Description Length. If you enter an integer code here and the Translate Raw Descriptions Using Description Table is checked in the Settings and a matching description number is found in the description table, then the description from the table will replace the integer value you entered in the Description field. The integer value you
entered will then be moved to the Code field.

**Note:** Side shots should be placed within the block of foresights immediately following the instrument point record for the instrument point from which they were shot. You may append side shots to the end of a traverse file, but they must be preceded by a begin open traverse record.

**Foresight Tie records**

In some cases, you will need to tie to an existing traverse. You use a **Foresight Tie** record to do this. This record is used in the reduction process to determine what known point you are tying into. It is necessary if there are side shots taken at the last setup along with the tie point.

In a closed traverse, you must end a traverse by occupying a known point and turning an angle to a second known point. The second known point is the tie point.

**Reference Bearing**

**From Point**
Enter the point ID of the from point.

**To Point**
Enter the point ID of the to point

**Bearing (Azimuth)**
Bearings must be entered in the form Qdd.mmsss where Q is the quadrant (1 = NE, 2 = SE, etc), d is whole degrees, m is minutes, and s is seconds (you can specify seconds to the nearest .1 seconds but when you do not wish to specify tenths of a second, a trailing is zero it is not required).

Azimuth is entered as ddd.mm.sss (when the leading d or the trailing s is zero, it is not required)

**Coordinate Value record**

You can use either the Add or Insert menus or toolbars to create a new coordinate record. You can then hand enter known coordinates for a point. Coordinates can be used as a reference point during the reduction process.

**Entering Coordinate Value records from a Coordinate File**
Instead of hand entering coordinate points, you can insert coordinate records from an existing coordinate file.
Click the Insert menu, then pick the Coords From File menu item.
Elevation

You can specify the elevation for a given point ID using an Elevation record.

Scale

You may specify a scale factor in a Scale record. A scale factor is a decimal number. You may enter as many scale factors as you wish. A scale factor will be used until another is encountered. Scale factors should be placed before an Instrument Point record.

Note: Multiple Traverses: If you are combining more than one traverse in a single raw data file, you must separate the traverses with special records. After inserting or adding a begin traverse record, you may type in a comment regarding the traverse in the Comment column. You may also specify the order in which the traverses are to be processed by using the first part of the Comment field. Please see Traverse reduction order below for more details.

Note: If you are processing the data with SurvNET, the Scale records are ignored. SurvNET calculates scale factors automatically when working on State Plane coordinates.

Beginning and/or ending a Traverse

Note: If you are processing the data with SurvNET, Traverse Records (LT, OT, CT, ET) are ignored. Since SurvNET adjusts all data simultaneously, it requires no traverse definitions.

Use Loop Traverse, Open Traverse and Closed Traverse records to delineate multiple traverses within a single file.
Traverse reduction order

The order in which the traverses appear in the raw data file is typically not important. Traverses are processed in the order in which they appear in the file. Traverses may be entered in a sequential order or you may embed one traverse within another. However, if the coordinates computed from one traverse are needed for the reduction of another traverse, then traverse order **is important**. If this condition is true for a raw data file and the traverses have NOT been placed in the raw data file in the correct order, then you need to specify a Traverse Order Number for each traverse in the file.

**Note:** If you specify Traverse Order Numbers, the traverses in the file will be reduced in the order of their Traverse Order Numbers.

Traverse Order Numbers

Each Loop Traverse, Open Traverse or Closed Traverse comment field can contain a Traverse Order Number.

**Note:** The Traverse Order Number must be an integer and must appear as the first entry in the Comment field separated from the remainder of the comment by a space.

For example, the comment field of a Loop Traverse record having a Traverse Order Number of 3 should look like this:

```
3 this is a comment
```

*If any one Begin Traverse record has a Traverse Order Number, then all Begin Traverse records MUST have a Traverse Order Number. Also, the Traverse Order Numbers in a given file must begin with 1 and continue sequentially. You may not duplicate a Traverse Order Number for any Begin Traverse record in a given file.*

**IMPORTANT NOTE:** Reducing a raw data file having Traverse Order Numbers that violate any of the above specifications will have unpredictable results. Error messages during the reduction process may not reflect the fact that improper traverse order numbering is actually the root cause of the problem.

Loop Traverse

This record indicates the beginning of a loop traverse. A loop traverse begins and ends at the same point. If you wish to add a comment to identify the traverse in some way, just type it in the Comment column.

Closed Traverse

This record indicates the beginning of a closed traverse. A closed traverse ties into known points at both ends. If you wish to add a comment to identify the traverse in some way, just type it in the Comment column.

**Note:** If you are running a Closed Traverse and tying into a single point, a reference azimuth must be placed at the last instrument point if you wish to adjust the angular error.

Open Traverse
This record indicates the beginning of an open traverse. An open traverse is a group of side shots. If you wish to add a comment to identify the traverse in some way, use the **Comment** column.

**End Traverse**

Signals the end of the data records for any of the traverse types.

**Comment**

Inserts a comment line above the current active line. Comment lines are ignored during processing.

**Data On/Off**

*Data On/Off* records surround a series of records that are to be ignored during processing by C&G or SurvNET. The first *Data On/Off* record encountered causes processing to skip to the next *Data On/Off* record. Processing continues beginning at the record after the second *Data On/Off* record. This can be used when trying to isolate errors in a traverse.

**The Add and Insert Tool bars**

**ADD Tool Bar:** add the various types of traverse records to the end of the current file.

**Insert Tool Bar:** insert one of the various types of traverse records above the current record.

Notice that the only difference between the appearance of the Add Toolbar and the Insert Toolbar above is the check mark in the lower right hand corner of each icon of the Insert Toolbar.

**Toolbar Icon Explanation**

- **IP Add/Insert an Instrument Point record**
- **FS Add/Insert a Foresight record**
- **FT Add/Insert a Foresight Tie record**
- **DR Add/Insert a Reference Bearing record**
- **S Add/Insert a Scale record**
- **C Add/Insert a known Coordinate point record**
- **E Add/Insert an Elevation benchmark record**
- **LT Add/Insert a Loop Traverse record**
- **OT Add/Insert a nOpen Traverse record**
- **CT Add/Insert a Closed Traverse record**
- **ET Add/Insert an End Traverse record**
SE Add/Insert a Standard Error record for Network Least Squares Adjustment (SurvNET) program
Co Add/Insert a Comment record
DO Add/Insert a Data On/Off record

The Least Squares Toolbar

The "network" icon:
Selecting this icon will start the SurvNET Network Least Squares program. If SurvNET has already been started, clicking this icon will bring it to the front so you can work with it. (See the Tools menu section and the SurvNET section for additional info.)

The "eyeball" icon:
This icon brings up a separate window displaying a scaled map of the current raw data file. (See Graphic View under the View menu section)

The "C" icon:
Clicking this icon hides all Comment records. The Comment records still remain in the raw file, they are just not shown on the screen. You will find that there are some actions you cannot perform when Comments are off.

The "No DO" icon:
Clicking this icon removes all the Data On/Off records from the raw data file.

Status bar

When this menu item is checked, the status bar will display. The status bar is along the bottom border of the CGEditor window. On the left side of the status bar a brief help message is displayed when you hold the cursor over such things as menu items or toolbar icons. It also has indicators that tell you if Caps Lock or Num Lock are turned on and displays the Row/record number that is currently active.

Graphic View

Clicking on this menu item brings up a window containing a graphic representation of the traverse. The traverse lines and points are drawn to scale using the data from the current raw data file.
The Graphic View Window

The Graphic View window shows a scaled drawing of the current raw file traverse lines and points. The toolbar icons at the top of the window can be used to move around in the view and change its appearance. The icons will be discussed as they appear from left to right:

**Pan:** This works very much like the CAD Pan command. When you click the hand icon the cursor changes to a hand. When you click on the graphic screen the first time you are "grabbing" the graphic. You can then move it to the proper view and click a second time to "put it down". You may repeat this as many times as you wish in order to move around the drawing. When done with the Pan command, click on the Pick Point icon.

**Zoom In:** Clicking on this icon causes the graphic image to be enlarged a preset amount. The zoom factor cannot be configured. If you wish to see a certain area of the graphic image it is recommended that you click Zoom Extents then use Zoom Window to view the desired area.

**Zoom Out:** As with Zoom In, Zoom Out reduces the image size a preset amount. The zoom factor is not configurable.

**Zoom Extents:** Zooms the image so all points and lines can be seen on the screen.

**Zoom Window:** Allows you to click on two diagonal corners of the rectangular area that you wish to see.

**Pick Point:** Use this icon to allow you to pick a point on the graphics screen in order to "zoom" to the first instance of the associated point ID found in the raw data editor window. This allows you to rapidly and conveniently locate a given point ID in the data file. This is especially useful in trouble shooting for errors or other problems in the data that may be more easily detected in the graphic image than when viewing the raw data.

When you pick near a plotted point on the graphics screen its point ID is noted. The raw data file is then searched for that point ID. The active field in the editor window is then set to the first instance of that point ID. You can pick the same location several times to move to the next instance of the point ID in the file.

If you have a large Pick Radius set (See Graphic Settings) or are zoomed out, picking a point may result in more
than one point being found. If this occurs, a dialog box listing the nearby points will pop up. Using the list box in the dialog choose the desired point ID and press <Enter> or click OK to find the point in the data file. Clicking this icon also allows you to turn off the Pan feature when you are done panning.

Brings up the **Graphic Settings** dialog:

![Graphic Settings Dialog](image)

The graphic settings dialog allows you to configure the appearance of the various items that may be seen on the graphics screen.

**Note:** The **Graphic Settings** dialog is also used for the **SurvNET** program and thus the items on the **Error Ellipses** and **GPS** tabs have no effect on the **CGEditor Graphic View**.

**Points and Trav/SSs tabs**

**Control Points, Fixed Control Points and Floating Points and Traverse, Sideshots and Azimuths:** Specify whether the symbols, labels or lines for any of these should be shown. Also, if they are to be shown, specify symbol and/or line color, symbol type and point ID label size.

**Symbol:**
Choose to represent the various types of points as a Square, Triangle or Circle using the drop down list.

**Color:**
For symbol or line color you can choose Red, Green, Blue, Cyan, Magenta or Yellow from the drop down list.

**Size:**
Specify the point symbol size.

**Pt. Num.**
Text: Check the check box if you want the points labeled.

**Size:** If the points are to be labeled, specify the label height.
Pick Radius
When you pick near a point plotted on the graphics screen, the current field in the editor window moves to the first instance of that point in the current raw data file. Setting the pick radius allows you to specify how large an area around the pick point is to be searched for raw data points drawn in the Graphics View window.

Error Ellipses tab (Has no effect in CGEditor)

GPS tab (Has no effect in CGEditor)

️ Refresh Graphics: Allows you to refresh the graphics to view recent changes in the raw data due to editing.

Important Note: For the Refresh Graphics to reflect recent changes in the raw data file, you must save the file itself prior to refreshing the graphics.

Settings Menu

<table>
<thead>
<tr>
<th>Settings</th>
<th>Ctrl+Shift+R</th>
</tr>
</thead>
<tbody>
<tr>
<td>Raw Data File</td>
<td>Ctrl+Shift+R</td>
</tr>
<tr>
<td>Record Color</td>
<td>Ctrl+Shift+L</td>
</tr>
<tr>
<td>✚ Validate Records</td>
<td>Ctrl+Shift+O</td>
</tr>
</tbody>
</table>

The items in the settings menu can be used to configure how the data in the raw data file will be interpreted and the appearance of that data as seen in the CGEditor.

Raw Data File Settings dialog

When you click on the Raw Data File menu item you will see a dialog box that allows you to specify many of the more important settings related to the currently open raw data files. You can also set up the defaults that will be used for newly created raw data files.

Note: See the More on Default Settings subsection at the end of the Settings Menu section.
The Raw Data File Settings dialog

Current File

To view and/or edit the settings for a given file, pick the file using the Current File list box. You can also view and/or edit the DEFAULT settings for newly created files.

File Information

This portion of the dialog allows the user to specify job or project specific information. Except for description length, these items are for your own information and do not effect processing of the raw data.
Job: Enter any name you wish to identify the job or project.
Operator: Enter the name of the person who led the field work.
Client: The name of the person or company for whom this work was done.
Date: Date in any format you wish to use.
Temperature: Temperature at the time the field work was done. For your reference only. May be Celsius or Fahrenheit.
Pressure: Atmospheric pressure at the time the field work was done. For your reference only. May be in any units.
Book: Field book number for the field work.
Page: Page number in the field book.
Description Length: Specify the length of the description field used in this file.

Set Defaults:
This button sets the items in the File Information portion of the dialog as the current default values. When a new raw data file is created, these default settings will be used. See the More on Default Settings heading at the end of
the **Settings** section.

**Restore Values:**
This button allows you to set the values in the File Information portion of the dialog back to what they were when you opened the **Raw Data File Settings** dialog.

**Save As Default:**
Sets the default values for the **File Information** portion of the dialog. These values are used as the default settings when a new file is created. See the **More on Default Settings** heading at the end of the **Settings** section.

**File Measurement Info**

**Angular Units:** Clicking the button to the right changes the angular units from **Degrees** to **Grads** or vice versa.

**Distance Units:** Clicking the button to the right changes the distance units from **Foot** to **Meter** or vice versa.

**Foot Definition:** Clicking the button to the right changes the foot definition from **US** feet to **International** feet or vice versa. This button is only active when **Distance Units** are set to **Foot**.

**Traverse Angles:** Choose one of the items in the list to specify how the traverse angles were measured:
1. Horiz. Angles
2. Azimuths
3. Deflection Angles

**Direction:**
Specify what type of angle is used to define the direction of a line. Clicking the button to the right changes the direction from **Bearing** to **Azimuth** or vice versa.

**Azimuth Direction:**
Specify the reference direction for azimuths. Clicking the button to the right changes the azimuth direction from **North** to **South** or vice versa. This button is only active when **Direction** is set to **Azimuth**.

**Coordinate Order:** Clicking the button to the right changes the Coordinate Order from North-East to East-North or vice versa.

**Vertical Reference:** Pick one of the items from the list to the right to specify the reference orientation for measuring vertical angles:
1. Zenith
2. Nadir
3. Horizontal

**Set Defaults:**
This button sets the items in the **File Measurement Info** portion of the dialog to the current default values. See the **More on Default Settings** heading at the end of the **Settings** section.

**Restore Values:**
This button allows you to set the values in the **File Measurement Info** portion of the dialog back to what they were when you opened the **Raw Data File Settings** dialog.

**Save As Default:**
Sets the default values for the **File Measurement Info** portion of the dialog. These values are used as the default settings when a new file is created. See the **More on Default Settings** heading at the end of the **Settings** section.

**Edit Options**
**Elevation Off:**
Check this check box to turn off the Elevation data entry column for this file. This makes data input more convenient since you do not have to enter any data in the Elevation column, nor do you have to tab through it. Turning off elevations does not cause any data to be deleted from the current file.

**Code Off:**
Check this check box to turn off the Code data entry column for this file. This makes data input more convenient since you will not have to enter any data in the Code column. Turning off codes does not cause any data to be deleted from the current file.

**Description Off:**
Check this check box to turn off the Description data entry column for this file. This makes data input more convenient since you will not have to enter any data in the Description column. Turning off descriptions does not cause any data to be deleted from the current file.

**Note:** You can turn the Elevation, Code and Description data entry columns on or off while editing a file by clicking on the column heading.

**Distance Component:**
Specify how distances are to be entered. Clicking the button to the right changes the Distance Component from Slope Dist-Vert Angle to Horiz. Dist-Vert. Dist. or vice versa.

**Translate Raw Descriptions Using Description Table:**
This check box is only active if descriptions are on. If you check this check box, integer codes entered in the Description field will be looked up in the specified description table (See the following item.). If a matching description number is found in the description table, the code will be moved to the Code field and the description found in the description table will be placed in the Description field. If no matching description number is found, the Description field remains as entered.

**Desc Tbl:**
Click on the Desc Tbl button use a file dialog to set or change the description table. The description table is used to set the Description field when an integer number is entered in the Description field. (See the previous item.) If you prefer, instead of clicking on the Desc Tbl button you can also type in the full file path in the edit box.

**Set Defaults:**
This button sets the items in the Edit Options portion of the dialog to the current default values. See the More on Default Settings heading at the end of the Settings section.

**Restore Values:**
This button allows you to set the values in the Edit Options portion of the dialog back to what they were when you opened the Raw Data File Settings dialog.

**Save As Default:**
Sets the default values for the Edit Options portion of the dialog. These values are used as the default settings when a new file is created. See the More on Default Settings heading at the end of the Settings section.

**Other Edit Options dialog**

Click the Other Options button to bring up the Other Edit Options Dialog box.
Current File:
Click on the name of the file in the file list for which you wish to review and/or specify the settings. You can also choose to view or edit the DEFAULT settings.

Default values for new record:
Checking the check box for the following items causes CGEditor to "remember" the most recently entered value in the respective field. Thus when you insert or add a record containing one of the checked items, it will be filled in with a "default" value.

Backsight ID
Horz. Angle
Vert. Angle
Foresight ID
Rod Height
Code
Description

Note: The previously used field values are not "remembered" and thus will not be used to fill in new records the next time you open the CGEditor.

Set Defaults:
This button sets the items in the Other Edit Options dialog to the current default values. See More on Default Settings at the end of the Settings section.

Restore Values:
This button allows you to set the values in the Other Edit Options dialog back to what they were when you opened the Raw Data File Settings dialog.

Save As Default:
Sets the default values for the items found in the Other Edit Options dialog. These values are used as the default settings when a new file is created. See More on Default Settings at the end of the Settings section.

Click OK to close the Other Edit Options dialog.

Click OK to close the Raw Data File Settings dialog.
More on Default Settings:

When the CGEditor is started from CGSurvey, many of the initial default settings may not be those you had specified in a previous session. This is because many of the default settings you previously specified were overridden by the current CG Settings specified in CGSurvey. However, you may yourself override the default settings for the current session only by changing any of the settings and clicking the Save As Default button. If you wish to change the "default" settings for future editing sessions, you must change the CG Settings in CGSurvey.

Settings overridden by the settings on the various tabs in the CAD C&G Options dialog:

- **File Information**: only Description Length is overridden by the settings in the CAD C&G Options dialog.
- **File Measurement Info**: ALL items are overridden by the settings in the CAD C&G Options dialog.
- **Edit Options**: ALL items are overridden by the settings in the CAD C&G Options dialog.
- **Other Edit Options**: NONE are overridden by the settings in the CAD C&G Options dialog.

Record Color

To set the color for a given record type click the Record Color menu item. Then, in the Record Color dialog, click on the record type and a color selection dialog will appear. Click on the color you want the that record type to have. If you click the Set Defaults button, the original program default colors are set. Click the OK button to save the color settings and close the dialog. Click the Cancel button to close the dialog without saving the changes.
Validate Records

If this menu item is checked, all the records in the file will be validated prior to saving the file. To change the Validate Record setting, just click the menu item. If an invalid record is encountered when saving a file with the Validate Records menu item checked, you are asked if you want to edit the invalid field, ignore the error or ignore all errors. If you decide to edit the offending field, the field will be highlighted and you can edit it and attempt to save again.

The Tools menu has several items that can be used to find and replace specific text in specific types of fields. It even allows you to apply simple mathematical functions to allow you to edit the data in a group of fields in a single step.

Goto (Ctrl + T):

Select this item to go to a certain row (or record) number. In the dialog box that comes up, type in the desired row number and click OK. The editor window will zoom to that record and set the current field to the first editable field in the record.
Find (Ctrl + f) menu item:

The Find dialog allows you to enter a value to find and set the detailed search criteria.

Find: Type in the string or number you are searching for in the edit box or pick a previous search string from the list.

Field is a: Choose what type of data is in the field you are looking for. Check appropriate checkbox for matching case and/or whole word.

Columns to search:
The default is to search All columns, but if you choose the Columns radio button, you can enter a comma separated list of column numbers. The column to the right of the TYPE column is column 1 and it is the first column in which you can search.

Search:
You can search By Rows or By Columns and you can choose to search Up or Down from the current field.

Once you have specified the parameters for the search, click the Find Next button to find the first instance of the search string. Continue to click the Find Next button to find the next instance of the string. To just find the next instance of a string and close the dialog box, you can click OK.

Find Next (F3) menu item: Finds to the next occurrence of the string previously specified in the Find dialog.

Find Prev (Shift + F3) menu item: Moves you to the previous occurrence of the string previously specified in the Find dialog.

Find Record Type menu item: Allows you to find the next record type of the type specified. The search starts at the current record. When you click this menu item, the Find Record Type dialog box is displayed. Choose the record type you wish to look for by picking from the list then specify the direction of search and click the Find Next button to find the record. Click Cancel when done.
Replace (<Ctrl> + r) menu item: When you click on this menu item, the Replace dialog appears.

The Replace dialog allows you to specify a Find: value and a Replace with: value. The other fields in the Replace dialog are the same as the Find dialog. You can view the Find: value one instance at a time by clicking the Find Next button, if you decide to replace a given value found just click the Replace button. Alternatively, you can allow the software to automatically replace all the instances of the Find: value encountered in the specified columns in the raw data file by clicking the Replace All button.

Note: Before clicking the Replace All button, be sure to specify whether you wish to replace matching fields in the highlighted Selection of fields/records or in all the fields in the Whole File.

Data On/Off (<Ctrl> + d) menu item:

Selecting this menu item inserts a Data On/Off record above the current record. Records between pairs of Data On/Off records are ignored when the traverse is reduced. This can be useful when trying to find problems in a traverse.

Change

The items in this submenu allow you to change specific types of fields in the raw data file.
Point ID (<Ctrl> + I) menu item: This menu item allows you to change point IDs for instrument points, backsight points, or foresight points. You can change individual points one at a time or you can make a global change. You can specify a value to find and a value to replace it with. The Change Point ID dialog has several sections that are similar to the Replace dialog.

Field is a: You must specify how you want to treat the point ID field. You can do this by clicking on the String or Number radio buttons.

Define: You must specify whether you wish to specify the replacement value by Value or Formula.

Note: The Values: (Input -> Output) section of the dialog changes its title to Formula: when you elect to Define by Formula. Also, the content of this portion of the dialog changes according to the field type (see Values: or Formula: section below).

Instr. Point, Backsight, and Foresight check boxes: Check the check boxes of the types of point IDs you wish to change.

Values: or Formula: section
When Define is set to by Value and Field is a is specified as either a String or a Number then the title of this section of the dialog becomes Values: (Input -> Output) (as shown in the dialog above). In this configuration the Change Point ID dialog functions like the Replace dialog except that it only searches the point ID fields specified.
Specify the value to search for in the edit box to the left of the "→" and the value to replace it with in the edit box to the right of the "→".

The Find Next, Replace and Replace All buttons act exactly the same as the Find Next, Replace and Replace All buttons in the Replace dialog.

When Define is set to Formula the title of this section of the dialog becomes Formula:

If Field is a is specified as a String, the dialog is as shown below:

In this configuration the formula acts to add a prefix and/or a suffix to the existing point ID (represented by [Old]). Enter the prefix in the edit box to the left of [Old] and the suffix in the edit box to the right of [Old]. If you do not wish to add a prefix or you do not wish to add a suffix, you may leave either the left or right hand edit boxes empty.

If Field is a is specified as a Number, the dialog is as shown below:

In this configuration the formula adds a specified number to a given point ID. Enter the positive or negative number in the edit box to the right of "[Old] +".

Chapter 18. CGSurvey Module
NOTE: When the Field is a is specified as a Number and a point ID containing non-numeric characters is encountered, it will be skipped and no change will be made to it.

**Change Height (<Ctrl> + h)**

Use this menu item to change the instrument height and/or rod height. Clicking this menu item brings up the **Change Height** dialog.

![Change Height dialog](image)

**Action section of dialog**

Use this section to determine how the height is to be changed when Define is set to Formula.

**Multiply/Divide:** Choose this if you wish to multiply or divide the height by a given number.

**Add/Subtract:** Choose this if you wish to add a specified number to the height or subtract a specified number from the height.

**Define section of dialog by Value:** If you choose by Value, this command becomes like the Replace command, except that it acts only on instrument heights and/or rod heights.

**Formula:** This allows you to specify a number to apply to the height by addition, subtraction, multiplication, or division. (See the Action and Values:/Formula: sections.)

**Values:/Formula: section of dialog**

Depending on what you choose in the Action and Define sections there are several possibilities for this section of the dialog:
When **Define** is set to **by Value** the **Action** section of dialog is disabled and the title of this section becomes **Values: (Input->Output)**

In this configuration the feature functions like the **Replace** command, except that it acts only on instrument heights and/or rod heights.

When **Define** is set to **Formula**, the **Action** section of dialog is enabled and the title of this section becomes **Formula**;

When the **Action** is set to **Multiply/Divide**, the **Formula** section changes as seen below:

In this configuration you can multiply or divide the instrument height or rod height by the number specified in the edit box. To switch between multiply and divide, just click on the button with the multiply ("*") or divide ("/"") symbol on it.

When **Action** is set to **Add/Subtract**, the **Formula** section changes as seen below:
In this configuration you can add or subtract the number specified in the edit box to or from the instrument height or rod height. To switch between add and subtract, just click on the button with the add ("+") or subtract ("-") symbol on it.

**Search section of the dialog**

Use this section of the dialog to specify how the records will be searched. The search begins at the currently active field.

**Instrum.** and **Rod** checkboxes: Check one or both of these check boxes to specify which types of heights are to be searched/changed.

**Find Next** button: Use this button to move to the next field that matches the specifications you entered.

**Replace** button: Use this button to replace the highlighted text that was found.

**Change All button:** Use this button to make the changes specified to all matching fields in the file. Be sure to specify whether to apply the changes to the highlighted **Selection** (records or fields) or to the **Whole file**.

**Cancel button:** Click the Cancel button to close the dialog.

**Change Angle** (<Ctrl> + g)

Choose this menu item to change vertical and/or horizontal angle fields. Clicking the **Change Angle** menu item brings up the **Change Angle** dialog: This dialog is almost identical to the **Change Height** dialog and will not be described in detail. The differences are: the **Multiply/Divide** action seen in the **Change Height** dialog is replaced by the **Make Opposite** action; you can check either the Vertical or Horizontal check boxes to specify the angles you wish to change; choosing **Formula** and **Make Opposite** disables the **Formula:** section of the dialog due to the fact that the action to be taken is merely to reverse the sign of the angle.

**Change Distance** (<Ctrl> + D)

The **Change Distance** dialog is almost identical to the **Change Height** dialog. The only difference is that you can choose to change the **Slope** distance and/or the **Horizontal** distance by checking the checkboxes.

**Change DescLen** (<Ctrl> + j)

This command allows you to set the description length for the current raw data file. It displays the **Longest description length:** that is found in the current records in the file. It allows you to specify a new **Description length:**.

**Warning:** If you specify a length less than the longest description found in the file, the descriptions that exceed that length will be truncated.
Network Least Sq. menu item

This menu item runs the SurvNET Network Least Squares Adjustment program. Please refer to the section on SurvNET for a detailed description of this very powerful traverse and level loop adjustment program.

Window menu

This menu contains many of the standard Window menu items found in other programs. It allows you to arrange the currently open windows in several configurations. It has the added functionality of the New Window command which allows you to have two or more views of a single file.

Help

For information regarding the CGEditor program version click the About CGEditor... menu item.

Editing C&G Mapcheck Files

Mapcheck files are typically used to check the closure of a given parcel of land given the deed description of that parcel. A mapcheck file may contain straight line boundaries as well as boundaries described by both tangent and non-tangent curves.

Creating or Opening a Mapcheck File

To create a new file or open an existing file choose File on the main menu then either click New or Open. If you choose New a submenu will appear, click the C&G Mapcheck File menu item. In either case you will then see a file dialog. Browse to the directory where you wish to work and, if creating a new file, type in a file name, or, if opening an existing file, click on a mapcheck file (*.cgm). Next, click the Save button for a new file or the Open button for an existing file.

If you are creating a new file, an empty file will be shown in its own document window within the editor. If you are editing an existing file, the data from the file will appear in a similar document window. It is possible to have multiple documents open at the same time. So you could create a new file and open an existing file in the same
editing session and each would appear in its own window in the editor. You can have as many new and/or existing files open as your project demands. You may also cut, copy and/or paste between files.

Settings: Before entering any data you should check the current settings. Click the Settings menu item then click Map Check File to review and/or change the current settings. (For more details, see the Settings Menu section of Editing C&G Mapcheck Files.)

Mapcheck Data Entry

Opening an existing template file or creating a new one is very similar to opening or creating a raw traverse data file. There are three types of records that you may use in a mapcheck file:

Straight line (identified as Line in the Type column)

Tangent Curve (identified as TC in the Type column)

Non-tangent Curve (identified as NTC-C or NTC-R in the Type column for Chord or Radius definition NTC records)

Adding and Inserting new records

To create a new record in the current file you must either use the Add or Insert menu item or the Add or Insert toolbar.

Note: If the Add and/or Insert toolbars are not showing, click the View menu then choose the menu item for the toolbar you want to turn show.

When you click on one of the Add menu items or toolbar icons, an empty record is added to the end of the file. If you click on one of the Insert menu items or toolbar icons, an empty record is inserted above the currently active record or field. To make a record the currently active record, just click on one of its fields.

Moving from field to field: While entering data, to move to the next field, press the Enter or Tab key. To move to the preceding field press the Esc key or the Shift and Tab keys at the same time.

Straight Lines

There are two fields to be filled out in a Straight Line (or Line) record:

Bearing or Azimuth: For a bearing, use the standard C&G bearing notation:

For Bearing: Qdd.mmsss
Where
q = quadrant (1 = NE, 2 = SE, 3 = SW, 4 = NW)
d = 2 digit bearing
m = minutes
s = seconds and tenths of seconds

For example: enter S 35° 22' 34.2'' E as 235.22342

For Azimuth, use the notation: ddd.mmsss

Distance: Enter the length of the boundary in whatever units you have specified in the Map Check File Settings.
Code: Enter a code (optional).

Note: If Code Off is checked in the Map Check File Settings dialog, this field will not be active. However, clicking on the Code column title will turn it on.

Description: Enter a description (optional).

Note: If Description Off is checked in the Map Check File Settings dialog, this field will not be active. However, clicking on the Description column title will turn it on.

If Translate Mapcheck Descriptions Using a Description Table is checked in the Map Check File Settings dialog and you have entered an integer number description, then when you move to the next field, the description table will be searched for a description number matching the integer entered. If a matching description number is found, the description from the table will be placed in the Description field and the integer originally entered in the Description field will be placed in the Code field.

Tangent Curves

For a Tangent Curve record there are six possible fields to enter. Of the following six fields you must enter data for two of the first four:

Radius - decimal distance
Arc Length - decimal distance
Chord - decimal distance
Central Angle - angle specified as ddd.mmss (degrees.minutes and seconds to nearest .1 sec.)
Code (optional - see Straight Lines above)
Description (optional - see Straight Lines above)

Non-Tangent Curves

The fields in a Non-Tangent Curve record vary according to whether it is defined using the chord bearing/azimuth or radius bearing/azimuth.

When using Non-Tangent Curve record it is necessary to specify whether the chord or radius definition will be used when specifying the curve. There are four ways to accomplish this:

1. Prior to Inserting or Adding the record, use the Settings menu then choose Map Check File. In the Map Check File Settings dialog set the Curve Definition in the File Measurement Info section of the dialog.
2. Prior to Inserting or Adding the record, use the Settings menu to check or uncheck the Non-Tan Curves Use Chord menu item. When the Non-Tan Curves Use Chord menu item is checked, newly created Non-Tangent Curve records will added or inserted that use the chord definition, otherwise they will use the radius definition.
3. Prior to Inserting or Adding the record, click the C-R toolbar icon. When the icon appears depressed, newly created Non-Tangent Curve records will use the chord definition, otherwise they will use the radius definition.
4. To change the type of curve definition for an existing Non-Tangent Curve record, use the Edit main menu and choose the Change Curve Def'n menu item. This changes the current record from what it is now to the opposite type of curve definition.

For both the Chord and Radius definitions the following fields are present in the record:
Chord or Radius Brg/Azimuth
used to orient the curve properly as it leaves the PC. As noted in the **Tangent Curves** section, bearings must be entered in the qdd.mmsss format and azimuths entered in the ddd.mmsss format. **Radius**

<table>
<thead>
<tr>
<th>Arc Length</th>
<th>Chord</th>
<th>Central Ang</th>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
</table>

All but the first field has been discussed earlier in the **Tangent Curves** section and will not be described here.

### Editing a Mapcheck File

Most of the menu items found in the mapcheck menus have been discussed in the **Editing Traverse Raw Data Files** section. Only the differences will be discussed here.

**File Menu:** The **File** menu when editing a mapcheck file is identical to the **File** menu discussed in the **Editing Traverse Raw Data Files** section.

**Edit Menu:** With the exception of the **Change Curve Def'n** menu item, the **Edit** menu is identical to the **Edit** menu discussed in the **Editing Traverse Raw Data Files** section. **Change Curve Def'n** was discussed above in the **Non-Tangent Curves** section.

**Add Menu:** The **Add** menu allows you to add **Straight line**, **Tangent Curve** and **Non-Tangent Curve** records to the end of the file.

**Insert Menu:** The **Insert** menu allows you to insert **Straight line**, **Tangent Curve** and **Non-Tangent Curve** records above the current record.

**View Menu:** Allows you to turn the toolbars on and off.

### Settings Menu

The **Settings** menu contains items that allow you to specify the format of the data in a mapcheck file and how this data will appear in the **CGEditor**.

**Map Check File settings menu item**

The **Map Check File** menu item brings up the **Map Check File Settings** dialog (see below). This dialog allows you to specify settings for each of the mapcheck files currently open in the editor. It also allows you to specify the default settings for creating new map check files.
Current File: Use this list to choose a file you wish to set or view the settings for. You may also set or view the DEFAULT settings that are used for newly created files.

File Information and Edit Options:
The settings in the File Information and Edit Options sections have been discussed under the Settings Menu section of Editing a Raw Data File.

File Measurement Info:
Most of the settings in the File Measurement Info section have been discussed under the Settings Menu section of Editing a Raw Data File. However, a Curve Definition: item has been added to this section for mapcheck files:
Curve Definition: click the Curve Definition button to change from Chord to Radius definitions and vice versa. Curve Definition only applies to the insertion or addition of Non-Tangent Curve records.

Record Color menu item

The Record Color menu item has been discussed under the Settings Menu section of Editing Traverse Raw Data Files. The only difference is that here you are setting the colors for the various types of mapcheck records instead of raw data records.

Validate Records

This menu item allows you to set whether records are validated prior to being saved. (See also, Validate Records in the Settings Menu section of Editing Traverse Raw Data Files.)

Non-Tan Curves Use Chord: Use this to switch which types of Non-Tangent Curve records are added or inserted.
Tools, Window and Help Menus the items in these menus have been discussed in the Editing Traverse Raw Data Files section

C&G Cross Section Files

Cross section files contain data which defines one or more topographic or design cross sections along an alignment. Any features using a cross section file assume that it is at right angles to the alignment. Each cross section is identified by its station along the alignment. Each cross section is defined by a Station record specifying a station on the alignment followed by a series of Point records specifying the offset and elevation of points on the cross section at that station. Cross sections can be used to visualize a site, specify design elevations and calculate volumes. Opening an existing cross section file or creating a new one is very similar to opening or creating a map check file.

Cross Section File Data Entry

Station Records: There are three fields to be filled out in a Station record:
Station: Specifies the station of this cross section along the alignment. For example: station 6+45.37 is indicated as 645.37.
Left Slope: This field defines the slope at the left side of the cross section in feet per foot (or meters per meter if units are set to meters). This slope will be used to extend this cross section to meet any cross section it overlays.
Right Slope: This field defines the slope at the right side of the cross section in feet/foot (meters/meter). This slope will be used to extend this cross section to meet any cross section it overlays.

Point Records

There are two fields in a Point record:
Offset: The Offset defines the perpendicular distance from the alignment to this point on the cross section.
Elevation: The Elevation specifies the elevation of this point on the cross section.

Cross Section File Data Editing

Adding and Inserting new records: To create a new record in the current file you must either use the Add or Insert menu or toolbars.

Note: If the toolbars are not showing, click on the View menu then click the item for the toolbar you want to turn on.

Settings Menu item

Record Color:
The Record Color menu item has been discussed under the Settings Menu section of Editing Traverse Raw Data Files. The only difference is that here you are setting the colors for the various types of cross section records instead of raw data records.

Validate Records: This menu item has been described in the Settings Menu section of Editing Traverse Raw Data Files.
US Foot: If this menu item is checked units are US feet. If the Meters menu item is checked, this menu item is disabled.

International foot: If this menu item is checked units are International feet. If the Meters menu item is checked, this menu item is disabled.

Feet: If this menu item is checked units are Feet.

Meters: If this menu item is checked units are meters.

Note: The settings for US Foot and International foot will be ignored if Meters is checked.

C&G Template Files

Template files contain data defining standard cross section templates that can be used to create a cross section file that represents the design cross sections for a proposed alignment. Cross section files created using templates can be overlaid on existing cross sections to allow the computation of cut and fill volumes and to visualize the design alignment. Opening an existing template file or creating a new one is very similar to opening or creating a map check file.

Entering and Editing Template Data

Entering and editing template data is analogous to that described in Entering and Editing Cross Section Data except that, instead of being identified by their station along the alignment, templates are identified by an integer template identifier. This identifier is used when building a cross section from templates in order to specify a template among the many that a template file may contain. Templates are placed along a proposed alignment at various stations and thus create a series of cross sections using the alignment elevation to set the elevation of the template points. When building cross sections along an alignment using templates, cross sections at stations between two template stations result in a series of cross sections being created to transition between the templates.

Template File Data Entry

Template Records: There are five fields to be filled out in a Template record:

Template: Template number for identifying the template

Left Slope: Specifies the slope at the left side of the template in feet/foot (meters/meter). This slope will be used to extend this template generated cross section to meet any cross section it overlays. Right Slope: Enter the slope at the right side of the template in feet per foot (or meters per meter units are set to meters). This slope will be used to extend this template generated cross section to meet any cross section it overlays. Offset: The Offset defines the distance from the centerline of the template to this point on the cross section. The template centerline should be assigned a 0.0 offset. The 0.0 offset is placed on the alignment when cross sections are generated from templates.

Elevation: The Elevation specifies the elevation of this point on the template. If the elevation of the centerline point is set to 0.0, then this elevation can be used to directly compute the elevation of the point based on the elevation of the alignment where the template is placed.
Editing a Template File:  All template menu items and editing procedures are identical to those described for cross sections.

Editing Coordinate Files

Coordinate files contain data on the Point IDs, Northings, Eastings, Elevations, Descriptions and, for C&G files, Codes for various points located in the field and points created by calculations and/or by hand data entry. The coordinate file may have points from a single job, portions of a single job or many jobs. The Point ID must be a unique identifier for a given point. Typically Point IDs are integer numbers but may also be any combination of letters and numbers depending on the format of the file.

The CGEditor can be used to edit six different types of coordinate files. All the supported coordinate file types have Point ID, Northing, Easting, Elevation, and Description fields. In all formats, any given point may have a blank Description field. The types of files supported and a brief description of their differences follows:

C&G Numeric (*.crd)
Point ID: any integer number between 1 and 65,536.
Description: The maximum description length for a given file can vary between 1 and 100 characters and is set when the file is created. A given point description entry may be blank.
Code: up to 4 characters long. Used to filter and sort points. The Code field may be blank.

C&G Alpha-numeric (*.cgc)
Point ID: up to 10 characters long and can contain any combination of alphabetic and numeric characters.
Description: The maximum description length for a given file can vary between 1 and 100 characters and is set when the file is created. A given point description entry may be blank.
Code: up to 4 characters long. Used to filter and sort points. The Code field may be blank.

Carlson Numeric (*.crd)
Point ID: any positive integer number containing 1 to 9 digits.
Description: entries can be from 0 to 31 characters long.
(Code field is not supported.)

Carlson Alpha-numeric (*.crd)
Point ID: any a series of from 1 to 9 alphabetic or numeric characters.
Description: entries can be from 0 to 31 characters long.
(Code field is not supported.)

Simplicity (*.zak)
Point ID: can be any positive integer number containing 1 to 8 digits.
Description: entries can be from 0 to 28 characters long.
(Code field is not supported.)

Land Desktop (*.mdb)
Point ID: can be a series of from 1 to 255 alphabetic or numeric characters.
Description: entries can be from 0 to 255 characters long.
(Code field is not supported.)

Creating or Opening a Coordinate File
To create a new file or open an existing file choose File on the main menu then either click New or Open. If you choose New a submenu will appear, click the Coordinate File menu item or click on the “C” icon in the Standard toolbar. Next pick the type of coordinate file you wish to create using the Coordinate File Type dialog:

A new coordinate file with a temporary name will appear in its own document window in the CGEditor and will contain only a single blank coordinate Point record.

If you are opening an existing file using the Open menu item, you will be asked to choose the file using file dialog. Browse to the directory where you wish to work click on a coordinate file and click the Open button The coordinate records from the file will appear in a separate document window in the CGEditor.

It is possible to have multiple documents open at the same time. So you could create a new file and open an existing file in the same editing session and each would appear in its own window in the editor. You can have as many new and/or existing files open as your project demands. You may also cut, copy and/or paste between files.

Settings: Before entering any data you should check the current settings. Click the Settings menu item then click Coordinate File to review and/or change the current settings. (For more details, see the Settings Menu section of Editing Coordinate Files.)

Entering and Editing Coordinate File Data

Once a coordinate file has been opened or created, you can edit any of the fields in any of the records. To create a new coordinate point you must use the Add/Insert main menu or toolbar. Both the Add/Insert menu and toolbar allow you to add or insert individual blank records or one or more records from an existing coordinate file. When you add a record or records, they are appended to the end of the file. When you Insert one or more records they are inserted just above the current record.

Insert and Adding Coordinate Records from an Existing Coordinate File
If you choose to either the Add or Insert Pts from File or the corresponding toolbar item, you will see the C&G Select Points from: dialog.

This dialog consists of a list of the points choosen so far from the file listed in the Change File to Select From edit box. Use the File button to set the file name and the Open button to open the file for use. When the dialog first comes the point list is empty.

Choose Points section
Choose one of the available methods you will use for choosing points. Different methods will cause data entry controls to appear below the Choose Points section.

Note: Any time there are points in the list the REMOVE from SELECTION button will be enabled. Clicking this button will remove points from the list according to the current method being used to choose points.

All
If you choose all and not all of the points in the file are in the list, the ADD from FILE button will be enabled. Clicking the ADD from FILE button will add all the points from the file to the list.

Block
If you choose the Block method, the following Define Block section will appear below the Choose Points section of the dialog.
Fill in the **Starting Point ID** and **End Point ID** then click the ADD from FILE button.

**by Desc**

If you choose the **by Desc** method, the following **Specify Description** section will appear below the **Choose Points section** of the dialog.

Fill in the description to look for and check the **Match Case** and **Match Whole Work Only** checkboxes as needed. Next click the **ADD from FILE** button and any matching point records will be added to the list.

**by Code**

If you choose the **by Desc** method, the following **Specify Code** section will appear below the **Choose Points section** of the dialog. This section of the dialog looks and functions the same as the **Specify Description** section shown above except you must specify a code.

**by Elev**

If you choose the **by Desc** method, the following **Specify Elevation** section will appear below the **Choose Points section** of the dialog.
Specify the high and low elevation values. You can do this by directly entering the elevation values or you can type a point ID in the **Point ID** edit box then click on another edit box. When you do this the elevation of the point is written to the appropriate **Elevation** edit box. If you used a point ID to get the elevation, you can edit the value if necessary. Next click the **ADD from FILE** button to add the points to the list.

in Radius
in Rect

**Coordinate File Data Entry**

There is only one type of coordinate record called a **Point** record. This record has six fields:

- **Point ID**: Point identifier must be unique. Its format varies according to the type of coordinate file.
- **Northing**: Specifies the northing or Y coordinate of a point.
- **Easting**: Specifies the easting or X coordinate of a point.
- **Elev**: Specifies the elevation or Z coordinate of a point. (May be On or Off. To turn the column on click the column heading.)
- **Code (C&G coordinate files only)**: a 4 character optional field used to group points. May be blank. (May be On or Off. To turn the column on click the column heading.)
- **Description**: Text describing the point. May be blank. Length limited by type of coordinate file. (May be On or Off. To turn the column on click the column heading.)

After adding or inserting a **Point** record, fill in the various fields as needed. Use the Tab or Enter keys to move from one field to the next. If you press Enter when in the last activated field in a record, a new blank record will be created just below the current record and the current field will be set to the **Point ID** field in the new record.

To replace the data in an an existing record, just click once on the field you wish to replace and begin typing the new data. To edit the data in an an existing record, click twice on the field you wish to edit and make any edits required in the existing data.

**Settings Menu**

**Coordinate Files**

Choosing this menu item brings up the Coordinate File Settings dialog
Settings for
drop down list box allows you to specify settings for any coordinate file currently open in the CGEditor as well as choose to set the Default settings for new files you create.

Type of File is only visible for the files currently open.

Description Length:
this edit box can be used to set a new description length for the file. If you choose to change the description length, any descriptions that already exist in the file will be truncated to the new length.

Translate Coordinate Descriptions Using Description Table checkbox
if this is checked then the description table file name edit box and the Browse... button will be enabled and you will be required to specify a description table to use.

Description ON checkbox - if this is checked then the Description column will be activated in the editor.

Point Code ON checkbox - if this is checked then the Code column will be activated in the editor. (Only applies to C&G coordinate files)

Elevation ON checkbox - if this is checked then the Elevation column will be activated in the editor.

Units: click the button to switch between Foot and Meter.

Foot Definition: click the button to switch between US and International feet. (Disabled if Units are set
Coordinate Display section

Places displayed: drop down list - use to specify the number of decimal places displayed in the editor for northing, easting and elevation.

Note: the Places displayed setting does not effect the values actually stored in the coordinate file, only how they are displayed in the editor window.

Coordinate Order: click button to switch between North-East and East-North.

Printing: Page Orientation section

choose Portrait or Landscape. You may wish to choose Landscape to avoid having the coordinate records with long descriptions causing each page to span 2 pages in width.

The Set Defaults, Restore Values and Save As Default have been covered elsewhere.

US Foot menu item

If this menu item is checked units are US feet. If the Meters menu item is checked, this menu item is disabled. The check will also be set or cleared by changes in the Coordinate File Settings dialog.

International foot menu item

If this menu item is checked units are International feet. If the Meters menu item is checked, this menu item is disabled. The check will also be set or cleared by changes in the Coordinate File Settings dialog.

Feet menu item: If this menu item is checked units are Feet. The check will also be set or cleared by changes in the Coordinate File Settings dialog.

Meters menu item: If this menu item is checked units are meters. The check will also be set or cleared by changes in the Coordinate File Settings dialog. Note: The settings for US Foot and International foot will be ignored if Meters is checked.

Tools Menu

With the exception of Renumber Points, the items on the Tools menu are similar to those items already described for other file types.

Renumber Points menu item

When you choose the Renumber Points menu item you will receive a warning regarding the problems that may be encountered in existing C&G drawings.
After considering the problems you may encounter due to point renumbering respond Yes or Yes-Don't Ask Again to continue with the renumbering operation, or No to cancel the operation.

If you choose to continue with the renumbering of points, you will see the Renumber Points dialog:

**Renumber Points** dialog

**Points to ReNumber section**
First choose All or Enter Points.
If you choose Enter Points you must fill in the edit box specifying the points to renumber. The points to renumber can consist of single points or range(s) of points. Multiple entries of ranges and/or single points must be separated from the next entry by a comma (","), and ranges must be specified using a dash ("-")

**Renumbering Method section**
choose Add or Multiply then enter the Amount to Add: or Multiply by: in the edit box. You may specify a positive or negative whole number.

When done click OK. Click Cancel to end the command without changes to the coordinate file being edited.
A C&G point group is essentially a list of points placed in a specially formatted text file (*.pts). It is possible to create and/or edit point group files using any plain text editor like Microsoft Notepad or Wordpad if you know the format of the file. Typically it is far easier to use the CGEditor to create and/or edit C&G point group files. Point groups have many uses in C&G commands: road alignments, property boundaries, define Include and Exclude Boundaries for Topo commands, etc. In the case of alignments, a point group can also include vertical curve information.

C&G point group files are organized into named subgroups. The subgroup name can be anything you wish to use to identify the points that follow. You may have several subgroups in a single point group file. For example, if you are defining subdivision lots, then you may choose the subgroup names to be lot 1, lot 2, etc. For an alignment you can make the subgroup name the starting station and C&G features will make this the default starting station when asking you for an alignment. Point groups can also be used to.

Creating and Opening Point Group Files

You may open and/or create as many files as are needed for your project.

To create a new empty point group file choose the File menu then the New menu item then the Point Group File menu item or, more simply, just click the "P" toolbar icon on the Standard toolbar. In either case, a document window will appear within the main CGEditor window. This will have a single blank record or row for the Subgroup name - identified by SGR in the Type column.

To open an existing point group file, choose File then Open... Then, in the file dialog, browse to the directory where your point group file is located, highlight the desired file and click the Open button. The records will be read from the file and will be displayed in a separate document window.

Entering and Editing Point Group File Data

If you do not have a subgroup name record, choose the Add/Insert main menu then, if you wish to place it at the end of the file, choose the Add Subgroup menu item or, if you wish to insert it above the current record, choose the Insert Subgroup menu item. After filling in the subgroup name, you can just press Enter to add a single Point record (identified by PNT in the Type column) below the subgroup name record. Alternatively, you can use the Add/Insert menu to add or insert a single point or you can choose to add or insert several points from a coordinate file. These same add and insert methods can be found on the Add/Insert Toolbar.

If you choose to Add or Insert Pts from File the following dialog comes up:
The use of this dialog to choose points has been described in detail under the section on Editing Coordinate Files. Please refer to that section for more details. After choosing the points you wish to add or insert into the point group using the C&G Select Points from ... dialog, click OK and the point records will be created in the point group file being edited.

**Horizontal Curves**

You may have noticed that the Rad Pt Type column is marked with `<None>` for the points you have inserted so far. However, if you wish to specify a curve in your alignment or lot boundary, you must designate the record as a radius point. If you click on the Cw toolbar icon (for clockwise) or the Cc toolbar icon (for counter clockwise) or choose similar items on the Tools menu, you will notice that the Rad Pt Type column for the point changes to CW or CCW to indicate that the point is a radius point. If a radius point is specified, the preceding point is assumed to be the PC and the following point is assumed to be the PT. If you wish to change the point back to not being a radius point, click the Not Radius Pt toolbar icon or use the Tools menu.

**Vertical Curves**

You may enter vertical curve information in a point group file. This allows you to not only specify the horizontal location of the alignment, but also its vertical alignment. A point group file that has vertical curves in it may not contain any subgroup records. If you attempt to place vertical curve data in a file having one or more subgroups, you will be given the following warning:
As indicated by the choices in the dialog, you may continue and place vertical curve info in a point group file containing subgroups, but it will not be usable in C&G commands.

If you have no subgroups (or if you do and answer "Yes" to the warning) and this is the first vertical curve in the file, the Enter Vertical Curve Information dialog will come up.

![Enter Vertical Curve Information dialog](image)

Enter the information in the dialog to specify the vertical curve. The Starting Station and the PVI Station should be entered as decimal numbers and when you click in another edit box the decimal station will be converted to standard station notation. The Slope in and the Slope out should be entered as a percent (For example, enter 2 or 2.0 for 2%). When you click OK the vertical curve records VC1 and VC are added in the document window.

For the second and succeeding vertical curves, you can either Add Vertical Curves to the end of the vertical curve records or you can Insert Vertical Curves within the existing vertical curve records. For these vertical curve records, the dialog requires fewer entries:
This is a result of the fact that the initial vertical curve **Starting Station**, **Initial PVI Elevation** and **Slope in** control the overall vertical orientation of the succeeding vertical curves thus you need only enter the **PVI Station**, **Length** and **Slope out** for these vertical curves. When you click **OK**, another vertical curve record will be added to or inserted into the document.

Once the vertical curve information has been specified you can go ahead and enter the points specifying the alignment.

**Settings Menu**

The Settings menu allows you to configure the point group file and the record appearance.

Choose the **Point Group Settings** menu item to bring up the **Point Group Settings** dialog:

In this dialog you can set the units and the page orientation for printing.
Note: the units setting only effects the display of stations in station notation.

Choose the Record Color menu item to bring up the Record Color dialog. Set the display color of the various records by clicking on the line for the record type. This brings up a color dialog that allows you to pick from the 16 available colors. Click OK when done.

Tools Menu

The items in the Tools menu are, for the most part, self explanatory or have been covered in detail for other types of files.

Pulldown Menu Location: CG-Survey>Tools>CGEditor
Keyboard Command: eda, cg_edit_all
Prerequisite: May need existing C&G raw traverse data file (*.cgr), C&G Map Check file (*.cgm), C&G Cross Section file (*.cew), C&G Template file (*.ctp), coordinate files (*.crd, *.cgc, *.zak, *.mdb) and/or C&G Point Group files (*.pts)
Introduction

- SurvNet reduces survey field measurements to grid coordinates in assumed, UTM, SPC83 SPC27, and a variety of other coordinate systems. In the 2D/1D model, a grid factor is computed for each individual line during the reduction. The elevation factor is computed for each individual line if there is sufficient elevation data. If the raw data has only 2D data, the user has the option of defining a project elevation to be used to compute the elevation factor.

- SurvNet supports a variety of map projections and coordinate systems including the New Brunswick Survey Control coordinate system, UTM, and user defined systems consisting of either a predefined ellipsoid or a user defined ellipsoid and one of the following projections, Transverse Mercator, 1 Standard Parallel Lambert Conformal, 2 Standard Parallel Lambert Conformal, Oblique Mercator, and the Double Stereographic projection.

- A full statistical report containing the results of the least squares adjustment is produced and written to the report (.RPT) file. An error report (.ERR) file is created and contains any error messages that are generated during the adjustment.

- Coordinates can be stored in a Carlson (.CRD) file, C&G (.CRD) file, Simplicity file (.ZAK) or an LDD file. An ASCII coordinate (.NEZ) file is always created that can be imported into most any mapping/surveying/GIS program. The user has the option to compute unadjusted preliminary coordinates.

- There is an option to compute traverse closures during the preprocessing of the raw data. Closures can be computed for both GPS loops and total station traverses. Closure for multiple traverse loops in the same raw file can be computed.

- When processing Angle-Only records for triangulation, if there is a zenith angle and rod height (zero is a valid rod height), a 3D triangulation will be performed, calculating an elevation of the triangulation point. This is true in both the 3D and 2D/1D models.

- SurvNet can combine GPS vectors and total station data in a single adjustment. GPS Vector files from Leica, Thales, Topcon and Trimble can be input, as well as GPS files in the StarNet format. Additionally GPS vectors can be read from NGS G-files. There is also an option to read the G-file section of an Opus report.

- SurvNet includes a variety of blunder detection routines. One blunder detection method is effective in detecting if the same point number has been used for two different points. Additionally this blunder detection method is effective in detecting if two different point numbers have been used for the same physical position. This method also flags other raw data problems. Another blunder detection method included in SurvNet is effective in isolating a single blunder, distance or angle in a network. This method does not require that there be a lot of redundancy, but is effective if there is only one blunder in the data set. Additionally, SurvNet includes a blunder detection method that can isolate multiple blunders, distances or angles in a network. This method does require that there be a lot of redundancy in the network to effectively isolate the multiple blunders.

- Other key features include: Differential and Trig level networks and loops can be adjusted using the network least squares program. Geoid modeling is used in SurvNet, allowing the users to choose between the Geoid99 and the Geoid03 model. The user can alternately enter the project geoid separation. There are description codes to identify duplicate points with different point numbers. The user can specify the confidence interval from 50 to 99 percent.

SurvNet performs a least squares adjustment and statistical analysis of a network of raw survey field data, including total station measurements, differential level data and GPS vectors. SurvNet simultaneously adjusts a network of interconnected traverses with any amount of redundancy. The raw data can contain any combination of angle and distance measurements, and GPS vectors. SurvNet can adjust any combination of trilaterations, traverses,
triangulations, networks and resections. The raw data does not need to be in a linear format, and individual traverses do not have to be defined using any special codes. **All measurements are used in the adjustment.**

**General Rules for Collecting Data for Use in Least Squares Adjustments**

Least squares is very flexible in terms of how the survey data needs to be collected. Generally speaking, any combination of angles, and distances combined with a minimal amount of control points and azimuths are needed. This data can be collected in any order. There needs to be at least some redundancy in the measurements. Redundant measurements are measurements that are in excess of the minimum number of measurements needed to determine the unknown coordinates. Redundancy can be created by including multiple GPS and other control points within a network or traverse. Measuring angles and distances to points in the network that have been located from another point in the survey creates redundancy. Running additional cut-off traverses or additional traverses to existing control points creates redundancy. Following are some general rules and tips in collecting data for least squares reduction.

- **Backsights should be to point numbers.** Some data collectors allow the user to backsight an azimuth not associated with a point number. SurvNet requires that all backsights be associated with a point number.
- **There has to be at least a minimum amount of control.** There has to be at least one control point. Additionally there needs to be either one additional control point or a reference azimuth. Control points can be entered in either the raw data file or there can be a supplemental control point file containing the control point. Reference azimuths are entered in the raw data file. The control points and reference azimuths do not need to be for the first points in the raw file. The control points and azimuths can be associated with any point in the network or traverse. The control does not need to be adjacent to each other. It is permissible, though unusual, to have one control point on one side of the project and a reference azimuth on the other side of the project.
- **Some data collectors do not allow the surveyor to shoot the same point twice using the same point number.** SurvNet requires that all measurements to the same point use a single point number. The raw data may need to be edited after it has been downloaded to the office computer to insure that points are numbered correctly. An alternative to renumbering the points in the raw data file is to use the 'Pt Number substitution string' feature in the project 'Settings' screen. See the 'Redundant Measurement' section for more details on this feature.
- **The majority of all problems in processing raw data are related to point numbering problems.** Using the same point number twice to different points, not using the same point number when shooting the same point, misnumbering backsights or foresights, and misnumbering control points are all common problems.
- **A big source of problems with new users is a misunderstanding in defining their control for a project.** It is always best to explicitly define the control for the project. A good method is to put all the control for a project into a separate raw file.
- **Some raw data collector files may have preliminary unadjusted coordinates included with the raw data.** These coordinate records should be removed from the raw file. The only coordinate values that should be in the raw file are the control points. Since there is no concept of 'starting coordinates' in least squares there is no way for SurvNet to determine which points are considered control and which points are preliminary unadjusted points. So all coordinates found in a raw data file will be considered control points.
- **When a large project is not processing correctly, it is often useful to divide the project into several raw data files and debug and process each file separately as it is easier to debug small projects.** Once the smaller projects are processing separately they can be combined for a final combined adjustment.

SurvNet gives the user the option to choose one of two mathematical model options when adjusting raw data, the 3D model and the 2D/1D model.

In the process of developing SurvNet numerous projects have been adjusted using both the 2D/1D model and the 3D model. There are slight differences in final adjusted coordinates when comparing the results from the same network using the two models. But in all cases the differences in the results are typically less than the accuracy of
measurements used in the project. The main difference in terms of collecting raw data for the two different models is that the 3D model requires that rod heights and instrument heights need to be measured, and there needs to be sufficient elevation control to compute elevations for ALL points in the survey. When collecting data for the 2D/1D model the field crews do not need to collect rod heights and instrument heights.

In the 2D/1D model raw distance measurements are first reduced to horizontal distances and then optionally to grid distances. Then a two dimensional horizontal least squares adjustment is performed on these reduced horizontal distance measurements and horizontal angles. After the horizontal adjustment is performed an optional one-dimensional vertical least squares adjustment is performed in order to adjust the elevations if there is sufficient data to compute elevations. The 2D/1D model is the model that has been traditionally been used in the past by non-geodetic surveyors in the reduction of field data. There are several advantages of SurvNet's implementation of the 2D/1D model. One advantage is that an assumed coordinate system can be used. It is not necessary to know geodetic positions for control points. Another advantage is that 3D raw data is not required. It is not necessary to record rod heights and heights of instruments. The 2D/1D model allows you to mix 2D and 3D measurements. Elevations are not required for the control points. The primary disadvantage of SurvNet's implementation of the 2D/1D model is that GPS vector data cannot be used in 2D/1D projects.

In the 3D model raw data is not reduced to a horizontal plane prior to the least squares adjustment. The 3 dimensional data is adjusted in a single least squares process. In SurvNet's implementation of the 3D model XYZ geodetic positions are required for control. The raw data must contain full 3D data including rod heights and measured heights of instrument. The user must designate a supported geodetic coordinate system. The main advantage of using the 3D model is that GPS vectors can be incorporated into the adjustment. Another advantage of the 3D model is the ability to compute and adjust 3D points that only have horizontal and vertical angles measured to the point. This feature can be used in the collection of points where a prism cannot be used, such as a power line survey.

When using the 2D/1D model if you have 'Vertical Adjustment turned' ON in the project settings, elevations will be calculated and adjusted only if there is enough information in the raw data file to do so. Least squares adjustment is used for elevation adjustment as well as the horizontal adjustment. To compute an elevation for the point the instrument record must have a HI, and the foresight record must have a rod height, slope distance and vertical angle. If working with .CGR raw data a 0.0 (zero) HI or rod height is valid. It is only when the field is blank that the record will be considered a 2D measurement. Carlson SurvCE 2.0 or higher allows you to mix 2D and 3D data by checking or unchecking the 3D MODE checkbox in the Configuration dialog (General Tab). A comment record "–Elevation: 3D" or "–Elevation: 2D" will be inserted into the .RW5 file and SurvNET will pay attention to those records. A 3D traverse must also have adequate elevation control in order to process the elevations. Elevation control can be obtained from the supplemental control file, coordinate records in the raw data file, or elevation records in the raw data file.

SurvNet can also automatically reduce field measurements to state plane coordinates in either the NAD 83 or NAD 27 or other supported geodetic coordinate systems. In the 2D/1D model a grid factor is computed for each individual line during the reduction. The elevation factor is computed for each individual line if there is sufficient elevation data. If the raw data has only 2D data, the user has the option of defining a project elevation to be used to compute the elevation factor.

A full statistical report containing the results of the least squares adjustment is produced and written to the report (.RPT) file. An error report (.ERR) file is created and contains any error messages that are generated during the adjustment. Coordinates can be stored in the following formats:
- C&G numeric (*.crd)
- C&G alphanumeric (*.cgc)
- Carlson numeric (*.crd)
Carlson alphanumeric (*.crd)
Autodesk Land Desktop (*.mdb)
Simplicity (*.zak)
ASCII P,N,E,Z,D,C (*.nez)

A file with the extension .OUT is always created and contains an ASCII formatted coordinate list of the final adjusted coordinates formatted suitable for printing. Additionally an ASCII file with an extension of .NEZ containing the final adjusted coordinates in a format suitable for input into 3rd party software that is capable of inputting an ASCII coordinate file.

SurvNet produces a wealth of statistical information that allows an effective way to evaluate the quality of survey measurements. In addition to the least squares statistical information there is an option to compute traverse closures during the preprocessing of the raw data. Traverse closures can be computed for both GPS loops and total station traverses. This option has no effect on the computation of final least squares adjusted coordinates. This option is useful for surveyors who due to statutory requirements are still required to compute traverse closures and for those surveyors who still like to view traverse closures prior to the least squares adjustment.

Starting Survnet

Using SurvNET Standalone

Double click on the SurvNET icon on the desktop or use the Start menu > Programs (or All Programs) > SurvNET

Using Carlson 2010:

Entry into the SurvNet program is easy. It can be accessed in two different ways. The easiest way to start the program is to select SurvNet from the Survey menu. The other method is to start SurvNet from within the Raw Data File editor. To bring up the Raw Data File editor select Edit-Process Raw Data File from the Survey menu (see below).
To access SurvNET from within the Carlson Raw Data Editor choose the **Process (Compute Pts)** menu then the **SurvNET** menu item (see below).

Using the Carlson Expanded CG Survey Menu or the CGSurvey Standalone Menu:

In Carlson, with the **Survey Settings - CG Survey Menu** set to **Expanded** or in CGSurvey, choose the **CGTrav** menu then the **SurvNET (Network Least Squares)** menu item.

**Note:** When you use the **Compact CG Survey Menu** option, the **CG-Survey** main menu does not allow access to SurvNET. You must use the **Survey** main menu as described above to do this.
or use the CGTools menu and the SurvNET menu item, then pick SurvNET Network Least Squares (see below)

The SurvNet Start-up Dialog

The SurvNet Start-up dialog is displayed when SurvNet is first started (see below). SurvNet is a project based program. Before performing a least squares adjustment an existing project must be opened or a new project created. This opening dialog box allows the user to open or create a project on start-up. You also can create or open a project from the Files menu. Since all project management functions can be performed from the Files menu you need not use the start-up dialog except as a convenience. If you do not wish to see the Start-up dialog when you
start SurvNET, uncheck the **Show this dialog box on start-up** checkbox then click the **Cancel** button.

The following is a view of the SurvNet main window after an existing project has been opened.

---

**Menu System Overview**

The following graphic shows the main network least squares window. Least squares operations are initiated using the menus and toolbars found here.
File Menu

Selecting the File menu opens the following menu:

SurvNET projects

SurvNET is a project based system. Everything related to processing raw data must be specified in the project settings.

A Project (.PRJ) file is used to store all the settings and files necessary to reprocess the data making up the project. You can create a New project, or Open an existing project. It is necessary to have a project open in order to process the data.

The Save Project As Default can be used to create default project settings to be used when creating a new project. The current project settings are saved and will be used as the default settings when any new project is created. Project settings are covered in the Settings menu sections.

Some statutes and jurisdictions still require the computation of traditional traverse closures. SurvNet gives the surveyor the ability to compute the closures of multiple traverses within a project as part of the preprocessing of the project raw data. Closures for single or multiple traverses can be computed for a single project. Additionally, GPS closures can be computed for GPS loops. To compute closures you must first create a "Closure" file (.CLS). Closure files define the type of traverse loops that are to be computed and the point numbers that make up the traverse.

There are two options in the FILE menu that are used to create and edit the closure, .cls, files:

Open Traverse Closure File
New Traverse Closure File
After choosing the 'New Traverse Closure File' you will be prompted for a new file name. After choosing a file name the following dialog box is displayed.

First enter the point sequence which defines the traverse in the 'Ordered Traverse Point List' grid field. If you initiate the traverse closure input dialog from the FILE menu (as apposed to running it from the Settings Dialog), you will have the option to pick the points graphically.

Set the check boxes to set whether vertical closure and angle closures are to be computed. Then choose what type traverse is being entered.

Enter the points that define the traverse. If you check the "Allow graphic pt. pick" box, the graphic window will pop up. You can then pick the points graphically. The points will go into the list separated by commas.

If you manually enter the points, they can be entered in the form:

1,23,30-35,45,23,1
A comma separates the point numbers. You can select a range (30-35) when the points are sequential. You must start with the first backsight point number and end with the last foresight point number. For example, if you have a simple loop traverse with angle closure using points 1, 2, 3 and 4, it will be entered as "4,1,2,3,4,1" where 1 is the first occupied point and 4 is the initial backsight.

You can turn the "Angle Closure" ON or OFF. If the angle closure is ON, you will be shown the total angular error and error per angle point. If the final closing angle was not collected you can turn "Angle Closure" OFF and only the linear closure will be computed.

You can turn the "Vertical Closure" ON or OFF. If the vertical closure is ON, you will be shown the total vertical distance closure.

In order to calculate the traverse closure, you must select the TRAVERSE TYPE. It can be:

**Pt. to Pt. Trav.** - A point to point traverse is a traverse that starts at a set of known coordinates and ends at another known coordinate. This option assumes you start from two control points and tie into two control points if an angle closure is desired and one control point if only a linear closure is desired. The first backsight distance and last foresight distance if angle closure is ON are not used in computing the linear closure. Following is an example of a pt. to pt. traverse with angle closure.

100,101,2-5

In the above pt. to pt. list Pt 100 is the starting backsight point, Pt. 101 is the starting instrument point. Pt. 4 is the ending instrument point and the foresight to the angle closure point is point 5. If a closing angle was not collected the list would look as follows '100,101,2-4'.

**Loop Trav., Int. Az. Ref.** - A closed loop traverse that begins by backsighting the last interior point on the traverse. Following is an example.

7,101,2-7,101

In the above example closed loop with angle balance list, point 7 is the backsight point and point 101 is the first occupied point. If the closing angle 6-7-101 was not collected the list would be entered as follows '7,101,2-7'
**Loop Trav., Ext. Az. Ref.** - A closed loop traverse that begins by backsighting an exterior point (point not on the traverse).

100,101,2-7,101,100

In the above example loop with exterior reference and angle balance list, point 100 is the backsight point and point 101 is the first occupied point. If the closing angle 7-101-101 was not collected the list would be entered as follows '100,101,2-7,101'

**GPS Loop Closure:** - GPS loop closures can be computed using this option.

A,E,F,A

In the above example GPS loop, closure will be computed from the GPS loop going from A-E-F-A.

After the closure, .CLS, file has been created the preprocessing project settings need to be updated to include the closure file in the project. Following is a view of the settings screen that defines a closure file to be used in
preprocessing. Notice that the check box 'Compute Traverse Closure' is checked and a closure file has been entered in the edit box field. Notice that the 'Edit/Create' button can be used to edit an existing closure file or create a new closure file.

When the data is processed, the closure reports will appear in the RPT and ERR files. Traverse Closures will show the error of closure with and without angles balanced. Following is an example of a closed loop traverse report:

**Traverse Closures**

---

**Traverse points:**
103-118, 43-44

**Traverse starting and ending on different points;**

Compute angle closure.

Compute vertical closure.

<table>
<thead>
<tr>
<th>BS</th>
<th>IP</th>
<th>FS</th>
<th>Angle</th>
<th>FS H. Dist.</th>
<th>FS V. Dist.</th>
</tr>
</thead>
<tbody>
<tr>
<td>103</td>
<td>104</td>
<td>105</td>
<td>173-07'48.5''</td>
<td>310.4916</td>
<td>-7.7483</td>
</tr>
<tr>
<td>104</td>
<td>105</td>
<td>106</td>
<td>167-48'21.5''</td>
<td>253.4909</td>
<td>5.6306</td>
</tr>
<tr>
<td>105</td>
<td>106</td>
<td>107</td>
<td>200-52'46.0''</td>
<td>381.4896</td>
<td>8.4879</td>
</tr>
<tr>
<td>106</td>
<td>107</td>
<td>108</td>
<td>149-09'05.5''</td>
<td>410.5470</td>
<td>-16.6830</td>
</tr>
<tr>
<td>107</td>
<td>108</td>
<td>109</td>
<td>080-42'36.5''</td>
<td>245.5728</td>
<td>9.4221</td>
</tr>
<tr>
<td>108</td>
<td>109</td>
<td>110</td>
<td>174-21'17.5''</td>
<td>175.3846</td>
<td>-5.6971</td>
</tr>
<tr>
<td>109</td>
<td>110</td>
<td>111</td>
<td>201-42'21.5''</td>
<td>367.0014</td>
<td>-11.8161</td>
</tr>
<tr>
<td>110</td>
<td>111</td>
<td>112</td>
<td>171-52'54.5''</td>
<td>237.7806</td>
<td>7.5346</td>
</tr>
<tr>
<td>111</td>
<td>112</td>
<td>113</td>
<td>192-32'53.5''</td>
<td>368.8396</td>
<td>-7.0329</td>
</tr>
</tbody>
</table>
Correct Ending Coordinates, North: 1400952.0140 East: 2241884.7010
Ending Coordinates, North: 1400951.7962 East: 2241884.8180
Error, N: -0.2178 E: 0.1170 Total: 0.2472 Brg: N 28-14'34.6''W
Distance Traversed: 4882.4190 Closure: 1:19751
Correct Ending Elevation: 948.1710
Ending Elevation: 948.1221
Elevation Error: -0.0489

Closure After Angle Adjustment

103 104 105 173-07'48.3'' 310.4916 -7.7483
104 105 106 167-48'21.3'' 253.4909 5.6306
105 106 107 200-52'45.8'' 381.4896 8.4879
106 107 108 149-09'05.3'' 410.5470 -16.6830
107 108 109 080-42'36.3'' 245.5728 9.4221
108 109 110 174-21'17.3'' 175.3846 -5.6971
109 110 111 201-42'21.3'' 367.0014 -11.8161
110 111 112 171-52'54.3'' 237.7806 7.5346
111 112 113 192-32'53.3'' 368.8396 -7.0329
112 113 114 171-30'58.8'' 338.0024 -19.1945
113 114 115 184-54'03.5'' 344.5005 16.3157
114 115 116 149-20'19.5'' 353.8455 7.5562
115 116 117 202-19'01.5'' 390.1117 -9.9180
116 117 118 112-36'32.0'' 293.9931 2.0060
117 118 43 146-06'36.5'' 411.3674 -7.7112
118 43 44 270-04'01.5''

Chapter 19. SurvNET

Closing Az: S 47-39'47.8''W
Computed Closing Az: S 47-39'51.3''W
Total angular error: 000-00'03.5''
Angular error per point: 000-00'00.2''
Correct Ending Coordinates, North: 1400952.0140 East: 2241884.7010
Ending Coordinates, North: 1400951.7752 East: 2241884.8397
Error, N: -0.2388 E: 0.1387 Total: 0.2762 Brg: N 30°08'45.6"W
Distance Traversed: 4882.4190 Closure: 1:17679

Following is an example of a GPS loop closure report.

Traverse Closures
=================

GPS Loop Points:
A,E,F,A

GPS Loop Closure;
Misclosure, X:
-0.0323
Y:
-0.0162
Z:
-0.0105
Closure error:
0.0376
Perimeter: 20229.3858
Precision: 1:537594

GPS Loop Points:
C,F,D,B,C

GPS Loop Closure;
Misclosure, X:
-0.0121
Y:
-0.0101
Z:
0.0002
Closure error:
0.0158
Perimeter: 41332.9807
Precision: 1:2622216

GPS Loop Points:
F,D,B,F

GPS Loop Closure;
Misclosure, X:
-0.0022
Y:
-0.0044
Z:
0.0097
Closure error:
0.0109
Following is a view of the closure file that created the above GPS closure report. The 'Vert. Closure', and 'Angle Closure' toggles serve no purpose with GPS loop closures.

SurvNet provides the ability to generate reports that give the surveyor the information needed to determine if his survey is within ALTA positional tolerances. It is required that the user define which points are to be included in the ALTA testing. The points to be included for ALTA testing are defined in an .Alt file.

There are two options in the FILE menu that are used to create and edit the ALTA, .alt, files:

Open ALTA, Rel. Err. Ellipse File
New ALTA, Rel. Err. Ellipse File

After choosing the ALTA file to be created or edited the following dialog box is displayed.
The above dialog box allows the user to define the points to be included in the ALTA report processing. There are two sections in the .RPT file created through the ALTA reporting. The following report shows the sections of the ALTA report generated by the data in the dialog box. The first section of the report displays only the relative error ellipses between points. The point sequences used in this section come from the list on the right hand side of the above dialog box. The second section of the report performs an ALTA tolerance test and displays only those connections that fall outside of the ALTA tolerances (as set in the ADJUSTMENT tab of the SETTINGS dialog box). The program first checks the specific point sequences defined by the list on the right side of the dialog box. The program then checks all the connections between all the points listed on the left hand side of the dialog box.

When adding points to either section, you can choose the option to **Allow graphic pt. pick**. This option is only available if you run the ALTA dialog from the FILE menu (as apposed to from the Settings dialog). A graphic window will pop up and you can pick the points graphically that you want to include in the ALTA report.

There can be many connections to check if the point list on the left hand side of the dialog box has a lot of points. The user can limit the number of sequences to be displayed that fail the ALTA test by entering a number in the "Max. Connections to display" field.

Notice that you can enter points based on descriptions in the left hand list box. If you wished to check connections between all points with TP, EIP, MON descriptions, enter the descriptions in the edit field and press the 'Add' button. If TP, EIP, and MON represented traverse points, existing iron pipes and monuments then ALTA testing would be performed on those point types.

After you have created the .ALT point file you need to set a few project settings. These settings define the ALTA tolerances, specify the .ALT file to be used, and define the type of reporting to be generated. The 'Adjustment' tab sheet within the project 'Settings', has a relative error ellipse section where the ALTA report settings are located.

All the ALTA reporting settings reside within the Relative Error Ellipse box.

**Note:** You do not have to "Enable sideshots for relative error ellipses" to get an ALTA report on sideshots that are selected for the report. All points selected for the ALTA report will automatically be included in the computational process.
The 'Rel. Err. Points File:' check box must be checked, and an .ALT file must be chosen to get an ALTA report. The .ALT file defines which points will be included in the ALTA reporting. See the previous discussion on the creation of the .ALT file if you are unsure of how to create an .ALT file.

Check the 'Include ALTA tolerance report' check box to create the ALTA tolerance checking report section. If an .ALT file has been chosen then the relative error section of the report will always be generated.

Next make sure the appropriate tolerance and PPM has been defined. The ALTA standards define their positional standard as .07 plus 50 PPM. Additionally, the ALTA standards require that the computations be performed to a 95% confidence. The confidence interval is set in the 'Confidence Interval:' edit field.

After the project has been processed the ALTA/Relative Error portion of the report is displayed in the report window under its own tab.
The following is a sample ALTA report:

Relative Error and ALTA Tolerances
==================================

Alta Tolerance Report ,Specific Connections, 95% Confidence Interval

<table>
<thead>
<tr>
<th>Sta.</th>
<th>Sta.</th>
<th>Dist.</th>
<th>Semi Major</th>
<th>Actual</th>
<th>Allowable</th>
<th>Ratio</th>
<th>Semi Major</th>
<th>Actual/Allowable</th>
<th>Semi Minor</th>
<th>Max. Err. A</th>
</tr>
</thead>
<tbody>
<tr>
<td>27</td>
<td>500</td>
<td>204.5030</td>
<td>0.0783</td>
<td>0.0002</td>
<td>0.9830</td>
<td>0.0588</td>
<td>0.95-06'32 ''E</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>500</td>
<td>502</td>
<td>66.8572</td>
<td>0.1132</td>
<td>0.0733</td>
<td>1.5432</td>
<td>0.0842</td>
<td>S 86-05'S0-00''E</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>34</td>
<td>36</td>
<td>237.9748</td>
<td>0.3731</td>
<td>0.0819</td>
<td>0.8920</td>
<td>0.6731</td>
<td>S 00-00'00''E</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

Chapter 19. SurvNET
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>506</td>
<td>556</td>
<td>806.5402</td>
<td>1.0818</td>
<td>0.1103</td>
<td>9.8054</td>
<td>0.2586</td>
<td>S 86-37'40.4''E</td>
<td>S 86-37'40.4''E</td>
</tr>
<tr>
<td>507</td>
<td>556</td>
<td>827.2364</td>
<td>1.0832</td>
<td>0.1114</td>
<td>9.7268</td>
<td>0.2446</td>
<td>S 86-37'05.9''E</td>
<td>S 86-37'05.9''E</td>
</tr>
<tr>
<td>505</td>
<td>556</td>
<td>818.7994</td>
<td>1.0779</td>
<td>0.1109</td>
<td>9.7158</td>
<td>0.2386</td>
<td>S 86-48'24.5''E</td>
<td>S 86-48'24.5''E</td>
</tr>
<tr>
<td>508</td>
<td>556</td>
<td>854.9436</td>
<td>1.0836</td>
<td>0.1127</td>
<td>9.6108</td>
<td>0.2477</td>
<td>S 86-38'39.4''E</td>
<td>S 86-38'39.4''E</td>
</tr>
<tr>
<td>509</td>
<td>556</td>
<td>880.6338</td>
<td>1.0848</td>
<td>0.1140</td>
<td>9.5129</td>
<td>0.2489</td>
<td>S 86-45'39.4''E</td>
<td>S 86-45'39.4''E</td>
</tr>
<tr>
<td>521</td>
<td>556</td>
<td>798.2729</td>
<td>1.0387</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Latitude</td>
<td>Longitude</td>
<td>Altitude</td>
<td>Speed</td>
<td>Course</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>---------</td>
<td>-----------</td>
<td>----------</td>
<td>-------</td>
<td>--------</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.1099</td>
<td>9.4500</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.2318</td>
<td>S 87-22'50.2''E</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>556</td>
<td>793.0518</td>
<td>1.0334</td>
<td>0.1097</td>
<td>9.4245</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.2127</td>
<td>S 87-21'38.9''E</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>556</td>
<td>907.2084</td>
<td>1.0856</td>
<td>0.1154</td>
<td>9.4106</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.2379</td>
<td>S 87-07'38.4''E</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>556</td>
<td>918.6572</td>
<td>1.0861</td>
<td>0.1159</td>
<td>9.3682</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.2525</td>
<td>S 86-52'46.5''E</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>556</td>
<td>935.1194</td>
<td>1.0885</td>
<td>0.1168</td>
<td>9.3228</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.2426</td>
<td>S 87-22'21.7''E</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>556</td>
<td>941.3134</td>
<td>1.0830</td>
<td>0.1171</td>
<td>9.2516</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.2283</td>
<td>S 87-33'40.2''E</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>556</td>
<td>962.0899</td>
<td>1.0893</td>
<td>0.1181</td>
<td>9.2231</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.2345</td>
<td>S 87-36'45.6''E</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>556</td>
<td>656.1441</td>
<td>0.9453</td>
<td>0.1028</td>
<td>9.1946</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.1952</td>
<td>S 87-09'41.3''E</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Latitude</td>
<td>Longitude</td>
<td>Distance</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
<td>----------</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>S 87-34'16.6''E</td>
<td>513</td>
<td>978.6797</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>S 87-42'02.1''E</td>
<td>514</td>
<td>981.5606</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>S 87-41'57.3''E</td>
<td>519</td>
<td>993.3973</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>S 87-32'58.7''E</td>
<td>504</td>
<td>1004.0126</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>S 87-17'23.7''E</td>
<td>520</td>
<td>1132.1493</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>S 86-39'15.0''E</td>
<td>551</td>
<td>1152.1979</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>S 86-11'23.8''E</td>
<td>550</td>
<td>1004.0126</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>S 86-11'23.8''E</td>
<td>550</td>
<td>1004.0126</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Chapter 19. SurvNET**
If the "Ratio Actual/Allowable" is 1.0 or less, the positional tolerance of the two points have passed the ALTA standards. The first part of the report labeled "Specific Connections" will show all selected connections whether they passed or failed. The second part of the report, labeled "All Connections" will only show the connections that "failed" (we chose to see the worst 25).

**Settings Menu**

The project settings are set by selecting Settings > Project from the menu, or pressing the SE icon on the tool bar. The project settings dialog box has six tabbed windows, Coordinate System, Input Files, Preprocessing, Adjustment, Standard Errors, and Output Options. Following is an explanation of the different project settings tabbed windows.

Notice that there are two buttons at the lower left of the dialog box. The 'Save Project' button can be used to store the current settings to the active project. If there is no active project then the user will be prompted for a new project file name. Projects can also be saved using the 'File/Save Project' menu option from the main menu. The 'Save as Default' button can be used to save the current project settings as the default settings whenever a new project is created. Default project settings can also be defined using the 'File/Save Project as default' menu option from the main menu.
Coordinate System

The Coordinate System tab contains settings that relate to the project coordinate system, output units, the adjustment model and other geodetic settings.

You can select either the 3D model or the 2D/1D mathematical model. If you choose 2D/1D mathematical model you can choose to only perform a horizontal adjustment, a vertical adjustment or both. In the 3D model both horizontal and vertical are adjusted simultaneously. The 3D model requires that you choose a geodetic coordinate system. Local, assumed coordinate systems cannot be used with the 3D model. GPS vectors can only be used when using the 3D model.

If using the 2D/1D mathematical model you can select Local (assumed coordinate system), or a geodetic coordinate system such State Plane NAD83, State Plane NAD27, UTM, or a user-defined coordinate system as the coordinate system. When using the 3D model you cannot use a local system.

Select the 'Horizontal Units for' output of coordinate values (Meters, US Feet, or International Feet). In the 3D model both horizontal and vertical units are assumed to be the same. In the 2D/1D model horizontal and vertical units can differ. The 'Horizontal unit' setting in this screen refers to the output units. It is permissible to have input units in feet and output units in meters. Input units are set in the 'Input Files' tabbed screen.

If you choose SPC 1983, SPC 1927, or UTM, the appropriate zone will need to be chosen. The grid scale factor is computed for each measured line using the method described in section 4.2 of NPAA Manual NOS NGS 5, "State Plane Coordinate System of 1983", by James E. Stem.

If using the 2D/1D model and you select a geodetic coordinate system, you have a choice as to how the elevation factor is computed. You can choose to enter a project elevation or you can choose to have elevations factors computed for each distance based on computed elevations. In order to use the 'Compute Elevation from Raw Data' all HI's and foresight rod heights must be collected for all points.
If you choose a geodetic coordinate system and are using the 2D/1D model you will want to select "Project Elevation" if any of your raw data measurements are missing any rod heights or instrument heights. There must be enough information to compute elevations for all points in order to compute elevation factors. For most survey projects it is sufficient to use an approximate elevation, such as can be obtained from a Quad Sheet for the project elevation.

**Geoid Modeling**

If you are using either the 3D or the 2D/1D adjustment model using SPC 1983 or UTM reduction you must choose a geoid modeling method. A project geoid separation can be entered or the GEOID99 or GEOID03 grid models can be used. The project must fall within the geographic range of the geoid grid files in order to use GEOID99 or GEOID03 models.

Geoid modeling is used as follows. Entering a 0.0 value for the separation is the method to use if you wish to ignore the geoid separation. In the 2D, 1D model it is assumed that elevations entered as control are entered as orthometric heights. Since grid reduction requires the data be reduced to the ellipsoid, the geoid separation is used to compute ellipsoid elevations. The difference between using geoid modeling and not using geoid modeling or using a project geoid separation is insignificant for most surveys of limited extents. In the 3D model it is also assumed that elevations entered as control are orthometric heights. Since the adjustment is performed on the ellipsoid, the geoid separation is used to compute ellipsoid elevations prior to adjustment. After the adjustment is completed the adjusted orthometric elevations will be computed from the adjusted ellipsoid elevations and the computed geoid separation for each point.

Geoid modelling is especially important for projects covering large extents. If you incorporate GPS vector data from an OPUS solution into your project it will be necessary to use geoid modelling, otherwise your results will be poor.

If you choose the GEOID99 or GEOID03 modeling option, geoid separations are computed by interpolation with data points retrieved from geoid separation files. The geoid separation files should be found in the primary the installation directory. Grid files have an extension of .grd. These files should have been installed during the installation of SurvNet. These files can be downloaded from the Carlson/C&G website, carlsonsw.com, if needed. The geoid files used by SurvNet are not in the same format as the geoid files available from NGS. The geoid files used by SurvNet must come from Carlson/C&G, either installed during installation or downloaded from the Carlson website.

If you choose to enter a project geoid separation the best way to determine a project geoid separation is by using the GEOID03 option of the NGS on-line Geodetic Toolkit. Enter a latitude and longitude of the project midpoint and the program will output a project separation.

**Working With User-defined Coordinate Systems**

SurvNet allows the creation of user-defined geodetic coordinate systems (UDP). The ability to create user-defined coordinate system allows the user to create geodetic coordinate systems based on projections that are not explicitly supported by SurvNet. A SurvNet user-defined coordinate system consists of an ellipsoid, and a map projection,. The ellipsoid can be one of the explicitly supported ellipsoids or a user-defined ellipsoid. The supported map projections are Transverse Mercator, Lambert Conformal Conic with 1 standard parallel, Lambert Conformal Conic with 2 standard parallels, Oblique Mercator (NGS), and Double Stereographic projection. User-defined coordinate systems are created, edited, and attached to a project from the Project Settings 'Coordinate System' dialog box. To attach an existing UDP file, *.udp, to a project use the 'Select' button. To edit an existing UDP file or create a new UDP file use the 'Edit' button.
The User-defined Oblique Mercator projection used by SurvNet uses the Oblique Mercator projection formulas published in the NGS document "State Plane Coordinate System of 1983" by James Stem. This implementation of the Oblique Mercator projection uses the convention of the False North and East being the natural origin, as opposed to the origin being the center of the projection.

The following dialog box is used to create the user-defined coordinate system. The ellipsoid needs to be defined and the appropriate map projection and projection parameters need to be entered. The appropriate parameter fields will be displayed depending on the projection type chosen.
Test - Use the 'Test' button to enter a known latitude and longitude position to check that the UDP is computing correct grid coordinates. Following is the test UDP dialog box. Enter the known lat/long in the top portion of the dialog box then press 'Calculate' and the computed grid coordinates will be displayed in the 'Results' list box.

Load - Use the 'Load' to load the coordinate system parameters from an existing UDP.

Save - Use the 'Save' button to save the displayed UDP. The 'Save' button prompts the user to enter the UDP file name.

OK - Use the 'OK' button to save the UDP using the existing file name and return to the 'Coordinate System' dialog box.

Cancel - Use the 'Cancel' button to return to the 'Coordinate System' dialog box without saving any changes to the
UDP file.

If you need to define an ellipsoid chose the 'User-Defined' ellipsoid option. With the user-defined ellipsoid you will then have the option to enter two of the ellipsoid parameter.
**Raw Data Files:** Use the 'Add' button to insert raw total station files into the list. Use the 'Remove' button to remove raw files from the list. All the files in this list are included in the least squares adjustments. Having the ability to choose multiple files allows one to keep control in one file and measurements in another file. Or different files collected at different times can be processed all at one time. If you have multiple crews working on the same project using different equipment, you can have "crew-specific" raw data files with standard error settings for their particular equipment. Having separate data files is also a convenient method of working with large projects. It is often easier to debug and process individual raw files. Once the individual files are processing correctly all the files can be included for a final adjustment. You can either enter C&G (.CGR) raw files or Carlson (.RW5) files into the list for processing. You cannot have both .CGR and .RW5 files in the same project to be processed at the same time. Notice that you have the ability to highlight multiple files when removing or adding files.

Carlson RW5 files can contain GPS vector records. If you wish to use the vectors from the RW5 file, check the "Include any GPS Vectors" box. You can also select RW5 files containing vectors in the GPS vector Files area.

**Level Raw Files:** Differential and Trig level files can be entered and processed. There are two type of level file supported by SurvNET:

- .TLV files - this is the new Carlson level file. It can contain Trig-Level and/or Differential-Level data. This is the file created by SurvCE version 2.0 or higher.
- .LEV files - this is Carlson's old level file format. It can contain single-wire or three-wire differential-level data.

You can view/edit these files by pressing the "Edit" button next to the level file input field.

Under the tools menu pull down, you have the option to convert level files from other formats to either a TLV or LEV format.

**GPS Vector Files:** GPS vector files can be entered and processed. Both GPS vector files and total station raw files can be combined and processed together. You must have chosen the 3D mathematical model in the Coordinate System tab in order to include GPS vectors in the adjustment.

Currently, the following GPS vector file formats are supported.

- Thales: Thales files typically have .obn extensions and are binary files.
- Leica: Leica files are ASCII files.
- StarNet ASCII GPS: See below for more information on StarNet format. These files typically have .GPS extensions.
- Topcon (.tvf): Topcon .tvf files are ASCII files.
- Topcon (.xml): Topcon also can output their GPS vectors in XML format which is in ASCII format.
- Trimble Data Exchange Format (.asc): These files are in ASCII format
- Trimble data collection (.dc): These files are ASCII.
- LandXML, (*.xml)
- NGS G-File
- NGS G-File from an OPUS report
- Carlson RW5 files containing GPS vector records

The following is a typical vector record in the StarNet ASCII format. GPS vectors typically consist of the 'from' and 'to' point number, the delta X, delta Y, delta Z values from the 'from' and 'to' point, with the XYZ deltas being in the geocentric coordinate system. Additionally the variance/covariance values of the delta XYZ's are included in the vector file.
The GO record is a comment. The G1 record includes the 'from' and 'to' point and the delta X, delta Y, and delta Z in the geocentric coordinate system. The G2 record is the variance of X, Y, and Z. The G3 record contains the covariance of XY, the covariance ZX, and the covariance ZY. Most all GPS vector files contain the same data fields in varying formats.

Use the 'Add' button to insert GPS vector files into the list. Use the 'Delete' button to remove GPS vector files from the list. All the files in this list will be used in the least squares adjustments. All the GPS files in the list must be in the same format. If the GPS file format is ASCII you have the option to edit the GPS vector files. The Edit option allows the editing of any of the ASCII GPS files using Notepad. Typically, only point numbers would be the fields in a GPS vector file that a user would have need to edit. The variance/covariance values are used to determine the weights that the GPS vectors will receive during the adjustment and are not typically edited.

For a variety of reasons it is common for GPS vector data collected with GPS equipment to have point names that do not match the point names used in the total station data. Generally the easiest way to handle this situation is to first convert the GPS data into the StarNet ASCII format using the 'Tools/Convert GPS file to ASCII' menu option. Once the file has been converted to ASCII it is straightforward to change the G1 records using any text editor to reflect the correct point numbers.

Supplemental Control File: The supplemental control file option allows the user to designate an additional coordinate file to be used as control. The supplemental control files can be from a variety of different file types.

- C&G numeric (*.crd)
- C&G alphanumeric (*.cgc)
- Carlson numeric(*.crd)
- Carlson alphanumeric(*.crd)
- Autodesk Land Desktop (*.mdb)
- Simplicity (*.zak)
- ASCII P,N,E,Z,D,C (*.nez)
- ASCII P,Lat,Long,Ortho,D,C (*.txt)
- CSV ASCII NEZ with std. errors
- SDMS (.ctl) control file

Note: You should never use the same file for supplemental control points and for final output. Least squares considers all points to be measurements. If the output file is also used as a supplemental control file then after the project has been processed all the points in the project would now be in the control file and all the points in the file would now be considered control points if the project was processed again. The simplest and most straight-forward method to define control for a project is to include the control coordinates in a raw data file.

Preprocessing

The Preprocessing tab contains settings that are used in the preprocessing of the raw data.
**Apply Curvature and Refraction Corrections:** Set this toggle if you wish to have the curvature refraction correction applied. Curvature/refraction primarily impacts vertical distances.

**Tolerances:** When sets of angles and/or distances are measured to a point, a single averaged value is calculated for use in the least squares adjustment. You may set the tolerances so that a warning is generated if any differences between the angle sets or distances exceed these tolerances. Tolerance warnings will be shown in the report (.RPT) and the (.ERR) file after processing the data.

**Horz./Slope Dist Tolerance:** This value sets the tolerance threshold for the display of warnings if the difference between highest and lowest horizontal distance exceeds this value. In the 2D model it is the horizontal distances that are being compared. In the 3D model it is the slope distances that are being compared.

**Vert. Dist Tolerance:** This value sets the tolerance threshold for the display of a warning if the difference between highest and lowest vertical difference component exceeds this value (used in 2D model only).

**Horz. Angle Tolerance:** This value sets the tolerance threshold for the display of a warning if the difference between the highest and lowest horizontal angle exceeds this value.

**Vert. Angle Tolerance:** This value sets the tolerance threshold for the display of a warning if the difference between the highest and lowest vertical angle exceeds this value (used in 3D model only).

**Compute Traverse Closures:** Traditional traverse closures can be computed for both GPS loops and total station traverses. This option has no effect on the computation of final least squares adjusted coordinates. This option is useful for surveyors who due to statutory requirements are still required to compute traditional traverse closures and for those surveyors who still like to view traverse closures prior to the least squares adjustment. This option is used to specify a previously created closure file.
To use this option the user has to first create a traverse closure file. The file contains a .cls extension. The traverse closure file is a file containing an ordered list of the point numbers comprising the traverse. Since the raw data for SurvNet is not expected to be in any particular order it is required that the user most specify the points and the correct order of the points in the traverse loop. Both GPS loops and angle/distance traverses can be defined in a single traverse closure file. More details on creating the traverse closure files follow in a later section of this manual.

**Pt. Number Substitution String:** This option is used to automatically renumber point names based on this string. Some data collectors do not allow the user to use the same point number twice during data collection. In least squares it is common to collect measurements to the same point from different locations. If the data collector does not allow the collection of data from different points using the same point number this option can be used to automatically renumber these points during processing. For example you could enter the string '=' in the Pt. Number Substitution String. Then if you shot point 1 but had to call it something else such as 101 you could enter '='1' in the description field and during preprocessing point 101 would be renumbered as point '1'. With small projects it may be just as easy to edit the raw data.

**Adjustment**

![Adjustment Settings](image)

**Maximum Iterations:** Non-linear least squares is an iterative process. The user must define the maximum number of iterations to make before the program quits trying to find a converging solution. Typically if there are no blunders in the data the solution will converge in 2-5 iterations.
Convergence Threshold: During each iteration corrections are computed. When the corrections are less than the threshold value the solution has converged. This value should be somewhat less than the accuracy of the measurements. For example, if you can only measure distances to the nearest .01' then a reasonable convergence threshold value would be .005'.

Confidence Interval: This setting is used when calculating the size of error ellipses, and in the chi-square testing. For example, a 95% confidence interval means that there is a 95% chance that the error is within the tolerances shown.

Enable sideshots for relative error ellipses: Check this box if you want to see the error ellipses and relative error ellipses of sideshots. This checkbox must be set if you want to use the "relative error ellipse inverse" function with sideshots. When turned off this toggle filters out sideshots during the least squares processing. Since the sideshots are excluded form the least squares processing error ellipses cannot be computed for these points. When this toggle is off, the sideshots are computed after the network has been adjusted. The final coordinate values of the sideshots will be the same regardless of this setting.

Large numbers of sideshots slow down least squares processing. It is best to uncheck this box while debugging your project to avoid having to wait for the computer to finish processing. After the project processes correctly you may turn on the option for the final processing.

Note: If you wish to get statistics on certain selected sideshots, you can create an ALT file with the selected points. This will force them to be included in the calculation process - even if you have "Enable sideshots for relative error ellipses" unchecked.

Relative Err. Points File: The new ALTA standards require that surveyors certify to the relative positional error between points. Relative error ellipses are an accepted method of determining the relative positional error required by the ALTA standards. The points that are to be included in the relative error checking are specified by the user. These points are defined in an ASCII file with an extension of .alt. To select an .alt file for relative error checking use the 'Select' button and then browse to the file's location.

There is a section later in the manual that describes how to create and edit the .alt file.

Include ALTA tolerance report: Turn this toggle on if you wish to include the ALTA tolerance section of the report.

Allowable Tolerance, PPM: These fields allow the user to set the allowable error for computations. Typically the user would enter the current ALTA error standards, i.e. 0.07' & 50 PPM.

See the later section in this manual for more detailed information on creating and interpreting the ALTA section of the report.

Standard Errors
Standard errors are the expected measurement errors based on the type equipment and field procedures being used. For example, if you are using a 5 second total station, you would expect the angles to be measured within +/- 5 seconds (Reading error).

The Distance Constant, PPM settings, and Angle Reading should be based on the equipment and field procedures being used. These values can be obtained from the published specifications for the total station. Or the distance PPM and constant can be computed for a specific EDM by performing an EDM calibration using an EDM calibration baseline.

Survey methods should also be taken into account when setting standard errors. For example, you might set the target centering standard error higher when you are sighting a held prism pole than you would if you were sighting a prism set on a tripod.

The settings from this dialog box will be used for the project default settings. These default standard errors can be overridden for specific measurements by placing SE records directly into the Raw Data File (see the above section on raw data files).

If the report generated when you process the data shows that generally you have consistently high standard residuals for a particular measurement value (angles, distances, etc.), then there is the chance that you have selected standard errors that are better than your instrument and methods can obtain. (See explanation of report file). Failing the chi-square test consistently is also an indication that the selected standard errors are not consistent with the field measurements.

You can set the standard errors for the following:

**Distance and Angle Standard Errors**

**Distance Constant:** Constant portion of the distance error. This value can be obtained from published EDM specifications, or from an EDM calibration.

**Distance PPM:** Parts per million component of the distance error. This value can be obtained from published EDM specifications, or from an EDM calibration.
specification, or from an EDM calibration.

**Horizontal Angle Pointing:** The horizontal angle pointing error is influenced by atmospheric conditions, optics, experience and care taken by instrument operator.

**Horizontal Angle Reading:** Precision of horizontal angle measurements, obtain from theodolite specs.

**Vertical Angle Pointing:** The vertical angle pointing error is influenced by atmospheric conditions, optics, experience and care taken by instrument operator.

**Vertical Angle Reading:** Precision of vertical angle measurements, obtain from theodolite specs.

**Instrument and Target Standard Errors**

**Target Centering:** This value is the expected amount of error in setting the target or prism over the point.

**Instrument Centering:** The expected amount of error in setting the total station over the point.

**Target Height:** The expected amount of error in measuring the height of the target.

**Instrument Height:** The expected amount of error in measuring the height of the total station.

**Control Standard Errors**

**Direction (Bearing / Azimuth):** The estimated amount of error in the bearing / azimuth (direction) found in the azimuth records of the raw data.

**North, East, Elev:** The estimated amount of error in the control north, east and elev. You may want to have different coordinate standard errors for different methods of obtaining control. Control derived from RTK GPS would be higher than control derived from GPS static measurements.

**GPS Standard Errors**

**Instrument Centering:** This option is used to specify the error associated with centering a GPS receiver over a point.

**Vector Standard Error Factor:** This option is used as a factor to increase GPS vector standard errors as found in the input GPS vector file. Some people think that the GPS vector variances/covariances as found in GPS vector files tend do be overly optimistic. This factor allows the user to globally increase the GPS vector standard errors without having to edit the GPS vector file. A factor of 0 should be the default value and results in no change to the GPS vector standard errors as found in the GPS vector file. The maximum value allowed is 10.

**Differential Leveling Standard Errors**

These setting only effect level data and are not used when processing total station or GPS vector files.

**Avg, Dist. To BS/FS:** This option is used to define the average distance to the backsight and foresight during leveling.

**Rod Reading Error per 100 ft./m:** This option is used to define the expected level reading error.

**Collimation Error:** This is the expected differential leveling collimation error in seconds.

**Standard Error Definition Files**

The Standard error settings can be saved and then later reloaded into an existing or new project. Creating libraries of standard errors for different types of survey equipment or survey procedures is convenient method of creating standards within a survey department that uses a variety of equipment and performs different types of surveys. Standard error library files, *.sef files, can be created two ways. From the 'Settings/Standard Errors' dialog box the 'Load' button can be used to import an existing .sef file into the current project. A .sef file can also be created from the existing project standard errors by using the 'Save As..' button.
Standard error files, .sef files, can also be managed from the main 'Files' menu. Use the 'Edit Standard Error File' menu option to edit an existing standard error file. Use the 'New Standard Error File' option to create a new standard error file.

After choosing one of the menu options and choosing the file to edit or create, the following dialog box will be shown. Set the desired standard errors and press the 'OK' button to save the standard error file.
These settings apply to the output of data to the report and coordinate files.

**Display Precision**

These settings determine the number of decimal places to display in the reports for the following types of data. The display precision has no effect on any computations, only the display of the reports.
Coordinates (North, East, Elevation) - Chose 0-4 decimal places.
Distances - Chose 0-4 decimal places
Directions (Azimuths or Bearings) - nearest second, tenth of second, or hundredth of second.

**Format**

These settings determine the format for the following types of data.

**Direction** - Choose either bearings or azimuth for direction display. If the angle units are degrees, bearings are entered as QDD.MMSSss and azimuths are entered as DDD.MMSSss. If the angle units are grads, bearings are input as QGGG.ggggg and azimuths are input as GGG.ggggg.

**Coordinate Display** - Choose the order of coordinate display, either north-east or east-north.

**Null Elevation** - Choose the value for null elevations in the output ASCII coordinate NEZ file. The Null Elevation field defaults to SurvNet's value for NO ELEVATION, of -999999999.0.

**Angle Display** - Choose the units you are working in, degrees or gradians.

**Coordinate File Output**

These settings determine the type and format of the output NEZ file. An ASCII .NEZ and .OUT files are always created after processing the raw data. The .OUT file will be a nicely formatted version of the .NEZ file suitable for printing. The .NEZ file will be an ASCII file suitable to be input into other programs. There are a variety of options for the format of the .NEZ file. Following are the different ASCII file output options.

- P,N,E,Z,CD,DESC (fixed columns); Point,north,east,elev.,code,desc in fixed columns separated by commas.
- P,N,E,Z,CD,DESC; Point,north,east,elev.,code,desc separated by commas.
- P N E Z CD DESC (fixed columns); Point,north,east,elev.,code,desc in fixed columns with no commas.
- P N E Z CD DESC; Point,north,east,elev.,code,desc separated by commas.
- P,N,E,Z,DESC (fixed columns); Point,north,east,elev., desc in fixed columns separated by commas.
- P,N,E,Z,DESC; Point,north,east,elev., desc separated by commas.
- P N E Z DESC (fixed columns); Point,north,east,elev., desc in fixed columns with no commas.
- P N E Z DESC; Point,north,east,elev., desc separated by commas.
- P,E,N,Z,CD,DESC (fixed columns); Point,east,north,elev.,code,desc in fixed columns separated by commas.
- P,E,N,Z,CD,DESC; Point,east,north,elev.,code,desc separated by commas.
- P E N Z CD DESC (fixed columns); Point,east,north,elev.,code,desc in fixed columns with no commas.
- P E N Z CD DESC; Point,east,north,elev.,code,desc separated by commas.
- P,E,N,Z,DESC (fixed columns); Point,east,north,elev., desc in fixed columns separated by commas.
- P,E,N,Z,DESC; Point,east,north,elev., desc separated by commas.
- P E N Z DESC (fixed columns); Point,east,north,elev., desc in fixed columns with no commas.
- P E N Z DESC; Point,east,north,elev., desc separated by spaces.

**CSV ASCII with std. errors** (This format is useful as it can be used as a supplemental control input file type option, where the coordinate standard errors output for one project can be used as input for another project.)
You can also set the output precision of the coordinates for the ASCII output file. This setting only applies to ASCII files, not to the C&G or Carlson binary coordinate files which are stored to full double precision.

* N/E Precision: number of places after the decimal to use for North and East values (0 - > 8) in the output NEZ ASCII file.

* Elevation Precision: number of places after the decimal to use for Elevation values (0 - > 8) in the output NEZ ASCII file.

If you want to write the calculated coordinates directly to a C&G or Carlson coordinate file, check the "Write to Carlson/C&G .CRD file" box and select the file. You can choose the type of Carlson/C&G file to be created when you 'select' the file to be created. You may wish to leave this box unchecked until you are satisfied with the adjustment. Following are the different available coordinate output file options.

* NOTE: If coordinate points already exist in the CRD file, and they have different values, before a point is written, you will be shown the NEW value, the OLD value, and given the following option:
**Cancel:** Cancel the present operation. No more points will be written to the Carson/C&G file.

**Overwrite:** Overwrite the existing point. Notice that if you check the 'Do Not Ask Again' box all further duplicate points will be overwritten without prompting.

**Do not Overwrite:** The existing point will not be overwritten. Notice that if you check the 'Do Not Ask Again' box all further duplicate points will automatically not be overwritten - only new points will be written.

### Process Menu

![Process Menu Image](image)

When you select Process > *Network Adjustment* from the menu, or select the NETWORK ICON on the tool bar, the raw data will be processed and adjusted using least squares based on the project settings. If there is a problem with the reduction, you will be shown error messages that will help you track down the problem. Additionally an .err file is created that will log and display error and warning messages.

The data is first preprocessed to calculate averaged angles and distances for sets of angles and multiple distances. For a given setup, all multiple angles and distances to a point will be averaged prior to the adjustment. The standard error as set in the Project Settings dialog box is the standard error for a single measurement. Since the average of multiple measurements is more precise than a single measurement the standard error for the averaged measurement is computed using the standard deviation of the mean formula.

Non-linear network least squares solutions require that initial approximations of all the coordinates be known before the least squares processing can be performed. So, during the preprocessing approximate coordinate values for each point are calculated using basic coordinate geometry functions. If there is inadequate control or odd geometric situations SurvNet may generate a message indicating that the initial coordinate approximations could not be computed. The most common cause of this problem is that control has not been adequately defined or there are point number problems.

Side Shots are separated from the raw data and computed after the adjustment (unless the "Enable sideshots for relative error ellipses" toggle is checked in the adjustment dialog box). If side shots are filtered out of the least squares process and processed after the network is adjusted, processing is greatly speeded up, especially for a large project with a lot of side shots.

If the raw data processes completely, a report file, .RPT, a .NEZ file, an .OUT file, and an .ERR file will be created in the project directory. The file names will consist of the project name plus the above file extensions. These different files are shown in separate windows after processing. Additionally a graphic window of the network is displayed.

- **.RPT file:** This is an ASCII file that contains the statistical and computational results of the least squares processing.
- **.NEZ file:** This file is an ASCII file containing the final adjusted coordinates. This file can be imported into any program that can read ASCII coordinate files. The format of the file is determined by the setting in the project settings dialog box.
- **.OUT file:** The .OUT file is a formatted ASCII file of the final adjusted coordinates suitable for display or printing.
- **.ERR file:** The .ERR file contains any warning or error messages that were generated during processing. Though some warning messages may be innocuous it is always prudent to review and understand the meaning of the
messages.

The following is a graphic of the different windows displayed after processing. Notice that with the report file you can navigate to different sections of the report using the Tabs at the top of the window.

If you have "Write to Carlson/C&G.CRD" checked in the output options dialog, the coordinates will also be written to a .CRD file.

GPS vector networks can be adjusted with the current version of SurvNet. This chapter will describe the processing of a simple GPS network. Following is a graphic view of the GPS network that is to be adjusted. Points A and B are control points. The red lines represent measured GPS vectors. Most GPS vendor's software can output GPS vectors to a file as part of the post processing of GPS data.
When processing GPS vectors certain project settings are important. In the following settings dialog box notice that the 3D-model has been chosen, and SPC 1983 with an appropriate zone has been chosen. The 3-D model and a geodetic coordinate are required when processing GPS vectors. Though it is not require for GPS processing it is in most cases appropriate to chose to do geoid modeling, especially if the project covers a large extents. The following settings dialog box shows the raw files used in processing GPS files. A GPS vector file must be chosen.
GPS vector files from various GPS vendors are currently supported. Select the vector files to be processed:

Coordinate control for the network can be in one of several files. The control can be located in the GPS vector file itself. More typically, the control points can be regular coordinate records in the .RW5 or the .CGR file. The coordinates can also be entered as 'Supplemental Control' in one of the available formats. When the control coordinates are in the raw data file or supplemental coordinate file, the coordinates are expected to be grid coordinates. If the control coordinates are found in the GPS vector file, they are assumed to be Earth centered XYZ.

Very often the point numbering convention used in the GPS data collection is different than the point number convention used when collecting total station data. If the point numbers in the GPS file differ from the total station point number it is easy to first convert the native GPS format file to a ASCII .GPS using the 'Tools/Convert GPS file to ASCII' menu option. The .GPS ASCII files can easily be edited to ensure point numbers are consistent between GPS and total station data.

It is not unusual to have different distance units for GPS, total station data, and control data. Often the GPS vector data is in metric units but the total station raw file is in US Feet. So, the distance units must be specified for the different raw data types.

In the Preprocessing Settings dialog box the only important setting is the 'Compute Traverse Closures:' options. If GPS loop closures need to be computed, the loop point numbers need to be entered into a closure file. See the chapter on traverse closures to see how to create closure files.
There are two GPS standard errors fields in the Standard Errors Settings dialog box. The GPS vector XYZ standard errors and covariances do not need to be defined as project settings since they are typically found in the GPS vector data files. The Instrument centering standard error is the estimated error in centering the GPS unit over the survey point. The 'vector Std. Err. Factor' can be used to globally increase the variance/covariances found in the GPS files without having to edit the GPS file itself.
Processing a Total Station and a GPS Vector Network

Processing a GPS vector network together with conventional total station data is similar to processing a GPS network by itself. The only difference in regards to project settings is that a raw data file containing the total station data needs to be chosen as well as a GPS vector file. The project must be set up for the 3D model and a geodetic coordinate system needs to be chosen. The total station must contain full 3D data, including all rod heights and instrument heights measured. Following is a view of the Input Files Settings dialog box showing both a GPS vector file and a total station raw data file chosen in a single project. It is not uncommon to have different distance units for GPS data and total station data, so make sure the correct units are set for data types.

One of the most common problems for new users in combining GPS and total station data is not collecting HI's and rod heights when collecting the total station data. Since the 3D model is being used complete 3D data needs to be collected.

The 'Preprocess, compute unadjusted coordinates' option allows the computation of unadjusted coordinates. If there are redundant measurements in the raw data, the first angle and distance found in the raw data is used to compute the coordinates. If a state plane grid system has been designated the measurements are reduced to grid prior to the computation of the unadjusted coordinates. If the point is located from two different points the initial computation...
A variety of blunder detection tools are available that gives the user additional tools in analyzing his survey data, and detecting blunders. The standard least squares adjustment processing and its resulting report can often be used to determine blunders. No blunder detection method can be guaranteed to find all blunders. So much depends on the nature of the network geometry, the nature of the measurements, and the intuition of the analyst. Generally, the more redundancy there is in a network the easier it is to detect blunders.

There are three different methods that can be used to track down blunders in a network or traverse.

**Option 1) Preprocess the raw data:**

The 'Preprocess the raw data' option validates the raw data. It displays angle and distance spreads as well as checks the validity of the raw data. Traverse closures are computed if specified. It also performs a "K-Matrix" analysis. The "K-Matrix" analysis compares the unadjusted, averaged measurements with the computed preliminary measurements (measurements calculated from the preliminary computed coordinates). This method will catch blunders such as using the same point number twice for two different points. The report will be sent to the ERR file. The ERR file will contain the tolerance checks, closures and the K-Matrix analysis. Following is an example of the report created using the 'Preprocess the raw data' option. Notice that the first section of the report shows the angle and distance spreads from the multiple angle and distance measurements. The second part of the report shows the 'K-matrix analyses.

Additionally there is a 'Point Proximity Report' section that reports pairs of different points that are in close proximity to each other which may indicate where the same point was collected multiple times using different point numbers.

The 'Preprocess the raw data' option is one of the simplest and effective tools in finding blunders. Time spent learning how this function works will be well spent. If the project is not converging due to an unknown blunder in the raw data this tool is one of the most effective tools in finding the blunder. Many blunders are due to point
numbering errors during data collections, and the 'K-matrix' analysis and 'Point Proximity' search are great tools for finding this type of blunders.

-----------------------------
LEAST SQUARES ADJUSTMENT ERROR REPORT
-----------------------------

Tue Mar 21 16:04:32 2006
Input Raw Files:
   C:\data\lsdata\cgstar\CGSTAR.CGR
Output File: C:\data\lsdata\cgstar\cgstar.RPT

Checking raw data syntax and angle & distance spreads.

Warning: Missing Vert. Angle. Assumption made as to whether it is direct or reverse.
   1
   5.00
   180.00050
   4

Warning: Missing Vert. Angle. Assumption made as to whether it is direct or reverse.
   1
   5.01
   145.54300
   2
   H&T

Horizontal Angle spread exceeds tolerance:
   IP: 1,
   BS: 5,
   FS: 2
   Low: 109-19'10.0'' ,
   High: 109-19'17.0'' ,
   Diff: 000-00'07.0''

Horizontal Angle spread exceeds tolerance:
   IP: 2,
   BS: 1,
   FS: 6
   Low: 190-32'02.0'' ,
   High: 190-32'10.0'' ,
   Diff: 000-00'08.0''

K-Matrix Analysis.

Distance: From pt.: 4
   To pt.: 5
   Measured distance: 309.61
   Initial computed distance: 309.65
   Difference: -0.04

Distance: From pt.: 12
   To pt.: 3
   Measured distance: 144.63

Chapter 19. SurvNET
Initial computed distance:
144.66
Difference:
-0.03

**Distance: From pt.: 5 To pt.: 6**

- Measured distance: 348.51
- Initial computed distance: 523.29
- Difference: -174.79

**Angle: IP: 4 BS: 3 FS: 5**

- Measured angle: 093-02'11.5''
- Initial computed angle: 093-01'45.1''
- Difference: 000-00'26.4''

**Angle: IP: 12 BS: 11 FS: 3**

- Measured angle: 140-39'24.5''
- Initial computed angle: 140-40'32.6''
- Difference: -000-01'08.1''

**Angle: IP: 5 BS: 4 FS: 6**

- Measured angle: 117-30'42.5''
- Initial computed angle: 117-31'16.4''
- Difference: -000-00'33.9''

**Point Proximity Report:**

- Points 3 and 30 are within 0.05 of each other.

The problem with the above project was that point 6 was accidentally used twice for two separate side shots. Because of the point numbering problem the project would not converge, using the regular least squares processing. The 'Preprocess the raw data.' option was then used. Notice in the K-matrix section the distance from 5 to 6 shows a difference of 174.79' and the angle 4-5-6 shows a difference of 065-50'47.6''. Then notice that the other listed differences are in the range of .02' for the distances and less than a minute for the angles. This report is clearly pointing out a problem to point 6.

Note the point proximity report section. During data collection point number 30 was used as the point number when the point was previously collected as point 3.

In the first section of the report notice that there are several warnings concerning whether a horizontal angle reading was collected in direct or reverse reading. The preprocessing software uses the vertical angle reading to determine the angle face of the horizontal angle reading. If the vertical angle is missing the program makes its best
guess as to whether the angle was collected in direct or reverse face. Since all horizontal angle spreads in the report are reasonable, the preprocessing software must have made the correct determination.

**Option 2) Float one observation:**

This option is useful in finding a single blunder, either an angle or distance, within a network or traverse. If there is more than a single blunder in the network then it is less likely that this method will be able to isolate the blunders. If the standard least squares processing results in a network that will not converge then this blunder detection method might not work. Use the 'Preprocess the raw data' blunder detection method if the solution is not converging. Also this method will only work on small and moderately sized networks. This method performs a least squares adjustment once for every non-trivial measurement in the network. So for large networks this method may take so long to process that it is not feasible to use this method.

With this method an adjustment is computed for each non-trivial individual angle and distance measurement. Consecutively, a single angle or distance is allowed to float during each adjustment. The selected floated angle or distance does not "constrain" the adjustment in any way. If there is a single bad angle or distance, one of the adjustment possibilities will place most of the error in the "float" measurement, and the other measurements should have small residuals. The potentially bad angle or distance is flagged with a double asterisk (**). Since an adjustment is computed for each measurement this method may take a long time when analyzing large data files.

The adjustments with the lowest reference variances are selected as the most likely adjustments that have isolated the blunder. You have the choice to view the best adjustment, or the top adjustments with a maximum of ten. In the above example we asked to see the top 5 choices for potential blunders. The results are shown in the ERR file. Following is a section of the report generated where an angular blunder was introduced into a small traverse. Notice the '***' characters beside the angle measurements. In this report the two most likely adjustments were displayed. The blunder was introduced to angle 101-2-3. Angle 101-2-3 was chosen as the 2nd most likely source of the blunder, showing that these blunder detection methods though not perfect, can be a useful tool in the analysis of survey measurements. Notice how much higher the standard residuals are on the suspected blunders than the standard residuals of the other measurements.

---

Adjusted Observations

----------
### Adjusted Distances

<table>
<thead>
<tr>
<th>From Sta.</th>
<th>To Sta.</th>
<th>Distance</th>
<th>Residual</th>
<th>StdRes.</th>
<th>StdDev</th>
</tr>
</thead>
<tbody>
<tr>
<td>101</td>
<td>2</td>
<td>68.780</td>
<td>-0.006</td>
<td>0.608</td>
<td>0.008</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>22.592</td>
<td>-0.006</td>
<td>0.573</td>
<td>0.008</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>47.694</td>
<td>-0.002</td>
<td>0.213</td>
<td>0.008</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>44.954</td>
<td>-0.001</td>
<td>0.069</td>
<td>0.008</td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>62.604</td>
<td>0.005</td>
<td>0.472</td>
<td>0.009</td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>35.512</td>
<td>0.006</td>
<td>0.539</td>
<td>0.008</td>
</tr>
<tr>
<td></td>
<td>101</td>
<td>61.704</td>
<td>0.003</td>
<td>0.314</td>
<td>0.009</td>
</tr>
</tbody>
</table>

**Root Mean Square (RMS)**

0.005

### Adjusted Angles

<table>
<thead>
<tr>
<th>BS Sta. Occ. Sta.</th>
<th>FS Sta.</th>
<th>Angle</th>
<th>Residual</th>
<th>StdRes.</th>
<th>StdDev(Sec.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>101</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Chapter 19. SurvNET*
Adjusted Azimuths
Occ. Sta. FS Sta. Bearing Residual StdRes StdDev(Sec.)
101 7 N 00-00'00''E

Root Mean Square (RMS)
Root Mean Square (RMS)

Statistics

Solution converged in 2 iterations
Degrees of freedom: 3
Reference variance: 0.78
Standard error unit Weight: +/- 0.88
Passed the Chi-Square test at the 95.00 significance level
0.216 <= 2.347 <= 9.348

Adjusted Observations

Adjusted Distances
From Sta.  
To Sta.  
  Distance  
  Residual  
  StdRes.  
  StdDev

 Adjusted Distances
From Sta.  
To Sta.  
  Distance  
  Residual  
  StdRes.  
  StdDev
101   
  2     68.781
  -0.005 0.473
  0.009

  3     22.592
  -0.005 0.512
  0.009

  4     47.690
  -0.006 0.586
  0.009

  5     44.950
  -0.005 0.523
  0.009

  6     62.605
  0.006 0.607
  0.009

  7     35.512
<table>
<thead>
<tr>
<th>BS Sta.</th>
<th>Occ. Sta.</th>
<th>FS Sta.</th>
<th>Angle</th>
<th>Residual</th>
<th>StdRes</th>
<th>StdDev(Sec.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>101</td>
<td>2</td>
<td>172-11'03''</td>
<td>-213</td>
<td>*</td>
<td>7</td>
<td>58 **</td>
</tr>
</tbody>
</table>

Chapter 19. SurvNET 1481
Adjusted Azimuths
Occ. Sta.  
FS Sta.  
Bearing  
Residual  
StdRes  
StdDev(Sec.)

<table>
<thead>
<tr>
<th>No</th>
<th>Occ. Sta.</th>
<th>FS Sta.</th>
<th>Bearing</th>
<th>Residual</th>
<th>StdRes</th>
<th>StdDev(Sec.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>101</td>
<td>7</td>
<td>N-00-00'00''E</td>
<td>-0</td>
<td>0</td>
<td>5</td>
<td></td>
</tr>
</tbody>
</table>

Root Mean Square (RMS)
0

Statistics
Solution converged in 2 iterations
Degrees of freedom: 3
Reference variance: 0.89
Standard error unit Weight: +/-0.94
Passed the Chi-Square test at the 95.00 significance level
0.216 <= 2.675 <= 9.348

The blunder is most likely in the measurement containing the largest residual and standard residual. The observation marked with ** is the observation that floated. It is also most likely the measurement containing the blunder.

**Option 3) Re-weight by residuals & std err:**
This method is capable of detecting multiple blunders but one is more likely to find the blunders if there is a high degree of redundancy (network of interconnected traverses). The higher the degree of freedom the more likely this method will find the blunders. This method will not work if the standard least squares processing will not converge. Use the 'Preprocess the raw data' blunder detection method if the network is not converging.

First, select the number of adjustments or passes you wish to make. Each time an adjustment is completed, the measurements will be re-weighted based on the residuals and standard errors. Hopefully, after three or four passes, the blunders will become obvious. The results are shown in the ERR file, look for the measurements with the highest standard residuals. These measurements are more likely to contain blunders.

The theory behind this method is that after processing, the measurements with blunders are more likely to have higher residuals and computed standard errors. So, in the next pass the measurements are reweighted based on the computed residuals, with less weight being assigned to the measurements with high residuals. After several passes it is likely that the measurements with the blunders have been reweighed such that they have little effect on the network.

As a rule of thumb three or four passes are usually sufficient. Following is a section of the report showing the results of the 'Reweight by residuals & std. err.'. This report was generated using the same data used in the earlier example. Notice that it has flagged the same two angle measurements.

The 'Reweight by residuals & std. err.' method performs a new adjustment for each pass. So, this method will take longer than the standard least squares adjustment, but does not take near as long to complete processing as the 'Float one Observation' method for larger networks.

Adjusted Observations
=====================

<table>
<thead>
<tr>
<th>Adjusted Distances</th>
<th>From Sta.</th>
<th>To Sta.</th>
<th>Distance</th>
<th>Residual</th>
<th>StdRes.</th>
<th>StdDev</th>
</tr>
</thead>
<tbody>
<tr>
<td>101</td>
<td>2</td>
<td>68.778</td>
<td>-0.009</td>
<td>0.827</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Chapter 19. SurvNET 1483
<table>
<thead>
<tr>
<th>BS Sta.</th>
<th>Occ. Sta.</th>
<th>FS Sta.</th>
<th>BS-Occ.</th>
<th>Occ.-FS</th>
<th>Angle</th>
<th>Residual</th>
<th>StdRes</th>
<th>StdDev (Sec.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>3</td>
<td>0.942</td>
<td>0.014</td>
<td>22.588</td>
<td></td>
<td>-0.010</td>
<td>0.015</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>4</td>
<td>0.208</td>
<td>0.002</td>
<td>47.694</td>
<td></td>
<td>-0.002</td>
<td>0.009</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>0.077</td>
<td>0.001</td>
<td>44.954</td>
<td></td>
<td>-0.001</td>
<td>0.006</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>6</td>
<td>0.919</td>
<td>0.010</td>
<td>62.608</td>
<td></td>
<td>0.010</td>
<td>0.016</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>7</td>
<td>1.040</td>
<td>0.011</td>
<td>35.517</td>
<td>100</td>
<td>0.011</td>
<td>1.040</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>101</td>
<td>0.398</td>
<td>0.004</td>
<td>61.705</td>
<td></td>
<td>0.004</td>
<td>0.398</td>
<td></td>
</tr>
</tbody>
</table>

Root Mean Square (RMS) 0.008

Adjusted Angles

Chapter 19. SurvNET
<table>
<thead>
<tr>
<th>Occ. Sta.</th>
<th>FS Sta.</th>
<th>Bearing</th>
<th>Residual</th>
<th>StdRes</th>
<th>StdDev(Sec.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>101</td>
<td>148</td>
<td>N 00-00'00''E</td>
<td>-1</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

Root Mean Square (RMS)

45

Statistics

----------
Solution converged in 1 iterations
Degrees of freedom: 3
Reference variance: 1.77
Standard error unit Weight: +/- 1.33
Passed the Chi-Square test at the 95.00 significance level
0.216 <= 5.322 <= 9.348

The blunder is most likely in the measurement containing the largest residual and standard residual.
Tools Menu

**Inverse Buttons** - The 'Inverse' button is found on the main window (the button with the icon that shows a line with points at each end). You can also select the Tools->Inverse menu option. This feature is only active after a network has been processed successfully. This option can be used to obtain the bearing and distance between any two points in the network. Additionally, the standard deviation of the bearing and distance between the two points is displayed.

The **Relative Error Ellipse Inverse** button is found on the main window (the button with the icon that shows a line with an ellipse in the middle). You can also select the Tools > Relative Error Ellipse menu option. This feature is only active after a network has been processed successfully. This option can be used to obtain the relative error ellipse between two points. It shows the semi-major and semi-minor axis and the azimuth of the error ellipse, computed to a user-defined confidence interval. This information can also be used to determine the relative precision between any two points in the network. It is the relative error ellipse calculation that is the basis for the ALTA tolerance reporting. If the 'Enable sideshots for relative error ellipses' toggle is checked then all points in the project can be used to compute relative error ellipses. The trade-off is that with large projects processing time will be increased.
If you need to certify as to the "Positional Tolerances" of your monuments, as per the ALTA Standards, use the Relative Error Ellipse inverse routine to determine these values, or use the specific ALTA tolerance reporting function as explained later in the manual.

For example, if you must certify that all monuments have a positional tolerance of no more than 0.07 feet with 50 PPM at a 95 percent confidence interval. First set the confidence interval to 95 percent in the Settings/Adjustment screen. Then process the raw data. Then you may inverse between points in as many combinations as you deem necessary and make note of the semi-major axis error values. If none of them are larger than 0.07 feet + (50PPM*distance), you have met the standards. It is however more convenient to create a Relative Error Points File containing the points you wish to check and include the ALTA tolerance report. This report takes into account the PPM and directly tells you if the positional tolerance between the selected points meets the ALTA standards.

Convert GPS File to ASCII

The purpose of this option is to convert GPS vector files that are in the manufacturers' binary or ASCII format into the StarNet ASCII file format. The advantage of creating an ASCII file is that the ASCII file can be edited using a standard text editor. Being able to edit the vector file may be necessary in order to edit point numbers so that the
point numbers in the GPS file match the point numbers in the total station file. The following dialog box is displayed after choosing this option.

![Convert GPS File dialog box](image)

First choose the file format of the GPS vector file to be converted. Next use the 'Select' button to navigate to the vector file to be converted. If you are converting a Thales file you have the option to remove the leading 0's from Thales point numbers. Next, use the second 'Select' button to select the name of the new ASCII GPS vector file to be created. Choose the 'Convert' button to initiate the file conversion. Press the 'Cancel' button when you have completed the conversions. The file created will have an extension of .GPS. Following are the different GPS formats that can be converted to ASCII.

**Thales:** The Thales GPS vector file is a binary file and is sometimes referred to as an 'O' file. Notice that you have the option to remove the leading 0's from Thales point numbers, by checking the "Remove leading 0's from Thales point numbers" check box.

**Leica:** The Leica vector file is an ASCII format typically created with the Leica SKI software. This format is created by Leica when baseline vectors are required for input into 3rd party adjustment software such as SurvNet. The SKI ASCII Baseline Vector format is an extension of the SKI ASCII Point Coordinate format.

**Topcon (.TVF):** The Topcon Vector File is in ASCII format and typically has an extension of .TVF

**Topcon (.XML):** The Topcon XML file is an ASCII file. It contains the GPS vectors in an XML format. This format is not equivalent to LandXML format.

**Trimble Data Exchange Format (.ASC):** The Trimble TDEF format is an ASCII file. It is typically output by Trimble's office software as a means to output GPS vectors for use by 3rd party software. The Trimble Data Exchange file can also contain traverse data. The conversion dialog will give you the option to create either an RW5 or CGR file with the traverse data, along with the GPS file containing the vector data.
Trimble Data Collection (.dc): The Trimble .dc format is an ASCII file. It is typically output by Trimble's data collector. It contains a variety of measurements including GPS vectors. This option only converts GPS vectors found in the .DC file.

LandXML (.XML): The landXML format is an industry standard format. Currently SurvNet will only import LandXML survey point records. The conversion does not currently import LandXML vectors.

NGS G-File: The NGS G-File is the format used National Geodetic Survey in their processing software.

NGS G-File from an OPUS report: Every OPUS report contains a G-File section. The vectors making up this G-file are the vectors from the control points to the computed point making up the OPUS solution. These OPUS vectors can be extracted and then combined with other GPS or total station data to create a larger SurvNet project. If the OPUS vector data is used in a SurvNet project it is important to use Geoid modelling since the control points making up the OPUS solution typically cover a large extents.

Carlson RW5: Carlson SurvCE version 2.0 or higher can store GPS vectors in the RW5 raw data file. Unlike other vector files, these vectors are Antenna to Antenna so the rod height information must be obtained from the RW5 file. This allows you to edit rod heights and re-process the vectors. Additionally, RW5 vectors are always in meters, regardless of the job units.

GeoLab IOB Format: GeoLab's vector format.

Trimble LandXML (*.jxl): Trimble vector files in Land XML format.

Convert Level Files

The purpose of this option is to convert differential level files from digital levels into C&G/Carlson differential level file format. At present the only level file format that can be converted are the level files downloaded from the Topcon digital levels.
EDM Calibration

The EDM Calibration program allows a surveyor to enter and process the raw data collected on an EDM calibration baseline. The purpose of an EDM calibration is to determine if the EDM is measuring within standards. The program performs a statistical analysis of that data as outlined in "Use of Calibration Base Lines", by Charles J. Fronczek, NOAA Technical Memorandum NOS NGS-10. The NGS document can be downloaded from the NGS website. NGS maintains a webpage on EDM Calibration Base Lines. The manual and other information on EDM calibrations can be found at http://geodesy.noaa.gov/CBLINES/calibration.shtml. Following is the main EDM Calibration dialog box. NGS publishes the EDM calibration data in metric units. SurvNet's EDM calibration program currently expects the data to be collected in meters.
The basic flow of this program is to first fill out the lower portion of the dialog box which contains different text fields, EDM constant values, and the optional Atmospheric Corrections settings. Next, fill out the grid in the upper portion of the dialog box. This grid contains the field data collected and also the published distances between monuments of the baseline. After this information has been filled out use the 'Compute' button The program will then display the result of the calibration in the window in the lower portion of the dialog box as follows.

After the file is processed the results can be stored as an ASCII text file. Use the 'Save Output' or the menu option "File/Save Results File As...". to save the results. First, you will be prompted for an output file name. The input data can also be stored. Once stored it can be opened and processed again.

Following is the entire output with a brief explanation of the results. Comments about the results are inserted in bold.

EDM Calibration Report

Observed Data

EDM Type:
Date: Time:
Prism description:
Weather description:
Comment:
The above section shows the input. The input consists of the observed slope distances and the measured HI's. The from and To elevations are published data from the data sheet from NGS on the particular baseline being used. The published distances are also published data from the data sheet from NGS. In this example atmospheric correction was turned off so the temperature and Pressure fields are irrelevant.

Results

Null Hypothesis, HO: EDM scale error and EDM constant error = 0.0

If the scale error and the EDM constant are 0.0 then the edm is without error. So the purpose of the statistical test is to test how close to 0.0 are the results.

Scale Error (ppm): -0.00000044
Constant Error: -0.0032

The two above lines show the values for the computed scale error and constant error.

Scale Standard Error: 0.00000403
Constant Standard Error: 0.0026

The two above lines show the values for the computed standard errors of the scale error and constant error.

Reference Variance: 0.0000126
Scale t-Value: -0.1096
Constant t-Value: -1.2110
Degrees of Freedom: 5
Critical t-Value at the 1 percent confidence level: 4.0320
Cannot reject the HO for the scale error. (The scale factor is 0.0)
Cannot reject the HO for the constant error. (The constant is 0.0)

The above lines show the final results of the statistical test. Since the test determined that we cannot reject the null hypothesis, this edm is in good working order.

EDM Calibrations and Atmospheric Corrections

The atmospheric correction algorithms used in the edm calibration are from the NGS manual. To use this method both dry-bulb and wet-bulb temperature needs to be measured or the vapor pressure, e, and the dry bulb temperature needs to be measured. Refer to the NGS documentation for a detailed explanation of the atmospheric corrections that they use.
It is probably most common to turn atmospheric correction off in the calibration program, and turn atmospheric correction ON on the EDM (total station). When atmospheric correction is turned off in the calibration program the user does not need to enter the temperature into the grid or any of the other atmospheric values. If atmospheric corrections are turned OFF then the grid input columns 'Temp.(dry bulb)', 'Pressure, (mm of Hg)', and 'Temp. (wet bulb)' will not be displayed since they are not needed.

Constants can be entered for both the EDM and the reflector. These values are added to the observed distances during processing. Typically they are set to 0.0.

The following text fields have no effect on any computations and are simply comments that can be used to document the calibration.
Entering Data Into the EDM Calibration Grid

Blank data records are inserted into or deleted from the grid using the following tool bar.

The first button deletes the current highlighted record. The second button inserts a new blank record before the current highlighted record. The third button inserts a new blank record after the current highlighted record. Alternately the 'Edit' menu options could be used to delete and insert new data records.

Following is a brief explanation of the fields that make up the grid.
From Sta. - This field represents the station name where the EDM is located. Any name can be used, but you must be consistent and used the same name whenever you occupy or measure a distance to the station.

From HI. - This field represents the height of instrument of the from station. It should be in the same units as the measurements. If horizontal distances are being entered into the grid then all the HI fields should be set to a constant value such as 0.0.

From Elev. - This field represents the elevation of the station. This value is published as part of the baseline calibration sheets obtained from NGS. If horizontal distances then all the Elevation fields should be set to a constant.

To Sta. - This field represents the station name where the prism is located. Any name can be used, but you must be consistent and used the same name whenever you occupy or measure a distance to the station.

To HI. - This field represents the height of instrument of the to station. It should be in the same units as the distance measurements. If horizontal distances are being entered into the grid then all the HI fields can be set to a constant value such as 0.0.

To Elev. - This field represents the elevation of the station where the prism is located. This value is published as part of the baseline calibration sheets obtained from NGS. If horizontal distances then all the Elevation fields should be set to a constant.

Observed S. Dist. This is the measured slope distance. This can be a measured horizontal distance. If it is a horizontal distance then all the HI's and elevations should be set to a constant value.

Published Dist. This field represents the published distance between the From and To station. This value is published as part of the baseline calibration data obtained from NGS for the particular baseline being observed.

Temp. (dry bulb) This field is only present if atmospheric corrections are turned on.

Temp. (wet bulb) This field is only present if atmospheric corrections are turned on.

Pressure. (mm of Hg) This field is only present if atmospheric corrections are turned on.

Edit Output Files

You can edit any of the output files created by SurvNET processing:
Report File (.RPT)
NEZ File (.NEZ - ASCII coordinate file)
Formatted NEZ File (.OUT - ASCII coordinate file)
Error File (.ERR) - file containing list of processing errors).

SurvNET will use Microsoft Notepad as the editor.

**Edit Level Files**

If you have a .TLV or .LEV level file in your project, this option will run the Carlson Level Editor program and automatically load the level file for editing.

**Export Graphics**

This function will create a proprietary graphic file of the graphic window that can be displayed in Carlson Software.

**View Menu**

**Graphics**

SurvNet provides a window that graphically displays the survey network. Additionally the user is able to display error ellipses, and GPS vectors. The user has much control over how the network is displayed. The graphic tool is a useful tool in debugging networks since the raw data can be displayed prior to adjustment. If there are problems with the raw data the graphics often reflect the problem. The actual graphics cannot be output or saved. The graphics can be shown independent of whether the project has been processed.

The following snapshot shows a view of the graphic window. The graphic window can be accessed using the eye icon on the main tool bar. A project must be opened before the graphic window can be displayed. The graphics window will only display error ellipses after the project has been processed.

The tool bar in the graphics window contains buttons that allow the user to pan, zoom in, zoom out, zoom extents, and zoom to a window. Additionally there is a button that allows the user to navigate to points in the .CGR raw data editor. Also, there are buttons that will refresh the graphic, and change the graphic settings.
Pan:  
Use this button to pan the graphics.

Zoom in:  
Use this button to zoom in on the graphics.

Zoom out:  
Use this button to zoom out on the graphics.

Zoom extent:  
Use this button to zoom to the extents of the graphics

Zoom to window:  
Use this button to zoom to the extents of a user picked window.

Pick Point:  
This button allows the user to navigate within the .CGR raw editor from the graphics window. Currently this button serves no purpose when working with .RW5 data..

Settings:  
This buttons is used to change the graphic display settings.

Refresh:  
This button will refresh the graphic view. Graphics are generated from the saved raw data file. If you make changes to the raw file in the raw editor you must save the file before the changes will be reflected in the refreshed graphic screen.

Following is a description of the options in the graphics setting dialog box, which is accessed using the tool
Points Options

These settings determine how the different type control points are displayed in the graphics window. Different graphic settings can be applied to standard control points, fixed control points and floating control points. The symbol node display can be controlled as to symbol type, symbol color, symbol size. The control point name can be displayed and its size set from this setting dialog box.

The graphic pick radius defines a search radius. This radius is used when navigating the .CGR editor using the graphic window. You can pick a point graphically and the cursor in the editor will go to the next field containing that point number. The radius is defined in terms of the distance units of the raw data file.

![Graphic Settings Dialog](image)

Trav/SS's Options

These settings determine how the network line work will be displayed for total station raw data. There are settings for traverse data, side shot data, and azimuth control. The program considers any point that has only a single angle and distance to it a side shot. The user can control the color of the traverse lines. The symbol node display can be controlled as to symbol type, symbol color, symbol size. The point name can be displayed and its size set from this setting dialog box.
Error Ellipses Options

These settings determine how the error ellipses will be displayed in the graphic window. Error ellipses will only be displayed if there is a successful least squares adjustment. The display of the error ellipses is relative. The program automatically determines a default relative error ellipse size. The user can modify the visual size of the error ellipses using the track bar in the following dialog box. The user can also control the color of the error ellipse from the following dialog box.

GPS Options

The settings in the following dialog box determine how GPS vectors will be displayed in the graphic window. The user can control the color of the GPS vector lines. The symbol node display can be controlled as to symbol type, symbol color, symbol size. The GPS point names can be displayed and their size set from this setting dialog box.
Toolbars

Many of the most commonly used functions can be accessed using the toolbar. Following is an explanation of the buttons found in the toolbar.

Create New Project - New project Icon.

Open an Existing Project - Open file Icon.

Save the Current Project - Disk Icon.

Print One of the Reports - Printer Icon.

Settings - Wrench Icon. This icon initiates the SETTINGS->STANDARD ERRORS tab.

Data Collector Transfer Program - This icon will initiate either the C&G Data Collector Transfer/Conversion program or the Carlson SurvCom program. The C&G program allows you to transfer data from the data collector, or convert the data collector file to a .CGR file format. It supports all major data collectors. The Carlson program connects specifically to the Carlson SurvCE data collector.

Edit Raw Data - This icon can be used to start either the .RW5 raw data editor or the .CGR raw data editor. If your project has multiple raw data files, you will be shown a list and asked to select the file you wish to edit. The appropriate editor will be called depending on what type raw files are defined in the project settings. If no raw file or project has been specified the default raw editor as defined in the Settings menu will be executed. Any changes you make in the editor need to be saved before returning to SurvNet for processing.

Inverse - Icon has a line with points on each end.
Relative Error Ellipses - Icon has a line with points on each end and an ellipse in the middle.

Process Network - Icon that looks like a traverse network.

Graphics - Icon that looks like an eye. This icon is active once a project has been opened.

**Raw Traverse Data**

SurvNet works equally well for both Carlson users and C&G users. The primary difference between the two users is that a Carlson user will typically be using an .RW5 file for his raw data and a C&G user will typically be using a .CGR as the source of his raw data.

SurvNet is capable of processing either C&G (.CGR) raw data files, Carlson (.RW5) raw data files or SDMS (.PRJ) raw data files. If the raw data is in another format, you can use our conversion tools to create one of the supported formats.

Measurement, coordinate, elevation and direction (Brg/Az) records are all recognized. Scale factor records in the .CGR file are not processed since SurvNet calculates the state plane scale factors automatically. The menu option 'Global Settings' displays the following dialog box. If the 'Use Carlson Utilities' is chosen then the .RW5 editor will be the default raw editor and Carlson SurvCom will be the default data collection transfer program. If the 'Use C&G Utilities' is chosen then the C&G .CGR editor will be the default raw editor and C&G's data collection transfer program will be the default data collection transfer program.

Standard errors are estimated errors that are assigned to measurements or coordinates. A standard error is an estimate of the standard deviation of a sample. A higher standard error indicates a less accurate measurement. The higher the standard error of a measurement, the less weight it will have in the adjustment process.

Although you can set default standard errors for the various types of measurements in the project settings of SurvNet, standard errors can also be placed directly into the raw data file. A standard error record inserted into a raw data file controls all the measurements following the SE record. The standard error does not change until another SE record
is inserted that either changes the specific standard error, or sets the standard errors back to the project defaults. The advantage of entering standard errors into the raw file is that you can have different standard errors for the same type measurement in the same job. For example, if you used a one second total station with fixed backsights and foresights for a portion of a traverse and a 10 second total station with backsights and foresights to handheld prisms on the other portion of the traverse, you would want to assign different standard errors to reflect the different methods used to collect the data.

Make sure the SE record is placed before the measurements for which it applies.

If you do not have standard errors defined in the raw data file, the default standard errors in the project settings will be applied to the entire file.

**Carlson Raw Data Editor:**

The raw data editor can be accessed from the tool bar icon. Following is an image of the .RW5 editor. Refer to the Carlson raw editor documentation for guidance in the basic operation of the editor. The following documentation only deals with topics that are specific to the .RW5 editor and SurvNet.

You can insert or Add Standard Error records into the raw data file. Use the INSERT or ADD menu option and select Standard Errors, or pick the SE buttons on the tool bar. Use the 'Add' menu option to insert standard error records into the raw files.
SEc - Control Standard Errors

You can set standard errors for Northing, Easting, Elevation, and Azimuth using the 'Control Standard Error' menu option. Azimuth standard errors are entered in seconds. The North, East and Elevation standard errors affect the PT (coordinate) and EL (elevation) records.

You can hold or fix the North, East and Elevation fixed by entering a "!" symbol. You can allow the North, East and Elevation to FLOAT by entering a "#" symbol. You can also assign the North, East and Elevation actual values. If you use an "*" symbol, the current standard error values will revert to the project default values.

North East Elevation Azim

! ! ! (Fix all values)

# # # 30.0 (Allow the N., E. & Elevation to Float)

0.01 0.01 0.03 5.0 (assign values)

* * * (return the standard errors back to project defaults)

When you fix a measurement, the original value does not change during the adjustment and all other measurements will be adjusted to fit the fixed measurements. If you allow a value to float, it will not be used in the actual adjustment, it will just be used to help calculate the initial coordinate values required for the adjustment process. Placing a very high or low standard error on a measurement accomplishes almost the same thing as setting a standard error as fixed or float. The primary purpose of using a float point is if SurvNet cannot compute preliminary values, a preliminary float value can be computed and entered for the point.

Direction records (Reference azimuths) cannot be FIXED or FLOAT. You can assign a low standard error (or zero to fix) if you want to weight it heavily, or a high standard error to allow it to float.

Example:

North East Elev Azim

CSE ! ! !

PT 103 1123233.23491 238477.28654 923.456
PT 204 1124789.84638 239234.56946 859.275
PT 306 1122934.25974 237258.65248 904.957

North East Elev Azim

CSE * * *

PT 478 1122784.26874 237300.75248 945.840
The first SEc record containing the '! ' character and sets points 103, 204, and 306 to be fixed. The last SEc record contains the '* ' character. It sets the standard errors for point 478 and any other points that follow to the project settings. The Azimuth standard error was left blank.

**MSE - Measurement Standard Errors**

You can set the standard errors for distances, horizontal angle pointing, horizontal angle reading, vertical angle pointing, vertical angle reading, and distance constant and PPM.

"Distance" - distance constant and measurement error, can be obtained from EDM specs, or from performing an EDM calibration on an EDM baseline, or from other testing done by the user.

"PPM" - Parts per Million, obtain from EDM specs, or from performing an EDM calibration on an EDM baseline, or from other testing done by the user.

"Pointing" - total station horizontal angular pointing error in seconds. This value is an indication of how accurately the instrument man can point to the target. For example, you may set it higher in the summer because of the heat waves. Or you may set it higher for total stations running in Robotic Mode because they cannot point as well as a manual sighted total station.

"Reading" - total station horizontal angular reading error in seconds. If you have a 10 second theodolite, enter a reading error of 10 seconds.

"V.Pointing" - total station vertical angular pointing error in seconds. This value is an indication of how accurately the instrument man can point to the target. For example, you may set it higher in the summer because of the heat waves.

"V.Reading" - total station vertical angular reading error in seconds. If you have a 10 second theodolite, enter a reading error of 10 seconds.

Example:
Distance Point Read V.Point V.Read PPM
MSE 0.01 3 3 3 3 5
You can enter any combination of the above values. If you do not want to change the standard error for a particular measurement type, leave it blank.

If you use an "*" symbol, the standard error for that measurement type will return to the project default values.

**SSE - Setup Standard Errors**

These standard errors are a measure of how accurately the instrument and target can be setup over the points.

"Rod Ctr" is the Target Centering error. This value reflects how accurately the target prism can be set up over the point.

"Inst Ctr" is the Instrument Centering error. This value reflects how accurately the instrument can be set up over the point.

"Ints Hgt" is the Instrument Height error. This value reflects how accurately the height of the instrument above the mark can be measured.

"Rod Hgt" is the Target Height error. This value reflects how accurately the height of the prism above the mark can be measured.

Example:
TargCtr InstCtr HI TargHgt
SSE 0.005 0.005 0.01 0.01

You can enter any combination of the above values. If you do not want to change the standard error for a particular measurement type, leave it blank.

If you use an "*" symbol, it will return the standard error to the project default values.

**C&G Raw Data Editor:**

You can set standard errors for control, measurements and instrument setup using the Insert->Standard Error menu option:

![Standard Error dialog box](image)

This will open a Standard Error dialog box:
This dialog allows you to create three types of standard error records: Control, Measurement, and Setup. You need only enter the values for the standard errors you wish to set. If a field is left blank no standard error for that value will be inserted into the raw data file.

You can hold the North, East and Elevation fixed by entering a "!" symbol (as shown above). If you want to fix a point, you can press the Set Fixed Point button and it will place a "!" symbol in each field. You can allow the North, East and Elevation to FLOAT by entering a "#" symbol. You can also assign the North, East and Elevation actual values. If you use an "*" symbol (or press the "Set Project Defaults" button), the current standard error value will return to the project default values.

In the above example, a Control Standard Error record (SEc) will be created:
Below are some sample values for control standard errors:

North East Elevation Azim
! ! ! (Fix all values)
# # # 30.0 (Allow the N., E. & Elevation to Float)
0.01 0.01 0.03 5.0 (assign values)
* * * (return the standard errors back to project defaults)

When you fix a measurement, the original value does not change during the adjustment and all other measurements will be adjusted to fit the fixed measurements. If you allow a value to float, it will not be used in the actual adjustment, it will just be used to help calculate the initial coordinate values required for the adjustment process. Placing a very high or low standard error on a measurement accomplishes almost the same thing as setting a standard error as float or fixed. The primary purpose of using a float point is if SurvNet cannot compute preliminary values, a preliminary float value can be computed and entered for the point.

Direction records (reference azimuths) cannot be FIXED or FLOAT. You can assign a low standard error (or zero to fix) if you want to weight it heavily, or a high standard error to allow it to float.

MSE - Measurement Standard Errors

You can set the standard errors for distances, horizontal angle pointing, horizontal angle reading, vertical angle pointing, vertical angle reading, and distance constant and PPM.

"Distance" - distance constant and measurement error, can be obtained from EDM specs, or from performing an EDM calibration on an EDM baseline, or from other testing done by the user.

"PPM" - Parts per Million, obtain from EDM specs, or from performing an EDM calibration on an EDM baseline, or from other testing done by the user.

"Pointing" - total station horizontal angular pointing error in seconds. This value is an indication of how accurately the instrument man can point to the target. For example, you may set it higher in the summer because of the heat waves. Or you may set it higher for total stations running in Robotic Mode because they cannot point as well as a manual sighted total station.

"Reading" - total station horizontal angular reading error in seconds. If you have a 10 second theodolite, enter a reading error of 10 seconds.

"V.Pointing" - total station vertical angular pointing error in seconds. This value is an indication of how accurately the instrument man can point to the target. For example, you may set it higher in the summer because of the heat waves.

"V.Reading" - total station vertical angular reading error in seconds. If you have a 10 second theodolite, enter a reading error of 10 seconds.

Example:
You can enter any combination of the above values. If you do not want to change the standard error for a particular measurement type, leave it blank. If you use an "*" symbol, the standard error for that measurement type will return to the project default values.

The following SEm record will be created:

**SSE - Setup Standard Errors**

These standard errors are a measure of how accurately the instrument and target can be setup over the points.

"Targ Ctr" is the Target Centering error. This value reflects how accurately the target prism can be set up over the point.

"Inst Ctr" is the Instrument Centering error. This value reflects how accurately the instrument can be set up over the point.
"HI" is the Instrument Height error. This value reflects how accurately the height of the instrument above the mark can be measured.

"Targ Hgt" is the Target Height error. This value reflects how accurately the height of the prism above the mark can be measured.

Example:

You can enter any combination of the above values. If you do not want to change the standard error for a particular measurement type, leave it blank.

If you use an "*" symbol, it will return the standard error to the project default values.

The following SEs record will be created:
There are several other features available in both the Carlson and C&G editors that are useful to SurvNet.

- **Insert Coordinate records from file** - when inputting control into a raw data file, it is more convenient to read the control point directly from a coordinate file than it is to manually key them in. The "Insert Coordinates" function allows you to select points in a variety of manner making it easy to select just control points. For example, you can select points by description, code, point blocks, point number, etc.
- **Data ON/OFF records** - when trying to track down problems, sometimes it is convenient to remove certain sections of raw data prior to processing. The editors have a special record (DO record) that will turn OFF or ON certain areas of data. For example, when you insert a DO record all data following that record will be turned OFF (it will be shown in a different color). When you insert another DO record further down, the data following it will be turn back ON. It is simply a toggle. In the example below, the instrument setup at point 106 backsighting 105 was turned OFF.
On the SurvNET toolbar, the one with the network, and eye icons, you can press the "remove data on/offs" icon and all DO records will be removed from the raw data file, showing the data as it originally existed.

**Graphics and the C&G Editor** - When using the C&G editor the graphics window can be used to navigate within the raw data. To use this feature initiate the graphics window from the C&G Editor.

Press the graphic 'Pick Point' button then pick the desired point in the graphic window. The text editor cursor should move to the next record that contains that point number.
If there is more than one point number within the search radius the following dialog box is displayed so that the desired point can be chosen.
One of the benefits of least squares is the ability to process redundant measurements. In terms of total station data, redundant measurement is defined as measuring angles and/or distances to the same point from two or more different setups.

It is required that the same point number be used when locating a point that was previously recorded. However, since some data collectors will not allow you to use the same point number if the point already exists, the following convention for collecting redundant points while collecting the data in the field is used. If you begin the point description with a user defined string, for example a "=" (equal sign) followed by the original point number, we will treat that measurement as a redundant measurement to the point defined in the description field. The user defined character or string is set in the project settings dialog. For example, if point number 56 has the description "="12", we will treat point number 56 as a shot to point number 12, not point 56. Make sure the Preprocessing Settings dialog box has the Pt. Number Substitution String set to the appropriate value.

Alternately, the point numbers can be edited after the raw data has been downloaded from the data collector.

Supplemental Control Files
In order to process a raw data file, you must have as a minimum a control point and a control azimuth, or two control points. Control points can be inserted into the raw data file or alternately control points can be read from coordinate files. Control points can be read from a variety of coordinate file types:

- C&G or Carlson numeric (.CRD) files
- C&G Alphanumeric coordinate files (*.cgc)
- Carlson Alphanumeric coordinate files (*.crd)
- Autodesk Land Desktop (*.mdb)
- Simplicity coordinate files (*.zak)
- ASCII (.NEZ) file
- ASCII latitude and longitude (3D model only)
- CSV ASCII NEZ with std. errors.
- SDMS (.clt) control file

**ASCII (.NEZ) file**

Typically the standard errors for the control points from a supplemental control file will be assigned from the NORTH, and EAST standard errors from the project settings dialog box. The option 'CSV ASCII NEZ with std.' is the exception. With this option the standard errors are field within the file.

In the ASCII .NEZ file, the coordinate records need to be in the following format:

Pt. No., Northing, Easting, Elevation, Description<cr><lf>
103, 123233.23491, 238477.28654, 923.456, Mon 56-7B<CR><LF>

Each line is terminated with carriage-return <CR> and line-feed <LF> characters.

**ASCII latitude and longitude (3D model only)**

In the ASCII latitude and longitude file, the records need to be in the following format:

Pt. No., Latitude (NDDD.mmssssss), Longitude (WDDD.mmssssss), Elevation (Orthometric), Description<cr><lf>
FRKN,N35.113068642,W083.234174724,649.27<CR><LF>

Each line is terminated with carriage-return <CR> and line-feed <LF> characters.
CSV ASCII NEZ with std. errors.

In the CVS ASCII .NEZ with std. errors file, the coordinate records need to be in the following format: This format is typically created as an output NEZ option. The typical use of this format is if the control for a project was initially created as a project. Then the points from that projects can be used as supplemental control for subsequent projects and the actual standard errors of the control will be used.

504, 204015.23528803, 786760.95695104, 876.15662064, 0.002, 0.003, 0.004, ,1

Each line is terminated with carriage-return <CR> and line-feed <LF> characters.

The major advantage of putting coordinate control points in the actual raw data file is that specific standard errors can be assigned to each control point (as described in the RAW DATA section above). If you do not include an SE record the standard error will be assigned from the NORTH, EAST, and ELEVATION standard errors from the project settings dialog box.

**Warning:** The supplemental control file and the final output file should never be the same. Since least squares considers all points to be control points only control points should be in a supplemental control file. If the supplemental control file has coordinate values for points that are not control points then these coordinate values will still be treated as control.

**SurvNET Editor (CGEditor)**

The CGEditor can be used to edit several types of files or create new ones. You can edit several types of coordinate files, C&G Raw Data files (*.cgr), C&G Point Groups (*.pts), C&G Cross Section files (*.cew), C&G Map Check files (*.cgm) and C&G Template files (*.ctp). The CGEditor has many sophisticated editing tools that make editing fast and relatively easy. Please refer to the CGEditor section of the CG-Survey Tools menu for a detailed explanation of how to use the CGEditor.

**Pulldown Menu Location:** CG-Survey > Tools > CGEditor  
**Keyboard Command:** cg_edit_raw  
**Prerequisite:** None

**Data Collector Transfer**

There are two variables that affect the interaction between your data collector and CG-SURVEY. One is the data collector itself and the other is the software you use in the data collector. This section provides information on the use of data collectors and software that will interact with CG-SURVEY.

**NOTE:** This manual is not a substitute for your data collector manual.

**GENERAL INFORMATION ON USING DATA COLLECTORS**

Before using the data collector program, make sure the correct data collector, communication port and communication parameters have been selected in the Settings dialog box.
Direction of Transfer:

Choose either "Data Collector to Computer" or "Computer to Data Collector".

Data Collector and Computer Transfer Options

The left dialog box pertains to "Data Collect Options" such as file source, file format and the file being transferred. The right dialog box pertains to the Desk Top "Computer Options". Below are instructions for setting both.

Data Collector Options

Pressing the icon will bring up the list of data collectors to choose. From the list select the type of data collector being used.
Use Data Collector:

Check this box to transfer data to/from the data collector. You can also transfer to a file instead of a data collector.

Use Disk File:

Check this box if the data is in computer file. The data must be in the format of the data collector selected.

File Name:

To select the file path click on browse. In the file dialog box specify the path and file name of the file to be opened. select or enter the path and file name of the file desired file.
Transfer Coordinates with Raw:

Some field software allows un-adjusted coordinates to be carried in the raw file as the field data is collected. This gives you the option to transfer this data or not. If you do not want approximate coordinates calculated in the field to be confused with control when processing the raw data, leave this box unchecked.

Computer Information

File type: Choose the file type you are transferring/converting. Example: Raw Data, Coordinate, ASCII, etc.
File Format: C&G will import and export several types of file formats for both Raw and Coordinate files.

Raw Files Coordinate files

Current C&G (*.cgr) C&G Alpha/Num (*.cgc)
Old C&G (*.raw) C&G (*.crd)
OBS (*.obs) ASCII (*.asc, *.txt, etc.)
Geolab (*.iob) Geolab (*.neo)
StarNet (*.dat) StarNet (*.pts)
SDR2x (*.dat) SDR2x (*.dat)
SDR33 (*.dat) SDR33 (*.dat)
Simplicity (*.zak)
LDT (*.mdb)

**Description Table:**

To use a description table check "Use Description Table" box.
You have the ability to use multiple description tables. Examples of that might be:
State DOT
Boundary
As-Built
Topography
Each of these could have different codes and descriptions and this option would allow you to choose which description table to use for the reduction of this file.
To change the description table click the "Browse" button ÖInstructions-depending on the type data collector, type file and direction of transfer, this option will give you step by step directions on how to proceed.

Below is an example of a description table:
Prompts

Instructions: Will guide you step by step through the transfer routine

Current Status
Will indicate the status of the transfer

Transfer:
Once all of the settings are set correctly clicking on this button will begin the transfer between the data collector/file and the desktop.

Settings
At the bottom middle of the main screen is the "Settings" option that allows you set more detailed information as well as set defaults for future use.
Data Collector

This dialog box allows you to select the type of data collector you are transferring to and/or from.

When you select the down button to the right of the data collector shown and the "Show Defaults only" box is unchecked, you will see the complete list of all the data collectors that C&G interfaces with.
You also can create a Default List. This default list should consist of the various data collectors your company may have and/or interface with on an everyday basis.

You can use the Show Defaults only check box to limit the data collectors which may be selected from the Data Collector list on the main Data Collector Transfer Screen. If this box is checked, only those data collectors you have specified for the default list will be show.

To add a data collector to the default data collector list:
First make sure the Show Defaults only box is unchecked.

Next Select a data collector from the list by scrolling up and down the list using the arrow keys.

When the new data collector is selected the Communications Dialog will open and you can set all the default values for the data collector,

Once the settings are correct, click Add DC button

Now click the Save List to save the changes to the list.

When through setting all of the typical data collectors you may use, check the Show defaults only check box and only those instruments and settings will be displayed for your selection.

To remove a data collector from the default list:

Make sure the Show Defaults only is checked.

Highlight the data collector you wish to remove from list

Click on the Remove DC

Click on the Save List button

Chose OK and verify that the data collector is no longer in the default listing.

Communications

The Communication box allows you to set manually the:

Port
Baud rate
Parity
Word length
Stop bits
When a data collector is selected, C&G reads a list of default settings and compares it to the settings currently shown. If the current settings are different than those recommended the defaults will be displayed and a Set Recommended button will be displayed. This allows you to automatically set the recommended communication parameters for your data collector.

The Measurement portions of the Settings dialog box pertains RAW and Coordinate data input, whether entered by hand or transferred by data collector:
Angle Mode........................ Degrees or Grads
Direction Mode..................... Bearing or Azimuth
Azimuth Direction............... North or South
Vertical Input..................... Zenith, Nadir or Horizontal
Distance............................ Foot or Meter
Foot Definition................... U.S. or International
Coordinate Position............. North-East or East-North
Description Length............. 1 to 100 characters

The Description Table portion of the Settings dialog allows you to select the default description table.

As mentioned earlier you can have multiple description tables, here is where you would select the description table to use.
The Use Description Table option, when checked, will replace any integer description found in the raw data file with corresponding description found on the description table. When this check box is not checked data will be transferred as entered.

Default Path for Output Files

Allows you to set the default location for storing transferred files

Receiving Coordinates from Data Collectors
There is a point protection feature in place when bring coordinates into an existing coordinate file from a data collector.
**Transfer Options**

Depending on the type of data collector that you are using, you will be able to perform some or all of the following functions:

- Receive raw data from the data collector.
- Receive raw data from a file.
- Send raw data to the data collector.
- Receive coordinates from the data collector.
- Receive coordinates from the data collector file.
- Send coordinates to the data collector.
- Send a program to the data collector.
- Execute a program on the data collector.
- Delete files on data collector
- View files on data collector

As data is received from a particular data collector or file, it is converted to a .CGR or .CRD file. Data that is sent to the data collector is converted from the .CGR or .CRD format to the data collector format.
Select Points

When transferring coordinates to the data collector this option allows you to choose which points are to be transferred. When you click on the Select Points button the following dialog box comes up.

Change file select from: Click the file button to select the coordinate file that you want transfer coordinates from.

Choose Points: This option allows you to select groups of points to be included from the file you have opened, using the C&G selection options.

All Points: All Points in the file will be selected.
Block: select blocks of Points.

Desc: select points by their description.

Match Case: Match the case of the Text.  
Match Whole Word Only: in the example shown, if this box is NOT checked points with the descriptions BOC, BOC1, BOC2, etc. would all be included. If the box were checked, only points with the description BOC would be included.

Code: select points by Code

Match Case: Match the case of the text  
Match Whole Word Only: in the example shown, if this box is NOT checked points with the descriptions BOC, BOC1, BOC2, etc. would all be included. If the box were checked, only points with the description BOC would be included.
**Elevation:** select points by elevation

**Low Value:**
Point ID: Point Number
Elevation: elevation at point

**High Value:**
Point ID: Point Number
Elevation: elevation at point

If a point number is entered in the point ID box the elevation for that point will be used for either the high or low elevation.

If only an elevation is entered (no point number) the block of points will be selected strictly based on elevation.

**In Radius:** select all the points within a given radius.

If a point number is entered in the point ID box, the northing and easting of that point will be used for the center of the search circle.

To manually enter a northing and easting, leave the Point ID box empty and enter the values for the northing and easting of the circle.

Enter the radius for the search circle, in Feet or Meters.

**In Rectangle:** Select all the points within a given rectangle.

If a point number is entered in the point ID box, the northing and easting of that point will be used for that corner of the rectangle.

To manually enter a northing and easting, leave the Point ID box empty and the northing and easting values.

The two points defined the diagonal corners of the rectangle.

**In Choice:** This option allows you to choose to include or exclude points previously in the C&G select
In the choose points dialog box: select by Desc
Then type: GS as the description
in the choice dialog box: select Exclude
Any point that has "GS" in the description field will be removed from the selection set.

Total selected Points: the total number of points selected is shown in the lower right hand corner of the dialog box.
Default Column Width: the column ID, Northing, Easting, Elevation, Code and Description columns have a default width. If you have changed the widths of the column widths to their original configuration.

The remainder of this section discusses specific data collectors and software.

CG-Field & FieldPlus Data Collectors

Establish a connection between the data collector and desktop computer with a standard 9-Pin serial cable, USB cable, Bluetooth, etc. Check the settings as shown above.

Download a Description Table

You can transfer the desktop description table directly to the CG-FieldPlus data collector. The table will be placed in the data collector's DC_DESC.TBL file. CG-Field will let you use codes without a description table. Simply delete the DC_CODES file from the data collector and use the code numbers to enter descriptions.
When you transfer the file to the desk top, the codes will automatically be replaced with the appropriate description. (This allows you to combine codes.)
For example, if you enter [1 20 30], in the description field on the data collector when the transfer takes place these numbers will be read from the desk top description table and converted to the corresponding description, such as [BL TC SW].
Receiving Raw Data from CG-Field

NOTE: When uploading raw data from a data collector using CG-FieldPlus, a read-only file in the original CG-Field format is created on the computer (in the data directory) with a .R$$ extension.

On the desk top data collection transfer dialog box, set the following:

Set transfer method to Data Collector to Computer.
Data Collector Type: CGFIELD+
Use Data Collector:
Transfer Coordinates with raw: -yes or no (your choice)
File Type: Raw Data
File Format: C&G (*.cgr)
File Name: enter the path where the file is to be stored or click on the "Browse" button and select the path.
Description Table: enter the path where the Description Table is stored or click on the "Browse" button and select the path
Select Transfer when all settings are correct.

On the data collector Utils menu, select:
1:C&G Transfer
2:Send Raw Data
Enter or select the raw data file
The file will be transferred.

NOTE: CG-Field uses only 2-character point codes. If you have CG-SURVEY set for 4-character point codes, the CG-Field file will be converted to a 4-character format but it will still have the correct 2-character code. If you download the same file back to the data collector, the downloaded file will be correct if you did not add any codes that actually consist of 4 characters.

Receiving Coordinate File from CG-Field

On the desk top data collection transfer dialog box, set the following:

Transfer Data Collector to Computer
Data Collector: CGFIELD+
Use Data Collector:
File Type: Coordinate
File Format: C&G (*.crg) or C&G (*.cgc)
File Name: enter the path where the file is to be stored or click on the "Browse" button and select the path.
Description Table: enter the path where the Description Table is stored or click on the "Browse" button and select the path
Select Transfer when all settings are correct.

On the data collector Utils menu, select:
1:C&G Transfer
3:Send Coords
Select Points
All points
Blocks of points
From points file
The file will be transferred.

NOTE: In any transfer routine it is important to prepare and have ready the device that will be receiving data first.

Sending Coordinate File to CG-Field

On the data collector Utils menu, select:
1:C&G Transfer
3:Receive Coords

On the desk top data collection transfer dialog box, set the following:
Transfer: Computer TO Data Collector
Data Collector: CGFIELD+
Use Data Collector:
File Type: Coordinate
File Format: C&G (*.crd) or C&G (*.cgc)
File Name: enter the path where the file is to be stored or click on the "Browse" button and select the path.
Check the Select Points settings:
This tool allows you to select what group or groups of coordinates are transferred to the data collector.
Select Transfer: when all settings are correct.

NOTE: You should not download a file containing a 4-character code to your data collector. You will be warned that the last 2 characters of the code will not be sent. This means that a code of 1584 will be received as 15.

Receiving ASCII File from CG-Field

On the desk top data collection transfer dialog box, set the following:
Transfer Data Collector to Computer
Data Collector: CGFIELD+
Use Data Collector:
File Type: ASCII
File Name: enter the path where the file is to be stored or click on the "Browse" button and select the path.
Select Transfer when all settings are correct.

On the data collector Utils menu, select:
1:C&G Transfer
6:Send ASCII
File Name With Extension
File:
Transfer Name:
******,***
<Enter>
Sending ASCII File to CG-Field

On the data collector Utils menu, select:
1:C&G Transfer
5:Receive ASCII

On the desk top data collection transfer dialog box, set the following:
Transfer Computer to Data Collector
Data Collector: CGFIELD+
Use Data Collector:
File Type: ASCII
File Name: enter the path where the file is to be stored or click on the "Browse" button and select the path.
Select Transfer when all settings are correct.

The following are examples of typical data collection transfer settings. There will be cases with certain models or manufactures where special instructions will be need and C&G will provide those as needed.

There three different dialog boxes involved with data collection transfer:

C&G Data Collection Transfer (shown above)
Settings
Description Table Editor.

The function and settings for each of these is described in detail in the previous pages.

The examples shown on the following pages show transfers directly from and to data collectors. These same transfer routines will also work with files that have been downloaded to the desktop computer.

**File Conversion Utility**

To convert data from files select Use Disc File and either hand enter the path and name or click on "Browse" and search for the file location. These files need to be in the correct data file format.

![Data Collector Options](image)

**Receiving Raw Data**
On the desk top data collection transfer dialog box, set the following:

**Select Data Collector to Computer**
- **Data Collector:** (select data collector from list)
- **Use Data Collector:**
- **Transfer Coordinates with raw:** -yes or no (your choice)
- **File Type:** Raw Data
- **File Format:** C&G (*.cgr)
- **File Name:** enter the path where the file is to be stored or click on the "Browse" button and select the path.

**Select Transfer:** when all settings are correct.
**Begin transfer from data collector**

**Receiving Coordinate Data**
On the desk top data collection transfer dialog box, set the following:

**Select Data Collector to Computer**

**Data Collector:** (select data collector from list)

**Use Data Collector:**

**File Type:** Coordinate

**File Format:** C&G (*.crd) or C&G (*.cgc)

**File:** enter the path to store the file or click on the Browse button and select the path.

**Description Table:** enter the path where the Desc Table is located or click on the Browse button and select the path.

**Select Transfer:** when all settings are correct.

**Begin transfer from data collector**

NOTE: In any transfer routine it is important to prepare and have ready the device that will be receiving data first.

**Receiving ASCII Data**
On the desk top data collection transfer dialog box, set the following:

Select Data Collector to Computer
Data Collector: (select data collector from list)
Use Data Collector:
File Type: Coordinate
File Format: ASCII (*.nez)
File: enter the path to store the file or click on the Browse button and select the path.
Description Table: enter the path where the Desc Table is stored or click on the File button and select the path.
Select Transfer: when all settings are correct.
Begin transfer from data collector

Sending Coordinate Data
Prepare Data collector to receive Coordinate file
On the desktop data collection transfer dialog box, set the following:

**Select Computer to Data Collector**
**Data Collector:** (select data collector from list)
**Use Data Collector:**
**File Type:** Coordinate
**File Format:** C&G (*.crd) or C&G (*.cgc)
**File:** enter the path to file or click on the Browse button and file

Check the **Select Points setting:**
**Select Transfer:** when all settings are correct.

**Sending ASCII File**
On the desk top data collection transfer dialog box, set the following:

Select **Computer to Data Collector**

**Data Collector:** (select data collector from list)

**File Type:** ASCII

**File:** enter the path to store the file or click on the **Browse** button and select the path

**Select Transfer:** when all settings are correct.

**Sending Description Table**
On the desk top data collection transfer dialog box, set the following:

**Select Computer to Data Collector**

**Data Collector:** (select data collector from list)

**File Type:** Description Table

**File:** enter the path to store the file or click on the File button and select the path

**Select Transfer:** when all settings are correct.

---

**SURVCE DATA COLLECTOR**

You can receive coordinates and raw data from the data collector, or send coordinates to the data collector. Make sure SurvCE is selected as the data collector.

**Recieve Coordinates from SurvCE**
On the desktop, click on "Data collector to Computer": select SurvCE as the Type data collector. Set FILE TYPE to Coordinate: and select the desired File Format. 

On the Data Collector, Select FILE >DATA TRANSFER: Choose Carlson/C&G Transfer. 

On the desktop, select BROWSE button next to the FILENAME field: You will see the coordinate files that are on SurvCE. 

Select the File you wish to download: and press OK.
Press the Transfer button. If you do not have a destination FILE NAME selected, you will see the following dialog:

In this case, the file already exists. If you press OK the coordinates will be written to the existing file. Point Overwrite Protection will allow you to select which points you wish to bring in. You can decide individually whether you want to overwrite a point or not, or you can select overwrite ALL points, or you can select to bring in ONLY new points.

A file with the same name and an C$$ extension will also be created with the data that came directly from survCE in survCE’s format. This file is ready-only and can be archived for legal purposes.
Recieve Raw Data from SurvCE

On the desktop, click on "Data collector to Computer": select SurvCE as the Type data collector. Set FILE TYPE to Raw Data: and select the desired File Format. On the Data Collector, Select FILE > DATA TRANSFER: Choose Carlson/C&G Transfer. On the desktop, select BROWSE button next to the FILENAME field: You will see the raw data files that are on SurvCE.
Select the File you wish to download: and press OK.

The selected raw data file will be transferred and converted to the selected format. A file with the same name and a R$$ extension will also be created with the data that came directly from survCE in SurvCE's format. This file is read-only and can be archived for legal purposes.

Send Coordinates to SurvCE
Select Computer to Data collector. Make sure the Data Collector TYPE is set to SurvCE: select the file to be set to SurvCE (N_DRUIDH.crd). If you do not select a destination name, it will be sent to the same named file as the source.

**If you do not want to send ALL the points, but need to select specific point:** press the SELECT POINTS button and choose the point to transfer.

**On the data collector select FILE > DATA TRANSFER:** Choose Carlson/C&G Transfer

**On the Desktop, Press the TRANSFER BUTTON:** The selected coordinates will be transferred.

If the file already exists on SurvCE, you will see the following dialog:

You have the following choices:
Overwrite the existing file
Skip the file (do nothing)
Rename the file
Merge the points.

If you select the Merge option, you will see Carlson’s standard merge dialog:

This dialog allows you to fix all conflicts prior to transferring the points.

**TOPCON DATA COLLECTORS**

Use Topcon cable A-5 if your computer has a 25-pin serial port, or Topcon cable A-16 if your computer has a 9-pin serial port.

When uploading raw data from a Topcon/TDS data collector, a read-only file in the original data collector format is created on the computer (in the data directory) with a .R$$ extension.

When you send the description table to a Topcon/TDS data collector, only the first 999 descriptions will be sent.

**FC1 DATA COLLECTOR**

For the transfer program to be able to access any data in the FC1, it must be stored in the FC1 using the Program 2 supplied with the FC1 transfer software.
First locate the necessary cables to connect the FC1 to your computer. (your dealer should be able to help you with this).

**NOTE:** Currently, the only programs that are supported are ET1 and GTS3, which are supplied with the system.

Follow these instructions:
Select either ET-1 or GTS-3 when prompted.
Once you have loaded Program 2 into the FC1, you may enter your field data in either of two ways. The first way, is by connecting the FC1 to your total station and let the total station record angular and distance measurements for you by using the ET1 (GTS3) section of the FC1 program. The other way is to use the Manual Entry section of the program to store all of your field data directly through the FC1's keyboard.

### Collecting Data using the FC1

(The following steps will be followed no matter which data entry method you use):

1) Set up data recording mode in the FC1.
2) Enter job information: job name, operator, instrument number, date, temperature, pressure.
3) Enter instrument point information: point number, H.I., backsight point, angle in instrument to backsight.
4) Enter foresight point information: point number, rod height, horizontal and vertical angles, distance.
5) If there are other foresights from the same instrument point, repeat step 4; or if you have another instrument setup, go to step 3; or if you are through, go to the end of the program.

**NOTE:** Never press the `<skip>` key when the FC1 is asking for data. Only use the `<skip>` key to by-pass "go to" options (see step 5 below).

### Automatic Recording of Data

1) To set up the recording mode, have the FC1 connected to the ET1 (GTS3), and turned on. Wait until the left side of the display says READY.

If the right side of the display says PRG >2, then you are ready for step 1A.
Otherwise, press these keys: `<func>`, `<#>`, `<Enter>` and then go to step 1B below.

A) Press the `<F1>` key.
B) When the display says GOTO 7 ET1-PROG? ("GOTO 7 GTS3-PRG"), press the `<Enter>` key.
2) Enter any name you want for the job-id:
Enter the name of the operator.
Enter the instrument number.
Enter the date, temperature, and pressure.
3) Sight the backsight point with the instrument:
Enter the instrument point number.
Enter the instrument height (H.I.).
Enter the backsight point number.
Press `<Enter>` for the rod height.
Press `<Enter>` when the display says REC MODE 2 (REC V/H< MODE? on GTS3).
When the display says MODE>, press <2> and the ET1 should send angular information to the FC1.
4) Turn to the foresight.
   Enter the foresight point number, and press <Enter>.
   Enter a description for the foresight and press <Enter>.
   Enter the foresight rod height and press <Enter>.
When the REC MD3-DR/2R (REC SD/V/HMODE?) message appears, press <Enter>, then choose mode 3 if you are entering a direct angle.
   If this is your second angle to that foresight, then you may use mode 2 to record angles only.
5) After step 4, then you should see this message in the display: GOTO 18 FS.PT#?. If you wish to turn more angles from the current instrument point, then press <Enter>, and go back to step 4.
   -or-
   Press <Skip>. The next message will be GOTO 13 INST.PT? If you want to record another instrument set-up, then press <Enter>.
   -or-
   Press <Skip>. The next message is, GOTO 8 OPER.? To change operators, press <Enter>, and go to step 2.
   -or-
   Press <Skip>. The next message is, GOTO 53 END? To end input for this job, press <Enter>.

Steps on Manual Recording of Data

1) To set up the recording mode, have the FC1 turned on. Wait until the left side of the display says READY.
   If the right side of the display, says PRG>2 then you are ready for step 1A.
   Otherwise press these keys: <func>, <#>, <Enter> and go to step 1B.
   A) Press the <F1> key.
   B) When the display says GOTO 7 ET1-PROG? (GOTO 7 GTS3-PRG): press the <skip> key.
When the display says GOTO 30 MANUAL?: press the <Enter> key.
2) Enter any name you want for the job-id:
   Enter the name of the operator:
   Enter the instrument number:
   Enter the date, temperature, and pressure:
3) Enter the instrument point number:
   Enter the instrument height (H.I.).
   Enter the backsight point number:
   Enter the rod height if desired:
   Enter the angle in the instrument: when the backsight was taken.
   Enter the vertical angle and distance: if desired.
4) Turn to your foresight. Enter the foresight point number, and press <Enter>.
   Enter a description for the foresight and press <Enter>.
   Enter the foresight rod height and press <Enter>.
   Enter the horizontal angle, slope distance, and vertical angle to the foresight.
5) After step 4, then you should see this message in the display: GOTO 43 FS. PT#?
   If you wish to turn more angles from the current instrument point, then press <Enter>, and go back to Step 4.
   -or-
   Press <Skip>. The next message will be GOTO 36 INST.PT? If you want to record another instrument set-up, then press <Enter>.
   -or-
   Press <Skip>. The next message is GOTO 31 OPER.? To change operators, press <Enter>, and go to step 2.
   -or-
Press <Skip>. The next message is GOTO 1 MENU? To go to the menu for another job, press <Enter>.
-or-
Press <Skip>. The next message is END. Press <Enter> to end entry for this session.

Receive Data from FC1

Once you have your data stored in the FC1, you must upload it to the computer.

Select the Receive Raw Data function. If you have already dumped the data stored on the FC1 to a computer file (in the Topcon format), you may choose to receive the data from the file. Enter the file name that contains the data, and the file name for the .CGR file.

**NOTE:** To power your FC1 while sending data to the computer, you must plug the power cable into the signal port at the top of the FC1 and toggle the FC1’s power switch to EXT.

TOPCON PROPAC DATA COLLECTOR

To enable the Propac to collect raw data in a format suitable for CG-Survey's data transfer program, the CG program must be installed on the 71B. To load the software: connect the Propac to the computer com port.

Follow the directions to download.
You may store the CG program in a freeport on the 71B. This has several advantages, the main one being it will not be lost if the batteries die.

Under the Propac options choose Load CG Program Into Propac.

**On the 71B:**
Type Freeport(.01) and key <Endline>.
Type COPY CG TO :PORT(.01) and key <Endline>.

**For ROM Versions Prior to 1.75**
Type DEF KEY ‘f7’,"USER @ RUNCG": and key <Endline>.

**For ROM Versions 1.75 or Later**
Type DEF KEY ‘f7’,"USER @ CONT PRGM2": and key <Endline>.

This will set up the raw data collection program to run on the Propac when the yellow function key and the <7> key are pressed. Unless something happens to the 71B, you should not need to reinstall the CG-Field program again.

Now delete the CG-Field program from the main memory of the Propac by typing PURGE CG:MAIN and key <Endline>. The program is still stored in the freeport.

To use the CG-RAW data program, turn the Propac on and type RUN PRO then key <Endline>. From the KEYS prompt press the yellow function key then the <7> key. This will start the CG program, then just follow the prompts.

---

**Chapter 19. SurvNET**
The CG raw data program is the only one needed on the Propac other than the Propac options already available. If you are collecting coordinates and elevations instead of raw data, simply follow the Propac instructions.

To transfer the collected data to and from the computer, choose the Propac option you wish and follow the directions on the screen.

If you have already downloaded the data stored on the Propac to a computer file (in the Propac format), you may choose to receive the data directly from the file. Enter the file name that contains the data, and the file name for the .CGR file (raw data file) or .CRD file (coordinate file).

**FC-4 DATA COLLECTOR**

The C&G data collector transfer program can accept data that was collected from the FC-4 in either the traverse mode or topo mode. It can receive coordinates from the FC-4 and also send coordinates to the FC-4 for stakeout. The CG data collector transfer program supports most the valid methods of collecting data in the traverse or topo mode of the FC-4 (including the ability to collected direct and reverse angles). Refer to the FC-4 users manual to learn the different methods of data collection supported by the FC-4.

**Special Features - When translating the FC-4 file to a raw data file using the C&G data collector transfer program:**

1) If an FC-4 record is not used, the record will be placed in the raw data file as a comment with the message Not Used appended. No FC-4 record will be ignored. For example, *123 Not Used
2) Remarks ("R" records) will be placed in the raw data file as a comment record.
3) Coordinates will be placed in the raw data file as a coordinate record, (C 23 10000.0000 10000.0000 923.24 'TP).
4) When using the FC-4 Benchmark function, the following will be placed in the raw data file:
   A) The benchmark coordinates.
   B) The measurements to the benchmark as a foresight point.
5) When using the FC-4 Angle-Offset function the following will be placed in the raw data file:
   A) A comment line saying the next line is an angle/offset and showing the 1st and 2nd angle recorded to the point.
   B) A foresight record combining the first distance measurement and the 2nd angle measurement.
6) When using the FC-4 Distance-Offset function the following will be placed in the raw data file:
   A) A comment line saying the next line is a distance/offset and showing the slope distance, vertical angle and offset distance measured to the base point.
   B) A foresight record with a new slope distance and vertical angle calculated from the above information.
7) When using the FC-4 Perpendicular-Offset function the following will be placed in the raw data file:
   A) The foresight record to the base point.
   B) A comment line saying the next line is a perpendicular offset and showing the offset forward/backward, the offset left/right and the offset up/down.
   C) A foresight record with a new horizontal angle, slope distance and vertical angle calculated from the above information.

**NOTE:** If there is no left/right offset, data will not convert correctly to a CG-SURVEY raw data record. For example, if the Perpendicular Offset routine is used to locate a point away from the instrument but on the same
line, the resulting data record will use the wrong horizontal angle.

8) Backsight azimuths are transferred to the .CGR file as reference azimuths.

When a file is first created on the FC-4 the user will be prompted for some header information. When the data is transferred to the computer, the C&G data collection transfer program will use the job-id as the file name for the raw data file created on the computer.

To prepare the data collector and computer for data transfer, connect the A-5 or A-16 cable to the serial port of the FC-4 and to the appropriate serial port of the computer. Make sure the correct data collector comm port has been chosen in Settings Dialog.

Choose the appropriate menu option on the FC-4, then follow the instructions and answer the prompts as they appear on the screen. Once the raw data has been downloaded into the computer the raw data can be edited, reduced and printed out from the Traverse/Input Edit program.

If you have already downloaded the data stored on the FC-4 to a file on the computer, you can transfer the data using the "Use Disc File" command

**TOPCON and TDS**

**Transferring Data**

On the C&G Data Collector Transfer screen set the data collector option to:

![Data Collector Options]

Check Settings to make sure all options are set correctly
Note: See opening section of this chapter for detailed instructions on the Settings dialog box and on sending and receiving files.

Sending Description Table to 48

When sending the description table (DC_CODES file) to the 48, the following occurs:
A new file (DESCRIPT.TXT) is created in the data directory on the computer.

The first 200 descriptions are duplicated from the DC_CODES file.
After that, the first 100 descriptions are reproduced 7 times with the following mapping codes preceding the descriptions:
201 - 300 BL*(DESC)
301 - 400 EL*(DESC)
401 - 500 CL*(DESC)
501 - 600 CF*(DESC)
601 - 700 OC*(DESC)
701 - 800 PC*(DESC)
801 - 900 PT*(DESC)
The DESRIPT.TXT file is then sent to the 48.

TOPCON CR2 CARD READER
Data collected and stored using the Topcon Card Reader is in the same format as data on the FC-4. All data format rules for the FC-4 apply here.

Set-Up
Card Read Preparation. Before using the card reader it is necessary to set the two DIP switches on the bottom of the unit to the settings described below. The direction on the switch which is marked 'OFF' is really a '1'. You should read the attached label, not the switches.

The CR2 should be set as follows:
Baud: 19200
Parity: None
Stop Bits: 1
Word: 8
SW1 DIP Switch: Set the communication parameters

SW2 DIP Switch: Sets other parameters
Use the interface cable supplied with the CR2 unit and plug it into the comm port on the computer. Make sure you select the Topcon CR2 data collector and the correct comm port.

The Card Reader program allows:

1) Receive raw data from the CR2 or from a CR2 file.
2) Receive coordinates from the CR2 or a CR2 file.
3) Send coordinates to the CR2.
4) Send or receive a description table to CR2.
5) Receive description table.
6) Send or receive ASCII files from the CR2.
7) Send an executable (EXE) file to the CR2.
8) Catalog (or directory) of all files on CR2.
9) Delete files on the CR2.
10) Format cards for the CR2.

Receiving Data from the CR2

You may receive raw data files (.R), coordinate files (.N), ASCII files or description table from the CR2. All files on the CR2 of the type you wish to receive will be shown on the screen

Raw Data
Coordinates
ASCII
Description Table

Receiving Data from a CR2 File

If you have already downloaded the data stored on the CR2 to a file on the computer, you may choose to receive the data from the file.

Sending Data to the CR2

You may send coordinate (.CRD) files, ASCII files, EXE files or description table to the CR2. Select the file you wish to send.

You may not send a file to the card reader that already exists on the CR2. You must delete the file first. The .CRD files will be converted to .N files. ASCII files will be transferred without conversion, (make sure the file you are transferring is a true ASCII file).

EXE files
Programs with .EXE extensions can be transferred to the CR2. These files will be transferred with a .X extension.

Note: See opening section of this chapter for detailed instructions on the Settings dialog box & information on sending and receiving files.
Catalog: The catalog function will show you all existing files on the Topcon Card Reader.
Deleting Files: All files on the CR2 will be shown on the screen. Select the file you wish to delete. Be careful, once the file is deleted it is gone forever.
Format: The format function will allow you to format a card, making it ready to accept (store) data. If the card is already formatted, you will be warned that all information on the card will be lost, be careful.

SOKKIA (LIETZ) SDR2 DATA COLLECTOR

General Information

Use the cable supplied with the SDR2 data collector to plug into your computer's serial port. When uploading or downloading to or from the computer, turn the switch on the cable toward the word PRINTER. If this does not work, turn the switch toward the word COMPUTER and try again. If you still have trouble please call us.
In order to use the Lietz SDR2 data collector with the transfer program, there are 4 areas that you must consider: (1) Entering data into the data collector in a format that can be sent to your computer, (2) the transfer program itself, (3) sending calculated coordinates back to the data collector, and (4) the data collector code conversion table which converts numeric codes for points into English-language descriptions as the data is sent to the computer.
Sokkia (Lietz) data collectors allow you to enter attribute data. To use attribute data with CG-SURVEY, it must be appended to the description records in the following format:
DESCRIPTION [attribute name] attribute

For example: PIPE [Diameter] 18"

Entering Data into the Data Collector

Note: that all of the following assume that you have a Getting Started book and Operator's Manual from the Lietz Company.

1) To begin a new job, press <clear> until Select operation appears in the display. Press the <Menu> key. When JOB appears in the display, press <Enter>, and enter the job name and scale factor.
2) To enter field data, press <clear> until Select operation appears in the display. Press the <Prog>. When Traverse appears in the display, press <Enter> and begin traversing.
2a) You may use the TOPO program rather than the Traverse program. If you use this program, you must use the R option when sending data to your computer. The "Transferring Field Data to the Computer" section of this contains more about this.

Note: The coordinates that you enter for the first instrument point are for the internal use of the SDR2, and can be changed when your field data gets to the computer.
Note: When recording your first backsight information, simply enter an azimuth
from the instrument point to the backsight (0.0000 will do). The azimuth information is also only used internally in the SDR2. You can change all of that as you reduce your field notes on the computer.

**Note:** At each instrument setup, the first angle recorded must be to your backsight. Your instrument may be "zeroed" or not, but when the Traverse Reduction program runs, it will subtract the backsight angle from the foresight angles.

**Transferring Field Data to the Computer**

If you have already dumped the data stored on the SDR to a computer file (in the SDR format), you may choose option to receive the data from the file. Enter the file name that contains the data, and the file name for the .CGR file (raw data file) or .CRD file (coordinate file).

Before data can be transferred in either direction between the computer and the SDR2, you must set up the transfer parameters in the SDR2. Once these have been set, they will not change, until you change them again. You do not have to set them each time. (The only parameter that you may wish to change is the baud rate.)

In our tests, the computer can receive data from the SDR2 at 4800 baud, its fastest speed, but the SDR2 could only receive points at 1200 baud. For fastest transmissions to and from the SDR2, you might wish to change this parameter in the SDR2.

The SDR-22 and SDR-24 data collectors will send to the computer at 9600 baud and receive data from the computer at 4800 baud.

1) Set up parameters by pressing `<clear>` until the message *Select operation appears in the SDR2 display.* Then, press `<Menu>`. Press the up or down arrow until Parameters appears in the display, then press `<Enter>`. You can then go from one parameter to the next by pressing the up or down arrows. When a parameter you wish to change shows on the display, press the `<Edit>` key, and change it. (See the SDR2 operator's manual.)

**These parameters must be in effect:**

- **Baud:** 4800 (or 1200 for sending to the SDR2, see above discussion.)
- **Parity:** not set
- **Word length:** 8
- **Checksum:** N
- **Coords:** N-E-Elev

2) After the parameters have been set, simply connect the SDR2 to the computer, and select the transmission option. (On the Lietz transfer cable, there is a switch that must be set to DTE.)

3) Choose the same baud rate at the computer as you selected in the SDR2 parameters. When the computer says *Waiting for data...*, press `<clear>` on the SDR2

---

*Chapter 19. SurvNET*
until Select operation shows in the display window. Press the <Menu> key. Press an up or down arrow key until Comms output shows in the display, then press <Enter> on the SDR2. Answer <N> if you do not wish to send all jobs. Then enter the job that you do wish to send. (See the SDR2 manual for a complete discussion of this process.)

4) **The SDR2 should then send its information to the computer.**

**Note:** As each job record is encountered in the computer will ask you for a file name to store the data in. You may press <Enter> to use the same name as was used in the SDR2 or enter another name. You must use a valid DOS name (all numbers and letters of 8 or less characters will be fine.)

Attribute data collected by the SDR (13AT records) is appended to the descriptions as follows: DESC[Attribute Name]Attribute

Example: PIPE[diameter]18"

---

**Transferring Coordinates to the SDR2**

Be careful of the units when transferring coordinates. For example, if the SDR2 is set to Metric Mode, the SDR2 will automatically convert the coordinates from feet to meters. Before you can transfer coordinates to the SDR2, you must first set up the transfer parameters in the SDR2. Refer to the first part of the previous section for details about how to do this. Then:

1) **Ready the SDR2 by pressing <clear> until Select operation appears on the display.** Press the <Menu> key. Then press the up or down arrows until Comms input appears on the menu. Press <Enter>.
2) **Select the Send Coordinates option and press Transfer.**
3) **Select the coordinate file on the computer.**
4) **Choose which coordinates to send.**

---

**SOKKIA (LIETZ) SDR33 DATA COLLECTOR**

The SDR33 works the same as the SDR2. In Equipment Options there are two SDR33 choices, because when creating a new job on a SDR33 the format is determined by setting the Point ID field to Numeric (4) or Alpha (14).

---

**SDR33 4-Pt**

To transfer data to CG-SURVEY, select this setting if your SDR33 is set to Numeric (4). The highest point number allowed is 9,999.

---

**SDR33 14-Pt**

---

*Chapter 19. SurvNET*
The C&G *.cgc files allow 10 character Alphanumeric point numbers. While C&G *.crd files allow only 5 digit numeric point numbers.
To transfer a SDR33, set to Alpha (14), the file format setting must be set to *.cgc.

Note: See opening section of this chapter for detailed instructions on the settings dialog box and on sending and receiving files.

LEICA (WILD) GRE3/GRE4 AND GIF-2 INTERFACE

Set Up for GRE3/GRE4

Select the Wild: GIF-2 under Equipment Options. Before transferring data from the GRE3/4 to your computer, you must first set up the transfer parameters in the GRE3. To do this follow these steps on the GRE3/4:
1) \(<\text{Set}\> <\text{Mode}\> <7> <0> <\text{Run}\> <4> <8> <0> <\text{Run}\> <\text{Run}\>
(Sets the baud rate to 4800. If you wish, you may leave it at 2400, which is the rate the T2000 needs to communicate with the GRE3/4.)
2) \(<\text{Set}\> <\text{Mode}\> <7> <1> <\text{Run}\> <2> <\text{Run}\> <\text{Run}\>
(Sets even parity.)
3) \(<\text{Set}\> <\text{Mode}\> <7> <2> <\text{Run}\> <1> <\text{Run}\> <\text{Run}\>
(Use protocol.)
4) \(<\text{Set}\> <\text{Mode}\> <7> <3> <\text{Run}\> <0> <\text{Run}\> <\text{Run}\>
(<\text{CR}\> only.)
5) \(<\text{Set}\> <\text{Mode}\> <7> <4> <\text{Run}\> <2> <\text{Run}\> <\text{Run}\>
(ACK/NAK + <\text{CR}\>.)
6) \(<\text{Set}\> <\text{Mode}\> <4> <0> <\text{Run}\> <4> <\text{Run}\> <\text{Run}\>
(DDD.MMSSS).
7) \(<\text{Set}\> <\text{Mode}\> <4> <1> <\text{Run}\> <1> <\text{Run}\> <\text{Run}\>
(Feet).
8) \(<\text{Set}\> <\text{Form}\> <.> <\text{Run}\> <\text{Rec}\>
(for the T2000)
-or-
\(<\text{SET}\> <\text{FORM}\> <+/-> <.> <\text{RUN}\> <1> <1> <\text{RUN}\> <\text{REC}\>
(for the T1000)

**Note:** The above parameters do not "go away" when the GRE3/4 is switched off. They will stay the same until you change them or re-initialize everything.

**Note:** See opening section of this chapter for detailed instructions on the Settings dialog box & information on sending and receiving files.

---

**Switch Settings/Cable**

**Option 1**
GIF-2 Switches Cable Configuration
= X GRE-3/4 Computer
S1 < 2 < 3
S2 < 3 < 2
S7 < 7 < 7
5 <
(Jump 5, 6, 8, 20) 6 <
8 <
20 <

**Option 2**
GIF-2 Switches Cable Configuration
= X GRE-3/4 Computer
S1 < 2 < 3
S2 < 2 < 2
S7 < 3 < 7
7 <
Data Collection Format for GRE3, GRE4, GIF-10

The transfer program expects your data to be in a specific format. To get your data in this format, follow these steps.

1) To begin a new job enter a "CODE 1" block into the GRE3/4.
Example:
RDY [CODE]
CODE [1]
I1 ? [RUN]
your job number (Example: 87001)
[RUN]
I2 ? job date (Example: 091687 for Sept. 16, 1987)
[RUN]
I3 ? [REC]

2) Define the first automatic point number for your first foresight.
Example:
RDY [SET]
SET [NR0]
S NR [2] for point number 2 as first foresight.
[RUN]

3) At each instrument point, enter a "CODE 2" block into the GRE3/4.
Example:
RDY [CODE]
CODE [2]
[RUN]
[RUN]
I2 ? [instrument height] EX: [550] for 5.50 feet.
[RUN]
I3 ? [REC]

Note: Each instrument point "CODE 2" block must be followed by a measurement reading to your backsight. You will probably need to change the point number for the backsight by:

RDY [NR]
NR [point number] EX: 4 for backsighting point 4.
[RUN]
THEN:
RDY [MEAS]
REC [REC]
-or-
4) **Record your foresights. If necessary, change the rod height and/or the description of the foresight.** Use “CODE 3” or “CODE 4” to do this. Both codes are essentially the same, but one asks for the description first and the other asks for the rod height first, allowing you to skip the second entry by pressing [REC] rather than entering a value (see the third example below). This step may be skipped if you do not wish to change either rod height or description from the previous entry.

**Example 1:**
RDY [CODE]
CODE [3] Code 3 = description, rod height
[RUN]
I1 ? [0][1] Description = 01 (must be 2 digits)
[RUN]
I2 ? [5][5][0] Rod height = 5.50 feet
[RUN]
I3 ? [REC]
See following section on Setting-up Description Codes.

**Example 2:**
RDY [CODE]
[RUN]
I1 ? [5][5][0] Rod height = 5.50 feet
[RUN]
I2 ? [1][0] Description = 10 (must be 2 digits)
[RUN]
I3 ? [REC]

**Example 3:**
RDY [CODE]
CODE [3] Code 3 = description, rod height
[RUN]
I1 ? [1][2] Description = 12 (must be 2 digits)
[RUN]
I2 ? [REC] (leave the rod height the same)

5) **Take your measurement (make sure that the point number is correct first):**
RDY [MEAS]
REC [REC]

6) **Now, go to step 4 for another foresight or to step 3 for another instrument set-up:**

**Uploading from Data Collector to the Computer**

If you have already dumped the data stored on the GIF-2 to a computer file you may
choose to receive the data from the file. Enter the file name that contains the data. After you have collected your field data, connect the GRE3/4 to your computer. Then select the receive option on the computer. The baud rate in the computer must match the baud rate in the GRE3/4. After selecting the baud rate on the computer, follow the steps on the screen to initiate transmission.

Those steps are:
1) **Connect the GRE-3/4 to the computer, turn it on,** and wait for RDY to show on the display.
2) **Put the GRE-3/4 in upload mode by pressing** `<Data>` **on the GRE-3/4.**
3) **Press** `<GoTo>`, `<Run>`, and wait for the GRE-3/4 to display D CD.
4) **Press** `<Send>` **and press** `<Run>` **on the GRE-3/4.**

After the computer detects the end of transmission, it will begin to format the data in a usable form. When each job record is encountered (CODE 1), you will be prompted to give the computer the name that you want to enter the file name for that job.

### Sending Coordinates to the GRE-3/4

From the Menu, select the send coordinates option.
The baud rate in the computer must match the baud rate in the GRE3/4. Initiate transmission on the GRE-3/4 by doing the following:

**Note:** See opening section of this chapter for detailed instructions on the Settings dialog box & information on sending and receiving files.

1) **On GRE-3/4, SET MODE 80** `<Run>` **2 `<Run>` `<Run>` to select file 2.
2) **On GRE-3/4, SET MODE 81** `<Run>` `<blocks>` `<Run>` `<Run>` to dimension file 2.
3) **Press any key to continue:**
4) **Next, select the points you wish to send:** The transmission will begin.

### LEICA (WILD) GIF-10 INTERFACE

**Note:** (Refer to data collection format GRE3 within this section)

### Receiving Raw Data from GIF-10 Interface:

Select the receive raw data option on the computer.
If you have already dumped the data stored on the GIF-10 to a computer file (in the Wild format), you may choose receive the data from the file. Enter the file name that contains the data.

The baud rate in the computer must match the baud rate in the GIF-10. Do the following
1) Set the comm parameters as follows:
Baud: (your choice)
Parity: EVEN
Protoc: ACK/NAK
Stop Bit: 2
End Mark: CR
Connected AS: DTE
2) Put the GIF-10 in upload mode by selecting <Send> on the GIF-10.
3) Press <Run> on the GIF-10 and select the file you wish to send.
4) Press <Run> on the GIF-10.

Sending Coordinates to the GIF-10 Interface:

Select the send coordinates option.
The baud rate in the computer must match the baud rate in the GIF-10.
Do the following on the GIF-10:
1) Create receive file in GIF-10 now.
2) Put the GIF-10 in download mode by selecting Receive on the GIF-10.
Select the points you wish to send. The transmission will begin.

Note: See opening section of this chapter for detailed instructions on the Settings dialog box & information on sending and receiving files.

LEICA (WILD) GIF-10/WS

This is a Wild GIF-10 interface that will accept data in the same format as WildSoft. You will be asked for the Observation Pattern when the file is transferred. This pattern can be either BS-FS-FS-BS or BS-FS-BS-FS. As with WildSoft, codes 101 and above will be treated as descriptor codes. Code 100 will be subtracted from the descriptor code and that description will be read from CG-SURVEY’s description table. So 101 is description 1, 102 is description 2, and so forth.

The following table shows acceptable WildSoft data collection codes:

WildSoft Data Collection Codes

<table>
<thead>
<tr>
<th>Code</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Start Job</td>
</tr>
<tr>
<td>2</td>
<td>Occupy a Point</td>
</tr>
<tr>
<td>3</td>
<td>FS to Traverse Point</td>
</tr>
<tr>
<td>11</td>
<td>Assign Coordinates</td>
</tr>
<tr>
<td>13</td>
<td>Target Height</td>
</tr>
<tr>
<td>14</td>
<td>Add to Target Height</td>
</tr>
</tbody>
</table>
LEICA (WILD) GIF-10/WS2

This is the exact same interface as the GIF-10/WS except 100 is not subtracted from the descriptor code.

LEICA (WILD) GIF-10/TOPOS

This is a Wild GIF-10 interface that will accept data in the same format as the Canadian software TOPOS. To select this format, choose GIF-10/TOP from the data collector choices in the Equipment Options. The following information explains the format.

These six Wild codes are used:

<table>
<thead>
<tr>
<th>Code</th>
<th>Field 1</th>
<th>Field 2</th>
<th>Field 3</th>
<th>Field 4</th>
<th>Rectype</th>
</tr>
</thead>
<tbody>
<tr>
<td>91</td>
<td>Job Name</td>
<td>Date</td>
<td>Temperature</td>
<td>Pressure</td>
<td>New Job</td>
</tr>
<tr>
<td>10</td>
<td>Label #</td>
<td>HI Instrument Pt.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>Label #</td>
<td>RH Backsight Pt.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>30</td>
<td>Label #</td>
<td>RH Trav. Pt.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>40</td>
<td>Label #</td>
<td>RH Side Shot Pt.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Label #</td>
<td>RH Offset Angle SS</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1) If RH (rod height) is 999 it will be considered no value (do not calculate elevation for this point).
2) The Label# (point description number) can contain up to eight characters. The first four and last four will be read as separate descriptions. For example, if Label# is 00210034, then description 21 will be pulled from the description table and description 34 will be pulled from the description table. If 21 is BL* and 34 is TC, then the resulting description will be BL* TC.
3) Point numbers are taken from measurement records. A measurement record will follow code 10, 20, 30, and 40 records. For example: In this example, there is a side-shot record (40), a point label description (71), a rod height (2.150), and a point number (332).
4) If an offset distance is placed in Field 3 of a side-shot record, the measured angle will be shown in a comment line prior to the data record with the newly calculated angle.
5) If a comment is placed in field 4 of a side-shot record, the comment will be appended to the point's description. Example: If the label# is 25 and the comment is 150, description 25 (lets say TREE) will be pulled from the description.
You are allowed to read and write to the Leica Data Pro formatted GSI files. There is no communication directly with the Leica Total stations.

GEODAT 122/124 DATA COLLECTOR

In order to use the Geodat 122 or 124 data collector with the transfer program, there are three areas that you must consider: (1) entering data into the data collector in a format that can be sent to your computer, (2) the transfer program itself, and (3) the data collector code conversion table which converts numeric codes to more readable descriptions when the data is sent to the computer. The following section describes how to enter your data into the data collector. The next section will then give you some information about how to transfer the data. The data collector code conversion table can be changed with menu selection E from the program menu.

Entering Data into the Data Collector

1) Each individual job stored in the Geodat's memory should begin with a job identifier. To enter a job identifier, follow these steps:
   a) Press the <Info> key.
   b) At the prompt "inFo=" enter a job number, like this: inFo=87001<Ent> (meaning to press the <Ent> key.)
   c) At the prompt "dAtA=" enter the date like this: Example: dAtA=050187<Ent> (for 05/01/87)

2) For each instrument location, you must enter an instrument point identifier.
   Follow the following steps to do this:
   a) Press the <Stn> key.
   b) At the "Stn=" prompt enter you instrument point number like this: Stn=1<Ent> (for instrument point 1)
   c) At the "iH=" prompt enter the instrument height, like this: iH=5.5<Ent> (for 5.5 feet)

   d) Next the prompt "PCod=" will appear on the display. At this time, enter your backsight point, just like the foresights in the next step. You may enter "0" (zero) for all of the fields except:
      "Pno=" (enter the backsight point number)
      "Hor=" (enter the angle in your instrument when you take the backsight.)
   3) Recording foresights. You are now ready to record a foresight:
      a) At the "PCod=" prompt enter the point code for your foresight like this: PCod=10<Ent> (for point code 10)
Note: The point code will be used to assign a description to your foresight. The description that is associated with each code is up to you. Use the "Edit data collector code table" program to set up your codes before uploading your data to the computer.

b) At the "Pno=" prompt enter your foresight point number like this:
Pno=2<Ent> (for point number 2)
c) At the "SH=" prompt enter the rod height of your foresight like this:
SH=5.5<Ent> (for 5.5 feet)

The next three fields may be entered manually or may be automatically stored by your instrument.
d) At the "Hor=" prompt enter the horizontal angle to your foresight like this:
Hor=65.1253<Ent> (for 65 degrees, 12 minutes, and 53 seconds.)
e) At the "ELE=" prompt enter the vertical angle to your foresight like this:
ELE=90.1215<Ent> (for 90 degrees, 12 minutes and 15 seconds)
f) At the "diSt=" prompt enter the slope distance to your foresight like this:
diSt=100.128<Ent> (for 100.128 feet)

Now, go to step 2 for a new instrument point, or step 3 for another sight from the current instrument point.

Note: If you have already dumped the data stored on the 122/124 to a computer file (in the 122/124 format), you may choose to receive the data from the file. Enter the file name that contains the data, and the file name for the .CGR file.

Receive Data from Data Collector

Select the receive raw data option.
1) Before you upload your data, make sure that the description table is current.
2) Before you initiate the upload program, you must first define the upload parameters for the Geodat. To do this, follow the steps outlined below.
3) This should not have to be done each time. The values that you enter should stay the same until you change them.
a) Press the <F>, the <1>, the <0> and the <Ent> keys. (For function 10.)
b) Answer the baud rate question like this: bAud=1200<Ent> (for 1200 baud you can use 300 baud, but it will take longer to transfer your data.)
c) Make sure that "Eob=" looks like this: Eob=0123456789<Ent>
d) Make sure that the "StArt=" prompt looks like this: StArt=035<Ent>
e) Make sure that the "StoP=" prompt looks like this: StoP=000<Ent>
f) Make sure that the "ErrCodE=" prompt looks like this: ErrCodE=037<Ent>
g) Make sure that the "nuLLS=" prompt looks like this: nuLLS=000<Ent>

GEODAT 126, 400, 500 AND INTERNAL MEMORY THEODOLITES
These Geodat data collectors use the following data entry format:

**Instrument Point Setup**
Labels Explanation
*2 Instrument Point
3 Height of Instrument
*62 Backsight Point
21 Backsight Angle
6 Backsight Rod Height
7 Horizontal Angle to Backsight
8 Vertical Angle to Backsight
9 Slope Distance to Backsight
* Indicates required code

**Note:** Pcodes (label 4) cannot be used anywhere except in foresight records.

**Note:** The order of the instrument point setups is not important.

**Foresight Points**
Labels Explanation
*5 Foresight point
6 Backsight rod height
*7 Horizontal angle to backsight
*8 Vertical angle to backsight
*9 Slope distance to backsight
4 Pcode (Description)
* Indicates required code

**Note:** Foresight points must begin with either a Pcode (label) or a foresight point (code 5). The order of the remaining parameters is not important.

Label 4 (Pcodes) are placed in the description field of the raw data file. If you cannot get the entire point description into a single Pcode, we allow you to use multiple Pcodes for an individual point.

Example: 4 = Manhole, 4 = Inv. -10.23, 4 = 12” Conc.Pipe

The resulting point description is: Manhole, Inv. -10.23, 12” Conc.Pipe

If the Append Info Records to Pcode toggle is on, info records (label 0=) that directly follow a Pcode (label 4=) will be appended to the Pcode prior to being placed in the point description.

Example: 4 = Manhole, 0 = Inv. -10.23, 0 = 12” Conc.Pipe

The resulting point description is: Manhole, Inv. -10.23, 12” Conc.Pipe
I. The Cable

Your cable should be made as follows:
NC - No connection.

**Geodat 126 (male)Computer 25 Pin**

2 .......................................... 2 (TxD)
3 .......................................... 3 (RxD)
7 .......................................... 7 (S.GND)
5-NC ——5 (CTS) jumper 5-6-8-20
6-NC ——6 (DSR)
8-NC ——8 (CD)
20-NC ——20 (DTR)

**Geodat 126 (male)Computer 9 Pin**

2 .......................................... 3 (TxD)
3 .......................................... 2 (RxD)
7 .......................................... 5 (S.GND)
5-NC ——8 (CTS) jumper 8-6-1-4
6-NC ——6 (DSR)
8-NC ——1 (CD)
20-NC ——4 (DTR)

II. Set Protocol 2 and 5; Set Format 2

Be sure the INT./EXT. switch is set to INT. if you are not connected to an external power source. Be sure the on/off switch is in the on position.

Set protocol by using program 51 in the Geodat.

Protocol 2 Protocol 5
1: 9600 1: 9600
2: 2 2: 2
3: 7 3: 7
4: 2 4: 2
5: 10 5: 10
6: 0 6: 0
7: 0 7: 0
8: 0 8: 0
9: 0 9: 0
10: 0 10: 0
11: 0 11: 0
12: 0 12: 0
13: 0 13: 0
14: 1.13 14: 1.13
15: 0 15: 0
16: 3.371310 16: 3.371310
Set format by using program 50 in the Geodat.
Format 2
1: 1
2: 80
3: 13
4: 15

III. Data Storage in the Geodat 126

Raw data is gathered into job files using the pre-programmed UDS’s in the Geodat 126. Call us if you wish to create others.

To use the existing programs, begin by choosing program #10. This sets up the header information and first instrument/backsight points. For foresights, choose program #0 if you are carrying elevations or program #1 for horizontal locations only. Use program #11 to change instrument set-ups. These programs are explained on page 8:4 in the Geodat manual.

Coordinates are transferred from and into area files.

Special numeric point codes may be used. These codes are converted to alphanumeric descriptions as the data is received from the Geodat 126. The codes are defined in the description table.

IV. UDS Requirements

The initial testing of the Geodat 126 was done using the standard UDS’s supplied with the Geodat 126. If you wish to try using your own, these rules apply:

1) A measurement must end with label 9. (See sample UDS’s 0, 1, 2, 3.)
2) Each Job. No. file must begin (1st record) with ADM type data (see sample UDS 10). This sequence must end with label type 74 - Air Pressure.
3) Each instrument station sequence must end with Hz. Ref. (Label 21). See the UDS 11 in Geodat 126 manual for sample.

Select the receive/send option from the computer menu and follow the prompts. If you have already dumped the data stored on the DR-2 to a computer file (in the DR-2 format), you may choose to receive the data from the file. Enter the file name that contains the data, and the file name for the .CGR file (raw data file) or .CRD file (coordinate file).

GEODAT 400 DATA COLLECTOR

Setting up the Geodat 400 for use with the transfer program:
1) Set protocol 0 (as shown below).

2) Set format 0 (as shown below).

Be sure the on/off switch is in the on position.
Set protocol by using program 51 in the Geodat field instrument.

Protocol 0
1: 9600
2: 0
3: 8
4: 1
5: 10
6: 0
7: 1
8: 17
9: 19
10: 0
11: 0
12: 0
13: 0
14: 1.13
15: 0
16: 1.04

Line 7 implements software handshaking between the 400 and the MS-DOS computer by using a value of 1. When the value of item 7 is 0, then no software handshaking is done.

Line 8 is given a value of 17 which is the Xon value used for the communication handshaking.

Line 9 is given a value of 19 which is the Xoff value used for the communication handshaking.

Set format by using program 50 in the Geodat field instrument.
Format 0
1: 1
2: 80
3: 324:
4 *

Note: It is important that the values above be set as we show them or our software can not communicate with the Geodat 400 Data Recorder.

If you have already dumped the data stored on the 400 to a computer file (in the 400 format), you may choose to receive the data from the file. Enter the file name that contains the data, and the file name for the .CGR file (raw data file) or .CRD file (coordinate file).

**Uploading Raw Data to the Computer**

After you have collected your field data, connect the Geodat 400 to your computer. Select
the receive raw data option.
The baud rate in the computer must match the baud rate in the Geodat 400.

Do the following:
1) Connect the 400 to the computer, turn it off, then on.
2) Make certain that you have selected the correct protocol and format.
3) Enter name of Geodat job file.

**Download Coordinates into 400 Area File**

Select the send coordinates option.
Select the points to send.
Ready the 400 with the following steps:
1) Connect the 400 to the computer, turn it off, then on.
2) Make certain that you have selected the correct protocol and format.
3) Enter name of Geodat area file.
The coordinates will be transferred.

**Get Coordinates from 400 Area File**

**Receive coordinates from 400 Area File**

The baud rate in the computer must match the baud rate in the 400. Do the following:
1) Connect the 400 to the computer, turn it off, then on.
2) Make certain that you have selected the correct protocol and format.
3) Enter name of Geodat area file.
The transmission will begin.

**GEODAT 500 DATA COLLECTOR**

Setting up the Geodat 500 for use with the transfer program:
1) Set protocol 0 (as shown below).
2) Set format 0 (as shown below).
Be sure the on/off switch is in the on position.
Set protocol by using program 51 in the Geodat field instrument.

<table>
<thead>
<tr>
<th>Protocol 0</th>
<th>1: 9600</th>
</tr>
</thead>
<tbody>
<tr>
<td>2: 0</td>
<td></td>
</tr>
<tr>
<td>3: 8</td>
<td></td>
</tr>
<tr>
<td>4: 1</td>
<td></td>
</tr>
<tr>
<td>5: 10</td>
<td></td>
</tr>
<tr>
<td>6: 0</td>
<td></td>
</tr>
<tr>
<td>7: 1</td>
<td></td>
</tr>
<tr>
<td>8: 17</td>
<td></td>
</tr>
<tr>
<td>9: 19</td>
<td></td>
</tr>
</tbody>
</table>
Line 7 implements software handshaking between the 500 and the MS-DOS computer by using a value of 1. When the value of item 7 is 0, then no software handshaking is done.

Line 8 is given a value of 17 which is the Xon value used for the communication handshaking.

Line 9 is given a value of 19 which is the Xoff value used for the communication handshaking.

Set format by using program 50 in the Geodat field instrument.

Format 0
1: 1
2: 80
3: 32
4: *

**Note:** It is important that the values above be set as we show them or our software can not communicate with the Geodat 500 Data Recorder.

The C&G Data collector Transfer dialog box has an additional option for the GEODAT 500 collector, as shown below. The show DC files:
This Option actually reads and displays the data files on the GEODAT 500 data collector. From the display options you can select to view all files, just coordinate files or just raw files.

If you have already dumped the data stored on the 500 to a computer file (in the 500 format), you may choose to receive the data from the file. Enter the file name that contains the data, and the file name for the .CGR file (raw data file) or .CRD file (coordinate file).

You can also delete files from the GEODAT 500. Be careful, once the files is deleted it is gone forever. When you have the files selected, you want to transfer, select exit.
The Geodat 500 program allows:
1) Receive raw data from the Geo 500
2) Receive raw data from a file.
3) Receive coordinates from the Geo 500.
4) Receive coordinates from a file.
5) Send coordinates to the Geo 500.
6) Catalog (or directory) of all files on Geo 500.
7) Delete files on the Geo 500.

Receiving Data from the 500

You may receive raw data files (M=), or coordinate files (I=).
All files on the 500 of the type you wish to receive will be shown on the screen (for example, all I= files for coordinate).
1) Select the file you wish to receive.
Raw Data (Job Files)

2) After the raw data file is transferred, you will be asked to select the file name it will be stored under on the computer. The default value will be the same name with a .CGR extension.
Coordinates (Area Files)

3) After the coordinate file is transferred, you will be asked to select the file name it will be stored under on the computer. The default value will be the same name with .CRD/.IDX extensions.

Sending Data to the 500
You may send coordinate (.CRD) files to the 500. All coordinate files on the computer will be shown on the screen. Select the file you wish to send.
1) You may select the only the coordinates that you wish to send (you do not have to send the entire file).
   Catalog
   2) The catalog function will show you all existing files on the Geodat 500.

Deleting Files

All files on the 500 will be shown on the screen.
1) Select the file you wish to delete. Be careful, once the file is deleted it is gone forever.
2) Press <Esc> if you do not want to delete a file.

GEODIMETER TOTAL STATIONS WITH INTERNAL MEMORY

You can select Geodat 500 and interface directly with any Geodimeter that has internal memory. To transfer data from a Geodimeter Total Station with internal memory, do the following:

1) In Equipment Options, select Geodat 500 as the data collector and run data collection program.
2) Use Geotronix cable #571136756. Connect RS232 on computer to RS232 on Geodimeter with cable.
3) Power on Geodimeter and turn off compensator with Function 22 as follows:
   Key
   <F> (Function)
   <22>
   <Ent> (Enter)
   <0>
   <Ent>
   Then press <Ent> until P0 is displayed on Geodimeter screen.

4) Set the END character to 4 with Function 79 as follows:
   Key
   <F> (Function)
   <79>
   <Ent> (Enter)
   <4>
   <Ent>
5) Initiate comm port on Geodimeter as follows:
   Key
   <Mnu> (menu)
   <4> (data com)
   <1> (select device)
   <2> (serial)
   <Yes> (serial on)
   <1.8.0.9600> (com=) skip if already set
   <Ent> (enter)
6) You may now select all options on the computer menu for data collection transfer with the Geodimeter. See Geodat 500 instructions for data transfer (disregard formatting procedures).

SMI 48 ENHANCED DATA COLLECTOR

The SMI interface routine works only with SMI Enhanced Cards. Use the interface cable supplied with the SMI unit (plugs into the comm port on the computer).

SMI 48 transfer Versions 5

Receiving Data

If you have already dumped the data stored on the SMI to a file on the computer, you may choose to receive the data from the file.

Receiving Raw Data from the SMI
Select the Receive raw data option on the computer. On the SMI, select TOPC and then RAW. The transfer will begin. The file name will be shown on the screen after the transfer is complete. You may enter a new file name if you wish.
Our reduction program does not allow a raw data file with mixed angle types (for example: azimuths, angles right, deflections, etc.). When you are collecting data on the SMI, stick to one angle type. You can mix distance types if you wish (slope/zenith, horizontal/vertical).

Receiving Coordinates from the SMI

1) Select the Receive Coordinates option on the computer:
On the SMI select TOPC and then SMI.
2) On the SMI, enter the first and last point numbers you wish to send:
The transfer will begin.

Sending Coordinates to the SMI
1) On the SMI select TD48 and the SMI.
2) Select the Send Coordinates option on the computer. You will be asked if you wish to send descriptions. The answer to this question depends on whether the SMI coordinate file you are sending to is a 15 byte file (no descriptions) or a 30 byte file (descriptions).
3) On the computer, select the points you wish to send. When the selection set is complete, press <T> for transmit. The transfer will begin.

**SMI 48 transfer Versions 6, 7 & 8**

**Receiving Raw Data from the SMI**

1) Get the C&G Transfer Program ready to receive raw data: Press Transfer
2) On the SMI data Collector select [PRINT]: set the soft-key to [WIRE]

**Receiving Coordinates from the SMI**
1) Get the C&G Transfer Program ready to receive raw data and Press Transfer
2) On the SMI data collector select [JOB], then [KERM]: set the soft-key to [NE] and [COMM]. select [SEND] and then select the points to transfer.

Sending Coordinates to the SMI

1) On the SMI data collector select [JOB] the [KERM]: set the soft-key to [NE] and [COMM], select [RECV].
2) Configure the C&G Transfer Program to send Coordinates: select the points to be sent and press TRANSFER

Nilon Data Collection Transfer

Receiving Raw Data from the Nikon Total Station:

1) Get the C&G Transfer Program ready to receive raw data and Press Transfer
2) On the Nikon select [MENU]. Select option [SET] and then option [COMM]. Set "Ext.Comm:" to Nikon. Set the communication parameters to match those in the C&G transfer program.
3) From the Main Menu on the Nikon select "Comms" and "Download": select format: NIKON and Data: RAW
4) Press ENTER to send.
Receiving Coordinates Data from the Nikon Total Station

1) Get the C&G Transfer Program ready to receive raw data and Press Transfer
2) On the Nikon select [MENU]. Select option [SET] and then option [COMM]. Set "Ext.Comm:" to Nikon. Set the communication parameters to match those in the C&G transfer program.
3) From the Main Menu on the Nikon select "Comms" and "Download": select format: NIKON and Data: COORD.
4) Press ENTER to send.

Sending Coordinates Data from the Nikon Total Station

1) On the Nikon select [MENU]. Select option [SET] and then option [COMM]. Set "Ext.Comm:" to Nikon. Set the communication parameters to match those in the C&G transfer program.
2) From the Main Menu on the Nikon: select "Comms" and "Upload Data". Press ENTER to receive.
3) Configure the C&G Transfer Program to Send Coordinates: select the points to be sent and press TRANSFER.

Pulldown Menu Location: CG-Survey>CGTools>Data Collector Transfer
Keyboard Command: DC, CG_DATA_COLLECTOR
Prerequisite: Check Cable Connection & Communication Parameters

Example Projects

On the installation disk there are a variety of different least squares projects one can use to become familiar with least squares and SurvNet. These projects are located in the C&G/Carlson application folder under the \Data\SurvNet\ subdirectory.

When you open a project for review, you will need to check the project settings - input data files tab to see if the data files are listed. If they are not, you will have to re-select them.

Simple Traverse with Traverse Closure

This project is located in \Data\SurvNet\2DTraverse. The name of the project is Traverse. This project illustrated a basic loop traverse with two control points and a known azimuth for control. This project also illustrates how to obtain traditional closure information as part of the least squares report. The program uses the 2D/1D model and uses a local coordinate system.

Traverse using State Plane Coordinates

This project is located in \Data\SurvNet\SPCTraverse. The name of the project is TravSPCUSFt. This project illustrated a basic network with three GPS control points for control. This project is computed using the SPC83 NC Grid coordinate system. The project is set up to generate traditional loop closure data. The program uses the 2D/1D model. No elevations are computed or adjusted as there were no HI's or rod readings collected. Notice, that the
project uses two raw data files. One file contains the raw angle & distance data. The other raw data file contains the control for the project.

**Network with ALTA Reporting**

The ALTA reporting project is located in `\Data\SurvNet\ALTARpt`. The name of the project is ALTARpt. This project illustrates how to perform ALTA tolerance testing on points within a network.

**GPS Network with GPS Loop Closures**

The GPS network project is located in `\Data\SurvNet\GPSNetwork`. The name of the project is GPSOnly. This project is a simple GPS network. In addition to the least squares computation and report, GPS loop closures were generated for various GPS loops for this project.

**Level Network**

The differential leveling project is located in `\Data\SurvNet\LevelNetwork`. The name of the project is network1. This project is a simple differential leveling network.

**Basic 3D Project**

The basic 3D adjustment project is located in `\Data\SurvNet\3DNetwork`. The name of the project is pg08. This project is a simple four point example network. Notice in the raw data that all set up records have an HI and all FS readings have valid rod heights. Also note that there are valid vertical angles for every slope distance. Since the 3D model is a true one process 3 dimensional adjustment, you must enter all valid slope distances and vertical angles. Be aware that you cannot just enter a horizontal distance and a vertical angle of 90 from reduced field notes when adjusting using the 3D model.

**3D Project Combining Total Station and GPS Vectors**

The total station raw data combined with GPS vectors example is located in `\Data\SurvNet\GPSandTtlSta`. The name of the project is GPSandTtlSta. This project illustrates a 3D model adjustment that combines both GPS vectors and data from a total station. Since there is GPS data the 3D model must be used. Notice that the GPS vectors are in meters but the total station data is in US feet and the output coordinates are in US feet. Always make sure your units are correct for each data type especially when using the 3D model.

**Resection**

The total station raw data combined with GPS vectors example is located in `\Data\SurvNet\Resection`. The name of the project is Resect. This project illustrates an angle and distance resection. There is no real difference in a resection project than any other angle and distance network in terms of how the data is collected or how the project is set up.

**Network Processing Reports**

**Report File:** A report file consisting of the project name with an .RPT extension is generated after successfully processing the raw data. The report file will be shown in a text window so you can analyze the data. You can pick the "Printer" icon if you want a hardcopy. The following sections review some example results from several different types of adjustments.
2D-1D Local Coordinate System

The following explanations should be used in conjunction with the report at the end of the explanatory text.

Project Settings

The first section of the report displays the project settings at the time the project was processed.

Tolerances

The second section of the report displays warning and error messages generated during the preprocessing of the raw data. The primary messages displayed will be warnings when multiple angles, horizontal distances, and vertical differences exceed the tolerance settings as set in the project settings. The low and high measurement and the difference are displayed. It is prudent to pay attention to any messages generated in this section of the report. Some warnings may be innocuous but it is prudent to check and understand all warning messages.

Unadjusted Observations

The next four sections list the reduced and averaged, but unadjusted measurements that make up the network. Multiple measurements of the same angle or distance are averaged to a single measurement. The standard error of multiple averaged measurements is less than the standard error of a single measurement. When multiple measurements are used, the standard error for the averaged measurement will be computed using the average of the mean formula.

The first of the four sections is a list of the control coordinates used in the network adjustment. These coordinates could have been read from the .CGR raw data file, or from the .CRD or .NEZ supplemental coordinate file. Notice that the standard errors for the control points are displayed.

The second of the four measurement sections shows the distances and distance standard errors used in the adjustment. These distances are horizontal distances computed from all slope distance and vertical angles for that distance, including all foresight and backsight distances. The standard error settings used to calculate the final distance standard error include the distance standard error, the PPM standard error, the target centering standard error and the instrument centering standard errors. The techniques and formulas used to calculate the final distance standard error are found in section 6.12 of the textbook "Adjustment Computations, Statistics and Least Squares in Surveying and GIS", by Paul Wolf and Charles Ghilani.

The third of the four measurement sections shows the angles and angle standard errors used in the adjustment. These angles are the averaged angle value for all the multiple angles collected. The standard error settings used to calculate the final angle standard error include the pointing standard error, the reading standard error, the target centering standard error and the instrument centering standard errors. The techniques and formulas used to calculate the final angle standard error are found in section 6.2 of the textbook "Adjustment Computations, Statistics and Least Squares in Surveying and GIS", by Paul Wolf and Charles Ghilani.

The fourth of the four measurement sections shows the azimuths and azimuth standard errors used in the adjustment. Azimuths can only be defined as a direction record in the .CGR raw data file.

Adjusted Coordinates

If the adjustment of the network converges the next section displays a list of the final adjusted coordinates and the computed standard X, Y standard error. An interpretation of the meaning of the X, Y standard error, is that there is a 68% probability that the adjusted X, Y is within plus or minus the standard error of the X, Y of its true value.

The next section displays the error ellipses for the adjusted coordinates. The error ellipse is a truer representation of the error of the point than the X, Y standard error. The error ellipses are calculated to the confidence interval as
defined in the settings screen. In this report the error ellipse axis is larger than the X, Y standard errors since the error ellipses in this report are calculated at a 95% probability level as set in the Settings screens. The maximum error axis direction is along the axis of the semi-major axis. The direction of the minimum error axis direction is along the semi-minor axis and is perpendicular to the semi-major axis. If a point is located from a variety of stations, you will most likely see that the error ellipse will approach a circle, which is the strongest geometric shape.

**Adjusted Observations**

The next three sections list the adjusted horizontal distance, horizontal angle, and azimuth measurements. In addition to the adjusted measurement the, residual, the standard residual and the standard deviation of the adjusted measurement is displayed.

The residual is defined as the difference between the unadjusted measurement and the adjusted measurement. The residual is one of the most useful and intuitive measures displayed in the report. Large residuals in relation to the standards of the survey are indications of problems with the data.

The standard residual is the a priori standard error divided by the residual of a measurement. The a priori standard errors are the standard errors of the measurements as displayed in the unadjusted measurement section. A standard residual of 1 indicates that the adjustment applied to the measurement is consistent with the expected adjustment to the measurement. One or a few measurements having high standard residuals, in relation to the rest of the standard residuals, may be an indication of a blunder in the survey. When all standard residuals are consistently large there is likely an inconsistency in the a priori standard errors and the adjustments being made to the measurements. In other words the standard errors defined for the project are too small, in relation to the survey methods used.

The standard deviation of the measurement means that there is a 68% probability that the adjusted measurement is within plus or minus the standard deviation of the measurement's true value.

Additionally, the root mean square of each measurement type is displayed. The root mean square is defined as the square root of the average of the squares of a set of numbers. Loosely defined, it is as an average residual for that measurement type.

**Statistics**

The next section displays some statistical measures of the adjustment including the number of iterations needed for the solution to converge, the degrees of freedom of the network, the reference variance, the standard error of unit weight, and the results of a Chi-square test.

The degree of freedom is an indication of how many redundant measurements are in the survey. Degree of freedom is defined as the number of measurements in excess of the number of measurements necessary to solve the network.

The standard error of unit weight relates to the overall adjustment and not an individual measurement. A value of one indicates that the results of the adjustment are consistent with a priori standard errors. The reference variance is the standard error of unit weight squared.

The chi-square test is a test of the "goodness" of fit of the adjustment. It is not an absolute test of the accuracy of the survey. The a priori standard errors which are defined in the project settings dialog box or with the SE record in the raw data (.CGR) file are used to determine the weights of the measurements. These standard errors can also be looked at as an estimate of how accurately the measurements were made. The chi-square test merely tests whether the results of the adjusted measurements are consistent with the a priori standard errors. Notice that if you change the project standard errors and then reprocess the survey the results of the chi-square test change, even though the final adjusted coordinates may change very little.

**Sideshots**

The next section displays the computed sideshots of the network. Sideshots are filtered out of the network adjustment as part of the preprocessing process if the 'Enable Sideshots for Error Ellipses' toggle is off. Least squares adjustment requires a lot of computer resources. Sideshots are filtered out to minimize the computer resources needed in a large
network adjustment. The sideshots are computed from the final adjusted network points. The results of the side shot computations are the same whether they are reduced as part of the least squares adjustment or from the final adjusted coordinates.

**VERTICAL ADJUSTMENT REPORT**

The next part of the report displays the results of the vertical adjustment. In the 2D/1D model the horizontal and the vertical adjustments are separate least squares adjustment processes. As long as there are redundant vertical measurements the vertical component of the network will also be reduced and adjusted using least squares.

The first section displays the vertical benchmarks used in the vertical adjustment. Next, is listed the points that will be adjusted as part of the vertical adjustment. The following section displays the measurements used in the adjustment. The measurements consist of the vertical elevation difference between points in vertical adjustment. The lengths between these points are used to determine the weights in the vertical adjustment. Longer length lines are weighted less in the vertical adjustment than shorter length lines.

The next section displays some statistics about the vertical control: Number of unknown elevations, number of routes, number of fixed and non-fixed benchmarks, and degrees of freedom.

The next section displays the adjusted elevations and the computed standard deviations of the computed elevations. Following the adjusted elevation section is a section displaying the final adjusted elevation difference measurements and their residuals. Finally, the computed side shot elevations are displayed.

**State Plane Reduction Report file:**

When reducing to a state plane coordinate system, there is additional information displayed in the report file.

First, notice the heading of the report. The heading indicates that the project is being reduced into the North Carolina zone of the 1983 State Plane Coordinate System. The heading shows that the elevation factor is computed based on a project elevation of 250 feet:
Low: 109-19'10.0''
High: 109-19'17.0''
Diff: 000-00'07.0''

Horizontal Angle spread exceeds tolerance:
IP: 2,
BS: 1,
FS: 6
Low: 190-32'02.0''
High: 190-32'10.0''
Diff: 000-00'08.0''

Horizontal Angle spread exceeds tolerance:
IP: 2,
BS: 1,
FS: 3
Low: 096-03'48.0''
High: 096-03'56.0''
Diff: 000-00'08.0''

Horizontal Angle spread exceeds tolerance:
IP: 3,
BS: 2,
FS: 4
Low: 124-03'50.0''
High: 124-03'56.0''
Diff: 000-00'06.0''

Horizontal Angle spread exceeds tolerance:
IP: 5,
BS: 4,
FS: 10
Low: 039-26'35.0''
High: 039-26'45.0''
Diff: 000-00'10.0''

Horizontal Angle spread exceeds tolerance:
IP: 10,
BS: 5,
FS: 11
Low: 241-56'23.0''
High: 241-56'35.0''
Diff: 000-00'12.0''

Horizontal Angle spread exceeds tolerance:
IP: 11,
BS: 10,
FS: 12
Low: 114-56'20.0''
High: 114-56'34.0''
Diff: 000-00'14.0''

Horizontal Angle spread exceeds tolerance:
IP: 12,
BS: 11,
FS: 3
Low: 140-39'18.0''
High: 140-39'31.0''
Diff: 000-00'13.0''
Horizontal Angle spread exceeds tolerance:
   IP: 5,
   BS: 4,
   FS: 1
   Low: 117°-30'35.0'',
   High: 117°-30'50.0'',
   Diff: 000'-00'15.0''

Horizontal Distance from 2 to 3 exceeds tolerance:
   Low: 324.15,
   High: 324.20,
   Diff: 0.04

Vertical Distance from 2 to 3 exceeds tolerance:
   Low: 6.62,
   High: 8.36,
   Diff: 1.74

Vertical Distance from 3 to 4 exceeds tolerance:
   Low: 11.46,
   High: 11.51,
   Diff: 0.05

Horizontal Distance from 12 to 3 exceeds tolerance:
   Low: 144.64,
   High: 144.66,
   Diff: 0.02

HORIZONTAL ADJUSTMENT REPORT
================================

Unadjusted Observations
========================

Control Coordinates:
   1 Observed Points,
   0 Fixed Points,
   0 Approx. Points
Sta.  N:  E:  StErr N:  StErr E:
       658428.26  2150182.70  0.01  0.01

Distances:
   14 Observations
From Sta.
   To Sta.  Dist.  StErr
       1     5     290.45  0.01
       1     2
<table>
<thead>
<tr>
<th>BS Sta.</th>
<th>Occ. Sta.</th>
<th>FS Sta.</th>
<th>Angle</th>
<th>StErr (Sec.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>6</td>
<td>2</td>
<td>292.21</td>
<td>0.01</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>3</td>
<td>52.39</td>
<td>0.01</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
<td>3</td>
<td>324.19</td>
<td>0.01</td>
</tr>
<tr>
<td>3</td>
<td>20</td>
<td>3</td>
<td>275.60</td>
<td>0.01</td>
</tr>
<tr>
<td>20</td>
<td>21</td>
<td>20</td>
<td>134.66</td>
<td>0.01</td>
</tr>
<tr>
<td>21</td>
<td>22</td>
<td>21</td>
<td>116.07</td>
<td>0.01</td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>21</td>
<td>50.12</td>
<td>0.01</td>
</tr>
<tr>
<td>5</td>
<td>10</td>
<td>4</td>
<td>309.65</td>
<td>0.01</td>
</tr>
<tr>
<td>10</td>
<td>11</td>
<td>5</td>
<td>129.99</td>
<td>0.01</td>
</tr>
<tr>
<td>10</td>
<td>15</td>
<td>10</td>
<td>126.01</td>
<td>0.01</td>
</tr>
<tr>
<td>10</td>
<td>15</td>
<td>10</td>
<td>10.00</td>
<td>0.01</td>
</tr>
<tr>
<td>11</td>
<td>12</td>
<td>11</td>
<td>129.43</td>
<td>0.01</td>
</tr>
<tr>
<td>12</td>
<td>3</td>
<td>11</td>
<td>144.65</td>
<td>0.01</td>
</tr>
</tbody>
</table>

Angles:
- 15 Observations

BS Sta.
Occ. Sta.
FS Sta.
Angle
StErr (Sec.)
<p>| | | | | | | | | | | | | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>109-19'13.5''</td>
<td>7.7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>6</td>
<td>190-32'06.0''</td>
<td>26.2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>3</td>
<td>096-03'52.0''</td>
<td>7.3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>4</td>
<td>124-03'53.0''</td>
<td>7.8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>20</td>
<td>185-23'56.0''</td>
<td>12.8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>20</td>
<td>21</td>
<td>180-15'26.0''</td>
<td>17.6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>21</td>
<td>22</td>
<td>183-26'45.0''</td>
<td>31.2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>4</td>
<td>5</td>
<td>093-02'11.5''</td>
<td>7.5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>10</td>
<td>039-26'40.0''</td>
<td>10.4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>10</td>
<td>11</td>
<td>241-56'29.0''</td>
<td>15.6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>10</td>
<td>15</td>
<td>056-23'10.0''</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
125.0

10
  11
  12
  114-56'27.0''
  15.5

11
  12
  3
  140-39'24.5''
  15.3

12
  3
  2
  325-54'30.0''
  9.5

4
  5
  1
  11
  7-30'42.5''
  7.7

Azimuths:
  1 Observations
  Occ. Sta.
  FS Sta.
  Bearing
  StErr (Sec.)

1
  2
  N 45-00'00.0''E
  5.0

Adjusted Coordinates
-----------------------

Adjusted Local Coordinates
Sta.
  N:
  E:
  StErr N:
  StErr E:

1
  658428.26
  2150182.70
  0.02
  0.02

2
  658634.88
  2150389.32
  0.02
  0.02

5
  658554.12
<table>
<thead>
<tr>
<th>Sta.</th>
<th>Semi Major</th>
<th>Semi Minor</th>
<th>Max. Error Az.</th>
<th>Axis</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.05</td>
<td>0.05</td>
<td>S 29-26'39.4''E</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>0.07</td>
<td>0.07</td>
<td>N 45-00'00.0''E</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>0.07</td>
<td>0.10</td>
<td>N 10-58'28.2''E</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>0.07</td>
<td>0.07</td>
<td>N 84-37'31.0''E</td>
<td></td>
</tr>
</tbody>
</table>

**Adjusted Coordinates Error Ellipses, 95% CI**
<table>
<thead>
<tr>
<th>From Sta.</th>
<th>To Sta.</th>
<th>Distance</th>
<th>Residual</th>
<th>StdRes.</th>
<th>StdDev</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>5</td>
<td>290.46</td>
<td>0.01</td>
<td>1.42</td>
<td>0.01</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>292.21</td>
<td>-0.00</td>
<td>0.40</td>
<td>0.01</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>324.17</td>
<td>-0.01</td>
<td>1.62</td>
<td>0.01</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
<td>275.59</td>
<td>-0.01</td>
<td>1.11</td>
<td>0.01</td>
</tr>
<tr>
<td>3</td>
<td>20</td>
<td>134.66</td>
<td>-0.00</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Adjusted Observations**

**Adjusted Distances**

From Sta.

To Sta.

Distance

Residual

StdRes.

StdDev

1

5

290.46

0.01

1.42

0.01

2

292.21

-0.00

0.40

0.01

3

324.17

-0.01

1.62

0.01

4

275.59

-0.01

1.11

0.01

3

20

134.66

-0.00
<table>
<thead>
<tr>
<th>BS Sta.</th>
<th>Occ. Sta.</th>
<th>FS Sta.</th>
<th>Angle</th>
<th>Residual</th>
<th>StdRes</th>
<th>StdDev(Sec.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.00</td>
<td>0.02</td>
<td>20</td>
<td>21</td>
<td>116.07</td>
<td>-0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>0.02</td>
<td>4</td>
<td>5</td>
<td>5</td>
<td>309.65</td>
<td>0.01</td>
<td>0.64</td>
</tr>
<tr>
<td>0.01</td>
<td>5</td>
<td>10</td>
<td>10</td>
<td>130.00</td>
<td>0.01</td>
<td>0.97</td>
</tr>
<tr>
<td>0.01</td>
<td>10</td>
<td>11</td>
<td>11</td>
<td>126.01</td>
<td>0.00</td>
<td>0.16</td>
</tr>
<tr>
<td>10</td>
<td>0.01</td>
<td>11</td>
<td>11</td>
<td>129.44</td>
<td>0.01</td>
<td>0.98</td>
</tr>
<tr>
<td>0.02</td>
<td>12</td>
<td>3</td>
<td>12</td>
<td>144.66</td>
<td>0.01</td>
<td>0.94</td>
</tr>
<tr>
<td>0.02</td>
<td>Root Mean Square (RMS)</td>
<td>0.01</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Adjusted Angles
BS Sta.
Occ. Sta.
FS Sta.
Angle
Residual
StdRes
StdDev(Sec.)

<table>
<thead>
<tr>
<th>5</th>
<th>1</th>
<th>2</th>
<th>109-19'19.2'</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.7</td>
<td>0.7</td>
<td>9.9</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>1</th>
<th>2</th>
<th>3</th>
</tr>
</thead>
<tbody>
<tr>
<td>096-03'43.4'</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Occ. Sta.</td>
<td>FS Sta.</td>
<td>Bearing</td>
</tr>
<tr>
<td>----------</td>
<td>---------</td>
<td>---------</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>N 45-00'00.0''E</td>
</tr>
</tbody>
</table>

Statistics
============
Solution converged in 2 iterations
Degrees of freedom:6
Reference variance:2.84
Standard error unit Weight: +/-1.68
Failed the Chi-Square test at the 95.00 significance level
1.237 <= 17.023 <= 14.449

Sideshots
==========
From
To
<table>
<thead>
<tr>
<th>Bearing</th>
<th>Dist.</th>
</tr>
</thead>
<tbody>
<tr>
<td>N</td>
<td>E</td>
</tr>
<tr>
<td>StDev. N</td>
<td></td>
</tr>
</tbody>
</table>
LEAST SQUARES VERTICAL ADJUSTMENT REPORT

Mon May 08 10:16:16 2006
2D Geodetic Model.
Input Raw Files:
C:\data\lsdata\cgstar\CGSTAR.CGR
Output File: C:\data\lsdata\cgstar\cgstar.RPT
Curvature, refraction correction: ON

VERTICAL BENCHMARKS

<table>
<thead>
<tr>
<th>Station</th>
<th>Elevation</th>
<th>Std. Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>569.8500</td>
<td>FIXED</td>
</tr>
</tbody>
</table>

POINTS TO BE ADJUSTED

Station
2,5,3,4,10,11,12

MEASUREMENT SUMMARY

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Elev. Diff. (unadjusted)</th>
<th>StdErr</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>5</td>
<td>7.5040</td>
<td>0.0162</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>7.5659</td>
<td>0.0163</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>6.9843</td>
<td>0.0162</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
<td>-11.4907</td>
<td>0.0161</td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>4.3557</td>
<td>0.0165</td>
</tr>
<tr>
<td>5</td>
<td>10</td>
<td>2.2639</td>
<td>0.0150</td>
</tr>
<tr>
<td>10</td>
<td>11</td>
<td>1.0931</td>
<td>0.0150</td>
</tr>
</tbody>
</table>
STATISTICAL SUMMARY

Total Unknown Elevations: 7
Total Elev. Routes: 9
Total Fixed BM's: 1
Total non-fixed BM's: 0
Degrees of freedom: 2

ADJUSTED ELEVATIONS

<table>
<thead>
<tr>
<th>Station</th>
<th>Adjusted Elev</th>
<th>Standard Dev.</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>577.4336</td>
<td>0.02463</td>
</tr>
<tr>
<td>5</td>
<td>577.3363</td>
<td>0.02462</td>
</tr>
<tr>
<td>3</td>
<td>584.4355</td>
<td>0.02907</td>
</tr>
<tr>
<td>4</td>
<td>572.9625</td>
<td>0.03072</td>
</tr>
<tr>
<td>10</td>
<td>579.6004</td>
<td>0.03286</td>
</tr>
<tr>
<td>11</td>
<td>580.6935</td>
<td>0.03575</td>
</tr>
<tr>
<td>12</td>
<td>581.0764</td>
<td>0.03469</td>
</tr>
</tbody>
</table>

ADJUSTED MEASUREMENT SUMMARY

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Elev. Diff. (adjusted)</th>
<th>Residuals</th>
<th>Std. Dev.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>5</td>
<td>7.4863</td>
<td>-0.0177</td>
<td>0.025</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>7.5836</td>
<td>0.0177</td>
<td>0.025</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>7.0019</td>
<td>0.0177</td>
<td>0.025</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
<td>-11.4730</td>
<td>0.0177</td>
<td>0.024</td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>4.3738</td>
<td>0.0181</td>
<td>0.024</td>
</tr>
<tr>
<td>5</td>
<td>10</td>
<td>2.2641</td>
<td>0.0001</td>
<td>0.024</td>
</tr>
<tr>
<td>10</td>
<td>11</td>
<td>1.0932</td>
<td>0.0001</td>
<td>0.024</td>
</tr>
<tr>
<td>11</td>
<td>12</td>
<td>0.3829</td>
<td>0.0001</td>
<td>0.024</td>
</tr>
<tr>
<td>12</td>
<td>3</td>
<td>3.3591</td>
<td>0.0001</td>
<td>0.025</td>
</tr>
</tbody>
</table>

Vertical Sideshots

<table>
<thead>
<tr>
<th>Station</th>
<th>Elevation</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>577.6338</td>
</tr>
<tr>
<td>20</td>
<td>571.7662</td>
</tr>
<tr>
<td>21</td>
<td>581.2509</td>
</tr>
<tr>
<td>22</td>
<td>580.1399</td>
</tr>
<tr>
<td>15</td>
<td>579.6004</td>
</tr>
</tbody>
</table>

2D-1D State Plane Coordinate System

Note: highlighted explanatory text is found within the report text.

LEAST SQUARES ADJUSTMENT REPORT

Tue Mar 21 17:37:27 2006
2D Geodetic Model.
Input Raw Files:
  C:\data\lsdata\cgstar\CGSTAR.CGR
Output File: C:\data\lsdata\cgstar\cgstar.RPT
Curvature, refraction correction: ON
Maximum iterations: 10 , Convergence Limit: 0.002000
1983 State Plane Coordinates, zone:3200 North Carolina
Elevation factor computed from project elevation,250.000000.
Elevation Units: US Feet
Horizontal Units: US Feet
Confidence Interval: 95.00
Project Geoid Height:
  0.00
Default Standard Errors:
  Distance: Constant 0.010 ,PPM: 5.000
  Horiz. Angle: Pointing 3.0'' ,Reading: 3.0''
  Vert. Angle: Pointing 3.0'' ,Reading: 3.0''
  Total Station: Centering 0.005 ,Height: 0.010
  Target: Centering 0.005 ,Height: 0.010
  Azimuth: 5''
  Coordinate Control: N:0.010, E:0.010, Z:0.030,

Horizontal Angle spread exceeds tolerance:
  IP: 1,
  BS: 5,
  FS: 2
  Low: 109-19'10.0'' ,
  High: 109-19'17.0'' ,
  Diff: 000-00'07.0''

Horizontal Angle spread exceeds tolerance:
  IP: 2,
  BS: 1,
  FS: 6
  Low: 190-32'02.0'' ,
  High: 190-32'10.0'' ,
  Diff: 000-00'08.0''

Horizontal Angle spread exceeds tolerance:
  IP: 2,
  BS: 1,
  FS: 3
  Low: 096-03'48.0'' ,
  High: 096-03'56.0'' ,
  Diff: 000-00'08.0''

Horizontal Angle spread exceeds tolerance:
  IP: 3,
  BS: 2,
  FS: 4
  Low: 124-03'50.0'' ,
  High: 124-03'56.0'' ,
  Diff: 000-00'06.0''

Horizontal Angle spread exceeds tolerance:
  IP: 5,
  BS: 4,
  FS: 10
  Low: 039-26'35.0'' ,
  High: 039-26'45.0'',
Diff: 000-00'10.0''

Horizontal Angle spread exceeds tolerance:
  IP: 10,
  BS: 5,
  FS: 11
  Low: 241-56'23.0'',
  High: 241-56'35.0'',
  Diff: 000-00'12.0''

Horizontal Angle spread exceeds tolerance:
  IP: 11,
  BS: 10,
  FS: 12
  Low: 114-56'20.0'',
  High: 114-56'34.0'',
  Diff: 000-00'14.0''

Horizontal Angle spread exceeds tolerance:
  IP: 12,
  BS: 11,
  FS: 3
  Low: 140-39'18.0'',
  High: 140-39'31.0'',
  Diff: 000-00'13.0''

Horizontal Angle spread exceeds tolerance:
  IP: 5,
  BS: 4,
  FS: 1
  Low: 117-30'35.0'',
  High: 117-30'50.0'',
  Diff: 000-00'15.0''

Horizontal Distance from 2 to 3 exceeds tolerance:
  Low: 324.15,
  High: 324.20,
  Diff: 0.04

Vertical Distance from 2 to 3 exceeds tolerance:
  Low: 6.62,
  High: 8.36,
  Diff: 1.74

Vertical Distance from 3 to 4 exceeds tolerance:
  Low: 11.46,
  High: 11.51,
  Diff: 0.05

Horizontal Distance from 12 to 3 exceeds tolerance:
  Low: 144.64,
  High: 144.66,
  Diff: 0.02

HORIZONTAL ADJUSTMENT REPORT
==============================

Unadjusted Observations
========================
Control Coordinates:
   1 Observed Points,
   0 Fixed Points,
   0 Approx. Points
Sta. N: E: StErr N: StErr E:
1 658428.26 2150182.70 0.01 0.01

The first distance listing in the Unadjusted Observation section of the report shows the unadjusted horizontal ground distances

Distances:
14 Observations
From Sta. To Sta. Ground Dist. StErr
1 5 290.45 0.01
1 2 292.21 0.01
2 6 52.39 0.01
2 3 324.19 0.01
3 4 275.60 0.01
3 20 134.66 0.01
20 21 116.07 0.01
21 22 50.12 0.01
4 5 309.65 0.01
5
<table>
<thead>
<tr>
<th>BS Sta.</th>
<th>Occ. Sta.</th>
<th>FS Sta.</th>
<th>Angle (Sec.)</th>
<th>StErr</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>129.99</td>
<td>0.01</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>11</td>
<td>126.01</td>
<td>0.01</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>15</td>
<td>10.00</td>
<td>0.01</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>12</td>
<td>129.43</td>
<td>0.01</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>3</td>
<td>144.65</td>
<td>0.01</td>
<td></td>
</tr>
</tbody>
</table>

**Angles:**
15 Observations

<table>
<thead>
<tr>
<th>BS Sta.</th>
<th>Occ. Sta.</th>
<th>FS Sta.</th>
<th>Angle (Sec.)</th>
<th>StErr</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>1</td>
<td>2</td>
<td>109-19'13.5''</td>
<td>7.7</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>6</td>
<td>190-32'06.0''</td>
<td>26.2</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>3</td>
<td>096-03'52.0''</td>
<td>7.3</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>4</td>
<td>124-03'53.0''</td>
<td>7.8</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>20</td>
<td>185-23'56.0''</td>
<td>12.8</td>
</tr>
<tr>
<td>3</td>
<td>20</td>
<td>21</td>
<td>180-15'26.0''</td>
<td></td>
</tr>
</tbody>
</table>
17.6

20
  21
  22
  183-26'45.0"
  31.2

3
  4
  5
  093-02'11.5"
  7.5

4
  5
  10
  039-26'40.0"
  10.4

5
  10
  11
  241-56'29.0"
  15.6

5
  10
  15
  056-23'10.0"
  125.0

10
  11
  12
  114-56'27.0"
  15.5

11
  12
  3
  140-39'24.5"
  15.3

12
  3
  2
  325-54'30.0"
  9.5

4
  5
  1
  117-30'42.5"
  7.7

Grid Azimuths:
  1 Observations
Occ. Sta.
FS Sta.

Chapter 19. SurvNET

1602
There is a new section displaying the reduced unadjusted grid distances. The grid factor, the elevation factor, and the combined factor used to reduce the ground distance to a grid distance are included in the listing:

<table>
<thead>
<tr>
<th>From Sta.</th>
<th>To Sta.</th>
<th>Grid Dist.</th>
<th>Grid Factor</th>
<th>Z Factor</th>
<th>Combined Factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
<td>290.41</td>
<td>0.99988685</td>
<td>0.9998804</td>
<td>0.99987490</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>292.18</td>
<td>0.99988686</td>
<td>0.9998804</td>
<td>0.99987491</td>
</tr>
<tr>
<td>2</td>
<td>6</td>
<td>52.38</td>
<td>0.99988689</td>
<td>0.9998804</td>
<td>0.99987494</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>324.15</td>
<td>0.99988692</td>
<td>0.9998804</td>
<td>0.99987497</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
<td>275.57</td>
<td>0.99988695</td>
<td>0.9998804</td>
<td>0.99987500</td>
</tr>
<tr>
<td>3</td>
<td>20</td>
<td>134.65</td>
<td>0.99988697</td>
<td>0.9998804</td>
<td>0.99987501</td>
</tr>
<tr>
<td>20</td>
<td>21</td>
<td>116.06</td>
<td>0.99988700</td>
<td>0.9998804</td>
<td></td>
</tr>
</tbody>
</table>
There is a new section displaying the reduced unadjusted horizontal angles with the t-T correction applied. The t-T correction is generally a small correction. For most surveys of limited size the correction is negligible. The t-T correction is displayed in seconds.

Grid Horizontal Angles:
15 Observations
BS Sta.  Occ. Sta.  FS Sta.
Angle  StErr (Sec.)  t-T

<table>
<thead>
<tr>
<th>BS Sta.</th>
<th>Occ. Sta.</th>
<th>FS Sta.</th>
<th>Angle</th>
<th>StErr (Sec.)</th>
<th>t-T</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>1</td>
<td>2</td>
<td>0.99987504</td>
<td>22</td>
<td>50.11</td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>309.61</td>
<td>0.99988691</td>
<td>0.99998804</td>
<td>0.99987495</td>
</tr>
<tr>
<td>5</td>
<td>10</td>
<td>129.97</td>
<td>0.99988688</td>
<td>0.99998804</td>
<td>0.99987493</td>
</tr>
<tr>
<td>10</td>
<td>11</td>
<td>125.99</td>
<td>0.99988689</td>
<td>0.99998804</td>
<td>0.99987494</td>
</tr>
<tr>
<td>15</td>
<td>10</td>
<td>10.00</td>
<td>0.99988690</td>
<td>0.99998804</td>
<td>0.99987494</td>
</tr>
<tr>
<td>11</td>
<td>12</td>
<td>129.41</td>
<td>0.99988690</td>
<td>0.99998804</td>
<td>0.99987495</td>
</tr>
<tr>
<td>12</td>
<td>3</td>
<td>144.63</td>
<td>0.99988694</td>
<td>0.99998804</td>
<td>0.99987498</td>
</tr>
</tbody>
</table>

Chapter 19. SurvNET
<table>
<thead>
<tr>
<th></th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>2</td>
<td>6</td>
<td>190-32'06.0''</td>
<td>26.2</td>
<td>0.0</td>
</tr>
<tr>
<td>1</td>
<td></td>
<td></td>
<td>096-03'52.0''</td>
<td>7.3</td>
<td>0.0</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>3</td>
<td>124-03'53.0''</td>
<td>7.8</td>
<td>-0.0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3</td>
<td>20</td>
<td>185-23'56.0''</td>
<td>12.8</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>20</td>
<td>21</td>
<td>180-15'26.0''</td>
<td>17.6</td>
</tr>
<tr>
<td></td>
<td></td>
<td>21</td>
<td>22</td>
<td>183-26'45.0''</td>
<td>31.2</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td>4</td>
<td>5</td>
<td>093-02'11.5''</td>
<td>7.5</td>
</tr>
<tr>
<td>5</td>
<td></td>
<td>10</td>
<td>10</td>
<td>039-26'40.0''</td>
<td>10.4</td>
</tr>
<tr>
<td></td>
<td>10</td>
<td>11</td>
<td>241-56'29.0''</td>
<td>15.6</td>
<td>0.0</td>
</tr>
<tr>
<td>5</td>
<td></td>
<td>10</td>
<td>15</td>
<td>056-23'10.0''</td>
<td>125.0</td>
</tr>
</tbody>
</table>

Chapter 19. SurvNET
Adjusted Coordinates
====================

<table>
<thead>
<tr>
<th>Sta.</th>
<th>N:</th>
<th>E:</th>
<th>StErr N:</th>
<th>StErr E:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>658428.26</td>
<td>2150182.70</td>
<td>0.02</td>
<td>0.02</td>
</tr>
<tr>
<td>2</td>
<td>658634.86</td>
<td>2150389.30</td>
<td>0.02</td>
<td>0.02</td>
</tr>
<tr>
<td>5</td>
<td>658554.11</td>
<td>2149920.95</td>
<td>0.03</td>
<td>0.02</td>
</tr>
<tr>
<td>3</td>
<td>658886.98</td>
<td>2150185.59</td>
<td>0.02</td>
<td>0.03</td>
</tr>
<tr>
<td>4</td>
<td>658863.56</td>
<td>2149911.03</td>
<td>0.03</td>
<td>0.03</td>
</tr>
<tr>
<td>20</td>
<td>658999.20</td>
<td>2150111.20</td>
<td>0.03</td>
<td>0.03</td>
</tr>
</tbody>
</table>
In the Adjusted Coordinates section of the report there is a new section displaying the latitude and longitude of the final adjusted points. Additionally the convergence angle, the grid factor, the elevation factor, and the combined factor are displayed for each point:

**Adjusted Geographic Coordinates**

<table>
<thead>
<tr>
<th>Sta.</th>
<th>Latitude</th>
<th>Longitude</th>
<th>Conv.</th>
<th>Grid Factor</th>
<th>Z Factor</th>
<th>Combined Fact.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>35-33'29.13143''N 78-29'42.16576''E</td>
<td>000-17'29.2''</td>
<td>0.99988684</td>
<td>0.99998804</td>
<td>0.99987488</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>35-33'31.16445''N 78-29'39.65237''E</td>
<td>000-17'30.7''</td>
<td>0.99988689</td>
<td>0.99998804</td>
<td>0.99987493</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>35-33'33.66835''N 78-29'42.10255''E</td>
<td>000-17'29.2''</td>
<td>0.99988695</td>
<td>0.99998804</td>
<td>0.99987500</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>35-33'33.45055''N 78-29'42.42733''E</td>
<td>000-17'27.3''</td>
<td>0.99988695</td>
<td>0.99998804</td>
<td>0.99987499</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>35-33'34.78212''N 78-29'43.76102''E</td>
<td>000-17'28.7''</td>
<td>0.99988698</td>
<td>0.99998804</td>
<td>0.99987503</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>35-33'35.74495''N 78-29'43.76102''E</td>
<td>000-17'28.3''</td>
<td>0.99988701</td>
<td>0.99998804</td>
<td>0.99987505</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>35-33'31.40380''N 78-29'44.35979''E</td>
<td>000-17'27.9''</td>
<td>0.99988690</td>
<td>0.99998804</td>
<td>0.99987494</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>35-33'31.19087''N 78-29'42.85714''E</td>
<td>000-17'28.8''</td>
<td>0.99988689</td>
<td>0.99998804</td>
<td>0.99987493</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>35-33'32.24222''N 78-29'41.96349''E</td>
<td>000-17'29.3''</td>
<td>0.99988692</td>
<td>0.99998804</td>
<td>0.99987496</td>
<td></td>
</tr>
</tbody>
</table>

**Adjusted Coordinates Error Ellipses, 95% CI**

<table>
<thead>
<tr>
<th>Sta.</th>
<th>Semi Major</th>
<th>Semi Minor</th>
<th>Max. Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.05</td>
<td>0.05</td>
<td>N 17-17'30.9''E</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Adjusted Observations

Adjusted Distances

<table>
<thead>
<tr>
<th>From Sta.</th>
<th>To Sta.</th>
<th>Distance</th>
<th>Residual</th>
<th>StdRes.</th>
<th>StdDev</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>5</td>
<td>290.43</td>
<td>0.01</td>
<td>1.42</td>
<td>0.01</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>292.17</td>
<td>-0.00</td>
<td>0.40</td>
<td>0.01</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>324.13</td>
<td>-0.01</td>
<td>1.62</td>
<td>0.01</td>
</tr>
</tbody>
</table>

Chapter 19. SurvNET
Chapter 19. SurvNET

Root Mean Square (RMS)

Adjusted Angles

BS Sta.
Occ. Sta.
FS Sta.
Angle
Residual
StdRes
StdDev(Sec.)
Chapter 19. SurvNET

1
  2
  3
  096-03'43.4''
  -8.6
  1.2
  9.2

2
  3
  4
  124-03'48.1''
  -4.9
  0.6
  10.1

2
  3
  20
  185-23'56.0''
  -0.0
  0.0
  21.5

3
  20
  21
  180-15'26.0''
  -0.0
  0.0
  29.7

3
  4
  5
  093-02'12.8''
  1.2
  0.2
  9.3

4
  5
  10
  039-26'37.2''
  -2.8
  0.3
  14.4

5
  10
  11
  241-56'27.5''
  -1.5
  0.1
  21.2

10
### Adjusted Azimuths

<table>
<thead>
<tr>
<th>Occ. Sta.</th>
<th>FS Sta.</th>
<th>Bearing Residual</th>
<th>StdRes</th>
<th>StdDev(Sec.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
<td>N 45-00'00.0''E</td>
<td>-0.0</td>
<td>0.0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>8.4</td>
</tr>
</tbody>
</table>

**Root Mean Square (RMS)**

0.0

**Statistics**

**Solution converged in 2 iterations**

Degrees of freedom: 6

Reference variance: 2.84

Standard error unit Weight: +/-1.69

Failed the Chi-Square test at the 95.00 significance level

1.237 <= 17.037 <= 14.449
## Sideshots

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Bearing</th>
<th>Dist.</th>
<th>N</th>
<th>E</th>
<th>StDev. N</th>
<th>StDev. E</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td></td>
<td>N 55-32'06.0''E</td>
<td>52.38</td>
<td>658664.50</td>
<td>2150432.48</td>
<td>0.02</td>
<td>0.02</td>
</tr>
<tr>
<td>20</td>
<td></td>
<td>N 29-50'09.6''W</td>
<td>50.11</td>
<td>659139.69</td>
<td>2150022.58</td>
<td>0.04</td>
<td>0.05</td>
</tr>
<tr>
<td>10</td>
<td></td>
<td>N 86-00'28.6''W</td>
<td>10.00</td>
<td>658657.77</td>
<td>2149990.30</td>
<td>0.03</td>
<td>0.03</td>
</tr>
</tbody>
</table>

### GPS Network

Note: The following section shows the report generated by the least squares adjustment of the GPS network. Explanations of the report are included in the report section and are in bold text.

---

**LEAST SQUARES ADJUSTMENT REPORT**

---

Mon May 08 13:03:02 2006

3D Geodetic Model.

Input Raw Files:

```
C:\data\lsdata\3dModel\gpsOnly\control.cgr
```

GPS File:

```
C:\data\lsdata\3dModel\gpsOnly\chapt16.gps
```

Output File: C:\data\lsdata\3dModel\gpsOnly\gpsOnly1.RPT

Traverse File: C:\data\lsdata\3dModel\gpsOnly\gpsLoops.cls

Curvature, refraction correction: OFF

Maximum iterations: 10, Convergence Limit: 0.002000

1983 State Plane Coordinates, zone: 4803 Wisconsin South

Horizontal Units: Meters
The following section shows the unadjusted measurements that make up the network. The control coordinates are displayed first followed by the GPS vectors. The control coordinates are displayed as latitude/longitude, SPC Grid XYZ, and geocentric XYZ. If geoid modeling is set both ellipsoid and orthometric elevations are displayed, ellipsoid elevation in the latitude/longitude section and orthometric elevation in the SPC section. The GPS vector section shows the unadjusted delta XYZ, variances and covariances of the vectors.

Unadjusted Observations
=================================

Control Coordinates:
  0 Observed Points,
  2 Fixed Points,
  0 Approx. Points

Sta.  Latitude  Longitude  Z (Ellip.)  StErr N:  StErr E:  StErr Z:

A
43-15'46.28901''N 89-59'42.16399''W 1382.62  FIXED  FIXED  FIXED

B
43-23'46.36261''N 89-54'00.75701''W 1235.46  FIXED  FIXED  FIXED

Grid XYZ
Sta.  N:  E:  Z (Geoid):
      StErr N:  StErr E:  StErr Z:

A
140291.2060  600402.2380
Geocentric XYZ
Sta. X: Y: Z: StErr X: StErr Y: StErr Z:
A 402.3510 -4652995.3008 4349760.78 FIXED FIXED FIXED
B 8086.0316 -4642712.8473 4360439.08 FIXED FIXED FIXED

GPS Vectors:
13 Observations
From Sta.
Delta X Variance Delta X Covariance XY
To Sta.
Delta Y Variance Delta Y Covariance XZ Delta Z
Variance Delta Z Covariance YZ

A 11644.223
0.001969 -1.916E-005
C 3601.217
0.001875 1.904E-005
3399.255
0.001965 -1.904E-005
<p>| | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>-5321.716</td>
<td>0.0004316</td>
<td>-4.2E-006</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B</td>
<td>3960.544</td>
<td>0.000461</td>
<td>-4.46E-006</td>
<td></td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>-6681.247</td>
<td>0.0005092</td>
<td>4.14E-006</td>
<td>-729.015</td>
<td></td>
</tr>
<tr>
<td>D</td>
<td>-11167.608</td>
<td>0.00054</td>
<td>-5.5E-006</td>
<td></td>
<td></td>
</tr>
<tr>
<td>E</td>
<td>3634.075</td>
<td>0.0003838</td>
<td>4.32E-006</td>
<td>3173.665</td>
<td></td>
</tr>
<tr>
<td>F</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1616</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Chapter 19. SurvNET
The optional Traverse Closure section shows the GPS loop closures for the GPS loops defined in the closure, .CLS file.

Traverse Closures
================
GPS Loop Points:
A,E,F,A

GPS Loop Closure;

Misclosure, X:  
-0.0323
Y:  
-0.0162
Z:  
-0.0105
Closure error:  
0.0376
Perimeter: 20229.3858
Precision: 1:537594

GPS Loop Points:
C,F,D,B,C

GPS Loop Closure;

Misclosure, X:  
-0.0121
Y:  
-0.0101
Z:  
0.0002
Closure error:  
0.0158
Perimeter: 41332.9807
Precision: 1:2622216

GPS Loop Points:
F,D,B,F

GPS Loop Closure;

Misclosure, X:
-0.0022
Y:
-0.0044
Z:
0.0097
Closure error:
0.0109
Perimeter: 30814.5047
Precision: 1:2833226

Following are the final adjusted coordinates. Included in the report are point grid factor, elev. factor and the combined factor. Following the adjusted coordinates are the error ellipses, followed by the adjusted measurements section.

Adjusted Geographic Coordinates

Adjusted Grid Coordinates, (Meters)
Sta.
N:
E:
Z (Geoid):
StErr N:
StErr E:
StErr Z:
C
145233.5553
612043.7117
1103.10
0.0062
0.0062 0.0060
E
145091.9380
595081.6888
914.98
0.0053
0.0053 0.0052
D
154179.9383
596919.0552
894.01
0.0051
0.0050
0.0052
F
146611.7860
601518.4564
1024.24
0.0029
0.0027
0.0028

Adjusted Geocentric Coordinates, (Metric)
Sta.
X:
Y:
Z:
Adjusted XYZ Coordinates Error Ellipses, 95% CI

Sta.  
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>0.0161</td>
<td>0.0159</td>
<td>S 25-49'31.6''E</td>
<td>0.0157</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E</td>
<td>0.0138</td>
<td>0.0137</td>
<td>S 29-24'51.2''E</td>
<td>0.0136</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D</td>
<td>0.0133</td>
<td>0.0130</td>
<td>S 11-30'48.4''E</td>
<td>0.0135</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F</td>
<td>0.0074</td>
<td>0.0070</td>
<td>S 05-18'52.7''E</td>
<td>0.0073</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Adjusted Observations
GPS Vectors:
  13 Observations
From Sta.
  Delta X
  Residual
  StdRes
  StdDev
To Sta.
  Delta Y
  Residual
  StdRes
  StdDev
            Delta Z
  Residual
  StdRes
  StdDev

<table>
<thead>
<tr>
<th></th>
<th>Delta X</th>
<th>Residual</th>
<th>StdRes</th>
<th>StdDev</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>11644.2435</td>
<td>0.0203</td>
<td>0.4581</td>
<td>0.0062</td>
</tr>
<tr>
<td>C</td>
<td>3601.2230</td>
<td>0.0065</td>
<td>0.1502</td>
<td>0.0062</td>
</tr>
<tr>
<td></td>
<td>3399.2795</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>-5321.7125</td>
<td>0.0039</td>
<td>0.1894</td>
<td>0.0053</td>
</tr>
<tr>
<td>E</td>
<td>3634.1005</td>
<td>0.0251</td>
<td>1.2810</td>
<td>0.0053</td>
</tr>
<tr>
<td></td>
<td>3173.6781</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B</td>
<td>3960.5330</td>
<td>-0.0112</td>
<td>0.5219</td>
<td>0.0062</td>
</tr>
<tr>
<td>C</td>
<td>-6681.2418</td>
<td>0.0049</td>
<td>0.2181</td>
<td>0.0062</td>
</tr>
<tr>
<td></td>
<td>-7279.0098</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.0050</td>
<td>0.2378</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Column</td>
<td>Value</td>
<td>Standard Error</td>
<td>p-value</td>
<td>df</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
<td>----------------</td>
<td>---------</td>
<td>-----</td>
</tr>
<tr>
<td>B</td>
<td>-11167.6067</td>
<td>0.0009</td>
<td>0.0406</td>
<td>0.0050</td>
</tr>
<tr>
<td></td>
<td>0.0009</td>
<td>0.0050</td>
<td></td>
<td></td>
</tr>
<tr>
<td>D</td>
<td>-394.5281</td>
<td>-0.0077</td>
<td>0.3288</td>
<td>0.0051</td>
</tr>
<tr>
<td></td>
<td>0.0077</td>
<td>0.0051</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>-0.0013</td>
<td>0.0568</td>
<td></td>
<td>0.0052</td>
</tr>
<tr>
<td>D</td>
<td>15128.1644</td>
<td>-0.0003</td>
<td>0.0194</td>
<td>0.0063</td>
</tr>
<tr>
<td></td>
<td>0.0003</td>
<td>0.0063</td>
<td></td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>-6286.7131</td>
<td>-0.0077</td>
<td>0.4275</td>
<td>0.0064</td>
</tr>
<tr>
<td></td>
<td>0.0077</td>
<td>0.0064</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>-0.0009</td>
<td>0.0573</td>
<td></td>
<td>0.0061</td>
</tr>
<tr>
<td>D</td>
<td>-1837.7566</td>
<td>-0.0107</td>
<td>0.6844</td>
<td>0.0056</td>
</tr>
<tr>
<td></td>
<td>0.0107</td>
<td>0.0056</td>
<td></td>
<td></td>
</tr>
<tr>
<td>E</td>
<td>-6253.8502</td>
<td>0.0032</td>
<td>0.2006</td>
<td>0.0057</td>
</tr>
<tr>
<td></td>
<td>0.0032</td>
<td>0.0057</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.0010</td>
<td>0.0619</td>
<td></td>
<td>0.0057</td>
</tr>
<tr>
<td>F</td>
<td>-1116.4498</td>
<td>0.0025</td>
<td>0.2079</td>
<td>0.0027</td>
</tr>
<tr>
<td></td>
<td>0.0025</td>
<td>0.0027</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>-4596.1557</td>
<td>0.0053</td>
<td>0.4606</td>
<td>0.0029</td>
</tr>
<tr>
<td></td>
<td>0.0053</td>
<td>0.0029</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>-0.0077</td>
<td>0.6259</td>
<td></td>
<td>0.0028</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>------</td>
<td>-------</td>
<td>-------</td>
<td>-------</td>
<td>-------</td>
</tr>
<tr>
<td>F</td>
<td>10527.7799</td>
<td>-0.0053</td>
<td>0.2318</td>
<td>0.0061</td>
</tr>
<tr>
<td></td>
<td>C</td>
<td>-994.9372</td>
<td>0.0005</td>
<td>0.0223</td>
</tr>
<tr>
<td></td>
<td></td>
<td>-956.6272</td>
<td>-0.0026</td>
<td>0.1175</td>
</tr>
<tr>
<td></td>
<td></td>
<td>-6438.1411</td>
<td>-0.0047</td>
<td>0.3391</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>E</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>-962.0744</td>
<td>-0.0050</td>
<td>0.3507</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>-1182.2367</td>
</tr>
<tr>
<td></td>
<td></td>
<td>-4600.3844</td>
<td>-0.0057</td>
<td>0.4188</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>D</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>5291.7758</td>
<td>-0.0027</td>
<td>0.1889</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>5414.4321</td>
</tr>
<tr>
<td></td>
<td></td>
<td>6567.2308</td>
<td>-0.0003</td>
<td>0.0220</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>B</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>5686.2978</td>
<td>0.0052</td>
<td>0.4292</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>6322.3917</td>
</tr>
</tbody>
</table>

Chapter 19. SurvNET
The final section displays a variety statistical measures, followed by sideshots if there are any. Side shots would be a point that has only a single GPS vector going to or from the point.

Statistics
==========
Solution converged in 2 iterations
Degrees of freedom: 27
Reference variance: 0.26
Standard error unit Weight: +/-0.51
Failed the Chi-Square test at the 95.00 significance level
14.573 <= 6.927 <= 43.195

Sideshots
========

GPS Vectors and Total Station
Following is a report generated from a project that combined GPS vectors and total station data. Notice that the report is very similar to the GPS vector only project report. Explanations of the report are included in the report and are in bold, normal text.

---
LEAST SQUARES ADJUSTMENT REPORT
---

Mon May 08 15:08:39 2006
3D Geodetic Model.
Input Raw Files:
   C:\data\isdata\3dModel\GPSCombined\rawCombined.cgr
GPS File:
Output File: C:\data\lsdata\3dModel\GPSCombined\gpsCombined2D.RPT
Curvature, refraction correction: OFF
Maximum iterations: 10, Convergence Limit: 0.000200
1983 State Plane Coordinates, zone:0202 Arizona Central
Horizontal Units: Meters
Confidence Interval: 95.00
Project Geoid Height: -30.000

Default Standard Errors:
Distance: Constant 0.002, PPM: 5.000
Horiz. Angle: Pointing 0.6', Reading: 0.0'
Vert. Angle: Pointing 2.0', Reading: 3.0'
Total Station: Centering 0.001, Height: 0.002
Target: Centering 0.001, Height: 0.002
Azimuth: 5'
Coordinate Control: N:0.010, E:0.010, Z:0.030,
GPS: Centering:0.001, Vector Err. Factor:10.0

3-DIMENSIONAL ADJUSTMENT REPORT
==================================

Notice that in this example geoid modeling was used. Notice that the ellipsoid elevation is displayed with the latitudes and longitudes. Orthometric elevations are displayed with the SPC83 grid coordinates.

Unadjusted Observations
========================

Control Coordinates:
  0 Observed Points,
  2 Fixed Points,
  0 Approx. Points
Sta.  Latitude    Longitude
   Z (Ellip.)  StErr N: StErr E: StErr Z:
 17   32'-58'09.73116''N 112-47'13.55718''W 179.384  FIXED  FIXED  FIXED
12   33'-04'44.24403''N 112-54'36.04569''W 194.299  FIXED  FIXED  FIXED

Grid XYZ
Sta.
   N:  E:  Z (Geoid):
   StErr N: StErr E: StErr Z:
 17

Chapter 19. SurvNET
Notice that in the 3-D model distances are not reduced to horizontal or grid. Slope distances are reduced to mark to mark distances. A Mark to mark distance is the computed slope distance from the monument to monument.

Mark to Mark Slope Distances:

<table>
<thead>
<tr>
<th>From Sta.</th>
<th>To Sta.</th>
<th>Dist.</th>
<th>StErr</th>
</tr>
</thead>
<tbody>
<tr>
<td>13</td>
<td>51</td>
<td>4013.947</td>
<td>0.022</td>
</tr>
<tr>
<td>51</td>
<td>52</td>
<td>2208.268</td>
<td>0.013</td>
</tr>
<tr>
<td>52</td>
<td>53</td>
<td>2202.068</td>
<td>0.013</td>
</tr>
<tr>
<td>53</td>
<td>18</td>
<td>2714.298</td>
<td>0.016</td>
</tr>
</tbody>
</table>
Notice that in the 3-D model distances vertical angles are considered as separate measurements. Vertical angles have also been converted to mark to mark vertical angles.

Mark to Mark Vertical Angles:
  8 Observations
From Sta.  To Sta.
  Vertical
Ang.  StErr (Sec.)
  13
      51  090-04'46.6''
          3.6
  51
      52  090-14'33.0''
          3.6
  52
      53  089-43'23.7''
          3.6
  53
      18  089-58'21.3''
          3.6
  51
      15  090-27'52.0''
          3.6
  52
      15  090-05'53.1''
          3.6
  52
      16  090-07'37.0''
          3.6
<table>
<thead>
<tr>
<th>BS Sta.</th>
<th>Occ. Sta.</th>
<th>FS Sta.</th>
<th>Angle</th>
<th>StErr (Sec.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>13</td>
<td>51</td>
<td>067-58'23.5''</td>
<td>0.8</td>
</tr>
<tr>
<td>13</td>
<td>51</td>
<td>52</td>
<td>160-18'01.7''</td>
<td>0.9</td>
</tr>
<tr>
<td>51</td>
<td>52</td>
<td>53</td>
<td>213-47'22.1''</td>
<td>0.9</td>
</tr>
<tr>
<td>52</td>
<td>53</td>
<td>18</td>
<td>198-52'17.3''</td>
<td>0.9</td>
</tr>
<tr>
<td>13</td>
<td>51</td>
<td>15</td>
<td>240-35'47.0''</td>
<td>0.9</td>
</tr>
<tr>
<td>51</td>
<td>52</td>
<td>15</td>
<td>320-50'46.2''</td>
<td>0.9</td>
</tr>
<tr>
<td>51</td>
<td>52</td>
<td>16</td>
<td>142-02'01.5''</td>
<td>0.9</td>
</tr>
<tr>
<td>52</td>
<td>53</td>
<td>16</td>
<td>061-14'43.7''</td>
<td>0.9</td>
</tr>
</tbody>
</table>
GPS Vectors:
  8 Observations
From Sta.
  Delta X
  Variance Delta X
  Covariance XY
To Sta.
  Delta Y
  Variance Delta Y
  Covariance XZ
  Delta Z
  Variance Delta Z
  Covariance YZ

<table>
<thead>
<tr>
<th></th>
<th>Delta X</th>
<th>Variance Delta X</th>
<th>Covariance XY</th>
<th>Delta Y</th>
<th>Variance Delta Y</th>
<th>Covariance XZ</th>
<th>Delta Z</th>
<th>Variance Delta Z</th>
<th>Covariance YZ</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>-507.728</td>
<td>6.64E-005</td>
<td>7.231E-005</td>
<td>13</td>
<td>-5749.936</td>
<td>0.0002136</td>
<td>-1.914E-005</td>
<td>-8484.249</td>
<td>-6.468E-005</td>
</tr>
<tr>
<td></td>
<td>12</td>
<td>5291.644</td>
<td>4.281E-005</td>
<td>16</td>
<td>-4337.804</td>
<td>0.0001497</td>
<td>-1.252E-005</td>
<td>-3048.755</td>
<td>-4.592E-005</td>
</tr>
<tr>
<td></td>
<td>13</td>
<td>4725.685</td>
<td>0.0001066</td>
<td>15</td>
<td>-1175.977</td>
<td>0.0002265</td>
<td>-5.722E-005</td>
<td>1127.564</td>
<td>-9.329E-005</td>
</tr>
<tr>
<td></td>
<td>13</td>
<td>5799.369</td>
<td>5.779E-005</td>
<td>16</td>
<td>1412.130</td>
<td>0.0001984</td>
<td>-1.63E-005</td>
<td>5435.492</td>
<td>7.569E-005</td>
</tr>
</tbody>
</table>

Chapter 19. SurvNET
15
3797.625
0.0001611
0.0001685
17
-3625.824
0.001025
-8.94E-005
-2841.898
0.0003411
-0.000365
16
2723.952
6.601E-005
6.098E-005
17
-6213.925
0.0001595
-3.951E-005
-7149.837
0.0001187
-8.61E-005
16
3983.996
4.166E-005
3.668E-005
18
-2884.461
9.022E-005
-2.464E-005
-1679.646
6.868E-005
-4.835E-005
17
1260.043
3.331E-005
2.912E-005
18
3329.461
7.695E-005
-1.931E-005
5470.192
6.021E-005
-4.279E-005

Adjusted Geographic Coordinates

Adjusted Grid Coordinates, (Meters)

Sta.
N:
E:
Z (Geoid):
StErr N:
StErr E:
StErr Z:
13
  220822.407
  122293.821
  205.469
  0.011
  0.006
  0.007
51
  222914.991
  125719.002
  200.982
  0.013
  0.008
  0.028
52
  224634.004
  127105.001
  191.980
  0.011
  0.009
  0.028
53
  225289.986
  129206.984
  202.983
  0.011
  0.008
  0.032
18
  225217.062
  131920.203
  204.850
  0.008
  0.005
  0.007
15
  222134.510
  127117.007
  188.195
  0.013
  0.008
  0.011
16
  227273.259
  127147.034
  186.643
  0.007
  0.004
  0.006

Adjusted Geocentric Coordinates, (Metric)
Sta.
  X:
  Y:
  Z:
StErr X:
StErr Y:
StErr Z:
13
  -2083128.851
  -4933602.055
Adjusted XYZ Coordinates Error Ellipses, 95% CI

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>13</td>
<td>0.030</td>
<td></td>
<td>0.013</td>
<td>N 20-10'14.1''E</td>
<td>0.019</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>From Sta.</td>
<td>To Sta.</td>
<td>Distance</td>
<td>Residual</td>
<td>StdRes.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>---------</td>
<td>----------</td>
<td>----------</td>
<td>---------</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>51</td>
<td>4013.941</td>
<td>-0.005</td>
<td>0.244</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0.013</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>51</td>
<td>52</td>
<td>2208.258</td>
<td>-0.011</td>
<td>0.803</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0.010</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>52</td>
<td>53</td>
<td>2202.072</td>
<td>0.004</td>
<td>0.281</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0.011</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>53</td>
<td>18</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Adjusted Observations**

=======================

Adjusted Mark to Mark Distances

From Sta.
To Sta.
Distance
Residual
StdRes.
StdDev

13
51
4013.941
-0.005
0.244
0.013
51
52
2208.258
-0.011
0.803
0.010
52
53
2202.072
0.004
0.281
0.011
53
18

Chapter 19. SurvNET
<table>
<thead>
<tr>
<th>BS Sta.</th>
<th>Occ. Sta.</th>
<th>FS Sta.</th>
<th>Angle</th>
<th>Residual</th>
<th>StdRes</th>
<th>StdDev(Sec.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>13</td>
<td>51</td>
<td>067-58'22.4''</td>
<td>-1.1</td>
<td>1.3</td>
<td>0.4</td>
</tr>
<tr>
<td>13</td>
<td>51</td>
<td>52</td>
<td>160-18'02.3''</td>
<td>0.6</td>
<td>0.7</td>
<td>0.7</td>
</tr>
<tr>
<td>51</td>
<td>52</td>
<td>53</td>
<td>213-47'22.2''</td>
<td>0.1</td>
<td>0.1</td>
<td>0.7</td>
</tr>
</tbody>
</table>

Adjusted Angles

Root Mean Square (RMS) 0.008
<table>
<thead>
<tr>
<th>From Sta.</th>
<th>To Sta.</th>
<th>Vertical Ang.</th>
<th>Residual</th>
<th>StdRes</th>
<th>StdDev(Sec.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>13</td>
<td>51</td>
<td>090-04'55.5''</td>
<td>-9.0</td>
<td>2.5</td>
<td>1.4</td>
</tr>
<tr>
<td>51</td>
<td>52</td>
<td>090-14'36.5''</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* Root Mean Square (RMS) 0.6

Adjusted vertical angles
From Sta.  To Sta.  Vertical Ang.  Residual  StdRes  StdDev(Sec.)
13 51 090-04'55.5'' -9.0 * 2.5 1.4
51 52 090-14'36.5''
-3.5
1.0
2.9

52
53
089-43'25.0''
-1.2
0.3
3.1

53
18
089-58'22.0''
-0.7
0.2
2.4

51
15
090-27'53.0''
-1.0
0.3
3.4

52
15
090-05'52.9''
0.2
0.1
2.3

52
16
090-07'39.9''
-2.9
0.8
2.1

53
16
090-20'24.9''
-0.9
0.2
2.3

Root Mean Square (RMS)
3.6

GPS Vectors:
  8 Observations
From Sta.
  Delta X
  Residual
  StdRes
  StdDev
To Sta.
  Delta Y
  Residual
  StdRes

Chapter 19. SurvNET
<table>
<thead>
<tr>
<th>StdDev</th>
<th>Delta Z</th>
</tr>
</thead>
<tbody>
<tr>
<td>Residual</td>
<td>StdRes</td>
</tr>
<tr>
<td>StdDev</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
</tr>
<tr>
<td>-0.0022</td>
<td>-507.7297</td>
</tr>
<tr>
<td>0.267</td>
<td></td>
</tr>
<tr>
<td>0.0061</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td></td>
</tr>
<tr>
<td>0.0102</td>
<td>-5749.9259</td>
</tr>
<tr>
<td>0.699</td>
<td></td>
</tr>
<tr>
<td>0.0109</td>
<td>-8484.2524</td>
</tr>
<tr>
<td>-0.0037</td>
<td></td>
</tr>
<tr>
<td>0.409</td>
<td></td>
</tr>
<tr>
<td>0.0072</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>5291.6464</td>
</tr>
<tr>
<td>0.0028</td>
<td></td>
</tr>
<tr>
<td>0.430</td>
<td></td>
</tr>
<tr>
<td>0.0045</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>-4337.7947</td>
</tr>
<tr>
<td>0.0096</td>
<td></td>
</tr>
<tr>
<td>0.785</td>
<td></td>
</tr>
<tr>
<td>0.0074</td>
<td>-3048.7649</td>
</tr>
<tr>
<td>-0.0095</td>
<td></td>
</tr>
<tr>
<td>1.298</td>
<td></td>
</tr>
<tr>
<td>0.0055</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>4725.6931</td>
</tr>
<tr>
<td>0.0085</td>
<td></td>
</tr>
<tr>
<td>0.818</td>
<td></td>
</tr>
<tr>
<td>0.0080</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>-1175.9849</td>
</tr>
<tr>
<td>-0.0083</td>
<td></td>
</tr>
<tr>
<td>0.549</td>
<td></td>
</tr>
<tr>
<td>0.0115</td>
<td>1127.5557</td>
</tr>
<tr>
<td>-0.0086</td>
<td></td>
</tr>
<tr>
<td>0.754</td>
<td></td>
</tr>
<tr>
<td>0.0100</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>5799.3676</td>
</tr>
<tr>
<td>-0.0014</td>
<td></td>
</tr>
<tr>
<td>0.185</td>
<td></td>
</tr>
<tr>
<td>0.0060</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>1412.1252</td>
</tr>
<tr>
<td>-0.0048</td>
<td></td>
</tr>
<tr>
<td>0.339</td>
<td></td>
</tr>
<tr>
<td>0.0107</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>15</td>
<td>5435.4912</td>
</tr>
<tr>
<td>17</td>
<td>3797.6184</td>
</tr>
<tr>
<td>17</td>
<td>-3625.8277</td>
</tr>
<tr>
<td></td>
<td>-2841.9072</td>
</tr>
<tr>
<td>16</td>
<td>2723.9438</td>
</tr>
<tr>
<td>17</td>
<td>-6213.9378</td>
</tr>
<tr>
<td></td>
<td>-7149.8428</td>
</tr>
<tr>
<td>16</td>
<td>3983.9875</td>
</tr>
<tr>
<td>18</td>
<td>-2884.4705</td>
</tr>
<tr>
<td></td>
<td>-1679.6485</td>
</tr>
<tr>
<td>17</td>
<td>1260.0437</td>
</tr>
<tr>
<td>18</td>
<td>3329.4673</td>
</tr>
<tr>
<td></td>
<td>5470.1943</td>
</tr>
</tbody>
</table>
Statistics
==========
Solution converged in 3 iterations
Degrees of freedom: 27
Reference variance: 1.32
Standard error unit Weight: +/- 1.15
Passed the Chi-Square test at the 95.00 significance level
14.573 <= 35.620 <= 43.195

Sideshots
----------

Vertical Adjustment
======================================
LEAST SQUARES VERTICAL ADJUSTMENT REPORT
======================================
Tue Mar 21 17:37:27 2006
2D Geodetic Model.
Input Raw Files:
   C:\data\lsdata\cgstar\CGSTAR.CGR
Output File: C:\data\lsdata\cgstar\cgstar.RPT
Curvature, refraction correction: ON

FIXED VERTICAL BENCHMARKS
Station
  Elevation
  1 569.8500

POINTS TO BE ADJUSTED
Station
  2, 5, 3, 4, 10, 11, 12

MEASUREMENT SUMMARY
From
   To
   Elev. Diff. (unadjusted)
StdErr
  1
    5 7.5040
    1 0.0145
    2 7.5659
    0.0145
    3 6.9843
    0.0145
    4 -11.4907
    0.0146

Chapter 19. SurvNET 1638
<table>
<thead>
<tr>
<th>Station</th>
<th>Adjusted Elev</th>
<th>Standard Dev.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>569.8500</td>
<td>0.00000</td>
</tr>
<tr>
<td>2</td>
<td>577.4336</td>
<td>0.02465</td>
</tr>
<tr>
<td>5</td>
<td>577.3363</td>
<td>0.02465</td>
</tr>
<tr>
<td>3</td>
<td>584.4355</td>
<td>0.02915</td>
</tr>
<tr>
<td>4</td>
<td>572.9628</td>
<td>0.03070</td>
</tr>
<tr>
<td>10</td>
<td>579.6003</td>
<td>0.03341</td>
</tr>
<tr>
<td>11</td>
<td>580.6935</td>
<td>0.03641</td>
</tr>
<tr>
<td>12</td>
<td>581.0764</td>
<td>0.03519</td>
</tr>
</tbody>
</table>

**STATISTICAL SUMMARY**

- Total Unknown Elevations: 7
- Total Elev. Routes: 9
- Total Fixed BM's: 1
- Total non-fixed BM's: 0
- Degrees of freedom: 2
## ADJUSTED MEASUREMENT SUMMARY

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Elev. Diff. (adjusted)</th>
<th>Residuals</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>5</td>
<td>7.4863</td>
<td>-0.0177</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>7.5836</td>
<td>0.0177</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>7.0019</td>
<td>0.0177</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
<td>-11.4728</td>
<td>0.0179</td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>4.3735</td>
<td>0.0178</td>
</tr>
<tr>
<td>5</td>
<td>10</td>
<td>2.2641</td>
<td>0.0001</td>
</tr>
<tr>
<td>10</td>
<td>11</td>
<td>1.0932</td>
<td>0.0001</td>
</tr>
<tr>
<td>11</td>
<td>12</td>
<td>0.3829</td>
<td>0.0001</td>
</tr>
<tr>
<td>12</td>
<td>3</td>
<td>3.3591</td>
<td>0.0001</td>
</tr>
</tbody>
</table>

### Vertical Sidesthots

<table>
<thead>
<tr>
<th>Station</th>
<th>Elevation</th>
</tr>
</thead>
<tbody>
<tr>
<td>20</td>
<td>571.77</td>
</tr>
<tr>
<td>21</td>
<td>581.25</td>
</tr>
<tr>
<td>22</td>
<td>580.14</td>
</tr>
<tr>
<td>15</td>
<td>579.60</td>
</tr>
</tbody>
</table>
Index

Plus-0.5in, 640
2 Point - 2 Point Intersect, 640
2 Tangents, Arc Length, 285
2 Tangents, Chord Length, 286
2 Tangents, Degree of Curve, 287
2 Tangents, External, 287
2 Tangents, Mid-Ordinate, 286
2 Tangents, Radius, 285
2 Tangents, Tangent Length, 287
2 Tangents, Through Point, 288
2D Align, 228, 229
2D Polylines, 29, 56, 59–64, 116, 132, 139, 141, 142, 144, 279, 393, 690, 693, 727, 728
2D Scale, 221
2D-1D Local Coordinate System, 1583
2D-1D State Plane Coordinate System, 1597
3 Point, 283, 292, 293, 650
3-Radius Curve Series, 291
3D Entity to 2D, 255
3D Faces from TIN, 1308
3D Polyline, 29, 124, 125, 205, 208, 239, 251, 253, 284, 334, 576, 612, 690, 691, 693, 694, 696, 698, 886, 899, 917, 950
3D Polyline by Slope on Surface, 255
3D Polylines, 125, 239, 252
3D Viewer Window, 264, 267, 379, 856, 863, 864, 888
4 Sided Building, 60, 620
AASHTO, 673
Add Culvert to Polyline, 835
Add Intersection Points, 237
Add Point by Two Slopes, 239
Add Points, 1295
Add Points At Elevation, 252
Add Polyline Arcs, 238
Add Polyline Vertex, 238
Add Prefix/Suffix To Text, 226, 227
Add Zig to Polyline, 835
Adjoiner Text, 71, 806, 808, 809
Align by Two Pairs of Points, 428
Align Points, 423, 433, 449
All topo items, 1304
Alphanumeric, 48, 380, 409, 422, 1062, 1515, 1559
Angle/Distance, 72, 446, 761, 793
Angle Balance, 503, 526, 528, 602
Angle Info, 348
Angle Mode, 351, 381, 382, 630, 1029, 1526
Angle Reckoning, 1171
Angles Right, 1166
Annotate Menu, 774
Annotation, 3, 18, 26, 311, 313, 317, 320, 323, 325, 586, 743, 789, 805, 823, 841, 941, 944, 1316, 1317
Annotation Defaults, 775, 783, 819
Aperture Object Snap, 403
Arc Length, 285, 288, 673, 681, 776, 825, 1411, 1412
Arcview, 975
Area, 1148, 1149, 1151, 1152, 1200, 1203, 1316, 1338, 1361, 1572
Area/Layout Menu, 702, 751
Area by Closed Polyline, 710
Area by Interior Point, 710
Area by Lines & Arcs, 709, 710
Area Defaults, 705, 706, 708, 710, 713, 714, 743, 767
Area Label Defaults, 623, 712
Area Radial from Curve, 722
Area Summary, 1148, 1149
Arrowhead, 328, 460, 464, 846
ASCII File, 50, 110, 111, 418, 981, 982, 991, 1036, 1037, 1042, 1370, 1371, 1533, 1534, 1539
ASE, 33, 200, 1238
Attach Image to Entity, 978
Attribute Definitions, 769
Attribute Layers, 580
Attribute Layout ID, 411, 413, 456, 581
Audit, 195
Audit Links, 972
Authorizing Carlson Software, 10
Auto Annotate, 119, 237, 743, 783, 785, 787, 789, 791, 794, 821
AutoCAD Calculator, 1341
AutoCAD Overview, 168
Auto Create Points, 1258, 1259
Auto Lines, 1338
Auto Map, 1231, 1243
Automatic Point Numbers, 411
Auto Point Number, 1338
Auto Point Plot, 1338
Auto Tablet On, 380
Azimuth-Distance with Leader, 802
Backsight, 911
Bearing-Bearing Intersect, 637
Bearing-Distance Intersect, 638
Bearing-Distance with Leader, 801
Bearing & 3D Distance, 345
Bearing Annotation, 778
Bearing Area Cut-off, 1149
Bearing Area Cutoff, 723
Bearing with Leader, 800
Benchmark, 295
Best Fit, 1167
Best Fit Circle, 667
Best Fit Curve, 292
Best Fit Line by Average, 669
Best Fit Line by Least Squares, 670
Best Fit Transformation, 1270
Blips, 236
Block Explode, 208
Bold Curve Leader, 332
Border, 1197
Boundaries, 304
Boundary, 29
Boundary Polyl ine, 3
Break, 116
Break, At Selected Point, 215
Break, Select Object, 2nd Point, 215
Break, Select Object, Two Points, 215
Break at Intersection, 215
Break by Crossing Polyline, 213
Breakline, 581
Break Lines, 1291
Breaklines, 852
Breakpoint Descriptions, 920
Break Polyline at Specified Distances, 214
Brg-Dist w/Leader, 72
Bubble Cul-de-Sac, 1155
Buffer Offset, 207
Building Dimensions, 69
Building Offset Extensions, 653
Building Pad, 745
By Code, 1293, 1298
By Description, 1292, 1299
By Point Number, 1291, 1298
C&G Point Scanning, 1336
Calculate Horizontal, 1138
Calculate Offsets, 293
Callout Leader, 331
Calls, 1222
Call Table, 1228
Carlson File Types, 26
Carlson Points, 220
Carlson Registration, 12
Carlson Settings Explorer, 387
Centerline, 26
Centerline Conversion, 701
Centerline Conversions, 201
Centerline File, 685
Centerline ID, 685
Centerline Menu, 672
Centerline Report, 19
CGCogo, 1120
CGDos Drawings, 1005
CGDraw, 1185
CGEarth, 1342
CGEditor, 1310, 1350
CGFile, 984
CGMngmt, 1248
CG Options, 1310
CG Snap, 1339
CGSurvey Module, 983
CGTools, 1310
CGTopo, 1286
CGTrav, 1014
Change Attribute Style, 217
Change Block/Inserts Resize, 220
Change Block/Inserts Rotate, 218
Change Block/Inserts Substitute, 219
Change Elevations, 164
Change Entity Layer, 1332
Change Layer, 64
Change Point Layer Color, 466
Change Polyline Elevation, 246
Index
Distance Resection, 1172
Distance with Leader, 801
Divide Along Entity, 648
Divide Between Points, 647
Dozer, 28, 190
Dozer Push, 26
Dragline, 26, 28
Draw, 1232–1234, 1238, 1241, 1244, 1274, 1277, 1279
   1287, 1293, 1299, 1300, 1306, 1309, 1311, 1315, 1316, 1323, 1329, 1347, 1350, 1355, 1363–1367, 1369–1373
   1388, 1391, 1399, 1400, 1409–1413, 1417, 1423, 1425, 1433, 1434, 1441, 1445, 1453, 1457, 1458, 1464, 1466, 1468
   1512, 1535, 1552, 1557, 1567
   Draw 3D Grid File, 887–890
   Draw Barscale, 123, 814
   Draw Box Around Text, 294, 859, 861, 866
   Draw By Example, 326
   Draw Centerline File, 683
   Draw Cross Sections, 1363, 1365, 1367, 1368
   Draw End Point Leaders, 793
   Draw Field to Finish, 557–561, 564, 565, 572, 574
   575, 582
   Draw Grid, 809, 930, 933
   Drawing Block, 335
   Drawing Cleanup, 193, 195
   Drawing Explorer, 113, 357–360, 367
   Drawing Inspector, 117, 344, 345, 400, 1243, 1244
   Drawing Settings, 1183–1185, 1186, 1209, 1211, 1212
   1213, 1228, 1230
   Drawing Setup, 123, 137, 499, 57, 78, 125, 186, 190, 311
   315, 316, 318, 322, 326, 329, 332, 350, 351
   353, 379, 380, 396, 397, 416, 441, 579, 600
   623, 689, 695, 704, 775, 780, 812, 818, 828
   836, 840, 841, 843, 974
   Drawing Template, 177
   Draw Legend, 811, 813
   Draw Lot Setback, 752
   Draw Mapcheck, 1203, 1206
   Draw Menu, 278
   Draw North Arrow, 813, 931
   Draw Pipe, 941, 946
   Draw Polyline Blips, 236
   Draw Polyline File, 191
   Draw Profile, 19, 28, 353, 918, 919, 926, 927, 931, 949
   Draw Standard Item, 308–310, 314
   Draw Text On Arc, 827
   Draw Text on Tangent, 830
   Draw Triangular Mesh, 863, 864, 912
   Drop C&G Attributes, 1244, 1245
   Duplicate Points, 423, 424
   Dynamic Annotation, 380
   Dynamic Annotation Note, 794
   Eagle Point, 20, 171, 475, 563, 564
   Eagle Point Coding, 563
   Earth Curvature, 523, 541, 543
   Edit, 1201, 1202, 1204, 1252, 1254, 1258, 1271
   1274, 1276, 1279, 1283, 1285, 1317, 1342
   1343, 1346, 1347, 1350, 1351, 1355, 1359
   1378, 1384, 1386, 1387, 1397, 1400, 1409–1413
   1417, 1423, 1425, 1433, 1434, 1441, 1445, 1453, 1457
   1458, 1464, 1494, 1496, 1500, 1502, 1505
   Edit-Process Level Data, 549
   Edit-Process Raw Data File, 477, 501, 587, 603, 605
   606
   Edit Area Table Properties, 714
   Edit Coordinates (CGEditor), 1258
   Edit Cross Section File (CGEditor), 1342
   Edit Level File, 1083, 1089, 1094
   Edit Map Check File, 1111
   Edit Menu, 199, 508, 555, 1088, 1091
   Edit Multiple Pt Attributes, 455
   Edit Point, 150, 417, 440
   Edit Point Attributes, 410, 453
   Edit Points, 443, 582, 593, 1295, 1297
   Edit Polyline Section, 241
   Edit Polyline Vertex, 240
   Edit Process SDMS File, 556
   Edit Raw File, 1018, 1019
   Edit Symbol Library, 392, 813
   Edit Table, 981
   Edit Text, 222
   Edit Text on Arc or Tangent, 830, 831
   Edit_Template File (.CGEditor), 1359
   Elevate 2D Polylines, 729
   Elevation Difference, 623, 631, 890, 933, 936
   Elevations, 1336, 1366, 1432, 1597, 1639
   Elevation Zones, 888
   Empty Print File, 1012
   End Areas, 26
   Enter-Assign Point, 627, 629
   Enter and Assign, 130, 415
   Enter Deed Description, 585, 591
   Entities to Polylines, 234, 883
   Entity Insertion Point Rotate, 221
   Erase, 1238
   Erase by Closed Polyline, 201
   Erase by Layer, 200

Index
Index

Erase Links, 972
Erase Outside, 202
Erase Point Attributes, 117, 461
Erase Points, 444
Erase Select, 200
Erase Sub-Areas Hatch, 749
Erase Surface from DWG, 1302–1305
Example Projects, 1581
Exclude Boundaries, 1304, 1424
Exit Drawing Standards, 325
Explode Carlson Points, 468
Export Coordinates to ASCII, 989
Export LandXML File, 187
Export Lot File to MDB Database, 771
Export Lot File To Old SurvCADD, 772
Export SHP File, 975
Export Text, 426
Export Text/ASCII File, 18, 420, 423, 426, 442
Export Topcon Grid or TIN File, 908
Extend, 3, 29, 56, 57, 59–64, 116, 117, 132, 210–213,
280–282, 405, 1361, 1364
Extend Arc, 210
Extend by Distance, 210–211
Extended Entity Data, 197
Extended Point Information, 410
Extend To Edge, 209
Extend to Intersection, 209–210
Extract Project Archive, 368
Extrapolate, 253, 885, 892, 920
Extrapolate Grid, 888
Extrapolation, 885

Fence Diagram, 27
Ferm Codes, 27
Field to Finish, 2, 16, 27, 36, 112, 115, 124, 128, 156–158, 160, 298, 300, 316, 413, 454, 476, 536,
558, 561, 564
Field to Finish Inspector, 583, 584
File Editor, 550, 552, 554, 1085, 1086, 1089
File Menu, 174, 504, 555, 1087, 1091, 1377, 1412
Fillets, 29, 135, 230, 231, 252, 254, 727
Fillet 3D Polyline, 251
Find Bad Angle, 537, 1105, 1318
Find Lot Name, 760
Find Point, 346
Fit Polylines, 1220
Fit Structure, 733, 739, 741, 1157, 1159, 1161, 1162,
1164, 1219
Fit Structure Setup, 1166
Fit Text Inside Arc, 831
Fit Text Outside Arc, 831
Fix Coords, 1262
Fix Label Overlaps, 805
Fix Point Attribute Overlaps, 463, 465
Flip Last Label, 796
Flip On/Off, 797
Flip Selected Labels, 797
Flip Text, 119, 225, 689, 696, 704, 786, 788, 827, 930
Flood Note, 396
Flow Leader, 332
Four Way Control, 662, 1182, 1184, 1185
Freeze ALL Layers, 1334
Freeze Layer, 67, 122, 146, 163, 275, 445
Freeze Points, 145
From Breakline Layer, 1294

General Commands, 170, 623, 624, 628
General Information, 1120, 1121, 1556
Geodimeter, 473, 477, 496–498, 506
Geologic Column, 27
GIS Database Settings, 958, 961, 971
GIS File, 413, 959
GIS Inspector, 962
GIS Inspector Settings, 961, 963
GIS Links, 25
GIS Menu, 957
GIS Query/Report, 964
GLO-Corner-Proportioning, 1182
Global Edit, 1186, 1187, 1190
Global Reannotate, 805
GPS Network, 1612
GPS Vectors and Total Station, 1623
Graphic Scale, 1212, 1213
Grid File, 19, 242, 245, 253, 359, 379, 414, 523, 886,
890, 892, 904, 913
Grid File Utilities, 27, 190, 885
Guard Rail, 837

Hatch, 301, 304, 377, 744, 746, 749, 765, 811, 812,
856, 917, 1193, 1195
Hatch Sub-Areas, 749
HEC-2, 27
Highlight Crossing Plines, 248
Highlight Non-Tangent Polylines, 247
Highlight Unclosed Polyline, 249
Hinge-Radial Area Cut-off, 1151
Hinged Area, 139, 140, 720
Index

1648

Line by Angle-Distance, 652
Line On/Off, 629, 633
Lines, 1340, 1410, 1411, 1490
Lines and Polylines, 1216, 1220, 1222
Lines by Codes, 1219
Lines by Description, 1217, 1218, 1295
Lines by Point Number, 1216
Line Table, 822
Line Type Scaler, 58
Line Up Text, 227
Linework Intersection Points, 636
Links Manager, 431
LISCAD, 493, 495
LisCad, 473
List, 341, 352, 359, 406, 410, 417, 418, 426, 433, 439
440, 448, 450, 452, 478, 482, 564, 583, 592
604, 630, 655, 813, 908, 959, 960, 1026
1027, 1265, 1268, 1279, 1313, 1346, 1347
1350, 1358, 1366, 1388, 1523, 1524
List Elevation, 165, 345
List Points, 51, 141, 417, 422, 433, 560
List Raw File, 1094
List Templates, 1359
Load Saved Report, 349
Locate by Azimuth, 634
Locate by Bearing, 635, 638
Locate by Line-Bearing, 633
Locate by Turned Angle, 634
Locate on Real Z Axis, 130, 411, 414, 641, 650
Locate Point, 16, 20, 30, 52, 53, 129, 411, 416, 463
501, 559, 635, 981
Lock Layers, 277
Lot File, 146, 151, 154, 596, 758, 760, 762, 765, 768
771, 773
Lot File by Interior Text, 146, 764
Lot File by Pick Interior, 763
Lot File to Centerline, 772
Lot Inspector, 769
Lot Layout, 137, 138, 142, 275, 726
Lot Manager, 765
Lot Network Boundary, 747
Lot Network Hinged Area, 758
Lot Network Inspector, 759, 760
Lot Network Labels, 758
Lot Network Linework, 755
Lot Network Output To Lot File, 760
Lot Network Renumber Lots, 760
Lot Network Report, 758
Lot Network Road Network, 751
Lot Network Settings, 742, 751, 757, 759, 760
Lot Network Sliding Side Area, 757
Lot Network Subdivide Area, 755
Main Contours, 1303
Make 3D Grid File, 883, 889, 903
Manhole, 76, 115, 322, 943–945, 1072, 1261, 1568
Manual Storage, 1260
Map Check by Pnts, 606
Map Check by Screen Entities, 608
Map Draw, 1293, 1294
Map Erase, 1294
Map Points from, 426
Maps, 886
Maptech, 506
Max Samples, 382, 384
Measured, 495, 1473, 1476
Menu System Overview, 1436
Merge, 1344, 1345, 1547
MicroStation, 190, 191
Middle Ordinate Solution, 1141, 1316, 1339
Minimum Frontage, 756, 759
Mirror, 30, 231, 736, 737, 741, 742, 795, 796, 1159
1161, 1164, 1165
Mirror and Flip Selected Labels, 796
Mirror Selected Labels, 795
Mortgage Block, 396
Mouse Click Settings, 390
Move, 203, 211, 266, 279, 324, 385, 393, 410, 422
431, 432, 443, 459, 460, 464, 465, 592, 676
703, 720, 732, 738, 739, 742, 766, 769
790, 791, 794, 797, 800, 803, 804, 812, 846
Index
Index

885 893 912 931 952 1151 1209 1232 1238 1261 1279 1315 1326

Plot Grid File, 1309
Plot Points and Symbols, 1210, 1212, 1215, 1217
Plot Points on Screen, 1210
Plot Preview, 178
Point Code, 1337, 1421
Point Defaults, 37, 38, 53, 411, 413, 456, 466, 558, 628, 629, 638, 649, 657, 659, 660, 662
Point Description, 20, 39, 40, 346, 416, 432, 468, 627, 628, 634, 648, 653, 767, 842, 935, 1200, 1211, 1218
Point Entity, 456
Point Entity Grouping, 196, 410
Point Group Manager, 438, 440, 444, 922
Point Groups, 1281, 1284, 1516
Point ID, 342, 431, 1033, 1034, 1061, 1116, 1131, 1132, 1147, 1199, 1233, 1237, 1264, 1278, 1311, 1341, 1387, 1404, 1416, 1419, 1420, 1530, 1558
Point Label, 1240, 1241, 1278, 1366, 1367
Point Layer, 379, 581, 653
Point Links, 410
Point Manager, 1248, 1252, 1253, 1257
Point Notes, 410, 523, 560, 700
Point Number Report, 423, 434
Point Object Snap, 382, 403
Point on Arc, 647
Point Protect, 185, 189, 418, 437, 484, 486, 487, 489, 491, 492, 493, 497, 522, 625
Point Range, 28, 425, 483
Points, 1340, 1366, 1380, 1387, 1394, 1418, 1419, 1422, 1425, 1428, 1433, 1446, 1461, 1469, 1476, 1487, 1489, 1528, 1529, 1531, 1533, 1539, 1568, 1587, 1600, 1613, 1617, 1624
Points and Lines, 1340
Points Menu, 409
Points on Arc, 1141
Points on Centerline, 698, 952
Points on Line, 1136
Polygon Processor, 28
Polyline by Nearest Found, 334
Polyline File, 191
Polyline Info, 347
Polyline Report, 619
Polylines by Point, 1219
Polyline to Centerline File, 683, 685
Polyline to Lot File, 762
Polyline to RW5 File, 620
Polyline to Special Line, 833
Polyline to Tree Line, 834
Pre-calculated grids, 28
Preferences, 368, 375, 402
Print View Print File, 1013
PRO, 15, 28, 31, 33, 180, 216, 353, 378, 918, 920, 924, 937, 950, 956, 1051, 1053, 1548, 1550
Process Boundaries, 1301
Process Deed File, 591
Process Menu, 1468
Process Only Strata with Beds, 385
Product Overview, 2
Profile Conversions, 953, 956
Profile from Grid or Triangulation Surface, 921
Profile from Points on Centerline, 922
Profile from Surface Entities, 919
Profiles, 1369, 1371
Profile to 3D Polyline, 950
Profile To Points, 951
Project Explorer, 13, 17, 356, 362, 365
Project Setup, 389
Properties and Layers, 172
Properties Manager, 232, 273
Properties Toolbar, 173, 273
Property lines, 64
Public Land Section, 1180, 1185
Purge, 197, 198, 343
Query, 1242, 1243, 1316
Quick Keys, 16, 29
Quick Profile, 917, 919
Quick Traverse, 1014, 1015, 1159, 1316, 1319, 1320, 1338
Radial Stake Out, 1167
Radial Stakeout, 658, 659, 1166
Radius Point, 289, 290, 347, 587, 619, 690, 1233
Railroad, 293, 825, 952
Railroad Curves, 696
Railroad Curve Table, 822
Raster Image, 305
Raw File On/Off, 628
Redraw, 261
Reduce Direct-Reverse, 837
Index
Index

Reduce Map Check File, 1111
Reduce Polyline Vertices, 191, 194, 235
Reduce Traverse, 1094, 1095, 1110
Reduce Vertices, 3, 856, 858
Refresh Screen, 1246–1248
Refresh Status Line, 1286
Regen, 261
Registration, 10, 13
Remove Area Table Rows, 717
Remove Duplicate Polylines, 242
Remove Groups, 196
Remove Points, 1296
Remove Points from Screen, 1211, 1212
Remove Polyline Arcs, 242, 245
Remove Polyline Segment, 116, 162, 242
Remove Polyline Vertex, 243
Remove Reactors, 196, 794
Remove Spaces From Text, 227
Remove XData, 197
Renumber Points, 432, 435, 467, 538, 1254, 1255
repackaged, xxvi
Replace Text, 22, 228
Replot Descriptions, 842
Report Grade Elevation, 700
Report Log, 579
Report Sub-Area, 749
Rescale Drawing, 397
Resection, 643, 644, 1171, 1582
Residuals, 28, 534, 668, 671, 1597, 1640
Resize, 514
Resize Point Attributes, 462
Restore Due North, 272
Restore Layer, 39
Reverse Calls, 1225, 1226
Reverse Polyline, 138, 234, 235, 683, 725
Right-of-Way Easements, 1152
Right of Way, 672, 756, 1316
Rigid Body Transformation, 430
Road Design, 128, 29, 613, 752, 900
Roadside Ditch, 28
Roadways, 1152, 1155, 1157
Rotate by Pick, 221
Rotate Points, 270, 423, 433, 448, 1266
Rotate Text, 223, 808
Runoff, 28

468, 498, 504, 508, 508, 555, 572, 573, 591
594, 603, 612, 676, 682, 696, 706, 717, 754
765, 771, 782, 792, 812, 827, 857, 874, 918
924, 927, 949, 968, 968, 969, 979, 986
988, 991, 1068, 1087, 1091, 1141, 1145
1146, 1196, 1252, 1253, 1290, 1377, 1385
1409, 1417, 1451, 1455, 1491, 1500, 1565
Save/Load Tablet Calibration, 400
Save/Restore Layer State, 277
Save As, 177, 355, 393, 552, 555, 572, 573, 591, 594, 812, 874, 959, 988, 1087, 1091, 1377, 1397–1400, 1422, 1463
SB-Slope, 28
Scale, 222, 229, 230, 232, 266, 302, 307, 311, 315, 316, 318, 323, 325, 326, 359, 351, 352, 379
380, 397, 400, 423, 433, 450, 458, 460, 462, 464, 519, 523, 528, 530, 532, 533, 541, 543
576, 579, 586, 623, 689, 695, 704, 705, 749
775, 777, 780, 782, 787, 793, 799, 800, 806
810, 818, 836, 841, 846, 858, 859, 865, 866
928, 928, 929, 931, 933, 947, 984, 1110
1119, 1212, 1213, 1215, 1266, 1268, 1279
1312, 1313, 1324, 1325, 1327, 1365, 1370
1385, 1389, 1492, 1501, 1585
Scale Point Attributes, 54, 461, 462
Scale Points, 450
Screen Pick Point, 433
SDPS, 384
Seam Stacking, 384
Search Radius, 384
Section File, 612, 1011, 1012, 1018, 1285, 1343
1370, 1371, 1375, 1376, 1414
Section Subdivision, 656, 1180, 1181
SEDCAD, 26, 383
Select by Area, 257
Select by Elevation, 256
Select by Filter, 255
Selection of Items, 171
Select Similar, 257
Sequential Numbers, 18, 145, 326, 727
Set/Reset X-Hairs, 398
Set Active Area Table, 714
Set Back Measure-Move, 732
Set Coordinate File, 409, 421, 501, 673
Set CRD File for Lot Files, 772
Set Current, 1280, 1336
Set Data Directory, 15
Set Default, 1280, 1396, 1399, 1422
Index

1652

Set Drawing Standards Data Source, 313
Set Layer, 274
Set Line Type, 1186
Set Lot File, 760
Set Point Elevations by 3D Polylines, 618
Set Point Elevations by Surface Model, 618
Set Polyline Origin, 245
Set Project/Data Folders, 353, 557
Set Table Position, 821
Settings File Manager, 389
Settings Menu, 350, 1379, 1385, 1410, 1412–1414, 1417, 1420, 1427, 1451
Setting Up a Project, 13
Set UCS to World, 401
Setup DOS Dwg, 1008
Sewer, 28, 63, 322, 356, 923, 925, 943, 945, 947
Sewer Structure, 28, 324
Shade, 266, 570
Show Free Points, 1261
Show Surface, 1297
Show Used/Free Points, 1261, 1262
Show Used Points, 1262
SHP File, 20, 975
Shrink-Wrap Entities, 333
Side Shots, 627, 630, 632, 1103, 1105, 1468
Sight Distance, 529, 924
Size Lot by Frontage, 757
Sketch, 836
Sketch Tree Line, 836
Sliding Side Area, 142, 143, 721
Slope Distance, 498, 540, 541, 550, 556, 631, 644, 655, 1071, 1085, 1093, 1568, 1625
Slope Zone Analysis, 912
Smart Prompting, 961, 962
SML, 26, 477, 490, 491, 507, 548, 673, 1080, 1083, 1577, 1580
Smoothing, 858, 908
Smooth Polyline, 59, 236, 581
Snap Tolerance, 239
Softdesk, 471, 474, 506, 953, 956
Sokkia/SDR, 487, 488, 548, 955
Sokkia G, 477, 489
Solar Observation, 1176, 1177, 1313
Solar Observations, 663
Special Leader, 3, 73, 520, 844
Special Line/Entity, 836
Spiral, 294, 674, 677, 679, 681, 687, 688, 1143, 1145
Spiral Curve, 293
Spiral Curve Design, 1143
Spiral Curve Stakeout, 1144
Spiral In, 679
Spirals, 679
Spline, 133, 194, 1222, 1317, 1329
Split Bed by Parameters, 385
Split Text into Two Lines, 225
Spot Elevations, 896
Spot Elevations By Surface Model, 895
SRVPNO, 411, 447, 581
Stack Label Arc, 73, 824
Stake-Out, 1166, 1167
Stakeout Horizontal, 1145
Standard Align, 230
Standard Copy, 203
Standard Cul-de-Sac, 1155, 1156
Standard Explode, 207
Standard Offset, 204
Standard Report Viewer, 20, 45, 51, 149, 346, 349
Starting Survnet, 1433
Start Point Number, 411, 412
Startup Wizard, 13, 15, 37, 47, 48, 109, 110, 129, 151, 178
State Plane, 427, 452, 530, 532, 1389, 1454, 1585
Station-Offset, 19, 613, 615, 696, 698, 1134, 1241, 1242
Station/Elevation, 944
Station Offset, 1131, 1134, 1136
Station Offset From Coords, 1135
Station Polyline/Centerline, 19, 685, 688
Stockpile, 164, 167
Store Project Archive, 367, 368
StrataCalc, 26
Strata Isopach Maps, 26
Strata Quantities, 29
Superelevation, 28, 613
Surface 3D FlyOver, 267
Surface 3D Viewer, 267
Surface Inspector, 28
Surface Manager, 875, 876, 880, 882, 903
Surface Menu, 849
Surface Model, 234, 269, 282, 899, 903, 904, 920, 950
SurvCE, 18, 27, 28, 377, 379, 481, 483, 488, 489, 504, 507, 532, 550, 564, 612, 613, 959, 980, 981, 1044, 1045, 1047, 1049, 1084, 1281, 1432, 1457, 1489, 1500, 1541, 1542, 1544–1546
SurvCOGO, 507, 549
Survey Menu, 476, 1434
Surveyors Assistant, 477
Index

1654

Write Surface to DWG, 1301 [1302 1306]
X Intersections, 1154
Xref Manager, 183 [184]
Y Intersections, 1154
Zeiss, 419 [420 507]
Zone Polylines, 191
Zoom - Center, 262
Zoom - Dynamic, 261
Zoom - Extents, 262
Zoom - Previous, 261
Zoom - Window, 261
Zoom IN, 262
Zoom OUT, 262
Zoom Points, 263
Zoom Selection, 263
Zoom to Point ID, 1341

Variable Offset, 205
Ventilation, 25
Vertical Adjustment, 1638
Vertical Angle, 498 [511 522 536 541 627 631
  634 635 1071 1320 1387 1463 1568
  1626]
Vertical Angle Mode, 412
Vertical Curve, 1131
Vertical Curve Design, 1147
View, 4 [17 20 22 28 30 40 42 44 46 55 58 64
  67 79 81 83 96 113 115 118 122 136
  146 163 164 170 174 181 182 184 197
  260 263 264 266 267 270 277 304 306
  353 367 379 380 524 525 584 591 597
  673 675 749 765 789 791 804 810 852
  888 890 904 931 978 997 1013 1030
  1227 1263 1321 1341 1379 1385 1392
  1395 1410 1414 1527]
View Menu, 260 [1378 1412 1496]
Viewpoint 3D, 269 [852 887 888 907]
Visual COGO, 629 [630 632 633]
Visual Map Check, 1113
Volume, 3 [165 167 851 867 870 889 893 895
  903 950]
Volumes, 1359
Volumes By Layer, 893
Volumes By Triangulation, 867 [868]

Web Site, 31
What is New, 17
White Solid Behind Text, 295
Wild, 66 [128 155 415 418 421 495 548 954 956
  1063 1067 1068 1559 1563 1565]
Wildsoft, 438 [493 495 506
Windows Calculator, 1341
Write Block, 337
Write Polyline File, 20 [189 226]